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If you have questions in relation to Infor products, please use the Infor Online Support service on 

inforxtreme. If you do not have an Infor Xtreme Support account, click Register now and complete 

the registration form. You will receive a login ID and password within 24 hours. 

When you access Infor Xtreme, you will see the following options: 

 To access Infor's knowledge databases, incidents, documentation, software downloads, and 

community discussion forums, click the coresponding links on the menu on the top of the start 

page. 

 To add an error report, select one of the following options from the Incidents menu: 

 Add Product Incident : To ensure that your error report is sent to the right support group, 

please specify the product, version, and other relevant information. 

 Add General Information Request : Use this option for all other queries. 

 To obtain the customer service number for your region, click Contact Infor on the top right of 

the start page, enter a product name, and click Search. 

When this document is updated after a product release, the new version of the document is 

published on Infor Xtreme. We recommend that you check this website periodically for up-to-date 

documents. 

If you have comments on the documentation, please contact documentation@infor.com. 

 

Contact Infor 
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The following options for getting help are available in Infor COM in addition to the Online Help: 

1. Open the Help menu and select Contact Infor Xtreme Support to get into touch with Infor 

Xtreme Support. 

2. If you have questions on Infor COM products, please visit the http://www.inforxtreme.com site. 

If you do not have an account for this site yet, please register using the Register now button. 

You will receive an ID and password within 24 hours. 

Infor Xtreme provides documentation on support calls, a knowledge base, as well as the latest 

available User and System Online Helps. 

3. Please send any comments you may have on the Infor COM documentation to the 

documentation@infor.com e-mail address. 

Please note: If any of the functions described in this Online Help are not available to 

you, it could be because of one of the following reasons: 

 The functions in question are not part of the of the purchase/license agreement concluded 

with Infor. 

 They are functions that have not been implemented for all markets or are not relevant to 

particular markets.  

Please contact your Infor consultant if you have any questions relating to these issues. 
 

Get help 
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You are in the start interface when the only elements displayed on the screen are the navigation 

bar (page 33), the Data, View, Options and Help menus (page 39), as well as the gadget area. 

When you open an object in the navigation bar, you are brought to the desktop (page 32). 
 

Start interface 
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To go to the desktop, open an object on the navigation bar (page 33) of the start interface (page 

31). The top section of the desktop will then display the start form (page 34). 

Note: A start form is not displayed for all objects that are called. For objects such as Reports, a 

different form is displayed allowing you to select data records or to run functions. 

The desktop contains a few more menus (page 39) than the start interface: Data, Edit, View, 

Functions, Go to, Tools, Window, and Help. 

When you load or create a data record in the start form, the object form (page 38) is displayed in 

the large, empty area below the start form and to the right of the navigation bar. 

You can hide the navigation bar and the start form manually and automatically. You will find the 

required commands in the Options submenu. If the start form and navigation bar are both hidden, 

the object form takes up the entire desktop. 
 

Desktop 



Infor COM 7.5 User Guide | 33 

 

General 

 

When you start Infor COM the navigation bar is displayed at the left side of the start interface 

(page 31) and the desktop (page 32) of Infor COM. It is structured as follows. 

Upper icon bar At the upper edge of the navigation bar—above the Infor 

logo—there is an icon bar with the following four buttons: 

Memo, Show/hide navigation bar, Record process, and 

Compress process. 

Hide navigation 

bar 

The icon for hiding the navigation bar is located to the right of 

the Infor logo. Click the hidden navigation bar to display it again. 

Icons The following four icons are located above the navigation bar: 

Modules, My objects, Quick search (see "Use quick search" 

page 71), and Memo (see "Using the memo" page 71). 

My objects shows the My objects view. By default, the following 

objects are located there: History, Browser applications, 

Frequently used menus, Favorites, and Manage 

Favorites/History. You can use the Workflow Management 

System to add further individual objects. 

Navigation 

bar 

The navigation bar shows the following modules: Sales, Design, 

Planning, Finance, Manufacturing, Inventory, Purchasing, and 

System functions. You can change its width by dragging with 

the mouse. Click a module to show its objects and folders. Click 

an object to open the start form. 

Please note that the folders displayed in the modules depend 

on the desktop that was configured for the user group. For 

further information, see the Help on user administration. 
 

Navigation bar 
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Click an object in the navigation bar (page 33) to display the start form on the desktop (page 32). 

A start form is not displayed for all objects. For objects such as reports, a different form is 

displayed allowing you to select data records or to run functions. 

The start form may contain up to six tabs. Not all of the start forms contain all of the tabs described 

here. 

Start form 
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Tab Explanation 

Open On the Open tab, you can enter the required data for loading an existing data record. To 

open a sales order for example, enter the order ID or, if available, the ID of the purchase 

order it is based on. Then click Load to load the sales order into the object form. 

You can also load a selection of several data records into an overview table first. Use 

wildcards or filters to enable you to systematically select specific data records. For 

information on using filters, please read the following sections on the Filters tab. Please 

also refer to the information regarding the Open via item tab. 

Using the Previous data record and Next data record buttons: 

Use these two buttons on the Open tab to load data records and browse through an 

existing pool of data records. 

 

Technical details: Essentially, this is done only by using the primary key of the 

respective objects. In most cases primary keys are the object's number. So for example 

the Sales orders object's primary key is the customer order number, the I tem  (Design) 

object's primary key is the item number. Data records are sorted in ascending order 

according to their primary keys. First they are sorted numerically and then alphabetically.  

If no data record is open and also no primary key is specified yet, the <<  button loads the 

last data record, i.e. the data record with the biggest primary key, and the >>  button loads 

the first data record i.e. the data record with the smallest primary key in the data record 

inventory.  

When the primary key is specified the <<  button loads the data record with the next lowest 

primary key, i.e. the previous data record, from within key. The >>  button loads the data 

record with the next highest primary key, i.e. the following data record in the data record 

inventory.  

Note:  The entries of other fields on the Open tab are ignored. 

 

If a data record is loaded, you can scroll backwards and forwards through the pool of data 

records, starting from the present one. While scrolling, the fields on the Open tab always 

display the data for the currently loaded data record. 

Open via item This tab supplements the options available on the Open tab for loading a data record. For 

example, to open a sales order, you can enter the ID of an item that is included in this 

order. If the item is included in more than one sales order, the corresponding data records 

are first loaded into an overview table from which you can select the required order. If you 

specify a customer ID in addition to the item ID, the selection is restricted to orders from 

this particular customer. The same principle applies for purchase orders (Purchasing > 

Purchase orders). 

New You can enter the basic data required to create new data records on the New tab of the 

start form. For further information on this subject, see Create new data records (page 

64). 

Filters You can use filters to select data records from the pool of existing data records according 

to specific criteria and display them in a table. In the above example, a filter is chosen in 

the Name field which selects all sales orders for which an order confirmation but no 
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Tab Explanation 

advance shipping notice (ASN) has been printed. If you click Apply, all sales orders that 

meet these criteria will be displayed in a table. Use the Advanced button to call the Filters 

dialog box where you can change the filter's effect. 

For further information on filters, see the Filters section of the Help on system functions. 

Import You can load objects from a file on the Import tab. When you save the data, it is re-saved 

to the database. 

Example:  In the Allocation tables object (System functions module, 

Administration folder), you can use this function to import tables from infor mapping 
table files (*.imt). 

Note:  In contrast to the Import tab, you can load data directly from the database on the 

Open tab of the start form. 

Workflow The Workflow tab in the start form is only completed if the corresponding object was 

selected as a file attachment in a Microsoft Outlook task/message. The tab contains 

information relating to the corresponding task/message. For more information, see 

Workflow. 

Hiding the start form manually 

There are four buttons located on the right of the tab bar on the start form: 

 

You can use these to navigate to the previous and next tabs, to select a page or to hide the start 

form except for the tabs. 

Hiding the start form automatically 

Use the View > Options > Hide automatically menu command to hide the start form automatically. 

Default settings for dialog boxes 

The following buttons allow you to work with default settings for the user. 
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Buttons Description 

 
These buttons from left to right, permit the following actions: 

 
Save as default: Click this button to save the current values as the 

default setting for the current user. 

 
Restore default setttings: Click this button to load the previously 

saved values for the current user. 

 
Delete default settings: Click this button to reject the saved values 

for the current user. 

 
Clear fields: Click this button to clear the input fields of the dialog 

box. 
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The object form is shown on the desktop (page 32) as soon as you load or create a data record in 

the start form (page 34). 

All required object data is entered into and displayed in the object form. An object form consists of 

a form header, a notebook, and, depending on the type of object and view currently selected, 

a totals l ine and/or a status bar  (footer). 

The form header contains the key fields of the object. 

A notebook and its tabs (page 54) form the main area for entering and viewing object data. In the 

case of items, for example, you will find tabs for entering and maintaining planning data, supplier 

data, purchase prices, and much more. 

In the totals l ine, you can see how various totals are formed and what they include. The 

structure and content of the totals line depends on the view that you have just selected. 

The status bar  (which cannot be seen in the screenshot above) displays the current object 

status and the name of the employee currently using the system. For a detailed description of the 

status bar click here. 

The status l ine at the very bottom of the window (which cannot be seen in the above 

screenshot), provides brief information on menus and menu items, for example, if you move over 

them with the mouse, together with license and database names, unrounded values, etc. 

Views of an object 

An object generally has multiple views, which you can select from the View menu (page 44) on the 

desktop (page 32). The views are displayed on the object form. 

 

Object form 
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A bar containing the Infor COM menus is located on the start interface (page 31) and desktop 

(page 32). Open a menu by simply clicking it with your mouse. Alternatively open it by pressing Alt 

+ <underl ined character> . If a menu or command is dimmed in a menu, it means that it is not 

available in the current program situation. The scope and content of the menus differ between the 

start interface and desktop. 

The menu bar on the start interface contains the following menus: Data (see "Data menu" page 

39), View (see "View menu" page 44), Options (see "Options menu" page 42), Help (see "Help 

menu" page 50). 

The menu bar on the desktop contains the following menus: Data (see "Data menu" page 39), Edit 

(see "Edit menu" page 43), View (see "View menu" page 44), Functions (see "Functions menu" 

page 47), Go to (see "Go to menu" page 48), Tools (see "Tools menu" page 48), Window (see 

"Window menu" page 49), Help (see "Help menu" page 50). 

Note: You can also access numerous menu commands by using an icon in the icon bar (see 

"Toolbar" page 55). 
 

Data menu 

For general information on menus, see Menus (page 39). 

The Data menu is available on the start interface (page 31) and on the desktop (page 32). The 

number and type of commands contained in it vary. This will be pointed out in the descriptions of 

the menu commands. 

Menu command Explanation 

Load Desktop This command is only available in the Data menu of the start interface (page 31). 

Use this menu to reload desktop objects from the database. This becomes necessary 

when the objects have been modified in the IDM (Infor COM Dialog Manager) and the 

desktop must be updated as a result. 

Note:  You may also need to empty the form cache. 

Menus 
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Menu command Explanation 

Quick search Use this command in the Data menu to open the Quick search (see "Use quick 

search" page 71) dialog box. 

Memo Use this menu command or the corresponding shortcut (CTRL+H ) to open the 

memo (see "Using the memo" page 71). 

On the start interface (page 31), this command is available in the Data menu, and on 

the desktop (page 32), it is available in the Edit menu. 

New The New command is only available in the Data menu of the desktop (page 32). Use 

this command to display the New tab on the start form (page 34). 

Open The Open command is only available in the Data menu of the desktop (page 32). Use 

this command to display the Open tab on the start form (page 34). 

Reload The Reload command is only available in the Data menu on the desktop (page 32). It 

is available in all objects. 

You can use it to reload additional data records in the Overview view of an object that 

is already open. When you run this command, the Open dialog box will be displayed 

where you can enter the criteria for selecting the data record(s) to be reloaded. 

Example: In the Item overview view, you have loaded the items of a product group 

by entering the key, and now you would like to load the items of another group. To do 

this, select the Reload menu command. Alternatively, press Alt  + D + L .In the 

Open dialog box which then appears, enter the key for the other group and press OK to 

confirm. The items found will be added to the overview. 

You can also use this menu option when creating consolidated invoices. 

Close This menu command is only available in the Data menu of the desktop (page 32). Use 

this command to close the object form (page 38). If the object form is not open, the 

menu command is dimmed. 

Saves This menu command is only available in the Data menu on the desktop (page 32). 

Use this command to save the currently edited data record in the database. During this 

process, the fields displayed in the header record are saved as key fields. 

These special considerations should be taken into account when saving items and 

BORs. 

Save as This menu command is only available in the Data menu on the desktop (page 32). It 

cannot be run in the Overview view of an object. 

You can generate a new data record, for example a sales order or an inventory location, 

from a data record that has already been generated. To do this, load the original data 

record into the object form (page 38). Then select the Save as command from the 

Data menu or press Alt  + D + A . The Save as (see "Data menu" page 39) 
dialog box will open. 

Delete This menu command is only available in the Data menu on the desktop (page 32). 

You can use it to delete a currently loaded data record from the database, provided that 

it is still in a status that allows this action. 
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Menu command Explanation 

Example:  Purchase orders cannot be deleted once they have been printed or closed. 

The command cannot be run in the Overview view. You will need to load the data 

record to be deleted in the object view. You will be prompted to confirm that you want to 

delete the record permanently. 

Note: You cannot undo the Delete command. 

Send This submenu is only available in the Data menu on the desktop (page 32). It contains 

the following menu commands: 

Follow-up 

 Opens the Ad-hoc workflow for follow-up dialog box. 

Task 

 Opens the Ad-hoc Workflow dialog box. 

Message 

Opens the E-mail dialog box. 

Save link 

Opens the Save link dialog box. 

Add to Favorites 

Adds the currently loaded data record to the list of favorites (page 70). When you 

execute this command, the Add to Favorites dialog box is opened. In this dialog box, 

enter the name under which you want the data record to be saved in the Favorites list 

and click OK to confirm. 

Print The Print menu command is available for example in the Data menu of the desktop. 

When you select this command, a dialog box generally opens where you specify the 

data to be printed before the data on the screen is sent to the default printer in Windows 

(see Set up printer): 

When printing master data (such as items, tools, and so on), the Print dialog box is 

opened where you can use options to specify which resource data is to be printed. 

If you print movement data (such as sales orders, purchase orders, and so on), the 

Create document dialog box is opened. The current status of the data will determine 

which documents can be printed. 

You can also call the Create document dialog box using the Create document 

command form the Functions menu. 

The Shop floor documents dialog box is called in production orders. This is where 

you can stipulate which documents (for example, material sheets, manufacturing 

travelers, and so on) are to be printed for the order. 

Set up printer Use this command form the Data menu to access the dialog boxes in which to set up 

the printer properties. Alternatively, press Alt + D + S . 

Exit Use this command to exit Infor COM. 
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Options menu 

For general information on menus, see Menus (page 39). 

The Options menu is only available on the start interface (page 31). 

Menu command Explanation 

Form cache statistics Use the Form cache statistics command in the Options menu on the start 
interface (page 31) to open the Form cache statistics info box. The forms currently 

loaded will appear with their internal system names and the degree to which the form 

cache is filled. The form cache is a special type of memory in which the contents of 

frequently accessed locations in the main memory and the addresses of the 

corresponding data objects are temporarily stored.  

Empty form cache Use this menu command in the Options menu on the start form (see "Start 

interface" page 31) to empty the form cache and reload the forms from the database 

(repository) if you want them to be displayed again. You must empty the form cache if 

changes were made in the IDM (Infor COM Dialog Manager) while you were working in 

Infor COM. 

Clear VARIANTS 

cache 

When these commands are run, the decision logic and feature sheet cache is emptied. 

LJ4 Debugger Call this command to open the main window of the Lj4 Debugger, which allows you to 

control the course of a debugger session. 

On the start interface (page 31), this command is located in the Options menu. On 

the desktop (page 32), you will find it in the System submenu in the Tools menu. 

For detailed information on the LJ4 Debugger, see the associated Online Help. 

Field info Use this menu command to call the Field info form. The form contains information on 

names used in the system and properties of form elements. When opened, the form 

displays information on the particular element where the cursor was positioned when the 

command was called. When you reposition the cursor while the Field info form is open, 

the information displayed changes accordingly. 

On the start interface (page 31), you will find the Field info command in the Options 

menu. On the desktop (page 32), call this command from the System submenu in the 

Tools menu. You can also open it on the desktop by pressing the F9  function key. 

Record process The Record process command opens the start dialog box for recording processes. 

On the start interface, you can select this command from the Options menu. On the 

desktop, you can access it from the Tools menu. 

Compress process The Compress process command opens the start dialog box for compressing a 

process recording. 

On the start interface, you can select this command from the Options menu. On the 
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desktop, you can access it from the Tools menu. 

Trace output Use this command in the Options menu to call the Trace output dialog box (process 

tracing, error logging) in which the trace output for the Infor COM runtime can be 

controlled. 

Dump system 

information 

This menu command compresses the information relating to the Infor COM installation 

into a zip file. Typically this information is also needed by Infor Xtreme Support when 

processing service requests. 

Select the command to open the Dump system information dialog box. Select the 

required system information in this dialog box and confirm your selection by clicking OK. 

The zip file is then created in the user-specific log folder. 

On the start interface, you can access the Dump system information command from 

the Options menu. On the desktop, you can access it by selecting Tools > System. 

Installation 

information 

Opens the Installation information dialog box, which displays all installed Infor COM 

components. 

Set language Use this menu command in the Options menu to set the language that is to be used in 

Infor COM. Calling this command opens the Set language dialog box. Select the 

required language from the combo box in the Language field and confirm by clicking 

OK. 

User group settings See User group settings for more information. See the following entries in the Help on 

User administration. 

Log off and log on 

under a new name 

For information, refer to Log off and log on under a new name. 

User privileges 

administration 

For more information, see User privileges administration.  

Role administration For more information, see Role administration. 

 
 

Edit menu 

For general information on menus, see Menus (page 39). 

The Edit menu is only available on the desktop (page 32). 

It contains commands that enable you to manipulate selected data records and in which the 

Clipboard is also used. The commands are needed primarily for editing tables. 
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Menu command Explanation 

Cut This command from the Edit menu cuts the selected data and places it on the Clipboard, 

so it can be pasted later. 

Copy This command from the Edit menu copies the highlighted data to the Clipboard. 

Paste Use this command from the Edit menu to insert the data from the Clipboard at the current 

cursor position. 

Display table in Excel Use this command to export the data in the currently displayed view to Excel. 

This command is also available in the context menu of the row header. 

Output table to file Use this command to export the data in the currently displayed view to a (text) file. 

Note : In the file, the columns are separated by tabs. 

This command is also available in the context menu of the row header. 

Insert new row This command in the Edit menu inserts a new row into a table above the row in which the 

cursor is positioned. 

Delete row This command from the Edit menu deletes a highlighted row from a table. 

Next row Use this command in the Edit menu to jump to the next row in a table. If you are in a 

single record view, the next line is loaded. 

Previous row Use this command in the Edit menu to jump to the previous row in a table. If you are in a 

single record view, the previous line is loaded. 

Expand all For information, refer to Show/hide component data records. 

Collapse all For information, refer to Show/hide component data records. 

Filter submenu The Filter submenu in the Edit menu contains the Define filter and Reset filter 

commands. 

Define filter 

You can use filters to generate reports or objects containing selected database fields. 

Click this button to open the Filters form. 

For further information on the subject of filters, please see Use filter and Edit filter. 

Reset filter 

Use this command to reset all filter definitions. 

 
 

View menu 

For general information on menus, see Menus (page 39). 
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The View menu is available on the start interface (page 31) and on the desktop (page 32). 

Use the commands and options in the View menu to determine which data you want to be 

displayed and which interface elements you want to show/hide. 

On the desktop, the menu contains special commands that are valid throughout the system for 

displaying the different views of objects. 

Note:  Depending on the object, only some of the views may be available or the names of the 

views may vary slightly. 

The following example shows the views in a sales order: 

Views available in a sales order: 

 Order overview 

This table typically contains data from the document header of one or more orders. You 

can open this view by entering the % character into the Order ID field when opening sales 

orders. You cannot make any modifications here. 

 Order 

You can see the entire order here. The top third of the form contains the document header 

with the customer data; the bottom part contains a table with the order lines. You can 

modify each line individually. 

 Order header 

The form of the sales order's header record (HR record) is loaded. Infor COM works with a 

fictitious HR record here.  You cannot create it yourself in the sales order. This fictitious 

header record contains all order lines for the order. You can make modifications which will 

affect the entire order. 

 Order lines 

An individual line from the Order view is displayed in the single record view. You can 

modify this particular line. 

As you can see from the examples, the names of the views are derived from the names of the 

corresponding object. 
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On the desktop the View menu is divided into two parts: The top section displays the views, 

described in the previous sections, and the bottom part displays the shortcuts that you can use to 

navigate between the available tabs (page 54) of the view currently displayed. Click here (see 

"Hotkeys and function keys" page 76), for more detailed information on these shortcuts. 

Menu command Explanation 

Modules Use this command in the View  menu or the CTRL+Q shortcut to display the 

Modules  view of the navigation bar (page 33). 

My objects Use this command in the View menu or the CTRL+Y  shortcut to display the My 

objects view of the navigation bar (page 33). By default, this view contains the 

History, Favorites, and Manage Favorites/History modules. Using the workflow 

management system, additional, individual modules can be added. 

Options This submenu in the View menu contains the following commands and options: 

Show/hide navigation bar. Use this menu command to manually hide the navigation bar. 

Show/hide start form Use this menu command to manually hide the start form. 

Show/hide automatically. Use this menu command to hide the navigation bar 

automatically. This option is activated and deactivated via a mouse click. 

Show/hide completely. Use this menu command to hide the start form and the 

navigation bar automatically. This option is activated and deactivated via a mouse click. 

Overview view If multiple data records are loaded for an object (see Selecting data records) the 

selected data records are first loaded into an overview table. 

This overview table is loaded when you call the Overview view. In this overview, open 

the required data record by double-clicking its row number. 

Gadgets This command allows you to open the gadget manager. See Gadgets. 

Object view The object view is the default view after loading a data record. Typically the view is 

labeled with the name of the respective object. 

In objects with movement data, lines are displayed in this view as a table. This type of 

object usually also has a header view and a line view. 

Example: The Order view of the Sales orders, Production orders, and Rough 

plan. orders objects displays all order lines. 

In the case of objects for master data administration, master data for the respective 

object is displayed in the object view: 

Example: The Item view of the Items object displays the master data for an item. 

Header view In this view, only the header data of the data record loaded is displayed. 

Example: Order header view of a sales order 

This view is not available in all objects. 

Example:  Items 

Line view This view displays only data for an individual object line. The position of the cursor when 



Infor COM 7.5 User Guide | 47 

 

General 

 

Menu command Explanation 

you switch to the Single record view determines which line will be loaded into this 

view. 

Example: Order line view for displaying the data of a single sales order or 

production order line 

Note:  This view is not available in all objects. Example:  Items 

Features This menu command is only available in the View menu of the desktop. When you use 

the VARIANTS module this view is also available in the objects of the Sales module. 

See Features. 

Feature overview This menu command is only available in the View menu of the desktop. When you use 

the VARIANTS module this view is also available in the objects of the Sales module. 

See Feature overview in Sales order. 

Feature selection This menu command is only available in the View menu of the desktop. When you use 

the VARIANTS module this view is also available in the objects of the Sales module. 

See Feature selection. 

Notes This menu command is only available in the View menu of the desktop. Use the Notes 

view to enter texts for the Infor COM text fields. For more detailed information on this 

view, click here. 

 
 

Functions menu 

For general information on menus, see Menus (page 39). 

The Functions menu always contains the functions that you need for working with an object in the 

respective situation. 

In the Sales orders object, for example, you need the Price calculation and Calculate delivery date 

functions, while the Functions menu in the Purchase receipt object provides all commands 

required for postings. 

The functions are explained in the Help topics of the respective procedures in which they are used. 
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Go to menu 

For general information on menus, see Menus (page 39). 

You can use the commands in the Go to menu to go from one object to other objects of other 

modules without having to close the object that is currently open. 

The commands in the Go to menu are very object-specific. As a result, you can select the 

Company master command in a sales order to go to the master data of the affected customer. If 

you are viewing an item's master data, use the Price table command to get to the item's price 

definitions. 

Use Alt+F4 to return to the object. 
 

Tools menu 

For general information on menus, see Menus (page 39). 

The Tools menu is only displayed on the desktop (page 32). 

Menu command Explanation 

Mailbox The Mailbox menu command in the Tools menu opens the Open dialog box for 

the Mailbox. 

Allocation tables Use the Allocation tables menu command in the Tools menu to display the start 

form for opening an allocation table. 

System Note:The System submenu contains only commands used for calling internal 

information and functions and is therefore of particular interest to system 

administrators. 

The following menu commands are found in the System submenu: 

Current table status 

Opens an info box containing status information on the current VTab*. The current 

table is always the one in which the cursor is positioned. The box provides 

information, for example, about the name of the VTab, the name of the view, the 

number of lines, and so on. 

Field info 

For more detailed information, click here (see "Options menu" page 42). 
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User privileges administration 

The User privileges administration dialog box opens. 

LJ4 Debugger 

For more detailed information, click here (see "Options menu" page 42). 

DL Debugger 

Use this command (or SHIFT + F12) to activate the DL Debugger (see Decision 

logics). The next decision logic process you start will then be logged automatically by 

the debugger. We recommend activating the DL Debugger if you want to test your 

decision logics for correct syntax. 

Dump system information 

For more detailed information, click here (see "Options menu" page 42). 

Installation information 

Opens the Installation information dialog box, which displays all installed Infor 

COM components. 

ISL Interpreter This command in the Tools menu starts the ISL console (ISL = Infor Script 

Language). You can use the ISL query language to submit database queries, run 

scripts, or import/export database tables, for example. 

Use the quit statement to close the ISL console. 

Trace output Use this command in the Tools menu to call the Trace output dialog box (process 

tracing, error logging) in which the trace output for the Infor COM runtime can be 

controlled. 

On the start interface (page 31), you will find this menu in the Options menu. 

For further information, see the Online Help of the LJ4 Debugger. To call this Online 

Help, press the F1 function key in the Lj4 Debugger. 

You will find information on creating and evaluating traces in the 

TracePerformanceTools.chm topic in the Help directory of your Infor COM 

system, if you open the Traceviewer topic. 

 
 

Window menu 

For general information on menus, see Menus (page 39). 

Multiple windows (views) can be opened simultaneously on the object form (page 38) in Infor 

COM. You can switch between these views while editing. You can use the commands in the 

Window menu to resize and arrange windows differently according to the Windows standard. 
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The top part of the menu contains the commands for arranging the loaded windows. 

In the bottom part, you can see which windows are currently open. By clicking one of the names 

(or using the ARROW keys and the SHIFT key) you can switch to a different window. The 

result is the same as if you had used the corresponding command in the View menu. 

Menu command Explanation 

Overlapping Use this menu command to cascade all currently loaded windows. 

Tile vertically Use this menu command to tile all currently loaded windows vertically. 

Tile horizontally Use this menu command to tile all currently loaded windows horizontally. 

Arrange icons  Use this button located in the title bar of any window to minimize the window to 

the size of an icon. You can then use the Arrange icons command from the 

Window menu to arrange the icons. 

Close all 
This command closes all windows in Infor COM that are currently open. 

 
 

Help menu 

For general information on menus, see Menus (page 39). 

In addition to commands for opening the Infor COM Online Help, you can also use the Help menu 

to obtain various items of information about your Infor COM installation. 

Menu command Explanation 

Contents This command in the Help menu opens the Infor COM Online Help for 

users. You can find your required Help topic on the Content , Index , or 

Find  tabs of the Help program. 

Context Note: This command is not available in the Help menu on the start 
interface (page 31). 

The Context command in the Help menu opens context-sensitive Help. 

Context-sensitive Help topics describe the element on the Infor COM 

interface where the cursor is located when you open the Help. The topic that 

is opened when you call the Help in this way depends on the position of 

your cursor, which must be positioned in a field. In overviews and tables that 

do not have any input fields, click the left number bar and open the Help. 

Using Help This command provides information on how to use the Infor COM Online 
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Help. 

About This command opens an info box containing some basic data on your Infor 

COM installation. 

Module information This command in the Help menu opens the Module information info 

window, which shows the versions of the DLL components installed on your 

Infor COM system. 

DLL = Dynamic Link Library:  A group of executable routines that 

are stored separately as files with the extension DLL. They are loaded as 

needed while Infor COM is running and are linked to it. 

Contact Infor Global Support To contact Infor Xtreme Support or enter a support case, select Help > 

Contact Infor Global Support. The COMMON.SUPPORTCENTER.URL 

parameter setting must be taken into account here. 
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The following Help topics provide information on how to use some of the basic elements in the 

Infor COM forms. 
 

Input fields 

You enter data in input fields. 

To enter data in an input field, you must position the cursor in that field. To do this, click the field 

with the mouse or jump to it using the TAB key on your keyboard. A cursor will appear in the field 

in the form of a flashing, vertical line. Any characters you enter will start at this position. 

Use the SHIFT+TAB shortcut to jump to the previous input field in the sequence. 

Any fields that serve merely to display values in the current editing situation and that may not be 

edited are dimmed. You cannot activate dimmed fields using the mouse or the TAB key. 

There are also fields with shortcut menus (page 52). 
 

Shortcut menus 

A shortcut menu is a list of commands that is displayed when you click a specific field using the 

right mouse button. These commands can also be called using the corresponding menu in the 

menu bar. 
 

Check boxes 

A check box located next to an option indicates that you can select or deselect the option. To select an option, click 

it and a check mark will appear in the check box. Click it again to deselect (clear) it. 
 

Basic form elements 
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Option fields 

Option fields are options that exclude one another. 

In a list of options, you can select exactly one of them by clicking its option field. The other option 

that is currently selected is then automatically deselected. The selected option is indicated by a 

black dot in its field. 

When using a keyboard, use the tab key to move from the current cursor position in the form to the 

option currently selected. The option name is then framed by a dotted border. Use the arrow keys 

to move to the option that you want to select instead. Use the tab key to exit the area containing 

the option fields. 
 

Combo boxes 

It is often easier and quicker to select a value from a list rather than to enter it. Therefore, some 

fields in Infor COM have a combo box, which allows you to select the required value. 

Some combo boxes provide a precisely defined group of values for selection. These values are 

maintained in separate allocation tables. For example, the values defined in the combo box for the 

Payment terms field shown below are stored in the ZAHLBED allocation table. 

Opening a combo box and selecting data using the mouse:  

Use the left mouse button to click the black arrow to the right of the input field. Then left-click the 

required value in the box. 

Opening a combo box and selecting an entry via the keyboard:  

Use the Tab key to enter the field. Press Alt  + Down arrow to open the combo box. Use the 

arrow keys to mark the desired entry in the box. Press Tab or Enter  to copy the selected value 

to the field. 
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Tabs 

Typically, the notebooks in the object forms (see "Object form" page 38) contain several tabs. 

A tab is a page that contains data relating to a specific, independent topic. 

These pages are much like an index whose tabs indicate the names of the pages. The tab of the 

page that is currently active is highlighted in color: 

You can display a tab by clicking the tab or by using one of the arrow keys to the right of the tabs. 
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The toolbar is located on the desktop (page 32) below the menu bar (see "Menus" page 39). It 

contains a number of buttons that carry out a function when clicked. 

Depending on the program situation, the number of buttons on the toolbar varies. Any function that 

you access using these buttons can also be selected from a menu. 

Toolbar 
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 New: Displays the New tab on the start form where you can 

enter the data required to create a new object. 

 Open: Displays the Open tab on the start form where you can 

enter the data required to open an object. 

 Save: Saves the object. 

 Print: Prints the current document. 

 Cut: Cuts the selected data and places it on the Clipboard. 

 Copy: Copies the selected data to the Clipboard. 

 Paste: Pastes the data from the Clipboard to the current cursor 

position. 

 Memo: Opens the Memo (see "Using the memo" page 71) 

feature. 

 Next row: Jumps to the next row in the table. 

 Previous row: Jumps to the previous row in the table. 

 Define filter: You can use filters to generate reports or objects 

that are based on selections via database fields. Click this 

button to open the Filters form. 

 Reset filter: Resets all filter definitions. 

 Overview view: Opens the table overview for multiple selected 

objects, for example, orders, customers, items, etc. 

 Object view: Displays the currently loaded object (for example, 

sales order, purchase order) in table format and with all lines 

included. 

 Header view: Only the header data for the currently loaded 

object is displayed, e.g. the order header for a sales order or 

production order. 

 Line view: Only the data for the currently highlighted line of an 

object is displayed, e.g. the data for a sales order line. 

 Features: Allows you to enter features for a product 

configuration item. 

 Notes: Displays the Notes view where you can enter texts for 

the text fields. 

 Show/hide navigation bar: Shows or hides the navigation 

bar. 

 Show/Hide gadget area: Shows or hides the gadget area. 
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 Gadgets: Opens the gadget dialog box. 

 Assign incoming documents 

 Open files in d.3: Opens a file in the d.3 archive. 

 Add file to d.3 

 Create document: Opens the Document dialog box. 

 Price calculation: Calculates the prices for individual lines and 

for the entire object (for example, a sales order or purchase 

order). 

 Calculate total weight: Calculates the weight of a delivery, 

provided that the weight is stored in the master data for the item. 

 Find master data: Opens the function for finding master data. 

 QIS Search: Opens the quick item search function. 

 Check availability: Starts a check to determine the availability 

of an item in the inventory. 

 Calculate manufacturing costs: Opens the manufacturing 

costing function. 

 Schedule: Allows the scheduling of a production order. 

 Excel: Opens Excel. 

 Record process: Opens the process recording function. 

 Compress process: Opens the start dialog box for 

compressing a process recording. 

 Context: Opens the Help for the current form. The current 

cursor position determines the context-sensitive Help that is 

displayed here. 

 Load in APS: Loads a production order for detailed planning in 

APS.  
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These general functions are available to you in all parts of the system: 
 

Find master data 

When creating a new object, you must load resources from the database. When processing 

previously created objects, you can reload resources. 

Examples 

 Loading item resources and additional costs in sales orders. 

 Loading item resources, operations, work centers, suppliers, and tools in BORs. 

 Loading item resources, operations, work centers, and tools in production orders. 

If you do not know the ID of a resource, or you know only part of it, you can use the Find master 

data command to open a search form. In this form, you can search for the resource using various 

criteria and then transfer it to the respective object. 

Proceed as described below. The procedure is based on the assumption that you have already 

opened an object. 

1. Place the cursor in the row of the object form (page 38) in which you later want to insert the 

resource(s). 

2. Select Go to > Find master data. The Find master data form is displayed. 

In this form, there is a tab for each resource type that you can load into the object. 

3. Display the page for the corresponding resource and enter the known criteria for your search. 

Example:  Open the Items tab if this is the resource you are looking for. If you know it, 

specify the item type using the Sales item, Pur. item, In-hse manuf., and/or Set items 

options. Alternatively, enter the key, for example for the group of goods. Use wildcards if 

you want to search by a partial item ID. 

4. After you have entered the preselection criteria, click the Find button. All resources found are 

then listed in the table. 

General functions 
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5. Select the required resource by clicking its ID on the numbering bar. You can select multiple 

successive resources by holding down the SHIFT key and then simply clicking the row 

number of the first and last resource to be highlighted. To select multiple non-successive 

resources, hold down the CTRL key while clicking only the row numbers of the required 

resources. 

6. When you click the Accept button, all highlighted resources will be transferred to the object 

form (see step 1). 

7. To close the Find master data dialog box, click Close, and you will return to the object form. 
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Print reports 

In all Infor COM modules, you have the option of printing reports: 

8. Click the Reports object in the relevant module. The Report overview dialog box is displayed. 

9. Select the required report in the table by clicking the relevant row number. If necessary, you 

can also perform the following tasks: 

 You can select a different output currency from the list box for the Output currency field. 

See Issue reports in switchable currency (see "Issue reports in different currencies" page 

60) for more information. 

 Click the Preview button to display the report in print preview. If you press Close while you 

are in the preview, you will return to the report selection. 

 If you would like to limit the data for printing reports, click the Filter button (see Use filter). 

10. When you press OK to confirm, the print command will be sent to the printer currently set as 

the default printer. Before doing so, you can configure the printer properties according to the 

Windows standard using the Printer button. Once printing is complete, the dialog box closes 

and you return to the Infor COM start interface (page 31). 

Note:  You can also start the print process by double-clicking the corresponding row number. 
 

Issue reports in different currencies 

You can output reports in different currencies. For more information, see Print reports (page 60). 

Select the required output currency from the combo box for the Output currency field in the Report 

overview dialog box, which is displayed when you open the Reports object. 
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You can choose between the transaction currency and any other currency (CHF, USD, etc.), 

provided the currency is stored in the FREMDWEUR allocation table. When you select the 

transaction currency, the data is printed exactly as it is stored in the corresponding object (order, 

purchase order, etc.). When you select another currency, the data is converted to the required 

currency once it has been loaded and before it has been printed. The conversion is always based 

on the daily rate from the foreign currencies allocation table, and because the exchange rate is 

fixed for Euro countries, there is no currency fluctuation. This means that the results will always be 

identical, even for temporary conversions. To maintain an acceptable runtime when printing 

reports, the value fields are converted on a 1:1 basis. As a result, inaccuracies will occur in the 

cent range in rounded total amounts. While it is possible to have these inaccuracies resolved by 

additional calculation routines, this would have a substantial negative effect on runtime behavior 

because (in a worst-case scenario) the entire order would first have to be reloaded and 

recalculated for each line that is to be printed. Furthermore, when this procedure is used, the 

conversion of the original total would always deviate from the temporary total. 
 

Use preview function when printing documents and reports 

Use the preview function to view documents and reports before printing them. 

 
 

Select lines 

In Infor COM, you can show and hide specific lines in tables by selecting them. This can be 

especially helpful when working with large tables that contain many lines. 

In order to be able to select a line, you must first highlight it. While holding down the CTRL key, 

click the row header of the corresponding lines. If the lines to be highlighted are all in a sequence, 

hold down the SHIFT key instead of the CTRL key. Then click the first and last line of the 

sequence. 

Once you have highlighted all required lines, right-click anywhere in the row header. A shortcut 

menu with the following commands will appear: 
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Command  Effect  

Invert selection All previously selected lines will be deselected, all lines previously not selected 

will now be selected. 

Select all Selects all lines of the table. 

Select highlighted Selects only the highlighted lines. All other lines in the table are hidden. 

Cancel selection Cancels a selection previously made. 

 
 

Show/hide child data records 

In tables, data records are displayed row by row. In some cases, data records contain subordinate 

data that can be shown or hidden. 

If a data record contains subordinate records, this is indicated by a plus sign that is displayed next 

to it. When you click the sign, the rest of the structure is displayed: 

If you click the minus sign that is now shown, the structure is collapsed again. 

Note:  You can also use the Expand all and Collapse all menu commands from the Edit menu to 

do this. 
 

Use placeholders when loading data records 

Wildcards can also be referred to as placeholders. 

In Infor COM, you can select specific data records from all data records available for an object and 

load them into an overview table. 

Example: 

You assign IDs to all of your sales orders that indicate, among other things, the month and year 

during which they were placed. Now you would like to load all orders for all customers, or maybe 

for just one specific customer during a specific month and year, into the overview table. 
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To select the required data records from the entire number of data records available, you must 

enter the respective data into the fields of the corresponding Open tabs. 

Wildcards are very helpful in this respect, because you can use them to replace individual 

characters or even entire character strings in the data to be entered. This will be illustrated by the 

examples in the following section. 

In Infor COM, two wildcard characters are available to you: the percent symbol (%) and the 

underscore (_). 

The percent symbol is a wildcard for any character or any character string that can be in its place. 

It can be used multiple times and at any position in the data record ID. 

You enter:  These data records are loaded:  

% A1010, A2010, A2015, A2021, A2040, A3011, A40C155, 

BA1010, DA1010 

%1010 A1010; BA1010, DA1010 

A20% A2010, A2015, A2021, A2040 

A%1% A1010, A2010, A2015, A3011, A40C155 

The underscore, on the other hand, represents exactly one character in the string. It can be used 

multiple times and at any position in the data record ID. 

You enter:  These data records are loaded:  

_A1010 BA1010, DA1010 

A_010 A1010, A2010 

A_01_ A1010, A2010, A2015 

A__1_ A1010, A2010, A2015, A3011 

You can also combine the two wildcards: 

You enter:  These data records are loaded:  

%10_0 A1010, BA1010, DA1010 

Note: The more fields you populate on the Open tab, the more accurately you can narrow down 

your selection of specific data records. 

Exception regarding the use of wi ldcards:  
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In the Prices, Discounts and Additional costs objects, the wildcards in the Item group and 

Company group fields on the Open tab of the start form are not accepted. If you would like to load 

all data records in these objects into the overview table, leave the default value at 0 (zero) in both 

fields or delete it. In the Item ID and Company ID fields, on the other hand, the wildcards are used 

as previously described. 
 

Create new data records 

When creating new data records such as new sales orders or new purchase orders, begin by 

entering data on the New tab of the start form (page 34) in the corresponding object. To do so, you 

must first go to the New tab of the start form: 

1. On the navigation bar (page 33), click the module that contains the required object. 

2. Click the object. Click the Purchase orders object, for example, if you want to enter a new 

purchase order. To display the start form on the desktop, click the object. 

3. On the start form, click the New tab to display the page. 

4. Enter the required data in the relevant fields. In the case of a purchase order, this would be the 

PO ID and Supplier ID. The ID for the new data record (in our example, the PO ID) is 

suggested by the system according to the numbering. However, you can overwrite it with an ID 

of your choice. 

5. Click Create to open the object form (page 38). The header of the object form contains the 

previously entered data. With the exception of the ID for the new data record, you can still 

change any of the data here. The data record for the object has now been created and can be 

amended with additional data. 

 To activate the New tab in the start form, you can also click on the button with the icon shown 

here, which is located on the toolbar. You can also select the New command from the Data menu. 

This command can also be accessed by pressing Ctrl+N or Alt+D+N. 

The data entered on the New tab is transferred to the header of the object form. With the exception 

of the assigned ID, any of the data can be modified later. 
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Hide columns 

To hide columns on any tab in Infor COM, proceed as follows. 

1. Click the column title and hold the mouse button down until a black rectangle appears. 

2. Drag the rectangle downward. As soon as the black rectangle changes to a black cross, 

release the mouse button. The column is now no longer displayed. 

You can use the Customize current view dialog box to show the column in the view again. 
 

View history 

Infor COM automatically keeps a history of recently used data records. See also Delete history. 

To display the history, complete the following steps: 

1. Select View > My objects. 

2. Click History. 

The most recently loaded data records are listed. Click an entry to open the corresponding 

data record. 

Note: The maximum number of entries can be preset in the configuration using the 

COMMON.PRIVATE.MAXNUMBERHISTORY parameter. In the standard version, the 

number is set to 25. 
 

Export data to Excel 

In many Infor COM objects, it is possible to export data to Microsoft Office Excel. To do this, select 

the Excel command from the Go to menu in the corresponding objects. To find out which objects 

support the export of data, see the table at the end of this Help topic. 

Prerequisi tes 

 Microsoft Office Excel 2003 (or higher) must be installed on the Infor COM client. 
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 When Excel is opened, the cursor must be positioned in a valid table. Otherwise, a message is 

generated informing you that no data could be found for transfer to Excel. 

Configuration 

The interface for exporting data to Excel is configured using the COMMONXL section. For more 

information, see Configuration (Microsoft Excel). 

Note: When exporting data to Excel, the application must initialize first. This process can take 

some time. 
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Module  Object View 

Sales Quotes Quote 

Quote header 

Quote line 

Quote overview 

 
Sales orders Order 

Order header 

Order line 

Order overview 

 
Advance shipping notices 

(ASN) 

Advance shipping notice, ASN 

ASN header 

ASN line 

Advance shipping notice overview 

 
Invoices Invoice 

Invoice header 

Invoice line 

Invoice overview 

 
Credit memos Credit memo 

Credit memo header 

Credit memo line 

Credit memo overview 

 
Received credit memos Credit memo 

Credit memo header 

Credit memo line 

Credit memo overview 

 
Invoice journal Invoice journal 

Single record 

 
Order releases Order release 

Order release header 

Order release line 

Order release overview 

 
Message editor Log record overview 

 
Prices Price tables 

Single record 
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Module  Object View 

 
Shipping material account, 

Ship.mat. act 

Shipping material account, Ship.mat. act 

Shipping material account header 

Shipping material movements 

Design Item Item overview 

 
BORs BOR 

 
Work centers Work center overview 

Planning Item account Item account 

Item overview 

 
Rough planned orders Order 

Order header 

Order line 

 
Capacity account Capacity account 

Work center overview 

Finance Inventory value journal Inventory value journal 

Inventory value journal overview 

 
Posting journal Posting journal 

Single record 

Manufacturing Production orders Order 

Order header 

Order line 

Inventory Inventory information Inventory information - structural overview 

Inventory information overview 

Batch-tracked inventory information 

 
Packaging information Packaging information - structural overview 

 
Inventory journal Inventory journal 

Inventory journal overview 

Purch. PO proposals PO proposal overview 

Price comparison 

 
Purchase orders PO 

PO header 

PO line 
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Module  Object View 

 
Invoice journal Invoice journal 

Single record 

 
Purchase credit memos Purchase credit memo 

Purchase credit memo header 

Purchase credit memo line 

 
Debit memos Debit memo 

Debit memo header 

Debit memo line 
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Favorites 

 Infor COM allows you to define and manage objects and data records as favorites. Favorites 

make it easier for you to find and manage objects. They are saved in the Favorites section in the 

My objects view of the navigation bar (page 33). To display this view, open the View menu and 

select My objects, or press Ctrl+Y. Then click the Favorites section. A list of currently defined 

favorites is then displayed. 

The maximum number of entries can be preset in the configuration using the  

COMMON.PRIVATE.MAXNUMBERFAVORITES parameter. In the standard version, the number 

of entries is set to 25. 
 

Manage Favorites 

You can use the Manage Favorites function to change the favorites' names or sort order and 

delete individual favorites. 

To manage your saved Favorites (page 70), complete the following steps: 

1. Select View > My objects.. 

2. Click Manage Favorites/History. 

3. Click Manage Favorites. 

The Manage Favorites overview view will open. 

4. The following actions are possible: 

 To change the name of a favorite in the Favorite name column, click the name and then 

overwrite it. 

 Right-click the Sort order column header and select Sort > Descending or Ascending. 

 To delete the selected row, select Edit > Delete row. 
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Use quick search 

The quick search in Infor COM enables you to easily search for and load data records using a 

single, predefined feature. The quick search is available in all processes. 

To access the Quick search function, select Data > Quick search. 

This opens the Quick search dialog box. You then need to use the combo box in the Browse field 

to select the application (object) containing the required data record. 

Example:  You want to find and load a particular sales order. In this case, select the Sales orders 

application. 

Once you have specified the application, the corresponding predefined search criterion will 

automatically be displayed in the Search for field on the left. 

Example:  When searching in the Sales orders application, the search is conducted using the 

order ID. 

Finally, you must enter the ID of the required object in the Search for field on the right. The entries 

in this field are saved per user for one day and then deleted. 

Example:  If you are looking for a sales order, you will need to specify its ID. Wildcards can also 

be used here. 

Click the Find button to start the search. 
 

Using the memo 

You access the memo by opening the Edit menu and selecting the Memo command. 

You can save text in the memo. You can enter the text manually or insert the contents of the 

Clipboard. 

To close the memo, click the Close button. 
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Save link menu command 

Use this menu command (Data > Send) to open the dialog box of the same name which you can 

use to save a reference to the current object. You will find more details in the Help topic for this 

dialog box. 

 



Infor COM 7.5 User Guide | 73 

 

General 

 

The following Help topics provide you with information on general dialog boxes and tabs in Infor 

COM. 

If you are working with the dialog box in question, you can also call the associated Help topic by 

pressing the F1 function key or by pressing the Help button. 
 

Specify language dialog box 

In this dialog box, you can specify the language to be used in Infor COM. Select the required 

language from the combo box in the Language field and confirm by clicking OK. 
 

Form cache statistics dialog box 

In the Form cache statistics dialog box, you will see the currently loaded forms with their internal 

system names and the degree to which the form cache is filled as a result. 

Cache: A special type of memory in which the contents of frequently accessed locations in the 

main memory and the addresses of the corresponding data objects are temporarily stored. 
 

Trace output dialog box 

Use this dialog box to define how the trace output for the Infor COM runtime is to be controlled. 
 

Change password dialog box 

In this dialog box, you can change your password for logging on to Infor COM. 

General dialog boxes and tabs 
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To change the password, enter the new password in the two fields labeled New password and 

Confirm new password. The characters you enter are displayed as asterisks. Then click OK. 
 

Report overview dialog box 

You can display the Report overview dialog box in all modules by opening the Reports object. 

The descriptions and names of all available reports for the respective module are listed in the table 

of this dialog box. Click OK to start printing. 

For a detailed introduction on printing reports, click here (see "Print reports" page 60). 
 

Add to Favorites dialog box 

To open this dialog box select the Add to Favorites command from the Send submenu of the Data 

menu. You must specify the name of the new favorite here. For more information, see Favorites 

(page 70). 
 

Quick search dialog box 

For detailed information, see Quick search (see "Use quick search" page 71). 
 

Memo dialog box 

For detailed information, see Memo (see "Using the memo" page 71). 
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Save as dialog box 

This dialog box is opened when you call the Save as (see "Data menu" page 39) menu command 

(Data menu). The type and number of fields displayed depends on the object that is to be saved 

under a different ID. 

In each case, the dialog box contains a field proposing the new ID for the object to be saved. The 

ID is determined according to the numbering that has been saved, but it can be overwritten if 

required. 

If a manually entered ID already exists, a corresponding error report is generated by the system. 

When you confirm the error report by clicking OK, the Save as dialog box displays again to allow 

you assign another ID. 

In addition to this ID field, other input fields and check boxes may also be displayed, depending on 

the object. 

Examples: 

 When you copy an item, one of the things that you can do is use the BOR and Prices check 
boxes (page 52) to specify whether the BOR and the prices for the original item are to be 

copied. 

 When copying a sales order, you can change or transfer the customer ID, the job ID, the 

requested date, etc. When copying from sales orders, purchase orders, and manufacturing 

orders, the status of the order is reset so that it corresponds with a newly entered order. 

 All entered data and selected options in the dialog box are transferred to the header record of 

the object. All fields can be changed at a later stage, except for the ID. 

Note for e-PROCUREMENT i tems:  If a Release procurement flag is set on the 

Communication tab, it is not transferred when you save.. 

When saving supplier RFQs, you can select the Close original RFQ check box. When you do this, 

the original supplier RFQ is saved again and then closed. 
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A hotkey, also called a shortcut, is generally understood to mean a combination of keys that you 

press simultaneously in order to run a function. Function keys (F1-F12) can also be used as 

shortcuts for running functions. 

In Infor COM, you have a number of these hotkeys and function keys at your disposal. 

Please note: In certain areas of Infor COM, the hotkeys and function keys listed below are 

assigned to different functions. 

Example:  In the SFDC module, the F8 function key is not used to change to a single record view, 

but to indicate the end of an operation. 

Hotkeys and function keys 
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Key combination Explanation 

Alt +  Undo 

Alt +  Expands a combo box (see "Combo boxes" page 53) 

Alt + F4 Closes the object that is currently open 

Alt + Tab Switches the application 

Alt + Shift + Tab Switches the application (back) 

F1 Opens the context-sensitive Infor COM Online Help 

Ctrl + F1 Opens the main table of contents in the Infor COM Online 

Help 

F9 Opens the Field info (see "Options menu" page 42) 

F10 Switches to the menu bar 

F11 Prints the current Infor COM screen content 

F12 Starts the LJ4 Debugger 

Shift + Insert Inserts 

Shift + F8 Selects files (beginning and end of selection) 

Shift + F10 Opens the shortcut menu for the current field 

Shift + F11 Opens User privileges administration 

Shift + F12 Starts the DL Debugger 

Ctrl + C Copies 

Ctrl + D Deletes a table row 

Ctrl + E Inserts a table row. 

Ctrl + G Opens the Quick search (see "Use quick search" 

page 71) 

Ctrl + H Opens the Memo (see "Using the memo" page 71) 

Ctrl + Insert Copies 

Shift + Delete Cuts 

Ctrl + F4 Closes the current window 

Ctrl + S Saves 

Ctrl + V Pastes 

Ctrl + W Shows or hides the navigation bar 

Ctrl + X Cuts 

Ctrl + Esc Opens the Windows Start  menu 
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Key combination Explanation 

Shift + Ctrl + W Shows or hides the start form (page 34) 

 

Shortcuts used in navigation 

Key combination Explanation 

Ctrl + N Displays the New tab on the start form 

Ctrl + O Displays the Open tab on the start form 

Ctrl + F6 Switches between windows within one application 

Ctrl + Shift + Tab Switches between windows within one application (back) 

Ctrl + Shift + Down 

Arrow key 

Switches to required tab 

Ctrl + Q Displays the Modules view of the navigation bar 
(page 33) 

Ctrl + Y Displays the My objects view of the navigation bar 

Ctrl + Tab Switches between windows within one application 

Ctrl + Shift + N Switches to the next tab 

Ctrl + Shift + B Switches to the previous tab 

Ctrl + Shift + S Opens the Change tab dialog box. You can use the 

arrow keys to select the required tab and then open it by 

pressing Enter. 

 

Function keys for selecting windows 

For large objects: 

F5 Overview 

F6 Object 

F7 Header record 

F8 Line 
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For small objects: 

F5 Overview 

F8 Single record 
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To get more information about how an error occurred and how it can be resolved, enter the ID for 

the error message displayed in Infor COM on the Index or Find tabs 

 

Transactions 
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Description and use of process recording 

The Record process function lets you record complete processes in Infor COM and save them to a 

video file. 

Use this function when you have questions regarding Infor COM and need detailed process 

documentation for Infor Xtreme Support. 

Record the process in a video file rather than noting down each of your actions in a process in 

writing. This recording includes not just your actions, but all system messages. 

Send the video file to Infor Xtreme Support. The simplest and most convenient means of transfer 

is electronic data transmission (e-mail). 

Note: Please include a brief explanation of what happened with your recording. 

By playing your recording, Infor Xtreme Support can follow the process, determine the cause of 

the problem, and work out a solution. 

 

 

Process recording 
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Performance tips for process recording 

Recording processes (see "Description and use of process recording" page 81) in Infor COM 

requires additional system resources. To minimize losses in performance while working with Infor 

COM and recording processes at the same time, follow the recommendations in the Help topics 

listed below. 
 

Capacity limits during process recording 

Your computer's system performance and the current utilization of resources by running 

processes set certain limits for the process recording function. 

Example: 

You are working on a simple client (workstation) with only one hard disk. To work simultaneously 

with Infor COM and the IDM (Infor COM Dialog Manager), you start the database and the table 

server on the client. You then make an adjustment in an application, which usually results in a 

compilation (= parsing) of adjustment(s). 

The processor is already utilizing its resources for parsing and working with Infor COM. Other 

applications may require processing resources. In addition, some programs were loaded into the 

RAM and continually access the hard disk. 

Starting a process recording would launch another process and, depending on the f/s rate (see 

"Resolution and number of images per second and sound" page 84) chosen, multiple images per 

second would be saved to the hard disk. 

Conclusion: 

During process recording, try to keep the load on the processor, RAM, and hard disk to a 

minimum. 

Do not start processes unless these are the target of process recording. Run only those programs 

that you need in order to record processes. 
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For more information, see other performance tips (see "Performance tips for process recording" 

page 82).  
 

AVI file 

During a process recording (see "Description and use of process recording" page 81), several 

images per second - depending on the f/s rate (see "Resolution and number of images per second 

and sound" page 84) chosen - are taken and stored in a special AVI file on your hard disk (AVI: 

Audio Video Interleaved). AVI is a standard format that can easily be edited. A video file can 

rapidly become very big due to the amount of image information. 

As a result, you should make sure that you do not record more any actions than are necessary. 

 Record the process in follow me mode (see "Recording types during process recording" page 

87), but pause the recording (press CTRL+SHIFT+F3 = Pause) while you are performing 

actions that do not need to be recorded. You can then continue recording (press 

CTRL+SHIFT+F3 = Resume). 

 In single image mode (see "Recording types during process recording" page 87) you only take 

shots of relevant screen sections. 

File size should be kept low with a view to sending your recording using electronic data 

transmission. In addition to the automatic compression of image information (see "Video 

compressors" page 85), you should also compress (see "Compress process recordings" page 98) 

the video file prior to transmitting it. 

Ensure that your recording is informative. Infor Xtreme Support should be able to follow the 

process. Check first yourself that your recording properly reflects the issue (see Play back a 

process recording (page 96)). 

Note: We recommend that you include a brief written explanation. 
 

Compile repository (parsing) 

You cannot record a process while the repository is being compiled. Ensure that the repository is 

compiled prior to recording because of potential capacity limits during process recording (page 

82). 
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Resolution and number of images per second and sound 

The resolution, rate in frames (images) per second (f/s), and audio recording during a process 

recording (see "Description and use of process recording" page 81) directly influence the size of 

the video file (see "AVI file" page 83) and the recording speed. 

You can select a higher f/s rate with fast computers and small screen sections. The more frames 

per second you record, the bigger the video file. At the same time, recording and playback 

decrease in speed. 

You can set the f/s rate in the Frames section of the Record process start dialog box. 

You can use smaller screen sections if you move the recording range manually like in Process 

recording using single image recording (page 87). 
 

Color resolution 

The number of colors set is also important for the performance of process recordings (see 

"Description and use of process recording" page 81). It indirectly influences the size of the video 

file (see "AVI file" page 83) and the recording speed. 

A PC can work at various color depths and resolutions. Check the display mode of your 

workstation. 

For more information on this, look up screen resolution in the Online Help of your Windows 

version. 

Many of today's PCs work in high-color mode with 16 bits per pixel and can display 65,536 colors 

or more. 

When you record in high-color mode, a multitude of image information must be read from the 

graphics memory, compressed, and written to the AVI file. This requires a lot of time, processor 

performance, and free memory space on your hard disk. 
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In most cases, an 8-bit display mode in 256 colors is sufficient for recording a program. The 

program optimizes the color range of your display to ensure minimum loss of quality. In 8-bit 

mode, the volume of information to be read and compressed is two, three, or even four times 

smaller than in other display modes. The recordings can therefore be compressed faster, and they 

generate AVI files that are significantly smaller. 
 

Hard drives 

Video files (see "AVI file" page 83) are generated during process recording (see "Description and 

use of process recording" page 81). If possible, do not save your AVI file on the same hard drive 

as your database because this disk is accessed frequently, and performance is reduced as a 

result. 
 

Network drives 

Always store the video files (see "AVI file" page 83) generated during process recording (see 

"Description and use of process recording" page 81) on your local workstation and not on a 

network drive. Data transmission over the network is considerably slower than from a local hard 

drive. 
 

Compressed directories 

Make sure that the AVI files (see "AVI file" page 83) generated during process recording (see 

"Description and use of process recording" page 81) are not stored in compressed directories. 
 

Video compressors 

The image information obtained in a process recording (see "Description and use of process 

recording" page 81) is stored in an AVI file (page 83). 
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To reduce the size of such video files, video compressors compress the image information while 

saving it. This facilitates faster recording and playback. 

Note: This type of compression should not be confused with file compression using compression 

or archiving programs. Video and audio compressors compress information before saving it to a 

file. 

Video compressors are part of the standard Windows components. The drivers for video and 

audio compressors are usually set up when you install Media playback. 

To determine if and which video compressing codecs are installed on your computer, check the 

Online Help of your Windows system. Search for keywords such as video, codecs, or multimedia. 
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Recording types during process recording 

There are two recording types for recording actions and processes (see "Description and use of 

process recording" page 81) in Infor COM: 

Single image recording 

This method uses Pause mode to move the recording range to the screen area to be shot. Then a 

single screenshot is taken, and the image is saved to a video file. You may need to reposition the 

recording range for the next image. 

Follow me mode 

Unlike single image recording, in Infor COM you can record your actions in an uninterrupted 

sequence. It is like shooting a picture of your actions. Follow me means that the recording range 

automatically follows each movement of your mouse pointer. You can perform actions such as 

data entry, function calls, and navigation as usual. 

This mode has the additional benefit that the size of the resulting video file can be kept relatively 

small. You can also include a larger screen area in your recording. For example, you can move a 

section with 800x600 pixels over a screen resolution of 1280x1024 pixels. 

Note: 

 Do not perform more than one action per second with the mouse. 

 The result of this recording method may look confusing to a viewer. Take a look at it yourself 

(see Play back a process recording (page 96)). You may need to practice the recording 

technique. 

Consider potential capacity limits during process recording (page 82). 
 

Process recording using single image recording 

You clicked OK in the start dialog box and started process recording. A flashing rectangle on your 

screen represents the current recording range. The flashing indicates that the recording is running. 

Procedure: 
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Note: To cancel a process recording at any time, press CTRL+SHIFT+F2. 

1. Press CTRL+SHIFT+F3 (Pause/Resume) to pause the recording. The highlighted area is 

crossed by two diagonals to indicate that the recording is paused. 

2. We recommend that you position the mouse pointer in the middle of the rectangle. In this 

position, the pointer and any activities you perform with it are always in the center of the 

recording range. 

3. Press the CTRL and SHIFT keys and hold them down. 

4. Move the pointer to the required position on your screen. You do not have to press a mouse 

key. The recording range that is still crossed out follows the movements of your pointer as long 

as you hold down CTRL and SHIFT together. 

5. Release the two keys when the recording range is positioned on the required screen area. 

6. Now press CTRL+SHIFT+F4 to take a screenshot of this area. The image is stored in the 

video file (see "AVI file" page 83). The function remains in Pause mode. 

7. If you want to take more single images, repeat the steps described starting from step 2. 

8. If you have finished taking screenshots, press CTRL+SHIFT+F2 to end the function. 
 

Process recording in Follow me mode 

You clicked the OK button in the start dialog box and started process recording. A flashing 

rectangle on your screen represents the current recording range. The flashing indicates that the 

recording is running. 

Procedure: 

Note: To cancel a process recording at any time, press CTRL+SHIFT+F2. 

1. Position the cursor in the middle of the rectangle. This way, it will always capture the center of 

the recording range. 

2. Press the Ctrl and Shift keys and hold them down. This allows the recording range to track the 

mouse pointer movements. 

3. Now perform the Infor COM process that you want to document. The recording range tracks all 

mouse pointer movements as long as you hold down CTRL+SHIFT. 
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 If the recording range can capture all actions in its current position, you do not need to hold 

the two keys down. Press them again if you need to drag the mouse pointer beyond the 

limits of the recording range for an action. Remember that the mouse pointer should be in 

the center of the recording range. 

 Press CTRL+SHIFT+F3 (Pause/Resume) to pause the recording at any time. The 

recording range is crossed by two diagonals to indicate that the recording has been 

paused. It may be useful to pause a recording if some actions in the process are not 

relevant for solving the problem. Press CTRL+SHIFT+F3 once again if you want to 

resume the recording. 

4. If you have recorded your process, press CTRL+SHIFT+F2 to stop the recording. 
 

Default settings for Record process 

You can start process recordings (see "Description and use of process recording" page 81) 

directly in Infor COM. The running program is HyperCam™. You can define settings for frames, 

resolution, and audio recording in the Infor COM start dialog box prior to starting. These are 

transferred directly to HyperCam™. Because you can call, start, perform, and end a recording 

directly in Infor COM, you will not usually have to deal with HyperCam™. 

The only situation in which you must explicitly start the recording program and define the 

above-mentioned settings in the HyperCam™ dialog boxes is when you want to record a process 

and Infor COM has not been started (see Open process recording with HyperCam (page 95)). 

The examples below demonstrate how the settings entered in the start dialog box are transferred 

to HyperCam™, focusing on relevant fields only. 

Example 2 shows the default parameter settings of Infor COM. 

Example 1 

Settings in start dialog box for process recording: 

File name: clip.avi (example) 

Record sound: no 

Frames: 1 frame per second 

Resolution: 800 x 600 

These settings are transferred to HyperCam: 
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AVI file tab 

AVI file name: clip.avi 

Record audio:  

Rate in frames per second, record: 1 

Playback: 1 

 

Section tab 

Start X 3 

Start Y 3 

Width 794 

Height 594 

 

Example 2 

Settings in start dialog box for process recording: 

File name: clip.avi (example) 

Record sound: no 

Frames: 2 frames per second 

Resolution: 800 x 600 

These settings are transferred to HyperCam™: 

AVI file tab 

AVI file name: clip.avi 

Record audio:  

Rate in frames per second, record: 2 

Playback: 2 
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Section tab 

Start X 3 

Start Y 3 

Width 794 

Height 594 

 

Example 3 

Settings in the start dialog box: 

File name clip.avi (example) 

Record sound no 

Frames 2 frames per second 

Resolution: 1024 x 768 

These settings are transferred to HyperCam™: 

AVI file tab 

AVI file name: clip.avi 

Record audio:  

Rate in frames per second, record: 2 

Playback: 2 

 

Section tab 

Start X 3 

Start Y 3 

Width 1018 

Height 762 
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Example 4 

Settings in the start dialog box: 

File name: clip.avi (example) 

Record sound: no 

Frames: 3 frames per second 

Resolution: 1280 x 1024 

These settings are transferred to HyperCam: 

AVI file tab 

AVI file name: clip.avi 

Record audio:  

Rate in frames per second, record: 3 

Playback: 3 

 

Section tab 

Start X 3 

Start Y 3 

Width 1274 

Height 1018 

For more detailed information on the possible settings, see the Online Help for HyperCam. This is 

located in the Help directory of your Infor COM system under the file name WinCorder.hlp. 
 

Coordinate recording parameters with client 

For best results in process recording, adjust the required parameters to the performance of the 

Infor COM client (workstation) on which you want to record Infor COM processes. 
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You can define the settings in the Record process start dialog box. Once you have found the 

optimum settings for the client it is useful, and recommended, to use these settings for all other 

process recordings on this client. 

The start dialog box contains the Use last recorder setting option for this purpose. If this option is 

selected, all other options are dimmed to prevent accidental changes. 

The term Recorder refers to HyperCam™. HyperCam™ is the recording program that records in 

the background. It uses the settings that were defined in the start dialog box as being most 

optimum for the client. To apply the start dialog settings to HyperCam™ and make them the 

default settings for future recordings, you need to perform the following action on the client before 

carrying out the first recording: 

1. Open the start dialog box of the process recording function if you have not already done so. 

 From the Infor COM desktop, select Options and Record process. 

  If you are already in a start interface, click this button in the toolbar or select the 

command from the Tools menu. 

2. Ensure that the Use last recorder setting option is not selected. 

3. Enter the optimum settings for your computer. 

Note the performance tips (see "Performance tips for process recording" page 82). 

4. Click OK to start the recording function. This closes the dialog box. 

5. When you see a flashing rectangle on your screen, press CTRL+SHIFT+F2 to stop the 

recording function. 

6. Open the start dialog box again (see step 1). 

The optimum settings have now been copied to HyperCam™ and stored there. For more 

information on this transfer, see the Default settings for Record process (page 89) Help topic. 

Select the Use last recorder setting option to save these settings in the start dialog box as well. For 

future process recordings, all you have to do to start the recording function is to click the OK button 

in the start dialog box. 

Default settings: 

If you deselect the Use last recorder setting option, these settings are reset to the default: 

 Record sound = deselected 
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 Frames = 1 or 2 frames per second. 

This depends on the color depth (8 or 16 bits): 

2 frames/sec.:  256 colors 

1 frame/sec.: > 256 colors 

 Resolution = 800 x 600 
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Open process recording 

There are several ways to start the Process recording (see "Description and use of process 

recording" page 81) function. 
 

Open process recording from the desktop 

To open the start dialog box for process recording on the Infor COM desktop: 

Select Options and Record process. This opens the Record process start dialog box. 
 

Open process recording in an application 

You can start the process recording (see "Description and use of process recording" page 81) 

function from within an Infor COM application: 

 Click the button with this icon or select Tools > Record process. In both cases, the Compress 

process start dialog box opens. 
 

Open process recording with HyperCam 

You can open the HyperCam™ program for process recording (see "Description and use of 

process recording" page 81) without having to open Infor COM. This is necessary if you want to 

record specific behavior during the Infor COM login process or start process and send it on to Infor 

Xtreme Support. 

Procedure: 

In the Infor COM directory, double-click the WinCorder.exe file. This launches HyperCam™: 
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Section tab 

Start X 3 

Start Y 3 

Width 794 

Height 594 

You can define far more settings in HyperCam™ for your process recordings than you could when 

opening this function from the Infor COM desktop or from an application (see Open process 

recording from the desktop (page 95) and Open process recording in an application (page 95)). 

For more detailed information on the possible settings, see the Online Help for HyperCam. This is 

located in the Help directory of your Infor COM system under the file name WinCorder.hlp. 

Default settings for Record process (page 89) describes the default settings recommended for the 

rate in frames per second when you open process recording independently of Infor COM. 

If you have defined all the settings, click the Start Rec. button to start recording. 
 

Play back a process recording 

Processes (see "Description and use of process recording" page 81) that were recorded and 

stored in an AVI (see "AVI file" page 83) file can easily be played back. All you need is a playback 

program that supports AVI format, such as Windows Media Player. If the required program is 

installed, you have two options for opening the recording file. 

Option 1 

Use the find and open files functionality of the playback program to go to the directory in which the 

video file is stored. You can find the detailed steps in the Online Help of the program that you are 

using. 

Remember: You defined file names and selected the directory in the start dialog box of the 

process recording. 

Option 2 
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Use a file manager such as Windows Explorer to go directly to the directory of the relevant file. 

Double-click the file, and it will open with its application if the AVI file type is linked to this 

application. 

For information on how to assign a file type to a program, see the relevant topic in your Windows 

Help. You can search for it using the keyword file type. 

Playing back the recording 

Programs normally use standardized icons for playback. For details, see the Online Help of your 

player. 

 Play recordings. 

 Pause recordings. 

 Stop recordings. 
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Compress process recordings 

A process recording (see "Description and use of process recording" page 81) is stored in a 

special video file (see "AVI file" page 83). Because such a recording may produce a large quantity 

of data, the associated video file can be very big. 

Any big files should be compressed before being sent to Infor Xtreme Support via electronic data 

transfer. 

You can open data compression in Infor COM. 
 

Open compression of process recordings from the desktop 

To start the Compress process recordings (page 98) function from the Infor COM desktop: 

Select Options and Compress process. This opens the Compress process start dialog box. 
 

Open compression of process recordings in an application 

There are two ways of opening the Compress process recordings (page 98) function from an Infor 

COM application: 

 Click the Compress process button in the toolbar or select Tools and Compress process from 

the menu. 

In both cases, the Compress process start dialog box opens. 
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Create authorization models 

To create an authorization model, you first have to create an authentication model with user 

groups, users, and login modules in the Infor COM Management Console (IMC). For more 

information, see the Help topic on Management Console. 

You can map your company template in Infor COM when assigning access privileges to objects 

(including menus, dialog boxes, allocation tables, applications). 

You can access objects using roles. Roles group access privileges and access restrictions to 

related objects under a self-explanatory name. Different roles can then be grouped into roles with 

subroles. 

In Infor COM, roles are assigned to user groups, not individual users. 

Please note: You must select unique role names as usage privileges are assigned by role. 

Company template   Role template   Appl ication template  

Contains all user groups and 

users 

User groups may be created 

as required 

User groups are edited in 

Infor COM Management 

Console 

Language and desktop 

preferences are assigned in 

Infor COM 

 Contains objects (including 

menus, dialog boxes, 

allocation tables, applications, 

etc.), which can or cannot be 

accessed 

Roles may be created as you 

like 

Roles are created in Infor COM 

by selecting Options > Role 

administration on the start 

interface. 

 Contains all Infor COM objects 

(including menus, dialog boxes, 

allocation tables, applications, 

etc.) 

There is a list of default modules 

and forms 

 

 

The authorization model permissions are determined in the following steps: 
 

User administration 
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Define permissions in User administration 

Final access privileges (no access, read-access, full access) for each user to objects (including 

menus, dialog boxes, allocation tables, applications) are a compilation of individual access 

privileges assigned on several levels: 

 Default permission (page 100) 

 Role permission (page 101) 

 Role-based access privileges for objects (page 101) 

 Role combinations (page 101) 

 User group association (page 103) 
 

Default permission 

The configuration file determines the system's general access mode using the 

COMMON.AUTHENTICATION.DEFAULTPERMISSION parameter. If the user has not been 

assigned a role, the user has either full access or no access to the system.  

Additional role permission can either limit default permission (role intersection) or extend it (role 

union). 

Default permission is set in the COMMON.AUTHENTICATION.DEFAULTPERMISSION 

parameter of the configuration. 

It provides the basis for the role model to be developed. 

 Ful l  access: 

The whole system is completely available to all users who have been successfully 

authenticated. There are no restrictions on use. 

Use roles to limit access rights. 

 No access: 

The whole system is completely locked for all users who have been successfully 

authenticated. Before you start Infor COM, the desktop is empty and contains no functions. No 

applications can be selected when opening via Infor COM Start. 

The system is only accessible through roles. 
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Role permission 

Every role describes a complete set of access privileges for all objects in the system. For this 

purpose, roles are assigned standard access privileges for all objects not explicitly mentioned in a 

role, analogous to global preset access. If the default privileges are set to No access, objects can, 

for example, be explicitly set to Full access for the role. 

If the default privileges of the role are set to Full access, objects can, for example, be explicitly 

flagged with Read-access or No access. 

Role permissions are assigned in the Role administration dialog box. 
 

Role-based access privileges for objects 

Assigning access privileges for objects (including menus, dialog boxes, allocation tables, 

applications, etc.) allows you to control which applications can be started with a role and which 

objects can be accessed after starting Infor COM. 
 

Role combination 

The final access privileges are determined on the basis of preset privileges assigned by the 

combination of role permissions. 

Starting from default permission, two roles can be combined into one role with a higher status in 

three different ways: 

If a user group is assigned more than one role, the following applies: 
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Role union If more than one role has been created for a user group, the 

users have maximum access rights for the roles of the user 

group. 

Role intersection If more than one role has been created for a user group, the 

users have minimum access rights for the roles of the user 

group. 

Role identity If more than one role has been created for a user group, 

privileges are added together (role union) and then restrictions 

are subtracted (role intersection). 

Interaction between role combination and role intersection : 

A role combination  at user group level (user group was assigned more than one role) and at 

role level (role contains more than one subrole) first adds all of the rights of roles assigned by role 

union and then subtracts restrictions of roles assigned by role intersection . 

Examples of interaction between default  permission and role permission : 

Role permission is permission created through roles. 

For more information about creating roles, see Create roles (see "Create roles manually" page 

104). 

Example 1: 

Default permission: Full access 

Role permission: Role union 

Role permission is irrelevant when default permission is set to Full access, because the user 

already has access rights to the entire system. 

Example 2: 

Default permission: Full access 

Permission by role: Role intersection 

When default permission is set to Full access, role intersection limits access rights to privileges 

assigned in role permission. 

Example 3: 
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Default permission: No access 

Permission by role: Role union 

When default permission is set to No access, role union grants access rights assigned in role 

permission. 

Example 4: 

Default permission: No access 

Permission by role: Role intersection 

Role permission with role intersection is irrelevant when default permission is set to No access, 

because the user continues to have no access to the system. 

Note: A user group can be assigned more than one role and this means that role permission may 

have other effects. 
 

User group association 

A user can be assigned to more than one user group. The user's access privileges result from the 

role combinations of all of the user groups with which the user is associated.  

Note: Privileges can only be assigned to user groups, not to an individual user. 
 

Assign language and desktop preferences 

In addition to system access privileges, language and desktop preferences are assigned by 

selecting Options > User group settings. Preferences are set for user groups, not individual users. 
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Create, customize, and assign roles. 

You have the following options for working with roles in Infor COM. 
 

Create roles manually 

A default privilege for access to Infor COM application objects and other applications is defined for 

each role and the role combination is set between the default privilege that was assigned in the 

Management Console, and the role permission. Depending on the default setting, you can assign 

objects to the role to extend or restrict access. 

Note: The following example defines restrictions on the underlying NGDesk default desktop by 

hiding the TIME master data object for the Sales group. 

 

To create roles, complete the following steps: 

1. Log on to Infor COM with a user account that has administrator rights. 

Note:  If both the Infor COM login and Windows login are used, click Ignore to skip the first 

login dialog box and go to the second one. 

 If Infor COM is not yet started, start Infor COM and enter an administrator user name and 

password in the login dialog box that opens. 

 If Infor COM is already open or was started without a login dialog box, select Log off and 

log on under a new name from the Options menu. 

Log on as the administrator. 

Note: The Options menu is only available on the start interface. 

2. In the Options menu on the start interface, select User group settings. 

3. In the dialog box that opens in the left side of the tree structure, select the user group that you 

want to assign a role to. 

Example: Sales 

The upper right side displays the preferences for this user group. 

The assigned roles are displayed in table format in the lower half of the screen. 

4. To create a new role, right-click in the lower area and in the shortcut menu, select Create new 

role. 
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5. Enter a unique name for the role. 

Example: No TIME master data 

The processed user group is marked with an asterisk to indicate that changes have been 

made but not yet saved. The changes are not active in the system yet. 

6. Right-click the role in the lower right window and select the role combination: role union, role 

intersection or role identity. 

 Example: role intersection. 

Role combination Description 

Role union If more than one role has been created for a user group, the users have 

maximum access rights for the roles of the user group. 

Role intersection If more than one role has been created for a user group, the users have minimum 

access rights for the roles of the user group. 

Role identity If more than one role has been created for a user group, privileges are added 

together (role union) and then restrictions are subtracted (role intersection). 

7. Define the role privilege, which regulates the access user groups that are assigned this role 

have. 

 Right-click the role name you just created in the User group settings dialog box and select 

Edit in the shortcut menu. 

 Enter a description in the Role administration dialog box header and define the default 

privileges. 

Example: Full access 

Note: If the default setting for the default privileges is set to No access, the users of the 

relevant groups cannot access the system. The Full access privilege and the Role 

intersection setting results in access privilege on the basis of role privilege. 

8. To assign object access privileges to a role, right-click the Protected object field in the Role 

administration dialog box and select Add from the shortcut menu. 

9. The Add object to be protected dialog box opens. From the object tree, select the object you 

want to add and click OK. 

Example: Dialog boxes\Infor COM[NGDesk]\Manufacturing[folProduction]\TIME master 

data[folODCMaster] 

The default setting for the object is the default privileges of the role. 
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10. To change the access privilege, select the object in the lower right area and select the 

corresponding command in the shortcut menu. 

Example: No access 

11. Right-click on the role names, select Save in the shortcut menu and close the Role 

administration dialog box. 

12. Right-click the Sales user group in the Save shortcut menu and close the User group settings 

dialog box. 

13. On the Infor COM start interface, open the Options menu and select Log off and log on under a 

new name. 

Log on with a user account from the user group. 

Use the login module set for this user to log on. Click Ignore to go to the login module. 

14. Check whether the business objects and functions are shown or hidden as defined in the 

permission. Make sure no unintended access privileges are assigned or denied. 

15. To edit privileges, create and combine additional role privileges and assign user groups. You 

can also customize existing role privileges using additional role-based object access 

privileges. 

You can also use the following procedure to create roles: Create roles based on business 

processes (page 106). 
 

Create roles based on business processes 

Use this procedure to navigate through Infor COM throughout the business process and create or 

analyze associated roles for the respective form objects. 

Requirements: 

 An authentication model with user groups and users and an authentication method (login 

module) must be registered in Infor COM Management Console (IMC). 

 Roles are set based on the preset privilege in Management Console or in the configuration file. 

If the system is open in the default setting, only read-access is possible or the system is 

completely blocked. 

See Define permissions in User administration (page 100). 
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1. Log on to Infor COM with a user account that has administrator rights. 

Note:  

If both the Infor COM login and Windows login are used, click Ignore to skip the first login 

dialog box and go to the second one. 

 If Infor COM is not yet started, start Infor COM and enter an administrator user name and 

password in the login dialog box that opens. 

 If Infor COM is already open or was started without a login dialog box, select Log off and 

log on under a new name from the Options menu. 

Log on as the administrator. 

Note: The Options menu is only available on the start interface. 

2. In the Options menu, select Role administration. 

3. Right-click the left half of the dialog box that opens and select the Create new entry shortcut 

menu. 

4. Enter a unique name for the role and complete your entry. 

5. In the upper right part of the dialog box, select Default privileges, which are the basic role 

privileges for all user groups that are assigned this role. 

6. In the Description field, enter a brief description of the role. 

7. Right-click the current role name on the left side and select Save from the shortcut menu. 

 Leave the dialog box open. 

8. On the Infor COM start interface, open the Options menu and select User administration. 

Leave the dialog box open during the following steps. 

Note: The Role administration and User privileges administration dialog boxes must be 

left open because the Options menu with the user administration commands is only 

available on the start interface. 

In the following step, a business object is opened, and the Role administration and User 

privileges administration dialog boxes can no longer be opened. 

Automatic synchronization only works in the User privileges administration dialog box if the 

dialog box was opened before the business object is opened. 

9. Starting from the default privilege that was defined, select the business objects you want to 

use to extend (No access, Read-access by default) or restrict (Full access, Read-access by 

default) privileges. 

10. On the Infor COM start interface, open the object that you want to add to the role. 

Example:  Select Purchasing > Master data > Suppliers. 
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11. If, for example, you want to change the privilege for a certain tab and not for the entire object, 

select a data record on the start form and click Load. 

In the required view, position the cursor on the required tab. 

12. Go to the User privileges administration dialog box. 

Automatic synchronization selects the object currently open in the left window of the dialog 

box. 

Right-click the lower right window and in the shortcut menu select Add. 

13. In the Add role dialog box, select the role you just created and click OK. 

14. In the User privileges administration dialog box, select the role in the lower right window and in 

the shortcut menu, select the required privilege: No access, Read-access, or Full access. 

Once the role is added, it has the default permission you defined earlier in the Role 

administration dialog box. 

15. Right-click the role or the object in the left window and select Save from the shortcut menu. 

Note:  When you go to the Role administration dialog box, the lower right area contains the 

object with the defined privilege entered. 

You can change from the User privileges administration dialog box to the Role administration 

dialog box by double-clicking the role. 
 

Customize roles 

The User privileges administration dialog box in the Options menu allows you to assign roles to 

objects (such as menus, dialog boxes, allocation tables, applications). 

This dialog box is useful for navigating through Infor COM throughout the business process and 

for analyzing roles associated with the different form objects. 

This provides an overview of all roles and access rules for a particular object. 

If the dialog box is open and you navigate to a particular form in Infor COM, the dialog box is 

simultaneously updated and the relevant object is displayed. 

You must create roles before you can assign them to an object. To create new roles, open the 

Options menu and select Role administration. 

You can leave the User privileges administration dialog box open. 
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In addition to assigning access privileges to particular objects, you can also use rights to define an 

administrator role and a developer role: 

 Administrator role:  

Users can only open authorization maintenance if they belong to a user group that was 

assigned a role with the correct privilege. 

 Developer role:  

Users can only open developer tools such as Infor COM Dialog Manager (IDM) if they belong 

to a user group that was assigned a role with the correct privileges. 
 

Assign roles to user groups 

The User group settings dialog box in the Options menu allows you to assign role, desktop, and 

language settings to user groups. 

User groups are created according to the company template in Infor COM Management Console. 

Settings can be inherited. If you do not make any settings for a subgroup, the settings of the parent 

group apply. 

You can assign role union, role intersection, and role identity to combine roles. 

Note: In the dialog box you can create a role and then double-click the name to edit it. 
 

Create role hierarchies 

Role hierarchies are created using the Copy command. The copied role is not a true copy. All 

changes made to one instance of a copied role affect all instances of the role. After a change is 

made to one instance, all instances are flagged as changed and not yet saved. 

To create role hierarchies, complete the following steps: 

1. Log on to Infor COM with a user account that has administrator rights.  

Note: If both the Infor COM login and Windows login are used, click Ignore to skip the first login 

dialog box and go to the second one. 

 If Infor COM is not yet started, start Infor COM and enter an administrator user name and 

password in the login dialog box that opens. 
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 If Infor COM is already open or was started without a login dialog box, select the Log off 

and log on under a new name command in the Options menu. 

 Log on as the administrator. 

Note: The Options menu is only available on the start interface. 

2. Select Options > Role administration. 

3. Right-click in the left half of the dialog box and select Create new role from the shortcut menu. 

4. A new entry is created. Enter a unique name for the role. 

Press Enter to complete the entry. 

5. In the upper right part of the dialog box, select Default privileges, which are the basic role 

privileges for all user groups that are assigned this role. 

6. In the Description field, enter a brief description of the role. 

7. On the left side, select the current role name, and in the shortcut menu, select Save. 

8. Create additional roles using steps 3 through 6. 

9. Assign a role to another role. 

 In the left window, select the role you want to assign to another role and select Copy from 

the shortcut menu. 

 In the left window, select the role you want the role to be added to and select Add from the 

shortcut menu. 

10. In the shortcut menu, select Save to save the changes. 
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Note: See also Configuration (Sales). 

The Sales component contains all the functions required for order processing, from the quote to 

invoice creation with integrated document flows. The sales processes are closely linked to 

planning processes, materials management processes, and warehouse management processes. 

In addition, material availability, delivery date calculation, and variant generation play an important 

part in Sales. 

The Sales Help includes information on order processing (page 207) and master data (see 

"Master data (Sales)" page 354) in Sales, as well as on the batch processes (page 387) and 

archiving processes (see "Archive sales orders" page 402) available in Sales. 

 

Sales basics 
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Order processing basics 

Open the Order processing folder in Sales to create and edit sales documents. 
 

Create document 

For information on documents in Sales (see "Order processing basics" page 113), see the 

corresponding Help topic. 

To create documents in Sales, complete the following steps. 

1. Open the sales order for which you want to create the document. 

2. Select Functions and Create document. 

3. In the Document section, select the document you want to create. 

Depending on the setting of the COMMON.LEITSTAND.FREMDFERTIGUNGVORSCHLAG 

parameter or the current order status, you may not be able to select some of the options. 

When you select a document, additional options for the document are provided in the lower 

section of the form. 

4. Click Edit if you only want to include partial quantities of an order. You can then modify the 

quantities of the individual order lines before printing the document. 

Note: The order status generally changes after you print the document. 
 

Edit document 

For information on documents in Sales (see "Order processing basics" page 113), see the 

corresponding Help topic. 

Documents that have already been printed can be edited afterwards if changes need to be made. 

Please note that the processing status of the sales order determines whether or not changes are 

permitted. 

1. Open the sales order that is the basis for creating the document. 

2. To edit a printed document, select Functions and Edit document. 
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3. In the Doc. section, select the document type that you want to edit. 

Note: Document types that have not yet been created cannot be selected. 

4. Click the Edit button to access the document. 

Please note: It is not possible to edit an order confirmation. 
 

Create reports for consolidated documents 

For information on documents in Sales (see "Order processing basics" page 113), see the 

corresponding Help topic. 

If you do not want to use the standard documents configured by default in the system, you can 

create your own reports. 

Contact your consultant if you want to do this. 

To create reports for consolidated sales documents, proceed as follows: 

1. Check how the COMMON.VERTRIEB.SAMMELBELEGSUFFIX parameter for consolidated 

documents is set in the configuration. 

2. Create a report for the individual document, for example an advance shipping notice. The 

name of the report can contain no more than 11 characters less the suffix length. For the suffix 

S, the maximum permitted length would therefore be 10 characters. 

Please note: If you want to use a standard report for the individual document, this is 

automatically used for the consolidated document. In this case, it doesn't make any sense to 

create a consolidated document. 

3. Create a report for the corresponding consolidated document (for a consolidated ASN, for 

example). When naming consolidated documents, make sure you read Define report for 

consolidated advance shipping notice (ASN) (page 237). 
 

Print sales documents in batch 

For information on documents in Sales (see "Order processing basics" page 113), see the 

corresponding Help topic. 
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You can print sales documents from different orders in one action using a batch printout. Use the 

Batch processes folder in Sales for this. 

1. Select the required document type by clicking the corresponding object. 

2. In the batch printout dialog box, you can enter selection criteria for the document, or select 

these from the combo boxes. The following are some of the options available to you. 

 By entering a range for the order IDs, you can restrict the batch printout to specific order 

IDs. 

 You can select documents for specific customers by selecting a customer ID range or by 

selecting customer names in the Description field. 

 If you have entered the name of the customer in the field, you can restrict the customers 

alphabetically. 

 By entering the name of the editor (according to the logon in Infor COM), the documents 

corresponding to the editor's orders can be printed. 

 You can use Delivery week and the document-specific date field to make further 

restrictions to document printing. 

3. Confirm the criteria with OK to initiate the print order. To cancel the print process, click the 

Cancel button. 
 

Record types (Sales) 

Please note: Depending on the configuration of your system, not all record types may be 

available. Individual record types may only be available if certain components are licensed or 

through customizations. 

The record type indicates the type of data record of the row entered. The record types displayed 

below are important in Sales. 

 

The following record types cannot be selected in sales documents: 

Record type Label Description 

HR Header Header lines (HR lines) are used for quotes and sales orders. You cannot 

select HR lines - they are created by the system. For further information 

on HR lines in Sales, see View menu. 

DH Customer, Cust. DH lines are used in advance shipping notices and invoices. Otherwise, 

the same applies as for HR lines. DH lines are also created by the system. 

S Order release total The RT1 record contains information from the Outline agreement view 
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of the order release (see "Order releases" page 293). 

SI Set item This is the header record for set items. 

SM Service material This record type in the service order allows costs for materials used for the 

service to be to passed on to customers. The system generates these 

records by copying MA lines from the BOR. 

M2R Material to be 

repaired 

Material to be repaired forms the core component of repair orders. 

The following record types can be selected in sales documents: 

Record 

type 

Designation Description 

SV Service This record type indicates services with respect to the customer. 

CM Credit memo You can print credit memos (page 247) when you cancel invoices. 

Credit memo lines are indicated by this record type. 

EC Employees This is a record type in a field service order. This record type is used to 

display the employees required for an operation and to take them into 

consideration in planning in the GPP. 

RTM Returned material If you are using Service, this record type is used in Repairs receipt in 

inventory. 

CI Component item line This record type is available for component item lines (see 

"Component item lines in sales order" page 218). 

TL Tool This record type is used to enter tools. 

TX Text record This record type is used to enter texts. 

AC Additional cost This record type indicates additional costs. 

PP Payment plan This record type indicates lines of payment plans (page 365). 

ST, SE Subtotal, Subtotal end You can use these record types to enter subtotals (see "Generate 
subtotal" page 120) in orders. 

 
 

Statuses (Sales) 

The current status of an order indicates the extent to which is has been processed. See also the 

explanations for the Status field in the context-sensitive Help for the order header. 
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You can determine the printed documents and any inventory issue in the sales order header at a 

glance using the Status field and the gages. 

Example: A blue OC gage indicates a printed order confirmation. 

 

The Status type can be used to describe the status more accurately, that is, this classification is 

more detailed. Depending on the business processes triggered in Infor COM, three-digit numbers 

are set automatically by the program for more accurate differentiation in addition to the rough 

classification (single-digit number). These numbers can be found on the Other tab of the order. 

They are not displayed in the order header but can be used for internal selections. 

The status type of individual lines is displayed in the Order line view.  

The IDs are irrelevant for normal operation. However, they can be used for filtering and in Data 

maintenance, etc. You can edit the status types using the ZUSTDART allocation table by selecting 

System functions > Tables. 

 

The following statuses and status types are used: 



118 | Infor COM 7.5 User Guide 

 

Sales 

 

Status Segment Status type Meaning 

Quotes [1] 180 Quote A quote has been created. 

  181 Quote costed A quote has been costed. 

  182 Quote printed A quote has been printed. 

  185 Quote replaced A quote has been replaced. 

  188 Quote rejected A quote has been rejected. 

  189 Order An order has been created. The Order status 

only exists in the Quote document type if an 

order has been created from the quote. 

It is also created with the Create order from 

quote command in the Functions menu. 

Sales orders [2] 190 Sales order An order has been created. Unlike status type 

189, the Sales order status can be seen in 

the Sales order document type. 

  191 Order printed The order confirmation has been printed. 

  192 Order canceled The order confirmation has been canceled. 

  193 Partial order printed The order confirmation has been printed for 

part of the order. 

  194 Order release 

completed 

An order release has been completed as per 

outline agreement. 

Planning [3] 200 Order scheduled The (production) order has been scheduled. 

Advance shipping 

notices 

[4] 210 Advance shipping 

notice (ASN) 

An advance shipping notice has been created. 

  211 ASN printed The advance shipping notice has been printed, 

the line is released for inventory posting. 

  212 Partial ASN printed The advance shipping notice has been printed 

for part of the order. 

  213 ASN canceled An advance shipping notice has been 

canceled. 

  217 ASN prepared The advance shipping notice has been saved 

but not yet printed. 

  218 Partial ASN prepared Parts of an order have been saved as an 

advance shipping notice but not yet printed. 

  219 ASN not applicable The advance shipping notice is not applicable. 

See Services invoice. 

Inventory issue [5] 220 Issue A full issue has been entered. 
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Status Segment Status type Meaning 

  221 Partial issue A partial issue has been entered 

  222 Return The goods have been returned. 

  223 Unplanned issue An unplanned issue has been entered for the 

order. 

  224 Not issued  

  229 Issue not applicable Issue of the goods is not applicable. See 

Services invoice. 

  250 Processed This is the last status in the cycle Order -> 

Invoice -> Delivery + Issue 

  251 Partially processed Corresponds to status 250 for partial quantities 

Sales 

invoices 

[6] 230 Invoice  

  231 Invoice printed The invoice or credit memo has been printed. 

  232 Partial invoice printed The invoice has been printed for part of the 

order. 

  233 Invoice paid EDI/VDA functionality 

  236 Prepayment The invoice should be paid before delivery. 

  237 Partial prepayment The invoice should be paid in part before 

delivery. 

  239 Closed manually The order line has been closed manually. 

Sales 

credit memos 

 234 Invoice canceled The invoice has been canceled. 

  235 Credit memo printed A credit memo has been printed. 

  238 Credit memo canceled The credit memo has been canceled. 

Received 

credit memos 

 240 Received credit memo EDI/VDA functionality 

  241 Partial credit memo 

received 

EDI/VDA functionality 

  242 Internal invoice EDI/VDA functionality 

  243 Internal partial invoice EDI/VDA functionality 

  244 Credit memo 

outstanding 

 

  245 Credit memo canceled  
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Status Segment Status type Meaning 

  246 Closed manually  

 

 
 

Generate subtotal 

A subtotal determines the amount for any number of lines in an order. 

To generate a subtotal, complete the following steps: 

1. Select the required lines in the sales order by clicking on the line headers. 

2. Select Functions > Generate subtotal. 

The subtotal is output in the documents. 

Please note:  

 Subtotals are generally blocked for partial delivery 

 Subtotals cannot be nested (that is, a subtotal cannot contain other subtotals) 

 Subtotals cannot contain any additional costs 
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Sales tax calculation 

This topic describes how sales tax is calculated in Infor COM and which default settings (in the 

configuration and in the master data) are required for the calculation to work correctly. In addition, 

country-specific features relating to the calculation of sales tax are dealt with and information is 

provided on tax exemption in the United States and Canada. 

See also Configuration (Sales tax calculation). 
 

How is sales tax calculated for international trade? 

Click here (see "Sales tax calculation" page 121) for general information about sales tax 

calculation. 

This Help topic describes the specifics of sales tax calculation for POs from foreign countries and 

deliveries to foreign countries. 

The decision as to which sales tax rate applies can depend on the following factors: 

 The ship-to address (for sales orders) or the supplier address (for purchase orders) 

 The bill-to address 

 The sales tax ID: For customers, the sales tax ID is defined on the Company profile tab. For 

your own company, it is defined using the COMMON.ABSENDER.USTIDNR parameter in the 

configuration. 

 The terms of delivery 

 The Force flag on the Prices/discounts tab 

The following possible combinations can be derived from these factors. 

Note: All of the cases listed below - with the exception of the standard case and case 9 - apply 

exclusively for tax systems in the EU. 
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Standard case 

(Purchasing/Sales) 

The supplier address and the ship-to address are in the same country. This 

case involves a purchase or sale within the same country. The standard item 

taxes for this country are used. 

Case 1 (Purchase) The supplier address is in a different EU country, the tax ID of your own 

company refers to an EU country (default: Country of own company). 

Statutory rule: Acquisition tax must be charged at 0%. 

The sales tax rate that is applied is the one that has the usage flag 13. 

Case 2 (Purchase) The supplier address is in a different EU country, the sales tax ID of your own 

company is not specified, invalid or refers to a non-EU country. 

Statutory rule: The sales tax rates of the supplier country are applied. 

Case 3 (Purchase) The supplier address refers to a non-EU country. 

Statutory rule: The international acquisition tax of 0% is to be charged. The 

sales tax rate with usage flag 14 is applied. 

Case 4 (Sale) The ship-to address is in a different EU country, the sales tax ID of the 

customer refers to a valid EU country (Default: The customer's country). 

Statutory rule: This is an EU delivery with 0% sales tax. The sales tax rate 

with the usage flag 11 is applied. 

Case 5 (Sale) The ship-to address is in another EU country, the sales tax ID of the customer 

is not specified, invalid or refers to a non-EU country. 

Statutory rule: The item-specific sales tax rates of the supplier company's 

own country are used (as if it were a domestic delivery). 

Case 6 (Sale) The ship-to address is in a non-EU country, the bill-to address is in the 

company's own country, the terms of delivery are Ex works. 

Statutory rule: The item-specific sales tax rates of the company's own country 

are used (as if it were a domestic delivery). 

Case 7 (Sale) The ship-to address is in a non-EU country, the bill-to address is in the 

company's own country, the terms of delivery are not Ex works. 

Statutory rule: This is a third-country delivery with 0% sales tax. The sales tax 
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rate with usage flag 12 is used. 

Case 8 (Sale) The ship-to address is in a non-EU country, the bill-to address is not in the 

company's own country. 

Statutory rule: This is a third-country delivery with 0% sales tax. The sales tax 

rate with usage flag 12 is used. 

Case 9 (Sale) The customer has its registered offices in a foreign country (EU or non-EU 

country), the supplier has its registered offices in the same country as the 

customer. The supplier is instructed to send the goods directly to the 

customer, i.e. the goods do not leave the foreign country. 

In this case, the foreign item tax is charged. 

Please note: As Infor COM is unable to determine this case, the customer 

can select the Force check box in the Local tax section of the 

Prices/discounts tab of the order. When this check box is selected, the sales 

tax rate for the country of the supplier's address is always used. 
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How do I adjust the sales tax manually? 

In certain cases such as the following, Infor COM may not be able to calculate the sales tax 

correctly: 

 For purchase invoices, there may be differences in the amount if the supplier rounds sales tax 

amounts differently to Infor COM. 

 In connection with third-party delivery, there can be combinations whereby the tax types 

proposed by Infor COM are not correct. Due to the multitude of possible combinations, it is not 

possible to depict them all in Infor COM. 

In these cases, Infor COM allows you to manually change both the tax types and the calculated 

sales tax amounts in the documents in Purchasing and Sales. 

Please note: Manual changes to the sales tax rate or amount can have serious consequences 

for the sales tax calculation process. They are therefore are only permitted in very few exceptional 

cases. Only specialized employees can implement such changes. If in doubt, contact your Infor 

consultant. 

The adjustments can be made on the Sales tax tab of the line view of Purchasing and Sales 

documents (for example, purchase order, sales order, etc.) 

The following sections describe how you can change the tax type and/or sales tax amount: 

Change tax type 

Change sales tax amount 

Note: You can also change sales tax amounts in the header view (document header, order 

header, for example). Please note that when you do this, there is generally a difference between 

the sales tax total in the line view, and the amount used in the document header view. 

 

Example: 

Invoice line view 
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Invoice line Net Tax, Sales tax Tax amount Gross 

1 10 7 % 0,7 10,7 

2 20 19 % 3,8 23,8 

3 20 7 % 1,4 21,4 

4 10 19 % 1,9 11,9 

The sales tax amounts entered here in the lines are grouped together in the Invoice header view 

as follows: 

Invoice header view 

Invoice line Net Tax Tax amount Gross 

Total 60  7,8 67,8 

Lines at 7 %  7 % 2,1  

Lines at 19%  19 % 5,7  

 

 Changes to a line: 

If you change the sales tax amount of the line to 0.71, the tax amount in the Lines at 7% row in 

the Invoice header view is increased to 2.11 while the total tax amount for the invoice 

increases to 7.81. 

 Changes in the Invoice header view: 

If you change the sales tax amount of the Lines at 7% row to 2.09, the gross amount in the 

Total row changes to 7.79. 

If you manually enter sales tax amounts in the Invoice header view, the amounts of the 

individual lines are always ignored, even if these were also changed in the individual lines. 

Note: To avoid inconsistencies in the Financials link, it is not possible to manually overwrite 

the sales tax total line. 

 

 

Manual changes to the sales tax amount affect financial accounting as follows: 

 The arithmetically correct value is transferred. 

 An adjustment posting record corresponding to difference compared to the manually entered 

amount is generated. 

 Only the manually changed amount is maintained in the posting journal. 
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Foreign currency invoice 

You can use a foreign currency table (FREMDWEUR allocation table) that contains the average 

exchange rates to specify the currency in which the prices should be entered (separately for each 

order). In addition, you can enter the current daily rate in the order. The conversion for the sales 

statistics is carried out using the average exchange rates or, where available, using the daily rates 

in the base currency (see "Define base currency" page 126). 
 

Display currencies with ToolTips 

When foreign currency is calculated (see "Foreign currency invoice" page 126), the ToolTip 

function converts the amounts in the currency fields into a configurable currency unit. 

To display a currency using ToolTip, complete the following steps: 

1. Use the COMMON.PREISRECHNUNG.TOOLTIPWE parameter to configure the currency that 

you want to display via ToolTip. 

2. Using your mouse, point to a field that displays an amount in any currency unit. 

A display window will appear containing the converted amount in the configured currency. 
 

Define base currency 

In Infor COM, the base currency is the currency in which all internal monetary values (amounts, 

prices, costing data, statistics, and so on) are maintained. 

You can configure the base currency using the COMMON.PREISRECHNUNG.DEFAULTWE 

parameter. 

When you enter purchase orders or sales orders, the base currency is preset in the document 

unless another currency is stored in the business partner master data and you have not manually 

changed the currency in the document. 
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Change transaction currency in documents 

The currency with which a business transaction (quote, order, PO, and so on) is processed is 

designated a transaction currency in Infor COM. 

The transaction currency can differ from the base currency (see "Define base currency" page 

126). It is different in the following two cases: 

 A currency other than the base currency is stored in the master data of a customer. 

 The base currency that was preset in the sales order is changed manually there. 

To change the transaction currency in an existing document (in a sales order, for example), 

complete the following steps. 

1. Open the sales order. The lines entered are displayed on the Order tab. 

2. In the totals line in the footer of the line table, change the selection in the Currency field by 

using the combo box to enter a new transaction currency. 

3. Click the line table. 

4. Select the required conversion option in the Currency conversion dialog box. 

5. Confirm the selection with OK. 
 

Define alternative currency 

An alternative currency in Infor COM is any currency that is taken into account by the price 

calculation function whenever the price that is being searched for is not available in the transaction 

currency. 

When calculating prices in sales orders and purchase orders, Infor COM attempts to retrieve the 

price for a resource from the price table. If the price is not stored in the transaction currency, the 

system searches for the price in the alternative currency. If the price is found in the alternative 

currency, the price is converted to the transaction currency using the Alternative currency/Foreign 

currency conversion rate from the FREMDWEUR foreign currency table. 

You can define the alternative currency using the 

COMMON.PREISRECHNUNG.ALTERNATIVWE parameter. 
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Assign inflation surcharges 

Some raw materials are subject to currency fluctuations to a lesser or greater extent. These 

currency fluctuations affect both the purchase prices and the sales prices of items that are 

dependent on raw materials. You can assign inflation surcharges to such raw materials in order to 

even out price fluctuations. 

In Purchasing, currency fluctuations are absorbed by you as the purchaser. In Sales, these 

fluctuations are passed on to the customer. 

On the Inflation surcharges tab for an item, assign raw material to the item by selecting it from the 

combo box. 

You can access the Item inflation surcharges report by selectingDesign > Reports. This report lists 

items along with their associated inflation surcharges. 

See also: Configuration (Inflation surcharges). 
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Please note: This function must be licensed separately. 

Project is used for creating and managing projects in Infor COM. Projects can include quote 

projects, order projects, and basic projects, for example. 

For basic information on Project, see Project basics (see "Project processing basics" page 129). 

Please note: If you are using the NGDeskWithSalesiProj desktop, you can use the Order 

portfolios and Time recording objects available in the Consolidated orders folder instead of the 

Project processing object. These objects provide considerably reduced project processing 

functions for users who do not need the entire functionality of Project. 

 
 

Project processing basics 

Please note: This function must be licensed separately. 

Project helps project managers to control the management of complex engineering projects. The 

system provides support for the hierarchical planning of resources and material requirements. 

Target values can be compared continuously with the actual expenses accrued. Project-relevant 

information relating to objectives, the current situation, and forecasts for operations and material 

are available at all times. The information requirements of the whole company as well as individual 

departments and groups can be compiled and evaluated from the current projects. 

The integrated capacity planning function and the ability to graphically edit this planning data (see 

GPP) support project managers and line supervisors in the monitoring and scheduling of 

resources. Extensive cost center and project evaluations, which can be compiled individually and 

defined according to fixed criteria, are available online and in printed form. 

For more information, see Use Project (see "Project organization" page 130). 

See also Configuration (Project). 
 

Project processing 
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Project organization 

For general information on project processing, see Project processing basics (page 129). 

Companies that use Project are generally divided into various organizational units that operate as 

profit centers. A distinction is made between sales, manufacturing, and service units. Each of 

these units works out its own budget, which must be compared on an on-going basis with the 

current data and forecast data so that variances can be detected as early as possible. 

In most cases, a project (see "Projects" page 165) is processed by several organizational units in 

parallel, where this includes foreign subsidiaries and third-party suppliers in some cases. 

Note: For a detailed description of the steps involved in creating a project, see Create a basic 

project (page 167), Create quote project (page 171), and Create order project (page 177). 

Project is a tool that is designed for both the project manager and the processing team. It provides 

continuous information on objectives, hours accrued, outstanding purchase orders with 

sub-suppliers, deliveries, invoices, etc. 

The system supports the hierarchical planning of resources and material requirements. These 

target values can be compared continuously with the actual expenses accrued. Project-relevant 

information relating to objectives, the current situation, and forecasts for operations and material is 

available at all times in summarized form as well as in detail. The information requirements of the 

whole company as well as individual departments and groups can be compiled and evaluated from 

the current projects. 

The integrated capacity planning function and the ability to graphically edit this planning data 

support project managers and line supervisors in the monitoring and scheduling of resources. 

Extensive cost center and project evaluations, which can be compiled individually and defined 

according to fixed criteria, are available online and in printed form so that even specific 

requirements can be covered. 
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The project costs and project progress can be monitored continuously by the project manager both 

in each individual unit and as a whole. Consolidated and detailed information on target costs, due 

dates, and materials must be provided for this. To ensure that utilization is distributed as evenly as 

possible across all the organizational units and group companies, it is important to be able to get 

an overview of all resources and add additional resources if necessary. The system supports this 

requirement and allows users to incorporate third-party capacity into a project. 

Purchase orders for material from sub-suppliers are handled using Project by printing the relevant 

order documents, monitoring goods receipt, and entering the invoices in the system. This means 

that current liabilities in relation to sub-suppliers can be monitored at all times both in terms of the 

individual project and the company as a whole, thereby supporting financial planning. 

All of the relevant data for project evaluation (at group line level) is defined in the Progress 

monitoring (page 192) function. Each project is controlled by an area (profit center), which is also 

responsible for the profitability of the entire project. To obtain detailed information about the 

success or failure of a project, not only can you view the overall success of a project from the 

evaluations, you can also see the less significant successes achieved by all internal and external 

parties involved in the project. Changes that are made during the project - such as price changes, 

extended requirements, etc. - are documented in the system and stored as special order changes 

so that the project progress can be reconstructed at any time. 
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Allocation tables (Project processing) 

For general information on project processing, see Project processing basics (page 129). 

When working with Project, the following allocation tables must be maintained: 
 

IPRAICCODES 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Equipment identification codes for project processing 

Usage: The EIC codes for project processing are predefined in this table. 

The group lines are identified using the equipment identification codes (EIC) defined in the 

IPRAICCODES allocation table. The EIC is used to structure the project. For single lines, this field 

indicates whether the line is a single operation line or a single material line. 
 

IPRALTERN 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Alternatives 

Usage: The alternatives stored here can be used as alternative lines in the project line of single 

lines. 
 

IPRANWRECHT 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Applicable law 
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Usage: This table is used to define the place of jurisdiction for legal disputes related to the 

project. The selected entry is available on the Contract data tab for the project. 
 

IPRARBMAT 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Abbreviations for operations and material 

Usage: These abbreviations are used in the project structure to display single lines. 
 

IPRARTGARAN 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Creditor types 

Usage: This allocation table is used to define the creditor type for a surety. The selected entry is 

available on the Sureties tab in the project header. 
 

IPRBUERGEN 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Warrantors 

Usage: This allocation table is used to enter the possible warrantors for a surety. The selected 

entry is available on the Sureties tab in the project header. 
 

IPRDARSTELL 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 
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Description: Views 

Usage: The texts stored here are used as selection criteria when opening a project. You can 

select the display types stored here from the View field on the Open tab. 

 
 

IPREPALANG 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Single operation line statuses 

Usage: The various statuses for a single operation line are defined in this allocation table. 
 

IPREPMLANG 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Single material line statuses 

Usage: The various statuses for a single operation line are defined in this allocation table. 
 

IPREREIGN 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Events 

Usage: The events in the detailed list of an overview schedule can be selected from an event list. 

The event descriptions (milestones) are stored in this allocation table. 
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IPRFOKOSTAT 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Progress monitoring statuses 

Usage: The possible progress monitoring statuses are defined in this allocation table. 
 

IPRFOLGSCHA 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Consequential damages 

Usage: The consequential damage entries stored in this table can be entered on the Contract 

data tab in the project header. 
 

IPRGARANTAB 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Warranty expiration 

Usage: This allocation table describes the possible warranty expiration date options. The 

selected entry is available on the Contract data tab on the project header. 
 

IPRGEFAHRU 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Transfer of risk 
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Usage: This table contains the options for the transfer of risk, which you can enter on the 

Contract data tab in the Project header view. 
 

IPRISVCGENT 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Equipment file generation types in Project 
 

IPRJN1BUCH 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Activate progress monitoring 

Usage: These entries are used in the Progress overview in the project header, for example. The 

entries Yes and No should not be changed. 
 

IPRKALKZUS 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Surcharge types  

Usage: This table stores the surcharge types that are available for the calculation of surcharges. 
 

IPRKAUTART 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Warranty types 
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Usage: This allocation table is used to define the various warranty types. The selected entry is 

available on the Sureties tab in the project header. 
 

IPRKONSORT 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Consortium types 

Usage: You can define the various consortium types in this allocation table. The selected entry is 

available on the Contract data tab in the project header. 

 
 

IPRKOSTART 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Cost types 

Usage: The cost types table is used for entering cost types on the Direct costs tab in Costing, for 

example. The mark-ups for the cost types are also defined in this table. 
 

IPRLEISTART 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Activity types 

Usage: The activity types table is used for entering activity types on the Direct costs tab in 

Costing, for example. The mark-ups for the activity types are also defined in this table. 
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IPRMATART 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Material types 

Usage: This allocation table is used for specifying the various material types. 
 

IPRPROJDEF 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Project prefixes 

Usage: This table contains the prefixes used for projects. 

General 

PF 

Within a single project type, you can have several different project prefixes (PF). The project prefix 

must be unique. 

Client 

In this field, 1 indicates the standard client, while 101 stands for basic projects. 

Project type 

The project category within a project type is useful to know.  It can be used for breaking down 

evaluations. It must be linked to a prefix for organizational purposes. The project categories are 

entered in the IPRPROJKAT allocation table. 

Comment 

Comments can be stored here for documentation purposes. 



Infor COM 7.5 User Guide | 139 

 

Sales 

 

Assignment 

You can use this tab to assign project categories to the project prefixes. 

This ensures that different project types that are generally identified by their project prefix (for 

example,  A=quote projects, P or K=order projects) can also have various project categories. 

Assigned categories 

This table contains the assigned categories, i.e. the categories that should be available for 

selection for the selected project type in the Category field in the Project header view. 

Other categories 

This table contains the remaining categories, i.e. those categories that should not be available for 

selection for the selected project type in the Category field in the Project header view. 

Note: When you open this allocation table for the first time, you are asked whether all categories 

should be associated with all project prefixes. 
 

IPRPROJKAT 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Project categories 

Usage: This allocation table contains the project categories. For more information, see the Help 

topic on the IPRPROJDEF allocation table. 
 

IPRPROJTYP 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Project types 

Usage:  This allocation table stores the project types. Project types can be sales orders/order 

projects and quote projects. 
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IPRRECHNART 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Descript ion: Invoice classes 

Usage: This allocation table is used for storing the invoice classes for the payment plan. These 

classes are then provided in the definition of the individual payment plan lines. 
 

IPRRECHNTYP 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Invoice types 

Usage: This allocation table is used for specifying the invoice type of the project. This is selected 

on the New dialog box of a project. 
 

IPRRUECKTRK 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Customer's right of withdrawal 

Usage: This allocation table is used to specify the customer's right of withdrawal. The selected 

entry is available on the Contract data tab in the project header. 
 

IPRRUNDUNG 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Rounding types 
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Usage: You can use this allocation table to enter rounding specifications for amounts. 
 

IPRSTATARTB 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Procurement status types 

Usage: The different procurement statuses are defined in this allocation table. These are 

displayed in the overview of single lines and provide information regarding the progress of the line 

on the Infor COM side. 
 

IPRSTATARTV 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Sales status types 

Usage: The different sales statuses are defined in this allocation table. These are displayed in 

the overview of single lines. 
 

IPRSTATIGP 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Group line status 

Usage: This table contains the statuses of the group lines. 
 

IPRSTATIPR 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 
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Description: Project statuses 

Usage: This table contains the processing statuses of a project. 
 

IPRSTREITER 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Arbitration boards 

Usage: You can use this allocation table to describe the possible types of litigation (court, court of 

arbitration, etc.). The selected entry is available on the Contract data tab in the project header. 
 

IPRTXARTRTF 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: RTF text types 

Usage: You use this allocation table to store the texts that you want to use for printing 

documents. 
 

IPRVERSFREI 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Shipping release for project header 
 

IPRVERTRART 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Agreement types 
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Usage: The agreement type is stored on the Contract data tab in the project header. 
 

IPRVERTRUMF 

For general information about the allocation tables used for Project, see Allocation tables in 

Project (see "Allocation tables (Project processing)" page 132). 

Description: Scope of contract 

Usage: This allocation table is used to define the contractual scope of the project, i.e. the goals to 

be achieved by this project. The selected entry is available on the Contract data tab in the project 

header. 
 

Project structure 

For general information on project processing, see Project processing basics (page 129). 

Creating a project structure is the basis for all subsequent operations in Project. You can access 

the project structure by opening a project and  selecting View and Project. 

There are two different types of structures: 

 Quote/order structures with reference to corresponding records in Infor COM 

 Basic project structures that are used internally in Project only (see Basic projects (see "Items" 

page 151)). 

The following diagram shows an extract from a specialized project structure. For information on 

how to create a basic project with a structure, see Create a basic project (page 167). 
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The project structure has three levels or line types. 

 (1) Project header: The project header contains the master data for the project. This contains 

the most important information on the project and only needs to be entered once for each 

project. 

 (2) Group lines: Each project is divided into various components or sub-projects. The resulting 

project branches are consolidated on all levels by group lines (page 145). Group lines 

organize the structure. They form containers for subtotals and outline due dates and are 

important elements for cost specifications and for classifying quotes. Each individual group 

line can be broken down into further group lines or single lines. 

 (3) Activity lines (single lines (page 147)): Planned activities are organized into activity lines 

and tracked during procurement. Activity lines are used as follows: 

 As wildcards for entering unconfirmed planning data 

 As references to items in the item master 

 As a means of storing planned/released/actual activities in the project 

 As a source of information and reference for suppliers/deliveries 

Single lines are the actual cost units of the project. There are essentially two different 

types of lines: Material lines and operation lines. Hours are scheduled, identified, and 

offset in operation lines. Material lines can be ordered (bought in), stored, and offset. 

Each project can be structured hierarchically with these line types up to max. 6 levels with a total 

of 99,999 group and single lines. Information is consolidated in detail for operations on all group 

lines and single lines. Only group lines can be entered on the top level. All other hierarchies can 

contain single lines or group lines. 

The project structure is not only displayed graphically in Project; it is also the platform used for 

editing and adding lines. 

The project structure is characterized by the fact that the views for Sales, Costing, and 

Manufacturing run together here. The mapped structure forms the basis for handling the 

processes that occur over the entire processing chain: 

 Creating/printing a quote 

 Creating documents for a quote 

 Creating documents for an order 

 Print order confirmation 

 Creating an invoice 

 Releasing/monitoring procurements by cost and due date 

 Coordinating due dates 

 Calculating concurrent costs 

 Monitoring project progress 

 Reporting 
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Printing 

Structures must be organized in such a way that they provide consistent data for printouts. 

Typically, it is important that structure elements at lower levels appear as independent lines in the 

quote. 
 

Group lines 

For general information on project processing, see Project processing basics (page 129). 

You can access the group lines of a project (see "Project processing" page 129) by double-clicking 

the required group line in a project structure (page 143). 

The group line forms the header of a hierarchy or project branch. It contains the planned default 

values for the underlying structure. It is used to release an organizational unit (department or 

group) with clear objectives. For more information, see Handle projects (page 159). 

Since group lines not only contain planned default values but also a summary of the current data, 

actual values and forecasts are available at each level for monitoring purposes. As a result, 

information on organizational units as well as on costs, forecasts, and due dates for assemblies 

can be obtained once a suitable project structure exists. Periodic consolidation of all current 

projects in an organizational unit can determine key figures that provide clear information on 

efficiency. 

The following features are characteristic of group lines: 

 Costs and sales prices can be entered directly in groups or calculated from sub-groups. 

 Groups have their own descriptive standard text types that are queried in the quote and can be 

printed if included. 

 Groups can have their own due date ranges that can be linked with project scheduling. 

 

Group lines can be differentiated according to top groups, intermediate groups, and end groups. 

Please note: The options for creating group lines are limited according to the hierarchy level. 
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Top groups 

The group lines at the first hierarchy level are called top groups. They contain the most important 

sections of a project. Each group stands for a manufacturing unit, a profit center, a syndicate 

partner, or an affiliated corporation. However, a profit center or manufacturing unit can also be 

listed in several top groups. 

You can insert a top group into a project structure by selecting New  group line from the 

Functions menu. 

Top groups contains activities that must be shown and costed together in the quote. A certain 

location/person is responsible for implementation and requests for due dates are shared. 

Intermediate groups 

Intermediate groups are located between the top groups and the end groups in the hierarchy. 

Intermediate groups contain activities that must be shown and costed together in the quote. They 

structure the whole order according to criteria that can differ for each object type. 

End groups 

End groups are the group lines that contain single lines. End groups have an SL list, i.e. a list of 

single activity lines. No additional sub-groups can be created for group lines with a single line list. 

End groups represent a grouped activity that is precosted roughly as a whole, but is actually 

formed by a series of single activities. 

Deleting/Canceling 

Depending on the processing status, Project differentiates between deleting and canceling. 

Deleting involves deleting the data from the tables. Canceling simply sets a status. The data 

remains in the tables and is no longer included in costing. 

You can only delete data that has not been released, otherwise it is canceled automatically. 

If lines exist under the group line, these are deleted or canceled first by the function. The function 

allows you to delete the current group line and the directly subordinate hierarchies. 
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Single lines 

For general information on project processing, see Project processing basics (page 129). 

In addition to the group lines (page 145) that structure the project, the single lines (activity lines) 

carry out the function of the actual cost units. They form the lowest hierarchy level of a structure 

and contain planned and actual values. They are used for placing orders in Planning and 

Purchasing, for example. The actual costs are updated continuously following release. 

Specific activities to be provided in the project are defined in these lines. 

 

Examples: 

 Special types of internal work activities: 

 Design tasks 

 Assembly operations 

 Project management 

 Internal/subcontracted activities: 

 Expenses, charges, etc. 

 Procurement of purchased items specifically for the project 

 Triggering of internal production orders for assemblies in the project 

 Ordering subcontracted activities, such as excavation, crane work, expert reports 

If an activity is not known exactly yet, a plan line is opened in the project structure. For known 

activities, however, a direct reference to an Infor COM item is opened. 

Note: Activity items can also relate to basic items for VARIANTS calculations. 

The planned/procurement status of the requested detailed activities in terms of type, descriptions, 

costs, sales price, supplier, and due dates is stored in the activity lines. 

Single lines are the cost units in the system. 

A distinction is made between the two single line types single material line and single operation 

line. 
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Single operation line 

Single operation lines are generally opened by the person responsible for starting the directly 

superordinate group line. The specific workload contained in the group line can be split into any 

number of single lines so that meaningful units with clear objectives can be released. Single 

operation lines normally contain brief job instructions in the form of a job description, the hours 

estimated for completing the order, the resulting costs, as well as start and end dates. 

The person responsible for carrying out the operations is appointed and this person subsequently 

enters his/her working hours via the Time recording function. The time management system that is 

integrated in Project is linked directly with project processing, which ensures that the accrued 

hours in the single operation lines are kept up to date at all times. Forecasts, which are 

consolidated in the group lines, are entered periodically for each line. 

This line is ideal for relatively large flat-rate releases that should only be assigned working hours 

and are not managed by Planning. This applies to design tasks, assembly operations, and project 

management. 

Hours are scheduled, entered, and set off in operation lines. 

For a description of how to use operation lines, see Start an operation order (Project) (see "Start 

operation order" page 153). 

Single material line 

Supplier RFQs or direct purchase orders and material reference lists for inventory references can 

be generated from within Project. It is important that all data is managed in Project and purchasing 

or inventory references are initiated from within Project.  For standard items, the material and 

supplier data required for this is transferred to the project from the item database. Purchase orders 

and material reference lists can be displayed either for an entire structure or individually for each 

line. 
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Single material lines are used for material, third-party activities, and expenses. They contain 

equipment or individual items that are taken from inventory or bought in. Only items that were also 

entered in single lines in the project can be purchased. The data required for this, such as texts 

and information on costs, for example, can be entered manually and transferred from the item 

database to the project, or copied from bills of materials or other single lines using the Copy tool 

for standard components. If this data is entered manually, you can search for equipment and 

individual items in the item/equipment master and transfer them from here. 

The release for Purchasing can be run either for an entire structure or for single lines. 

For material lines, purchase orders or inventory reservations are initiated, equipment lists are 

created, and invoices are entered. 
 

Select single lines 

For general information on single lines, see Single lines (Project) (see "Single lines" page 147). 

To limit the selection of single lines to be displayed in the line view, complete the following steps: 

1. Open the project whose single lines you want to select. 

2. From the Functions menu, select Select single lines. 

3. Select the required single lines using the combo box and check boxes. For a description of the 

various fields, see Select single lines. 

4. Click OK to confirm your selection and load the selected single lines. 
 

Transfer from GPP 

For general information on single lines, see Single lines (Project) (see "Single lines" page 147). 

This function is available if you are using GPP. When you select Transfer from GPP from the 

Functions menu in a project, you can choose from between three options: 

 Accept: Start and end dates in planning are transferred from the Graphical Project Planner 

 Reject: Start and end dates are not transferred from GPP 

 Delete forecast: If you are using employee resource planning, potential forecast values can be 

deleted by this process 
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Master data 

For general information on project processing, see Project processing basics (page 129). 

All of the master data required for processing an order is managed in Project. 
 

Employee 

For information on master data in Project, see Master data (Project) (see "Master data" page 150). 

The employees in the employee master correspond to the TIME Employee list. 

The employee master contains all of the key information, such as activity category, relevant cost 

center, entry and exit date, as well as details of the permissions required for handling projects 

using Project. 
 

Suppliers 

For information on master data in Project, see Master data (Project) (see "Master data" page 150). 

The supplier master is managed by Purchasing and contains all of the data required for 

processing purchase orders. 

Suppliers can be grouped into supplier groups with or without price list entries. They can be 

re-entered for RFQs, if necessary. Project checks that supplier parameters are correct. These 

include address assignments, in particular. 
 

Customers (Project) 

For information on master data in Project, see Master data (Project) (see "Master data" page 150). 

The customer master in Project is managed in Sales. 

Customers can be grouped into customer groups with or without price list entries. 
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Project checks that customer parameters are correct. These include address assignments, in 

particular. 
 

Work centers 

For information on master data in Project, see Master data (Project) (see "Master data" page 150). 

Work centers are created in Design. It is a good idea to enter a project-related key for specific 

project work centers. 

The exact costs must be entered on the Costs tab for project costing. In particular, the time unit on 

which the costs are based and the conversion factors must be entered correctly. Check the 

following configuration settings for this: 

 The COMMON.IPROJ.KOSTEN_EPA=KostenSumme entry must be set in the configuration. 

This setting ensures that the price that is used for costing the single operation line is taken 

from the total costs (Total costs field on the Costs tab). 

 If industrial time is to be used for costing, the 

COMMON.GLOBAL.EXTTYPETIME=Industrial entry must be set in the configuration. 

 If using industrial time for costing, the entry 1 hr = 100 min must be set in the MEUMRECH 

allocation table. 
 

Items 

For information on master data in Project, see Master data (Project) (see "Master data" page 150). 

Items are entered in Design. A number of special points must be noted when entering items in 

Project. 

Pure planning items 

For example, these include the following specific terms: 

 Expenses (flight costs, for example) 

 Project management (as grouped line only) 

 Insurance (specification item without costs) 
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Wildcard items 

These are one-off activities and items to be procured, such as sub-designs (specifications) or 

planned complex in-house items. 

Inventory items 

These are items resulting from either in-house manufacturing or Purchasing and are normally 

located at the warehouse. 

FRA purchased items 

These are activities and items that are to be purchased externally, such as one-off items or 

re-used items (possibly with price lists used by suppliers). 

FRA in-house items 

These are internal activities and manufactured items, such as one-off items or re-used items 

(possibly with price lists used as profit centers). 

Items for special tests 

These are items that are to be opened for special cases. 

When working with Project, please use the following parameters in particular for the individual 

items: 

 Fixed requirement allocation or Inventory (Planning tab in the item) 

 Purchased/Sales/In-house item (item header) 

 Definition of prices in the price list for this item 

 Standard suppliers (Supplier tab in the item) 

 Default texts and foreign-language texts 
 

Operation orders 

For general information on project processing, see Project processing basics (page 129). 
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Operation orders are production orders that are initiated from single operation lines (see "Single 

lines" page 147) (SOL) included in the single line list for a group line (see "Group lines" page 145). 

Operation orders are used for operations that are initiated and managed outside of Planning, for 

example, design work, project management, software engineering, external assembly operations, 

etc. 

Please note: Only operation orders are created from single operation lines. 

Requirements in Infor COM 

To enter single operation lines and report working hours, work centers must be entered in Infor 

COM. For information on how to Enter single operation line, see Enter single operation line (see 

"Enter single operation lines" page 169). For information on initiating an operation order, see Start 

an operation order (see "Start operation order" page 153). 

Requirements in TIME 

Time recording is generally based on the entry of SFDC transactions in TIME. 

This requires the creation of the following master data in TIME: 

 Time account groups 

 Time and attendance templates (determined for each specific customer) 

 Employee groups 

 Employee 

Check the following settings, for example: 

 In the TIME master data folder in the Manufacturing module, load the employee group and 

select the Group members tab. 

 Check that all group members have been entered correctly, including the ID card ID in the ID 

card field, which is needed for entering working hours. 
 

Start operation order 

For general information on operation orders, see Operation orders (page 152). 

An operation order can only be initiated in an order project for which progress monitoring was 

performed - see Perform progress monitoring (page 193). 

To initiate an operation order from within a group line, follow the steps below: 
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1. Select this group line. From the Functions menu, select Transfer and Create operation order. A 

list of all operation lines that have not yet been released is displayed in the project. 

2. Select the required line, click the Accept button and confirm the dialog box. 

The line is now released. If there are no resources as yet for the production order, the 

resource AA-IPROJ is created. If a production order does not yet exist for the project, a 

production order is now opened. Other lines for the same project are added to this production 

order. 

The production order ID and the feedback ID for the line are used as the reference when 

entering the line in TIME. You will find the production order ID in the PO/manufacturing ID field 

on the PO/manufacturing tab in the project. The Feedback ID for the production is also shown 

there in the Feedback ID field as well as on the Other tab in the production order. 

3. Go to the operation order and release the production order by selecting Release from the 

Functions menu. Transactions can now be received on the basis of this production order using 

TIME. 

4. In Manufacturing, open the TIME  order time folder and select Delayed transactions. Select 

the Transaction 2 tab. 

Enter the ID card ID of the employee in question in the ID card field, the feedback ID of the 

production order line under FID and the posting ID as well as the duration in working hours. 

Please note: After you save, the transaction is no longer displayed and can only be viewed 

again in SFDC processing once SFDC processing has been carried out. 

After the SFDC transaction has been entered, the quantity is displayed in the production order. 
 

Copy tool 

For general information on project processing, see Project processing basics (page 129). 

You can access the Copy tool in the project structure (page 143) by selecting Copy tool from the 

Functions menu, for example. 

As soon as you open the Copy tool, the project that is currently being processed is displayed in 

both the source project and target project fields. You can perform the following functions: 

 Copy within the current project 

 Copy from a basic project to an existing basic project 

 Copy from a basic project to a quote or order project 
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 Copy from a quote/order project to a basic project 

For general information on how to Copy project structure, see Copy project structure (page 155). 
 

Copy project structure 

This Help topic describes how you can use the Copy tool (page 154) to Copy project structure 

from one project to another. 

1. In the Project processing folder in Sales, select the Open tab to open a project. 

2. From the Functions menu, select Copy tool. 

The project structure of the project that you opened will be displayed in the Source project 

window at the top left of the dialog box that appears. You can also use the Job field to choose 

a different project if you want. Select the Basic projects check box if you want to limit the 

selection to basic projects (page 166). 

The ID of the current project is also displayed as the target project in the Target project section 

at the top right. 

3. Select the target project using the Job field. If you want to define a basic project as the target 

project, select the check box of the same name. 

4. Select an element in the source structure on the left window. To copy a single line list, 

complete the following steps: 

 Select the single line list in the source project (top form) 

 Select the single line list or the lowest group line in the target project (top form) 

 Select the lines that you want to copy in the source project (bottom form) 

 Click either the Copy or Move button. 

5. The Copy button is now active. Click this button to start copying the lines. 
 

Project scheduling 

For general information on project processing, see Project processing basics (page 129). 

Project offers several options for managing and monitoring due dates: 

 At project level, you can enter an Overview schedule (milestone schedule) - see Enter 
overview schedule (page 157). 

 For group lines and single lines, you can enter coordination dates that can refer in turn to the 

overview dates. For more information, see Enter coordination dates (page 157). 
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 All dates are transferred to the Graphical Project Planner (GPP) for graphic representation and 

interactive due date maintenance. For more information, see Edit dates with the GPP (page 

158). 

Operation orders form the basis for actions carried out on single lines. These operation lines relate 

to work centers or procurements via purchase order or production order. The main prerequisites 

here are that the work centers must be defined and event texts must be entered in the 

IPREREIGN allocation table. 

Overview schedules 

Several overview schedules can be used for each project. These are managed on the Scheduling 

tab. 

Coordination dates 

Coordination schedules can be managed for group lines and single lines on the Coordination 

dates tab in the Group line/SL list view. This may involve several entries for group lines, but only 

one due date can be entered for single lines. The due dates are displayed on the Coordination 

dates tab for group lines, on the Project line tab for single operation lines, and on the 

PO/manufacturing tab for single material lines. 

The coordination dates can be linked with a specific milestone from the overview schedule. 

However you can also enter dates without reference to a milestone. 

The due dates for material lines are managed differently. The following table provides an overview 

of how due dates are managed for different material lines: 

Item Due date management 

In-house manufacturing FRA Due date tracking is possible 

In-house manufacturing/purchasing in 

warehouse 

Availability due date only 

Purchasing FRA directly to project Due date tracking is possible 

Direct actual entry No due date management 

 

Note: If coordination dates are entered at different levels (group line and single line) of the project, 

an overview of the existing coordination dates can be displayed in the Project header view. To do 

this, select Coordination schedule from the Functions menu. 
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Enter overview schedule 

For general information on project scheduling in Project, see Project scheduling (page 155). 

To edit an overview schedule, complete the following steps: 

1. Open the project for which you want to enter the overview schedule. 

2. Select the top project level on the Project structure tab and then select View and Project 

header. 

3. Select the Scheduling tab. 

4. Enter the data for the overview schedule in the Schedule section. 

5. Enter the list of milestones for the current overview schedule in the Milestones table. 

Note: You can also enter several schedules at this point. 
 

Enter coordination dates 

For general information on project scheduling in Project, see Project scheduling (page 155). 

Each overview schedule can be managed in further detail in a separate coordination schedule. 

You must open the complete coordination schedule from the Scheduling tab in the Project header 

view - the required coordination schedule can be selected there. When you select the Group 

line/SL list view for a selected group line, only the due dates relating to this business period are 

displayed. If there are no coordination dates stored when you open the schedule via the group 

line, the form is cleared and you can enter new due dates. If due dates have been entered already, 

these are displayed and can be changed or deleted. 

To enter coordination dates for a group line, proceed as follows - the procedure is slightly different 

for single lines because the due date fields are displayed on the Project line and 

PO/manufacturing tabs. 

1. Open the project for which you want to enter coordination dates. 

2. In the project structure, double-click a group line and then select Coordination dates from the 

View menu. 
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3. On the Characteristics tab, select the group line for which you want to enter due dates, if 

applicable. 

4. Switch to the Project line tab and for activities, enter operation lines in which the operations 

can be entered. 

5. Now enter the due date on the Coordination dates tab. The scheduled time allocation is 

already displayed in the Hr/period field. The due date is displayed automatically when you 

select Schedule (Sch) and Milestone (MS). The line title is transferred. 

6. From the Functions menu, select Coordination schedule to display an overview of the existing 

coordination dates at project level. 

7. On the next Open dialog box, enter the schedule in the Schedule field and click OK to confirm. 

8. All due dates for the group line are displayed in the following Coordination schedule dialog 

box. For information on editing due dates in the Graphical Project Planner, see Edit due dates 

with the GPP (see "Edit dates with the GPP" page 158). 
 

Edit dates with the GPP 

For general information on project scheduling in Project, see Project scheduling (page 155). 

You can use the Graphical Project Planner to graphically edit due dates that have been entered 

previously. 

You can transfer the due dates from the project structure for an open project by selecting Go to 

->GPP. 

You can adjust the due dates there and return them to Project. 

Note: There are two buttons on the Scheduling tab, which you can use to transfer data to and 

from the GPP. 
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Handle projects 

Project handling is based on an order project (see "Order projects" page 176) (see Create order 

project (page 177)). Once the order project has been created, the project data is added and the 

project is released. Subsequent project handling typically involves the tasks described below. 
 

Cost projects 

For general information on project processing, see Project processing basics (page 129). 

The following costing types are available in Project: 

 Preliminary costing 

 Continuous costing 

 Final costing (see "Batch calculation of manufacturing costs" page 165) 

Note:  In Project, costing is always performed in the base currency. 

The costs used for costing in Project are transferred from the master data and entered manually in 

the project. You can therefore define which lines of the project structure are to be used in 

manufacturing costing or sales price costing. The single lines can be totaled for each group line. 

Please note: Material is classified according to cost types, and operations according to activity 

types. 

Costing in Project is divided into the calculation of manufacturing costs (see "Manufacturing 

costing in projects" page 160) and sales prices (see "Sales price calculation in projects" page 

162). 

It differs from resource list costing in Infor COM in one important aspect: 

In Project, costing takes evolving structures into account. You can specify in the structure whether 

the costs/prices will be fixed at a certain point in the structure, or totaled from bottom up. To cost a 

project, the costs (budgets) known at this time can therefore be entered and fixed or calculated. 

A system-wide configuration setting allows you to define whether a purchase or sales price will be 

taken from the price list. However, you also have the option of changing this manually in each line 

using a check box. 
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A costing process is always based on a project structure that has been created manually and/or 

generated using the Copy tool. If costs to be copied are defined in the copy template (generally a 

basic project) when you copy the structure, these will be copied also - a check box is available for 

this in the Copy tool. 

Single lines 

When costing single lines, a distinction is made between single operation lines (SOL) and single 

material lines (SML). 

The costs and overhead surcharges for SOLs, but not the sales prices, can be stored on the Costs 

tab in the work center master data. 

For SMLs, a distinction is also made between purchased items and in-house items. When you 

create purchased items, the costs can be taken from the item master or the purchase price list 

(depending on the parameter setting). These amounts are always stored on the Planned costs tab 

for the line. 

The sales prices can be taken from the price list. 

Group lines 

Group lines never contain master data. The use of specifications (page 198) would be an 

exception here. When you create a new corresponding line, this allows you to transfer the costs 

once, but it is not possible to update the costs. 
 

Manufacturing costing in projects 

For general information on costing, see Costing (see "Cost projects" page 159). 

Project allows you to reconcile and display the manufacturing costs (MC) that are entered in the 

group and single lines (see "Project structure" page 143) in overview form. For information on 

calculating manufacturing costs, see Perform manufacturing costing (see "Perform manufacturing 

costing in projects" page 161). These costings can be performed at project level (Project header 

view) or at all group levels. Here, the values are displayed separately according to line type (group 

line, single line) and status (Released, Actual, etc.). 
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Lists/evaluations according to activity type (operation lines) and cost type (material lines) are also 

available. The cost and activity type can be assigned from an allocation table to each material and 

operation line. The total for each cost and activity type can then be viewed downward at each level 

using the project structure. 

Direct costs for project activities can either be taken from price lists or entered manually. 

Manufacturing costs are calculated by adding an overhead surcharge to the direct costs. Total 

manufacturing costs also include a mark-up for administration and sales costs. 

Costing is based on the figures from the group lines and single lines as well as from Progress 

monitoring (page 192). 

The specified forecast values are taken into account in the group line. These values, which are 

totaled for the selected group lines, are displayed in the Planned costs in GL row on the Costs tab 

in the Group line/SL list view. 

Note: You can exclude single operation and material lines from the costing process by selecting 

Option in the Alternative field on the Project line tab in the Group line/SL list view. 

For information on performing manufacturing costing, see Perform manufacturing costing (see 

"Perform manufacturing costing in projects" page 161). 
 

Perform manufacturing costing in projects 

For general information on calculating manufacturing costs, see Calculate manufacturing costs 

(see "Manufacturing costing in projects" page 160). 

There are two ways of performing manufacturing costing. 

1. Open the project for which you want to perform manufacturing costing. 

2. Select one of the options below: 

 Select the Project header view to perform costing for the entire project. 

 To perform costing for a group line, select a group line in the project structure and then 

from the View menu, select Group line/SL list. 
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3. From the Go to menu, select Costing. If you are running the Costing function for the first time, 

the costs will be calculated from scratch. Whenever you perform costing again, the values that 

were calculated last are displayed without any interim changes. 

The data displayed depends on the view that was displayed before you selected the Go to 

function. 

 

 

Switch from Display 

Project header 
The costing for the entire project is displayed. 

Project structure 
The costing for the entire project is displayed and positioned in the current 

line of the project structure. 

Group line 
The costing for the group line and its substructure is displayed. 

Single line 
The costing for the single line is displayed here. 

To update the costing in this case, select Cost from the Functions menu. 
 

Sales price calculation in projects 

Project offers two ways of calculating the sales price from the manufacturing costs: 

Calculating the sales price at 

project level 

This calculates the correct commercial sales 

price for the project as a whole 

Calculating the sales price at 

group line/single line level 

A special sales price is always maintained and 

displayed at the group line and single line level 

 

The group lines and single lines in the project structure (page 143) together with the project master 

form the basic framework for quote costing. The material and operation costs as well as the hours 

are used as initial values here. 
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1. Calculate sales price at project level 

The Cost function is available in the Costing dialog box for manufacturing costs. 

You can also offset various mark-ups for in-house and third-party costs by selecting Check 

mark-ups from the Functions menu. This calculates the sales price including mark-ups. 

2. Calculate sales price at group line/single line level 

A special sales price is available at the group line and single line level. It can be calculated 

from the relevant manufacturing cost values by entering a margin (mark-up in %) or by 

entering a value directly while taking the mark-up into account. 

This method is used when the calculation involves handling very different margins and/or if the 

single line values for the total sales price of the project are binding. 

3. Parallel method 

We recommend using both methods in parallel. Even when you want to display single lines 

and set up special price concessions for the customer, it makes sense to calculate the 

required commercial sales price, i.e. the price at which the project will still contribute to 

company revenue. 

Requirements at group line level 

The calculation is based on the figures from the group lines or single lines, depending on how the 

Prices from substructure check box is set - see Costs. 

Requirements at  single line level 

The sales price to be set for this line can be determined by entering the margin on the SP costing 

tab. 

Note: If the base currency and foreign currency are identical, the value can only be entered in the 

foreign currency field. 

The rate and currency for the sales price are transferred from the project. This sales price currency 

will not be affected if you change the project currency at a later stage. 

Quote costing at project level 

Overhead costs are added directly to plan lines containing inventory and manufacturing costs. 

Plan lines for external activities are used for quote prices. 
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The expected manufacturing costs, separated according to manufacturing costs and external 

costs and differentiated according to cost types, are calculated by accumulating the plan lines. 

The mark-ups can now be added to these cumulative values. The following diagram shows quote 

costing on a project level in context. 

Manufacturing costs External costs 

+ Assembly overhead costs + Material overhead costs 

+ Project overhead costs + Material overhead costs 

+ Sales overhead costs + Manufacturing overhead costs 

and so on. + Bank charges 

 + Reserves 

= Total manufacturing costs 1 

+ Insurance costs Misc. direct costs 

 + Special payments 

+ Licenses 

+ Rep. commissions 

= Total manufacturing costs 2 

+ Sureties Special costs/values 

 + Profit/risk 

+ Penalties 

= Sales price 

Quote costing at group level and single line level 

The sales price can also be determined independently of the manufacturing costs: 

 By sales prices at the single line level. These can be taken from price lists, from a margin 

based on the manufacturing costs, or they can be set as required 

 By sales prices at a group level of any hierarchy. These can be calculated using a group 

margin from the cumulative manufacturing costs for the group, from the retail sales prices for 

single lines, or they can be entered manually 

Quote costing projects the sales price for the project. Ideally, the value obtained corresponds to 

the value that was determined in the project as the required sales price. 
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Batch calculation of manufacturing costs 

Batch calculation of manufacturing costs can be performed for single material lines (SML). To 

initiate this, select  Functions > Batch processes > Batch calculation of manufacturing costs from 

the Project or Group line/SL list views. 

The function cancels the final costs for the production order linked to the single material line. The 

following tasks are completed when you select this function: 

 The batch calculation of manufacturing costs is performed 

 The actual costs are transferred to the SML 

Note:  This function is only available for ordered single material lines, which have not been 

closed, and for which the In-hse manuf. and Fixed requirement allocation properties have been 

selected. 
 

Projects 

For general information on project processing, see Project processing basics (page 129). 

You can open existing projects or create new projects using the Projects object in the Project 

processing folder in Sales. 

Complex projects, such as those managed using Project, typically share the following properties: 

Projects incorporate the following properties: 

 Element of risk (achievement of objectives is uncertain) 

 Complex tasks and large order volumes 

 Interdisciplinary in nature (several internal and external parties work on the tasks) 

 Project duration of several months up to several years 

Note: You can load all single lines that can be ordered by selecting Functions > Select single lines. 

See also the Select single lines (see "Select and transfer single lines" page 181) Help topic. 

In Project, you work with two project types: 

 Quote projects (page 171) 

 Order projects (page 176) 

Basic projects (page 166) are also provided as the basis for the structure of these project types. 
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For information on how to create quote and order projects, see Create quote project (page 171) 

and Create order project (page 177). 

For information on how to perform a batch analysis of a project, see Perform batch analysis of a 

project (page 188). 
 

Basic projects 

For general information on projects, see Projects (page 165). 

Basic projects are template projects that are used for creating quotes, development orders, and 

sales orders. The copy function allows you to copy an entire project or just part of a project for use 

in a new project. Basic projects cannot be released, which means that no costs can be posted to 

basic projects. 

For information on how to create a basic project, see Create a basic project (page 167). 

The structure of a project (see "Project structure" page 143) (positioning) also requires lines 

whose precise specification is not yet known and will be worked out later. These lines are called 

plan lines here. 

Plan lines (with no item reference) are lines whose effective assignment to an item is not yet 

clarified at the time they are created - their type is only defined after release. For example, 

standard costs must be calculated first, or internal preliminary costing must be performed for a 

grouped purchase order. 

There are various ways of entering data for the structure branches created in this way: 

A distinction is made between the following lines: 

 Lines with new data entered directly: this involves a new, manually created item or line for 

which more detailed information is not available in the database 

 Lines with template data from a set of specifications (page 198): similar plan lines already exist 

for these lines - associated guideline data is stored in a catalog (specs). 

The details of the group line are then refined to include important procurement units (deliveries) or 

activities (operations) that must either be specified later or developed as you go along, or for which 

you know that new external orders need to be issued (project-specific one-off items). 

If required activities (operations) are to be processed in an order project, they must always be 

specified as work centers in the Infor COM master. 
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Create a basic project 

For detailed information on project structures, see Project structure (page 143). For information on 

basic projects, see Basic projects (page 166). 

This Help topic describes how to create a basic project. The process of setting up projects is the 

same for basic projects, quote projects, and order projects. Unlike quote projects (see "Create 

quote project" page 171) and order projects (see "Create order project" page 177), basic projects 

are created using the Projects object in the Project processing folder in Sales. 

1. Select the Projects object in the Project processing folder in Sales. Then select the New tab 

and enter the required data for the Job, Cost center, Category, Project manager, and 

Customer ID fields. 

2. In the Documents section, select the address ID and the related form ID for each document. 

3. On the Customer tab, enter the payment and delivery terms as well as the shipping type as 

required. 

Information on the other tabs in the view: 

 The data on the Customer tab is taken from the customer master automatically. 

 The fields on the Prices tab are calculated using project costing once the project structure 

has been set up. No processing is required at this stage. 

 The credit memos issued over the course of the project are displayed on the Credit 

memos tab. You cannot enter any data here. 

 Any number of texts can be entered on the Texts tab. The text types selected in the combo 

box determine where the text that was entered is to be used. The IDs are used for printing 

quotes, for example. 

 Sureties can be entered on the Sureties tab and linked to milestones, if necessary. 

 You can store the most important details of the contract on the Contract data tab. 

 You can define milestones for the project on the Scheduling tab. 

4. Select Functions > Copy tool. On the Copy tool dialog box, select the basic project that you 

want to copy from.  

Click Copy to start copying. 

Note: The Copy tool is of most benefit for quote and order projects, but it can be used for basic 

projects also. 

5. From the Functions menu, select Document management to enter the project cover sheet for 

the project header. Click the File selection button in the opened document to include the cover 

sheet. 
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6. Select View > Project. 

7. Select the required line on the Project structure tab. From the Functions menu, select  New 

group line to enter another group line. In the EIC field on the New group line dialog box, enter 

two characters for each level. 

Use the Subgroup check box on the New group line dialog box to specify whether you would 

like to create the new group line at a lower level of the hierarchy or at the same level. For 

subgroups at the next level, the EIC will include two additional characters. You need to enter 

the corresponding name, cost center, and description.  

8. Enter the name of the responsible employee, the cost center, and the description of the task. 

Click OK to confirm your entries and display the project line. 

The Project line tab is already populated. 

Information on the other tabs in the view: 

 The entries on the Costs tab are dependent on the flags that are set; for example, Prices 

from substructure, Total MC from substructure, and Direct costs from substructure. If these 

flags are not set, the costs can be entered manually. 

 If the Prices from substructure flag is not set on the Costs tab, the sales prices can be 

entered on the SP costing tab. 

 As described for the project master, you can store texts for the group line on the Texts tab. 

 Foreign-language texts for printing reports and for evaluations can be entered on the 

Foreign-lang. texts tab. 

 The other tabs are not relevant for basic projects. 

9. You can enter additional group lines by selecting New group line from the Functions menu. 

For instructions on how to enter single lines, see Create single material line (see "Create 

single material lines" page 168), Enter single operation line (see "Enter single operation 

lines" page 169), and Enter expenses/additional costs (see "Enter expenses/additional 

costs in projects" page 170). 
 

Create single material lines 

For general information on projects, see Projects (page 165). 

To create a single material line (see "Single lines" page 147), complete the following steps: 

1. Open a project and in the Project view, select the group line to which you want to add the 

single line. 
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2. From the Functions menu, select New  single material line to open the New single material 

line dialog box. 

3. You can enter the following item options. 

 Item master: This option allows you to Create single material line with a reference to an 

item from the item master. 

 Plan: When you select this option, you create a plan line that has not yet been assigned an 

item from the item master. The content of these plan lines is based on a set of internal 

specifications that are organized as a catalog of activities with a two-level key. 

 Expenses/additional costs: If you select this option, additional costs are entered for direct 

release and for entering costs. 

Select one of the options and complete the fields as required. 

4. Click OK to confirm your entries. The Group line/SL list view of the project is displayed. 

 

Information on the tabs in the view: 

 You do not need to make any changes on the Project line tab if you selected the Item 

master option on the New single material line dialog box. 

 If the item master contains cost data, this data is copied to the Planned costs tab. The 

overhead surcharge is taken from the allocation table. 

 The data for the PO/manufacturing tab is copied from the item master. The link with the 

schedule must also be selected. The due dates can be changed manually after you select 

the milestone. 

 Text can be stored for the line on the Texts and Foreign-lang. text tabs. 

5. Save your entries. 
 

Enter single operation lines 

For general information on basic projects, see Basic projects (page 166). 

For general information on operation orders, see Operation orders (page 152). The following steps 

show you how to enter a single operation line (see "Single lines" page 147) within a project 

structure (page 143). 

1. Open a basic project. On the Project view, select the group line to which you want to add the 

single operation line. 

2. From the Functions menu, select New single operation line to open the New single operation 

line dialog box. 

3. Selected the required work centers using the fields. 



170 | Infor COM 7.5 User Guide 

 

Sales 

 

4. Click OK to confirm the dialog box. The Group line/SL list view of the project is displayed. 

Information on the tabs in the view: 

 The hours to be scheduled are entered on the Project line tab. The latest due date is 

copied using the Schedule/milestone field. The possible start date must be entered in the 

Start date field. 

 Enter the planned costs for the operation line on the Planned costs tab. The cost record is 

transferred from the selected work center and multiplied by the number of hours. The 

overhead surcharge is copied and calculated from the allocation table for the activity type. 

 Text can be stored for the line on the Texts and Foreign-lang. text tabs. 

5. Save your entries. 
 

Enter expenses/additional costs in projects 

For general information on setting off expenses/additional costs, see Expenses/additional costs 

(see "Expenses/additional costs in Project" page 186). 

Single material lines with the Additional costs flag can be entered in the project structure. The 

main prerequisite for this is that the corresponding items for the additional costs are stored in the 

master data. 

1. Open the project in which you want to enter expenses and switch to the project structure by 

selecting View and Project. 

2. Select the group line to which you want to add the new line and then select Functions and New 

single material line. 

3. Select the Expenses/additional costs option on the following dialog box. The Key and 

Resource or Desc. fields now contain the master data for the additional costs from Infor COM. 

Click OK to confirm. 

4. Enter the budgeted amount on the Planned costs tab. The Planned costs tab contains budget 

figures only, since no purchase orders are entered. 

5. Select the Invoice check box on the SP costing tab. This check box is used to release the 

Invoice tab. 

6. On the Invoice tab, select the Set off by expenditure check box. 

Please note: The Set off by expenditure check box is only visible if the 

COMMON.IPROJ.LEISTUNGSVERRECHNUNG=yes parameter is set in the configuration. 
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7. Select Functions and Release expenses/additional costs to release the line. Once released, 

the status of the line is set to Released. 
 

Quote projects 

For general information on projects, see Projects (page 165). 

As well as creating quotes, you can also use Project to perform detailed costing and due date 

calculations. This involves entering the key due dates and actions relating to the project to be 

quoted. This data is then managed by the system. Quote IDs can be assigned freely and various 

versions of a quote can be managed in the system at the same time. 

The only difference between the quote structure and the actual order project structure is the level 

of detail. The following options are provided: 

 Several organizational units can participate in the quote creation process in Project, 

 Single lines or entire structures from other quotes or from current projects can be transferred, 

 The project manager can view the current processing status of the quote at any time. 

 

The following queries and evaluations are possible for existing quote structures: 

 Transfer to order structure (see Transfer quote project to order project (page 179)) 

 Complete printing (see "Print a quote project" page 174) of all relevant data stored 

 Selective printing of certain hierarchies 

 Report of all quotes in progress according to various criteria 
 

Create quote project 

This Help topic describes how to create a quote project (see "Quote projects" page 171). 

1. Select Sales > Order processing > Quotes. 

2. On the New tab, enter the customer data as well as any other data that may be required. 

Select Create to confirm the data. 

3. Select Data >Save. 

4. Then from the Go to menu, select Project to switch to the project structure and complete the 

required fields on the New tab. 

Please note: No lines should be entered in the quote before switching. 
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5. Select the Address ID and  Form ID for the quote in the Documents section on the Progress 

overview tab. 

6. On the Customer tab, enter the payment and delivery terms as well as the shipping type as 

required. 

Information on the other tabs in the view: 

 The data on the Customer tab is taken from the customer master automatically. 

 The fields on the Prices tab are calculated using project costing once the project structure 

has been set up. No processing is required at this stage. 

 The credit memos issued over the course of the project are displayed on the Credit 

memos tab. You cannot enter any data here. 

 Any number of texts can be entered on the Texts tab. The text types selected in the combo 

box determine where the text that was entered is to be used. The IDs are used for printing 

quotes, for example. 

 Sureties can be entered on the Sureties tab and linked to milestones, if necessary. 

 You can store the most important details of the contract on the Contract data tab. 

 You can define milestones for the project on the Scheduling tab. 

7. Select Functions > Copy tool and select a basic project that you want to copy on the Copy tool 

dialog box (see Copy and edit quote structure (page 174)). 

Click Copy to start copying. 

Note: The Copy tool is of most benefit for quote and order projects, but it can be used for basic 

projects also. 

8. Select Functions > Create document. In the following dialog box, select the Quote and Print 

options (see also Print quote project (see "Print a quote project" page 174)). 

9. From the Functions menu, select Document management to enter the project cover sheet for 

the project header. Click the File selection button in the opened document to include the cover 

sheet. 

10. Select View > Project. 
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On the Project structure tab, select the required line. From the Functions menu, select 

New group line to enter another group line. In the EIC field in the New group line dialog 

box, enter two characters for each level. Use the Subgroup check box in the New group 

line dialog box to specify whether the new group line is to be created at a lower level of the 

hierarchy, or at the same level. For subgroups at the next level, the EIC will include two 

additional characters. You must enter the corresponding name, cost center, and 

description. 

Enter the name of the responsible employee, the cost center, and the description of the 

task. Click OK to confirm your entries and display the project line. 

The Project line tab is already populated. 

The following section contains information about the other tabs in the view: 

 The entries on the Costs tab are dependent on the flags that are set; for example, Prices 

from substructure, Total MC from substructure, and Direct costs from substructure. If these 

flags are not set, the costs can be entered manually. 

 If the Prices from substructure flag is not set on the Costs tab, the sales prices can be 

entered on the SP costing tab. 

 As described for the project master, you can store texts for the group line on the Texts tab. 

 Foreign-language texts for printing reports and for evaluations can be entered on the 

Foreign-lang. texts tab. 

 The other tabs are not relevant for basic projects. 

 

Other options available: Create request for quote (see "Create RFQ" page 176), Transfer 

quote project to order project (page 179),  Update quote project (page 173), Perform 

pricing (page 175) 
 

Update quote project 

This Help topic describes how to update a quote project (see "Quote projects" page 171). 

1. Select Sales > Order processing > Quotes. 

2. On the Open tab, select the required quote project and click Load to confirm. 

3. Select Functions > Quote update 

4. Click OK to confirm the Quote update dialog box. 
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5. On the following Project processing dialog box, specify which attachments should be copied to 

the new project and confirm by clicking OK. 

The project is copied and linked to the new quote. The original project is assigned the status 

Closed. 
 

Copy and edit quote structure 

For general information on quote projects, see Quote projects (page 171). For information on the 

Copy tool, see Copy tool (page 154). 

To copy quote structures, complete the following steps: 

1. Open the quote project. 

2. From the Functions  menu, select Copy. 

3. On the Source project window, select the Basic project check box. 

4. Select the source project in the Job field. 

5. Select the target project in the Target project section based on the Job field. 

6. Select the Project row in both the source and target project. 

7. Click the Copy button. 

Note: This process copies the entire basic project. 

8. You can now complete the following tasks for the copied structure: 

 Enter data manually, 

 Add other copied structures from other projects to this copied structure, 

 Clean up the structure by deleting unnecessary sections (to do this, select Edit and Delete 

row in the Project view).  

Note: You can select multiple rows for deletion by holding down the CTRL key while 

clicking. 

You can also make changes on the tabs in the Group line/SL list view. 
 

Print a quote project 

For general information on quote projects, see Quote projects (page 171). 
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Quotes for plant and machinery are generally very demanding in terms of the design and layout of 

the printed document. In addition, quotes for projects are often very detailed and may have to be 

modified later. This is why quotes for projects are generally created using Word. Project allows 

you to output the data to Word in the same form in which it was created in the project structure - 

with all formatting, text, and graphics intact. 

1. Open the quote project. 

2. From the Functions menu, select Create document. When you confirm the next dialog box, the 

quote opens as a Word document. 

Note: To ensure that the sections are printed in the correct position on the printed document, 

you must number the individual components accordingly – see also Texts. 

Printed quotes are based on a format template (.dot file), which is specified in the 

COMMON.IPROJ section of the configuration. You can find this template in the 

WinwordReports directory of your Infor COM system. 

The parameters that are set also affect the printouts, for example, how much text, and which 

hierarchies are to be printed, etc. 
 

Perform pricing 

This Help topic describes how you can perform pricing for single material lines within a quote 

project (see "Quote projects" page 171). 

1. Select Sales > Project processing > Projects and open the required quote project. 

2. Select the required single material line in the project structure. From the View menu, select 

Group line/SL list. 

3. Select the required single material line from the Characteristics tab. Then from Functions 

menu, select Pricing in Purchasing or Pricing in Sales, depending on the item. 

Note:  If you select Pricing in Purchasing, and the Purchasing price list check box is selected 

on the Planned costs tab, the costs are taken from the price table for the purchased item. 

Otherwise, they are taken directly from the costs themselves. 

The Pricing in Sales function uses the price table for the sales item to update the Net 0 

sales price of the single material line on the SP costing tab. 
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Create RFQ 

For general information on order projects, see Order projects (page 176). 

To create a request for quote, you need to use three dialog boxes. 

 You can access the Create RFQ dialog box from within a quote project. Select the group line 

for which you want to create the RFQ and confirm your selection by clicking OK. 

 The second dialog box allows you to select the single lines. 

 When you click OK to confirm the dialog box, the New dialog box appears and displays the ID 

of the RFQ to be created. 

The following description shows you how to create a supplier RFQ in a quote project. 

1. Open the quote project (see "Quote projects" page 171) containing the material line for which 

you want to create an RFQ and select the Project structure tab. 

2. Click the + sign to select the group line and the subordinate single line list containing the 

material line, if applicable. 

3. Select the line for which you want to create the RFQ. A new (one-off) item is created when you 

create an RFQ for a plan line. 

4. From the Functions menu, select Transfer and Create RFQ. On the following Create RFQ 

dialog box, enter the parent group line for the material line and confirm by clicking OK. 

5. On the following Create RFQ dialog box, select the lines to be transferred by clicking the line 

header(s) while holding down the CTRL key. Then confirm your selection by clicking Accept. 

6. The RFQ ID is displayed by default in the next dialog box. Confirm this to access the RFQ. 

7. You can now print the RFQ by selecting Create document from the Functions menu. You can 

also use the functions available in the Purchasing module to track the progress of the RFQ. 

Note: The created RFQ is entered on the RFQ tab of the SL list view of the single material line. 
 

Order projects 

For general information on projects, see Projects (page 165). 

Order projects can either be entered directly or copied from existing quote projects (page 171) or 

other order projects. All employees working on an order use Project. This ensures that there is 

consistent documentation and control during each phase of a project. 
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An order project is a project that supports feedback transactions (operations) and requirements 

generation (material) and is therefore always assigned a customer (even for internal projects). 

A record is always kept of all engineering lines and all purchasing lines for material and operations 

ordered from suppliers. The level of detail of the order structure breakdown must be adapted 

according to requirements. Structures are only essential for opening single lines in order to enter 

engineering costs, material purchases, and for inventory acquisitions, if these are to be carried out 

using the system. You can select the hierarchy level at which this is done. 
 

Create order project 

This Help topic describes how to create an order project that reflects the most important 

procurement processes based on a basic project (see "Basic projects" page 166). 

1. Use the New tab in the Sales orders object in the Order processing folder in Sales to create a 

new sales order by entering the required data and clicking Create to confirm your entries. 

Note: Alternatively, you can transfer the structure from the quote project (see "Transfer quote 

project to order project" page 179). 

2. Then from the Go to menu, select Project to switch to the project structure and complete the 

required fields on the New tab. 

Please note: No lines should be entered in the quote before switching. 

3. In the Documents section, select the address ID and the related form ID for each document. 

4. On the Customer tab, enter the payment and delivery terms as well as the shipping type as 

required. 

Information on the other tabs in the view: 

 The data on the Customer tab is taken from the customer master automatically. 

 The fields on the Prices tab are calculated using project costing once the project structure 

has been set up. No processing is required at this stage. 

 The credit memos issued over the course of the project are displayed on the Credit 

memos tab. You cannot enter any data here. 

 Any number of texts can be entered on the Texts tab. The text types selected in the combo 

box determine where the text that was entered is to be used. The IDs are used for printing 

quotes, for example. 

 Sureties can be entered on the Sureties tab and linked to milestones, if necessary. 

 You can store the most important details of the contract on the Contract data tab. 

 You can define milestones for the project on the Scheduling tab. 
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5. Select Functions > Copy tool. On the Copy tool dialog box, select the basic project that you 

want to copy from.  

Click Copy to start copying. 

Note: The Copy tool is of most benefit for quote and order projects, but it can be used for basic 

projects also. 

6. From the Functions menu, select Document management to enter the project cover sheet for 

the project header. Click the File selection button in the opened document to include the cover 

sheet. 

7. Select View > Project. 

8. Select the required line on the Project structure tab. From the Functions menu, select  New 

group line to enter another group line. In the EIC field on the New group line dialog box, enter 

two characters for each level. 

Use the Subgroup check box on the New group line dialog box to specify whether you would 

like to create the new group line at a lower level of the hierarchy or at the same level. For 

subgroups at the next level, the EIC will include two additional characters. You need to enter 

the corresponding name, cost center, and description.  

9. Enter the name of the responsible employee, the cost center, and the description of the task. 

Click OK to confirm your entries and display the project line. 

The Project line tab is already populated. 

Information on the other tabs in the view: 

 The entries on the Costs tab are dependent on the flags that are set; for example, Prices 

from substructure, Total MC from substructure, and Direct costs from substructure. If these 

flags are not set, the costs can be entered manually. 

 If the Prices from substructure flag is not set on the Costs tab, the sales prices can be 

entered on the SP costing tab. 

 As described for the project master, you can store texts for the group line on the Texts tab. 

 Foreign-language texts for printing reports and for evaluations can be entered on the 

Foreign-lang. texts tab. 

 The other tabs are not relevant for basic projects. 

10. You can enter additional group lines by selecting New group line from the Functions menu. 

 

You have several options here, including the following: 

Calculate manufacturing costs (see "Perform manufacturing costing in projects" page 161) 

Enter payment plans (page 195) 
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Copy tool (page 154) 

 
 

Transfer quote project to order project 

For general information on order projects, see Order projects (page 176). 

For information on how to create an order project, see Create order project (page 177). The 

following topic describes another option: copying the structure of a quote project to the new order 

project. 

1. Open the quote by selecting Sales > Order processing > Quotes. 

2. From the Functions menu, select Quote > Order. 

3. On the Copy attachments section of the Project processing dialog box, select the check boxes 

for the items to be transferred to the order project. 

4. Click OK to confirm the Project processing dialog box. 

The quote is transferred to an order by copying the entire project structure. 

5. The processing steps from here are the same as those described for creating a quote project 

(see "Create quote project" page 171). 
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Release order projects 

For general information on order projects, see Order projects (page 176). 

After you create an order project (see "Create order project" page 177), the same project can be 

released for operation and material release. 

Both Purchasing functions (for procurement) and Sales functions (for shipping and invoicing) are 

used in Project. The Supplier RFQs (see "Create RFQ" page 176), Transfer to Purchasing (see 

"Release material lines" page 183), Planning (see "Transfer lines to Planning" page 184), and 

Shipping request (see "Create shipping requests" page 185) functions are available in released 

projects. 

The term Release describes releasing a structure in the order project for further processing. Once 

this is done, the directly subordinate lines (group lines and single lines) can be released, i.e., costs 

can be accrued. 

At the same time, the change function is activated and this ensures that the modified data is 

retained in the system. Changes to costs in group lines must be implemented after using the 

Change order tab. 

Please note:  

 Structures can only be released in order projects (page 176); they cannot be released in quote 
projects (page 171). 

 Releases must be performed in a hierarchy from top to bottom. For example, parent groups 

must be released before subgroups. 

 Progress monitoring (page 192) allows you to release all of the group lines in a project at the 

same time (multiple release). Single release (releasing a single group) does not require 

progress monitoring. 

To release several group lines at the same time, complete the following steps: 

1. Open the order project in the Project view. 

2. From the Functions menu, select Release all GLs. 

Note: For information on releasing single group lines, see Release group lines (page 181). 
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Release group lines 

For information on releasing order projects, see Release order projects (page 180). The following 

instructions describe how to release individual group lines. The group line must be released first 

before you can release a single line (transfer it to Planning or Purchasing, for example). 

1. In the Project view, open the project containing the group line that you want to release and 

select the required group line. 

2. From the View menu, select Group line/SL list. Then from the Functions menu, select Release 

group lines and confirm the message that is displayed. 

Please note that the group lines must be released hierarchically. 
 

Select and transfer single lines 

To find out how to release group lines, see Release group lines (page 181). 

The following instructions show how to simultaneously load several single lines to be ordered. 

1. Open the project with the single lines to be released. 

2. Release the parent group lines. 

3. Select Functions >Select single lines. 

4. Select the Create procurement check box and select the required transfer type. The following 

steps vary depending on the transfer type. 

Transfer to Planning 

 Click OK to view the single lines to be ordered in list format. 

 Select the required line on the Characteristics tab and enter the delivery date on the  

PO/manufacturing tab, if required. 

 Select Functions > Transfer > Transfer to Planning. 

 On the following Transfer to Planning dialog box, select the required line(s) and click 

Accept. 

Note: For plan lines, the One-off items dialog box is displayed after this step. Click OK to 

confirm this dialog box. 

Once transferred, the status of the single material lines is Released. You can open the 

sales order by selecting Go to > Sales order. 

Transfer to Purchasing 

 Click OK to view the single lines to be ordered in list format. 

 Select Functions > Transfer > Transfer to Purchasing. 
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 On the next Transfer to Purchasing dialog box, select the required line(s) and click Accept. 

Note: Order planning of the sales orders will now start automatically. 

The PO/manufacturing ID and the feedback ID are entered on the PO/manufacturing tab 

for the line. 

Use the Go to menu to access the PO proposal, item account, and order structure. 

Create operation order 

 Click OK to view the single lines to be ordered in list format. 

 Select the required line on the Characteristics tab. 

 Select Functions > Transfer > Create operation order. 

 In the following Create operation order dialog box, select the required line(s) and click 

Accept. 

During the transfer, a production order is created with the single operation lines as OP 

lines. After the transfer, the production order is displayed. The lines that have just been 

transferred are selected, and the Release dialog box is opened. 

Note: In the project, the single operation line is assigned the status Released, and the 

production order ID and feedback ID are entered in the Operation order/FID field on the 

Project line tab. 

You can now use the Go to menu to access the operation order and the work center 
account. 

 

Release operation lines 

For general information on order projects, see Order projects (page 176). 

Material and operation lines can be released as soon as the group lines to which the single lines 

are assigned have been released (see Release order projects (page 180)). For information on how 

to release material lines, see Release material lines (page 183). 

Note: To load all single lines that can be ordered, select Functions > Select single lines. 

In the standard version of Infor COM, an operation order is created when the lines are released. 

Employees can then use this operation order to enter their hours via SFDC or the Time recording 

function in Project. 

1. Select the operation line to be released. 

Note: You can select and release several operation lines for processing at the same time by 

holding down the CTRL key while clicking. You can select the lines in the Project or Group 

line/SL list views. 

2. Select Functions > Transfer > Create operation order. 

3. On the following Create operation order dialog box, select the required line(s) by clicking the 

row header. 
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4. Click OK to confirm the dialog box. 

5. Click OK to confirm the Release dialog box. 

Operation lines are released in the same way as material lines. One operation order is created 

for each order project, and one operation is entered for each operation task (single operation 

line). The production order form containing the currently stored operations is displayed as 

confirmation. 

Note: This is for information purposes only. Please do not make any changes here. 

6. Close the production order form to return to Project. The operation line now has the status 

Released and is linked to the operation order via the feedback ID. 
 

Release material lines 

For general information on order projects, see Order projects (page 176). 

This Help topic describes how material lines are ordered in a project. Purchase orders are initiated 

from material lines (SMLs), which are listed in the single list of a group line (GL). 

Note: To load all single lines that can be ordered, select Functions > Select single lines. 

Purchase orders from Project can only be initiated for FRA items. They can therefore be initiated 

for all single material lines that have not yet been released and that relate to a purchased item with 

a fixed requirement allocation. 

Non-FRA items are interpreted as inventory items and are procured in lots by saving requirements 

in Planning - see Transfer lines to Planning (page 184). 

The initiated PO proposals and the purchase orders generated  in Purchasing on the basis of 

these PO proposals are tracked in Project and the relevant values - such as PO price, quantity, 

supplier, and delivery date - are displayed. 

In the purchase order process, a distinction is made between quote projects and order projects 

(see table). 

Quote projects Order projects 

Purchase orders are not 

possible. 

Purchase orders can be initiated for single material lines in order projects. Purchase 

orders are not initiated directly from RFQs in Project; they are always initiated from 

the single material line - this ensures that feedback can be entered for the project. 
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Material and operation lines can be released once the group line to which the single lines are 

assigned has been released (see Release group lines (page 181)). For information on releasing 

operation lines, see Release operation lines (page 182). 

Material lines that were created with the Purchasing and Fixed requirement allocation flags can be 

transferred to Purchasing for processing as PO proposals. Subsequent processing in Purchasing, 

Goods receipt, and Invoice receipt is tracked in the project. 

1. In the Project view, open the project containing the material line to be released. 

2. Select the material line to be released. 

Note: You can select and release several operation lines for processing at the same time by 

holding down the CTRL key while clicking. You can select these lines in the Project and Group 

line/SL list views. 

3. Select Functions > Transfer > Transfer to Purchasing. 

4. On the dialog box that is displayed, select the group line and click OK to confirm your 

selection. 

5. On the following dialog box, select the lines that you want to transfer by clicking the row header 

and then clicking Accept. 

Please note: To transfer the lines, you must first complete the Supplier and Delivery date 

fields on the PO/manufacturing tab in the Group line/SL list view of the line. 

6. Click OK to confirm the One-off items form, if necessary. In this case, an item ID is generated 

and the corresponding master data is stored in the item master. The line is then released from 

the project view and subsequent processing is tracked from within the project. 
 

Transfer lines to Planning 

For general information on order projects, see Order projects (page 176). 

Material and operation lines can be released as soon as the group lines to which the single lines 

are assigned have been released (see Release order projects (page 180)). 

Note: You can load all single lines that can be ordered by selecting Functions > Select single lines. 

See also the Select single lines Help topic. 
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Warehouse material or items manufactured in-house are released in the same way as described 

for Transfers to Purchasing (see "Release material lines" page 183). The only difference is that 

these single lines are transferred to Planning as orders, and in the standard version, they are then 

processed there using the normal procedure. 

1. Select the line that you want to transfer. 

2. From the Functions menu, select Transfer and Transfer to Planning. 

3. If you select this menu command from the project structure, you must enter the required group 

line on the following Transfer to Planning dialog box and confirm your entry by clicking OK. 

4. The lines that can be selected for transfer are displayed on the next dialog box. Select the lines 

that you want to transfer by clicking the row header (hold down the CTRL key while clicking to 

select several lines), and then select Accept. 

5. If the One-off items dialog box is displayed, confirm this by clicking OK. The selected lines are 

transferred to Planning. The line in the project is now released. Subsequent processing in Infor 

COM is monitored from within the project. 
 

Create shipping requests 

For general information on order projects, see Order projects (page 176). 

Note: This function is available for released lines only. 

Advance shipping notices from Sales are handled as shipping requests in Project. To create 

shipping requests, complete the following steps: 

1. Select the line that you want to transfer. 

2. From the Functions menu, select Transfer and Create shipping request. 

An availability check is carried out. 

3. The following dialog box then displays either all released lines (when you select the function 

from the project structure), or just the relevant released line. Select the required line by clicking 

the row header. Then click Accept. 

4. The MA lines in the sales order were already generated when you released the line 

(transferred it to Planning or Purchasing). 

The ID of the advanced shipping notice to be generated is therefore displayed immediately in 

the following New dialog box. Click OK to confirm. The advance shipping notice is displayed. 
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Expenses/additional costs in Project 

For general information on projects, see Projects (page 165). 

In order project processing, it is important to have the option of entering additional costs (i.e. lines 

not requiring a PO to be triggered first) in the project structure and in service orders, so that these 

can be assigned to the project. The aim is, as part of purchase invoice approval, to be able to post 

actual costs to the project without a previous PO and without inventory movements. 

Examples of such lines are expense reimbursements and assembly material statements. 

These are prepared in special material lines (SML) contained in the SL list of a group line (GL). 

These lines do not relate to material resources but to account assignment resources for additional 

costs such as expenses or freight.  

With regard to special types of expenditure that occur frequently, for instance expenses, it is 

advisable to already provide for these lines in the base model structure. It is important that the 

accounts are entered correctly on the Purchasing and Sales tabs in the master data for these 

lines, because otherwise errors may occur during invoice approval. 

The following special points must be taken into account for such lines: 

 No procurement functions (Create RFQ, Transfer to Purchasing, Transfer to Planning, Create 

shipping request) are permitted for these single material lines. 

 These lines cannot be transferred to the sales order. 

 The RFQ, PO/Manufacturing, and Shipping tabs are not relevant for these single material lines 

and are deactivated. 

 The default values for creating a purchase invoice can be entered on the Planned costs tab. 

The following Help topics describe how to enter expenses and activities and how to set off 

expenses by accrued expenditure in Project and in service orders. 

Enter expenses/additional costs in projects (page 170) 

Enter expenses/additional orders in SERVICE 
 

Select and release expenses 

To enter expenses (see "Expenses/additional costs in Project" page 186), complete the following 

steps: 
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1. Open the project containing the expenses lines to be released. 

2. Select Functions >Select single lines. 

3. Select the SML and Direct act. entry check boxes. 

4. Click OK. 

The expenses lines found are displayed in the Group line/SL list view. 

5. Select the required line and then select Functions > Release expenses/additional costs. 

6. Proceed by selecting Functions > Transfer > Transfer expense recording. 

The Purchasing > Expense recording form is opened. 

7. Select the Supplier ID on the New tab and click Create. 

You can use this tab to enter a new expenses sheet for the employee. A creditor must be 

entered for each employee who charges expenses. The system automatically completes the 

Ext. inv. ID and Date fields. 

8. Enter the expense amounts on the Prices tab. 

Please note the following points: 

 Several lines and projects can be posted for a single person. 

 Different currencies can be used when recording expenses. 

 Select the No transfer to Financials check box in the form header if you do not want to 

transfer the documents to Financials via the invoice journal. 

 Click Save to save the data. However, the data is not posted. It can be displayed again for 

further editing. 

9. On the Project lines tab, select the project to be posted from the ProjID field and the required 

line from the Ln ID field . 

Select Functions -> Invoice approval to perform invoice approval and post the data (i.e. to 

both Project and the posting journal). Click OK to confirm the following invoice approval 

dialog box. 

After invoice approval, the expense recording is assigned the status Approved and cannot 

be changed again. 

Note: You can now use the  Projects object in the Project processing folder in Sales to 

view the expenses lines on the Group line/SL list view on the Invoice journal tab. You can 

also cancel the expenses lines by selecting  Functions -> Cancel. 
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Perform batch analysis of a project 

You can access the function used for batch analyzing a project in the Project header view of the 

open project (see "Projects" page 165) by selecting Functions -> Batch analysis of project. 

A project generally contains a number of links to objects in Infor COM. The batch analysis of a 

project analyzes these links and updates the project if required. 

 

You can use the Batch control object to set the batch analysis of projects as an automated batch 

process. 

1. Select System functions > Administration > Batch control. 

2. From the Edit menu, select Insert new row. 

3. In the Job field, enter the name of the action. 

4. In the Action field on the Action tab, enter iProjProjekt.Batchanalyse. 

5. On the Time control tab, enter the time basis, interval, and maximum duration for the action. 

Then save your data by selecting Data > Save. 

 

The batch analysis function can be subdivided into the following tasks: 

 

 
 

Plausibility checks 

For an overview of the batch analysis of projects, see Perform batch analysis of a project (page 

188). 

The single material lines (SML) and single operation lines (SOL) are linked to the corresponding 

Infor COM items and work centers. 

Plausibility checks involve checking for the existence of items and work centers as well as 

checking for any changes made. If necessary, the single lines are updated accordingly or error 

messages are output 
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Calculate ordered values 

For an overview of the batch analysis of projects, see Perform batch analysis of a project (page 

188). 

The Batch analysis of project function calculates the ordered values for singles lines that have 

already been ordered but not closed yet. 

If a line is Ordered, it means that it was transferred to Planning. 

This update option is provided because although the values are copied from the Planned segment 

to the Order segment during the ordering process (Transfer to Purchasing, Planning, Operation 

order), they can be changed subsequently in the sales order or operation order. The batch 

process updates the values in the project. 
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Post actual costs for SML 

For an overview of the batch analysis of projects, see Perform batch analysis of a project (page 

188). 

In the batch analysis, costs are posted for single material lines that are ordered but  not yet 

closed. 

The following table provides an overview of the possible line statuses. 

Ordered If a line is Ordered, it means that it was transferred to Planning. 

Canceled Lines that were transferred to Planning or Purchasing can no longer be deleted; 

they can only be canceled. However, if actual costs have accrued, the lines 

cannot be canceled. 

Note: If actual costs accrue for a line that has already been canceled, the line 

is reset to Ordered. 

Closed Lines are flagged as being closed if they have been delivered to the customer in 

full. 

 

For information on posting actual costs from purchase orders and production orders, see Post 

actual costs from purchase orders (page 190) and Post actual costs from production orders (page 

191). 
 

Post actual costs from purchase orders 

For general information on posting actual costs, see Post actual costs (see "Post actual costs for 

SML" page 190). 

During the ordering process, the single material lines (SML) are transferred to the sales order, 

where an MA line is created for every ordered SML. The SML line and MA line are linked via the 

feedback ID of the MA line. 



Infor COM 7.5 User Guide | 191 

 

Sales 

 

If the sales order is planned, a PO proposal is created in Purchasing for every MA line whose item 

is a purchased item and which has a fixed requirement allocation. A purchase order can then be 

created from this PO proposal, and inventory receipts and purchase invoices can be entered 

against this purchase order. 

 The actual costs of the SML are calculated using the associated purchase invoices. These are 

accumulated from the item costs, (pro rata) costs from additional costs, and direct actual 

costs. 

The calculated values are saved in the Actual costs form section on the Planned costs tab in 

the Single record view of the project. 

 Other purchase order data, which is transferred from the purchase order line to the SML by the 

batch analysis is displayed on the PO tab. 

If there is no purchase order found for an SML and the actual costs in the SML are not equal to 

zero, a related message will be generated in the mailbox. 

Note: In general, these costs are required, however you can use the Reset actual costs function 

to delete previously accrued costs. 
 

Post actual costs from production orders 

For general information on posting actual costs, see Post actual costs (see "Post actual costs for 

SML" page 190). 

During the ordering process, the single material lines (SML) are transferred to the sales order, 

where an MA line is created for every ordered SML. The SML and the MA line are linked via the 

feedback ID of the MA record, which is saved in the Feedback ID field in the SML. 

If there is no production order found for an SML (if it was deleted in Infor COM, for example), a 

message is generated in the mailbox. 

To delete previously accrued costs from the PO and Manufacturing tabs, select Functions > Batch 

processes > Reset actual costs. 

Note: It is generally useful to retain the costs and to close the SML with the costs. You can then 

generate a new production order using a new SML. 
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Post actual costs from the inventory journal 

For general information on posting actual costs, see Post actual costs (see "Post actual costs for 

SML" page 190). 

During the ordering process, the single material lines (SML) are transferred to the sales order, 

where a material line (MA line) is created for every ordered SML. The SML and the MA line are 

linked via the feedback ID of the MA line. 

CostingModel=0 The actual costs are calculated from the inventory journal. If 

there are several lines for an SML in the inventory journal, the 

posting values and quantities are totaled. 

CostingModel>0 The actual costs are calculated from the inventory value 

journal. If there are several records for an SML in the inventory 

value journal, the posting values and quantities are totaled. 

 
 

Post actual costs from the invoice journal 

For general information on posting actual costs, see Post actual costs (see "Post actual costs for 

SML" page 190). 

For ordered SMLs of the expenses/additional costs type, the batch analysis function searches for 

the linked lines in the purchase invoice journal. The prices from the lines that are found are 

accumulated for every SML and are restored in the SML in the Actual costs form section of the 

line. 
 

Progress monitoring 

For general information on projects, see Projects (page 165). 

To start progress monitoring, select  Monitor from the Functions menu in the Project header view 

of the project master. 
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For large projects, progress monitoring is performed when you start the project. All relevant 

costing data and the due dates together with the processing date are stored in individual progress 

monitoring tables. Other records can then be stored periodically (monthly or quarterly). 

This allows you to record the progress and development of the project in terms of costs and due 

dates. 

Project differentiates between provisional progress monitoring and definitive progress monitoring. 

 In provisional progress monitoring, the data is calculated and stored with the Provisional flag. 

You can start provisional progress monitoring as often as you want. The project manager uses 

the resulting progress monitoring evaluations as documentation for progress monitoring 

sessions within the project team. 

 Definitive progress monitoring can be started as soon as the required clean-up operations 

have been completed in the project. The provisionally frozen data is assigned the status 

Definitive. Only one definitive data master can be stored per month. 

Definitive progress monitoring must be performed at least once a year in order to determine 

the project sales revenue for the financial year. 

Note: Provisional progress monitoring must always be performed before definitive progress 

monitoring. 

The two processing steps are generally started in close succession. Both processing steps are 

required in order to ensure that the process runs smoothly from an organizational point of view, 

particularly in the case of current projects. The data contained in the progress monitoring tables 

can be evaluated using lists. 
 

Perform progress monitoring 

To perform progress monitoring (page 192), complete the following steps: 

1. Open the project (see "Projects" page 165) for which you want to perform progress monitoring. 

2. Switch to the Project header view. From the Functions menu, select Monitor. 

3. Define whether you want provisional progress monitoring or definitive progress monitoring. 

4. Define whether you want to release the group lines, if necessary. 

5. Click Start to confirm. 
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Sales functions 

Sales functions in this context refer to commercial processing, such as invoicing customers via 

direct clearing of individual systems and/or via payment plans. 

In projects, for example, it may be necessary to convert down payments to sales revenue for 

evaluation in accordance with IAS or US GAAP if specific project progress is to be posted. These 

functions are integrated into the existing Infor COM processes so that statistical evaluations also 

take project data into account. 

For more information, see Create sales orders (page 194), Enter payment plans for order projects 

(see "Enter payment plans" page 195), and Print order confirmations and invoices (see "Print and 

cancel documents" page 196). 
 

Sales orders (Project) 

For general information on sales functions, see Sales functions in Project (see "Sales functions" 

page 194). 

The sales order, which is created for order projects, contains costs only. The revenue accrued for 

this order is managed in Sales orders. These sales orders are created automatically when you 

create an order confirmation or invoice – see Create sales orders (page 194). They can be 

assigned to an order project using the same ID (in addition to the order project ID, the sales order 

is also assigned the suffix selected in the COMMON.IPROJ.SALESORDERSUFFIX entry in the 

configuration). 

 Sales orders with the suffix V identify the revenue that is invoiced (directly) against the 

delivery. 

 Sales orders with the suffixes V1-Vn are created for revenue that is invoiced using payment 

plans. 

Please note: No manual changes can be made to sales orders with the suffix V(n). 
 

Create sales orders 

For general information on sales orders, see Sales orders (see "Sales orders (Project)" page 194). 
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As a prerequisite for the description below, you must already have created an order project as 

described under Create order projects (see "Create order project" page 177). 

1. Open the order project in Sales by selecting Project processing  and Projects . 

2. Select Functions and Create document . 

3. Select the Order confirmation  or Invoice option and confirm your selection by clicking 

OK. 

4. On the following dialog box, select the line that you want to confirm or invoice and click 

Accept to confirm your selection. The sales order is then created. 

5. In the Projects object in the Project processing folder in Sales, open the sales order that you 

created by selecting the ID of the sales order from the combo box in Sales order field. For 

information on the numbering system used for sales orders, see Sales orders (see "Sales 

orders (Project)" page 194). 

Example: The ID for sales order 10007 is 10007V. 
 

Enter payment plans 

For general information on sales functions, see Sales functions in Project (see "Sales functions" 

page 194). 

The following Help topic describes how to create invoices for existing payment plans. As a 

prerequisite for the description below, you must already have created an order project as 

described under Create order projects (see "Create order project" page 177). Once you have set 

up the project structure, you can enter payment plans. A project generally contains one payment 

plan, but several payment plans can be created for each project. 

1. Open the order project in Sales by selecting Project processing  and Projects . 

2. From the Functions menu, select Sales and Payment plan. 

3. Enter the description  for the payment plan. 

4. Double-click the row header of the entered payment plan line to open the payment plan and 

enter the credit terms. 
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5. Enter the basic data for down payments or for payments on account on the Amounts tab. 

Select the payment plan from the Type column, and the payment plan with the required 

percentages from the Payment column. The amounts are calculated on the basis of the % 

lines or they can be entered manually. 

6. Enter the due dates for the payment plans on the Due dates tab. You can enter both the 

actual payment period and the forecast payment period here. 

7. If you want, you can use the Terms tab to enter remarks to be printed on the invoice. Other 

information and texts can be entered in the usual way by double-clicking a payment row. 

8. Use the View menu to switch to the Payment plan header . You can change the payment 

period to be printed on the invoice here if necessary. 

9. Select Functions > Sales structure. Select the payment plan from the PP column of the 

following dialog box and click Save. 

Note: Once you have assigned the relevant lines, you can open the payment plan from within 

the project by selecting Functions, Sales, and Payment plan. The total for the sales 

prices from the selected and assigned lines is now displayed in the payment plan. 
 

Print and cancel documents 

For general information on sales functions, see Sales functions in Project (see "Sales functions" 

page 194). 

Order confirmations and invoices are printed directly from within the project. 

1. From the Functions menu, select Create document. 

2. On the following form, select the invoices that you want to print. Click Accept to confirm your 

selection.  

The invoice (or down payment or final invoice, depending on your selection in the Create 

documents dialog box) is then printed. 

3. Cancel document printing by selecting Edit document from the Functions menu. 

4. On the following dialog box, select the Invoice and Cancel options and click OK to confirm. 

5. The invoices that have already been printed are displayed on the Select dialog box. Select the 

required invoice if necessary. Confirm your selection again by clicking OK. 

6. Click Yes to confirm the following prompt. 
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7. The Print dialog box now shows the data for the credit memo to be printed. Confirm once again 

by clicking OK. 
 

Invoice lines 

For general information on sales functions, see Sales functions in Project (see "Sales functions" 

page 194). 

Lines can also be invoiced directly in the project structure. A delivery does not have to be carried 

out. The description below describes how to invoice group lines directly. 

1. Open the project in which you want to enter invoicing details for the group line. 

2. From the Functions menu, select Sales and Sales structure. 

3. Select the check box in the In column for the group line for which you want to start printing 

invoices. 

Note: You cannot enter a payment plan in the PP column. 

4. Click Save and select the Group line/SL list view. The Invoice flag is now set on the SP costing 

tab. 

5. From the Functions menu, select Create document followed by the Invoice option to create the 

invoice. Click OK to confirm the dialog box. 

6. Select the required invoice lines on the next dialog box. You can also change the invoice 

amounts here in order to enter partial invoices. 

Note: You can create invoices for single lines in the same way as for group lines. 
 

Post down payments to Sales 

For general information on sales functions, see Sales functions in Project (see "Sales functions" 

page 194). 

If projects run over a long period of time, full down payments or partial down payments must be 

posted to Sales. Project allows this type of reposting to be carried out with very little input on your 

part. 

1. Open the project for which you want to repost down payments. 
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2. From the Functions menu, select Create document. Then select the Invoice and Print options 

and confirm by clicking OK. 

3. From the Prices tab on the next form, select the lines that you want to fully or partially transfer 

to Sales, and then enter the quantities and amounts to be reposted. 

4. On the Set off down payments tab at the bottom of the form, select the down payments from 

which the reposting amount is to be subtracted. 

5. Confirm by clicking Accept. 

 
 

Specifications 

Project specifications (Specs) provide a catalog of activities in which you can store all kinds of 

activities that are not made concrete until the detail engineering or procurement stage. 

Unlike the items in the Infor COM master, these activities are not very specific and have no 

resource list, in particular. Specification lines are not transferred to the master as one-off items 

until project processing. 

Specification activities can be managed as purchased items or in-house items. Specifications are 

less suited for operation activities since these cannot be processed subsequently. 

Costs, prices, texts, etc. can also be stored for specification activities, if these are known. 

In principle, specification activities are handled in the same way as master resources when 

creating lines in the project - they are called plan lines. 

In addition to texts, the following information is also transferred to the project from the 

specifications: 

 Default values for manufacturing costs 

Gross procurement/purchase price, for example, the supplier's list sales price 

Overhead surcharge as a percentage 

Manufacturing costs: Procurement price plus overhead surcharge 

 Default values for sales prices 
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Manufacturing costs 

+ Margin 

= Sales price 

 Unit of measure/cost unit 

 Cost type 

 Company type 
 

Time recording in projects 

The Time recording function for operation activities in projects enables operation orders primarily 

from Design, Planning, and Assembly to be entered directly on the screen. Absences, flextime, 

and overtime can be documented and managed here also. 

Requirements: 

 A value of 1 must be entered for the employee in question in the Enter projects combo box on 

the TA privileges tab in the Employee master. 

 An operation order, an operation line in a project, or an operation order from Manufacturing 

must be released for processing. 

Please note: Operation lines can only be released if the parent group line is also released. 

Note: Operation orders with the status Closed cannot be posted. 

For information on performing time recording, see Perform time recording in projects (page 199). 
 

Perform time recording in projects 

To perform time recording in projects (page 199), complete the following steps: 

Note: To enable time recording, you must release both the parent group lines and the single 

operation lines for which time recording is to be performed. Click here (see "Release operation 

lines" page 182) to find out how to carry out a release. 
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1. Open the project for which you want to perform time recording, select the released operation 

line in the Project view and then select Go to and Time recording. 

Note: Alternatively, you can open the Time recording object by selecting Project processing in 

the Sales module. 

Please note: You can only use the Go to function for released operation lines - see Release 

operation lines (page 182). Once released,  the line is linked to the operation order by means 

of the feedback ID. 

2. Enter an employee ID for the transaction on the Open tab and confirm this by clicking OK. The 

Time management form now contains the data for the current month for the user who is 

currently logged on to the system. 

3. On the Project overview tab, select the project ID in the Order column and then select a 

released operation line in the FID column, for example. 

4. Enter the times on the Time recording tab. 

5. You can enter further additional text for each month on the Work center/description tab. 

6. Save the lines that you have entered. 

When you save the time recording entries, all saved data records are displayed on a dialog 

box. You then have the option of entering descriptions here. You can edit these later by 

selecting Functions and Change descriptions. 

Operation orders that are entered in Time recording remain displayed on the Time recording tab 

until such time as you remove them by selecting Edit and Delete row. Deleting the row also 

deletes all order times that were entered in the current month. No rows can be deleted in a closed 

month. 

 
 

Perform period-end closing (Project) 

For general information on time recording in projects, see Time recording in projects (page 199). 

The month-end closing is performed in two stages. To close a period for time recording, complete 

the following steps: 

1. Select the Time recording object in the Order processing folder in Sales. 
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2. Complete all fields on the Time recording tab. 

3. Enter the proposals for processing flextime/overtime on the Overtime management tab. 

4. Select the Close period function to end your time recording session. 

The month-end processing function can close this data correctly as soon as you have printed the 

time recording document and obtained the relevant manager's signature. If the manager does not 

agree to the flextime and overtime proposals that are entered, he/she can cancel the period-end 

closing using the Undo period-end closing function and re-release time recording for processing. 

You can then make adjustments and run period-end closing again. 
 

Period posting 

The Period posting function definitively posts the time recording entries (see "Time recording in 

projects" page 199) with the comment Period closed and these entries can no longer be changed. 

Before the entries are actually posted, various information for monthly posting is displayed on the 

Period posting tabs. 
 

GPP 

For information on GPP, see the GPP Help topic. 
 

Document management 

In Project (see "Project processing basics" page 129), project-relevant documents are stored in 

the Document management function. 

You can access the Document management function by selecting Document management in the 

System functions module, or by selecting Document management from the Functions menu in the 

Project header view of a project. 
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Documents can be created as part of an engineering, assembly, or sales activity that is managed 

as a operation task (single operation line) in Project. Other documents originate from 

Project-internal operation processes, such as materials management or financial and accounting 

systems. 

 In Project, all documents relating to an order project must be stored. For information on linking 

projects to documents, see Link projects to documents (see "Store documents" page 205). 

RFQs to suppliers, purchase orders to suppliers, and invoices to customers that are created from 

within Project or are prepared for word processing, are assigned a purchase order ID or invoice ID 

when this function is selected. Once the data supplied by Project has been edited in a word 

processing package, these documents will also be stored and managed in Document 

management. 

Please note: Permission for entering and changing document types should only be granted to a 

very small group of users. 

Two types of attributes are managed for documents: 

 General document ID: Attributes that occur for all document types and can therefore always be 

specified. 

The system assigns a unique ID to each document that is assigned to a project, and further 

information (attributes) is added for each document in the general document ID section. 

 Variable document ID: Attributes that contain different descriptions and properties based on 

the document type. 

In addition to the general attributes, other user-definable attributes can be assigned for each 

document type. These attributes make it easier for you to search for documents and identify a 

document uniquely. 

Note: For information on the transfer of documents with PRO.FILE, see the Exchange documents 

Help topic. 

Search functions 

There are various options available for searching for documents: 

 You can search for a document directly using the document ID and the Document 

management object in the System functions module. 

 You can select Document management from the Functions menu within the Project header 

and Group line/SL list views of a project. Various attributes can be incorporated into the search 

using this form. All documents or the documents that are linked to the object in question can 

be listed here. You can then create/remove a link to the documents that are found by selecting 

Link/Remove link from the Functions menu. 
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 You can search for a document by selecting Document management from the Functions menu 

within the item, customer, and supplier master as well as from various documents, such as 

purchase orders, production orders, and sales documents. 
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Allocation tables (Document management) 

DOCPDFPAR 

Description: Parameter data for archiving PDF files in Document management 
 

DOKPRNART 

Description: Print processes in Document management 
 

DOKPRNDEF 

Description: Default print settings for Document management 
 

DOKSTAT 

Description: Document statuses 

Usage: The status of documents is managed in Document management and can be used as a 

selection criterion when opening Document management. 
 

DOKTYP 

Description: Document types 

Usage: This table contains the document types that are available for selection in Document 

management. 
 

DOKUVERW 

Description: Document management 
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Store documents 

For general information on managing documents in Project, see Document management (page 

201). This Help topic describes how to create a link between project lines and documents. 

1. Open the project for which you want to store documents. 

2. In the Project view, select the line for which you want to store the document. 

3. From the View menu, select Group line/SL list. 

4. From the Functions menu, select Document management. 

5. Select the New tab, enter data in the Doc. type, Name, and Title fields, and click Create to 

confirm. 

6. Click the Select file button on the form header and select the document in the Open dialog box 

that is displayed. 

7. From the Data menu, select Save to save the assignment of the document to the project line. 
 

Link documents 

For general information on managing documents in Project, see Document management (page 

201). 

The following Help topic describes how to link a document to a project. 

Note: The procedure described here can also be performed in the Project header view, which is 

used to store documents for the project. 

The procedure can also be performed in purchase orders, production orders, and in most sales 

documents using the Document header and Document line views as well as in the item, customer, 

and supplier master. 

1. Open the project that you want to link a document to. 

2. From the View menu, select Project header. 

3. From the Functions menu, select Document management. 
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4. In the Standard selection tab that is displayed, select the Everywhere option in the Find field 

and click Load. 

All the documents that are found are then displayed. Linked documents are highlighted in blue. 

5. Select the required document and then select Functions and Link. 

Note: You can remove the link again by selecting Functions and Remove link. 

6. Save the link by selecting Data and Save. 
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The sales documents for processing sales orders are available in the Order processing folder. A 

number of analyses using journals and reports are also available. 

Additional Help is also available on the invoice journal (page 248), the reports (see "Reports 

(Sales)" page 249) available in Sales, and the statistics (see "Statistics (Sales)" page 252) in 

Sales. 

 

Order processing 
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Quotes 

Call 

Sales > Order processing > Quotes 

Description 

You use this document type to submit a (binding) quote to the customer indicating that you want to 

deliver certain goods under certain conditions. A customer RFQ may precede the quote. 

Functions 

Enter reason for rejection 

Cost quote 

Quote update 

Calculate delivery date 

Configuration 

COMMON.ANGEBOT.BRIEFKOPFPAPIER 

In practice 

If you have a large amount of released quotes, you will find it more difficult to trace specific, 

individual quotes. Because of this, Infor COM offers a range of options you can use to specifically 

select and trace created quotes. 

 To delete an open quote, select Data > Delete. 

 Use the filter and selection options relating to the quotes on hand and the quote status on the 

Open tab of the quote. You can use these options to select quotes according to follow-up due 

dates or requested delivery dates. 

 For rejected quotes, enter the date and reason for rejection. You can manage all possible 

reasons for rejection in the  ABLGRUND allocation table. 

 Copy quotes. The procedure is the same as the procedure used for copying an order (see 

"Copy sales order" page 215). 
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 Use autotexts to make customized changes to quotes. Refer also to the notes on the 

document language (see "Define document language for companies" page 357). 

 Use the alternative line function (AL check box on the Quote tab) to offer a customer 

alternative selection lines (see "Enter alternative line" page 211). 

 Use Quote update to customize quotes according to the customer's requirements. 

Having your own numbering allows you to establish a correlation between the original 

quote and the updated quote. 

 Use the evaluation reports in the Repots object in the Order processing folder for the following 

analyses: 

 The current quotes on hand 

 The quotes by order probability 

 The rejected quotes 

 The quotes that have been converted to orders 

 Transfer the quotes directly to the sales orders. For more information, see Transfer quote to 
sales order (page 210). 

 

Create quote 

For general information on quotes (page 208), see the corresponding topic. 

To enter a quote for a customer, open the Order processing folder in Sales and then select 

Quotes. Proceed as follows to enter a quote. 

1. Click Quotes and then select the New tab. The next available quote ID is assigned. It can be 

overwritten. 

2. Select the customer ID. The description noted in the customer's master data now appears in 

the Cust. desc. field. These details are sufficient for creating the new quote. You can enter 

data in the other fields if you like. 

3. Confirm your entries by clicking the Create button. 

4. In the quote header, you can now change the data that was entered (with the exception of the 

quote ID), or you can add data that has not yet been entered.   

5. In the table under the quote header, enter the individual lines of the quote. Select the AL check 

box if this is an alternative line (see "Enter alternative line" page 211). 

6. In the Resource field, enter the ID of the item to be entered or select this from the combo box. 

All items starting with the character entered are listed in the combo box. 
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7. In the Quote field, enter the required quantity of the item. The unit of measure is displayed and 

can be changed here. 

8. The calculated unit price is displayed in the Price field. For more information, see Prices and 

discounts in Sales (page 368). 

9. Select Data and Save to save your entries. 

You can use quote costing to calculate the quote price. 

For information on how to generate a sales order from a quote, see Transfer quote to sales order 

(page 210). 
 

Print quote 

For general information on quotes (page 208), see the corresponding topic. 

Before you can print a quote, you have to open it first. To do this, click the Order processing folder 

in Sales, and select Quotes. Then proceed as follows. 

1. In the dialog box on the Open tab, enter the quote ID and confirm your entry by selecting Load. 

2. In the open quote, open the Functions menu and select Print. 

3. In the Print dialog box, you can display a print preview of the quote on the screen. To do so, 

click the Preview button. 

4. Click OK. 

If you make changes and want to reprint the quote, select Functions and Repeat printout or 

Functions and Cancel. You can now print the quote again. 
 

Transfer quote to sales order 

For general information on quotes (page 208), see the corresponding topic. 

If a sales order is placed for a quote, you can transfer the created quote to sales order 

maintenance as follows. You can generate any number of orders from a quote or parts of a quote. 
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1. If all lines can be transferred to the order, select Functions and then Create order from quote. 

Note: If the customer did not order all lines, select the lines that were ordered. To do so, hold 

down the CTRL key and click the individual row headers of the lines in question. 

2. Select Functions and Create order from quote. This opens up the Save as dialog box. 

3. When you select OK to confirm your entries, the order is copied to order maintenance under 

the confirmed ID and you can make changes and corrections to it there. 
 

Enter alternative line 

For general information on quotes (page 208), see the corresponding topic. 

You can use the Alternative line function to offer your customer one or more additional selection 

lines for a line in a quote. 

The quote price of an alternative line is not included in a quote's total. In the quote printout, an 

alternative line is identified with the abbreviation A. 

Please note that no Sq. ID is assigned for an alternative line. This field displays 0 for alternative 

lines. This is not printed on the document. 

Click here (see "Quotes" page 208) for Help on how to enter alternative lines in a quote. 

1. Open a quote. 

2. On the Quote tab, select the AL check box for the line that is to be managed as an alternative 

line. 

 

Note: When you convert a quote to an actual sales order (via Functions  > Quote > Order), 

do not delete alternative lines that have not been ordered, or clear the corresponding check 

box. Instead, prior to selecting the function, select the lines that you want to transfer to the 

sales order by holding down the Ctrl key and clicking the relevant IDs in the row header to the 

left. Any lines that you do not select will not be transferred to the order. 

This ensures that the original quote is retained. 
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Sales orders 

Call 

Sales > Order processing > Sales orders 

Description 

A sales order is a request from the customer to provide a particular service. 

Configuration 

To create inventory requests, set UseAdvancedPickingInSales=yes parameter in the 

configuration. 

Functions 

Create inventory requests: This function allows you to create inventory requests. If the appropriate 

parameters are set, this function must be run in order to be able to create an advance shipping 

notice. 

Reserve inventory for all lines: It is possible to reserve all order lines in the same reservation 

process, so that you don't have to access the reservation function for each individual line.  

This ability to reserve all lines enables the use of underlying search strategies such as issue by 

FIFO, or same-batch issue. A message also indicates whether the reservation was carried out for 

all lines, and any missing lines are also flagged 

Automatically generated reservations can be modifed or cancelled manually at any stage. 

Reserve same batch 

Maintain shipment tracking details: If you are working with an e-shop link, you can publish 

shipment tracking information via this e-Commerce link. 

There are two ways of storing this information in Infor COM: 

 From a loaded advance shipping notice  

 From a loaded sales order 
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You can access this process from both locations via Functions > Maintain shipment tracking 

details. 

For each advance shipping notice, you can store as many shipment IDs with a shipment tracking 

link as you require. 

Note: No syntax checks are carried out. 

Select replacement item 

In practice 

Click here (see "Enter sales order" page 213) for information on how to enter a sales order. 

If a quote exists, you can copy it to a sales order without having to re-enter the data - see Transfer 

quote to sales order (page 210). 

For information on how to enter, print (see "Print order confirmations" page 387), and cancel (see 

"Cancel order confirmation" page 222) order confirmations (see "Print order confirmation" page 

222), see the corresponding Help topics. 

Please also note the Help topics on closing (see "Close sales order" page 225) and archiving (see 

"Archive sales orders" page 402) sales orders. 

Create component item lines in sales order (see "Component item lines in sales order" page 218) 

Disc. item: For a discontinued item, (Disc. item = 5, Planning tab), a sales order can only be saved 

if the requirement can be covered by available inventory. 
 

Enter sales order 

You enter incoming purchase orders from your customer as a sales order (see "Sales orders" 

page 212). 

1. In the Sales module, click the Order processing folder followed by the Sales orders object. 

Select the New tab. 

The next available order ID is assigned. You can overwrite this ID if required.  

To create a sales order for a delivery to the consignment warehouse, select the Consignment 

delivery check box. 
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2. In the Customer ID field, enter a customer ID or select one from the combo box. 

3. You can enter additional text in the Job field. This can be used later for filtering orders. 

4. You can also enter the customer's PO ID. This can be included in subsequent printouts. 

5. If a requested delivery date has been agreed with the customer, you can enter this date here. 

Note: You can then calculate the earliest possible delivery date in the order itself by selecting 

Calculate delivery date from the Functions menu. 

6. Click Create. 

The data you entered in the previous dialog box is now displayed in the order header. With the 

exception of the order ID, you can correct this data here if necessary. 

7. From the order lines table on the Order tab, select the item(s) you require. You can enter the 

item ID in the Resource field. A description of the item is displayed in the Description field 

when you confirm. 

To search for the item, select Go to > Find master data. 

Note: It is also possible to enter an item for which no master data exists. For more information, 

see the Enter one-off item in sales order Help topic. 

8. In the Quantity field, enter the required quantities. The calculated unit price is displayed in the 

Price field. All group flags are taken into account here. For more information, see the Prices 

and discounts in Sales Help topic. 

Repeat steps 7 and 8 until you have entered all lines in the order. Select Data and Save to save 

the order and Data and Close to close the order entry form. 
 

Create sales order with product configuration item 

To enter a sales order with a product configuration item, carry out the following steps. 

Please note:  The steps are intended to be quick instructions. For detailed Help on working 

with product configuration generation, see Using VARIANTS. 

1. In Sales, use the Sales orders object on the New tab to enter the customer ID and click Create. 

2. On the Order tab, enter the resource ID of the product configuration item (item with assigned 

category). 

Note: For items with discontinued item flags of 5, the creation of a new sales order will be 

rejected if the available inventory cannot cover the requirement. 
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3. On the Features tab, enter the order features on the feature sheet – see the Enter order 

features Help topic. 

4. Select Edit and Insert sheet to add local feature sheets or Edit and Delete sheet to delete 

them. 

5. Select Functions and Close. 

6. From the Functions menu, select Generate product configuration order. 
 

Copy sales order 

If you want to enter a sales order (see "Sales orders" page 212) that is similar to one that is 

already saved, you can copy the saved order by saving it under a different order ID and then make 

the required changes. 

1. Open the sales order on the Open tab. 

2. In the order form, select Data and Save as. The Save as dialog box opens and the next 

available order ID is entered by default. You can overwrite it if required. 

The customer is set by default from the loaded order, but you can choose another customer 

from the combo box. 

The Job, PO ID, and requested date from the original order are also copied over. Change 

these as required. 

3. When you click OK, the order is displayed in table form. You can now make the necessary 

changes, for example item or quantity changes. 

4. Select Data and Save from the menu to save the new order. 
 

Enter sales order for delivery to consignment warehouse 

Customers generally request the delivery of stock to their consignment warehouse by creating an 

order on their end. This order is then used as the basis for creating a sales order at your end. 
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As with any sales order, you can manually reserve batch-tracked inventory in your own warehouse 

by selecting Go to > Reservation > Warehouse address. If the status of the sales order is Issue, 

you can also reserve batch-tracked inventory in the consignment warehouse of the relevant 

customer by selecting Go to > Reservation > External address. For more information, see the 

Reservations in customer consignment warehouses (see "Create reservations in customer 

consignment warehouse" page 1071) Help topic. 

To enter a sales order for a delivery to a consignment warehouse, complete the following steps:  

For information on which requirements need to be met for a consignment delivery on the 

warehouse side, see Customer consignment warehouses. 

1. In the Sales module, click the Order processing folder followed by the Sales orders object. 

Select the New tab. 

The next available order ID is assigned. You can overwrite this ID if required.  

To create a sales order for a delivery to the consignment warehouse, select the Consignment 

delivery check box. 

2. In the Customer ID field, enter a customer ID or select one from the combo box. 

3. You can enter additional text in the Job field. This can be used later for filtering orders. 

4. You can also enter the customer's PO ID. This can be included in subsequent printouts. 

5. If a requested delivery date has been agreed with the customer, you can enter this date here. 

Note: You can then calculate the earliest possible delivery date in the order itself by selecting 

Calculate delivery date from the Functions menu. 

6. Click Create. 

The data you entered in the previous dialog box is now displayed in the order header. With the 

exception of the order ID, you can correct this data here if necessary. 

7. From the order lines table on the Order tab, select the item(s) you require. You can enter the 

item ID in the Resource field. A description of the item is displayed in the Description field 

when you confirm. 

To search for the item, select Go to > Find master data. 

Note: It is also possible to enter an item for which no master data exists. For more information, 

see the Enter one-off item in sales order Help topic. 
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8. In the Quantity field, enter the required quantities. The calculated unit price is displayed in the 

Price field. All group flags are taken into account here. For more information, see the Prices 

and discounts in Sales Help topic. 

9. Repeat steps 7 and 8 until you have entered all lines in the order. 

10. Select the External warehouse tab. 

Note: This tab displays the coordinates of the consignment warehouse location. If several 

consignment inventory locations exist for the customer, you can select the inventory location 

for each order line. If you do not select an inventory location, the first inventory location in the 

alphabetical sequence of available locations is posted automatically. 

11. Check whether the Area, X, Y, and Z fields contain the coordinates of the required 

consignment inventory location. If not, select these from the combo boxes in the fields. 

12. From the Functions menu, select Create document. In the dialog box that is displayed, select 

the Order confirmation option and click OK to confirm. The order confirmation is printed. 

13. Select Data and Save to save the sales order and Data and Close to close the sales order. 
 

Enter one-off item in sales order 

The general procedure for entering an order is described in the Enter sales order (page 213) topic. 

Items that are not stored in the item master data can also be entered in a sales order (see "Sales 

orders" page 212). 

Note: This description also applies for entering one-off items in the PO. 

1. Carry out steps 1-6 in the Enter sales order (page 213) Help topic. 

2. Enter the ID of the one-off item in the Resource field on the Order tab. The system then 

informs you that no master data exists for this item. 

3. Confirm this message with OK and continue entering the other line data for the sales order. 

4. When you save the order data (by selecting Data and Save), or initiate a document printout (by 

selecting Functions and Create document), the One-off items form opens. 
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5. Use the combo box in the OOIt field to select whether you want to generate a one-off item or a 

standard line item from the item. The system creates one master data record for each item that 

you defined as a one-off item or a standard item. You can retrieve and edit the master data 

records by selecting One-off items in Design or directly from the order by selecting Go to and 

Item master. 
 

Store ship-to address for order line 

A different ship-to address can be assigned to each line in the sales order (see "Sales orders" 

page 212). 

1. Open the sales order. 

2. Select View followed by Order line and then select the Documents/due dates tab. 

3. Enter the required address for the line in the Ship-to address field. 

Note: If partial deliveries are prohibited in an order, you cannot enter a different ship-to 

address for a line. Likewise, if different ship-to addresses are entered in the order lines, you 

cannot prohibit partial deliveries. 
 

Component item lines in sales order 

As a preliminary step to the planned transfer of BOR structures and lines to the sales order (see 

"Sales orders" page 212), you can enter these lines manually in the sales order. These component 

item lines are used to provide information to your customers, and they can also be used for 

pricing. 

To enter component item lines, select the CI record type for a line in the RT field on the Order tab 

of the open sales order. 

The following example shows a material line with one CI record assigned: 

The CI record is then entered in the same way as a material line. The only special point to note 

relates to the entry of the price. The price specified in the CI records depends on the calculation 

type chosen. Component item lines can be used in price calculation in five different ways. The 

component item line itself is always calculated like a material record using the following formulas: 

Net 0 = Quantity * Price 
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Net 1 = Net 0 – Discounts 

Use the COMMON.PREISRECHNUNG.VARIANTE parameter in the configuration to configure 

the effect of the calculated price on the order total. 

There are five calculation types, and these are illustrated below using simplified examples. 

Default price calculation setting (COMMON.PREISRECHNUNG.VARIANTE=0) 

In this calculation variable, no differentiation is made between material records and CI lines for 

price calculation. The value of the component item lines is added to the material price (MA line). 

This is the default setting in the configuration. 

 

Calculation: 

 Net 0 amount of the material = Quantity * Price 

 Net 0 amount of the order = Total of Net 1 amounts of MA and CI lines 

Example: 

SV

O 

Resource Net 0 Net 1 

H

R 

Customer

1 

280.- ... 

M

A 

Material1 ... 120.- 

CI Line1 ... 100.- 

CI Line2 ... 60.- 

As the component item lines are included directly in the invoice total, they are also forwarded to 

the invoice journal and taken account of in the Financials link. 

Price calculation with material reference 

(COMMON.PREISRECHNUNG.VARIANTE=1) 

In this variable, only the values from the material records are included in the order total. The prices 

of the component item lines are already included in the material prices and are only used to 

provide your customer with information. 

Calculation: 
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 Net 0 amount of the material = Quantity * Price 

 Net 0 amount of the order = Total of Net 1 amounts of MA lines 

 

Example: 

RT Resource 

MA 978-3892 

CI 978-3893 

 

Graduated price calculation (COMMON.PREISRECHNUNG.VARIANTE= 2) 

In graduated price calculation also, only the values from the material records are included in the 

order total, as in variable 1. However, unlike the previous variables, these are calculated by adding 

the component item lines together. It is assumed here that the material price can be reflected fully 

by the component item lines listed. 

 

Calculation: 

 Net 0 amount of the material = Total of Net 1 amounts of CI lines 

 Net 0 amount of the order = Total of Net 1 amounts of MA lines 

 

Example: 

RT Resource Net 0 Net 1 

HR Customer1 160.- ... 

MA Material1 160.- 160.- 

CI Line1 ... 100.- 

CI Line2 ... 60.- 
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Graduated price calculation with cost surcharge 

(COMMON.PREISRECHNUNG.VARIANTE=3) 

This variable is similar in principle to variable 2. Unlike variable 2, however, in variable 3 the total 

of component item records determines the costs of the material record, not the Net 0 value. A 

surcharge can then be calculated on the material value in the form of a profit margin, for example, 

which is determined from the price table record for Material1. Again, only the material records are 

included in the order total. 

Calculation: 

 Net 0 amount of the material = Total of Net 1 amounts of CI lines + Profit margin 

 Net 0 amount of the order = Total of Net 1 amounts of MA lines 

Example: 

RT Resource Net 0 Net 1 

HR Customer1 176.- ... 

MA Material1 160.- + 10 % 176.- 

CI Line1 ... 100.- 

CI Line2 ... 60.- 

 

Graduated price calculation with price surcharge 

(COMMON.PREISRECHNUNG.VARIANTE=4) 

In this calculation variable, the prices of the component item lines act as a surcharge on the 

initially calculated material price and therefore increase the Net 0 value. Again, only the materials 

are included in the overall order total. 

As with variable 0, it is assumed here that the material price corresponds to a basic price that may 

rise depending on the order composition. 

The component item lines listed therefore correspond to inflation surcharges. Unlike variable 0, 

this price increase should be reflected in the price of the corresponding material line as well as in 

the order total. In this way, the price increases are also taken into account in material discounts. 

Calculation: 



222 | Infor COM 7.5 User Guide 

 

Sales 

 

 Net 0 amount of the material = (Quantity * Price) + (Total of Net 1 amounts of CI lines) 

 Net 0 amount of the order = Total of Net 1 amounts of MA lines 
 

Print order confirmation 

A sales order (see "Sales orders" page 212) whose order lines are available (see Check 

availability) and for which the delivery date can be confirmed (see Calculate delivery date) can be 

confirmed to the customer by means of an order confirmation. 

The order confirmation is the document you use to confirm to the customer, in writing, the 

acceptance of a contract offer entered in the sales order (see "Sales orders" page 212). 

Note: If you print an order confirmation in the order release, the Outline agreement confirmation 

document is printed. 

1. Open the sales order. On the Open tab, enter the Order ID and confirm by clicking Load. This 

opens the order. 

2. To print the document, select Functions and Create document. 

3. In the Create document dialog box, activate the Order confirmation option in the Doc. form 

section. 

4. The Print option is set by default in the Order confirmation form section. If you select Test print, 

the order confirmation is printed but the status of the order does not change. 

5. Click OK to print the document. Alternatively, you can activate the print preview. 

6. After you print the order confirmation, the status of the order changes to Order printed. The OC 

field in the status display is now in color. 

You can only print the order confirmation once in this way. For information on how to cancel an 

order confirmation, see Cancel order confirmation (page 222). 
 

Cancel order confirmation 

If you want to reprint a printed order confirmation (see "Print order confirmation" page 222) after 

changes have been made to it, you must first cancel  the order confirmation. To do this, proceed 

as follows. 
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1. Select Functions and Edit document in the opened order. The OC status display must be filled 

in to indicate a printed order confirmation. 

2. Select the Order confirmation and Cancel options in the Edit document dialog box. 

3. Confirm with OK. 

4. Select Yes to confirm the query that appears asking you whether you really want to cancel the 

order confirmation. 

5. The order confirmation is now canceled. The OC status display is empty again after the 

cancellation. You can now print the order confirmation again as described under Print order 

confirmation. 

 

If you want to print the same order confirmation again, select Functions and Edit 

document. In the Edit document dialog box, select the Order confirmation option button 

and Repeat printout. 

Note: Prices and discounts are fixed by Infor COM when you print the order confirmation. 

If you cancel the order confirmation, and cancel the fixed price and fixed discount when 

doing this, and would like to reuse the current prices, you can use the 

COMMON.VERTRIEB.RESETPRICEFIXING=yes parameter in the Infor COM 

Management Console configuration. 
 

Archive sales order 

For details of how to archive multiple sales orders (page 212) in one batch process, see Archive 

sales orders (page 402). 

To archive an individual sales order, proceed as follows: 

1. Click Sales orders in the Sales folder. This displays the Open dialog box. 

2. In the Order ID field, enter the ID of the order to be archived. Click Load. This opens the order. 

3. Select Functions and Archive. 

If the order has not yet been closed, the system asks you whether you still want to archive the 

order. Confirm this by clicking Yes. The order is then moved to the archive database. 
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4. The order is archived under its current order ID, unless an order with that ID already exists in 

the archive database. If the ID already exists, the Save order as...to archive dialog box opens. 

The Order ID field in this dialog box automatically proposes another ID. You can, however, 

overwrite this ID. 

 

ID assignment works on the following principle : 

Sales orders are saved under their current order ID for archiving and activating. When you 

save the sales orders, the system checks whether an order with this ID already exists in 

the relevant database. If this is the case, the system automatically proposes a different ID. 

You can accept this order ID or assign your own, which you can then use to archive or 

activate the order. 

The following cases illustrate the concept that the system uses to assign order IDs. 

ID assignment during archiving 

 Case 1: The ID of the order to be archived is 1000. An order with this ID does not exist in 

the archive database. Therefore, the order is saved to the archive database with the ID 

1000. 

 Case 2: The ID of the order to be archived is 1000. However, an order with this ID already 

exists in the archive database. The order is saved to the archive database with the ID 

1000-1. 

 Case 3: The ID of the order to be archived is 1000. Two orders with the IDs 1000 and 

1000-1 already exist in the archive database. Therefore, the order is saved to the archive 

database with the ID 1000-2. 

 Case 4: The ID of the order to be archived is 1000-1. However, an order with this ID 

already exists in the archive database. The order is saved to the archive database with the 

ID 1000-1-1. 

 Case 5: The ID of the order to be archived is 1000-1. However, an order with this ID and 

an order with the ID 1000-1-1 already exist in the archive database. Therefore, the order is 

saved to the archive database with the ID 1000-1-2. 

As you can see, a sequential ID is simply added to the original order ID to retain the 

reference to the source record. 

 

ID assignment during activation 

 Case 1: The ID of the relevant order from the archive is 1000. An order with this ID does 

not exist in the movement data. The ID of the order generated by the activation is also 

1000. 

 Case 2: The ID of the relevant order from the archive is 1000. An order with this ID already 

exists in the movement data. The ID of the order generated by the activation is 1000-1. 



Infor COM 7.5 User Guide | 225 

 

Sales 

 

 Case 3: The ID of the relevant order from the archive is 1000. Two orders with the IDs 

1000 and 1000-1 already exist in the movement data. The ID of the order generated by the 

activation is 1000-2. This type of situation can occur if an order was already generated 

from the archive order with ID 1000 and it was assigned the ID 1000-1. 

 Case 4: The ID of the relevant order from the archive is 1000-1. However, an order with 

this ID already exists in the movement data. The ID of the order generated by the 

activation is 1000-1-1. This type of situation can occur if an order was already generated 

from the archive order with ID 1000-1 and it was assigned the ID 1000-1. 

As you can see, a sequential ID is simply added to the original order ID to retain the 

reference to the source record. 

 

Before you print documents and confirm due dates, you can check whether the items can 

be delivered on the requested delivery date. 

You can include the warehouse inventory, the planned POs, and the manufacturing 

workload in this check. 

Depending on how accurate you want the check to be, you can use one of the functions (in 

the Functions menu). 

To print the document, select Functions and Create document. 
 

Close sales order 

You need to close a sales order (see "Sales orders" page 212) before you can delete it. If you do 

not close the order manually, the system displays a prompt and automatically closes it before 

deletion. 

Note: You can only close sales orders for items with fixed requirement allocations if the fixed 

requirement allocation has already been canceled. 

1. Select Functions and Close in the order. 

2. Confirm the query that is displayed with Yes. 

The status of the order is set to Closed manually. 

You can then delete (see "Delete sales order" page 226) the order. 
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Delete sales order 

Sales orders (page 212) that are no longer required in the movement data can be deleted. To be 

able to delete an order, you must first close (see "Close sales order" page 225) it. 

If you try to delete an order that has not yet been closed, a dialog box opens up displaying some of 

the data from the order to be deleted. If you confirm this dialog box by selecting OK, the order is 

closed automatically and then deleted. 

To delete an order, proceed as follows: 

1. Select Data and Delete from the order. 

2. The subsequent dialog box displays some of the fields from the order to be deleted and 

requires confirmation. 

3. Click OK to confirm the dialog box. 
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Advance shipping notices (ASN) 

For general information on order processing (page 207), see the corresponding topic. 

Call 

Sales > Order processing > Advance shipping notices 

Description 

The ASN provides notification of the goods shipment by the supplier. The ASN contains details of 

the delivery, such as quantity, item description, and terms of delivery. 

Several checks are performed when you print an advance shipping notice: 

 If deliveries have been prohibited for a customer (configurable in the company master), a 

message is displayed on the screen. You can print the advance shipping notice if you 

expressly confirm this in the dialog box. 

 Has the minimum delivery value specified in the company master been reached? If not, the 

advance shipping notice is not printed. 

 The following checks are carried out for partial deliveries: 

 A check is run to determine whether partial deliveries are prohibited in the company 

master. This is displayed in the ASN header using the Part.del. prohib. check box and can 

be changed manually. Otherwise nothing is printed. 

 A check is run to determine whether the minimum delivery percentage set in the 

configuration has been reached. For further information, see Print partial advance shipping 

notice (ASN) (page 234). 

In the configuration, you can use the COMMON.VERTRIEB.MINLIEFPROZ=0,000 parameter 

(default setting) to configure whether a minimum delivery percentage (based on quantity) must 

generally be observed for partial deliveries. If a partial delivery is received and the delivery 

quantity is below the specified percentage based on the total quantity, the system issues an error 

message. 

 For consolidated deliveries, the system checks whether the option of consolidated deliveries is 

stored in the company master. If not, this must be changed manually in the advance shipping 

notice. Otherwise, the advance shipping notice is not printed. 
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Configuration 

COMMON.VERTRIEB.MINLIEFWERT 

COMMON.VERTRIEB.AUTOENTNAHME 

Functions 

You can use the Availability check function to check whether the lines required for delivery are 

available in inventory. 

Maintain shipment tracking details: If you are working with an e-shop link, you can publish 

shipment tracking information via the e-Commerce link. 

There are two ways of storing this information in Infor COM: 

 From a loaded advance shipping notice 

 From a loaded sales order 

You can access this process from both locations via Functions > Maintain shipment tracking 

details. 

For each advance shipping notice, you can store as many shipment IDs with a shipment tracking 

link as you require. 

Note: No syntax checks are carried out. 

Create and cancel advance shipping notice (ASN) with issue 

You can create and print an advance shipping notice (see "Advance shipping notices (ASN)" page 

227) from a sales order (see "Sales orders" page 212). 

For general information on advance shipping notices, click here (see "Advance shipping notices 

(ASN)" page 227). 

The following steps describe how to create an advance shipping notice, how to check the 

availability and inventory movements of the material to be delivered, and how to cancel the 

advance shipping notice. 

1. Select Sales > Order processing > Sales orders. Enter the customer ID on the New tab and 

click Create. 
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2. On the Order tab, select the required data in the Resource and Quantity fields and select 

Functions > Check availability to determine whether the items are available for the order. 

Note: Select Go to > Inventory information to view detailed information on the warehouse 

inventory for the item at different warehouse addresses. 

3. Select Functions and Create document.In the Create document dialog box, select the Issue 

document option in the Doc. form section and the ASN with issue option in the Issue document 

form section, and then click OK. 

Note: Instead of ASN with issue, select the ASN option in order to edit the advance shipping 

notice in goods issue in Inventory. 

Use the Issue list list box to specify whether an issue list is to be generated. 

4. Confirm the subsequent dialog box with OK. 

When the advance shipping notice is printed, the status of the order changes to Issue. An 

inventory movement from the source inventory location to the goods issue location is carried 

out in Infor COM. 

Note: You can check the issued batch-tracked inventory by selecting Go to > Inventory 

information. 

5. Select Functions > Edit document. 

6. In the Edit document dialog box, select the ASN and Cancel options, click OK and then, in the 

dialog box that is subsequently displayed, click Yes to confirm. 

The canceled quantity is posted back to the original source inventory location. 

7. Select Inventory > Information > Inventory journal. On the Open tab, enter the document ID of 

the advance shipping notice that was created and click OK. 

You can view the inventory movements that took place on the Transaction tab. 
 

Create advance shipping notice (ASN) with manual issue 

For general information on advance shipping notices, click here (see "Advance shipping notices 

(ASN)" page 227). 

The Create and cancel advance shipping notice (ASN) with issue (page 228) Help topic describes 

how to create an advance shipping notice with automatic goods issue. 

This current Help topic describes how to create an advance shipping notice and then manually 

carry out the goods issue in Inventory. 
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1. Select Sales > Order processing > Sales orders. Enter the customer ID on the New tab and 

click Create. 

2. On the Order tab, select the required data in the Resource and Quantity fields and select 

Functions > Check availability to determine whether the items are available for the order. 

Note: Select Go to > Inventory information to view detailed information on the warehouse 

inventory for the item at different warehouse addresses. 

3. Select Functions and Create document.In the Create document dialog box, select the Issue 

document option in the Doc. form section and the ASN option in the Issue document section. 

4. Click OK. In the dialog box that is then displayed, enter the required ID for the advance 

shipping notice and click OK to confirm the dialog box. 

5. Select Inventory > Goods issue > Sales issue. Enter the ASN ID on the Open tab and click 

Load. 

6. Select Functions > Full inventory issue to set posting ID 171 for all lines. 

7. Select Functions > Post. 

The status of the advance shipping notice is set to Issue. 

8. Select Inventory > Information > Inventory journal. On the Open tab, enter the required criteria 

and click Load to confirm. You can then check the listed inventory movements. 
 

Create advance shipping notice (ASN) with issue list and manual issue 

1. Select Sales > Order processing > Sales orders. Enter the customer ID on the New tab and 

click Create. 

2. On the Order tab, select the required data in the Resource and Quantity fields and select 

Functions > Check availability to determine whether the items are available for the order. 

Note: Select Go to > Inventory information to view detailed information on the warehouse 

inventory for the item at different warehouse addresses. 

3. Select Functions and Create document. 

4. Select the options Issue document and ASN. In the Issue list list box, select the Generate 

manually entry and click OK. 

5. Enter the ASN ID in the dialog box that is displayed and then click OK. 
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6. Select Go to > Inventory information > All addresses and click F3 to expand the view for the 

current line. 

The batch-tracked inventory that is being moved to the goods issue location is displayed. 

7. Select Inventory > Goods issue > Issue lists. On the New tab, select the ID of the created 

advance shipping notice in the Document ID field and click Create. 

8. Select Functions > Print list and confirm the dialog box that is displayed with OK. 

9. Select Functions > Release to release the list. 

The Movement status is set to Completed. 

10. Select Inventory > Goods issue > Sales issue. Enter the ASN ID on the Open tab and click 

Load. 

11. Select Functions > Full inventory issue to set posting ID 171 for all lines. 

12. Select Functions > Post. 

 
 

Create and post pick list 

1. Select Sales > Order processing > Sales orders. Enter the customer ID on the New tab and 

click Create. 

2. On the Order tab, select the required data in the Resource and Quantity fields and select 

Functions > Check availability to determine whether the items are available for the order. 

Note: Select Go to > Inventory information to view detailed information on the warehouse 

inventory for the item at different warehouse addresses. 

3. Select Functions and Create document. 

4. Select the Issue document and Pick list options and click OK. 

5. Select Inventory > Goods issue > Sales issue. In the Open dialog box, select the Pick list 

option, select the Order ID of the pick list just created and click Load. 

6. Select Functions > Full inventory issue and then select the Manual specification check box on 

the Inventory tab. 

7. Double-click the row header of the required line in order to enter batch-tracked inventory. 
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8. Select Functions > Reload batch-tracked inventory. In the dialog box that is then displayed, 

enter the data for the batch-tracked inventory to be entered and click OK. 

Note: Alternatively, you can also scan the batch-tracked inventory to be entered. 

9. Select View > ASN and then Functions > Post. 

The advance shipping notice is printed, the inventory is moved from the source inventory 

location to the goods issue location, and the goods are issued from the goods issue location. 

10. Select Inventory > Information > Inventory journal to check the postings. 
 

Automatically assign serialized and batch IDs 

Please note: In these step-by-step instructions, the items entered in the sales order must be 

serialized/batch items. 

1. Select Sales > Order processing > Sales orders. Enter the customer ID on the New tab and 

click Create. 

2. On the Order tab, select the required data in the Resource and Quantity fields and select 

Functions > Check availability to determine whether the items are available for the order. 

Note: Select Go to > Inventory information to view detailed information on the warehouse 

inventory for the item at different warehouse addresses. 

3. Select Functions and Create document. 

4. Select Issue document and ASN. In the Issue list list box, select the Generate automatically 

option and click OK. 

5. Select Inventory > Goods issue > Issue lists. Enter the order ID on the Open tab and click 

Load. 

6. Switch to the Issue list view and select the Properties tab. Check the assigned serialized/batch 

IDs of the issue list. 

7. Select Inventory > Goods issue > Sales issue. Enter the order ID on the Open tab and click 

OK. 

8. Select Functions > Full inventory issue. Enter the Trans. qty on the Transaction tab and click 

OK. 

9. Select Functions > Post. 
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Print advance shipping notice for consignment delivery 

The following overview describes how to generate and print an advance shipping notice for a 

delivery to a customer consignment warehouse. You can do this in the underlying sales order 

(Sales orders object), or in the Advance shipping notices object (Sales > Order processing). 

There are two options available for printing advance shipping notices. For detailed step-by-step 

instructions, see Print advance shipping notice for consignment delivery. 

Advance shipping notice without issue ASN with issue 

When you print an advance shipping notice 

without issue, the goods are transferred from your 

current inventory location to the defined goods 

issue location. Before printing the advance 

shipping notice, you can also select whether you 

want to work with an issue list (see "Movement 

lists" page 1049). Once the advance shipping 

notice is printed, the relevant batch-tracked 

inventory is automatically reserved for the 

underlying sales order and is assigned the 

reservation status Consignment-reserved. This 

batch-tracked inventory is no longer be available 

for other issues. 

It's also possible to print advance shipping 

notices with the simultaneous issue of 

batch-tracked inventory (ASN with issue 

option). In contrast to printing advance 

shipping notices without issues (see 

above), the difference here is that the 

batch-tracked inventory is transferred from 

your current inventory location to the 

consignment inventory location directly. In 

addition, the Generate and release 

automatically option is the only option 

available if you're working with an issue 

list. 

 

If an advance shipping notice was printed without issue, you need to manually post the transfer of 

goods from the goods issue location to the consignment inventory location. To do this, select 

Inventory > Goods issue > Sales issue and use posting ID 173 Move to consignment. 

 For more information, see Transfer batch-tracked inventory to a customer consignment 

warehouse (page 1079). 

Note:  

 If you are working with an issue list (see previous point), you must release this list first. 

 You must transfer the full advance shipping notice quantity. It is not possible to transfer a 

smaller or larger quantity. 
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 The External coordinates tab in Sales issue displays the consignment inventory location(s) 

specified beforehand in the sales order. You cannot make any changes here. 

 If the advance shipping notice is canceled after the transfer to the consignment inventory 

location, the relevant batch-tracked inventory is automatically posted back to the original 

batch-tracked inventory (using posting ID 174). 

 After the transfer to the customer consignment warehouse, the batch-tracked inventory is 

assigned the status Transferred and is now reserved for the sales order. The status of the 

sales order is set to Issue. This status also permits the reservation of batch-tracked inventory 

located at the consignment warehouse of the relevant customer.  

 For more information, see Reservations in customer consignment warehouses (see "Create 
reservations in customer consignment warehouse" page 1071). 

 From a posting point of view, the process is evaluated as a transfer. 

 

Provided the goods have not yet been issued from the consignment inventory location, you can 

also carry out the following actions: 

 Carry out inventory adjustments (see "Inventory adjustment" page 1188) 

 Transfer (page 1125) batch-tracked inventory or partial batch-tracked inventory quantities to 

and from customer consignment warehouses. Note that batch-tracked inventory transferred 

from a customer consignment warehouse will, of course, no longer be available for 

subsequent issues from this warehouse. Instead, transfers allow goods that were not accepted 

by the customer to be posted back to your own warehouse. 

 Using the Inventory count lists (page 1178) object, you can increase the inventory at a 

customer consignment warehouse as part of an inventory count. 

 
 

Print partial advance shipping notice (ASN) 

For general information on advance shipping notices (see "Advance shipping notices (ASN)" page 

227), see the corresponding Help topic. 

If an order is not to be delivered in full or cannot be delivered in full, you can make partial 

deliveries. 

Note: Refer to the restrictions outlined under Advance shipping notices (ASN) (page 227). 

1. Select Sales > Order processing > Sales orders. On the Open tab, enter the data of the sales 

order for which the partial advance shipping notice is to be printed and click Load to confirm. 

2. Select Functions and Create document. 

3. Select Issue document in the Doc. section and then click the Edit button. 
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4. Then enter the quantities for the partial delivery of a line in the ASN qty field on the ASN tab.  

If individual lines are to be delivered, hold down the CTRL key and select the lines by clicking 

the respective row headers. 

Note: If the No PD check box in the row is selected, the line is blocked for partial deliveries. 

5. Then select  Functions and Create document  

and choose ASN or ASN with issue, as appropriate. Select the required options and confirm 

that you want to create the document. 

6. Partial delivery records are created as a result of the partial delivery. 

Select Functions and Advance shipping notice (ASN) overview to display the partial deliveries 

to date. 

7. You can check the delivered quantities and the quantities issued from the warehouse on the 

Actual quantities tab. 
 

Print shipping documents 

For general information on advance shipping notices (see "Advance shipping notices (ASN)" page 

227), see the corresponding Help topic. 

You can print shipping documents and reports for the shipping materials entered. 

Before printing, you should specify the names of the reports to be printed in the following locations: 

 You store the name of the report for shipping material labels in the Addform field for the 

shipping material. The number of labels printed is determined by the number specified in the 

Number field on the Shipping materials tab. 

 For packing lists, bills of lading and additional forms, assign the report names on the 

Documents/costs tab in the Document header view. 

Note:  If you do not enter names for the reports, Infor COM assigns the standard form to the 

packing list and bill of lading. Shipping material labels and additional forms are not displayed. 

 For the packing list, the entry from COMMONSTD is preset as the default report name. You 

cannot print until the shipping material assignment is complete. For the bill of lading, you can 

store a form in the Form ID field in the SPEDIT allocation table. 

The additional form is only needed if you need to print a second form, as there are two 

different carriers, for example. The name of the additional form must be entered manually. 

For newly created advance shipping notices, complete the following steps when printing shipping 

documents: 
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1. Select Sales > Order processing > Advance shipping notices. Complete the fields on the New 

tab and click Create to confirm. 

2. Select Functions> Create document. In the dialog box that is displayed, select the ASN or ASN 

+ issue options as well as the Shipping documents option. 

All shipping documents are printed together with the advance shipping notice. 

For existing advance shipping notices, complete the following steps: 

1. Select Sales > Order processing > Advance shipping notices. Complete the fields on the Open 

tab and click Load. 

2. Select Functions and Create document. Select the Shipping documents or Packing list 

options. 

Note: Shipping documents here refer to labels, bills of lading, and additional forms. 

The shipping documents are not stored as documents and therefore do not have a document ID. 
 

Print consolidated advance shipping notice (ASN) 

For general information on advance shipping notices (see "Advance shipping notices (ASN)" page 

227), see the corresponding Help topic. 

Consolidated ASNs can be printed if lines from several different orders for a customer are grouped 

together in one advance shipping notice. 

Note: Refer to the restrictions outlined under Advance shipping notices (ASN) (page 227). 

1. In Sales, click the Order processing folder, select Advance shipping notices, and click the New 

tab. If required, you can overwrite the advance shipping notice ID that is proposed. 

2. Select the Customer description or Customer ID from the combo box, or enter it directly. Click 

Create to confirm. 

3. All lines for which there are outstanding deliveries to the customer are loaded. The 

corresponding order IDs are displayed on the Document IDs 1 tab. 

Note: In the event that not all outstanding lines are displayed, check whether the 

Consolidated ASN check box is selected in the sales order in question  (Order header view, 

Texts/conditions tab). 

An advance shipping notice for the lines to be loaded should not have been printed yet. 
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4. You can create the advance shipping notice automatically with the available quantities: 

Select Functions and Check availability to transfer the inventory available in the warehouse to 

the ASN qty field. If the line can be covered using warehouse inventory, the outstanding 

quantity is entered in the ASN qty field. If the outstanding quantity is not available, the quantity 

of available items is used. 

5. For partial delivery of a line, manually enter the partial quantity in the ASN qty field for that line. 

Note: If the No PD check box is selected for the line, the line is blocked for partial deliveries. 

If individual lines are not to be delivered, select all lines except for these. To do this, hold down 

the CTRL key and click the ID list of the respective lines. Lines not selected are not transferred 

to the consolidated ASN when you create the ASN. 

Warning: Do not delete the row from the ASN, as this would delete the line from the order. 

6. Select Functions and Create document to print the consolidated advance shipping notice. This 

opens the Create document dialog box. 

7. Click OK to start printing the consolidated ASN. All available lines are transferred to the 

consolidated ASN by default. 

Note: Alternatively, you can select individual order lines for the consolidated ASN by clicking 

the number in the row header. If you hold down the CTRL key as you click, you can also select 

individual order lines for document printing. 

For details of how to select the form (report) for printing a consolidated ASN, see Select report 

for consolidated advance shipping notice (ASN) (see "Define report for consolidated advance 

shipping notice (ASN)" page 237). 
 

Define report for consolidated advance shipping notice (ASN) 

For general information on advance shipping notices (see "Advance shipping notices (ASN)" page 

227), see the corresponding Help topic. 

Using a consolidated ASN (see "Print consolidated advance shipping notice (ASN)" page 236) as 

an example, this topic describes how to select reports (forms) in Sales when printing consolidated 

documents. 

1. Select Sales > Order processing > Advance shipping notices. Enter the ASN data on the Open 

tab and click Load. 
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2. Select View > Advance shipping notice (ASN) header and then select the Documents/costs 

tab. 

3. Enter the required form ID for the advance shipping notice in the Form ID column. 

This setting determines which report will be selected for the consolidated document. 

 If a standard document is selected as an ASN, the standard document is also used for the 

consolidated ASN. Infor COM automatically selects the document for ASN printing in this 

case. There is no way for you to explicitly configure a document for the consolidated ASN. 

The consolidated document suffix is not considered in the case of standard documents. 

Note: The system identifies standard documents by their name, as long as this has not 

been changed by the user. 

 If a report created by the user is specified as an ASN report, the system searches for the 

corresponding report for the consolidated document by name when printing the 

consolidated ASN. 

The following naming conventions apply. 
The name of a report created by the user must have the following structure: 

<Name of the consolidated ASN report> + <Suffix from the configuration>. 

Example: The ASN report created by the user is called irSalesDN. The suffix S is specified 

in the configuration. When printing a consolidated ASN, the program searches for a report 

called irSalesDNS. 

The report must therefore exist under this name. For details of how to create your own 

report, see Create reports for consolidated documents in Sales (see "Create reports for 
consolidated documents" page 114). 

Notes: 

 The names of the consolidated documents in Purchasing and Sales must not exceed 11 

characters. Therefore, the names for the consolidated documents and corresponding 

individual documents must be chosen so that the combination of the name of the individual 
document and the suffix is no longer than 11 characters. 

 In addition, the suffix cannot be a character that is already being used as the last character 

in the name of the individual document. 
 

Print advance shipping notice (ASN) with issue list 

For general information on advance shipping notices, click here (see "Advance shipping notices 

(ASN)" page 227). 

This Help topic describes how to create and print advance shipping notices with issue lists. 

1. Select Sales > Order processing > Sales orders. Enter the customer ID on the New tab and 

click Create. 
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2. On the Order tab, enter the required data in the Resource and Quantity fields and then select 

Functions and Create document. 

3. In the Create document dialog box, select the Issue document option in the Doc. form section 

and the ASN option in the Issue document form section. Set the Generate manually option in 

the Issue list section. 

4. Click OK and also confirm the dialog box that is displayed with OK. 

Note: Select Go to > Inventory information > Warehouse address to view the intended 

movement of batch-tracked inventory for the selected line. 

The issue list can now only be manually generated and released by selecting Inventory > 

Goods issue > Issue lists. 

5. Create the issue list by selecting Inventory > Goods issue > Issue lists and select Functions > 

Release. 

The item batch-tracked inventory of the issue list is not at the goods issue inventory location. 

 



240 | Infor COM 7.5 User Guide 

 

Sales 

 

Invoices 

For general information on order processing (page 207), see the corresponding topic. 

You use an invoice to bill the customer for your service. When the invoice is printed depends on 

the particular business transaction. The invoice is generally printed after the ASN has been 

created and the goods have been shipped. 

If the status is Partial issue, a partial invoice for the lines already delivered is printed when you 

start invoice printing. 

For a process description for printing invoices, see Print invoices (page 388). 
 

Print and cancel invoice 

For information on invoices, click here (see "Invoices" page 240). 

Invoice printing in Infor COM includes printing of partial invoices, consolidated invoices, and pro 

forma invoices. 

You usually print an invoice from the open sales order. You can access the sales order in Sales in 

the Order processing folder by selecting Sales orders. 

1. Click Sales orders in Sales. In the dialog box on the Open tab, enter the order ID and click 

Load. 

2. To print a document, select  

Functions and Create document. 

3. In the Create document dialog box, select Invoice and Print. 

4. Click OK to print. 

5. After the invoice is printed, the order status changes to Invoice printed. 

The invoice then appears in the invoice journal. 

Note: The invoice can only be printed once in this way. If you need to reprint the invoice after 

making changes, you must first cancel the printed invoice as follows: 

6. In the open sales order, select Functions and Edit document. 

7. Select Invoice and Cancel in the dialog box. Confirm your selection by clicking OK. 
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8. Click Yes to confirm that you want to cancel the invoice. 

9. The Print dialog box opens. The system proposes a document ID for the credit memo, but you 

may overwrite this if you need to. Confirm by clicking OK. 

10. If you want to print the same invoice again, select Functions and Edit document from the 

menu. In the dialog box that displays, select Invoice and Reprint. 
 

Print consolidated invoice 

For information on invoices, click here (see "Invoices" page 240). 

By creating a consolidated invoice in Sales, you can combine the lines from multiple sales orders 

into one invoice and transfer them to the invoice journal. 

1. In Sales, click the Order processing folder, select Invoices, and click the New tab. 

2. Select the customer using the customer ID or name from the relevant combo box in the 

corresponding fields of the dialog box on the New tab. Confirm with OK. The invoice form 

opens. 

Note: Alternatively, you can also create an invoice for individual orders from the customer and 

subsequently reload further lines from other orders by selecting Data and Reload. 

3. All lines with the status Issue or Partial issue in the selected customer's orders are displayed in 

the table. You can now make any necessary changes. 

Select the lines you want to include. To do this, hold down the CTRL key and click the ID fields 

of the lines. Lines that are not selected are not transferred to the consolidated invoice. 

4. To print, select Functions and Create document. Select the Invoice option and click OK to 

confirm. 
 

Print partial invoice 

For information on invoices, click here (see "Invoices" page 240). 

If an order has been partially delivered (that is, its status is Partial issue (see Print partial advance 

shipping notice (ASN) (page 234)), a partial invoice can be printed. To do this, proceed as follows. 
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1. You can load the sales order in Sales by clicking the Order processing folder and selecting 

Sales orders. This displays the Open tab. 

2. Enter the ID of the order in question in the Order ID field or select it from the combo box. 

Confirm by clicking Load. The sales order is loaded. 

3. To open the Create document dialog box, select Functions and Create document. The Invoice 

and Print options are selected by default. 

4. Click OK to start invoice printing. The invoice includes the lines with their delivered quantities. 

You can also print invoices directly: 

1. Click Invoices in the Order processing folder in Sales. 

2. Click the New tab. 

3. Enter an ID in the Invoice ID field. 

If you select an order ID or advance shipping notice ID and click Create, the lines are 

displayed with the previously delivered quantities and those yet to be calculated. You can still 

make changes to the prices on the Invoice tab. 

4. To open the Create document dialog box, select Functions and Create document. The Invoice 

option is set by default. 
 

Pro forma invoice 

For information on invoices, click here (see "Invoices" page 240). 

Pro forma invoices are certificate invoices that are required together with other export documents 

in foreign trade, especially by importers, and in some cases by the relevant authorities (among 

others) with regard to exchange rate stipulations. 

However, pro forma invoices can also be used for new international customers to whom deliveries 

can only be made following prepayment. 

Pro forma invoices are printed before the actual invoices. If the status of the sales order is Invoice 

printed, a pro forma invoice can no longer be created. 

No invoice IDs are assigned for pro forma invoices. The order status does not change when you 

print a pro forma invoice. Payment plans are not printed on pro forma invoices. They only contain 

the material lines. 
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You can print a pro forma invoice directly from the order by selecting Functions and Create 

document, or by selecting Invoices. 

 



244 | Infor COM 7.5 User Guide 

 

Sales 

 

Print pro forma invoice 

This Help topic describes how to print a pro forma invoice (page 242) in Sales from the order or 

from the invoices. 

Printing in the order 

1. Load the sales order for which you want to print the pro forma invoice. To do so, open the 

Order processing folder in Sales and select Sales orders. In the dialog box on the Open  tab, 

enter the order ID, and select Load to confirm your entry. 

2. In the order, select Functions and Create document. This opens the Create document dialog 

box. 

3. Select the Invoice check box in the Doc. form section and the Pro forma invoice check box in 

the Invoice form section. 

4. Start document printing with OK, or click the Preview button to display the pro forma invoice on 

the screen before printing. 

Printing in the invoice 

1. In Sales, click the Order processing folder and select Invoices. Click the New tab. Enter the 

order ID of the order for which the pro forma invoice should be generated. 

2. Select Functions and Create document. This opens the Create document dialog box. 

3. Activate the Pro forma invoice option and confirm with OK, or select Preview to see a print 

preview. 
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Special invoicing 

A special invoice corresponds to a sale without an advance shipping notice and issue posting 

(Example: sale of services). 

A special invoice completely bypasses inventory. You can print an invoice from the sales order 

(Status: Sales order) immediately using the Special invoicing option (see Special invoice, create 

document (see "Perform special invoicing" page 245)). This option is only displayed if the special 

invoice is released. For more information, see the Help topic for the 

COMMON.VERTRIEB.SONDERFAKTURA parameter in the configuration. Special invoices are 

permitted for the entire order and at line level. 

However, it is not possible to invoice a partial quantity using a standard invoice and the remainder 

using a special invoice. 

The invoice is included in the invoice journal and is transferred to Financial accounting. 

There are no special points to note regarding the Intrastat settings. 
 

Perform special invoicing 

To perform special invoicing (page 245), proceed as follows: 

1. Create a sales order. 

2. Select Functions and Create document. 

3. Select Invoice in the Doc. form section. 

4. Select Special invoicing in the Invoice form section (this option is only available if this function 

is enabled). 

5. Start invoice printing with OK. 

 

Please note: The planned quantity is not set to zero on the Texts/details tab in the Order 

line view after invoice printing. 

As a result, this order still appears in the item account even though an invoice has already 

been printed. 

Special invoicing is disabled by default. 
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Inpayment slips 

For information on invoices, click here (see "Invoices" page 240). 

The ISR configuration is used to define country-specific customizations for Switzerland. Swiss 

users should refer to the separate Help for the localized Swiss version. You can find this by 

entering the keyword "Country-specific customizations for Switzerland". If this Help is not 

available, please contact your consultant. 

For Swiss customers, you can print inpayment slips with reference number (ISR) in accordance 

with the ISR procedure. The ISR procedure is a payment procedure of the Swiss post for 

inpayments made to post accounts using inpayment slips with reference number. An ISR is an 

inpayment slip of the Swiss post you can use to transfer money to a post account. The inpayment 

slip contains a machine-readable code line consisting of a participant ID and a reference number. 

The participant ID identifies the account holder (final recipient of the payment) at the post. The 

reference number is used to identify the paying party and the invoice paid to the account holder 

(final recipient of the payment). In this way the entire payment procedure, from the moment of the 

inpayment to the posting of the amount at payment recipient's account, is handled electronically. 
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Credit memos 

For general information on order processing (page 207), see the corresponding topic. 

Infor COM offers two ways of issuing a credit memo to a customer, for example for an incorrect 

delivery. The third possible method is described under Received credit memos (page 247). 

 The system generates credit memos automatically when you create a credit memo document 

by issuing a cancellation from a sales document. 

 Select Credit memos and New to enter credit memos manually. See Print and cancel credit 

memos (page 247). 
 

Print and cancel credit memos 

The following sections show you the two ways in which you can create credit memos (page 247). 

 Generate credit memo from cancellation 

 Generate credit memo manually 

 Display credit memos 

 Cancel manually generated credit memos 

 
 

Received credit memos 

For general information on order processing (page 207), see the corresponding topic. 

You can only create received credit memos for customers if the Credit memo check box has been 

selected on the External customer data tab in the company master data. For detailed information 

on this topic, see Credit memo procedure. 

If the Credit memo check box in the company master data is selected, an internal invoice is 

automatically created when the advance shipping notice or the invoice is created. As soon as the 

credit memo is received from the customer, enter it using the dialog box described here. The credit 

memo you enter is automatically compared with the internal invoice. You can enter multiple credit 

memos for the same internal invoice. 
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Note: When creating a new invoice, you can also generate an internal invoice manually by 

selecting the Internal invoice check box. 
 

Invoice journal 

For general information on order processing (page 207), see the corresponding topic. 

The approved (in Purchasing) or printed  (in Sales) invoices are recorded in an invoice journal 

and can be documented by printing a report. The data from the invoice journal can be transferred 

to Financial accounting. 

If data is transferred to Financial accounting using the invoice journal, make sure that the records 

transferred to the invoice journal contain accounts. You must enter these accounts in the master 

record (customer, supplier, item). 

Please note: You cannot print invoices in Sales or approve invoices in Purchasing without the 

accounts entered in the master data. 

Interfaces to the Varial Guide, Varial Plus, Datev, and Profib financial accounting systems are 

included as standard. Please contact us for information about additional interfaces. 
 

Record types (invoice journal) 

For information on the invoice journal (page 248), see the corresponding Help topic. The following 

table shows an overview of the record types for Purchasing and Sales that are contained in the 

invoice journal (see also Record types (Sales) (page 115)). 

Record type Description 

CM This record type shows the lines for canceled invoices or credit memos that were entered 

manually. 

DH The DH line is the header record of the order: 

Customer in the sales order 

Supplier in the PO 

HR The item lines of the purchase order are flagged HR. 

MA This record type shows the item lines from the Sales order. 
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Reports (Sales) 

For general information on order processing (page 207), see the corresponding topic. 

Please note: Report names are always structured as follows: ir<module><report name>. For 

more information on the reports not found in this Help topic, see the Help topics for the reports for 

the modules concerned. 

In the Sales module, open the Order processing folder and click Reports. This opens the Report 

overview dialog box. 

Note: You can influence the displayed lists by assigning user privileges. 

This dialog box provides you with access to a number of reports in Sales. These reports make 

sales-relevant data records, according to the criteria selected by you, available in list form as a 

printout. 
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Report Contents 

Rejected quotes This report lists all rejected quotes by reason for rejection. 

Invoice reconciliation report - 

Credit memos 

A report is available here for customers with credit memo procedures that 

prints the reconciliation between the credit memos expected and those 

actually received. 

Quotes by 

order probability 

This report lists all quotes sorted by order probability. 

Quotes on hand The Quotes on hand report shows open quotes, including lines. 

Draft quote This report contains an overview of all quotes with their basic conditions, 

the binding period of the quote, and an estimate of the order probability. 

Archived sales orders 

by order 

This report lists archived sales orders by order ID. 

Archived sales orders 

by customer 

This report lists archived sales orders by customer. 

Orders on hand by 

item group flag 

This report lists existing orders sorted by item group flag. 

Orders on hand by 

item 

This report lists existing orders sorted by item. 

Orders on hand by 

customer 

This report lists existing orders sorted by customer. 

Missing feedback transactions 

 on certificates of entry 

This report lists certificates of entry for which feedback has not been 

entered but for which an invoice already exists. 

Quotes specified in 

order 

This report lists the quotes transferred to an order. 

Pick list sorted by customer Sorted by customer, this pick list catalogs all lines in an order that have 

available inventory and can therefore be issued from the warehouse. 

Pick list sorted by 

warehouse 

Sorted by warehouse, this pick list catalogs all lines in an order that have 

available inventory and can therefore be issued from the warehouse. 

Customer overview This report provides an overview of customers created, including contacts. 

Advanced shipping notices without 

certificates of entry 

This report issues all issued advance shipping notices that correspond to 

intra-EU deliveries but do not have certificates of entry. 

Outstanding issues This report lists the advance shipping notices with outstanding issues. 

Outstanding deliveries 

by order 

This report lists outstanding deliveries sorted by order. 

Outstanding deliveries 

by customer 

This report lists outstanding deliveries sorted by customer. 
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Report Contents 

Outstanding invoices 

by order 

This report lists outstanding invoices sorted by order. 

Outstanding invoices 

by customer 

This report lists outstanding invoices sorted by customer. 

Price list This report produces a price list for the period specified in the Due date 

field. 

Price list (date-specific) This list shows all prices that were valid at the date specified in the Price 

list printout selection window. 

Note: The report only shows prices that were entered for a company, that 

is, for which a company ID is stored in the price master data. 

Price list with period, 

customer and record selection 

This report produces a price list sorted by record type for the period 

specified in the Due date field. 

Commission calculation, 

representative 1 

This report lists the commission calculation for representative 1. 

Commission calculation, 

representative 2 

This report lists the commission calculation for representative 2. 

Invoice journal This report shows the invoices in the invoice journal, including details. 

Invoice journal - consolidated This report outputs the invoice journal in a compact form. The individual 

lines of an invoice are not of importance here. Only the invoice total of a 

customer is of interest. 

Invoice journal report This report lists all invoices in the invoice journal. 

Reply overview for all mass mailings 

(abbreviated) 

This report gives an overview of the replies to mass mailings. 

Returns This report provides an overview of all generated, accepted, and rejected 

returns. 

Sales revenue target by customer for 

current year 

These reports evaluate the annual revenues in view of the specified sales 

target/bonus. A prerequisite is that the Sales target and Sales bonus 

values and the Sales bonus flag in the company master data have been 

filled in for the customer. 

Sales revenue target by customer for 

previous year 

The same applies as for the Sales revenue target by customer for 

current year - but based on the previous year. 

Address overview All recorded company addresses including contacts and telephone 

numbers are listed. 

Sales order 

overview 

This report lists sales orders together with order lines and the order total. 

Sales price list Like Item-specific price list. However, you cannot sort the sales price 

list by record type. It only refers to the sales prices. 
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Report Contents 

Processes per 

customer 

This report provides an overview of current customer-based processes, 

sorted by customer. 

Additional costs overview This report generates an overview of the additional costs that were 

recorded. 

 
 

Statistics (Sales) 

See the Online statistics Help topic. 
 

Intrastat 

Access 

Sales > Order processing > Intrastat 

Purchasing > Intrastat 

Description 

Intrastat declarations are declarations on intra-Community trade statistics pursuant to EC 

Regulation 638/2004 on Community statistics relating to the trading of goods between member 

states of the European Community. The purpose of internal trade statistics is to collect data on the 

reciprocal, actual movement of goods between EU member states. 

Companies that make intra-Community deliveries or acquisitions are obliged to submit 

declarations. 

Note: In Germany, these movements of goods are specified in the German value-added tax law 

(Umsatzsteuergesetz). 
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Infor COM provides you with support in creating these statistics by creating a file, which is then 

imported, summarized and sent by the statistics software of the responsible national statistics 

authority. 

The statistics software that is used differs according to the EU member country. For example, 

Germany uses the IDES Intra-Community Trade Data Capture Software, while other countries of 

the EU use the IDEP software package that was developed on behalf of EUROSTAT, the 

statistical office of the EU. 

Please note: Contact your national statistics office for information about obtaining the relevant 

software, and install and configure it locally. You can then import the Infor COM generated file. 

During the configuration, the fields in the Infor COM generated file must be mapped to the Intrastat 

fields in the statistics software. An import filter that corresponds to the <infor> output must be 

created. 

Configuration 

See Configuration (INTRASTAT) 

Use Allocation tables in the Administration folder in System functions to enter some of the data 

that is of relevance for the Intrastat declaration. 

Before assigning Intrastat values to the items, you need to populate the allocation tables with the 

details stipulated by the relevant statistics authority. The tables must always be kept up-to-date. 

For a list of the allocation tables for Intrastat, see Allocation tables (Intrastat). 

In practice 

 Intrastat data must be reported once per month. Intrastat automatically calculates the next 

possible period. In this way, only valid and consecutive periods can be output and reported. 

 The weight that is entered on the UOM/size management tab in the item is used for the 

Intrastat declaration. However, some item IDs are exempt from specifying the weight. The 

corresponding exemption list is provided by the relevant statistics authority. 
 

Intrastat data model 

For an explanation of the structure of the database table, see the context-sensitive Help under 

System functions > Administration > Data model. 
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Connection between Advanced shipping notices and Intrastat journal table 

relFBL 

Advanced shipping notice 

 relIntrJrnl 

Intrastat journal table 

AcpPart.BelegNrLief 1:n BelegNrLief 

DbPart.RNr 1:1 UrRNr 

DbPart.RNr 1:1 UrRelation 

 

Connection between Purchase orders and Intrastat journal table 

relGb 

Purchase order 

 relIntrJrnl 

Intrastat journal table 

AcpPart.BelegNrLief 1:n BelegNrLief 

DbPart.RNr 1:n UrRNr 

DbPart.RNr 1:n UrRelation 

 

Connection between Sales orders and Intrastat journal table 

relFb 

Sales orders 

 relIntrJrnl 

Intrastat journal table 

DbPart.RNr 1:n SplittLiefRNr 

 

Connection between relIntraMinutes and Intrastat journal table 

relIntrMinutes 

Journal of generated 

declarations 

 relIntrJrnl 

Intrastat journal table 

IntraDate 1:n IntraDatum 

 

Connection between relInvLink and Intrastat journal table 
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relInInvLink 

Purchase iInvoices 

 relIntrJrnl 

Intrastat journal table 

RNr 1:n UrRNr 

 

Data summarization is no longer carried out in Infor COM. In Germany, please use the IDES tool 

supplied by Federal Statistics Office to summarize your data. The data is no longer written to the 

relintrcomp table, instead it is exported from the relintrjrnl table 

The relIntrComp (Intrastat summarization table) still exists, but it is not lused any longer. 
 

Intrastat master data maintenance 

Master data for customers 

The Address and Company profile tabs in Sales > Master data > Customers need to be checked. 

A ship-to address must be stored on the Address tab and a different EU member state to the 

customer's own must be specified in the Country field. If there is only one default address stored 

for a customer, an EU member state that is different to the customer's own must be specified in 

the Country field. 

The tax ID of the customer must be specified in the Tax ID field on the Company profile tab. 

Master data for suppliers 

The Address and Company profile tabs in Purchasing > Master data > Suppliers need to be 

checked. 

A ship-to address must be stored on the Address tab and a different EU member state to the 

supplier's own must be specified in the Country field. If there is only one default address stored for 

a supplier, an EU member state that is different to the supplier's own must be specified in the 

Country field. 

The tax ID of the supplier must be specified in the Tax ID field on the Company profile tab. 
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Master data for items 

You enter the Intrastat data for items in Design > Items. The data is stored on the Purchasing, 

Sales, Purchase prices, Sales prices, and UOM/size management tabs. 

Important note:  For the transfer to Intrastat to work correctly, the EU commodity code and, if 

applicable, the weight must be stored for the relevant item before you enter a PO or a sales order. 

Changes to this Intrastat data must be reflected in existing documents. If you use the Go to 

function in a purchase order or sales order to open the item master and then add or change 

Intrastat data, the data is not automatically updated for previously created lines in the document. 

Items > Purchasing > Intrastat 

EU comm. code 

In this field, specify the EU commodity code for the item that is currently loaded. The values from 

the STATWNR allocation table are available for selection. 

Country of origin 

In this field, select the country in which the goods were obtained or manufactured in full. If more 

than one country was involved in the manufacturing process, specify the country in which the last 

significant processing occurred whereby this processing resulted in a new product or represented 

a significant manufacturing step. 

If the country of origin is unknown or the goods are domestic goods, please select the EU member 

state from which the goods are dispatched. 

Region 

This field is only used in France, Belgium and Germany. 

In this field, enter the region of the domestic country in which the incoming goods are likely to 

remain, provided this information is required by the relevant statistics authority. 

The following rule applies only in Germany: Enter 25 if the goods are destined for abroad. 

 

Items > Sales > Intrastat 
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EU comm. code 

In this field, specify the EU commodity code for the item that is currently loaded. The values from 

the STATWNR allocation table are available for selection. 

Region of origin 

This field is only used in France, Belgium and Germany. 

In this field, enter the region of the domestic country in which the goods (in-house items or 

merchandise) were manufactured or processed, provided this information is required by the 

relevant statistics authority. 

The following rule applies only in Germany: Enter 99 if the goods were produced or processed 

abroad. 

 

Items > Purchase prices 

An Intrastat supplier must be selected on the Purchase prices tab (see "Master data for suppliers" 

above). In addition, a price for the item must be specified on this tab. 

Items > Sales prices 

An Intrastat customer must be selected on the Sales prices tab (see "Master data for customers" 

above). In addition, a price for the item must be specified on this tab. 

 

Items > UOM/size management 

If the relevant statistics authority has not exempted an item from the weight specification, the 

weight of the item and, if required, a quantity conversion must be specified on the UOM/size 

management tab. 

 
 

Settings in INTRAPARAM 

The INTRAPARAM allocation table controls Intrastat. All values that are of importance for 

generating the output files are stored in this table. 
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1. Open the INTRAPARAM allocation table. 

2. In the ID (Key value (numeric)) column, enter a consecutive ID for the current setting. 

3. In the ID column, select the parameter for which a value is to be stored. The parameters 

available for selection here are taken from the INTRADEFPAR allocation table. 

4. In the Description column, enter any description for the current parameter. 

5. In the Intra country column, enter the country for which the current setting is to be stored. 

6. In the Value column, enter the value that is to apply. 
 

Maintain on hold statuses 

To access this function, select Sales > Order processing > Maintain on-hold statuses. 

It is recommended that you maintain the on-hold status if there are any changes to the credit limit 

arrangements for a customer or cash flow was stopped and reactivated again. In this case, you 

can load all orders for this customer and put them on hold or you can load all orders that are on 

hold for this customer and release them. 

In addition, you can use the selection criteria to put individual orders on hold or to release them. 

1. Select Sales > Order processing > Maintain on hold statuses. 

2. Enter selection criteria to select the sales orders whose on hold status you want to edit. 

3. Select the required option in the Maintain on hold statuses section. 

4. The selected orders are displayed in a table in the dialog box that is subsequently displayed. 

If applicable, select the required orders by keeping the CTRL key pressed down and clicking 

the row header. 

5. Click Start. 
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Automotive basics 

Common goals of automobile suppliers and other suppliers include reducing capital tied up in 

warehouse inventory, increasing inventory revenue, and decreasing vertical integration. The last 

goal in particular increases the part played by external goods and integrates suppliers more 

closely into the value-added process. This integration increases the requirement for 

communication between companies, whereby information must be exchanged at the least 

possible cost. 

The concept of electronic data interchange (EDI) helps meet these requirements. 

Electronic data interchange (EDI) generally refers to the electronic transfer of business documents 

such as purchase orders and invoices between different companies' computer systems in 

compliance with agreed standards (see "EDI standards" page 260). 

Example: An automobile manufacturer uses EDI to release deliveries from the supplier at short 

notice. Larger delivery quantities are agreed in contracts and released in instalments. Running 

balances are maintained as cumulative quantities (page 307). 

There are three issues when exchanging data electronically between automobile manufacturers 

and suppliers: Order release management (see "EDI and order release management" page 277), 

packaging (see "EDI and packaging" page 291) handling, and payment transactions (see "EDI and 

payment transactions" page 288). 

 The first phase of the process involves the importing of messages (see "Import messages" 

page 318). All messages are imported. If errors occur, messages containing errors are 

stored and can be viewed and edited later. 

 The EDI journal (page 315) logs all incoming and outgoing messages in full. 

 The structure of the messages to be imported or exported is stored in the message profile 

(see "Message profiles" page 326). 

 You can use the Message editor (page 325) to edit messages containing errors. 

 You release messages using the corresponding EDI ID, which is defined in the EDI master 

data (page 349). 
 

Automotive 
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EDI standards 

Description 

Certain conditions must be met before EDI (see Automotive basics (page 259)) can be used 

between business partners. Rules (standards) must be agreed and formats and standards must 

be complied with in order to ensure that the electronic exchange of data is carried out smoothly 

without any errors. 

Formats 

The following are examples of important formats that have been created for the standardization of 

these rules: VDA (Industry standard for the German automotive industry, increasingly replaced by 

EDIFACT), GALIA (Industry standard mainly for the French automotive industry, similar to 

ODETTE), ODETTE (European automotive industry), ANSI ASC X12 (American, 

industry-independent), and UN/EDIFACT (worldwide, industry-independent, but with 

industry-specific sub-standards). 

EDI standards 

The following table displays a comparison of common EDI standards for the VDA, ODETTE, and 

EDIFACT formats. The EDI standards available in Infor COM are stored in the AMTYPEEDI 

allocation table. 

Converter 

Converters are used for converting messages from or to the data format used by the respective 

application system. These programs convert incoming messages into the format that the 

application software can process. For outgoing messages, the converter uses the interfaces 

provided in the application system and converts the existing data to the corresponding format. 

Depending on the converter’s configuration level, it can also coordinate the receipt of messages or 

the transfer of data to the message recipient. The method used for transferring messages from the 

sender to the recipient is not defined - all transfer methods can be used for transporting messages. 
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Examples 

Business process Description VDA  ODETTE  EDIFACT 

Delivery order release A customer (message sender) uses this 

message to notify the supplier (message 

recipient) of goods pending delivery. The 

customer informs the supplier of the status of 

the goods order release if, for example, the 

goods are to be delivered at a specified 

location. 

VDA 4905 DELINS DELFOR 

Invoice Message used for requesting payment for 

goods that have been delivered according to 

the terms agreed between the salesperson 

and buyer. 

VDA 4906 INVOIC-OD INVOIC 

Payment advice A payment advice is a message between 

trading partners, for example, a salesperson, 

buyer, bank, that notifies the partner of a 

payment or other form of financial 

settlement. The information refers to 

payments of goods and services, as itemized 

in detail on the payment advice. 

VDA 4907 REMADV REMADV 

Credit memo The account servicing institution sends a 

credit memo to the account holder to inform 

the account holder that the account has 

been credited with a specified amount, in 

settlement of the referenced business 

transaction.  

4908_1: Settlement invoice 

4908_2: Credit memo data 

VDA 4908 CREDIT CREADV 

Delivery advice (EDI 

Advance shipping 

notice (ASN)/ 

ASN (Advanced 

Shipping Notice) 

The supplier sends this message to the 

customer (manufacturer) to advise on 

shipped deliveries.  

VDA 4913_1: Advance shipping notice and 

transportation data, suppliers, and 

customers 

VDA 4913_2: Advance shipping notice and 

transportation data, suppliers, 

subcontractors, and customers 

VDA 4913 AVIEXP DESADV 

Purchase order The customer (data sender) uses a purchase 

order to contract a supplier (data recipient) to 

deliver or produce the goods or services 

described in the message under specified 

VDA 4915 ORDERR ORDERS 



262 | Infor COM 7.5 User Guide 

 

Sales 

 

Business process Description VDA  ODETTE  EDIFACT 

conditions. 

JIT delivery A customer (message sender) uses this 

message to notify the supplier (message 

recipient) of the goods to be delivered. A 

supplier is obliged to deliver the specified 

goods at a determined time and location. 

VDA 4915 DELINS DELJIT 

Direct order release 

(manufacturing order 

release) 

This message enables the customer to 

transfer precise information on the 

progression of delivery and just-in-time 

requests to the supplier and supports the 

delivery order release message. 

VDA 4916 CALDEL DELJIT 

Carrier order Order that is sent to a partner to contract 

carrier or transportation services for a 

shipment in accordance with agreed terms. 

VDA 4922 TRINAD IFTMIN 

Tag The VDA4902 tag describes the format for a 

globally valid transportation label design for 

simplifying the transportation of goods and 

data exchange. 

VDA 4902 --- --- 

PO confirmation Electronic transfer of the purchase order 

confirmation from the supplier to the 

customer. 

--- --- ORDERRSP 

Load carrier Load carrier account statements (4927_1) 

and movements (4927_2). 

VDA 4927   
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Allocation tables (Automotive) 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

The following allocation tables are used in Automotive: 
 

AMCOMPPAR 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Parameters for EDI comparison 

Usage: This allocation table is used for automated EDI comparisons when importing order 

releases. Parameters are used to specify what activities are performed when there are variances 

from a specific standard in a specific time period. 

 

EDI std. 

This field indicates the EDI standard for the order release. 

Number 

This entry refers to the Time unit field. The TUnit and Number fields indicate the time period. 

TUnit 

You use this combo box to select the required time unit. 

Tolerance in % (+) 

This value defines the upper deviation limit in percent. 

Tolerance in % (-) 

This value defines the lower deviation limit in percent. 



264 | Infor COM 7.5 User Guide 

 

Sales 

 

Compare totals 

If this check box is selected, the totals of the current order release status (within the given time 

period) are compared to those of the previous status. The comparison is made by day, or over the 

entire specified period. 

Mailbox 

If this check box is selected, a mailbox entry is written each time the limit values are exceeded. 

Print 

If this check box is selected, an EDI comparison variance report is created automatically if the limit 

values are exceeded when importing the order releases. 
 

AMDATATYPES 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: AM data types 

Usage: This table contains field types that you can use to characterize the fields in the message 

editor in Automotive, for example. 
 

AMDATETYPES 

Description: Date field formats 

Usage: This allocation table provides the entries that can be selected for the Date format field in 

the message profile of the Message profile record view. 

It is used to format and mask date fields during EDI imports and exports. 

Example: The date and time are imported into 2 fields in the EDI transfer and linked in the target 

field in Infor COM. 
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AMDESTTAB 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: AM target table 

Usage: This table specifies the database tables or views that are required for importing and 

exporting messages. 
 

AMEDI4913TT 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Transfer reason 4913 

Usage: This table specifies the transfer reasons that are required when using ASN EDI 

messages with a subcontractor (S/C). 
 

AMEDI4927PK 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: VDA Recommendation 4927, process keys 

Usage: This table specifies the process key that is required for EDI load carrier exchanges. 
 

AMEDI4927TT 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Transfer reason 4927 

Usage: This table specifies the transfer reasons that are required for EDI load carrier exchanges. 



266 | Infor COM 7.5 User Guide 

 

Sales 

 

 

AMFIELDTYPE 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Field types 

Usage: This table contains the field types and conversions for importing and exporting 

messages. 
 

AMJLSTATUS 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Statuses in the EDI journal 

Usage: This allocation table stores all of the message status levels in the EDI journal. 
 

AMLOADL 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Statuses in load lists 

Usage: This allocation table stores all of the statuses for load list lines or load list headers. 
 

AMLOGSTATUS 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Statuses of AM messages 

Usage: Shows the various statuses that can be assigned to messages in the message editor. 
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AMOWNPLANTS 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Own plants 

Usage: This allocation table allows you to store plants for your own company. The plants stored 

in this allocation table can be selected from the Plant field on the Address tab of the master data 

for your own company. 
 

AMOWNPLCDIS 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Own loading points 

Usage: This allocation table contains the unloading points of your own company. 
 

AMPROFDESCR 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Message profile descriptions 

Usage: The description specified here is displayed at various places in the message profiles 

(page 326). 
 

AMPROFHD 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Parameters for message profiles 
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Usage: This allocation table contains the various properties that can be assigned to the control 

parameters of a message profile. It is used in message profile management. 
 

AMRECTYPE 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: EDI record types 

Usage: This allocation table defines the record types for messages as well as the EDI standard 

to which each record type belongs. 
 

AMREPLACE 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Field replacements 

Usage: This allocation table contains the various field replacements and conversions that are 

carried out on the basis of fields. It is used in profile maintenance. 
 

AMRULE 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: EDI transfer rules (AM) 

Usage: This allocation table stores the rules for transferring field contents in Automotive. For 

more information, see the Message Help topic. 
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AMSHIFT 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Delivery intervals (shift plan) 

Usage: This allocation table stores the delivery intervals for calculating the shipping or arrival 

date of order release lines. It is used in the Unloading points object. 
 

AMTYPEDEM 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Order release requirement types 

Usage: This allocation table contains all of the requirement types that can be used in delivery 

order releases or JIT delivery order releases and manufacturing-synchronized order releases. 

They are transferred when you import the relevant message. 
 

AMTYPEDOC 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: VDA document types for payment advices 

Usage: This allocation table stores the document types for payment advices. For more 

information, see Payment advices (page 311). 
 

AMTYPEEDI 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 
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Description: EDI methods 

Usage: This allocation table stores the EDI methods used in Infor COM. 

 

EDI std. 

Indicates the EDI standard for the specific EDI method. 

RT 1 rec. 

Shows the first record type (start record type) of the corresponding EDI standard. 

Lst rec RT 

Shows the last record type (end record type) of the corresponding EDI standard. 

RT for new process 

Show the record type used to flag a new object (order, advance shipping notice etc.) 

Abbreviation 

Shows the abbreviation for an EDI method. 
 

AMTYPEPAY 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: VDA payment types 

Usage: This allocation table stores the VDA payment types that are transferred as part of a 

payment advice. For more information, see Payment advices. 
 

AMUSAGE 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Usage keys 

Usage: This allocation table stores the usage key for order releases in Automotive. 
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KNZEDI 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: AM/Trade flags 

Usage: This allocation table is used to indicate whether a customer should be taken into account 

in EDIFACT or VDA links. 
 

MEEDI 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: EDIFACT units of measure 

 

Usage: This allocation table stores the unit of measure abbreviations according to the EDIFACT 

standard and the corresponding units of measure assigned within the Infor COM system. You can 

also store a conversion factor for converting the EDIFACT unit of measure to the Infor COM unit of 

measure. The conversion is carried out in the same way as in the FREMDWEUR allocation 

table. 

 

Basis 

This field contains the basis for the conversion between the EDIFACT and Infor COM unit of 

measure. 

Ext. UOM 

This field provides a description of the EDIFACT unit of measure. 

Factor 

The factor used for converting the units of measure. 
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UOM 

This field provides a short description of the Infor COM unit of measure. 

Description 

A more detailed description of the Infor COM unit of measure is displayed here. 
 

MEVDA 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: VDA units of measure 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table stores the unit of measure abbreviations according to the EDIFACT 

standard and the corresponding units of measure assigned within the Infor COM system. You can 

also store a conversion factor for converting the EDIFACT unit of measure to the Infor COM unit of 

measure. The conversion is carried out in the same way as in the FREMDWEUR allocation table. 

 

Basis 

The basis for converting between the VDA unit of measure and the Infor COM unit of measure. 

Ext. UOM 

This field provides a description of the VDA unit of measure. 

Factor 

This field contains the factor used for converting between the units of measure. 

UOM 

A short description of the Infor COM unit of measure. 

Description 

A more detailed description of the Infor COM unit of measure. 
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TRANSP 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: Means of transportation 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table stores the transportation flags. You can store them on the Unloading 

points tab in Companies, for example. 
 

VARTVDA 

For an overview of the Automotive allocation tables, see Allocation tables (Automotive) (page 

263). 

Description: VDA shipping types (coded) 

Usage: This allocation table stores the shipping types according to the VDA standard. It is used 

in the VDA sh tp field on the VDA shipping type tab in the SPEDIT allocation table. 
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Allocation tables (Shipping material) 

For general information, see Shipping materials (see "Shipping material, Ship. mat." page 332). 

The following allocation tables are used in connection with shipping materials. 
 

PACKGROUP 

For an overview of the allocation tables used for shipping materials, see Allocation tables 

(Shipping material) (page 274). 

Description: Shipping material groups 

Usage: This allocation table is used in the item master to assign an item to a shipping material 

group. This shipping material group can then be used to create and open packing instructions. 

This means you only need to create one packing instruction for all items that are packed in the 

same way. 
 

PACKCODE 

Description: Packaging keys 
 

PMACCTYPE 

For an overview of the allocation tables used for shipping materials, see Allocation tables 

(Shipping material) (page 274). 

Description: Shipping material account types 

Usage: This table contains the account types that are assigned to new shipping material 

accounts. 
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PMGROUP 

For an overview of the allocation tables used for shipping materials, see Allocation tables 

(Shipping material) (page 274). 

Description: Load carrier groups 

Usage: This allocation table stores the shipping material groups for the shipping material account 

and the load carrier EDI. 

The table is used for classifying shipping materials when exporting shipping material statements. 
 

PMLISTTYPE 

Description: Shipping material movement triggers 

 
 

PMOWNER 

For an overview of the allocation tables used for shipping materials, see Allocation tables 

(Shipping material) (page 274). 

Description: Shipping material owners 

Usage: This table contains the different type of shipping material owner. 
 

PMSELECTION 

For an overview of the allocation tables used for shipping materials, see Allocation tables 

(Shipping material) (page 274). 

Description: Load carrier movements 

Usage: This allocation table is used in the Shipping material account. It contains the entries used 

for selecting load carrier movements. 
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PMTYPE 

For an overview of the allocation tables used for shipping materials, see Allocation tables 

(Shipping material) (page 274). 

Description: Shipping material types 

Usage: This allocation table stores the different shipping material types. For more information, 

see Shipping materials. 

Type: Shows a short description of the shipping material type according to VDA. 
 

PMUSAGE 

For an overview of the allocation tables used for shipping materials, see Allocation tables 

(Shipping material) (page 274). 

Description: Modules for shipping material usage 

Usage: This allocation table indicates the Infor COM modules in which a set of packing 

instructions is used. 
 

Reports (Automotive) 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

In the Sales module, open the Order processing folder and click Reports. This opens the Report 

overview dialog box. 
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Rep. Contents 

Order release prices  

EDI master data This report provides the EDI master data (page 349) sorted by EDI 

standard. 

Cumulative quantities - 

Check list 

This report provides a checklist of the cumulative quantities (page 

307) by order ID. 

VMI inventory limits This report prints all outline agreement VMI parameters as well as the 

inventory details and next deliveries for the VMI warehouse. 

 
 

EDI and order release management 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

This Help topic describes how to use electronic data interchange for transferring delivery order 

releases and JIT delivery order releases in the automotive industry. Order release management 

uses the following components: 

Outline agreements (order releases) 

In the automotive industry, serialized items are generally ordered using outline agreements (see 

"Order releases" page 293). Outline agreements regulate the total requirements over a specified 

time period as well as the purchase order quota. For more information, see Enter outline 

agreement and order release in Sales (page 296). 

Releases 

The outline agreements are fulfilled by various  order release types. For more information, see 

Delivery order releases and JIT delivery order releases (see "Delivery order releases and JIT 

deliveries" page 278) and Manufacturing order release (page 279). 
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Manufacturer-specific agreements 

MAIS pick-up sheet (page 281), AMES-T (page 282), Alternative PSA logistics (page 284), 

Document-oriented material flow (BeloM) (page 287) 

Cumulative quantities 

The concept of cumulative quantities  (see "Cumulative quantities" page 307) is used to regulate 

the extent to which an outline agreement is already fulfilled by the current order releases. 

You can compare two order release versions using the EDI comparison (page 305) function. 

Processing order release data 

The order release data is processed in Manufacturing planning where it is used as the basis for 

the outline agreements. Since the outline agreements do not order specific sales quantities, 

suppliers must hold expected capacities at their own risk. 

The goal of maintaining high capacity utilization with low warehouse inventory can be achieved 

using the incoming delivery order releases and JIT delivery order releases. 
 

Delivery order releases and JIT deliveries 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

For basic information about using electronic data interchange in order release management, see 

EDI and order release management (page 277). 

Delivery order releases 

The Help topic on Import messages (page 318) explains how you transfer delivery order releases 

and JIT deliveries. 

The automobile manufacturer releases the items requirement using a delivery order release (see 

EDI standards (page 260)). Delivery order releases are created for recurring situations whose 

requirements change in terms of quantity and time. They describe the requirement dates for the 

near, middle, and distant future for up to 24 weeks. 



Infor COM 7.5 User Guide | 279 

 

Sales 

 

For example, delivery order releases are generated in weekly cycles and fully replace the old 

order releases. They are summarized by customer or by plant. 

The delivery order release references the associated outline agreement. The individual 

characteristics apply according to the outline agreement. 

When searching for an outline agreement, you can use the manufacturer (customer ID), plant, 

reference ID (resource), or unloading point (inventory location) as search keys for identifying the 

required outline agreement. 

The packaging type is specified by the resource ID and the capacity of the shipping material (see 

"Shipping material, Ship. mat." page 332) is specified in an additional record type. 

JIT deliveries 

The Just-in-Time strategy requires deliveries that are accurate to the hour. This is achieved by 

synchronizing requirements between the manufacturer and supplier on a daily basis. 

The JIT delivery order release is therefore made available to the supplier by EDI on a daily basis 

(see EDI standards (page 260)). It contains the planned quantities derived from the manufacturing 

control system of the manufacturer for a close range period of 1-15 days. 

When you use JIT delivery order release, the delivery order release is used as a planning tool 

only. The requirement quantities in the JIT delivery order release are binding. JIT delivery order 

releases must be set using the JITDeliveryAktiv =yes parameter. For more information, see the 

Infor COM Management Console Help. 
 

Manufacturing order release 

For basic information on using electronic data transfer for delivery order releases and JIT delivery 

order releases in the automotive industry, see the EDI and order release management (page 277) 

Help topic. 

In addition to the delivery order release and JIT delivery order release (see "Delivery order 

releases and JIT deliveries" page 278) types, you can also use manufacturing order releases 

(MOR). 
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Description 

A manufacturing order release is essentially a further refinement of the JIT delivery order release. 

It is used to accurately control manufacturing on the supplier side and also serves as precise 

shipping instructions for the delivery of special items in a specified sequence. 

If a manufacturer has both individual items and entire system components delivered on the 

conveyor, then system suppliers deliver complete systems in synchrony with vehicle assembly. 

The precisely sequenced control is transmitted by EDI using the manufacturing order release, 

according to VDA 4916, for example. 

The customer item ID is assigned to each vehicle ID and is compared to an individual assembly 

order. 

What makes a manufacturing order release particularly useful is that it provides specific, 

vehicle-related, precisely-sequenced information through the assignment of reference IDs for 

production IDs (or, in this case, for vehicle IDs in automobile manufacturing). 

Cumulative quantities are not transferred with a manufacturing order release. The dates in the 

manufacturing order release replace the delivery order release and JIT delivery order release lines 

for the corresponding time period. The transferred quantities must be delivered independently of 

any existing differences within the cumulative quantities. 

Multiple manufacturing order releases for one reference ID are differentiated through unique 

production IDs (vehicle IDs). Each production ID is stored in a separate additional table for the 

order release line. All quantities of an item and a delivery date are grouped in an order release line 

in the order release. 

In practice 

Manufacturing order releases are sent by automobile manufacturers using electronic data 

interchange methods such as VDA messages in accordance with the VDA 4916 standard. They 

are then stored by the Seeburger™ box either as an ASCII link file or in a database table. 

This data is transferred to existing order releases. All EDI data is stored in a log table and can be 

edited there afterward. Any errors that occur during transfer are logged in the mailbox. 
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An automobile manufacturer can send the same manufacturing order release multiple times: as a 

new record, as a change, as a deletion/cancellation, or as a repeat order. For the first transfer, all 

reference IDs must be sent. If a change is made, then only the reference IDs affected by the 

change are sent. 

New manufacturing order releases are usually sent 2-4 days before delivery. In a manufacturing 

order release, suppliers can be notified of changes through EDI up to 2 hours before the 

scheduled delivery date. 
 

MAIS pick-up sheet 

For basic information on using electronic data transfer for delivery order releases and JIT delivery 

order releases in the automotive industry, see the EDI and order release management (page 277) 

Help topic. 

Note: MAIS pick-up sheets are used by a small number of automobile manufacturers only (for 

example, Opel). 

Description 

With the MAIS (material information system) method, the customer transmits information to 

automobile suppliers and carriers using a pick-up sheet, which is similar to a JIT delivery order 

release. The pick-up sheet specifies exactly which material is required and when the customer's 

carrier will pick up the material from the supplier. 

The following table shows the differences between the two methods: 

MAIS pick-up sheet JIT delivery 

Item IDs and quantities are released within a 

time slot. The time slots of the MAIS pick-up 

sheet replace the dates and quantities in the 

delivery order release. 

Weekly order release 

Each item is released in the corresponding 

quantities at specific times. 

Daily order release 

 

Automobile manufacturers often send JIT delivery order releases with agreed packaging by EDI 

as a DELJIT EDIFACT message. A converter then stores these as an ASCII link file (like a JIT 

delivery order release), or in a database table. 
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This data is transferred to existing order releases. All EDI data is saved in a log table. You can 

maintain the data in Sales under Message editor in the Messages folder. Any errors that occur 

during the transfer are logged in a mailbox. 

The tags required for the sent items must contain the document IDs stored in the MAIS pick-up 

sheet. In addition, the tag matches the tag of the delivery order release. The document ID is 

shown instead of the ASN ID. 

In practice 

A MAIS pick-up sheet can only be delivered in its entirety. For example, if it contains three item 

IDs, the pick-up carrier either accepts all three items in the required quantities or refuses the 

receipt. For this purpose, the carrier is provided with a document containing all the required data 

from the MAIS pick-up sheet. The pick-up carrier receives all required information from the 

manufacturer through the MAIS pick-up sheet. The carrier creates the pick-up sheet as supporting 

documentation and brings it along for the pick-up. The document is updated manually in shipping 

(for example, weight added, stamped). There is no separate supporting documentation such as an 

advance shipping notice or bill of lading created. 
 

AMES-T 

For basic information on using electronic data transfer for delivery order releases and JIT delivery 

order releases in the automotive industry, see the EDI and order release management (page 277) 

Help topic. 

The Advanced Mobility Engineering & Services for Transportation (AMES-T) rules of Volkswagen 

AG apply to suppliers of Volkswagen AG. 

A single shared database connects up the AMES-T customers, suppliers, and carriers involved in 

the business processes across Volkswagen's logistics system. 

The manufacturer sends the required order releases to the supplier and carrier at the same time. 

The carrier provides the supplier with the pick-up dates and the pick-up quantity for the relevant 

date. The supplier confirms the date with the carrier. The supplier processes the order releases 

and provides the agreed quantity of goods on the agreed dates. 

In the context of AMES-T, the following points must be noted for suppliers. 
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Transfer of order releases 

Order releases are transferred in the following steps: 

1. The manufacturer orders items from the supplier by EDI. Both the supplier and the carrier are 

notified simultaneously. 

2. The carrier provides the supplier with the pick-up dates and the pick-up quantity for the 

relevant date. 

3. The supplier confirms the date with the carrier. 

4. The supplier processes the order releases and provides the agreed quantity of goods on the 

agreed dates. 

Confirmation of pick-up dates with carrier 

5. The supplier confirms the date specified by the carrier the day before loading. 

6. The confirmation contains the following information: 

 Weight and quantity of the shipping material 

 Receiving plant and warehouse with an exact description of the unloading point 

 Hazardous goods/risk class 

 Delivery date at Volkswagen AG 

 Item IDs and quantities 

 Pick-up date 

Transfer of advance shipping notice data to PDF generator 

7. The supplier provides the goods with the accompanying documents at the agreed pick-up 

date. 

8. To print the load list/transportation, shipment, and EDI accompanying documents, the PDF 

generator requires the master data for the supplier, customer, and carrier as well as the 

advance shipping notice data in VDA 4913 format, for example. The PDF generator uses this 

data to print the required documents. 

9. The carrier checks the goods and accompanying documents against this pick-up list. If there 

are any variances, the supplier makes the adjustments in Infor COM and creates a new file for 

the PDF generator. 
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Transfer of ASN EDI to customer 

Once the goods are shipped, the ASN EDI is completed. Ensure that the data in the ASN EDI 

matches the corresponding data in the accompanying documents. 

Maintenance of master data in PDF generator 

Any changes made to the master data, either in Infor COM or in the PDF generator, must be made 

in both systems. 

Please note: To export the AMES-T link file, select Functions and Export AMES-T data from the 

load list. The file is stored in the configured directory. The Export AMES-T data field on the 

Transportation data tab of the load list header is populated. 
 

Alternative PSA logistics 

For basic information on using electronic data transfer for delivery order releases and JIT delivery 

order releases in the automotive industry, see the EDI and order release management (page 277) 

Help topic. 

The following information regarding alternative logistics applies to suppliers of the automobile 

manufacturer PSA (Peugeot S.A.) 

The main component of the Alternative logistics process implemented in certain PSA plants is the 

ability to deliver containers with KANBAN IDs and the ability to support routing codes (clear time 

and location specifications for delivery). 

PSA organizes the goods into delivery streets based on their routing code, from where they are 

sorted for the conveyor belt. Suppliers are therefore required to support the use of routing codes 

only, i.e. only goods with this special routing code may be delivered to a given unloading point. 

Suppliers must support the required information on all documents and in the advance shipping 

notice EDI. 

The message profiles that are used here are 4915 CALDEL PSA and 4913 AVIEXP PSA. 
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Note: The message profile to be imported using the Import message function is CALDEL PSA. 

The routing code and the Kanban ID are then transferred to record type 5A4 and to the order 

release. 

The Alternative logistics process includes the following settings and processes. If necessary, 

contact your consultant for more information on how to customize your system for this process. 

Overview of the process involved in the PSA logistics process. 

 CALDEL JIT deliveries are received 

 Load lists are generated with CALDEL purchase order IDs and routing codes 

 Tags are printed according to PSA specifications 

 AVIEXP messages (DESADV) are sent according to PSA specifications 

 

Load lists 

In the load list, the check box for the PSA logistics process (Alternative PSA logistics) is 

transferred from the unloading point and displayed on the EDI tab in the Load list header view. 

When creating packages, the first lines to be delivered are then processed in accordance with 

their shipping dates. 

Note: The fill quantities of the packages and the Kanban quantities must match. 

Kanban IDs and routing codes are transferred to the packages and displayed. 

Please note: You may need to adjust the Package quantities tab in the load list to make the fields 

visible. 

You can repack packages to create mixed masters. Please note that mixed packages must always 

contain routing codes only, as they will not be accepted by PSA otherwise. 

Only goods with this special routing code can be delivered to a predefined unloading point. The 

code is transferred with the order releases and propagated to the load list. 

 

Set up unloading point 

1. In the Sales module, open the AM master data folder, click the Unloading points object, and 

open the required unloading point. 

2. Select View > Unloading point line and then select the Flags tab. 
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3. Select the Alternative PSA logistics check box. 

 

Assign shipping documents 

Tags: 

1. In the Sales module,  open the Packaging folder, select the Packaging instructions object, 

and open the required packaging instruction. 

2. On the Tag tab, assign the irAMMatTPSA document to the Mixed tags or Same-typetags 

fields. 

This Galia-ETI9 document was created in accordance with PSA requirements. 

Note: You can also make this assignment on the Tag tab in the shipping material 

requirements. 

 

Advance shipping notice: 

1. In the Sales module,  open the Packaging folder, select the Packaging instructions object, 

and open the required packaging instruction. 

2. On the Tag tab, assign the irAMMatTPSA document to the Mixed tags or Same-typetags 

fields. 

This Galia-ETI9 document was created in accordance with PSA requirements. 

Note: You can also make this assignment on the Tag tab in the shipping material 

requirements. 

 

Order releases 

Order release data can be maintained manually in the order release line on the Automotive tab. 

You can set the order release type here to JIT delivery and enter the KANBAN ID (Kanban) and 

routing code (Route suffix). 

 

ASN EDI 

The packages are processed in the ASN EDI using the 4913 AVIEXP profile. 
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Document-oriented material flow (BeloM) 

For basic information on using electronic data transfer for delivery order releases and JIT delivery 

order releases in the automotive industry, see the EDI and order release management (page 277) 

Help topic. 

The document-oriented material flow (BeloM) standard developed by BMW allows the optimization 

of internal BMW material flow control through the consistent use of VDA tags across all BMW 

plants. 

This procedure requires the transfer of specific material flow-related information to tags and 

delivery documents. For delivery documents, transportation documents are used in accordance 

with VDA4939. 

Transportation documents, on which the full EDI advance shipping notice is printed out in the form 

of a PDF417 barcode, are required for the BeloM document-oriented material flow standard - see 

Changes to shipping documents below. 

Once the actual load list has been created, the menu only allows the creation/issue of the EDI 

advance shipping notice. The EDI data is not sent until after the shipping documents have been 

printed.  

Note:  You can activate the BeloM document-oriented material flow menu in the unloading point 

or in the order release header ( Customer data tab) by selecting the VDA4939 Shipping 

documents check box. 

When the BeloM document-oriented material flow procedure is used, alternative documents are 

entered in the load list (on the Documents tab in load list header). 

Tag irAMMatTBMW, irAMMatTBsm 

Bill of lading irAMSMB 

Accompanying 

documentation 

irAMSPB 

 

The following sections contain more information on changes made to shipping documents and 

processes in the load list as a result of the BeloM document-oriented material flow standard: 

Changes to shipping documents 
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The following applies to the VDA 4902 tag: 

 The 5-digit unloading point as well as the warehouse location and usage must be printed in 

field 2 

 A PDF417 is printed as the barcode in field 8, which also contains the transportation 

information 

 Only the barcodes for fields 12 and 15 are mandatory 

 

In VDA 4905, a route is transferred to record type 518. 

The BeloM document-oriented material flow standard requires three specific documents 

(transportation and shipment documents): 

 Shipment item sheet: Contains all lines of a shipment (i.e. all advance shipping notices) 

 Shipment master sheet: Contains outline data for shipping as well as all packages, 

dimensions, and weights 

 Transportation master sheet: Contains all shipments dispatched from a sender. 

 

Changes to load list function 

The menu commands for printing advance shipping notices, bills of lading, and accompanying 

documents are dimmed in the BMW load list. Instead, a menu command for printing shipping 

documents is displayed in accordance with VDA 4939. 

After the EDI advance shipping notice is created, the date, transfer ID, and EDI ID are displayed in 

the load list header. 

 
 

EDI and payment transactions 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

This Help topic describes the use of electronic data interchange for payment transactions in the 

automotive industry. 

Financial settlement in the context of electronic data interchange comprises traditional invoices 

sent by regular mail, credit memo procedures, and payment advices. 
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Invoice EDI 

The usual settlement process is based on the EDI invoice in VDA 4906 format, for example. The 

supplier accumulates the invoice data for a specific time period (weekly or monthly) and processes 

this data as a (VDA) message, for example. For more information, see Electronic data interchange 

of invoices (see "Create EDI invoices" page 290). 

This collective settlement is possible since the invoice is settled by the automotive industry at a 

fixed date in the month following delivery. 

 The manufacturer's supplier system compares the expected invoice amount with the invoice total 

transferred by EDI based on the advance shipping notice data and the corresponding price. 

Credit memo procedure 

When using credit memo procedures (see "Credit memo procedure" page 312), the supplier does 

not issue an invoice for services provided. Instead the customer provides the supplier with a 

weekly credit memo for the goods shipment based on the valuated goods receipt. The supplier 

carries out invoice approval by comparing the credit memo data with the invoice data. The credit 

data can be transferred using the VDA 4908 EDI message, for example. This format enables the 

supplier to carry out an automatic comparison with the transferred credit memo file. 

Payment is made once the financial settlement process has been completed. 

Payment advice 

Once the credit memo is transferred, you can use the payment advice, which is transferred as an 

EDI message (e.g. VDA 4907). A payment advice (see "Payment advices" page 311) is a 

message that contains detailed information about the credit memos and invoices to be processed 

(such as currency, settlement date, and payment amounts). 

When using credit memos, only the credit memo ID is included as a reference on the payment 

advice, which means that all credit memos related to this ID are settled. 

Note : § 14 of the German Sales revenue tax law forbids the processing of payments without 

documentation. A written grouped invoice that meets this law's requirements must be created and 

sent to the customer by regular mail or fax. If the supplier does not issue an invoice, and the 

customer issues a credit memo instead, the customer must send the supplier the credit memo in 

writing. 
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Create EDI invoices 

For an overview of how to use electronic data interchange for financial settlements, see EDI and 

payment transactions (page 288). 

This Help topic describes how to use electronic data interchange for transferring invoice data 

between suppliers and customers. This can be based on VDA recommendation 4906, for 

example. 

To create an EDI invoice, complete the following steps: 

1. In the Sales module, open the Order release management folder and click Order release. 

2. Select an order release line to be invoiced (status is Issue). 

3. Select Functions and Create document. Then select the Invoice and Print check boxes. 

4. Click OK to confirm. 

A standard invoice is generated and the EDI link file is stored in the configured folder. The file 

name is structured as follows: 

<customer ID>INVOICE<current date>.INH. 

You can use the COMMON.AUTOMOTIVE.PRINTINVOICE parameter to prevent the 

standard invoice from being printed automatically. 

5. In Order release management, open the EDI journal and select the invoice by going to 

Customer and EDI std.. You can identify the invoice by the export date. 

 

Note: The COMMON.AUTOMOTIVE.DIRECTEXPORT parameter or EDI master data allows 

you to determine whether the messages should be created directly or by means of a dialog 

box or file process. 

 

Adjust EDI invoices 

You can adjust EDI invoices once the data has been transferred. In this case, the EDI 

recipient is generally notified of the adjustment. You can resend adjusted data under a 

new shipment ID, for example, using the Message editor (page 325). 

 

Automatically export EDI invoices 
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For information on exporting EDI messages, see the Export messages (page 329) Help 

topic. 
 

EDI and packaging 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

In the context of packaging, there are three relevant issues when using electronic data 

interchange in the automotive industry: Delivery forms, shipping processing, and returnable 

packaging management. 

Delivery forms 

Shorter ordering intervals and a simultaneous reduction in PO quantities increases the frequency 

with which goods are transported between customers and suppliers. There are three options 

available for delivering to customers. 

 Deliveries to customers can be carried out by direct delivery (as a full or consolidated load). 

The full load option is used if the delivery is sufficient to fill a truck completely. Generally, a 

consolidated trip involves the freight consolidator delivering to all suppliers in the area. 

 Instead of delivering directly, the delivery can also be made to a subcontractor's finished 

goods warehouse in the vicinity of the customer. The plant is then supplied from this 

warehouse according to requirements. The customer and supplier both provide the 

subcontractor with the supply and planning details for the agreed scope of delivery. The 

inventory in the warehouse is the property of the supplier. 

 A third possibility for supplying the manufacturer is to use a consignment warehouse at the 

manufacturer's plants. This consignment warehouse is planned and stocked by the supplier, 

but is operated by the manufacturer. The goods remain the property of the supplier until they 

are issued to the assembly location. 

Shipping processing 

In the context of electronic data exchange, there are four main issues to consider during shipment 

processing: 

 Picking the goods (load lists (page 300) and packing instructions). 

The shipping quantity determined by the order release system in conjunction with the 

cumulative quantities (page 307) is itemized in a load list (see "Load lists" page 300) according 

to reference ID. Depending on the form of delivery, the scope of the load is synchronously 

summarized in a pick list for later delivery. Each load list is assigned a unique reference ID that 

identifies the overall shipping process. 
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 Packaging the order release correctly according to the packing instruction is crucial when 

assembling the load, since the manufacturer arranges transportation and manufacturing 

according to the size and composition of the container. Tags containing shipping and 

product-related data are affixed to the shipping materials (see "Shipping material, Ship. mat." 
page 332) in order to identify the goods. The tags, which can be barcoded in DIN A5 format 

according to VDA 4902, for example, supplement the advance shipping notice and 

transportation data sent by electronic data interchange. Each individual container is identified 

by the supplier ID and the unique package ID that the supplier assigns to each package. The 

customer uses a scanner to enter and immediately post the packages during goods receipt. 

The barcode label remains on the shipping material until the items are processed. 

 Creating the transportation documents (bills of lading, accompanying documents) 

Transportation documents that accompany a delivery include the carrier order in VDA 4922 

format, for example. These documents fulfill the requirements of the supplier, carrier, and 

automobile manufacturer. The advance shipping notice is not required when you use 

electronic data interchange to transfer advance shipping notice and transportation data. The 

EDI accompanying document, which summarizes the delivery data, is also used. 

 Electronic data interchange of transportation data 

The exchange of ASN and transportation data varies according to whether the goods are 

received at the premises of the automobile manufacturer or at the premises of the 

subcontractor. In either case, the automobile manufacturer expects the ASN and 

transportation data to be transferred electronically (in VDA 4913 format, for example) at the 

time of the shipment. The manufacturer calculates the arrival time of the goods based on the 

posted departure time and the planned delivery time. The manufacturer can also reserve 

inventory locations based on the posted shipping material breakdown.  

The advance shipping notice information transferred by EDI is compared with the container 

data on the tag that is entered via scanner. The barcode label is assigned to the EDI data 

using a unique supplier ID/package ID combination that is included on both information 

carriers. 

For deliveries via an external warehouse, the subcontractor must be integrated into the 

EDI-managed information network. The supplier sends the advance shipping notice and 

transportation data to the customer and the subcontractor (in VDA 4913 format, for example). 

Returnable packaging management 

Increasingly, the ownership and maintenance of returnable packaging is being transferred to 

subcontractors who specialize in returnable packaging management. These subcontractors hire 

out the packaging to the supplier for a fee. The manufacturer reimburses the supplier a fee for a 

specific number of days. 

Warehouse inventory of shipping material is therefore an additional cost factor to be planned for 

on the supplier side. 

Two issues must be taken into consideration here: 
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 All shipping material movements and the current shipping material balance must be managed 

in a shipping material account (see "Shipping material account, Ship.mat. act" page 339). 

 Load carrier data is exchanged via EDI in VDA 4927 format, for example. The load carrier data 

contains a monthly detailed statement with all inventory and movement data as well as 

event-driven statements for returnable packaging shipments and requests. 
 

Order release management 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

For basic information on using electronic data transfer for delivery order releases and JIT delivery 

order releases in the automotive industry, see the EDI and order release management (page 277) 

Help topic. 

The first part of this Help module describes order releases (page 293) and explains how to 

generate load lists (see "New load lists" page 297). 

The second part shows you how to carry out an EDI comparison (page 305). 

For more information, see the Cumulative quantities concept (see "Cumulative quantities" page 

307) Help topic and the related Payment advices (page 311) Help topic dealing with payment 

processing. 

The EDI journal (page 315) is described in a separate Help topic. 

The Retrospective price change (page 315) Help topic describes how to work with retroactive price 

changes in Automotive business relationships. 
 

Order releases 

Order releases play an important role in the context of order release management (page 293). 



294 | Infor COM 7.5 User Guide 

 

Sales 

 

Outl. agreement 

With a purchase order, a customer generally issues a concrete delivery order with defined 

quantities and dates. However, in the automotive industry this type of individual order is usually 

issued for test prototypes only, for example. Serialized items are processed using outline 

agreements. An outline agreement is based on the purchase order quota and the total 

requirements for a specified time period. The customer informs the supplier of the number of 

vehicles of a particular model that will be built and the percentage of the total volume of the 

serialized item that the supplier needs to deliver. 

An outline agreement substantiates long-term agreements with a customer. The parties agree 

which items are to be purchased under which conditions and over which time period. Agreements 

are normally made based on quantity. 

Note: You maintain outline agreements in the Order releases object in Automotive. 

The customer profits from this form of contract due to the price advantage of procuring larger 

quantities. Based on long-term requirement planning, the supplier can optimize purchasing and 

production. For information on how to enter an outline agreement in Sales, click here (see "Enter 

outline agreement and order release in Sales" page 296). 

Order release 

An order release in Infor COM provides an overview of the releases carried out for an outline 

agreement. It therefore reflects the current order release status of a specified outline agreement. 

An order release provides an overview of the releases actually carried out over the duration of the 

outline agreement, which are carried out based on the terms of the outline agreement. The order 

release is a continuous order until the agreed release quantity has been fulfilled and, if necessary, 

beyond that point. The underlying terms of the outline agreement are defined on the Outline 

agreement view of the order release. 

An order release is created for each item and the respective order releases, which can vary daily, 

are then sent to the supplier. The order release is adjusted according to the new requirement 

messages (order releases).  
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Releases 

Delivery order releases and JIT delivery order releases are created for recurring requirement 

situations that differ in terms of quantity and/or time period. These order releases are then 

transferred to the supplier. They are based on the requirements calculated by the automobile 

manufacturer and describe the requirement dates for the near, middle, and distant future for a 

period of up to 24 weeks. 

The first five to nine weeks are specified in delivery days in the form of arrival and shipping dates. 

The subsequent requirement periods provide an overview and are grouped into calendar weeks or 

months, depending on the manufacturer. 

You enter the order releases for existing order releases in the table on the Releases tab (Order 

release view). 

For information on how to enter an order release, see Enter outline agreement and order release 

in Sales (page 296). 

For information on how to enter releases, see Enter releases (page 296). 

Order release price calculation 

In Automotive, it must be possible to define prices at customer, item, and plant level. It should also 

be possible to define prices based on a freely defined validity date. 

Note: The price tables in Sales are limited to 255 due date tables with 4 fixed time periods each. 

The outline agreements created between customers and suppliers can also contain pricing policy 

specifications, for example, times of price changes or regular price discounts. 

For low-volume serialized parts and sample parts, for example, it is possible that there was no 

price defined at the beginning of the outline agreement, although the delivery still needs to go 

ahead. In this case, an estimate price is defined in advance. Delivery lines with an estimate price 

flag must not be invoiced before the final price is fixed. If the estimate price flag is removed, the 

new price is entered as the basis for invoicing in the advance shipping notice lines and the 

corresponding open order release lines. 

For more information, see also Enter order release prices and estimate prices (page 297). 
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Enter outline agreement and order release in Sales 

For general information on order releases, see Order releases (page 293). 

Use an outline agreement to enter long-term agreements with a customer. These are generally 

quantity and time-specific. 

1. In the Sales module, select the Order releases object in the Order management folder and 

then select the New tab. In the form, select the customer in the Customer ID field and the item 

you want covered by the outline agreement in the Resource field. Confirm your entries by 

clicking Create. 

Note: If the currency unit of the outline agreement differs from the one stored for the 

customer, select the required currency unit in the Currency unit field. 

2. To view the outline agreement data, select View and Outline agreement. In the Quantity field, 

select the total delivery quantity that you want to agree upon with the customer and the unit of 

measure, if applicable. 

3. In the Confirmed date field on the Order release overview/dates tab, enter the fulfillment date 

by which all items are to be delivered. 

Note: This data is displayed later in the Order release view in the Outline agreement form 

section. 

4. Save the outline agreement/order release by selecting Data and then Save. For information on 

how to enter subsequent releases for this outline agreement, see Enter releases (page 296). 
 

Enter releases 

For general information on order releases, see Order releases (page 293). 

For information on how to enter an outline agreement and order release, see Enter outline 

agreement and order release in Sales (page 296). 

You can enter releases for an entered order release. Releases are normally entered automatically 

when electronic data transfers are carried out. However you can also enter them manually in 

Automotive using the Import messages (page 318) object. To enter a release manually, complete 

the following steps: 
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1. Open the order release for which you want to enter a release by clicking the Order releases 

object in Sales. 

2. Enter the release on the Releases tab. 
 

Enter order release prices and estimate prices 

For general information on order releases, see Order releases (page 293). 

The following instructions describe how to enter order release prices and estimate prices. 

1. In Sales, open the Order release management folder and select the required order release. 

2. Select Go to and Order release price calculation. 

3. In the Price changes tab, enter the date in the Valid from field, as well as the old price, new 

price, and the estimate price (EP) flag. 

If the price entered in the price table is flagged as an estimate price, the line price is also 

marked as an estimate price in the order release on the Prices tab (Convert estimate prices). 

The price change data is saved on the Change history tab. In addition, the user, date of the 

change, and a comment are entered for each change that is made. 

To convert an estimate price to an actual price, clear the EP check box and save the price in the 

price table with the corresponding validity date. 

Notes 

 When creating a delivery line, the prices entered on the Prices tab in the order release are 

taken from the order release price calculation. 

 For order release lines with estimate prices, no calculation is carried out. However, they 

are taken into account for statistical evaluations. 

 The Reports folder in the Sales module includes an Order release prices report. You can 

use this report to print the order release pricing information that has been saved. 
 

New load lists 

For an overview of order release management, see the Order release management (page 293) 

Help topic. 
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Call 

To generate a load list (see "Load lists" page 300), select the Order release management folder in 

Sales and click New load lists. 

Creation 

Select a customer ID and ship date, for example. The load lists are created for the relevant dates 

in the order release. 

In general, when you merge load list lines to form a load list, a new load list is generated for each 

customer, plant, and shipping type. If you select the Separate load lists for each unloading point 

flag for an unloading point, a new load list must be generated for each customer, plant, shipping 

type, and unloading point. For order release lines of the MAIS pick up sheet (see "MAIS pick-up 

sheet" page 281) type, a separate load list must also be created per customer for each document 

ID. 

If the Availability check function is selected on the New  tab, the available inventory is included 

automatically when the possible actual quantity is calculated. If the availability check is not 

selected, the planned quantity is entered as the actual quantity. 

Outstanding order release lines 

Outstanding order release lines are determined as follows: 

 The difference between the cumulative planned quantity (CPQ) and the cumulative delivered 

quantity (CDQ) is determined for the order releases selected on the New tab for the load list. 

All order release lines that have not yet been delivered and that correspond to the specified 

selection criteria are taken into account. 

 The cumulative outstanding delivery quantity for all lines is calculated taking into account the 

predefined shipping date or arrival date for the order release. 
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Note 

When generating a new load list, the system evaluates the Shipping: Determine rel. type for entire 

rel. flag, which is entered on the Flags tab for the unloading point line.  

If this flag is selected, the system first determines the highest order release type of the entire order 

release. It then accumulates the quantities for this order release type from the order release lines 

yet to be delivered and enters these quantities in the load list. 

If the flag is not selected, the system determines the highest order release type from the order 

release lines yet to be delivered. 

Example 

The tables below provide an example. 

CRQ 1000 CDQ 1800 CPQ 2800 

Abs. CRQ 10000 Abs. CDQ 10800 Abs. CPQ 11800 

 

 ID Quantity Due date 

Last ASN 44335 700 3/30/2014 

Last planned load list 44336 1000 4/1/2014 

 

Type Due date Order release quantity CORQ Cumulative quantity comparison 

MA 01.04.2000 100 1100 700 

DR 03.04.2000 100 1200 600 

DR 06.04.2000 100 1300 500 

WP 13.04.2000 300 1600 200 

WP 20.04.2000 500 2100 -300 

MP 12.05.2000 2000 4100 -2300 

RE 03.06.2000 6000 10100 -8300 

 



300 | Infor COM 7.5 User Guide 

 

Sales 

 

For the order release, the difference between the cumulative planned quantity and the cumulative 

delivered quantity is calculated. Then the cumulative open delivery quantity of all lines is 

calculated for the order release, taking into account the predefined shipping date or arrival date. 

If the difference between the cumulative planned quantity and the cumulative delivered quantity is 

lower than the cumulative open delivery quantity of all lines (in other words, the total of all open 

delivery quantities for an item for a predefined shipping date), a new load list line is created 

according to the following formula: 

 

Planned delivery quantity = Cumulative open delivery quantity - (Relative cumulative planned quantity - Relative 

cumulative delivered quantity) 

When this load list line is generated, the cumulative planned quantity is automatically increased by 

the planned delivery quantity. 

Example: In the above example, the following load list lines would be assigned a shipping date 

of 5/12/2014: 

 

Cumulative open delivery quantity (100 + 100 + 100 + 300 + 500 + 2000) 

- Relative cumulative planned quantity (2800) 

+ Relative cumulative delivery quantity (1800) 

_____________________________ 

= Planned delivery quantity 2100 
 

Load lists 

Call 

Sales > Order release management > Load lists 
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Description 

A load list is a list of the goods that are to be transported (load) via a given means of transportation 

(e.g. a truck). 

Load lists should use freely definable selection criteria (e.g. customer, order release, plant, or 

unloading point) for a preset shipping date (the requested date from the order release) to display 

all order release lines to be delivered with your planned delivery quantities. See Generate load list 

(see "New load lists" page 297). 

Please refer to the EDI and packaging (page 291) Help topic also. 

Functions 

Autom. reservation: The system attempts to reserve the actual load list quantity according to the 

issue strategy, taking into account the warehouse coordinates of the item from the load list line. If 

only a partial quantity of the actual load list quantity can be reserved, no reservation is made. An 

inventory transaction is displayed indicating that an insufficient quantity was found. 

If partial quantities were reserved, you can view and modify them by selecting Go to and 

Reservation. 

If, when creating the advance shipping notice, the system determines that only part of the actual 

quantity was reserved, it displays an error message and cancels the creation of the advance 

shipping notice (for this load list line). 

If individual load list rows are selected, the function is run for these rows only. If there are no rows 

selected, all lines are processed. 

You can view the reserved quantity on the Coordinates tab. 

Create actual load list: When you select this function, the status of the current planned load list is 

changed to Actual load list. The packages are generated during this process. 

Check shipping material availability: Use this function to check whether the required shipping 

materials are available. 

Create follow-up load list: You can use this function to create another load list if, for example, a 

truck is fully loaded. All outstanding lines are transferred to a new follow-up load list. See Create 

follow-up load list (page 303). 

Expand all/Collapse all: You can use these functions to show/hide substructures in the load list. 
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Update shipping material requirement via packing instruction: This function checks whether a 

more up-to-date packaging instruction exists and, if it does, it uses this as the current packaging 

instruction. 

Print shipping documents in acc. with VDA4939: You can use this menu command to print the 

shipping documents in the load list sent to BMW in accordance with VDA 4939 (see 

Document-oriented material flow (BeloM) (page 287)). 

Print advance shipping notice and create EDI: You can use this menu command to print the 

advance shipping notice. EDI data will be created, but not sent. 

Create advance shipping notice with issue and EDI: You can use this menu command to print and 

issue the advance shipping notice. EDI data will be created, but not sent. 

Send EDI advance shipping notice: You can use this menu command to send advance shipping 

notice EDI data. 

 

Since the EDI advance shipping notice is sent on the basis of the load list in the standard version, 

various functions are provided for creating and sending EDI advance shipping notices. 

Example: When EDI advance shipping notices are sent, a standard advance shipping notice is 

generated and the EDI link file is stored in the configured directory (see DeliveryNoteFile). The 

file name is structured as follows:  

<Customer ID>DELNOTE<Current date>.INH. 

You can access the advance shipping notices in the EDI journal under the export date by 

specifying the customer ID and the EDI standard VDA 4913. 

In practice 

For information on how to generate load lists, see Generate load list (see "New load lists" page 

297). This Help topic describes how to assign shipping materials (see "Shipping material, Ship. 

mat." page 332) to a load list (as well as an advance shipping notice line). For general information 

about packages, see Packages (see "Shipping material, Ship. mat." page 332). 

 If an order release line or an order line is created, the packing instructions are either taken 

from the order releases that were received via EDI or from the master data for the item and are 

used to determine the shipping material requirements. 
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 These shipping material requirements form the basis for planning shipping material (see 

Packaging (page 329)). The packing instructions are taken from the order line and transferred 

to the load lists. Otherwise, the current default instructions are transferred and the quantities 

are calculated. Both alternatives are determined by the LoadListPackagingFromOrder entry. 

You can access the assigned shipping material from a load list line by selecting Go to and 

Shipping material. 

You can also view information about the packages (see "Packaging" page 329) on the Package 

quantities tab. 

Notes:   

 If you change the actual quantity on the Load list tab, the packages are generated again. You 

can check this in the line view on the Required ShM quantities tab. 

 If you change the fill quantity in the line view on the Required ShM quantities tab, the package 

quantities are adjusted. This allows you to achieve optimum utilization of pallet capacity. 

 Double-click a row header in the opened load list to access the line view. The line view 

displays the shipping material requirements. 
 

Create follow-up load list 

Load lists (page 300) are compiled for a ship-to address and a shipping date. All order release 

lines that match the required criteria are included in one load list. 

If you need to distribute a load list to several load lists with the same time and shipping date, 

complete the following steps. 

1. Select Sales > Order release management > Load lists to open the load list for which you need 

to create a follow-up load list. 

2. Edit the load list so that the lines corresponding to the first truck, for example, are prepared 

accordingly. Complete lines are ignored during the transfer. 

Example: 

A load list contains three lines. The first line is partly delivered, the second line is not 

delivered at all, and the third is delivered in full. 
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I tem ID Act.  qty  Planned qty  

100011 1830 2440 

100012 0 200 

100013 200 200 

3. Select Functions > Create load lists. The menu command is available for planned and actual 

load lists. 

Example: 

The follow-up load list from the previous example contains the following lines. 

I tem ID Act.  qty  Planned 

quanti ty  

100011 610 2440 

100012 200 200 

You can also transfer individual lines to a new load list if you select them before calling the 

command. 

Note: For unsaved load lists, you will be asked whether the changes should be saved. 

Click Yes to confirm and save the changes in the existing load list. 

The new load list is created: 

 The header data is transferred to a new load list and a new ID is assigned. 

 For all lines, the difference between planned and actual quantities is transferred as the 

new actual quantity. 

 Lines that have already been delivered in full are not transferred to the new load list. 

 Packages are also created for new load lists in actual load list status. 

 The original load list is stored on the Transportation data tab in the Load list header view. 
 

Calculate volumes 

Infor COM allows you to view the shipment volume. The shipment volumes calculated on the basis 

of the generated packages and the associated unit of measure are displayed in the load list 

header. This information is then transferred from here to an ASN EDI or for output on documents. 

To calculate the volume, complete the following steps: 

1. In Sales, select the Packaging folder and enter the  length, width, and height specifications for 

the required shipping materials. Enter the volume unit also. 
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2. In Sales, open the required load list by selecting Order release management and Load lists. 

In terms of calculating the weight of packages and shipments, a volume calculation is carried 

out each time a package is changed or regenerated (for example, if the quantity is changed in 

the load list line). 

3. You can also change the size dimensions for each package on the Package weight tab. 

The changed data is taken into account when calculating the volume. 

Costing in detail: 

The first step of the calculation involves attempting to determine the volume unit. If a meter 

size dimension or cubic meter volume unit is already defined in the packages, m3 is set as 

the volume unit for the shipment. Otherwise, the volume unit is determined from the 

LVME allocation table based on the size dimension of the first package. 

The second step involves calculating the shipment volume. The system searches for 

packages with the same size dimensions so that the calculation only needs to be carried 

out once for all packages (performance optimization). The result of the calculation is 

returned in the load list header. 
 

EDI comparison 

Description 

The delivery order release/JIT delivery order release EDI transfers the delivery order release/JIT 

delivery order release data (see "Order releases" page 293) sent by the automobile manufacturer 

via EDI to existing order releases. If the delivery order releases/JIT delivery order releases are 

new, new order releases are created automatically. All EDI data is stored in a log table where it 

can be maintained at a later stage. Any errors that occur during the transfer are logged in the 

mailbox. 

EDI profile 

Since the field assignments differ from manufacturer to manufacturer or vary from time to time, 

each automobile manufacturer is assigned a different EDI profile for the transfer of data to the 

order releases. 
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Automatic comparison 

When you import data from the delivery order releases and JIT delivery order releases, the 

quantities and dates are compared automatically with the previous import of the same order 

release. This EDI comparison is then printed out. Report comments are also generated 

simultaneously in mailbox 110. 

Please note: The AMCOMPPAR allocation table stores the tolerance values for the variance 

report as well as the relevant period. It also defines whether the comparison is based on the 

quantities for the individual dates or for the total quantity over the entire period. The output method 

in the event of an error is also defined here. 

Manual comparison 

You can also select any two order release statuses and compare them with each other. 

 For more information on how to carry out the EDI comparison, see Carry out EDI comparison 

(page 306). 

Note: If during this comparison the system determined that a tolerance value has been exceeded, 

it prints a list and/or generates a mailbox entry. The parameter settings for the old/new comparison 

are stored in the AMCOMPPAR allocation table. 
 

Carry out EDI comparison 

For information on EDI comparisons, see EDI comparison (page 305). 

1. Select Sales > Order release management > EDI comparison. 

Note: The data displayed in the header of the following page is taken from the order release. 

2. In the Old and New sections of the form on the Delivery order release tab, use the check box to 

select the order release statuses for both chronological statuses of the order release that you 

want to compare in the field of the same name. 
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Cumulative quantities 

Call 

Sales > Order release management > Cumulative quantities  

Definition 

A cumulative quantity is a cumulative amount of an item that represents the accumulated 

quantities starting from a cut-off date. 

Description 

Cumulative quantities (CQ) are required for checking the delivery situation for outline 

agreements/order releases (see "Order releases" page 293). Cumulative quantities are key 

figures that represent accumulated quantities starting from a cut-off date. They enable you to 

easily compare planned and actual delivery quantities. When requirement situations change 

frequently, cumulative quantities provide you with an overview of the current status and the most 

recent changes. 

The cumulative quantity system allows you compare planned and actual figures. In all order 

release systems, the customer provides the supplier with the cumulative quantity of the received 

deliveries. The supplier must manage the accumulated delivered quantity in the supplier's system. 

The difference between both figures corresponds to the goods in transit. For each delivery day, 

the cumulative planned quantity that must be delivered by this time is recorded. The comparison 

between the cumulative order release quantity and the cumulative delivered quantity provides 

information on the inventory requirement situation. 

Cumulative quantities are updated in the following situations: 

 When you create a new order release or delivery order release/JIT delivery order 

release/manufacturing order release, 

 When you change an order release or delivery order release/JIT delivery order release, 

 When you enter a new order release, 

 When you create/change/delete a load list, 

 When you print or cancel an advance shipping notice, 

 When you transfer old data. 
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Types 

 Cumulative delivered quantity: The cumulative delivered quantity indicates the quantity 

delivered to the automobile manufacturer (customer), i.e., the quantity for which an advance 

shipping notice was created. The cumulative delivered quantity is updated for each new 

advance shipping notice and is managed using absolute (over the entire term of an outline 

agreement) and relative (from a cut-off date) quantities. In relation to the cumulative delivered 

quantities, there are no differences in terms of delivery order releases/JIT delivery order 

releases, and manufacturing order releases. 

 The Cumulative received quantity is the delivery quantity that the customer confirms having 

received. The cumulative received quantity is updated using delivery order releases and JIT 

delivery order releases and is managed using both absolute (over the entire term of an outline 

agreement) and relative quantities (from a cut-off date).  

Note: You must specify in the message profile (see "Message profiles" page 326) whether the 

cumulative received quantity is transferred relatively (starting from a cut-off date) using the 

order release/JIT delivery order release, whether it is confirmed using the last advance 

shipping notice only, which is required to calculate the cumulative received quantity, or 

whether neither of these alternatives is used. 

 The cumulative order release quantity is the sum of the relative cumulative received quantity 

and the total order release quantities up to and including the order release date. It is shown for 

each order release date, and differs for delivery order releases, JIT delivery order releases, 

and manufacturing order releases. It is updated each time a delivery order release, JIT 

delivery order release, or manufacturing order release is transferred. 

 The Cumulative planned quantity is the sum of all created load lists (page 300) since the set to 

zero date (relative cumulative quantity), or since the outline agreement was created (for 

absolute cumulative planned quantity). 

The following always applies: Cumulative received quantity <=  Cumulative delivered quantity 

<=  Cumulative planned quantity. 

The difference between the cumulative delivered quantity and the cumulative planned quantity 

is the amount used to generate load lists (but not advance shipping notices) on a certain date. 

Each time a load list is changed, the cumulative planned quantities are changed also. The 

cumulative planned quantity remains the same for delivery order releases, JIT delivery order 

releases, and manufacturing order releases. It is managed as a relative and absolute quantity. 

In practice 

Cumulative quantities should be displayed for an order release, order release line, advance 

shipping notice, and item account. You can view each form by selecting Go to and then 

Cumulative quantities. Depending on the order release type (delivery order release, JIT delivery 

order release, manufacturing order release) you can display different values for the same outline 

agreement. 
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Example 

The following example illustrates the concept of cumulative quantities and demonstrates the 

practical uses of working with cumulative quantities. 

 Date Unit CPQ CDQ Cumulative 

received 

quantity 

Requested dates for order 01.01. 

10.01. 

20.01. 

30.01. 

100 

110 

120 

130 

0 0 0 

Load list created 01.01. 100 100 0 0 

ASN created 01.01. 100 100 100 0 

Load list created 10.01. 110 210 100 0 

ASN created 10.01. 110 210 210 0 

Customer confirms receipt of both 

deliveries via EDI 

  210 210 210 

Load list created 20.01. 120 330 210 210 

Changes made to load list, as 

inventory too low 

20.01. -15 315 210 210 

ASN created 20.01. 105 315 315 210 

Load list created 30.01. 145 (130+15) 460 315 210 

ASN created 30.01. 145 460 460 210 

Customer confirms receipt 

(delivery from 1/30 has not been 

received yet) 

  460 460 315 

 

Working with cumulative quantities offers advantages such as the following: 

 You can determine the quantity in transit from the difference between the cumulative delivered 

quantities (CDQ) and the cumulative received quantities (CRQ), i.e. the proportion of the 

delivered quantity that has not yet been posted as goods receipts by the automobile 

manufacturer. 

 The quantities are generally  set to zero by the automobile manufacturer via the order release 

EDI. When this set-to-zero EDI is transferred, the cumulative delivered quantities (CDQ) and 

cumulative planned quantities (CPQ) are recalculated automatically by the program. 
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View cumulative quantities 

Cumulative quantities (page 307) document the delivery status of order releases (page 293). To 

view cumulative quantities for an order release, complete the following steps: 

1. Select Sales > Order release management > Cumulative quantities, enter the order ID of the 

order for which you want to view the cumulative quantities, and confirm by selecting Load. 

2. Note the following on the Order release data table section of the Cumulative quantities view: 

The cumulative delivered quantity must always be greater than or equal to the cumulative 

received quantity. 

Example: 

In the following example, 49,500 units were delivered since 10/27/2014, in other words, 

the last set-to-zero date, (see Relative cumulative delivered quantity) and subsequently 

confirmed (see Relative cumulative received quantity). 

Rel. CRQ 49.500 Rel. 

CDQ 

49.500 Rel. CPQ 49.500 Set to zero 10/27/2014 

Abs. CRQ 148.500 Abs. 

CDQ 

148.500 Abs. CPQ 148.500   

3. To determine the period for which the order release applies, select Go to and Order release. 

Then select View and Outline agreement. The Date field on the Order release overview/dates 

tab shows the date the outline agreement was issued. The absolute cumulative delivered 

quantities and absolute cumulative received quantities are calculated beginning from this date. 

Example: In the example, this is 148,500 units. 

The relative cumulative quantities are calculated beginning from the last set-to-zero date (in 

the example, 10/27/2014). 

Note: DR in the Type column on the Delivery order releases tab of the order release stands 

for daily order release. The Requested date is the date when the customer would like the order 

to be delivered. The cumulative order release quantity is the sum of the relative cumulative 

received quantity and the order release quantity up to and including the requested delivery 

date. 
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Payment advices 

For general information on payment transactions in Automotive, see EDI and payment 

transactions (page 288). 

For an overview of order release management, see the Order release management (page 293) 

Help topic. 

Call 

Sales > Order release management > Payment advices 

Description 

A payment advice is a message exchanged between trading partners to indicate a payment or 

other form of financial settlement. 

In Automotive, a payment advice contains detailed information on an incoming payment and is 

required in order to allocate and reconcile the outstanding items. 

The information refers to the payment of the goods and services that are itemized in the payment 

advice. 

Example: VDA Recommendation 4907 is required for record types and record type structures, for 

example. 

Record 

type 

Meaning Fields 

911 Transfer prefix Customer ID, Supplier ID, Transfer IDs, Payment date 

912 One-off payment data Document type, Date, Final value, Sign, Payment advice ID 

919 Payment data suffix Record type counter, Payment type, Payment totals 

 

This method description regulates the processing of electronic data interchanges between the 

automotive industry and suppliers. 
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In practice 

The subcontractors (suppliers) send the goods to the manufacturer first. For payment, there are 

two options available: 

 Use of the credit memo procedure (page 312) was agreed with the manufacturer for payment 

of the goods. In this case, the manufacturer transfers the credit memo to the supplier when the 

goods are received (as per VDA Recommendation 4908, for example). This data together with 

the data taken from the internal Infor COM invoice are used to generate a received credit 

memo. The data on the payment advice can then be compared to the data on the received 

credit memo using the link to the external credit memo ID. 

 An invoice is sent to the manufacturer. In this case, the subcontractor sends an invoice to the 

beneficiary (also possible via EDI using VDA Recommendation 4906, for example). When 

paying for the goods, the payment advice includes a reference to the Infor COM invoice, 

which, in turn, allows the payment data to be compared with the invoice data. 

You can import payment advice data using the Import messages object by clicking the Payment 

advice check box in the relevant dialog box. For more information, see the Import messages (page 

319) Help topic. 

 
 

Credit memo procedure 

For an introduction to this Help topic, see EDI and payment transactions (page 288). 

For an overview of order release management, see the Order release management (page 293) 

Help topic. 

Description 

Subcontractors (suppliers) do not usually create invoices for their goods and services when using 

the credit memo procedure. Instead, the beneficiary (customer) periodically generates a credit 

memo for the goods delivery that was received based on the service provided to the customer by 

the supplier. The customer then sends this credit memo to the supplier. The credit memo is based 

on the goods receipt data valuated using the prices and is simultaneously assigned to the due 

dates. 
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The additional effort required on the part of the subcontractor is covered by EDI message VDA 

4908 - Electronic data interchange of credit memo information. The subcontractor can manually 

compare his advance shipping notice and invoice information with the transferred credit memo file. 

The ASN ID is used as the search criterion for the comparison on both sides. 

Prerequisites 

 The credit memo sent by the beneficiary has the same effect in Infor COM as an invoice; it 

affects both incoming payments for financial accounting and sales revenue statistics. 

 The Infor COM-internal invoice is created by the subcontractor when the goods are issued. If a 

credit memo is received later, it is used for comparison. 

 The financial accounting department of the subcontractor is responsible for following up on the 

credit note in Infor COM (complaints, tracking incoming payments, etc.). 

Invoice approval 

The task of invoice approval is therefore shifted to the supplier, who must compare the credit 

memo data with his invoice data. Any variances are highlighted in color in the received credit 

memo on the Internal invoice tab. 

The subcontractor is responsible for resolving any differences and initiating adjustment postings. 

Configuration 

You can enter the following default settings in the header of message profile of EDI standard 4908: 

 Plausibility check: If you enter the value No here, the business-related contents (quantities, 

units of measure, prices) will not be checked more closely when you import messages in 

Automotive. 

 Update internal invoice: If you enter the value No here, you will be able to create any number 

of (partial) received credit memos without changing their status. Please note that this setting 

can be overridden if the COMMON.AUTOMOTIVE.UPDATEINTINVOICE parameter is the 

default setting. 

If No is the default setting in both cases, the following functions are activated: 

The creation of all CM rows from the EDI, even if these are not included on the original advance 

shipping notice (ASN). 

In practice 

Both received credit memos and settlement invoices are created as document objects during the 

EDI import. Settlement invoices can be identified, loaded and printed using Numbering 825. 
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Create credit memo 

For information on the credit memo procedure, see Credit memo procedure (page 312). Credit 

memo data is imported when messages are imported. See Import messages (page 319). 

1. In the Sales module, open the Messages folder and select the Import messages object. 

2. In the Type form section, select Credit memos. 

3. If required, use the button in the Import file section to select the path for the file containing the 

credit memo you want to import. 

4. Click OK. When a credit memo is received in Infor COM, the internal invoice and credit memo 

are reconciled. Only the matching credit memo lines are saved in Received credit memos 

(page 247). Records that do not match are logged in a mailbox (and/or Workflow). 

The reconciliation produces a variance report, which indicates the lines from the internal 

invoice that were reconciled with the received credit memo. 

Configuration: You can use the COMMON.AUTOMOTIVE.PRINTBYIMPORTPAYMENT 

configuration parameter to specify whether the report is printed when data is imported, or 

whether it is printed later from the Received credit memos object in the Sales module. 

The invoice journal logs the creation of invoices only. For credit memo customers, the 

journal is updated when the internal invoice is created and transferred to Financial 

accounting. If a credit memo is received, the variance report is transferred to Financial 

accounting, and the outstanding items can be processed. The credit memo is therefore not 

transferred to Financial accounting automatically. You must post it to the correct financial 

accounting system manually. 

5. Go to Sales > Order release management > EDI journal (page 315) to view the imported data 

records. To go to the required credit memo, double-click the row header of the line. To go to 

the  Message editor (page 325), select Go to and Message header. 
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EDI journal 

Call 

To access the EDI journal, select the following: 

 Sales > Order release management > EDI journal 

 Purchasing > e-PROCUREMENT > EDI journal 

Description 

The EDI journal allows you to check incoming and outgoing messages. All imported and exported 

messages are logged in the EDI journal. The journal allows you to track every exchanged 

message. 

In practice 

To edit a message, select a line in the table in the EDI journal and from the Go to menu, select 

Message editor. For more information, see Message editor (page 325). 
 

Retrospective price change 

Call 

Sales > Order release management > Retrospective price change 
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Description 

In Automotive business relationships between customer and supplier, retroactive price changes 

may be applied to business periods that are already closed, or for parts that are already delivered, 

if the goods recipient makes a price change to invoices that have already been cleared. 

In this case, a financial reconciliation must be carried out. Depending on the difference from the 

price already paid, the corresponding invoice lines are processed and grouped together in a sales 

order/credit memo. This data is transferred to Financial accounting and incorporated into the 

corresponding statistics via the sales order/credit memo. 

To do this, select all invoice lines affected by the price changes, and group them together in a 

sales order/credit memo for each goods recipient. 

For the new price, enter the difference between what was paid already and the new price. There 

are two distinct scenarios here: 

Positive difference 

If the new price is greater than the original invoice price, the supplier can invoice the customer for 

the difference. To do this, a sales order is generated and invoiced via the Settlement invoice 

function (corresponding to special invoicing), for which no inventory posting has been made. 

Negative difference 

If the new price is less than the original invoice price, the supplier must credit the customer for the 

difference. In this case, a credit memo is generated and is transferred to Financial accounting 

when printed. 

Please note: The generated sales orders can be identified by numbering method 830. 

In practice 

For step-by-step instructions, see Carry out retrospective price change (page 317). 

Please note: When surcharges or deductions (inflation surcharges, fixed discounts, percentage 

discounts, etc.) are applied to original invoices, value-based differences may occur during value 

reconciliation via the Retrospective price change process as the difference is calculated using the 

invoiced price only. 
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To create a new retrospective price change for a retrospective price change that has already been 

carried out, the generated invoice must first be cancelled or the sales order must be deleted. 
 

Carry out retrospective price change 

For information on retrospective price changes, click here (see "Retrospective price change" page 

315). 

1. Go to Sales > Order release management > Cumulative quantities 

2. Populate all fields on the Retrospective price change dialog box. 

3. Click OK to start the generation. 

In Sales, a new object (sales order or credit memo) is generated by numbering method830. 

This object is assigned a flag to indicate that it was generated from the retrospective price 

change process. 

 

Open sales order 

1. Go to Sales > Order release management > Sales orders, populate the required fields, and 

confirm by selecting Load. 

If the retrospective price change is for a sales order, the Retrospective price change tab will be 

displayed. 

2. You can edit any fields that may be edited in the lines, or delete unnecessary lines.  

3. Select Functions > Create document to print the settlement invoice. 

 

 

Open credit memo 

1. Select Sales > Order processing > Credit memos, populate the required fields, and confirm by 

selecting Load. 

If the retrospective price change is for a credit memo, the Retrospective price change tab will 

be displayed.  

2. You can edit any fields that may be edited in the lines, or delete unnecessary lines. 
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3. Select Functions > Print and click OK to confirm the following dialog box. This will generate the 

credit memo document and transfer the values to Financial accounting. 

 
 

Messages 

Call 

You can edit messages in the Automotive and e-Procurement module by selecting 

Sales/Purchasing > Messages > Message editor. 

Description 

Within Automotive, this term refers to the EDI messages that are used by the system. 

EDI messages are documents that are exchanged electronically between trading partners. The 

standardized structure of EDI messages allows them to be interpreted in exactly the same way by 

both the sender program and the recipient program. 
 

Import messages 

Call 

Sales > Messages > Import messages 

Purchasing > Messages > Import messages 

Description 

For important background information on importing messages, see Order releases (page 293) and 

Messages (page 318). These Help topics explain how to import messages (see "Messages" page 

318). 

The following explanations apply to Automotive, however you can also follow the same procedure 

to import messages in e-Procurement. 
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Configuration 

The main default settings for importing messages are defined in the COMMON.AUTOMOTIVE 

section of the configuration. 

In practice 

The Dummy.arc synchronization file must be included in the import directory. Generating the 

Dummy.dta file from the Dummy.arc file locks messages and prevents them from being used for 

other processes. 

Messages are imported according to the following process. 

1. The customer informs the supplier of how many vehicles of a particular model will be built over 

a particular time period – for more information, see Order releases (page 293) and Order 

release outline agreements. The order releases are derived from the requirements calculated 

by the automobile manufacturer and describe the requirement dates for the near, middle, and 

distant future for a period of up to 24 weeks, for example (see EDI and order release 

management (page 277)). The subsequent requirement periods provide an overview and are 

grouped into calendar weeks or months, depending on the manufacturer. In the automotive 

industry, these order releases can be sent via EDI once a week. 

2. Using electronic data interchange, the manufacturer sends data encrypted according to the 

VDA, ODETTE, or EDIFACT standard. This data is stored directly as an ASCII link file, or it 

can be stored in a database table using either the Automotive function or special conversion 

software (for example, WinELKE from Seeburger). You can maintain the data later using the 

message editor. Any errors that occur during the transfer are logged in a mailbox. 

3. The data is transferred to existing order releases when the messages are imported. New order 

releases are created automatically for new delivery order releases and JIT delivery order 

releases, provided the relevant setting is defined in the message profile. 

 
 

Import messages 

For information on importing messages, see Import messages (page 318). 
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To import order release data within the scope of an order release, complete the following steps: 

1. In the Purchasing or Sales module, select the Messages folder and click the Import messages 

object. 

2. Flag all messages to be imported. The path and file name are displayed in the Import file form 

section next to the selected options. 

Example: The default import file for delivery order releases is sa5xx.dta. 

For more information on the individual messages, see the following Help topics: 

 Delivery order releases and JIT delivery order releases (see "Delivery order releases and 
JIT deliveries" page 278), Manufacturing order releases (see "Manufacturing order 

release" page 279) 

 MAIS pick-up sheet (page 281) 

 Credit memos (see "Credit memo procedure" page 312) 

 Payment advice (see "Payment advices" page 311) 

 Load carrier files (see "Shipping material, Ship. mat." page 332) 

 S/C ASN data (see "Subcontractors" page 350) 

To change the path or file, open Explorer using the button to the right next to the file field.  

Live run mode indicates that the data is transferred to the database immediately. The file is 

deleted once the import is completed. 

 The Process modified records option is not active since no records have been processed 

manually. 

3. Select the Rename after import option to ensure that the original file is retained in the current 

directory. 

4. Click OK to start the import. The processing status is displayed in the Status row. 

Note: Messages are generally imported automatically using the Batch control (see "Use 

time-controlled batch processes (Automotive)" page 321) object. 

For information on the data structure of the above messages, see Message profiles (page 

326). 
 

Edit messages 

For more information on importing messages, click here (see "Import messages" page 318). 

If invalid messages were imported, an error message is displayed once the import is completed. 

You can adjust these errors as follows: 
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1. Open the Message editor in the Messages folder in Sales. Select the invalid messages by 

entering the Customer and EDI std.. The invalid messages are flagged in the table by the 

status 20/21. Mailbox entries are generated for lines with the status 20. 

2. Double-click an invalid line with the status 20. 

3. Display the error message on the Mailbox tab. 

4. Go to the Data tab and adjust the error. 

5. Save your changes. Click Yes in response to the prompt about whether you want to assign the 

status Manually processed to the data records. 

6. From the Messages folder, select the Import messages object. On the Import messages dialog 

box that is displayed, select the Process modified records check box. 

 This ensures that only manually processed records are imported again. 
 

Use time-controlled batch processes (Automotive) 

For more information on importing messages, click here (see "Import messages" page 318). 

To minimize your administrative workload, Automotive allows to use time-controlled batch 

processes. 

To do this, go to System functions, open the Administration folder, and select Batch control. 

The Batch control object stores processes that are scheduled to start at a specific time. 

To work with time-controlled batch processes, complete the following steps: 

1. In System functions, click the Batch control object in the Administration folder. Then select the 

Status tab and create the required time-controlled actions. 

The following table provides an example. 

Job 

AM Import messages 

AM Export messages 

2. Save the jobs. 
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3. In System functions, open the Administration folder and click the Batch control object. In the 

Act. column, select the required processes, or click the Start button below the table. The 

processes are either run immediately or at the next possible start time with no further 

messages displayed. Error messages are stored in the relevant mailboxes. 
 

Trade data import 

The Trade data import module allows you to exchange messages in EDIFACT format, which is 

accepted worldwide. 

Please note: You must have the correct configuration defined beforehand. 

Customers and suppliers communicate in Infor COM as before. The messages are converted 

using conversion software (see table): 

 Customer, Cust.  

Messages are received  Messages are sent 

Standard conversion Conversion software Standard conversion 

   

Infor COM EDI master data, EDI message profile, EDI Message editor, EDI message processing, EDI journal 

 

There are also interfaces provided for Automotive and Sales. 

Apart from basic EDI functions such as master data, profiles, a message editor, message 

processing, and an EDI journal, the Trade data import module also provides the following 

documents: 

 EDI purchase order receipts (EDIFACT ORDERS) 

 EDI order confirmations (EDIFACT ORDRSP) 

 EDI outgoing advance shipping notices (EDIFACT DESADV) 

 EDI invoice issues (EDIFACT INVOIC) 
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The following diagram provides a general overview of the various EDI functions: 

 

For more information on EDIFACT standards, see EDI standards (page 260). 

For an overview of the functions available in this module, click here: 

Customer, Cust.  Company type 

PO EDIFACT ORDERS 

 

Receives information 

   

 EDIFACT ORDRSP 

 

Sends order confirmation 

   

 EDIFACT DESADV 

 

Sends advance shipping notice 

   

 EDIFACT INVOIC 

 

Sends invoice 

 

For an overview of the advantages of using EDIFACT standards, click here: 
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Worldwide ODETTE (European automotive industry) 

ANSI X.12 (North American standard) 

EDIFACT SUBSETS 

XML 

ENX 

… 

EDIFACT 

Regional VDA (German automotive industry) 

SEDAS 

EDIFACT SUBSETS (such as EDIBDB) 

… 

EDIFACT 

 Industry-specific Industry-neutral 

 
 

Use Trade data import 

For general information on the credit memo procedure, see Credit memo procedure (see "Trade 

data import" page 322). 

The following process shows a typical example of how the Trade data import object is used: 

1. To create the master data for EDIFACT standards, select the AM master data object in Sales. 

Then select the New tab, assign the company or address ID to the EDI profile, and click 

Create. 

2. In the header form, select the EDI profile, the file name (for export). Then on the Plants tab, 

assign the address IDs. 

3. Use the Message profiles object in the Messages folder to check the message format 

definition and stored information. 

4. In the sales order for example, select Functions and Create document. Created documents are 

logged in the EDI journal (page 315). 

Note: The required documents must be activated in the configuration. 

5. Use the Message editor in the Messages folder to correct any errors. 
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Allocation tables (Trade data import) 

For general information on the credit memo procedure, see Credit memo procedure (see "Trade 

data import" page 322). 

The following allocation table is relevant for the Trade data import object: 
 

EDIINVRECS 

For more information, see Allocation tables (Trade data import/export) (see "Allocation tables 

(Trade data import)" page 325). 

Description: Record types for EDI invoices 

Usage: This allocation table defines the record types and sequence for EDI invoices in the Trade 

data import object. 
 

Message editor 

For information on messages in the context of electronic data interchange, see Messages (page 

318). 

To access the Message editor in Purchasing or Sales, select the Message editor object in the 

Messages folder of either module. You can also access it from the EDI journal. 

You can use the Message editor to update or adjust invalid or incomplete messages imported 

using the Import messages (page 318) object. 

WARNING: Only the system administrator should be permitted to edit messages. We strongly 

recommend restricting the user rights for accessing the messages accordingly. 

Invalid messages are flagged on the Links tab with the status 20 or 21.  

The Data tab displays the consecutive content of the data records. The Find tab displays the 

search terms included in the data record if they have already been assigned. 



326 | Infor COM 7.5 User Guide 

 

Sales 

 

To edit a single data record, select Single record from the View menu to access the single record 

view.  

The Desc. field contains the field names of the data fields for the selected record type. The Data 

column shows the content of each field. You can manage entries in the mailbox in the Text column 

on the Mailbox tab. An EDI entry in the Sender column on the Mailbox tab shows that the mailbox 

entry occurred when the EDI data was imported. 
 

Message profiles 

For information on messages in the context of electronic data interchange, see Messages (page 

318). 

As EDI business partners send EDI data in various formats (see "EDI standards" page 260) (VDA, 

EDIFACT, ODETTE, etc.), and specific manufacturers use both mandatory and optional fields in 

these standardized formats, profiles are used to map the specific characteristics of each company 

in terms of data transfers. All field mappings and process parameters are listed in a table. You can 

access this table by selecting the Message profiles object in the Messages folder in either the 

Purchasing or Sales module. 

WARNING: Only the system administrator should be permitted to edit message profiles. Before 

changing a message profile, we recommend creating a backup profile by selecting Save as from 

the Data menu. 
 

View message profile 

Message profiles (page 326) define the structure of the data that is imported using the Import 

messages (page 318) object. 

1. Open the VDA 4905 message profile. The following table shows a form section with all the 

settings of the table located on the right side of the form header. 
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Function Parameters 

Order release with cum. quantities (Y/N) Yes 

Evaluate last ASN (Y/N) No 

Replace due dates Y/Extend due dates N Yes 

Replace preview date if extending Yes 

Übertragungsnr. neu prüfen (J/N) (Check new transfer ID (Y/N)) No 

Create new orders Yes 

 

The settings in the example specify that the customer delivers cumulative quantities, that 

the last advance shipping notice should not be evaluated, and that the old order release 

should be completely replaced by the new one. The Replace preview date if extending 

option is related to the setting directly before it. It has no effect since Replace due dates 

was set to Yes. The option for checking transfer IDs is not selected, which could lead to 

duplicate transfer IDs. If there is no order release found for the transferred data, a new 

order release is created automatically. 

2. The following example displays a section from the Message tab. 

 

The record types in the following table (e.g. record types 511 and 512 visible here) are set by 

the respective EDI standard. Each line is numbered sequentially. 
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Ext. RT Line of Length Date Field Rule Mand 

511 100 6 9 0 7 0 Not selected 

511 101 15 9 0 10 0 Not selected 

511 102 24 5 0 3 0 Selected 

511 103 29 5 0 3 2 Selected 

511 105 34 6 0 7 0 Selected 

511 106 40 6 0 8 0 Not selected 

512 107 6 3 0 7 4 Selected 

512 108 9 9 0 3 0 Selected 

 

The transfer of the 9-digit supplier ID begins at position 15 of the data record. The date 

format is YYMMDD. The string field type is used and no rule is stored. This is a mandatory 

field, i.e. it must be completed before the message can be sent. 
 

Create message profile 

To create a message profile (see "Message profiles" page 326), complete the following steps: 

1. Open an existing message profile in Sales by selecting the Messages folder and then 

Message profiles. 

2. From the Data menu, select Save as. 

3. On the dialog box that is displayed, enter the EDI standard and EDI profile. 

4. Click OK to confirm. 

5. Make the required changes on the individual tabs of the profile. Help for the settings is 

available in the context-sensitive Help. 
 

Delete messages 

For information on messages in the context of electronic data interchange, see Messages (page 

318). 
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You can use this function to delete messages (page 318) regardless of their status. You can 

choose one of two methods: 

 In the Message editor (page 325), select the message to be deleted and then select Functions 

and Delete message. 

 Select the Delete messages command to display a dialog box for selecting the messages to 

be deleted. 
 

Export messages 

For information on messages in the context of electronic data interchange, see Messages (page 

318). 

You can export EDI messages (page 318) in Sales by selecting the Messages folder and then the 

Export messages object. 

Please note: The Dummy.arc synchronization file must exist in the export directory. Generating 

the Dummy.dta file from the Dummy.arc file locks messages and prevents them from being used 

for other processes. 

You can specify the data you want to export in the Export messages dialog box. 

You can also define the export as a time-controlled action. This action processes the messages, 

reads the EDI standard, determines the configuration entry for the path and file name of the export 

file, and then exports the data. It also saves error messages in the default mailbox and writes to 

the additional EDI table for text. Only messages with the status New or Manually processed are 

taken into account when exporting. 
 

Packaging 

Call 

Purchasing > Packaging 

Sales > Packaging 

Inventory > Packaging 
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Description 

For information on how to handle packages in the context of EDI, see EDI and packaging (page 

291). 

Packaging refers to the wrapping of items using shipping materials, either to delimit the item 

quantity or to secure the item. 

The packaging of items and components in industrial manufacturing has become an increasingly 

integrated part of the manufacturing process over time. The goal of packaging and shipping 

material management in Infor COM is to have this integrated into the item master and order 

release processing system as well as the packaging planning process. 

Terms 

The following overview displays the terms used in Automotive in the context of packaging. 

Shipping materials (see "Shipping material, Ship. mat." page 332) 

Packing instruction 

Shipping material account (see "Shipping material account, Ship.mat. act" page 339) 

Shipping material outside inventory: This is shipping material that is not managed in inventory and 

is used only in inventory or shipping. These shipping materials are flagged on the Ship. mat. tab in 

the shipping material master data. 

Assignment: A packing instruction can be assigned to an item or item group, and/or a business 

partner, plant, or unloading point. The assignment contains the criteria that can be used to find the 

most suitable packing instruction. 
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Shipping material requirements: A shipping material requirement is generated as a result of a 

manual or automatic assignment to an order line, order release line, or purchase order line (using 

packing instructions, if necessary) – see also Assign shipping materials (see "Load lists" page 

300). 

It is calculated by multiplying the unit of measure in the order release line by the quantity of 

individual shipping material lines and can be manually modified later. 

A shipping material requirement is a quantity-based description of the packaging structure – 

similar to the packing instruction, but related to the document line (purchase order, order, advance 

shipping notice, etc.) and with the quantities required for this line. 

It is calculated from the packing instruction when an order release line is created or modified. 

To view the shipping material requirement for an order release, go to the order release and select 

Go to > Shipping material requirements. 

Planning a shipping material requirement includes covering requirements and generating orders 

using backward scheduling from LD, starting from the requirement date. You can also carry out 

ED and CD calculations and an exception check if necessary. 

Package: A package corresponds to the item quantity (including packaging) that is grouped into 

one unit by the selected packaging. 

One package therefore equates to one unit of packaging plus goods. 

Packages can be moved, repacked and assigned a label (e.g. pallets, small load carriers). 

The package is used to calculate the weight, and it serves as the basis for the inventory postings 

for the shipping material. 

Packages can be generated in an advanced shipping notice. In turn, you can go from the 

advanced shipping notice to the shipping material requirements. 

Load units: A load unit is a handling unit created by the loader that cannot be broken down during 

transportation. Load units have several individual containers, such as cartons, boxes, or crates. A 

load unit has a unique scannable ID, which enables load unit data to be displayed. 

The customer or forwarding agent – depending on who transferred the goods to be transported to 

the carrier – creates the load units for transportation. A load unit can be made up of several 

packages or may comprise just a single package. In the packaging hierarchy, load units are set at 

packaging level 0. 
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Shipping material, Ship. mat. 

Description 

Shipping material means an item with a specific usage and additional properties. Shipping 

material is a general term for bins, pallets, means of transportation, shipping material outside 

inventory, racks, frames, etc. 

Shipping materials can be either in-house items or purchased or sales items. Shipping materials 

are generally purchased items (this also applies to hired shipping materials).  

Note: The terms shipping material and load carrier (VDA term for shipping material) are used 

interchangeably in the following explanation. 

Functions 

To display all packing instructions in which the current shipping material is contained, select 

Functions and Use in packing instructions. 

Configuration 

Shipping materials are configured in the COMMON.PACKAGING section. 

In practice 

Shipping materials or load carriers (auxiliary tools for storing and transporting goods) can belong 

to the automobile manufacturer who provides them to their supplier free of charge on request. 

Automobile manufacturers can instead engage external operators who specialize in returnable 

packaging management. These operators acquire ownership of the containers and take 

responsibility for maintenance and administration themselves. This means that packages 

(shipping materials) must be managed and planned in Infor COM and fully integrated into the item 

master and order processing functions. 

You can use all item-related functions such as Purchasing, Inventory management, Storage, 

Movements, Goods issue, and Inventory count for shipping materials. Shipping materials can also 

be included in planning as normal purchased items or manufactured items. See also Manage 

shipping materials (page 333). 
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Example: The following diagram shows an example of a package structure assembled from 

several shipping materials that can be defined using a packing instruction (SLC = Small Load 

Carrier). 

Note: Cover 4410, SLC 4413, and underlay are shipping materials. 

 

 
 

Manage shipping materials 

For general information on shipping materials, see Shipping materials (see "Shipping material, 

Ship. mat." page 332) 

In general, a shipping materials are treated as purchased items, even if they are hired shipping 

materials. You can therefore use all item-related functions such as Purchasing, Inventory 

management, Storage, Movements, Goods issue, and Inventory count for shipping materials also. 
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Goods receipt For goods receipt, the posting must be made to an inventory location that 

allows shipping material to be issued automatically if a delivery goes out to 

a customer, plant, or unloading point. You can enter the inventory location 

when the purchase order is created so that the goods receipt automatically 

posts to the correct location. 

Inventory In Inventory, inventory locations are set up that allow customer-specific 

receipts and issues. This allows the inventory journal to calculate the flow of 

shipping materials as well as the shipping material life. Inventory is also 

shown in relation to specific inventory locations so that account statements 

for shipping materials can be created for a combination of customer, plant, 

and unloading point. 

Goods issue An issue is carried out automatically from the corresponding inventory 

location. The basic setting should permit dummy inventory. If inventory 

shows a negative quantity, a request for returnable packaging is required. 

Inventory count To balance out inventory differences for load carriers, inventory counts are 

performed by both partners (supplier and manufacturer). The inventory 

count can be carried out for specific inventory locations. After the posting, 

the inventory count data can be issued and transferred from the inventory 

journal. 

Load carrier EDI The actual shipping material EDI (see EDI and packages (see "EDI and 

packaging" page 291)) is split into several transfer types: 

 Account statements from load carriers 

 Movement messages from load carriers 

 Inventory count inquiries and feedback from load carriers 

 Returnable packaging requests 
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Create shipping material 

For general information on shipping materials, see Shipping materials (see "Shipping material, 

Ship. mat." page 332) 

1. In Sales, select the Packaging folder, open the Shipping materials object, and select the New 

tab. Enter the relevant data and click Create to confirm. 

The tabs of the opened shipping material view are identical to those used for creating items - 

with the exception of the Shipping material tab. 

2. Enter the required data on the Shipping material tab. In particular, make sure that you have 

entered the correct value in the Shipping material type field. 

3. Use the Tag check box to determine whether individual tags are to be created for each 

shipping material. 
 

Repack shipping material 

For general information on shipping materials, see Shipping materials (see "Shipping material, 

Ship. mat." page 332) 

You can repack shipping material (see "Shipping material, Ship. mat." page 332) of the Single 

packing material type. For example, you can repack it within a load list from a Master shipping 

material type to another Master shipping material type in order to save on pallets. 

1. In Sales, open the Order release management folder and select the Load lists object. 

2. From the View menu, select Repack. 

Both tables on the Repack tab display the same information. In the standard version, only 

shipping material of the Master shipping material type is displayed. In addition, the tab displays 

the partially used shipping materials first. The Full check box for these shipping materials is 

cleared. You can select different line records in both tables. 

3. In the upper table, select the single shipping material type you want to repack by clicking the 

row header. 

4. In the lower table, use the same method to select the master shipping material type to which 

you want to repack the shipping material. 
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5. From the Functions menu, select Repack. 

Note: You can also physically repack additional shipping materials in master shipping materials 

that are flagged as full. This flag does not affect the repacking of such master shipping materials. 
 

Enter packages 

For general information on shipping materials, see Shipping materials (see "Shipping material, 

Ship. mat." page 332) 

The Shipping material solution provided in Infor COM is based on the advanced planning of 

packages (see "Packaging" page 329). However, sometimes items are not packed into 

immediately accessible shipping materials until just before delivery. In addition, it is often 

necessary to pack different shipping items into one shipping material unit. 

To cover this, you can enter packages in the load list (see "Load lists" page 300). The values in the 

load list are preset from existing shipping material requirements. You can also enter additional 

packages or delete and copy rows. 

Packages are entered in groups rather than individual packages. 

Example: A row may have an entry of 5 boxes, which means 5 individual packages are 

generated. 

Please note:  When you save the packages, the system checks whether the quantities in the 

item lines are fully distributed as fill quantities. If this is not the case, an error message is displayed 

and the packages are not generated. 

To enter packages, the status of the load list must be Actual load list. You cannot access the quick 

entry function if it is not in this status. Another requirement is that none of the individual load list 

lines can have the status ASN or higher. Otherwise modified packages are no longer transferred 

to the existing advance shipping notices. 

To enter packages, complete the following steps: 

1. Create the actual load list (open a planned load list and select Functions -> Create actual load 

list). 

2. In the opened load list, select View and Enter packages to go to the entry form and enter the 

required packages and assignments on the appropriate tabs. 
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3. Assign all shipping materials to a load list line. If there are batch items, you can select from 

previously reserved batches and assign the batch IDs to the packages to be created. 

4. Check that the quantities are fully distributed. For an overview, refer to the load list lines 

displayed in the upper table with the quantities and remaining quantities. 

5. To generate the packages, select Functions and Enter packages, or simply exit the view. The 

packages are then generated automatically. 
 

Packing instructions 

For an overview of packaging, see Packaging (page 329). 

A packing instruction groups together shipping materials (see "Shipping material, Ship. mat." page 

332) and their quantities. In terms of structure, a packing instruction is similar to a bill of resources, 

with the individual lines corresponding to shipping materials. The list of shipping materials maps 

the structure of the packaging and the relationship of the shipping materials to each other. 

Example 

Level Line Shipping material, 

Ship. mat. 

Short description Type QtyPerPkg 

1 1 ShM1-0001 Euro pallet 120x80 Master 1 

2 2 ShM2-0002 SLC4413 Single 27 

3 3 ShM3-0001 Cover SLC4413 Addition 1 

2 4 ShM3-0002 Underlay 120x80 Addition 2 

2 5 ShM3-0003 Cover 4410 Addition 1 

 

A packing instruction can be assigned to an item or item group, business partner, plant, or 

unloading point. In addition, you can change the request based on a validity date. 
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You can use packing instructions as a simple way to assign a shipping material to an order line 

and populate it with the corresponding quantities. Use the 

COMMON.PACKAGING.AUTOPACKAGINGFORAUTOMOTIVESALESORDER parameter in the 

configuration to control whether packing instructions are assigned to order release lines 

automatically or manually. When the advance shipping notice is created, packages are 

automatically or manually generated from these shipping material requirements, which you can 

view and repack individually. You can also create tags or package lists. 

Please note: Addit. shipping material may not contain subordinate shipping material. 

Note: You can store shipping material groups in the PACKGROUP allocation table. You use the 

Statistics/documents tab to assign these shipping material groups to an item. You can then create 

combined packing instructions for all items that the group was assigned to. 

You can determine the optimal packing instruction (packing instruction/assignment with the most 

matching features) as follows: 

 It can be found and transferred automatically. This is what happens when you select Save. 

 It can be found manually. To do this, go to the shipping material requirement from the order 

(release) and select the required instruction from those available. 

For information on how to create a packing instruction, see Create packing instruction (page 338). 
 

Create packing instruction 

To create a packing instruction, complete the following steps: 

1. In Sales, select the Packing instructions object in the Packaging folder and select the New tab. 

Complete the required entries and click Create to confirm. 

2. Create the packing instruction on the Text/quantities tab by entering the levels and assigning 

the shipping materials hierarchically to each level. 

Example 
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Level Line Shipping material, 

Ship. mat. 

Short description Type QtyPerPkg 

1 1 ShM1-0001 Euro pallet 120x80 Master 1 

2 2 ShM2-0002 SLC4413 Single 27 

3 3 ShM3-0001 Cover SLC4413 Addition 1 

2 4 ShM3-0002 Underlay 120x80 Addition 2 

2 5 ShM3-0003 Cover 4410 Addition 1 

3. Enter the information required for the tag on the Tag tab. 
 

Shipping material account, Ship.mat. act 

Description 

The shipping material account helps the user to plan and handle hired shipping materials. 

The shipping material EDI handles the exchange of data relating to shipping material movements 

and their associated account statements. Four different types of data exchange (import and export 

procedures) are used in this process. 

 Account statements from load carriers 

 Movement messages from load carriers 

 Inventory count inquiries and feedback 

 Returnable packaging requests 

The shipping material account displays an overview of the shipping material movements and the 

resulting shipping material inventory. Movements can include deliveries and goods receipts, for 

example. A shipping material account always refers to a supplier-customer relationship. 

Functions 

The shipping material account provides the following functions, for example: 

 All inventory and movements for a customer-supplier relationship are displayed in full 
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 The shipping material movements transferred by a business partner via EDI are compared 

with the shipping material movements carried out internally, with unconfirmed movements, 

variances, and deviations highlighted in color 

 Variance report created automatically when messages are imported 

 Data continuously prepared for exporting messages 

 History of all message traffic carried out for a document 

 Access to goods receipt 

 Open via shipping material 

For more information, see Import shipping material data (page 342) and Export shipping material 

data (page 342). 

Requirements 

To use shipping material accounts, you must meet a number of requirements, including the setting 

up of shipping material accounts for the following: 

 Hired shipping material from customers 

 Hired shipping material from third parties 

 Your own shipping material that you exchange with suppliers, customers, or third parties 

Functions 

The following functions are available from the Functions menu in the shipping material account: 

Reconciliation posting 

Use this function to manually balance differences between your shipping material inventory and 

that of your business partner. You do not need a message to do this. 

Export 

Calculate costs for hired ShM statement 

Hired shipping materials are reusable, individually flagged shipping materials that are provided to 

the user by the hire company either free of charge or at a cost. Hired shipping materials must be 

returned to the hire company. You can use this function to calculate the cost of hired shipping 

materials for which a charge is applied  - see Calculate costs for hired ShM statement (page 

343). 
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Archive 

Over time, a large number of movements will accumulate in the shipping material account, which 

will slow work down. The archiving process allows confirmed movements to be archived 

automatically after a defined archive period. You can specify the archiving settings using the 

Archiving active and Archive period parameters on the Settings tab in the shipping material 

account header. 

Performance 

To improve the performance of the shipping material account while loading and processing data, 

you can use the EDI shipping active, EDI receipt active, and Display delivery data options in the 

Shipping material  account header  view. Deactivating these settings can improve 

performance. You can find detailed information about this in the context-sensitive Help. 
 

Use shipping material account 

Prerequisites 

To log data when using a shipping material account (see "Shipping material account, Ship.mat. 

act" page 339), the associated companies, addresses, and unloading points must be entered in 

the shipping material account. 

Rules 

Data is logged in accordance with the following rules: 

 The data to be logged is used to access the account address assignments and read the 

account. The most exact record is always read. 

Example:  If an account exists for a plant and another account exists for an unloading point, 

this record must not be read if a posting is carried out for the plant only. 

 The system creates a log entry only if it finds exactly one shipping material account. There is 

no log entry created if there are no accounts or more than one account found. 

 The account is set by default for all shipping material records in Goods receipt, however you 

can also modify it here. 
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 In Goods issue, the account is populated when the advance shipping notice is created, 

however you can modify these entries beforehand. For example, you can allow the combined 

usage of your own shipping material and external shipping material. For example, you could 

process part of the shipping material through your own account, and the other part through the 

carrier's account. 
 

Import shipping material data 

For more information on the shipping material account, see Shipping material account (see 

"Shipping material account, Ship.mat. act" page 339). 

To import shipping material data, which is then displayed in the shipping material account (see 

"Shipping material account, Ship.mat. act" page 339), select the Import messages object in the 

Messages folder. 

For the import to function correctly, you must use the VDA 4927 (LDTIMP) message profile that 

was supplied with Infor COM. 

Please note the following points: 

 If necessary, you can issue a variance report or a complete report, or generate a workflow 

when importing account statements. 

 You can view and compare the imported data, but you cannot use it to carry out postings in 

Infor COM. 

 The account also maps your relationship with your business partner. It is not possible to create 

a business partner with more than one usage (customer and supplier). 
 

Export shipping material data 

For more information on the shipping material account, see Shipping material account (see 

"Shipping material account, Ship.mat. act" page 339). 

To export shipping material data, which is then displayed in the Shipping material account (see 

"Shipping material account, Ship.mat. act" page 339), use either of the following methods: 

 You can send account statements regularly at specified intervals. Define the timeframe in the 

Shift plan field in the shipping material account. A daily process automatically sends out all 

messages that need to be sent. 

 You can manually initiate the sending of messages by selecting Functions and Export. The 

message to be exported is set in the header of the account and the data is prepared for the 

selected transfer type. 
 



Infor COM 7.5 User Guide | 343 

 

Sales 

 

Calculate costs for hired ShM statement 

For more information on the shipping material account, see Shipping material account (see 

"Shipping material account, Ship.mat. act" page 339). 

You can calculate the costs for hired shipping materials. The calculation can be carried out based 

on: 

 Standard hired charges per unit or time unit 

 Each individual shipping material per unit or time unit 

The calculation also manages charge-free days. The result is output as a report that lists the 

amount due and the individual movements. 

 

1. In Sales, open the shipping material account for which you want to calculate the hired charges 

by selecting Packages and Shipping material account. 

2. Open the View menu, select Shipping material account header and then click the Shipping 

material hire tab. 

3. Specify the Hire per. (no chrg) in work days or calendar days (SP field), enter the hired charge 

per unit and day, and enter the document name for outputting the report in the Report name 

field. 

4. Select Functions and Calculate costs for hired ShM statement. 

5. Populate the fields for the output periods in the following dialog box and click OK. 

Note: You can reprint the report at any stage by selecting Functions and Reprint. 

 

Vendor-managed inventory (VMI) 

Click here for information on Supplier consignment warehouses. 

A consignment warehouse is a warehouse belonging to a supplier that is located at the recipient's 

company. Some advantages of consignment warehouses for the recipient include guaranteed 

supply due to the quicker availability of materials, and lower handling costs as invoices are created 

per period. 
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Some automobile manufacturers have gone as far as setting up supplier logistic centers as 

buffers. 

A supplier logistic center is a shared consignment warehouse belonging to several suppliers 

located in direct proximity to a large customer. 

For this warehouse, outline parameters such as minimum and maximum inventory are defined for 

each supplier and item. Inventory messages and receipt and issue messages (VDA 4913 with 

process keys 30, 35, and 36) are used to inform the supplier of the fill level and movements. 

Additional deliveries are initiated independently by the supplier. 

For VMI items, only delivery order releases may be transferred. JIT delivery order releases cannot 

be transferred. 

The delivery is generally made via a subcontractor, i.e. using the S/C warehouse on the 

customer's premises. The delivery is carried out via a quarantine warehouse, where the inventory 

in the quarantine warehouse corresponds to the quantity in transit. If there is no quarantine 

warehouse, the calculation is carried out using the cumulative quantities. 

Delivery order releases are therefore unlinked from the deliveries. 

The inventory data from the supplier logistic center and the automobile manufacturer's delivery 

order release quantities allow the supplier to plan the optimal delivery date and the optimal 

replenishment quantity. 

Possible strategies 

Strategy Implementation 

 Reduction of inventory costs Small shipping quantities close to minimum 

 High supply guarantee Small shipping quantities close to minimum 

 Reduction of handling and transportation costs Large shipping quantities 

 Simultaneous manufacturing Small shipping quantities 

 Reduction of setup costs Large shipping quantities 
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Once it is time to replenish the inventory, the supplier triggers a delivery notification. The 

responsibility for the warehouse inventory therefore transfers to the supplier. The automobile 

manufacturer does not need to do anything. 

This function is referred to as vendor-managed inventory (VMI) or supplier-managed inventory 

(SMI). 

Configuration 

To enter the basic settings for VMI handling, complete the following steps: 

 The first requirement for VMI is that the COMMON.AUTOMOTIVE.VMIACTIVE parameter is 

set to yes – see also Configuration (Automotive). 

 Enter the main master data for VMI handling on the VMI tab in the unloading point (S/C 

warehouse location). This  master data is transferred automatically to any new outline 

agreements that are created. 

 Important settings are stored in the VMI allocation tables (see "Allocation tables (VMI)" page 

347) and at least some of these settings can be maintained here. 

Planning 

VMI planning can be triggered by event, by time, or manually. 

Event-controlled planning: All business processes that can trigger VMI planning are entered in the 

VMIEVENTS allocation table. 

Time-controlled planning: The AM.VMI.al_generateFromBatchScheduler action can be configured 

and activated using batch control. 

Manual generation: Since changes made to VMI-specific data in the outline agreement can impact 

VMI planning results, you are prompted to confirm whether VMI generation should be carried out 

when you save the outline agreement. 

Note: VMI planning can be triggered manually at any time by selecting Functions and Perform VMI 

generation. 

VMI generator 

The task of the AM VMI generator is to generate new JIT delivery order release lines based on the 

VMI parameters in unloading points and outline agreements. 

Note: The AM VMI generator is also available in the Batch control object. 
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Once they are generated, the JIT delivery order release lines are saved as order lines in existing 

order releases, and the new cumulative quantities are generated. 

Note: In order to obtain the most accurate planning result possible, the VMI generation transit 

quantity can be taken into account. The quantity in transit is then subtracted from the generated 

JIT delivery order release quantities. 

You can choose between three configurable methods here: 

 Quantity in transit is not offset 

 Quantity in transit = Cumulative delivered quantity (CDQ) - Cumulative received quantity 

(CRQ) 

 Quantity in transit = Quarantine inventory in VMI warehouse 

Functions 

The following table provides an overview of the VMI functions available. 

View Function Description 

All Perform VMI generation Starts VMI generator 

 Print VMI inventory overview Prints the VMI inventory overview list 

Order release 

overview 

VMI filtering Filters according to VMI order release (must be done 

before VMI inventory overview is printed) 

 Remove VMI filtering Filters according to VMI order release 
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Allocation tables (VMI) 

The following allocation tables contain VMI (see "Vendor-managed inventory (VMI)" page 

343)-specific information and data. 
 

VMIDISPMODE 

For an overview of the allocation tables used for VMI, see Allocation tables (VMI) (page 347). 

Description: VMI planning modes 

Usage: This allocation table contains the VMI planning modes. 
 

VMIEVENTS 

For an overview of the allocation tables used for VMI, see Allocation tables (VMI) (page 347). 

Description: VMI planning triggers 

Usage: This allocation table contains the business processes that can act as triggers for VMI 

planning. Additional business processes can be added to this table. 

Description 

This field shows the name of the business process. 

Active 

You can use this check box to activate the required business process, i.e. set it as a trigger for VMI 

planning. 

 
 

VMIREPLMODE 

For an overview of the allocation tables used for VMI, see Allocation tables (VMI) (page 347). 

Description: VMI fill modes 
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Usage: This allocation table contains the VMI fill modes. 
 

VMISALDMODE 

For an overview of the allocation tables used for VMI, see Allocation tables (VMI) (page 347). 

Description: VMI balance calculation 

Usage: This allocation table contains the VMI balance calculation options. 

 
 

VMISTATUS 

For an overview of the allocation tables used for VMI, see Allocation tables (VMI) (page 347). 

Description: VMI status display configuration 

Usage: The entries in this allocation table allow you to configure the VMI status display. 
 

VMITRQMODE 

For an overview of the allocation tables used for VMI, see Allocation tables (VMI) (page 347). 

Description: Configuration of transportation quantity calculation 

Usage: This allocation table allows you to configure the transportation quantity calculation. 
 

AM master data 

Use this folder to manage the master data used in special functions in the Automotive components 

(see Automotive basics (page 259)). 
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EDI master data 

For an overview of the functions available in Automotive, see Automotive basics (page 259). 

All the customer/supplier-specific information required for electronic data interchanges is managed 

in the EDI master data. 

This data is available when you use the e-Procurement, Automotive, or Trade data import/export 

(see "Trade data import" page 322) components. 

The EDI master data establishes a link between the company and the EDI ID, and between the 

message and the transfer profile used to process the message. 

All the plants and unloading points (page 350) assigned to the EDI sender are also stored in 

Automotive. 
 

View EDI master data 

If agreements are made with an automobile manufacturer using electronic data interchange, enter 

these agreements in the EDI master data (page 349). 

1. You can view agreed EDI master data in the EDI master data object. 

The following table shows a sample master data header for a customer. 

Plant  H2 

EDI std.  4905 - Delivery order release 

EDI ID  12477 

EDI profi le  VDA 

The EDI master data is determined for each specific plant. In our example for the 

customer's H2 plant, VDA 4905 (order release) was specified as the EDI std. and 12477 

was agreed as the EDI ID. The validity date indicates the date from which the agreement is 

valid. 

2. To view the plants and unloading points of the customer that apply to the agreements, go to 

the Plants tab. You can store several unloading points (page 350) for each plant. 
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Unloading points 

You can access unloading points in the AM master data folder in Sales. 

An unloading point is the point at the recipient's facilities where goods are received. For 

information on how to store an unloading point, see Store unloading point (see "Enter unloading 

point" page 350). 
 

Enter unloading point 

To store an unloading point (see "Unloading points" page 350), select the Master data folder in 

Sales. Then open the customer for which you want to store the unloading point and select the 

Unloading point tab. 

If an unloading point has already been stored for a company, you can open this unloading point 

using the  Unloading points object in the AM master data folder in Sales. The Unloading point tab 

is selected automatically in this case. The steps described below continue from this point. 

1. If several addresses exist for a company, select View and Company/addresses overview to 

display the Company/addresses overview. Select the relevant address by double-clicking the 

row header. The company data is displayed. 

2. You can now store the information for the unloading points on the Ship to section of the form. 
 

Subcontractors 

For general information on electronic data interchange in the transportation and supply process, 

see EDI and packaging (page 291). 

Delivering to a subcontractor (S/C) instead of to the end customer is a very common delivery 

process.  

In Infor COM, a delivery is made to a consignment warehouse. The subcontractor stores the 

goods, unpacks them, and carries out other minor associated tasks. Later, the end customer 

issues the goods - usually a different quantity from that delivered. The issue transaction is also 

sent to the supplier. 
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When dealing with subcontractors, Infor COM differentiates between two different procedures: 

 Internal subcontractor: In this case, the system assumes that when the goods arrive at the 

subcontractor, this inventory is included in planning on the customer side. The cumulative 

delivered quantity is already incremented when the goods are delivered to the subcontractor. 

 External subcontractor: In this case, the subcontractor holds onto the goods. The cumulative 

delivered quantity is not incremented until the goods are transferred to the end customer as 

they are not available for planning by the end customer until this point. 

It can therefore make sense for a supplier to access the warehouse of a subcontractor if the 

distance between the supplier plant and manufacturer plant is considerable. In this case, the best 

way of ensuring accurate-to-the hour delivery would be to use the warehouse of an external 

subcontractor that is located nearer to the manufacturer and operated by a third-party. 

To view a sample process using subcontractors, see Work with subcontractors (page 352). 

Both the supplier and the manufacturer are notified about the inventory in this warehouse. When 

the manufacturer requires goods, he issues these from the supplier's external warehouse. The 

goods remain the property of the supplier until they are issued. The manufacturer is not invoiced 

until the goods are issued. 

The electronic data interchange of advance shipping notice and transportation data between 

suppliers, subcontractors (S/C), and customers is carried out using VDA recommendation 4913, 

for example. 

You can now use the Unloading point (see "Unloading points" page 350) function to assign a 

subcontractor warehouse to each unloading point. Make the required entry in the S/C W/H field on 

the Unload pt. tab. 

Note the following points about specific business processes - the first three points are most 

relevant. 

 Delivery advice: The delivery advice is created in the form of an advanced shipping notice and 

is sent as an EDI message. The corresponding quantity of goods is posted from the internal 

warehouse to the quarantine warehouse. The goods may be moved to a truck or other means 

of transportation, for example, and can no longer be accessed by the supplier. The cumulative 

quantities are updated. 
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 Subcontractor receipt message: When the subcontractor receives the goods, he sends a 

receipt message by EDI. The receipt message is imported using the Import messages (page 

318) object and stored in the EDI journal (page 315). The goods are reposted from the 

quarantine warehouse to the subcontractor warehouse. Any discrepancies that occur in 

relation to the delivery advice are logged in a mailbox. 

Note: You can access the receipt message from the EDI journal. The goods receipts 

confirmed by the subcontractor are reconciled with the advance shipping notice data in the 

displayed receipt message. 

 Subcontractor issue message: If the manufacturer issues goods from the S/C warehouse, the 

subcontractor sends the supplier a copy of the advance shipping notice as an issue message. 

This message is then imported using the Import messages object in Infor COM. The goods are 

posted from the S/C warehouse and an invoice is created for the quantity issued. 

 Subcontractor inventory message: The subcontractor sends the inventory messages by EDI in 

order to synchronize the warehouse inventory. Any variances in the inventory at the S/C 

warehouse are posted automatically. A mailbox entry is generated. 

 Subcontractor RMA: When an RMA is carried out, the cumulative delivered quantity and 

delivered quantity can be reduced automatically, provided the corresponding setting is defined 

in the configuration. The goods are not reposted again, and only a mailbox entry is generated. 

 Subcontractor transportation damage/loss/difference: If the subcontractor reports 

transportation damages, losses, or discrepancies, you can adjust the cumulative delivered 

quantity and delivered quantity in the order release by the quantity reported, provided the 

corresponding setting is defined in the configuration. 

 Set to zero: Make sure that when the manufacturer sets the cumulative received quantities to 

zero, only the advance shipping notices sent to the subcontractor are used for recalculating 

the cumulative delivered quantities. Advance shipping notices sent from the subcontractor to 

the manufacturer (order release messages) do not affect the cumulative quantities and 

delivered quantity in the order release. They are only used as a basis for invoicing the 

manufacturer. 
 

Work with subcontractors 

The step-by-step instructions in the following Help topic highlight the main steps involved in 

working with subcontractors (page 350) in Infor COM. 

1. Open a load list and check whether the customer is a subcontractor customer using the Cust. 

W/H location field in the Load list line view (the field is only populated if this is the case). 

2. Go to the Load list view and select Functions and Create and send EDI advance shipping 

notice (ASN) with issue.  

The link file is stored in the configured directory. 
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3. Load the sales item in the Master data folder in Sales and select the Inventory tab. It should 

display the quantity posted from the main warehouse to and from the quarantine warehouse. 

To view the detailed inventory postings, open the Inventory journal in the Information folder in 

Inventory. 

4. Open the Import messages object in the Messages folder in Sales. Select the S/C ASN data 

check box, select the file to be imported for the receipt message, and select the Rename after 

import option. You can now check the changes to the inventory as described in point 3. 

5. Open the Import messages object in the Messages folder in Sales. Select the S/C ASN data 

check box, select the file to be imported for the issue message, and then import this file.  

When the issue receipt is imported, a standard invoice is printed at the same time and the EDI 

invoice is saved in the configured directory. 
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For general information on Sales, see Sales basics (page 111). 

In the Master data folder in Sales, maintain the master data for customers (page 354) and 

employees (page 358) (representatives, for example), as well as sales items (see "Sales item" 

page 359), tools, services (page 360), additional costs (page 363), and payment plans (page 365). 

The maintenance of prices and discounts (see "Prices and discounts in Sales" page 368) using 

the price flags in the price table is a central aspect of master data maintenance in Sales. 

In addition, you can store commissions (page 382) in the commission table. 
 

Customers 

Call 

Sales > Master data > Customers 

Description 

The term "customer" refers to a company that purchases or uses your products or services. You 

normally create companies in Finance by selecting the Master data folder. In Sales, the Master 

data folder allows you to create customers. The advantage of this is that customer-specific 

settings are predefined when these new customers are created. 

Orders from customers are processed in Sales via the Sales orders (page 212) object. 

Master data (Sales) 
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Configuration 

It is possible for an online validation check for accuracy to be carried out by the connected 

financial accounting system on company master data that has been created or modified in 

Purchasing and Sales. This is helpful in cases where changes are made to credit limits, or if a 

sales tax ID has been entered incorrectly. If an invalid sales tax ID is used while the online link is 

active, an error message is output immediately. The online validation function is activated via the 

COMMON.FIBU.ONLINE.BUSINESSPARTNER=yes parameter. 

When the customer or supplier master data is saved, the processes for transferring business 

partners to the configured financial accounting system are then called for the business partner you 

were processing. All of the data checks that would be carried out for a batch transfer are now 

carried out by Infor COM and the financial accounting system. The configuration parameters and 

interface configuration settings saved for the transfer of master data are evaluated and applied. 

For more information, see Infor Finance online functions. Error messages are displayed directly on 

the screen and are not saved. There are no additional mailbox entries. If the transfer is successful, 

there are no messages displayed. 

In practice 

Create new customers (page 355) 
 

Create new customers 

For an overview of the creation of master data in Sales, see Master data (Sales) (page 354). 

You can save customer-specific data using the company master in Infor Finance, or you can 

select Customers in the Master data folder in Sales. The price calculation type, document 

printouts, terms of delivery, and accounts that you define here are preset on all other relevant 

forms. 

Note: By assigning group flags when entering customers, different price and discount calculation 

types can be automated. For this reason, we recommend that you read Prices and discounts in 

Sales (page 368) before you start entering data. 

To enter address data for a customer, complete the following steps. 
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1. Create a new customer or open an existing customer by selecting Customers in the Master 

data folder in Sales. 

2. Use quick entry to enter the company addresses one below the other in the address table 

under the company header. 

Note: When you enter the first address, the address type is automatically set to Standard 

address. You can change this by making another selection from the combo box. 

3. Make an entry in the Address format field on the Address tab. 

Note: The choice of address format determines which fields are available for entering address 

data. 

4. Enter the remaining necessary address data for the customer, for example, enter the language 

flag for document printout in the Language field (see also Define document language when 

creating master data (see "Define document language for companies" page 357)). 

5. In the table on the right-hand side, enter the necessary telephone numbers, fax numbers, and 

so on for the address. The telephone number entered in the address table is automatically 

transferred as the first one. 

6. Enter the contacts in the company on the Contact tab. 

 To create a contact that has not yet been entered, complete the fields Title 1, Name, 

Phone, and so on. 

 Then open the Go to menu and select Employee (confirm the query about backing up the 

data with Yes). This opens the employee master data. 

 Enter the Name of the employee and complete the fields Title 1, Lang., and so on. 

 The company from whose master data you executed the Go to command is displayed in 

the Company header. The Address field contains the address whose row was active in the 

addresses table before the Go to command was executed and for which you now want to 

enter the contact. If you have assigned multiple addresses to the company, you can select 

one or more additional addresses from the combo box. 

Addresses can only be selected here. Therefore, if you do not find the required address in 

the combo box, close the employee data and enter it for the company. 

7. Fill in the fields of the Communication and Function form sections for the currently selected 

address.  

You can enter usage flags for employees. 

8. Select Data and Save to save the data and close the form to return to the company master 

data. 

9. If applicable, make the default settings for price calculation on the Customer business data 

tab. 
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10. Click the Customer documents tab and select the required texts (payment and delivery terms) 

from the combo boxes. Also, select the document specifications including address and form 

details. 
 

Define document language for companies 

When you create customers, addresses, or employees, you can store this language flag or country 

ID to manage text output on documents. 

The procedure is the same in all three situations. You store the language flag using 

COMMONSTD. The relevant settings are shown in the following table. 

Company COMMONSTD.STD-RELFIRMA.SPRACHKNZ SprachKnz=us 

Addresses COMMONSTD.STD-RELANSCH.ANSCHSATZ.SPRACHKNZ AnschSatz.SprachKnz=us 

Employees COMMONSTD.STD-RELPERSON.SPRACHKNZ SprachKnz=us 

 

When you create a document, the system searches for a stored language flag in a defined 

sequence. 

For the contact See the Lang. field in the employee header 

For the address 
See the Lang. field on the Address tab of the company master 

For the company See the Lang. field on the Company profile tab 

In the configuration COMMON.GLOBAL.TOOLLANGUAGE parameter 

 

 

Example 

 The head office of company A is in the United States. As a result, the default language flag for 

A is us. 

 There is also a plant in France. The language flag set for this plant is fr. 
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 Mr. Doe, employed by company A, works in France. However, he speaks better English than 

he does French. For this reason, the us language flag is stored for him. 

Result: If a document is addressed to the head office, it is displayed in English. If a document 

is addressed to the plant in France, it is displayed in French. If the document is intended for 

Mr. Doe, it is again displayed in English. 

In practice 

The following instructions show you how to set a company flag. 

1. Select System functions > Administration > Configuration. 

2. Set the COMMONSTD.STD-RELFIRMA.SPRACHKNZ entry as required. 

3. The associated language flags are stored in the SPRACHE allocation table. 

4. Start Infor COM and create a new customer (see Create new customers (page 355)). 

5. Switch to the Company profile tab. The Lang. field is preset to the default language flag.   

6. Save the customer and create a new quote for this customer. 

7. Print the quote. The quote is created in the required language. 
 

Employees 

For an overview of the creation of master data in Sales, see Master data (Sales) (page 354). 

In Sales, you can store employees responsible for different functions. For general information on 

employees, see Employees. 

For information on how to store contacts for a company, see the Create new customers (page 

355) Help topic. 

For information on how to create a representative, see Create representative (page 384). 
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Sales item 

Use the Sales items object in Sales to create a sales item - see Create sales item (page 359) or 

open an existing sales item. When you select this object, the Sales items check box is selected 

and dimmed. 
 

Create sales item 

For general information on creating items, see Create new item. 

The following example shows you how to create a sales item that is also a purchased item. Only 

the most important settings are referred to here. 

1. In Sales, click Master data and select Sales items. Click the New tab in the dialog box. 

2. Select the Sales item and Pur. item check boxes and click Create. In this way, you define that 

no in-house manufacturing takes place for this item. 

3. Enter the sales prices on the Sales prices tab. See the Store sales prices Help topic. 

4. Create the supplier on the Suppliers tab and enter the supplier with the purchase price, unit of 

measure, delivery time, and delivery time unit (DLTU). 

5. As the item created is merchandise, also enter purchase prices. You do this on the Purchase 

prices tab. 

Price calculation in Purchasing is described in detail in the Prices and discounts in Purchasing 

Help topic. 

6. In the next step, enter the accounts first on the Accounting tab. When entering items, you must 

enter at least the base currency account in accordance with your chart of accounts. The 

account is required for invoice approval. 

In addition to the accounts, you must ensure that the price and discount flags for 

purchasing are entered correctly on the Purchasing tab – see Prices and discounts in 

Purchasing. 

Note:  To go to the price table, select Go to and Price table. The Current period tab 

shows the price flags with the prices that are valid for the current period. 
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7. Like in step 6, enter the accounts and price/discount flags for Sales on the Accounting and 

Sales tabs - see Prices and discounts in Sales (page 368). 

8. If required, enter a representative on the External item/representative tab. You can enter up to 

two representatives here. A prerequisite is that they have been created in the employee 

master. If all prerequisites for commission calculation have been fulfilled, commission is 

calculated in the sales order for the representatives entered here. 

9. If required, enter an external item ID or external item name on the External item/representative 

tab if your customer uses different item IDs or designations in his purchase orders. 

10. Enter the inventory location of the item on the Inventory flags tab. The inventory location 

entered here is set as the default for future inventory postings. 

11. Enter the default settings for document printing on the Statistics/documents tab. As our sample 

item 965-1322 is an item of merchandise, no settings can be made for manufacturing 

documents. 

12. Enter cost records for the item on the Costs tab. For basic information on working with cost 

records in Infor COM, see Cost records. You need to manually enter costs records for items 

not manufactured in-house. See Enter cost records. 

13. If it is necessary to convert item units of measure, you can specify up to five conversion factors 

on the UOM/size management tab. 

If you want to use units of size stored for the item when you enter orders, you can allocate 

fixed units of size to the item on the same tab. 

14. If the item is sold abroad, enter a foreign-language description for the item on the 

Foreign-language text tab. This description can be printed on documents sent to customers 

abroad. 
 

Services 

See Services 
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Set items 

Call 

Sales > Master data > Set items 

Description 

Set items are logical groups of sales items that are generally sold together. You can define a set 

item in the master data by assigning a set line to the relevant item in the BOR, similar to a bill of 

materials. 

Examples 

Set items Set items 

Kitchen sink unit 

(Series manufacturing) 

Bedroom 

(product configuration 

manufacturing) 

Number/lines Number/lines 

1 sink basin 1 double bed 

1 waste pipe 2 nightstands 

1 drain trap 1 closet 

 

Configuration 

Set items are configured using the entries in the COMMON.SET section of the configuration. 

Price calculation 

The prices of set items are stored in the price tables (see "Prices and discounts in Sales" page 

368). 

Two models of structuring prices are permitted for set items: 
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 The set item provides the price. 

In this case, the prices of the set lines are ignored. Invoicing is carried out for the set item. 

Sales revenue and volume statistics are generated for the set item. Consumption statistics 

and inventory issues are generated for the set lines. 

 The set lines provide the price. 

In this case, the set item cannot have a price. Invoicing as well as sales 

revenue/quantity/consumption statistics, and inventory issues are carried out for the set lines. 

Which model is used is determined from the prices that are stored. If a price is entered for the set 

item, then this always takes precedence. If no price is entered, the prices of the individual 

components are used for price calculation. 

Inventory management 

Inventory management for set items takes place solely via the lines. Set items cannot be stored or 

issued. The following options are possible for inventory postings: 

 The price is stored for the set item. 

In the inventory form, the set item is displayed as the first line and the set lines are displayed 

as subsequent lines. When you enter a posting ID in the set item, this is automatically 

transferred to the lines. If you enter a quantity in the set item, the quantities for the set lines are 

determined automatically using the set quantity ratios. 

 The price is stored for the set lines 

In the inventory posting form, the set item is displayed as the first line and the set lines are 

displayed as subsequent lines. When you enter a posting ID in the set item, this is 

automatically transferred to the set lines. The quantities can only be entered in the set lines. 

Notes 

 Set items are supported in quotes and sales orders but not in order releases. It is also not 

possible to plan set items. You can only plan the components of set items. 

 No inventory management takes place for set items. RMAs can only be posted to set lines. 

 Partial deliveries are possible by specifying reduced delivery quantities in the set item - 

provided partial delivery is enabled. The set lines are delivered in the correct quantity ratio. 

 Depending on the price calculation (see this section), either the set items or the set lines are 

transferred to the invoice journal. 

  

Further specifics regarding set items are available in the following overview. Click the respective 

link to view the details. 

Record type: The SI record type is provided for set items. For more information on this record type, 

see the Record types (Sales) (page 115) Help topic. 
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Additional costs 

For an overview of the creation of master data in Sales, see Master data (Sales) (page 354). 

In Sales, you can access the additional costs relating to Sales by selecting Master data and 

Additional costs. 

You can use this object to enter sales costs, that is, additional costs of sales, beyond the cost of 

the item to be invoiced. 

The following costs are sales costs directly attributable to an item (direct sales costs): 

 Packaging costs 

 Shipping and freight costs 

 Representative commissions 

All frequently incurred additional costs, for example, transportation and insurance costs, can be 

saved as additional costs and retrieved in the order. 
 

Create additional cost 

To create an additional cost (ms-its:sales.chm::/4061.htm), proceed as follows. 

1. Open the Master data folder in Sales and select Additional costs. Click the New tab, enter the 

required data, and click Create to confirm you entries. 

2. Enter the accounts on the Accounting tab and the price flags on the Sales tab. You will find 

information on price calculation under Prices and discounts in Sales (page 368). 

Using a combination of this price flag and the price flag entered for the customer, the system 

finds the price for the additional costs in the price table. 

Enter the prices for the additional costs on the Prices tab. 

Note: Discounts are not applied to additional costs. 

The remainder of the procedure is the same as for creating a sales item (see "Create sales 

item" page 359). 

 

For information on how to enter the created additional cost into a quote or order, see Enter 

additional costs in quote/order (see "Enter additional costs in orders" page 364). 

ms-its:sales.chm::/4061.htm
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Enter additional costs in orders 

For an overview of the creation of master data in Sales, see Master data (Sales) (page 354). 

You can enter additional costs (ms-its:sales.chm::/4061.htm) as lines on the Quote tab when 

entering a quote, and on the Order tab when entering an order. The following procedure relates to 

sales orders. 

1. Open the sales order in Sales by selecting the Order processing folder and Sales orders. 

2. To select additional costs, enter the AC record type in the RT field on the Order tab. 

3. Select the additional cost from the combo box in the Resource field. The Quantity field is 

populated in accordance with the type of additional cost. 

 If a price is saved for a unit of measure in the master record for the additional cost (for 

example, per unit or per kg, or also per 1000 units or per 100 kg), the quantity for which the 

price should be calculated is entered in the Quantity field. 

 If a percentage surcharge on the net order value (= Net 1 in the totals line at the bottom of 

the tab) is saved in the additional cost, the Quantity field must be left blank. The Basis field 

in the master data for the additional cost contains the entry 0 in this case. 

The calculation is already possible when the resource is selected, no further input is 

required. However, in this case, you need to initiate price calculation manually by selecting 

Functions and Price calculation. 

Please note: Additional costs cannot be discounted. 

 

ms-its:sales.chm::/4061.htm
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Payment plans 

For an overview of the creation of master data in Sales, see Master data (Sales) (page 354). 

In Infor COM, you can print multiple partial invoices for a customer's order, for example, for down 

payments. You can store the specifications on which the partial payments are based as payment 

plans. This allows you to select payment plans from a combo box when you enter sales orders. 

Specifying a payment plan means that sales orders are invoiced in partial steps. There is no 

time-based or quantity-based dependency between the delivery and the invoice. 

If you want to invoice a sales order using a payment plan, enter the invoice amount and 

percentage, print a corresponding invoice, and then process your order lines as usual. 

The following types of partial invoices exist: 

 Down payment invoice: The customer receives an invoice before a service has been provided. 

Down payments are not included in sales revenue statistics. 

 Payment(s) on account: Partial services have been provided for which invoices are issued to 

the customer. 

 Final invoice: All amounts that are still outstanding are invoiced together. The payments on 

account already made are listed for documentation. 

The time for partial invoices can be specified directly before they are actually printed or planned in 

advance over a long period. The invoiced partial amounts are managed within the order as 

records with their own PP record type. 

The following conditions apply: 

 You have to choose between payment on account invoices and normal invoices in the sales 

order. You cannot have a combination of both. 

 Orders with payment plans cannot be included in consolidated invoices. 

 Orders with a payment plan are transferred during the invoice batch printout. 
 Only the invoice amount is printed on down payment and payment on account invoices, and 

not the order lines. These are only listed on the final invoice. 

 A prerequisite for the final invoice is the inventory issue of the lines. 

 Only the material lines, and not the payment plans, are printed on pro forma invoices. 

 Payment plans are only printed on payment on account invoices and the final invoice. 
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Create payment plan 

You can enter recurring payment plans (page 365) in Sales by selecting Master data and Payment 

plans. You can then choose the required payment plan for each order in the sales order on the 

Payment plan tab. 

To create a new payment plan, proceed as follows: 

1. Open the Master data folder in Sales and select Payment plans. Click the New tab, make the 

required entries, and click Create to confirm. 

2. To create a down payment invoice, enter the required percent value of the down payment on 

the Sales tab. This is output on the invoice. The customer then receives an invoice before the 

(final) provision of service. 
 

Print payment on account invoices 

This Help topic describes how to print payment on account invoices for payment plans (page 365). 

1. Open the sales order for which you want to create the payment on account invoice. 

2. Select Functions > Create document. 

In the dialog box that displays, select the Document invoice. The following selection options 

are then provided in the Invoice form section: 

 Down payment: Select this option for partial payments before the service is provided. 

 Payment on account: Select this option for partial payments after the service is provided. 

 Final invoice: Click this button to print the last partial invoice. To print the final invoice, the 

order must be fully issued from the warehouse. 

All order lines less those already invoiced are printed in the final invoice. All payment plans 

in the order that are not yet invoiced are deleted when the final invoice is printed. 

Note:  When printing down-payments or payments on account, the cash discount terms 

from the order are applied automatically. The 

COMMON.VERTRIEB.PAYMENTTERMSFORPAYMENTPLANS configuration entry can 

be used to control whether the cash discount terms from the order header or other terms 

should apply. This allows you to hold off on printing terms until the final invoice. 

The following checks are performed in the print process: 
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 When you select payments on account, the system checks whether the order contains 

payment plans that have not yet been printed. 

 If just one plan is found, this is printed. 

 It several plans are found, a dialog box appears asking you to select the required payment 

plan. This is then printed. 

 If the order value is reached with the payment on account to be printed, a final invoice is 

printed automatically. 

 Invoice cancellation: Partial invoices can only be canceled if a final invoice has not yet 

been printed. If a final invoice already exists, you must cancel this first. 

 Down payments are not included in sales revenue (statistics) until the final invoice is 

issued. Payments on account are included immediately. 

 Orders for which down payments or payments on account have been printed are blocked 

for pro forma invoices, special invoicing, cash sales, and prepayments. 
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Prices and discounts in Sales 

For an overview of the creation of master data in Sales, see Master data (Sales) (page 354). 

Prices and discounts are entered in Sales in the Master data folder using the Prices, Prices - 

Additional costs and Discounts objects. Price lists are the starting point for storing prices in Infor 

COM. 

Price lists contain the standard prices for items and item groups. These prices must be entered in 

either the supplier or item master data or in the price tables so that they become available for 

automatic price calculation in the documents. 

Price lists allow you to, for example, enter different prices for the same item and the same 

customer based on the quality of an item. The price is assigned with the price list flag, which 

means that the price list assigned to the item will determine the price of the resource. Prices are 

entered in the price table. 

Price list flags must be maintained in the price table, as well as in the resource and order master 

data. Price list categories are stored in the PRICELIST allocation table. 

In order to use this function, the COMMON.PREISRECHNUNG.MULTIPRICELIST parameter 

must set to yes in the configuration.  

Prices or price records are set prices for item group and/or item ID combinations, or company 

group and/or company ID combinations. The price calculation is carried out on the basis of the 

prices entered. 

Discounts are price reductions granted for a variety of reasons (quantity discounts, reseller 

discounts, and so on). 

Note: You should observe certain rules for the price and discount flags stored for sales items and 

customers. These are described in the Price tables section of the Prices and discounts in 

Purchasing Help topic. 

Please note: You generally enter prices for an item or suppliers in the item master, not in the 

price table. The flags are transferred to the price table when you save and they are managed 

there. Price calculation will not function correctly if you only store prices in the price table. 

However, you can enter prices for item groups and company groups in the price table. 
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When you enter, for example, a sales order, the flags of the customer required for price calculation 

are loaded by default from the customer's master data and the flags of the entered items are also 

loaded by default. These flags are used to calculate the net prices, discounts, total prices, and so 

on, based on the price table entries. 

The following links provide a detailed overview of the various aspects of price calculation. 
 

Price tables 

Enter prices and discounts for the price table using the Prices, Prices - Additional costs and 

Discounts desktop objects in the Master data folder in Sales. 

Price tables contain all price details: 

 Purchase prices for material, 

 Sales prices for merchandise and products manufactured in-house, 

 Prices for additional costs, 

 Discount rates and discounting guidelines. 

 

Example of item group flags: 

Item grp Customer groups 

1 Standard sales items with no special agreements 

200 Standard sales items with no special agreements 

210 Metal items 

220 Wooden items 

230 Small items 

To define a standard sales item, you can choose between item group flags 1 and 200. The 

advantage of flag 200 over flag 1 is as follows: If you set item group = 200 when you open 

the price table, the corresponding companies (customers) are displayed. This selection is 

not available if you choose item group flag 1. 
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Due date tables 

Due date tables (DT) are maintained in System functions. To maintain the tables, open the 

Administration folder and select Allocation tables in the FITERMIN table. Up to four time 

intervals, or periods can be defined in due date tables. A due date table must be assigned to each 

record in a price, discount or sales tax table. It is possible to define different prices, discounts, and 

sales tax rates in the periods. You could do this for the following reasons, for example: 

 Prices can vary depending on the period if you introduce new price lists from a specific date. 

 Discounts can vary depending on the period if you decide to change discounts from a specific 

date. 

 The statutory sales tax rate can be increased at a certain time. 

Note: Using the due date (requested date in Sales, delivery date in Purchasing, for example), 

the price is read and calculated from the corresponding time interval. You can use the 

COMMON.PREISRECHNUNG.TERMINEINKAUF, COMMON.PREISRECHNUNG.TERMINVERTRIEB, and 

COMMON.PREISRECHNUNG.TERMINFERTIGUNG parameters to change the setting for the due date 

used in the calculation of prices for the respective modules. 
 

Price calculation 

Price calculation uses the price records stored in the price table. Price records have the PR record 

type. You determine prices for the items ordered by the customer using a combination of company 

ID, item ID, company group flag, and item group flag. 

Hierarchical check during price calculation 

If company and item group flags are set, the price is determined via the price table using the flag 

specifications, and a hierarchical check is performed. 

Note: You can configure whether the check should only include levels 1-6, or all levels, i.e., levels 

1-8 using parameters COMMON.PREISRECHNUNG.VERTRIEBSTUFE1 to 

COMMON.PREISRECHNUNG.VERTRIEBSTUFE6 in the configuration. The default setting for 

the check is levels 1-6. Once one of the criteria applies, the search is ended and the price for that 

row is used for the item. 

The hierarchical check is performed on a row-by-row basis in accordance with the following table. 
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 RT Item grp Item ID Co. grp Company ID Description Result of price 

calculation 

1. PR * 102-0201 * 123456 Company ID and item ID 

have been created 

Special item price for 

the customer 

2. PR 201 empty * 123456 Company ID and item 

group have been created 

The customer receives 

a special price for the 

item group 

3. PR * 102-0201 210 empty Company group and item 

ID are specified, company 

ID is empty 

Item price for the 

customer group 

4. PR 201 empty 210 empty Company group and item 

group are specified, 

company ID and item ID 

are empty 

Item group price for the 

customer group 

5. PR * 102-0201 1 empty Company group = 1, item 

ID is specified, company 

ID is empty 

Standard price of the 

item 

6. PR 201 empty 1 empty Company group = 1, item 

group is specified, 

company ID and item ID 

are empty 

Standard price of the 

item group 

7. PR 1 empty * 123456 Company ID is specified, 

item group = 1 

Standard price for the 

customer 

8. PR 1 empty 210 empty Company group is 

specified, 

item group = 1, company 

ID and item ID are empty 

Standard price for the 

customer group 

* = Any entry 

 

Example: Row 1 of the table contains a price record (PR record type) valid for item ID 102-0201 

and company ID 123456. This means that the price of item 102-0201 for customer 123456 is 

stored in this row. 

If the company and item group flags are set, the flag settings are used to determine the price from 

the price table and a hierarchical check is performed as described below. 
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Prerequisites for price calculation 

For price calculation in Sales to work correctly, that is, for the correct price to be displayed in the 

sales order, the following prerequisites must be met. 

1. A price flag >= 200 is stored in the Price field on the Customer business data tab in the 

company master data of the customer. 

2. A price flag >= 200 is stored in the Price field on the Sales tab in the master data of the item. 

Flags >= 100 and < 200 are reserved for purchased items. 

3. A price is stored in the price table for the combination of the customer price flags and the item 

price flags. 

Example: 

RT Item grp Item ID Co. grp Company ID DT % Current period CU 

PR 200 965-1295 200 1900 1 Not selected 502,000 CHF 

In this example, a price of CHF 502 per unit is entered in the Current period column of the 

price table for item 965-1295 and customer 1900. 

4. The item ID of the item to be delivered is selected on the Order tab in the sales order. Thus the 

conditions are met for the hierarchical check performed when calculating the price in sales 

orders, and the price determined in the price table is entered into the respective fields. 

Example: 

SVO Resource Short description Quantity, Qty, Q UOM Price 

MA 965-1295 Spring package 1,00 U 502,00 

This excerpt from the Order tab of the sales order shows the result. 

The price of CHF 502 is output to the Price field after the item is confirmed. 

Note: The prices are generally based on the period of the confirmed date. If this due date 

field is empty in the sales order, the prices are read from the period of the requested 

delivery date. 

For tax calculation, the following applies: Infor COM generally bases tax calculation on the 

delivery date requested by the customer. You can view the requested date in a sales order 

on any tab in the header of the form. 
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Examples of price calculation 

Item 990-1500 belongs to item group 200. Refer to the following table for the sales prices of the 

item for different customers and customer groups: 

SVO Item grp Item ID Co. grp Company ID DT % Current period CU 

PR 200 990-1500 1  1 Not selected 629,670 EUR 

PR 200 990-1500 2  1 Not selected 635,740 EUR 

PR 200 990-1500 200 1000 1 Not selected 491,000 EUR 

PR 200 990-1500 200 1700 1 Not selected 621,320 EUR 

 

For company group 1 the sales price is EUR 629.67, while for company group 2 it is EUR 635.74. 

In addition, company-specific prices are set for customers 1000 and 1700, who are assigned to 

customer group 200. 
 

Discount calculation 

Apart from prices, discount rates can be stored in the price tables. The discounts available for 

selection are described in the Discount calculation section of the Prices and discounts in 

Purchasing Help topic. The information provided there for PO lines and POs similarly applies to 

order lines and orders here. 

Please note: The discount flags must be stored in both the item/supplier master data and the price 

table for automatic discount calculation in documents. 

It is not enough to enter the discounts in the price table. 

The customer master (Customer business data tab) specifies whether the discounts are calculated 

through addition or multiplication. These settings are loaded by default into the sales order and 

can also be changed there. 

The following steps show how discounts are entered and calculated. A hierarchical check of the 

entries in the price table is carried out for the discount calculation. 
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Hierarchical check during discount calculation 

Discounts that you give to your customers are managed in the price table. In the following order, 

we show how the check for stored discounts is performed in four steps. 

Example: Item 965-1295 (item group 200) is sold to customer 1500, who belongs to company 

group 220. An order is generated. 

SVO Item grp Item ID Co. grp Company ID DT % Current period 

D1 200 965-1295 200 1700 1 Selected 1,000 

D1 200 965-1295 200 1750 1 Selected 2,000 

D1 200 965-1295 220  1 Selected 3,000 

 

If the item is entered in the sales order, the system checks the price table for entries in a specified 

sequence to identify a stored discount. We already saw this hierarchical check above in the 

Hierarchical check during price calculation section in the example of prices. This also applies to 

discounts. 

When the first matching condition is identified, the price record data is transferred to the sales 

order. 

Check 1: Is there a discount record containing item ID 965-1295 and company ID 1500? The 

answer is no. 

Check 2: Is there a discount record that contains both item group flag 200 and company ID 1500? 

This is also not the case here. 

Check 3: Is there a discount record containing company group flag 220 and item ID 965-1295? 

The answer is yes. A discount of 3% is recorded for this combination, which is then transferred to 

the sales order. 

The following cases show how individual discounts are calculated. 
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Line discounts 

Line discounts are discounts relating to an individual order line. The following options exist for 

setting line discounts: 

 Discount records (D1, D2 record types) 

 Quantity discount records (QD record type) 

 Value discount records (VD record type) 

Line discounts are calculated correctly subject to the following prerequisites. 

 The discount flag >= 200 is stored in the company master data of the customer on the 

Customer business data tab. 

 A flag >= 200 is stored in the master data of the item. 

 A discount is stored in the price table for the combination of the price flags of the supplier and 

the price flags of the item. 

Examples 

SVO Item grp Item ID Co. grp Company ID DT % Current period 

D1 200 965-1310 200 1700 1 Not selected 7,000 

D1 200  200 1700 1 Not selected 5,000 

D1 200  200  1 Not selected 6,000 

This section from the price table shows three discounts. Customer 1700 receives a discount of 7% 

on item 965-1310 in the current period, a discount of 5% on item group 200, and all customers in 

customer group 200 receive a discount of 6% on item group 200. 

 

SV

O 

Item grp Item ID Co. grp Company ID DT % Current period Limit 

VD 200 965-1295 1  1 Selected 0,100 10.000,00 

VD 200 965-1295 1  1 Selected 0,250 20.000,00 

The following table shows a line-based value discount. The customers receive a value discount of 

0.1% on the line value for item 965-1295 above an order value of EUR 10,000, and a line discount 

of 0.25% above an order value of EUR 20,000. 

The item ID of the item to be ordered is selected from the Order tab in the sales order. This fulfills 

the conditions for the hierarchical check when calculating prices in sales orders, and the price 

calculated in the price table is entered. 
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Example: 

SVO Resource Short description Qty UOM Price FxdDis TotalDisc 

MA 965-1295 Spring package 1,00 U 796,76 0,000 7,97 

This excerpt from the Order tab shows the result. A discount of 1% was calculated on the price of 

796.76. 

 

Note: If the discount is not calculated in the order, you can quickly correct any errors on the 

Discount groups tab of the order. Ensure that the discount flags of the company and item 

correspond. In the example, the item group flag 200 and the company flag 200 should be stored 

for the item. 

Example: 

RT Resource Price Sales tax Disc1 

MA 965-1295 200 1 200 

 

Company groups 1700 200 1 200 

The table shows extracts of the settings on the Discount groups tab. 

The Disc1 column (discount 1) shows both flags that are loaded by default from the item master or 

company master. If one of the flags was set incorrectly, you can correct this here. 
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Order (value) discounts 

Order value discounts are granted on the overall order total, depending on the order value. 

Order discounts are granted on the overall order total, regardless of the order value. 

Note: Order discounts are assigned using the D2 discount type (standard discount 2) and order 

value discounts using the VD record type. As these two discount types are also used for line 

discounts, the following special points must be noted when using them for order discounts. 

The following table provides an overview of the entries you have to make in the price table and in 

the Order header view on the Prices/discounts tab in order to ensure the correct calculation of 

order value discounts and order discounts. 

 Company group Company ID Item group Item ID 

Information from the 

order header 

* Company ID 1 --- 

 Company group --- 1 --- 

 1 --- 1 --- 

 

* Any value 

--- Field must be empty 

As the discounts apply to the entire order, they are always item-independent. This is mapped using the search for 

item group 1 and the empty Item ID field. 

 

 

Complete the following steps to check whether there is an order discount: 

1. Is there a record with item group (Item grp) 1? This 1 is the default flag for order discounts. The 

item ID field must be empty, as there is a line discount if it contains an item ID. 

2. Is there a record with a company ID specified? If so, the discount record is calculated on the 

order total of an order for that company. 
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3. Is there a record with a company group flag specified? If so, the discount record is calculated 

on the order totals of orders for that customer group. 

Example: The value discount of 2 percent (read from the Current period column) applies for all 

customers in company group 200. It is calculated on the order total of the customers who 

belong to this company group. See the following example for the relevant settings in the price 

table. 

Examples: 

An order discount 2 (record type D2) of 3 percent applies in the current period for customer 

1700, who belongs to customer group 230. See the table for the settings for the discount 

record in the price table. 

SVO Item grp Item ID Co. grp Company ID DT % Current period 

D2 1  230 1700 1 Selected 3,000 

 

Customer 1700 receives a value discount of 1% above a total order value of EUR 30,000 

and a value discount of 2.5%above an order value of EUR 60,000. 

Customer group 200 receives a discount of 5% above a total order value of EUR 300,000 

and a value discount of 10% on the total order value above an order value of EUR 

600,000. 

 

SV

O 

Item grp Item ID Co. grp Company ID DT % Current period Limit 

VD 1  200 1700 1 Selected 1,000 30.000 

VD 1  200 1700 1 Selected 2,500 60.000 

VD 1  200  1 Selected 5,000 300.000 

VD 1  200  1 Selected 10,000 600.000 
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Discounts for individual business transactions 

You can also control discounts that are only granted in individual business transactions using 

defaults in the price table by creating these discounts as general discount groups. The 

explanations given in the Discounts for individual business transactions section of the Prices and 

discounts in Purchasing Help topic apply here also. 

Example: 

SVO Resource Price Tax Disc1 

MA 978-3000 200 1 2 

 

Company 

groups 

1700 200 1 2 

 

The Disc1 (discount 1) column in the order table shows the flag for Discount 1, which was copied 

from the item master data. 

This matches the flag from the Company groups row at the bottom of the Discount groups tab, 

which is loaded by default from the company master. As a result, a discount of 2% is automatically 

output in the document if you enter item 978-3000 in the sales order, assuming a corresponding 

discount is specified in the price table for this combination of flags. See the following table for the 

price table settings. 

SVO Item grp Item ID Co. grp Company ID DT % Current period 

D1 2  2 700 1 Selected 3,000 

 
 

Record types (Price table) 

For information on calculating prices in Sales, see Prices and discounts in Sales (page 368). 

The record type distinguishes the type of prices and discounts allocated to the item. This allocation 

can be set in both the price table and the item master. 
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Record type Description 

PR Prices in the configured currency unit. They are preset in the 

COMMON.PREISRECHNUNG.DEFAULTWE parameter. 

When entering prices in a foreign currency, you must enter these under CU. They 

are only converted if the FREMDWEUR allocation table is maintained.  

D1 This record type is base discount 1. It can be stored as a line discount for an item. 

D2 This record type indicates Base discount 2. It has a different calculation basis 

from Base discount 1. It can be also be used as an order discount, unlike base 

discount 1. 

QD Quantity discounts are entered on an item-specific basis. Always enter quantity 

discounts for the item. 

VD Value discounts can be based on the value of the line, that is, the unit price 

multiplied by the quantity. They can also be granted for order values. 

AC The prices for additional costs can only be allocated in the price table and by 

selecting Prices - Additional costs. They cannot be assigned in the item master. 

 
 

Update prices 

For information on calculating prices in Sales, see Prices and discounts in Sales (page 368). 

The price update function allows you to carry forward prices from one period to another. 

1. Open the price table for the prices to be updated by opening the Master data folder in Sales 

and selecting Prices. 

2. Select Functions and Price update. 

3. In the Price update section of the dialog box that is displayed, first use the check boxes to 

select the period(s) to which the prices are to be transferred. 
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4. In the first combo box to the right of = Period, select the period from which the price should be 

copied. 

5. In the second combo box, you can select a basic arithmetic operator that should be applied to 

the price update. 

6. In the input field, you have the option of entering an amount to which the arithmetic operator 

should be applied. 

7. In the Rounding field, select the rounding type (whole number, round up, round down) and set 

the Accuracy. 

Example: 

In the following example, the price from period 1 is copied to periods 2, 3, and 4, and it is 

also increased by the unit 1. The amount calculated is always rounded up to the nearest 

cent. 

Period 1 Not selected 

Period 2 Selected 

Period 3 Selected 

Period 4 Selected 

= Period 1 + 1,000 

Rounding type 0 

Accuracy 0,010 
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Commissions 

For an overview of the creation of master data in Sales, see Master data (Sales) (page 354). 

If you work with representatives, you can use commission tables to calculate representative 

commissions. You can access the commission tables from the Master data folder in Sales. When 

you open this folder, click Commissions. 

The following examples show you how to read commission tables. 

 

Representative, Rep. Rep grp. Item grp Item ID Co. grp Company ID DT % Current 

period 

 SO 50  200  1 Activated 2,000 

1350-04  0 965-1310 1  1 Activated 1,000 

 

Case 1: A commission of 2 percent (where the % check box is selected) is stored for item group 

50, company group 200, and representative group SO. You enter the commission rate in the 

Current period field. For example, the commission is due when a customer from company group 

200 orders an item from item group 50 and a representative of representative group SO is stored 

in the order. 

Case 2: When item 965-1310 is sold to companies from company group 1, representative R007 is 

due commission of 1 percent. 

For details of the prerequisites that must be met to calculate representative commissions, see 

Representative commissions (page 383). 

Commissions are calculated at two levels: 

a You allocate the representatives to a customer or an item. 

 Representatives who receive an order commission for concluding a contract with specific 
customers can be permanently assigned to these customers. For details of how to do this, 

see Assign representative to a customer (page 385). In this case, the representative data 

is automatically written to the order header (Commissions tab) when you create orders. 

Representatives specified in the order header receive an order commission, that is, the 

basis for commission calculation is the total of the Net 2 amounts of all lines in the order. 

These are located in the totals line in the order header/PO header. 
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 Representatives who receive an item commission for selling specific items can be 

permanently assigned to these items in advance. For details of how to do this, see Assign 
representative to an item (page 386). 

 You can assign representatives for an order commission or item commission in the sales 

order as the case arises. You can also delete default representatives in the sales order or 

replace them with other representatives. 

b You allocate commissions in the commission table. The guidelines for price storage described 

in the Price and discounts in Sales (see "Prices and discounts in Sales" page 368) Help topic 

apply here in principle. This means that you can use the commission tables for cross-item or 

cross-company commission rates, for example. 
 

Representative commissions 

For information on commissions (page 382), see the corresponding Help topic. 

Note: A commission can only be stored for either a representative or a representative group.  

The following prerequisites must be met for calculating representative commissions in sales 

orders: 

 The master data of the companies to which the representatives belong must be entered. The 

representatives are later assigned to the companies as employees. If the representatives are 

employees in your company, you must enter the master data of your firm. See also Enter 

master data for own company. 

Specify Own company when entering new information in the Usage 1 field in the master data. 

 The master data of the representatives must be entered and must be assigned to their 

companies. Representatives are created like all other employees. They just need to be 

assigned the Representative usage. 

 Either the representative or a representative group must be specified for each representative 

commission rate. Commission rates that do not follow this rule can result in commissions 

being assigned incorrectly. 

 The commission rates for calculating future order commissions and item commissions must be 

created in the commission table. 

 The commission basis must be defined in the 

COMMON.PREISRECHNUNG.PROVISIONSBASIS parameter. You can choose between a 

Net 1 amount or a contribution margin. 

 If you want to subdivide the representatives into groups, you must first define these 

representative groups. For a description of the standard procedure for this, see Create 
representative groups (page 385). Commissions can also be calculated for representative 

groups. 

Please note the following points: 
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 Representatives who receive an order commission for concluding a contract with specific 

customers can be permanently assigned to these customers in advance. For a description of 

the standard procedure for this, see Assign representative to a customer (page 385). When 

you enter orders, the assigned representatives are then transferred automatically to the order 

header. 

 Representatives who receive an item commission for selling specific items can be 

permanently assigned to these items in advance. For a description of the standard procedure 

for this, see Assign representative to an item (page 386). When you enter orders, the assigned 

representatives are then transferred automatically to the order line of the item. 

If you have not assigned any representatives to customers and items, you can enter the 

representatives for an order commission or item commission in the sales order later, at any time. 

You can also delete default representatives in the sales order or replace them with other 

representatives. 
 

Create representative 

For information on commissions (page 382), see the corresponding Help topic. 

For details of the prerequisites that must be met to calculate representative commissions, see 

Representative commissions (page 383). To create a representative, proceed as follows. 

1. In Sales, click the Master data folder, select Employees, and then click the New tab. 

2. Enter the representative's last name and first name in the dialog box. 

Select the Representative usage from the combo box of the Function field and specify the 

employee ID. The ID assigned by the system can be overwritten. 

3. Confirm your entries by clicking Create. 

4. Fill in the representative data in the fields in the form header. 

5. In the Co. ID field, select the ID of the company with which the representative is employed. If 

the representative works for your company, select the ID of your company here. 

6. If you have already selected the Representative usage in the dialog box on the New tab, the 

Function field is populated with this usage by default. 

7. Save your entries by selecting Data and Save. 
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Create representative groups 

For information on commissions (page 382), see the corresponding Help topic. 

Representative groups are created and maintained in the VERTGRP allocation table access via 

System functions > Tables. To do this, complete the following steps: 

1. Select System functions > Tables. 

2. On the Open tab, enter the table name VERTGRP. 

3. Click OK to confirm. 

4. In the next free row in the table, enter the flag and description of the representative group. 

5. Save your entries by selecting Data and Save. 
 

Assign representative to a customer 

For information on commissions (page 382), see the corresponding Help topic. 

To assign a representative to a customer, you must have stored the representative. See also 

Create representative (page 384). You store representatives for a customer in the customer 

master. 

1. Click Customers in Sales. 

2. In the dialog box on the Open tab, enter the customer's company ID and click Load to confirm. 

3. Select the Company profile tab. 

4. In the Representative1 and Representative2 fields in the Rep. form section, enter the IDs of 

the two possible representatives, or select the IDs from the combo boxes for these fields. 

5. The Representative group flags are added automatically when you enter the representative 

IDs, provided the representatives have been stored. 

6. Select the Commission flag for each representative. These commission flags are evaluated as 

company group flags when calculating commission. 

7. Save your entries by selecting Data and Save. 
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Assign representative to an item 

For information on commissions (page 382), see the corresponding Help topic. 

To assign a representative to an item, you must have entered the representative. See also Create 

representative (page 384). 

Representatives are assigned to an item in its master data. To do this: 

1. In Sales, click the Master data folder and select Sales items. 

2. In the dialog box on the Open tab, enter the item ID in the Item field and click Load to confirm. 

3. Select View and External item/representative to switch to the relevant tab. 

4. In the Representative1  and  Representative2 fields in the Rep. form section, enter the IDs of 

the two possible representatives, or select the IDs from the combo boxes for these fields. 

5. The Representative group flags are added automatically when you enter the representative 

IDs, provided the representatives have been stored. 

6. Select the Commission flag for each representative. These commission flags are evaluated as 

company group flags when calculating commission. 

7. Save your entries by selecting Data and Save. 
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For general information on Sales, see Sales basics (page 111). 

You can use the Batch processes folder in Sales to batch print various documents. 

This option exists for shipping documents, order confirmations, ASNs, and invoices. 

In addition, you can use Reprint order confirmation, Reprint advance shipping notices (ASN), and 

Reprint invoices to reprint documents. 

The Print sales documents in batch (page 114) topic describes the batch printout procedure. 

Please note the following special features: 

 When you batch print advance shipping notices, you can use the configuration to control 

whether goods are issued automatically, or whether you just want to print an advance shipping 

notice. 

 Invoice batch printing only works for issued lines. Payment plans, prepayment, cash sales, 

and so on are ignored in this case. 
 

Print shipping documents 

See Batch processes (Sales) (see "Batch processes" page 387). 

This function allows you to automatically create all necessary shipping documents for the load list. 

You can print shipping documents in Sales using the Batch processes folder 
 

Print order confirmations 

See Batch processes (Sales) (see "Batch processes" page 387). 

You open batch printing for order confirmations in Sales by selecting the Batch processes folder 

and then Print order confirmations. 

 
 

Batch processes 
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Print advance shipping notices (ASN) 

See Batch processes (Sales) (see "Batch processes" page 387). 

You open batch printing for advance shipping notices in Sales by selecting the Batch processes 

folder and then Print ASNs. 
 

Print invoices 

See Batch processes (Sales) (see "Batch processes" page 387). 

You open batch printing for invoices in Sales by selecting the Batch processes folder and then 

Print invoices. 
 

Reprint order confirmations 

See Batch processes (Sales) (see "Batch processes" page 387). 

To repeat the batch printout for order confirmations that have already been printed, select Reprint 

order confirmations in Sales. 
 

Reprint ASNs 

See Batch processes (Sales) (see "Batch processes" page 387). 

To repeat the batch printout for ASNs that have already been printed, select Reprint ASNs in the 

Batch processes folder in Sales. 
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Reprint invoices 

See Batch processes (Sales) (see "Batch processes" page 387). 

To repeat the batch printout for invoices that have already been printed, select Reprint invoices in 

the Batch processes folder in Sales. 
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Mailings are written communications that are sent to business partners in the form of a letter, fax, 

or e-mail. You can create them using the mail merge template provided. The template fields act as 

placeholders - these are populated with the corresponding addressee information and written to 

the mail merge document when you create a mail merge. 

You can also create labels in the same way. 

For international mass mailings, use mail merge templates in the corresponding language. This is 

controlled in Infor COM by the language flag. 

In Infor COM you can create plannable (see "Plannable mass mailings" page 392) and ad hoc 

mass mailings (page 393) in the Mailings folder in Sales. You can then decide if the addressees 

can be assigned in advance of the mass mailing. 

Language templates 

In Infor COM, you can assign different language autotexts and templates to companies and 

employees using the Language field in Companies or Employees. The Language field is always 

preset to the default language. For more information, see Define document language when 

creating master data (see "Define document language for companies" page 357). 

Assign language flags and templates 

The Information tab in Mass mailings shows all languages for which a flag is set in the Language 

field on the Communication tab. 

Before you can print mailings, you must assign a template to every language. 

There is no language displayed on the Information tab if there was no language flag set on the 

Communication tab for the addressees. If you want to assign a mail merge or label template, a 

message is displayed indicating that there was no language set. 

Mailings 
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If you want all addressees to have the same template for your mailing, select a language on the 

Information tab and assign the template. 

If you want to assign different templates to the addressees, you must first enter the language flag 

in the master data. If you open the Go to menu in Mass mailings and switch to the company and 

employee master, the changes for the current and previously created mass mailings will be 

applied. 

Enter title/salutation 

Enter the title of the person based on the language flag in the Language field. To do this, go to the 

employee header in Employees and enter the information in the Title 1 and Salutation fields. 
 

Assign addresses 

For general information on mailings, click here (see "Mailings" page 390). 

In Sales, open the Mailings folder and select Assign addresses to assign a mailing type to 

business partners, which you can select according to certain criteria. 

To assign individual business partners to a mailing type, go to Companies and select the 

Memo/details tab. 

For more information, see Assign addressees to a mailing type (see "Assign addressees to a 

mass mailing" page 396). 
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Mass mailings 

For general help on mailings (page 390), see the corresponding Help topic. 

In Sales, open the Mailings folder and select Mass mailings to create plannable (see "Plannable 

mass mailings" page 392) and ad hoc mass mailings (page 393) and assign addressees. 

You can also enter and edit feedback (see "Enter feedback" page 400) for each mass mailing. 

To do this, you first need to go to the Finance module, open the Master data folder, and enter the 

addressee information in Companies and Employees. 
 

Plannable mass mailings 

Plannable mass mailings (page 392) correspond to information that is sent to business partners 

and is known well in advance or is sent on a regular basis (such as trade fair invitations, Christmas 

greetings). These mass mailings generally require a certain amount of preparation time. 

Determining and assigning mailing types 

Create and update the following information: 

You can update the mailing types that your company sends out regularly (such as newsletters) or 

at specified times (such as holiday greetings) in the MAILTYPE allocation table in the 

Administration folder of the System functions module. 

Assign the required mailing types to your business partners on the Memo/details tab in Companies 

in the Master data folder of the Finance module. 

To assign multiple business partners that meet a particular criterion, you can define the 

addressees in Sales. To do this, open the Mailings folder and select Assign addressees. 

 

Creating a mass mailing 

To create a plannable mass mailing, open the Mailings folder in Sales and select Mass mailings. 

In the Reload addressees dialog box, assign the addressees in the Mass mailing type field. 

Example: Christmas greetings 
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In Companies or Assign addressees, define the business partners you want to receive annual 

Christmas cards in the future. 

Shortly before the Christmas period, create a mailing using Mass mailings. In Reload addressees, 

select the Christmas greetings entry in the Mass mailing type field. 
 

Ad hoc mass mailings 

Ad hoc mass mailings (page 392) are designed to provide business partners with up-to-date 

information. In Sales, open the Mailings folder and select Mass mailings to create a mass mailing 

and assign the corresponding address information. 
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Send mass mailings 

In Infor COM, you can print mail merges and, if required, labels and envelopes in Mass mailings 

(page 392). To do so, follow these steps: 

1. Set up templates (page 394) 

2. Assign addressees to a mailing type (page 396) 

3. Create mass mailings (page 396) 

4. Assign addressees to a mass mailing (page 396) 

5. Assign language mail merge and label templates (see "Assign language-specific templates" 

page 397) 

6. Create mail merge and label document (page 397) 

7. Print mail merges and labels (page 398) 

 

Then enter the replies if required. For more information, see Enter feedback (page 400). 
 

Set up templates 

Note: The following description applies for Microsoft Office 2000, the procedure may vary for 

other versions. 

For general information on sending mass mailings, see Send mass mailings (page 394). 

Use the MACMailing.dot template provided for mail merges and labels and the associated 

MACMailingFields.txt control file in the sysinfo\office_2000 folder. 

Copy the files to the same folder. 

Add the path to this folder to the COMMON.VERTRIEB.MAC-MAILINGPATH parameter in the 

configuration. The COMMON.VERTRIEB.MAC-TEMPPATH parameter defines the folder where 

temporary files are stored. 

There is no guarantee that other templates will work properly. 

Use the MACMailing.dot template provided as a sample for language mail merge templates. 
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Occasional problems may occur with the link between the template and the control file. To check 

the link and remedy any errors, complete the following steps: 

1. Start Microsoft Word. 

2. On the standard toolbar, click Open. 

3. In the Files of type field in the Open dialog box, select Document Templates (*.dot). 

4. Browse to the sysinfo\office_2000 folder. 

5. Select the MACMailing.dot file. 

6. Click Open. 

7. In the mail merge toolbar, click Insert Merge Field. You then have 2 options: 

 If the merge fields are displayed in list format, the setup is correct. In this case, you can 

skip steps 8-20. 

 If only one merge field is displayed, complete the following steps: 

8. On the mail merge toolbar, click the Add New Record button. The Mail Merge Helper dialog 

box opens. 

9. Click Import Data. 

10. Select Header Options. 

11. On the Header Options dialog box, click Open. 

12. In the Files of type field in the Open dialog box, select Text Files (*.txt). 

13. If necessary, go to the sysinfo\office_2000 folder, which contains the header file. 

14. Select the file name. 

15. Click Open. The Header Record Delimiters dialog box is displayed. 

16. In the Field Delimiter combo box, select the character you want to use to separate fields in the 

Preview field. 

17. Click OK. You return to the Mail Merge Helper. 

18. Click Close. 

19. On the mail merge toolbar, click Insert Merge Field. The merge fields are then displayed in list 

format. 

20. On the standard toolbar, click Save. 
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Assign addressees to a mailing type 

Before carrying out the following steps, you must have completed the following steps in Send 

mass mailings (page 394): 1 

1. In Sales, open the Mailings folder and select the Assign addresses folder. 

2. From the combo box on the dialog box, select the Mass mailing type to which you want to 

assign addressees. 

3. Click OK. 

4. In the Open addressees dialog box, use the combo boxes to define who you would like to 

include in mass mailings based on the mailing type. 

5. Click OK. The selected addressees are displayed in a table. 

6. To add more addressees, open the Data menu and select Reload. Otherwise, close the table. 
 

Assign addressees to a mass mailing 

Before carrying out the following steps, you must have completed the following steps in Send 

mass mailings (page 394): 1-3 

1. In an open mass mailing, open the Functions menu and select Reload addressees. 

2. Use the fields in the dialog box to define the business partners to be written to. 

3. Click OK. You return to Mass mailings. 

4. To add more addressees, open the Functions menu and select Reload addressees. 

5. Save the data. 
 

Create mass mailings 

Before carrying out the following steps, you must have completed the following steps in Send 

mass mailings (page 394): 1-2 

1. In the Mailings folder in Sales, open Mass mailings. 

2. In the dialog box that opens, click the New tab. 
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3. Enter a description for the mass mailing. 

4. Click Create. 

5. Save the data. 
 

Assign language-specific templates 

Before carrying out the following steps, you must have completed the following steps in Send 

mass mailings (page 394): 1-4 

1. In an open mass mailing, go to the Information tab. 

2. Select the first row. 

If the Language field does not contain a value, see Company and employee data language 

templates. 

3. From the Functions menu, select the Mail merge or Label submenu and then select the Assign 

template command. 

The Open dialog box is displayed. 

4. Select the appropriate template. 

5. Click Open. 

The file name and path are displayed in the Mail merge template or Label template field. 

6. Enter the general salutation in the Alias contact field. See also Information. 

7. Save the data. 

Follow these instructions for all languages displayed. 
 

Create mail merge and label document 

Before carrying out the following steps, you must have completed the following steps in Send 

mass mailings (page 394): 1-5 

1. In an open mass mailing, go to the Information tab. 

2. Select the first row. 

3. From the Functions menu, select the Mail merge or Label submenu and then select Assign 

template. 
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4. In the File name field, enter the name of the mail merge or label document. 

5. Click Save. 

The file name and path are displayed in the Mail merge document or Label document field. 

6. Save the data. 

Follow these instructions for all languages displayed. 
 

Print mail merges and labels 

Before carrying out the following steps, you must have completed the following steps in Send 

mass mailings (page 394): 1-6 

Make sure a mailing address, fax number, or e-mail address is entered on the Addresse tab so 

that data records can be printed correctly. 

1. In an open mass mailing, go to the Communication tab 

2. Apply a mail freeze or check the mail freeze for addressees you do not want to contact. 

3. From the Functions menu, select the Mail merge or Label submenu and select the required 

print option. 

For more information, see Mail merge/label printing variables (see "Create mail merge and 

label document" page 397). 

4. Save the mass mailing. 
 

Mail merge/label printing variables 

For general information on sending mass mailings, see Send mass mailings (page 394). 

The following print options are available on the Mail merge and Label submenus of the Functions 

menu: 

 

Offline 

Use this option if there is a large number of letters and printing these would take too long. 

A Word file containing the letters is generated. You can then print this file later. 
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The status of the mass mailing is set to Printed offline. 

 

Online 

A letter is created for each addressee and printed from the connected printer. 

The status of the mass mailing is set to Printed online. 

 

The following options are available for mail merges only: 

 Test print 

Use this option to see what the mail merge will look like. After the test print, the status of the 

mass mailing will still be Addressees assigned. 

 Reprint 

Reprints mailings that were printed offline or online. 
 

Define mail freeze 

You can use a mail freeze to define which business partners or companies you do not want to 

contact as part of the next plannable mass mailing (see "Plannable mass mailings" page 392). In 

Employees or Companies, select the freeze option for the corresponding mailing type. 

Business partners with a mail freeze are included when addressees are assigned provided they 

meet the selection criteria. Setting a mail freeze prevents a mailing from being created for these 

addressees. You can remove the mail freeze before you print the mail merge for addressees for 

whom you do in fact want to create a mailing. 

Example: You are planning the next trade fair invitation. You do not want to include contact A this 

time as the trade fair does not concern his industry. On the Memo/details tab in the employee 

master record, activate the mail freeze for the corresponding mailing type. 

Create the mass mailing and select as the addressees all business partners that were assigned 

the trade fair invitation mailing type. All contacts with this mailing type are loaded regardless of 

whether a mail freeze was activated for this mailing type. 

If you really do not want to send a trade fair invitation to contact A, for whom you activated the mail 

freeze, leave the mail freeze activated. No mailing is printed for this addressee. 

If you would like to invite contact A to the trade fair, remove the mail freeze. A mailing is printed. 
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If you had planned on inviting contact B but learn shortly before you print invitations that she 

cannot come, activate the mail freeze for this contact. No trade fair invitation is printed for this 

contact. 

You can select three types of mail freeze. 

Mail freeze for 

mailing types 

You can select a mail freeze for each selected mailing type for a contact. The 

contact does not receive a mailing if a mass mailing is created based on this 

mailing type. Activate the mail freeze on the Memo/details tab in Employees or 

Companies. 

Please note: A mail freeze will only be applied if you select the addressee from 

the Mailing type field after selecting Reload addressees in Mass mailings. 

 The field must contain the corresponding mailing type. To further restrict 

addressees, you can populate additional fields. 

Mail freeze for 

employees 

If you activated a mail freeze for a contact on the Memo/details tab in 

Employees, the employee will not receive a mailing even if the flag is not set for 

a mailing type. 

Mail freeze for 

companies (general 

mail freeze) 

If you select the general mail freeze on the Memo/details tab in Companies, 

none of the contacts in this company receive mailings, regardless of the mail 

freezes set in Employees. 

In the case of ad hoc mass mailings, if you have activated a mail freeze for an 

employee or company, a mail freeze is also applied by default to the selected 

employees or to all contacts. 

 
 

Enter feedback 

You may need to enter replies for mass mailings (page 392) to carry out a cost/benefit analysis or 

to initiate follow-up actions. 

There are two ways to enter feedback: 
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 To enter the feedback from a particular addressee, open the Mailings folder in Sales and 

select Enter feedback to enter the feedback ID. 

If the feedback ID is printed on the reply, you can enter the feedback using a barcode reader. 

 If you want to enter more than one set of feedback, open the Mailings folder in Sales and 

select Mass mailings. Then select the Replies tab and load the data records. 
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For general information on Sales, see Sales basics (page 111). 

Note: See also Configuration (Archive). 

When you archive documents in the Archive folder in Sales, a document from the current stock of 

movement data is moved to a special archive database, where it can be managed until further 

notice. Archived documents are no longer managed in the overview table of the current 

documents. 

You cannot archive individual lines of a document separately. Documents are always archived 

completely together with their current status. 

Whether or not an order is closed (fully invoiced) is irrelevant when it comes to archiving. Before 

you archive sales orders that are still open, the system issues a prompt to this effect. 

You can archive documents individually or simultaneously in batches using batch process 

archiving. 

The standard procedure is described in Archive sales orders (page 402) and Batch archive sales 

orders. 

You can view and reactivate (see "Activate sales orders" page 404) archived sales orders at any 

time, that is, you can copy them again from the archive database to the movement data at any 

time. 

Note: The processes described for sales orders apply for other archived document types also. 

For information on how to delete sales orders, see Delete archived sales orders (see 

"Delete/export sales orders" page 406). 
 

Archive sales orders 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

To archive sales orders, complete the following steps: 

Archive (Sales) 
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1. Select Sales > Archive > Archive sales orders. 

2. In the Archive sales orders dialog box, use the Order ID and Cust. ID fields, for example, to 

narrow down the documents to be archived. 

Please note: You can make a further selection using the check boxes in the Status form 

section. If you use the Invoiced selection criterion (default setting), the current selection will be 

further narrowed down to sales orders with the status Invoice printed. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select the Selection from list check box to display a list of all chosen documents prior to 

archiving. 

Note: If you want to exclude one or more of the documents displayed in this list from 

archiving, select every line that you want to archive. Documents that are not selected will 

not be archived. 

If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

5. Select the Confirmation for outstanding sales orders check box to instruct the system to report 

all outstanding (that is, not yet closed) orders prior to archiving. 

6. Click OK to start the archiving process. 
 

Archive credit memos 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

To archive credit memos, complete the following steps: 

1. Select Sales > Archive > Archive credit memos. 
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2. In the Archive credit memos dialog box, make the required restrictions for the documents to be 

archived - for example, using the Credit memo ID and Cust. ID key fields. 

Please note: Use the check boxes in the Status form section to make a more detailed 

selection. If you use the Inv cancld selection criterion (default setting), only credit memos that 

are based on invoice cancellations are selected. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select the Selection from list check box to display a list of all chosen documents prior to 

archiving. 

Note: If you want to exclude one or more of the documents displayed in this list from 

archiving, select every line that you want to archive. Documents that are not selected will 

not be archived. 

If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

5. Select the Confirmation for outstanding credit memos check box to instruct the system to 

report all outstanding (that is, not yet closed) credit memos prior to archiving. 

6. Click OK to start the archiving process. 
 

Activate sales orders 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

The Archive sales orders (page 402) Help topic describes how to archive sales orders. The 

following steps show you how to activate archived sales orders again, that is, how to make them 

accessible for document processing. 

 

When you reactivate a sales order, you are basically creating a new order. The order receives the 

status Sales order. The archive order continues to remain in the archive database. 
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Note: You can only activate sales orders on a one-by-one basis. Batch activation of multiple sales 

orders is not possible. 

1. Select Sales > Archive > Sales orders. 

2. On the Open tab, enter the order ID in the Order ID field and click Load to confirm. 

To display all archived orders, enter % in the Order ID field and click OK to confirm. 

If there is more than one order, the order overview is opened. Select the required order by 

double-clicking the ID in the row header. 

Note: The following form where the document that is still archived is displayed has very 

limited functions and is only designed to allow you to view all order data. 

3. Select Functions > Activate. 

4. The system now opens a dialog box that proposes an order ID for the new document. 

Complete the rest of the fields in line with your requirements. 

Note: This order ID is the same as the ID for the archive document, provided that a document 

does not already exist with this ID in the movement data. If this ID does already exist, then the 

system automatically assigns a different ID. 

5. Confirm your entries by clicking OK. 

A new document with the details you just entered is now created from the archive order. The 

system switches to the order form to further process this new document. 
 

Activate order releases 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

1. Select Sales > Archive > Order releases. 

2. On the Open tab, enter the order ID in the Order ID field and click Load to confirm. 

To display all archived orders, enter % in the Order ID field and click OK to confirm. 

If there is more than one order, the order overview is opened. Select the required order by 

double-clicking the ID in the row header. 

Note: The following form where the document that is still archived is displayed has very 

limited functions and is only designed to allow you to view all order data. 

3. Select Functions > Activate. 
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4. The system now opens a dialog box that proposes an order ID for the new document. 

Complete the rest of the fields in line with your requirements. 

Note: This order ID is the same as the ID for the archive document, provided that a document 

does not already exist with this ID in the movement data. If this ID does already exist, then the 

system automatically assigns a different ID. 

5. Confirm your entries by clicking OK. 

A new document with the details you just entered is now created from the archive order. The 

system switches to the order form to further process this new document. 
 

Activate credit memos 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

Proceed as follows to activate an archived credit memo. 

1. Select Sales > Archive > Credit memos. 

2. On the Open tab, enter the Credit memo ID and and click Load to confirm. 

To display all archived credit memos, enter % in the Credit memo ID field and click OK to 

confirm. 

If there is more than one credit memo, the credit memo overview is opened. Select the 

required credit memo by double-clicking the ID in the row header. 

3. Select Functions > Activate. 

4. An order ID for the new document is proposed in the dialog box that is displayed. Complete the 

remaining fields as required. 

5. Click OK to confirm. 
 

Delete/export sales orders 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

For information on how to archive sales orders, see Archive sales orders (page 402). To delete an 

archived sales order, proceed as follows. 
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"Delete" here means that the orders are exported from the archive to a file. 

The name of the export file is specified in the COMMON.ARCHIVM8 section of the configuration. 

The target drive, together with the target directory where the file is to be stored, is defined in the 

ARCHIV section of the configuration. 

This file is created for the first export and updated each time you subsequently export data. 

1. Select Sales > Archive > Delete/export SO archive. 

This opens the Delete/export archived sales orders dialog box. 

2. Use the From - To fields to select the orders to be deleted. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

Select the Selection from list check box to once again display a list of the sales orders 

selected for deletion prior to the data export. 

Note: To exclude one or more of the displayed documents on the list from deletion, select 

all the lines to be deleted. Documents that are not selected will not be deleted. 

To select certain orders from the list, press and hold the CTRL key and then click the IDs 

in the row headers of the orders that you want to delete. Orders that are not selected will 

not be exported. 

If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

4. Select OK to start the data export. 
 

Delete/export order releases 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

1. Select Sales > Archive > Delete/export order releases. 

This opens the Delete/export archived order releases dialog box. 

2. Use the From - To fields to select the order releases to be deleted. 
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3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select the Selection from list check box to once again display a list of the order releases 

selected for deletion prior to the data export. 

Note: From the list that is displayed, you can select individual order releases for deletion. To 

do so, press and hold the CTRL key and then click the ID in the row header of the order 

releases that you want to delete. Order releases that are not selected will not be deleted. 

If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

5. Select OK to start deleting. 
 

Delete/export credit memos 

For general information on archiving in Sales, see Archive (Sales) (page 402). 

1. Select Sales > Archive > Delete/export credit memos. This opens the Delete/export archived 

credit memos dialog box. 

2. Use the From - To fields to select the credit memos to be deleted. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select the Selection from list check box to display a list of all selected credit memos prior to 

deletion. 

Note: From the displayed List (displayed if the Selection from list check box is selected), you 

can select individual credit memos to be deleted. To do so, keep the CTRL key pressed down 

and click the ID in the row header of the credit memos that you want to delete. 
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If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

5. Select OK to start deleting. 
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A log with information on the deleted documents is available in this folder. 
 

Missing document IDs 

To access this process, select Sales > Logs > Missing document IDs. 

Depending on the country, national legislation may require that documents be available 

contiguously. This requirement may conflict with the Infor COM feature that allows you to delete 

documents. 

The Missing document IDs desktop object therefore allows you to display deleted documents or 

information on deleted documents so that you can achieve a complete documentation of the 

document sequence. 

 

Logs 
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Design is used to prepare the resources (page 435) (items work centers, machines, tools) and 

BORs (page 461) for order processing. Use the objects in this folder to enter and maintain the 

master data for the resources. 

 

Design basics 
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Allocation tables (Design) 

The following allocation tables are important when working in Design. 
 

AGRKNZx 

Description: Item group flag x 

Type: This allocation table can be modified by the user. 

Usage: Items can be combined into groups in the item master. The group flags can be used for 

selection in the Filter function and for statistical evaluations. You can assign up to five group flags 

per item in allocation tables AGRKNZ1 to AGRKNZ5. 

Example: The groups for the first group sort order are created in the AGRKNZ1 allocation table. 

The groups created in this table are available for the item in the first group flag field. 

Note: The Parent group 1/2 fields are currently not evaluated. 
 

ARTAUSLAUF 

Description: Item quarantine flags 

Type: This allocation table can be modified by the user. 

Usage: Flags for items are stored in this allocation table. They can be allocated to the individual 

items in the item master. They control the output of messages and the type of storage; see the 

information on the Validity section of the form. 

The following are the default values in this allocation table: 

Description 

 0 (Standard line item): Items with this flag are not checked again when they are used. This flag 

is set by default.  

This row in the allocation table must not be changed. 



414 | Infor COM 7.5 User Guide 

 

Design 

 

 1 (Special item): When used in BORs or orders, items with this flag trigger a message that 

refers to the special item. You can then decide whether you want to use the item, cancel the 

process, or continue the process with another item. 

This row in the allocation table must not be changed. 

 2 (Discontinued item): This flag works in conjunction with the due date entry in the Disc. date 

field. 

If the specified discontinued date of the item is after the computer date, the system only 

informs you that it is a discontinued item. You can cancel or continue the process. 

If the discontinued date is before the computer date, the system refuses to save the current 

process and displays a message to this effect.  

This row in the allocation table must not be changed. 

 3 (Prohibited item): If an item with this flag is used in BORs, purchase orders, or orders, the 

system refuses to save the current process and displays a message to this effect. 

This row in the allocation table must not be changed. 

 4 (User entry): You can include your own flags in entry 4. These are treated as special items, 

which means that a note appears containing the text stored in this allocation table. The item 

can be saved despite this warning. 

 5 (Discontinued item by consumption of remaining inventory qty): In this case the item is 

quarantined if the inventory that is currently available cannot cover requirements. If this is the 

case, an error message is displayed when you save the business object. If you save in a batch 

process, the error message is written to mailbox 20. 

Using this item in a PO results in an error message. If the item is used as materials 

provided, the system checks whether the inventory currently available can cover the 

requirement. 

Creating a production order for this item results in an error message. If the item is used as 

a material line, the system checks whether the inventory currently available can cover the 

requirement. 

If sales orders are created for this item, the system checks whether the inventory currently 

available can cover the requirement. 

If you generate a variant order, the system checks whether the inventory currently 

available can cover the requirement. If not, you are not permitted to create the new variant 

order. The error is logged to mailbox 85. 

 

 
 

ARTKLASSE 

Description: Item classes 
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Usage: Item classes are stored in this allocation table. They can then be selected in the Item 

class field in the item header. 
 

ARTKNZ 

Description: Item flags 

Type: This allocation table can be modified by the user. 

Usage: This allocation table is available in the item master. The flags stored here can be used as 

price flags for items. They set the type of price calculation in the order but can be replaced in the 

order. 

For information on using these flags when calculating prices, see Prices and discounts in Sales. 
 

CHSTSTATUS 

Type: The user is not allowed to modify this allocation table. 

Description: Statuses for managing change statuses 

Usage: See Change status management. 
 

EINMARTIKEL 

Description: One-off items 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table appears in a list box in the One-off items dialog box. This dialog box 

appears if new resources that do not yet exist in the master data are included and saved in the 

order or BOR maintenance. 
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LVFORMEL 

Description: Size management formulas 

Type: This table must be filled in by the user. 

Usage: Formulas for calculating lengths, areas, and volumes are stored in this allocation table. 

The allocation table is available in the item master on the UOM/size management tab in the 

Formula field's list box. It is also used in Sales, Purchasing, and Manufacturing control on the Size 

management tab. 

F ID 

Enter an ID for the formula here. The formulas must be numbered sequentially in ascending order. 

Formula for size management 

Specify the database fields required for calculation here. 

You can extend the formulas to include waste factors, totals, etc. However, constants cannot be 

referenced; these must be entered manually in the formulas. 

The result must be assigned to the DbPart.LvErgMenge field. The formula can use all numerical 

fields in the DbPart structure. 

Type 

Specify the dimension for the formula result. The list box accesses the LVTYP allocation table. 

The types are required for selecting the possible dimensions. 

Label 

Provide a meaningful description for the formula here. 
 

LVME 

Description: Units of measure for size management 

Type: This allocation table can be modified by the user. 
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Usage: The appropriate square measures and volume units for the size dimensions are stored in 

this allocation table. This means, for example, that the product of two fields with the unit of 

measure m is an area with the unit of measure m2. 

The abbreviations for the square measure and the volume unit for the specified size dimension are 

stored in every row. 

UOM 

Specify the abbreviation of a UOM to be used to measure the lengths, widths, and heights of 

items. This UOM must also be included in the  MEBASIS allocation table. 

Sq. measure 

Specify the abbreviation of a UOM to be used to calculate the area for the adjacent size 

dimension. This UOM must also be included in the  MEBASIS allocation table. 

Volume unit 

Specify the abbreviation of a UOM to be used to calculate the volume for the adjacent size 

dimension. This UOM must also be included in the  MEBASIS allocation table. 
 

LVTYP 

Description: Size management formula types 

Type: The user is not allowed to modify this allocation table. 

Usage: The numerical key for lengths, square measures, and volume units is stored in this table. 

Other allocation tables, for example LVFORMEL, use this key. 
 

MANUFCLASS 

Description: Item master: Manufacturer classes 

Usage: The manufacturer classes entered in this table can be used in the item master to classify 

the item. 
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MEBASIS 

Description: Units of measure 

Type: This allocation table can be modified by the user. 

Usage: All units of measure (UOM) are stored in this allocation table. They are used at various 

places in the program, for example in the item master (e.g. the UOM for warehouse inventory 

management) and the movement data (e.g. the UOM for PO or order quantity). See also the Help 

topic relating to the LVME allocation table. 

UOM 

The key value for the unit of measure (ZTKey field) is specified here. This field is the same 

regardless of the language. If Infor Infor COM is used in multiple languages, these entries must be 

the same in all table versions. 

Issue UOM 

In the German standard version, this field is identical to the UOM field. However, it is designed as 

a language-dependent field, which means that the corresponding foreign-language abbreviation 

can be entered here for a foreign-language table. This should then be used instead of the UOM 

field for output purposes, in documents for example. 

Description 

This field provides a description of the unit of measure. 

Basis 

This field specifies the basis on which a quantity is rounded in the current unit. 

Examples: 0.01 means that the quantity is rounded up to two decimal places. 1.00 means that 

the quantity is rounded up to a whole number. 

Round: The following values can be stored in this field: 
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0 Do not round 

1 Round to whole number 

2 Round up 

3 Round down 

Type 

This field indicates the formula type for measures of length, area, volume, and weight. You can 

choose from the values in the LVTYP allocation table (size management formula types). 
 

MEUMRECH 

Description: Unit of measure conversion 

Type: This allocation table can be modified by the user. 

Additions are possible or existing unit of measure abbreviations can be adapted to the entries in 

the MEBASIS allocation table. The conversion factors between these generally used UOMs 

should not be changed. 

Usage: Resource-independent conversion factors are managed in this allocation table (for 

example, centimeters to meters). This allocation table can be used to add data or to adapt existing 

UOM abbreviations to the entries in the MEBASIS allocation table. The conversion factors 

between the generally used UOMs should not be changed. 

Basis 

This field specifies the quantity for the initial UOM. 

UOM of 

This field specifies the initial UOM. 

Factor 

This field specifies the quantity for the target UOM. 

UOM by 

This field specifies the target UOM. 

Example: Basis 10, UOM of : cm factor 1, UOM by: cm specifies: 10 centimeters = 1 decimeter 
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PARAMRESSAB 

Description: BOR reconciliation 

Usage: This allocation table is required for the BOR reconciliation based on actual data (the 

Reconcile BOR function in BOR maintenance). 
 

PRODUCTGRPS 

Description: Item groups 

Usage: This table can be used to combine inventory items into product groups for the purposes 

of analysis. 
 

TEILECHAR 

Description: Items character 

Usage: This allocation table permits further specification of items in item master data 

management. This can be, for example, a spare part, a standard item, a DIN item, or any other 

typical user classification. 
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Record types (BOR) 

Record type Description 

OP (60) This record type represents an operation where the work center group is always 

displayed when a selection is made – even if you select a single work center. 

The processing duration is calculated for each of these lines. On the 

Times/quantities tab, default settings are entered (from the BOR) for the setup 

times and runtimes, or new entries are specified (for new lines). 

The work center’s capacity is checked in line with the assigned shift plan. 

AO (66) This record type is an alternative operation. 

PH (125) A PH record is a phantom assembly, i.e. an assembly saved as a BOR. For 

more information, see Map assemblies to BORs (page 468). 

ES (65) This record type (external source) represents the supplier of a material to be 

purchased. 

SCO (115) This record type (subcontracted manufacturing) represents a third-party 

assembly whose BOR is in the subsequent rows of the order. 

For further information, see Subcontracted manufacturing (page 827). 

Note: The SCO record type is also supported as a milestone. This means that 

the dependent transactions can now also be triggered using milestone flags 

when subcontracted operations are entered in Purchasing. 

SCM (91) This record type (subcontracted material) indicates material that a 

subcontracted manufacturer provides in order to process an order. 

Note: This record type is only of use within a subcontracted manufacturing 

structure. The record type cannot be used in a Purchasing purchase order, that 

is, in conjunction with an ES record. 
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Record type Description 

HR (10) The HR line is the resource header record. It is set by the system and cannot be 

entered manually. If a BOR is assigned to multiple resources (in other words, it 

is not exclusive), an HR line is set for every resource assigned to the BOR 

when the BOR is loaded. 

BH (15) The BH record type (by-product header) is used to identify by-products. 

MA (90) The MA record stands for materials that are needed for manufacturing. 

Materials can be purchased items or in-house items. 

Purchased items: During order planning, a purchase order is generated at the 

next level. Materials are assigned to the HR line (header line) to which the 

supplier is assigned as the ES line (external source). To map the order 

structure of the resource, on the  Functions menu, select Structure BOR. 

In-house items: During order planning, a production order is generated at the 

next level. Materials are assigned to the HR line (header line) to which the 

corresponding BOR is assigned. To map the order structure of the resource, on 

the Functions menu, select Structure BOR. 

RM (16) This record type (residual material) represents receipts of residual and waste 

material in addition to the main product. See also Record types (Inventory). 

SY (130) This record type (synchronization point) is a delineation line between 

assemblies that prevents parallel scheduling of assemblies. 

As subcontracted manufacturing portions of a production order are handled as 

assemblies, a synchronization point also removes parallel scheduling when 

scheduling in the case of outsourcing. 

The function of this record type is illustrated using a practical example in the 

Store subcontracted manufacturing in manufacturing structure Help topic. 

F The TRA record maps transportation times. 

TL, TLR For more information, see Record types (Tools) (page 492). 
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Record type Description 

TX The TX record is a text line. For information on how to use TX records, see 

Outsourcing. 

The record type is used for classifying the items. The main components of BORs are OP lines 

(operations) and MA lines (materials). The record type is displayed on all tabs of the BOR. For 

more information, see alsoRecord types (Manufacturing) (page 819). 

You do not have to enter the record type yourself, it is set automatically when a resource is 

selected. 

The following record types are permitted in the BOR. 
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Record type Description 

OP (60) This record type represents an operation where the work center group is always 

displayed when a selection is made – even if you select a single work center. 

The processing duration is calculated for each of these lines. On the 

Times/quantities tab, default settings are entered (from the BOR) for the setup 

times and runtimes, or new entries are specified (for new lines). 

The work center’s capacity is checked in line with the assigned shift plan. 

AO (66) This record type is an alternative operation. 

PH (125) A PH record is a phantom assembly, i.e. an assembly saved as a BOR. For 

more information, see Map assemblies to BORs (page 468). 

ES (65) This record type (external source) represents the supplier of a material to be 

purchased. 

SCO (115) This record type (subcontracted manufacturing) represents a third-party 

assembly whose BOR is in the subsequent rows of the order. 

For further information, see Subcontracted manufacturing (page 827). 

Note: The SCO record type is also supported as a milestone. This means that 

the dependent transactions can now also be triggered using milestone flags 

when subcontracted operations are entered in Purchasing. 

SCM (91) This record type (subcontracted material) indicates material that a 

subcontracted manufacturer provides in order to process an order. 

Note: This record type is only of use within a subcontracted manufacturing 

structure. The record type cannot be used in a Purchasing purchase order, that 

is, in conjunction with an ES record. 

HR (10) The HR line is the resource header record. It is set by the system and cannot be 

entered manually. If a BOR is assigned to multiple resources (in other words, it 

is not exclusive), an HR line is set for every resource assigned to the BOR 

when the BOR is loaded. 
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Record type Description 

BH (15) The BH record type (by-product header) is used to identify by-products. 

MA (90) The MA record stands for materials that are needed for manufacturing. 

Materials can be purchased items or in-house items. 

Purchased items: During order planning, a purchase order is generated at the 

next level. Materials are assigned to the HR line (header line) to which the 

supplier is assigned as the ES line (external source). To map the order 

structure of the resource, on the  Functions menu, select Structure BOR. 

In-house items: During order planning, a production order is generated at the 

next level. Materials are assigned to the HR line (header line) to which the 

corresponding BOR is assigned. To map the order structure of the resource, on 

the Functions menu, select Structure BOR. 

RM (16) This record type (residual material) represents receipts of residual and waste 

material in addition to the main product. See also Record types (Inventory). 

SY (130) This record type (synchronization point) is a delineation line between 

assemblies that prevents parallel scheduling of assemblies. 

As subcontracted manufacturing portions of a production order are handled as 

assemblies, a synchronization point also removes parallel scheduling when 

scheduling in the case of outsourcing. 

The function of this record type is illustrated using a practical example in the 

Store subcontracted manufacturing in manufacturing structure Help topic. 

F The TRA record maps transportation times. 

TL, TLR For more information, see Record types (Tools) (page 492). 

TX The TX record is a text line. For information on how to use TX records, see 

Outsourcing. 

In addition, EMS provides additional record types. 
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Record types in the EMS environmental management system: 

Record type Description 

MC This record type stands for material constituents. See Material data 

management (available in German only). 

RM This record type indicates waste/residual materials. See the Enter waste in 
Manufacturing Help topic (available in German only). 

 
 

Assemblies 

Assemblies are items that are made during manufacturing and are processed but are not 

managed in the inventory (unlike material records). 

Assemblies can be included in BORs using assembly lines. A separate BOR is stored for each 

assembly. 
 

Routing 

The routing contains all operations that are required for manufacturing a product. You can view the 

routing of an item that has been manufactured in-house by opening the routing's BOR (see 

"BORs" page 461) in Design and selecting the Routing option button in the Display section of the 

form in BOR view in the BOR header. 
 

Lots 

A lot comprises a number of similar individual parts that are manufactured together in a production 

order. A lot is characterized by the unique assignment of setup time to operation and work center. 

The number of parts that is processed as a lot is known as the lot size. 

The lot size is entered in the Lot size section of the item master on the Planning tab. 

The lot creation criteria specified in this section of the form perform the following function. 
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 They are specified for Planning if the Create lots breakdown parameter is specifically enabled. 

 You can initiate lot creation manually in the item account. You can go to the item account from 

Planning and Manufacturing. 

 They form the basis for the lot size calculation when the Andler method is used. 

 
 

Machine efficiency 

The term machine efficiency describes the ratio of actual performance to normal performance 

(performance based on empirical values). 

You will find machine efficiency as a field in various BOR forms. You can make a manual entry 

there. The effects of this entry depend on the record type. 

 

Machine efficiency in the order header 

Enter the settings for the Machine efficiency field on the Scheduling tab in the Order header view 

in the production order. 

Please note: The setting you enter here has the same effect for operations and materials – it 

causes an increase or decrease in the manufacturing quantity. For operations, the total time is 

also increased accordingly based on the formula Total time = RTi * quantity + STi. 

The following example illustrates this. The table below contains an order with no machine 

efficiency: 

SVO Qty TT Eff.  RTi STi 

HR 200 0 0 1 0 

OP 200 1001 0 5 1 

MA 200 0 0 1 0 

 

If you enter a machine efficiency of 20%, the order appears as in the following table when the 

quantity/duration calculation is performed again. 
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SVO Qty TT Eff. RTi STi 

HR 200 0 20 1 0 

OP 240 1201 0 5 1 

MA 240 0 0 1 0 

To be able to enter a quantity of 200 units, a quantity of 240 units must be manufactured, because 

40 reject units are expected, for example. 

Please note that these 40 units are not entered, they are "lost". 

 

Operations 

For operations, the machine efficiency includes an adjustment of the total duration if the machine 

requires more or less than 100% of the time for this resource. 

The total time (TT) is included in cost accounting, capacity planning, and scheduling. 

It is calculated according to the following formula: 

 

Example: 

The machine operates 10% faster than assumed in the standard time. 

 

SVO Qty STi RTi Eff. 

HR 200    

OP  50,00 5,75 -10 

The total time is then calculated as follows: 

 

 

 

Material 
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For materials, the machine efficiency includes an adjustment to the required material quantity (in 

other words, not the order quantity), if rejects are expected for example. 

Important: The material quantity is increased or decreased so that the order quantity to be 

manufactured is actually achieved. Therefore a quantity of material adjusted by the machine 

efficiency is used. This means that the machine efficiency is positive if, for example, more material 

than normal is used in a manufacturing process. A larger/smaller order quantity is not 

manufactured, so in principle the change in material usage has no effect on the order quantity. 

Please note therefore that the transaction quantity is reduced by the machine efficiency when the 

manufactured quantity is subsequently entered. 

The quantity is calculated according to the following formula: 

 

Example: 

10% more material is required to account for rejects: 

RT Quantity Eff. 

HR 200  

O 200  

S 200 10 

The total quantity is then calculated as follows: 

 

 

The following applies in both cases, i.e. for both time and material adjustments: 

 If the machine efficiency is a positive value, more time or material is required. 

 If the machine efficiency is a negative value, less time or material is required. 
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Milestones 

Milestones (page 430) are order lines which when entered in the SFDC system trigger not only the 

entry of the milestone but also the entry of what are know as dependent lines. Dependent lines are 

lines that are automatically entered when a milestone is entered. 

You use milestones when entering transactions for production orders. For information on the 

options afforded to you by working with milestones, see SFDC transactions and milestones.  

Sample applications of milestones are available in More efficient transactions using milestones. 

The following basically applies: To be able to work with milestones, you must set them. Among 

other places, you can enter Milestones (MS) and Milestone groups (MSG) on the Print/post tab of 

the production order. Another way of setting milestones is described in the Help on the Order data 

tab. 
 

Milestone flags 

The following list provides an overview of the six possible milestone flags. 
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0 Always enter transaction 

 These lines are released and confirmed individually. They do not belong to a milestone group. Therefore, 

there are also no dependent lines.  

1 Milestone 

 This flag indicates a milestone. This means that a transaction for a line with Milestone flag 1 also 

triggers a transaction for the dependent lines that you specified using Milestone flags 2 to 5. When 

entering a transaction, all lines dependent on this milestone are therefore also entered. Dependent 

lines are lines with a milestone flag greater than 1 and in which the same figure is entered as for the 

milestone in the MSG (milestone group) field. 

2 Dependent line 

 All lines flagged with Milestone flag 2 are considered to be dependent lines for a milestone. For header 

lines (a header record in the production order designates the finished product manufactured by that order), 

a partial actual transaction is made for an end transaction of the milestone. See also SFDC transactions 

and milestones. For the other record types (operations and material lines), the relevant target values are 

entered when the first transaction is entered against the milestone. 

Note: The functions of Milestone flag 2 are provided in a more practical sense by flags 3 to 5. This flag is 

still only supported for the purposes of compatibility. Therefore, please use milestone flags 3 to 5 where 

possible. 

3 Dependent line (enter with start transaction) 

 You can use this milestone flag to specify that the dependent record is entered in shop floor data collection 

with target values in the start transaction of the milestone. 

4 Dependent line (enter at end) 

 You can use this milestone flag to specify that the dependent record is entered in shop floor data collection 

with partial actual values in the end transaction of the milestone. 

5 Dependent line (enter each transaction) 

 You can use this milestone flag to specify that the dependent record is entered in the same way with partial 

values for each transaction of the milestone in question. 
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Milestone groups 

Lines that belong together form a Milestone group. Enter the same ID for the milestone and all 

corresponding dependent lines. 

 

Example 1: 

There are two milestone groups in this example: 

Line 5 is an operation record with three dependent lines, line 20 is an operation with two 

dependent lines. 

RT LINE MS MSG  

O 1 0 0 Independent line that is entered separately 

O 5 1 1 Milestone 1 

O 10 2 1 Dependent on line 5 

O 15 2 1 Dependent on line 5 

S 19 3 1 Dependent on line 5, MA issue at start transaction 

O 20 1 2 Milestone 2 

O 22 2 2 Dependent on line 20 

S 28 3 2 Dependent on line 20, MA issue at start transaction 

 

 

Example 2: 

The milestone groups do not have to be sorted in the table, in other words they do not have be 

placed in chronological order. See the following example. 
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RT LINE MS MSG  

O 1 0 0 Independent line that is entered separately 

O 5 1 2 Milestone in group 2 

O 10 2 1 Dependent on line 22 

O 15 2 1 Dependent on line 22 

S 19 3 1 Dependent on line 5, MA issue at start transaction 

O 20 2 2 Dependent on line 5 

O 22 1 1 Milestone in group 1 

S 28 3 1 Dependent on line 22, MA issue at start transaction 

 
 

Bill of materials 

The BOM contains all components (individual parts and assemblies) required for manufacturing a 

product. You can view the BOM of an item that has been manufactured in-house by opening the 

its BOR (see "BORs" page 461) in Design and selecting the BOM option button in the Display 

section of the form in the BOR view in the BOR header. 
 

Replenishment time 

In the resource master (in the item, for example), enter the duration required to replenish the item 

in the RPLT (Replenishment time) field on the Planning tab. You can specify the duration in the 

time unit of Calendar days, Workdays or Weeks. If more than one supplier exists for this item, set 

a standard time tha Planning can use as the replenishment time. 

The replenishment time of an item is required for the following purposes. 

 It is used by Sales to calculate the delivery date and to check availability. 

 It is used when scheduling orders (order breakdown in Planning). 

 It is used by Planning in minimum inventory monitoring. 
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Purchased items: For purchased items, the replenishment time corresponds to the delivery time of 

the supplier, taking into account the delivery time unit entered in the supplier data. 

If there are multiple suppliers for this item, set a default period for the replenishment time that 

Planning can assume. 

In-house items: For in-house items, the replenishment time is calculated from the lead time using 

the structure of the item to be manufactured and the manufacturing quantity minus the 

replenishment time saved due to any advance stocking of incoming purchased items or 

assemblies. 

The setup times and runtimes (BOR) must be considered. Currently, this time is not calculated 

automatically, and must be entered manually. 
 

Fixed requirement allocation (FRA) 

Fixed requirement allocation (FRA) is an item property (Planning tab) that is used to indicate the 

manufacture of an item that is based on a sales order. FRA items are generally manufactured to 

order, that is, a sales order sets the manufacturing process in motion. Where an FRA item is 

requested by an order, the sub-orders (purchase orders or production orders) created to fulfill the 

order are permanently linked to the triggering order. The sub-orders are assigned the ID of the 

sales order along with a three-digit consecutive number. 

Further information on this is available in Fixed and dynamic requirement allocation. 

Properties and features of fixed requirement allocation: 

 The fixed requirement allocation of resources is used primarily in sales order and 

manufacturing product configuration in which items must be strictly manufactured/ordered and 

tracked on a job-specific basis. 

 The sub-orders are assigned the ID of the order creating the requirement, plus a sequential 

three-digit ID (for example SO1002-001, SO1002-002, etc.). 

 The quantities of sub-orders generated can be accessed from another area as long as the 

assignment was not explicitly deleted in Planning. 

 Existing assignments can be separated and/or new assignments created in the item account. 

For further details, see Change fixed requirement allocation. 
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Resources 

All factors of production involved in the provision of the business service are designated as 

resources. 

The resources form the basis for the data in the system. They are entered at different points in 

Infor COM. 

Resources include: 

 Items (finished products, purchased items, merchandise) and BORs for products 

manufactured in-house 

 Capacities (machines, work centers) 

 Tools 

 Data on business partners (customers, suppliers, etc.) 

A resource is identified uniquely in the system using its resource ID and record type. 

The record type determines the type of resource (item, machine, supplier). For the Item resource, 

the item type is also determined by its use. 

The resource ID is used as a unique identifier for the data records in the system. 

Note: Creating standard records can make it easier to enter data. Data stored in the standard 

record is set by default for every new resource created and can be changed as needed. To 

change the data, use COMMONSTD. 
 

View resource where-used lists 

The Where-used list function is called from a resource master using the Functions menu and the 

Where-used list command. 

The where-used list is available for the following resources: 

 Item: All BORs to which the item has been added are listed. 

 Work centers: All BORs to which the work center has been added are listed. 

 Operations: All BORs to which the operation has been added are listed. 

 Tools: All BORs to which the tool has been added are listed. 

 Suppliers: All items that this supplier provides and that are entered in a BOR are listed. 
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You can use the level depth to select the depth of the breakdown structure of the BOR. The result 

is that sections from the structure BORs relating to the selected item are displayed. The maximum 

level depth is 16. 

 

 

Sample item: 

The table shows an extract from the where-used-list for item 602-0012. 

Str. Line BOR Item 

1 9 965-1390 965-1390 

2 10 965-1100 965-1500 

2 10 965-1100 965-1100 

2 10 965-1100 965-1200 

2 10 965-1100 965-1300 

1 8 965-2132 965-2132 

1 9 965-2136 965-2136 

1 6 978-3893 978-3893 

2 3 978-3892 978-3892 

The fields can be interpreted as follows: 

 Str. field, level 1: Item 602-0012 (record type MA) is used in the BOR of item 965-1390 on the 

first level. 

 Str. field, level 2: Item 965-1390 is included in BOR 965-1100. As item 602-0012  is part of 

the BOR for item 965-1390, it is therefore used in the BOR of item 965-1100 on the second 

level. 

 

 

Sample work center group: 

The following table shows the where-used list for work center group 1200. 
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Str. Line BOR Item 

1 2 965-1320 965-1320 

2 12 965-1100 965-1500 

2 12 965-1100 965-1100 

2 12 965-1100 965-1200 

2 12 965-1100 965-1300 

 

The fields can be interpreted as follows: 

 Field Str., Level 1:  Work center group 1200 is used on the first level of the BOR for the item 

965-1320. 

 Field Str ., Level 2:  The item 965-1320 is used in the BOR 965-1100. It is also used in the 

BOR for item 965-1500, for example. Based on the BOR for item 965-1320, this work center 

group is used on the second level of BOR  965-1100. 
 

Define inspection flag for resources 

Inspection planning determines inspection requirements for resources (page 435), establishes 

inspection targets, and plans their implementation. Inspection conditions and methods to be used 

for the inspection are also outlined in the inspection plan. Details are specified in relation to the 

possible use of an inspection plan in Design for items on the UOM/size management tab in the 

Inspection flags form section. 

You can enter the settings for inspection planning in the COMMON.QUALITAETSSICHERUNG 

section in the configuration. 
 

Size and residual size management 

Size management 

When you select the Size management option, the length, width, and height dimensions of an item 

are stored in its batch-tracked inventory and used as properties for splitting batch-tracked 

inventory (see "Item properties for splitting batch-tracked inventory" page 1048). 
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To activate the Size management function, select the Size management check box on the 

Inventory flags tab in the master data for the item. If you select this option, the system will always 

expect you to enter the unit of length. You enter this value on the Size management section of the 

UOM/size management tab in the master data for the item. 

All other Size management data is entered on this tab also: The three Length, Width, and Height 

dimensions, the Size management formula used for calculating the Size management result as 

well as the quantity conversion factor(s), if applicable. 

For more information, see the Help topic for the Size management form section. 

The dimensions are preset on special tabs (the Size management tab, for example) in purchase 

orders, sales orders, and production orders, where you can modify them if necessary. You can 

specify the number of items required in these dimensions. The system then uses the Size 

management formula and possibly a quantity conversion factor to automatically calculate the 

resulting purchase order or sales order quantity. 

Note: You can also store length, width, and height dimensions, formulas, and one or more 

quantity conversion factors for items for which the Size management function is not selected. 

Taking into account the required number of items, the system uses this data in purchase orders 

and sales orders to calculate the purchase order or order quantity. However, the batch-tracked 

inventory is stored without the dimension values. 

 

Residual size mgt 

To select the Residual size mgt function, you need to select both the Size management check box 

and the Residual size mgt check box on the Inventory flags tab in the master data for the item 

(Design > Items). 

Note: If you select the Residual size mgt function, you cannot select serialized ID management 

and the automatic generation of dummy inventory. 

If you do select this option, the system will always expect you to specify the unit of length and the 

size management formula before the item can be saved. If the inventory unit of measure differs 

from the Size management unit of measure, you will also have to specify a quantity conversion 

factor. All of this data is entered on the UOM/size management tab in the master data for the item. 
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If the Residual size mgt function is selected, as is the case when the Size management function is 

selected on its own, the Size management data is also preset from the item master in purchase 

orders, sales orders, and production orders where it can be used to calculate the purchase order 

or order quantity. 

The Residual size mgt function also provides the following option: If there is no batch-tracked 

inventory available in the required size for inventory issues for sales orders or purchase orders, 

you can use the Sales issue or Inventory transactions objects to split the batch-tracked inventory 

into the required length from batch-tracked inventory available in larger sizes. You do this by 

means of manual batch-tracked inventory specifications. The Residual size mgt function stores 

any remaining residual sizes as new batch-tracked inventory. 

The following requirements must be met here: 

 The item must not be managed in units of measurement such as packages, cartons, bags, 

units, etc.  

 As the availability of suitable batch-tracked inventory is always checked automatically when 

advance shipping notices are printed in Sales, you must select the Pick list option when 

specifying the issue document in sales orders (Sales > Sales orders). 

Note: As an alternative to entering manual batch-tracked inventory specifications, you can use 

the Inventory adjustment object (Inventory > Special functions) to manually split the batch-tracked 

inventory into the required number and length before carrying out the posting, that is, the issue. 

This method also allows you to split the batch-tracked inventory of items that are managed in the 

warehouse in units of measurement. For an overview of how this is done, see Split batch-tracked 

inventory for Residual size management items (page 1190). 

 
 

Integrate drawing in resources 

To add a drawing to an item, proceed as follows - the following description assumes that the 

drawing to be integrated already exists as a file. 

1. Open the item for which the drawing should be stored and go to the Drawing tab in the opened 

item using the View menu. Then click the white area on the right of the tab. 

2. In the Edit menu, select the Insert object command and select the Create from File option 

button. 
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3. Click Browse and, in the dialog box that is displayed, go to the directory that contains the 

drawing file to be integrated. Double-click the name of the file to copy the path and file. 

Note: If you have not created a separate folder for graphic files, you can use the Infor COM 

sysinfo\BMP subfolder to store pictures. 

4. Select the Link check box if you only want to store the location of the source file and display 

the linked file. In this case, the file is updated when the source file is edited. Double-click the 

icon on the Drawing tab to start the application to edit the file.  

Selecting/deselecting the Link check box displays Help text in the Result form section and this 

describes the selected option. 

If the check box remains deselected, the file is embedded. Changes to the source file are not 

subsequently updated in Infor COM. 

Please note: In any case, select the Display As icon check box if you select the Link 

check box, as otherwise a preview of the object that may be a multiple of the size of the 

linked object is generated and stored in the database. 

5. The drawing is displayed in the Drawing field. To edit the drawing, start the application linked 

to the file by double-clicking the drawing. 
 

Define document printing in resources 

The following documents can be printed for items in Design and Manufacturing (in the production 

order). The documents are sorted below by the record types with which they are stored. 
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Stored in the HR line 

Receipt document/R  

The material receipt document  is the document for the inventory receipt 

transaction. It is entered in the HR line. 

Manufunfacturing traveler/T  

The manufacturing traveler contains a description of all operations in the 

order. It must be entered in the HR line. 

Kit list/K  

The kit list contains a description of all materials in the order. It is entered in the 

HR line. 

Assembly operation/A  

The assembly operation list contains a description of all operations 

belonging to an assembly. This list must be entered in the AS line or the HR 

line (this is then output with all AS and all OP lines). 

Assembly material/M  

The assembly kit list contains a description of all materials belonging to an 

assembly. This list must be entered either in the AS line or the HR line. In the 

latter case, it is output with all AS and MA lines. 

Stored in the MA line 

Material sheet/S  

The material sheet contains the description of the material. It is 

entered in the MA line. 

Other 

Shop floor document/D  

The shop floor document contains the description of the operation. It is 

entered in the OP line. 

Labels/L  

Labels can be printed for every item. They can be entered in the HR line 

(goods receipt label) or in the MA line (goods issue label). 

Customer document 1-3  

To facilitate customizations, three areas have been provided for user-specific 
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documents. These documents are not integrated by default - any entries you 

make will have no effect. If you want to use a document, it must be defined in the 

report generator. In addition, a customization must be implemented to control 

document printing. 

 
 

Enter buffer times for resources 

Enter buffer time settings in different resources (page 435). This Help topic describes how you 

enter them in the work center (see "Work centers" page 481) for example. 

1. Click Work center in Design. 

2. Select the work center to be opened on the Open tab and confirm by clicking Load. 

3. On the Planning tab, enter an average value for Order buffer time, Machine buffer time, 

WaitPer and Transp. time. 

The values stored are taken into consideration when scheduling in Planning and when scheduling 

manually in Manufacturing. 

Please note: The buffer times do not extend the processing time, they are represented as gaps 

between operations. You can also store transition times between any machines you specify in the 

UEZEITEN allocation table. 
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Make-or-buy 

Description 

When it comes to make-or-buy decisions, it is a question of deciding whether certain items should 

be manufactured in-house or procured from suppliers. 

There should be an option to procure items that are regularly manufactured in-house from an 

external source, and vice versa. 

The objective of make-or-buy decisions is often to optimize the value chain for a product. 

In Infor COM make-or-buy decisions are made using rough planning. 

In Infor COM, use the Make-or-buy check box to flag items affected by make-or-buy decisions. 

You can either do this when creating the item or on the Planning tab in the item master. 
 

Assign BOR 

To assign a BOR to a make-or-buy item: 

1. Open the required item in Design and Items. 

2. Select Functions > Make-or-buy > Assign BOR in the item that you opened. 

You can use this dialog box to assign any number of BORs to an item. BORs must have been 

entered in the master data first, however. 

3. Optional: Select Functions > Make-or-buy > Go to BOR to go to the assigned BOR. 

4. Select the BOR that you want to assign and confirm it by clicking OK. 
 

Load orders with a procurement type that can be changed 

To load orders with a procurement type that can be changed: 

1. In Planning, select the Exceptions object. 
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2. Select the Make-or-buy option in the dialog box that appears in the IDs section and click OK. 

Note: When you select this option, only rough planned orders, detailed purchase orders with 

the status Printed and detailed production orders with the status Released will be loaded. 

Go to the order to further process the orders that have been loaded. 
 

Change procurement type 

To change the procurement type: 

1. In Planning select Rough planned orders and on the Functions menu select Change 

procurement type. 

Note: Rough planned orders can be edited until their status is Released. For POs, the status 

must be Printed. 

2. Select the procurement type and enter the required quantity for the specific procurement type. 

3. From the list, select the required BOR and confirm by clicking OK. 

Note: The newly generated procurement orders are either purchase orders (status: Created) 

or production orders (status: Scheduled). 

4. If required, check the receipts from Purchasing or Manufacturing in the item account. 
 

Make-or-buy in Value flow 

The following special conditions apply to make-or-buy items in Value flow. 

 

 For value flow model 3 and Purchasing as the main usage, the purchase price is used for the 

valuation of purchase orders, otherwise the manufacturing costs from the Alternative costs for 

MoB tab are used in production orders. 

 For value flow model 3 and In-house manufacturing as the main usage, the standard cost is 

used for valuation of the purchase order and in the production order. 
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Change status management 

 

In addition to the status you can activate a quarantine flag to lock the relevant change status, 

regardless of its status, for inventory issues and releases for production orders.The Change status 

function allows you to manage the changes that are made to items during their life cycle. You can 

use this function to ensure that only items with released change statuses are sold, manufactured 

or integrated into components. The change statuses provide a history of the changes to an item. It 

is not obligatory for an item to have a change status but it can have any number of change 

statuses. 

Change statuses are classified and evaluated using an assigned status. Change status 

management must be configured – see Configuration (Change status). The Change status 

function described here requires the COMMON.CHANGESTATUS.OPERATIONMODE 

parameter to be set to 1. The former Valid from field is no longer available in the new Change 

status function. 

To create a change status, go to the change status management by selecting Go to > Change 

status in an item and then define a first change status there. 

Note: Before using the Go to function, it may be necessary to select the Change status inventory 

split flag on the Inventory flags tab of the item. 

Change statuses for an item are classified and evaluated using an assigned status. When a 

change status is created, In progress is set as the default status. 

The following statuses are possible. Please note that the status information is non-binding and the 

statuses can be handled differently for different companies. 
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Status Explanation 

In progress This status includes items that are neither in the planning phase nor in design. 

An issue is possible only if the relevant change status is explicitly requested. 

This status can occur several times per item. 

Pre-serialized This status includes prototypes that do not yet have a release for the series. 

This status can occur several times per item. 

Serialized This status indicates release for series manufacturing. 

An item can only be assigned this status once. 

Note: When a change status switches to Serialized, a previously existing 

change status of Serialized is set to Expiration. 

Expiration This status indicates discontinued items. 

This status can occur several times per item. 

End of life This status indicates products that have reached the end of their life cycle. It is 

only possible to switch to this status if there is no inventory for the change 

status and relevant movement data no longer exists. 

This status can occur several times per item. 

 

In addition to the status you can activate a quarantine flag to lock the relevant change status, 

regardless of its status, for inventory issues and releases for production orders. 
 

Determine change status 

If multiple change statuses (see "Change status management" page 445) exist for an item, you 

need to determine the current change status. 

The change status is determined from the following sequence: 

1. Serialized 
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2. Expiration 

3. Pre-serialized 

4. In progress 

5. End of life 

Example: If a Serialized change status exists, this is the change status. If it does not exist , the 

Expiration change status (if present) is the current change status, and so on. 

 

If there are multiple change statuses for one status, you need to define the current change status 

within the current status. 

Note: If the system is able to determine this status itself, the check box is predefined and cannot 

be edited. 

 
 

Change the change status 

There can be two reasons for making a change in the change status management: 

 A different or a new change status becomes the current change status (according to the 

Current check box) or the change status ID changes. The status of the current change status 

therefore changes in certain circumstances. 

 The status of a change status changes. 

The following table shows which status transitions are permitted. 
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 New status 

Current status Undefined In progress Pre-serializ

ed 

Serialized Expiration End of life 

Undefined Yes, during 

creation when 

change status is 

unknown, during 

goods receipt 

yes yes yes yes yes * 

In progress no no yes no yes yes * 

Pre-serialized no yes no no yes yes * 

Serialized no no no no yes yes * 

Expiration no no no no no yes * 

End of life no no no no no no 

 

 

For each change, the Planning type and Receipt generation parameters of the - possibly new - 

change status, as well as the associated BOR ID in the case of in-house manufacturing items, are 

written to the item master. 

If the status changes to In progress, the Do not plan planning type is assigned in the item master. 
 

Change statuses in the modules 

The following topics show how the change status management has an effect on the individual 

modules. 
 

Change status in the BOR 

As soon as an additional change status is defined, a copy of the current BOR is automatically 

generated and its ID is entered in the change status management. 

The BOR is then manually edited. 
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Use the COMMON.CHANGESTATUS.BORINSERTCURRCHANGESTATUS parameter to set 

whether the current change status ID is to be written to the MA records of the BOR when creating 

the BOR. If this is prevented, you can process the material according to the FIFO principle: 

Expiration change statuses, for example, can therefore be used up even though a new Serialized 

status was already defined. 

Manual editing of the change status information in the MA records of the BOR is not permitted. 

The BOR is structured as follows: <Item ID><BORNoSeparator><Change status ID>. The 

<BORNoSeparator> is defined using the COMMON.CHANGESTATUS.BORNOSEPARATOR 

configuration parameter. 

 
 

Change status in Sales 

When you generate load lists in Sales, the change status is transferred from the order release into 

the load list line. The ship date of the load list is then used to run a check in the change status 

history as to whether the change status is still valid. If not, the valid change status that is 

determined is transferred to the load list. The change status is transferred to inventory during 

inventory release. If there is not enough inventory available for this change status, the actual 

quantity is automatically reduced to the quantity that can be delivered. 

You can only create sales orders for items with the Pre-serialized, Serialized and Expiration 

change statuses. 
 

Change status in Manufacturing 

Planning is used to create production orders based on the planning parameters that were 

populated when the sales order was planned. When you create an order manually, you can select 

the required change status from the combo box. 

Note: If no change status are stored for the MA records in the production order, Planning uses the 

FIFO principle. If change statuses have been specified, precisely these statuses are requested. 

When a production order is released, the status of the header and line change statuses is checked 

since they could have been changed in the meantime. The order is released only if the status is 

valid. 
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Rule: Serialized parts can only be manufactured with serialized and discontinued items. 

Pre-serialized parts may also be manufactured with pre-serialized parts. 
 

Change status in Purchasing 

Planning can create purchase orders for the required change status. You can manually enter a 

permitted change status. 

In order release management in Purchasing, the valid change status for the PO date for the order 

release line is determined from the change status history and is displayed. The change status 

cannot be edited here and is used only for the planned/actual comparison. 

In Goods receipt, the change status from the order release is set as the default and you can 

compare it with the change status of the goods. 
 

Change status in Inventory 

If the status of a change status is converted from a released status to a quarantined status (Not 

defined, End of life), this must be unlocked in the individual inventory records. 
 

Change status in Planning 

Items that participate in change status management cannot have the Minimum inventory planning 

type. 

If a change status is stored in a sales order or production order, the availability check determines 

the inventory for the change status. 
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Call 

Design > Items 

Description 

Items are resources (page 435) that you can create in Purchasing, Sales, Design, and 

Manufacturing. 

In Infor COM, you can manage all the materials required for your operating processes together 

with specific data relating to these materials. Materials may include sales items, spare parts, 

merchandise, assemblies, raw materials, individual items, purchased items, or hazardous 

materials as well as any waste material generated. 

Item master data is created or managed based on the following information:  

 Product range (standard products or make-to-order products) 

 Manuf. type (make-to-inventory manufacturing or make-to-order manufacturing) 

 Manuf. mode (mass manufacturing, high-volume manufacturing, limited-lot manufacturing, or 

make-to-order manufacturing) 

 

You can access the following information at any time in the item master data. 

 Item name 

 Planning data 

 Inventory details and locations 

 Cost records 

 Suppliers 

 Purchase/sales prices 

 Quantity conversion factors 

 Size management data 

 Drawings 

 Autotexts as additional information or for document output 

Functions 

Where-used list (see "View resource where-used lists" page 435) 

Item 
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Replace master data in BORs (page 467) 

Export 
 

Create item 

Save your entire product range in the item master. The stored data is used for price calculation, 

order generation, and planning, for example. 

When saving item master data, see also Update user resources (page 475). 

In Infor COM, you have several alternatives to choose from when creating items.  

 Sales items: See Create sales item 

 Purchasing > Master data > Purchased items 

A BOR containing an ES record is automatically created when you create a purchased item. 

 Manufactured items: See Create manufactured item 

 One-off items: See Create one-off item (page 455) 

 Use the Master data folder in Purchasing to create subcontracted activities. 

 Shipping materials: See Create shipping material (ms-its:sales.chm::/473.htm) 

 Set items: See Create set item 

Note on default settings in accounts: When you create new items, the account categories are 

automatically filled using the templates from COMMONSTD. You can use the COMMONSTD 

section in the configuration to control which account categories are to be filled (0 - Domestic, 1 - 

EU, 2 - International). 
 

Maintain item data 

The following tasks must be performed to maintain item data. 

ms-its:sales.chm::/473.htm
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Maintain 

autotexts 

You can store autotexts in the Additional texts form section on the 

Purchasing and Sales tabs in the item, for example. 

Define size 

management 

You can access size management for the items on the UOM/size 

management tab. See also the Help topics relating to Control resource size 

management. 

Store external  

i tem ID 

When you enter a line in an order, for example, external item IDs allow you 

to enter a customer's external ID instead of your item ID, thus making it 

easier for the customer to process the order. Save the external item ID on 

the External item/representative tab in the external item table. 

Store 

foreign-language 

texts 

For deliveries to foreign countries, store foreign-language names for item 

data on the Foreign-language texts tab in the item master. 

Convert  units of 

measure 

Set the requirements for converting units of measure on the UOM/size 

management tab in the item master of the section entitled Quantity 

conversion factors. For more information, refer also to the LVME, MEBASIS, 

and MEUMRECH allocation tables. 

 
 

Store purchase prices 

To store prices for purchased items, use Purchasing > Master data > Purchased items > Purchase 

prices. 

All item data that you want included in the price calculation should already be entered in master 

data management when you enter the items. These items are then set by default in Purchasing 

each time an item is selected. A BOR and a price table are also created automatically for the item. 

The stored data affects the following price-related information: 

 Purchase prices 

 Prices for subcontracted activities 

 Item-specific discounts (for example, standard quantity discounts) 
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 Item group-specific discounts 

 Supplier-specific prices or discounts 

All prices and discounts entered are saved in the price table (see the Prices and discounts in 

Purchasing Help topic). 

Select the Go to menu and the Price table command to perform inspections, corrections, and price 

changes at any time. 
 

Store sales prices 

To store sales prices: 

1. Select Design > Items, enter the item data for the required sales item on the Open tab and 

click Load. 

2. Click the Sales prices tab and store the relevant prices there. See Prices and discounts in 

Sales for more detailed information. 

Note: The item data that you enter here will be used as the default data every time that you 

select the item in Sales and will be used to calculate prices. 

The data entered affects the following price-related information: 

 Sales prices 

 Item-specific discounts (for example, standard quantity discounts) 

 Item group-specific discounts 

 Customer-specific prices or discounts 

 Customer group-specific prices or discounts 

3. Select Go to > Price table to go to the price table and make any necessary adjustments there. 

 
 

Enter cost records 

You have two options when it comes to storing cost records for an item. Calculate the cost records 

using Functions and Cost rollup (for in-house items) or enter the cost records manually. 

To manually enter cost records for an item, complete the following steps: 
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1. In Design, open an item and select the Costs tab. 

2. Enter cost records for the following cost types: Material, Wages, Machines, Setup, Fixed PrC, 

and Other fxd. Specify the reference quantity (per field) and reference unit for each cost 

record. 

3. Specify the quantity of the item to be costed in future by entering a value in the Lot (proposal) 

field. 

To enter this value, first select theFixed lot size entry in the combo box in the field on the right. 

Related options: 

 Select Min. planning from the combo box to the right of Lot (proposal) to use the smaller 

value from the Quantity field on the Planning tab of the item master data. 

 Select Max. planning from the list box to the right of Lot (proposal) to use the greater value 

from the Quantity field on the Planning tab of the item master data. 
 

Create one-off item 

In orders and purchase orders, you can also enter lines with items that were not yet entered in the 

master data at the time you created the order. 

There are two options: 

 Items that you want to update in the item mater later: The difference between these items and 

standard items is that is that one-off items in your master data are flagged using a check box. 

As a result, you can select such one-off items in the item master at any time, either to delete 

them or convert them to standard line items. You can handle one-off items in the same way as 

standard items. 

 Items that you want to manage in the order without master data: For these items you must 

decide whether to include them in the item master at the time you create the invoice. Create 

the item masters when you want the item in the sales order to be invoiced. In doing so, you 

can specify in turn whether to define the items as one-off items or as standard items. You must 

not create any item masters for items that you no longer include in the sales order or that you 

may want to offer free of charge. 

See Enter one-off item in Sales order for more information on this topic. 

To enter one-off items in the item master: 

1. Select Design > Items > New. 

2. Click the required usage flags in the Usage form section and click the One-off items usage 

flag. 
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3. Click Create. 

You can now store the required data for the item in the same way as a standard line item. 
 

Use replacement items 

In the item master you can enter alternative materials on the Replacement items tab provided 

COMMON.STAMMDATEN.SPAREPARTSNOTEBOOK is set to yes. 

When the availability is checked in Manufacturing, Sales and Purchasing, you can select one of 

these alternative items if an item is not available. 

PO 

If the availability check for materials provided detects that a material provided is not available and 

alternative materials are stored in the item master, select Functions > Select replacement item to 

select an alternative material. 

Once you select an alternative material, a new material provided line with the same quantity as the 

original line will be created for the alternative material. The original line is retained as a TX record. 

Production order 

If the availability check detects that a material is not available and alternative materials are stored 

in the item master, select Functions > Select replacement item to select an alternative material. 

Once you select an alternative material, a new material line with the same quantity as the original 

line will be created for the alternative material. The original line is retained as a TX record. 

Sales order 

If the availability check detects that a material is not available and alternative materials are stored 

in the item master, select Functions > Select replacement item to select an alternative material. 

Once you select an alternative material, a new material line with the same quantity as the original 

line will be created for the alternative material. The original line is retained as a TX record. 
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Create intermediate products 

Intermediate products are items that are generated during the manufacturing process but are 

neither raw materials or end products. They are always in-house manufacturing items, but do not 

require a separate BOR. Intermediary products are ignored completely by the Costing and Value 

flow functions. You do not need to enter costs for intermediate products or carry out cost rollup. 

They are ignored by Planning. 

The IH record type is provided for posting intermediate products from manufacturing to the 

warehouse, and the IP record type is used for posting intermediate products from the warehouse 

to manufacturing. When using the IH or IP record types, only those items whose Intermediate 

product check box is activated will be available for selection. 

This means that after each step in the manufacturing process (in-house and subcontracted 

manufacturing), the resulting intermediate product can be posted in and out of inventory (for 

quality inspection, for example). 

Please note: Although the record types are optional, they must always be used in pairs. 

Inventory transactions for subcontracted manufacturing receipts can also be created for 

intermediate products. This allows the products to be posted from subcontracted manufacturing to 

the inspection warehouse. 

1. Select Design > Items > New. 

2. On the New tab, enter the required data and select the In-hse manuf. and Intermediary product 

check boxes in the Usage section. 

3. Enter the required data for the item. 

4. Select Data >Save. 
 

Store default coordinates for item 

This Help topic describes how you can store default receipt coordinates and default issue 

coordinates for an item. These coordinates play an important role in inventory strategies. 
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1. Select Design > Items, enter the Pur. item and Sales item usage on the Open tab and select 

the item ID for the required item in the Item field. 

2. Click the Default coordinates and enter the Default issue coordinates and default receipt 

coordinates. 

Note: You can only populate the inventory area or enter only individual coordinates. See the 

context-sensitive Help for further assistance on entering accurate values. 

3. Use the required Coordinate specification precision. 
 

Quantity conversion 

When you create or modify item master data, the system checks how feasible it is to convert the 

units of measure to one another if they differ. Such units of measure would include Receipt UOM, 

Issue UOM, Inventory UOM, Result for size management UOM, Lot size UOM, Minimum inventory 

UOM, Valuation price UOM, and Cost UOM. 

If the system discovers that certain units of measure cannot be converted to each other, a 

message to this effect will be displayed, requesting you to define the relevant conversion factors. 

The message will list the units of measure that cannot be converted to one another. 

The conversion factors are stored in the item master data (Design > Items) on the UOM/size 

management tab in the Quantity conversion factors form section. 

Examples:  

 For example, if a resource is ordered in kilograms but planned in the order in meters, a kg/m 

conversion factor must be applied. 

 If you plan the material in an operation in a UOM other than the one used for the finished 

product, a conversion factor must be created in the master data of the finished product. The 

conversion is performed by scheduling the order and selecting the Calculate quantity and 

duration check box in the Schedule dialog box. All quantities in the order are converted from 

the UOM of the finished product to the UOM specified in the operation. 
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When the dimensions and formulas for size managed and residual size managed items are 

entered (see Size and residual size management (Inventory)), the system itself, if required, will 

define a corresponding conversion factor if the inventory UOM is different to the size management 

UOM. A conversion factor must be defined for items that are subject to residual size management. 

Items that are only size managed, on the other hand, can be saved without a conversion factor. 

Please note, however, that the absence of the factor becomes a problem at the latest when the 

order quantity in orders is to be calculated from the size management number and the dimensions. 
 

Enter change reasons 

When you modify one or several items you can enter a change reasons while saving the modified 

items. 

Prerequisite: The COMMON.STAMMDATEN.ITEMHISTORY configuration parameter must be set 

to yes and COMMON.STAMMDATEN.ITEMHISTORY_CHANGEREASONMODE must be set to 

1. You can use the COMMON.STAMMDATEN.ITEMHISTORY_CHANGEREASONCOND 

parameter to set a condition that controls the entry of change reasons. 

In addition, you need to select Design > Histories > Definite item history to define the fields whose 

changes you want to be logged. 

Proceed as follows to enter change reasons: 

1. In the Design module, select Items and enter the Item ID of the required item in the Item field 

on the Open tab. Alternatively, enter the % wildcard to select multiple items. 

2. Implement the changes to the item master data: 

 If one item is open, implement the changes to this item in the Item view. 

 If several items are open, implement the changes to all items in one go in the Item 

overview view. 

3. Select Data and Save. 

4. Enter the change reason in the dialog box that is displayed: 

 For one changed item: Enter the change reason in the Entry section. 

 For multiple changed items: Enter the change reason in the Entry section. Activate the 

Accept change reason for all changed data records check box to store the change reason 

with all modified items. 

5. Click OK. 
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6. In the Design module, open the Histories folder, select the Display item history object, and 

enter the ID of the modified item in the Resource field on the Open tab. 

7. Activate the Change reason tab to display the entered change reasons. 
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Call 

Design > BORs 

Description 

The BOR records the elements required to manufacture a resource, such as material, assemblies, 

tools, machines, machine groups, employees, and external services. It is the totality of routing and 

bill of materials and is therefore the central object for representing in-house items (see also 

Manufactured items). 

One advantage of the BOR is that it can be used to map product configurations (see 

"Knowledge-based product configuration generation" page 510). 

A BOR contains the following information: 

 Standard bill of materials with the following components: 

 Material  lines: These include the type and quantity of components that make up the item 

that is produced. 

 Assemblies: The BOR can be broken down to the raw material or the assembly. 

 Component item lines 

 Routing which contains the component parts required for manufacturing: 

 Operations (see "Operation catalog" page 478) 

 Standard times for the operations (see Time calculation): Setup times, overlapping for 

follow-up and preliminary operations, and parallel planning are entered in operations. 

These form the basis for scheduling the production order and dispatching it to the capacity 

account. 

 Waste generated during manufacturing 

 

The BOR must be read from bottom to top. 

 The last operation (record type = OP) is at the top; multiple operations are also possible. 

 This is followed by the materials belonging to or required by the last operation (record type = 

MA). 

 The penultimate operation, if there is one, comes next (record type = OP). 

 The material belonging to or required by the penultimate operation (record type = MA) are 

listed next, and so on. 

BORs 
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 There may be other record types in addition to OP and MA lines, for example, the tools used. 

For further information, see Record types (BOR) (page 421). 

Types 

 The BOR for purchased items contains the supplier or suppliers from which the purchased 

item can be obtained together with a series of corresponding details, such as the delivery time. 

For purchased items, the BOR is automatically created when you open the Items object in 

Design or Manufacturing and complete the Purchasing and Purchase prices tabs. 

 The BOR for in-house items must be created manually and contains 

 the standard bill of materials with material, assemblies, tools, and 

 the routing with the necessary operations (see "Operation catalog" page 478) to which the 

required material is assigned directly and the standard times for operations (see Time 

calculation). 

Functions 

The Reconcile BOR (page 475) function allows you to update the standard values for the runtime 

and setup time in BORs based on production order lines entered as finished. This function 

therefore allows virtual planning of production order times. 

To perform the update, specific standard values are required. You can enter these in two ways: 

 By entering predefined values in the configuration. 

 Resource-specific use of the Reconcile BOR tab in the resources. 

The Update weight in master data function transfers the weight from the BOR header to the associated 

master record. 

 

This example shows an extract from the Texts/structure tab in the BOR of in-house item 978-3893. 

Note: To obtain this view, you must select the BOR option in the Display section in the BOR 

header. You can access this check box in BOR view. 
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Str. SVO Resource Short description STi RTi/qty Wrk ctr WkCtrF 

1 OP 8362 Weld parts with robot 50 100,00 8362 Not selected 

1 OP 3080 Rotate items on Gildemeister III 100 15,00 3080 Not selected 

1 OP 2070 Saw items as specified 10 5,00 2071 Activated 

1 OP 2070 Saw items as specified 100 3,00 2072 Activated 

1 MA 602-0012 Round rod 40mm 0 0,36  Not selected 

1 MA 602-0011 Round rod 30mm 0 0,26  Not selected 

 

Starting with the finished product, the routing and required materials are entered in the table. Read 

from the bottom upwards, the BOR contains the components of the manufacturing process for 

resource 978-3893, starting with items 602-0011 (30-mm round bars) and 602-0012 (40-mm 

round bars) using operations 2070 to 8362. 

The last (top) operation, which is required to manufacture item 978-3893, Weld items with robot, 

belongs to the work center group (record type OP) 8362 and has a setup time of 50 industrial 

minutes. A duration of 100 industrial minutes is assigned to the operation. 

Before operation 8362, operation 3080 is performed, and before this, operation 2070. 2070 is 

listed twice as it is performed in two different single work centers, 2071 and 2072, with different 

setup times and working hours. The single work centers are listed in the Wrk ctr column. The 

machines 2070 and 2071 are fixed for the two operations and so cannot be changed over. The 

selected check box WkCtrF indicates this. 

Note: The BOR shown here is created on a single level. The advantage of the single-level modular 

system used here is that a bill of materials and routing of items and assemblies can be recorded 

once and then used in different items. Planning generates a multi-level order structure from the 

single-level structure. You can obtain a preview of this multi-level structure BOR in the BOR by 

selecting Functions and then Structure BOR (see Map structure BOR (page 465)). 

The two materials required for the operations (602-0012 and 602-0011) can be found at the 

bottom of the list. 

Materials required for one or more operations are therefore included in the BOR below the 

operation(s). For the materials in the example, you can view the suppliers by expanding them (see 

the explanation for the Str. field in the Help topic for the Times/quantities tab). See also the 

following table. 
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Str. SVO Resource Short description STi RTi/qty WkCtrF Level 

1 MA 602-0011 Round rod 30mm 0,00 0,26 Not active 1 

 HR 602-0011 Round rod 30mm 0,00 0,00 Not active 0 

 SCO 2700 Simon Industrial Distributors 5,00 0,00 Not active 1 

One of the suppliers of item 602-0011 is Simon Industrial Distributors. 

Enter the operations and the materials required by these operations line by line in the BOR. These 

lines are listed in chronological sequence when the BOR is transferred to a production order.  

For further information, see Generate production order from BOR. 

In practice 

Starting with the finished product, the routing is entered in the table (BOR). The sequence in the 

BOR shows which materials must be available for this operation. This is how the system identifies 

which materials must be available at the start of the operation. See also Create BOR (page 464). 

In Planning, rough or detailed orders in which due dates are assigned to the lines are generated 

from the BOR - see Plan order. 
 

Create BOR 

This Help topic shows you how to create a new BOR in a standard procedure. 

1. Select Design > BOR, enter the required data on the New tab and confirm by clicking Create. 

2. Select the required lines in the Resource column on the Texts/structure tab. 

The following rules apply to work centers or the operation catalog. 

 Group work centers, single work centers, and operations can be selected using the combo 

box or the Go to menu and the Find master data command. 

 In the OP line, the work center group is always used as a resource ID, even if you have 

selected single work centers or operations. You can view selected operations or single 

work centers in the Wrk ctr field on the Texts/structure tab. 

 If a group is entered, all single work centers entered for the group are included in capacity 

planning and the breakdown in production orders. 

 If a single work center is entered, this is used first. In the event of bottlenecks, its 

alternative work centers are considered. 
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 If master data standard times have been entered for the operation, these are set by default 

in the STi (setup time) and RTi/qty (runtime) fields.  

They can be changed for every BOR. 

Please make sure that you start with the last line (usually an operation) and then enter 

each individual operation or each necessary material line in turn up to the first line (usually 

a material line). 

3. Specify the times for the operations and the quantities for the items required for planning or 

scheduling in the production order on the Times/quantities tab. For an example of this tab, see 

BORs (page 461). 

4. You have the option of specifying overlaps of operations already in the BOR on the Scheduling 

modes tab. For example, in the Tr. time or Trans. qty fields enter the duration or a production 

quantity after which the system shifts automatically to the next work center. 

5. Specify the number of manufacturing documents to be printed per line on the Print/post tab. 

Depending on the record type, special documents may have to be specified for printing.  

For the operations, enter the required number of shop floor documents in the D column; for the 

materials, enter the number of material sheets in the S column. The remaining documents are 

generally intended for entry in HR lines, which you can access using the Functions menu and 

the Structure BOR command. 

6. Enter further specifications for managing the order on the NPI/discontinuation control tab. 

On this tab, it is possible to make the generation of orders adhere to specific dates, for 

example. You can also specify that the utilization of different machines be made dependent on 

the order quantity.  

For an example of this tab, see Activate NPI/discontinuation control in BORs (page 473). 

7. Save the BOR. 

Note: See also Save items and BORs (see "Update user resources" page 475). 
 

Map structure BOR 

This topic contains general information on the BOR (see "BORs" page 461). To understand the 

following models, refer specifically to the Example of a BOR section. 

You can map the order structure of a resource (without scheduling) by selecting the Structure 

BOR command from the Functions menu in the Design section in an open BOR. 
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Note: To assign current dates to the structure BOR from the sales order on the Functions menu 

select Plan order. Using the Go to menu and the Order structure command, you can then display 

the structure BOR with assigned dates. 

The structure BOR breaks down the material lines of the BOR to the raw material. 

A dialog box appears. Use it to select the breakdown level. In-house manufactured items that have 

a proprietary BOR can be inserted into the finished product’s BOR up to level 16. 

Example: The following table shows you a section of the Texts/structure tab of the BOR of 

resource 978-3892 with a breakdown to level 3. We have limited the display to the first two 

resources, 1200 and 965-4705. 

The HR line in the first row of the BOR shows the item to be manufactured. In row 3, you can see 

item 965-4705, which is listed again in row 4 to level 2. Rows 5 ff. contain the BOR for item 

965-4705. Items 602-0012 and 601-0009 from this BOR are purchased externally. On level 3, 

these items are therefore listed with the corresponding supplier in the following row. 
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Row SVO Resource Str. BOR 

1  978-3892 1  

2 OP 1200 1 978-3892 

3 MA 965-4705 1 978-3892 

4 HR 965-4705 2  

5 OP 3080 2 965-4705 

6 OP 8362 2 965-4705 

7 AS 990-6000 2 965-4705 

8 OP 2070 2 990-6000 

9 MA 602-0012 2 990-6000 

10 HR 602-0012 3  

11 SCO 2700 3 602-0012 

12 AS 990-6001 2 965-4705 

13 OP 8410 2 990-6001 

14 MA 601-0009 2 990-6001 

15 HR 601-0009 3  

16 SCO 2700 3 601-0009 

 

For more information on the structure of the BOR, see Order structure. 
 

Replace master data in BORs 

It may be necessary to update BORs (page 461) if a resource is replaced in the manufacturing 

process or a process is converted. You then have the option of replacing the resource with another 

resource in all or just selected BORs.  

This function is available in Design for the Items, Work centers, Tools, and Operation catalog 

resources. You can open this function in Manufacturing by selecting Manufactured items. 

1. Open the resource that should be replaced with another resource in the BORs. 

2. Use the Functions menu and the Replace master data in BORs command to initiate the 

replacement process. 
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Assign multiple BORs to an item 

You can assign multiple  BORs (page 461) to an item, for example, if it is both manufactured 

in-house and subcontracted (depending on the capacity situation). 

1. Open the item and select Go to and BOR. Then click OK to confirm the dialog box. 

2. Enter the manufacturing structure for the item on the Texts/structure tab and save the BOR. 

3. Close the BOR and return to the item master. The BOR ID is now entered in the BOR field on 

the Planning tab of the item master. 

4. Select the Functions menu command and then Assign BOR. 

5. Delete the contents of the BOR ID field in the dialog that follows and confirm by clicking  OK. 

The BOR ID field on the Planning tab of the item is is now empty again. 

6. Use Go to and  BOR to reopen the selection dialog box where the item ID is the default BOR 

ID. 

7. Overwrite this and confirm with OK; you can enter the second BOR in the table. 

8. Save and exit the BOR. The new ID is now in the BOR field in the item master. 

9. Before each planning run of the item, make sure that the required BOR has been assigned to 

the item: You can select the required BOR using the list box in the BOR ID field. 
 

Map assemblies to BORs 

Multi-level order structures can be generated if a number of assemblies are manufactured 

simultaneously and processed to form the finished product. 

The levels can be assigned to material (MA lines) and assemblies (AS lines). 

The main differences between opting for AS lines and MA lines are outlined below. 

Material records 

 Material records (MA lines) are managed and planned as inventory. 

 There must be a BOR for each material. 
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 When production orders are generated, a production order is generated from the BOR for 
every MA line. 

Assembly records 

 Assemblies are items that are made during manufacturing and processed. 

 They are not managed as warehouse inventory and are not planned. 

 Unlike MA lines, no proprietary production order is generated for AS lines when production 

orders are generated. 

 They can be listed directly in the BOR as an AS record. The level that defines the assembly 

structure must be entered: the AS record receives level 1 while the following OP and MA lines 

are assigned the next levels (2 and so on). 

 Assemblies can also be saved as a BOR. In this case, you need to insert a phantom assembly 

(PH record) in the parent BOR. 

Please note: The quantities entered for the PH record do not play an role during order 

generation. We recommend that you always enter the quantity 1 for the PH record. 

 Multiple AS lines in a production order are scheduled in parallel. 

 

There are two ways of working with assemblies. 

 

Example 1: 

Example 1 shows you how to enter assemblies as AS lines with the corresponding resources 

directly in the BOR. 

The assemblies are recorded in the BOR. 

The Texts/structure tab of BOR 965-4705, Idler body 650, is structured as follows. The Level 

column was taken from the Costs tab of the BOR. 
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Str. RT Level Resource Description, Desc. 

1 O 1 3080 Rotate items on Gildemeister III 

1 O 1 8362 Weld parts with robot 

1 M 1 990-6000 Pipe section for idler body 

1 O 2 2070 Saw items as specified 

1 S 2 602-0012 Round bar 40mm 

1 M 1 990-6001 Ring for idler 

1 O 2 8410 Burn items as specified 

1 S 2 601-0009 Sheet steel 10mm ST37 

The AS lines (the assemblies) have the level ID 1. The resources needed to manufacture the 

assemblies are assigned level ID 2. The assemblies are scheduled in parallel. Both assemblies 

are available when the Weld parts with robot operation begins. 

 

Example 2 

Example 2 shows you how to copy AS lines that are already recorded as a proprietary BOR into a 

BOR. 

Proprietary BORs are recorded for the assemblies. 

If proprietary BORs are saved for the assemblies, the BOR of the finished product is structured as 

follows. 

Str. RT Level Resource Description, Desc. 

1 O 1 3080 Rotate items on Gildemeister III 

1 O 1 8362 Weld parts with robot 

1 M 1 990-6000 Pipe section for idler body 

1 L 2 990-6000 Pipe section for idler body 

1 M 1 990-6001 Ring for idler 

1 L 2 990-6001 Ring for idler 

The following is entered for each assembly with a saved BOR: 

 An AS record with the designation of the assembly, level 1 
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 A PH record with the phantom assembly containing the BOR designation for the assembly, 

which should ideally match the assembly designation. The PH record is assigned level number 

2 

Please note: The table is only an example. AS records (assemblies) can in theory be 

entered on every level. The level number of the PH record must always be 1 higher than 

the associated AS record. 

When orders are generated in Manufacturing, the BOR is then inserted for each PH record, and 

the result corresponds to the structure from example 1. In other words, proprietary production 

orders are not generated for the assemblies. 

Purchase orders are generated that can be forwarded to Purchasing for the required 

subcontracted materials (purchased items). 

 
 

Enter times and quantities in BORs 

The parts and operations required for manufacturing must be entered in the BOR (see "BORs" 

page 461) in Design. 

The standard times for calculating the duration of manufactured are specified in the same way. 

These are required in Planning and for scheduling in Manufacturing, for example. See also Time 

calculation. 

When entering BOR lines, you can search for master data using the Find master data command in 

the Go to menu. For more information, see Find master data. 

The data stored in the BOR is set by default in the production order and used to calculate the 

order. You can overwrite it in the order. Scheduling must then be performed again and the 

quantity/duration calculation initiated. 

The table below shows the most important settings on the Times/quantities tab, using resource 

978-3893 as an example. 

Operation 2070 (record type OP) shows shift plan 0, the setup time (STi) of 100 industrial minutes 

and working time per unit (RTi/qty) of 3 industrial minutes. The shift plan stored in the master data 

is used in shift plan 0. 



472 | Infor COM 7.5 User Guide 

 

Design 

 

Str. SVO Resource IMI STi RTi/ 

qty 

UOM Time 

basis 

For RTi For STi Round Eff. 

1 OP 8362 0 50,00 100,00  0,00 Not selected Not selected 0 0 

1 OP 3080 0 100,00 15,00  0,00 Not selected Not selected 0 0 

1 OP 2070 0 10,00 5,00  0,00 Not selected Not selected 0 0 

1 OP 2070 0 100,00 3,00  0,00 Not selected Not selected 0 0 

1 MA 602-0012 0 0,00 0,36 m 0,00 Not selected Not selected 0 0 

1 MA 602-011 0 0,00 0,26 m 0,00 Not selected Not selected 0 0 

The STi and RTi fields are particularly important. 

STi (delivery time/setup time) 

The meaning of the STi field changes depending on the type of record for which it is set. 

The field acquires the following meanings for the individual records: 

 OP lines 

OP lines are operations: Here, the STi field indicates the setup time in industrial minutes. 

 MA lines, AS lines 

MA lines are material records, and AS lines are assemblies. Here, the STi field indicates the 

provisional quantity or fixed quantity (number of units). This is always calculated in the 

production order independently of the finished product quantity. 

 TL lines 

TL lines are tools. The STi field indicates the number of tools here. 

 ES lines 

 For suppliers (record type ES), the STi field indicates the supplier's delivery time. 

RTi (runtime/quantity) 

The meaning of the RTi field changes depending on the type of record for which it is set. 

The field acquires the following meanings for the individual records. 

 OP lines: OP lines are operations. The RTi/qty field here specifies the time required to 

manufacture one unit. 

Note: The meaning of the unit of measure in operation depends on the 

COMMON.GLOBAL.ARBEITSGANGME parameter. If it is set to no (default), the unit of 

measure in the operation is a comment field, which is not evaluated. If it is set to yes, the unit 

of measure in the operation is evaluated in the quantity-duration calculation. In this case, store 

the unit of measure into which you want the quantity from the order header or from the parent 

assembly line to be converted. You must first have stored the conversion in the relevant item. 
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 MA lines, TL lines: MA lines are materials; TL lines are tools. The RTi/qty field here indicates 

the unit of measure per unit of finished product incorporated into the manufacturing process of 

the resource (in the example of the BOR). 

 AS lines: For an assembly to be included in the quantity/duration calculation, this field must be 

set (generally with a value of 1.00). It indicates how many UOMs of the assembly are required 

to manufacture a unit of measure of the resource (header). 

Example: In the BOR of an item, the number 6 is entered for an OP line (operation). In this case, 

the number 6 indicates the time worked. This Help topic contains information on time calculation. If 

the number 6 is entered in the TRi/qty field for an MA line, this specifies the quantity of the material 

(for example, in kg or units) that is required to manufacture the resource. 
 

Store scheduling modes in BORs 

You can find general help on BORs (page 461) in the topic of the same name. 

During scheduling the operations are arranged in the specified sequence as long as no 

parameters for overlaps have been indicated. You can set these in the BOR itself on the 

Scheduling modes tab; they are then included automatically in the production order. 

It is also possible to define in-house manufactured items of the finished product as assemblies. 

Scheduling can then be defined in such a way that the assemblies are manufactured in parallel. 
 

Activate NPI/discontinuation control in BORs 

In BORs (page 461), material lines and operations can be selected or deselected in accordance 

with a due date or quantity scales in the BOR view on the NPI/discontinuation control tab: 

This allows you, for example, to use a smaller, slower but quickly set-up machine for up to a 

certain quantity, and, for larger quantities, to use a machine that is more time-consuming to set up 

but much faster at doing the work. 

For orders with a fixed requirement allocation (FRA), NPI/discontinuation control takes effect only 

when you create a new order. If you change existing orders with FRA, NPI/discontinuation control 

is ignored for this process. 
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The NPI/discontinuation control tab is only displayed in the BOR if the function is selected. Select 

it in Configuration by setting the  COMMON.STAMMDATEN.EINAUSLAUFSTEUERUNG parameter to yes. 

The following table is an example of BOR 978-3893. 

The Saw items as specified operation is assigned to two work centers, depending on the quantity 

to be manufactured. For order quantities up to 199 (To quantity column) you want to perform the 

operation at work center 2071; for quantities from 200 (From qty. column) you want to use work 

center 2072. Both work centers belong to work center group 2070. 

Str. SVO Resource Short description Wrk ctr From date To date From qty. To quantity 

1 OP 8362 Weld parts with 

robot 

8362   0,00 0,00 

1 OP 3080 Rotate items on 

Gildemeister III 

3080   0,00 0,00 

1 OP 2070 Saw items as specified 2071   0,00 199,00 

1 OP 2070 Saw items as specified 2072   200,00 0,00 

1 MA 602-0012 Round rod 40 mm   3/29.06/ 

2014 

0,00 0,00 

1 MA 602-0011 Round rod 30 mm  3/30.06/ 

2014 

 0,00 0,00 

When you generate an order, resource 602-0012 is used in the production order for a current date 

up to 6/29/2014 (To date column); for a date from 6/30/2014, resource 602-0011 (From date 

column) is used. 

 
 

Define size management in BORs 

In BORs (page 461) and production orders, you can specify the dimensions (length, width, height) 

required for manufacturing to determine the material usage. The materials required for an order 

are determined based on the specified dimensions and taking into account the quantity factor. 

Please note: The data saved in the resource is set by default in the BOR. See also Control 

resource size management. 
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Update user resources 

To optimize runtimes when saving items and BORs, Infor COM separates the saving process from 

the associated recalculation of all user resources. The user resources of an item are resources 

that contain these items in their BOR. The user resources of a BOR are resources to which this 

BOR is assigned. 

An entry is logged in mailbox 22 when you save the ID of the related item or BOR. The 

time-consuming calculation involved in updating user resources can then be performed in a batch 

process outside the peak times at which Infor COM is used. This batch process takes the 

resources that have been logged in mailbox 22 and then deletes them from the mailbox once they 

have been processed. 

Use Batch control in Infor COM to configure and release this batch process. Create the action  

Infor.MasterData.Resource.Item.BS::IDataManager.calculateNotifiedItemsCascading there. See 

Batch control for a detailed description of the procedure. 

Please note: The batch process must be run to update the user resource data. 
 

Reconcile BOR 

The following steps explain how to perform a BOR reconciliation. Make sure that the parameters 

for the BOR reconciliation are stored in the configuration (COMMON.STAMMDATEN section). 

1. Open the resource (for example, the work center) and select View and Reconcile BOR to 

switch to the Reconcile BOR tab. 

Enter the specified parameters for the reconciliation. The parameters stored here have priority 

over the values stored in the configuration. 

Example: :Reconciliation parameters 

Abgleich_A1=60, 2, 1, 10.0, 10.0, 2.0, 2.0 (Note) 

Instead of the Abgleich_A1 parameter used here or where multiple parameters are used, 

descriptions can be used following the pattern Abgleich_A2, Abgleich_A3, etc. 
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This example specifies the following reconciliation parameters. 

Record type to be updated 

60 This record type is the default setting for the Operation record type, but you can also store other 

resource record types such as material records 

Standard values to be updated 

2 RTi update: The following settings are permitted here: 0 = none, 1 = only if setup entered, 2 = always. 

1 STi update: The following settings are permitted here: 0 = none, 1 = only if setup time entered.  

 Maximum variance for transferring the entered values 

Standard values that exceed the maximum configured variance are not included in the calculation. 

For the runtime (RTi) and the setup time (STi), the percentage is stored for the maximum variance up 

to which the entered values are transferred. 

10.0 Runtime variance for automatic transfer (in %): The default variance is 10%. 

10.0 Setup time variance for automatic transfer (in %): This functions in a similar way to the runtime 

variance. The default variance is 10%. 

 Smoothing factor for calculating the new standard values: 

The smoothing factor indicates the weighting with which the standard value (RTi or STi) calculated 

from the production order lines entered as finished is included in the calculation of the new standard 

value. 

Example: Smoothing factor 2 means that the average value of the old and calculated standard 

value becomes the new standard value. 

Smoothing factor 1 means that the calculated standard value becomes the new standard value. 

The formula is:New standard value = old standard value + (calculated standard value 

- old standard value)/smoothing factor 

2.0 RunTimeSmthFac: The default setting for the runtime smoothing factor is 2, that is, the variance 

applied is 50%. 

2.0 STiSmthFac: The default setting for the setup time smoothing factor is 2, that is, the variance applied 

is 50%. 

2. Open the BOR for which a BOR reconciliation is to be performed, and select the Functions 

menu command and then Reconcile BOR. 

3. Enter the necessary settings in the Reconcile BOR dialog box and confirm with OK. 

4. Check the results on the Reconciliation tab. Flag the lines to be transferred in the Transfer field 

and select Functions followed by Transfer new planned times. 
 



Infor COM 7.5 User Guide | 477 

 

Design 

 

Call 

Design > Reconcile orders 

Description 

Changes in BORs (page 461) are flagged as internally programmed. As soon as you change 

quantities, times, etc. or add or delete lines, all BOR lines are assigned a flag. 

If you want to update changes in production orders that have already been generated, select 

Reconcile orders in the submenu in Design. The dialog window that appears displays the progress 

of the reconciliation once it has started. 

In the standard system, all production orders are changed until the status is Scheduled. There is 

no option to exclude specific orders. 

In Manufacturing, you can use the On hold for BOR reconciliation  check box on the Scheduling 

tab in the Order header view to set the lock on an order basis in the open production order. 

 

Reconcile orders 
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Call 

Design > Operation catalog 

Description 

The operation catalog provides a selection of predefined operations for creating routings. 

An operation describes an individual manufacturing step in production planning and control when 

a production order is being processed. 

Certain standard operations in a manufacturing process are constantly repeated. The times of 

standard operations are based on different parameters (which generally cannot be modified) 

incorporated into the operation. Fixed setup times and runtimes can therefore be stored for an 

operation. These values are transferred directly to the BOR or production order when the 

operation is transferred. 

To describe an operation, a unique ID (operation ID) and name, the unit processing time, setup 

time, required materials, and process materials, etc. are used. The routing reflects all operations in 

a resource. 

Operations form the real knowledge base of production process components. You can judge a 

company’s production capabilities by its range of cataloged operations, not its machines. 

Assigning cost centers and costs allows you to cost orders and transfer these costings to financial 

accounting. 

Multiple operations that are repeated daily may be carried out at each work center. Maintaining the 

operations is therefore a requirement for describing the processes that occur in the work centers. 

You can execute many different operations, repeated daily, at each work center (see "Work 

centers" page 481). 

To be able to describe the processes at the work centers, you need to manage and maintain the 

operations. 

The following requirements apply here: 

Operation catalog 
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 Operations can be assigned to group and single work centers. 

 You can assign any number of operations to a work center. 

 Operations can also contain setup times and runtimes as the standard times. 

 You enter cost types for operations. 

 You can assign operations to cost centers. 
 

Create operation 

To create an operation (see "Operation catalog" page 478), proceed as follows: 

1. In Design, click Operation catalog and select the New tab. 

2. Enter an ID of your choice in the Operation field and populate the Key and Desc. fields. 

3. Click Create. 

4. Use the combo box to assign a work center group or work center in the header of the 

operation. 

5. Store the setup and runtimes of the standard operation on the Time/costs tab in the 

Processing time form section. These values are accepted when you transfer the operation to 

the BOR or production order. 

6. Select the shift plan that you want to use to form the basis for your capacity planning. 

7. Enter wage and machine costs and the overhead key in the Costs form section and assign a 

cost center to them. 

8. In the View menu, select the Notes menu command to enter detailed job instructions. 

9. Select Save from the Data menu to save the operation. 
 

Assign operation to a work center 

You can define any number of standard operations for each work center (see "Work centers" page 

481)/work center group. To assign an operation (see "Operation catalog" page 478) to a work 

center, complete the steps below. 

1. Select Design > Operation catalog and open the required operation. 



480 | Infor COM 7.5 User Guide 

 

Design 

 

2. In the Work center field in the header form of the operation, select the single work center to 

which the operation is to be assigned. 

Note: If you want to assign the operation to a work center group, enter only the input in the 

Work center group field. 

3. To save, select Data and Save. This automatically populates the Work center group field. 
 

Alternative operations 

Unlike alternative work centers (see Assign alternative work centers (page 483)), you cannot swap 

alternative operations. This is because they are only relevant in the orders where they were 

defined. 

Example: The following section from the Current tab of a production order shows work center 8370 

as the defined alternative for work center 4090. This alternative assignment is only relevant for 

order 5012007. 

5012007     

SVO Resource Qty Total time Duration 

OP 4090 80,00 480,00 480,00 

AO 8370 40,00 300,00 300,00 

 

Please note that the alternative operation (based on other capabilities of the machine) has 

different quantities, times and durations than the original record. 

Alternative operations are used and implemented only by APS. Planning ignores them. 

To enable APS to accept the operation alternatives, you must select the setting on the Data 

transfer 2 tab in the Configuration dialog box in APS (Operation alternatives section). 

To find out how alternative operations are assigned, see Planning board (APS). 
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Call 

Design > Work centers 

Description 

In Infor COM, work centers may be employee work centers, single machines, or groups of 

machines. You can access all work centers in Design by selecting Work centers. 

You must maintain a work center or a machine that you want to plan in the manufacturing process. 

This enables you to increase capacities or use subcontracted manufacturing, for example, if 

bottlenecks occur at particular work centers during manufacturing. You can also combine 

machines in work center groups if these can be used as an alternative for specific tasks. 

When you enter new work centers, choose whether you want to create a single work center, a 

group work center or an external/dummy work center. 

 You must assign each single work center to a work center group. You can combine more than 

one single work centers of the same type in a group. All work centers in a group can be 

allocated in parallel and replaced (alternative work centers). 

 Group work centers usually contain several single work centers, for example, several related 

machines or the same types of machines where the same processes take place in parallel. 

 Unlike single or group work centers external/dummy work centers are ignored in planning and 

value flow. The external/dummy work center ID is used to denote the work center in a dummy 

operation which is created during order generation if delivery time and model are specified in a 

subcontracted activity. The delivery time of a subcontracted activity is then taken into account 

during order scheduling. 

The single group is a special case. This group consists of an individual work center that is 

specified as a single work center as well as a work center group and is assigned to itself. 

Operations must be assigned to a work center or a work center group - for more information see 

Assign operation to a work center (page 479). 

Select the Functions menu command and then Where-used list from a particular work center to 

view how it is used in manufacturing different manufactured items. 

Work centers 
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If you change or replace a machine, a work center, or the sequence in the manufacturing process, 

you can replace the related master data in the BORs (seeReplace master data in BORs (page 

467)). This takes place either globally via the Replace all replacement type or via 

NPI/discontinuation control (see "Activate NPI/discontinuation control in BORs" page 473), which 

controls the valid range of the new work center using its start date. 
 

Create work center 

When you create a work center (see "Work centers" page 481), the parameters for scheduling the 

planning and detailed planning in Manufacturing are specified for each work center. The values 

are set by default in the BOR and in Manufacturing and can also be changed there. You can also 

plan alternatives for capacity bottlenecks. 

1. Select Design > Work centers > New enter data for the required fields and confirm by clicking 

Create. 

2. On the Planning tab, select the planning and SFDC shift plan and enter buffer times and 

planning type for the working hours planning. The available capacity of the work center or work 

center group is derived from the shift plan. 

3. Enter the hourly rates for work centers or work center groups on the Costs tab. The preliminary 

and final costing are based on these rates. For more information, see Time calculation. 

To find out how to cost manufactured items, see Roll up costs. 

4. On the Alternatives tab, select the alternative machines and/or machine groups, which, if 

required, can be used to replace a particular machine that breaks down. Use the Alternative 

machine field to make your selection.  

When you select a machine group, you can access all machines of the alternative group if 

necessary. However, if you select a single machine, you will quickly be able to move your 

operations to this alternative machine using Manufacturing control. 

5. If applicable, configure a machine location on the Default coordinates tab. 

You need to do this so that you know the target and source location for issue and receipt 

postings when inventory movements are performed in Manufacturing. 

If you do not select a location, the machine location specified in DefaultMachineLocationNo is 

used. 
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6. Save the data. 
 

Assign alternative work centers 

For general information, see Work centers (page 481). 

Machine failures or shutdowns can interrupt the manufacturing flow in the company. You must 

therefore react as quickly as possible if a machine is down. One important safety measure is to 

define alternative options that can be accessed quickly when required. 

There are two different types of alternatives: 

 Alternative machines 

 Alternative groups 

By defining alternative machines, you can quickly switch operations from one machine to another 

defined alternative machine within Manufacturing control. When you define alternative groups, you 

can access all machines in an alternative group. 

In Design, you can specify alternative work centers on the Alternatives tab in Work centers. 

Alternatives for machine allocation are included during the capacity check and scheduling. The 

following rules apply here and should be taken into account when entering master data for the 

work centers: 

 Any machine entered for a work center group on the Alternatives tab in the Work centers 

assigned to group field may be used as an alternative machine. 

 If you select the Plannable check box on the Planning tab for the machines in a group, the 

operations are distributed to all machines during scheduling. 

 Machines from another work center group can be used as alternative machines and are also 

taken into account in scheduling. 

 You can use a different work center group as an alternative for a work center group (for 

example, for the same type of manufacturing in different factory locations). 

In this case, however, the alternative machines are not included in automatic planning. Manual 

changes are authorized. 

 You can only move an operation manually from one machine to another if the second machine 

is entered as an alternative machine. 

Note: In APS, you define the handling of alternative work centers on the Planning tab in the 

Planning section. 
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Call 

You can manage master data for tool groups and single tools in Design > Tools. 

Description 

A tool group is a set of identical tools that can replace one another. The purpose of the tool group is to plan the 

grouped tools. 

You can include multiple single tools in one group and plan their use together if they belong to the same tool type. 

To find out the tool type to which a tool is assigned (according to the TOOLTYPE allocation table), check out the 

tool's Structure tab 

Note: The units in which the tool life information is maintained must be identical. 

Grouping tools lets you plan multiple tools without having to check the individual availability of each tool. Planning 

a tool group allows the system to access multiple tools and plan and issue tools automatically. 

The outstanding feature of individual tools is their uniqueness within the company. 

Create high-value, reusable tools as single tools. You can monitor their wear and tear using Tool life monitoring 

(see "Tools" page 484). You can assign single tools to a group of the same type. If the inventory is > 1, note the 

effect on tool life monitoring. 

Single tools can have any amount of batch-tracked inventory. 

Tools frequently require considerable investment. The Tool management module integrated in 

Planning and operative Manufacturing control in Infor COM provides an industry-independent 

solution for optimum use of your tool resource. 

Tools are treated like items, the purchasing and warehousing processes are similar to those for 

materials. They are planned as independent resources and used in manufacturing on a work 

center basis.  You can also assign them to operations using the milestone method. 

Tasks 

The overview below lists some important general tasks of Tool management: 

 Inventory, status, and usage monitoring for tool groups and single tool batch-tracked inventory 

 Tool life monitoring for single tool batch-tracked inventory 

 Tool requirement planning: Planning of tool repairs 

Tools 
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Tooling inserts 

You can assign multiple tooling inserts to a single tool on the Tooling inserts tab. The tooling 

inserts to be stored must in turn be created as single tools. 

Example: The die for patent fasteners tooling insert is stored with the screw press tool. 

Note: The maximum nesting depth of tooling inserts in tools is 1. You can produce several 

different items at the same time with one and the same tool depending on the types and number of 

tooling inserts used in a single tool. 

Tool-related times 

Tool-related times are maintained for standard operations (Design > Operation catalog). If you add 

an operation line to a BOR, these times are transferred as well. 

Transactions 

Tool transactions are performed in Inventory. For help on posting IDs for tools, see Inventory 

posting IDs. 

Tool life monitoring 

Tool life monitoring (only for single tools) is based on SFDC/MDC transactions to prevent tool and 

material damage. 

See Set up Tool life monitoring (page 491). 

The unit in which tool life is measured; depends on the tool type. 

Note:  If the warning limit for the tool life has been reached in some batch-tracked inventory, a 

repair order that complies with the stored BOR (for internal repairs) or a PO proposal (for 

third-party repairs) is generated for this batch-tracked inventory and the start date is the 

transaction date. This event is logged in the tool history. 

History 

Enable tool history using the Keep tool history check box on the Monitoring tab. 
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Functions 

Inventory information: Use Go to and Inventory information to see an overview of available 

batch-tracked inventory in the open tool. The Tool info tab also provides information about tool 

statuses. 

Where-used list: All BORs in which the tool has been inserted are listed using the where-used list. 

If the tool is not integrated in a BOR, a message to this effect is displayed. 

Replace master data in BORs: Selecting this function means that the data records for a tool are 

replaced by those of another tool in all BORs. To do this, set the replacement type to Replace all. 

The new tool is entered in the BOR with the tool to be replaced when you select 

NPI/discontinuation control. 

Assign characteristics: You can assign characteristics to a tool. To do this, in the open tool go to 

the Functions menu and select Assign characteristics. Once you have confirmed the dialog box, 

you can enter data for the previously selected feature on the Characteristics tab. 

Hide features: For instructions on hiding features, see Using VARIANTS (see "Use VARIANTS" 

page 511) and Combo box properties. 

Show hidden features: Use this menu command to show hidden features again. 

Lock/release tool: You can lock a tool in Inventory using the Special functions folder and 

Inspection. Use posting IDs 106 through 109 to lock/release tools. 

The lock is effective immediately, and this is indicated by the red Locked text box in the header 

form. If the tool is in a production order with this status, the production order is not released. 

Scrap tool: You can scrap a tool in Inventory using the Special functions folder and Inspection To 

do this, use posting ID 90 - Scrap defective material; see Inventory posting IDs. 

When the posting is performed, the tool is issued from the warehouse and the inventory is 

reduced. The process is documented on the History tab. 

Enter tool history: Use this function to add entries manually to the History tab if Tool history is 

enabled. 
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Configuration 

The right settings in the COMMON.WERKZEUGVERWALTUNG section are required for Tool 

management to work as it should. 

In practice 

Sell tool 

 
 

Add tools to tool group 

Proceed as follows to add tools to a tool group: 

1. Open a single tool that is to be added to the tool group. 

2. Click the Structure tab. 

3. Enter the tool group to which the tool is to be added in the Tool group field. 

4. Repeat steps 1 to 3 for every additional tool that is to be added to the tool group. 
 

Create tool BORs 

Proceed as follows to create a BOR for a tool (see "Tools" page 484): 

1. Open the tool. 

2. Select Go to > BOR. 

3. Select the required BOR in the dialog box that appears. 

 The manufacturing BOR is required for in-house tool manufacturing. 

 The preparation BOR is required when the tool has to be treated prior to its use in 

manufacturing. 

 The standard version does not include assembly and disassembly BORs. 

 Create the renewal BOR if the tool has to be treated after it has been used in 

manufacturing. It is used for internal repairs (see Monitoring tab) to generate a production 

order. 



488 | Infor COM 7.5 User Guide 

 

Design 

 

Please note: Abbreviations are attached to the tool ID depending on the type of BOR 

created. 

Note: Tool BORs may be circular. The tool for which you create a BOR can itself be part 

of the BOR. This is usually required for renewal BORs. 

 



Infor COM 7.5 User Guide | 489 

 

Design 

 

Repair tool 

Tool repair orders can be assigned externally or internally. This means that a repair order that can 

either be processed internally or contracted to a third party as a PO proposal in Purchasing is 

created automatically if the repair interval is exceeded. For a description of this procedure, see 

Repair tool (page 490). 

Third-party repair: If set to Third-party repair in the Generate repair orders section on the 

Monitoring tab, the repair is subcontracted to a company; if set to Internal repair the repair is 

carried out in-house. A PO proposal containing supplier, inventory, and quantity details is 

generated via Functions and Repair tool. 

Following confirmation, the PO proposal can be processed and posted in Purchasing using PO 

proposals. 

Tools to be repaired are displayed as material provided, the repair job itself as tool purchase order 

with material provided (structure DH-TLR-MA) whereby the tool to be repaired is provided. 

If the tool repair is ordered from the supplier, the tools to be repaired are issued from the 

warehouse when the advance shipping notice is printed. 

Please note: A renewal BOR must be created before internal repairs can be carried out. If this is 

the case, a detailed production order is generated. 

Internal repair: In general, TL records in repair production orders are posted as in regular 

production orders, i.e the tool is assigned when the order is released or at the latest when the start 

transaction of the corresponding repair operation is entered. The tool is then transferred to the 

respective machine location. 

The tool is returned to the original inventory when the end transaction of the repair operation is 

entered (if the tool is a return tool (the Return tool check box is selected on the Inventory tab in the 

tool master data) or the user returns it manually via the Transfer object in the Inventory module. 

Repair production orders differ from regular production orders in the following way: 

 The batch-tracked inventory to be repaired is reserved when the order is generated and thus 

prevents other production orders from accessing it. 

 No tool life posting is carried out. 

 No posting to the order header is carried out as there is no new batch-tracked tool inventory to 

be generated. 
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 If the MMON.WERKZEUGVERWALTUNG.MAXIMALCUTTINGTIMEAFTERREPAIR 

parameter is set to yes in the configuration file, 

the remaining life in the batch-tracked inventory is set to the maximum value specified in the 

tool master when the end transaction is carried out. 

The following events are written into the tool history: 

 Repair: When the repair is triggered, i.e. when the repair order is generated. 

 Release/Return: When the repair order is released. 

 Transactions to the repair operation: Start, Partially complete, Interrupted, End. 

Renewal: When the tool life is reset to its maximum. 
 

Repair tool 

To repair a tool: 

Please note: A BOR must be present to be able to repair a tool (see Create tool BORs (page 

487)). 

1. In the open tool, select Functions and Repair tool. You are then asked in the dialog box that 

appears whether you want to enter reasons for the repair, or change them if they are already 

entered on the Monitoring tab. You have two options here. 

 Answer Yes to switch to Text system and enter the texts there. Close Text system after 

you have entered the texts. 

 Answer No to perform the repair directly. 

2. In the Repair tool dialog box on the Batch-tracked inventory quantities tab, enter the required 

quantity of the batch-tracked inventory to be repaired in the Spec. qty. field and confirm by 

clicking OK. 

The following messages are displayed. 

 A detailed production order for the repair was generated (in-house repair) 

 A PO proposal was generated (third-party repair) 

Note: Define the setting for internal or third-party repair on theMonitoring tab in the 

Generate repair orders section. 
 

Restore tool life 

Renewing a tool (see "Tools" page 484) means restoring it for use. 
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This function increases the remaining rate, remaining production quantity or remaining life on the 

Planning tab to the maximum rate of shots, maximum production quantity or maximum tool life and 

logs the number of renewals on the Tool maintenance tab (Rnwl field). 

Note:  When you create a new tool, the Maximum number of renewals field on the Monitoring tab 

is set to 0. To enable renewal, enter a number >= 1. 

Tool renewal is logged in the history if the Keep tool history switch on the Monitoring tab is set 

Example: Sharpening a blade 

Unlike a repair (see "Repair tool" page 490), no PO or production order is created, only the 

number of renewals is increased (until the maximum number is reached) and the remaining life is 

reset to Maximum. 

Please note: Renewal requires that the Permanent tool switch on the Monitoring tab is set. 

1. In Inventory, select Special functions and Inspection to go to the Tool tab and enter the 

required tool. Click Load to confirm. 

2. On the Inspection tab, enter posting ID 94 in the PID field and the quantity of tools to be 

renewed in the batch-tracked inventory in the Posting qty field. 

3. Select Functions and Post. 
 

Set up Tool life monitoring 

This Help topic describes how to configure and use Tool life monitoring (see "Tools" page 484). 

1. Use the the configuration parameters 

COMMON.WERKZEUGVERWALTUNG.CUTTINGTIMESUPERVISIONPERTOOL and 

COMMON.WERKZEUGVERWALTUNG.CUTTINGTIMECOMPLETIONMODE to configure 

Tool life monitoring. 

Note: Also note the setting for 

COMMON.WERKZEUGVERWALTUNG.AUTOMATICLOCKTOOLS. 

2. Select Design > Tools, load the tool, and select the Tool planning tab. 

3. Select the Monitor rate of shots, Monitor prod. qty or Monitor tool life check box. The name of 

the check box depends on the Tool type set on the Structure tab in the tool master. 

Note the information in the context-sensitive Help for the Tool planning tab. 
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Record types (Tools) 

For general help on tools, see Tools (page 484). 

The record type identifies the type of data record in a line. The following record types are relevant 

to Tool management: 

Record 

type 

Description 

TL (70) This record type represents a tool in production orders and BORs 

that is required for manufacturing. In scheduling, a tool item is taken 

into account in the same way as a material line.  

ATL See Record types (Manufacturing) 

TLR (75) This record type (Tool receipt) indicates the type of header record for 

tools. It is needed in Purchasing and Manufacturing to post to tools. 
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Allocation tables (Tools) 

For general help on tools, see Tools (page 484). 

The following allocation tables are relevant when working with tools: 
 

ACTIONTP 

Description: Action types for tool event control 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table defines the action types for tool event control. These entries can be 

logged in the tool history. 
 

DISTURB 

Description: Reasons for tool disruption 

Type: This allocation table can be modified by the user. 

Usage: Reasons for tool disruption are stored in this allocation table. The table is used to classify 

the reasons for tool faults on the Reason tab in the tool master record. You can also store a 

description of the reason (text) and a troubleshooting option (text) there. 
 

EVENTTYP 

Description: Tool event control event types 

Type: This allocation table can be modified by the user. 

Usage: This allocation table defines the potential tool-related events for event control. These 

entries can be logged in the Tool history object. 
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TMCONDINT 

Description: Tool maintenance: Interval sequence 

Usage: This table specifies the maintenance interval to be used following the next repair. Specify 

the sequence of the intervals to be used in the First, Second, and Third fields. 
 

TOOLAST 

Description: Tool assembly statuses 

Type: The user is not allowed to modify this allocation table. 

Usage: Tool assembly statuses are stored in this allocation table. The allocation table is used in 

Tool management. 
 

TOOLOST 

Description: Tool operating statuses 

Type: The user is not allowed to modify this allocation table. 

Usage: Tool operating statuses are stored in this allocation table. The allocation table is used in 

Tool management. 
 

TOOLSST 

Description: Tool storage statuses 

Type: The user is not allowed to modify this allocation table. 

Usage: Tool storage statuses are stored in this allocation table. The allocation table is used in 

Tool management. 
 



Infor COM 7.5 User Guide | 495 

 

Design 

 

TOOLTYPE 

Description: Tool types 

Type: This allocation table can be modified by the user. 

Usage: This allocation table contains the tool types known to Tool management, together with 

their properties. The allocation table is used in Tool management. It may only be changed by a 

consultant and following consultation with the Infor Development team. 

Text 1 

Describes a tool type. 

Text 2 

Depending on the tool type, this field either contains the default text for the number of cavities or is 

left blank. This default text is displayed on the Planning tab in Tool management. A consultant may 

change the text, cavities for example, to include customer terminology. 

Text 3 

Depending on the tool type, this field contains the Max. rate of shots, Max. production qty., Max. 

tool life or Max. tool life/die default texts. 

A consultant may change the text, as varying terminology is often used in different industries (for 

example, different terms may be used for the same concept in the metal processing and plastics 

processing industry). If changes are made, the information in the Text 5 and Text 6 columns must 

be adapted accordingly. 

Text 4 

Depending on the tool type, this field either contains the default text for the number of dies or is left 

blank. The Number of dies parameter is required for only a few tool types. A consultant may 

change the text. 

Text 5 

Depending on the tool type, the Monitor rate of shots, Monitor prod. qty, or Monitor tool life default 

texts may be stored here. A consultant may change the text. Changes must match the texts in the 

Text 3 column. 
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Text 6 

Depending on the tool type, this field contains the Remaining rate of shots, Remain. manuf. qty, or 

Remaining life default texts. A consultant may change the text. Changes must match the texts in 

the Text 3 column. 

Text 7/8/9/10 

These columns are not used. 
 

TOOLUNITS 

Description: Units of measure for (remaining) tool life 

Type: This allocation table can be modified by the user. 

Usage: This allocation table contains valid units for (remaining) tool life data. 

UOM 

Specifies the internal ID of a unit of measure. 

Issue UOM 

Specifies the abbreviation of a UOM that is displayed in the program. 

Basis 

Specifies the rounding basis for a unit of measure. 

Round 

Specifies if and how a unit of measure is to be rounded. 

Type 

Indicates the type for measures of length, area, volume, and weight. 
 

TOOLUSAGE 

Description: Tool life dependencies 

Type: The user is not allowed to modify this allocation table. 
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Usage: This allocation table contains external circumstances (dependency factors) that influence 

tool wear (tool life reduction due to using the tool in manufacturing). The allocation table is used on 

the Planning tab in Tool management. 

Description 

Production 

quantity/time-dependent 

Tool wear depends solely on the quantity of operations or time. 

Item-dependent Tool wear depends on the item manufactured. Example: A drilling tool 

shows more wear with item 4711 than with item 4712 as the hole to be 

drilled into item 4711 is twice as deep and causes more wear on the 

drill. 

Operation-dependent Tool wear depends on the operation. If, for example, the engagement 

time of a lathe tool in operation 4711 is twice that of operation 4712, it 

wears out twice as fast in operation 4711 compared to operation 4712. 
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Tool Construction 

The Tool Construction component makes functions for tool construction available to you. 

 

Note: See also Configuration (Tool Construction). 

The extensions are relevant for the following modules: 

 In the Design module, the Tools object includes a Goods receipt history (Goods receipt tool 

tab), cost history (Expense tab), and additional tool maintenance data (Operation tab). 

 In the Sales module, you can use tools as sales items in a sales order. 

 You can access the Tool costing function from a quote in the Sales module. You can then use 

the Go to menu here to access the tool costing. 

 The Order transactions object allows you to enter the status of a machine counter, for 

example. For more information, see Tool transactions. 

 If the event of defects, you can use the Replace tool function in the production order. To do 

this, select the function of the same name from the production order. 

 You can display an overview of all repair orders (see Tool life monitoring) by selecting the Tool 

repair order overview report in the Manufacturing module. 

 The EVENTTYP allocation table includes the additional Release, Release return, and Repair 
order created events, see also History. 
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In Design, you can access the Check tool inventory desktop object. 

This batch process lets you check the entire tool inventory and lock it if the remaining life falls 

below the warning limit or the date for the next renewal is exceeded. 

Note: The system goes to mailbox 180 when the batch process is complete. 
 

Check tool inventory 
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The Material constituents business object in the Design module is part of material data 

management in the licensed EMS add-on module. 
 

Material constituents 
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If you click Reports in Design, a dialog box is displayed. All available reports are displayed. 

For general information on reports, see the Print reports Getting Started guide. 

Please note: Report names are always structured as follows: ir<module><report name>. For 

more information on the reports not found in this Help topic, see the Help topics for the reports for 

the modules concerned. 

This dialog box provides you with access to a number of reports in Design. These reports make 

data records, according to the criteria selected by you, available in list form as a printout. 

Note: You can influence the displayed lists by assigning user privileges. 

 

 

Rep. Contents 

Operation overview This report displays the existing operation catalog (page 478). 

Work center overview This report displays the existing work centers (page 481). 

Items - Discontinued items This report allows you to display all discontinued items. It groups together all 

items that do not have the Standard line item flag. 

Item -  

External item ID 

This report creates an item list including any available external item IDs and 

business partners belonging to these. 

Item costs This report displays the cost data on the items. 

Item 

size management 

This report lists the data on size management of the items. 

Item shipping  

materials 

This report provides an overview of the items designated as shipping materials. 

Item characteristics This report displays the items with their stored characteristics. 

EU commodity code 

for item 

This report displays Intrastat data on the items. 

Item inflation  

surcharges 

This report lists items, together with the inflation surcharges stored for these 

items. 

Item accounts  

Item overview This report provides an overview of the existing items. 

Reports (Design) 
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Rep. Contents 

Item overview - 

Planning 

This report provides planning data for the item. 

Item overview of  

foreign-language texts 

This report provides an item overview with the foreign-language texts stored for 

each item. 

Business partners - 

Address overview 

This report gives an overview of the addresses and contact persons stored for the 

business partner. 

Customer statistics - 

Sales revenue 

These statistics provide an overview of planned and actual sales revenue for 

individual customers. 

Customer overview This report provides an overview of existing customers, including the addresses 

stored for them. 

Supplier statistics - 

Sales revenue 

These statistics provide an overview of planned and actual sales revenue for 

individual suppliers. 

Supplier overview This report provides an overview of existing suppliers, including the addresses 

stored for them. 

Supplier overview - 

Outstanding invoices 

This report provides an overview of outstanding purchase invoices for each 

supplier. 

Supplier overview - 

Who's who 

This report lists for each supplier the items provided by that supplier. 

Outstanding invoices 

by customer 

This report provides an overview of outstanding invoices for each customer. 

RoHS - Item composition 

RoHS - Purchased item 

overview 

RoHS - Sales item overview 

See Material data management reports EMS (availabel in German only). 

External item ID 

overview 

This report provides an overview of items with external item IDs and the name of 

the business partner that uses this external item ID. 

External business 

partner ID overview 

This report lists all business partners for which an external company ID is stored. 

Sales price list This report lists the sales prices for the selected period per customer. 

Tool overview This report lists the recorded tools. 

Payment plan overview This report provides an overview of existing payment plans. 

Additional costs overview This report lists the additional costs recorded. 
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The Adjust cards business object in the Design module is part of the scope of the licensed Plastics 

add-on module. For more information, see Adjust cards. 
 

Adjust cards 
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The QIS groups form the basis for the quick item search (QIS). 

The Quick item search function uses groups and features to help you find items. You can also use 

this function to find items whose ID and description you don't know.  

When you do this, you restrict the search progressively using criteria. Each time you select a 

criterion, the updated result list is displayed. The list is updated simultaneously when you modify 

the search criteria. This gives you direct control over the search and allows you to decide whether 

you need to further restrict it.  

Use the Item search function to load item master data or edit BORs and orders, for example. 

This is where you define the search fields (features) for the search. You can access the Quick item 

search function for item-related processes in the relevant start forms and tabs and via the 

Functions menu. 

The aim of the item search is to categorize items according to QIS groups. 

The groups must be created in Design using QIS groups. You can define these entirely according 

to your business requirements. You also need to enter the item master data for the item search. 

When you do this, assign the item to a QIS group and enter the data for the individual features. 

Example: You create a QIS group called SMS at your company with the group description Screws, 

nuts, washers. 

Define the following fields for this group: Feature 1 to Feature 3, Item type, Thread type/size, and 

Length/basic material. These fields will now be used as the search fields for the item search. 

Then, in Design go to Items and assign the item-specific feature data for screws, nuts, and 

washers. For the Item type feature, specify whether the item is a screw, nut, or washer. For the 

Thread type/size feature, enter the type and size of each item, etc. 

You can subsequently use the item search to find items that belong to the SNW QIS group based 

on this group and these features. 

Please note: To  use the Quick item search (QIS) function, the COMMON.QIS.ACTIVE parameter 

must be set to yes in the configuration. 
 

QIS groups 
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Create QIS groups for item search 

For general information on the quick item search (see "QIS groups" page 504), click here. 

Before completing the steps below, please note the following: 

If you want to assign a manipulation and/or plausibility function to a group, you first need to create 

the function in the Infor COM Dialog Manager. Once you have done this, these functions will be 

started automatically when items are saved. 

1. Click QIS groups in Design. The start form opens. 

2. Click the New tab. 

3. Enter a unique name or an abbreviation for the group in the Group field. 

4. Enter a meaningful group name in the Group description field. 

5. Click Create. 

The QIS group form is displayed. 

6. Select the corresponding check boxes to make this group available in Sales, Purchasing, 

and/or BORs. 

7. Enter any manipulation functions or plausibility functions and specify a value in the Eval. field. 

8. Enter the first search criterion in the Feature 1 field on the Features1-8/additional features tab. 

9. To print the feature in reports and documents, select the IPF check box. 

10. In this form section, assign further features as instructed in steps 8 and 9. 

11. If you would like to use additional features for this group, assign them in the Additional features 

form section. 

12. If you have not installed the accessory search feature, use the fields on the Features 9-20 tab 

as additional search criteria. 

13. Save the group. 

14. Create further groups using the start form or close QIS groups. 
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Create item master data for the item search 

For general information on the quick item search (see "QIS groups" page 504), click here. 

This Getting Started guide provides basic information how to assign an item to a QIS group (see 

"QIS groups" page 504) and specify item-specific features. 

Before completing the steps outlined below, please note the following: 

You first need to define QIS groups in order to create the item search in the item master. See 

Create QIS groups for item search (page 505). 

1. Click Items in Design and go to the Open tab on the start form. 

2. In the Item field, select the items that you would like to assign to a QIS group or select the 

items using one of the other fields on this tab. 

3. Click Load. The loaded item master data is displayed. 

4. If you have loaded more than one item, select the item you want to process. 

5. Go to the Item view. 

6. Go to the QIS features tab. 

7. In the Group field, select the group you want to assign the items to. 

The features of the group are displayed in the text fields in the QIS features form section. 

8. Enter the item-specific data for the individual features in the QIS features form section. 

Select existing features from the combo box. 

9. Save your entries. 

10. If you want to assign another item to the group, select it in the Item overview view or load it 

using the start form. 
 

Load items using the start form 

For general information on the quick item search (see "QIS groups" page 504), click here. 

Proceed as follows to load items using the quick item search function: 

1. Click the relevant object to load the required item. 
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2. In the Group field on the QIS tab, select the QIS group you want to use. 

The names of the group features are then displayed in the text fields. 

3. Use the combo box to select a feature. 

4. Select additional features as required to further restrict your search. 

5. Click Load. All items that meet the criteria are loaded. 
 

Load items using the QIS search dialog box 

For general information on the quick item search (see "QIS groups" page 504), click here. 

To access the QIS search dialog box, proceed as follows: 

1. Open a sales order. 

2. From the Go to menu, select QIS search. 

3. Using the combo box in the Group field, select the group you want to use. 

The names of the group features are then displayed in the text fields. 

4. Select a feature from the combo box. 

All items to which this feature has been assigned are listed in the table on the right-hand side. 

5. Use the combo box if you need to select additional features. The result list on the right-hand 

side is updated automatically each time a feature is selected. 

6. Select the item to be loaded from the table on the right-hand side. 

7. Enter the quantity in the Qty field. 

8. Click Accept. 

9. Select further items as required using Multiple selection (see "Multiple selection in item search" 

page 507). 

10. Click Close. The items are displayed. 
 

Multiple selection in item search 

For general information on the quick item search (see "QIS groups" page 504), click here. 
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To view the Getting Started guide on multiple selection, see Load items using the QIS search 

dialog box. 

Selecting more than one item from the result list 

Select the items while holding down the Ctrl or Shift  key as in Windows. 

In this case, please note that all selected items with the quantity entered in the Qty field will be 

included. 

Searching for additional items 

1. Click Clear fields. 

2. Complete steps 2-8 described in the Getting Started guide Load items using the QIS dialog 

box (see "Load items using the QIS search dialog box" page 507). 

3. To load additional items from the result list, complete steps 5-8 in the Getting Started guide 

Load items using the QIS search dialog box (page 507). 

4. Repeat steps 1-3 in this Getting Started guide to search for additional items. 

5. Click Close. The items are displayed. 
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VARIANTS basics 

Please note: This function must be licensed separately. 

To compete on today's markets, made-to-order and product configuration manufacturers must be 

in a position to fulfill specific customer needs. This situation has caused a significant increase in 

product configuration variety, while the quantities and lot size per product configuration has 

decreased. 

These two trends are increasing cost and logistics requirements and can result in longer lead and 

delivery times. 

The manufacturer must consequently ensure that effective product configuration management is 

in place while simultaneously implementing a more compact product structure design with fewer 

items. The traditional filing of a routing and BOR for each individual product configuration becomes 

inefficient. 

The VARIANTS component (computer-aided planning) allows you to manage a variety of product 

configurations based on a knowledge base (see "Knowledge-based product configuration 

generation" page 510). 

In contrast to series manufacturing, product configuration manufacturing does not use bills of 

materials and work lists stored as BORs; instead it uses a stored knowledge base. Product 

configuration items are therefore assigned flexible BORs rather than fixed BORs, as the former 

are generated for each order using the stored knowledge base. 

Product configuration manufacturers benefit from the following VARIANTS features: 

 The number of BORs is reduced, which simplifies data entry and maintenance. 

 Plausibility checks in the order prevent the acceptance of product configurations that are 

technically unfeasible. 

 Accurate preliminary costing can also be performed for unique items. You can respond 

promptly to special customer requests and calculate accurate prices 

 

In this component, you can perform the following tasks: 

VARIANTS 
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 Maintain categories (see "Categories, subcategories, and characteristics" page 533) and 

subcategories 

 Draft feature sheets (page 541) 

 Manage base BORs (see "Knowledge-based product configuration generation" page 510) 

 Enter characteristics (page 536) 

 Enter order features (page 539) 

 Create and test decision logics (page 545) 

 Maintain tables (page 597) 

 Perform data maintenance (page 598) for features 

 

For an introduction to working with VARIANTS, see the Help topics mentioned above. For more 

information on how to proceed, see Using VARIANTS (see "Use VARIANTS" page 511). 

Please note: If you want to use VARIANTS functions, you will need to purchase a license for the 

VARIANTS component. 
 

Knowledge-based product configuration generation 

Product configurations 

Knowledge-based product configuration generation is an indispensable tool for made-to-order and 

product configuration manufacturers. The product configuration of a product is created by 

modifying its design parameters. 

What is special about VARIANTS is the fact that it offers open product configuration solutions. It 

does not store every single product configuration, but rather the knowledge (the knowledge base) 

about the manufacturing-related correlation that exists, depending on the specifications for a 

product configuration. 

Knowledge base 

The knowledge base is compiled by the specialists within a company. It forms the basis for the 

automated creation of product configuration order documents. It contains the following 

components: 

 Manufacturing rules for material and work center selection 

 Formulas for calculating material use and standard times 

 Price and cost tables 
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Important: In the case of an order, the product configuration to be manufactured is only assembled 

according to the decision rules that exist in the knowledge base at the point in time when the order 

is created. This is the crucial difference compared to standard sales items. 

VARIANTS knowledge base 

The VARIANTS knowledge base primarily consists of two elements: The base BOR and the 

decision logic. 

 The base BOR contains the basic structure of the document to be produced. Bills of materials 

and routings can be derived from this base BOR. The base BOR is stored as the BOR for the 

document to be produced; however, it does not contain actual resources, but wildcards for 

these resources. 

Example: A base BOR contains a drilling operation. The actual machine that is used to 

perform the drilling is not decided until the order is created and the features required by the 

customer are entered 

 Decision logics re used to determine the actual resources when an order is generated. The 

decision logic contains a set of rules for this purpose. These rules use conditions to query 

criteria that must be fulfilled before specific actions are carried out. 

Example: Based on the required material, a decision logic determines which machine will be 

used to perform the drilling operation contained in the base BOR as a wildcard. 
 

Use VARIANTS 

For standard usage of the VARIANTS component, proceed as described in the following steps. 

1. To work with VARIANTS, first create the category (see "Categories, subcategories, and 

characteristics" page 533) that you will store for a product configuration item. 

Note: A knowledge base (see "Knowledge-based product configuration generation" page 

510) must exist for this step. In other words, you should have already grouped the items and 

defined categories, subcategories, and characteristics. 

The following process requires you to create a Standard items category. 

The table below shows the Subcategories tab for the opened Standard items category. 
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Subcategories Description ID Feature sheet Type 

SCREWS SCREWS 0 Screws 0 

The Standard items category contains the Screws subcategory. The Screws feature sheet 

is assigned in turn to this subcategory. The characteristics (page 536) are assigned using 

this feature sheet. To assign characteristics, the Type field must be set to 0. The ID field is 

not relevant for this type of feature sheet. 

2. Select Go to > IDM. In the IDM, create the Screws feature sheet. 

To find out how to design a feature sheet, see Feature sheets (page 541). 

The following screenshot shows the Screws feature sheet: 

Type  Standard (DIN/ISO)   

Thread  Length  mm 

Strength  
   

3. Open item 102-0010 and select the Characteristics tab to assign characteristics to this item 

using the feature sheet that was just created. 

4. Select Functions > Assign characteristics. 

The following table shows item 102-0010 with the features stored for it via the assigned 

Screws feature sheet. 

Type Socket head Standard (DIN/ISO) 912  

Thread M10 Length 50 mm 

Strength 8,8    

The options to be selected using check boxes were stored in the feature sheet. You can 

use the stored features to search for this item in various forms. In addition, when you 

generate the product configuration order (see step 12) you can use decision logics (page 

545) to select the resources required for manufacturing the finished product by means of 

the assigned features. 

5. In the item master, create the finished product to be manufactured, that is 960-1000 (drilled 

bar) - the sales item - and assign it a category on the Planning tab. You must do this first 

before you can generate a product configuration order for the item. 

The following table shows the DRILLBAR category assigned to item 960-1000. 
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Category DRILLBAR 

Please note: Unlike the resources needed to manufacture the product configuration 

item, no characteristics are assigned to the product configuration item itself. 

The following table shows an example of the Features tab for the product configuration 

item 960-1000 drilled bar. 

Material   Thickness 0 mm 

Length 0 mm Diameter 0 mm 

Width 0 mm Number of drilled holes 0  

 

6. Because a product configuration item always has to have a fixed requirement allocation, you 

must select the Fixed requirement allocation flag on the Planning tab each time. 

7. Select Go to > BOR. In the dialog that is displayed, select As base and click OK. 

A base BOR is then assigned to this finished product. In this context, the term "base" 

means that wildcards are entered for various lines in the BOR. 

Example: For the drilled bar sales item, we create a base BOR with drilling and sawing 

work centers as well as the flat material resource . The features entered in the order and 

the features stored in the base BOR determine which machines are used for drilling and 

sawing and which flat material is processed. 

The following screenshotshows an extract from the Texts/structure tab of the BOR: 

Str. SVO Ln ID Resource 

1 OP  DRILL 

1 OP  SAW 

1 MA  FLATMATERIAL 
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Please note: The BOR's base items must also be stored in the master data just like the 

items that replace the base item during product configuration generation. In addition, 

characteristics are assigned to the base items (see step 1). 

In our example, a variety of drilling machines, saws, and flatmaterials made of different 

materials and with different dimensions, including the characteristics to be assigned (see 

step 1), must be created. 

8. (Note: This step is optional and is not taken into account in the following steps: 

You can create a quote for the customer. Use View and Features to go to the feature sheet 

and enter the required features for the product configuration quote. Once you have entered the 

features, close the quote by selecting Functions and Close. 

To cost the quote, select Functions and Cost quote.The program recognizes that it is a product 

configuration item and processes the decision logics that are used to calculate the prices and 

are stored in the subcategory. Close the quote costing form once you have completed the 

costing. Confirm that you want to accept the costed data. You can now convert the quote to an 

order by selecting  Functions > Create order from quote.) 

9. In the next step, enter the order features. Create an order with a product configuration item (in 

other words, a sales item for which you have entered a base BOR). See also Create sales 

order with product configuration item. 

A sample base BOR for the drilled bar product configuration item is shown in the following 

table: 

Str. SVO Resource Decision logic 

1 OP Drill Drill 

1 OP Saw Saw 

1 MA FLATMATERIAL Flatmaterial 

 

Here, the Drill, Saw, and Flat material decision logics are stored on the Item ID tab of the 

BOR. 

The following image shows an extract from the Drills decision logic: 
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IF: Diameter >= 10 
  THEN: CALCULATE: "PreDrill".     
 END. 

 

$KTxt = "Drill with " + Diameter[2.1] + mm". 
$LNr =  "". 
* 
IF: Diameter < 10 
               THEN: $Te = Diameter * Thickness * 0.0010 * Number_Drill. 
               $Tr = 0.5 
               $MNr = "8610". 
LOGEND. END. 

If the diameter >= 10 mm, the PreDrill decision logic should be executed. If the diameter is 

less than 10 mm, the specified formula is calculated instead. 

 

The syntax for creating decision logics is detailed under Statements and operators in 

decision logics (page 551). 

10. Select the Features tab or the Features view and, using the feature sheet, assign the required 

order features to the item for the current order. 

Using features with restrictive selection: For individual features, it may be that only a 

limited selection is possible. You can control this by selecting list boxes with preset entries, 

for example, or by using decision logics stored for the feature. You can choose from either 

of these options when defining feature sheets. 

The following example for the Drilled bar feature sheet shows how an error message is 

displayed if you enter an incorrect value in the Length field. In this case, a Length decision 

logic is preventing an input of less than 50 mm. 

IF: Length < 50 
 THEN: ERROR: "Length too small: Minimum 50mm!". 
 LOGEND.END. 
IF: Length > 500 
 THEN:  ERROR:: "Length too big: Maximum 500mm!". 
 LOGEND.END. 

In our example, the Length decision logic was stored with the Drilled bar feature sheet, 

which has been stored for the Drillbar category and the Drillbar subcategory. 

Hiding features: If you have stored the Hidden property for a feature, you can show or hide 

certain fields on the screen, such as the Price field, for example (see Draft feature sheets 

(see "Edit feature sheets" page 542)). To do this, select Functions > VARIANTS > Hide 

features/Show hidden features. 
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11. Select Functions > VARIANTS > Calculate to run the price calculation for the feature sheet. 

There are three main ways in which you can calculate the price. 

Note: These commands are not available in the Features view. 

 To perform a calculation for a feature sheet, select Functions > VARIANTS >Calculate. 

 To perform the calculation for all sheets in the order line, select Functions > VARIANTS > 

Close. 

 From the Functions menu, select VARIANTS and Calculate order if you want to perform a 

calculation for all items in the order. 

Calculating prices via tables: When calculating prices, it makes more sense for decision 

logics to access and retrieve prices from tables (page 597). The TABLE: and TABSEARCH:  

statements are provided for this purpose. For more information about these statements, 

see General statements in decision logics (page 552). For an example illustrating the use 

of these operations, see the Drilled bar decision logic. 

12. To transfer the order to Planning or Manufacturing, select Functions and Generate product 

configuration order. Then confirm the following dialog box by clicking Start. 

Transfer to detailed planning 

If you had specified in the Order generation dialog box that you wanted to submit the order 

for rough planning, you can load the order in Planning by selecting the Rough planned 

orders object and transfer it to Detailed planning at a later stage. 

When you select Detailed, you can load the scheduled orders in Manufacturing. Please 

note that product configuration items always have fixed requirement allocations. 

13. After you have generated the order, select Go to > Order structure and view the results of the 

product configuration generation. 

Once the production orders have been processed and the manufactured items have been 

posted to Inventory, the order can be processed. You can check the item's current 

inventory by performing an availability check in Sales. 

Please note: Because of the fixed requirement allocation, you cannot print an advance 

shipping notice until the production order has been completed and the manufactured item 

has been posted to Inventory. 
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User group management and VARIANTS 

In User group management, you can define user groups from G0 to G3 (G0 is the VARIANTS 

administrator). You can assign privileges for each group in the standard sheet for entering 

features. Group privileges are managed as follows: 

Group Privileges 

G0 VARIANTS administrator with all privileges 

G1 General opening privileges, editing of characteristics lists and tables 

G2 Opening of characteristics lists and tables, modification of table data 

G3 Opening of characteristics lists and tables, modification of characteristics 

 

Please note: Users who are not assigned a group can only open tables, characteristics lists, 

and order features. 

All users can edit features in sales orders. 

Only the G0 user group can save modified decision logics, tables, characteristics lists, and so on. 
 

Decision logic and Lj4 comparison 

The table below compares the language scope of the decision logics to the Lj4 options. Functions 

that map decision logics in Lj4 will be provided on a gradual basis. You can use the standard Lj4 

functions until a specific function for decision logic mapping is available. 

Feature names 

ID DL command Meaning Lj4 alternative 

1 Feature name Read feature name CAP.GetFeature() function 

2 Feature name Write feature name CAP.SetFeature() function 
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Labels 

3 Label Go to function  

4 ^ Exponentiate  

5 ^0,5 Square root  

6 % Percent value  

7 := Assignment if empty If query 

8 :<, :> Assignment if greater/less 

than 

If query 

9 $PI PI Definition of a constant in Lj4 

10 $e Eulerian number Definition of a constant in Lj4 

 

Alphanumeric operators 

12 + Link strings & 

14 > Truncate spaces on the left LTrim 

15 < Truncate spaces on the right RTrim 

16 ?= Check literal in string CompareStr, FindStr, SubStr 

17 |= Check literal in string CompareStr, FindStr, SubStr 

18 LNG: String length Length 

19 {} Indirect access to variables  

20 [xn1.n2] String formatting CopyStr, FillStr, FindStr, FormatNumStr, 

FormatStr, and so on 
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Other characters 

21 * Comments // or /* ... */ 

22 */ Comments to end of line // 

23 ! OR ? 

24 =! Transfer value to MTEXT  

25 =? Output variable contents  

26 $Fehler Return function value  

 

Mathematical functions 

27 ABS: Abs. value 

28 SIN: Sine 

29 COS: Cosine 

30 TAN: Tangent 

31 ASIN: ArcSine 

32 ACOS: ArcCosine 

33 ATAN: ArcTangent 

34 SINH: Hyperbole 

35 COSH: Hyperbole 

36 TANH: Hyperbole 

37 EXP: Exponent 

38 LN: Natural logarithm 

39 LG: Base 10 logarithm 

40 RN5:n Round to n decimal places 

41 RDN:n Round down to n decimal places 

42 RUP:n Round up to n decimal places 

43 RND:n Round to n decimal places 
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Keywords 

44 IF: Condition If 

45 OR: Or link Or 

46 AND: And link And 

47 THEN: Condition is true Then 

48 ELSE: Condition is false Else 

49 END: Closing condition End if 
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General statements 

50 QUIT: Closes the open file  

51 DLOGIC: Opens another decision logic 

without returning to the current one 

 

52 EXPORT: Opens a file for writing  

53 ERROR: Issues message and cancels action  

54 IMPORT: Opens a file for reading  

55 DELETE: Deletes a file  

56 DELVAR: Deletes obsolete variables  

57 LOGEND: Cancels the decision logic  

58 MESSAGE: Issues a message  

59 MTEXT: Issues a message including request 

for data entry in a field 

 

61 CALCULATE: Opens another decision logic and 

returns to the current one 

 

62 SELECT: Accesses CAP tables for 

context-sensitive features 

 

63 CLGET: Releases characteristics for use  

64 CLSEARCH: Searches for MID using properties  

65 START: Opens an external program  

66 TABLE: Searches in a table and cancels if 

search was unsuccessful 

 

67 TABSEARCH: Searches in a table and returns 

ERROR=F if search was 

unsuccessful 

 

68 TEST: Activates the debugger Lj4 Debugger 

69 TEXT: String initiates printing  

70 TRANSFER: Reads lines in file or writes lines to 

file 

 

71 CONTINUE: Continues for label  
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Other functions 

74 READ: Provides read access to certain relations 

75 WRITE: Provides write access to certain relations 

76 DUP: Copies records of certain relations 

 
 

Import/export VARIANTS structures 

VARIANTS structures represent data that is required for a VARIANTS application, for example 

categories/subcategories (see "Categories, subcategories, and characteristics" page 533), feature 

sheets (page 541), decision logics (page 545), or tables (page 597). 

Tip: You can use this function to transfer processes developed on a test system from the test 

system to the live system once development has been completed. 

To import or export data, select the corresponding Functions command in the active category or in 

an active table. For more information, see the corresponding Help topics. 

Once the export has been initiated, the relevant data is copied to a subdirectory of the 

VariantsReorg directory, which is created in your VARIANTS directory for this purpose. 

Example: Exporting the Closet category would result in the following: 

 The VariantsReorg\Closet  subdirectory is created in your Infor COM directory. The files are 

stored in this subdirectory. 

The name of the subdirectory always corresponds to the name of the exported category. 

 The following files are located in the VariantsReorg\Closet directory after export: 
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Prefix Extension Meaning 

Cat_ .IO Category 

SubCat_ .IO Subcategories 

TABK_ .IO Table headers 

TABZ_ .IO Table rows 

DL_ .IO Decision logics 

 .IO Feature sheets 

  Feature sheet data 

 

Note: The feature sheet files do not have a prefix and their file names always correspond 

to the relevant feature sheet name. A feature sheet will always have two files: A file with 

the extension IO and a file with the same name but no extension. The feature sheet can 

only be imported if both of these files exist. 

To select the required category when importing data to the system, open the Functions 

menu and select Import data to open the relevant selection dialog box. 

You can only choose the category file here; you cannot choose subcategory or feature 

sheet files. The selection dialog box therefore contains Cat_ by default. 

The category you want to import cannot exist in the system at the time of importing - if it is 

in the system, the import procedure will be stopped automatically. The dependent data 

(feature sheets, decision logics) may already exist in the system, but it will be overwritten 

during the import 
 

Assign VARIANTS function keys 

To allow you to switch faster between Infor COM and VARIANTS, you can assign function keys to 

menu commands. 

Use the Infor COM Dialog Manager here to define the appropriate objects (see IDM_us.chm Help 

file). 

The following overview contains two examples of how a function key is assigned. 

Example 1: Totals calculation using F2 
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The following example illustrates how to start a totals calculation in a sales order using the F2 key. 

DialogDef Menu mnuCAPSMAUFunctionCalculateSum 

Caption = "steSummen_berechnen_F6" 

StatusBarText = "ste_Summen_berechnen__F6" 

ShortCut = F2 

End // DialogDef Menu mnuCAPSMAUFunctionCalculateSum 

 

Example 2: Accessing decision logics using F3 

The following example allows you to switch to the decision logic from the BOR using the F3 

function key. 

DialogDef Menu mnuCAPChangeDLogic 

Caption = "ste_Entscheidungslogik" 

StatusBarText = "steEntscheidungslogik_Verzweigt_in_die_Entscheidungslogik" 

ShortCut = F3 

Description = " Menu item to Go to: Decision logic" 

End // DialogDef Menu mnuCAPChangeDLogic 

 
 

Price calculation in VARIANTS 

There are different ways of calculating prices: 

 If you set the PRICE: statement in the decision logic, the item price can be extracted from  

Infor COM price tables. 

 You can use a formula to calculate a price in a decision logic. 

Requirement: All price flags are set to 0. For more information, see Examples of price 

calculation using decision logics (page 525). 

You can use this flag in the item master of the finished product to determine that you want to 

calculate the price using VARIANTS. 

Please note: If you also want to access agreed prices, you need to save them with the price 

flag in the item master. You can set the flags in the order if you want to calculate the agreed 

price and you can delete them when you want to determine the price using VARIANTS. 

 You can save price tables as VARIANTS tables. To do this, you must use the TABLE: or 

TABSEARCH: statement in the decision logic to calculate the price (see also DL - General 
statements (see "General statements in decision logics" page 552)). 

 You can also calculate the price in Infor COM using order costing. 

 You can combine the described price calculation methods to calculate the price. 
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You can calculate the price using VARIANTS while you are still in the quote phase before an order 

structure has been created for manufacturing. 

 The unit price is calculated per feature sheet by referring to tables or by calculation. 

A decision logic that is specified in the standard sheet when the feature sheets are defined 

forms the basis for the price calculation. 

 Once all feature sheets have been populated, you can calculate thetotal price by selecting 

Functions > Close. 

This function automatically runs the decision logic with the same name as the category. 

The total price is determined before an order is generated. When you save the features in 

VARIANTS, the calculated price is transferred to the sales order. 

The price is then displayed in the sales order once you save it. 
 

Calculate order in VARIANTS 

To access the Calculate order function in the sales order, open the Functions menu, select  

VARIANTS, and then Calculate order. You can access this function in the Features view by 

selecting Functions and Calculate order. 

The Calculate order function allows you to total all rows in a sales order. 
 

Examples of price calculation using decision logics 

In order for a price to be calculated in VARIANTS, the price flag of the finished product must first 

be set to 0. There are two ways to do this: 

 A price flag of 0  in the item master (Sales tab) is useful if you intend to always use 

VARIANTS to calculate the sales price for the item. 

 On the other hand, set the price flag in a sales order to 0 (Discount groups tab) if, as a rule, 

you do not want to use VARIANTS to calculate the sales price of the item. 

Alternatively, you can determine the price as follows: 

Calculate the base price in Infor COM and the mark-ups using a VARIANTS summation logic. 

Example: To calculate the price for a drilled bar product configuration, you must create the 

decision logic below. This decision logic accesses a stored table. 
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* Price calculation for Flatmaterial 

* Test: "ON". 

TABLE: "Flmat_Price". 

Material price = (Length * Length_Pr) + (Width * Width_Pr) + (Thickness * Thickness_Pr). 

 

Explanation: The TABLE: command searches the Flmat_Price table for key features (variables for 

which, for example, the feature types Key or To key are entered in the standard sheet). 

The length, width, and thickness variables are not stored in the Flmat_Price table but are 

transferred to the sales order by the feature entry process. 

For more detailed information on the syntax used in decision logics, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

In addition to calculating the price, you can also perform other calculations using the TABLE: 

command. For example, you can also determine the drilling price in the decision logic: 

Example: If the diameter of the drilled hole is >= 10 mm, a pilot hole must be drilled. USD 5.00 is 

charged per drilled hole. 

If the diameter of the drilled hole is < 10 mm, a pilot hole is not required. In this case, USD 3.00 is 

charged for each drilled hole. For more information, see the following decision logic: 

* Price calculation for Flatmaterial 

* TEST: "ON". 

IF: Diameter >= 10. 

     THEN: Drilling price = 5.00 * No_Holes. 

END 

THEN: Diameter < 10. 

      THEN: Drilling price = 3.00 * No_Holes. 

END. 

TABLE: "Flmat_Price". 

Material price = (Length * Length_Pr) + (Width * Width_Pr) 

+ (Thickness * Thickness_Pr). 

Total price = Drilling price + Material price. 

 

Explanation: The Diameter, Drilling price, and No_Holes variables in the sales order are 

transferred by the feature entry process. The material price is calculated in the same way as in the 

previous example. 

When the total price is calculated, only the two calculated prices are added together. 
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Infor COM VARIANTS communication 

The following field names are transferred from Infor COM to VARIANTS generation and can be 

modified from within VARIANTS. 

Field name Meaning 

$SAext Record type (external) 

$ME Unit of measure 

$Menge Quantity for sales order line 

The $KTxt (description) text field is represented by two variables in VARIANTS:  $KTxt1 and 

$KTxt2. 

The $KTxt field has 42 characters. The $KTxt1 and $KTxt2 fields have 20 characters. 

$KTxt1 and $KTxt2 are automatically combined when they are transferred. 

Note: The COMMON.CAP.VPPSFELDER=0 setting specifies the length that variables should have in 

VARIANTS. 

 When data is transferred from Infor COM fields to VARIANTS, this entry has the following effect: 

If it is set to 0, up to 30 characters can be used for variables in VARIANTS. A field containing more 

than 30 characters is divided into two VARIANTS variables. The first of the two variables will 

contain the first 30 characters. If the setting is 1, variables can contain a maximum of 45 

characters. 

Example: If an item description in VARIANTS is 42 characters in length, the KTxt field in 

VARIANTS will be written to the two $KTxt1 and $KTxt2 VARIANTS variables. KTxt1 will contain 

30 characters in this case. 

The transfer of field contents is defined in the CAPPRG configuration and in the Infor COM 

Management Console configuration. 

Please note: You must close and restart VARIANTS to save changes to the configuration. 

In order for the changes to the CAPPRG configuration to take effect, it is not absolutely necessary 

to restart VARIANTS. Only the CAPPRG.CAP_INT and CAPPRG.CAP_GEN sections are read 

again when VARIANTS is restarted next (but also if a decision logic is interrupted by the user or if 

an error occurs). 



528 | Infor COM 7.5 User Guide 

 

Design 

 

 
 

Restrictions when working with VARIANTS 

The following table contains a number of restrictions that you should bear in mind when using 

VARIANTS. 
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Feature sheets 

Length of feature sheet names 19 

Length of field names = Variable names 17 

Maximum number of features per form 120 

Number of characters for features 
1.200 

Tables 

Length of table names 17 

Length of column names 17 

Maximum number of columns 120 

Maximum number of characters for values (minus 

number of columns) 

860 

Decision logic 

Length of decision logic names 19 

Maximum number of simultaneous variables 2.500 

Length of field names = Variable names 17 

Text length for CONTINUE: labels 45 

Length of variable content (text) 45 

Length of field content in Infor COM fields 30/45 

Number of characters per row 127 

Number of characters for text issued with MESSAGE: 

and MTEXT: 

127 

TEXT: Number of characters per assignment 256 

Number of characters for TEXT: and other assignments 

with TEXT: + 

64 kB 

Depth of nesting for brackets and CALCULATE: calls 16 

Characteristics list 
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Length of field names = Variable names 17 

Maximum length of all properties 860/430 (SQL Server) 

Maximum number of search results 2.500 

Maximum number of properties 120 

 

Combo boxes 

Maximum number of entries (minus number of existing 

variables) 

Approx. 2,500 
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Allocation tables (VARIANTS) 

When you work with VARIANTS, the following allocation tables are used: 
 

CAPDLOGIC 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Decision logic classes 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table contains events that start decision logics and Lj4 functions within 

VARIANTS, such as Change, Enter, Exit, and so on. 
 

CAPDLUSAGE 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Decision logic usages 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table populates the Type field in the Where-used list form for decision 

logics. 
 

CAPFILETYPE 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Graphic file types for VARIANTS 

Type: The user is not allowed to modify this allocation table. 
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Usage: This allocation table stores file types for incorporating graphics into feature sheets. 
 

CAPLABELS 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Linking form objects to descriptions 

Type: The user is not allowed to modify this allocation table. 

Usage: Links between various form objects in the feature sheets are stored in this allocation 

table. 

Example: A label can be attached to a particular text box. 
 

CAPMAPFIELD 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Database field assignment for combo boxes in VARIANTS 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table is used to maintain dependent fields, for example, fields for 

context-sensitive combo boxes. The content of one combo box can depend on the content of 

another. 
 

CAPMBTYP 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Feature sheet types 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table is used to store feature sheet types for VARIANTS. 
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CAPTYPE 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Field types for VARIANTS 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table stores field types for VARIANTS. 
 

CAPZTYPE 

For an overview of allocation tables used in VARIANTS, click here (see "Allocation tables 

(VARIANTS)" page 531). 

Description: Field access types for VARIANTS 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table is used to store the feature definitions for VARIANTS, such as 

optional field, mandatory field, key, and so on. 
 

Categories, subcategories, and characteristics 

Use categories, subcategories, and characteristics to build a hierarchical system for classifying 

items. For more information on this topic, see Using VARIANTS (see "Use VARIANTS" page 511). 

Category 

The first level is the category. You can assign the required category to a product configuration item 

in the Category field on the Planning tab. 

Example: Standard items category. 
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Subcategories 

Subcategories (second level) are assigned to the category. You can assign one or more 

subcategories to each category. 

Example 1: Standard items category, Screws subcategory. 

Example 2: Raw materials category, Color, Paper subcategories. 

You can assign subcategories to a category on the Subcategories tab in Category maintenance. 

Subcategory characteristics 

Characteristics (page 536) (third level) are assigned to a subcategory. Characteristics describe a 

specific resource. 

Examples: Type and Thread strength characteristics for the Screws subcategory of the Standard 

items category. 

You can enter characteristics both for subcategories and for items. 

Feature sheet 

Characteristics are assigned to the subcategory using the feature sheet (see "Feature sheets" 

page 541) which is stored for the subcategory. You can display the available categories in 

VARIANTS by selecting Design and then Categories. In the Category field, enter % and click OK 

to confirm. 

Example: The Screws feature sheet is entered for the Standard items category and the Screws 

subcategory. 

Item characteristics 

You can assign characteristics to the item in the item master on the Characteristics tab. Use 

Functions and Assign characteristics to assign a(nother) category or another feature sheet to the 

item. 
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Order features 

Order features (page 539) are entered in the sales order. They characterize the actual product 

configuration of the item that the customer wants. See Create sales order with product 

configuration item. 

 

Note: To import or export categories/subcategories in VARIANTS, select Functions and Import 

data/Export data. 

When you do this, the category that is currently loaded within Category maintenance is exported. 

For general information on this subject, see Import/export VARIANTS structures (page 522). 
 

Maintain categories and subcategories 

Click here (see "Categories, subcategories, and characteristics" page 533) for information on 

categories and subcategories. In the following example you will see how these objects are 

maintained. 

1. In Design, open the VARIANTS folder and select Categories. In the Categories field, select 

Standard items and confirm by clicking OK. 

2. The subcategories belonging to the category are displayed on the Subcategories tab. 

The following table shows the Screws subcategory for the Standard items category. 

Subcategory Description ID Feature sheet Type 

SCREWS Screws 0 Screws 0 

Enter autotext for a subcategory using View and Notes. The ID assigned to the autotext by 

the system is displayed on the Drawing tab. On this tab, select Edit and Insert object to 

store a graphic or an OLE object for the subcategory. 

3. From the Go to menu, select IDM to go to the feature sheet definition for the current 

subcategory. 

For more details on how to proceed, see Draft feature sheets (see "Edit feature sheets" page 

542). 
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Characteristics 

Characteristics are the lowest level in the system for classifying items in VARIANTS - see 

Categories, subcategories, and characteristics (page 533). 

When you assign characteristics to an item, you can use the characteristics list search (see 

"Search characteristics list" page 538) at a later stage to select an item according to specific 

features. 

The characteristics are stored in the item master. For information on how to assign characteristics 

to an item, see Enter characteristics (page 536). 

Please note: A distinction is made between characteristics and order features (page 539), which 

are stored with an order. 

Note: In Data maintenance, you can output the characteristics to the relation using the SELECT * 

FROM relsml command. 
 

Enter characteristics 

This Help topic describes how characteristics are maintained in the item master. 

1. Open item 102-0010 in Design via the Item object and switch to the Characteristics tab using 

the View menu command. 

The following table shows an extract of the stored characteristics – the description of the 

subcategory is on the top left of the tab. 
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Type Socket head 

Thread M10 

Strength 8,8 

Standard (DIN/ISO) 912 

Length 50 

2. In most cases, you can select Assign characteristics from the Functions menu to assign 

multiple categories to an item. In our example, the Standard items category with the Screws 

subcategory was assigned to the item. The current category is displayed in the Characteristics 

field in the item header. You can also select a different category here, whose features will then 

be displayed on the Characteristics tab. If you entered decision logics or Lj4 procedures when 

defining the feature sheets, these are run when the feature sheets are switched. 

3. You can also assign Descriptive features to the item by selecting Functions and Assign 

characteristics. In the following dialog box, you can only select from the 

categories/subcategories whose feature sheets have the Type 4 (see the Help topic for the 

Subcategories tab). 

The following table provides an example. 

Subcategory Description ID Feature sheet Type 

T_CL_D_1 CL descriptions 0 T_CL_Desc. 4 

T_CL_D_2 CL description 2 0 T_CL_Desc_2 4 

The table indicates the subcategories that have been created in VARIANTS in the Design 

module using the Categories object for the T_Rawmt category. The feature sheets of these 

subcategories are Type 4. They are available when you select the Descriptive features tab 

in the item and when you select Assign characteristics from the Functions menu. 
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Search characteristics list 

Call 

 Sales order: Go to > Search in characteristics lists 

 Design > Items: Open tab > Find CL 

Description 

The term characteristics list in Infor COM refers to a list of characteristics for a category or 

subcategory. You can enter the characteristics for a resource, such as an item, on the 

Characteristics tab in the item's master data. You can use the characteristics entered on this tab 

for the characteristics list search. 

Example: The following screenshot shows an example of a characteristics list: 

Subcategories Description ID Feature sheet Type 

SCREWS SCREWS 0 Screws 0 

In this example, the Basic material, Thickness, and Width characteristics were defined for the 

characteristics list using the Flatmaterial feature sheet. 

In practice 

If you have assigned characteristics to a resource on the Characteristics tab, you can use these 

features in a characteristics list search and quickly find the items that you want to insert into an 

order or a BOR, for example. 

 
 

Use characteristics list search 

For general information about characteristics in VARIANTS, see Characteristics (page 536). 

For general information on the characteristics list search, see Search in characteristics lists (see 

"Search characteristics list" page 538). This Help topic illustrates how to proceed when searching 

a characteristics list, using a sales order as an example. 
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1. Open the sales order. 

2. From the Go to menu, select Search in characteristics lists. 

3. In the dialog box that opens, select a category and subcategory from their respective combo 

boxes and click OK. 

4. The Search values and Search results windows are now displayed. Enter the search values in 

the Search values window and select Functions > Find. 

As of the second feature, the search is limited; in other words, the selection is already limited 

based on the first entries. This means you cannot enter any property combinations that do not 

exist. 

5. Highlight the required item ID in the Search results window and select Functions > Accept. The 

resource is added to the BOR at the current cursor location. 

The Search results window contains both the Features and Master data tabs. 
 

Order features 

While characteristics (page 536) describe a particular resource, order features describe the 

product configuration of a finished product - see Knowledge-based product configuration 

generation (page 510). Order features define the particular properties of the product configuration 

item for a specific sales order. 

To enter order features in a sales order for a selected line, open the View menu and select 

Features. Use the feature sheet that is displayed to enter the order features for the product 

configuration order. 

Note: In Data maintenance, you can output the characteristics to the relation using the  

SELECT * FROM relsmau command. 
 

Enter order features 

See Characteristics (page 536) and Order features (page 539) for information on the differences 

between these two terms. 

You can maintain order features in quotes, sales orders and costings using the Features tab or by 

selecting from the Features, Feature overview, or Feature selection view. 
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Features tab 

The table shows the resource ID and short description of the sales order as well as the customer 

ID and customer description (this line can also contain features). 

See the following example. The data displayed below changes according to the line selected in 

this table. 

Resource Short description 

1750 Marvin Manufacturing Inc. 

FURN-CABINET Cabinet with 3 units 

The actual feature sheet is displayed in the form section underneath the table. It is always updated when you 

change order lines or subcategories. 

Features view 

If the input area on the Features tab is too small for the feature sheet, select View > Features to 

open a new form with more space for displaying the features. 

Feature overview view 

To navigate within feature sheets and to maintain features, you can use the Feature overview 

view. The Sequence tab from this view is available for faster entry in the Features view. 

The 'Feature overview' view shows the current status of feature entry - that is, the structure and 

sequence of the feature sheets generated to form the product configuration for the current time. In 

this view, you can also position the cursor within the structure, meaning that you can for example 

hop directly from the first to the last feature sheet. 
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Feature selection view 

This view allows you to use command buttons to select feature sheets and insert new feature 

sheets into the existing structure. 

If you click on a global feature sheet, it is displayed in feature maintenance. Selecting a local sheet 

incorporates the new sheet in the structure following the current line in the subcategory table. 

Note: The Features view offers the same functionality, which allows you to work faster without 

switching the view. 

You can view the structure in Feature overview. 
 

Feature sheets 

Description 

Feature sheets provide the input form for selecting characteristics (page 536) and order features 

(page 539). 

When you create or open a category, you will see the Feature sheet on the Subcategories. To edit 

the feature sheet entered in this field, select Go to from the category and click IDM. 

In practice 

The Infor COM Dialog Manager is the integrated development environment for VARIANTS. All 

objects required in VARIANTS are created and modified using the Infor COM Dialog Manager. 

You can define feature sheets in a special draft mode in the Infor COM Dialog Manager. The 

feature sheet you select in a subcategory is automatically opened in graphic mode. You can use 

the functions in the toolbar to add or edit form elements. This toolbar provides the following 

functions for designing feature sheets: 
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From top to bottom: 

 

Check box 

Child form 

Combo box 

Command button 

Label 

Picture box 

Text box 

Left-click the required toolbar element and then click the feature sheet. The element will be added 

to the form. You can use the arrow tool to change the size of the inserted element by dragging the 

square dots that surround the element. 

Right-click the element to control the predefined properties of the element in a shortcut menu. 

Each element has its own properties. 
 

Edit feature sheets 

This Help topic describes feature sheet (see "Feature sheets" page 541) design. We are assuming 

that you are going from a subcategory to feature sheet maintenance. See Maintain categories and 

subcategories (page 535). 

1. Select Design > VARIANTS > Categories and open a category - make a selection on the Open 

tab and click Load. 

On the Subcategory tab, the feature sheet is stored in the field of the same name. 

2. Select Go to > IDM. 

When you go to the Infor COM Dialog Manager from an active subcategory, you open draft 

mode to edit the feature sheet that is stored for the active subcategory. 

3. Edit this feature sheet and its individual elements either using the toolbar or by right-clicking 

the feature sheet to open the property dialog box. For more information on the corresponding 

settings, see the topics for the properties of the corresponding object, for example Combo box. 

Note: If you change the structure of a feature sheet, that is, if you add or delete features, or 

change their length or type, you should reorganize (see "Reorganize feature data" page 543) the 

data when saving. 
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Reorganize feature data 

When saving feature sheets (page 541) in the Infor COM Dialog Manager, you can reorganize 

characteristics data (relSML), order feature data (relSMAU), and table data (relTABZ). You will 

need to do this if you change the structure of a feature sheet, i.e., if you add or delete features or 

change their length or type. 

Reorganization ensures that the format of the feature properties stored in the tables for the 

specified objects matches the form structure of the feature sheet. This is the only way to ensure 

they are properly displayed and edited. 

When a feature sheet is saved in the Infor COM Dialog Manager, the system checks whether 

reorganization is necessary. You can suppress this check using the COMMON.CAPNT.DOREORG 

switch. 

The following actions are verified when reorganizing feature data: 

 Adding of features 

 Deletion of features 

 Changes to feature types (conversion of alphanumeric to numeric values and vice versa) 

 Changes to feature lengths 

Note: Reorganization does not check feature names that have been changed. 
 

Improve runtime performance 

When using features (see "Characteristics" page 536, "Order features" page 539) in VARIANTS, 

note that dependencies regularly occur between features, particularly where combo boxes whose 

valid entries are determined using decision logics or Lj4 are concerned. 

Updating dependent features – whose selection list and valid content depends directly on other 

features – can be a very time-consuming process in certain situations. 

 Editing individual feature sheets 

 Exiting individual features 

 Accessing combo boxes 

 Switching between feature sheets 

 Closing feature entry 

Note: As a critical limit for an acceptable runtime, around 8-10 features can be considered per 

feature sheet. 
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For information on maintaining feature sheets, see Maintain categories and subcategories (page 

535) and Draft feature sheets (see "Edit feature sheets" page 542). 

There are a number of ways to improve runtime performance: 

 Define leading features: To define that this object is a leading feature, open the Layout tab 

and, from the Dependency form section, select the Leading check box. 

 Define dependent features: To define an object as a dependent feature, i.e. that the content of 

the feature can depend directly on the content of other features, open the Layout tab and in 

the Dependency form section, select the Dependent check box. 

Please note: For this function to work, the following setting is necessary: 

DependingFeatures=yes. 
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Decision logics 

Call 

Design > VARIANTS > Decision logics 

Description 

A decision logic stores rules that define decisions in terms of product configurations to be 

manufactured. A rule contains conditions that must be met for certain actions to be carried out. 

The unique thing about VARIANTS is that you can prepare and cost any product configuration 

without having to store it as a resource in the master data. This is possible using bases and 

decision logics. 

A base contains the basic structure (BOR) of an item to be manufactured, while the decision logic 

decides which product configuration of a component of this BOR will be used for the order in 

question. 

Example: The following screenshot shows an extract from the Texts/structure tab for the Plate 

BOR for the Paper plate item. 

Str. SVO Ln ID Resource 

1 OP  Painting 

1 MA  Color 

1 OP  Punching 

1 MA  Paper 

 

Note that the work centers are not described exactly and the paint and paper materials are not 

defined. This is carried out by the decision logic in the actual order. 
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You can assign decision rules to base resources (works centers plus paint and paper materials in 

our example) that define the product configurations that you want to manufacture if an order is 

issued. You store these decision logics in the Decision logic field on the Item ID tab of the BOR for 

each required line. 

The decision logics stored here contain the rules that determine which product configurations are 

manufactured for a sales order, for example, and which resources are used for manufacturing. In 

our example, the decision logics determine which work centers are used to cut the paper and to 

paint the plates. 

This principle is illustrated in following extract from the Paint decision logic: 

 

 

IF: Decor = "without" ! "natural". 

  THEN: $SAext = "". 

  LOGEND. 

END. 

$KTxt1 = "Paint a color: ". 

$KTxt2 = Decor. 

$MNr   = "Paint". 

 

 

These statements have the following effects: If the customer orders plates with the decor types 

Without or Natural, the Painting work center is removed. Otherwise the Description field contains 

the text Paint red for the color Red and the Resource field contains the description Paint. 

Note: Decision logics require a particular syntax. For an overview of this topic, see Statements 

and operators in decision logics (page 551). 

Structure 

The following screenshot illustrates the structure of decision logics: 
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Decision logic 

Rule1 

IF: Condition 

THEN: Action 

Rule2 

IF: Condition 

THEN: Action 

Rule3 

ELSE: Action 

 

Log 

You can use the COMMON.CAP.DEBUGLOG=yes entry to log debugger messages in an ASCII 

file  (.\LOG\Capi010.txt). 

Functions 

Test: To test a decision logic, you need to open it first. Once open, select Functions and Test. The 

decision logic interpreter (page 549) is called. 

Note: If the TEST: "On" statement is commented out by means of a * symbol, testing will not be 

possible. In this case, delete the * symbol and save the decision logic again. 

Where-used list: This function allows the usage data for the currently loaded decision logic to be 

displayed, printed, and exported to Excel. See also Decision logic usage (page 596). 

Examples 

Examples of conditions: 
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 Feature properties that must be met (such as paper thickness when manufacturing paper 

plates) 

 Values (such as length of raw material) 

 Intermediate results 

Examples of actions: 

 Calculating values and intermediate values 

 Determining values from tables (such as extracting prices from a price table) 

 Determining items using characteristics lists 

 Determining work centers 

 Populating data fields in orders 

 Calling other decision logics 

 Error results 
 

Assign decision logics 

The assignment type of a decision logic (see "Decision logics" page 545) determines the time the 

calculation is called. You can select from the following options: 

BOR header 

Enter the decision logic in the Decision logic name field in the BOR header. 

Any decision logic you enter here is run when data is transferred from the sales order to a 

production order. 

Example: Enter a decision logic in this field if a description for a base product in the sales order 

that was modified by a summation logic is to be transferred to a production order when it is being 

created. For more information, see the Configuration Help. 

 

Feature sheet 

Link the decision logic to a feature via an entry in the feature sheet.  

This product configuration is described in the Decision logic section of the Combo box Help topic. 

The decision logic is run for this product configuration once you have entered the features in the 

sales order using the Go to and Features commands. 
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Line (Material, Operation) 

Link the decision logic to a line (material or operation). 

Enter the decision logic on the Item ID tab in the BOR. To run the decision logic when opening 

product configuration generation in the sales order, select Functions and Generate product 

configuration order. 

Category 

Link the decision logic to a category/subcategory using the entry in the Category table for the 

finished product category. Any decision logic stored here is run when (for example, in an order) 

you open the Features view for the first time. The decision logic can be used for initializations. 

Decision logic 

Link the decision logic to another decision logic by entering a statement in the decision logic. 

There are two ways to do this: 

 Enter the DLOGIC:Name statement if you want to go to the other decision logic. 

 Enter the CALCULATE:Name statement if you want to run another decision logic and then 

return to the original decision logic. 
 

Decision Logic Interpreter 

The decision logic interpreter is essential for testing decision logics (page 545). To activate it, 

select Functions and then Test in the opened decision logic. 

You can choose from the following options when testing a decision logic. 

Test in the VARIANTS process 

1. In the decision logic, insert the keyword  

TEST: "On" one row above the section you would like to test. 

2. In Infor COM, start the action that you want to address with the decision logic, for example 

Close or Planning. 

3. The decision logic runs as usual until it reaches the row containing  TEST: "On". 
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4. The decision logic interpreter window opens from here. 

Structure: 

The decision logic interpreter dialog window is structured as follows: 

 Name of the decision logic and current row number (first row) 

 The last four rows of the decision logic that has just been processed. 

One or more "#" symbols are displayed below those four rows. This indicates the current 

position in the decision logic. 

 Comments for the action that was just carried out 

The button bar contains the buttons described below. You can also use the debugger via 

the specified function keys. 

Continue Continue to next step. 

Statement Skips the current statement and runs the decision logic until the next period. 

End of log Runs the decision logic through to the end (switch off single-step function). 

DebugEnd The DebugEnd button quits the debugger. 

Variables Allows you to view the contents of the variables. (see below). You can switch between 

the debugger and the variables window using the F11 function key. 

Cancel Cancels the decision logic. 

Restart Restarts the decision logic from the beginning. 

Edit Allows you to edit the current statement in single-line mode. You can change the 

edited line here. Press Return to save the modified line to the database. Press 

Restart to restart the modified decision logic. 

Variables After you select the variables, the system opens up a new window containing the 

contents of all known variables. If you would like to modify a value to influence the 

remainder of the program, select the variable and press Return. You can now 

change the value and the program can continue with the new variable. 

Test in VARIANTS 

1. Load the decision logic that you want to test. 

2. In the Decision logic menu, select Functions and then Test with Debug. 

Note: 

 If the decision logic works with variables that are defined outside of the decision logic (for 

example, in the feature sheet or another decision logic), you must enter the corresponding 

variables and test values directly in the decision logic. 

 You must delete these variables with test values after the test is complete or insert a * as 

the first character in the line to switch them off. 
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 When testing directly in VARIANTS, you do not need to switch on the TEST: keyword. 
 

Statements and operators in decision logics 

Decision logics (page 545) require a precisely defined syntax with regard to the statements and 

operators used in them. In addition, the use of comments and the processing sequence are also 

significant. This Help topic will give you a general overview of the conventions that must be 

observed in VARIANTS. 

Comments 

To insert comments in logics, enter "*" in the first field in the row. This allows you to add a title or 

the purpose of the decision logic at the beginning of statements. Use */ to add comments to the 

end of statements. 

Sequence 

The decision logic you enter is processed from left to right. Multiplication and division do not have 

priority over addition and subtraction. You must use brackets to group arithmetic operations that 

belong together. A maximum of 15 levels are permitted. 

Permissible fields 

 Descriptions of features from feature sheets are permitted. If you want to use a feature field in 

a decision logic, enter the field name in the decision logic. This is the name of the Feature 

column, not the short description.  

You can use field names in calculations, value assignments, comparisons, and so on. 

 Database fields used by Infor COM are also permitted. You can populate these fields using a 

decision logic. 

Examples: 

 Descriptions for printing working papers 

 Resource IDs (machine allocation) 

 STi and RTi fields when calculating times (see Time calculation) 
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Agreements 

 The TEST: "On". statement should generally be in place at the start of a decision logic. This 

statement is flagged as a comment with an asterisk (*) if you only perform decision logic tests 

in the active decision logic from the Functions menu using the Test with Debug command. If 

you want to test whether the decision logic works in a sales order (to check, for example, that 

the variables have been assigned properly), delete the asterisk and re-save the decision logic. 

Test mode will be enabled when the decision logic or sales order is opened, and you can verify 

the integrity of each statement. 

 Field names are not case-sensitive. Special characters are also permitted. 

 Each statement (such as IF:) ends with a colon (:). 

Statements must be closed with a period (.) at the end of the line except in the case of =! and 

=? (question marks and exclamation marks already include a period). 

 If a row contains more than one statement, you must insert a space after every period. 

 Close every keyword with a colon (:) except END. and LOGEND. 

 If the first expression of an IF: statement is correct and is followed by OR:, other expressions 

are not evaluated. 

 When the IF keyword is used, brackets are not taken into account. 

 The names of decision logics in the BOR must not overlap with table names. 

 

The following links will also help to explain statements in decision logics. 

General statements (see "General statements in decision logics" page 552) 

Feature names (see "Features and field names in decision logics" page 581) 

Comparison operators (see "Comparison operators in decision logics" page 582) 

Mathematical operators (see "Mathematical operators in decision logics" page 585) 

Mathematical functions (see "Mathematical operators in decision logics" page 585) 

Alphanumeric operators (see "Alphanumeric operators in decision logics" page 587) 

Formatting (see "Format decision logics" page 589) 

System variables (see "System variables in decision logics" page 591) 

Keywords (see "Keywords in decision logics" page 595) 
 

General statements in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 
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The VARIANTS component provides a range of statements for different areas of application in 

decision logics. 

Statement syntax 

<Command> <Field name/literal>. 

You can enter field names or strings (literals) after a command. Please note that you must always 

enter a period (".") at the end of a statement. 
 

QUIT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

QUIT: "FileName". 

This statement closes an open file. 
 

FILEATTR 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

FILEATTR: FileName ([FilePath]) attribute 

This statement changes the file attributes. Parameters can be alphanumeric variables or strings. 

N resets all file attributes, S makes all file attributes write-protected, and V hides the file. 

Example: 

FileName = "Test.txt". 
FilePath = $Temp + "\\". 

 

FILEATTR: FileName (FilePath) "N". */ reset all attributes 
FILEATTR: FileName (FilePath) "S". */ write-protected 
FILEATTR: FileName (FilePath) "V". */ hidden 
FILEATTR: FileName (FilePath) "N". */ reset all attributes. 
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DBEXIT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

DBEXIT: 

This statement releases the database transaction. If DBEXIT: is not set or not reached, all 

statements to the database since the last DBINIT: statement are discarded. 
 

DBINIT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

DBINIT: 

This statement initiates the database transaction. 
 

DLOGIC 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

DLOGIC: "Name". 

The statement is continued in another decision logic. No result is returned. 

In the example: For all diameters greater than 30 mm, the system exits the current decision logic 

and runs the PreDrill decision logic. The decision logic name can also be a variable. 

Example 

IF: Diameter > 30. 
   THEN: DLOGIC: "PreDrill". 
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EMAIL 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

EMAIL: [("TCPIPAddress or Servername")] "Recipient" "Reference" ([Path Name])["ND"]. 

Recipient indicates the recipient e-mail address. Ref. indicates the reference line in the e-mail. 

[Path] and [Name] can be omitted. MS Outlook must be installed for you to use this command. The 

system automatically recognizes the MAPI driver, but the mapi32.dll file must be in the system 

path. 

If the message is to be sent directly in the network, the addresses can be input directly as a 

TCP/IP address or server name  - an attachment is not required in this case.The e-mail is sent 

directly (without using MS Outlook). 

Text created with the TEXT: statement is transferred to MS Outlook. 

The [ND] parameter suppresses the dialog box and immediately places the e-mail in the outbox. 

Example: 

EMAIL: ("194.25.134.96") "ABI.Filderstadt@t-online.de" Reference (). 

 
 

EXECUTE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

EXECUTE: "Word.doc" ["C:/Path/"] [(Parameter1 Parameter2)]. 

The file is started using the program stored for this file extension in the operating system (for 

example *.doc = MS Word). 

The maximum length of a parameter list is 20 characters. Use "+" to add longer parameters. 

Example: 
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Filename = "Text.txt". 
Filepath = $Temp + "\\". 

 

EXPORT: Filename (Filepath). 
TEXT: "Sample file". TRANSFER: Filename. 
QUIT: Filename. 
EXECUTE: Filename Filepath. 

 
 

EXPORT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

EXPORT: "Filename.TXT" ("C:\TEMP\"). 

EXPORT: "Filename.TXT" ("C:\TEMP\" "+"). 

The file C:\TEMP\Filename.TXT is opened for write access. Any existing data is overwritten. Add a 

+ to the statement to attach records to an existing file. 
 

ERROR 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

ERROR: "Text". 

Text is an error message with up to 127 characters. This statement cancels processing and 

returns the error message Text. 

Example: 

IF: Length > 6000. 
   THEN: ERROR: "Length must be less than or equal to 6000". 
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QUESTION 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

QUESTION: "Text". 

Enter a field name or literal with a maximum length of 127 characters. This statement stops 

processing and outputs the text. You can type Yes or No at the prompt: Yes -> $Fehler = "", 

otherwise $Fehler = F 
 

GETINI 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

GETINI: "Section" "Filename" ("Entry"). 

The configuration is searched for the Section section, which is then searched for the Entry entry. If 

the entry exists, it is interpreted as a variable. If it is not found, the $Fehler = system variable is set 

to "F". 

The filename can be a variable or a string, for example Ini\User. 

Example: 

GETINI: "USER" ("Name"). 
Name = ? "ABI" 

 
 

UPPER/LOWER 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

UPPER/LOWER (format text) 

The LOWER: and UPPER: functions convert a string from upper to lower case and vice versa. The 

following example shows the syntax. 
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Example: 

A = "LOWER1". 

B = "upper2". 

X = LOWER:A + UPPER:B. 

X =? "lower1UPPER2" 

 
 

IDX 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

IDX: "String" ("Search string"). 

This statement determines the position of one or more characters in a string. 

Example:  

String = "abcdefgh". 

X = IDX: String("c"). 

X=?    3.000000 

"c" was found in the third position. 

 
 

YMD 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

YMD:DDMM YYYY. 

This statement converts the date to the format YYYYMMDD. 

Date must be an alphanumeric or numeric variable. The format can vary (see example). Day can 

contain one or two digits, Month must always contain two digits, and year can contain two or four 

digits. 

Note: The result is always a string. 

Example: 
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* Name of the decision logic: "YMD" 
TEST: "On". 
Date = 0. 
DDMMYY = "11.12.33". 
Date = YMD: DDMMYY. 
Date =? "33.12.11"  

 

DDMMYY = "11.22.3333". 
Date = YMD: DDMMYY. 
Date =? "3333.22.11"  

 

DDMMYY = 12233. 
Date = YMD: DDMMYY. 
Date =? "332201"  

 

DDMMYY = 112233. 
Date = YMD: DDMMYY. 
Date =? "332211"  

 

DDMMYY = "11223333". 
Date = YMD: DDMMYY. 
Date =? "33332211" 

 
 

COPY 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

COPY: "Source.TXT" "Target.TXT" ("C:\SourcePath\") ("C:\TargetPath\"). 

This statement copies C:\SourcePath\Source.TXT as C:\TargetPath\Target.txt 
 

READ 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

CL properties are extracted to the clipboard and can then be copied using the DUP: statement; 

however, they do not appear in the variables list. 
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If the CL properties are to appear in the variables list, this can be achieved using the CLGET: 

statement. You can also use the READ: statement to extract the individual columns in the CL 

relation as variables. The name of the relation is added as a prefix. 

Example:  

TEST: "On". 

READ: "102-0010" SML(NbName). */ Name of the standard sheet as a SML_NbName variable 

=? "Screws" 

 
 

LEFT/RIGHT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

LEFT/RIGHT (replace text) 

Use this statement to replace text. Syntax: 

X = variable("string to replace" "replacing string"). 

Note the space between the expressions in brackets and the placement of each expression in 

quotation marks. 

The bracket must follow the alphanumeric variable directly without a space. You can replace 

individual characters or entire words. If you want to replace several single characters, you must 

repeat the statement accordingly. 

WARNING: A distinction is made between upper and lower case. 

Examples: 

A = "100,20". 

X = A("," "."). 

X =? "100.20" 

 

B = "100Left20". 

X = B("Left" "Right"). 

X =? "100Right20" 
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LJ4 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

LJ4: "Programname" ([Parameter1] [Parameter2]...). 

This statement opens an Lj4 program with parameters. If a parameter is defined without the prefix 

ByVal, it will be returned as a variable. The Lj4 program returns a $Fehler = "" if the program 

name is True, otherwise $Fehler = "F". 

 

Example: The following example extracts the available inventory of a resource. 

*AvStock = 0. 

$MNr = "F602-0013". 

LJ4: "CAP.AvailabilityResource" ($MNr AvStock). 

AvStock =? 123.000000 

 
 

LNG 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

LNG: 

This statement returns the length of the string as a number. 

Example: 

A = "String". 

N = LNG: A. 

N = 12. 

Note: The target variable is converted to numeric format if required. 
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DELETE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

DELETE: "Filename.txt" [("C:/TEMP/")]. 

This statement deletes the file C:\TEMP\Filename.txt. 
 

DELVAR 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

DELVAR: Variable1 Variable2 Var_*. 

This statement deletes variables 1 and 2, together with all variables that begin with Var_ . 
 

LOGEND 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

LOGEND. 

This statement ends or cancels this decision logic. 
 

MESSAGE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

MESSAGE: "Text". 

This statement issues a message containing up to 127 characters and/or fields. 
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FEATURE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

FEATURE: 

When you open a feature sheet, the cursor is automatically positioned on the first feature of the 

standard sheet, and when you exit a field, it jumps to the next field.  You can use a 

category/subcategory decision logic to position the cursor on any other feature. 

Example:  

IF: Length > 50. THEN: FEATURE: Thickness ("C"). END. 

* If the value in the Length feature is greater than 50, * is located in the Thickness 

field. 

 
 

MTEXT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

MTEXT: "Text". 

This statement issues a message containing up to 127 characters and/or fields. The message 

prompts you to enter data for a field that requests data with =! If you click OK, the entry is 

transferred to the variable and system variable $Fehler = "" is set. If you click Cancel, the entry is 

deleted and the system returns $Fehler = "F". 

Example:  

MTEXT: "Enter the paper type". 

Paper type=! 
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PUTINI 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

PUTINI: "Section" "Filename" ("Entry"). 

The configuration file is searched for the Section section, which is then searched for the Entry 

entry. If the entry exists, it is replaced with the content of the variable. If the section or the entry 

do not exist, they are created accordingly. 

The file name can be a variable or a string, for example Ini\User 

Example:  

Name = ? "ABI". 

PUTINI: "USER" ("Name"). 

 
 

CALCULATE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

CALCULATE: "Name". 

This statement executes another decision logic (DL) and returns to this position. 

In the Example: The PreDrill decision logic is run for all diameters greater than 30 mm. The 

system then returns to the previous logic. Name can also be a variable. 

Example:  

IF: Diameter > 30. 

   THEN: CALCULATE: "PreDrill". 

 
 

CALCULATE + 

This statement is a general statement used in decision logics in VARIANTS. 
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CALCULATE:+ "logic name". 

This statement starts the decision logic with an empty variables list. 

Example: 

* Two global variables 
M1 = 1234567890. 
M2 = "global variable content1". 
M3 = "global  variable content2". 

TEST: "On". 

*Call a sublogic with a local variables list 
CALCULATE:+ "Calculate2". 

* Values of global variables after the sublogic is run 
M1 =? 1234567891.000000 
M2 =? "global variable content1" 
M3 =? "global variable content2" 
M4 =? 

 

* Decision logic "Calculate2" * 
* is called by "Calculate1". 

 

* Local variable 
Value1 = 1. 

 

* Extract variables from the parent variables list 
VARGET: M1 M2 M3. 
M1 =? 1234567891.000000 
M2 =? "" 
M3 =? "" 

 

*Calculations. 
 M1 + Value1. 

 

* Local variables the same as those in the calling program 
M2 = "local variable content". 

 

*local variable 
M4 = "local variable". 

 

*Write variable contents to the parent variables list 
VARPUT: M1 M4. 
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RESTART 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

RESTART: 

You can use this statement to restart the current decision logic without entering the name of the 

logic. 

Example:  

* Name of the logic 

Value := 0. 

IF: Value < 100 THEN: RESTART: END. 

Alternative with decision logic entry: 

IF: Value < 100 THEN: DLOGIC: "NameofLogic". END. 

 
 

RTF_RTF 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

RTF_RTF: Source1 (PathSource1) Source2 [(PathSource2)] Target [(PathTarget)]. 

This statement combines two RTF texts into one. All three file names must be specified.  The 

path for the second source and/or the target path can be omitted; the parameter for PathSource2 

is then used. 

The first file should have an empty line at the end if required, since the second file is attached 

directly at the end. Source2 and/or Target can also be the "{TEXT:}" string. This RTF text can 

then for example be written to a file using TRANSFER: or printed in a document. 

The wildcards in the text are only replaced if the target is "{TEXT:}". 
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RTF_TXT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

RTF_TXT: Source (PathSource) Target [(PathTarget)]. 

This statement expands an RTF text by another (ASCII) text. The path for the target path can be 

omitted; the parameter for PathSource is then used. 

The first file should have an empty line at the end if required, since the second file is attached 

directly at the end. The target can also be the "{TEXT:}" string. This RTF text can then for 

example be written to a file using TRANSFER: or printed in a document. 

The wildcards in the text are only replaced if the target is "{TEXT:}". 
 

SELECT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

SELECT: "Table name". 

The selection in a combo box is read from a table, and the entries are compiled as 

context-sensitive variables from $Sel_1 to approximately $Sel_780. The table column you want to 

use for the selection must be set with Variable name = ? or !. 

 Up to 2 columns can be compiled. The required columns or variables are set with a 

question mark. 

 Tables with From and To keys are not permitted. 

 All subsequent keys in the table are ignored when the first variable is set to a question 

mark. Subsequent keys will be incorporated if you set the variable to an exclamation mark 

(!). 

Example: Values table 

Key Key2 Key3 Column4 

Value1 Value2 Value3 Value4 

If you want to use columns 3 and 4, use the following variables for your search: 
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Key1 = "Value1". Key2 = "Value2". 

Key3 = "?". Column4 = "?". 

SELECT: "Value". ->  $Sel_1 = "Value3=Value4" 

All subsequent keys are ignored when the first variable is set to a question mark. 

Key1 = "Value1". Key2 = "?". 

Key3 = "XXXXX". Column4 = "?". 

SELECT: "Value". ->  $Sel_1 = "Value2=Value4" 

The result is that Key3 should be ignored. Key3 = "*") 

Subsequent keys will be incorporated if you set the variable to an exclamation mark (!) instead of a 

question mark (?). 

Key1 = "Value1". Key2 = "!". 

Key3 = "Value3". Column4   = "?". 

SELECT: "Value". ->  $Sel_1 = "Value2=Value4" 

 

Key1 = "Value1". Key2 = "!". 

Key3 = "XXXXX". Column4   = "?". 

SELECT: "Value". ->  $Fehler = "F". 

 

 
 

SELCL 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

SELCL: 

This statement returns a list of variables to populate the combo box. The list consists of the 

property's contents which were set to ?. 

$MNr can also be set to "?". You can choose from the available resource IDs. If one or more 

properties are set to "*" (= wildcard), the system returns more or fewer hits as $Sel_1 ... $Sel_n. 

Examples: 
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 Basic material = "AL". 

 Thickness = 5. 

 Width = 20. 

 $MNr = "?". 

 

TEST: "On". 

 SELSML: "FLATMATERIAL". 

 

 IF: $Fehler = "". THEN: 

  $Sel_1 =? "F602-0013"  

 END. 

 

* Search for basic materials using wildcard 

 

 Basic material = "*". 

 Thickness = 5. 

 Width = 20. 

 $MNr = "?". 

 

 SELSML: "FLATMATERIAL". 

 

 IF: $Fehler = "". THEN: 

  $Sel_1 =? "F602-0013"  

  $Sel_2 =? "F602-0037"  

  $Sel_3 =? "F602-0061" 

 END. 

 
 

SELVQL 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

SELVQL: Statement name relAlias (Key1 [Key2 ...]) [n] (Field1[,Alias] [Field2...]) 

A combo box can be populated with a VQL statement. See SELECT: 

[n] is the length for Field1 + ”=" + contents of Field2. 

The length of the numeric fields are based on the following: 
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Byte = 2-digit, without decimal places 

Short = 4-digit, without decimal places 

Word = 8-digit, without decimal places 

Real = 8-digit (or 9 with decimal places) 

 

Example: 

*  ExampleSELVQL 

TEST: "On". 

 Ac_MNr = "M%". 

 SELVQL: "USvqlSMGSelMNr"  (DbPart.MNr) 12 

                           (DbPart.MNr DbPart.KTxt). 

 $Sel_1 =? "M-BTMSHELF     =Floor, neutral" 

 $Sel_2 =? "M-BTMSHELF-01  =Brittany floor"  

 $Sel_3 =? "M-BTMSHELF-02  =Oslo floor"  

VQL statement: 

ScriptDataDef VQLStatement USvqlSMGSelMNr 

#{+Comment} 

// Load item ID 

SELECT * 

FROM relAc 

By   relAc 

WHERE DbPart.MNr like :DbPart.MNr 

#{-Comment} 

End // ScriptDataDef VQLStatement USvqlSMGSelMNr 

 

 
 

FEATGET 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

You can use this statement to read features from feature entry and transfer them as variables. If 

no features exist, the system variable $Fehler = "F" is set. 

FEATGET: FID (Sequential ID). 
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FID Feedback ID for the order line 

Sequenti

al ID 

Sequential ID for the feature sheet, usually 0. In this case, all global features are read in as 

variables. 

Example:  

FEATGET: 1800 (3). */returns all features in the sheet as variables 

 
 

CLGET 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

CLGET: "Item ID". 

All CL properties for the Item ID resource can be used as variables. 

Please note: The contents of existing variables with the same name will be overwritten. 
 

CLSEARCH 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

CLSEARCH: "Item ID". 

The first suitable item ID is returned as $MNr using the CL properties. 

All properties in the standard sheet that are defined as keys must exist. If properties are defined as 

Property = * or ! VARIANTS will ignore these key properties. 

If the search is unsuccessful, the $Fehler = variable will be set to F. 
 

WHILE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

You can use this function to program loops in the decision logics. 
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If the WHILE: query is not fulfilled, the loop will run through until WHILEEND:. Use WHILECONT: to 

position the cursor at the start and WHILEEXIT: to exit the loop. 

You can use the IF:, THEN:, END commands as normal within the loop. It is not possible to nest 

multiple WHILE: statements, you can however do this using sublogics. 

Example:  

* Test WHILE 

A = 0. 

B = 0. 

WHILE: A < 5 

THEN: A + 1. 

IF: A > 3. 

THEN: WHILECONT:. */ continue with WHILE: 

ELSE: C = 1. 

END. 

IF: A = 1. THEN: CALCULATE: "TestWHILEu". END 

B = 1. 

WHILEEND. 

A =? 5.000000 

B =? 1.000000 

C =? 1.000000 

X =? 3.000000 

 
 

WHILEEND 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

See WHILE (VARIANTS) (see "WHILE" page 571). 
 

WHILEEXIT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

See WHILE (VARIANTS) (see "WHILE" page 571). 
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WHILECONT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

See WHILE (VARIANTS) (see "WHILE" page 571). 
 

START 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

START: "C:\Path\Program.exe" (P1 P2 P3) "W". 

Calls C:\Path\Program.exe with 3 parameters. The maximum length of a parameter list is 20 

characters. Use + to add longer parameters. The system supports a maximum of 3 parameters. W 

(as the 4th parameter) can be used to initiate a waiting period in VARIANTS, which then waits until 

the called program has been closed. 

 

START: "C:\Path\Program.exe" (Parameter1 Parameter2) "W" "D". 

This statement calls C:\Path\Programm.exe with parameters. The maximum length of a parameter 

list is 20 characters. Use "+" to add longer parameters. Parameters P1 and P2 are separated by a 

space when transferred. 

If the working path is missing, the current directory is used. If you set W, the decision logic will wait 

until the called program has been closed before resuming. 

D calls the program in the background so that items such as the logon form and program logo are 

not shown. 

Example: 1: 

Filename = " /p C:\Temp\Test.doc". 

START: "C:\Program Files\Microsoft Office\Office\Winword.exe" (Filename) "W". 

X = 1. */ when Word is closed, continue from here 

 

Example: 2: 
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Filename = "Test.scr". 

Filepath = "SYSINFO/BMP/". 

 

EXPORT: Filename (Filepath). 

P1 = "10" + "," + "10". 

Diameter = 8. 

TEXT: "_Circle " + P1 + " _d " + Diameter. TRANSFER: Filename. 

TEXT: "_Zoom _E". TRANSFER: Filename. 

QUIT: Filename. 

START: "\"C:\Programs\AutoCAD LT 97\aclt.exe\" /b" (Filename "" Filepath). 

 
 

STATUSBAR 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

STATUSBAR: "String". 

This statement issues a string, field name, or literal with up to 45 characters. 

Example:  

Value = "Hello World 1". 

STATUSBAR: Value. 

STATUSBAR: "Hello World 2". 

The two messages appear on the left-hand side of the status line one after another. They remain 

active until they are overwritten by another message issued by the program or operating system. 
 

STR 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

STR: "String" STR: "Format string" 

This statement converts a string to another format. The string is adapted to the output format if it is 

longer than Format string. If it is shorter than Format string, formatting will be truncated. 

Example:  



Infor COM 7.5 User Guide | 575 

 

Design 

 

Text = "DDMMYYHHMMSS". 

Text1 = Text STR: "##.##.## ##:##:##". 

Text1 =? "DD.MM.YY HH:MM:SS"  

 

Text1 = YMD: Text STR: "##.##.## ##:##:##". 

Text1 =? "YY.MM.DD HH:MM:SS"  

 

Text1 = "311202235959" STR: "##.##.## ##:##". 

Text1 =? "31.12.02 23:59" 

 

Text = "311202". 

Format = "##.##.## ##:##:##". 

Text1 = Text STR: Format. 

Text1 =? "31.12.02" 

 
 

TABLE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

TABLE: "Table name". 

This statement searches in the specified table. If no value is found, processing is cancelled. 
 

TABSEARCH 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

TABSEARCH: "Table name". 

This statement searches in the specified table. If no value is found, the $FEHLER variable is set to F 

and can be queried using IF: $FEHLER = "F". The search key is automatically generated from the 

current features according to the table standard sheet and results are stored as new features. 

Example: 

IF: "Table name" = F. 

   THEN: ERROR: "No value stored". 
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TEST 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

TEST:"ON" / "OFF" / "Variable name". 

The test run by the decision logic to check for errors is enabled/disabled. All steps are shown 

when you call a decision logic. If you specify a variable name, the decision logics, including the 

variable name, are processed and the debugger is started. Once the error has been remedied, 

you can comment out TEST: with an asterisk (*). The TEST: Variable name statement runs the 

debugger if these variables are called. 
 

TEXT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

You can print this string (up to 64,000 characters) or write it to an ASCII file with the EXPORT: 

statement when you run a decision logic. Up to 79 characters can be assigned to each program 

line. The remaining characters can be appended using the + parameter. 

Examples: 

TEXT: "String1". 

TEXT: + "String2". 

TEXT: [[+] ""][("Filename" ["Path" ["Section"]])] 

Path and section are optional. If the section is to be incorporated and you do not need the path, 

the path must be entered as an empty string (""). 
 

DMY 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

DMY: YYYYMMDD 

This statement converts the date to the format YYYYMMDD. 
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Date must be an alphanumeric or numeric variable. The format can vary (see example). Day can 

contain one or two digits, Month must always contain two digits, and Year can contain two or four 

digits. 

Note: The result is always a string. 

Example:  

* Name of the decision logic: "YMD" 

 

TEST: "On". 

Date = 0. 

YYMMDD = "33.12.11". 

Date = YMD: YYMMDD. 

Date =? "11.12.33"  

 

YYMMDD = "3333.22.11". 

Date = YMD: YYMMDD. 

Date =? "11.22.3333"  

 

YYMMDD = 332201. 

Date = YMD: YYMMDD. 

Date =? "012233"  

 

YYMMDD = 332201. 

Date = DMY: YYMMDD. 

Date =? "012233"  

 

YYMMDD = "33332211". 

Date = DMY: YYMMDD. 

Date =? "11223333" 

 
 

TRANSFER 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

TRANSFER: "Filename.txt" [("Variable or separator" ["Section"])] "K". 

If only one variable name is transferred, the line that is read in the file is transferred to this variable. 

If the line cannot be read or located, $Fehler is set to F. 

TRANSFER: "Target_Filename" ("Source_Filename" ["Path" ["Section"]]). 
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If the section is to be incorporated and you do not need the path, the path must be entered as an 

empty string (""). 

Example 1: 

* File consists of only one line with the number 300 

* Format is automatically detected and the variable is created. 

 IMPORT: FileIMPORT (FilePFAD). 

 TRANSFER: FileIMPORT ("TMP1"). 

 TMP1 =?     300.000000 

 QUIT: FileIMPORT. 

 

 

Example 2: 

IMPORT: TRANSFER: "Filename.txt" [("Name" "Section")]. 

The first or next line in the file is read. 

If Section exists, the Section is searched for first, and then the line that begins with Name. The 

value is assigned. 

 

 

Example 3: 

EXPORT: TRANSFER: "Filename.txt". 

The text created using the TEXT: command is transferred. 

EXPORT: Filename (Standardsheet path). TRANSFER: Filename (";"). 

The characters permitted for export/import with standard sheets are: 
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* 

; 

: 

| 

# 

/ 

\ 

~ 

, 

"" 

If the separator is missing or invalid, "*" is used. If no separator is to be used, use an empty string 

(""). 

If the two K (short description) and B (description) switches are set, all standard sheet entries are 

written to a file as headers. 

 

Example: 

EXPORT: "test" ("C:\Temp\\" "NBName" "+"). 

TRANSFER: "test" "|" "K". 

QUIT: "test". 

 

 
 

VARGET 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

VARGET: Variable name1 [Variable name2]. 

If a sublogic has been called using CALCULATE:+, this statement can extract one or more variables 

from the parent variables list and create them as local variables. See also CALCULATE:+ 
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VARPUT 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

VARPUT: 

If a sublogic has been called using CALCULATE:+, this statement can transfer one or more variables 

from the local variables list to the parent variables list. See also CALCULATE:+ 
 

MAKEDIR 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

MAKEDIR:"Path specification". 

The specified directory is created. Multiple directories cannot be created at the same time. 

Example:  MAKEDIR: ("C:\TEMP\EXPORT\\"). 

This statement creates a subdirectory called EXPORT in the C:\TEMP directory. 
 

CONTINUE 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

CONTINUE: "Label." 

This statement jumps to Label. It can only jump forward. 

In the Example: In this case, the label must be entered further down in the decision logic at 

Label, where execution is to continue. The labels must not be embedded in IF, THEN, or END 

statements. 

Example:  
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CONTINUE: Label. 

(Statements) 

Label. 

 
 

TX 

This statement is a general statement (see "General statements in decision logics" page 552) 

used in decision logics (page 545) in VARIANTS (see "VARIANTS basics" page 509). 

The formatting in the ^X statement can display integers in hexadecimal format. A small x stands for 

lower case and a large X stands for upper case. 

^X8,8 ^X8,8 is the maximum formatting permitted. The number in front of the comma stipulates the minimum 

number of places that are to be returned; the number after the comma stipulates how many places 

(with leading zeros) are returned. 

Please note: The recipient variable must be alphanumeric. 

Examples:  

Hexnumber = "". 

Number = 1024. 

Hexnumber = Number[^X8,8]. 

Hexnumber =? "00000400" 

Number = 1035. 

Hexnumber = Number[^x8,6]. 

Hexnumber =? " 00040b" 

 
 

Features and field names in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

Field names from VARIANTS and Infor COM can be used in decision logics (page 545). 17 

numeric or alphanumeric characters are permitted. 

If you want to transfer fields from Infor COM to VARIANTS or vice versa, you must define them in 

the CAPPRG configuration. 
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The first character must be a letter or $ sign (please note: $ is reserved for Infor COM fields, see 

below). The other characters can be letters, numbers, or the underscore ("_") sign. 

Examples: Field1, Field_1, $Feld1 

Labels 

Like field names, jump names are closed with a period. 

Example: here. 

These are evaluated by the CONTINUE: label statement, for example. 

Literals 

A literal in the VARIANTS component is the content of a variable, field name, or feature, for 

example. Literals can have numeric values or strings as feature types. 

Literals are written in inverted commas. 

Examples: 123 or 1.23 (numeric features), "Text" (string). 
 

Comparison operators in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

The following table provides an overview of the comparison operators used in decision logics. 
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Operator Meaning 

= Equal to 

? Does this variable exist? 

Example: IF: ? Name 1. THEN: Name2 = Name1. END. 

> Greater than 

< Less than 

>= Greater than or equal to 

>= Less than or equal to 

<> Not equal to 

 

Syntax for comparison operators 

The following table provides an overview of the syntax used for comparison operators. 

Keyword Syntax Example 

IF: <Expression> <Operator> <Expression> 

[!<Expression] 

A = 1!2!3 

[OR: <Expression> <Operator> <Expression>] A = B :< 2. 

[AND: <Expression> <Operator> <Expression>] B <= 4. 

THEN: <Value assignment> [<Value assignment>] 

<Statement> <Comparison> 

Price = 10.00. 

[ELSE: <Value assignment> [<Value assignment>] 

<Statement> [<Statement>] <Comparison>] 

Price = 10.50. 

END.  Price = ? 10.00 

 

 

Explanation: The square brackets [] indicate optional expressions. 

Please note: IF: allows unlimited nesting, but ELSE: always refers to the last IF: 

Example 1: 

A = 2. 

The variable A is assigned the value 2. 
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IF: A = 1 ! 2 ! 3. 

 THEN:  Price = 10.0. 

 ELSE: Price = 10.50. 

END. 

If A is assigned 1, 2 or 3 , the price is 10.00. 

Price = ? 10.0 

 

The price is queried. Since A has the value 2, a price of 10.00 is output. 

 

Example 2: 

A = 2. 

B = 3. 

IF:  A = 1. 

   OR: A = B :< 2. 

      AND:  B <= 4. 

   THEN:  Price = 10.0. 

   ELSE: Price = 10.50. 

END. 

Price =? 10.0 

 

 

Example 3: 

A = 2. 

B = 2. 

Price = 0. 

IF: A = 1. 

   THEN: Price = 10.0. 

END. 

 

IF: B = 2. 

   THEN: Price +  1.50. 

END. 

Price =? 1.50 
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Mathematical operators in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

The following table provides an overview of the mathematical operators used by decision logics 

(page 545). 
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Operator Arithmetic 

operation 

Example 

+ Addition A = 5 + 2. 

- Subtraction A = 5 - 2. 

* Multiplication A = 5 * 2. 

/ Division A = 5 / 2. 

^ Exponents A = 5 ^ 2. 

^ Root A = 25 ^ 0.5. 

% Percent value A = 100 - 10%. Result: 90 

= Assignment A = 5. 

:= Set value (if it is 

unknown or not 

created/defined) 

(1) A = 5. A := 10. (Result: 5) 

(2) A := 10. (Result: 10) 

:< Set value if less 

than 

A = 5. A :< 100. (Result: 100) 

:> Set value if greater 

than 

A = 5. A :> 3. (Result: 3) 

$e Euler number 2,718282 

$MB_KBez Description of the 

standard sheet in 

a table. 

$MB_KBez=Subcategory. 

$PI Constant PI A = 3 * PI. (Result: A = 3 * 3.14593) 

$TxtLeng Number of 

characters since 

the last \n in the 

notes. 

$TxtLeng=0. 

$WE Base currency 

from the 

configuration 
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Examples  

 

The following examples illustrate how the above operators are used. 

Width := 1200 + Margin. 

If a value has not yet been entered for the Width variable, it is populated with 

the total from 1200 and the value of the Margins variable. 

Area = Length * Width :<1000 :>600000. 
Area = Length * (Width :<100 :>1000). 
Price = Price * Quantity - 5%. 

The Price variable is assigned the values from the product of the Price and 

Quantity variables minus 5 %. 

 
 

Alphanumeric operators in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

The following table shows the alphanumeric operators used in decision logics. 
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Operator Meaning Example 

= Assignment A = "a" 

+ Add up to 20 characters (at least the 

destination field must be alphanumeric) 

A = "a" + "b". 

Result: ab 

:= Set value if it is unknown or not 

created/defined 

(1) A = "a". A := "b". 

Result: "a" 

(2) A := "b". 

Result: "b" 

>, < Cut off leading or trailing spaces. Spaces 

are not permitted between field names and 

the operator. 

A = "a". B = "b...." 

A = A + B<. 

Result: "ab" 

\f Pagebreak (form feed) during text output  

\n Line break during text output MESSAGE: "1stLine\n2ndLine". 

\t Tab in an output text MESSAGE: "Text1\tText2". 

\" Quotation marks within text MESSAGE: "Text\"1\"". 

?= Does the string contain the permitted 

characters? 

IF: Field ?= "ABC". THEN: ... 

(The condition is met if any part of the field contains 

"ABC".) 

Example: xABCxxx 

|= Does the string consist of a combination of 

permitted characters? 

IF: Field |= "ABC". THEN: ... 

(The condition is met if the field consists of any 

combination of the characters "ABC".) 

Examples: A, B, C, AB, CA 

LNG Returns the length of the string as a number Text = "abc". X = LNG: Text. 

Result: X = 3 ("abc" contains 3 letters) 

{} Contents of a variable (1) A1 = 5. B = 1. C = "A" + B. 

Result: C is assigned the variable name A1: C = A1 

(2) D = {C} 

D is assigned the contents of the variable defined in C. 

Therefore: D = {A1} = 5 

~= Does the string also contain the invalid 

characters? 

IF: Field ~= "ABC". THEN: ... 

(The condition is met if no part of the field contains "A", 

"B", or "C".) 

Examples: xAy, xxByAzC 
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 Format numbers as a string without trailing 

zeroes. 

Value2 = 1.560089. 

Value1 = "" + Value2[0.4g]= "1.56" 

This expression contains up to 4 characters without 

zeroes. g stands for the number of all significant 

characters including places before the decimal point. 

 
 

Format decision logics 

This topic contains formatting options you can use in decision logics. 

[xn1,n2] 

Basic statement for formatting text. The statement must be between square brackets. Use 

commas without spaces as separators. 

The individual components of the expression have the following meanings: 

x = 0 You can use the x expression to show leading zeros in numeric fields. The expression x=0 sets 

the leading zeros to zero. 

x = - You can left-align text using this expression. 

x = + You can right-align text using this expression. 

x = # This expression formats numbers with a thousands separator 

n1 = This expression indicates the minimum length of the destination field including places before 

and after the decimal point and decimal places. 

n2 = This expression indicates the entire transfer length or decimal places. 

Field + n This expression indicates that a number is output beginning with digit (n+1) in the field (counting 

from the start). 

Field - n This expression indicates that a number is output beginning with digit n in the field (counting 

from the end). 

 

Examples: 

Last name="Mayer".First name="Jack".Title="Dr.   ". 

The Last name, First name, and Title variables are replaced with the corresponding values. 
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Last name1=First Name + "Mayer". 

The Name1 variable is populated with the first name and the last name Mayer. In our example, the 

Title 1 variable stands for Jack Mayer. 

Title 1=Title< + " " + Name1. 

(The <- character is explained in DL - Alphanumeric operators (see "Alphanumeric operators in 
decision logics" page 587)). 

The Title 1 variable contains the title, followed by a space and the Name1 expression. In our 

example, the Title 1 variable is Dr. Jack Mayer. 

Test1=Name+1[0,3]. 

The Test1 variable is assigned the value Name+1, which means that the name is output, beginning 

with the second digit. [0,3]  means that the entire transfer length is 3 characters. 

In our example, Test1 is assigned the value aye. 

Test2 = Name+3[0,2]. 

The Test2 variable is assigned the value er in the result. 

Test3 = Name+1[5,2]. ->"---ay" 

The minimum transfer length is 5, but the string from the name has only 2 characters. In the result, 

3 spaces are inserted before the string. The variable Test3 is assigned the value _ _ _ ay in the 

result. 

Test4 = Name+1[-5,2]. 

The Test4 variable is assigned the value ay_ _ _. 

S1=1. S2 = 2. S3 = 3. 

Test5 = Name-4[S2,S3]. 

The Test5 variable is assigned the value aye. 

Name = "Radius ". Value = 1.5634. 

Name = Name + Value[0,2]. -> "Radius 1.56". 

The Radius variable is assigned the Radius 1.56 value (rounded). 
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System variables in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 



592 | Infor COM 7.5 User Guide 

 

Design 

 

$Batchmode During generation, this variable checks whether the decision logic was started in the batch 

process. The messages from the MESSAGE: and ERROR: statements plus all system 

messages are written either to the mailbox or to the status line only. When a decision logic 

is started, an additional system variable is generated during generation that represents the 

batch flag from the calling Lj4 program. The status can be checked in the decision logic, and 

messages can be suppressed there. A distinction is made between the following modes. 

0 No batch 

1 Batch without mail, wait/delay --> fix 

2 Batch with mail. A mailbox record is written for each message with 

iw_error_wait. 

3 fix --> delay 

4 fix/delay --> wait 

9 Suppress all messages. 

Example: 

IF: $Batchmode = 0. 

  THEN: MESSAGE: "Material not found. Using default". 

 END. 

$FDir Directory where CAPEXE.EXE is located. 

Example: 

$FDir = "\CAP_Suite\" 

$FDrv Current drive letter. 

Example: 

$FDrv = "C:" 

$Fehler = "F" System error flag. Automatically set to "" or "F" by TABSEARCH:, CLGET: depending on the 

result. 

$Focus If the combo box is currently active, the value is True. Otherwise (when switching sheets, 

for example), it is False. Querying this variable can accelerate the refresh rate when 

sheets are changed. Inactive combo boxes are displayed only and are not populated 

further. 

Example: 

IF: $Focus = "false". 
   THEN: Column1 = Field name. 
        TABLE: "Table name". 
        $Sel_1 = Column1 + Column2. 
        LOGEND. 
  ELSE: Column1 = "?". 
        Column2 = "?". 
        SELECT: "Table name". 
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END. 

$LfAkt ID for the current feature sheet when the action is started (for example, when an export 

routine is started). It allows you to create a graphic for the current local feature sheet, for 

example. 

$Mark If the current row of the table is selected, $Mark ="Y". Otherwise $Mark = "". 

$MSG Result of the last check using "IF:" can be displayed as a message. 

Example: 

MESSAGE: $MSG. 

$Speichern Set by the system if a change was made when the feature was entered. Can only be 

queried as a variable. 

Example: 

$Speichern = "N": Saved 

$Speichern = "Y": Must be saved 

$Temp Directory for temporary files from the Temp operating system variables. 

Example: 

$Temp= "C:\Temp\" 

$TxtLeng Number of characters since the last "\n" (for "TEXT:" statement). 

$TxtMax Total number of characters (for "TEXT:" statement). 

$View Current database view. 

Example: 

$View="viwVertrieb" 

$Win_User Logon name in Windows. 

Example: 

$Win_User="Administrator" 

$ZwangsBer This variable determines whether the summation logic is to start before closing the feature 

entry screen. It can be set to Yes/No via decision logic. 
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Other characters in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

The following table contains additional characters that play an important role when creating 

decision logics. 

Operator Meaning Example 

. Closes expressions.  

* * as the first character in the row indicates a comment 

line. 

 

*/ Comment from this point to the end of the row  

! Implicit OR: IF: Answer = "a" ! "b"! "c". 

!C Requests values for this variable and displays the 

string defined by MTEXT:. All $Sel__ variables are 

available for selection in a combo box. 

 

=! Accepts entered values requested by MTEXT:. MTEXT: "Entry:".A=! 

=? Output of the variable content in the decision logic A=? 

 
 

Mathematical functions in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

The following table lists the mathematical functions available in the VARIANTS component. 

Function Meaning Example 

RDN:n Rounds down to n decimal places W = 1.457. W RDN:2. = 1.45 

ABS: Returns the absolute value of a number (without a 

sign) 

W = -1. X = ABS:W. = 1 

ACOS: Returns the arc cosine of a number W = 1.X = ACOS:W. = 0 

ASIN: Returns the arc sine of a number W = 1.X = ASIN:W. = 90 
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ATAN: Returns the arc tangent of a number W = 1.X = ATAN:W = 45 

RUP: Rounds up to n decimal places W = 1.457. W RUP: 2. = 1.46 

COS: Returns the cosine of a number W = 1. X = COS:W. = 0.999848 

COSH: Returns the hyperbolic cosine of a number.  

EXP: Raises the base e to the power specified as the 

argument. Use the "^" operator to raise any base to 

a power. 

EXP:1 = 2.718282 

LG: Returns the log base 10 of a number. LG:10 = 1 

LN: Returns the natural log of a number. LN:2.718282 = 1 

RN5:n Rounds to n decimal places. W = 1.426. W RN5:2. = 1.45 

W = 1.424. W RN5:2. = 1.40 

Rounding accuracy: 5 hundredths 

RND:n Rounds up or down to n  decimal places W = 1.457. W RND:2. = 1.46 

W = 1.452. W RND:2. = 1.45 

SIN: Returns the sine of a number. W = 1. X = SIN:W. = 0.017452 

SINH: Returns the hyperbolic sine of a number.  

TAN: Returns the tangent of a number. W = 1. X = TAN:W. = 0.017455 

TANH: Returns the hyperbolic tangent of a number.  

The angle functions sin:, cos:, tan:, sinh:, cosh:, tanh:, asin:, acos:, and atan: are 

specified in degrees (0° to 360°). Only a field or literal is permitted after the colon, for example 

sin:35. You can use up to 15 sets of brackets ( ). 
 

Keywords in decision logics 

For general information on statements and operators in VARIANTS, see Decision logic statements 

and operators (see "Statements and operators in decision logics" page 551). 

The following table contains VARIANTS keywords that are used with conditions. 

Keyword Meaning Example 

IF: Checks whether a condition is true. The following 

action depends on the result. 

IF: Basic material = "A1" 

OR: In the example: The condition is met if at least one 

of the two requirements (Basic material = A1, Hole 

IF: Basic material = "A1" 

 OR: Hole > 50 
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> 50) is accomplished. 

AND: In the example: The condition is only met if both 

requirements are accomplished. 

IF: Basic material = "A1" 

 AND: Hole > 50 

THEN: Specifies the action you want to be carried out 

when the condition is met. 

IF: Basic material = "A1" 

 THEN: CALCULATE: "abc" 

ELSE: Specifies the action you want to be carried out 

when the condition is not met. 

IF: Basic material = "A1" 

 THEN: CALCULATE: "abc". 

 ELSE: CALCULATE: "xyz". 

END: Ends the IF: statement. IF: Basic material = "A1" 

 THEN: CALCULATE: "abc". 

 ELSE: CALCULATE: "xyz". 

END. 

 
 

Access to Infor COM relations in decision logics 

See Decision logics (page 545) for basic information on decision logics in VARIANTS. 

As you cannot address all relations using the READ, WRITE, and DUP statements, you will also need 

to use the VQL, VQLUPD, and VQLDUP commands. 

READ: key [SML()] 

key = field or literal. The CL relation can be read. 

READ: ["Prefix"] ActVt (Field1 [Field2 Field3...]). 

The current virtual table is read. ActVt stands for the current view. Prefix is the string that you 

want to use instead of the name of the ActVt view. The name of the ActVt  view can be very long, 

which causes a conflict with the maximum length for variable names. 

To determine which fields can be addressed directly, check the view in the DataBase domain of 

the Infor COM Dialog Manager. 
 

Decision logic usage 

To open the Decision logic (see "Decision logics" page 545) usage object, open the VARIANTS 

folder in Design and select Decision logic usage. 
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You can use this object to create and evaluate a where-used list for decision logics. 

All basic VARIANTS data (such as feature sheets, subcategories, decision logics, and so on) are 

searched for decision logic usage and stored in a table as part of this batch process. 

This data can now be evaluated in the decision logic. Open the decision logic and select Functions 

and Where-used list in order to  evaluate the usage data for the currently loaded decision logic 

and display it on a form. 

 Usages are displayed along with the decision logics for all other objects such as BORs, 

summation logics, subcategories, and features. 
 

Tables 

When preparing any kind of data, you can use VARIANTS (see "VARIANTS basics" page 509) to 

maintain tables whose data you can access using, for example, decision logics (page 545). 

To enter a table in Design, select VARIANTS and Tables. 

You can use tables for a variety of functions. 

 Price tables 

 Dimension tables 

 Tables containing technical machine data 

 Tables containing standard times 

 Material allocation tables 

 Material/work center allocation tables. 

 

Note: You can import and export VARIANTS table data by selecting Functions and then Import 

file/Export file or Functions and then Excel import/Excel export. 

When you do this, the table that is currently shown in the overview is exported. 

For general information on this topic, see Import/export VARIANTS structures (page 522). 
 

Maintain tables 

See Tables (page 597) for information on tables in VARIANTS. 
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The columns in a table are defined by a feature sheet (see "Feature sheets" page 541) in Infor 

Dialog Manager. To access the IDM, select Go to and IDM in the table overview. 

Each field in the form will represent a column in the subsequent table. The order of the columns in 

the table is based on the order of the fields that have been entered. 

Enter the table contents in the Table view of the opened table. 

The first row in the table must be initialized by selecting the Edit menu and then Insert new row. 
 

Data maintenance 

Data maintenance in VARIANTS (see "VARIANTS basics" page 509) is designed to maintain 

features in tables. In Design, open the VARIANTS folder and select Data maintenance to open 

Data maintenance. 

Data maintenance is a faster and more direct alternative for changing features than entering data 

in resources. The contents are checked immediately when they are entered. 

Note: You can export data from a table and process it using a table calculation, for example. To 

do so, open the Functions menu and select Export file. 
 

Conversion 

To convert CAP standard sheets, select Design > VARIANTS > Conversion. You can use this 

function to convert standard sheets from older CAP versions to the current  VARIANTS version. 

General procedure 

Depending on the volume of data you want to convert, the conversion process can be quite 

time-consuming. Therefore, when converting your standard sheets to Infor COM Dialog Manager 

forms, you should first perform the task on a test system. This also simplifies the required testing 

of VARIANTS processes after conversion. 
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You should not make any changes to the CAP master data (standard sheets, decision logics) 

stored on your live system while converting the test system and loading the CAP data back to your 

live system. The test system should contain the most current data during conversion. This does 

not apply to movement data (features, CAP table contents). The CAP master data must be current 

because it is transferred (import/export) to the live system after conversion on the test system. 

This allows you to test various processes on the test system until the results achieved are 

sufficient to run VARIANTS on your live system. 

The following steps should be performed for the conversion: 

1. Create a test system from the live system. 

2. Run the CAPNTrelSG.vqs script on the test system (to enter the feature sheet types in the 

subcategories). 

3. Convert the standard sheets using the conversion tool (open the VARIANTS folder in the 

Design module and select Conversion). 

4. Import the converted Infor COM Dialog Manager forms (DynChildForms) to the test system. 

5. Test the processes on the test system and make any necessary corrections. 

6. Export the VARIANTS master data (DynChildForms, standard sheets, decision logics). 

7. Import the VARIANTS master data to the live system. 

 

Please note: Steps 3, 4, and 5 should be repeated, depending on the VARIANTS data. We 

recommend converting the various standard sheets according to category/subcategory. In other 

words, you should convert all feature sheets that belong to a particular category one by one until 

the relevant process has been converted and tested. Continue this procedure for the next 

category. While it is possible to perform a complete conversion, it is not recommended due to lack 

to scope for testing. 

Converting standard sheets 

When converting standard sheets, Infor COM Dialog Manager forms are generated from the CAP 

standard sheet descriptions. The forms are exported in DOS and saved in a special directory, from 

which they can be imported to the Infor COM Dialog Manager and stored in the repository. 

The following conventions apply to Infor COM Dialog Manager form descriptions: 
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 Apart from the underscore ("_"), no special characters are permitted. During conversion, the 

names of the standard sheets and the features are checked for special characters and 

changed as required. The changes are subsequently made in the decision logics and the 

current standard sheets if the corresponding feature is queried in the sheets. 

 Numbers from 0 to 9 are permitted but they cannot be included as the first character in a 

name. 

After conversion, the following files will be located in the corresponding export directory: 

 CAPKonvert_prot.txt: Logs the actions performed during the conversion. It contains the names 

of the converted standard sheets as well as the names of modified features/standard sheets 

and corrected decision logics. 

 ConvDCF.wnd: Contains the form descriptions that can be imported using the Infor COM 

Dialog Manager. 

 Namen_Prot.txt: Contains the feature and standard sheet names that were modified during 

conversion. 

 relEL.io, relNB.io, relNBG.io: Contains a backup of the data modified during conversion. These 

files can be used to recover converted standard sheets and decision logics if errors occur 

during conversion. 

Importing form descriptions 

You can import and save the ASCII files generated during conversion and which contain the form 

descriptions. In the Infor COM Dialog Manager, select File and click Import. 

Note: The imported forms are not visible in the Infor COM Dialog Manager structure that is 

displayed. They are accessible in Infor COM Dialog Manager CAP mode only. 

Changing bitmaps dynamically 

In VARIANTS, you can no longer use decision logics from within a feature sheet to change 

bitmaps dynamically according to feature properties. Decision logics do not have access to the 

form object properties of feature sheets. 

To change bitmaps in VARIANTS, you must use Lj4 functions. 
 

Templates 

A template consists of a cross-subcategory set of up to 50 combo box, text box, and check box 

features. You can define templates and use them to quickly enter features in a sales order. For 

more information, see Create template (page 601). 
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The features defined in a template can be displayed in the sales order in table format. You can 

also access combo boxes in this table. 

The following applies: 

 Combinations, i.e. elements with several identical local sheets, are displayed one under the 

other in several rows. 

 In regular standard sheets, hidden fields are highlighted in color in the table. 

 To close the Quick edit screen, select Functions > Close and return to order (Alt + F7). 

 
 

Create template 

The data for a template is taken from the corresponding table on a cross-subcategory basis 

according to the feature sheet and assigned by employee.  

Templates are used for the quick entry of features in sales orders. 

To create a template, complete the following steps: 

1. Select Design > VARIANTS > Templates > New. 

2. Enter the name of the template in the Template name field, select the category and click 

Create. 

3. Enter the employee. 

4. Enter the details for all required feature sheets and features as follows:  

 In the Feature sheet column, select a feature sheet. 

 Then in the Feature field, select the required feature.  

5. Select Data >Save. 
 

CL 

The way in which this folder displays is determined by your specific VARIANTS license. 

This folder contains the following objects: 

Categories, subcategories, and characteristics (page 533) 

Decision logics (page 545) 
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Tables (page 597) 
 

Plausi. check 

The way in which this folder displays is determined by your specific VARIANTS license. 

Plausibility checks in VARIANTS are configured in the COMMON.CAPPLAUSI section of the 

configuration. See also Configuration (VARIANTS). 

This folder contains the following objects: 

Decision logics (page 545) 

Tables (page 597) 
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The objects in this folder allow you to define changes that are to be logged in items, BORs, and 

prices and to view these once the changes have been logged. 

For more on this topic, see Configuration (History) (ms-its:configuration.chm::/25640.htm). 

Note: The purchase order history is also available in the Archive folder inPurchasing. It cannot be 

configured. 

In terms of the history, you have the following options: 

 You can specify the fields that trigger logging in the history when they are changed. 

 You can open the corresponding history to view the changes. 
 

Display item history 

Call 

Design > History > Display item history 

Description 

Use the Display item history object to display the logged changes to the item master data. These 

changes include creating, updating, and deleting items. 

To find out how to enable logging in the item history, see Define item history. 

If an item is deleted, it is displayed in the item history on the Stat. tab with the ID Deleted. 
 

Display BOR history 

Call 

Design > History > Display BOR history 

History 

ms-its:configuration.chm::/25640.htm
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Description 

The BOR history logs changes in the BOR master data. These changes include adding, updating, 

and deleting BOR lines. 

To find out how to enable logging in the BOR history, see Define BOR history (page 605). Use the 

Display BOR history object in the History folder in Design to display the logged changes in the 

BOR master data. 

If a BOR is deleted, all BOR lines will appear as Deleted in the history.  

When you go to Display BOR history and enter the resource rather than the BOR on the Open tab, 

a report containing the BORs for the resource and the BORs in which the resource is a component 

part is displayed. 

 
 

Display price history 

Call 

Design > History > Display price history 

Description 

Use this menu item to view the price and discount history for deleted prices or discounts. 
 

Define item history 

Call 

Design > History > Define item history 
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Description 

The item history (see Display item history (page 603)) logs changes in the item master. These 

changes include creating, updating, and deleting items. 

The fields to be logged are specified in the History folder in Design using the Define item history 

function. 

The only field changes that are logged are those that have been defined inDefine item history. 

In practice 

To define the item history: 

The following instructions contain an example of the process for defining the item history. 

1. In Design, go to the History folder and select Define item history. 

2. In the Database table field select relAc and in the Field name field select DbPart.Planart and 

save your entries. 

3. In Design, select Items and open any item of your choice. 

4. Change the option displayed in the Pl. type section of the Planning tab and save your change. 

5. In Design, use History and Display item history to display the changed item and the change 

log. 

6. Select the Pl. type tab to check the change made to the planning type in the history. 

7. Select the Status tab. The ID field indicates the type of change that has been made. 

 
 

Define BOR history 

Call 

Design > History > Define BOR history 
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Description 

The BOR history (see Display BOR history (page 603)) logs changes to the BOR. These changes 

include adding, updating, and deleting lines in the BOR. 

The fields to be logged are specified in the History folder in Design using the Define BOR history 

function. 

Note: If you use the field name DBPART.IPOS when defining the BOR history, please note the 

following: 

This field is changed if the sequence of rows in the BOR is changed. If, for example, a row is 

deleted in the BOR, the deleted row is displayed in the history with the status Deleted while the 

following rows in the structure have the status Updated. 

In practice 

To define the BOR history: 

The following instructions contain an example of the process for defining the BOR history. 

1. In Design, go to the History folder and select Define BOR history. 

2. In the first row, select relAb as the Database table and DbPart.Te (runtime) as the Field name 

and save your entries. 

3. Open the required BOR in Design and BOR. 

4. Make a change in one line in the RTi/qty field on the Texts/structure tab. 

Note: Changes that do not affect the RTi/qty field, but affect one or more other fields, are not 

logged. 

5. On the Change comments tab, enter the employee who has made the change and the Change 

reason for the change in the BOR, and save the BOR. 

6. Open the change log in Design by clicking History and Display BOR history. 

You will find the change log on the Information tab.  

Please note: As the history saves all fields in the database table, any modified fields will also 

be displayed. 
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Define price history 

Call 

Design > History > Define price history 

Description 

The price history logs changes to the price master data. 

The fields to be logged are specified in the History folder in Design using the Define price history 

function. 

If when changing the prices, one of the fields defined there is changed, this change is recorded in 

the price history. If fields that were not specified using the Define price history function are 

changed, no entry is made in the price history. 

In practice 

To define the price history: 

The following instructions contain an example of the process for defining the price history. 

The following step-by-step instructions show how you can set the price history using the Basis 

field as an example. 

1. In Design, go to the History folder and select Define price history. 

2. In the Database table field, selectrelFi and select Basis in the Field name field and save your 

entries. 

Note: Press Ctrl + D to delete lines from the Define price history table. 

3. In Sales, go to Master data and open the Prices object. Open one or more prices. 

Note: You can also change the price in the item master (for example, in Design and Items). 

See the information in Configuration (History) (ms-its:configuration.chm::/25640.htm). 

4. On the Current period tab, change the value that is displayed for the required price line in the 

Basis field and save the change. 

5. Check the change that you have made on the Price history 1/2 tabs. 

ms-its:configuration.chm::/25640.htm
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6. Enter a comment about the change in price in the Remarks field. 

 

Note: You can view the price history in Purchasing and Sales by clicking Master dataand Prices 

on the Price history 1/2 tabs. 
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Planning is the main focus of the various modules in Infor COM: 

Area Purpose of Planning in this module 

Sales You can check whether requested delivery dates can be met. 

Inventory You can perform availability checks (see "Availability check" page 618) and monitor 
minimum inventory (see "Minimum inventory monitoring" page 656). To carry out these 

functions, the system needs to access the warehouse inventory. 

Purchasing You can generate PO proposals. This can be triggered by Sales (sales orders), Inventory 

(minimum inventory shortfall), or Manufacturing (required raw materials). 

Manufacturing You can generate and transfer (see "Transfer PO proposals" page 666) production orders for 

covering requirements. 

The purpose of Planning is the optimum coordination of receipts and issues for every resource 

(material, work center). An item account (page 637) is managed for each item and a capacity 

account (page 649) is managed for each work center. 

Prerequisites for optimum planning: 

 You must enter the planning parameters for all items and work centers. 

 You enter the item data required by Infor COM Planning on the Planning and Inventory 

tabs in the master data for the relevant item. To access an item's master data, select Items 

in the Design module. For more information, see Planning (not location-based) or Planning 

(location-based) and Inventory. 

 Enter the work center data required by Infor COM Planning for capacity checking and 

scheduling on the Planning tab in the master data of the relevant work centers. To access 

a work center's master data, select Work centers in the Design module. For more 

information, see Planning (machine). 

 Purchasing must contain active data. Suppliers and their purchasing conditions, such as 

delivery times, must be entered in the system. 

 Manufacturing data must be consistent. You must have created BORs for in-house items. 

 Inventory must be maintained, and the warehouse inventory must be as up to date as 

possible. 
 

Planning method 

Resources can be based on different planning criteria: 

Planning basics 
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Requirement-oriented 

planning 

In requirement-oriented (deterministic) planning, the requirements for a finished 

product are broken down into individual requirements based on its BOR. Individual 

requirements are then covered by generating purchase orders for purchased items 

and production orders for in-house items and assemblies. 

Consumption-oriented 

planning 

Consumption-oriented (stochastic) planning (minimum inventory monitoring) is based 

on guideline values for the anticipated consumption of in-house and purchased items. 

The guideline values are stored in the master data for each item, either on the 

Planning (not location-based) or on the Planning (location-based). The 

consumption-oriented planning of an item is performed using the Minimum 
inventory monitoring (see "Call minimum inventory monitoring" page 660) 

function. 

 
 

Planning operations 

Planning individual sales orders 

Planning individual sales orders allows you quick access to detailed information on the current 

delivery date (see "Calculate delivery date" page 619) of individual order lines. Delays are flagged 

directly in the order. If planning always affects a correspondingly large volume of data, this can 

lead to considerably longer runtimes. In this case, you can use the Fast planning function, which 

only checks the availability of specially flagged resources and therefore works significantly faster. 

Planning individual resources 

When processing individual items or work centers, you can limit planning to one resource. In this 

situation, all affected items or work centers are planned in addition to the selected resource. 

Planning all resources 

If you want Planning to ensure that all of your tasks are completed, all resources must be planned. 

To do this, you need to run the minimum inventory monitoring (page 656) and batch planning 

(page 661) processes. 

This results in the generation of orders and PO proposals and the creation of delay and bottleneck 

flags. 
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Sales order-specific planning 

Planning generates planned orders required for sales orders at a ratio of 1:1 (production orders 

and purchase orders). For resources with a fixed requirement allocation (FRA) flag, important 

sales order information (order ID, job, product configuration IDs) is copied from the sales order 

and displayed in the planned orders. This enables you to immediately identify the originator of the 

requirement. In the case of made-to-order manufacturers, this means that the costs of the 

materials used and work completed can be assigned directly to the cost unit (sales order). Net 

requirements are not calculated for FRA resources, existing warehouse inventory is not accessed 

and there are no lots (see "Lot size" page 685) created. 
 

Fixed and dynamic requirement allocation 

In Infor COM, receipts (resources) can be assigned to issues (requirement originators) in two 

ways: 

Fixed requirement allocation (FRA) 

The Fixed requirement allocation (FRA) property is an item property that is used for order-based 

manufacturing. An order generated by the system for an FRA item is always linked to its trigger 

requirement by a 1:1 assignment, that is, exactly one rough planned PO proposal or rough 

planned production order (receipt) is generated to cover each requirement (issue). For more 

information, see Change fixed requirement allocation (page 643). 

Dynamic assignment 

An issue is covered by the earliest possible receipt. Purchase orders/production orders are not 

assigned directly to the requirements, instead they are assigned using the due date. 

Please note: Fixed requirement allocation is not permitted for order release items, as these cannot 

be accessed. 
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Rough and detailed planning in Planning 

There are essentially two different planning horizons used in the Planning module of Infor COM. 

Rough planning Rough planning is planning over a relatively long period of time. The result of rough planning 

remains in Planning and is not transferred to Purchasing or Manufacturing. 

Detailed planning Detailed planning is short-term planning that is determined by the transfer horizon. 

 

Due dates in Planning: 

Planning calculates three due dates for each resource: 

 The earliest date (ED) 

 The current date (CD) 

 The latest date (LD) 

These due dates are calculated both for operations and for material lines. For more information, 

see the Help topic on the Due dates tab in the order structure. 

Transfer horizon 

The transfer horizon in Infor COM Planning represents a time limit. This time limit determines 

which rough planned orders are taken into account by Purchasing and by Manufacturing control 

during the transfer to detailed planning (page 665), and which rough planned orders retain in the 

rough planned status for the time being. 

This only applies to orders with a current date (CD) that falls within this limit. 

Note:  An order is transferred to detailed planning as soon as the current date places just one of 

its lines within the transfer horizon. 

The transfer horizon begins with "today" (= system date) and continues for the horizon you 

specified. You can specify one horizon each for Purchasing and Manufacturing using the 

ANEINKAUFHORIZONT and  ANFERTIGUNGHORIZONT parameters in the 

COMMON.DISPOSITION section of the configuration. In the standard version, both horizons are 

set to 336 hours = 14 days. 
 



614 | Infor COM 7.5 User Guide 

 

Planning 

 

BOR data for planning 

A BOR is required for each resource that you want to plan. This BOR is used as a miscellaneous 

standard bill of materials and routing for in-house items. The exact material required is assigned to 

each operation, whereby the manufacturing structure is a fixed value. These are the basic 

elements of scheduling in Planning. 

Each line in the BOR is assigned a due date and quantity. This gives you a rough planned order 

(see "Rough planned orders" page 663) for manufacturing a product. The order is maintained in 

Planning before being transferred to detailed planning (see "Transfer to detailed planning" page 

665) in Purchasing or Manufacturing. 

The BOR for a purchased item contains details of the supplier(s) and the relevant delivery times. It 

is essential to ensure that items are ordered on time in Purchasing. 

For more detailed information on BORs, see BORs. 
 

Pull-in time flag in Planning 

You can set this length of time in the configuration using the 

COMMON.DISPOSITION.VORZIEHZEIT parameter. In the standard version, the pull-in time is 

set to 37.5 hours. The pull-in time is a logistical control factor and is evaluated in Planning. It 

specifies the maximum length of time the earliest date (ED) may be before the latest date (LD). 

This means you can use it to set up a time buffer to ensure that the latest date will be adhered to 

when work starts for the earliest date. The duration of the pull-in time has the following effects: 

 If the pull-in time is too short, capacity utilization is high, inventory balance is reduced, and 

lead time is shortened. This may cause problems with the delivery date, however.  

 If the pull-in time is long, work may start too soon. This increases the lead time and the 

inventory balance, but helps ensure that the delivery date can be kept. 

 If this control factor is not known, it should be determined using specific requirements. For 

example, you establish the length of time that orders are currently released ahead of time. 

Shorten the pull-in time in several phases until you have optimized the situation. 
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Exception flags in Planning 

The Infor COM Planning module sets exception flags when the calculation of the due date reveals 

conflicts with other dates (e.g. sales dates). The exception flags are displayed in the form of check 

boxes in the order structure (page 617) of sales orders and production orders, in detailed 

production orders and in the item accounts (see "Item account" page 637), capacity accounts (see 

"Capacity account" page 649), and work center accounts. 

Either all or only some of the flags are displayed, depending on the program situation. 

D = Delay 

If this check box is selected, there is a delay for this resource, i.e. the earliest date is after the 

latest date and the latest date cannot be met. The lowest line in the order structure with an active 

delay flag may be the cause. Any subsequent delays may be follow-on delays. 

If the originator is an operation (OP record), go to the capacity account (page 649), where you can 

obtain information about the current situation at this work center. To resolve the delay, you can 

increase capacity, for example. 

If the originator is an MA record (material), go to the item account (page 637). You can track the 

receipts and issues on the Balance tab. For purchased items, you can generate purchase orders 

in order to create the required receipts (see "Generate receipts in the Item account" page 641). 

If the delay cannot be resolved due to the replenishment time (RPLT) or capacity utilization, you 

must intervene and adjust the due date. 

Note:The order must be replanned after every change in order to remove the exception flags. 

O = Bottleneck 

If the Bottle. exception flag is selected for a resource, then the bottleneck for the order occurs in 

this resource. The earliest date (ED) and the latest date (LD) are closest together here. 

If the delay flag (D - see above) is still selected for this resource, the main delay is here. In other 

words, the biggest overlap between the earliest and latest due dates occurs here. This resource is 

therefore the originator of the delay in the order. 
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S = Demand shortage 

Demand shortage means that there are not enough receipts to cover the requirement. The 

requirement date is the current date (CD), and therefore the earliest date from the point of view of 

the order. Neither a production order (for in-house manufactured items) nor a purchase order (for 

purchased items) can cover the requirement at the current date. 

For more information, see Resolve shortages in Item account (see "Eliminate shortages in item 

account" page 641). 

M = Modified quantity 

If this exception flag is selected in the order structure, this means that only part of the quantity of 

the generated order or the generated purchase order is displayed in theQuantity field in a HR 

record, as this partial quantity already covers the requirement. The production or purchase orders 

cover other issues with the remaining quantity. This is particularly the case when lots are formed. 

If this exception flag is set in an IR record, it means that more items than are actually needed for 

this order are available at the warehouse. Intervention is therefore not necessary. 

If this exception flag is set in an MA record, it means that the requirement quantity was reduced by 

an inventory or order reservation (as shown in the item account). Only the outstanding remaining 

quantity (Requirement – Reservation) is shown in the order structure. 

For an explanation of HR records and IR records, see Record types (Item account) (page 638). 

B = Batch planning 

If this check box is selected, the resource will be included in the next batch planning (page 661) 

process. 

RS = Reschedule 

If this check box is selected, the order is rescheduled. Previously confirmed sales orders are given 

priority. For more information, see Planning new sales orders (see "Plan new sales orders" page 

622). 
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F = Due date fixing 

In some processes, you can fix the due dates. Fixed due dates do not change when processes are 

replanned. You can do this in the planning accounts for items and work centers, for example. 

Selecting the F check box next to the ED and LD fields fixes these due dates. 

L = Check lot 

This exception flag is set in some processes. It indicates that lot creation parameters stored in the 

item master (on the Planning tab), in particular the lot quantity, need to be adjusted by the system 

because minimum and maximum criteria were violated. In this case, check the lots generated and 

modify them if necessary. 

See Exceptions (page 670) for information on how to edit affected orders. 
 

Order structure 

The order structure is mainly used for the multilevel display of related orders. 

You can access the order structure from sales orders, production orders, rough planned orders 

(page 663), the item account (page 637), or exceptions processing (see "Exceptions" page 670) 

by selecting Go to > Order structure. 

You can manipulate an order structure once it is broken down. This means that you can insert new 

order lines in existing orders, move or delete existing orders or order lines, and reschedule the 

structure using the latest date (LD) or the current date (CD). 

Notes:  

 The system checks whether the order structure can be manipulated for the current processing 

status. 

 Manipulation is only useful for fixed requirement allocations. 

 The lines in the order structure are normally displayed in collapsed view. Clicking the plus sign 

in the Level column opens the next level down. For more information about this method, see 

Show/hide component data records. 
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Availability check 

The result of the availability check shows the quantity of the checked material resource available 

at the time of the function call. The quantity of planned receipts is not included in this check. This 

will be taken into account when planning the  order or in the list of order shortages. 

The currently available quantity of an item is calculated as follows: 

 Available warehouse inventory (Physical - Reserved - Not inspected - 

Quarantined) 

- Quantities in orders that have the status ASN printed, that is, orders for which 

an advance shipping notice was printed but inventory has not yet been issued. 

- Quantities in orders for which a pick list has been printed but no inventory 

issue was carried out (Requirement: 

COMMON.DISPOSITION.AVAILABILITYCHECKWITHPICKLIST=yes). 

- Quantities in released production orders. 

- Requirement of the line for which an availability check is currently being 

carried out. 

= Available inv. balance 

The quantity determined is displayed on the Availability tab of the corresponding object. The 

balance specifies the quantity available after inventory has been issued for the line currently being 

processed. 

 If the balance is negative, the requested delivery date cannot be kept. You can use the 

delivery date calculation (see "Calculate delivery date" page 619) function to generate a 

proposed date in Sales. 

 If the balance is positive or 0, the requested delivery date can be kept. 

Notes:  

 The system only carries out an availability check if negative inventory is not permitted. 

 The availability check can also be activated in the Batch order release batch process. 

 For items with a fixed requirement allocation (FRA), the system generally only takes account 

of the FRA inventory and the assigned, reserved inventory when calculating the available 

inventory. Inventory that is not assigned or reserved is not taken into account. 

Configuration 

COMMON.LEITSTAND.FREIGABEHORIZONT=14 
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Check availability 

You can use the Availability check (page 618) function in Infor COM to check whether goods can 

be delivered for urgent sales and production orders. To do this, the system calculates the current 

warehouse inventory and all reserved lines (for which an advance shipping notice has been 

printed). 

1. Select Sales > Sales orders and load the required order. 

The Check availability function is available as in Advance shipping notice, Production 

order and Rough planned orders. 

2. Select Functions > Check availability. 

 The Available field displays the quantity that would still be available in the warehouse after 

the item is posted. If this quantity is positive or equals zero, the requested delivery date can be 

confirmed and the advance shipping notice printed. If the quantity is negative, then the item is 

not available. 

Note: You can use the Calculate delivery date (page 619) function to determine the delivery date. 
 

Calculate delivery date 

The Calculate delivery date function is available in the Quotes and Sales Orders objects (Sales > 

Order processing). It calculates the earliest possible delivery date of a quote line or order line and 

displays this as the delivery date. 

Note: If you do not specify a requested date in the order header or when creating a new record, 

Infor COM sets Today, i.e. the system date, as the requested date. Before calculating the delivery 

date, the requested date is displayed in the Request field on the Due dates tab. 

Function 

The delivery date is calculated using the data available in Infor COM at the time you call the 

function. Depending on the type of resource, the earliest availability date is calculated as follows: 
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 In-house manufactured i tems : The earliest delivery date of an in-house manufactured 

item is determined by the availability of the resources required to manufacture it (see 

Purchased items and Operations). All steps in the manufacturing structure must be broken 

down first. Then the earliest availability dates of these resources can be calculated. 

 Purchased i tems: The warehouse inventory is calculated first. If this is sufficient to cover 

the requirement, then Earliest date = Current date. If it is not sufficient, the remaining 

requirement is calculated: Remaining requirement = Requirement - Warehouse inventory. The 

earliest date for the remaining requirement is calculated based on the current date, i.e. from 

the time you call the function plus the time taken for its procurement. 

 Operations: When you call the function, you can choose whether work centers (see 

Capacity account (page 649)) should be taken into account. If they are to be taken into 

account, you can specify whether or not you want to search for gaps. When you search for 

gaps, the system uses the required date to find gaps between orders that are already planned 

in the capacity account for the work center. 

By searching for gaps, the start date of the first suitable gaps is set as the earliest start 

date of the operation. 

Note: The start date of a gap is the end date of the previous operation. Its end date is the 

start date of the following operation. 

If you do not search for gaps, the end date of the last operation on the work center is set as 

the earliest start date of the operation. 

If work centers are not taken into account, the system assumes that capacity is unlimited. 

In this case, the current date is set as the earliest start date of the operation. 

After calculating the delivery date 

 In the delivery date structure (Functions > Delivery date structure ...), you can see how the 

delivery date of the line was ultimately derived from the earliest dates of all components. 

 The result of the delivery date calculation is displayed in the Delivery date field on the Due 

dates tab. 

 In a sales order for which no order confirmation has yet been printed, the date is also entered 

in the Confirmed date field. 

Using the delivery date calculation function from Infor COM 6.3 

You can continue using the delivery date calculation function from Infor COM 6.3. See 

Configuration (Calculate delivery date Infor COM 6.3). 

The delivery date is calculated using the replenishment time that is stored in item's master data 

rather than using the BOR breakdown function. 
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Calculate delivery date 

For general information on the calculation of delivery dates, click here (see "Calculate delivery 

date" page 619). 

This Help topic describes how you can calculate the earliest possible delivery date for a quote or 

order line: 

1. Select Sales > Sales orders and open the required sales order. 

2. Highlight the required line(s). 

3. Select Functions > Calculate delivery date. The Calculate delivery date dialog box will display. 

4. Select whether work centers should also be taken into account in the calculation. 

5. If you chose to have work centers taken into account, you need to select whether you want the 

system to find gaps in operations. 

6. Click OK. The dialog box will close and the delivery date will be calculated. 

The calculated delivery date is displayed for each selected line in the Delivery date field on 

the Due dates tab. In a sales order for which no order confirmation has yet been printed, 

the date will also be added to the Confirmed date field. The delivery date structure 

(Functions > Delivery date structure...) shows how the delivery date of a line was 

calculated. 
 

Order planning 

All lines in an order are planned. The function can be used for sales orders and production orders. 

You can carry out the following functions in Planning: 

 Check material availability 

 Coordinate receipts and issues 

 Generate purchase orders 

 Generate production orders 

New sales orders are accessed in special way. See Planning new sales orders (see "Plan new 

sales orders" page 622). 
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Plan order 

To plan orders (see "Order planning" page 621), complete the following steps: 

1. Select Sales > Sales orders and load the required sales order. 

2. Select Functions > Plan order. 

Note: The breakdown parameters (see "Breakdown parameters in Planning" page 624) are all 

preset in the configuration. 

3. Click Start. 

4. Select Go to > Order structure to access the order structure (page 617). 

If the requested delivery date cannot be met, exception flags (see "Exception flags in 

Planning" page 615) will be set. You will need to intervene manually. 

You can also plan orders in batches (see "Batch planning" page 661). In this case, the logs 

are stored in the relevant mailbox. 
 

Plan new sales orders 

When new sales orders are entered in Sales, the Reschedule flag is set automatically for every 

line for which requirement-oriented planning is performed. The flag is deleted again after the first 

planning process has been run for the newly entered order. 

You use a check box to set the Reschedule flag. To locate this check box, go to the Planning 

section on the Texts/details tab of the sales order, or the RS column on the Balance tab in the item 

account. You can access the item account from the Go to menu. 

For information on how to plan orders, click here (see "Plan order" page 622). 

Rescheduling resources 

To avoid shifts in the due dates for previously confirmed orders, new lines with the Reschedule 

flag are selected for identifying the earliest and current dates. 
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Material (MA records) 

MA records are assigned the earliest date (ED) and current date (CD) as the earliest receipt date. 

The receipt can be in the form of a production order or a purchase order. 

Operations (OP records) 

 All operations, except for those to be rescheduled, are sorted by the current date. 

 The operations to be rescheduled are sorted by the required start date. 

 For every operation, the system looks for gaps or idle periods between previously planned 

orders in the capacity account (page 649) of the work center, starting from the required start 

date. 

If a gap is found, the system checks how much total free capacity is available for the 

operation within the planning period for the work center. There may be several gaps. The 

planning period is calculated based on the start date of the first gap and a period that was 

set using the COMMON.DISPOSITION.PLANUNGSZEITRAUMAP parameter. In the 

standard version, the default period is one week (168 hours). 

 If the calculated capacity is sufficient for the operation with the Reschedule flag, it is inserted 

here. 

 If the capacity is not sufficient, the procedure is repeated after the next gap and the new 

planning period is checked. 

 The current date assigned to the operation inserted into the gaps is the start of the first gap 

found in the planning period. 

 The capacity requirement of the newly-planned operation is deducted from the balance. 

 Distribution to the individual work centers and any splitting that is required is carried out in 

detailed planning. 
 

Capacity planning 

Capacity planning in Infor COM covers due date monitoring based on work center availability, as 

well as material planning. The earliest dates for the operations on the machines to be planned are 

calculated based on work center occupancy, shift plans, and capacity adjustments. 

Capacity planning basics 

Optimum capacity planning requires a realtime transaction from all operations on the work centers 

to be planned. The feedback can be provided manually on the screen or using an SFDC terminal. 
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The following data must have been entered in the work center master data: 

Pl. type The planning type allows you to determine whether a work center is to be planned 

as a normal work center, a bottleneck work center, or not at all. 

It is advisable not to plan a work center that always has sufficient free capacity 

and will therefore never experience bottlenecks. However, this does not mean that 

the operations that run on the work center are not assigned a due date. It only 

means that no capacity balancing is performed on the machine, in other words, no 

invoicing by earliest date (ED) takes place. If a work center is to be planned, it 

should be flagged as Plannable. 

Shift plans Shift plans form the basis for scheduling orders and machines. 

If possible, you should not make any changes to the default shift plans in Infor 

COM, as different parameters in the configuration access these settings. Events 

such as public holidays, company vacations, etc. must be maintained however. 

Buffer times Buffer times are reserved as breaks between operations for organizational or 

technical reasons. 

Capacity adjustment 

factors 

To incorporate seasonal capacity fluctuations and fluctuations caused by absence 

or vacations into planning, you must define appropriate adjustment factors. These 

factors are maintained in the KAPKORR allocation table. 

 
 

Breakdown parameters in Planning 

There are various breakdown parameters provided for setting up Planning in Infor COM. 

The breakdown parameters are set on the Breakdown parameters for planning dialog box. The 

dialog box is displayed when you select the Batch planning object in the Planning module, or the 

Plan order function in a sales order or production order, or Plan item in the item account (page 

637). 
 

Planning by latest date (LD) 

If this breakdown parameter (see "Breakdown parameters in Planning" page 624) is used, all order 

lines are scheduled backward starting from the due date. Due date calculation for each item and 

operation is based on the relevant BOR. 
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For material lines, the latest date by which the material must be available in order to meet the 

customer's requested delivery date is calculated. For operation lines, it is the latest date by which 

the operation must start in order to meet the due date. 

Example: 

The BOR for item 1 (HR record type) contains the following lines: 

1. The final assembly operation (OP record type) with a setup time (STi) of 15 IM and a runtime 

(RTi) of 8 IM (IM =Industrial minutes). 

2. Material 2 (record type MA), 1 unit (runtime) of which is required for each unit of item 1. 

3. Material 3, 4 units of which are required for each unit of item 1. 

4. The pre-assembly operation with a setup time of 4 industrial minutes and a runtime of 5 

industrial minutes. 

5. Material 4, 2 units of which are required for each unit of item 1. 

6. Shift plan 10 is valid for the operations. It defines a 40-hour week with working hours from 

08:00 to 16:00. 

You now want to manufacture 1000 units of item 1. The requested delivery date is 3/29, at 12:00 

PM. 

SVO Resource STi RTi Qty ST Duration 

HR Item 1   1000 29.3. 12:00  

OP Final assembly 15 8  15.3. 11:51 8015 

MA Material 2  1 1000 15.3. 11:51  

MA Material 3  4 4000 15.3. 11:51  

OP Pre-installation 4 5  7.3. 9:48 5004 

MA Material 4  2 2000 7.3. 9:48  

Calculating the latest date (LD): 

For item 1, the latest date (LD) is the requested delivery date, i.e. 3/29 at 12:00 PM. Backward 

scheduling is performed starting from this due date. 
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The duration of the Final assembly operation is calculated as follows: (1000 units x 8 industrial 

minutes) + 15 industrial minutes = 8015 industrial minutes = 80.15 hours. Calculated backward 

from the requested delivery date of 3/29 at 12:00, the operation must start at 11:51 on 3/15 at the 

latest. 

The duration of the pre-assembly operation is calculated as follows: (1000 units x 5 industrial 

minutes) + 4 industrial minutes = 5004 industrial minutes = 50.04 hours. Calculated backward from 

the requested delivery date of 3/29 at 12:00, the operation must start at 09:48 on 3/7 at the latest. 

Material 2 and Material 3 are required for the final assembly, and must therefore be available on 

3/15 at 11:51 at the latest. Material 4 is required for pre-assembly, and must therefore be available 

on 3/7 at 09:48 at the latest. 

If the latest date (LD) of the first operation (pre-assembly in the example) is already in the past 

when Planning is called, the customer's requested delivery date cannot be met. 

Deactivate the two breakdown parameters Planning by earliest date (ED) (page 627) and Update 

earliest date (ED) at higher levels (see "Update earliest date at higher levels" page 629) if you 

want to perform planning by latest date only. 
 

Parameter for planning by latest date 

You can set the following breakdown parameters (see "Breakdown parameters in Planning" page 

624) when planning by latest date (see "Planning by latest date (LD)" page 624): 
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Rough planned If this option is selected in the Orders for section, the result of the order breakdown 

remains in the planning. Any PO proposals and production orders that are created are 

saved as rough plans in the Rough planned orders object in Planning. From here, 

you can then transfer them to detailed planning in Purchasing or Manufacturing. 

Detailed If this option is selected in the Orders for section, the result of the order breakdown is 

transferred directly from planning to detailed planning. This means: 

The detailed PO proposals created are copied to the PO proposals object in 

Purchasing and can be used to generate purchase orders there. 

The detailed production orders that are created are transferred to the Production 

orders object in Manufacturing. 

Create lots If this check box is selected, the lot creation criteria are checked for every item to be 

planned. The lot creation criteria are stored in the item's master data (in the Lot size 

section on thePlanning tab). The PO and manufacturing lots are created on the basis 

of this data. 

Please note: This only applies to items for which the Fixed requirement 
allocation (see "Fixed and dynamic requirement allocation" page 612) property 

is  not selected. 

Change order 

quantities 

Select this check box if you want to copy quantity changes in a sales order to component 

item orders. This will delete the old order and create a new order with the new quantity. If 

the check box is cleared, the old order is retained and new orders are generated with the 

difference quantity. 

 
 

Planning by earliest date (ED) 

Requirements-oriented materials planning by earliest date (ED) examines the current material and 

capacity situation to identify the earliest possible date when the relevant resource will be available 

for each order line (material or operation). 

The earliest date is a due date from the resource perspective, that is, the sequence of the 

associated orders is not taken into account. 

The order sequence is only taken into consideration by the current date (CD), which is 

automatically identified during ED planning by midpoint scheduling from an order bottleneck. The 

current date can therefore be seen as the earliest date from the order perspective. 

An optimal earliest date lies between the latest date minus the maximum pull-in time (see "Pull-in 

time flag in Planning" page 614) and the latest date itself. 
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A delay occurs if the earliest date is later than the corresponding latest date. 

Please note: When determining the earliest/current date in the context of material planning, you 

must ensure that the PO dates and delivery times are maintained accurately in the Purchasing 

module. 
 

Parameter for planning by earliest date 

You can set the following breakdown parameters (see "Breakdown parameters in Planning" page 

624) when planning by earliest date (see "Planning by earliest date (ED)" page 627): 
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Include material Select this check box if you want to plan material (MA records) when planning by the 

earliest date (ED). 

The earliest dates of the requirements are then calculated, based on the availability of 

materials.  

The following applies for items planned on an order basis with the Bottleneck 

(always plan) or Full planning only planning types: 

If a bought-in item is missing, that is, if the requirement cannot be covered from the 

available warehouse inventory, the system creates a corresponding rough planned 

external procurement order. 

If an in-house item is missing, a corresponding rough planned production order is 

created. 

For items that are planned using minimum inventory monitoring (page 656), with 

the planning types Reorder point (fixed quantity), Reorder point (variable 

quantity), Reorder cycle (fixed quantity), or Reorder cycle (variable 

quantity), it should always be possible to cover the requirement from the available 

warehouse inventory. If this is not possible, the exception flag S (=shortage) is 

displayed in the order structure. 

Note : Items that are flagged in the master data with the Do not plan planning type 

are not planned. 

Include work centers Select this check box if you want operations (OP records) to be taken into account 

when reconciling issues/receipts by the earliest date (ED). When planning is started, 

reconciliation of issues/recepts is then used to calculate the earliest date of each 

operation. 

Note : Issue/receipt reconciliation by ED can also be accessed using the Reconcile 

issues/receipts by ED function in the capacity account (page 649). 

Select both options if you want to plan material and operations. Planning of MA and OP 

records is very complex because when assigning dates, the system must not only take 

into account the availability of material but also the availability of capacity in the 

relevant period. 

 
 

Update earliest date at higher levels 

Using the Update ED at higher levels  breakdown parameter (see "Breakdown parameters in 

Planning" page 624) (also called delivery modification), any changes to the earliest dates (ED) that 

were made during the current issues (operations and material) are updated forward along the 

order structure in all parent levels of the entire order network, up to the finished product. 
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Parameter for planning by earliest and latest date 

You can also set the following breakdown parameters (see "Breakdown parameters in Planning" 

page 624) for planning by the earliest and latest date: 

Planning type 

You can choose between two planning types: 

Full planning During full planning, all resources assigned the For full planning only or 

Bottleneck (always plan) planning type are planned. Resources assigned these 

planning types are broken down during full planning and checked for shortages. 

Orders are created to cover the requirement and dates are planned. Select this 

planning type if you want to copy the orders to detailed planning or to Purchasing. 

Fast planning During fast planning, only items assigned the Bottleneck (always plan) planning 

type are planned. Bottleneck resources include, for instance, bottleneck machines or 

materials that are difficult to obtain or that have a long replenishment time. The 

planning process is shorter, since not all lines and levels of an order are checked in 

this planning type. This procedure is useful for quickly checking the dispatching of a 

sales order, for example. 

Exception check 

See Exception check in Planning (page 630). 
 

Exception check in Planning 

The following breakdown parameters (see "Breakdown parameters in Planning" page 624) control 

the exception check function for Infor COM Planning. 



Infor COM 7.5 User Guide | 631 

 

Planning 

 

Surplus A receipt has a surplus if its subsequent issues do not fully deplete the inventory. This only 

applies, however, if the receipt quantity was not determined by defining the minimum 

quantity or the rounding factor during lot size creation. 

 

Shortage An issue shortage occurs if the balance is negative. 

 

Delay Delay indicates that the customer's requested delivery date cannot be met due to the 

resource being unavailable. The following situations can occur: 

The latest date is earlier than the current date (system date) plus the replenishment time. 

The earliest date is later than the latest date. 

The current date is later than the latest date. 

For more information on the use of exception flags in Planning, see Exception flags in 

Planning (page 615). 

 

 



632 | Infor COM 7.5 User Guide 

 

Planning 

 

Allocation tables (Planning) 

The following allocation tables belong to the Planning module: 
 

ABCKLAS 

Description:  ABC classification 

Usage:  For more details, see ABC analysis (page 693). 

Type: This allocation table can be modified by the user. 
 

BUFTIME 

Description:  Transition time specification 

Usage:  This allocation table is used for storing starting points for the transition time 

specifications in APS. Transition time specifications define the intervals in which the operations of 

a production order are to be scheduled. 

0: The Infor COM transfer time is used (that is, buffer times and transfer times, for example). 

1: The Infor COM transfer times are ignored. Once the current operation has been completed, the 

next operation is started with the next shift. 

2: The Infor COM transfer times are ignored. Once the current operation has been completed, the 

next operation is started the following day. 

3: The Infor COM transfer times are ignored. Once the current operation has been completed, the 

next operation is started the following week. 
 

IMCPASSIGNM 

Description:  Types of fixed requirement allocation 
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Usage:  This allocation table is used for storing the fixed requirement allocation types. You can 

make your selection on the Planning tab in the item master. 
 

IMCPLSTATUS 

Description: Loading statuses for plant overviews (item account) 
 

KAPKORR 

Description:  Absolute capacity adjustments 

Usage:  For more detailed information, see Absolute capacity adjustments (see "Make absolute 

capacity adjustments" page 650). 

Type: This table must be filled in by the user. 
 

MINBESTERM 

Description:  Minimum inventory calculation 

Usage: This table contains both of the options included in the combo box in the Calculate min. 

inv. field on the Planning tab in the item master data: 

0: Do not calculate 

1: Use Median Absolute Deviation calculation (MAD) 

For more detailed information, see Calculate minimum inventory quantities for planning types 1 

and 2 using MAD (page 676). 
 

PLANART 

Description:  Planning types 
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Usage:  This is the most important parameter in the Planning module. It determines the 

procedure to be used for planning items. The planning types stored in this allocation table are 

provided for selection on the Planning type section of the Planning tab in the item master data. 

Type: The user is not allowed to modify this allocation table. 
 

PLANKAP 

Description:  Relative capacity adjustments 

Usage:  For more detailed information, see Relative capacity adjustments (see "Make relative 

capacity adjustments" page 651). 

 
 

STERM 

Description:  Pull in/postpone LD planning 

Usage:  The entries are stored in the LD field on the Inventory area tab in the item account. 

 
 

UDECK 

Description:  Shortage/Surplus 

Usage: The flags stored in this allocation table are used when planning a resource if there is a 

shortage/surplus, provided the check boxes for checking the shortage and/or surplus are selected 

in the planning dialog box. The flags enable you to select specific relevant orders in exceptions 

processing so that you can respond to the situation by adjusting the quantity, for example. The 

following flags are stored in the allocation table: 

 Inventory availability not checked 

 Absolute surplus 

 Absolute shortage 
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For more information, see Exception check in Planning (page 630). 

Type: The user is not allowed to modify this allocation table. 
 

VERZUG 

Description:  Delay flags 

Usage:  You can set the following delay flags: 

0 No delay 

1 LD delay 

2 ED delay 

3 CD delay 

The Delay flag is set in Planning if the latest date (LD) is in the past, if the earliest date (ED) is later 

than the LD, or if the current date (CD) is later than the LD. For the flags to be set, the LD and ED 

planning parameters must be selected on the planning dialog box, the exception check function 

must be enabled, and the Delay check box must be selected. Once planning has been carried out, 

all orders with a delay flag can be loaded to eliminate delays in exceptions processing. 

For more information, see D = Delay in Exception flags in Planning (page 615). 

 
 

WBZSPLAN 

Description:  Time units for replenishment time 

Usage: This allocation table populates the Replenishment time combo box on the Planning tab in 

the item master. It specifies the replenishment time unit (in calendar weeks, calendar days, or 

workdays). For more information, see Replenishment time. 
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XYZKLAS 

Description: XYZ classification 

Usage: See XYZ analysis (page 691). 
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Call 

Planning > Item account 

Description 

An item account is managed for every item planned in Infor COM. An item account contains the 

following information: 

 The orders for which issues of the item are scheduled 

 Anticipated receipts from purchase orders or production orders 

 The quantities that are available in addition to the planned quantities 

 The product into which the item is integrated (if it is a component item) 

Functions 

Plan item: This function creates PO proposals for items with changes relevant for planning. It can be used for all 

receipt generation types. 

In practice 

Movements in the item account stem from the following areas: 

Receipts: 

 Warehouse inventory, W/H inv. 

 Rough planned PO proposals and production orders 

 PO proposals and POs from Purchasing 

 Detailed production orders 

Issues: 

 Sales order requirements from Sales 

 Rough planned material requirements 

 Detailed material requirements from Manufacturing control 

The receipts and issues displayed in the item account are sorted according to the current date (CD) - the receipt 

precedes the issue if the current date is the same. 

Special functions for order release items: 

Item account 
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 Order release items have a unique Order release item account view, in which the order 

release order data for the item is displayed. 

 Only rough planning takes place when the Plan item function is selected (see Rough planned 

orders (page 663)). 

 Selecting Go to and Order releases (e-PROCUREMENT) takes you to Order release 

management. 

Background: Since the item account contains the quantities and due dates of the rough planned orders down to 

the day, but weekly demands, monthly demands, and remaining requirements are combined in order release 

management, differences may arise outside the precise daily order release dates. Order release management 

provides more detailed information. 

 

 
 

Record types (item account) 

The RT field on the item account (page 637) tabs shows the record type: 
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Record type ID Label Description 

IR 5 Inventory record 

(available) 

The inventory count record always appears in the first row of an 

item account table, provided the item is included in inventory. This 

record is used in balancing. 

HR 10 Header record Header records are resources and identify the receipts. Purchase 

orders and production orders generate receipts for the item 

inventory and therefore act as resources. 

MC 15 By-product header This record type represents by-products. By-products are created 

if several finished product types are created from a single source 

material during one or more operations. By-product manufacturing 

is often used if secondary products are manufactured in addition to 

the actual product in order to avoid residual materials (by optimizing 

cutting, for example). 

D 16 Residual/waste 

material 

This record type represents residual and waste material. 

OP 60 Operation An OP record represents an operation. An operation describes an 

individual manufacturing step during manufacturing planning and 

sales management when a production order is being processed. 

SCO 65 External source This record type represents a supplier of subcontracted material. 

TL 70 Tool This record type represents a tool required for manufacturing. In 

scheduling, a tool item is taken into account in the same way as a 

material line. 

TL 75 Tool receipt This indicates the header record type for tools. It is used whenever 

more than one tool receipt is created in a BOR. This is the case, for 

example, with disassembly BORs that have several tool 

components as receipts. Tools are also assigned this record type in 

Purchasing. 

MA 90 Material record Material records are records that create requirements and indicate 

issues. Sales orders create requirements by triggering a 

quantity-based issue from the item inventory. Production orders 

create requirements if they require one item for the manufacture of 

another item (finished product).  

SCM 91 Subcontracted 

material 

The SCM record represents externally procured material. 

TX 110 Text record This record type represents a text-only line that is not taken into 

account in scheduling, capacity calculation, or covering 

requirements. For example, it can be used to enter alternative lines 

that can then be selected quickly if required. 

SCO 115 Subcontracted 

manufacturing 

The SCO record type represents a subcontracted manufacturing 

component. For more information, see Subcontracted 
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manufacturing. 

AS 120 Assembly This record type represents a material line that is created as part of 

manufacturing and can be processed further. It has its own 

manufacturing structure that is listed in the order under the AS 

record. Unlike MA records, assemblies are not incorporated into 

inventory. Assemblies are always scheduled in parallel, unless this 

option is explicitly disabled (using synchronization points). 

PH 125 Phantom 

assembly 

This record type represents an assembly that is saved as a BOR. 

SY 130 Synchronization 

point 

This record type is a delineation line between assemblies that 

prevents parallel scheduling of assemblies. Since the 

subcontracted manufacturing part of a production order is handled 

as an assembly, a synchronization point also removes parallel 

planning in scheduling when outsourcing is used. 

F 140 Transportation This record type represents a transportation line between two 

operations. It is taken into account in scheduling in the same way as 

an operation line. A transportation line may also represent the 

chronologically latest line of the production order. 

NC 150 NC program  

 
 

Status types in Item account 

A status flag provides information on the current processing status of an order. The status 

information consists of a status value and a brief description, for example, 191 Order printed, 

which indicates that an order confirmation has been printed. The Status field on the Balance 

displays the description only. The corresponding status values are recorded in the Status column 

on the Due dates tab. 

The following status types are available: 
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For rough planned orders:  10 Rough planned 1 

 11 Rough planned 2 

 12 Quantity fixed 

 13 Lot 

 A lot created by Infor COM for a purchase order/manufacturing. 

 14 Man. generated 

 A manually generated lot for a purchase order/manufacturing. 

 15 Sys. generated 

This is a purchase/production order generated by Infor COM. 

For production orders: 
See Status (Manufacturing) 

For sales order: See Status (Sales) 

For purchase orders: 
See Status (Sales) 

Note: Status types are maintained in the ZUSTDART allocation table. 
 

Eliminate shortages in item account 

If irregularities arise in balancing or scheduling, you can correct them in the item account. 
 

Generate receipts in the Item account 

To correct shortages and negative balances, use one of the following functions in the item account 

(page 637): 
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Function Description 

Generate receipts This function balances all receipts and issues in the item account by current date (CD) 

and initiates a receipt for each individual shortage. 

Create lots This function balances all receipts and issues in the item account by current date (CD). 

In the event of a shortage, several requirements may be covered by one receipt. The 

received quantity is calculated according to the lot parameters set for the item in lot 

creation. 

Insert order Use this function to manually create a planning order with the quantity needed to cover 

requirements. To do this, position the cursor in the line with a negative balance and then 

select this function. 

Plan item  This initiates a breakdown of the entire resource structure, right down to the lowest level. 

The system automatically creates planning orders (rough planned PO proposals and 

production orders) to cover issues. 

 
 

Access issues/receipts reconciliation in item account 

 

Issue/receipt reconciliation checks the scheduled reconciliation of receipts and issues. 

Open issues/receipts reconciliation 

To start issue/receipt reconciliation in the item account, select Functions > Reconcile 

issues/receipts. In the dialog box that is displayed, select issue/receipt reconciliation by either 

latest date or by earliest date. 
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Reconcile issues/receipts by latest date 

An inventory receipt must arrive on time in order to be able to cover requirements. However, it 

should not arrive too early either, otherwise it will cause excessive storage costs. Issue/receipt 

reconciliation by latest date (LD) was designed for that purpose. It checks whether the LD of the 

issues (MA records) matches the LD of the receipts (HR records). If this is not the case, the item 

account is first sorted by the current dates (CD). The LDs of the issues and receipts are then 

adjusted, provided the dates of the orders can still be modified. You can modify rough planned 

orders that have not yet been fixed, or detailed orders if their processing status still permits this 

(specified by the COMMON.DISPOSITION.FERTIGUNGNOAENDZUST and 

COMMON.DISPOSITION.EINKAUFNOAENDZUSTWS parameters). Fixed lines that cannot be 

taken into account are flagged accordingly. In this situation, the planner must make the required 

changes manually. A receipt whose LD can no longer be modified is assigned the Pull in LD or 

Push out LD exception flag. 

Reconcile issues/receipts by earliest date 

You want to calculate the earliest date when a requirement regarding current material availability 

can be issued or delivered. Therefore, the system checks whether the earliest date (ED) of the 

receipt (resource) and the ED of the issue (requirement originator) match. If this is not the case, 

the ED of the receipt is moved to the ED of the issue. This avoids unnecessary issue inventory 

times. 

Issue/receipt reconciliation by ED also takes place when items are planned during earliest 

date/current date calculation. It is carried out for both fixed requirement allocations and for items 

without fixed requirement allocations (FRA). For more information, see Fixed and dynamic 

requirement allocation (page 612). 
 

Change fixed requirement allocation 

Using the Change assignment function in the item account, you can remove existing assignments 

from the issues and receipts for an item or you can make new assignments. 
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Remove fixed requirement allocation 

To remove fixed requirement allocations (FRA) from the item account, complete the following 

steps. 

1. Select Planning > Item account and open the item account for the item. 

2. Select the Assignment tab. 

The table is split for FRA items. The left side lists every issue row by row, and the right side 

lists every receipt. If an issue has already been assigned to a receipt, they are both shown 

in the same row. If an issue has not yet been assigned a receipt to cover it, the receipt side 

of the row is empty. If a receipt has not yet been assigned, the issue side is empty. 

3. Position the cursor in the row of the issue from which you would like to remove the assignment. 

4. Select Functions > Change assignment. 

Note:  If, when you select this function, the cursor is positioned on the line of a receipt that 

has not been assigned, a corresponding message is displayed. 

5. Click the Separate button in the dialog box. This closes the dialog box and the allocation is 

removed. The issue and receipt are displayed in separate rows in the table. 

You could now assign another receipt to the issue. For more information, see Allocate fixed 

requirement (see "Change fixed requirement allocation" page 643). 
 

Create fixed requirement allocation 

To create fixed requirement allocations (FRA) in the item account, complete the following steps. 

1. Select Planning > Item account and open the item account for the item. 

2. Select the Assignment tab. 

The table is split for FRA items. The left side lists every issue row by row, and the right side 

lists every receipt. If an issue has already been assigned to a receipt, they are both shown 

in the same row. If an issue has not yet been assigned a receipt to cover it, the receipt side 

of the row is empty. If a receipt has not yet been assigned, the issue side is empty. 
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3. Position the cursor in the row of the issue in which you would like to make a fixed allocation to 

cover requirements. 

You can then assign either an existing order or a new order to cover to the issue. 

4. Select Functions > Change assignment. 

5. Optional: To assign an existing order, complete the following steps: 

1. Select the order in the Order ID field in theReceipt section. 

2. Click Assign. 

The issue and selected receipt are now located in one row of the table. 

6. Optional: To generate and assign a new order, complete the following steps: 

3. Click New order. 

4. If necessary, correct the order data and click OK. 

The new order is now displayed as a receipt and is located in a row together with the issue. 

The newly created order is managed in the Rough planned orders object in Planning. From 

there it can be transferred to detailed planning (see "Transfer to detailed planning" page 

665). 

For information on how to remove fixed requirement allocations, see Remove fixed 

requirement allocation (page 644). 
 

Calculate available inventory in the item account 

The following simplified example explains how to calculate available inventory within the 

replenishment time of the item account (page 637). 

Sales data: 

The current date is 4/20. The replenishment time for the item is 20 days. The replenishment date 

is therefore 5/10. 
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If an order (or a purchase order) to manufacture the item was issued today, the manufactured 

quantity would be available on 5/10 at the earliest/latest to cover requirements. Until then, both 

previously planned and new requirements can only be met by the current warehouse inventory 

and the receipts planned during this period. The primary aim of calculating available inventory is to 

identify exactly which quantities are available to you on a specific date in this period to cover new 

orders. 

The receipt/issue situation on 4/20 is as follows: 

 Order SVO Due date Receipt Issue Plan. bal. Available 

1  IR  100,00 0,00 100,00 30,00 

2 PrO1 HR 20.04.01 30,00 0,00 130,00 30,00 

3 O2 MA 20.04.01 0,00 70,00 60,00 30,00 

4 O5 MA 25.04.01 0,00 30,00 30,00 30,00 

5 PrO3 HR 30.04.01 20,00 0,00 50,00 50,00 

6 PrO4 HR 05.05.01 130,00 0,00 180,00 130,00 

7 O8 MA 10.05.01 0,00 50,00 130,00 130,00 

8 A10 MA 12.05.01 0,00 110,00 20,00 0,00 

9 O12 MA 20.05.01 0,00 20,00 0,00 0,00 

Note: The table structure is the same as on the Balance tab of the item account. 

Explanation 
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Row 1 
The IR record type indicates the current warehouse inventory which consists of 100 UOM of the 

item. This is evaluated as a receipt. Any inventory in the quarantine warehouse is not included. 

The Available field in the IR record of an item account shows today's available quantity, i.e. for 

cash sales. In the example, 30 UOM are available, although production order PrO1 yields a 

warehouse inventory of 100 UOM and a receipt of 30 UOM, giving a total inventory of 130 UOM. 

However, 70 UOM + 30 UOM = 100 UOM of this have already been allocated to orders O2 and 

O5. 

The 20 UOM received by production order PrO3 on 4/30 arrive too late to cover the requirements 

of orders O2 and O5. 

If you are not interested in how much inventory is currently available, and are more interested in 

the amount of inventory available at a later delivery date requested by the customer, assign the 

requested date to the correct time period in the item account. The available quantity will be 

displayed here. 

For example, 4/22 would fall within the time period created by the due dates for orders O2 and O5. 

The available inventory is always derived from the earlier date. In this example, this corresponds to 

the 4/20 date in row 3 where the available inventory is 30 UOM. 

Note that the available inventory is only calculated for dates that lie within the replenishment time. 

In the example, the inventory is calculated for requested delivery dates within the period of 4/20 to 

5/10 only. Where order requirements have a requested delivery date that is later than the 

replenishment date, the requirements can be covered by a production order created today or by an 

issued purchase order. 

Row 2 
Production order PrO1 generates a receipt of 30 UOM and increases the planned balance from 

100 UOM to 130 UOM. The available inventory of 30 UOM does not change, as the two orders O2 

and O5 still require 100 UOM. 

Rows 3 and 4 
Together, orders O2 and O5 generate an issue of 100 UOM. Due to this requirement, only 30 

UOM of the current balance of 130 UOM of available inventory are actually free to cover new 

orders with a requested delivery date in this period. 

Row 5 
With production order PrO3, 20 UOM are received on 4/30, increasing the planned balance to 50 

UOM. 50 UOM of the item are now available at this point to cover the requirements of new orders, 

even though 50 UOM are already planned for order O8 with a requested delivery date of 5/10. The 

quantity and timing of this requirement can be covered sufficiently by the receipt of production 

order PrO4 on 5/05, which means it does not have to be accounted for at this point. 

Row 6 
Production order PrO4 provides an additional receipt of 130 UOM on 5/05, increasing the planned 

balance to 180 UOM. However, the available inventory only increases to 130 UOM, as 50 UOM 

are already planned for order O8 on 5/10. 

Row 7 
Order O8 generates an issue of 50 UOM on 5/10. The available inventory still amounts to 130 

UOM, since the 50 UOM from order O8 were already accounted for in row 6. 

The replenishment time ends here 
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Rows 8 and 9 Rows 8 and 9 contain orders O10 and O12 with due dates of 5/12 and 5/20. Neither 

row displays available inventory anymore, as these due dates are later than the 

replenishment date of 5/10. In order to be able to cover requirements that only arise 

after the replenishment date of 5/10, production orders created today or purchase 

orders that are issued can cover the required receipt. They do not need to be 

covered by the available inventory that is available up to 5/10. 

Although no more available inventory will be calculated, you can see from this 

example that the requirements of orders O10 and O12 could also be covered by the 

available inventory of 130 UOM in the current order situation, provided no more 

requirement-generating orders are planned within the replenishment time in the 

interim. 
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Call 

Planning > Capacity account 

Description 

A capacity account is managed in Infor COM for every work center (for example, for a machine). A 

capacity account provides you with information on the following points: 

 The Shift plan assigned to the work center 

 The planning type used to plan the work center 

 The issues planned on the work center group, i.e. when and for which orders a capacity 

requirement exists. 

 The receipts that are scheduled. The system lists the capacities (WCA records) available for 

each calendar week. These are calculated from the shift plan assigned to the work center 

group. 

 The balance calculated by comparing a machine’s available capacity according to the shift 

plan and correction factors in the form of WCA records, and the capacity requirements 

scheduled on a machine in the form of OP records. 

 The finished product for which the capacities are required. 

 The order that is delayed, i.e. whose requested delivery date cannot be met. 

 The way in which the issues are distributed on the machines assigned to the work center 

group. 

In practice 

Bottlenecks at certain work centers can be eliminated by increasing capacities. Planning in Infor 

COM offers absolute and relative capacity adjustments. The manner in which the relevant 

calendar weeks are referred to is the difference between absolute and relative capacity 

adjustments (see "Make relative capacity adjustments" page 651). 

 For an absolute capacity adjustment, the affected week is identified using its calendar number. For 

instance, enter the number 21 if you want to make a capacity adjustment in calendar week 21 

specifically. 

Capacity account 
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 For a relative capacity adjustment, numbering is relative to the current calendar week. In the system, this 

is indicated by the number 0. The subsequent weeks are incremented. If you want to define adjustments 

for the next week and the week after that, for example, these weeks are assigned the numbers 1 and 2. 

This relationship remains constant over time. 

 
 

Make absolute capacity adjustments 

To correct the capacity account of a work center using absolute capacity adjustments, complete 

the following steps: 

1. From the Planning submenu, select Capacity account to open the start form. 

2. Enter the ID of the relevant work center in the Work center field on the Open tab, or select it 

from the combo box in the field. Confirm by clicking Load. This opens the capacity account of 

the work center. 

3. Make sure that the cursor is positioned in an OP record. 

4. Select Go to > Capacity adjustment tables, then select the Absolute capacity adjustment 

command from the submenu that is displayed to load the KAPKORR allocation table. 

Note:  You can open the KAPKORR allocation table outside the capacity account by 

selecting Allocation tables in the System functions. 

5. In a blank Res/work ctr field, enter the ID of the work center group that you just loaded in the 

capacity account or select one from the combo box. Omit this step if you only want to change 

the adjustment factor of a week you entered previously. Start the procedure from step 7. 

6. In the Wk field, enter the week (according to the calendar) in which you want to change the 

capacity. If, for example, you want to make an adjustment in week 12, enter the number 12. 

See also the explanation at the end of this Help topic. The Date is automatically entered after 

you exit the Wk field. 

7. In the Adj. % field, enter the adjustment factor by which you want to increase/decrease the 

capacity. For example, if you want to increase capacity to 150%, type in 150. 

8. Save your entries. 
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9. Close the table containing the adjustment factors by clicking the Close button at the top of the 

Infor COM title bar. This takes you back to the capacity account. The changed capacities are 

displayed there and included in the relevant balances. You will need to access these again if 

there are negative balances. 

10. Use the Reconcile issues/receipts by ED (earliest date) function to schedule the earliest dates 

again. After the capacity increase, the ED may precede the previous one. 

11. To perform scheduling after the earliest date up to the finished product, select the Plan work 

center function. 

12. In the Breakdown parameters for planning dialog box that is now displayed, select Update ED 

at higher levels and click Start to confirm. For more information on breakdown parameters, see 

Breakdown parameters (see "Breakdown parameters in Planning" page 624). 

Note:  If you change capacities, you must plan the work center (see "Plan work center" 

page 654) again. 

 

 
 

Make relative capacity adjustments 

To make a relative capacity adjustment in the capacity account of a work center, proceed as 

follows: 

1. From the Planning submenu, select Capacity account to open the start form. 

2. Enter the ID of the relevant work center in the Work center field on the Open tab, or select it 

from the combo box in the field. Confirm by clicking Load. This opens the capacity account of 

the work center. 

3. Make sure that the cursor is positioned in an OP record. 

4. Select Go to > Capacity adjustment tables and select the Relative capacity adjustment 

command from the displayed submenu. This loads the PLANKAP allocation table. 

Note: You can also open the PLANKAP allocation table outside the capacity account using 

the Allocation tables object in the Administration folder in System functions. 
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5. In a blank Res/work ctr field, enter the ID of the work center group that you just loaded in the 

capacity account or select one from the combo box. Omit this step if you only want to change 

the adjustment factor of a week you entered previously. Start the procedure from step 7. 

6. In the Rel. wk field, enter the number of the week in question relative to the current week. For 

more information, see the explanation at the end of this Help topic. 

7. In the Adj. % field, enter the adjustment factor to which you want to increase/decrease the 

capacity. For example, if you want to increase the capacity to 150%, type in 150. If, for a 

particular reason, you need to reduce the capacity of the work center to 80% in this week, type 

in 80. 

8. Save your entries. 

9. Close the table containing the adjustment factors by clicking the Close button at the top of the 

Infor COM title bar. This takes you back to the capacity account. The changed capacities are 

displayed there and included in the relevant balances. You will need to access these again if 

there are negative balances. 

10. Use the Reconcile issues/receipts by ED (earliest date) function to schedule the earliest dates 

again. After the capacity increase, the ED may precede the previous one. 

11. To perform scheduling after the earliest date up to the finished product, select the Plan work 

center function. 

12. In the Breakdown parameters for planning dialog box that is now displayed, select Update ED 

at higher levels and click Start to confirm. For more information on breakdown parameters, see 

Breakdown parameters (see "Breakdown parameters in Planning" page 624). 

Note:  If you change capacities, you must plan the work center (see "Plan work center" 

page 654) again. 

 
 

Making absolute and relative capacity adjustments in APS 

This topic describes how to make absolute or relative capacity adjustments (see "Capacity 

account" page 649) in APS. 
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1. In the APS configuration , set the Capacity adjustment tables option on the Data transfer 1 tab 

to Yes. The changes you have made to the capacity account in Infor COM determine which 

data is linked. 

2. To display loaded adjustment values, select Data > Capacity adjustment tables > Absolute 

capacity adjustment or Relative capacity adjustments. 

These values adjust the capacity supply of the associated balancing period, i.e. the content of 

the supply bars in the balancing views. 
 

Change shift plan in Planning 

Using the following procedure, you can increase capacity in the capacity account in the Planning 

module by changing the annual and daily shift plans. 

Please note: The shift plan that you want to change may also be assigned to other machines, 

depending on how the shift plans are organized. In this case, this shift plan’s capacity is also 

increased. 

1. In Planning, open the Capacity account for a work center. The Shift planning field in the header 

form allows you to view the current valid shift plan for the work center. 

2. Select Go to > Capacity adjustment tables > Shift plan to open the currently assigned shift 

plan. 

3. On the Annual overview tab in the shift plan, enter the ID of the relevant daily plan for the 

required days or select Functions > Enter daily shift plans to enter several daily plans 

simultaneously. 

4. Usually, an annual shift plan consists of daily plans stored in the Mon - Sun fields with the daily 

plan IDs. You can change an annual shift plan by assigning it other daily plans. Alternatively, 

you can change the stored daily plans. To do this, select Go to > Daily shift plan to access the 

daily shift plan. The Interval tab displays the various shift periods contained within a particular 

daily plan. You can now change the daily plan by assigning other shifts to it or by changing the 

times. 

5. Save your entries. 

6. Close the shift plan to return to the capacity account. 
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Note: If you change capacities, you must plan the work center (see "Plan work center" page 654) 

again. 

 
 

Plan work center 

You can eliminate work center bottlenecks by increasing capacity. There are several ways of 

doing this: 

 Assign a different shift plan (see "Change shift plan in Planning" page 653). 

 Make absolute (see "Make absolute capacity adjustments" page 650) or relative (see "Make 

relative capacity adjustments" page 651) capacity adjustments. 

Since changes to the capacity of a work center group can affect the entire order network, you need 

to replan the work center. Changes to the earliest dates (ED) are then updated directly on all 

parent levels of the order network. 

1. Load the capacity account (page 649) of the relevant work center if you have not already done 

so. 

2. Select Functions > Plan work center to display the Breakdown parameters for planning form. 

3. Make sure that the Update ED at higher levels option is selected. 

4. Click Start. 
 

Execute issues/receipts reconciliation by earliest date 

Issue/receipt reconciliation by the earliest date (ED) checks the coordination of capacity and issue 

schedules and pulls in the ED of capacity issues to the ED of capacity receipts. 

This is automatically carried out during planning when determining earliest/current date for every 

work center to be planned, but you can also do this manually for a specific work center in the 

capacity account. 

To carry out the issue/receipt reconciliation manually, complete the following steps: 

1. Select Planning > Capacity account and load the relevant work center. 
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2. Select Functions > Reconcile issues/receipts by ED. 
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Call 

Planning > Minimum inventory monitoring 

Description 

Minimum inventory monitoring is a stochastic (consumption-oriented) procedure for planning 

purchased and in-house manufactured resources. 

Minimum inventory monitoring is used to monitor the inventory of resources for shortfalls in 

specified minimum quantities. If a shortfall is determined, rough planned orders are automatically 

generated to cover the determined requirements. 

What happens during minimum inventory monitoring? 

 Minimum inventory monitoring takes into account all items that have been assigned the 

planning types Reorder point with fixed PO quantity, Reorder point with variable PO quantity, 

Reorder cycle for fixed PO quantity, and Reorder cycle for variable PO quantity. 

 The inventory in the warehouse and all receipts with an earliest date (ED) within the today 

(=system date) + replenishment time (RPLT) period are added up. 

 The calculated totals are compared with the corresponding minimum inventory quantities that 

have been set. 

For more information on minimum inventory monitoring taking into account the issues within 

the replenishment time, see theConfiguration section. 

 If the inventory totals that are calculated are less than the minimum inventory quantities that 

have been set, receipts in the form of rough planned PO proposals are used to cover the 

requirement for purchased items, and receipts in the form of rough planned production orders 

are used to cover the requirement for items manufactured in-house. 

 

Configuration 

You can use the COMMON.DISPOSITION.MINBESTUEBERWMITABG=yes parameter to specify 

that during minimum inventory monitoring, the inventory totals that are calculated are compared 

with both the specified minimum inventory and the issues whose current date (CD) falls within the 

period Today (=system date) + replenishment time (RPLT). 

Minimum inventory monitoring 
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The greater of the two values is then used in the minimum inventory monitoring process. 

Example: 

Fixed minimum inventory: 50 UOM, Issues determined within the replenishment time: 60 UOM. 

Determined inventory at the time of minimum inventory monitoring: 58 UOM.  

Result: In this case, minimum inventory monitoring identifies a shortage. A receipt is created. 

Note: The issues caused by sales orders without a confirmed date are not taken into account 

when calculating the issue total. 

In practice 

Before you can plan an item using minimum inventory monitoring, you must select the Min. 

inventory option in the Pl. type section of the Planning tab in the item’s master data. This enables 

the Minimum inventory tab. On this tab, enter the planning types (see "Minimum inventory 

monitoring planning types" page 657) and the minimum inventory parameters for the relevant 

warehouse address. 

With the help of the Infor COM batch control process, it is possible to automatically start the 

minimum inventory monitoring at a certain time by using the bfrm4.AppMinBestUeberw action. 
 

Minimum inventory monitoring planning types 

The planning types available for minimum inventory monitoring (page 656) are outlined below: 

Reorder point with variable PO quantity 

(=Planning type 4) If you assign this planning type to an item, it is planned as follows during 

minimum inventory monitoring: 

The inventory in the warehouse, and all receipts with an earliest date (ED) within the today (= 

system date) + replenishment time period are added. 

If the calculated total is less than the minimum inventory that has been set, the shortage is 

covered by creating a rough planned PO proposal for a purchased item or a rough planned 

production order for an in-house item. 
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The PO or manufacturing quantity in this type of rough planned order is determined by the 

inventory limit set in the item master minus the inventory total that is calculated. 

Set the Min. inv. and Inventory limit minimum inventory parameters on the Min. inv. tab in the item 

master data. 

 

If the order quantity is less than the minimum lot size, the order quantity is increased to this 

amount. The system then checks whether the order quantity is a whole-number multiple of the 

rounding factor. If not, the quantity is increased to the next value. 

Set the minimum lot size and the rounding factor in the Lot size form section on the Planning tab. 

Reorder point with fixed PO quantity 

(=Planning type 5) If you assign this planning type to an item, it is planned as follows during 

minimum inventory monitoring: 

The inventory in the warehouse, and all receipts with an earliest date (ED) within the today (= 

system date) + replenishment time period are added. 

If the calculated total is less than the minimum inventory set in the item master, the shortage is 

covered by creating rough planned PO proposals for purchased items and rough planned 

production orders for in-house items. 

The PO or manufacturing quantity in such a rough planned order corresponds to the PO quantity 

that you assigned to the item. 

You set the Min. inv. and PO quantity minimum inventory parameters on the Min. inv. tab. 

 

Reorder cycle for variable PO quantity 

(=Planning type 6) If you assign this planning type to an item, it is planned as follows during 

minimum inventory monitoring: 

When you call the minimum inventory monitoring function, the system first determines the current 

valid date at that moment (that is, the system date) and the date of the last minimum inventory 

monitoring process. 
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The system then checks whether the current date is within the period comprising the date of the 

last minimum inventory monitoring + PO period. Enter the PO period on the Min. inv. tab as a 

number of days. 

If minimum inventory monitoring is performed on a date that falls within this period, the item is not 

taken into account. 

If the current minimum inventory monitoring process is carried out on a date after this period, the 

inventory in the warehouse, and all receipts with an earliest date (ED) within the today (system 

date) + replenishment time period are added. 

If this calculated total is less than the minimum inventory that has been set, the shortage is 

covered by creating a rough planned PO proposal for a purchased item and a rough planned 

production order for an in-house item. 

The PO or manufacturing quantity in this type of rough planned order is determined by the 

inventory limit set in the item master minus the total that is calculated. 

You set the Min. inv. and Inventory limit minimum inventory parameters on the Min. inv. tab. 

 

If the order quantity is less than the minimum lot size, the order quantity is increased to this 

amount. The system then checks whether the order quantity is a whole-number multiple of the 

rounding factor. If not, the quantity is increased to the next value. 

You specify the minimum lot size and rounding factor in the Lot size section of the form. 

Reorder cycle for fixed PO quantity 

(=Planning type 7) If you assign this planning type to an item, it is planned as follows during 

minimum inventory monitoring: 

When you call the minimum inventory monitoring function, the system first determines the current 

valid date at that moment (that is, the system date) and the date of the last minimum inventory 

monitoring process. 

The system then checks whether the current date is within the period comprising the date of last 

minimum inventory monitoring + PO period. 

Specify the PO period on the Min. inv. tab as a number of days. 
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If minimum inventory monitoring is performed on a date that falls within this period, the item is not 

taken into account. 

If current minimum inventory monitoring runs on a date after this period, the inventory in the 

warehouse, and all receipts with an earliest date (ED) within the today (system date) + 

replenishment time period are added. 

If this calculated total is less than the minimum inventory that has been set, the shortage is 

covered by creating a rough planned PO proposal for a purchased item and a rough planned 

production order for an in-house item. 

The PO or manufacturing quantity in this type of rough planned order corresponds to the fixed PO 

quantity that you assigned to the item. 

You set the Min. inv. and PO quantity minimum inventory parameters on the Min. inv. tab. 

 
 

Call minimum inventory monitoring 

To activate minimum inventory monitoring (page 656), complete the following steps: 

1. Select Planning > Minimum inventory monitoring. 

2. In the Start and print section, select whether you want to print the PO proposals from minimum 

inventory monitoring report that is created during the process. 

3. To activate minimum inventory monitoring, click Start. All of the resources calculated during 

the check are displayed in sequence in the Description section of the dialog box. The stored 

minimum inventory and the calculated PO or manufacturing quantity are also displayed for 

each resource. 

The dialog box closes automatically once the check is complete. 

The PO proposals and production orders created during minimum inventory monitoring are 

managed as rough planned orders in the  Rough planned orders object in Planning. 

For information on how to transfer the rough planned orders to detailed scheduling in 

Purchasing or Manufacturing, see Transfer to detailed planning (page 665). 
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Call 

Planning > Batch planning 

Description 

Planning can be carried out in batches as well as being initiated from an order. In this case, the 

system takes all orders that were entered, changed, or generated since the last batch process and 

then plans these orders. 

If batch planning is started in the evening, the planner can deal with the problems found by the 

system the next morning. For more information, see the Process exceptions Help topic. 

Configuration 

 Activate the COMMON.BATCHDISPOSITION.AKTIV=yes parameter. 

 Enter a limit to indicate the deviation from which a flag is to be set after a change is made. 

 Specify the record types to be included in the batch planning process. By default, all items (MA 

records) with a requirements-oriented planning type, all operations (OP records), and all 

orders (HR records) are assigned a batch flag when they are changed or first created. 

In practice 

All orders with a batch flag are accessed by batch planning and planned. If you have not already 

set this using the relevant parameters, you must carry out the transfer to detailed planning. For 

more information, see Transfer PO proposals (page 666) (the POs can then be opened in 

Purchasing) and Transfer production orders (page 667) (the production orders are transferred to 

Manufacturing). 

The Batch control function in Infor COM allows you to automatically start batch planning at a 

specific time. You can define the following setting when configuring the time-controlled action for 

batch planning: bfrmM4.appBatchDisp action. 

If using e-Procurement, please note the following: 

Batch planning 
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During planning, all Purchasing order release resources (according to the flag in the master data) 

are stored in Rough planning. This also occurs if the Detailed option is selected for the order 

generation type during planning. In order to record the requirement situation at the time of 

planning, the current cumulative received quantity is copied to the required cumulative quantity 

and the date of the last planning is recorded for each planned resource during the planning 

process. 
 

Mailboxes for batch planning 

Various logs are kept during the batch process and these are stored in different mailboxes. 

Mailbox Description 

85 Errors that occur during breakdown are logged here, such as an 

invalid BOR or an item that the system cannot find. 

86 A list of orders created in the batch process is displayed. 

87 A list of the orders for which quantities or due dates have been 

changed is displayed. 

88 Deleted orders are logged in this mailbox. Orders are deleted if you 

have selected the Change order quantities breakdown parameter. 

Lot creation or quantity changes may have made orders 

superfluous and they are therefore deleted. 

99 All error messages that otherwise appear in the dialog box on the 

screen are displayed in this mailbox. For example: Error assigning 

an ID. 

Note: The contents of the mailboxes are not automatically deleted. 

You should therefore check these regularly and delete them 

manually if required. 
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Call 

Planning > Rough planned orders 

Description 

Rough planned orders can involve PO proposals or production orders. They are created to cover 

requirements as part of planning sales orders and production orders (see "Order planning" page 

621), minimum inventory monitoring (page 656), VARIANTS, and changing fixed requirement 

allocations (FRA) (see "Change fixed requirement allocation" page 643). 

Rough planned orders remain rough planned until they are transferred to detailed planning in 

Purchasing or to detailed planning in Manufacturing control. 

Note: Order release resources are not normally transferred to detailed planning (see Transfer to 

detailed planning (page 665)). However, you may want to do this in some cases; for example, if 

individual requirements are to be met in an exceptional case by another supplier without an 

e-Procurement outline agreement. To prevent these requirements from being processed by order 

release management also, an order release generation is performed with the now reduced 

requirements from rough planning when these requirements are transferred to detailed planning. 
 

Fix rough planned orders 

After fixing a rough planned order, the quantities in the rough planned order and the receipt 

created in the item account remain unchanged when changes are made to the quantities in the 

underlying production/sales order and the order is re-planned. If the quantity in a production/sales 

order is increased and the rough planned order is fixed, a new rough planned order is created for 

the differential quantity together with a corresponding receipt in the item account. 

To fix rough planned orders (page 663), complete the following steps: 

1. Select Planning > Rough planned orders and open the required order. 

Rough planned orders 
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2. Select Data > Save and fix. The quantity of the rough planned order (see "Rough planned 

orders" page 663) is fixed. 
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Call 

Planning > Transfer to detailed planning 

Description 

Rough planned PO proposals and rough planned production orders are created to cover identified 

requirements and are saved in the Rough plan orders object in the Planning module for planning 

sales orders and production orders (see "Order planning" page 621), for minimum inventory 

monitoring (page 656), for VARIANTS, and when changing fixed requirement allocations (see 

"Change fixed requirement allocation" page 643) (FRA). 

Please note: When you plan sales orders and production orders by latest date (LD), you must 

select the Rough planned option in the Orders for section of the Breakdown parameters for 

planning dialog box when prompted to enter the breakdown parameters. 

Notes: 

 The note on purchasing order release resources under Batch planning also applies for all 

individually-planned orders. 

 Since order release resources are only used in standard Purchasing in exceptional cases, the 

transfer to detailed planning is generally suppressed for order release resources. For a list of 

exceptions, see Rough planned orders (page 663). 

For more information, see Parameters for LD planning (see "Parameter for planning by latest date" 

page 626). 

In practice 

The following Help topics explain how to transfer rough planned orders to detailed planning. 

 
 

Transfer to detailed planning 
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Transfer PO proposals 

Note: The transfer horizon is an important criterion when transferring rough planned PO 

proposals. 

Transferring PO proposals via the Transfer to detailed planning function 

To transfer all rough planned PO proposals pending in the system to detailed planning in 

Purchasing in one go, complete the following steps: 

1. Click Transfer to detailed planning in Planning. 

2. Make sure that the Purchasing check box is selected. If the Manufact. check box is selected, 

the rough planned production orders will also be transferred to Manufacturing. You can 

prevent this by clearing this Manufact. check box. 

3. Click the Start button to start transferring rough planned orders to detailed planning. While the 

process is underway, the following information about the origin of the resource being 

transferred will be displayed in the Source section of the dialog box: Item ID, description, ID of 

underlying rough planned order, and earliest date. 

4. The system will display a message when the transfer is complete. 

Transferring specific rough planned orders to detailed planning 

To transfer individual rough planned PO proposals to Purchasing, complete the following steps: 

1. From the Planning submenu, select Rough planned orders to open the start form. 

2. Select the Open tab and enter a % character in the Order ID or Resource field as a wildcard, 

then click Load. This displays an overview of all rough planned orders currently in the system. 

3. Select the rough planned orders that you want to transfer to detailed planning. To do this, hold 

down the CTRL key and click the ID fields of the orders you want to select. Proceed with step 

4.  
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If, however, you want to further edit an order before transferring it, double-click the ID field 

of the relevant order to load it. After you have made your changes, select Functions > 

Transfer to detailed planning. Click Start on the dialog box that is displayed. This transfers 

the rough planned order to the detailed planning section of Purchasing. You will then be 

taken back to the overview of all rough planned orders. Repeat this procedure for any 

other orders you want to edit. 

4. From the overview, select Functions > Transfer to detailed planning. The Transfer to detailed 

planning dialog box is displayed. 

5. On the dialog box, click Start to start transferring the selected orders. 

Note: If you do not select any orders in the overview, all displayed orders will be 

transferred to detailed planning. 

6. After the system has transferred the selected rough planned PO proposals to detailed planning 

in Purchasing, they will be deleted from the list. 

In both cases, the rough planned PO proposals are transferred to the PO proposals object in 

Purchasing and saved as detailed PO proposals. There, you can generate purchase orders from 

the proposals – see Edit PO proposals. 
 

Transfer production orders 

Note: The transfer horizon is an important criterion when transferring rough planned production 

orders. 

Transferring rough planned production orders via the Transfer to detailed planning 

function 

To transfer all rough planned production orders pending in the system to detailed planning in the 

Manufacturing module in one go, complete the following steps: 

1. From the Planning submenu, select Transfer to detailed planning. This opens the Transfer to 

detailed planning dialog box. 

2. Make sure that the Manufact. check box is selected. 
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3. If the Purchasing check box is selected, rough planned PO proposals will also be transferred to 

Purchasing. You can prevent this by clearing the Purchasing check box. 

4. Click the Start button to start transferring rough planned production orders to detailed planning. 

5. While the process is underway, the following information about the origin of the resource being 

transferred will be displayed in the Source section of the dialog box: 

Item ID, description, ID of underlying rough planned order, and earliest date. 

6. The system will display a message when the transfer is complete. 

Transferring specific rough planned production orders to detailed planning 

To transfer specific rough planned production orders, complete the following steps: 

1. From the Planning submenu, select Rough planned orders to open the start form. 

2. Select the Open tab. 

3. Enter a % character in the Order ID or Resource field as a wildcard and click Load to confirm 

your entry. This displays an overview of all rough planned orders currently in the system. 

4. From the list, select the rough planned orders that you want to transfer to detailed planning. To 

do this, hold down the CTRL key and click the ID fields of the orders you want to select. 

Proceed with step 4. 

If, however, you want to further edit an order before transferring it, double-click the ID field 

of the relevant order to load it. After you have made your changes, select Functions > 

Transfer to detailed planning. Click Start on the dialog box that is displayed. This transfers 

the rough planned order to the detailed planning section of Purchasing. You will then be 

taken back to the overview of all rough planned orders. Repeat this procedure for any 

other orders you want to edit. 

5. In the overview, select Transfer to detailed planning from the Functions menu. This opens the 

Transfer to detailed planning dialog box. 

6. On the dialog box, click Start to start transferring the selected orders to detailed planning. 

Note: If you do not select any orders in the overview, all displayed orders will be 

transferred to detailed planning. 

7. The selected production orders are removed from the overview after they have been 

transferred. 
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In both cases, the orders are transferred to the Production orders object in Manufacturing. They 

can now be processed further as detailed production orders. 
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Call 

Planning > Exceptions 

Description 

If Planning identifies due date and capacity problems (indicated by the corresponding exception 

flags), you can optimize orders retroactively by implementing various measures in exceptions 

processing. 
 

Process exceptions 

This topic describes how to process exceptions (page 670) in Planning. 

1. In the Planning submenu, click Exceptions (page 670) to open the Exceptions dialog box. 

2. Select the type and assigned exception flag of the orders that you want to edit. 

3. Clicking OK confirms your selection and opens the Exception overview. The overview consists 

of the following tabs: Texts, Originator, Due dates, and Processing status. 

4. To process exceptions, go to the relevant object. Highlight the line and select one of the 

following commands from the Go to menu: 

 Item/capacity account 

Depending on the record type of the line, this takes you to either the item account (page 

637), where you can generate receipts to eliminate shortages for example, or to the 

Capacity account (page 649), where you can make capacity adjustments to eliminate 

bottlenecks. 

 Order 

This menu command allows you to load the related order for the selected line. In the order, 

you can use the Schedule function to carry out rescheduling. 

 Order structure 

Exceptions 
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In the order structure you can insert new lines in the order, move or delete orders or order 

lines, or reschedule the structure using the latest date (LD) or the current date (CD). 

5. If you want to include a line in batch planning at a later stage, select the B (Batch planning) 

check box on either the Texts or Processing status tab. This also flags the line in the 

corresponding order. 

 This flag can be found in the Order header view on the Scheduling tab for production 

orders and rough planned orders for a line with the HR record type, and in the Order line 

view on the Scheduling tab for lines with record types MA and OP. 

 The flag can be found in the Order line view on the Texts/details tab for sales orders. 

6. If required, you can set another check flag and/or specify a follow-up date on the Processing 

status tab. You can then filter according to this information for future exceptions processing. 

This information is not further evaluated. 
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Call 

Planning > Planning overview 

Description 

The Planning overview in Infor COM Planning provides an overview of all confirmed and planned 

receipts and issues for each item and month, over any period. These receipts and issues are then 

used to calculate the planned balance within a month and for the entire period. 

Example 

The following example shows the structure of the planning overview: 

PLANNING OVERVIEW 

Item Short 

description 

 Address ID Warehouse 

inventory, W/H 

inv. 

Opening inv. qty UOM 

300-00 Test item  1350 15,00  U 

Min. lot Min. inv. Monthly cons. Range Deviation Pl. type  

1,00 0,00 3,00 5,00 0,00 6  

Month Receipt Issue Planned 

receipt 

Plan. issue Planned balance  

05/2014 15,00 0,00 60,00 40,00 35,00  

06/2014 0,00 0,00 5,00 55,00 -15,00  

07/2014 0,00 0,00 0,00 0,00 -15,00  

08/2014 0,00 0,00 0,00 0,00 -15,00  

Total  15,00 0,00 65,00 95,00 -15,00  

 

Planning overview 
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Explanations 

Item Item ID 

Short description Item name 

Address ID The warehouse address ID. For more information, see explanations for the Address ID field in 

the Help topic on the Planning overview start dialog box. 

Warehouse inventory, 

W/H inv. 

This is the free inventory that is currently available (accurate to the second) in the main 

warehouse or supplier consignment warehouse. 

Opening inv. qty This is the opening inventory quantity at 0:00 hours on the first day of the first month of the 

defined period. It is added to the planned balance for the first month (see Planned balance 

field). 

UOM This is the basic unit of measure of the item. All subsequent values are converted to this basic 

UOM. If the values cannot be converted because there is no quantity conversion factor stored 

in the item master data or relevant allocation table, a message is sent to mailbox 99. 

Min. lot This is the minimum quantity that this item's lot must include. The minimum lot size is defined 

in the item's master data. 

Min. inv. This is the minimum inventory quantity specified in the item master data. 

Monthly cons. This is the average consumption per month. 

Range This is the quotient from the warehouse inventory and the average consumption per month 

(Monthly cons.). This value allows you to forecast how long the available inventory will last. 

The unit output is in months. 

Deviation This is the average deviation of single consumption from average consumption. 

Pl. type This is the planning type used to plan the item. 

Month This is the month's sequence number and the year. The above example shows a period from 

May to August 2014. 

Receipt This includes all actual inventory receipts for the item in this month. 

Issue This includes all actual inventory issues for the item in this month. 

Planned receipt This is all inventory receipts planned in this month using rough planned and detailed purchase 

orders and production orders. 

Plan. issue This includes all issues planned in this month by sales orders (relFb), production orders 

(relDb), rough planned orders (page 663) (relCb), and provided materials (relGb). 

Planned balance Calculation for the first month of the defined period: 

Opening inventory quantity (!) + Receipt - Issue + Planned receipts - Planned issues 

Calculation for all other months in the defined period: 
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Planned balance of the previous month + Receipt - Issue + Planned receipts - Planned issues 

Total The total from the Receipt, Issue, Planned receipt, and Planned issue columns are displayed 

in this row. The Planned balance field in this totals line contains the planned balance of the 

last month in the overview, i.e. the planned balance at the end of the period. 

Total = SUM [Receipt] - SUM [Issue] + SUM [Planned receipt] - [Planned issue] 
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Please note: Report names are always structured as follows: ir<module><report name>. For 

more information on the reports not found in this Help topic, see the Help topics for the reports for 

the modules concerned. 

The following reports are available in Infor COM's standard Planning module. 

Note: You can influence the displayed lists by assigning user privileges. 

 Work center group utilization overview 

 Inventory available for fixed requirement allocation 
 

Print planning reports 

To print planning reports, complete the following steps: 

1. Select Planning > Reports. 

2. Select the required report by clicking on the row header and click OK to print or preview. 

See Print reports. 

 

Reports (Planning) 
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Minimum inventory 

Call 

Planning > Calculations > Minimum inventory 

Description 

Minimum inventory can mean different things in Infor COM and it can be calculated using different 

methods, depending on the planning type of the item. 
 

Calculate minimum inventory quantities for planning types 1 and 2 using MAD 

You can calculate the minimum inventory using the MAD calculation for items that are planned 

with one of the two planning types – 1 Full planning only and 2 Bottleneck (always plan). 

The special feature of these planning types in terms of minimum inventory is that the minimum 

inventory fulfills the role of safety inventory. Infor COM therefore calculates the safety inventory in 

order to calculate the minimum inventory and then copies it as the minimum inventory, rounded off 

to a whole number if necessary. 

To calculate the minimum inventory, complete the following steps: 

1. Configure the supply capability factor via the 

COMMON.MINDESTBESTANDSRECHNUNG.SERVICEFAKTOR parameter. 

2. Choose the following settings in the item's master data on the Planning tab: 

 Enter the correct replenishment time (RPLT). 

 Select the Use Median Absolute Deviation calculation option in the Calculate min. inv. 

field. 

 Deactivate the Manual planning parameters option. 

Calculations 
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3. Then select Functions > Minimum inventory calculation in the master data of the relevant item.  

Note: Alternatively, you can start the calculation using the Min. inv. object (Planning > 

Calculations) if you want to perform the calculation for all similarly flagged items. 

The calculated safety inventory is displayed in the Safety inv. (MAD) field in the Safety 

inventory section of the Planning tab in the item's master data. 

How is the minimum inventory calculated? 

Based on the equation Minimum inventory = Safety inventory, the formula for calculating the 

minimum inventory is as follows: 

Safety inventory = MAD x Safety factor 

Note:  Click here for detailed information on the MAD (see "Median absolute deviation (MAD)" 

page 683) calculation and on safety factors (see "Calculate supply capability factor for supply 

capability level" page 679). 

Since the safety inventory depends on the replenishment time of the relevant item, it still needs to 

be recalculated in proportion to the replenishment time. Therefore, the final formula is as follows: 

Safety inventory (in replenishment time) = ((MAD x Safety factor)/20)) x Replenishment time 

The quotient 20 specifies the assumed average number of working days per month. This formula 

is explained as follows: 

 If the replenishment time is less than 1 month, the safety inventory is reduced. 

 If it is greater than 1 month, the safety inventory is increased. 

Note: If you calculate and specify minimum inventory manually, select the Manual planning 

parameters check box on the Planning tab of the relevant item master data to prevent both 

parameters from being overwritten by Infor COM. 
 

Calculate safety and minimum inventory for planning types 4, 5, 6, and 7 using 

MAD 

Please note: The COMMON.DISPOSITION.STANDORTBEZOGENEMINBEST=no parameter 

must be set for the following method of calculating the safety and minimum inventory. 
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You can use the MAD calculation to determine the values of the Safety inventory and Minimum 

inventory parameters for items that are planned using one of the planning types listed below. 

 Reorder point (variable quantity) 

 Reorder point (fixed quantity) 

 Reorder cycle (variable quantity) or 

 Reorder cycle (fixed quantity) 

 

To calculate the minimum inventory, complete the following steps: 

1. Configure the supply capability factor via the 

COMMON.MINDESTBESTANDSRECHNUNG.SERVICEFAKTOR parameter. 

2. Choose the following settings in the item's master data on the Planning tab: 

 Enter the correct replenishment time (RPLT). 

 Select the Use Median Absolute Deviation calculation option in the Calculate min. inv. 

field. 

 Deactivate the Manual planning parameters option. 

3. Select Functions > Minimum inventory calculation in the master data of the relevant item, or 

start the calculation using Min. inv. (Planning > Calculations) if you want to perform the 

calculation for all similarly flagged items. 

You can view the calculated safety inventory and minimum inventory in the Min. inv. and 

Safety inv. (MAD) fields on the Planning tab in the master data for the relevant items. 

The following section describes how Infor COM calculates both quantities. As you need to 

know what the safety inventory is before you can calculate the minimum inventory, the 

calculation of the safety inventory will be explained first. 

Calculating safety inventory 

The formula for calculating the safety inventory is: 

Safety inventory = MAD x Safety factor 

Note: For more information about MAD, click here (see "Median absolute deviation (MAD)" page 

683), and for more information about safety factors, click here (see "Calculate supply capability 

factor for supply capability level" page 679). 

Since the safety inventory depends on the replenishment time of the relevant item, it still needs to 

be recalculated in proportion to the replenishment time. Therefore, the final formula is as follows: 
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Safety inventory (in replenishment time) = ((MAD x Safety factor)/20)) x Replenishment time 

The quotient 20 specifies the assumed average number of working days per month. 

This formula indicates that: 

 If the replenishment time is less than 1 month, the safety inventory is reduced. 

 If it is greater than 1 month, the safety inventory is increased. 

Calculate minimum inventory 

The minimum inventory can be calculated once the safety inventory has been calculated: 

Minimum inventory = ((Average consumption/20) x Replenishment time) + Safety inventory 

The quotient 20 specifies the assumed average number of working days per month. 

Notes: 

 For items planned with planning type 4 - Reorder point (variable quantity), you can also 

calculate the minimum inventory quantity on the basis of sales forecasts. The difference 

compared with using the MAD calculation is that the inventory limit is calculated here as the 

second minimum inventory parameter, and not the safety inventory. 

 Major discrepancies between two minimum inventory calculations are logged in Mailbox 80. 

You can set limits for these discrepancies using the 

COMMON.MINDESTBESTANDSRECHNUNG.MINDBESTABW parameter in the 

configuration. 

 If you calculate and specify safety inventory and minimum inventory manually, select the small 

Manual planning parameters check box on the Planning tab to prevent both parameters from 

being overwritten by Infor COM. 
 

Calculate supply capability factor for supply capability level 

Supply capability allows you to reduce the risk of shortages during the replenishment time. It 

specifies the proportion of requirements the warehouse is capable of covering. Supply capability is 

quantified by the supply capability level. 

In addition to the planned consumption required to secure a particular supply capability level, a 

certain quantity of material, known as the safety inventory, must be held in inventory. The safety 

inventory is therefore determined by the required supply capability level. 
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During the calculation of safety inventory (see "Calculate minimum inventory quantities for 

planning types 1 and 2 using MAD" page 676), the supply capability level is expressed in the form 

of a supply capability factor. 

Calculate the supply capability factor 

It is assumed that the probability distribution of an item's period requirements is approximately the 

same as a normal distribution (also known as a Gaussian bell-shaped curve or error curve). 

Example: The consumption rates observed over a lengthy period of time for each period of an 

item have displayed the following frequency distribution: 

 

The area under the curve represents the entire number of consumption quantities, i.e. 100%. The 

average () is a consumption quantity of 60 units. The greatest frequency occurs here. The period 

requirements vary from this average by an average of 12 units. This deviation is described by the 

standard deviation (). 

During a normal distribution, the observed consumption quantities should be distributed between 

the Sigma limits under the curve as follows: 

68.26% is between -1 and +1 

95.44% is between -2 and +2 

99.73% is between -3 and +3 
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Normal distribution is standardized to calculate the safety factor or relevant supply capability level. 

There is no need to go into greater detail here. However, the following brief note will be of interest 

to statisticians: 

"During a linear transformation of a normal distribution, an N(,)-distributed random variable X is 

transformed into an N(0.1)-distributed random variable, that is, into a standard, normally 

distributed random variable R (often also called a "standard variable")." 

The practical advantage of standard normal distribution is that the random variable Z, which is 

required to calculate the safety factor, can be read at the required supply capability level in the 

relevant standard normal distribution tables. 

The following graph illustrates this: 

  

Legend: 

Z: Random variable 

A: Safety factor 

B: Supply capability level 

Only the positive half of the curve is relevant to the supply capability level and therefore also to the 

safety inventory, since even a supply capability level of only 50% (if Z = 0.00) can be reached 

without a safety inventory. 
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The diagram displays a number of sample supply capability levels and shows how the figures 

appear for the Zvalues 0.00, 1.00, 2.00, and 3.00. 

The supply capability level of 94.52% has been highlighted in yellow, as this is preset in the 

standard Infor COM system. This level is reached at a Z value of 1.60. The corresponding supply 

capability factor of 2.00 is calculated by the equation supply capabi l i ty factor = Z  1.25, i.e. 

1.60  1.25 = 2.00. 

The safety factors for other supply capability levels are calculated in the same way. 

Summary: 

Find the requested supply capability level in a standard Gaussian distribution table and note down 

the corresponding Z value. Multiply the Z value by 1.25 and enter the resulting supply capability 

factor in the COMMON.MINDESTBESTANDSRECHNUNG.SERVICEFAKTOR parameter. Infor 

COM will read this value here when calculating the safety inventory. 

  

The above table is an extract from a standard normal distribution table with the probabilities for 

particular Z values. The supply capability level 94.52% and the corresponding Z value 1.60 have 

been highlighted. This is preset in standard Infor COM systems by the supply capability factor 2.00 

(=1.60  1.25). 

The following table again illustrates various selected supply capability levels with their 

corresponding supply capability factors: 
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Supply 

capabi l i ty  

level  

Supply 

capabi l i ty   

factor  

50,00% 0,00 

78,81% 1,00 

84,13% 1,25 

94,52% 2,00 

97,72% 2,50 

99,18% 3,00 

99,87% 3,75 

 
 

Median absolute deviation (MAD) 

General definition: 

The Median Absolute Deviation is a mathematical measure of deviation. It indicates how much 

the individual values deviate from the mean value and also shows how representative the mean 

value is for individual cases. The MAD calculation may be based on the central value or the 

arithmetic mean. Based on these mean values, the deviations are calculated for each of a series 

of values and these are then added together according to their absolute value. The total is then 

divided by the number of values, which finally gives the arithmetic mean of the deviations. The 

formula for this is: 

  

(: signifies "Delta") 

Using the MAD calculation: 

The MAD calculation is an internal mathematical measure and is used in Infor COM Planning to: 
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 Calculate safety and minimum inventory for planning types 4, 5, 6, and 7 using MAD (page 

677) 

 Calculate minimum inventory for planning types 1 and 2 using MAD (see "Calculate minimum 

inventory quantities for planning types 1 and 2 using MAD" page 676) 

 Calculate XYZ classes (see "XYZ class" page 690) 

See below for a sample MAD calculation:  

Period  

 

Consumpti

on  

 

Deviation from  

mean  

Absolute 

deviation  

1 180 +20 20 

2 210 -10 10 

3 215 -15 15 

4 195 +5 5 

Total 800  50 

Average 200  12,5 

Average consumption = ((180+210+215+195)/4) = 200 units 

 units 

This means that the consumption quantity in a period varies by an average of 12.5 units from the 

average consumption quantity. This indicates that this deviation is a second-order mean value. 

Note:   The calculation of the median absolute deviation (MAD) is an approximation method for 

calculating the standard deviation, which is usually used as the deviation measure. However, MAD 

calculations are used in practice in data processing. MAD calculations are easier to understand 

than standard deviations and easier to calculate. The following relationship applies between the 

MAD calculation and the standard deviation: 

 = 1.25 x MAD 

(: Sigma) 
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Lot size 

Call 

Planning > Calculations > Lot size 

Description 

The goal of a business-oriented procurement planning system must be to provide the items 

specified in the requirements plan in the required quantities, at the right time, and at the lowest 

possible cost. 

By determining optimal order quantities and lot sizes, the purchasing costs defined by the order 

quantity can be minimized. Manufacturing costs may also be reduced by optimizing the setup and 

inventory costs through improved management of storage times. 

Infor COM provides a lot size calculation method based on the Andler method. The method has 

been modified to calculate an optimal quantity and two limit quantities. Purchasing order costs or 

production costs will increase dramatically if your figures exceed or fall below these limit 

quantities. 

Configuration 

The following parameters must be set in the configuration: 

 COMMON.LOSGROESSENBERECHNUNG.KOSTENINKREMENT 

The increment is the amount that the size increases by. This value defines the limit 

quantity interval in percent based on the minimum cost. 

 COMMON.LOSGROESSENBERECHNUNG.BESTKOSTEK 

This parameter specifies the costs for a purchase order in Purchasing. 

 COMMON.LOSGROESSENBERECHNUNG.LAGERZINSSATZ 

This parameter specifies the estimated inventory interest rate per item in percent. 

 COMMON.LOSGROESSENBERECHNUNG.AUFLAGEKOSTEN 
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The batch costs must be specified for the manufacturing items based on the purchase 

order costs in Purchasing. The setup costs for each lot are added to these batch costs in 

the system. The setup costs for each lot are based on the setup costs for each unit, 

multiplied by the calculated lot sizes. 
 

Lot size calculation according to Andler 

To determine optimum lot sizes and PO quantities automatically, Infor COM provides a lot size 

calculation (see "Lot size" page 685) method developed according to the Andler method. The 

calculation method is subject to the following assumptions: 

Defaul t  data (see "Set data for lot  size calculation" page 688): 

M: Material requirements in the calculation period (for example, in a year) 

PO: Purchase order costs for each purchase order or batch costs in manufacturing 

P: Price of a material unit 

W: Warehouse charge percentage for each item 

L: Lot size per purchase order 

C: Total costs  

The fol lowing formula has been developed to calculate the optimum lot size (L):  

C = S x M/L + ½ x L x P x W/100 

From this fol lows:  

Delta C/delta L = -S x M/L^2 + P x W/200 

Resolution according to L (=optimum lot size):  

L = SQRT ((S x M x 200)/(P x W)) 
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Below is a diagram of this calculation:  

 

Legend: 

 Red curve: PO costs; total requirement, for example, 20,000.00 

 Green curve: Inventory costs 

 Blue curve: Total costs 

 1: Maximum PO quantity 

 2: Optimum PO quantity according to Andler 

 3: Minimum PO quantity 

 4: Cost increment, for example 5%. 
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The optimum PO quantity according to Andler is always on the trough (=minimum cost) of the total 

cost graph. Two other intersections with the total cost graph are calculated based on the limit 

quantity interval specified in the configuration using the 

COMMON.LOSGROESSENBERECHNUNG.KOSTENINKREMENT parameter which is based on 

the minimum cost. If these two intersections are projected onto the quantities axis,  the minimum 

and maximum profitable PO quantities are calculated. If the values of these intersections are not 

met or if they are exceeded, the costs will increase again. 
 

Set data for lot size calculation 

To determine optimal lot sizes (see "Lot size" page 685) according to the Andler formula, you need 

to manually specify different data as follows: 

Required default  data in the Lot size section of  the Planning tab in the i tem 

master data: 

 Rounding factor  

The factor that is to be used to round the lot quantities. 

Note: The No. of days period parameter is set to 0 (zero) when this automatic method is 

used. 

The following data must be included in the calculation, but must not be entered manually: 

 Consumption in the calculation period  

Consumption in the calculation period (in a year, for example) for an item is taken from the 

item's consumption statistics (average consumption x 12 months). 

 Price of a material  uni t  

For purchased items, the price corresponds to the material costs of a material unit. For 

manufactured items, these are the manufacturing costs. 
 

Start lot size calculation 

To execute the automatic lot size calculation (see "Lot size" page 685) for all requirement-oriented 

planned items in Infor COM, complete the following steps. 
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1. Select Planning > Calculations > Lot size. 

2. Click Start. 

The result of the calculation is then transferred to the item's master data in the Lot size 

section of the Planning tab. 

3. Optional: If you want to calculate an optimal lot size for an item, open the item's master data 

and select Functions > Lot size calculation. You can read the result of the calculation in the 

Quantity field in the Lot size section of the Planning tab. 

Before you start the lot size calculation, make sure that you have entered all of the 

required default data (see "Set data for lot size calculation" page 688). 
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XYZ class 

Call 

Planning > Calculations > XYZ class 

Description 

You can use this object to carry out a batch XYZ analysis for all items. 

If you only want to carry out an XYZ analysis for a specific item, select the Calculate XYZ class 

function from the item's master data. 

You can view the flag for the class that is determined for an item in the XYZ class field of the 

Planning tab in the item master data. 
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Systems for classifying items 

You can use consumption-driven or demand-driven planning to plan items. To make it easier for 

you to decide which method should be used for planning specific items, you can analyze and 

classify the corresponding items based on specific criteria. 

ABC analysis (page 693) and XYZ analysis (page 691) can be used as classification systems in 

this context. 

You can use an ABC analysis to classify items according to the proportion they account for in a 

value to be defined, for example, in the annual consumption value. Classification according to 

ABC criteria must be carried out manually. 

The XYZ analysis classifies an item according to the degree of accuracy in predicting 

requirements. A special function is available for classifying items according to XYZ criteria. 

Specific coordinated procurement, storage, and distribution measures can then be developed for 

the classified items. 

In a combined ABC/XYZ analysis (page 694), the items are grouped together according to the 

criteria of both classification systems. Items analyzed in this way allow you to determine the 

optimum planning method and provision measure. 
 

XYZ analysis 

As with the ABC analysis (page 693), the XYZ analysis is another method used to classify 

consumption factors (see "Systems for classifying items" page 691). 

Whereas the ABC analysis classifies items according to their corresponding proportion of a value 

to be defined, for example, of the annual consumption value, in an XYZ analysis, the items are 

classified according to the degree of accuracy in predicting requirements. 

If you view requirement flows over a longer period, you can see that some items are consumed 

regularly in relatively constant quantities, whereas some fluctuate, and others are consumed 

completely irregularly. You can derive the degree of accuracy in predicting demand from the 

regularity of a requirement flow. 
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The following table explains this relationship: 

Class Requirement flow characteristic Prediction accuracy 

TX Constant has low fluctuation range High 

Y Fluctuates considerably. Tends to increase or 

decrease subject to  

seasonal influences. 

Medium 

AC Completely irregular. Low 

Determining the class according to the requirement f low:  

Infor COM first determines the relative (p) proportion that MAD (see "Median absolute deviation 

(MAD)" page 683) accounts for average consumption: 

p = (MAD/Average consumption) x 100 

The system then determines the interval in which the p percentage lies. These intervals are 

defined using the X and Y parameters in the COMMON.XYZ-ANALYSE section of the 

configuration. In the standard version of Infor COM, the classes are calculated based on the 

following intervals: 

X class, if 0%  p  60%. 

Y class, if 60 %  p  150%. 

Z class, if 150%  p. 

The class that is determined in this context is entered in the XYZ class field on the Planning tab in 

the item master data.  

You can change the intervals if required. You only need to set parameters for the interval 

maximums of the X and Y class here. You do not need to assign explicit parameters to the Z class. 

The lower interval limit for the Z class is automatically determined based on the maximum limit of 

the Y class interval. 

You can classify items based on ABC and XYZ criteria. For more information on the results of this 

combination, see Combined ABC/XYZ analysis (page 694) 

Please note: The XYZ analysis takes the COMMON.STATISTIK.GESCHAEFTSJAHR 

configuration parameter into account during the evaluation. 
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ABC analysis 

You can use the ABC class field on the Planning tab in the item master data to assign priority 

categories to items. Select the appropriate flag from the combo box. 

The classification flags available for selection (A, B and C) are stored in the ABCKLAS allocation 

table. You can change or add to these default settings. To access the table, select the Tables 

object in the System functions module, or select Tools > Allocation tables if you are in an 

application, for example the item master data. 

 

What is  a classi f ication according to ABC cri teria?  

Similar to the XYZ analysis (page 691), an ABC analysis is another tool used for classifying 

consumption factors (see "Systems for classifying items" page 691). 

It can be applied to all inventory control systems and is easy to use as it only requires the 

consumption values for the most recent periods for each item. 

While the XYZ method classifies items according to the level of accuracy in predicting 

requirements, the ABC analysis groups them according to their relative proportion of the item's 

total volume compared with their contribution towards a value to be defined in each case, such as 

annual consumption value, total inventory value, sales revenue, inventory turnover, or contribution 

margin. 

The annual consumption value is used elsewhere in this Help module. 

The ABC analysis is based on the fact that, in most cases, a relatively small proportion of the total 

items managed determines most of the annual consumption. These items are classified as A items 

(high priority) and require careful demand-led management, since inaccurate planning would 

involve unnecessary storage and shortage costs. B items and C items can be graded in the same 

way: B items (standard priority) represent a slightly larger proportion of the total volume of items, 

but have a proportionally lower annual consumption value. C items (low priority) represent the 

majority of items managed, but have the lowest annual consumption value. Planning of B and C 

items is usually driven by consumption considerations. 

An overview of the relationships explained above can be seen in a Lorenz concentration curve 

(page 694). 
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Lorenz concentration curve 

A Lorenz concentration curve illustrates the principle of ABC classification (see "ABC analysis" 

page 693). It compares cumulative quantities and value-based proportions. The following curve 

demonstrates the most frequently encountered class distribution. The values are therefore 

approximate: 

 

Axis legend 

Ordinate: Proportion of the annual consumption value as a % 

Abscissa: Proportion of the basic total as a % 

Explanation of curve shape 

A items: 10% of the items determine 70% of the annual consumption 

B items: 20% of the items determine 20% of the annual consumption 

C items: 70% of the items determine 10% of the annual consumption 
 

Combined ABC/XYZ analysis 

A combined ABC/XYZ analysis leads to a total of nine classification groups. It can be displayed 

schematically in a classification matrix with nine corresponding decision fields: 
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Selecting a planning method according to ABC/XYZ cri teria:  

 

Explanation: 

1: Requirement-oriented planning using planning type 1 or 2 

2: Consumption-oriented planning using planning type 5 

3: Manual planning, fixed requirement allocation 

4: Automatic update of the two safety inventory and optimal PO quantity planning parameters 

5: Manual maintenance of the two safety inventory and optimal PO quantity planning parameters 

You can use this diagram to decide which planning methods and provision measures are 

appropriate for the relevant items. 
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Call 

Planning > Planning log 

Description 

A planning log stores all relevant data and parameter settings that were set before the last 

planning process for an item or work center. 

 

Planning log 
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Finance 
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Note: See also the Configuration (Finance) Help topic. 

The Finance folder contains five groups of functions: 

 Master data (see "Master data (Finance)" page 699) management (both company and 

employee data) 

 Costing (page 709), including the creation of a cost history (see "Create cost history" page 

783) in the Administration folder 

 Value flow (page 749) 

 Journals (see "Journals and reports" page 766) 

 Statistics (see "Statistics basics" page 788) 

 Infor Finance data transfers 

 

The following table provides an overview of how these functions are broken down: 

Value flow 

* Inventory valuation 

* WIP valuation 

* Period-end closing 

* Historic costs 

* Statistics & evaluation 

Costing 

* Cost rollup 

* Manufacturing costs 

* Orders and quotes 

* Final costing 

* Cost units/projects 

Master data 

* Price data 

* Costing values 

* Costings/Cost types 

* Accounting information 

Interfaces 

* Internal Inventory value journal 

interface 

* Internal posting journal interface  

* Infor Finance interface  

* Varial interface 

Financial accounting/Cost 

accounting 

* Financial accounting 

* External cost accounting 

* Infor Finance international 

* Enterprise Information System 

(EIS) 

Miscellaneous 

* Inventory value journal 

* Posting journal 

* Reporting 

* Archiving 

 

 

Finance basics 
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The Master data folder in Finance lets you store and update master data for companies and 

employees. 

 

Master data (Finance) 
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Companies 

Call 

 Companies > Master data > Finance. 

Description 

This object allows you to enter and process company data. 

Company data includes any data relating to suppliers and customers as well as any data relating 

to your own company. As well as carriers, you can also enter other companies that do not fall 

under any of these categories. 

For all types of company, the required addresses are entered and it is possible to assign any 

number of contacts (employees). Customers and suppliers are identified by the Type of company 

flag. 

You can also enter accounts or information relating to outstanding items and credit limits, for 

example. 

Notes: 

 Several allocation tables provide information for creating addresses. 

 When creating a new company, see the information provided on the Co. account tab. 

 The default settings are controlled by via COMMONSTD. 

Configuration 

It is possible for an online validation check for accuracy to be carried out by the connected 

financial accounting system on company master data that has been created or modified in 

Purchasing and Sales. This is helpful in cases where changes are made to credit limits, or if a 

sales tax ID has been entered incorrectly. If an invalid sales tax ID is used while the online link is 

active, an error message is output immediately. The online validation function is activated via the 

COMMON.FIBU.ONLINE.BUSINESSPARTNER=yes parameter. 
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When the customer or supplier master data is saved, the processes for transferring business 

partners to the configured financial accounting system are then called for the business partner you 

were processing. All of the data checks that would be carried out for a batch transfer are now 

carried out by Infor COM and the financial accounting system. The configuration parameters and 

interface configuration settings saved for the transfer of master data are evaluated and applied. 

For more information, see Infor Finance online functions. Error messages are displayed directly on 

the screen and are not saved. There are no additional mailbox entries. If the transfer is successful, 

there are no messages displayed. 
 

Enter master data for own company 

Certain processes in Infor COM require you to also enter the master data for your own company. 

1. Select Finance > Master data, and Companies, then select the New tab. 

2. From the Type of company combo box, select Own company. 

3. You can use the default company ID generated by the system or define your own. 

4. Enter your company name in the Desc. field and confirm by clicking Create. 

5. Enter your company's address in the table on the Address tab. Enter each additional address 

(for example company location) on its own line. Use the Addr.type flags to specify the usage of 

each address. The first address in the table automatically defaults to the usage type Default 

address. For help with the table, see Addresses. 

6. In the Address form section under the table, complete the data for the corresponding 

addresses. When doing so, pay close attention to the address that is currently highlighted with 

the red rectangle in the row header. 

7. In the bottom table on the Contact tab, enter the employees of your company who, as the 

responsible project managers or salespeople, are to be involved, for instance, in project 

maintenance in sales. 

8. Use the Data and Save men commands to save your data. 
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Activate credit limit check 

This Help topic describes how to activate the credit limit check for a customer. For information on 

how to proceed if the credit limit has been exceeded, see Take action on exceeded credit limit 

(page 702). 

Note: Configuration of the connection to a financial account system is not described here. 

1. Set the COMMON.VERTRIEB.NEWORDERSONHOLD and 

COMMON.VERTRIEB.ALLOWCREDITCHECKOVERRIDE parameters in the configuration 

for the Infor Finance interface. 

2. Set the COMMON.FIBU.ONLINEPERSACC configuration parameter for linking the credit limit 

check with the financial accounting system. 

3. Configure the CCFAILS, FINACSTATE, CREDITCHECK, and HOLDSTATUS allocation tables 

as required. 

4. Open the relevant customers by selecting Sales > Master data > Customers and select the 

Company account tab. 

5. Select the Credit limit check check box. 

6. In the Credit limit field, enter the credit limit amount. 

Note: You can only enter the credit limit when creating the company account or when the 

company account is transferred to the financial accounting system. The financial accounting 

system will then be the master system for the credit limit. 

Exception: If the COMMON.VERTRIEB.ALLOWCREDITCHECKOVERRIDE=yes parameter is 

defined, you can deactivate the credit limit check in the company master for a customer, even 

if it has already been synchronized with the financial accounting system. 
 

Take action on exceeded credit limit 

If the credit limit check (see "Activate credit limit check" page 702) is activated for customers, the 

credit limit is checked continuously when orders are processed. 

This check comprises the entire order processing process, from order creation to invoice payment. 
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If the sum of the Outstanding order value, Invoiced, not posted, and Outstanding items values plus 

the value of the current order being processed exceed the credit limit, a dialog box informs you of 

this fact. 

Select one of the actions available in the dialog box. 

Note: If you select Put order on hold, the order is stored in a separate database table with the 

status on hold. 

You can identify orders on hold by the following: 

 The order ID in the order header is red. 

 The Order on hold statuses field on the Texts/conditions tab is set to Manually on hold. 

To find out how to maintain on hold statuses, see Maintain on hold statuses. 

Please note: In order releases the order release header on the Texts/conditions tab contains a 

check box that lets you skip the credit limit check for that order release if you select the check box. 
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Configure e-mail options 

Call 

Finance > Master data > Companies and Go to > Configure e-mail options 

Description 

Paperless communication between companies and within companies has become increasingly 

important. 

To facilitate paperless communication, you have the following options: 

 Send documents as attachments of an e-mail 

 Edit the mails to be send 

 Create e-mail batch processes 

Configuration 

E-mail transmission is configured in two steps: 

 The parameters for configuring e-mail are described in the Configuration (E-mail) topic. 

 In the company master, you configure the recipient (including Cc and Bcc) as well as the contents. For 

more detailed information, see the context help. 

By setting the COMMON.DOCUMENTASEMAIL.USEADDRESSCOMPANYCONFIGURATION 

parameter, you can specify that the system should use either the e-mail configuration for the 

company to which the document belongs, or the configuration for the company included in the 

(postal) address to which the document is sent. 

Functions 

Quick configuration 
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Export CAQ addresses 

This function is available in the company master for customers and suppliers. Load the required 

company master data and from the Functions menu select Export CAQ addresses. 

You can use this function to export customer and supplier data to files. These files are then used 

to prepare the data for CAQ import. Make sure that two 

COMMON.QUALITAETSSICHERUNG.QSDATEIFK (supplier master data) and 

COMMON.QUALITAETSSICHERUNG.QSDATEIKD (customer master data) parameters are set 

correctly in the configuration. 

You specify the path for the file export using the COMMON.QUALITAETSSICHERUNG.QSPFAD 

entry in the configuration. 
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Employees 

Call 

Finance > Master data > Employees 

Purchasing > Master data > Employees 

Sales > Master data > Employees 

Description 

It is possible to create employees with different functions (representative, etc.) and send 

shipments to these people. 

Contacts at outside companies can also specify this directly on the Contact tab. 
 

Transfer own employee IDs to documents 

When you create new employees, Infor COM assigns an employee ID to each employee 

according to an internal numbering method. In certain cases, it makes sense to assign an 

employee ID of your choice that is not included within this ID range (for representatives, for 

example) and to use this ID in documents as well (in sales orders, for example). For more 

information, see the explanations provided for the ID field in the context-sensitive Help. The 

following example shows what steps need to be taken for a representative. The 

COMMON.PERSONENSTAMM.ADRESSENR=yesparameter must be set in the configuration. 

This is the default setting. 

1. Create a new representative. Use a meaningful description in the Employee ID field. 

2. Assign a company to this representative on the Company tab. 
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3. If you create an order for the customer you assigned to the representative in step one, you can 

select the representative in the Rep. tab using the Rep1 field. In the Address ID field, you will 

find the employee ID of the representative instead of the company's address ID, in this 

example, Southwest region. 

Note: You can also assign a representative to a company on the Contact tab. In this case, 

however, you cannot transfer the corresponding employee ID to a document. 
 

Employee master 

Call 

In Manufacturing, open the TIME master data folder and select Employee master to open the 

employee master. 

Description 

The employee master contains fundamental data regarding all reporting employees and the rules 

and privileges for operating terminals as part of shop floor data collection (see "Shop floor data 

collection (SFDC)" page 839). 

Functions 

 If SFDC terminals are connected, you can select Functions and Start download to send any 

record in the employee master to the assigned terminal. This allows you to check an 

employee’s access permissions at a terminal while decreasing data traffic since employees 

can query current data in their employee records directly at the terminal. 

 Click here for Help on activating/deactivating. 

 You can select Functions and Left company to indicate that an employee has left the 
company. This status prevents employee data from being deleted (which can cause legal 

problems) and prevent the employee from being displayed if you browse or load employee 

master data using the % parameter. 

Configuration 

COMMON.PERSONENSTAMM.ADRESSENR 



708 | Infor COM 7.5 User Guide 

 

Finance 

 

In practice 

Please note that the entry privileges of an employee are dependent on the employee's status. 

Active, Act. Inactive Left the company 

Enter Cannot enter Cannot enter 

Participation in access control Participation in access control No participation in access control 

Download to terminal Download to terminal Cannot download to terminal 

Listed in browse boxes Listed in browse boxes Not listed in browse boxes 

Can be loaded in master and 

movement data 

Can be loaded in master and 

movement data 

Can only be loaded using the employee 

master 

Report evaluation Report evaluation No report evaluation 

 

Note: This status is displayed in yellow in the status line. 
 

Assign overhead key 

Call 

Finance > Master data > Assign overhead key 

Description 

This dialog box gives you the option of assigning the selected purchased or manufactured items 

and work centers an overhead key (page 714). Selecting the required resources lets you define 

different overhead keys globally for material and work centers. 

You can also specify the required default value for the costing schedule for items. 
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For more information on costing, see Costing components, which provides the basic information 

you need for costing, and also Costing in detail, which provides a description of how to carry out 

the costing process. 

The Costing component is based on two sub-components: Value flow (page 749) and the actual 

costing function. 

The value flow function works primarily in the background, coordinating and recording the effects 

of other modules on the total inventory value and average item price. 

Costing includes the following costing types: 

 Cost rollup 

 Calculate manufacturing costs and total manufacturing costs 

 Quote costing 

To understand costing in Infor COM, we recommend that you read the following Help topics in the 

order indicated. 

1. Costing components (page 709) 

2. Costing in detail (page 714) 

3. Cost rollup (page 729) 

4. Calculate manufacturing costs and total manufacturing costs (page 733) 

5. Quote costing (page 740) 
 

Costing components 

The following topics describe the elements used for costing that affect the calculation procedure 

for costing (cost types, cost records, cost basis, costing schedules, fields, overhead key). 

For information on how costs are calculated, see Costing in detail (page 714). 
 

Costing 
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Cost types 

There are six cost types in Infor COM. They are used on the lowest level of costing and as the 

source for all subsequent cost calculations. They are also the only fields that users can enter 

manually. All other cost fields are calculated automatically. 

The data for these fields can be created in the item master, work center master, or operation 

master in order to determine the total costs for a defined item lot size. You should think carefully 

about what lot sizes you choose. 

Infor COM calls these cost elements cost types and divides them into variable and fixed costs. 

Variable costs 
 Material - Cost type 1 

 Wages - Cost type 3 

 Machine - Cost type 3 

 Setup - Cost type 5 

Fixed costs 
 Fixed PrC (fixed 

production costs) - Cost 

type 2 

 Other fxd (other fixed 

costs) - Cost type 6 

 
 

Cost records 

Cost records contain the costs of factors of production (labor, material) for each reference unit; for 

example, material costs for each unit manufactured, or wage costs for each hour worked. They 

serve as the basis for costing and thus also the basis for additional costing factors.  

The cost records for resources (items, work center groups, work centers, operations) are entered 

on the Costs tab of the master data for each cost type (see "Cost types" page 710). 

You must create cost records for the following resources. 

As a rule, it is not necessary to enter cost records for in-house manufacturing items since they are 

determined from the costs of the resources being used, and are displayed on this tab if costing 

was carried out correctly. 
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For purchased items for further processing, however, and for the resources work centers, work 

center groups, and operations, you must enter the cost records so that the final product can be 

costed properly. 

For information on how to enter cost records, see the example in the Enter cost records topic. 
 

Cost basis 

The cost basis of a resource is the quantity used as the basis for costing and is defined as a 

number and unit of measure (10 kg, for example). In other words, it combines a quantity and a unit 

of measurement. In Infor COM, costs are always determined based on the cost basis. 

Infor COM allows you to define different cost bases for individual cost fields on each level of an 

assembly. The cost basis for the components of an assembly can be completely different to the 

cost basis used for its parent item. 

Example: The total material costs of an assembly can be expressed as a specific unit of measure 

(for example, 2 boxes), while the cost basis for the lines of the assembly is a combination of liters, 

kilograms, and meters. 

In addition, cost rollup allows you to define a separate cost basis for manufacturing costing using 

the appropriate dialog box on the item level. 

Please note: To use multiple cost bases within an assembly, you must adjust the corresponding 

conversion settings on the UOM/size management tab. 
 

Costing schedules 

Infor COM allows you to define the formula to be used for costing unit costs, manufacturing costs, 

and quotes (including price increases). This can also include calculating a sale price. 

A costing schedule is a table that defines individual relative mark-up rates (administrative 

overhead costs, for example), and absolute mark-up rates (packaging cost, for example). You can 

create your own costing schedules or edit existing schedules. To do so, select System functions > 

Administration > Allocation tables and modify them accordingly. The standard system provides 

two allocation tables with costing schedules. 
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Note: The ZSCHEMA allocation table contains existing costing schedules. You can also add new 

schedules if necessary.   

 ZSCHEMA1 is the schedule that is used for master data costing and for calculating the unit 

sales price. 

The first eleven lines of the ZSCHEMA1 allocation table contain the default settings that are 

used in the corresponding fields of the total manufacturing costs table in Cost rollup. 

 ZSCHEMA2 is the schedule that is used for quote costing and for calculating the quote price. 

To specify the Infor COM costing schedule that is to be used for mark-up costing, go to the item 

master, select the Costs tab and specify the schedule in the Cost sched. field for the in-house 

manufacturing item that you want to cost. 

Please note: You can copy costing schedules, adjust the values in the copies, and then use the 

copied schedules for costing. 

Do not change the original costing schedule under any circumstances. If you would like to make 

changes, contact your consultant. 
 

Cost fields 

Each resource in Infor COM has a variety of cost fields that are specifically defined for the 

resource. 

The content of these cost fields are integrated into system operation; they are either entered 

manually or calculated automatically (for example, by cost rollup (page 729)). 

You can view the content of almost all of the following fields on the Costs tab of the resource. 

The following table shows the most important cost fields along with a short explanation of how 

their values are entered and the functions they use. 
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Field Populated by Read by Note 

Material 

Wages 

Machines 

Setup 

Fixed PrC 

Other fxd 

 (Batch) cost rollup 

 Manual entry by user 

in the master data 

 Cost rollup 

 Manufacturing costing 

 Quote costing 

The costs in these cost 

fields generally serve as 

the basis for costing. 

Valuation price  Batch cost rollup 

 Manual entry by user 

in the master data 

 Inventory valuation 

 Sales (as costs for calculating 

the contribution margin) 

This valuation price is 

the typical valuation 

price for inventory 

valuation. 

Average price Online average price  

calculation for purchased 

items 

 Inventory valuation 

 Financials/Cost accounting 

link 

 Based on the parameter 

setting for cost rollup, 

manufacturing costing, and 

quote costing 

The average price is 

only important for 

purchased items. 

Last purchase 

price 

Online average price  

calculation for purchased 

items 

 For display only in the master 

data or 

 Based on the parameter 

setting for cost rollup, 

manufacturing costing, and 

quote costing 

The last purchase price 

is only important for 

purchased items. 

Maximum 

purchase price 

Online average price  

calculation for purchased 

items 

 For display only in the master 

data or 

 Based on the parameter 

setting for cost rollup, 

manufacturing costing, and 

quote costing 

The maximum purchase 

price is only important 

for purchased items. 

Minimum 

purchase price 

Online average price  

calculation for purchased 

items) 

 For display only in the master 

data or 

 Based on the parameter 

setting for cost rollup, 

manufacturing costing, and 

quote costing 

The minimum purchase 

price is only important 

for purchased items. 
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Overhead key 

For help on overhead costing see Overhead costing (page 725). In Infor COM overhead costs are 

calculating using overhead keys. 

Overhead keys are numerical key values in the form of percentages, which are added to the 

individual cost records. Overhead keys are created and updated in the  GKZUSCHL allocation 

table. 

In Infor COM, an overhead key contains the six percentage rates for the mark-ups that are used to 

assign the overhead costs to the six cost types (page 710) Material, Wages, Machine, Setup, 

Other fxd, and Fixed PrC. 

For information on how to add overhead costs to direct costs using overhead keys, see Calculate 

manufacturing costs (page 737) and Calculate total manufacturing costs (page 738). 

The overhead key is available for a specific resource. It is assigned directly to the individual 

resources (or resource groups) and adds mark-ups to the resource’s cost records during mark-up 

costing. 

Store the overhead key on the resource's Costs tab in the Overhead key field. 

See also Overhead costing (page 725). 
 

Costing in detail 

The following overview lets you go to a specific costing-relevant topic using the links. 

 Different requirements apply when costing resource lines. For more information, see Line 

costing (page 715). 

 For information on how lot sizes affect costing see Costing and lot sizes (page 720). 

 For information on calculating warehouse inventory, see Inventory valuation (page 753). 

 For information on calculating average prices, see Average price calculation (page 721). 

 For information on multiple machine operation costing, see Multiple machine operation costing 

(page 722). 

 For information on how efficiency affects costing, see Costing and efficiency (page 722). 
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 For information on how to generate the cost history of an item, see Item cost history (page 

723). 

 For information on costing by-products, see By-product costing (page 724). 

 For information on costing with overhead costs, see Overhead costing (page 725). 
 

Line costing 

When you cost an item or order, the underlying data from the BOR line for this item is used. 

The FdCst parameter on the Costs tab in the BOR has a decisive impact on the costing of BOR 

lines. The effects of this setting depend on the record type. For effects on costing material lines 

(see "Material line costing" page 715), costing subcontracted manufacturing lines (see "Costing of 

subcontracted manufacturing lines" page 716), and costing operation lines (see "Operation line 

costing" page 717), see the respective topics. 

 
 

Material line costing 

For information on costing lines, see Line costing (page 715). 

For the MA record type, only the flags 0, 1, and 2 are used for the FdCst configuration parameter. 

The following table shows how the FdCst setting affects the calculation of costs. 
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KFix=0 Non-FRA item Planned costs and actual costs are calculated individually for each cost type: 

Material, Fixed PrC, Wages, Machines, Setup, and Other fxd. 

Planned costs: The costs for each cost type are multiplied by the planned 

quantity. 

Actual costs: The costs for each cost type are multiplied by the actual 

quantity. 

KFix=0 FRA item Costs are calculated in the same way as for non-FRA items, except that the 

actual costs can be taken from the production order. 

KFix=1  The total of the planned costs and actual costs corresponds to the valuation 

price for the cost type defined in the 

COMMON.KALKULATION.BEWPREISKOSTEN90 parameter in the 

configuration (see note below). 

KFix=2  The planned and actual costs for the cost type defined in the 

COMMON.KALKULATION.BEWPREISKOSTEN90 parameter (see note 

below) are derived by interpreting the valuation price in the BOR as unit costs. 

The valuation price is multiplied by the quantity. 

Note: The configuration includes an entry that specifies the cost type to which the valuation price 

should be assigned for record type 90 (MA record).  

The COMMON.KALKULATION.BEWPREISKOSTEN90  parameter is defined in the 

configuration. Cost type 1 (material) is set as a default, but you can specify any cost type from 1 to 

6. 

Note: This value is only evaluated if the KFix>0 flag is used to indicate that the valuation price 

needs to be taken into account. 
 

Costing of subcontracted manufacturing lines 

For information on costing lines, see Line costing (page 715). For information on subcontracted 

manufacturing, see Subcontracted manufacturing. 

There are three costing options available for subcontracted manufacturing lines (SCO record 

type). 

 Costs can be calculated from the lower levels upward (if operations were completed by the 

supplier and materials were provided by the supplier). In this case, cost variances can occur 

because actual times/quantities differ from the planned times/quantities (for example, because 

a greater quantity of material than planned is required). 

 Costs can be taken from the valuation price set in the subcontracted manufacturing line, which 

can be defined as total costs or unit costs. In this case, there will be no differences between 

planned and actual costs. 
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 The actual costs for the subcontracted manufacturing line can be taken from the purchase 

order or purchase invoice. If an invoice is available, the actual costs are taken from this 

invoice; otherwise, the order price is used. The planned costs can be taken from the valuation 

price or calculated from lower levels. In this case, a variance may occur due to the difference 

between valuation price and purchase invoice or order price. 

These options can be combined as required in Infor COM. You can select the costing method to 

be used by means of the FdCst flag in the subcontracted manufacturing line. 

Please note: The FdCst=8 setting should always be used for SCO records. For other settings, 

please contact your consultant. 

The COMMON.LEITSTAND.FREMDFERTIGUNGPREISEINKAUF parameter should also be 

taken into account here. 

Important note: The configuration includes a COMMON.KALKULATION.BEWPREISKOSTEN115 

parameter for record type 115 (subcontracted manufacturing). This parameter allows you to 

specify the cost type to which the valuation price is to be transferred. Cost type 3 (wages) is set by 

default, but you can specify any cost type from 1 to 6. 

 

KFix flags 1, 3, 5, and 7 do not take the valuation price's unit of measure into account, whereas 

flags 2, 4, 6, and 8 do. This means that you cannot calculate costs based on the valuation price's 

unit of measure if the total costs are defined in the valuation price. 

Please note: This value is only evaluated if the KFix>0 flag is used to indicate that the valuation 

price needs to be taken into account. 
 

Operation line costing 

For information on costing lines, see Line costing (page 715). 

For the OP record type, only the flags 0, 1, and 2 are used for the FdCst parameter. 

Time is an important element used in operation line costing; Infor COM calls this total operation 

duration. 

You can use three fields to configure how the total operation duration is calculated: Time basis, 

F.RT (runtime), and F.ST (setup time). 
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These fields are located on the Times/quantities tab in the BOR. They affect the calculation of total 

operation duration as follows: 

Time basis = 0 

Total operation duration = (Quantity * Job time + Setup time) * (Efficiency + 100) / 

100 

 

Time basis > 0 with F.ST selected 

Total operation duration = (Quantity * Job time + Quantity * Setup time / Time basis) 

* (Efficiency + 100) / 100 

 

Time basis > 0 with F.RT selected 

Total operation duration = (Quantity * Job time / Time basis + Setup time) * (Efficiency 

+ 100)/100 

 

 

Time basis > 0 with both F.RT and F.ST selected 

Total operation duration = (Quantity * Job time / Time basis + Quantity * Setup time 

/ Time basis) * (Efficiency + 100) / 100 

 

Discrepancies can occur if the actual time is greater or less than the planned time. 

If KFix=0, costs are calculated based on all cost types. 

Costs are calculated for each cost type: Material, Fixed PrC, Wages, Machines, Setup, and Other 

fxd. 

The following table shows two examples. In the first example, there is no time basis defined for the 

setup time; in the second example, there is a time basis specified for the setup time. 

Example 1: No time basis defined for the setup time (default setting) 
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Cost type Cost calculation 

Material Material costs * Total operation duration 

Fixed PrC Fixed production costs * Total operation duration 

Wages Wages * (Total operation duration - Setup time) 

Machines Machines * (Total operation duration - Setup time) 

Setup If Setup costs <> 0: Setup costs * Setup time 

Otherwise: (Wages + Machines) * Setup time 

Other fixed 

costs 

Other fixed costs * Total operation duration 

 

Example 2: Time basis defined for setup time 

Cost type Cost calculation 

Material Material costs * Total operation duration 

Fixed PrC Fixed production costs * Total operation duration 

Wages Wages * (Total operation duration - Setup time / Time basis * Quantity) 

Machines Machines * (Total operation duration - Setup time / Time basis * Quantity) 

Setup If Setup costs <> 0: Setup costs * Setup time / Time basis * Quantity 

Other fixed 

costs 

Other fixed costs * Total operation duration 

 

 KFix = 1 

Total costs = Valuation price for the cost type set in the BewPreisKosten60 parameter (see 

note below). 

 KFix = 2 

Costs = Unit costs based on the valuation price for the cost type defined in the 

COMMON.KALKULATION.BEWPREISKOSTEN60  parameter (see note below), i.e. the valuation 

price multiplied by the quantity.  
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Important note : The configuration includes a 

COMMON.KALKULATION.BEWPREISKOSTEN60=3 parameter for record type 60 (operation). 

This parameter allows you to specify the cost type to which the valuation price is to be transferred. 

Cost type 3 (wages) is set by default. You can specify any cost type from 1 to 6. 

Note: This value is only evaluated if the KFix>0 flag is used to indicate that the valuation price 

needs to be taken into account. 
 

Costing and lot sizes 

The lot size used for calculating item costs is defined in the Lot field (Proposal) on the Costs tab of 

the item. 

Note: You must specify a logical lot size to ensure that costs are calculated for realistic batch 

sizes. 

You can choose from three possible lot sizes: 

Min. planning If Min. planning is selected, the lot size is set by default to the 

smaller size on the Quantity field on the Planning tab in the 

item master. 

Max. planning If Max. planning is selected, the lot size is set by default to the 

larger size on the Quantity field on the Planning tab in the 

item master. 

Fixed lot size Select this setting and then enter a quantity in the Lot field 

(Proposal). 

 

For greater accuracy, you can configure cost rollup (page 729) to let the costs of assemblies at the 

lower levels take into account the lot size of each of these assemblies. 

Example: If an item has total costs of 100 (incl. setup costs) and is costed using a lot size of 50, 

the unit costs amount to 2. If this item is used in a BOR that requires 4 units of this item, the total 

standard costs are calculated as 4 * 2 = 8. 
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Average price calculation 

As a rule, the term "Average price" refers to the weighted average price. A weighted average is 

created from the opening inventory quantities and receipts during the financial year and then used 

to valuate both the issues and the end inventory. 

 

The term "Moving average price" also refers to the average price. A new average price is 

calculated immediately after each receipt, and that price is then used to valuate each issue until 

the next receipt. 

The average price of an item is based on the average cost of the warehouse inventory. It is 

calculated using the rolling average price method, which re-calculates the average price every 

time costs change as a result of an inventory movement. 

An average price calculation is carried out for purchased items only. 

The calculation is based on the following formula: 

 

Explanation: 
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Vnew New value 

Qnew New quantity 

APold Previous average price of the item before the current 

transaction 

Qold Total warehouse inventory of this item before the current 

transaction 

PT Price per unit of the item at the time of the current transaction 

QT Item quantity purchased in the current transaction 

 
 

Multiple machine operation costing 

Multiple machine operation means that several machines are operated by one worker. Multiple 

machine operation is represented by the same process in Infor COM, scheduled several times in 

parallel. Processes can also be split. 

Effects on costing 

Splitting a process into two parallel processes doubles the accrued costs. 

When cost records for the process are generated, the number of machines used by one worker 

must already be established. Labor costs for the worker must be divided by the number of 

machines, particularly when parallel processes are involved. You cannot change the number of 

machines to determine other costs. 
 

Costing and efficiency 

Efficiency is used to specify where a process is performed by more than one worker. It refers to 

the number of resources running in parallel. 
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If efficiency is doubled, all accrued costs are doubled. 

When the cost record for the process is generated, the number of workers involved must already 

be established. Machine costs must be adjusted according to the number of workers assigned. 

You cannot change the efficiency factor to determine other costs. 
 

Item cost history 

Description 

Using the cost history has the following advantages: 

If you change or save the resource costs manually on the Costs tab or using Cost rollup, a 

historic cost record is generated and assigned a unique cost ID. 

Historic cost records are also generated in the following cases: 

 When you change the valuation price manually 

 When changes are made to material costs as a result of inventory receipts (requires the 

COMMON.DURCHSCHNITTSPREIS.DPINMATERIALKOSTEN=yes parameter to be set 

in the configuration) 

 Costing uses the cost records valid at that time. 

 The Historic costs tab lets you track the development of cost records over time. 

 

Effects on costing 

 (Batch) cost rollup always works with the cost records currently valid. 

 Manufacturing costing calculates costs using the cost records that were valid at the time the 

order was created. 

How costing works depends on the entry in the FdCst field in each BOR line (see 

COMMON.KALKULATION.CALCHISTORYFUNCTIONACTIVE). 

If you start the Manufacturing costs batch process (page 744) program, you can save the 

costs for each production order as individual data records. 

To view the costs, select the Historic costs tab in the item. For each costed production order, the 

ID field allows you to access a row that displays the planned and actual costs for each record. 

 

Value f low model 
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In value flow model 0 cost rollup (page 729) uses the current costs from the resource master, and 

manufacturing costing (see "Calculate manufacturing costs and total manufacturing costs" page 

733) uses the historic costs valid at the time the production order was released. If they are not 

found, the costs from the resource master data are used. 

If the value flow model is greater than 0, cost rollup also uses the current costs from the resource 

master data. Manufacturing costing reads the values from the posting journal. 

Configuration 

You can activate the cost history for an item using the 

COMMON.KALKULATION.CALCHISTORYFUNCTIONACTIVE=yes entry in the configuration. 
 

By-product costing 

By-product manufacturing generates multiple different products (by-products) due to technological 

or natural reasons. See By-product manufacturing. 

In some cases, by-products generated during manufacturing can be utilized, posted to inventory, 

and sold as a product. 

A by-product is defined by the BH record type and can be stored in the BOR of manufactured 

items. 

By-products do not have their own costs; their costs are included in the costs of the manufactured 

item. They are therefore costed according to the remaining value method. 

By-product costs are not extrapolated to the manufactured item costs. 

Example of a BOR with by-products: 
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Record type Item name Qty Costs 

HR Casing 2 325.00 

MC Upper housing 1 162.50 

MC Lower housing 1 162.50 

OP Split housing  150.00 

MA Report 2 500.00 

In this BOR the calculated costs of material and the operation total 650.00. These costs are 

divided proportionally between the header record (HR) and by-products (BH): 650/4=162.50. 

The by-products each receive a fourth of the costs, 162.50, and the header record receives the 

remaining half of the costs, 325.00. 

The header record costs are those inherited from a higher level BOR. 

 

The above costing process is carried out for each of the six cost types (page 710). 

Note: The unit of measure for by-products must be compatible with their parent items. If the unit 

of measure differs, you must specify the conversion factor in the master data of the parent product 

or by-product. 

By-product details are used in item costing, production order costing, quote costing, cost rollup 

batch process, and cost rollup batch process (multi-level). 
 

Overhead costing 

Overhead costing in Infor COM allocates overhead costs for cost centers to reference units using 

mark-up percentages (overhead surcharges). 

Direct costs/overhead costs 

Direct costs are costs that are added directly to a product (for example piecework wages). 

You obtain the direct costs of a resource in Infor COM by adding the six cost records (in the Costs 

section on the item's Costs tab). 
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In contrast to direct costs, overhead costs cannot be added directly to a product or service 

because they are accrued for multiple products or services of a cost area (such as depreciations, 

electricity costs, and so on). Overhead costs are allocated to defined reference units using 

mark-up percentages. 

Costing 

Infor COM calculates overhead costs using overhead keys (see "Overhead key" page 714). 

 
 

Calculate setup costs 

Setup costs are costs incurred due to set up, which refers to such setup operations as setting up a 

machine for a certain operation. 

Infor COM provides a setup costing process in which the setup costs are either calculated from the 

wages/machine costs or from custom setup cost hourly rates. 

Using the setup costing function affects the Wages, Machine, and Setup cost types. 

Setup costs can be calculated using four different methods. To specify the method (1-4) that Infor 

COM is to use, you use the COMMON.KALKULATION.RUESTKOSTENMODUS parameter in the 

configuration. For information on time entries required for calculating setup costs, see Time 

calculation. 

The settings are: 

RuestKostenModus=1 

In this case, the Setup cost type is handled like a normal cost type. Setup costs are not calculated. 

Setup costs = Total operation duration (Total time) * Setup cost 

type 

Machine costs = Total operation duration (Total time) * 

Machines cost type 

Wage costs = Operation content (Total time) * Wages cost type 

 

RuestKostenModus=2 
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You want setup costs to be shown, but an individual Setup cost record is not maintained. The 

setup costs are therefore calculated using the Machine and Wages cost types. 

Setup costs = (Setup time (STi) * Machines cost type) + (Setup time (STi) * Wages cost 

type) 

Machine costs = (Operation content (Total time) - Setup time (STi)) * Machines cost type 

(from the work center) 

Wage costs = (Operation content (Total time) - Setup time (STi)) * Wages cost type 

 

RuestKostenModus=3 

You want to show setup costs. A setup cost record is defined, which is also used for calculation. 

Setup costs are calculated using the Setup cost type (specified in the work center). 

Setup costs = Setup time (STi) * Setup cost type (from the work center) 

Machine costs = (Operation content (Total time) - Setup time (STi)) * Machines 

cost type (from the work center) 

Wage costs = (Operation content (Total time) - Setup time) * Wages cost type 

 

RuestKostenModus=4 

This setting specifies that if the Setup cost type is entered in the work center, costing is the same 

as for RuestKostenModus=3. Otherwise, the setup costs are calculated from the machine and labor 

costs, as with the RuestKostenModus=2 setting. 
 

Costing types 

When you run cost rollup (page 729), the dialog box provides the options Compl. or Fast. Which 

option you select affects the costing results considerably. 
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Complete costing Complete costing always breaks down the in-house items with record type 

MA to the lowest level of the BOR (16) or to the level you enter in the 

Maximum level depth field. 

In other words, the BOR is broken down to the maximum level depth; 

subordinate assemblies are broken down to the lower levels during the 

costing process. 

or cost rollup, the default setting is Compl. 

Fast costing If you use the Fast costing function, the BOR for in-house items with the 

record type MA are only broken down further in the costing (and costs 

calculated) if all cost types (page 710) (fixed and variable) have a value of 

zero. Otherwise the values of these items that are currently stored in the 

item's master data are used. This is why this costing type is called fast 

costing. 

Note: Complete costing is appropriate when setup costs are not primarily 

influenced by lot size. 

When setup costs are significant, it is usually more appropriate to use fast 

costing since the setup costs for the required lot size are costed 

accordingly. We recommend that you cost subordinate assemblies using a 

typical lot size before you cost the item. 

 

The following table shows the advantages and disadvantages of the two methods. 
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Fast costing Complete costing 

 Faster processing time 

 Smaller, shorter BOR 

 The costs calculated are only 

as accurate as the cost records 

on the lower levels. Fast 

costing therefore makes sense 

if the costs are well-maintained 

at the lower levels. 

 Longer processing time 

 Full BOR 

 From the second level on, only the actual lot size is used in 

the BOR, which is not necessarily the typical lot size for the 

item. This can lead to misleading results for setup costs. 

 
 

Cost rollup 

Call 

You can enable cost rollup from an item by selecting Functions >Cost rollup or as a batch process 

(see "Cost rollup batch process" page 745). The direct and overhead costs are saved in both 

cases. 

In the dialog box, specify the Costing type (see "Costing types" page 727). 

Description 

Cost rollup describes the means used to determine the manufacturing costs for an item 

manufactured in-house. It is carried out by adding all costs for each component (incl. operations) 

of the assembled item for a given lot size. Assemblies are included. 

Put simply, cost rollup is BOR costing. It comprises complete costing and mark-up costing. 

Example: Cost rollup is used in series manufacturing for example, where standard BORs are 

created for standard products. Cost rollup can calculate the costs and potential sales prices. 

You can edit the level of the structure at which the costing process begins (default: 16). By 

breaking down the BOR, costs are added or calculated up to the highest level (the finished 

product). 
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Calculation basis 

Cost rollup is based on the following data: 

 Raw material: Cost records calculated for purchased items 

 Operations: Work center costs (wages and machine costs) 

 BOR: Routing and bill of materials for manufacturing the finished product, including specified 

quantities 

 Level depth 

 Complete/Fast costing: You can define this setting when you start the Costing procedure 

 Costing schedules: These schedules can be defined at higher or lower levels. Each costing 

schedule has its own allocation table containing the formulas for costing. See also Costing 

schedules. 

 Overhead keys: Overhead keys are saved in the system at the resource level. Overhead cost 

rates are saved in the GKZUSCHL allocation table. See also Overhead costing. 

 Fixed costs flags: Defined in each resource, they determine exactly which lower-level costs 

are included in cost rollup and how. 

 Lot size: The lot size entered when cost rollup is called (see below). You can call the cost 

rollup function from the item to be costed by selecting Functions and Cost rollup. 

If the starting level is an in-house item, the currently saved costs are taken from the master data 

(in other words, the current values of the fixed and variable cost types). 

For information on how to enter these costs in resources, see Store cost records in resources (see 

"Cost records" page 710). 

Please note: The entry in the Material field on the Costs tab is always used for costing purchased 

items. Costing does not take purchase prices stored for the supplier into account. 

Schedule 

Cost rollup calculates costs according to the following formula: 
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Manufacturing material 

+ Manufacturing wages 

+ Machine/Setup costs 

+ Product-fixed manufacturing costs/Other fixed 

costs Manufacturing costs 

= Direct costs 

+ Overhead surcharge as per overhead key 

= Manufacturing costs 

 

Result 

Cost rollup returns the cost records, direct costs, manufacturing costs, and total manufacturing 

costs of the finished product. 

Direct costs equal the manufacturing costs plus additional surcharges for sales, administration, 

packaging, and so on. These surcharges are predefined in the costing schedule, which is stored 

on the Costs tab in the item master. 

The manufacturing costs equal the direct costs plus the overhead surcharges according to the 

overhead key and overhead cost mode. 

Based on the BOR and cost records in the resource masters, the direct costs are the cost records 

times the contents of the RTI and STi fields. 
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The results can be transferred to the item master as cost data. You can also transfer the 

manufacturing costs to valuation price. 

Strictly speaking, manufacturing costs and total manufacturing costs are calculated via mark-up 

costing, which is automatically carried out as an integral part of cost rollup. Mark-up costing is 

explained in the Calculate manufacturing costs and total manufacturing costs (page 733) Help 

topic. 

After the cost rollup process is complete, the sales price is calculated via quote costing (page 

740). The sales price equals the direct costs plus the profit mark-ups. Profit mark-ups are stored in 

the costing schedule, which is entered on the Costs tab in the item master. 

In practice 

Notes and errors that occur in the calculation are saved to Mailbox 61. 

To transfer the costing result to MS Excel select Go to > Excel. 

You can print the following reports from the Cost rollup view by selecting Data > Print: 

Direct costs This report outputs the direct costs by cost type (without overhead surcharges) 

across the entire structure. 

Manufacturing costs This report outputs the manufacturing costs by cost type (with overhead 

surcharges) across the entire structure. 

Structure only This report displays detailed information on the manufacturing structure. 

 

Configuration 

If CalcHistoryFunction=yes, the new costs (including overhead costs) are saved to the historic 

costs table each time the cost types are updated. In the item master the Historic costs tab lets you 

view then with and without overhead costs and the date when the costs were modified. See also 

Item cost history (page 723). 
 

Run cost rollup 

This topic explains how to roll up costs. 
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1. Select Design > Item and open the item you want to cost. 

2. On the Functions menu select Cost rollup. 

3. In the following dialog box define 

 The quantity you want to cost (Costing for). 

Note: If a lot size is already defined in the item master data, it is automatically used as the 

default setting. 

 The manufacturing structure level to which you want costs to be calculated (Maximum 

level depth) 

 Whether you want to use complete costing or fast costing (Costing type) 

4. Click OK to confirm your entries. 

The active Direct costs tab displays the cost rollup result. 

Each line represents one resource. The costed finished product is displayed on the first 

line. All resources involved are listed underneath, according to the manufacturing 

structure. 

You can view the calculated cost records (page 710) in the six fields from Material to 

OFxCst in the finished product line. 

The total of all cost records is indicated in the final product's Total field. This corresponds 

to the product's direct costs. 

5. If you want, you can follow up by carrying out mark-up costing to calculate the manufacturing 

costs and total manufacturing costs. See Calculate manufacturing costs and total 

manufacturing costs (page 733). 
 

Calculate manufacturing costs and total manufacturing costs 

Call 

You can open the manufacturing costing function from a sales order, production order, or rough 

planned order by selecting Calculate manufacturing costs from the Functions menu. A batch 

process (see "Manufacturing costs batch process" page 744) is also available. 
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Description 

Manufacturing costing refers to production order costing. Unlike quote costing (page 740), which 

supports pricing, manufacturing costing controls the costs of an order. 

Manufacturing costing lets you see what it costs to produce an order. 

Note: Unlike with Cost rollup, this function does not write any costs to the order and does not 

change the item master data. The costs are displayed for information only. 

Manufacturing costing evaluates the following data: 

 Production order with material quantities and operation durations 

 Costs in item and work center master data 

 Selection of complete or fast costing 

 Level depth default value 

Manufacturing costing returns the following results: 

 When you open manufacturing costing, planned and actual costs (if available) are calculated 

to check cost development and compared on the Overview tab. 

 You can display remaining costs, final costs, and deviations from planned values. 

Note: The fields displayed will vary according to whether the manufacturing costing function was 

opened from a sales order or a production order. In the Manufacturing module, you can also 

display a planned/actual comparison, and the resource transactions are evaluated. 

Overview 

The following table provides an overview of how manufacturing costs and total manufacturing 

costs are calculated in Infor COM. The costing method used here is differentiating mark-up 

costing. 
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Material direct costs (Manufacturing material)  

Material 

costs 

 

 

 

 

Manufacturing 

costs 

 

 

 

 

 

 

 

 

Total 

manufacturin

g costs 

Material overhead costs (mark-up based on 

manufacturing material) 

Production direct costs (manufacturing wages)1  

Production 

costs 

 

Production overhead costs (mark-up based on 

manufacturing wages)1 

Misc. manufacturing costs 

Admin. overhead costs (mark-up based on manufacturing costs) 

Sales overhead costs (mark-up based on manufacturing costs) 

Misc. direct sales costs 

1Performance qty * rate 

Definitions 

Manufacturing costs comprise the material costs and production costs. If you take the 

manufacturing costs and add administration and sales overhead costs and miscellaneous direct 

costs of sales (such as insurance, freight, packaging, commission), you get the total 

manufacturing costs. 

See also the following definitions: 

Term Definition 

Direct  

material costs  

Material direct costs can be added directly to a product (based on bills of materials). 

Material  

direct costs 

Material overhead costs are costs that cannot be allocated to individual cost units 

(products), for example procurement costs, inventory costs, inspection costs, HR costs, 

or depreciation costs. 

The material costs per unit equal the material cost mark-up rate per unit times the 

material cost mark-up rate from the formula Material overhead costs/Material 

direct costs. 

Material costs Material costs equal the material direct costs plus the material overhead costs per unit. 
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Term Definition 

Production  

direct costs 

Production direct costs are manufacturing wages that can be assigned directly to a 

product. 

Manufacturing  

overhead costs 

Manufacturing overhead costs are the production costs that cannot be assigned directly 

to individual cost units (products), for example indirect labor/material costs, energy, 

process materials, or cost-accounting depreciation/interest. 

Manufacturing overhead costs are added to the production direct costs using a mark-up 

rate, which is calculated from the production overhead costs and the production wages 

that can be allocated directly. 

Misc. manufacturing 

costs 

Miscellaneous manufacturing costs are direct costs that are incurred for certain orders, 

for example models. 

Production costs Production costs equal the total production direct costs and manufacturing overhead 

costs plus the miscellaneous manufacturing costs. 

Administrative  

overhead costs 

Administrative overhead costs are costs that are incurred in company administration that 

cannot be assigned directly to the product. 

Sales  

overhead costs 

Sales overhead costs are costs that are incurred in product sales that cannot be assigned 

directly to the product. 

Note: Administrative and sales overhead costs are added to the manufacturing costs. 

Miscellaneous direct 

costs for sales 

These costs are additional sales-related costs that can be assigned to a specific product. 

Infor COM lets you enter freight costs, special packaging costs, and sales commissions 

for example. 

 

Configuration 

When a production order is finalized, a final costing of manufacturing costs is carried out 

automatically, if applicable. If cost variances occur, they are transferred to the posting journal and 

will therefore be available for transfer to Financial accounting. 

The POSTCODEODC allocation table defines how cost variances are posted. The posting ID is 

29000 (production order cost variance). The accounts to be updated against this posting ID are 

defined in the BUCHKTO table. 

The inventory account for the production order item is used to specify the accounts to which the 

cost variances are to be posted, so that the correct line in the BUCHKTO table is read. 

The value to be posted is calculated from the balance of the WIP account for the production order 

and is stored as a posting record in the posting journal. The corresponding entries have the 

posting ID 29000 for the production order cost variance and a reference to the production order ID. 
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Cost variance postings are carried out for all six cost types (page 710). 

The COMMON.VALUEFLOW.SUPPRESSZEROPOSTINGS parameter indicates whether zero 

values can be posted. 
 

Calculate manufacturing costs 

You can calculate the manufacturing costs from within a sales order, production order, or rough 

planned order. The following procedure illustrates how you can view the manufacturing costs after 

you have run cost rollup. 

1. In the item master, run cost rollup (see Run cost rollup (page 732)). The active Direct costs tab 

displays the costing structure with the calculated direct costs of the in-house item. 

2. To calculate the manufacturing costs using mark-up costing go to the Manuf. costs tab. The 

manufacturing costs are calculated and displayed. 

You can see in the table that the overhead surcharges were assigned to all cost records (from 

Material to OFxCst). 

The Total field for the finished product contains the manufacturing costs. 

3. Open the sales order containing the item you want to cost. 

4. Select Functions and Calculate manufacturing costs and confirm the dialog box that is 

displayed with OK. 

5. In the Compare planned/actual section, select one of the display options: RemCosts, Final 

costs, or Variance. 

RemCosts  This option shows the open costs that are likely to be accrued by the time the order is 

finished. 

Final costs This option displays the probable final costs for the production order. If there are no 

variances during the manufacturing process, the final costs equal the planned costs. 

Variance If you select the Variance option, the difference difference between the planned and actual 

costs is displayed. 

 

6. To print the costing results, select File and Print. 
 



738 | Infor COM 7.5 User Guide 

 

Finance 

 

Calculate total manufacturing costs 

To calculate total manufacturing costs, complete the following steps: 

1. Run cost rollup. See Run cost rollup (page 732). 

2. Go to the Total manufacturing costs tab. 

The costing structure for the in-house item total manufacturing costs is displayed. 

Note: The total manufacturing costs will only be displayed if the costing schedule (see 

"Costing schedules" page 711) is stored on the Costs tab in the Cost sched. field. The amount 

and type of each of the mark-ups used are defined in the costing schedule . 

Mark-up costing for total manufacturing costs uses the  Master data mark-up costing costing 

schedule for example. 

The Overhead costs field is the cumulative value of the overhead surcharge that is added 

to the individual cost records when calculating the manufacturing costs during mark-up 

costing (see Calculate manufacturing costs (page 737)). The direct costs and overhead 

costs together produce the manufacturing costs. 

 

 

Direct costs 
+ Overhead costs 
+ Misc. direct costs for sales 
_____________________________ 

Manufacturing costs 

 

 

3. The Int. tax payt field allows you to specify a percentage that is deducted from the 

manufacturing costs per unit in order to adjust the item's flat value basis for the commercial 

balance sheet and tax balance sheet to take into account items that do not require activation. 

4. Enter values for miscellaneous direct costs of sales, such as insurance, freight, packaging, or 

commission. 

5. To end the cost rollup process select Data > Close twice. 
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6. When asked whether you ant to transfer the cost records to the item, select Yes. 

The resulting cost records are transferred to the item master data and displayed on the Costs 

tab. 
 

Compare cost rollup/manufacturing costing 

Cost rollup and manufacturing costing – based on planned values – do not always return the same 

result. There are several reasons why the two costing methods can cause differences to occur. 

 Lines with record type TX in the BOR (for example alternative lines) are converted to MA 

records in the production order. As a result, the costs of this new MA record are included in the 

calculation. 

 Changes are made to the RTi, STi, or Machine efficiency fields in the production order. 

 Lines are deleted or added in the production order. 

 The cost records have been modified between cost rollup and manufacturing costing. This can 

be due to manual reworking of the cost records and by writing the average prices back to the 

material cost record. 

 If the cost history is enabled, manufacturing costing uses the cost records at the time the order 

was created, while cost rollup uses the most current cost records. 

 Changes to overhead surcharges affect costing because there is no history for them. 

 If manufacturing costing and cost rollup use different costing types (complete or fast costing), 

the results cannot be compared. 

 Structural changes in the BORs such as shifting or switching work centers have an effect on 

the costing results. 

Note: Production orders that have already been created still have an unmodified structure 

and are costed on this basis, while cost rollup always costs using the current BOR. If no 

multi-level cost rollup batch process was run following the structural changes, fast costing in 

particular uses incorrect cost records. 

 The use of NPI/discontinuation control can cause different costing results. 

Note: Cost rollup generally works always with a quantity of 1 or a lot quantity, while 

manufacturing costing uses the order quantity. This quantity can differ. Consequently, different 

resources and operations can be used independently of their quantity, which has an effect on 

costing. 

 Using VARIANTS or decision logics can cause different costing results. 

Note: Product configuration generation often works with decision logics, which are stored 

in a base BOR. These decision logics can depend on order features for example. As a 

result, cost rollup is not possible. However, you can influence or use fields such as RTi, 

STi, and so on to select different work centers depending on the quantity for example. 
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Quote costing 

Call 

You can open quote costing from quotes or sales orders. To do so select Functions > Quote 

costing (see Perform quote costing (page 741)). 

Description 

Quote costing performs a costing based on a BOR and then supplies the costs and prices to the 

quote or order line. 

By determining manufacturing costs and incorporating mark-ups, Quote costing uses the same 

costing process as Cost rollup (page 729) to calculate an appropriate price for the item. The 

mark-up values used here are taken from the costing schedule that you select in the Cost sched. 

field (see Calculate total manufacturing costs (page 738)). 

 

The quote price is determined here using the following calculation: 

 

 

Total manufacturing costs 

+ Percentage profit mark-up (calculation: by the hundred) 

= Subtotal 1 (cash sales price) 

+ Percentage mark-up for agreed cash discount (calculation: to one hundred) 

= subtotal 2 

+ Percentage mark-up for agreed discount (calculation: to one hundred) 

= (Net) sales price (order) 

 

 

The costing results includes information such as the quote price (the price transferred to the 

quote), total manufacturing costs, and contribution margins. 
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CM Calculation Explanation 

CM1 Quote price 

- (Var. costs/Planned quantity) 

The amount contributed by a product unit toward 

covering the costs remaining after the variable costs are 

covered. 

CM2 Quote price 

- ((Variable costs+ MDC))/Planned 

quantity) 

The amount contributed by a product unit toward 

covering the costs remaining after the variable costs are 

covered including miscellaneous direct costs (MDC) from 

manufacturing. 

CM3 Quote price 

- Manuf. costs/Planned quantity 

The amount contributed, after the manufacturing costs 

are covered, by a product unit toward covering: 

• Operating and administrative overhead surcharges  

• Surcharges associated with determining sales prices 

 

CM4 Quote price 

- Total man. costs/Planned 

quantity 

The amount contributed, after the total manufacturing 

costs are covered, by one unit of the product toward 

covering: 

• Profit  

• Cash discount, and ordinary discount mark-ups 

 

 

 

In addition to quote costing (pricing), you can also define prices manually (such as attainable 

market prices) and calculate the attainable contribution margins. For more information, see 

Calculate contribution margin (page 742). 

Configuration 

You can use the COMMON.KALKULATION.USESUPPLIERPRICEFORQUOTES=yes parameter 

to specify that Quote costing should take into account the scaled prices stored for an item. 
 

Perform quote costing 

To cost a quote (see "Quote costing" page 740), complete the following steps: 
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1. Open or create the quote you want to cost by selecting Sales > Order processing > Quotes 

with the items and item quantities you want to cost. You must have created a costing schedule 

for the items. 

Note: You can also cost the quote in the sales order in the same way. 

2. Select Functions > Cost quote. 

Note: To cost selected lines, click the row header to select the lines before calling the 

function. To select multiple lines, hold down the CTRL key. 

3. To display detailed costing for the selected lines, select View > Quote costing. 

View Description 

Quote costing 

overview 

This view shows the costed quote price for each line of the quote. You can 

calculate the quote price for lot sizes by adjusting the quantities for each line. 

To update the costing structure from the BOR for the resource in this view, select 

Functions and Update structure breakdown. 

Quote  

costing 

This view  view contains the costing according to the populated costing 

schedule (see "Costing schedules" page 711) (usually Quote mark-up 
costing). You can edit the mark-ups or percentages to adjust the quote price. You 

can save the changes for the quote. 

Quote  

costing  

structure 

This view lets you edit quantities and times and add lines based on the 

EditKalkStrukt parameter. To recost the quote, select Functions and Re-cost. 

 
 

Calculate contribution margin 

The contribution margin is the amount that covers fixed costs after the variable costs have been 

subtracted from the sales revenue. 

Formula: Contribution margin = Net sales revenue - Variable costs 

It indicates the proportion (contribution margin) of individual products used to cover overhead 

costs that cannot be directly assigned to cost units. 

1. Run quote costing (see "Perform quote costing" page 741). 

This takes you to the quote costing overview. The Quotes tab displays the costed quote price 

and contribution margin 1 (CM 1) for each quote line. 
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2. From the View menu, select Quote costing to go to the single view for the selected line. In the 

Costs/prices per unit form section, along with the costed quote price per unit and the 

contribution margin 1 value (CM 1), three additional contribution margin variants are shown for 

the item (CM 2 to  CM 4). 

The values in the Costs and Surcharges sections refer to the quote quantity shown in the 

Planned quantity field in the form header. 

3. Change the quote price as required. Changes automatically recalculate contribution margins 1 

to 4. 
 

Post-project costing 

Call 

Finance > Costing > Post-project costing 

Description 

Post-project costing in Infor COM allows you to compare the costs and sales revenue for a project. 

Projects are defined in Infor COM using the Job or Cost unit fields. In the dialog box, indicate 

which field defines the project. 

This requires cost units or jobs to be stored in the master data. Post-project costing is based on 

the following formula: 
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Schedule Description 

Sales Shows the revenue from invoices and credit memos (Net 2 invoice field). The cost units 

must be set in the invoice. 

+ Planned sales 

revenue 

Shows the revenue anticipated from sales orders. The expected open revenue (without 

any previously assessed revenue) is shown for each existing sales order with the cost unit 

entered in its header form. The amounts are taken from the Net 2 field of the sales orders 

that are not yet settled. 

- Inventory issues Shows the costs incurred from inventory issues for Sales (to cost units) for items without a 

fixed requirement allocation. Because there is no direct assignment to the production 

order, these issues are valuated with the default inter-company prices (valuation prices) 

logged in the inventory journal at the time of the inventory issue. This also ensures proper 

valuation for later evaluation. 

- Production orders Shows the costs from production orders (incl. outstanding orders) calculated at the time of 

the last manufacturing costs batch process. For FRA items, the cost units are 

automatically transferred from Planning from the sales order to the production order. 

= Profit  

 

Post-project costing allows you to carry out the above costing types for an existing project and 

print a report. 

You can compare costs and revenues for a period using the Costs/sales revenue comparison (see 

"Reports (Finance)" page 776) report. 
 

Manufacturing costs batch process 

Call 

Finance > Costing > Manufacturing costs batch process 

Description 

This batch process allows you to calculate the manufacturing costs for orders in a single batch 

process (see Manufacturing costing (see "Calculate manufacturing costs and total manufacturing 

costs" page 733)). 
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To save the planned and actual costs for all six costs types and the quantities and durations in the 

system select Save final costs. 

This data is required for 

 The cost history (in the item master) 

 Post-project costing 

 The costs/sales revenue comparison (Statistics) 

 The production inventory count 

Please note: Each time you run manufacturing costing, you should first roll up costs. 

This prevents problems costing non-FRA items and lets you create new orders with the latest cost 

records when using the cost history. 
 

Cost rollup batch process 

Call 

Finance > Costing > Cost rollup batch process 

Description 

This batch process allows you to perform cost rollup (page 729) for several items. 

The cost rollup batch process should always be carried out after BOR or cost record changes. 

Note: The cost rollup batch process is always run with the default setting Use lot sizes at lower 

levels. 

The cost rollup batch process comprises the following steps: 

1. All items to be costed are determined and saved temporarily. 

2. Those items whose BORs comprise only purchased items or in-house items that have already 

been costed are determined from the saved data. 

3. The determined items are costed. 

4. Infor COM costs from bottom to top. In other words, lower level assemblies are always costed 

first followed by the next higher assembly. 

This process continues until all temporarily saved items have the Costed flag. 
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5. All temporarily saved items are deleted. 

Note:The temporarily saved items are also deleted when the multi-level cost rollup batch 

process is canceled. Consequently, you cannot continue costing from the same place if the 

process is canceled. 

Note: At the end of the cost rollup batch process, a message indicating the number of problems 

that occurred is issued. For information, see Mailbox 61. 
 

Cost unit batch process 

Call 

Finance > Costing > Cost unit batch process 

Description 

You can use this object to carry out order-based and period-based post-project costing. 

Orders are considered both projects and cost units and are costed as such. 

 
 

Period-end costing 

Call 

Finance > Costing > Period-end costing 

Description 

The purpose of period-end costing is to reduce the runtime of manufacturing costing. 
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The opened dialog box loads production orders that have been entered in full in inventory 

(Received status). 

Once you click Start, all orders selected in the Flag column are costed and indicated in the system 

as costed. 

The opened dialog box also lists all production orders that have already been costed and have 

postings after the last costing process (for example unplanned issue). 

Configuration 

The following configuration options are available for this dialog box: 

 To carry out period-end costing, the COMMON.KALKULATION.STABILIZATION parameter 

must be set to yes. Note that this parameter is not set manually; the system sets it when the 

cost history is generated. 

 The COMMON.KALKULATION.AUTOCOSTWORKSORDERS setting allows you to define 

automatic period-end costing for all production orders in the permitted status. 

 The COMMON.KALKULATION.SELECTWORKSORDERSTOCOST  parameter allows you 

to define whether all production orders displayed in the dialog box are preselected. 
 

Batch process - S/C activity 

Call 

Finance > Costing > S/C activity batch process 

Description 

You can use this object to carry out a cost rollup batch process (page 745). 

The batch process for subcontracted activities is similar to the batch process for cost rollup. The 

major difference is that you must insert an external source line (record type SCO) in a costing 

structure and in a BOR for costs to be projected to this line and for the FdCst flag and delivery 

price to be used in costing. 
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Configuration 

The COMMON.KALKULATION.DEFAULTSUBCONTRACTKFIXFLAG parameter allows you to 

define a default value for the FdCst flag. 
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Call 

Finance > Value flow 

Description 

As well the flow of goods, material, and quantities, an ERP system also records the corresponding cash flows. 

In addition to quantities of goods, values are also created at each individual level of processing during the 

production process. All of these value movements and cash flows constitute the value flow (see also Value flow 
basics (page 751)). 

The basis for valuating goods is the model used for calculating manufacturing costs and total manufacturing costs. 

See the graphic under Calculate manufacturing costs and total manufacturing costs (page 733). 

The following table provides an overview of where value flow data is generated. 

Area Processes that use value flow data 

Purchasing/Sales Purchase of goods, invoice approval, goods receipt, sale of 

goods, goods issue 

Inventory Inventory management (quantities), inventory count, quantity 

adjustments, dummy inventory, unplanned issues, unplanned 

receipts, rejects 

Manufacturing Material issues, issue of unfinished products, manufacturing 

receipts, receipt of unfinished products, SFDC: calculation of 

actual times and actual quantities, rejects 

Costing/ 

Value flow 

Costing (cost rollup, manufacturing costing, period-end 

costing), inventory revaluation 

 

Key features of the Value flow functionality in Infor COM are as follows: 

 Separating the inventory journal from the inventory value journal (page 767) allows you to 

distinguish between inventory and inventory value considerations. 

 The inventory value journal and posting journal (page 771) allow you to view inventory 

movements from a business perspective. 

 Various value flow models (page 754) are mapped taking into account basic valuation 

principles. 

 

Value flow 
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The value flow model is implemented in various valuation areas. These include inventory 

valuation (page 753), inventory revaluation (page 760), and period-end closing (see 

"Close period" page 758). 

Configuration 

When you create master data, various important value flow data is preset via the VFDEFUSAGE 

allocation table. This data includes inventory accounts, subcontracted activities, overhead keys, 

costing schedules, goods receipt accounts (purchased items), and revenue accounts (sales 

items).  

Note: As allocation tables are used, the corresponding sections in the COMMONSTD 

configuration are no longer evaluated. 

You can assign default values for creating purchased and sales items, subcontracted activities, 

additional costs, set items, tools, and services; see Preset value flow data (page 752). 

Default values for one-off items are defined based on their usage as purchasing/sales or 

manufactured items like normal items. 

In practice 

The value flow function in Infor COM, which includes management of postings and valuation 

guidelines using selectable value flow models (page 754) and posting of additional relevant data, 

runs in the background – with the exception of the interface to partner systems. For an overview 

of the interfaces available, see Finance interface. 

The value flow for consignment warehouses is described in Consignment warehouses. 
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Value flow basics 

The information in the following provides an overview of the theory behind the value flow (page 

749). 

 

The table below describes the individual value flow steps in the company. 

Cost type accounting 

Cost type accounting records and categorizes all costs incurred during the statement period. It is based largely on 

the accounts kept by accounting, distinguishes between expenses and costs, eliminates neutral costs and includes 

imputed costs. 

Note the following cost types: 

 Material costs: Material costs are generally calculated according to the update method. In 

other words, the basic material is recorded as used when it is issued from the inventory. 

 Employee costs: Employee costs include wages, salaries, and social charges. There are two 

types of labor costs: Manufacturing wages (direct costs) and indirect labor costs (overhead 

costs). Overhead costs are added to manufacturing wages as manufacturing overhead 

surcharge percentages. 

 Miscellaneous overhead costs: Miscellaneous overhead costs include energy, travel, and 

maintenance costs as well as rent, taxes, and insurance. 
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 Imputed costs: Imputed costs are costs that are used for cost-accounting depreciation, 

interest, employer's wages, rent, and ventures. 

Cost center accounting 

Cost center accounting calculates primarily costs per cost center as well as costing factors and 

provides information for cost planning. 

Cost centers are stored in work center groups, work centers, and operations for example. 

Cost unit accounting 

Cost units can be products (items) or orders. Information on the cost unit is stored in different 

places in the master data, for example in item or BOR master data. 

All FRA items are populated by default with the cost unit of the initiating sales order. 
 

Preset value flow data 

The following instructions use a purchased item to show how you preset value flow data when 

creating master data. 

Note: You can apply this to other item types (such as sales items or set items), subcontracted 

activities, additional costs, tools, and services. The sales accounts are also preset for payment 

plans. 

1. In the Purchasing module, open the Master data folder, select the Purchased items object, and 

activate the New tab. 

2. Specify the required order ID and click Create. 

The following table lists the default values that are preset for the different master data. 
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Item type Default setting 

Purchased items Accounting tab: If used as purchased items, the purchasing accounts are preset. 

If used as sales items, the sales accounts are preset. 

Costs tab: inventory account, inventory group, overhead key, costing schedule 

Subcontracted activities Accounting tab: purchasing accounts 

Costs tab: inventory account, overhead key, costing schedule 

Additional costs Accounting tab: purchasing accounts, sales accounts 

Set items Accounting tab: sales accounts 

Costs tab: inventory account, inventory group, overhead key, costing schedule 

Tools Accounting tab: If used as a purchased items, the purchasing accounts are set. If 

used as a manufactured items, no accounting accounts are set. 

Costs tab: inventory account, inventory group, overhead key, costing schedule 

Services Accounting tab: sales accounts 

Costs tab: inventory account, inventory group, overhead key, costing schedule 

Payment plans Accounting tab: sales accounts 

 
 

Inventory valuation 

First of all, the term inventory valuation refers to the general fact that a value is assigned to 

warehouse inventory as it represents a current asset. Inventory valuation occurs in Infor COM 

automatically through costing, inventory posting, etc. It includes the following areas: 
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Warehouse inventory valuation WIP valuation Closing & Valuation 

Warehouse inventory of 

raw, auxiliary, and process 

materials 

 

Warehouse inventory of 

unfinished products 

(assemblies) 

 

Warehouse inventory of 

finished products 

Valuation using 

 Standard cost, 

StdCost 

 Average price 

 Periodic average price 

 Average price 

according to issue 

sequence (FIFO) 

WIP (Work in Progress): 

Valuation of in-process 

production orders. The 

following are valuated: 

 Material issued 

 Times (actual 

quantity for planned 

records) 

 

WIP evaluation uses the 

average price. Price 

differences are posted 

out. 

Period-end closing 

 

Inventory revaluation 

 

Update standard costs 

 

Historic costs 

 
 

Value flow models 

 

A value flow model contains various specifications that define inventory valuation, value-based 

inventory changes, and manufacturing costs, as well as the posting process within Infor COM 

(inventory value journal (see "Inventory value journal" page 767)) right through to the transfer of 

postings (posting journal (page 771)) to the corresponding financial accounting software. 

The process includes the complete posting of values starting with receipt of goods, continuing 

through to manufacturing (including finished and unfinished products), all the way to sale of the 

goods and eventual transfer to the accounting system. 
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Please note: Depending on your installation, the use of certain value flow models may be 

subject to restrictions, make little business sense, or may not be permitted according to tax law 

(depending on the country). If in doubt, please contact your consultant. 

In Infor COM, it is possible to configure several value flow models. These are stored in the 

COSTMODEL allocation table. You can select the value flow model you require using the 

COMMON.VALUEFLOW.COSTINGMODEL parameter. 

Please note:  The entries in the STOCKACCVAL allocation table are based on the 

COMMON.VALUEFLOW.COSTINGMODEL = 3 parameter setting. If you change the default 

setting of this parameter, you will need to adjust the entries in the allocation table accordingly. 

When doing this, please see the notes on the Warehouse inventory per account report in the 

Reports (Finance) topic. 

The following value flow methods are supported in Infor COM: 

 

 

Value flow model Principle 

COMMON.VALUEFLOW.C

OSTINGMODEL=0 

Note: Value flow model 0 is the value flow model used in Infor COM 

Release 6.1. It is solely intended for users who do not want to work with 

the new value flow model. 

Average price and price 

differences 

(COMMON.VALUEFLOW.C

OSTINGMODEL=3) 

Price variances in Purchasing and Manufacturing are not charged to the 

product; instead they are accounted for separately. Warehouse inventory 

for purchased items is valuated using the average price. The standard 

cost is used for warehouse inventory for in-house manufacturing items. 

For issues, the difference from the standard cost is shown. 

Note: To use this value flow model, you must use the following 

parameters:  

COMMON.KALKULATION.CALCHISTORYFUNCTIONACTIVE=Yes and 

COMMON.FIBU.TRANSFERTORELVALFLPOSTING=Yes. 

Note : In the standard version of Infor COM, the (recommended) default value flow model is value flow model 3. 

This topic covers the posting codes (see "Value flow posting IDs" page 768) for value flow. 

 
 



756 | Infor COM 7.5 User Guide 

 

Finance 

 

Value flow model 3 

This Help topic provides an overview of how postings are handled when value flow model 3 is 

configured. 

Postings 

 The purchase invoices adjust (in the case of price variances) the average price, if applicable, 

and are posted to an inventory account. 

 Material purchases are calculated from consumption transactions and are divided into 

standard costs (material costs) and price differences (average price – material costs). 

Material purchases are also calculated based on delayed receipts of invoices (with an invoice 

price that differs from the PO price). 

 You can use online resequencing function to retroactively include these price differences in 

the average price calculation. 

 The WIP inventory value (for orders in progress) is determined using actual quantities and 

standard costs. 

 The change to the inventory for all production orders in progress is determined by posting all 

material issues and posted manufacturing services to a WIP account. 

 The change to the WIP inventory is determined using actual times valuated using the standard 

cost rate. Variances in the actual production costs therefore have a direct influence on 

expenses. 

 When a production order is closed, the manufacturing cost differences are calculated: 

(Actual quantities - Planned quantities) * Standard cost 

 The inventory of finished and unfinished items is valuated using standard manufacturing costs. 

 The inventory of finished and unfinished items is valuated using standard costs. 

Tax-relevant valuation 

A tax-relevant valuation is based on the purchased item's average price. However, average prices 

should be checked for their tax-related validity as part of a separate evaluation. If you find invalid 

average prices, you may have to revaluate the item. 
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SFDC posting batch process 

Call 

Finance > Value flow > SFDC posting batch process 

Description 

This batch process allows you to transfer postings from shop floor data collection (TIME) to 

financial accounting. 

For each posting from the SFDC journal multiple records are written to the posting journal (page 

771) separated by cost type, which is in turn separated by direct costs, overhead costs, and setup 

costs. This enables transfer to financial accounting or cost accounting. 

You must convert the SFDC posting ID to the value flow posting ID in order to determine the 

account IDs for the SFDC postings. 

The data is re-costed during the transfer. The cost types are taken into account at the work 

centers and costing parameters in the configuration. 

For the batch process to run successfully, the required allocation tables must be populated 

correctly beforehand. The steps required to do this are described in the following overview. 

In practice 

Once you have configured the SFDC posting batch process, you can start it by either manually 

selecting Finance > Value flow > SFDC posting batch process, or by setting the 

ValFl.IF.AcctJrn.ODCBooking.JITBatch action in Batch control so that it is repeated at regular 

intervals. 
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Configuration 

Allocation table Required setting 

JOURNALCODE A new posting ID 67 (forming the first two digits of the posting ID) must be added to the 

JOURNALCODE table. 

FINACCTYPE New accounts for SFDC postings must be added to the FINACCTYPE table. Values 25 

through 48 should be used here (values 1-24 are reserved for the inventory journal). 

SACHKONTEN In the SACHKONTEN table, enter the account IDs that are to be used in the BUCHKTO 

table to indicate the accounts that the costs should be posted to. 

POSTCODEODC See also the Help topic on the allocation table. 

BUCHKTO See also the Help topic on the allocation table. 

MAILBOX Mailbox ID 220 is reserved for transactions related to the SFDC posting batch process. 

If applicable, enter this mailbox ID in the MAILBOX allocation table. 

 
 

Close period 

Call 

You can access period-end closing in Finance by opening the Value flow folder and selecting 

Close period. 

Note: To manage business periods, in System functions open the Administration folder and select 

Business periods. 

Description 

In simplified terms, a period-end closing is a summary of all posted business transactions for a 

specific period. You use period-end closing to add up all inventory postings (receipts and issues) 

that were carried out during the period you want to close. The posting date of the movement is 

used to assign the transaction to the correct period. 



Infor COM 7.5 User Guide | 759 

 

Finance 

 

Configuration 

See Configuration (Finance) 

In practice 

The closing balance for the quantity and value of the inventory is calculated for each item, and the 

inventory quantities per period are saved for each inventory location.These saved values are used 

for valuating the warehouse inventory and for printing reports. 

Process: 

1. The system checks the end date of the first open period. If this end date is not earlier than the 

current date, the period cannot be closed and an error message will be displayed. 

Otherwise, the earliest open period is displayed and you will need to confirm that you want to 

continue with the process. 

2. The system checks whether the period ID saved by the last period-end closing is immediately 

before the current period chronologically. This ensures that the immediately preceding period 

was closed correctly and that the closing balances of the previous period can be used as the 

opening balances for the current period. 

3. The system checks whether only one balance per item was calculated for an inventory 

location. If this is not the case, the period-end closing process is canceled. If this occurs, 

please speak with your consultant. 

4. When you start the process, the earliest open period only is closed. A period cannot be closed 

if an earlier unclosed period still exists. 

5. All data records are deleted from the log file generated by period-end closing. These may have 

originated from an earlier unsuccessful attempt to close the period, for example. 

6. The closing balances of the previous period are transferred as the opening balance of the 

current business period – based on the BalanceFwdAllowed parameter setting. If there are no 

balances, you must calculate them manually. Contact your consultant to calculate the 

balances. 

7. The quantities and values of all inventory movements for the period to be closed are added to 

the opening balance. The following key figures are calculated at the end of a period: 



760 | Infor COM 7.5 User Guide 

 

Finance 

 

Available inventory quantity, Reserved inventory quantity, Inspection quantity, Total 

closing inventory quantity and value, Received quantity and value, Issue quantity and 

value. 

The average price for the period end is calculated as follows: 

 

Total closing value - Total received value + Total issue value - Opening value 

8. If several inventory locations are used, the following applies: 

 The six total values are calculated 

 The quantities and values of the movements are also costed 

 Total inventory value and total inventory quantity are costed for all inventory locations 

 The average price is calculated across the total sum of all inventory locations (not per 

inventory location). 

The total value is divided up between the inventory locations in proportion to their 

inventory quantity. Any rounding differences are assigned to the value for the inventory 

location with the largest inventory quantity. 

The expenses are then calculated for each inventory location as follows: 

 

Total closing value - Total receipts + Total issues - Value moved - Opening value 

The closing balances can be printed out using the Warehouse inventory per account report. 

If problems occur during period-end closing, detailed messages describing the problems are 

written to mailbox 62. The process continues, but an error message is output at the end and the 

period-end closing is not completed. 

Note: The program does not take into account items that have the No inventory transaction 

summary update flag set in the Inventory group field (Costs tab in the item). 
 

Inventory revaluation 

For general information about inventory valuation in Infor COM, see Inventory valuation (page 

753). 

Please note: Only accounting or employees with the necessary qualifications should revaluate 

inventory because of the effects an inventory revaluation has on the inventory valuation. 

Call 

Finance > Value flow > Inventory revaluation 
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Description 

Inventory revaluation lets you revaluate inventory items easily. All items that meet defined criteria 

are added to a report. You can manually edit individual items in the report, print the report, or 

export the report to Excel for further processing. Once you have made the required selection, you 

can update the prices in the database. 

Inventory revaluation is used to reduce (or, in rare cases, increase) the valuation of your 

warehouse inventory. The average price is re-calculated and the transactions for revaluating the 

warehouse inventory are written to the inventory posting journal or the inventory value journal. 

The revaluation processes can also be logged in various reports. 

After you select the items, a report of items that meet your selection criteria is shown along with 

the new price calculated after the devaluation. 

You can manually edit each report (for example, by deleting individual items from the report or 

editing the price retroactively). 

You can then post the report. This updates the item master data, generates inventory movements 

for revaluation, and calculates a new average price. You can then print reports or export them to 

an Excel TM spreadsheet. 

Note: For processing time reasons, we recommend creating multiple differentiated reports 

instead of one comprehensive report. 

 
 

Revaluate inventory 

The following example shows how to revaluate inventory for a list of items. 

1. In Finance open the Value flow folder and click Inventory revaluation. Go to the New tab. 

2. Select an ID for the list to be created in the Rep. field and assign a date as the cut-off date. 

Confirm by clicking Create. 

3. From the menu, select Functions and Add items to report. 
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4. Select the items you want to revaluate from the list boxes, select a criterion in the middle form 

section, and in the bottom form section, define how you want the new value of the item to be 

calculated. Click OK. 

5. The report shown on the Price details tab can be edited as required. If the report needs to be 

reviewed thoroughly before posting, you can save it by selecting Save from the Data menu or 

print it by selecting Print from the Data menu. 

6. After you have checked the list, you can carry out the posting by selecting Post from the 

Functions menu. 
 

Update standard costs 

This batch process lets you edit the costs of items, work centers, and tools. 

Please note: Use this batch process after cost rollup to be able to use the updated records later. 

This batch process creates the current manufacturing costs as a historic cost record with its own 

ID and the current date. For more information, see the context-sensitive Help on the Standard cost 

and Historic costs tab. 

This batch process sets the new standard cost and enters a revaluation posting in both the 

inventory value journal and the posting journal. With value flow model (see "Value flow models" 

page 754) 2, this occurs for all items that use standard costs. With value flow method 3, it occurs 

for purchased items only. 

Standard costs are used for inventory valuation. Please note therefore that running this batch 

process will result in a revaluation of the warehouse inventory of the corresponding items. The 

valuation change is logged in the inventory value journal. 

Please note:  

 For purchased items without a BOR, the standard cost is transferred from the Total field to the 

Direct costs column. 

 For non-purchased items or purchased items with BORs, the total in the Manuf. costs column 

is transferred. 

The old records are saved in Historic costs. 
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Posting generator 

 

Call 

Finance > Value flow > Posting generator 

Description 

The posting generator provides a new method for generating posting records. 

The following principles apply here: 

 Business processes (such as goods receipt, invoice approval, and so on) generate only the 

journals required for this process. The posting records for accounting are generated by a 

separate process. 

 Posting record generation can be fully controlled externally. 

 Posting record generation can be repeated. 

Configuration 

The valuation and account management settings for the posting generator are stored in the 

ACCRULCM3 and ACCRULCM3FF allocation tables. 

 
 

Generate postings using the posting generator 

This Help topic describes how to generate postings using the posting generator. 

1. Select Finance > Value flow > Posting generator. 

Result: The Posting generator selection criteria dialog box opens. 

2. In the Date from and Date to fields enter the required date span and select the Display 

inventory journal records check box. 
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3. In the Posting IDs table select the required posting IDs if necessary and click Start. 

Result: The inventory value journal displays the entries without postings in the posting journal 

that match the date span and selected posting IDs. 

4. To start generating postings for the posting journal, click Start. 

Note: Before you start, you can also select individual lines to generate postings only for these 

lines. 

5. To confirm the dialog box that opens, click Yes. 

Result: A message is displayed once all postings have been generated. 

Note: You can view the posting result in the posting journal. 
 

Delete postings using the posting generator 

This Help topic describes how to delete postings using the posting generator. 

1. Select Finance > Value flow > Posting generator. 

Result: The Posting generator selection criteria dialog box opens. 

2. Click Delete. 

3. In the Date from and Date to fields enter the required date span. 

4. Enter the span for the journal posting IDs you want to delete and click Start. 

Result: The posting journal is displayed. 

5. Select any lines you want to delete and click Delete. 
 

Activate batch control for Posting generator 

This Help topic describes how to activate time control for the posting generator. See also Define 

and start batch job. 

1. Select System functions > Administration > Batch control. 

2. In the Job field on the Status tab, enter the job description; for example, Posting generator. 

3. On the Action tab, enter the Infor.Finance.ValueFlow.Postings::IProcess.PostServer action for 

this job. 
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4. In the Interval field on the Time control tab, specify the duration and enter the maximum delay 

and maximum duration. 

5. On the Status tab, set thestatus to Released. 

6. On the Status tab, select the released batch job in the table and click Start. 
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This folder is located in Finance. This module includes the following journals as well as various 

reports. 

These journals reflect the entire value posting process, from the receipt of goods, to manufacturing 

(including finished and unfinished products), through to the sale of goods. 

 

Journals and reports 
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Inventory value journal 

Call 

To open the inventory value journal, select Finance > Journals and reports > Inventory value 

journal. 

Description 

The inventory value journal contains exclusively value-related information (value flow) for 

quantity-based inventory movements reflected in the inventory journal. 

In contrast to the inventory journal, which displays quantities and inventory balances, the inventory 

value journal displays postings related to value flow. All data relevant to the valuation of 

warehouse inventory is shown here. The posting IDs for value flow are explained under Value flow 

posting IDs (page 768). 

Note: Each entry in the inventory value journal has entries in the posting journal 

The viewpoint provided by the inventory value journal is primarily business-oriented and allows 

you to map the value flow in your company. 

Advantages: 

 It allows you to map valid value flow models. 

 It displays additional delivery costs and price/cost information separately. 

 It makes it easier to differentiate between inventory movements since receipts and issues 

and their values are displayed in separate columns. 

 It lets you identify associated transactions (such as goods receipts and purchase order 

cancellations) by common flags. 

 It displays all postings for inventory receipts and issues as well as their cancellations and 

valuations at the time of the receipt or issue. 

Configuration 

The behavior of the value flow journal is determined by the setting defined for the 

COMMON.VALUEFLOW.COSTINGMODEL parameter. 
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Value flow posting IDs 

Value flow posting IDs 

The Infor COM value flow function does not use the posting IDs in the BCODES allocation table. Instead it uses the 

posting IDs stored in the POSTCODES1 to 4, POSTCODEODC, and INVPOSTCODE allocation tables. 

The posting IDs for the value flow function correspond to the posting IDs (those relevant for value flow) in the 

BCODES allocation table and encrypt various properties of the posting. 

Posting ID structure 

The detailed structure of these posting IDs is shown in the following table. 

 

 

Position Module/content Value Description Allocation table 

1 Module 1-6 Posting ID modules (Purchasing, 

Manufacturing, Sales, Inventory, Value 

flow, TIME) 

PCMODULE 

2/3  10-99 Posting ID posting types (10 - receipt, 20 - 

issue, 30 - reposting, 40 - inventory count, 

50 - invoice amount, 60 - credit memo, and 

so on) 

PCTXTYPE 

4  0-9 Warehouse types for posting IDs (0 - main 

warehouse, 1 - TPD, 2 - supplier 

consignment warehouse, and so on) 

PCSTOCKTYPE 

5  0-9 0 - original, 1 - cancellation, 2 - RMA  

The first digit of the posting ID shows the module in which the posting originated according to the PCMODULE 

allocation table, while the type of transaction carried out is described in the second and third columns. The 

fourth digit of the posting ID contains the warehouse inventory type. The fifth digit of the posting ID indicates the 

posting direction (original, cancellation, or RMA). 

Assignment 

In the BCODES allocation table, assign the value flow ID using the VF ID field on the Description tab. 

The following table provides an overview of the relationships between the posting IDs in the value flow function and 

the posting IDs in the BCODES allocation table. 

 

 



Infor COM 7.5 User Guide | 769 

 

Finance 

 

POSTCODES 

posting ID 

Posting ID from BCODES Transaction type 

11000 151, 152, 153, 154, 168, 169 Purchasing receipt 

11001 140, 141 Cancellation of goods receipt from 

Purchasing 

11002 164, 165, 166, 167 Purchasing RMA 

11900 205 Invoice approval 

11901 206 Cancellation of invoice approval 

22000 183, 184, 188 Manufacturing issue 

22001 189 Cancel manufacturing issue 

21000 181, 182 Receipt from Manufacturing 

21001 189 Cancellation of receipt from 

Manufacturing 

32000 171, 172, 178 Sales issue 

32002 176, 177 Sales RMA 

41000 191 Miscellaneous receipt 

42000 192 Miscellaneous issue 

44000 7 Inventory count 

44000 194 Inventory adjustment 

51000 101 Opening balance 

54200 201 Revaluation 

 

Examples 

The following table includes three examples of the posting IDs from allocation table POSTCODES1-4 that are used 

in the value flow function: 
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ID Description 

11000 Purchasing receipt 

21000 Manufacturing receipt 

32000 Sales issue 

Explanation : ID 11000 should be read in order as follows: 1=Purchasing, 10=Receipt, 0=Own inventory, 

0=Original 
 

Resequencing 

Please note: This function must be licensed separately. 

Description 

(Online) resequencing changes the order of postings in the inventory journal by sorting invoice 

approvals according to time immediately after receipt of goods and by recalculating the average 

prices of all subsequent postings. This means that issues are valuated with the actual average 

price. The corresponding adjustment postings are recorded in the posting journal. 

In some cases the inventory valuation in Purchasing cannot correctly take price changes into 

account. Resequencing solves this problem. 

Examples: 

 After receipt of goods from an order (valuation by average pricing) with an order price, an 

issue occurs (at the current average price). 

 Invoice approval at a later stage indicates that the price is lower. In addition, the inventory 

quantity no longer covers the invoice approval quantity. 

 Resequencing sorts invoice approvals immediately after the order and recalculates the 

subsequent postings. Price changes can therefore be assigned chronologically and 

subsequent issue postings carried out using an exact value. It also prevents partial values that 

are no longer covered by inventory quantities from having to be directly reported as expenses. 

Configuration 

Resequencing must be configured using the COMMON.VALUEFLOW.ONLINERESEQUENCING 

parameter. The COMMON.VALUEFLOW.COSTINGMODEL=3 parameter must be set also. 
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Posting journal 

Call 

Finance > Journals and reports > Posting journal 

Description 

This journal contains the business transaction postings for financial accounting. The posting 

journal shows all transactions that are posted to the accounting system or are intended for the 

accounting system. 

The posting journal represents the central interface to external systems for transaction postings. 

Postings are shown here on the account level and/or are sorted by cost type. 

The data is read-only and cannot be modified. 

Note: Each entry in the inventory value journal (page 767) has entries in the posting journal. 

In practice 

The following postings, among others, are displayed in the posting journal: 

 Purchase receipt postings 

 Purchase invoices 

 Material issues for manufacturing, sorted by cost type as well as by direct costs and overhead 

costs 

 Goods issues in sales 

 SFDC postings (times, costs), sorted by cost type as well as by direct costs and overhead 

costs 

 Inventory revaluation 

 Inventory count and quantity adjustments 
 

Adjust posting 

The following procedure describes how to change incorrect postings in the posting journal. Note 

that the original documents are also modified. 
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Note: You can only select this function if the transfer status value is 0. This function cannot be 

used to adjust other postings since they have already been transferred to Financials. If errors 

occurred for these postings, the only way to adjust them is to use the dedicated business 

processes to cancel and repost them. 

This function also requires the COMMON.VALUEFLOW.COSTINGMODEL>0 parameter to be set 

in the configuration. 

1. Select Finance > Journals and reports > Posting journal and open the posting records you 

want to adjust. 

2. Select the posting record you want to change. 

3. Select Functions > Adjust posting. 

You can change the following fields: Acct ID, Process date (both in the form header), Cost 

center, Cost unit, Business period (on the Details tab). 

4. Adjust these fields as required. 

Changes in documents: 

Account ID, cost center, cost unit: When you save the changes, the original documents are 

adjusted in the associated orders or purchase orders based on the posting ID. 

The dependent documents and journals are based on the respective posting IDs. They 

include purchase orders, RMAs, invoice journal, temporary invoices (Purchasing) for 

RMAs, production orders, sales orders, credit memos (Sales) and invoices (Sales), old 

inventory journal, and dependent data in the posting journal and inventory value journal. 

The associated posting records with the same journal ID for the cost center and cost unit 

are also corrected in the posting journal. 

The following table shows the documents and fields for which posting IDs can be modified 

based on changes in the posting journal. 
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Document, Doc. Posting ID Modified attribute 

Purchase orders  11000, 11001, 11002, 11060, 11061, 11900, 11901 Account 

Returns 11000, 11001, 11002, 11060, 11061, 11160, 11161, 

11900, 11901 

Cost center, Cost unit 

Invoice (Purchasing) 

Invoice journal 

(Purchasing) 

11000, 11001, 11002, 11900, 11901 Account 

Invoice journal 

(Purchasing) 

15000, 15001 EU account 

Invoice journal 

(Purchasing) 

15100, 15101 Base acct. 

Invoice and invoice 

journal (Purchasing) 

11000, 11001, 11002, 11900, 11901, 15100, 15101 Cost center, Cost unit 

Temporary invoice for 

RMA (Purchasing) 

11000, 11001, 11002, 11900, 11901 Inventory account, 

11000, 11001, 11002, 11060, 11061, 11160, 11161, 

11900, 11901 

Cost center, Cost unit 
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Document, Doc. Posting ID Modified attribute 

Production orders 12060, 102061, 21000, 21001, 22000, 22001, 28000, 

28100, 28200 

Account 

Production orders 12060, 102061, 21000, 21001, 22000, 22001, 28000, 

28100, 28200, 29000, 29001  

Cost center, Cost unit 

Sales orders 32000, 32002 Account 

Sales orders 32000, 32002 Cost center, Cost unit 

Credit memo (Sales) 36000, 36001 EU account 

Credit memo (Sales) 36100, 36101 Base acct. 

Invoice (Sales) 35000, 35300, 35600 EU account 

Invoice (Sales) 35100, 35400, 35700 Base acct. 

Invoice journal 

(Sales) 

35000, 35001, 35300, 35301, 35600, 35601, 36000, 

36001 

EU account 

Invoice journal 

(Sales) 

35100, 35101, 35400, 35401, 35700, 35701, 36100, 

36101 

Base acct. 

Credit memo (Sales) 

Invoice (Sales) 

Invoice journal 

(Sales) 

35000, 35001, 35100, 35101, 35300, 35301, 35400, 

35401, 35600, 35601, 35700, 35701, 36000, 36001, 

36100, 36101 

 

Cost center, Cost unit 

Inventory journal (old) All Account 

Posting journal 11000, 11001, 11002, 11060, 11061, 11160, 11161, 

11900, 11901, 12060, 12061, 15000, 15001, 15100, 

15101, 15200, 15201, 18000, 18100, 18200, 19160, 

19260, 19360, 19460, 19460, 21000, 21001, 22000, 

22001, 28000, 28100, 28200, 29000, 29001,41000, 

42000, 44000, 51000, 54200, 67000, 67110, 67120, 

67130, 67140, 67150, 67160, 67210, 67220, 67230, 

67240, 67250, 67260, 91000, 91100, 92000, 92100 

External general ledger 

account, Transfer status 

Inventory value 

journal 

11000, 11001, 11002, 11060, 11061, 11900, 11901, 

12060, 12061, 18000, 18100, 18200, 21000, 21001, 

22000, 22001, 28000, 28100, 28200, 29000, 29001, 

41000, 42000, 44000, 51000, 54200 

Inventory account, Cost 

unit, Cost center 

Process date, Business period: These are only adjusted in the posting. 
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Cancel closing of production order 

To make a posting to a closed production order, you must first cancel the order closing postings in 

the value flow function. To do this, complete the following steps: 

1. To open the posting journal, select Finance > Journals and reports > Posting journal. 

2. Select the order line whose closing you want to cancel. 

Note: A production order closing is posted using posing ID 29000. To find an order with 

this ID, right-click the Posting ID column header, in the shortcut menu select Find, and in 

the Search for field in the following dialog box enter 29000. 

3. Select Functions > Cancel closing of production order and confirm the dialog box that is 

displayed with Yes. 

The function generates the corresponding postings with posting ID 29001 for all postings 

with posting ID 29000 and sets the production order status to Reopened. 

You can now make missing postings and then close the order again. 
 

Set transfer status 

The Set transfer status function sets the transfer status for multiple postings to transferred. The 

Reset transfer status resets the status to not transferred. 

Set transfer status 

This function lets you flag postings that you do not want to transfer to Financial accounting, for 

example. 

1. Select Finance > Journals and reports > Posting journal and open the postings you want to 

flag. 

2. Select the lines whose transfer status you want to set. 

3. Select Functions > Set transfer status. 
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All selected lines with a transfer status of 0 or 255 are set to transfer status 254, and the 

transfer date is set to the current date. This also applies for dependent postings that are 

not selected. 

An entry is written to mailbox 16 for all records that are not modified or for errors. 

Reset transfer status 

This function lets you flag postings that you want to transfer to Financial accounting but that have 

a transfer status that prevents them from being transferred. 

1. Select Finance > Journals and reports > Posting journal and open the postings you want to 

flag. 

2. Select the lines whose transfer status you want to reset. 

3. Select Functions > Reset transfer status. 

The transfer status for all postings with status 254 or 255 is reset without a confirmation 

prompt. If a line has another status, you are prompted to confirm. 

The dependent lines of postings are also modified. 

An entry is written to mailbox 16 for all lines that could not be modified. 
 

Inventory posting journal 

For an overview of the journals in Value flow (page 749), see Journals and reports (page 766). 

Please note: This object allows you to access the old inventory journal with its Release 6.1.06 

functionality. It only makes sense to do this if the COMMON.VALUEFLOW.COSTINGMODEL=0 

parameter is set in the configuration. 

This inventory journal contains both value-based and quantity-based information. 
 

Reports (Finance) 

For an overview of the journals in Value flow (page 749), see Journals and reports (page 766). 
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You can access the reports overview in Finance by opening the Journals and reports folder and 

clicking Reports. 

Please note: Report names are always structured as follows: ir<module><report name>. For 

more information on the reports not found in this Help topic, see the Help topics for the reports for 

the modules concerned. 

The following table displays an overview of the reports available. 

Note: You can influence the displayed lists by assigning user privileges. 
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Name Contents 

ABC projection Items are evaluated according to their classification. Items classified with A are 

generally items that constitute only a small portion of the total number of sales items, 

but a large portion of annual consumption. 

Class B items constitute a greater portion of total sales items, but have a lower annual 

consumption. Class C items constitute the greatest portion of total sales items, but 

have the lowest annual consumption. See the ABC list Help topic. 

The report shows the items along with the group they belong to, the actual inventory 

value, and the percentage of the total consumption. 

Reconciliation report for 

posting sequence 

To use this report, you must have licensed resequencing (page 770) and the 

COMMON.VALUEFLOW.COSTINGMODEL=3 parameter must be set in the 

configuration. 

This report allow you to display value-based changes to warehouse inventories for 

business periods that have already been closed. 

You cannot make changes to closed business periods. If an invoice needs to be 

canceled or a value of an inventory receipt or issue needs to be adjusted after the 

invoice period is closed, this report lets you display the value-based change to the 

warehouse inventory for the closed business period. 

Expenses per clearing 

account 

This report summarizes inventory issues from the inventory value journal (if 

COMMON.VALUEFLOW.COSTINGMODEL>0 is set in the configuration). The entered 

posting IDs are specified by the posting ID category as indicated in the  BCODES 

allocation table. See also Expenses per clearing account. 

Inventory count 

valuation with item totals 

This report valuates the inventory count records entered by WMS. These records are 

either selected from the old inventory journal 

(COMMON.VALUEFLOW.COSTINGMODEL=0) or from the new inventory value 

journal (COMMON.VALUEFLOW.COSTINGMODEL>0).  

They are shown on the Inventory count valuation report by warehouse location, 

and as an item total on the Inventory count valuation with item totals report. 

This report only prints items that were counted during a specific period (such as 

transactions with posting ID  7=Inventory count variance in the inventory journal). 

The period is determined by the value set in the 

COMMON.LAGER.INVENTURRUECKSCHAU parameter. The value of the parameter 

defines the number of days (counting backward from today) that are to be included in 

the report. 

Revaluation history You must first carry out an inventory revaluation before printing this report. It shows 

the item details together with the old and new average price. 

See also Revaluation history. 

Costs/sales revenue  

comparison 

This report can only be printed if a cost unit batch process has been carried out. 

It shows costs and revenue for selected cost units/periods and displays period profits 

or total profits. 
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Name Contents 

Production order 

variance 

Please note: Before printing this report, you must carry out period-end costing. 

This report allows you to compare actual and planned costs (including overhead) and 

output the variances after an order has been costed. It shows the total costs for each 

cost type as well as the planned and actual quantities. A total cost variance percentage 

is calculated for each production order. 

Warehouse inventory 

per account 

Prints an inventory valuation for the inventory accounts set on the Costs tab in the 

item master. 

You can print a detailed or summarized version. See also Inventory valuation (page 

753). The dialog box also allows you to select the price to be used to valuate the 

inventory as well as specify whether you want to use the current value or the value from 

a specific period. 

Please note:  For in-house manufacturing, the standard cost from the KOSTEN 

allocation table should be used as the price source when 

COMMON.VALUEFLOW.COSTINGMODEL=3 (default setting), and the average price 

should be used as the price source when 

COMMON.VALUEFLOW.COSTINGMODEL=0. 

WIP valuation Allows you to valuate current in-progress production orders. It uses the structure 

information saved during the manufacturing costing batch process. You must select the 

Save costing structure option for batch processes. 

All open production orders (with a status of Scheduled, Released, Canceled, or 

Started, but without a header status of Received) are processed, except for FRA 

orders. 

For each order, a line is displayed for each BOR item. Overhead costs are not 

included. 
 

Period-end closing journal 

To open the period-end closing journal, select Finance > Journals and reports > Period-end 

closing journal. 

Note: The data displayed in the period-end closing journal are generated by the Close period 

function. 
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Over the course of a business period, receipts and issues that change the item value in the 

inventory must be recorded for each item. 

These changes are totaled when the period is closed, and the change in the value is calculated. 

The item-related overview of the period-end closing journal provides a quick overview of these 

item changes. 
 

Totals and balances list 

To view the totals and balance list in Finance, open the Journals and reports folder. 

The total and balance list indicates the total of the debit and credit postings and the balances 

according to the selected criteria. 

Example: To display the totaled debit and credit postings and the balance for the cost center in 

the business period, select the business period and cost center. 
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You can use the dialog boxes in the Transfers folder in Finance to transfer data from Infor COM to 

(external) systems or to Infor Finance. 

In general, the functions available in the Transfers folder in the Finance module allow you to 

transfer customer, supplier, and related master data and movement data to a financial accounting 

software program. 

The functions available are determined by the type of financial accounting software used. 

Further information about the transfer of data is available in the FinanceLink documentation. 
 

Transfer movement data (Finance) 

Call 

Finance > Transfers > Movement data. 

Description 

This object allows movement data that is relevant for financial accounting to be transferred to your 

financial accounting system in the form of an ASCII export file in Datev format. 
 

Transfer master data (Finance) 

Call 

Finance > Transfers > Master data. 

Transfers (Finance) 
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Description 

This object allows master data that is relevant for financial accounting to be transferred to your 

financial accounting system in the form of an ASCII export file in Datev format. 
 

Transfer working hours (Finance) 

Call 

Finance > Transfers > Working hours. 

Description 

This object allows you to transfer working hours to the payroll accounting component of your 

financial accounting system. 
 

Transfer material movements (Finance) 

Call 

Finance > Transfers > Material movements. 

Description 

This object allows you to transfer data from the inventory journal to your financial accounting 

system. 
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Call 

Finance > Administration 

Description 

This folder provides various administrative functions for the Finance module. 
 

Create cost history 

Call 

Finance > Administration > Create cost history 

Description 

To create a cost history for items, in Finance open the Administration folder and select Create cost 

history. 

Please note: Contact your consultant before running this function. 

The Create cost history process generates a historic cost record for every item. The historical 

record is linked to existing inventory journal postings for example. Historic cost records are also 

generated for work centers. 

The process assigns a unique ID to every existing historic cost record. For more information, see 

the description provided for the ID field on the Historic costs tab. 

Use this function before setting the 

COMMON.KALKULATION.CALCHISTORYFUNCTIONACTIVE=yes parameter in the 

configuration. 

Administration (Finance) 
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Note: Before creating the cost history, you must start the Manufacturing costs batch process. It 

saves the final costs in the corresponding database table, from where they are read by the Cost 

history function. 

Possible error messages 

The following error messages may be generated in mailbox 64 when this function is being carried 

out. 

Message Meaning 

The Create cost history service 

program has been run already. Are you 

sure you want to run it again? 

If you continue with the procedure despite the preceding message, this 

message is displayed, provided the program has already been started. 

You can decide whether or not the process is to be continued. 

This function has already been run. If the COMMON.KALKULATION.CALCHISTORYFUNCTIONACTIVE 

parameter is set in the configuration, this message indicates that the 

program has already been run. 

 

The cost history for items manufactured in-house shows how the costs for an item have developed 

over time. The data is based on the manufacturing costing of completed production orders. 

This allows you to see how planned and actual costs have evolved over time. Detailed information 

about lot sizes and production data are also available. 
 

Update material costs 

Call 

Finance > Administration > Update material costs 

Description 

This process lets you update material costs in business processes by replaying them with values 

you define. You can replace material costs with the following values: 

 Average prices 

 Standard costs 

 Last purchase price 
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 Valuation prices 

Configuration 

To use this process, the CostingModel>0 parameter must be set. 
 

Analysis codes 

Call 

Finance > Administration > Analysis codes 

Description 

Note: Since this function depends on your company's operating requirements and the software 

used, please contact your Infor consultant about populating the various fields. 

This desktop object lets you populate mappings (assignments) for data transfer using the Finance 

Interface. 

Analysis codes let you include additional information with master data and movement data. The 

information categories and the values possible within a category are defined by the user. 

The function lets you create mappings for the Main ledger, Account, Customer, and Supplier 

allocation types. 

The analysis fields populated in this function can be used by your financial accounting software for 

specific analyses or can be output to special reports. 

There are 10 analysis fields for each allocation type. For each field you can enter an ID that is 

taken from the ANALYSISMAP allocation table. 

The code available for a field varies depending on the allocation type. 



786 | Infor COM 7.5 User Guide 

 

Finance 

 

In practice 

Data mapped for analysis can be read for accounts, customers, and suppliers when accounts are 

transferred to the financial accounting software. The analysis data is read for the general ledger 

when the posting journal lines are generated, and it determine how the analysis codes are 

populated in the posting journal. You can then transfer this information to the financial accounting 

software where it can be used for reports. 

Note: Only the Main ledger tab is important in the standard system. The Account, Customer, and 

Supplier tabs are intended specifically for transfer to the SunSystems financial management 

solution. Contact your consultant to configure these tabs. 

You can view the analysis IDs transferred in the corresponding postings in the posting journal on 

the Analysis IDs 1-5/Analysis IDs 6-10. 

Example: You can choose from Group flag 1 to Group flag 5, Tax, Country ID, and Currency for 

the Account allocation type. 
 

Plausibilities 

Call 

Finance > Administration > Plausibilities 

Description 

This desktop object lets you carry out different plausibility checks for item master data in Value 

flow. 

The following checks are carried out: 

 Is the standard price not equal to zero? 

 Is a clearing account specified for the item? 

 Is the inventory account that was specified for the item included in the BUCHKTO allocation 

table?  

 Are employee, summary, and revenue accounts specified for companies? 



Infor COM 7.5 User Guide | 787 

 

Finance 

 

In practice 

Any errors are logged in mailbox 16, and you can go directly to the mailbox display. 
 

Update totals fields 

Call 

Finance > Administration > Update totals fields 

Description 

A considerable amount of data is required for checking the credit limit on the Company account 

tab in the company master data. The credit limit is the total of the values from the following fields: 

Outstanding order value; Invoiced, not posted; and Outstanding items. 

To prevent runtime problems the data relevant to the credit limit (credit limit, outstanding items 

total, outstanding invoice value, and outstanding order value) is not in determined in realtime. 

Instead it is kept in the database. To retrieve current data for a business partner, in the company 

master data select Functions > Update totals fields in company master. This retrieves and saves 

the required values from Financial accounting. 

The Update totals fields batch process, which you can use to recalculate the data relevant to the 

credit limit for all customers and suppliers as a time-controlled process, delivers the same result. 

In practice 

For time control, enter the CreditCheck job with the 

Infor.Finance.CreditChecking.UserInterface::ICreditCheck.BatchStart action. 
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Statistics basics 

The following overview lists the most important functions that are provided by Statistics. For an 

introductory example regarding the use and operation of Statistics, see Statistics, example of 

function (see "How does the Statistics function work?" page 789). 

Configuration 

Statistics are configured in the COMMON.STATISTIK section. 

Creating totals records 

At various points in Infor COM, you can get statistics in the form of online statistics or reports. To 

do this, you must first extract and summarize (see "Extraction & summarization" page 796) the 

data from the log tables (see "Log tables and events" page 798). 

During summarization, summarization rules (page 808) are used to total the data records into 

totals records (see "Totals record maintenance" page 807). 

 

Performing a period change 

You can also carry out two types of period change manually: change of month and change of year. 

See also Change of year and change of month (page 800). 

 

Adjust order receipts 

Use Adjust order receipts (page 813) to check order receipts. 

 

Adjust totals records 

If you find duplicate totals records in the Totals record maintenance table (relEs), combine these 

totals records into one totals record using the Adjust totals records (page 812) function. 

Statistics 
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Prepare repeat E&S 

The Prepare repeat extraction and summarization (see "Prepare Repeat extraction & 

summarization" page 800) function allows you to make data adjustments or reset the extraction 

and summarization process. 
 

How does the Statistics function work? 

The following example illustrates what you can do with statistics. 

Print order confirmation 

Create a sales order for customer B (your company: A). 

Once the order confirmation is printed (event), sales order SO0001 for customer B (300-mm x 

30-mm drilled bar) is assigned a statistics flag. The flag is entered in the sales order directly. If you 

print the invoice for this order (event), the invoice lines are transferred to the Invoice journal log 

table (see "Log tables and events" page 798). 

Performing extraction and summarization 

The Extraction & summarization object is activated in the  Statistics folder of the Finance module.   

When you extract the order entry, master data and movement data are added to the data in the 

sales order line and then entered in the Maintain Ea statistics table as detailed statistics records 

(page 803). The sales order header records (HR record type; header record) are assigned record 

type ABK (Sales order confirmation), and the lines are assigned record type ABA (Item order 

confirmation). 

The sales revenue is extracted the same way, but the invoice lines from the invoice journal are 

used here, and the header records are assigned record type UK (Customer sales revenue) and 

the lines are assigned record type UA (Sales item sales revenue). 

The Summarization function uses summarization rules (page 808) to group the detailed data 

records in a totals record. 
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The Item order receipt by customer summarization rule groups the summarized records using the 

Item ID and Company ID data fields. Sales order SO0001 is then grouped with other orders from 

the same company (company B) and the same item (300mm x 30mm drilled bar) in one totals 

record. 

If Company B then issues order SO0052 (450mm x 30mm drilled bar), it will not be included in this 

totals record. The company is the same, but the order is for a different product. 

You can view the totals record in Totals record maintenance. 

Performing a period change 

Let's assume that an overrun of 31 days for the change of year is entered for the Item order receipt 

by customer summarization rule, and your financial year begins in January. The year is not 

changed automatically on January 1. It is not changed automatically until February 1 to allow you 

time to carry out internal evaluations for the previous year. If the overrun has not yet been 

exceeded, you can change the year manually. For more information, see Change of year and 

change of month (page 800). 

Adjust order receipts 

To check detailed statistics records that have already been generated for certain orders, select  

Adjust order receipts (page 813). 
 

Print and transfer statistics 

You can print statistics in the relevant area, for example Sales or Purchasing using the Statistics 

object, or transfer them to Excel (see "Transfer statistics to Excel" page 792) for further 

processing. 

For statistics with more than one record type, such as Sales revenue/sales/order receipt by item, 

you can upload record types independently of each other. 

In other words, beginning with the second record type (in the example: Sales rev., Order receipt by 

item), records are uploaded regardless of whether or not there are records in the list for the first 

record type (in the example: sales revenue). 
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To ensure this, set the COMMON.STATISTIK.PRINTINDEPFIRSTRECTYPE=yes parameter in 

the configuration. 

This slows down printing. 

This parameter is not activated in the default setting. Data records after the first record type are 

only printed in the combination record type + data field 01 ... data field 10, in which they exist for 

the first record type. 

Note: Statistical data is generated using the Extraction & summarization object. You should run 

this function regularly to make sure your statistics contain current data. 
 

Print statistics, example 

Our example includes the following record types: 

 Item sales revenue (UA) 
 Item sales (AA) 

 Order receipt by item (AEA) 

 

The following data is available for these record types: 

 
Data field 01 (Item ID) Value 

UA 978-3892 10 

 GED 15 20 

   

AA 978-3892 5 

 GED 16 6 

   

AEA 978-3892 7 

 GED 15 8 

 GED 16 9 

 

You receive the following print results: 

 Default configuration setting: PrintIndepFirstRecType=no 
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Item ID UA AA AEA 

978-3892 10 5 7 

GED 15 20 __ 8 

 Setting: PrintIndepFirstRecType=yes 

Item ID UA AA AEA 

978-3892 10 5 7 

GED 15 20 __ 8 

GED 16 __ 6 9 

No statistics are printed for item ID GED 16 in the default setting since there is no value for the 

Item sales revenue record type. 
 

Transfer statistics to Excel 

Microsoft Excel must be installed before you can transfer data to Excel. 

In addition to printing statistics, you can transfer them to Microsoft Excel where you can process 

the data for additional analyses or create charts. 

The transfer for each statistic is managed in the COMMONXL section of the configuration (see 

Configuration (Microsoft ExceI)). 

The following instructions explain the process using an example. 

1. Select Sales > Order processing > Statistics. 

2. Select the row with the required statistic and click OK. 

3. In the Output section select the Excel option and click OK. 
 

Create statistical reports 

Create statistical reports exclusively for summarization rules you created. They are created in Infor 

COM Dialog Manager. 

Note: Authorized users can make these changes only after participating in Statistics training. 

See also Change summarization rules (page 811). 
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For more information about customizations in the Infor COM Dialog Manager, see Idm_us.chm in 

the Help\us folder of your Infor COM system. 
 

Online statistics 

Online statistics are available to you at various points in Infor COM, for example, in Sales in the 

Order processing folder or in Purchasing. 

Because it is assumed that you run the Extraction & summarization process every night, in most 

cases (for sales, issues), it's only values from the totals records that are displayed. The advantage 

here is that data can be accessed very quickly because only one record needs to be read at a time 

before being displayed. 

Ideally, you should run Extraction and summarization (see "Extraction & summarization" page 

796) as a time-controlled process. See Action control. 

Data regarding the sales revenue, on the other hand, is actually displayed online. After you write 

an invoice, the associated data is immediately sent and displayed. 

The following objects let you go to online statistics: 

 Item master 

 Item account 

 Purchase orders 

 Customer master 

 Sales orders 

 Supplier master 

 

Please observe the notes on overruns for changes of periods regarding online sales revenue 

statistics: 

 Change of year and change of month (page 800) 

 Change of period and online statistics (page 802) 
 

Display online statistics 

Proceed as follows to display online statistics (page 793). 
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1. Click one of the objects (for example Item, Sales orders), which you can use to call online 

statistics. 

2. On the Open tab, select data records using the fields of the dialog box. 

3. Click Load. A form containing the data records opens. 

4. If you are in the overview view, go to single record view or press the F6 function key. 

5. In the Go to menu, select the required online statistics. 
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Allocation tables (Statistics) 

The following allocation tables are used in Statistics. 
 

M6DFTYP 

Description: Data field types in relEv 

Usage: Evaluated when summarization rules are maintained in Statistics. It defines the origin of 

the fields used for summarization. 
 

M6QUREL 

Description: Source relations in relEv 

Usage: Evaluated when summarization rules are maintained in Statistics. It defines the origin of 

the data you want to summarize. 
 

M6VERDTP 

Description: Summarization types in relEv 

Usage: This allocation table is evaluated when summarization rules are maintained in Statistics. 

It defines the type of summarization. 
 

SARTSTAT 

Description: Record types for Statistics 

Usage: This allocation table is used in Statistics in list boxes on the Open tabs (Maintain relEa, 

relEb, relEc, relEd) and when summarization rules are maintained. 
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STATISTIK 

Description: Statistics flags in relDl 

Usage: The statistics flags created in this allocation table are set for each accessed record 

following successful extraction in the log relations (for example, relFr invoice journal). Flags 

indicate the success of the extraction in these relations. 

For more information, see Statistics flag in journals (page 797). 
 

VBEREICH 

Description: Sales areas 

Usage: This table is used for assigning representatives to sales areas and reflects a two-level 

hierarchy of representatives for sales areas 1 and 2. The table is blank in the shipped version and 

can be used by the user to group representatives. 
 

Extraction & summarization 

Call 

Finance > Statistics > Extraction & summarization 

Description 

This function provides the data for statistics. 

During extraction, the statistics records are read from the log table (see "Log tables and events" 

page 798) records and updated with master data and movement data. This results in the creation 

of detailed statistics records (page 803). These detailed records are then summarized into totals 

records (see "Totals record maintenance" page 807). 

Requirements for extraction and summarization: 

 All master data (item master, company master, and so on) must be created. 
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 Current movement data that has not yet been processed by the statistics should be available 

in the log tables (invoice journal, inventory journal, SFDC journal, and so on). 

 

We recommend that you schedule extraction and summarization as a time-controlled process. To 

do this, select System functions > Administration  >Batch control. 

See also Change of year and change of month (page 800). 
 

Statistics flag in journals 

Statistics flags indicate data records included in the summarization. 

 

The following table explains the individual flags. 

Inventory journal/ 

invoice journal 

flag 

SFDC journal 

flag 

Meaning 

0 [Blank] These records have not been extracted yet. 

10 OP Records not extracted due to a posting ID that is not to be processed 

or an invalid record type. 

255 AC Records are already extracted. 

- S Records that were posted and adjusted before an extraction was 

started. 

 

If you open the Functions menu and select Adjustment to adjust 

postings in the SFDC journal, a new record with the new values is 

created. 

The previous record is flagged as canceled and is not taken into 

account in statistics. 
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Log tables and events 

Predefined events lead to statistics records being written to the log database tables (for example, 

the printing of an invoice, a goods issue, an inventory receipt from Manufacturing). 

This data forms the basis for the creation of totals records. 

The following table shows an overview of the log tables for the different modules. 
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Module ID Event Log table 

Sales    

Order receipt  Order confirmation is printed Order/Statistics ID flagged (relFb) 

Order receipt  Order confirmation is canceled Order/Statistics ID flagged (relFb) 

Order receipt  Confirmed order changed Order/Statistics ID flagged (relFb) 

Order receipt 3 Order closed/deleted prematurely Statistics log (relEp) 

Order receipt  Credit memo is printed 

(if parameter 

ExtraktionGUalsAE=yes in the 

configuration) 

Invoice journal (relFr) 

Sales  Invoice is printed Invoice journal (relFr) 

Sales  Invoice is canceled Invoice journal (relFr) 

Sales  Credit memo is printed Invoice journal (relFr) 

Purch.    

  Invoice approval 

Invoice approval is basis/preparation 

for purchasing statistics. 

This corresponds to a status change 

for a purchase order. The following 

event is triggered:  Invoice 

approved 

Invoice journal (relFr) 

Inventory    

  Goods receipt Inventory journal (relDl) 

Consumption  Goods issue Inventory journal (relDl) 

  Inventory receipt from 

Manufacturing 

Inventory journal (relDl) 

Consumption  Inventory issue for Manufacturing Inventory journal (relDl) 

Manufacturing    

  Complete transaction from 

employee 

SFDC journal (relIj) 

  Complete transaction from machine SFDC journal (relIj) 

 20 Inventory receipt for Manufacturing Statistics log (relEp) 
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Prepare Repeat extraction & summarization 

Call 

Finance > Statistics > Prepare repeat E&S 

Description 

This function does not normally need to be used. It is used purely for correcting errors. 

The Prepare repeat E&S function is used in the following situations: 

 Adjusting data after evaluating statistics 

You often do not realize until after you create concrete evaluations that the data required for 

statistics is not correctly maintained. For example, an incorrect group flag or no group flag at 

all may be entered in a few master records. If this happens, it is a good idea to adjust the data 

and then generate the statistics again. 

 Resetting extraction and summarization 

In Statistics, there are two types of data generated. Firstly, detailed data records are 

generated by the extraction process, and then totals records are created by summarizing 

these detailed records. 

Both types of data can be reset, if required. 

Please note: 

 If you repeat the extraction, you must repeat the summarization in order to display the correct 

totals records. 

 Since this involves the manipulation of data, back up the database first. 
 

Change of year and change of month 

There are two types of changes of period: 

 Change of month (deletion of daily fields) 

 Change of year (change of month and move monthly, quarterly, half-yearly and annual 

values). 

Using a field in Summarization rules (page 808), you can define for each target record type 

whether you want to perform the change automatically or manually. 
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 Automatically 

 An automatic change of month and change of year is performed when the overrun specified 

in the summarization rule has been exceeded. If a value of 0 is set, then 0 days are allowed to 

pass before an automatic change is performed; i.e. there is no overrun. 

 Manually 

 To perform a manual change, use the Change of month or Change of year functions. To do 

this, an overrun of more than 0 days must have been specified.  

These records are not included in the summarization if the system has recognized that a 

change is due. In other words, any records that fall within the new month or the new year are 

not summarized. 

The records are not processed until the change has been initiated manually or the overrun has 

been exceeded. If during summarization the system identifies that a change is due, a message is 

written to mailbox 66. 

 

Please note the following points: 

 Setting an overrun for a change of period 

 You can only carry out a manual change of month or change of year if you have defined an 

overrun for the change of month/year in the summarization rules and in the configuration. In 

the configuration, you need to change the COMMON.STATISTIK.MONATSWECHSEL and 

COMMON.STATISTIK.JAHRESWECHSEL parameters. 

When performing a manual change of period, it is only important that the value you enter in the 

configuration is not a value not equal to 0. 

For summarization rules (page 808), enter the exact overrun. For all summarization rules, we 

recommend that you specify the same overrun for changes of month (for example, 10 days) 

and for changes of year (for example, 31 days), so that the data in each module is always 

consistent. 

 Manual change of month and online statistics 

If you have allowed an overrun for a change of month and/or a change of year, you should 

perform any required period changes before online statistics data is evaluated. This is the only 

way to ensure that an evaluation will provide you with the current values. 

Unlike all other statistics, online statistics are created automatically. For more information, see 

Change of period and online statistics (page 802). 
 

Set financial year 

As a rule, the financial year coincides with the calendar year. If you want to deviate from this rule, 

you can do so by making changes to the configuration. 

To define the financial year in the configuration, set the 

COMMON.STATISTIK.GESCHAEFTSJAHR parameter to the first month of your financial year. By 

default, it is set to 1 (January). Summarization takes this parameter setting into account. 
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If you change the setting for the financial year while the program is running, you must run the 

Prepare repeat E&S function afterwards. Otherwise, serious errors will occur with your data. 
 

Change of period and online statistics 

The field for the current month in the online sales  revenue statistics  shows the total of the sales 

revenue that has not yet been summarized. This is due to the fact that  no reference can be 

established to the event date. If you have specified an overrun, it is possible that at the start of a 

new month some sales revenue from the previous month may be displayed in the field of the 

subsequent month. 

If this is the case, perform the change of period that is due. 

Example of online sales statistics: 

The last summarization you carried out was on January 20. Up to that date, your monthly sales 

revenue was $5,000.00. Between January 20 and 29, your sales revenue increased by 

$15,000.00 to $20,000.00. On January 29, this value is displayed correctly in the online sales 

revenue statistics. 

Because you have not performed another summarization since January 20, and the field for the 

current month displays the total sales revenue that has not yet been summarized, the February 

field (the field for the current month) on February 1 displays a sales revenue of $15,000.00 (the 

total that has not yet been summarized). The field for the month of January shows the sales 

revenue since the last summarization ($5,000.00). 

If the last summarization had been performed in December, the full monthly sales revenue for 

January ($20,000.00) would have been displayed in the February field on February 1. 

For more information, see Online statistics (page 793). 
 

Maintain Ea/Maintain Eb/Maintain Ec/Maintain Ed 

Call 

See Finance > Statistics > Maintain Ea/Maintain Eb/Maintain Ec/Maintain Ed. 
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Description 

You can maintain statistics tables using the Maintain Ea, Maintain Eb, Maintain Ec, and Maintain 

Ed objects. 

Depending on the event, the data is written to different detailed statistics tables. 

You can create summarization rules using the data fields in the detailed statistics tables. 

Summarization can generally only be carried out for one or more data fields in the statistics 

database tables. 

 Maintain Ea 

 The table contains value-based entries in the base currency. They are derived from events in 

Purchasing and Sales or from order events. They are logged in the invoice journal. 

 Maintain Eb 

 The table contains entries of quantities. They are derived from events that are logged in the 

Inventory journal. 

 Maintain Ec 

The table contains time-related data. The log data for the events is saved to the SFDC journal. 

 Maintain Ed 

 The Maintain Ed table (relEd) contains segment-specific statistics records. These are not 

created for every event. For each of the statistics records in the Maintain Ed statistics table, 

there is exactly one associated statistics record in one of the three statistics tables: Maintain 

Ea, Maintain Eb, and Maintain Ec. In other words, there is a 1:1 relationship between Maintain 

Ed and the other database tables. 

Conversely, the other three database tables also contain statistics records that have no 

corresponding statistics record in Maintain Ed. 

The association between any two records from Maintain Ed and another of the statistics tables 

is established by assigning an Ed ID. 

Additionally, the original  record type from Maintain Ea, Maintain Eb, and Maintain Ec is 

saved in Maintain Ed, thus ensuring quick access. The record type also indicates the original 

database table. 

Note:  For performance and data volume reasons, the writing of data to relEdis deactivated 

in the standard version of the software and if required, must be activated using the Infor COM 

Management Console configuration. 
 

Detailed statistics records 

Detailed statistics records are the result of an extraction (see "Extraction & summarization" page 

796). Each detailed record has exactly one associated record in the Infor COM database. These 

records are stored in separate statistics database tables that can be accessed using the Maintain 

Ea, Maintain Eb, and Maintain Ec desktop objects 
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The type of an event record determines where a record is written to during extraction. The 

statistics tables are assigned to the log tables as follows: 

Log database table Statistics database table 

Order receipt relEa 

Statistics log (relEp) relEa/relEb 

Invoice journal (relFr) relEa 

Inventory journal (relDl) relEb 

SFDC journal (relIj) relEc 

The records needed for specific statistics are classified using a record type. For example, the Print 

invoice event (see "Log tables and events" page 798) results in the creation of a record with record 

type UA (Item sales revenue). 
 

Record types and detailed statistics tables 

The short description of a detailed statistics record provides information about the origin and the 

type of the detailed statistics record. For example, UA lines are created from the invoice journal. 
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Record type Short description Statistics table 

ABA Item order confirmation Maintain Ea 

ABK Sales order confirmation Maintain Ea 

EUA Purchasing item sales revenue Maintain Ea/Maintain Ed 

EUL Supplier sales revenue Maintain Ea/Maintain Ed 

FZ Production order receipt Maintain Eb/Maintain Ed 

KFA Production order costs Maintain Eb 

DA Inventory issue Maintain Eb/Maintain Ed 

LU Customized inventory 

transaction 

Maintain Eb 

Term Inventory receipt Maintain Eb/Maintain Ed 

UA Sales item sales revenue Maintain Ea/Maintain Ed 

UK Customer sales revenue Maintain Ea/Maintain Ed 

UR Returned sales revenue Maintain Ea 

ZM Machining time Maintain Ec/Maintain Ed 

PP Time & attendance Maintain Ec 
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Insert detailed records 

Before completing the steps below, note the following: 

You must not violate the UniqueKey of the table when entering data. In the Maintain Ea, Maintain 

Eb, and Maintain Ec tables, this is the record ID (RecCount). If you violate this key, a 

corresponding error message is displayed (unique constraint ... violated). 

First, identify the highest record ID that has already been assigned by opening System functions 

and selecting Administration and Data maintenance. 

Example of how to identify the highest record ID: 

For the relEa statistics table (Maintain Ea) the statement is 

?select reccount = max(reccount) from relea. 

To enter new records, proceed as follows: 

1. In Finance, open the Statistics folder. 

2. Click Maintain Ea, Maintain Eb, or Maintain Ec. 

The start form opens. 

3. On the Open tab, select a detailed data record using the fields of the dialog box. 

4. Click Load. 

5. If required, go to the Detailed statistics record overview view. 

6. In the Edit menu, select Insert new row. 

7. Go to the Detailed statistics record view. 

8. Enter the relevant data. 

Note: Wen you enter a value in the Record ID field, make sure that it is one number greater 

than the previous maximum value. 

If you enter more than one record, you must assign record IDs in ascending order, beginning 

with the Highest record ID + 1. 

9. Save the data. 

 

Important notes: 
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 The highest record ID may not always be visible. For example, a data record could have been 

deleted. 

 When you insert new detailed data records, you must assign the record IDs manually.  

The record IDs of existing records must not be changed. 

If you change a record ID, this can result in a detailed record being summarized twice in the 

totals record, or not at all. When a change is made to existing record IDs, you can no longer 

rely on the totals records that have already been created. Record IDs are assigned 

automatically during extraction and are used to identify source records that have already been 

summarized. 
 

Totals record maintenance 

Call 

Finance > Statistics > Totals record maintenance 

Description 

You can view the totals record in Totals record maintenance. 

Totals records are created during summarization. They have a specific record type, which 

indicates the summarization rule that was used to create them. The record type of the totals record 

is therefore identical to the target record type of the summarization rule. 

Summarized totals records form the basis for different evaluations, which you can use in 

Purchasing or Sales, for example. 

Historical data 

When installing Infor COM for the first time, you can create historical data in Totals record 

maintenance. 

However, we do not recommend this procedure. It is better to create this type of data as detailed 

statistics records using Maintain Ea, Maintain Eb, and Maintain Ec functions for the following 

reasons: 

 During summarization, detailed records are automatically included in the totals records, 

automatically ensuring the different record types are consistent. 
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 If you have to recreate the totals records, historical data still exists if it is entered in the 

statistics tables. If you enter the data in the totals records, it is no longer available when you 

recreate the totals records. 

Std. values 

Many statistics compare the standard values and actual values. Enter these values manually. 

 If you want to create new data records, read Insert detailed records (page 806). 

 Totals record maintenance allows you to view totals records that were created using the 

summarization rule. 

If possible, do not change the data. The values in the totals records are populated 

automatically during summarization. 

If you change data or enter new data, you must perform a summarization run to get the current 

totals records. 
 

Summarization rules 

Call 

Finance > Statistics > Summarization rules 

Description 

Summarization rules are defined on a cross-site basis but can be modified for each individual site. 

Summarization rules control how a totals record is created from detailed statistics records. The 

system processes all activated summarization rules sequentially during summarization. 

The purpose of summarization is to merge extracted records into totals records based on certain 

criteria and separate the values into periods (monthly values, quarterly values, etc.). 

You can also use summarization rules to create classes. 

Note: To export summarization rules to a file, select Functions and Unload to file. Alternatively, in 

System functions, you can select Import/Export. You can import summarization rules only with the 

Import/Export feature. 

The following table contains the target record types and summarization rules that are implemented 

in Infor COM as standard. 
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Target RT Summarization rule 

AA Item sales 

ABAGR1 Sales by item group 1 

ABAK Item sales by customer 

ABAV Item sales by sales area 

ABKA Customer sales by item 

ABKAGR1 Customer sales by item group 1 

ABKGR1 Customer sales by industry 

ABKR Customer sales by region 

ABKV Customer sales by sales area 

AEA Order receipt by item 

AEAGR1 Order receipt by item group 1 

AEAK Item order receipt by customer 

AEAST Item order receipt by master data key 

AEAVB Item order receipt by sales area 

AEGESAMT Total order receipt 

AEK Order receipt by customer 

AEKA Customer order receipt by item 

AEKAGR1 Order receipt by customer and item group 1 

AEKGR1 Customer order receipt by industry 

AEKR Customer order receipt by region 

AEKVB Customer order receipt by sales area 

AEV Order receipt by representative 

D2 PO quantity by item 

BAGR1 PO quantity by item group 1 

BAGR2 PO quantity by item group 2 

BAL PO quantity by item and supplier 

BLA PO quantity by supplier and item 

BLB PO quantity by supplier industry 

DTAI Medium LTi/actual due date compl. (item) 

DTAS Medium LTi/planned due date compl. (item) 
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Target RT Summarization rule 

DTMI Medium LTi/actual due date compl. (mach.) 

DTMS Medium LTi/planned due date compl.(mach.) 

GALW Item weight per country and commodity ID 

GALW2 Item weight per country and commodity ID 

GALW2R Item weight per country and commodity ID 

KFA1KTR Cost type 1 - production orders per CU 

KFA2KTR Cost type 2 - production order per CU 

KFA3KTR Cost type 3 - production order per CU 

KFA4KTR Cost type 4 - production order per CU 

KFA5KTR Cost type 5 - production order per CU 

KFA6KTR Cost type 6 - production order per CU 

KFAKTR Production order costs per CU 

TTM Machine due date compliance distribution 

TTV Sales due date compliance distribution 

TTVAGR1 Item group 1 due date compliance distribution 

UA Item sales revenue 

UAGR1 Sales revenue by item group 1 

UAK Item sales revenue by customer 

UALW Item sales rev. per country and comm. ID 

UALW2 Item sales rev. per country and comm. ID 

UALW2R Item sales rev. per country and comm. ID 

UAST Item sales revenue by master data key 

UAVB Item sales revenue by sales area 

UGESAMT Total sales revenue 

UK Customer sales revenue 

UKA Sales revenue by customer and item 

UKAGR1 Customer sales revenue by item group 1 

UKGR1 Customer sales revenue by industry 

UKR Sales revenue by customer and region 

UKTR Cost unit sales revenue 



Infor COM 7.5 User Guide | 811 

 

Finance 

 

Target RT Summarization rule 

UKVB Sales revenue by cutomer and sales area 

UL Sales revenue by supplier 

ULA Sales revenue by supplier and item 

ULB Sales revenue by supplier industry 

VA Consumption by item 

WALW Item value per country and commodity ID 

WALW2 Item value per country and commodity ID 

WALW2R Item value per country and commodity ID 

 

The table will not correspond if you have created or changed any summarization rules. 

Please note: Authorized users can make these changes only after participating in Statistics 

training. 
 

Change summarization rules 

For information on summarization rules, see Summarization rules (page 808). This topic describes 

how to change summarization rules. 

Please note:  

 Authorized users can make these changes only after participating in Statistics training. 

 The summarization rules for online statistics (from the STATISTIK section of the Infor COM 

Management Console configuration) VA, UA, AA, UK, UKA, UGESAMT, UL, ULA, BLA, and 

BA) must not be changed. 

 

1. In Finance, open the Statistics folder. 

2. Click Summarization rules. 

3. On the Open tab, use the Summarization rule or Target record type field to select a 

summarization rule. 

4. Click Load. 

5. In the overview, go to the Summarization rule view. 

6. Make the required changes. 
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7. To save the summarization rule with the same name, select Data and Save. 

To save the summarization rule with a different name, select Data and Save as. 

If you changed an existing summarization rule, you should next carry out a summarization for the 

rule. 

If the new summarization rule is active, the associated totals records are generated with the next 

summarization run. 
 

Adjust totals records 

Call 

Finance > Statistics > Adjust totals records 

Description 

See Totals record maintenance (page 807). 

Please note: Normally there are no duplicate totals records. If a totals record appears twice, it is 

a mistake that may have resulted from entering totals records manually for example. 

The evaluation of case-sensitive 

fields is also case sensitive. 

In the relEs database table (Totals record 

maintenance), the key fields (data fields 

1-10) are case sensitive. 

The contents of these data fields depends on the summarization rule (see "Summarization rules" 

page 808) that generated the totals records with the respective record type. In one case, a field 

may contain the item ID and in another, the same field could contain the item description. Setting 

this field to upper case causes problems when fields contain descriptions. 

You cannot define the field as a matchcode since different JOIN statements, such as those on 

reports where you want the item description for an item ID to appear, would no longer function. 



Infor COM 7.5 User Guide | 813 

 

Finance 

 

Example of how duplicate totals records can occur: 

 A process generates an item ID that is written in lower case. The item ID is used when the relEa 

statistics table is summarized. The field is written in upper case here. When a comparison is 

carried out, ITEM ID and item ID are not considered identical. During summarization, the detailed 

data records with the item ID written in lower case are not found, and end up in a separate totals 

record. This results in duplicate totals records in the relEs table. 

When you select Adjust totals records, duplicate totals records are adjusted in two steps. 

1. Data fields 1-10 in the totals records are converted to all caps if the fields in the source 

database table are defined as upper case. 

2. Totals records that appear more than once are merged into a single record. 

Because the runtime may be extremely long, you can adjust the records in these two steps. 

As a rule, you should not need to use this function since duplicate totals records rarely occur. A 

duplicate totals record occurs when Infor COM differentiates between upper case and lower case 

in data fields. This can result in a data field existing in both upper case and lower case. Data (such 

as sales revenue data) is then shown in separate totals records in online statistics. This function 

merges the data into a single totals record. 

If you find duplicate totals records, try to determine how they occurred and eliminate the cause in 

cooperation with your consultant or service employees.  

In this context, "duplicate" means that records with identical record types and Data fields 1 to 10 

contents exist, the only difference being lower case or upper case letters. 
 

Adjust order receipts 

Call 

Finance > Statistics > Adjust order receipts 

Description 

This function has two different purposes: 



814 | Infor COM 7.5 User Guide 

 

Finance 

 

 You want to incorporate the existing orders issued prior to the introduction of Infor COM into 

the statistics. 

To ensure correct order receipt data for a later adjustment of such existing orders, you should 

run the Adjust order receipt process once immediately after enabling the order receipt 

statistics. This generates the corresponding data in Maintain Ea for all orders. 

 You want to check and possibly adjust the order receipt data (reconciliation with movement 

data). 

 

In order receipts, you cannot repeat the extraction after data errors have occurred (for example, 

for sales revenue) because the statistics flag is deleted from the sales orders after every 

extraction. 

When you use the Adjust order receipt process, you can adjust incorrect data. Every sales order is 

checked to make sure that its order receipt data in the statistics is correct. If this is not the case, a 

log record is written to mailbox 66, and an adjustment record may be written to the Maintain Ea 

table. 

Requirements: 

 You must have entered sales orders that display at least the status Order printed. 

 Because this process manipulates data, you should create a backup copy of the database 

before you run it. 

Configuration 

 The COMMON.STATISTIK.AKTIV=yes parameter must be set in the configuration. 

 For the COMMON.STATISTIK.KORRAEDATUM parameter, you must specify the event date 

that is to be used for statistics. 

 
 

Delete locks 

Call 

Finance > Statistics > Delete locks 
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Description 

Some processes in the Statistics module (such as extraction and summarization) cannot run or be 

started on more than one computer at a time. 

When you open one of these processes, the system checks whether the process has already 

been started by another user or whether it is locked. If so, when you start the process, an error 

message appears and the process is canceled. 

The following processes are locked: 

 Extraction and summarization (also locks Prepare repeat E&S, Adjust order receipts, Adjust 

totals records, Change of month, and Change of year) 

 Prepare repeat E&S  (also locks Extraction and summarization, Adjust totals records, 

Change of month, and Change of year) 

 Adjust totals records (also locks Extraction and summarization, Prepare repeat E&S, Change 

of month, and Change of year) 

 Change of month (also locks Extraction and summarization, Prepare repeat E&S, Adjust totals 

records, and Change of year) 

 Change of year (also locks Extraction and summarization, Prepare repeat E&S, Adjust totals 

records, and Change of month) 

 Adjust order receipts (also locks Extraction and summarization) 

 

The other user must stop the process first before the lock can be deleted and the process can be 

opened again. If the program stops responding during a process, the lock cannot be deleted. If this 

happens, you will be notified by an error message when you start Infor COM and asked whether 

you want to delete the lock. You can delete the lock immediately in this dialog box or later using 

the Delete locks function in Finance. 
 

Reconcile units of measure 

Call 

Finance > Statistics > Reconcile units of measure 
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Description 

If a customer modifies a unit of measure for receipts or issues retroactively in the item master, this 

results in falsified statistics. The Reconcile units of measure process therefore converts the 

quantities for all records for which the units of measure were modified retroactively in the item 

master in relEa and relEb to the new units of measure. Afterwards, you only have to regenerate 

the quantity-related totals records (repeat summarization for the respective rules). 
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The Manufacturing module allows you to create and manage production orders as well as monitor 

their progress, post material issues in inventory, and carry out shop floor data collection using 

TIME. 

In addition, APS is available in Manufacturing for rule-based detailed scheduling of production 

orders. 
 

Time calculation 

For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

As different manufacturing enterprises use different time calculation procedures, Infor COM 

provides a range of options. You can use default settings to help you carry out time calculations. 

The following sections provide an overview of the different time calculation procedures used. 

 REFA time is the most commonly used method. This has the following characteristics: 

 There are 60 minutes in every hour and 100 seconds in every minute. 

 All time-related information is expressed in minutes. 

 Decimal places (usually two) specify seconds as fractions of a hundred. 

 Industrial time works on the basis that each hour has 100 minutes, and each minute 100 

seconds. Although this method makes addition easier, it is difficult to convert the minutes and 

seconds into standard time. In Infor COM, industrial time is displayed in real format with two 

decimal places. For example, Infor COM displays 10000 industrial seconds as 100.00 

industrial minutes. 

 Full hours are sometimes used for calculations in accumulated fields. This occurs in the 

capacity account in Infor COM, for example. 

 Gregorian time, which is used for everyday purposes (60 minutes per hour, 60 seconds per 

minute), is not generally used in manufacturing industries. 

The following table displays the different time calculation procedures. The Database field specifies 

the database content in Infor COM. 

 

 

Manufacturing basics 
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Meaning in 

standard use 

Gregorian REFA Full 

hours 

Industrial seconds Database 

Five seconds 00:00:05 0,08[333] 0,00138 13,88888 0,13888 

Three-and-a-hal

f minutes 

00:03:30 3,5 0,05833 583,33333 5,83333 

Seven minutes 00:07:00 7 0,11667 1166,66667 11,66667 

A quarter of an 

hour 

00:15:00 15 0,25 2500 25 

One hour 01:00:00 60 1 10000 100 

3 hours 03:00:00 180 3 30000 300 

Two hours, 

thirty minutes, 

forty seconds 

02:30:40 150,66 2,51111 25111,11111 251,1111 

 

 

In Infor COM, you can select whether you would like to base your calculations on industrial time or 

REFA time. You can set this in the configuration. Both of the following settings are available: 

COMMON.GLOBAL.EXTTYPETIME=Industrial (Industrial time) 

COMMON.GLOBAL.EXTTYPETIME=REFA (REFA time) 

Please note: VARIANTS only uses industrial times for calculation (in decision logics for 

example). The times used in the introductory examples for this module are therefore in industrial 

minutes. 
 

Record types (Manufacturing) 

The record type identifies the type of data record that is entered or selected. It is displayed in the 

order header and in the manufacturing structure list, or must be selected there. It determines the 

resource type, and as a result, the sizes to be calculated (quantities, times, suppliers, and so on). 

The ID after the corresponding record type identifies the record type’s internal system ID. 
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Record type Description 

OP (60) This record type flags an operation where the work center group is always displayed when a 

selection is made – even if you select a single work center. 

The processing duration is calculated for each of these lines. On the Times/quantities tab, 

default settings are entered (from the BOR) for the setup times and runtimes, or new entries 

are specified (for new lines). 

The work center’s capacity is checked in line with the assigned shift plan. 

AO (66) The AO, AMA and ATL record types are handled like TX records and represent inactive 

operations, materials and tools. 

AS (120) This record type represents an assembly (a material line) that is created as part of 

manufacturing and can be processed further. It has its own manufacturing structure that is 

listed in the order under the AS record. Unlike MA records, assemblies are not incorporated 

into inventory. 

Assemblies are always scheduled in parallel, unless this option is explicitly disabled (using 

synchronization points). 

ES (65) This record type (external source) represents the supplier of a material to be purchased. 

SCO (115) This record type (subcontracted manufacturing) represents a third-party assembly whose 

BOR is located in the following lines of the order. 

For further information, see the Subcontracted manufacturing Help topic. 

Note: The SCO record type is also supported as a milestone. This means that the 

dependent transactions can now also be triggered using milestone flags when 

subcontracted operations are entered in Purchasing. 

SCM (91) This record type (subcontracted material) indicates material that a subcontracted 

manufacturer provides in order to process an order. 

Note: This record type is only of use within a subcontracted manufacturing structure. The 

record type cannot be used in a purchase order, that is, in conjunction with an ES record. 

HR (10) This record type (header) is always in the header of the production order and represents the 

entire order. 

IH (17) This record type (intermediate product receipt) represents the receipt of the intermediate 

product in the warehouse. 

You can use the IH and IP record types to post the intermediate product into and out of the 

warehouse after each manufacturing step, provided this product has been created as a 

separate item in the item master. Both record types are optional. The record types can also 

be used for in-house manufacturing. 

MA (90) This record type (material) represents a material line in a production order. For each of 

these lines, the quantity of the material required for the order is calculated. On the 

Times/quantities tab, default settings are entered (from the BOR) for the number of units 

of each finished product or you can specify new entries (for new lines). 

AMA (95) The AO, AMA and ATL record types are handled like TX records and represent inactive 

operations, materials and tools. 
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Record type Description 

IP (97) This record type (intermediate product issue) represents the issue of the intermediate 

product from the warehouse to manufacturing. 

For more information, see the IH record type. 

RM (16) This record type (residual material) flags receipts of residual and waste materials in addition 

to the main product. See also Record types (Inventory). 

SY (130) This record type (synchronization point) represents a delineation line between assemblies 

that prevents parallel scheduling of assemblies. 

As subcontracted manufacturing parts of a production order are handled as assemblies, a 

synchronization point also removes parallel scheduling when scheduling in the case of 

outsourcing. 

For a practical example of how this of this record type functions, see the Store 

subcontracted manufacturing in manufacturing structure Help topic. 

TRA (140) This record type represents a transportation line between two operations. It is taken into 

account in scheduling in the same way as an operation line. A transportation line may also 

represent the chronologically latest line of the production order. 

Note: Unlike operations, TRA lines are used exclusively for scheduling, and there are no 

transactions or capacity calculations. 

TL (70) See Record types (Tools) 

ATL (76) The AO, AMA and ATL record types are handled like TX records and represent inactive 

operations, materials and tools. 

TLR See Record types (Tools) 

TX (110) This record type (text record) represents a text-only line that is not taken into account in 

scheduling, capacity calculation, or covering requirements. For example, it can be used to 

enter alternative lines that can then be selected quickly if required. See also record types 

AO, AMA and ATL. 

 
 

Statuses (Manufacturing) 

For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

In Manufacturing, statuses refer both to the status of the product to be manufactured (header) and 

to the statuses of the individual material and operation lines of the production order. 
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Header 

The processing status of the product to be manufactured is displayed in the Header field. The 

statuses of the individual order lines are displayed in the Status field on the Current tab. If you 

switch from the selected line to the order line view, the Header field will be replaced by a field 

(Operation, for example) that displays the line status. 

In the case of detailed orders, the status of the header is one of the following: Scheduled, 

Released, Part. received, or Received. 

Note that additional statuses are possible for rough planned orders. 

These statuses are taken from the ZUSTDART and WSPOS allocation tables.Note that the 

statuses of the header (that is, of the finished product) and the individual lines are independent of 

each other. 

For example: The header record may have the status Received (that is, it has been posted to 

inventory), whereas individual operations still have the status Released (because the end 

transactions have not yet been entered, although the manufacturing process has already been 

completed). 

Please note: Your company’s particular operating requirements and conditions will determine 

whether it makes sense to process header lines and individual lines independently of each other. It 

may make more sense to link the entering of lines and header lines so that an end transaction for 

all lines in an order is automatically entered for the receipt transaction of the header record, for 

example. 

For more information on linking item and header record transactions, see SFDC transactions and 

milestones (page 896). 

The Status or (depending on the form) Order status field displays the order status in accordance 

with the ORDERSTATE allocation table. The order status is a characteristic of the entire order and 

is determined from the statuses (and queue positions) of the individual lines. 
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Scheduled All lines have the status Scheduled (status/queue position = 3/0) 

Released The only statuses are Released (status/queue position = 4/20) and Scheduled 

(status/queue position 3/0) 

In progress The status of at least one order line (depending on the record type) is In progress, Part. 

issued or Part. received (status/queue position = 5/4), or at least one line has the status 

Active disrupt. (status/queue position = 5/7) 

Interrupted The status of at least one order line is Interrupted (status/queue position = 5/5), 

Disrupted (status/queue position = 5/6), or has a Reason for a disruption (status/queue 

position = 5/8) 

Started There are 

lines that have not yet been started (with the status Scheduled (status/queue position = 

3/0) or Released (status/queue position = 4/20)) 

lines entered as complete (status/queue position = 5/3) 

lines with the status Complete, Issued, or Received - status/queue position = 5/1 - 

(header or material) 

There are no partially entered or interrupted lines. 

Entered The status of all material lines (header or material) is Received or Issued (status/queue 

position = 5/1) and all operations are complete (status/queue position = 5/3). The header 

record does not have the order status Closed. 

Closed All lines have the status Closed (status/queue position = 5/1). 

Reopened Closure of the order was canceled in the posting journal (status/queue position = 5/1). 

Rough planned All lines have the status Rough planned (status/queue position = 1/0). 

 

 

The determined order status (according to the ORDERSTATE allocation table) is entered in every 

line in the order (in the Order status field on the Other tab). 

Note: You can use the SatzartenHeaderANrWS parameter to set the record types that must be 

taken into account when the order status is determined. The following record types are set by 

default (according to the SATZART allocation table). 

 HR = Header (record type 10) 

 OP = Operation (record type 60) 

 MA = Material (record type 90) 
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Queue position 

The Queue position can be used to more accurately identify the processing status (see "Statuses 

(Manufacturing)" page 821) of a production order (that is, the product to be manufactured), as it 

takes SFDC transactions and inventory transactions into account. This allows for a more detailed 

breakdown. 

The queue positions are stored in the WSPOS allocation table. 

Example: 

An operation has the status Entered. The queue position specifies whether the operation was 

reported as In progress (Que = 4), Interrupted (Que = 5), or Complete (Que = 3). 

The queue position is displayed in the Que field on the Other tab. In the production order, the 

queue position can have the following values: 
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Value Explanation 

0 Displayed for status 3 (Scheduled) 

1 Closed (operation), Issued (material), Received (order header, intermediate product receipts) 

2 Transported 

3 Complete (operation) 

4 In progress (operation), Part. issued (material), Part. received (order header, intermediate product 

receipts) 

5 Interrupted 

6 Disrup. (alarm) 

7 Active disrupt. 

8 Reason 

9 Unplanned 

10 Progress 

18 Ready 

19 Provision 

20 Released (not yet available in the work center). This is displayed for status 4 (Released) 

71 Received by inspection (order header, intermediate product receipt) 

74 Partially received by inspection (order header, intermediate product receipt) 
 

Change flag 

For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

The D=Due date, U=Duration, and Q=Quantity change flags indicate whether or not automatic 

changes may be made to values as a result of rescheduling. 

Check box is selected: The Due date, Duration, or Quantity are fixed and are therefore ignored 

during rescheduling. However, you can still make manual changes, depending on the status of the 

order or line. 

If the duration has been fixed, the operation content is also fixed (Total time). 
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If this check box is not selected, the due date, duration, and quantity may be changed during 

rescheduling. 

The AendKnzFreigabe parameter determines whether or not these change flags are automatically 

set when the order or order line is released and thus whether changes can or cannot be made to 

the due date, duration, or quantity as a result of rescheduling after the release. By default, these 

flags are not set when you release an order or order line. 

The change flags are always deleted in the event of a canceled release so that rescheduling can 

take place. 

The change flags for an order line are set automatically as soon as a transaction (inventory 

transaction or SFDC transaction) is entered for the line. 
 

Multiple-machine operation 

For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

Multiple machine operation indicates a situation whereby one employee works at several 

machines at the same time (and therefore also on several orders). 

In Infor COM, multi-machine operation is represented by the same process, which is planned 

several times in parallel. 

Processes can also be split. 
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Subcontracted manufacturing 

Description 

The Subcontracted manufacturing function organizes the assignment of production orders for your 

items to suppliers, as well as the monitoring of this process. Subcontracted manufacturing also 

includes the transfer of materials provided to your suppliers. 

Specific internal company circumstances such as capacity bottlenecks may require operations to 

be subcontracted to third parties for a particular order. Usually, the activity can be performed by 

several subcontracted manufacturers under different conditions (price and delivery time). 

You can outsource parts of orders to subcontractors using either planned or unplanned 

subcontracted manufacturing. 

Planned subcontracted manufacturing 

Planned subcontracted manufacturing relates to operations that you usually outsource. 

The following conditions apply to planned subcontracted manufacturing: 

 The information for the subcontracted manufacturing job (routings and BOMs) is already 

stored in the BORs through the selected record type. 

 There are one or more possible suppliers for every activity to be outsourced. 

 The costs for the outsourced activity depend on the supplier. 

 The duration of an outsourced activity depends on the delivery time of the respective supplier 

or is determined using a subcontracted operation (see the section below dealing with the 

creation of subcontracted manufacturing work centers.) 

 When a production order is generated, information is passed on from the master data to the 

production orders about the possible alternative suppliers of an activity. 

 The decision in favor of a supplier depends on the price and deadline and is usually made by 

Purchasing. 

For more information on planned subcontracted manufacturing, see Handle subcontracted 

manufacturing (page 833). 
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Unplanned subcontracted manufacturing 

Unplanned subcontracted manufacturing describes operations that are outsourced for certain 

orders. 

Decisions to subcontract are made in the preparatory phase or during manufacturing. To 

subcontract an operation, select the operation and then select Functions and Outsourcing. 

Please note: This function is available for operations only. 

The selected operation is then converted to a TX record and an SCO record is created. The ID of 

the subcontracted activity is entered in the Operation ID field on the Item ID tab, and the selected 

supplier of the subcontracted activity is entered as the Resource. 

If a subcontracted activity structure is assigned to the supplier as a BOR, this is inserted 

automatically under the SCO record. The SY synchronization point must appear on the same level 

as the corresponding SCO record. In unplanned subcontracted manufacturing, a synchronization 

point is inserted automatically with the correct level ID. 

Example: 

Record type Level ID Resource 

TX 1 The operation that has been outsourced 

SCO 1 The subcontracted activity and the corresponding supplier 

OP 2 The updated BOR 

SY 1 The synchronization point for scheduling 

For an explanation of the record types, see Record types (BOR) (see "Record types 

(Manufacturing)" page 819). 

Alternatively, you can manually enter BOR data for a subcontracted activity in the production 

order. See Store subcontracted manufacturing in manufacturing structure (page 832). 
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Work centers 

Depending on the subcontracted manufacturers that work for you, create subcontracted 

manufacturing work centers if there is no flat rate specified for the subcontracted manufacturing 

(that is, in the subcontracted activity or in the SCO record) and the subcontracted manufacturing is 

instead to be itemized and paid according to the subcontractor's time and material outlay (for 

example, if the subcontracted manufacturer is to be paid by the hour). 

The difference between normal work centers and subcontracted manufacturing work centers is 

that 0 is entered as the planning type for subcontracted manufacturing work centers, as 

subcontracted operations are not planned (they do not occupy any of your work centers). 

In the subcontracted activity, specify the delivery time and delivery time unit in order to enter a 

dummy operation with the delivery time as the setup time and the delivery time unit as the shift 

plan in the subcontracted manufacturing structure and to automatically generate the associated 

dummy work center (provided this does not yet exist). The latter is recognizable by the description 

Subcontracted manufacturing delivery time (localized into the user's respective language). 

Configuration 

Note: If the COMMON.LEITSTAND.FREMDFERTIGUNGVORSCHLAG =no parameter is set, 

purchase orders are created. The feedback ID (FID) in a PO proposal or purchase order is on the 

Internal tab. 

Functions 

Entering reject transactions: If the subcontracted manufacturer produces rejects, the rejects to be 

entered are noted in the Rejects field on the Transaction tab when the receipt inventory 

transaction is carried out. 

Carrying out RMAs for subcontracted manufacturing POs: Posting IDs 135 and 136 are available 

through the inventory transaction for posting an RMA for a subcontracted manufacturing purchase 

order. 

Checking availability of materials provided: To check the availability of the materials provided 

before printing the purchase order, select Functions > Create document and then select the Check 

availability check box in the Create document dialog box in the purchase order. 
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Splitting third-party assemblies: 

1. You can split third-party assemblies during order release by reducing the order quantity in the 

Release dialog box (if, for example, you want to have a partial quantity processed by a 

different subcontracted manufacturer). You receive a released third-party assembly for the 

ordered quantity and a scheduled third-party assembly for the remaining quantity. 

Third-party assemblies can also be split if the SCO or IH record has milestone triggers. In this 

case, the dependent lines are also split. If the order header is dependent, a BH record is 

generated for both the order quantity and the remaining quantity. 

2. In the PO proposal and in the PO, you can reduce the order quantity to generate a PO 

proposal or a PO for the remaining quantity. When the PO proposal or PO is generated, the 

third-party assembly in the production order is split in a similar way as during release. 
 

Price calculation and costing of subcontracted manufacturing 

Prices for subcontracted manufacturing can be calculated in various different ways. They can be 

entered both in the BOR and in the production order. 

You can enter sliding-scale prices for every subcontracted manufacturer in the Master data folder 

in Purchasing by opening Subcontracted activities and entering the price details on the Purchase 

prices tab. The usual Price calculation rules apply. 

Note: You can use the COMMON.LEITSTAND.FREMDFERTIGUNGPREISEINKAUF parameter 

in the configuration to specify that price calculation is to be transferred in full from Purchasing. If 

this switch is set to 1 or 2 and the subcontracted manufacturing structures are stored in 

subcontracted activities, then the following occurs: 

Prices are no longer fixed during transfer to Purchasing. 

The price is taken from the price table for subcontracted materials, and for subcontracted 

operations, the valuation price stored in the production order is used. 

See also Costing of subcontracted manufacturing lines. 
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Enter inventory transactions for material provided 

Post the issue of the material delivered to the subcontracted manufacturer from the production 

order using one of the following options: 

Issue posting when 

releasing the production 

order 

Functions > Release, select the Material issue check box. 

When you confirm by clicking OK, all material lines are issued automatically. 

Issue posting during PO 

printing 

In the dialog box that is displayed after you print the PO, select the Issue option for 

the material provided. 

When you confirm by clicking OK, all material lines are issued automatically. 

Issue posting in the 

warehouse 

Functions > Inventory transaction > Functions > Full issue. 

The posting ID is entered for the full issue for all material lines. If you then select 

Functions and Post, this issue is posted. 

Issue during the receipt 

posting of the 

subcontracted 

manufacturing in the 

warehouse 

Inventory > Manufacturing > Inventory transactions  

For all subcontracted manufacturing components, the posting ID is entered for the full 

subcontracted manufacturing. If you then select Functions and Post, the entire 

subcontracted manufacturing is posted. The material lines of the material provided are 

automatically posted as issued. 

Alternatively, material provided can also be reposted to the subcontracted manufacturer's 

warehouse. To do this, you must create a corresponding inventory area (S/C warehouse area 

type, Subcontracted manufacturing consignment warehouse) and inventory location for the 

subcontracted manufacturer – see the Properties tab in inventory areas. 

In this case, the actual issue occurs during the receipt posting for the subcontracted manufacturing 

activity. 

If you want material provided to always be reposted, you should set the  

COMMON.EINKAUF.MATERIALTRANSFERTOEXTERNALSUPPLIER parameter  so that the 

corresponding option is available in the subsequent dialog boxes. 
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Issue posting 

when releasing the 

production order  

Functions > Release, select the Material issue and S/C warehouse 

check boxes. 

When you confirm by clicking OK, all material lines are automatically 

reposted to the subcontractor's warehouse. 

Reposting during 

PO printing  

Select the Reposting to subcontractor warehouse option in the 

dialog box that is displayed for the material provided after you print the PO. 

When you confirm by clicking OK, all material lines are automatically 

reposted to the subcontractor's warehouse. 

Reposting in the 

warehouse  

Functions > Inventory transaction > Functions > Reposting to 

subcontractor warehouse. 

The posting ID is entered for the reposting for all material lines. If you then 

select Functions and Post, this reposting is carried out. 

Note : If materials provided are not to be stored first but are instead to be 

delivered directly to the subcontracted manufacturer, posting IDs 

131/132 are available for this and posting ID 133 is available for 

cancellations. For the inventory transaction, you can enter the information 

regarding the subcontractor's Consignment location on the 

Coordinates tab. The items receive the bulk issue ID 3 (Inventory 

tab) so that they will not be reposted again when the subcontracted 

manufacturing purchase order is being printed. 
 

Store subcontracted manufacturing in manufacturing structure 

Help on subcontracted manufacturing is available in the Subcontracted manufacturing (page 827) 

Help topic. 

This Help topic describes how to carry out unplanned subcontracted manufacturing by storing the 

BOR of the subcontracted activity in the actual order itself. 

1. Open the production order in which you want to enter the subcontracted activity. 

2. If you also want to carry out preparatory operations before outsourcing, use a synchronization 

point (SY record type, sync resource) to separate these from the subcontracted 

manufacturing: 

Level of the SY record = level of the SCO record. 

For an overview, see the following example. 
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RT Resource 

OP 8310 

OP 8370 

MA 701-0004 

SCO 4000 

OP 8368 

OP 8410 

SCM Small items 

MA 602-0003 

SY Sync 

OP 2070 

OP 4090 

This guarantees that the operations are scheduled correctly. The operation 2070 is 

scheduled prior to the processing of the external assembly. 

If there was no synchronization point, the subcontracted manufacturing would be 

scheduled in parallel, because it would be regarded as an assembly. The operation 2070 

would be scheduled at the same time as the subcontracted manufacturing. 

3. In the RT field, select record type SCO and enter the ID of the resource in the Resource field. 

When you confirm, the lines of the BOR of the subcontracted activity are inserted and  

the synchronization point is generated automatically after the lines from the subcontracted 

activity has been inserted. Please note the information on dummy operations in the 

Subcontracted manufacturing (page 827) Help topic. 

Note: The costs of the material provided are not printed on the PO. 
 

Handle subcontracted manufacturing 

This topic outlines the entire subcontracted manufacturing process, from creating the 

subcontracted activity through to the production order, PO, and posting of the material provided. 

1. In Purchasing, click Subcontracted activities in the Master data folder and select the New tab. 

Enter the required data and confirm by clicking Create. 
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2. Enter the relevant supplier(s) on the Subcontracted manufacturer tab. 

Note: If you have more than one supplier, you can create a separate BOR for each supplier. 

3. Select the supplier for which you want to store the subcontracted activity. Then select Go to 

followed by Subcontracted manufacturer BOR and enter the BOR ID in the dialog box that is 

then displayed. Confirm the dialog box by clicking OK. 

Please note that a data record is created for every supplier that is created on the Purchase 

prices tab. A price is not set. This tab allows you to store sliding-scale prices for individual 

suppliers. For more information, see Prices and discounts in Purchasing. 

Note: This means that you can also create separate BORs for additional suppliers or use a 

combo box to assign BORs that have already been entered. 

4. Enter the BOR data on the Texts/structure tab of the BOR. Note that the subcontracted activity 

is inserted between then IH and IP record types. There can be multiple IP lines per BOR. 

The IH record type must always be at the firs record type in the BOR. 

Example: 

IH Intermediate product 2 

OP External work center 

SCM Subcontracted material 

MA Material 

IP Intermediate product 1 

For more information on record types, see the Record types (Manufacturing)  (page 

819)Help topic. 

5. To add the subcontracted activity to the production order, select the SCO record type at the 

required location and then, in the Resource field, select the resource ID of the required 

subcontracted activity. 

The BOR of the subcontracted activity is inserted at the required location: 
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IP Intermediate product 2 

IH Intermediate product 2 

SCO Subcontracted manufacturing supplier X 

OP External work center 

SCM Subcontracted material 

MA Material 

IP Intermediate product 1 

SY Synchronization point 

Please note that above the synchronization point, the BOR is inserted between the IP and 

IH record types. You must in turn insert the IP record type above the IH record type, 

because an issue must also be compared to the inventory receipt. The received and issue 

quantities must be identical. 

6. Select Functions and Release to release the production order. 

After it is released, you can access the PO from the SCO record by selecting Go to and 

Subcontracted manufacturing PO. 

Note: When the PO is generated, the ID of the production order remains in the Order column 

of the SCO record. The feedback ID of the PO lines and the PO ID are stored in the production 

order. When you process, print, and confirm the PO, the PO data is updated in the production 

order. 

Please note: In the purchase order, the IH record types appear as HR lines and IP record 

types appear as MA lines (material lines). The PO tab therefore displays the following 

record types. 

HR Intermediate product 2 

... As in previous step 

MA Intermediate product 1 

7. To print the purchase order, select Data and Print. When you print the purchase order, an 

option in the Material issue dialog box (set via 

COMMON.EINKAUF.MATERIALTRANSFERTOEXTERNALSUPPLIER parameter in the configuration by 

default) allows you to repost the material provided to a warehouse belonging to the 

subcontracted manufacturer, instead of removing it. In this case, the actual removal only 

occurs when the receipt transaction is entered. 
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The following posting IDs are used for repostings and return postings. You can check the 

repostings on the Internal tab of the purchase order using the status 143 in the Status4 

field. 

158 Partial subcontracted manufacturing issue 

159 Cancellation of S/C manufacturing: Cancellation posting for the material provided. This posting 

ID can be used to post back excess delivered material. 

160 Transfer to subcontracted manufacturing 

8. In the purchase order, select Functions and Inventory transaction. The following posting IDs 

will then be available on the Transaction tab for posting the subcontracted manufacturing 

activity. 

142 Cancel S/C manufacturing receipt to inspection 

143 Full subcontracted manufacturing receipt to 

inspection 

144 Partial subcontracted manufacturing receipt to 

inspection 

146 Partial subcontracted manufacturing receipt 

147 Full subcontracted manufacturing receipt 

149 Cancel subcontracted manufacturing receipt 
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TIME basics 

TIME is used for entering, managing, and analyzing shop floor data in the areas of time and 

attendance and order time in Manufacturing and Access control. 

The following graphic provides an overview of shop floor data collection (see "Shop floor data 

collection (SFDC)" page 839) with TIME. 

 

Notes on individual components: 

 The SFDC server is used for communication between terminals and TIME and for posting and 

storing data in Oracle. 

 The TIME work center is used for master data administration and adjustment or analysis. 

 TIME terminals are used to enter time and attendance and order time. 

TIME 
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 TIME access control complements the TIME system. Each terminal or PC can be equipped 

with external active card readers and a digital I/O interface card to control the door locking 

equipment depending on the number of serial interfaces. Access is controlled using TIME 

software. 

 

The following graphic provides an overview of data flow in TIME. 
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Shop floor data collection (SFDC) 

This Help topic deals with shop floor data collection in Manufacturing using the TIME component. 

You can learn more about how shop floor data is entered in SFDC transactions (page 879). 
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Evaluate SFDC data 

Data is not maintained in the evaluations of the entered shop floor data (with the exception of 

adjustments). The data shown is generated solely using time processing based on entered events 

and using the definitions and agreements stored in the master data of working hour entries and 

time and attendance entries. 

You can initiate time processing (see "SFDC processing" page 912) in three ways: 

 Manually (for example, after adjustments) 

 Automatically after each transaction relevant to time control 

 Cyclically using the time control applicable to Infor COM processes 

 
 

SFDC server 

As an independent program in relation to Infor COM, the SFDC server acts as an interface 

between Infor COM and the SFDC terminals and it also looks after the central administration and 

control of the terminals. 

With the SFDC server, you can: 

 Differentiate between online and offline status 

 Control clients 

 Reduce the number of licenses required for clients to access the database directly 

Configuration 

The parameter settings for the SFDC server are made in the odcserver.ini file in the Ini 

subdirectory of your Infor COM system directory. You will find brief explanations of the settings in 

the file. 

The parameter settings for the SFDC client are made in the odcstandard.ini file in the Ini 

subdirectory of your Infor COM system directory. You will find brief explanations of the settings in 

the file. 
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Set up and operate the SFDC server 

For information on the SFDC server (page 840), please see the corresponding topic. 

Two programs are available for working with the SFDC server. 

 ODCCom.exe 

 ODCdb.exe 

The following Help topic describes working with the program’s forms. 

Once ODCcom.exe has started, three tabs are displayed: Station, Detail, and Log. 

Station 

All terminals are read from the Infor COM master data and displayed in the Station form section. 

 In the Station section, you see the server in the top position of the directory tree with the 

assigned stations underneath. 

 In the Status form section, the symbol indicates that ping messages are being sent to the 

stations. These messages check at regular intervals whether a station is connected to the 

network. odcserver.ini is used to control the time interval for these checks, as well as the 

length of time during which the messages are sent. After the length of time has elapsed, the 

symbol closes.  

The color of the square symbol indicates the system status. Green represents error-free 

functioning while red indicates a malfunction. 

 In the Config section, you can switch the status check on/off using the Auto check box and you 

can enable/disable the display in the Stations section using the Show check box. 

 The Error form section shows system error messages that may occur. You can remove these 

using the Clear button. 

The buttons in the Edit section have the following functions. 

 Use the Edit button to select additional display fields and buttons. A selection list box for 

individual stations with their descriptions and IP addresses will appear and new stations can 

be entered. You can also set stations to active using the Active check box. The graphic 

displayed shows the form after the Edit button is activated. Click OK to confirm your settings; 

click Delete to delete the station displayed. Click Cancel to cancel editing. 

 Click Refresh to update the window status. Clients are then prompted to log on again. 

 Export Language allows you to download the relevant language entries. 

 Restart: The terminal tree is updated - not the status of the terminals, but which terminals are 

entered as active in the RELODCTERMINAL table. 

 Update Software: This button allows you to update terminal software. 

Please note: The updated software must then be present in the appropriate directory on the 

SFDC server. 
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The Station check box in the Show form section shows or hides the display of the stations. 

Detail 

You can see the terminals entered and their name and IP address on the Detail tab. You can tell 

from the Active column whether the status has been activated. 

In the Online field, you can check if the station is online (green symbol). The Download field 

provides the date and time of the last export. The Version column contains the version ID of the 

client software that was sent to the server at logon. 

In the Detail field of the Show form section, you can hide display details. 

Log 

All actions of the SFDC clients and of the server are documented in the Log tab. Transactions 

include system information on individual clients and the server such as download, start, and end, 

as well as all SFDC transactions (Clock in, Clock out, Start operation, and so on). If the number of 

transactions, which can be set in the Ini files, is exceeded, each additional entry causes the oldest 

entry to be deleted. 

 

The Dir field shows the direction or type of the transaction identified (examples: ClientAnswer, 

ServerPing). 

The terminal description is located in the Terminal field, while ID contains the specific ID of a 

transaction, which is assigned by a counter. 

The Type field contains the message type (such as transactions from server to client, export 

messages, SMS messages); the message content is in the Message field. 

You can hide/show individual transaction types in the display using the fields in the Show form 

section. 

The form which appears at the start of ODCdb.exe contains all transactions to be processed. 
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TIME master data 

The TIME master data folder is located in Manufacturing. You can enter all the master data 

required for shop floor data collection (see "Shop floor data collection (SFDC)" page 839) using 

the various desktop objects. Make sure you adhere to the following (theoretical) sequence. 

 Creating the employee groups (page 846) is central. 

 Based on this, you can specify the time account groups (page 851), the time and attendance 
templates (see "TA templates" page 848), and the processing instructions (page 854). 

 In the Links view, assign time account groups and time and attendance templates to the 

employee group. 

 When an employee record is created it is assigned to an employee group. When you save this 

record, the employee created is automatically included in the employee group. 
 

Employee master 

Call 

In Manufacturing, open the TIME master data folder and select Employee master to open the 

employee master. 

Description 

The employee master contains fundamental data regarding all reporting employees and the rules 

and privileges for operating terminals as part of shop floor data collection (see "Shop floor data 

collection (SFDC)" page 839). 

Functions 

 If SFDC terminals are connected, you can select Functions and Start download to send any 

record in the employee master to the assigned terminal. This allows you to check an 

employee’s access permissions at a terminal while decreasing data traffic since employees 

can query current data in their employee records directly at the terminal. 

 Click here for Help on activating/deactivating. 
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 You can select Functions and Left company to indicate that an employee has left the 
company. This status prevents employee data from being deleted (which can cause legal 

problems) and prevent the employee from being displayed if you browse or load employee 

master data using the % parameter. 

Configuration 

COMMON.PERSONENSTAMM.ADRESSENR 

In practice 

Please note that the entry privileges of an employee are dependent on the employee's status. 

Active, Act. Inactive Left the company 

Enter Cannot enter Cannot enter 

Participation in access control Participation in access control No participation in access control 

Download to terminal Download to terminal Cannot download to terminal 

Listed in browse boxes Listed in browse boxes Not listed in browse boxes 

Can be loaded in master and 

movement data 

Can be loaded in master and 

movement data 

Can only be loaded using the employee 

master 

Report evaluation Report evaluation No report evaluation 

 

Note: This status is displayed in yellow in the status line. 
 

Download employee master data 

As a rule, transactions are entered into TIME through terminals that are connected with the TIME 

server (online). 

If the connection between the server and the reporting terminal is interrupted (offline), the terminal 

must have information on the entry privileges of the reporting employee. The terminal retrieves this 

information from an Access database, in which TIME stores the necessary master data for these 

types of cases. This is in a preconfigured subdirectory in your Infor COM system. 
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Please note: To download data successfully, the relevant entries must be made in the 

Terminals object in the TIME master data folder of the Manufacturing module. In addition, the 

following parameters must be set: COMMON.ODCLINK.PARAMETERPATH, 

COMMON.ODCLINK.ORDERFILESPATH, COMMON.ODCLINK.PERSONDATAPATH, 

COMMON.ODCLINK.BCOMFILESPATH. 

Note: Data is transmitted to the Access database using ODCCom.exe (Communicator) in your Infor 

COM system directory. 

To make the data available for the terminals, proceed as follows. 

1. Select Manufacturing and open the TIME master data folder. Open one or more Employees or 

Employee groups. 

2. Select Functions and Start download. 

Please note: The term download describes the process from the viewpoint of the terminals. 

The Start download function causes an SFDC posting record with the posting ID 91 to be 

written. This posting record is accessed by SFDC processing. Once processing is complete, 

the methods specified in the Download type field on the Download tab of the terminal master 

data are run. If this field is empty, no action is carried out. 

The system notes the date of the successful download on the Terminals tab. The completed 

download contains the master data required by the terminal. 
 

Activate/deactivate employees 

An employee can only enter transactions once he or she has been activated; days are not created 

for deactivated employees. The procedure for activating and deactivating an employee is identical. 

The status of newly created employees is always inactive. Inactive employees are not permitted to 

enter transactions. 

Please note:  

 If you want to re-activate an inactive employee, then the activation date must be after the 

planned end of the last available period for this employee. If time periods are monthly, for 

example, you cannot re-activate an employee in the same month he or she was deactivated. 

 We recommend activating and deactivating employees at the end of a period. 

The following steps describe the activation process. 

Proceed as follows to activate an employee. 
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1. In Manufacturing, open the TIME master data folder and select Employee master. 

2. On the Open tab, select Inactive in the Status section. Then enter the name of the employee in 

the Employee ID field and click Load. 

3. Switch to the Start values tab. Enter the dates for the next status modifications in the Activate 

on and Deactivate on fields. These dates can even be in the past if they are greater than or 

equal to the date of the last evaluation (the last TA day) of the relevant employee. 

The Batch TA processing (page 916) process analyzes this data, activates and deactivates 

employees, and triggers a download if applicable. You can also modify the status immediately 

by selecting Functions and Activate/deactivate. If there is no valid value in the Activate on and 

Deactivate on fields, then the current date is used. 

Note: You can back date or make adjustments in different active phases, for example, even 

inactive employees can be adjusted. 

4. Open the View menu to switch to the Start values tab where you can check whether the 

employee is activated in the Validity section. 
 

Employee groups 

Call 

Manufacturing > TIME master data > Employee groups 

Description 

For time and attendance recording, it makes sense to group together employees who have the 

same working hours within a day. This approach simplifies adjustments to time and attendance 

recording, such as the introduction of new wage regulations. 

Each employee in the employee master is assigned to an employee group for more efficient 

management. Employees with identical working hours provisions (that is, with an identical time 

and attendance template (see "TA templates" page 848)) on all calendar days and in the same 

wage group are assigned to the same employee group. 

The properties of employee groups are by and large the same as the properties of employees. 

Different working hours can occur within a group depending on the day. 



Infor COM 7.5 User Guide | 847 

 

Manufacturing 

 

Example: 

Group Planned working hours per week  Daily working hours 

Industrial 36 hours Mo-Th: 8 hours 

Fr: 4 hours 

 

Functions 

The time-dependent links between the employee groups concerned and the time account groups 

(page 851), time and attendance templates (see "TA templates" page 848), and time account 

definitions (page 853) are entered in the employee group links input form. 

In practice 

Examples of groups that are frequently created: 

 Clerical staff 

 Clerical staff with flextime 

 Supervisory staff 

 Industrial, normal shift 

 Industrial with overtime entitlement 

 Industrial, 2 shift 

 Industrial, 3 shift 

 
 

Create employee group 

The following process shows you the most important steps in creating an employee group (see 

"Employee groups" page 846). 

1. In Manufacturing, open the TIME master data folder, select Employee groups and then the 

New tab. 

2. The system automatically inserts the group ID, which can be overwritten. Enter the employee 

group description in the Group name field and click Create. 

3. Go to the Create period tab and specify the beginning and end of the statement period using 

Period type. 
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4. On the Terminals tab, enter the terminals (page 917) for entering transactions. 

5. Specify the employee group privileges with respect to order time transactions and time and 

attendance transactions on the Order time privileges and TA privileges tabs. See the 

context-sensitive Help. 

6. Select View and Links to create assignments to the time account groups (page 851), the time 

and attendance template (see "TA templates" page 848), and the processing instructions 

(page 854). 

7. Assign the required time account group on the Valid time account groups tab. You can open 

the time account group using the Go to command. Make sure that each time account group 

has a unique start date. 

8. Switch to the TA template tab and enter one or more time and attendance templates. 

Example: You may require different templates for the weekdays Monday through Friday as 

well as Saturday/Sunday. In the Validity section, you can enter time and attendance templates 

whose validity only applies to certain periods (seasonal workers). 
 

TA templates 

Using the time and attendance templates, you can specify which type of working hours are valid 

for the individual intervals of a day for a specified employee group. You can define the planned 

working hours of the day, start and end of working hours, break rules, and so on, in these 

templates. The number of intervals per working day (time and attendance template) is unlimited. 

The breakdown of working hours into flextime, overtime, break, and so on, is defined using the 

time intervals on the Intervals tab of the time and attendance template. 

You can enter and display times in various formats in Infor COM. For more information, see Time 

calculation (page 818). 

For more information on how to create a time and attendance template, see Create time and 

attendance template (see "Create TA template" page 849). 

You can also create a distribution template as a special type of TA template. Distribution templates 

are TA templates that contain references to other TA templates. 

Example: 
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Create the following distribution template on the Interval tab. 

From To Time type (details) Template ID (details) 

0:00 10:00 Template change to TA template 1 

10:00 18:00 Template change to TA template 2 

18:00 26:00 Template change to TA template 3 

For postings within the intervals defined here, the TA template assigned to this interval is now 

accessed. 

Note: You can use the shortcut menu of the (selected) Template ID field in the Details form section 

to go directly to the assigned TA template. 
 

Create TA template 

For information on time and attendance templates, see the TA templates (page 848) Help topic. 

To create a time and attendance template, proceed as follows. 

1. In Manufacturing, open the TIME master data folder and select TA templates and then the 

New tab. The template ID is automatically inserted. Enter a name for the template and click 

Create. 

2. Enter the planned time and planned absences in the shift plan header. 

3. On the Interval tab, enter the individual time types. You can specify these in the Details form 

section. Enter each time type to transfer it to the table on the left and specify the interval in the 

From and To fields. The following tables show examples: 

 a simple time and attendance template Industrial Mo through Fr early shift. 
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From To Time type Explanation 

0:00 24:00 With time rounding; 

interval [min]: 15; Clock 

in: Round up; Clock out: 

Round down 

In the period from 0:00 to 24:00 hours, transactions 

are rounded up to the nearest quarter of an hour for 

Clock in transactions and similarly rounded down for 

Clock out transactions. 

0:00 6:00 Posting time; 6:00 All transactions between 0:00 and 6:00 hours are 

posted to 6:00. 

6:00 14:00 Basic shift; Automatic 

time account: 255, Basic 

shift violation 

During the basic shift time of 6:00 to 14:00, absence is 

posted to account 255 (Basic shift violation). 

10:00 10:30 Break; Break deduction 

[hr]: 0.5 

This time (0.5 hours) is automatically posted to the 

working hours as a deduction. 

14:00 16:00 To time account; Time 

account: 100, (overtime 

25%) 

The time between 14:00 and 16:00 is posted to time 

account 100 (overtime at 25% premium). 

24:00 24:00 Lockout time; 14:00 This setting ensures that the employee is automatically 

logged off at 14:00 if he or she forgets the Clock out 

transaction. 

 a Clerical staff Monday - Friday template 

From To Time type Explanation 

0:00 6:00 Posting time; 6:00 See Posting time in the previous example. 

6:00 8:00 Flextime See Flextime in the table in the Details form 

section under Interval. 

8:00 15:00 Basic shift; Automatic time 

account: 255, Basic shift 

violation 

See Basic shift in the previous example. 

9:00 9:15 Break; Break deduction 

[hr]: 0.25 

See Break in the previous example. 

12:00 12:30 Break; Break deduction 

[hr]: 0.5 

See Break in the previous example. 

15:00 18:00 Flextime See 6:00-8:00 

18:00 24:00 Posting time; 18:00:00 See Posting time in the previous example. 

24:00 24:00 Lockout time; 14:00 See Lockout time in the previous example. 
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Time account groups 

When entering TIME master data, the entry of time account groups as well as employee groups 

and time and attendance templates plays a key role. 

Time account groups contain several time accounts (see "Time account definitions" page 853). 

To be able to assign time account groups to the various employee groups, you must first define 

the time account groups. In Manufacturing, open the TIME master data folder and select Time 

account groups. For more information, see Create time account groups and definitions (page 851). 

Time account groups play an important part, in particular with respect to wage link. They bundle 

those groups of time account definitions that belong together at the time of transfer to payroll. 

Example: An important distinction among time account groups is the one between manual workers 

and clerical staff. 

Note: Do not delete or modify any time account groups, as this may affect the ability to perform 

retroactive calculations. Instead, create new time account groups with different time account 

definitions in every case. 
 

Create time account groups and definitions 

To enter time account groups (page 851), proceed as follows. 

1. In Manufacturing, select TIME master data > Time account groups and select the New tab. 

The group ID is automatically inserted by the system and can be overwritten. Enter the Group 

name for the time account group and confirm by clicking Create. 

2. On the Time accounts tab, enter the individual time accounts (see "Time account definitions" 

page 853) for these time account groups. For data to be stored, you must create at least one 

default time account and a time account for closing not found. 

The following table shows an example of these two accounts: 
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Time account ID Time account name 

100 Working hours 

300 Clock out transaction 

forgotten 

3. To record the properties of an account, highlight the account row and select View and Time 

account definition. 

4. Now enter the properties required for the time account on the Properties tab. 

5. Repeat steps 3 and 4 for all other time accounts. 

The following table shows a simple example of an entry on the Time accounts tab: 

Time account ID Time account name Properties 

100 Working hours Actual, Relevant to balance, Paid, Min. 

break 

150 Vacation Relevant to balance, Paid, Pl. time 

recon., Reason for absence, Pl. absence 

160 Public holiday Relevant to balance, Paid, Reason for 

absence 

200 Break  

300 Clock out transaction 

forgotten 

 

320 Basic shift violation TA mailbox 

6. Switch to the Time account assignments tab and make the assignments there by using the 

check box to assign one of the time accounts you have created to each required field. 

The above example would produce the following assignments: 

Field Assigned account 

Break 200 

Basic shift violation 320 

Vacation 150 

Closing not found 300 

Posting time violation 320 

Default time account 100 
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Time account definitions 

You can learn how to create time account groups (see "Create time account groups and 

definitions" page 851) in the corresponding Help topic. Each time account group contains a series 

of time accounts (definitions).. 

Time accounts are assigned to wage types in TIME. Time accounts represent Time counters. 

Times from the current day are counted in the time accounts with a positive or negative sign. 

Values from previous days are retained. 

In Manufacturing, open the TIME master data folder and select Time account groups to specify the 

time account definitions. When creating a new time account definition, enter the definition on the 

Time accounts tab and then open the View menu and select Time account definition. 

TIME differentiates between internal, freely definable, and external time accounts. 

 

By creating time account definitions, you can generate any number of additional time accounts 

according to the following principle: 

A time and attendance template is stored for an employee group. Each time account definition in 

this time and attendance template generates a time account with the same name for every day in 

a period. The updating of the values during the days in this period is regulated by processing 

instructions. Processing instructions for the time accounts assigned by the system are preset. 

Example 1: 

If an employee punches in at 7:00 hours and works until 20:00 hours, the assignment on this day 

could appear as follows: 

07:00 - 20:00 to the account Normal working hours = Time account 100 

18:00 - 20:00 to the account Late work bonus 20% = Time account 155 

Within TIME, the time account 100 is evaluated as paid time (parameter). Time account 155 is a 

bonus that is paid out in payroll accounting in addition to time account 100. In TIME, the time 

account 155 is evaluated as paid but not relevant to balance. Otherwise the employee in this case 

would be paid for 15 hours rather than 13 hours. 
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Example 2: 

Time account ID Normal hours Properties 

100 Normal hours Paid, Relevant to balance, Break, Min. break, Export 

182 Public holiday Paid, Relevant to balance, Export 

 

Time account definitions define remuneration rules. For each time account definition used by an 

employee during a day, time processing generates a data record in the movement data. This data 

record contains a time account, that is, a time counter. The time account provides information on 

how much time is allocated to a time account definition per day. 

The length of time for which a time account definition is valid is defined either by events 

(employee-related transactions) or in the time and attendance templates. 

A time and attendance template specifies the type of working hours (flextime, basic shift, break, 

and so on) that is applicable to individual time intervals during the day and which time account 

definitions are affected as a result. 

Time account definitions exist only as subelements of a group and, if modified, should be saved by 

saving the group. 
 

Processing instructions 

Please note also the information on processing instructions in Time account definitions (page 

853). 

To store instructions for processing SFDC transaction data, open Manufacturing, select the TIME 

master data folder and select Processing instructions. 

Calculation and clearing jobs are usually run at period-end closing and these can be automated by 

TIME. Even special daily clearings can be controlled in this way. In processing instructions, create 

typical transactions that you want to perform at the end of a statement period or at a specific point 

in time depending on the wage type (time accounts (see "Time account definitions" page 853)). 

Use the Processing instructions object to define in rules how and at what intervals new values are 

to be generated from the time accounts and in which time accounts the results are to be stored. 
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The condition and resulting action must be defined for each processing instruction. 

The grouping of processing instructions is an automatic consequence. A processing instruction 

must belong to a group of processing instructions. 

Load the time account group (see "Time account groups" page 851) for which you want to store 

the processing instruction and select a value from the Condition section. You can now edit an 

action in the Action field on the Validity tab. 

To open an editor for the instructions, select Functions and Processing instruction editor, or 

double-click the line. 

Action 

Action syntax is structured as follows: 

The entire statement after the command is always in parentheses. For wage types (time 

accounts), system accounts, and system variables, a "[Trigger]" must be inserted in front. 

Command([Trigger1]Statement,[Trigger2]Statement, ...) 

Acceptable triggers, commands and globally applicable variables can be found below in individual 

tables. 

The following table shows an example of an action. 

Condition Daily 

Action Limit([a]B,[a]310,200) 

Command: Limit 

Trigger: a 

Statement: B, 310, 200 (B = system account) 

Meaning Limit "Balance" (B) to "Time account 310" starting with the "200th hour" 

Trigger 

The following table shows the permitted triggers. 
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Trigger ("Switch") [a] for time account [Account] 

[t] temporary value (not saved) 

[s] sum of a time account 

[v] for system variable 

Commands 

The following table presents an overview of the applicable commands (see "Processing 

instructions - Commands" page 857). 

System accounts 

The following table shows the system accounts: 

Abbreviation German Meaning 

Ad Actual Actual time at the end of the day (attendance incl. breaks plus 

overtime) 

AS Balance Balance value at the end of the day = (Paid time minus planned 

time) plus balance from previous day 

GR Relevant to balance Time used for calculating the balance 

DB Daily bal. Balance value at the end of the day = (Paid time minus planned 

time) 

DOT Daily OvT (overtime) Overtime for the day (without previous day) 

AP Daily paid time  

HR Vacation Vacation balance in hours 

HD Vacation Vacation balance in days 

HED Vacation entitlement Vacation entitlement in days 

HEH Vacation entitlement Vacation entitlement in hours 

OT Overtime, OvT Overtime = (Actual minus planned) at the end of the day 

P Paid (NS = Normal shift) Paid time at the end of the day 

TD Planned Planned time for the day 

U1-U10 Unassigned system accounts  
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Processing instructions - Commands 

The following table shows the available processing instructions and their structure in detail. 

Explanation of table elements: 

 The Structure column shows how the action is structured in the processing editor, that is, the 

components that it comprises. 

 The Permitted triggers column specifies which triggers may or must be set for which 

component. [a] stands for time account, [s] for total account (total over the associated period) 

and [t] for temporary time account. 

 The Factor column specifies whether or not an additional multiplication or division is permitted 

for the respective parameter. 

 1) One of the given parameters must be specified here. 

 

Example: Application of factors for the Add instruction 

Add([a]10*2,[a]20,[a]30/60) 

Value 1 = Value from account 10, multiplied by 2 

Value 2 = Value from account 20 

Write to account 30: (Value 1 + Value 2)/60 

Add 

Explanation: Add Src1 and Src2 and write the result to Dest.  

Example: Add([a]100*3,[t]200/3,[a]400) 

Structure: Src1, Src1, Dest 

Permitted triggers: 

Src1: [a], [s], [v], [t] 

Src2: [a], [s], [v], [t] 

Dest: [a], [t] 1) 

Factor (*, /): 

Yes 

Yes 

Yes 
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CallSubGrp 

Explanation: Call to a subgroup 

Syntax: CallSubGrp('Subgroup ID') 

Any nesting level of subgroups is supported 

Corr_OVHC 

Explanation: This instruction allows you to correct overhead times automatically. 

The instruction expects a parameter that specifies the attendance time account. The value of this account is 

compared with the total order times and the overhead times for the day in question. If the attendance time is 

greater, the duration is assigned to an overhead account. If the attendance time is less, the duration is deducted 

from the overhead costs. 

An overhead cost rate must exist. 

Structure: Src 

Permitted trigger: Src: [a], [t] 1) 

Factor (*, /): No 

Get_Time 

Explanation: This instruction calculates a transaction time for the relevant employee on the day under review. 

Structure: 

DestGreg: The transaction time is displayed in Gregorian time. 11:10, for example, is output as 

1110 without formatting characters. 

DestMinutes: The transaction time is displayed in minutes. 11:10 for example, is output as 670 (11*60+10). 

LineConditionFound: 

This parameter is set as follows: 

0: If no transactions are found that meet the condition 

1: If a transaction was found that meets the condition 

SrcField: The following options (in inverted commas) are possible here: 

EventRec.PTTime, PTEventTime 

Sorting: Use asc or desc (in inverted commas) to specify whether the sort order should be 

ascending or descending – this is important for positioning. 

LineCondition: Transactions are listed in a particular sort order. The first transaction that meets the 

condition is selected. If no condition is specified, the first transaction is selected (with 'asc' sort 

order). 

Permitted triggers: 
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DestGreg: [a], [t] 1) 

DestMinutes: [a], [t] 1) 

LineConditionFound: [a], [t] 1) 

'SrcField': 

'Sorting': 

'LineCondition': 

Factor (*, /): 

No 

Yes 

No 

Div 

Explanation: Divide the values in Src1 and Src2 and write the result to Dest. 

Structure: See notes on Add instruction. 

Permitted triggers: See notes on Add instruction. 

Factor (*, /): See notes on Add instruction. 

If 

Explanation: You can use an If instruction to compare any number of values using And and Or operands. It is 

also possible to query a set of system variables. 

Example: 

If ((PersonNr In ('3%')) And ([a]100 > 30)) Then 

   Set(1,[a]10); 

Else_If ([a]200 > 30) Then 

   Set(1,[a]20); 

Else 

   Set(1,[a]30); 

End_If; 

Note: For the If instruction in particular, there is no need to use the [v] trigger in the case of 

system variables. This ensures optimized access to the system variables. 

Permitted triggers: [a], [s], [v], [t] 

Factor (*, /): Yes 
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Limit 

Explanation: The value of Src that exceeds Limit is added to the Dest account. The time in Src is 

set to Limit. 

Structure: Src, Dest, Limit 

Permitted triggers: 

Src: [a], [t] 1) 

Dest: [a], [t] 1) 

Limit: [a], [s], [v], [t] 

Factor (*, /): 

No 

No 

Yes 

Lj4 

Explanation: This instruction forms the interface for calling Lj4 methods (permits access to order times, for 

example). 

Syntax: Lj4('Lj4Method') 

Structure: ('Lj4Method') 

Max 

Explanation: Determine the maximum of Src1 and Src2 and write the result to Dest. 

Structure: See notes on Add instruction. 

Permitted triggers: See notes on Add instruction. 

Factor (*, /): See notes on Add instruction. 

Min 

Explanation: Determine the minimum of Src1 and Src2 and write the result to Dest. 

Structure: See notes on Add instruction. 

Permitted triggers: See notes on Add instruction. 

Factor (*, /): See notes on Add instruction. 
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Mul 

Explanation: Multiply the values in Src1 and Src2 and write the result to Dest. 

Structure: See notes on Add instruction. 

Permitted triggers: See notes on Add instruction. 

Factor (*, /): See notes on Add instruction. 

Reduce 

Explanation: 

If: 

Value of Scr1 >= Min and value of Src2 >= Min 

Then: 

   Determine reduction value = Minimum of Src1 and Src2 

   If reduction value > Max, then the reduction value is limited to  

   Max. 

   Deduct from Src1 reduction value and 

   Deduct from Src2 reduction value 

 

Structure: Src1, Src2, Min, Max 

Permitted triggers:  

Src1: [a], [t] 1) 

Src2: [a], [t] 1) 

Min: [a], [s], [v], [t] 

Max: [a], [s], [v], [t] 

Factor (*, /): 

No 

No 

Yes 

Yes 

Round 

Explanation: Round Src using rounding interval Interval according to Mode 

Evaluation only takes place if: 

Interval > 0 

Example: Round([a]100,15,1) 
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The value of account 100 is rounded to the next largest multiple of 15. 

Structure: Src, Interval, Mode 

 

Permitted triggers: 

Src: [a], [t] 1) 

Interval 

Mode: 

0 (Round down), 1 (Round up), 2 (Round to nearest) 

Factor (*, /): 

No 

No 

No 

 

Set 

Explanation: Sets a new value in an account 

Structure: Src, Dest 

Permitted triggers: 

Src: [a], [s], [v], [t] 

Dest: [a], [t] 1) 

Factor (*, /): 

Yes 

No 

Set_OTD 

Explanation: This function totals the duration field from relODCOTSum for the current employee 

and the TA day under review. The result is stored in Dest. Only those records that meet the 

SelectCondition are taken into account. 

SelectCondition must be formulated according to relODCOTSum view. 

Example: Set_OTD([a]10,'OTSum.AssignFlag=1 And OTSum.CostCenter=[v]CostCenter') 

Structure: Dest, 

'SelectCondition' 
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Permitted triggers: Dest: [a], [t] 1) 

Factor (*, /): Yes 

Set_OVHC 

Explanation: See also the Corr_OVHC instruction. 

 This command allows you to set the overhead times in the relevant TA account. 

This instruction writes the duration of the overhead costs (idle time) to the relevant overhead 

account. The overhead account is stored in the employee master. 

Shift 

Explanation: Carry forward from one account to another. Only applies if Src >= Min. The carry 

forward value is equal to the Src value but cannot be greater than the Max value. The carry forward 

value is deducted from Src and added to Dest. 

Structure: Src1, Dest, Min, Max 

Permitted triggers: 

Src: [a], [t] 1) 

Dest: [a], [t] 1) 

Min: [a], [s], [v], [t] 

Max: [a], [s], [v], [t] 

Factor (*, /): 

No 

No 

Yes 

Yes 

Sub 

Explanation: Subtract Src1 - Src2 and write to Dest.  

Structure: See notes on Add instruction. 

Permitted triggers: See notes on Add instruction. 

Factor (*, /): See notes on Add instruction. 
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Sum_OTField 

Explanation: Corresponds to a generalization of the Set_OTD command, as any numerical field from 

relODCOTSum can be totaled instead of the Duration field. 

Sample: Sum_OTField([a]10,'OTSum.Duration','AssignFlag=1 And OTSum.CostCenter='xy'') 

corresponds to the example formulated under Set_OTD. 

Structure: Dest, 'SrcField', 'SelectCondition' 

Permitted triggers: Dest: [a], [t] 1) 

Factor (*, /): Yes 

 
 

Access control 

For an overview of shop floor data collection (see "Shop floor data collection (SFDC)" page 839), 

see the corresponding topic. 

You define access rules between doors/door groups and employees/employee groups by 

selecting Access control in the Time master data folder in Manufacturing. If an employee is 

identified at a terminal (see "Terminals" page 917), a check is made as to whether rules have been 

defined for this employee or his/her group. If so, the rules are applied. 

For access control on public holidays, please see Define access control for public holidays (page 

867). 

 
 

Kaba Benzing access control 

In addition to TIME access control (page 864), TIME supports Kaba Benzing access control 

(Bedas 9290 access manager). The Bedas 9290 access manager can control up to 8 doors. An 

access reader (subterminal) must be installed at each door. 
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Technical note: Kaba Benzing installs the hardware and sets up the Kaba Benzing access 

manager. Doors are controlled using Kaba Benzing B-COMM WIN32 software. See the following 

graphic (GID = Group ID, DID = Device ID). 

 

 

Employee master data, public holidays, and access settings are set in TIME. 

You enable Kaba Benzing access control in the header form of Access control. 

Note the following points when using Kaba Benzing access control: 

1. On the Control access tab, assign an access profile to employees. Kaba Benzing access 

profiles are stored in the ODCPERSPROF allocation table. You can enter any profiles you 

need here. The table contains all valid access profiles. An employee can only be assigned to 

one of these profiles. 

Example: IT staff, management, cleaning staff 



866 | Infor COM 7.5 User Guide 

 

Manufacturing 

 

2. When using Kaba Benzing access control, you can differentiate between special day types 

(public holidays). Apply the required setting in the ODCSPDAYTYP allocation table. This table 

contains all existing special day types. You can store up to 9 types. 

Example: Public holidays, half-day vacations, bridge days. 

You can control access control behavior based on these special day types. 

3. You can now assign special day types to absences in the ODCABSENCE allocation table. You 

can then enter special days in the planning board by selecting Functions and Absences. The 

relevant date entries are then exported to Kaba Benzing access control (B-COMM WIN32). 

Door configuration 

Two types of door configuration are possible. 

Note: You can specify the type of access required using the 

COMMON.ODC.KABAACCESSLEVELISGLOBAL parameter in the configuration. 

 [1] Access to the doors is controlled by the access manager (Bedas 9290). This is the default 

setting. 

In door configuration 1, each subterminal (every door) which is controlled by the device 

manager is assigned to a fixed access authorization level, so subterminal 1 = access 

authorization level 1, subterminal 2 = access authorization level 2, and so on. Since a device 

manager can control up to 8 doors, a maximum of 8 access authorization levels can be 

assigned. 

 [2] Door access is controlled globally. 

In door configuration 2, areas or halls must be grouped into access authorization levels. 

In this case an access authorization level must be specified for each door. 

Please note: Only 1 – 16 access authorization levels are possible. 

Export 

Master data is exported to the Kaba Benzing B-COMM WIN32 software via download. To export 

the data, select Functions and Start download.  

The appropriate configuration of the SFDC server in the [KabaBenzingGateAccess] section is 

required for this download. The following settings must be defined: 

GateEntryAccessKABA=yes, ParameterPath (path for parameter files), OrderFilesPath (path for 

order files), PersonDataPath (path for employee master files), BComFilesPath (path for Kaba 

Benzing programs). 
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The paths must match those of the B-COMM WIN32 interface and refer to the same directories as 

the B-COMM WIN32 software and, if applicable, the computer name if B-COMM WIN32 is running 

on another computer. 

Please note: For the B-COMM WIN32 software to transmit the new master data to the access 

manager, the channel must be open. You can recognize this in B-COMM WIN32 by a check mark 

in front of the open channel. 
 

Define access control for public holidays 

Note: The steps described here apply similarly for other special day types (for example, vacation, 

illness). 

To define access control (page 864) for public holidays, complete the following steps: 

1. Store the definitions for calendar public holidays in the ODCBANKH allocation table. 

Please note: The ODCBANKH allocation table is not evaluated at doors that are controlled 

by Kaba Benzing access control. 

2. In the SDayType column, specify the type of special day for the respective public holiday. 

Note: The special day types are maintained in the ODCSPDAYTYP allocation table. 

3. In the ODCABSENCE allocation table, assign the required special day type to the planned 

absence. 

Example: The special day type S1 is assigned to the public holiday (PH). 

4. Select Manufacturing > TIME master data > Access control and define the access privileges 

for the special days for the respective employees in the Validity form section of the Access 

control tab. 

Example: If public holidays have the special day type S1, activate S1 for the employee to 

whom access is to be granted on a public holiday. 

If the system determines that the current day is a public holiday, access is only granted to the 

employee for whom the special day type for public holidays was activated in access control. 
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Example: May 1, which is stored as a public holiday in the system, falls on a Monday. 

Employee A has access on Mondays. However, this access privilege does not apply on 

special days. 

In order for this employee to also have access on special days such as May 1, the special 

day type assigned to May 1 must be activated for employee A in Access control. 

 
 

Access employee groups 

In the TIME master data folder in Manufacturing, select Access employee groups to define groups 

of employees for which you can then assign access authorizations for doors in Access control 

(page 864). 
 

TIME time & attendance 

The TIME time & attendance folder is in Manufacturing. Objects related to time and attendance 

are grouped together in this folder. 

 Employee-related order transactions are evaluated in the period overview (page 868). 

 The alarm overview (page 871) shows the transactions entered against alarm-relevant time 

accounts while the TA mailbox (page 871) lists error messages related to time and 

attendance. 

 You can plan absences and time and attendance templates in the planning board (page 872). 

 The employee status (page 874) returns status information on the individual employees. 

 Times that are relevant for the payroll are transferred via the wage link (page 874). 
 

Period overview 

Call 

Manufacturing > TIME order time > Period overview 
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Description 

The period overview is an evaluation of SFDC data. The period overview lists employee-related 

order transactions (only transactions with an employee ID card (see "Enter transactions with 

employee ID card" page 884)) and a period's time and attendance transactions (see "SFDC 

transactions" page 879). 

You can adjust values retroactively in the period overview. 

Functions 

Trace: You can start a trace log of processing instructions from the period overview by selecting 

Tools and Trace processing instructions. The log data is written to the default log file in your LOG 

directory. You can edit this file using the inforLogViewer.exe program and you can use the filter 

icon to filter for PinstTrace entries to view these entries. 

Note: This log should only be activated for a short period of time and only when required, since it 

significantly slows down the system. 

Adjustments: See Adjust time and attendance-related SFDC postings (page 870) 

Process adjustments: The system stores adjustment information when employee-related changes 

are made in the planning board. When the current calendar day is adjusted, the employee status is 

also adjusted. 

Select Functions and Process adjustments automatically to specify that processing instructions for 

a job are to be generated for time control in the event of adjustments. 
 

Daily overview 

Call 

Manufacturing > TIME order time > Period overview 

Select View and Daily overview. 
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Purpose 

The daily overview shows the events (see "Event table" page 915), the evaluated time accounts 

(see "Time account definitions" page 853) and the balances for an employee on a given day. 

Functions 

Select Hide deleted transactions to show or hide deleted transactions. 

Trace processing instructions: See Period overview (page 868) 
 

Adjust time and attendance-related SFDC postings 

Click here (see "Period overview" page 868) for general information on the period overview. 

In the period overview, you can display or adjust clock in and clock out transactions for an 

employee for an entire period. 

1. Select Manufacturing > TIME order time > Period overview. 

2. From the menu, select Functions and Adjustments. 

Note the color highlighting of the transactions in the Adjustments dialog box. 

Green The green highlighting indicates the saved SFDC transactions. 

Yellow Changes (adjusted, deleted and newly inserted SFDC transactions) 

are highlighted in yellow. 

Pink This color is an indicator before the reason for absence. It indicates 

that the absence displayed was inherited from the associated TA 

group or from the company. 

Blue Blue indicates that the reason for absence is vacation. 

rot Invalid transactions are displayed in red. 

Orange Values in orange in the TA date column indicate that there is an 

alarm trigger, for example, a basic shift violation. 

3. Make the required adjustments in the dialog box. 

Note: Use the check boxes after the clock in/clock out times to define whether the times are to 

be transferred as they are (1:1), that is, without time rounding and posting time. 
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4. Click Save to save the data. 

Note: A plausibility check is run before the data is saved. 

Please note: When inserting, modifying and deleting reasons for absence, the absence 

hierarchies and the Absence priority time account flag are checked. 

5. After the data has been saved, select Functions and Process adjustments to start the 

adjustment process in order to process the new transactions and absence entries. 
 

Alarm overview 

For general information on functions related to time and attendance in TIME, see TIME time & 

attendance (page 868). 

It contains all transactions entered against time accounts (see "Time account definitions" page 

853) with the Alarm and/or TA mailbox properties. 

Mailbox entries with the status 3 (follow-up), 4 (postponed), and 5 (received) are displayed. 

Note: To go to the mailbox, open the Go to menu and select TA mailbox. Open the Functions 

menu there and select Change status to change and save the mail status. 

Enter a date in Alarm overview to view a list of all employees for whom a time account definition 

(see "Time account definitions" page 853) with the Alarm attribute was used for this date or for 

whom the actual time as entered in Time and attendance differs from the order time total for the 

day. 

Note: Double-clicking a row or using the Go to menu allows you to go to the Daily overview (page 

869) where you can make adjustments. Corrections can then be processed in the alarm overview 

by selecting Functions and Process adjustments. 
 

TA mailbox 

For general information on functions related to time and attendance in TIME, see TIME time & 

attendance (page 868). 

To open the TA (time and attendance) mailbox, go to Manufacturing and open the TIME time & 

attendance folder or the TIME system folder. 
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The TA mailbox lists errors and general notes on SFDC processing (page 912). It applies only to 

time and attendance transactions. 

We recommend checking the mailbox every day. It contains warnings and reasons why 

adjustment processing or batch processes are canceled including the date and the employee ID of 

the relevant employee. It also contains additional information such as the expiration of vacation 

entitlement. 
 

Planning board 

For general information on functions related to time and attendance in TIME, see TIME time & 

attendance (page 868). 

To view the Annual overview, open the planning board. You can enter reasons for absence for 

individual days and print out the overviews. 

Absences and time and attendance templates can be planned for individual employees in the 

planning board. Provisions applied here take precedence over the validities defined in time and 

attendance templates (see "TA templates" page 848) using employee groups. 

For information on entering (half day) absences, see Enter absences in Planning board (see 

"Enter absences in the planning board" page 873). 

If only one employee is entered for this process, then the current absence days and the related 

reasons are listed in the annual overview. 

Functions 

The planning board offers the following functions. You can access each of them by selecting 

Functions in the open planning board. 
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Function Explanation 

Enter absences Note: This function is only available if the Absence planning - annual overview 

tab has been selected. 

You can enter specific absence times for the employee using this function. 

Enter time and attendance 

templates 

This function is only available if the TA templates tab has been selected. 

You can plan time and attendance templates for the employee using this function. 

Time and attendance 

template 

preview 

You can use this function to preview the time and attendance templates for the next 

30 days. The results from the preview are displayed without color in order to 

differentiate them from the planned templates. 

Note: You can set the preview limit using the 

COMMON.ODC.PTMODELPREVIEWLIMIT entry in the configuration. The default 

setting is 30 days. 

 

 
 

Enter absences in the planning board 

For information on the planning board (page 872), see the corresponding Help topic. To enter 

absences in the planning board, proceed as follows. 

1. In Manufacturing, open the TIME time & attendance folder and enter an employee ID. Click 

Load to open the planning board. 

2. Select the Absence planning - annual overview tab. Then select Functions and Enter 

absences. 

3. In the Enter absences dialog box, use the From and To columns to define the time interval for 

which you want to enter the absence. 

4. You can then use the relevant list box to select the Reason for absence to be entered for 

absence days. 

Note: To enter half-day absences, store them in the  ODCABSENCE allocation table with 

their own ID and description. You also need to select the check box in the HDays column of 

this table, and specify the basic absence in the Ref. to column. 
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Employee status 

For general information on functions related to time and attendance in TIME, see TIME time & 

attendance (page 868). 

For an overview of all employees, go to Manufacturing, open the TIME time & attendance folder, 

and select Employee status. The status of present employees is indicated as Present. 

In addition, absences are entered in Employee status using Batch TA processing (page 916). 
 

Wage link 

Infor COM does not contain any master data for payroll accounting, since this is handled by 

external systems. The times relevant to payroll accounting are transferred using link files. To 

activate the link, open Manufacturing, select the TIME time & attendance folder and then Wage 

link. Default settings for wage links are stored in the time account definitions (page 853). 

TIME and Infor Finance (or other payroll solutions) are linked using an ASCII file called PwBatchs. 

This file is created at the beginning of a new statement period for the previous accounting period 

from TIME. The Infor Finance file can then be read. 

The ODC.PTAbsenceLink.Batch.Varial.al_Exec time-controlled process is available for exporting 

the absences for all active employees for the current month. 

To link the date, proceed as follows: 

1. Enter the settings in the COMMON.ODCLINK section of the configuration. 

Varial example: 

 PTLINKNAME=Varial 

 PTLINKFILENAME=PWBATCHS.txt 

P&I example: 

 PTLINKNAME=PandI 

 PTLINKFILENAME=IMPVAR1.csv 

Global settings: 



Infor COM 7.5 User Guide | 875 

 

Manufacturing 

 

 PTLINKABSENCEFILENAME=PWSYMBOL.txt (name of the file to which the absence 

data is written) 

Note: You can start the export using Batch control. The 

ODC.PTAbsenceLink.Batch.Varial.al_Exec action exports all absences for all active 

employees for the current month. 

 PTLINKPATH=\\server4711\personal\Kopplung (example) 

(Path to the folder where the link file is to be written) 

 PTLINKABSENCECOMPANY=002 (default company for exporting absence data) 

 PTLINKWRITECOSTCENTER=yes 

Specifies that the cost center is also transferred during the wage link 

2. Open Wage link in the TIME time & attendance folder in Manufacturing. Help on the fields in 

the dialog boxes is available in the context-sensitive Help. 
 

Access journal 

In addition to controlling the doors, Access control (page 864) is responsible for logging the access 

data that occurs so that this can be made available for inspection purposes. 

For this purpose, the access journal displays the entered access data in an overview. This 

overview covers both TIME and Kaba Benzing access control. 

Both successful and unsuccessful access attempts are entered. 

 

Technical notes on saving access data 

TIME access control Kaba Benzing access control 

The data is sent from the terminals to the 

SFDC server (page 840). 

When the Kaba Benzing event file 

(BOOKING.DAT) is being imported, the 

access data is imported from the SFDC 

server (page 840). 

The SFDC server is used to save the access data to the relODCGAccJour table. 
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Reports (TIME) 

To print reports in TIME, open the TIME time & attendance folder or the TIME order time folder in 

Manufacturing and click Reports. 

The Report overview dialog box contains the following reports. 

Note: You can influence the displayed lists by assigning user privileges. 
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Report Description 

Record of absence - 

Annual overview 

The absence overview shows the absences of a selected employee/employee group 

with months and days over an entire year. The absences are displayed with the 

abbreviations provided under Reason for absence in the time account properties - see 

also the Absences/evaluation tab in the time account definitions. 

The header line shows the vacation time available, the vacation time already taken, 

and the remaining vacation time. 

Record of absence - 

Monthly overview 

The monthly overview shows all absences of selected employees in a particular 

month. 

Alarm list This report shows all time accounts that have the attribute Alarm in the Properties 

tab. 

Alarm list throughout  

period 

This report shows all time accounts for a selected period that have the Alarm time 

account property. 

Attendance list This report displays the attendance list with regard to attendance and absence. 

Operations report  

Operations report - 

Period 

 

Work center analysis by 

order transactions 

This report shows how many actual hours have accumulated according to the order 

transactions. Moreover, a distinction is made between the number of productive hours 

and the number of hours accumulated during Setup or Disruption. The report 

provides the times as well as the proportionate weightings. 

Order times by 

operation, day, and 

employee 

This report shows the Planned quantities as well as the Planned time for 

manufacturing (divided according to Operation, Day, and Employee). The 

transaction quantity and transaction time are determined based on feedback. 

The variance and working hours per unit are then displayed. 

Employee order time 

analysis 

This analysis calculates the net time actually worked by the employee. The number of 

hours the employee was present and the number of hours of attendance entered as 

Orders or as Disruption allows you to calculate the employee’s productivity. 

Planned absences The totals of all absences are shown in this report. Absences are listed in detail. 

Flextime check list  

Employee - Time 

monitoring 

 

Monthly report per 

employee 

 

Monthly figures - 

Project/FID/employee  

 

Period report by projects  

Period figures -  
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Report Description 

Project/FID/employee 

Time and attendance 

template planning 

The Time and attendance template planning report shows the effects of the 

planned time and attendance template on individual months and days for a selected 

employee for a year. 

Employee status by 

department 

This report shows the date and time of the beginning of the attendance and absence 

times for selected employees, sorted by home department. 

Employee status by 

cost center 

This report shows the date and time of the beginning of the attendance and absence 

times for selected employees, sorted by master cost center. 

Employee overview This report shows individual employees and their allocation to an employee group, 

home department, and master cost center. This information is stored in the 

employee master data. 

Productivity overview - 

Employee per year 

 

TA/OT and OH  

differences 

For this analysis, in the dialog box select from which TA/Order time difference in 

minutes and from which elapsed time a transaction against overhead costs will be 

entered. This will allow the differences between the time and attendance (TA) and 

order time (OT) selected and the overhead costs to become apparent. The 

employee’s productivity and the hours entered against Disruption are also calculated. 

Balance list Depending on the selection, the balance in hours, vacation days, planned 
hours, actual hours, paid hours, and overtime are calculated. Totals are 

created. 

Balance list by 

department 

Depending on the selection, the balance of hours, vacation days, planned hours, 

actual hours, paid hours, and overtime are calculated and the totals are created. They 

are sorted by department. 

Balance list by 

cost center 

Depending on the selection, the balance of hours, vacation days, planned hours, 

actual hours, paid hours, and overtime are calculated and the totals are created. They 

are sorted by cost center. 

Daily overview All transactions for the day and the resulting hours entered against time accounts by 

means of time and attendance templates are shown in the daily overview. 

Hours worked overview  

Time and attendance This report summarizes the times required for payroll accounting. The Daily 

balance, Balance, Paid, and OvT (overtime) are calculated per day based on 

planned/actual times and vacation days. 

Time accounts entered depending on time and attendance are displayed. 

As a result, totals are created and final accounts calculated. The final accounts can 

contain the hours required for the transmission of payroll data. 

Time card A time card is a punch card. Balance, Paid, and OvT (overtime) are calculated daily 

based on the planned and actual hours and vacation days depending on time and 

attendance. The report shows the result of the total as well as the credit at the 
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Report Description 

beginning and end of the month. The final accounts can contain the hours required for 

transmitting payroll data. 

Time account overview The time account overview provides a display of all time accounts in all time account 

groups. The overview shows how many hours and days have been entered against 

the time accounts. 

Time account overview 

by department 

The time account overview by department shows all time accounts that have been 

entered in a particular department. The overview shows how many hours and days 

have been entered against the time accounts. 

Time account overview 

by cost center 

The time account overview by department shows all time accounts that have been 

entered in a particular cost center. The overview shows how many hours and days 

have been entered against the time accounts. 

Time account overview 

by cost center and 

employee 

This report shows an overview of time accounts entered against a particular cost 

center. The time accounts are listed by employee. The number of hours and days 

entered against the time accounts is shown. 

Time account overview 

by employee 

The time account overview by employee shows all time accounts in all time account 

groups, according to employee. The overview shows how many hours and days have 

been entered against the time accounts. 

 
 

TIME order time 

For general information on TIME, see TIME basics (page 837). 

 In addition to entering time and attendance transactions, you can also use the SFDC 
transactions (page 879) object to enter order transactions (page 907). 

 SFDC transactions can also be posted with a time delay. The Delayed transactions (see 

"Delayed transactions (SFDC)" page 905) object is available for this. 

 The order status (page 907) is used to control the assignment of employees to orders. 

 A log of all transactions is available in the SFDC journal (page 909). 
 

SFDC transactions 

For general information on functions related to order time in TIME, see TIME order time (page 

879). 
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Use the SFDC transactions object to enter SFDC transactions (see "Shop floor data collection 

(SFDC)" page 839) for employees. You enter the SFDC transactions in Manufacturing by selecting 

the TIME order time folder and clicking SFDC transactions. 

Transactions can be either in real time (see "Real-time transactions" page 880) or delayed (see 

"Delayed transactions (SFDC)" page 905). 

A distinction is made between Time and attendance transactions and Order time transactions. 

Time and attendance transactions are employee-related transactions such as Clock in and Clock 

out transactions. See Employee group 1 transactions (page 884). These transactions are used 

exclusively by clerical staff, for example. 

Order time transactions are all order-related transactions. See the Employee group 2 transactions 

without multiple machine operation (page 886) and Employee group 2 transactions with multiple 

machine operation (page 891) Help topics. 

Note: If ODCModus=1 is set in the configuration, it is, in principle, not possible to enter SFDC 

transactions for the employee only. Each posting affects the employee and the operation.  

If you still want to be able to enter transactions for the employee only, even though this parameter 

is set, enter 1 in the Post employee only combo box on the Order time privileges tab for the 

employee/employee group. 

SFDC transactions also include the entering of milestone lines (see "SFDC transactions and 

milestones" page 896). 
 

Real-time transactions 

For general information on SFDC transactions (page 879), see the corresponding Help topic. 

There are basically two modes in which you can enter order transactions in SFDC (see "SFDC 

transactions" page 879) in real time, that is, with or without employee identification. The term 

employee identification simply means that the possibility of personal identification exists. As a rule 

this would involve transponders or ID cards. 

 Mode 1: Enter transactions without employee identification (see "Enter transactions with 
employee ID card" page 884) (for operations that do not require transactions related to 

employees). 

 Mode 2: Enter transactions without employee identification (see "Enter transactions without 
employee ID card" page 881). 
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Please note: The distinction is made during installation using the COMMON.ODC.ODCMODUS 

setting in the configuration. It is not possible to work in both modes at the same time. 
 

Enter transactions without employee ID card 

For general information on real-time transactions in TIME, see the Transaction types section in 

Shop floor data collection (see "Shop floor data collection (SFDC)" page 839). 

When entering transactions without an employee ID card, only order time transactions can be 

submitted. Group work and multiple machine operation are not possible in this mode. 

The following transactions are permitted: 

Start operation (OP) 

Meaning: Operation is started 

Prerequisites: Operation must exist and be released or interrupted. 

Action: Operation ID 

Result: Operation status is set to In progress (if previous status was Released). 

Internal transaction: The operation is stored with the start time in an internal table (event table (see 

"Event table" page 915)). 

Operation partially complete 

Meaning: Quantities and times are entered against the operation. 

Prerequisites: Operation must exist and status must be In progress. 

Action: Operation ID, quantity (if applicable), duration, etc. 

Result: The status of the operation is set to In progress. The start time for the calculation of the 

duration is set to the time entered. 

Internal transaction: The operation is stored in the event table with the values entered. 
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Interrupt operation 

Meaning: Operation is interrupted. 

Prerequisites: Operation must exist and status must be In progress. 

Action: Operation ID, quantity (if applicable), duration, etc. 

Result: Operation status is set to Interrupted. 

Internal transaction : The operation is saved in the event table with the time of interruption and the 

information entered. 

End operation 

Meaning: Operation is ended. 

Prerequisites: Operation must exist and status must be In progress. 

Action: Operation ID, quantity (if applicable), duration, etc. 

Result: No more transactions can be entered against this operation. 

Internal transaction : The operation is saved in the event table with the end time and the 

information entered. 

Start setup OP 

Meaning: Setup is started for this operation. 

Prerequisites: Operation must exist and be released. 

Action: Operation ID 

Result: Operation status is set to Setup. Operation start time is stored in the status table. 

Internal transaction: The operation is saved in the event table with the start time and the values 

entered. 

Setup operation partially complete 

Meaning: Quantities and times are entered for this operation. 

Prerequisites: Operation must exist and status must be Setup. 
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Action: Operation ID, quantity (if applicable), duration, etc. 

Result: Operation status remains unchanged; start time of the entered operation is replaced by the 

entered time. 

Internal transaction: The operation is stored in the event table with the values entered. 

End setup operation 

Meaning: Setup is ended for this operation. 

Prerequisites: Operation must exist and status must be Setup. 

Action: Operation ID, quantity (if applicable), duration, etc., indicates whether operation will be 

processed further. 

Result: Operation status is set to Interrupted or In progress. 

Internal transaction: The operation is saved in the event table with the end time of the setup and 

the information entered. 

Start reason for disruption 

Meaning: Start of disruption of an operation 

Prerequisites: Operation must exist and status must be In progress. 

Action: Operation ID, quantity (if applicable), duration and additional information on the time 

interval prior to the start of the disruption. 

Result: Operation status is set to Disruption. 

Internal transaction: The operation is saved in the event table with the start time of the disruption 

and the information entered. 

End reason for disruption 

Meaning: End of disruption of an operation 

Prerequisites: Operation must exist and status must be Disruption. 

Action: Operation ID, indication of whether operation should be continued or interrupted. 

Result: Operation status is set to In progress or Interrupted. 
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Internal transaction: The operation is stored in the event table with the disruption end time. 

Order information 

Meaning: Information about the order can be displayed. 

Prerequisites: Operation must exist and be available for posting. 

Action: Operation ID 

Result: Basic operation data is displayed, such as order texts, status, etc. 

Internal transaction: None 

 
 

Enter transactions with employee ID card 

For general information on real-time transactions in TIME, see the Transaction types section in 

Shop floor data collection (see "Shop floor data collection (SFDC)" page 839). 

There are two types of employee groups and they can submit different types of transactions. 

 Employees who can submit only time and attendance transactions – employee group 1 

(clerical staff) 

 Employees who can submit time and attendance transactions and order time transactions – 

employee group 2 (manual workers) 

For both groups, transactions are only accepted after the employee has been identified using the 

ID card. The ID card includes the employee’s ID. 

Note: Duration that is entered manually generally takes precedence over duration that is 

calculated by the system. If a duration is entered manually for an order transaction, this duration is 

used for processing. 
 

Employee group 1 transactions 

The following transactions apply for employee group 1. Only the Clock in and Clock out 

transactions are actual time and attendance transactions. 
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Clock in 

Meaning: Employee arrives on the shop floor. 

Prerequisites: Employee must be created and have a valid ID card. Status must be Absent. 

Action: Identification by ID card 

Result: Employee’s time and attendance template is determined. If it contains a basic shift check, 

the system checks for a basic shift violation.  If the basic shift is violated, a reason must be 

entered. 

Internal transaction: The ID card ID, time, and reason for the basic shift violation (if applicable) are 

entered in the event table. 

Clock out 

Meaning: Employee leaves the shop floor. 

Prerequisites: Employee must be created and have a valid ID card. 

Action: Identification by ID card 

Result: Employee’s time and attendance template is determined. If it contains a basic shift check, 

the system checks for a basic shift violation.  If the basic shift is violated, a reason must be 

entered. 

Internal transaction: The ID card ID, time, and reason for the basic shift violation (if applicable) are 

entered in the event table. 

 

The following two transactions are not actual transactions, but provide additional information about 

the data entered or displayed. 

Reason for absence 

Meaning: Employee leaves the shop floor and provides a reason for absence. 

Prerequisites: Employee must be created and have a valid ID card. Status must be Present. 
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Action: Employee presses the Reasons for absence key and identifies themselves using the ID 

card. Employee then selects a reason for absence from the list. 

Result: The employee status table records that the employee is leaving due to the reason for 

absence provided. 

Internal transaction: The ID card ID and time the employee leaves are entered in the event table. 

Employee details 

Meaning: Displays information on the employee. 

Prerequisites: Employee must be created and have a valid ID card. 

Action: Identification by ID card at the terminal 

Result: Basic employee data is displayed, such as presence since, number of vacation days left, 

etc. 

Internal transaction: Transaction in the event table 

 

 
 

Employee group 2 transactions without multiple machine operation 

The following transactions apply to Employee group 2. 

A distinction is made between transactions for employees without multiple machine operation and 

with multiple machine operation. 

The following table shows the transactions for employees not working in multiple machine 

operation mode. The first two transactions are time and attendance transactions. 

Clock in 

Explanation: Employee enters shop floor. 

Prerequisites: Employee must be created and have a valid ID card. The employee’s status must 

be Absent, or the daily employee table should not contain any entries.  

Action: Identification by ID card at the terminal. 
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Result: The employee’s time and attendance template is determined. If it contains a basic shift 

violation test, the system checks whether the basic shift has been violated. The operation to which 

the employee was assigned at the time of their last clock-out transaction is started. If the operation 

has ended in the interim, the employee is assigned to the overhead costs time account. 

Internal transaction: The ID card ID, time, and reason for the basic shift violation (if applicable) are 

entered in the event table. 

A record with relevant information is stored for the order to which the employee is assigned. 

Clock out 

Meaning: Employee leaves the shop floor. 

Prerequisites: Employee must be created and have a valid ID card. The employee's status must 

be Present. 

Action: Identification by ID card at the terminal. 

Result: The employee’s time and attendance template is determined. If it contains a basic shift 

check, the system checks for a basic shift violation. If the basic shift is violated, the employee must 

enter a reason. 

Internal transaction: The ID card ID, time, and reason for the basic shift violation (if applicable) are 

entered in the event table. An Interrupted record with the relevant information is stored for the 

order to which the employee is assigned. 

 

The following two transactions are not actual transactions, but provide additional information about 

the data entered or displayed. 

Reason for absence 

Meaning: Employee leaves the shop floor and provides a reason for absence. 

Prerequisites: Employee must be created and have a valid ID card. The employee's status must 

be Present. 

Action: Employee presses the Reason for absence button, identifies themselves using the ID card, 

and selects the reason for the absence. 
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Result: The operation to which the employee is still assigned is interrupted automatically, and the 

quantity is queried. 

Internal transaction: The ID card ID, time, and reason for the basic shift violation (if applicable) are 

entered in the event table. An Interrupted record with the relevant information is stored for the 

order to which the employee is assigned. 

Employee details 

See Employee group 1 transactions (page 884) 

 

The following transactions are order time transactions. 

 

Start Op 

Meaning: Operation is started or employees are started on this operation (for group work) 

Prerequisites: Operation must exist and be released. 

Action: Employee identifies themselves using ID card and selects a new operation and 

corresponding operation ID. 

Result: Employee is assigned to the operation. The allocation and start time are stored in the 

allocation table. This table shows the allocation or link between an employee and an operation for 

each record. 

Internal transaction: For the started operation, the ID card ID, operation, and all information 

relevant to the operation are stored in the event table. 

Operation partially complete 

Meaning: Quantities and times are entered against the operation. 

Requirements: The operation must exist and must be in progress or partially complete. The 

employee submitting the transaction must be assigned to the operation. 

Action: Employee identifies themselves at the terminal using their ID card and selects Operation 

partially complete. 



Infor COM 7.5 User Guide | 889 

 

Manufacturing 

 

Result: The start time of the operation is replaced by the time entered. 

Internal transaction: The operation is stored in the event table with the values entered. 

Interrupt operation 

Meaning: The employee’s work on this operation is interrupted. 

Prerequisites: Operation must exist and be In progress. 

Action: Employee identifies themselves at the terminal using their ID card and selects Interrupt 

operation. 

Result: The operation status is set to Interrupted if no other employee has been assigned to this 

operation. 

Internal transaction: The ID card ID and operation with the interruption time, etc. are stored in the 

event table. 

End operation 

Meaning: Operation is ended. 

Prerequisites: Operation must exist and be In progress. 

Action: Employee identifies themselves at the terminal using their ID card, selects End operation 

Result: No further transactions can be entered against this operation. The operation status is set 

to Complete. 

Internal transaction: An interrupt transaction with the quantity, working hours duration, and 

information relevant to the operation is stored. Interrupt transactions for all employees assigned to 

the operation are then stored and, if applicable, assigned to the corresponding overhead time 

accounts. The operation, operation end time, and entered data are stored as the last transaction. 

Start setup OP 

Meaning: Setup is started for this operation. 

Prerequisites: Operation must exist and be released for clocking transactions. 
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Action: Employee identifies themselves at the terminal using their ID card and selects Start 

operation setup. 

Result: The operation status is set to Setup. The employee is assigned to this operation. 

Internal transaction: The ID card ID and operation are stored in the event table with the start time 

and the values entered. 

Setup operation partially complete 

Meaning: Quantities and times are entered for this operation. 

Prerequisites: Operation must exist and operation status must be Setup. 

Action: Employee identifies themselves at the terminal using their ID card and selects Setup 

operation partially complete 

Result: The operation status does not change. 

Internal transaction: The ID card ID and operation are stored in the event table along with the 

values entered. 

End setup operation 

Meaning: Setup is ended for this operation 

Prerequisites: Operation must exist and the operation status must be Setup or In progress. 

Action: Employee identifies themselves at the terminal using their ID card, selects End setup 

operation, indicates whether work is to continue on the operation. 

Result: Operation status is set to Interrupted or In progress. 

Internal transaction: The ID card and operation are stored in the event table with the setup end 

time and the entered information. If the operation is interrupted, the employee may be assigned to 

the overhead time account. 

Start reason for disruption 

Meaning: Start of operation disruption 

Prerequisites: Operation must exist and operation status must be In progress. 
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Action: Employee identifies themselves at the terminal using their ID card, selects Start disruption, 

enters Reason for disruption, etc.  

Result: Operation status is set to Disruption. 

Internal transaction: The ID card and operation are stored in the event table with the start time and 

entered information. 

End reason for disruption 

Meaning: The end of the reason for disruption of an operation 

Prerequisites: Operation must exist and operation status must be Disruption. 

Action: Employee identifies themselves at the terminal using their ID card and selects End 

disruption. Indicates whether work is to continue on the operation. 

Result: The operation status is set to In progress or Interrupted. The duration of the disruption is 

entered against the operation in a separate field. 

Internal transaction: The ID card ID and operation are stored in the event table along with the end 

time. 

 

The following transaction provides additional information on the order. 

Order information 

Meaning: Displays information about the order. 

Prerequisites: Operation must exist and it must be possible to enter transactions for it. 

Action: Employee identifies themselves at the terminal using their ID card, selects Order info. 

Result: Basic employee and operation data is displayed. 

Example: ID card, assigned since, etc. 

Internal transaction: Transaction in the event table 
 

Employee group 2 transactions with multiple machine operation 

The following table shows transactions for employees with multiple machine operation. 
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Clock in 

See Employee group 2 transactions without multiple machine operation (page 886) 

Clock out 

See Employee group 2 transactions without multiple machine operation (page 886) 

 

The following two transactions are not actual transactions, but provide additional information about 

the data entered or displayed. 

Reason for absence 

Meaning: Employee leaves the shop floor and provides a reason for absence. 

Prerequisites: Employee must be created and have a valid ID card. The employee's status must 

be Present. 

Action: Employee presses the Reason for absence button, identifies themselves using their ID 

card, and selects the reason for absence 

Result: All operations to which the employee is still assigned are interrupted. 

Internal transaction: The ID card ID, time, user-defined fields, and reason for a basic shift violation 

(if applicable) are entered in the event table. An Interrupted record is stored with relevant 

information for every order to which the employee is assigned. 

Employee details 

See Employee group 1 transactions (page 884) 

 

 

The following transactions are order time transactions. 
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Start Op 

See Employee group 2 transactions without multiple machine operation (page 886) 

Operation partially complete 

See Employee group 2 transactions without multiple machine operation (page 886) 

Interrupt operation 

See Employee group 2 transactions without multiple machine operation (page 886) 

End operation 

Meaning: Operation is ended. 

Prerequisites: Operation must exist and be In progress. 

Action: Employee identifies themselves at the terminal using their ID card, selects End operation 

Result: No further transactions can be entered against this operation. The operation’s status is set 

to Complete. The status of all employees entered for this operation is set to Interrupted. 

Internal transaction: An interrupt transaction is saved with the quantity, working hours duration, 

and information relevant to the operation. Interrupt transactions are then stored for all employees 

assigned to the operation and, if applicable, assigned to overhead time accounts. The operation, 

operation end time, and entered information are stored as the last transaction. 

Start setup OP 

See Employee group 2 transactions without multiple machine operation (page 886) 

Setup operation partially complete 

See Employee group 2 transactions without multiple machine operation (page 886) 

End setup operation 

See Employee group 2 transactions without multiple machine operation (page 886) 
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Start reason for disruption 

See Employee group 2 transactions without multiple machine operation (page 886) 

End reason for disruption 

See Employee group 2 transactions without multiple machine operation (page 886) 

Arrange grouped operations at the terminals 

Meaning: Operations can also be grouped at the terminal where transactions are entered. 

Prerequisites: The operations must exist and it must be possible to enter transactions for them. 

Employees must have the necessary privileges. 

Action: Employee identifies themselves at the terminal using their ID card, selects grouped 

operations, enters the IDs of the operations and closes the group. 

Result: All grouped operations are identified via a unique ID. 

Internal transaction: Transaction in the event table with the IDs of the relevant operations. 

Submitting transactions for grouped operations 

Meaning: Transactions that can be stored for grouped operations correspond to the transactions 

for individual operations. If a transaction is entered against a grouped operation, the quantity and 

duration calculated are distributed to all operations. The method of distribution is either 

proportional to the outstanding quantities in the operation or an even distribution as defined in the 

configuration setting. 

 

 

The following transaction provides additional information on the order. 

Order information 

See Employee group 2 transactions without multiple machine operation (page 886) 
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Grouped operations are operations that have the same grouped operation ID (unique ID in the OP 

data record). Each transaction entered against one of these operations changes the status for all 

grouped operations with the same ID. See also SFDC processing and Create grouped operations 

(Work center account). 
 

Transactions for unplanned operations 

For general notes on transactions using employee ID cards, see Enter transactions with employee 

ID cards (see "Enter transactions with employee ID card" page 884). 

transactions can be entered at the SFDC terminals used to create unplanned operations (see also 

Unplanned subcontracted manufacturing in Subcontracted manufacturing (page 827)). 

Prerequisites: Only new operations can be added to existing orders. The employee must have a 

valid ID card and the necessary privileges to create unplanned operations. 

Action: Employee identifies themselves at the terminal using their ID card, selects operation to 

which they are assigned, selects the Unplanned operation function and enters the ID of the order 

and the operation. 

Result: An operation with the status Released is created for the order. The feedback ID of the 

newly inserted operation is displayed on the screen. 

Internal transaction: The information entered is reported in the event table. 

 
 

Tool transactions 

For general information on SFDC transactions (page 879), see the corresponding Help topic. 

For the SFDC transaction, the produced quantity can be reported using a machine counter than 

can be activated on the UOM/size management tab in Design > Work centers. 

The possibility of posting according to the machine counter, which is attached to the machine and 

reset at the end transaction, gives the SFDC transactions an extra dimension in that the counter 

reading can be entered (MDC transaction) instead of the accepted quantity. 
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For this purpose, the count mode from the work center is preset in the Order transactions form in 

TIME. The relevant options for the machine counter are in the section of the same name in the 

work center. 

Machine counter 

Note: This form section requires the COMMON.ODC.BOOKINGWITHMACHINECOUNTER=yes 

parameter to be set in the configuration. 

Counter 

This field shows the reading of the counter attached to the machine for the MDC transaction. 

Count mode 

The count mode specifies whether the counter reading takes the number of cavities into account. 

 Without machine counter: When you enable this option, the produced quantity or the rejects 

are entered. 

 Machine counter = Rate of shots * Number of cavities 

With this option, the accepted quantity is calculated according to the following formula: 

 

New counter reading - Old counter reading - Rejects counter 

 

In this case, the rejects correspond to the reading from the rejects counter. 

 Machine counter = Rate of shots 

With this option, the accepted quantity is calculated according to the following formula: 

 

(New counter reading - Old counter reading - Rejects counter) * Number of cavities 

 

Note: The rejects are calculated according to the following formula:  

 

Rejects counter * Number of cavities 

 

With this option, you can change the Number of cavities factor. 

 
 

SFDC transactions and milestones 

For general information on SFDC transactions (page 879), see the corresponding Help topic. 
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This Help topic provides you with an overview of the various uses of milestones and associated 

relevant information. One example for the use of milestones can be found in the More efficient 

transactions using milestones Help topic. 

 Milestones enable you to enter several lines of a production order in one SFDC transaction. 

This is achieved by defining a line as a milestone and declaring the other lines as dependent 

on this milestone. Selecting the milestone allows you to define whether the dependent lines 

are entered with the start or end transaction of the milestone for instance. 

Notes: 

 You can declare both operations and material lines as dependent lines. In principle there 

are no limitations in this respect. 

 If the milestone is an operation, then both operations and material lines can be defined as 

dependent lines. 

 You can set a milestone for the header record, in other words the product to be manufactured 

(on the Order data tab of the Order header view) and for any production order line on the 

Print/post tab of the production order. Only one milestone per order is permitted. If a milestone 

setting is to apply to every order of a resource to be produced, the milestone must be defined 

on the Print/post tab of the BOR. If you then generate a production order from the BOR, these 

settings are transferred. 

Note: If you set the milestone for the header record (the product to be manufactured) in the 

Order header view of the production order (Transaction status section), all dependent lines are 

entered together when an inventory receipt transaction takes place for the header record. In 

this case you have the option of closing the production order with all lines by entering an 

inventory receipt for the finished product from the open production order by selecting 

Functions and Inventory transaction. 

 Once you have released a production order, you can enter SFDC transactions (page 879) for 

the order lines. As a rule, the planned quantity is automatically inserted if you do not enter an 

amount when entering the lines. The planned quantity is the quantity corresponding to the 

production order specifications. If variances have occurred, you can enter the actual quantity 

(that is, the quantity actually used) in the Transaction quantity field when entering the SFDC 

transaction. If you enter an actual quantity that differs from the planned quantity, a variance 

occurs, which affects not just milestones, but also the lines depending on the milestones. 

Dependent lines in this case are calculated proportionately according to the planned/actual 

ratio. 

 When releasing a production order that contains a milestone structure, the following problem 

may occur: 

You want the materials issue to occur at the same time as the release, but you also want a 

material line to be entered at the end transaction for the associated milestone only. In this 

case, the system needs to know which of the competing sets of information on the material 

issue takes precedence. In order to resolve the conflict, you must use the 

COMMON.LEITSTAND.MSKNZFREIGABEENTNAHME parameter in the configuration to determine the 

milestone flags for which you want materials to be issued at the point of release. All milestone 

flags not included in the parameter retain their validity, so that the dependent lines can be 

entered according to their milestone flag and not automatically at the time of release. 

Examples: 
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 COMMON.LEITSTAND.MSKNZFREIGABEENTNAHME=[*] 

All dependent material records are entered at the time of release (according to the default 

setting). 

 COMMON.LEITSTAND.MSKNZFREIGABEENTNAHME=[3;4] 

Only the dependent lines with the milestone flags 3 and 4 are entered at release. 

Note: In the standard version, a material issue occurs for all material lines at release, 

which means you must clear the Material issue check box when using milestones. 

 If you release a production order with milestone lines and use SFDC transactions for this 

order, you normally cannot enter transactions for dependent lines. One exception allows you 

to carry out inventory transactions for dependent material lines. Select Functions and 

Inventory transaction and select the Inventory tab to carry out inventory transactions for the 

header record (the finished product) and all lines (even the dependent ones). If you 

subsequently select Data and Close twice, you can check the effects of your transactions in 

the Status column on the Production order status tab of the production order. 
 

More efficient transactions using milestones 

In the case of production orders with a lot of lines, it would be extremely time-consuming to submit 

several transactions for every single line. We therefore recommend using milestones. 

The example below shows how to work with milestones. 

Note: This example works solely with industrial time. See the Time calculation (page 818) Help 

topic. 

Please note: To post SFDC transactions in real time, SFDC processing (page 912) must be 

running on the server. 

1. First, define the milestone lines in the BOR. 

The following table contains a section from the Print/post tab of the BOR for resource 

965-2134. 
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SVO Resource MS MSG 

OP 2070 1 1 

OP 5010 2 1 

OP 8310 3 1 

OP 8362 4 1 

OP 8368 5 1 

OP 8410 2 1 

MA 601-0009 0 0 

2. Six operations and one material line are specified for the product you want to manufacture. 

While the material line (since it has the milestone group (MSG) 0) must be entered separately, 

the remaining lines are assigned to a milestone group. Resource 2070 is defined as a 

milestone (milestone flag 1), and the remaining operations are characterized as dependent 

lines and are therefore included on the milestone line during the SFDC transaction. The 

milestone flag (MS) determines how you want the transaction to occur. You can control the 

settings of the milestone flags on the Order data tab of the production order. There is a 

milestone flag for the finished product as well as for the manufacturing lines. Help on this is 

available in the Transaction status section in Order data. 

3. Now, create a production order for 10 units of the resource 965-2134 based on the BOR 

shown in step 1 (see also Create production order from BOR (see "Generate production order 

from BOR" page 920)). You will find the milestone information from the BOR on the Print/post 

tab. 

4. After the production order is created, it has the status Scheduled. To enter an SFDC 

transaction for the production order, select Functions and Release to release the production 

order. When the production order is released, the feedback IDs are automatically entered on 

the Other tab. These feedback IDs can then be used for SFDC transactions. 

5. Close the production order. In Manufacturing, open the TIME order time folder and select 

SFDC transactions to open the transaction form. Enter the ID card ID of an employee and 

select Start operation. The transaction form is displayed. Enter the feedback ID of the 

operation mentioned in step 4. You can now enter the data. Close the transaction form and 

return to the production order. 
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On the Production order status tab, you will see the following table with an additional MS 

column from the Print/post tab. 

SVO Resource Status MS 

OP 2070 In progress 1 

OP 5010 Completed 2 

OP 8310 Completed 3 

OP 8362 Released 4 

OP 8368 In progress 5 

OP 8410 Completed 2 

OP 601-0009 Released 0 

6. The current processing status of the order, as can be seen from the table, means the following: 

The milestone (resource 2070) is still In progress (as a result of the Start transaction), and 

operations 5010 and 8310 are already completed. This status is due to the milestone lines of 

the resources. In the case of milestone flags 2 and 3, the respective target values were posted 

at the time of the first milestone transaction, that is, for milestone flag 1 (resource 2070) as 

described in Milestones. 

Milestone flag 4 is only entered at the end transaction of the milestone with proportional actual 

values. The end transaction for the milestone is, however, still pending. 

Milestone flag 5 is In progress and was entered proportionately with the Partially complete 

transaction. 

Before continuing, compare the planned and actual quantities on the Production order 

status tab in the production order. This data is shown in the following table: 
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Resource Planned 

quantity 

Actual quantity, Actual qty, Act. qty Plan. dur. Act. dur. 

2070 10 0 24 0 

5010 10 10 24 24 

8310 10 10 18 18 

8362 10 0 84 0 

8368 10 0 30 0 

8410 10 10 90 90 

601-0009 10 0 0 0 

 

7. The actual quantity is either equivalent to the planned quantity automatically inserted in the 

production order from the BOR or to zero (which means that a transaction has not yet been 

entered). Until this point, therefore, the table does not show any variances between planned 

and actual values. 

Next, enter an actual quantity that is different to the planned quantity to demonstrate the 

proportionate calculation of actual values. 

 Return to the transaction form via SFDC transactions. Enter the ID card ID of an employee 

and click the End button. The transaction form is displayed. Enter the feedback ID of the 

operation mentioned in step 3. Enter 8 in the Quantity field, since it is assumed that 

instead of the planned quantity 10 only 8 units were produced. 

 The planned and proportionately calculated actual quantities in the production order are 

now displayed on the Production order status tab. 

8. The production order indicates that the materials line 601-0009 is entered with an actual 

quantity of 0. This is because this line was not assigned to the milestone group and therefore 

inventory was not issued automatically. You must therefore post the inventory manually. In 

order to do so, open the Functions menu in the production order and select Inventory 

transaction. 
 

Troubleshooting operations with milestones 

For information on troubleshooting (page 932), see the corresponding Help topic. 

This current Help topic describes how to troubleshoot errors that occur when entering transactions 

against operations with milestones. 
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Several different situations can occur. 

Header is not affected 

The header is the product that is to be manufactured. The settings for this are located in the 

Transaction status section and the Milestone group field on the Order data tab of the order header 

view in the production order. The transaction statuses are explained in the Milestones Help topic. 

If the header itself is not affected by the milestone posting (in other words, the transaction status 

on the Order data tab is Always enter transaction and 0 is entered in the Milestone group field), the 

following situations can occur. 

Operation is trigger 

This situation occurs if the following settings are on the Print/post tab of the production order. 

Record type MS MSG 

OP 1 > 0 

MA 3, 4, or 5 > 0 

In this case, all affected lines are copied and all affected old lines are set to Issued or Complete. 

The milestone group and the milestone flag in the old line are deleted. 

The processing of the MA lines depends on the milestone flag: 

3, 5 An issued quantity can be entered in the old and new line using a dialog box. 

4 There is no reaction. 

In the case of milestone flags 4 and 5, a proportionate posting of the actual values for the trigger 

must always be entered. The necessary remaining values in the dependent records are calculated 

by a quantity/duration calculation using the Quantity % field (see Times/quantities tab in the 

production order). 

Operation is dependent 

This situation occurs if the following settings are on the Print/post tab of the production order. 
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Record type MS MSG 

OP 5 > 0 

MA 1 > 0 

 

This combination is not permitted. The process is rejected and an error message is displayed. The 

operation is only posted as a result of the inventory transaction and therefore cannot be 

interrupted.  

Header is affected 

The header is the product that is to be manufactured. The settings for this are located in the 

Transaction status section and the Milestone group field on the Order data tab of the Order header 

view in the production order. The transaction statuses are explained in the Milestones Help topic. 

If the header is affected by the milestone posting, in other words, the transaction status on the 

Order data tab in the production order header is 1, 3, 4, or 5 and an entry > 0 is entered in the 

Milestone group field, the following situations can occur. 

 

Header is trigger, operation is dependent 

The HR record shows the setting for the header record. You can view this on the Order data tab in 

the Order header view. 

Record type MS MSG 

HR 1 > 0 

OP 3, 4, 5 > 0 

MA 3, 4, 5 > 0 

This combination is not permitted and the processing is rejected with an error message. 

 

Header is dependent, operation is trigger 

The HR record shows the setting for the header record. You can view this on the Order data tab in 

the Order header view. 
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Record type MS MSG 

HR 3, 4, 5 > 0 

OP 1 > 0 

MA 3, 4, 5 > 0 

 

All affected lines are copied and all affected old lines are set to issued or complete. The milestone 

group and the milestone flag in the old line are deleted. 

The processing of the MA lines depends on the milestone flag: 

Flags Processing type 

3,5 An issued quantity can be entered in the old and new line using a dialog box. 

4 There is no reaction. 

 

In the case of milestone flags 4 and 5, a proportionate posting of the actual values for the trigger 

must always be entered. The necessary remaining values in the dependent records are calculated 

by a quantity/duration calculation using the Quantity % field (see Times/quantities tab in the 

production order). 

 

Header is dependent, operation is dependent 

The HR record shows the setting for the header record. You can view this on the Order data tab in 

the Order header view. 

Record type MS MSG 

HR 3, 4, 5 > 0 

OP 3, 4, 5 > 0 

MA 1 > 0 

 

This combination is not permitted. The processing is rejected with an error message. The 

operation is only posted as a result of the inventory transaction and can therefore not be 

interrupted. For this reason, no troubleshooting can take place. 
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Delayed transactions (SFDC) 

For an overview of shop floor data collection (see "Shop floor data collection (SFDC)" page 839), 

see the corresponding topic. 

Entering delayed transactions is significant if employees work off site and the SFDC transactions 

are not entered until some time after the work has been completed. 

Note: For entering delayed transactions, the COMMON.ODC.TDMTABLE=Yes parameter must be set in 

the configuration. This setting allows you to enter transactions in table format. If the parameter is 

set to No, you can only enter individual transactions. 

 

The following delayed transactions are permitted. 

End setup operation 

Meaning: Setup times and quantities are entered against the operation. 

Prerequisites: The operation must exist. The employee must be entered in the employee master. 

Action: Input of employee and operation ID, and remaining fields (optional). 

Result: Status of operation is set to Interrupted. The quantity is entered against the operation and 

the duration is entered in the Duration field. 

Internal transaction: The entered data is saved in the event table. It is processed by SFDC 

processing (page 912). 

 

Operation partially complete 

Similar to Interrupt operation, although the operation status is not changed. 

 

End operation 

Meaning: The operation is ended and the input data is entered against the operation. 
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Prerequisites: The operation must exist. The employee must be entered in the employee master. 

Action: Input of employee and operation ID, and remaining fields (optional). 

Result: No further transactions can be entered against this operation. The status of operation is 

set to Complete. The quantity is posted to the operation. The duration is entered in the Duration 

field. 

Internal transaction: The entered data is saved in the event table. It is processed by SFDC 

processing. 

Interrupt operation 

Meaning: Times and quantities are entered against the operation. 

Prerequisites: The operation must exist. The employee must be entered in the employee master. 

Action: Input of employee and operation ID, and remaining fields (optional). 

Result: Status of operation is set to Interrupted. The quantity is entered against the operation and 

the duration is entered in the Duration field. 

Internal transaction: The entered data is saved in the event table. It is processed by SFDC 

processing. 

 

Interrupt employee operation 

Similar to Interrupt operation, only that the duration is credited to the Total time field of the 

production order. 

Interrupt operation + employee 

Two transactions are generated from this transaction. The first with the Interrupt operation posting 

ID, and the second with the Interrupt employee operation posting ID. 

End setup employee operation 

Similar to End setup operation, only the duration is credited to the Total time field of the production 

order. 
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Partially complete employee operation 

Similar to Operation partially complete, except that the duration is credited to the Total time field of 

the production order. 

End employee operation 

Similar to End operation, only the duration is credited to the Total time field of the production order. 

 
 

Order status 

For an overview of shop floor data collection (see "Shop floor data collection (SFDC)" page 839), 

see the corresponding topic. 

The order status shows which operations are assigned to an employee or which employees are 

logged on for which operation. 
 

Order transactions 

For general information on functions related to order time in TIME, see TIME order time (page 

879). 

In contrast to time and attendance transactions, order transactions (order time transactions) refer 

to transactions entered against operations. 

The Order transactions object in the TIME order time folder in Manufacturing allows you to display 

and adjust all order transactions. Unlike when you display the Period overview, all order 

transactions are listed and not just employee-specific ones. For operations that do not use time 

and attendance or for order time messages that are not employee-specific, this process is your 

only opportunity to make adjustments. 
 



908 | Infor COM 7.5 User Guide 

 

Manufacturing 

 

Insert order transactions 

Order transactions (page 907) are generally entered using SFDC transactions (page 879). 

You can also enter order transactions manually. To do so, proceed as follows. 

1. In Manufacturing, select the TIME order time folder and then Order transactions. Select one or 

more transactions in Order ID and click Load. 

2. Select Functions and Insert order transaction, complete the fields of the dialog box as 

required, and click OK. 
 

Adjust order transactions 

To adjust order transactions (page 907), proceed as follows. 

1. In Manufacturing, open the TIME order time folder and click Order transactions. Click Open 

and make the required selection. 

2. All order transactions (transactions entered against production orders) resulting from the 

selected OT events (order time events) are displayed on these tabs. Changes can be made to 

some fields. 

 If you change quantities (Quantity, Rejects, RMA quantity) or the duration, a data record 

with the quantity delta or duration delta is stored in the SFDC journal (page 909). The 

quantity delta or duration delta is automatically entered against the operation; grouped 

operations, milestones, or multiple machine operation are not taken into account. The 

quantity delta or duration delta is significant in connection with links and statistics. 

 If the Cost center, Cost unit, Cost type, or Work center fields are modified, a data record 

with the negative quantity and duration (and the old fields) is stored in the SFDC journal, 

as well as a record with the quantity, duration, and the newly modified fields. If the 

modified record is an operation transaction, the corresponding fields in the production 

order are changed. 

 The order transaction file also contains the order transactions from grouped operations. 

Quantities and times of these transactions are for informational purposes. Changing these 

values automatically results in changes to the related postings. 

 You can enter the reason for the change in the Comments field. 
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SFDC journal 

For general information on functions related to order time in TIME, see TIME order time (page 

879). 

To open the SFDC journal in Manufacturing, open the TIME order time folder and select SFDC 

journal. The SFDC journal logs entries for all transaction types (see "Shop floor data collection 

(SFDC)" page 839). 
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Transaction groups 

To manage transaction groups in Manufacturing, select TIME order time and Transaction groups. 

They are an aid when entering SFDC transactions. 

To minimize the amount of effort involved in entering transactions for employees - in particular for 

group work - transaction groups facilitate the possibility of entering SFDC transactions for an entire 

group of employees, whereby a single authorized employee, the Group transaction entry 

employee, enters order time transactions for the entire group. The members of the group can, 

depending on their privileges, also enter additional order time transactions themselves. 
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Group work 

Transaction groups (page 910) must be maintained in order for group work to be entered at the 

TIME terminal. 

The Group work process involves an authorized employee, the group transaction entry employee, 

managing or generating order time transactions for employees at the terminals. The other group 

members simply need to enter Clock in/Clock out transactions, while order time transactions can 

be generated by the group transaction entry employee. A prerequisite for this process is that 

transaction groups are defined. The transaction groups make a preselection of employees 

available to the group transaction entry employee. In the Group work process, the group 

transaction entry employee can manage all present employees belonging to his/her transaction 

group(s). 

Note: Depending on the setting, the other group members can also enter additional order time 

transactions. 

The group work process is only defined for the ODCModus=1 parameter setting and for the online 

status. 

Furthermore, only one operation may be selected for the process. Grouped operations are not 

permitted for group transactions. 

Please note:  

The group work button is also disabled if 

 the employee entering the transactions does not have the Group transaction entry employee 

order time privilege. 

 no operation is selected 

 the terminal has the status Offline 

To enter a group transaction, the employee entering the transaction must be assigned to an 

operation. 
 

TIME system 

For general information on TIME, see TIME basics (page 837). 
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The TIME system folder is in Manufacturing. Objects that start system activities or contain logs of 

system activities are grouped together in this folder. 

 SFDC processing (page 912) looks after the further processing of the transactions. 

 Errors that occurred during processing can be viewed in the Invalid transactions (page 915) 

object. 

 Stored time and attendance transactions are checked in Batch TA processing (page 916). 
 

SFDC processing 

For general information on functions related to order time in TIME, see TIME order time (page 

879). 

 

Access 

Manufacturing > TIME system > SFDC processing 

 

Definition 

SFDC processing is the central poster in TIME, distributing data from the event table to 

component relations. 

 

Functions 

Trace processing instructions: See Period overview (page 868) 

 

In practice 

The entry and further processing for SFDC transactions takes place in two steps: 

1. The transactions are entered and stored in the Event table (page 915). 
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2. New SFDC transactions are normally processed automatically according to a time interval 

defined in the configuration using the COMMON.ODC.PROCESSTIMEINTERVAL parameter. 

You can also trigger this manually by selecting Functions > Start processing. Processing can 

be interrupted during certain periods which you can define in the ODCBBREAK allocation 

table. 

Note: The display contains a maximum of 100 transactions. 

The following graphic provides an overview of how transactions are further processed. 

 

Continuous processing processes all transactions in chronological order. Each transaction 

processed receives a processed flag and a unique sequential ID. This ID primarily allows the order 

time transactions to be assigned to the respective events. Modifications made to production orders 

are also documented using these sequential IDs. 
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Continuous processing can occur in parallel in Infor COM as well as time-controlled or at a later 

time. The advantage of parallel processing is that SFDC transactions can be entered online; the 

disadvantage is that transactions can outpace themselves in offline terminals and under certain 

conditions an incorrect duration may be calculated or entered. 

If a duration is specified when the transaction is being entered, it overwrites the default duration 

calculation by Infor COM in continuous processing. 

The following graphic provides a (simplified) overview of how transactions are processed in TIME. 
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The SFDC server reports events not yet processed to time control (the poster). The poster 

processes the events and stores those successfully processed in the SFDC events table (they 

may still be required under certain circumstances for time analyses). The unsuccessfully 

processed events are stored in the Invalid SFDC events table. 
 

Event table 

For general information on further processing of SFDC transactions, see SFDC processing (page 

912). 

All SFDC transactions are stored in a central file, the event table. This file is also the interface to 

other transaction entry systems. 

Transactions in the event table are categorized according to the following criteria: 

 Time and attendance transactions, which come from the terminal where entries are made (in 

other words, from the transaction terminals).  

Example: Screen entry 

 Order time transactions, which come from the terminal where entries are made.  

Example: Screen entry 

 Order time transactions, which come from Infor COM on a time delay  

Example: Screen entry, external SFDC, and so on. 

Time and attendance transactions are the basis for calculating employee time accounts and 

balances. Order transactions are generated from order time transactions. They are recorded in the 

journal files (SFDC journal (see "SFDC journal" page 909)). 
 

Invalid transactions 

For an overview of the available system-related functions in TIME, see TIME system (page 911). 

To view invalid transactions in Manufacturing, open the TIME system folder and select Invalid 

transactions. 

This function lists invalid transactions or those not processed by the poster from SFDC 

processing. See also the Processing transactions section in SFDC processing (page 912). 

You can delete all loaded or selected records using the Delete function. 
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Batch TA processing 

For an overview of the available system-related functions in TIME, see TIME system (page 911). 

Time and attendance batch processing can be triggered manually or occur automatically. If you 

want batch processing to occur automatically, you must configure this in Time control. The batch 

process has the following functions: 

 It checks whether all employees have submitted a proper Clock out transaction. Whether such 

a Clock out transaction is correct depends on the applicable time and attendance template 

(see "TA templates" page 848). If a Clock out transaction has been forgotten, it is set by the 

batch process (according to the setting of the time and attendance template). 

 It undertakes the analysis of a daily overview for a Clock out transaction submitted. 

 It processes the absence days provided for in the time and attendance template or planning 

board. 

 It updates the employee status (page 874) and stores a reason for absence if applicable. A 

new time and attendance template is assigned, if required. 

 It performs batch adjustments for transactions modified manually and retroactively. 

 It writes transactions to the TA mailbox (page 871). 

 It writes transactions to the Alarm overview (page 871). 

Note: Perform this function after you have activated an employee in order to generate the days 

since the first active day of the employee. 
 

TA mailbox 

For general information on functions related to time and attendance in TIME, see TIME time & 

attendance (page 868). 

To open the TA (time and attendance) mailbox, go to Manufacturing and open the TIME time & 

attendance folder or the TIME system folder. 

The TA mailbox lists errors and general notes on SFDC processing (page 912). It applies only to 

time and attendance transactions. 

We recommend checking the mailbox every day. It contains warnings and reasons why 

adjustment processing or batch processes are canceled including the date and the employee ID of 

the relevant employee. It also contains additional information such as the expiration of vacation 

entitlement.
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Terminals 

For general information on TIME master data (page 843), see the corresponding topic. 

Shop floor data collection (see "Shop floor data collection (SFDC)" page 839) systems provide you 

with current information on the status of a production order at any given point in time. This allows 

for the optimization of production processes, shorter manufacturing times, and lower costs. The 

data entered using SFDC systems such as TIME forms the basis for production planning and 

control, order processing, and logistics. 

Data is entered at SFDC terminals and stored in databases, where it is made available to the 

various programs. For more information on the transfer of data from Infor COM to the terminals, 

see the SFDC processing (page 912), SFDC server (page 840), and Download employee master 

data (page 844) Help topics. 

To enter terminals in TIME, open Manufacturing, select the TIME master data folder and select 

Terminals. 

Note: Information can be downloaded to the terminals manually by selecting Functions and Start 

download. It can also be downloaded automatically. 
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Call 

Manufacturing > Production orders 

Description 

A production order is an internal order for the manufacture of a certain quantity of an item. A sales 

order is often the trigger for a production order. Inventory can also trigger a production order if, for 

example, the inventory for an in-house item goes below a defined level. 

Production orders can be generated from BORs, created manually, or created by Planning from 

rough planning by breaking down sales orders that were entered in Sales. 

The production order documents the work flow within Manufacturing. 

The order header of the production order contains all of the relevant information for the entire 

order. In addition to details on the item being manufactured, this information also includes the 

completion date, order quantity, and the status of the overall order, for example. You can store 

documents specific to production orders in the production order header on the Manufacturing 

documents tab. The available documents are specified in the WODOCUMENTS allocation table. 

The order table contains several tabs that provide an overview of all of the lines that are required 

in order to manufacture the item. The information provided in these order lines may include, for 

example, the line type (record type), quantities and durations assigned to the line, or the status of 

the individual line. 

Functions 

Disc. item: It is not possible for a sales order to be created for a discontinued item (Discontinued 

item = 5, Planning tab). If this item is flagged as a requirement, i.e. a material line, then the order 

can only be saved if the requirement is covered by the available inventory. 

Production orders 
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Inventory transaction: If the material required for the order was not issued automatically when the 

order was released, you can post this issue from the order afterwards. You can also use this 

function to carry out the receipt posting for the finished item and for any waste. An inventory 

transaction can only occur if at least one released line is available for entry in Inventory. 

Calculate critical quantity:  If the quantity specified for one or more order lines was changed 

within the order, you can recalculate the quantity to be manufactured. To do this, select Functions 

and Calculate critical quantity. 

A message is now displayed indicating the quantity of the finished product that you can 

manufacture based on the line quantities currently included in the order. 

The calculated result is automatically copied to the order header. 

Calculate total weight: You can calculate the total delivery weight of the order if the weight of the 

order lines has been saved in the master data. The total weight of the line is calculated for each 

line simultaneously. To do this, select Functions and Calculate total weight.  

The total delivery weight of the order is now displayed in a message box. This total delivery weight 

is entered in the Weight field of the Master data tab in the order header view. 

Similarly, the total weight of an order line is entered in the Weight field of the Master data tab in the  

order line view. 

Calculate total quantity: On the Size management tab of a production order, you can also enter 

order-specific sizes for the individual order lines in addition to fixed dimensions. When you enter 

this data, the formula that you have selected for measurements is evaluated automatically and the 

result is then displayed in the Total qty field. 

You can also recalculate the results automatically for all order lines by selecting Functions and 

Calculate total quantity . 

Plan order: You can replan an order if you are entering it manually or making changes to 

production orders. In this case, the following occurs: 

 The order is broken down and split into the different manufacturing stages. 

 The receipts and issues for the required resources are checked. 

 PO proposals, if necessary, are generated for required purchase items. 

Production orders, if necessary, are created for required component item lines (in-house items). 

Generate from BOR: You can use this function to add the BOR (if available) for the selected line to 

the production order. 
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Archive order: To move a production order from active inventory to the archive, select  Functions 

and Archive order. 

After you confirm that you want to archive the order, the production order is deleted from the list of 

active production orders and written to the archive. 

However, you can still access this order by selecting the Production orders object from the Archive 

folder in the Manufacturing module. From this location, you can also reactivate an order that has 

already been archived. 

Where-used-list for item: The where-used list for item function lists all orders that contain the 

corresponding item. 
 

Generate production order from BOR 

Click here for information on Production orders (page 918). 

To create a production order using a default routing (that is, from a BOR), follow the steps below: 

1. In Manufacturing, click Production orders and select the New tab. 

2. Fill in the required fields and select the Generate from BOR check box. 

3. Select Create to confirm your entries. 

4. The data you have entered is now displayed in the Order header. Dates, quantities and status 

are also displayed here. 

5. The required quantities, total processing time for each work center (total time), and earliest 

date (based on the requested delivery date entered) are assigned to the lines in the BOR. 

You can make manual changes to these lines. 

6. If you have changed the due date or quantity in the production order header or adjusted 

individual lines in the BOR, you must carry out scheduling again to determine due dates, 

duration, and quantities. To do this, select Functions and Schedule. For more information on 

scheduling, see Schedule production order (page 923). 

7. Select Data and Save from the menu to save your data. 
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Create new production order 

To generate a production order that is not based on a BOR, but is only used once (or rarely), 

complete the following steps: 

1. In Manufacturing, click Production orders and select the New tab. 

2. Fill in the fields on the tab as required and clear the Generate from BOR check box. 

3. Select Create to confirm your entries. 

4. The data you entered is displayed in the order header. Some of it can be updated and 

changed. You can also view dates, quantities, and the status in the header. 

5. You can now store data in the order line table by entering the required lines one after the other 

in the resource column. Make sure that you enter these lines starting with the finished product, 

all the way down to the raw material. A manufacturing table may contain the following, for 

example: 

 The last operation, for example, final assembly 

 The material assigned to the last operation (if available) 

 The predecessor of the last operation 

 The material assigned to the last operation’s predecessor (if available) 

 The predecessor of the predecessor, and so on 

up to the operation for the start of manufacturing and the raw material for the start of 

manufacturing 

Example: Manufacture of welded item 650A (item ID 965-2144) 
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SVO Resource Short description 

OP 1200 Attach bracket 

MA 604-0011 Channel steel 180 

OP 2070 Saw 

OP 3080 Facing lathe 

OP 4090 Cut tongue and groove 

OP 5010 Pillar drill 

OP 8310 Check joins 

OP 8362 Weld items with robot 

OP 8368 Sand blasting 

MA 602-0011 Round rod 30 mm 

The last operation in the manufacture of the item is final assembly and this is therefore 

entered in the first row. 

Item 604-0011 is required for final assembly. This material must then be listed in the next 

row. 

The operation that is chronologically before final assembly is the sweep saw (row 3). The 

operations before this are wood-turning (row 4) and milling (row 5). 

The list of operations ends with the first operation (chronologically), the sandblasting 

machine (row 10) for which the material 602-0011 is required. This material line forms the 

end of the manufacturing table. 

6. After you select the operations and materials, you must enter the required quantities and 

times. For more information on times, see Time calculation (page 818). 

Enter data in the following fields on the Time/quantities tab. 

 Material lines (MA lines): In the RTi/qty field, enter the number of required items, in relation 

to the issue unit of measure stored for the material in the master data. This is displayed on 

the Current tab. 
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 For operation lines (OP lines): In the STi field, enter the setup time for the operation, or the 

setup time for the material. In the RTi/qty field, enter the processing time or processing 

quantity for each unit of measure of the finished product. When operations are selected 

(as opposed to work centers or machines), the standard times saved in the master data 

are transferred as the default values to the production order. 

Note: In operations, the UOM field must remain blank. 

This means that if it always takes the same amount of time to process items, you should 

select the operation (not the machine) in the order. 

7. Once you have entered all operations and materials, you should carry out backward 

scheduling (see "Perform backward scheduling" page 924) to determine the due date, 

quantity, and duration for each line. 

8. Select Data and Save from the menu to save your data. 
 

Copy and change production order 

Click here for information on Production orders (page 918). 

You want to create a production order for which there is already a similar order in Manufacturing. 

In this case, it is best to copy the existing order and adjust it: 

1. In Manufacturing, click Production orders and then select the Open tab. 

2. Enter the order name of the order you want to copy and confirm this by selecting Load. 

3. When you have loaded the order, select Data and Save as. The Save as dialog box appears. 

4. Fill in the required fields as for creating a new production order and confirm with OK. The order 

opens and is scheduled with the new data. 

5. You can make adjustments to the order header and order lines. You will then need to 

reschedule. To do this, select Functions and Schedule. 

6. Select Data and Save from the menu to save your data. 
 

Schedule production order 

Click here for information on Production orders (page 918). 
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When a production order is created (from a BOR or by copying it from an existing order), the 

system automatically schedules back based on the completion date. Depending on the operation 

or material, you can view the start of the operation or the material provision date in the Due date 

field on the Current tab. 

You can change these dates and the completion date at a later stage. If you do so, you must then 

reschedule the production order. Order scheduling must also be performed if you manually create 

a new production order. 

1. In Manufacturing, select Production orders, open the production order that you want to 

reschedule and enter the order data on the Open tab. 

Note: Alternatively, you can open the production order using the ppc-reschedule filter (lines to 

be rescheduled) on the Filter tab. This filter loads all production orders for which a date change 

flag has been set and displays these in an overview. 

2. From the menu in the open production order, select Functions and Schedule. 

Note: In addition, the Reschedule production orders desktop object in Manufacturing is 

also available for rescheduling an order. See Reschedule production orders (page 998). 
 

Perform backward scheduling 

For general information on scheduling, see Schedule production order (page 923). 

Backward scheduling is useful if you have changed the completion date in the order header 

(Current field), or if there are no dates for the order lines when the order has been created 

manually. 

The order structure is calculated and rescheduled using the completion date. To carry out 

backward scheduling: 

1. From the menu, select Functions and Schedule. 

2. In the Schedule dialog box, select End date to ensure that scheduling is carried out based on 

the completion date specified in the order header. The direction Back is set by default, so that 

the system will reschedule backward to the start of manufacturing based on the end date. For 

operation lines, the system calculates the date on which work is started, while for material 

lines, it calculates the date on which materials are provided. 
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3. Select the Calculate quantity and duration check box if the quantity and duration of the 

individual lines are to be recalculated in addition to the dates. 

4. Click OK to start backward scheduling. If you have selected the Calculate quantity and 

duration check box, this calculation will be implemented for each line in the order before 

scheduling is carried out. 

The following data is then calculated based on the completion date in the order header: 

 For each operation line (OP line), the date the operation starts 

 For each material line (MA line), the date on which the material must be available 

Note: Backward scheduling may also come in useful if you change a date in the order 

(due to the temporary stoppage of a machine, for example) and this change does not 

impact subsequent lines. 

In this case, before selecting Functions and Schedule, position the cursor in the row of the 

changed date. In the Schedule dialog box, select Current line in the From section and 

Backward in the Direction section. 
 

Perform forward scheduling 

For general information on scheduling, see Schedule production order (page 923). 

Forward scheduling is useful if you want to specify the start of manufacturing for a production 

order, and want to recalculate all subsequent dates as well as the completion date. 

In this context, the order structure is recalculated and rescheduled based on the manufacturing 

start date. 

To carry out forward scheduling: 

1. For the first chronological operation or material line, enter the required date. This line is always 

displayed on the last row in the order table. 

2. From the menu, select Functions and Schedule. 

3. In the Schedule dialog box, select the Schedule check box. 

4. Select the Start date check box to carry out scheduling based on the manufacturing start date 

entered in the bottom row. 
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5. Select forward to carry out rescheduling from the manufacturing start date to the completion 

date. 

For operation lines, the system calculates the date on which work is started and for material 

lines, it calculates the date on which materials are provided. 

6. Select Calculate quantity and duration: This check box must be selected if the quantity and 

duration of the individual lines are to be recalculated in addition to the dates. 

7. Click OK to start forward scheduling. If you have selected the Calculate quantity and duration 

check box, this calculation will be implemented for each line in the order before scheduling is 

carried out. 

The following data is then calculated based on the start of manufacturing date: 

 For each operation line (OP line), the date the operation starts 

 For each material line (MA line), the date on which the material must be available 

 For the production order, the completion date in the order header 

Note: Forward scheduling may also come in useful if you change a date in the order (due to the 

temporary stoppage of a machine, for example) and this change is not to impact preceding lines. 

In this case, before selecting Functions and Schedule, position the cursor in the row of the 

changed date. In the Schedule dialog box, select Current line in the From section and Forward in 

the Direction section. 
 

Perform midpoint scheduling 

For general information on scheduling, see Schedule production order (page 923). 

It makes sense to use midpoint scheduling if, for capacity reasons (for example, a machine must 

be repaired) or because your supplier has changed the delivery date, you need to modify a date in 

the order, which means that all other dates in the production order need to be modified also. 

The order structure is calculated and rescheduled using the changed date. 

To carry out midpoint scheduling: 

1. Change the date of the operation or the material. Ensure that the cursor is then positioned in 

this row. You will be able to tell that the cursor is positioned in the row from the marker in the 

row header. 

2. From the menu, select Functions and Schedule. 
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3. In the Schedule dialog box, select the Schedule check box. 

4. Select Current line to ensure that scheduling is carried out based on the changed date (in the 

table row in which you positioned the cursor). 

5. Select Midpoint so that the system reschedules back to the start of manufacturing and forward 

to the completion date, based on the changed date. 

For operation lines, the start of work is calculated. For material lines, the material provision 

date is calculated. 

6. Select Calculate quantity and duration: This check box must be selected if the quantity and 

duration of the individual lines are to be recalculated in addition to the dates. 

7. Click OK to start midpoint scheduling. 

If you have selected the Calculate quantity and duration check box, this calculation will be 

carried out for each line in the order before the actual scheduling is carried out. 

The following data is then calculated based on the modified date: 

 For each operation line (OP line), the date the operation starts 

 For each material line (MA line), the date on which the material must be available 

 For the production order, the completion date in the order header 

Midpoint scheduling is also useful if all other dates in the production order must be recalculated 

because the date for an individual production order line has changed. 
 

Schedule machine 

After you schedule a production order (see "Schedule production order" page 923), the start dates 

are assigned to each operation. These are displayed on the Current tab. 

The following occurs when a machine is scheduled: 

 Scheduling of a work center group: The working hours are distributed evenly across the 

individual machines assigned to the group. 

 Every time scheduling is carried out, all single work centers of the work center group are used. 

 If a machine (a single work center) was fixed in the BOR for a product or when creating a 

production order, only this machine is taken into account in scheduling. 

 You can retroactively fix an individual work center in production order entry. To fix an individual 

work center, select the WkCtrF check box on the Texts/structure tab. The adjacent single work 

center will be fixed for all further scheduling. 

You may need to make manual changes if you need to eliminate bottlenecks or move dates. 
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You schedule machines in the work center account: 

1. Position the cursor on the row of the work center that you want to schedule. 

2. Select Go to and Item/work center account. All orders that are scheduled for this 

machine/machine group are displayed on a date-by-date basis in ascending order. 

 You can change a date manually. 

3. Select Functions and Schedule to enter the required parameters. 
 

Display processing status in color 

Click here for information on Production orders (page 918). 

The Status and Queue position fields on the Other tab of the order line view in the production 

order show whether an order is scheduled, released, in progress or completed. If the order is in 

progress, you need to switch to the order line view to determine how much progress has been 

made in processing the order. 

As this is time-consuming when you have a lot of orders, Infor COM allows you to see by means of 

a colored bar which work center is next for processing. 

You can use the COMMON.LEITSTAND.MACHCOLOURACTIVE, 

COMMON.LEITSTAND.MACHCOLOURREADY, and 

COMMON.LEITSTAND.MACHCOLOURNOTACTIVE to configure the colors displayed in the 

header form of the production order and in the production orders overview. 

1. Create a new production order. 

Note: In a new production order that has not yet been processed, the Color field in the header 

form of the order contains the color of the work center for the first operation in the order. 

2. Select Go to > Work center group colors. 

3. The MACHCOLORS allocation table allows you to define the colors for the work center groups 

that are to be displayed in the production order. 

Note: New colors for this color selection can be created in the COLORS allocation table. 
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4. Release the order. 

With each subsequent Complete transaction for an operation, the color for the work center of 

the respective successor operation is entered in the header form of the order. This means that 

during the course of the manufacturing process, the color displayed changes with each 

Complete transaction. 

Note: Click the Color field to display the description for the color. In this way, you can 

circumvent any inaccuracies in the display. 
 

Release production order for manufacturing 

Click here for information on Production orders (page 918). 

A scheduled production order can be released for manufacturing. When you release a production 

order, the production order lines are made available for SFDC transactions and inventory 

transactions. The work documents are also printed. The material issue can also be carried out in 

the warehouse. 

1. In Manufacturing, click Production orders and select the Open tab. 

2. Enter a description for the order you would like to release. Select Load to load this order. The 

system automatically assigns the status 3 = Scheduled when a production order is created. 

Backward scheduling is then carried out. 

Note: You can use wildcards (%, for example) to load multiple production orders and to 

release them together in the Order overview view. To do this, select the production orders and 

proceed as described below. 

3. In the menu, select Functions and Release. This opens the Release dialog box. The Release 

option field is selected automatically. If the Material issue check box is selected, the material is 

posted from warehouse inventory. If you are using milestones, please note the additional 

information under Release. 

4. Select the Print check box to print the shop floor documents. The BOR settings are inserted in 

the Print/post tab of the production order by default. You can overwrite these values if you 

want. 

5. Click Documents and select the required lists in the Shop floor documents dialog box that is 

displayed. 
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6. Click OK to release the production orders and to start the selected functions. Once you release 

the production order, the status changes to 4 = Released. 

The operations (lines with record type OP) have the same status. 

If you selected Release with Material issue, the material lines (lines with the record type MA) 

have the status 5 = Issued. If they are released without material issue, they are assigned the 

status 4 = Released. 
 

Close production order 

Click here for information on Production orders (page 918). 

Note: A production order can only be closed following a series of internal system checks to 

determine if this is permitted. 

When you close an order, a check is run to see if the order already contains the final costs and 

then, if applicable, an order costing is carried out to determine the final costs and a flag is set to 

prevent the calculated final costs from being overwritten. In addition, when using the Value flow 

models, the cost variance for the production orders is calculated and is stored in the posting 

journal for transfer to Financial accounting - for more information, see Calculate manufacturing 

costs and total manufacturing costs. 

Furthermore, when closing an order, a check is run to see whether rejects were posted during the 

processing of the order. 

1. Open the required production order by selecting Manufacturing > Production orders. 

2. Select Functions > Close order. 

When a production order is closed, it is assigned a defined final status. Once a production 

order has this status, you can no longer make changes or enter any more transactions. 

You can cancel the closure in the posting journal in order to permit the following postings 

for this order. 

 Cancel material issue 

 Cancel receipt 

 Adjust SFDC transactions 

 Delayed transactions 

 SFDC posting batch process 
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After you confirm that you want to close the order, the order lines are assigned the Closed 

status, the material lines are assigned the Issued status and the entire order is set to the 

Received status. 
 

Split order lines 

Click here for information on Production orders (page 918). 

When you split an order line in a production order, the planned data for the line is split between 

several identical lines that are scheduled simultaneously. The objective of splitting is to shorten the 

lead time. The main problem with splitting is that setup times are incurred for each parallel 

operation. 

Splitting can be used for operations, materials, or assemblies. 

In the Split dialog box, a split line may be split again several times. However, the changes only 

take effect when you confirm by selecting Accept. 

However, lines with the following attributes and groups containing lines with these attributes 

cannot be split. 

 Lines that have the record type 10 

 Lines that act as milestone triggers 

 Lines with a fixed requirement allocation 

 Lines with an enabled STi (setup) adjustment flag 

 Released lines (lines that you want to split must have a maximum status of 3 = Scheduled). 

 Reservations 

Splitting an operation involves breaking down the operation into several parts. 

This topic describes the splitting of operations and focuses on the main purpose of splitting, which 

is the short-term scheduling of parallel manufacturing.  

Splitting an operation for parallel processing is useful if similar machines are on hand for the 

operation. Splitting therefore usually applies to work center groups that have been assigned 

several single work centers. 

Note: If you split an order line that is contained in a group of lines that are already scheduled in 

parallel, the entire group is then split. 

If you want to set up parallel processing on multiple machines, follow the steps below. 
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1. In Manufacturing, click Productions orders to open the production order containing the 

operation that you want to split. Select the production order from the Open tab in the start form 

and click Load. 

2. Place the cursor on the relevant operation line (OP record type) and select Functions and Split. 

The Split dialog box is now displayed. Here you can specify details such as how many different 

operations you want to divide the selected operation into. Enter this value in the Enter split 

count >=1 field. Confirm your entry by clicking Accept. 

Note: Before accepting, you can manually edit the new lines in the tabs in the Split dialog box. 

If you do not select Accept beforehand, these changes are lost if you change the parameters 

and subsequently repeat the split procedure. 

3. You will now get the following result for the production order: 

 The original row is deleted from the order table and a row is inserted for each parallel 

operation. 

 The times and quantities are evenly distributed across the machines on the Current tab 

and the duration is recalculated. The change flags for fixing the quantity and duration are 

also set on the Current tab. 

 The original machine ID is entered in the Texts/structure tab for each of the parallel 

operations. Overwrite these values with the machine you want to use (single work center). 

 The PLcnt and PL ID fields for parallel manufacturing are populated on the Scheduling 

modes tab. 

 All other data assigned to the original operation now appears in the new operation lines. 
 

Troubleshooting 

Click here for information on Production orders (page 918). 

If a machine fault occurs when a released production order is being processed, you can use the 

Troubleshooting function to transfer the operation from this machine to an alternative one. The 

prerequisite for this is that the corresponding operation has the status Interrupted. 

Troubleshooting corresponds to splitting (see "Split order lines" page 931) a line in two, whereby 

the old order line receives the status Complete and the new line receives the status Scheduled. 

Troubleshooting can therefore only be carried out under the following conditions: 

 There can be no lines selected in the production order. 

 The record type must be 60 (operation). 

 The Status/Queue position combination must be 5/5. 

 The line must not be a milestone trigger. 
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 The planned value of the line may not exceed the actual value. 

You can carry out troubleshooting in the production order and in the work center account. To 

implement troubleshooting, place the cursor on the corresponding operation line and select 

Functions and Troubleshooting. 

A new operation line is inserted with the following data: 

 The status is set to Scheduled. 

 The planned quantity receives the remaining quantity and the planned duration receives the 

planned duration for the remaining quantity. 

If the resulting value is negative, because the actual values already exceed the target values, 

a corresponding dialog box appears and troubleshooting is canceled. 

 The change flags for Quantity and Duration are fixed. 

 All other data has been transferred from the original operation line. However, the data can be 

changed manually. 

The original operation line is changed - the status is set to Complete. 

The new operation line must be assigned the alternative machine as a resource description. This 

is then released by selecting Functions and Release. 

Note: If you implement troubleshooting from a work center account, the original operation line is 

no longer available there, because it has been assigned the status Complete. 
 

Standing orders 

Click here for information on Production orders (page 918). 

Standing orders are special types of production orders with operations that are permanently 

available in shop floor data collection (SFDC). No End transaction is entered for these operations. 

Standing orders can be used to enter overhead activities (operations that solely carry overhead 

costs) using SFDC. 

Example: A typical example is the Clean operation, which it should be possible to enter on a 

daily basis without having to re-create and release it every time. 

Standing orders are created in a similar way to production orders. Enter the required operations in 

the newly created production order and then flag the operations that were entered as overhead 

operations. There are two ways of doing this: 
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 Select Functions and Standing order in the production order. 

In this case, all operations in the production order are flagged as standing orders. 

 In the Order line view for the required operation in the production order, select the Standing 

order check box on the Other tab. 

Note: The Standing order flag is displayed on the Operation tab in the SFDC journal. 

 
 

Replace tool 

If a tool is damaged during manufacturing, you can replace it with another. 

1. Open the required production order by selecting Manufacturing > Production orders. 

2. Select the tool line that is to be replaced. 

3. Select Functions > Replace tool. 

Prerequisites: 

 Batch-tracked inventory is assigned to this line. 

 The associated operation is interrupted or has not yet been started 

The function carries out the following steps for the selected tool line in the production 

order. These steps would otherwise need to be posted manually in the event of a 

disruption. 

 The assignment of the damaged tool component to this tool line is canceled. 

 The damaged tool component is posted back to inventory and locked. 

 A new tool component, if available, is assigned to the tool line. 

 

If multiple batch-tracked inventory is available, there are two ways of controlling which one 

is selected: 

 By using the tool issue strategy (Planning tab in the tool master) 

 By reserving the required batch-tracked inventory in advance 
 



Infor COM 7.5 User Guide | 935 

 

Manufacturing 

 

If you want to compile an overview of certain order lines, select Order lines in Manufacturing. 

Order lines are usually processed in the production order or work center account. However, if you 

want, you can also combine any number of order lines in an overview, independently of an order 

or work center and make any necessary changes there. One of the advantages of this alternative 

processing method is that it allows you to load and check individual record types independently of 

a production order. 

Example: You want to view all subcontracting records in one overview. 

Unlike a production order, this overview is not structured. This means that each line in the table 

exists independently of the other lines. For this reason, changes to the structure data for the order 

are not permitted. This applies to the level ID and milestone flags in particular. You can further 

restrict the implementation of changes to order data using the CHKCHGAP allocation table. 

In contrast to processing a production order, you can still sort the overview by any field in 

ascending or descending order. To do so, right-click the column header and select Sort > 

Descending or Ascending. 

Note: Even if all lines from a production order have been loaded together in this table and sorted 

in the sort order, they do not represent an order structure in this context. 

Functions 

You can use the following functions from production order processing for loaded order lines: 

 You can release one or more order lines by selecting Functions and Release. 

 You can create grouped operations. 

 You can enter an inventory transaction for one or more order lines by selecting Functions and 

Inventory transaction. 

Finally, you can also load other order lines in the overview. 

 You can update the complete order for an order line. From the menu, select Functions and 

Update order. 

 You can update the complete assembly for an assembly line. From the menu, select Functions 

and Update assembly. 

Order lines 
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 You can update the complete milestone group for a milestone line. From the menu, select 

Functions and Update milestone. 

 As well as the above functions, you can also select Reload at any stage to update the 

overview with your choice of order lines. From the menu, select Data and Reload. 

 Lines that belong to a particular production order may be sorted in the Order sequence. From 

the menu, select Functions and Sort orders. 
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For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

Use the Manufactured items object in Manufacturing to create a manufactured item (see Create 

new item) or open one. When you select this object, the Manuf. item check box is selected and 

dimmed. Otherwise, the process is the same as the usual procedure for creating an item. 

 

Manufactured items 
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For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

You can call this application from the Manufacturing module by clicking the Order shortages 

object, or from the Order overview, or from an open production order by selecting the Order 

shortages function. You can use it to generate and print an order-related list of order shortages (by 

order) and an item-related list of order shortages (by item). 

Order shortage 

A shortage occurs for an item if it is unavailable at the time it is likely to be issued by 

manufacturing. 

The following documents generate receipts (sorted in descending order according to current date): 

 Printed purchase orders 

 Released production orders 

 Partially entered production orders (less quantity already entered) 

 Available warehouse inventory = Physical inventory – Reserved inventory – Quarantine 

inventory – Inspection inventory. 

The following generate issues (in order of priority): 

Order shortages 
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Prio Issues 

1 * Partially entered lines from detailed planning (Stat. 5, Que. > 3) 

* Materials provided in purchase orders that are released for inventory 

receipt 

2 * Released order lines from detailed planning (Stat. 4, queue position does 

not matter) 

* Printed sales order lines 

3 * Sales order lines created 

* Materials provided in created purchase orders 

* Scheduled order lines from detailed planning (Stat. 3, queue position 

does not matter) 

4 * Materials provided in created PO proposals 

5 * Order lines from rough planning (Stat. 1, queue position does not matter) 

The receipts are sorted in ascending order according to their priority and current delivery date. 

List of order shortages (by order) 

This list of shortages is created on an order-related basis. It displays the shortages for an order. 

List of order shortages (by item) 

This list of shortages is item-related. It displays the requirement-generating order. 

Example (see "List of order shortages - Example" page 940) 

Calculating shortages 

Shortages are determined by balancing the planned receipts and issues. 

Note that planned receipts are only balanced if you have cleared the Planned receipts excluded 

option on the shortage creation start form. If you select this option, the shortages are determined 

using the current warehouse inventory. 

The system generates the lists as follows: 

 It reduces the issue quantities for an item by the reserved quantities. Only the issues whose 

current date (CD) is within the period you have defined are taken into account for this. 

 It loads all receipts whose CD is before or on the CD of the latest of these issues, and sorts 

them in descending order by their current date. 
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 The system then starts to cover the quantity of the current issue using the receipt whose CD is 

closest to the CD of the current issue (for example, on the same or previous day). In each 

case, the receipt quantity is reduced by the issue quantity. 

 As soon as the receipt quantity is no longer sufficient to cover the issue, the receipt with the 

nearest CD is used to cover a requirement. Once the planned receipts are utilized, the current 

warehouse inventory is used to cover a requirement. 

 

If the system does not find any more receipts to cover a requirement, it calculates the shortage 

and records it in the list(s): 

Shortage = Available receipt quantity – Issue quantity. 

Shortage values are therefore always negative. 

The system uses remaining and, if necessary, reduced planned receipts along with current 

warehouse inventory to cover the subsequent issues. 
 

Generate and print lists of order shortages 

For general information on order shortages, click here (see "Order shortages" page 938). 

The following topic provides an overview of how to create, display, and print an order-related 

and/or item-related list of order shortages (see "Order shortages" page 938). 

1. Click Order shortages in Manufacturing. 

2. Enter the selected data in the Order shortages dialog box. 

3. Click Print. 
 

List of order shortages - Example 

In an order-related list of shortages, the Quantity column shows the total quantity of the specified 

resource required by each order to manufacture an in-house item by the current date (CD). The 

Shortage column indicates how much of that quantity cannot be covered by the current date with 

planned receipts and current warehouse inventory. 

All orders in the list are sorted according to ID and are displayed in ascending order 

(alphanumerically). Orders are sorted internally in ascending order according to the order shortage 

ID. If an order contains several lines with the same shortage, the order is then sorted internally in 

ascending order by current date. 
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Order shortage list (displayed by order) Date 6/3/2014 Page 1 of 1 

Order Resource Short 

description 

Qty Shortage UOM CD Status 

00085 PI1 Test item 20,00 -15,00 U 5/24/2014 12:00:36 3 

00088 PI1 Test item 30,00 -30,00 U 6/4/2014 11:00:36 3 

00093 PI1 Test item 5,00 -5,00 U 6/21/2014 13:30:36 1 

PrO_TEST PI1 Test item 20,00 -20,00 U 5/31/2014 12:00:00 

PM 

3 

PrO_TEST PI1 Test item 10,00 -10,00 U 6/15/2014 00:00:00 3 

PrO_TEST PI1 Test item 10,00 -10,00 U 6/20/2014 10:58:00 3 

 

The following table shows the item-related list of order shortages. The orders that generate 

requirements are sorted within an order shortage list according to their current date initially. If the 

current dates are identical, the orders are then sorted alphanumerically. 

Order shortage list (displayed by item) Date 6/3/2014  Page 1 of 1 

Resource Short 
descriptio
n 

    

Order Qty Shortage UOM CD Status 

PI1 Test item     

00085 20,00 -15,00 U 5/24/2014 12:00:36 3 

PrO_TEST 20,00 -20,00 U 5/31/2014 12:00:00 PM 3 

00088 30,00 -30,00 U 6/4/2014 11:00:36 3 

PrO_TEST 10,00 -10,00 U 5/15/2014 00:00:00 3 

PrO_TEST 10,00 -10,00 U 6/20/2014 10:58:00 3 

00093 5,00 -5,00 U 6/21/2014 13:30:36 1 
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Both sample lists show, for example, that the requirement created by the PrO_TEST production 

order has caused an order shortage for the PI1 resource. The production order shows the 

following image 

SV

O 

Resource Status Due date Qty UO

M 

Total 

time 

Duration 

OP 1200 Scheduled 5/31/2014 12:00 20,00 min 200,00 200,00 

MA PI1 Scheduled 5/31/2014 12:00 20,00 U 0,00 0,00 

MA PI1 Scheduled 6/15/2014 00:00 10,00 U 0,00 0,00 

MA PI1 Scheduled 6/20/2014 10:58 10,00 U 0,00 0,00 

 

In the item account for the PI1 resource, the situation looks as follows: 

Order SV

O 

Status Due date Receipt Issue Plan. bal. Available 

 IR Main warehouse  15,00 0,00 15,00 5,00 

 MA Scheduled 3/30.04/2014 0,00 10,00 5,00 5,00 

 HR Lot 5/1/2014 10,00 0,00 15,00 15,00 

 HR Lot 5/24/2014 50,00 0,00 65,00 25,00 

 MA Scheduled 5/24/2014 0,00 20,00 45,00 25,00 

 MA Scheduled 3/31.05/2014 0,00 20,00 25,00 25,00 

 MA Scheduled 6/4/2014 0,00 30,00 -5,00 0,00 

 MA Scheduled 6/15/2014 0,00 10,00 -15,00 0,00 

 MA Scheduled 6/20/2014 0,00 10,00 -25,00 0,00 

 HR Lot 6/21/2014 5,00 0,00 -20,00 0,00 

 MA Lot 6/21/2014 0,00 5,00 -25,00 0,00 
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To access APS, open Manufacturing and select APS. 

APS (Advanced Planning and Scheduling) is a component that is based on rules and is used for 

the detailed planning of all manufacturing processes within a user-defined time horizon. 

Production orders are automatically planned fully or partially, and can be manually replanned as 

required. 

The main task of APS is to create and monitor a resource assignment plan, in other words, to find 

corresponding dates for all operations on suitable resources. 

Functions 

The following table lists some functions, which will not be described further in the Help. 

 Missing language entries: To list all language entries in APS for which the (translated) string 

entry is missing, select Missing language entries from the System menu. 

 System information: To access the system information in APS, select System information from 

the System menu. 

It contains important information on, for example, the Infor COM directory or log file. You can 

use the copy and paste commands to select this information and paste it into any editor. This 

makes it easier to locate and identify problems. 

 Show log file: If errors occur, important information is collated in the log file. If program errors 

occur in APS, this file must be provided to the Infor support team. To open the log file, select 

System > Show log file. 
 

Use APS 

This topic familiarizes you with the most important functions of APS in a few short steps. 

1. Load your data from the Infor COM database. See Transfer data (APS) (page 962). 

2. After you have loaded the data, you can view it in the Planning board (see "Planning board 

(APS)" page 966) and use it for planning. Open the planning board and in the Select resource 

views dialog box, select one or more of the work centers that you want to view. 

Advanced Planning and Scheduling 

(APS) 
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3. Right-click to select the required view types (see "Data views in planning board (APS)" page 

967) for the work centers. 

4. Carry out a planning (see "Planning (APS)" page 950) operation by dragging and dropping a 

bar in a Gantt view using the mouse. When you do this, the operation represented by the bar is 

moved to another date. 

5. Check your results by referring to the evaluation table (see "Evaluate plan (APS)" page 958). 

6. Adjust the planning, if necessary. See Working with the planning board (see "Working with the 

planning board (APS)" page 981). 

7. Save the modified data in Infor COM. See Data interchange between Infor COM and APS 

(page 960) 
 

User administration (APS) 

APS allows you to define many configuration settings, such as parameters for customizing the 

user interface, information about the origin of data, and planning parameters, without having to 

modify the program code. See Configure APS (page 948). 

Generally, all configuration settings are managed via user profiles that summarize all specific 

values for a particular user. If you select a user profile when starting the program, the 

corresponding parameters are assigned. To access the user profiles in APS, select File and Select 

user profile. 

You can only edit existing user profiles or create new ones if you are logged on as Administrator. 

To access the user administration function in this profile, select Administration and User 

administration. You cannot change the settings of the Administrator profile itself here. 

Please note: Before customizing any configuration settings, we recommend that you create a 

separate user profile and apply your changes to this profile.See Create user profile (see "Create 

user profile (APS)" page 945). 

The following user profiles are provided in the system by default: 

 Administrator: All system functions are available for the Administrator profile. Specifically, the 

administrator is the only user that is allowed to create new users. 

Please note: For security reasons, the Administrator profile cannot be saved. This means 

that any changes are discarded after logging off. 
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 Default user: This profile contains commonly used settings, and should be used as the 

preferred template when copying a profile in order to create a new one. 

 Demonstration: The Demonstration profile provides a simplified user interface as well as 

configuration settings that are specifically adapted for Infor COM demonstration data. 
 

Create user profile (APS) 

This Help topic describes how to create a user profile (see "User administration (APS)" page 944) 

in APS when you are logged in as Administrator. 

1. Open the Administration menu and select User administration. 

Note: You can only access the Administration menu in the Administrator user profile. 

2. In the dialog box that opens, click the New button. 

3. In the Create new user dialog box, select the name of the new user and confirm by clicking 

OK. A message is displayed confirming that the user has been created. 

4. If required, make changes to the user's settings. 

5. Click Save to store the new user in the database. 

Open the File menu and select Select user profile to log on with the new profile. 

Name 

This field shows the name of the user. Any spaces used in the entry are displayed as 

underscores. 

Note: The name entered here will also be used as the name of the file containing the 

saved settings for this user. 

Lang. 

Define the language that you want the system to use for this profile. The languages are 

installed in the \wizard\system\lang directory. Default means that the language specified in 

the \wizard\aps.ini file is used. 
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Language flags 

Define the language flag that you want the system to use for this profile. The language flag 

is used, among other things, for determining the correct values from the Infor COM 

allocation tables. 

Default means that the language flag of the language specified in the Language column in 

used, in other words US for English (US) or DE for German. 

Active? 

If the user is set as active, he/she can be selected in the Select user profile dialog box. 

Example: You should deactivate the Demonstration profile because it is not suitable for 

standard use. 

Standard 

This profile is loaded when no other profile is assigned based on the settings of the Infor 

COM user. 

Configuration 

Use this check box to specify whether the user is allowed to select the System and 

Configuration menu command and whether the user can change user by selecting File 

and Select user profile. 

Please note: This switch should only be used in conjunction with the automatic assignment 

of profiles to Infor COM users. If you deactivate access for all active users, problems will 

occur when you try to access the Administrator profile. 

Infor COM users 

When you start APS in Infor COM (for example, while working with a production order or 

work center account), the current Infor COM user name is transferred and APS checks 

whether this user has been assigned a user profile. If this is the case, APS is started with 

the corresponding settings; otherwise, the settings of the profile defined as the default 

profile are used. 

Example: If the Demonstration user has set Miller and Smith as Infor COM users, then the 

Demonstration user profile is loaded automatically with all corresponding settings when 

these Infor COM users switch to APS. However, other Infor COM users load other APS 

users. The same Infor COM user cannot be entered for two different APS users. If you 

attempt to do this, the user is removed from the first profile. 
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If the Infor COM user who is attempting to switch to APS is not found as an APS user, the 

Default user is used. There can only be one default user or no default user at all. If no 

default user was selected, a selection dialog box in which you can select the APS user is 

displayed when you switch to APS. 

Note: We recommend that you create a default user. 
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Configure APS 

You can manipulate most of the processes within APS by modifying the APS configuration. This 

applies particularly to data transfer, planning board display, and planning processes. 

Please note: Do not confuse the following configuration of APS with the parameterization of 

APS using the Infor COM Management Console. 

To open the APS configuration, open the System menu and select Configuration. 

For more information on the individual settings on the configuration tabs, position the mouse 

pointer on the particular setting. This will display a small popup window containing descriptive text 

(a ToolTip). 

The default settings depend on which user is logged on. However, all users have the same 

privileges. 

For the Administrator user, a number of default settings are loaded automatically. The 

administrator can change these settings but cannot save them. See User administration (see 

"User administration (APS)" page 944). All settings tabs have the same button bar. 
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Save This option is only dimmed for the Administrator. All other users can save any 

changes they have made. 

Default When you click this button, the settings are reset to the Administrator's default 

settings. This enables you to correct any configuration-related errors by 

resetting the settings to a stable default configuration. 

Accept When you click this button, you accept the settings you have entered or any 

changes you have made without closing the configuration window. 

Please note that not all modified settings are available immediately. In some 

cases, additional steps are required before the new settings can take effect. 

OK Use the OK button to confirm your settings and close the configuration window. 

Cancel Use the Cancel button to close the configuration window without saving any 

settings you have entered. 

 

In addition to the information provided in the context-sensitive tooltip, the following links provide 

information about the individual tabs in the configuration: 
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Planning (APS) 

The meaning of the term planning in APS is the same as that used in Planning and Manufacturing. 

The planning process includes the planning of required materials, capacities, information, and 

operations, which then trigger and monitor order and program processing within Manufacturing 

control. 

The key planning tool in APS is the planning board (see "Planning board (APS)" page 966). 

 

In terms of the planning process, the following points are important: 

 You can store different rule combinations for different users. You can also create rules for 

different planning types (see "Planning types (APS)" page 950). The combination of rules (see 

"Rules (APS)" page 956) and their evaluations are stored in a planning profile (see "Planning 
profiles (APS)" page 954). 

 You can view the result of the calculation process in the form of information about the dates 

and quality of the calculated plan in the Evaluation table. 
 

Planning types (APS) 

By default, APS offers three planning types. 

 New planning (see "New planning (APS)" page 953) (automatic planning) creates an entirely 

new plan and all operations (see "Resource table (APS)" page 987) are planned from scratch. 

 Replanning (see "Replanning (APS)" page 952) (semi-automatic planning) is used to plan a 

previously specified number of operations. 

 Interaction (see "Interaction (APS)" page 951) refers to the manual planning procedure carried 

out by the user in the planning board. In this case the planning component is simply a control 

tool that checks the actions of the user and displays the corresponding results. 

For every planning type, there is a separate planning profile (see "Planning profiles (APS)" page 

954) for each user and this is loaded and evaluated automatically, when needed. 

 For New planning and Replanning, the associated planning profiles are loaded when you 

select the corresponding menu command. 

 The Interaction profile is loaded as soon as the user carries out any kind of interaction in the 

planning board, for example, when the user moves an operation bar. 
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This mechanism allows the user, for example, to activate only a few important rules for the new 

planning procedure so that an acceptable result is achieved more quickly, however it still enables 

all rules to be taken into account during the subsequent manual checking. 
 

Interaction (APS) 

You can manually change the assignment of a resource in the Gantt chart (see "Add Gantt order 

views (APS)" page 969) by dragging and dropping it with your mouse. 

Note: The Undo and Restore functions are available in the toolbar of the planning board for 

moving operations manually. These functions allow you to modify any planning result that doesn't 

fully meet your needs. 

Interaction or manual planning of this type is useful when, for example, certain information has not 

been entered in the APS knowledge base. 

You can manually modify the assignment of a resource in the Gantt chart by left-clicking and then 

dragging and dropping the individual operations. Note the following points: 

 Hold down the left mouse button and drag the bar for the operation in the required direction. 

While you are using the mouse to move the operation, APS comments on your actions. A 

yellow information window opens underneath the Gantt chart. In addition to the operation's 

default values, it displays the start date and end date corresponding to the current mouse 

position. This displayed data is designed to help you with the planning process. You can 

coordinate the earliest and latest date with the currently displayed start date and schedule 

operations accurately. 

 The frame that is shown while you hold down the mouse button displays the adjusted position 

and length that the operation would have if you released the mouse button. Once you have 

moved the operation by dragging & dropping it, APS evaluates your manual replanning of the 

operation in the information window. 

 The result of the graphical modification is verbalized. The effect on the overall planning is 

displayed - either rule violations caused by constraints not being complied with are indicated 

using a red font, or APS indicates that there are no errors in the planning. 

 The automatic adjustment of the replanning takes the shift plan into account, even during 

manual planning processes. This prevents, for example, the start of an operation from being 

scheduled on a weekend, public holiday, or vacation close-down, despite the fact that these 

are non-working days. 

The operation's lead time is modified based on the shift plan. If an unproductive time is 

included (for example, a weekend), the processing duration and thereby the length of the bar 

is extended. See also the balancing diagram (see "Balancing views (APS)" page 974) when 

operations exceed the aggregation period. 
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 After you have moved an operation, the system evaluates the action and presents the result in 

the information window. The planning result is described in detail; APS notifies you of any 

problems it has found. Graphically, a cluster of operations in the Gantt chart indicates potential 

problems. You may be able to immediately verify or falsify such problems in the utilization 

graph by checking whether any operations exceed the red line indicating the maximum 

utilization limit. 

 If you are not satisfied with the evaluation result of a manual replanning process, you can 

select the Undo function from the toolbar of the planning board to undo your action. Select 

Restore to restore a previously undone move. 

 Any problems that occur depend on the rules that you have defined. 
 

Replanning (APS) 

In the case of more complex planning, manual planning (see "Interaction (APS)" page 951) can be 

problematic because numerous subsequent errors can be caused by moving operations and these 

errors are generally difficult to remove manually. 

APS therefore gives you the option of replanning operations completely. For this, you can 

communicate to APS that changes that have been made or existing dates should be taken into 

account, in other words, they should be retained. You do this by fixing operations. 

Please note the following points in this regard: 

 Open the shortcut menu of a bar or of a Gantt view to fix individual operations or entire orders 

in the planning board (see "Planning board (APS)" page 966). Right-click the required bar 

object and select Fix operation .... Fixed objects are represented by a colored horizontal line. 

When you fix an operation, APS recognizes that its scheduling should not be changed during a 

subsequent replanning. 

Note: Fix order ... fixes the entire order, Fix operation x fixes a single operation. If you have 

selected multiple bars, Fix <number> operation(s) fixes all operations in one go. 

Fixing is not only taken into account during replanning (planning of specifically selected 

objects) but also during new planning (planning of all objects) and during manual scheduling. 

 The Replanning profile is loaded for replanning. The settings defined by this profile form the 

knowledge for the planning process. 

 While fixing objects excludes them from the replanning, you must select the objects that you 

want to replan. 

Example of a selected object:  

Keeping the left mouse button pressed down, draw a frame around the objects that you want 

to replan. This selects the objects. You can recognize selected objects by the black border 

surrounding them. Right-click the background of the resource window and select the Mark x 

selected operation(s) for replanning command. If you then start the planning by selecting 

Planning and Replanning, only the selected objects are included in the planning. 

 As with automatic planning, you can display and resume a canceled planning process in the 

evaluation table when replanning. 
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New planning (APS) 

From the Planning menu, select New planning to load the New planning profile, start the planning 

process for all operations loaded and scheduled in the system, and automatically create a 

completely new plan. When you do this, the current settings for the new planning profile are used. 

See Planning profiles (see "Planning profiles (APS)" page 954) for information on how planning 

profiles work and how you can customize them for controlling the planning process. 

After you select this command, the Planning window opens. It displays the progress of the 

planning process and the estimated calculation time still required. This estimated value is 

determined by the course of the planning so far. Delays can occur towards the end of the planning 

when scheduling becomes more difficult due to capacities becoming increasingly scarce. 

During planning, the specified rules are taken into account; you can enable, disable or weight 

these rules (see Rules (see "Rules (APS)" page 956)). 

If you have canceled a planning process, you can select Evaluation from the Planning menu to 

have the result that was achieved up until the process was canceled displayed in the evaluation 

table. 

After the new plan is created, APS automatically carries out the Evaluation function and displays 

the result in the evaluation table, which contains information about the dates and the quality of the 

calculated plan. See Evaluate plan (see "Evaluate plan (APS)" page 958). When a plan is 

evaluated, the severity of a rule violation is calculated based on this weighting and the penalty is 

shown in the evaluation table. 

Notes:   

 Fixed operations/orders are not planned. 

 By default, planning is carried out for operations of detailed orders with the status Detailed or 

Scheduled. You can configure the Plannable statuses parameter on the Planning 1 tab in the 

configuration to also plan operations for detailed orders with the status Released or operations 

for rough planned orders. 
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Planning profiles (APS) 

Planning profiles contain all of the information necessary to enable a plan to be calculated in a 

specific way in accordance with predefined quality requirements. Planning profiles therefore 

consist of a number of rules (see "Rules (APS)" page 956) and associated evaluations (see 

"Evaluate plan (APS)" page 958) that are carried out at a specific point in time. They also contain 

information about the corresponding planning type (see "Planning types (APS)" page 950). 

For example, the standard version contains profiles for new planning and for replanning. These 

are loaded and activated immediately before you start the new planning or replanning. 

 
 

Change planning profiles (APS) 

From the users' point of view, changing a planning profile (see "Planning profiles (APS)" page 954) 

primarily involves (de)activating rules or adjusting their weighting. To make these types of 

changes to the currently loaded planning profile, open the Planning menu and select Rules. 

The following steps illustrate how you change a profile. Note that, in order to use some of the 

functions referred to in the following, you must be logged on as Administrator. 

1. Load the profile you want to change by opening the Planning menu and selecting Rules (or 

click the Change profile button). Then click the Load button and select the profile that you want 

to change. Profile files have the extension *.pro, and APS stores them in the \config 

subdirectory of your APS folder. 

2. For users, to change a profile means to (de)activate rules or to adjust their weighting. To make 

changes to the profile you have currently loaded, open the Planning menu and activate the 

rules (by selecting the Active check box). 

The following table displays the settings for the different rules. 
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Name Active? Weighting 

Plannable work center Selected/deselected Serious violation 

Work center utilization Selected/deselected Medium violation 

Work center overlap Selected/deselected Slightly more serious violation 

 

 

3. When a rule is deselected in the Active column, it is ignored in the corresponding profile. This 

also means, for example, that no warning message is displayed during a user interaction. 

4. You can change the weighting of the rule by clicking the arrow in the Weighting column of the 

corresponding rule. The setting in the Weighting column affects the number of penalty points 

that are added in the evaluation when the rule is violated. The overall goal of automatic 

planning is to keep this number of points as low as possible. 

5. Save the profile by clicking the  Save button. 

Note: Do not overwrite the default profiles included in APS under any circumstances. Always 

save changes under a different file name. 

APS loads profiles automatically, as needed. If you have created new profiles, you must 

assign the new files containing the changed profiles to the corresponding planning types. 

This is not required if you have modified the existing files. 

To assign the files, open the System menu, select Configuration, and then click the 

Planning 2 tab. In the Planning profiles form section, define which profile file you want to 

load for which planning type. After you have assigned the files to the planning types, click 

the Save button. 

Note: A profile is assigned to the planning type of a specific user; a profile is therefore a 

user setting that is restored for this user when the system is loaded. If you make profile 

changes while you are logged in as Administrator, the Save button will not be available 

because Administrator user settings cannot be overwritten for security reasons. 

In this case, log off as Administrator, and then log on again as the user for whom the 

settings should be valid. Proceed by opening the user settings, and enter the settings as 

described. 
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Rules (APS) 

In planning, rules define conditions that a plan should fulfill, if possible. To access the rules, open 

the Planning menu and select Rules. 

The Active? column indicates whether the rule is active. Select or clear this check box to activate 

or deactivate a rule. 

The Name field shows the name of the rule. The Weighting field specifies the degree to which a 

restriction has been violated. You can define whether a rule violation is weighted as quite severe 

or as less severe. If rule violations cannot be avoided, more severe violations are generally 

eliminated first. 

Rule violations are displayed in the evaluation table. The following table shows the rules that are 

available in APS by default: 
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Name Description Weighting 

Plannable work 

center/Plannable tool 

Checks whether the line's current work center is plannable 

(see the Plannable option in the work center master data). 

Consistency violation 

Work center utilization/Tool 

utilization 

Checks whether the capacity utilization of a resource 

(default: 100%) is exceeded for the current period (default: 1 

week) during the scheduling of this operation. 

Medium violation 

Work center overlap/Tool 

overlap 

Checks whether scheduling the operation for the current 

date causes an overlap on the work center/work center 

group, or in other words, whether more than the maximum 

number of operations are scheduled in parallel. 

Slightly more serious 

violation 

Order too late Checks whether all operations can be completed before the 

Latest date of the order. 

Very serious violation 

Order too late (batch) See Order too late. However, any orders whose earliest 

date (ED) is later than the latest date (LD) and for which a 

"sensible" result can therefore no longer be achieved by 

automatic replanning are ignored. This rule is relevant for 

replanning and new planning. 

Very serious violation 

Order buffer Checks whether the specified buffer times between this 

operation and the preceding ones in the order are complied 

with during the scheduling of this operation. 

Lesser violation 

Fixed requirement 

allocation (FRA) 

Checks whether the fixed requirement allocation is violated 

during the scheduling of this operation, or in other words, 

whether the sequence overlaps more than one order. 

Slightly more serious 

violation 

Earliest due date Checks whether the start date of the current operation is 

after its earliest date. 

Slight violation 

Sequence backward Checks whether the successor sequence within the order is 

complied with during the scheduling of this operation. In this 

process, queue and transportation times as well as transfer 

durations are taken into account, but not buffer times. 

Consistency violation 

Sequence forward Checks whether the predecessor sequence within the order 

is complied with during the scheduling of this operation. In 

this process, queue and transportation times as well as 

transfer durations are taken into account, but not buffer 

times. 

Consistency violation 

Resource buffer (work 

center) 

Checks whether the specified buffer times between this line 

and its predecessors on the work center are complied with 

during the scheduling of this line. 

Slight violation 

Latest date Checks whether the start date of the operation is before its 

latest date. 

Slight violation 

Transfer rule Checks whether the transfer rule for an operation is complied Lesser violation 
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Name Description Weighting 

with (see the settings in the Overlapping form section in 

the resources). 

 

 

Note: You can use the Load and Save buttons to load a different planning profile (see "Planning 

profiles (APS)" page 954) or to save the current profile (under a different name). 

In addition, you can change to another profile by selecting Change profile. 
 

Evaluate plan (APS) 

When you open the Planning menu and select Evaluation, all active rules for the currently valid 

profile are checked for a specific number of objects, and the result is displayed in the evaluation 

table. For each rule violation, this table shows the number of penalty points, the severity of the 

violation, the verbalization of the rule, and the object that the violation is based on. 

When you select Evaluation from the Planning menu, the evaluation is always based on the profile 

that was loaded most recently. For new planning and replanning actions, this is the assigned 

profile or - if you have already worked in the planning board - the interaction profile. If you have 

modified the profile loaded most recently, the evaluation is carried out based on the modified 

profile; the evaluation process does not load a new profile. To ensure the evaluation is carried out 

with a specific profile, you should load the profile specifically by selecting Rules from the Planning 

menu and then clicking the Change profile button. 

The number of penalty points for a rule violation is calculated based on the weighting and severity 

of the violation. It is specified in percent and depends on the violation limits defined for the rule. 

For example, a violation of the Latest date by a few hours results in a significantly lesser number of 

penalty points than a violation by several days. 
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The top row of the table displays the total number of penalty points that have been calculated for 

this evaluation. This total is therefore an indication of the overall quality of the plan. At the same 

time, of course, it must be taken into account how many operations were included in the current 

evaluation. Generally you should aim for as few penalty points as possible. When a plan should be 

considered good or satisfactory depends on the type and weighting of the selected rules, the data 

used as the basis, and the preferences of the user. 

Note: You can open a shortcut menu for each violation (in other words, for each row of the table) 

by right-clicking the selected row. You can use this shortcut menu, for example, to go to the 

planning board (see "Planning board (APS)" page 966) in order to display the corresponding order 

or resource there and then make adjustments, if necessary. 
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Data interchange between Infor COM and APS 

To enable APS to display and plan order and resource data, you must first load the orders and 

resources that are relevant for the planning from the database. You can select the required data 

either in APS or in Infor COM. In Infor COM, use the Go to menu to make the selection in Work 

centers (for example, in the capacity account) or in Orders (for example, in the production order 

overview). In APS, open the Data menu and select Data transfer. 

To be able to transfer the data, APS needs to know the source of the data; in other words, it needs 

to know which database it should load the data from. 

In the standard version, the data is loaded from the Infor COM system directory containing both 

the Wizard folder and APS. If the required system is in a different directory, change this setting as 

described in the Configure database (see "Configure database (APS)" page 962) Help topic. 

In the following, the process of reading from the database or from files as well as the process of 

creating internal data structures is referred to as data transfer. 

For information on how to carry out a data transfer, see Transfer data (see "Transfer data (APS)" 

page 962). 

Notes: 

 To avoid potential problems in APS before loading data, you can delete all objects that have 

been loaded into main memory before you start a new transfer. To do this, open the System 

menu and select Delete all objects. 

 You can also check data for consistency errors. APS creates an error message for any errors 

it finds. To start checking, open the System menu and select Check objects. 

 To save data that was modified by APS back to Infor COM, you can either save transferred 

and modified orders in the order table or you can select Save modified orders from the File 

menu 

Transfer steps 

The following three steps describe how the data is loaded: 

 Enter the search or selection criteria in the dialog box fields on the Production order - due date 

or Production order - record type tab. 

 Click the Search button to search for header lines according to the specified criteria. You can 

carry out this step more than once; any new records found are added to the previous result. If 

you want to restart the search query, you can use the Delete button to clear the display. 
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 Use the Load button to load the orders for the header lines that were found (and selected in 

the ? column). 

Note: When you load orders, the referenced resources are automatically loaded at the same 

time. Select Fi le  and Load resources to load additional resources directly from the database. 

Notes on making a selection 

The Data transfer dialog box allows you to select large numbers of production orders and load 

them from the database into APS. It is essential that users select the production orders correctly, 

because the selection affects validity and efficiency: 

 Validity: If not enough production orders are loaded, relationships to orders that have not been 

loaded but that use the same resources are lost. 

 Efficiency: Too much data can makes system processing inefficient (depending on the 

hardware used). 

The following examples contain common selection variables: 

 Selection according to time horizon (Example: All production orders within the next 4 weeks): 

In this case, the relationships between different workshop areas are retained. However, there 

is the risk that unnecessary data will be loaded for the current planning task, with the result 

that the system can no longer work efficiently. 

 Selection according to work center IDs (Example: All production orders for work center 
4080): This enables you to restrict the data to specific machines or workshop areas. However, 

preceding and subsequent manufacturing areas are not covered completely. 

 Selection according to the status of the production orders: Typically, this selection method is 

used to avoid loading production orders that have already been completed (selection of all 

statuses except Completed). 

 Selection according to origin: Usually, planning in APS is only based on scheduled (or 

detailed) production orders. If you want to take future requests for capacity into account, you 

can also load the rough planned (that is, not yet scheduled) production orders. 

Additional transfer methods 

In addition to loading orders using the Data transfer dialog box, you can also use the Go to menu 

to transfer orders from Infor COM to APS. When you do this, you must, of course, bear in mind 

that when you transfer a single order to an otherwise "empty" APS system, for example, 

information can only be provided for the due dates of the individual manufacturing steps, but not 

for the capacity status of any assigned machines. 
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Updating data 

You can reload orders from the database in APS in various places by selecting the corresponding 

function from one of the numerous shortcut menus (you can also automate the function). This 

enables you to use APS as a monitoring instrument for Manufacturing. 
 

Configure database (APS) 

This topic describes how to define a different database connection to the default connection. 

1. From the System menu, select Configuration and open the Data transfer 1 tab. 

Please note: The Default default setting in the Infor COM directory field makes APS look for 

the Infor COM system in the directory above the Wizard directory. This means that it is usually 

not necessary to change the Default default setting. 

2. If you do need to change the Infor COM directory, click the button (labeled Default as long as 

the setting has not been changed) to open the window for the directory search. In this window, 

select the path for the Infor COM system from where you want to access the database (for 

example, the file server directory). 

3. Click OK to save the setting for the current user profile (see "User administration (APS)" page 

944). This ensures that the settings are available the next time the user logs on. 

Please note: You cannot save the settings of the Administrator profile. 
 

Transfer data (APS) 

To transfer data from Infor COM to APS: 

1. Open the File menu and select Data transfer. 

This dialog box allows you to select the required orders from the Infor COM database. To 

do this, you can begin by loading a number of order headers (see HR line in Record types 

(Manufacturing)) from the database and then selecting the ones for which you want to 

reload the complete order data. You can check and edit the loaded orders using APS. 

Depending on the default settings and any customizations implemented in your system, 

the search form may be displayed differently. 
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Note: Double-click a field in the table to switch directly to the order table for the data 

record. 

Please note the information on the selection of data records in Data interchange between 

Infor COM and APS (page 960). 

? 

A question mark indicates that the order has been selected. Selected orders are loaded or 

saved. Click the check box to change the default settings for the filter or deselect orders in 

the table that you do not require. 

You can reverse the sort order of the orders by clicking the question mark. 

Click the arrow to the right of the question mark to access to the following options: 

 Select: All data records are selected. 

 Select n lines: The number of lines specified in the subsequent dialog box is selected. 

 Deselect: All data records are deselected. 

Order ID 

Displays the order ID of the production order you have loaded. 

Status 

The colors in this column indicate the type of order data that has been loaded. The 

following table provides an overview of what the colors mean: 
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Color Meaning 

Gray The header order data is opened in a table for viewing. 

This is the status after you have run the Search 

command. No order data has yet been loaded. 

Green The order data has been loaded, but it has not yet 

been modified, for example, by planning. This means 

that you don't need to update the data source by 

writing the data back to the database. 

Red The order data has been modified. This means that 

you do need to update this data in - or save it to - the 

data source. If data has been modified, the check box 

is selected also. 

Resource, Description, LD, ED, Planning date, Status 

These fields are populated with values taken from the header of the production order. See 

also the detailed information on the Item, Desc., Latest, Earliest, Current, and Status fields 

in the Production order Help topic. 

Buttons 

To access the selection criteria for transferring data, use the Fi l ter  button in the Select 

f i l ter  dialog box. When you click the button, this opens a table where you can choose 

between predefined filters. Double-click the required filter to display the data that matches 

the criteria. Use the Load button to load this data. 

The Delete button removes the displayed data from the table (but it does not delete from 

the main memory any data that may already have been loaded). 

Click the Save button to write the orders in the ? column back to the database. 

2. Taking into account the notes on making selections in Data exchange between Infor COM and 

APS (see "Data interchange between Infor COM and APS" page 960), open the Production 

order - Due date tab and use the Order ID, Planning date and latest date (LD) fields to select 

the orders you want to load, or open the Production order - record type tab to select orders by 

record type. 

Example: 

To search for orders with a latest date between 01/01/2014 and 12/31/2014, enter the 

following settings. 

You can start the search without entering search criteria in the form. If you choose to do 

this, a warning message is displayed. 
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S

T 

bet 01/01/2014 3/31.12/2014 

 

To start searching for orders that match the specified criteria, click the Find button. 

3. In the ? column, deselect any orders that you do not want to load by clicking the check mark to 

undo the selection. 

4. Click Load to start the transfer process and make the selected orders available in APS. 

Note: The color of the field in the * status column indicates whether the order has been 

loaded completely (green), whether only the header data has been loaded (gray), or whether 

the order data has been modified in APS (red). 

 



966 | Infor COM 7.5 User Guide 

 

Manufacturing 

 

Planning board (APS) 

The planning board offers you a number of ways to display and plan the data loaded in APS. 

You can open the planning board by opening the Data menu for example, and selecting Open 

planning board. 

Note: Before you can open a planning board, you must have loaded the required data from APS. 

See also Data interchange between Infor COM and APS (page 960). 

When you have opened the planning board in APS, you can display the planning (see "Planning 

(APS)" page 950) carried out by APS in different views and then edit the planning data. 

The planning board consists of four areas: the toolbars (1), the data area (2), the time scale (3), 

and the information window (4). See also the following screenshot: 
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Data views in planning board (APS) 

APS offers different view types for displaying orders and resource assignments in the planning 

board (see "Planning board (APS)" page 966). The following screenshot shows (a) the Gantt 

resource view, (b) the utilization graph, and (c) the balancing view. 

 

 

 

 

 

Note: Apart from the data views of the planning board, there are also several table data views 

with fewer functions available. 

Please note: The following Help topic describes the features that the data views have in 

common. You can display Gantt order views and/or Gantt resource views in the planning board, as 

needed. 

Each data view is used for displaying an order or a resource. A data view is divided into the actual 

data area (2), where the resource assignment or order components are displayed and a label 

column (1) that provides information and functions – see the following screenshot. 
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The screenshot shows a multi-line Gantt order view and a single-line Gantt resource view, as well 

as a utilization graph. In the function area, you can see the various display icons for each view as 

well as the different object icons for production order, single work center, and work center group. 

The label column provides information on the order or resource displayed. For multi-line Gantt 

views, it also displays additional information on the resources that have been assigned to the 

corresponding order or on the orders whose operations are assigned to this resource. 

 At the top of the label column, an object icon (2), a display icon (1), and descriptive text are 

shown for the displayed object - see the following graphic (Gantt view) for a resource: 

 

 

 

 For multi-line Gantt views, the object icons and texts for the assigned resources or scheduled 

orders for each line are displayed next. You can change the width of the column using the 

mouse.  

Note: You can specify the width of the text column by selecting System and Configuration and 

opening the Data views tab (General form section). 

Texts that are not displayed in their entirety because the column is not wide enough are 

displayed in full when you open the ToolTip Help by positioning the mouse pointer on the text. 

 The display icon depends on the type of data view (Gantt, graph, or balancing view) and is 

used in the Gantt and balancing views for toggling the current display form in a single 

mouse click, in other words, for switching from the single-line to the multi-line display and 

back. 

 The object icon depends on the object displayed. It distinguishes between the different 

order types (production orders, sales orders, and purchase orders) and the different 

resource types (tools, employees, materials, and work centers) and also subdivides the 

resource types into single and group resources. The object icon provides functions for the 

corresponding object: Click once to display information in the information window, 

right-click to open a shortcut menu, and double-click to select all displayed bar objects 

associated with this object. 

 Click a data view to activate and select it (recognizable by the inverted label). 

If you hold down the CTRL key when clicking, you can select multiple views. 

Many of the toolbar functions require an active view, such as the function for displaying the 

complete assignment of a resource. 
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 When you move the mouse to the bottom of the label column, you can click and drag it to 

customize the height of the view within the range of the specified minimum and maximum 

values. The minimum height here is a definable value that prevents a view from disappearing. 

The maximum height is defined by the data displayed. 

To gain space quickly or to view all data at once, you can use the Minimum height and 

Maximum height toolbar functions. 

 

 

 

These functions allow you set all selected views to the minimum or maximum height in a single 

mouse click. 

Within the rest of the label column area, you can use the mouse (by dragging and dropping) to 

move the view and change the sequence of the views within the planning board. 

 
 

Add Gantt order views (APS) 

The Gantt chart is one of the views offered by APS for viewing the data on the planning board. You 

can use the Gantt chart for displaying orders, as described in the following, and for displaying 

resources. See Gantt resource views (see "Gantt resource views (APS)" page 971). 

In the planning board, orders are displayed in Gantt order views. The following notes explain how 

to work with the Gantt order view. 

1. Open the planning board by selecting Open planning board from the Data menu. 

2. In the toolbar, click the  button to display the required orders. 

In a Gantt order view, each operation in the displayed order is represented by a colored bar 

that indicates the exact start, duration, and end of the operation. The color of the bar depends 

on the color definition that is currently applied. If permitted by the operation's status, the user 

can replan the operation manually by moving the corresponding bar. If an operation contains a 

material line, it is displayed as a smaller (by default brown) bar above the operation bar. 

Gantt views can be displayed as single-line views or multi-line views. The following screenshot 

shows a multi-line Gantt order view: 
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In the single-line display of the Gantt order view, all bars are on one line. This makes the 

view relatively compact; details regarding the individual operations are hard to identify, 

especially if the operations follow each other closely. 

In the multi-line view, instead of operations, the individual lines of the production order are 

displayed each on their own line. In the label column, (see Data views in planning board 

(APS)), the corresponding resource (work center, tool) is shown for each time line. If these 

dates exist, the earliest and latest dates are shown for each line in the form of a (by 

default) green line underneath the bar. This clearly indicates the period of time within 

which the user can move the bar without violating these time frames – see screenshot. 

 

 

 

 

In the screenshot, the period starts on 10/11 and ends on 10/18. 

3. Right-click to open the Additional bars shortcut menu and select Predecessor/successor to 

display the predecessors and successors for each line or even for the complete assignment of 

the resource. The bars for these operations are shown a bit smaller and are not as bright in 

color so you can easily recognize the operations of the leading order. 
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4. The bars in the Gantt view provide information about the current dates associated with the 

operations. The current date always depends on the status; this applies to planned dates as 

well as to actual dates when the operation has already been started or maybe even 

completed. 

Use the Act. and Plan buttons on the toolbar to select the planning lines for the actual due 

dates and planning dates. The additional lines that are now displayed are referred to as 

planning lines. Each one of these lines explicitly represents the original planning date or the 

actual due date based on the current entered values, thus enabling you to compare planned 

and actual data. 
 

Gantt resource views (APS) 

For more information on the Gantt chart, see Add Gantt order views (see "Add Gantt order views 

(APS)" page 969). 

Gantt resource views are similar to Gantt order views, but their bars represent the individual 

operations assigned to the resources. 

Because resources or resource groups often allow you to process more than one operation at a 

time, parallel bars are nested in the single-line view. To a certain extent, this allows overlapping 

bars to be seen more clearly in this compact view. For an example of a single-line Gantt resource 

view, see the following screenshot. 

 

 

 

 

In the multi-line Gantt resource view, each operation line that has been planned for the resource is 

assigned a separate line. The label column displays the corresponding order. You can also use 

the Additional bars command on the shortcut menu to reload bars for predecessors and 

successors or entire production orders. 
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The following screenshot shows the multi-line Gantt resource view for the screenshot above. On 

the left, you can see the order IDs of the production orders in which resource 8370 is being used 

with an operation. 

 

 

 

In the multi-line Gantt resource view, each operation line that has been planned for the resource is 

shown in a separate line. The label column displays the corresponding order. Using the Additional 

bars function, you can display the bars for the predecessors and successors, or for entire 

production orders. 
 

Utilization graph (APS) 

The utilization graph displays the current utilization of a resource in the form of a graph or, in other 

words, as a horizontal line that is directly aligned with the time scale and whose height depends on 

the assignments at the corresponding point in time. Note the following points: 

 The maximum utilization of the resource is indicated by a dashed red line (see graphic (1)), 

which means that you can easily see the degree to which the resource is utilized at any given 

time. 

You can recognize planning problems immediately. Each operation causes the capacity 

utilization, which is represented by a corresponding line in the graph, to increase while the 

operation is being processed. The Gantt chart (see "Gantt resource views (APS)" page 971) 

and the utilization graph are precisely coordinated in terms of scheduling; you can clearly see 

which operation is causing an increase in capacity utilization. 

 

Position the mouse pointer on the graph view to display the degree of utilization corresponding 

to the current mouse position in percent. Overloads are also highlighted - the area between 

the maximum level and the graph line exceeding it due to the overload is shown in red (see 

graphic (2)). 

 The small green bars (see graphic (3)) indicate the shift plans and the resulting working 

capacity that is available. 

 Using the mouse, you can drag and open a selection frame in the graph view. After you have 

made your selection, the usual information and evaluation texts are displayed for all lines that 

utilize the resource within this selection frame. 



Infor COM 7.5 User Guide | 973 

 

Manufacturing 

 

 If you distribute percent utilization of a resource by a line over the period of time between the 

earliest date (ED) and the latest date (LD) for the line, this provides you with the rough 
assignment of the resource (see also Rough assignment graph (see "Rough assignment 

graph (APS)" page 973)). If there is a line with a duration of 5 hours, and 20 hours of capacity 

are available between its ED and its LD, this means that the line utilizes 25% of the resource's 

capacity available for this period. 
 

Rough assignment graph (APS) 

Please note: To display the rough assignment graph, you need to have selected the Rough 

assignment option on the Data transfer 2 tab in the APS configuration (accessible by selecting 

System and Configuration). Once you have done this, you can right-click to select the rough 

assignment view in the planning board. 

Like the regular utilization graph (see "Utilization graph (APS)" page 972), the rough assignment 

graph displays the rough assignment of a resource. When you visually compare the rough 

assignment line to the maximum resource utilization line, you can determine without any detailed 

planning whether the required resource utilization is feasible within the given ED-LD values. If the 

rough assignment of a resource already shows an overload, you cannot schedule the individual 

lines anymore within the corresponding dates for ED and LD without overloading the resource. 

The rough assignment graph in the following screenshot distributes the percentage-based 

capacity requirements over the period between earliest date and latest date (indicated by the 

green lines in the Gantt chart). 

 

 

 

 

The screenshot shows an overload. Because of the earliest date-latest date intervals predefined 

by Planning, this indicates that the specified operations cannot be scheduled without violating 

these due date limits. 
 



974 | Infor COM 7.5 User Guide 

 

Manufacturing 

 

Balancing views (APS) 

Balancing views compare the available capacity of a resource during a specific period of time to 

the capacity requested by the planned operations. 

The balancing diagram as well as the utilization graph (see "Utilization graph (APS)" page 972) 

allow you to compare supplied capacities to requested capacities. Unlike the utilization graph, the 

balancing view summarizes these capacities for a predefined period of time and thus provides an 

aggregate view. The balancing diagram provides information about whether basic capacities are 

needed and what the resulting utilization will be. The utilization graph, on the other hand, indicates 

whether there is a problem on a specific date. 

The following screenshot shows a multi-line balancing view over a period of several weeks with 

varying degrees of utilization. 

 

 

 

The two blue requirement bars with a black frame in the center of the screenshot are part of an 

operation that is planned from Friday through Tuesday; i.e., it utilizes the resource across the 

change of period. 

Note the following points for the balancing view: 
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 For each period, the supplied capacity is represented by a supply bar whose label and color 

indicate the supplied capacity within the set aggregation period as well as the degree of 

utilization. Underneath, the individual capacity requirements that result from the assignment of 

the resource during this period are shown as requirement bars. 

Usually, the top bar (the supply bar) covers a regular workweek from Monday through Friday. 

The bottom bar (the request bar) consists of the individual requirements. (Partial) bars 

represent the operations that require capacity from the particular resource and therefore 

determine the degree of utilization during the aggregation period. 

If the processing of an operation lasts longer than the limits of an aggregation period (for 

example, over a weekend), the capacity requirement is spread proportionally over two periods. 

This means that an operation can be divided into two (or even more) partial bars in the 

balancing diagram. When you click a partial bar, information is displayed about the exact dates 

of the operation or of the aggregation period. 

Note: Use the Merge requirements parameter on the Data views tab to specify that the 

requirements for a period are to be displayed as one single bar. 

 You can also display the balancing view with multiple lines (see previous graphic). This is only 

useful if you want to distinguish the individual requirements from each other and identify even 

small requirements. However, you cannot assign the lines to individual orders. 

 An operation creates a capacity requirement for a period if it is processed, or should be 

processed, partially or entirely within this period. A longer operation can therefore create 

capacity requirements in any number of periods that are represented by a corresponding 

number of requirement bars. 

 The requirement bars of a period are placed in order so that you can easily see the total 

requirement and compare it with the supply bars. This allows you to reconcile the capacity that 

is available during a certain period with the supplied capacity. 

 Weekends are displayed in gray, and the days are clearly separated from each other by 

dashed lines. If the current date falls within the period displayed, it is highlighted in yellow. 

 The color of the supply and request bars is determined by the color definition for the operation 

lines that is currently applied to the planning board. The color of the supply bar (the top bar) is 

controlled by the "capacity" color map, which depends on the degree of utilization of the 

resource. 

The default colors for the periods are as follows: 

 Periods with a sufficiently low utilization are displayed by a green bar. 

 Periods with a utilization of more than 70% are shown in pink to alert the user to the fact 

that a problematic situation may arise. 

 Periods with a utilization of more than 90% are shown in red. 

 Bars in the past are shown in gray. 

If the capacity requirements (request bar = bottom bar) for a period are displayed as a 

summarized bar, the color formatting is applied in accordance with the Requirement entry 

in the Capacity color map (the default color is blue). If the capacity requirements are 

represented by single bars, the color formatting is based on the color map that is currently 

activated for operations. By default, this is the color map used for statuses and is based on 

the following values: 
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Color Capacity 

Blue Detailed/Rough planned 

Yellow In progress 

Red Interrupted 

Brown Completed 
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Information in planning board (APS) 

The bar objects in the Gantt and balancing views provide information by means of associated bar 

texts (see "Text in planning board (APS)" page 977), positions (see "Position in planning board 

(APS)" page 977), colors (see "Colors in planning board (APS)" page 978), and other forms of 

highlighting (see "Highlighting in planning board (APS)" page 979). 

There are several ways of manipulating how this information is displayed in the planning board. 

See also the following Help topics. 
 

Text in planning board (APS) 

The following are different types of bar texts: 

 Bar label: When the default setting is used for Gantt bars, the bar label displays the order and 

the BOR line of the associated operation, for example. 

For the capacity supply bar, it provides information about the existing capacity and requested 

capacity. However, this information will only be displayed if the bar has a certain minimum 

length. 

 ToolTip: It is displayed as soon as you position the mouse pointer directly on the bar object. It 

contains more detailed information, for example, about the current, earliest, and latest date of 

an operation. 

 Text in the information window: Similar to the ToolTip, it contains additional information about 

the data object associated with the bar as well as an evaluation that is based on the currently 

valid planning profile. 
 

Position in planning board (APS) 

The position and length of a bar in a Gantt view provide information on the start and end of an 

operation. In multi-line views, the line position also indicates the production order that the 

operation is based on (in the Gantt resource view), or the resource that has been assigned (in the 

Gantt order view). In the balancing view, the position of a requirement bar allocates the start of an 

assignment to a capacity period, while the length indicates the requirement's proportion of the 

overall requirement during the period in percent. 
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All bar objects allow you to manually replan the base operation, provided the operation has an 

appropriate status. During this replanning process, you can change the due date as well as the 

assigned resources by dragging the bar from one resource view to another. 
 

Colors in planning board (APS) 

The color of the planning board bars can help you to identify relationships and statuses quickly, 

even for a large number of objects. 

This is why color maps can be helpful. In a color map, a data value is represented by a specific 

color. There are three different types of color maps: one for capacity bars, one for material bars, 

and one for the bars of operation and tool lines. 

Example: In the Status color map for operation and tool bars, by default, the Scheduled status is 

represented by the color blue and the status Released by the color green. The Late color map, on 

the other hand, shows operations for which the current date is after the Latest date in red and 

operations prior to the Earliest date in yellow. 

To change the colors used in a color map, complete the following steps: 

1. Click the  button. 

2. In the Color legend window, click Status, Capacity, or Material to load the information about 

the required color map. 

3. In the Description and Value columns, make changes by clicking the required field and 

overwriting the entry. In the Bar color and Text color columns, make changes by 

double-clicking the color you want to change and then making a selection in the Colors 

window. Confirm the selection in the Colors window by clicking OK. 

Notes:   

 If you only want to change the color of the bar, all you need to do is click the respective bar 

in the color legend. 

 Depending on the type of color map, you can add additional entries or delete existing 

entries. 

 Click Save to save your changes. These are then loaded automatically the next time APS 

is started. 
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Highlighting in planning board (APS) 

If the display contains a large number of bars, we recommend that you use the Highlight function 

for highlighting rather than the color maps. 

1. From the Highlight list box on the second toolbar, select the type of highlighting you require. 

The options Orders, Operations, Tools, and Items are available. 

2. When now you click a bar, all other bars that can be linked to the operation or line using the 

selected highlighting function (in other words, for example, all operations or lines that belong to 

the same order) are displayed in bright colors. All others are pale and move to the background. 

The following additional forms of highlighting are also available: 

 Light green lines to denote the Earliest and Latest date 

 Red horizontal line in a bar to indicate an operation with fixed due dates 

 Yellow line to indicate progress (provided, a partially complete transaction has been 

entered) 

 Red flag to indicate that APS has already written the operation to the database. 
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Customize display area in planning board (APS) 

You can use the third toolbar in the planning board as well as the time scale to control the display 

area. Both tools enable you to adjust the period that is displayed and the current zoom factor (in 

other words, the number of seconds per pixel). 

 The time scale describes the period that is currently displayed using a grid label that adapts to 

the corresponding resolution. You can change the time period using the scroll bar. The entire 

scrollable period depends on the planning horizon, in other words, it is determined by the 

earliest and the latest planning date. 

 Using the time scale, users can select a section in the current view and adjust the zoom so 

that only this section is visible. To make a selection, hold down the left mouse button and drag 

a frame to select an area within the time scale. This procedure is useful, for example, if you 

want to specifically look at one particular week in an overview view that covers several weeks. 
 

Configure planning board graphics (APS) 

You can configure the way in which resources are displayed graphically in the planning board (see 

"Planning board (APS)" page 966). To define the required settings, select System > Configuration 

> Bar 1/Bar 2. 

Examples of these settings are as follows: 

 Options for setting the display of bar objects on the Bar 2 tab: Numerous settings are provided 

to allow you define, for example, the display of additional information (such as texts inside the 

bars), shift plan lines at the bottom of the resource views, and additional bars in the Gantt 

order view. 

 Settings for the height and distance between individual objects: Reducing heights and 

distances between individual objects allows you to view significantly more work centers at a 

glance, for example. You can also get the information you need on problem areas by using a 

suitable color map (see "Colors in planning board (APS)" page 978) to indicate operations that 
are late, for example. 

 Restrictions on the use of graph views to allow identification of points in time during which 

work centers are underutilized or overutilized. 

 Exclusive use of balancing views to determine the capacity situation of multiple work centers 

over an extended period of time. This can be useful, for example, when workshop areas 

receive orders for one week and then decide on the assignment of machines themselves. 

 



Infor COM 7.5 User Guide | 981 

 

Manufacturing 

 

Working with the planning board (APS) 

This Help topic describes how to configure the various views in the planning board (see "Planning 

board (APS)" page 966) using the various functions available. For more information, see Use APS 

(page 943). 

Note: You can use the  button to cancel any number of actions. Once you have run the 

automatic Replanning and New planning functions, you can no longer cancel actions. In such 

cases, you need to reload the orders from the database. 
 

Correct rule violations (APS) 

One scenario where it is useful to work with the planning board is when adjusting the rule 

violations listed in the evaluation table (see "Evaluate plan (APS)" page 958). In this case, you can 

use the shortcut menu from within the evaluation table to load the required views into the planning 

board. If, for example, a due date has been violated, it is useful to display the Gantt view for the 

order concerned first. This view allows you to adjust the due dates of the individual operations by 

moving the bars with the mouse. When you do this, you usually need additional information about 

other orders that have been assigned to the same work centers. 

To display this information, complete the following steps: 

 Set the Gantt order view (see "Add Gantt order views (APS)" page 969) to multi-line and 

display the assignment of the relevant work centers within the order view by selecting the 

Additional bars function. The multi-line view displays the intervals between the earliest date 

and the latest date of the operations. These, in turn, provide important information about the 

period within which the operation can be scheduled. 

 Display the relevant work centers in additional views. You can access these views using the 

shortcut menu. 

 

When adjusting the planning, note the following points: 
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 You can replan (in other words, assign new dates to) individual operations by using the mouse 

to move the corresponding bar. When the bar is being moved, a highlighted frame shows the 

corresponding current position of the operation. At the same time, additional detailed 

information is displayed in another yellow detail window. The frame at the mouse pointer 

represents the position the bar would have if you released the mouse button at this moment. 

Depending on the shift plan, the length of the frame adjusts automatically to the anticipated 

duration of the operation. For example, if weekends are non-working times, the duration is 

extended accordingly. 

Please note: Moving planning bars manually may distort the order sequence; in other 

words, the moved operation may be placed before or after the predecessors/successors. To 

avoid complex replanning by hand, set the switch in the Automatic reconciliation section on the 

Planning tab in the configuration. 

 After you have completed the replanning, the relevant data views are updated and the 

assignment of the new due date is evaluated based on the current rules. The result of the 

evaluation is displayed in the information window in the planning board. 

Note: Planning adjustments can lead to new rule violations. We therefore recommend that you 

regularly include several operations in the evaluation. See Evaluate (see "Evaluate (APS)" page 

982). 
 

Evaluate (APS) 

When you correct rule violations (see "Correct rule violations (APS)" page 981), this often 

generates new rule violations. We therefore recommend that you carry out a regular evaluation 

that spans multiple operations. To do this, the following options are available: 

 When you extend a selection border, this results in an evaluation of all operations selected in 

this way. 

 When you double-click the object icon for a view (see Data views in planning board (see "Data 

views in planning board (APS)" page 967) (APS)), you select and evaluate all operations 

associated with the order or resource. 

 When you click the  button, this locates and selects all operations or lines of the currently 

selected view, or within all views if no view has been selected. 

 When you click the  button, this evaluates all selected operations or all displayed 

operations if no operation has been selected. 

To evaluate all loaded operations, select the Planning or Evaluation menu command. 

The evaluation table generated as a result of a planning process in APS lists the problems 

that could not be resolved during planning. This table lists all violations of constraints that 

were identified during this process. 

Note: If you click the buttons on the right of the table, you can scroll through the displayed 

messages on a page-by-page basis, if applicable. 
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Total (sum) 

This field displays the total number of penalty points, regardless of which filter you have 

selected and how the table is displayed. 

Total (displ.) 

This field displays the total number of penalty points for the currently selected (filtered) 

data records. The total depends on the level of severity selected in the Filter field. If the 

field is set to No violation, all penalty points are displayed. If this is the case, then Total 

(sum) corresponds to the value contained in the Total (displ.) field. 

Cnt 

Shows the number of violated constraints. 

Filters 

Use this field to choose a filter for selecting the displayed violated constraints according to 

various criteria. For example, select the violations to be displayed according to the severity 

of the violation. 

Penalty 

This column contains the number of penalty points that are assigned for the violation of the 

corresponding constraint. The penalty measure (between 1 and 10000) is calculated by 

multiplying the weighting (for example, Consistency violation = 10000) with the severity of 

the violation (in percent). 

Severity 

This column shows the degree to which a rule was violated. The value is specified in 

percent. 

Example: If an operation is planned more than one day after its latest date, the Latest date 

rule applies. If the delay is only for a few hours, the severity is decreased to 50%, for 

example. The number of penalty points is therefore halved. 

Reason 

Contains an explanation for the rule violation found. 
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Object 

This column displays the name of the operation or BOR line where the rule violation 

occurred. 

Order 

This column displays the order for the object where the rule violation occurred. 

Name 

This column contains the name of the rule that was violated. 
 

Move operation (APS) 

As well as replanning operations purely in terms of their scheduling (see Correct rule violations 

(see "Correct rule violations (APS)" page 981)), you can also move individual operations from one 

work center to another. You can also carry out this planning process by moving a bar with the 

mouse, in this case, from one view to another. 

Whether you can move an operation from one work center to another depends on the 

configuration setting Move to other work centers (System and Configuration, Planning 1 tab). 

 If None is set, you cannot move any operations. 

 If All is set, you are free to move any operation (in other words, without the system performing 

any checks). 

 If Alternatives is set, you can only move operations to work centers that have been explicitly 

identified as alternative work centers in the Infor COM database. 
 

Check loading of resources (APS) 

Gantt views (see "Data views in planning board (APS)" page 967) allow you to replan operations 

easily and, above all, very accurately. However, for work center groups with several parallel 

operations in particular, they only provide limited information about the work centers' capacity 

utilization. 
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The balancing view (see "Balancing views (APS)" page 974) and the graph view (see "Utilization 

graph (APS)" page 972) are better suited for displaying capacity utilization and especially for 

identifying overloads. When you use an appropriate zoom setting for displaying a resource, you 

can view its utilization over the entire assignment period at a glance. You can quickly identify 

overloaded times because they are highlighted in color. 

The following buttons are especially useful here: 

  

  

You can use these buttons to show the entire area of interest for a resource with a click of the 

mouse. To view detailed information, you can drag and open a suitably large selection frame in the 

time scale. The display then zooms according to the selection frame. 

While the graph view itself does not allow you to plan interactively, the balancing view can be used 

very well as a rough form of planning whose goal is not to plan individual operations down to the 

hour or even minute, but simply to create operation queues for individual workshop areas. These 

operation queues should utilize the capacity of these areas for a specific period of time (for 

example, for a week). The processing sequence is not fixed however, this is determined by the 

responsible technician or foreman. 

In a case like this, it is the goal of the user to distribute the specified operations over the individual 

capacity reservoirs so that the work centers are utilized as evenly as possible during these 

periods. If it is necessary to replan an operation, you can do so by moving the bar for the 

corresponding requirement like in the Gantt chart. 

Please note: You can only move requirement bars if a grouped bar is not displayed. 

 Note that the requirement bars are not displayed in exact alignment with the time scale. If users 

try to move operations using requirement bars, like in the Gantt chart, a frame is drawn that 

accurately identifies the corresponding current position and duration of the operation. When you 

release the mouse button (in other words, when you schedule the operation), the operation 

receives the assigned due date, and the requirement bars corresponding to this date are displayed 

in the balancing view. Frames and result bars in the balancing view can therefore differ greatly 

from each other due to this different focus at the time line. 
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Table data views (APS) 

In contrast to the data views in the planning board (see "Data views in planning board (APS)" page 

967), APS also provides table data views for displaying detailed data on individual resources and 

orders. These table data views are explained in the following. 

The following options are available for displaying your data concisely in Infor COM: 
 

Order table (APS) 

The order table is used to display the detailed data for one or more orders. The tree structure in 

the left part of the table shows the structure of the orders in terms of operations and their 

breakdown into BOR lines. Like in the BOR view in Infor COM, the structure is formed from the 

bottom up, in other words, the first operation is shown in the last line of the order and the last 

operation in the first line. 

The different tabs display the individual detailed data, such as the exact date data for each BOR 

line and operation in an order. 

To access the order table, open the Data menu and select Order table. In the dialog box that 

opens, define the selection criteria for the required orders. Confirm by clicking OK. When you click 

the + (plus) sign in the order table next to the directory icon for an order, you can open the 

individual operations of the order. For each operation, you can expand information about the 

required resources by clicking the + (plus) sign next to the operation name. Use the - (minus) sign 

to collapse the expanded subfolders. The following graphic shows a section of the order table. 

Note: In the tree structure, you can right-click any order or resource to open a shortcut menu with 

a number of functions. 

The columns of the table contain the various attributes of the orders or operations. You can 

manage the column criteria by selecting tabs, all of which can be configured. You can edit any field 

in the table that has a white background, which means that you can enter values in these fields. 

However, you cannot enter anything in fields that have a gray background. 
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Resource table (APS) 

Similar to the order table (see "Order table (APS)" page 986), the resource table provides detailed 

information about individual resources. For work center groups, the tree structure on the left side 

of the screen shows the relationship between the group and the individual work centers. 

 In the context of APS, resources are manufacturing means of any kind that are required to 

process an order. Resources include employees, materials, machines, or tools. 

 An operation is a group of resources that are planned in parallel. 

Like in the order table, you can view the resource data in detail before you start the planning. To 

open the resource table, open the Data menu and select Resource table. There are four tabs that 

provide you with detailed information about the production order: General, Time, Quantity, and 

Switch. For more information on the individual fields, refer to the Help topic on work centers. 

The following resource table shows all of the details for the individual resources: 

 

 

Resources  Short description Group Single PAct. Alternative 

resource 

4080  Spindle lathes x  2  

 4081 Spindle lathe1  x 1 4082 

 4082 Spindle lathe2  x 1 4081 

 

 

In the resource table, work center group 4080 is shown with the single work centers 4081 and 

4082. 

The fields PAct. (number of parallel activities) and Alternative resource are taken from the 

Planning and Alternatives tabs in Work centers. 
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Utilization table (APS) 

The utilization table is used to display the utilization of work centers. Supplied and requested 

capacities are compared to a period that you can define as required (shifts/days/weeks). When 

you use the Display single requirements switch, you can see in detail how the assignment of a 

specific operation to a work center affects the work center's capacity situation. 

The utilization table provides additional information on the utilization of a resource per period. You 

can select a period type of your choice. To view the utilization table, open the Data menu and 

select Utilization table. 

When the individual requirements are displayed, you can see to what extent individual operations 

are assigned to the work center. The shade of color of the utilization column is based on the color 

map for the supply bars in the balancing diagram; which means that you can easily recognize 

capacity bottlenecks. 
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Shift plans 

Note: The following description on maintaining shift plans applies to both APS and GPP. 

To access the shift plans, start APS or GPP, open the Data menu and select Shift plans > Display 

shift plan data. The functions provided by this command depend on the settings defined in the 

configuration. For more information about the fields displayed, see below. 

This dialog box displays an overview of the shift plan data that was loaded and is used for 

checking data. 

(Annual) shift plans in APS, like in Infor COM are composed of intervals, shifts, days, and weeks. 

In addition, shift plan chains are formed from successive annual plans. The individual shift plan 

objects of a shift plan chain can be listed here and the exact composition of the chain can 

therefore be checked. 

From, To (fields) 

These fields display the period for which shift plan data exists. 

Displayed, From 

These fields show the current and maximum number of pages respectively that you can scroll to 

by clicking the buttons on the right of the table. 

From, To (columns) 

These columns show the period covered by a shift plan object. 

Duration 

Shows the duration of the period covered by a shift plan. 

Type 

Displays the shift plan type. See also Store working hours in shift plan (APS). You can also filter 

the displayed shift plans according to type. To do this, use the Filter field. 

Please note: Use the Database or Files configuration setting on the Working hours tab to define 

whether you want to transfer the shift plans directly from the database or whether you want to 

maintain them redundantly - like in Infor COM Release 6.1. 
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Maintain shift plans 

Please note: The maintenance of shift plans depends on the configuration described in the 

associated topic. 

The shift plans are structured in exactly the same way as those in Infor COM; in other words, you 

create annual shift plans that contain all information related to the working hours of one year. This 

type of annual plan consists of 52 (sometimes even 53) weeks. For each weekday, a special daily 

plan must be set up that, in turn, consists of the shifts specific to the company. The exact time 

intervals (shift duration, breaks, overlapping of shifts) are defined in the intervals. 

 The smallest unit of a shift plan is therefore the interval, followed by the shift, the day, the week 

and finally, the year (annual plan). 

Complete the following steps to create shift plans in APS/GPP: 

1. Define basic working hours (intervals, shifts, days, weeks) 

2. Define public holidays and other days that are generally non-working days 

3. Create annual plans based on this data 

4. Assign the annual plans to the shift plan IDs in the Infor COM database 
 

Store working hours in shift plan 

To store working hours in a shift plan (see "Shift plans" page 989), complete the following steps: 

1. From the Data menu, select Shift plans and then Edit shift plans to open and edit a shift plan. 

2. Before you can create a new annual plan, you need to define the basic working hours. First, 

define the intervals (in other words, the working hours without breaks) by clicking the New 

button next to the interval table. 

3. In the dialog box, enter a name for the new interval (one that does not already exist). 

4. Specify the start and the end of the interval in the table. 

Please note that the start time must be before the end time and that times after 0:00 must be 

specified as 24+x. If, for example, an interval begins at 23:00 and ends at 5:00, you must enter 

the end time as 24+5 = 29:00. 
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5. After you have created the intervals, you specify the shift combinations. To do this, select the 

New, button, enter the name of the shift plan in the dialog box that is displayed, and then enter 

the intervals for the shift plan. 

 

Note: When you create the days, you should make sure that you also create a free day and a 

half day. Using these day elements, the annual plan can take half days and free days into 

account. 

It is also recommended that you create week elements with one additional free day each (in 

other words, one week with Monday free, one with Tuesday free, and so on.). These special 

weeks are used later when you generate the annual plans. If required, APS/GPP can also 

generate these weeks automatically. However, if you create them in advance, you can ensure 

that they are named in accordance with your requirements. 

 

Apart from the New button, the following buttons are also available for further editing: 

 

Copy Creates a copy of the displayed element and saves it under a different name. 

Delete Removes the element displayed. If it is still in use, a corresponding warning 

message is displayed. If you delete the element anyway, APS/GPP replaces 

it with the Default element. 

Usage Displays a tree structure that illustrates the subsequent elements in which the 

element you have selected is used. When you double-click one of the 

elements, it is displayed in the corresponding part of the shift plan window. 

Rename Allows you to rename a shift plan element. This is of particular interest in the 

case of weeks that were created automatically when the annual plan was 

generated. 
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Store non-working days in shift plan 

When generating annual plans, APS/GPP can take public holidays and other non-working days 

into account. To store non-working days and public holidays in the shift plan, complete the 

following steps: 

1. Open the Data menu and select Shift plans followed by Public holidays. If the Load public 

holidays selection window is displayed, select the required file with the information. 

2. Edit the public holiday data in the dialog box that is displayed. When you click the arrow for a 

line in the Type field, a list box will display the type of public holiday available. 

 In the Shift column, you can also assign a shift day to each public holiday by selecting a shift 

day from the list box. When generating the annual plans, the corresponding day in the default 

week is then replaced with this shift day. 
 

Create and edit annual plan 

To create an annual plan, complete the following steps: 

1. Open the Data menu and select Shift plans followed by Edit shift plans. 

2. Click the New button next to the annual plan display to open the input dialog box. 

3. You can now use the From and To fields to create a series of annual plans. This series 

describes a shift plan over a period of several years. In other words, at the end of a year, an 

automatic change to the next year takes place. The shift plans can differ, for example, due to 

the different non-working days to be considered. 

 As well as entering values in the From and To fields, enter a name for the shift plan. For the 

period from - to, this name is then linked with the corresponding years. 

Note:  Use the Predecessor and Successor fields in the Edit shift plans dialog box to modify 

the relations between series of annual plans retrospectively. Note that each annual plan can 

only be a predecessor and a successor to one other plan. 

4. Enter the Week as copy template. This specifies the week that you want to use as the default 

week. 
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5. The file containing the public holidays is used as the basis for the non-working times that need 

to be taken into account. Click the Change button to select a different file or click the Without 

button to continue without taking into account any public holiday-related information. 

6. You can now edit the annual plans you have created in the annual plan table in the shift plan 

dialog box: 

 For example, select Select from the shortcut menu to replace individual weeks. 

 Click the Replace button to replace a week throughout the entire annual plan. 

7. Save the shift plan file using the Save button. A shift plan file can store any number of annual 

plans. 
 

Assign shift plans 

When loading the data, only the IDs of the Infor COM shift plans are transferred from the 

database. In order for APS or GPP to be able to use the correct APS/GPP shift plans during 

scheduling, the corresponding names of the APS/GPP plans must be assigned to these IDs. You 

can do this using a dialog box, which you can open by selecting Data, Shift plans, and Shift plan 

assignment. 

In this dialog box, you assign the shift plans in APS/GPP to Infor COM shift plans. To create a new 

entry, click New. This opens a dialog box where you need to enter the ID of the Infor COM plan. 

Select the required APS/GPP plan as usual using the shortcut menu (right-click). You should enter 

an early year, if possible. Annual plan series make the transition to subsequent years 

automatically. 

After you have assigned the APS/GPP plans to the Infor COM plans, you must save this 

assignment. Use a meaningful file name that describes the contents of the file. 

Note: For technical reasons, the change of shift plan assignments will only take effect after you 

reload the resource and order data. This also means that, for example, the old shift plan data will 

be shown in the planning board until you have reloaded the data. 
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Configure shift plans 

APS/GPP usually requires the shift plan data at the time the system is started; it therefore needs 

to know where to find the relevant shift plan and allocation files. It also requires a default shift plan 

for unresolved situations that it can use when no plan has been specified (for example, because 

no APS/GPP plan was specified for an Infor COM shift plan ID). Define the configuration as 

follows: 

1. Open the System menu, select Configuration and then click the Working hours tab. 

2. In the Shift plans section, select the required settings for the Default shift plan, the Shift plan, 

and the Assignment file. 

Note: These options can only be accessed if the Load shift plans from Files setting is 

enabled. 

The configuration settings for the shift plan data determine which data is loaded by default. 
 

Save APS changes to database 

This Help topic describes how you can save the modified data back to the Infor COM database 

when you are finished planning. 

After you modify order data, you must save it to the database so that the changes are available in 

Infor COM. To save the changes, open the File menu and select Save modified orders. 

If you open the File menu and select Data transfer, you can specify more precisely the orders you 

want to save, for example, if you only want to save back some of the modified orders or just the 

data in one particular order. 

To do this, we recommend that you use the Filter button to first select just those orders that have 

been modified. You can then clear the orders that you do not want to save, as required. When you 

save the selected orders, their data is saved back to the database. 
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For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

Please note: Report names are always structured as follows: ir<module><report name>. For 

more information on the reports not found in this Help topic, see the Help topics for the reports for 

the modules concerned. 

These reports are displayed in Manufacturing when you select the Reports object. 

Note: You can influence the displayed lists by assigning user privileges. 

This dialog box provides you with access to a number of reports in manufacturing. These reports 

make data records, according to the criteria selected by you, available in list form as a printout. 

Reports (Manufacturing) 
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Report Contents 

Archived 

production orders 

Displays the archived production orders. 

Advice for 

sales orders 

This report provides an overview for manufacturing and specifies what items 

need to be delivered, together with the corresponding quantity, recipient, and 

delivery location. You can filter the orders, delivery dates, and the sales order job 

using the start form. The report then specifies the corresponding requirements of 

the first level, grouped according to order. 

Processing statuses of the 

production orders 

Displays all production orders and the corresponding processing statuses. 

Work center group 

utilization plan 

Specifies the production orders that utilize each work center group. 

Work center 

utilization plan 

Specifies the production orders that utilize each work center. 

Tool repair order overview This report allows you to display an overview of the tool repair order - see Repair 

tool. 

Note: The parameter setting 

COMMON.WERKZEUGVERWALTUNG.REPORTMAINTORDERS=yes is a 

requirement for this report. 

The report ID for tool repair orders is assigned according to numbering method 

513. The report shows selected repair order data that has been summarized 

from the production orders. 

The Summarize tool  rep. orders  function in Manufacturing  is 

used for preparing the data. A new report ID is assigned every time this 

summarization process is started. 

 

Please note: Information on reports that are assigned to other modules is available in the Help for 

the respective module. 
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Reschedule production orders 

Click here for information on Production orders (page 918). 

For general information on scheduling, see Schedule production order (page 923). 

If you have made scheduling changes to order lines in the work center or capacity account, you 

must carry out a rescheduling process to reschedule all orders affected by the changes. 

1. In Manufacturing, select Reschedule production orders. 

2. In the Reschedule orders tab, you can select the orders that you want to reschedule by 

specifying the Order ID, Job, and/or Resource. 

3. Decide, by selecting or clearing the With idle time check box, whether or not you only want to 

update the due dates of the order lines if a date overlap would otherwise occur. 

When you confirm by clicking Schedule, midpoint scheduling (see "Perform midpoint scheduling" 

page 926) is carried out from the new date for every order you have selected that contains a 

flagged date change. 
 

Summarize tool rep. orders 

This process is used for preparing the Tool  repai r order overview  report in Manufacturing. 

This report shows selected repair order data that has been summarized from the production 

orders. See also Reports (Manufacturing) (page 996). 
 

Batch processes (Manufacturing) 
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For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

The Accounts folder in Manufacturing contains the Work center account (page 999), Item account 

and Capacity account. 
 

Work center account 

Call 

Manufacturing > Accounts > Work center account 

Description 

The work center account allows you to view, from a work center, all manufacturing orders for 

which the work center is planned. 

Unlike the Order view found in the production order, the work center account provides a machine 

view. This allows you to easily check the utilization of a work center, and then take corrective 

action if necessary. Any changes you make in the work center account are automatically 

implemented in the relevant order. If you change a date, the system automatically offers to carry 

out midpoint scheduling for the changed production order. 

Functions 

Since a number of the functions provided in the production order affect the work center, you can 

also select these functions from the work center account: 

 Rescheduling of the work center 

 Releasing of the operation running on the work center 

 Troubleshooting for the work center during the manufacturing process 

 (Unplanned) outsourcing of the operation to a subcontracted manufacturer 

Accounts (Manufacturing) 
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In addition, you can also select the following functions in the work center account: 

 Grouped operations and 

 Sequence optimization 
 

Optimize sequence 

If several operations are to be carried out on the same work center, you can schedule their 

sequence in line with defined criteria to minimize the time required for setup or modifications, for 

example. 

To carry out optimized scheduling in this way, you need to carry out the following preparatory 

steps: 

 The scheduling criteria are defined for each relevant work center. 

 The different criteria are stored as machine types in the RFOLGEOPT allocation table 

 The corresponding machine type in the master data is assigned to each work center to be 

scheduled. 

Once these preparations are complete, you can carry out scheduling: 

1. In the work center account (page 999), select Functions and Sequence optimization for the 

new work center to be scheduled. 

All operations that will be carried out on this work center are sorted in the table in ascending 

order according to the criteria stored in the machine type. 

2. To schedule the operations in the created sequence, you must reschedule the work center. 

3. In order to update the dates in the corresponding production orders as well, you must 

reschedule the changed orders. 

 

Example of how scheduling criteria are assigned: 

You want to schedule operations based on the setup time, the duration of the operation, or the 

setup time and duration of the operation. The following machine types are therefore stored in the 

RFOLGEOPT allocation table: 
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M type Criterion Description 

OP DbSatz.DbPart.Te Can be scheduled according to runtime 

M DbSatz.DbPart:Tr Can be scheduled according to setup time 

NC DbSatz.DbPart.Tr, 

DbSatz.DbPart.Te 

Can be scheduled according to setup time 

and the job 

 

These machine types are stored in the master data for the corresponding work centers. On the 

Planning tab of the work center, the machine type B is assigned to a work center whose 

operations are scheduled based on the setup time. 

You can then sort and schedule the work center in the work center account based on the setup 

time. 
 

Create grouped operations 

Description 

You can use grouped operations to group together similar operations in a logical manner. This 

grouping has a knock-on effect in the SFDC system. If a transaction is entered against any 

operation in these grouped operations, this transaction is automatically entered for all 

corresponding operations. 

Conditions 

Operations can only be usefully grouped together if they fulfill the following conditions: 

 The operations are the same 

 The operations are short 

 The operations originate from different orders 

 The operations are carried out on the same work center 
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Create 

Grouped operations can be set up in the Work center account (page 999) and in the Order lines 

object. The following sections describe processing in the work center account, the procedure for 

order lines is the same. 

Carry out the following steps to set up grouped operations: 

1. In the work center account of the corresponding work center, select the operations that you 

want to group together. 

2. Select Functions > Grouped operations to assign a temporary ID to all selected operations. 

3. Select Functions > Release to release the operations on the work center. All operations that 

were assigned a temporary ID automatically receive a common group operation ID. 

Effects 

The creation of grouped operations has the following impact on SFDC: 

 Each transaction entered via SFDC for an operation belonging to the grouped operations is 

automatically implemented for all operations to which the same grouped operation ID is 

assigned. 

 Different transactions do not need to be entered for the same operation. For example, a start 

transaction may be entered against the chronologically earliest operation, and an end 

transaction may be entered against the chronologically latest operation. 

 Entered dates are entered identically for all operations, so that all operations receive this date 

as the start date for the start transaction and all operations receive the same due date for the 

end transaction. 

Depending on the setting selected in the configuration (DistributeGroupOfOperations 

parameter), entered times and quantities are distributed proportionally or equally across all 

grouped operations. 

Equal distribution means that times and quantities are divided by the number of operations, 

whereas for proportional distribution, the times and quantities are distributed across the operations 

proportional to the planned times and quantities. Proportional distribution is used in the standard 

version. 
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Call several times 

You can select the Grouped operations function multiple times to retroactively add individual 

operations to the grouped operations. The grouped operation ID is only assigned when the 

operations are released. 

Several groups 

If you want to create more than one set of grouped operations for a work center, select only the 

operations of the first set and release these before you select and release the next set. This 

means that each set receives its own grouped operation ID. 

If you have selected operations in the Order lines object and released these as grouped 

operations that are not to be performed on the same work center, a set of grouped operations is 

automatically created for each work center. 

Note: The temporary grouped operation ID for the operations is removed again when you exit the 

work center account. The ID is only assigned as an intermediate step between defining and 

releasing the grouped operations. It is therefore not possible to group operations without 

subsequently releasing them. 
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For general information on the Manufacturing component in Infor COM, see Manufacturing basics 

(page 818). 

Note: See also Configuration (Archive). 

To start archiving processes, open the Archive folder in Manufacturing and select the required 

object. 

During archiving, a production order is moved from the current movement data to a special archive 

database. Archived production orders are no longer managed in the overview table of current 

orders. 

Individual lines of a production order cannot be archived separately. Production orders are always 

archived completely and with their current status. 

It does not matter whether or not the order is closed when it is archived. The system automatically 

closes any unclosed production orders before archiving them. 

You can archive production orders for an individual order, or archive several orders 

simultaneously as part of a batch archiving process. 
 

Activate production orders 

For information on archiving production orders in Manufacturing, see Archive (Manufacturing) 

(page 1004). 

If you want to access an archived production order again, you must activate it. Follow the steps 

below to activate an archived production order. 

1. Select Manufacturing > Archive > Production orders. Click the Open tab. 

2. Enter the ID of the order to be activated in the Order ID field. 

Note: Use wildcards to display all archived production orders. 

3. Confirm by clicking Load. The archived production order is then opened. 

4. From the menu, select Functions and Activate. 

Archive (Manufacturing) 



Infor COM 7.5 User Guide | 1005 

 

Manufacturing 

 

5. Confirm by clicking OK. 

 A new production order is generated from the archive order using the data that you entered. 

The system switches to the production order form to continue processing the new production 

order. 
 

Archive production orders 

For information on archiving production orders in Manufacturing, see Archive (Manufacturing) 

(page 1004). 

To archive multiple production orders, follow the steps below: 

1. Select Manufacturing > Archive > Archive production orders. 

2. Use the from - to entries in the Order ID, Job, and Posting date key fields to specify the orders 

you want to be selected from the total stock of all orders for archiving. 

3. You can make further selections using the check boxes in the Status form section. 

Example: If you use the Closed selection criterion (default setting), the selection is restricted to 

production orders that have the status Closed. 

4. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

5. Before archiving, select the Selection from list check box to display a list of all selected 

production orders that you previously selected using the key fields. You can make a new 

selection by selecting lines. 

6. Click OK to start the archiving. 
 

Delete/export production orders 

For information on archiving production orders in Manufacturing, see Archive (Manufacturing) 

(page 1004). 

To delete archived production orders, complete the following steps. 
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"Delete" here means that the orders are exported from the archive to a file. 

The name of the export file is specified in the COMMON.ARCHIVM5 section of the configuration. 

The target drive, together with the target directory where the file is to be stored, is defined in the 

ARCHIV section of the configuration. 

This file is created for the first export and updated with additional export data each time the export 

is carried out. 

1. Select Manufacturing > Archive > Delete/export production orders. 

2. Use the entries in the from - to fields  to specify the orders you want to select for deletion from 

the total number of orders. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select Selection from list to display a list of the selected production orders before you export 

the data. You can make a new selection by selecting lines. 

5. Select OK to start the data export. 
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Allocation tables (Inventory) 

The following allocation tables are provided in WMS. 
 

BCBESTART 

Description: Warehouse inventory types 

Usage: This allocation table specifies the types of warehouse inventory. It is used in the 

BCODES (posting IDs) allocation table to populate the From inv. and To inventory fields and 

indicate the type of posting ID. 
 

BCBUCHART 

Description: Inventory posting types 

Usage: This allocation table contains the different inventory posting types available. The posting 

types in the BCODES allocation table describe the different types of posting ID. 
 

BCEFFECT 

Description: Effects of posting to a warehouse 

Usage: You can make the following quantity or value changes in the inventory journal: 

-1: Decrease 

0: - 

1: Increase 
 

Inventory basics 
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BCMENGE 

Description: Posting quantities 

Usage: Contains the quantities that can be posted using a posting ID. The entries in the Quantity 

field are taken from the BCODES allocation table. 

1: - 

2: Total quantity 

4: Partial quantity 
 

BCODES 

Description: Posting IDs 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table contains a number of IDs for the postings that can be performed in 

Infor COM. The posting IDs for TIME are managed in the ODCTRAC allocation table. Separate 

posting IDs are used for Value flow. For more information, see Value flow posting IDs. 

For more detailed information about the individual posting IDs in the table, see Inventory posting 

IDs. 

Notes: 

 The BCODES allocation table described here is an internal system table. It provides 

information to the system on how the various postings are managed. When you select IDs for 

pending postings from the combo boxes in the various objects (for example, Purchase receipt 

or Sales issue), the IDs are not provided by the BCODES internal allocation table described 

here. Instead, they are taken from the BUCHLNZ user allocation table. This table contains the 

same posting IDs and is solely used to allow you modify the text descriptions for the IDs 

according to your own requirements, as these changes are not easily made in the BCODES 

allocation table. For more information, see the following note. 

 You should not make changes to the BCODES allocation table unless this has been agreed 

with your Infor consultant. Please note that changes, such as the addition or deletion of 

posting IDs, must also be updated in the BUCHKNZ allocation table also. 

The allocation table contains the following four tabs: 
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Properties 

The properties of the posting ID specified on this tab control the basic behavior of Infor COM when 

posting all material movements. In addition to this table, the configuration entries are also used to 

classify posting IDs. 

The f ields on this tab are:  

ID 

The posting ID. 

Text 

The text description for the ID. Please do not modify the text here. Please see the first note at the 

start of this Help topic. 

Posting type 

This field specifies the type of posting. Posting types are defined in the BCBUCHART allocation 

table. 

Trigger 

The module that triggers postings using this ID. 

Qty 

Specifies whether the ID can be used to post a total quantity or a partial quantity. The entries are 

maintained in the BCMENGE allocation table. 

Direction 

Required for cancellation postings only. If the field contains a value other than Cancel, the 

transaction is considered an Original transaction. 

From inv., To inventory 

Specifies the type of inventory before and after the posting made using this ID. The inventory 

types are stored in the BCBESTART allocation table. 
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Inventory journal 

This tab acts as a checking mechanism when writing to the inventory journal. The Journal change 

ID column specifies which action can be performed with this posting ID. The Transaction quantity 

relation column indicates the relationship between the change quantity and the posting quantity, 

i.e., how the posting quantity is derived from the change quantity. 

The selected relDl column specifies that the data is written to the inventory movements table  

(relDl table). 

Description 

For more detailed information on this tab, see Value flow posting IDs. 

Statistics 

For each posting ID, this tab allows you to specify if and how inventory postings should be 

transferred to Statistics using the relevant posting ID when the inventory journal is extracted. 

In the Target RT (target record type) column, you can set whether a posting made using the 

relevant posting ID is to be added to the quantity-based evaluations in Statistics as an inventory 

issue, an inventory receipt, a customized inventory transaction, or not at all (Do not move) during 

the extraction. 

If this field does not contain an entry, inventory transactions with this posting ID are not valid for 

Statistics. 

Please note:  After you make changes to this tab, you must restart Infor COM and repeat the 

extraction and summarization process for the inventory journal. 
 

BCODES2 

Description: Posting IDs for purchase orders with materials provided 

Usage: The structure of this allocation table is the same as the structure of the BCODES 

(inventory posting ID) table. It contains the relevant inventory posting IDs for purchase orders with 

the value posting IDs for purchased items with materials provided. 
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BCPRICESRC 

Description: Price sources for inventory postings 

Usage: Contains the possible price sources. The entries in the Price source field are taken from 

the BCSYSTEMCAT allocation table. The following price sources are provided in the standard 

version: 

 Standard version: See Prices and discounts in Sales and Prices and discounts in Purchasing. 

 Average price 

 Valuation price 

 Manufacturing costs: See Cost rollup. 

 Original: This price source should be used for cancellations and purchase invoices only. 

 Difference: This price source is not used. 

 Inventory value adjustment: This price source is not used. 

 
 

BCRICHTUNG 

Description: Posting directions 

Usage: This allocation table contains the possible types of posting direction. The entries in the 

Direction field are taken from the BCODES allocation table. 
 

BCSEQUENCE 

Description: Sequences for inventory postings 

Usage: Contains the different sequences that you can use for cancellations of partial actions or 

for receipt of invoices where the canceled or invoiced amount differs from the original amount. The 

sequence is specified in the Description field when you define a transaction sequence (e.g. FIFO, 

LIFO). This field also specifies the name of the database table that is used to calculate the original 

actions. The Customization field also lists the database fields from the database table specified in 

the Description field. The partial actions are sorted according to these fields. The entries in the 

Sequence field are taken from the BCSYSTEMCAT allocation table. 
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Note: The Default opt. field is not currently used. 
 

BCSYSTEMCAT 

Description: System categories for posting IDs 

Usage: This allocation table specifies the properties of posting categories. You can select these 

from the System cat. field in the BCODES allocation table. 

For more information about using this table, see the Value flow models Help topic. 

Ref. 

This field specifies the value of the posting category that must be posted before the current posting 

category. 

Example:  Posting category Purchasing receipt (value 1) must be posted before category 

Purchasing invoice (value 3). 

PP deviation 

This field specifies the expenditure algorithm to be used. The possible algorithms are taken from 

the BCEXPENDALG (Expenditure algorithms) allocation table. 

Price source 

This field specifies the price source to be used. The entries available are taken from the 

BCPRICESRC (Price sources for inventory postings) allocation table. 

Sq. 

This field is only used for posting categories that contain a cancellation or a purchase invoice. It 

specifies the posting sequence to be used. The sequences available are stored in the 

BCSEQUENCE (Sequences for inventory postings) allocation table. 

Rcpt val, Iss val, Recpt qty, Iss qty., Repst qty, Expense 

For more information about these fields as well as additional information on using this allocation 

table, see Value flow models. 
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BCURHEBER 

Description: Triggers for inventory postings 

Usage: Contains the different modules available when specifying the triggers for an inventory 

posting: Purchasing, Sales, Manufacturing, Inventory count, Inventory. The entries in the Trigger 

field are taken from the BCODES allocation table. 
 

BEWEGUNG 

Description: Movement types 

Usage: Contains the descriptions for the possible values of the Movement type field in the 

Inventory posting journal module (Finance > Journals and reports). 
 

CHKCHGME 

Description: Permitted field changes in Inventory 

Usage: This allocation table specifies the status from which a database field in Inventory cannot 

be modified. In the Description field, enter the numeric ID of the status from which the database 

field next to it can no longer be modified. A status of -1 means that the field can never be modified 

regardless of its status. 
 

HANDLAGER 

Description: Bulk issue warehouses 

Usage: This allocation table contains the bulk issue flags for the Bulk. W/H field on the Inventory 

tab in the master data for an item. 

0: Not a bulk issue item 

1: Manufacturing issue 
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2: Non-manufacturing issue 
 

KOPPLUNG 

Description: Link flags 
 

TEMPUNIT 

Description: Units of temperature 

Usage: This allocation table is stored for temperature units fields such as in the master data for 

an inventory location, for example. It contains the following units: 

°C (Celsius) 

°F (Fahrenheit) 

K (Kelvin) 
 

WMSACTPFC 

Description: Coordinate selection options for automatic inventory control 
 

WMSACTREQT 

Description: Polling options for automatic inventory control 
 

WMSARCHST 

Description: Statuses of archived batch-tracked inventory 

Usage: This allocation table is used for differentiating between archived inventory items. It is 

required when canceling procedures. 
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Active = The batch-tracked inventory is in use. 

Merged = The batch-tracked inventory has been merged (see "Merging" page 1039) with other 

batch-tracked inventory. 

Issued = The batch-tracked inventory has been posted from the warehouse. 

Deleted = The batch-tracked inventory has been deleted. 

Manually deleted = The batch-tracked inventory quantity has reached 0.00 units but needs to be 

manufactured again for an inventory count, for example. 

Scrapped = The batch-tracked inventory has been scrapped. 
 

WMSASSIGNST 

Description: Assignment statuses of batch-tracked inventory 

Usage: This allocation table contains the receipt types of the inventory item: 

Unassigned  The batch-tracked inventory is still available in this quantity for 

resolving dummy inventory. 

Reserved Reservation 

FRA Fixed requirement allocation 

Dummy 

reservation 

Virtual reservation. The batch-tracked inventory is already 

reserved for resolving dummy batch-tracked inventory. This 

status is only displayed if you save before the resolve quantity 

has been reached (see Resolve dummy inventory (page 

1200)). 

Consignment-re

served 

Batch-tracked inventory reposted to customer consignment 

warehouses (see "Customer consignment warehouse" page 

1069) is automatically reserved for the underlying sales order 

and assigned this status. 
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WMSAUTOUNP 

Description: Options for automatic unpacking 

Usage: This allocation table is used to populate the Unpack column on the Transaction tab in 

Purchase receipt. 

All Everything is unpacked. Goods and shipping materials are posted to their respective 

warehouses separately. 

None (Default setting for UsePackages=yes) The goods are not unpacked. In accordance with 

the packing instruction or shipping material requirement that forms the basis of the PO 

line, the goods are packed and stored as load units. 

One level The first level is unpacked and the remainder is stored as load units. 

Example: For a delivery with a pallet at level 1, boxes with goods at level 2, and a cover 

at level 3, the pallet is stored separately while the goods in the box and the cover are 

stored as a load unit. 
 

WMSCONSIGNT 

Description: Consignment warehouse types 

Usage: This allocation table contains the different types of consignment warehouse. 

You can select these warehouse types from the Co. W/H tp. field in the master data for the 

inventory areas (page 1085). 
 

WMSCRDSPCS 

Description: Coordinate specifications 

Usage: Contains the entries used for determining the coordinate specification precision (page 

1053). 
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WMSDANGERLV 

Description: Risk classes 

Usage: This allocation table contains the risk classes for items and inventory locations. 
 

WMSDEFLOC 

Description: Item default coordinates 

Usage: In this allocation table you can store default values for the inventory coordinates of 

individual address IDs. These default values are suggested when the address ID is changed while 

defining the default coordinates in the item master data. 

 
 

WMSDEFLOCML 

Description:  Machine location default coordinates 

Usage: The blank allocation table WMSDEFLOCML can be used to create address-specific 

default machine locations. This allocation table is evaluated first. If it does not contain an entry for 

an address, the COMMON.WMS.DEFAULTMACHINELOCATIONNO parameter is used as 

before. 
 

WMSDIR 

Description: Posting directions in the warehouse 

Usage: This allocation table contains the possible posting directions for inventory movements. 
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Receipt  Incoming inventory item 

Issue  Outgoing inventory item 

Transfer  Inventory item is moved to 

different inventory location 

 
 

WMSFIXLOCT 

Description: Fixed location types 

Usage: This allocation table contains the possible types of fixed location (see "Fixed locations" 

page 1093). 
 

WMSINVST 

Description: Inventory count statuses 

Usage: This allocation table contains the possible statuses of inventory count lists (page 1178): 

Created The inventory count list has been generated 

Printed The inventory count list has been printed 

Started The inventory count list has been started and can now be posted 

(inventory items and inventory locations are quarantined) 

Partially posted The inventory count list has been partially posted 

Posted The inventory count list has been fully posted (inventory count 

freeze cancelled) 

Canceled The inventory count list was ignored, inventory count freeze 

released 
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WMSINVT 

Description: Inventory count types 

Usage: This allocation table contains the possible types of inventory count: 

Item = The inventory count is based on items 

Inventory location = The inventory count is based on inventory locations 

For more information on inventory counts in Infor COM, see Inventory count lists (page 1178). 
 

WMSJRNCCODE 

Description: Change IDs for posting IDs in the inventory journal 

Usage: This allocation table contains the change IDs for posting IDs in the inventory journal. 
 

WMSJRNPQREL 

Description: Relationship between transaction quantities and change quantities in the inventory 

journal 

Usage: This allocation table documents the relationship between transaction quantities and 

change quantities in the inventory journal. The system uses this ID to calculate the posting 

quantity from the change quantity. The ID is required to write to the journal. 
 

WMSLABEL 

Description: Label names 

Usage: This allocation table stores the reports required for printing inventory labels. 
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WMSMOVEST 

Description: Movement statuses 

Usage: This allocation table contains the possible statuses of inventory movements. For more 

information, see Movement lists (Inventory) (see "Movement lists" page 1049). 

Executable This status is used within the system only. Executable movements are 

displayed with the status Advised. 

Advised The inventory movement was generated and can be added or was already 

added to a movement list. 

Completed The underlying movement list was released. 

Canceled The list has been canceled. 

 
 

WMSMVLISTST 

Description: Movement list statuses 

Usage: This allocation table contains the possible statuses of movement lists (page 1049). 
 

WMSMVLSTCFG 

Description: Movement list configurations 

Usage: For more information on movement list configurations, see Movement lists (Inventory) 

(see "Movement lists" page 1049). 

You can set the relevant processes to allow the printing of movement lists. 
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Lang. 

The allocation table is loaded in the language of the editor. If the table contains values in other 

languages, you can view and edit them. To do this, click the plus sign in the Language field in the 

required table row or select Functions > Expand all. See also Create allocation table in more than 

one language. 

Order type 

The order type indicates the initiator of the inventory movement. Order types are stored in the 

WMSORDERT allocation table. 

 Purchase orders and production orders initiate receipt movements that occur when inventory 

receipts are posted for delivered or manufactured goods. 

 Sales orders and production orders initiate issue movements that occur when inventory issues 

are posted for sold items or for materials that are required for manufacturing. 

Since transfers or miscellaneous receipt postings generated by an inventory adjustment are not 

based on orders, the Inventory module is entered as the order type here. 

Exception:  The posting of consignment deliveries in Sales involves transfers (posting ID 173 

Move to consignment) that are based on a sales order. 

Direction 

This field displays the posting direction of the inventory movement as per the WMSDIR allocation 

table. 

Examples: 

 If you post an item from one inventory location to another, the direction is a Transfer within the 

warehouse. 

 For postings that issue items for production orders and sales orders, the direction of the 

inventory movements is Issue. 

Description, Desc. 

The description of the relevant movement list is displayed. You can use this field for your own 

comments. 

Movement list request 

Here you determine which combo box option should be set by default for each order type. 

Note: In order to avoid working with movement lists completely, enter the Work without a 

movement list option in each line. 
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Work without a movement 

list 

The inventory movements should be carried out without creating 

receipt lists. 

The movement lists are not printed and the inventory is posted 

directly. 

Generate manually You must manually create, print, and enter the movement lists for 

the inventory movements that were generated - see Manually 
generate movement lists (page 1050). The goods are not 

posted to the warehouse until you have printed the list (optional) 

and released it manually. 

Generate automatically The movement lists with the generated inventory movements are 

created automatically. However, the goods remain at the current 

inventory location until you have printed the lists (optional) and 

released them manually. The goods are not posted to the 

warehouse until the lists are released. 

Generate and print 

automatically 

The movement lists with the generated inventory movements are 

created and printed automatically. However, the goods remain at 

the current inventory location until you release the list manually. 

The postings are not carried out until the list is released. 

Generate and release 

automatically 

The movement lists with the generated inventory movements are 

created, printed, and released automatically. The postings are 

carried out. 

With dialog box 

Use this check box to specify whether users can edit the combo box containing the options for 

handling movement lists in the relevant process. In the standard version, this option is selected by 

default for all order types. If you clear the option, none of the allocation table settings explained 

here can be modified by users during a process. 
 

WMSMVLSTREQ 

Description: Movement list requests 

Usage: Contains the movement list requests that can be selected from the WMSMVLSTCFG 

(page 1021) allocation table. 
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Movement list request 

Here you determine which combo box option should be set by default for each order type. 

Note: In order to avoid working with movement lists completely, enter the Work without a 

movement list option in each line. 

Work without a movement 

list 

The inventory movements should be carried out without creating 

receipt lists. 

The movement lists are not printed and the inventory is posted 

directly. 

Generate manually You must manually create, print, and enter the movement lists for 

the inventory movements that were generated - see Manually 

generate movement lists (page 1050). The goods are not 

posted to the warehouse until you have printed the list (optional) 

and released it manually. 

Generate automatically The movement lists with the generated inventory movements are 

created automatically. However, the goods remain at the current 

inventory location until you have printed the lists (optional) and 

released them manually. The goods are not posted to the 

warehouse until the lists are released. 

Generate and print 

automatically 

The movement lists with the generated inventory movements are 

created and printed automatically. However, the goods remain at 

the current inventory location until you release the list manually. 

The postings are not carried out until the list is released. 

Generate and release 

automatically 

The movement lists with the generated inventory movements are 

created, printed, and released automatically. The postings are 

carried out. 

 

WMSNOTES 

Description: Notes in the inventory journal. 

Usage: This allocation table contains default notes, which the user can enter for inventory 

transactions. See COMMON.BUCHEN.NOTEEDITABLE. 
 

WMSORDERT 

Description: Order types 
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Usage: This allocation table contains the possible order types in Infor COM Inventory. It 

populates the Order type field, which displays the originator of receipt movements, issue 

movements, transfer movements, or generated batch-tracked inventory on various tabs in the 

Inventory module. 
 

WMSPICKST 

Description: Issue statuses 

Usage: This allocation table contains the issue statuses for items. 
 

WMSPINVCFG 

Description: Settings for perpetual inventory counts 

Usage: This allocation table allows you to define the perpetual inventory count type for each 

individual Inventory posting ID. 

Stamp type 

This field indicates the date type that is assigned for perpetual inventory counts. The permitted 

date types are entered in the WMSPINVTYP allocation table. 
 

WMSPINVTYP 

Description: Date assignment types for perpetual inventory counts 

Usage: The date assignment types entered here may be selected as options from the 

WMSPINVCFG (page 1025) allocation table in the Stamp type field. 
 

WMSPPCISSM 

Description: Automatic manufacturing issues 
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WMSPRNROUTE 

Description: Printer routing 

Usage: If the WMS.ALTERNATIVEPRINTER parameter is set to yes, a printer is determined 

from theWMSPRNROUTE allocation table by the current user when the label is printed. 
 

WMSPUTST 

Description: Receipt statuses 

Usage: This allocation table contains the receipt statuses for items. 
 

WMSQAST 

Description: Inspection statuses 

Usage: The entries in this allocation table are used for specifying the inspection status of 

batch-tracked inventory in the Purchasing inspection object (Inventory > Goods receipt), 

Manufacturing inspection (Inventory > Manufacturing), and the Inspection object (Inventory > 

Special functions). 

The following list indicates the different inspection statuses that you can choose from and shows 

how they are assigned: 

0 No inspection 

 If you posted a purchase order line in the Purchase receipt object (Inventory > Goods receipt) 

to the warehouse directly without any prior inspection using posting ID 151 (Full inventory 
receipt) or 152 (Partial inventory receipt). 

 If you posted a manufactured item line (HR record) from a production order in the Inventory 

transactions object (Inventory > Manufacturing) to the warehouse directly without any prior 

inspection using posting ID 181 (Full manufacturing receipt) or 182 (Partial manufacturing 
receipt). 

10 Order not inspected 

 If you posted a purchase order line in the Purchase receipt object to the Purchasing inspection 

object using posting ID 153 (Full inspection receipt) or 154 (Partial inspection receipt). 
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 If you posted a line for a manufactured item in a production order in the Inventory transactions 

object to the Manufacturing inspection object using posting ID 121 (Full manufacturing receipt 
-> Inspection) or 122 (Partial manufacturing receipt -> Inspection). 

 

20 Order quarantined 

 If you posted batch-tracked inventory in the Purchasing inspection object to the quarantine 

warehouse using posting ID 150 (Insp. to quarantine W/H receipt). You can cancel this type of 

posting using posting ID 155 (Cancel insp. to W/H receipt). The relevant batch-tracked 

inventory reverts to the status Order not inspected. 

 If you posted batch-tracked inventory in the Manufacturing inspection object to the quarantine 

warehouse using posting ID 120 (Insp. to quarantine W/H receipt).  

 If you posted batch-tracked inventory in the Sales issue object (Inventory > Goods issue) to 

the quarantine warehouse because of a goods return by a customer using posting ID 176 
(Return to quarantine W/H). 

 

30 Order inspected 

 If you posted batch-tracked inventory in the Purchasing inspection object to the warehouse 

using posting ID 156 (Inspection receipt -> Warehouse). You can only carry out this type of 

posting if the status of the batch-tracked inventory is still Order not inspected. You can cancel 

it using posting ID 155 (Cancel  Inspection -> Warehouse receipt). The status of the inventory 

will then revert to Order not inspected. 

 If you posted batch-tracked inventory in the Manufacturing inspection object to the warehouse 

using posting ID 124 (Inspection receipt -> Warehouse). You can only carry out this type of  

posting if the status of the batch-tracked inventory is still Order not inspected. You can cancel 

it using posting ID 125 (Cancel Inspection -> Warehouse receipt). The status of the inventory 

will then revert to Order not inspected. 

40 Order rejects 

This inspection status is assigned to batch-tracked inventory that results from reject quantities 

generated from inventory transactions for production orders. For more information, see Post 

rejects (see "Enter reject transactions" page 1153). 

60 Manually quarantined 

 If you posted batch-tracked inventory with the status Not manually inspected in the Inspection 

object to the quarantine warehouse using posting ID 105 (Not inspected -> Quarantined). 

 If you posted batch-tracked inventory with the status No inspection or Manually inspected in 

the Inspection object to the quarantine warehouse using posting ID 107 (Inspected  ->  
Quarantined). 

 If you posted batch-tracked inventory for a tool in the Inspection object using posting ID 93 
(Prohibit tool use). 
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70 Manually inspected 

 If you posted batch-tracked inventory with the status Not manually inspected in the Inspection 

object using posting ID 104 (Not inspected -> Quarantined). 

 If you posted batch-tracked inventory with the status Order quarantined or Manually 
quarantined in the Inspection object using posting ID 106 (Quarantined  ->  Inspected). 

80 Scrapped 

This inspection status is assigned to batch-tracked inventory (items or tools) that were scrapped 

using posting ID 90 (Scrap defective material. This status is managed within the system only. 

90 Not manually inspected 

 If you posted batch-tracked inventory with the status No inspection, Order inspected, or 

Manually inspected in the Inspection object using posting ID 108 (Inspected -> Not inspected). 

 If you reposted quarantined batch-tracked inventory (status Order quarantined or Manually 
quarantined) back to uninspected status in the Inspection object using posting ID 109 

(Quarantined -> Not inspected). 
 

WMSQUALCODE 

Description: Inspection flags 

Usage: Contains the three A, B, and C flags for the Inspection ID item property used for splitting 

batch-tracked inventory. The allocation table is stored in the Inspection flag field on the Inventory 

flags tab of the item master data. 
 

WMSQAPRIO 

Description: Quantity distribution priorities for importing inspection qtys 
 

WMSQUEUEST 

Description: Inventory request statuses 

Usage: This allocation table contains the possible statuses of inventory movements. 
 



Infor COM 7.5 User Guide | 1029 

 

Inventory 

 

WMSQUEUET 

Description: Inventory posting types 

 
 

WMSREALITYT 

Description: Special statuses for batch-tracked inventory 

Usage:  For information about dummy inventory, see Dummy inventory (page 1198). 
 

WMSRELOCST 

Description: Transfer statuses 

Usage: This allocation table contains the possible statuses of transfers (see "Transfer" page 

1125). 
 

WMSREQACT 

Description: Inventory request actions 

Usage: Inventory request actions are entered in the Request action field on the form header in 

Inventory requests. 
 

WMSREQMODE 

Description: Inventory request modes 
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WMSREQPOSTA 

Description: Inventory request transactions 

Usage: Inventory request transactions can be entered in the Picking post-processing field in 

Inventory requests. 

You can select from the following options. 

Action Description 

No action The advance shipping notice is manually created 

from the sales order. 

Create ASN The advance shipping notice is created 

automatically. 

Create and print ASN The advance shipping notice is created automatically 

and printed. 

Create, print, and issue ASN The document is created and the corresponding 

issue is carried out automatically. 

Automatic material 

consumption 

 

 
 

WMSREQSHTG 

Description: Backlog handling 

Usage: This allocation table contains the various ways in which backlogs can be handled. The 

options can be selected from the BackHndlg field on the Relation tab in an inventory request 

(Inventory > Inventory movements > Inventory requests).  

You can choose from the following options. 

Accept request If partial deliveries are allowed, the available inventory quantity is picked. A 

new delivery should be attempted at a later time. 

Postpone request This option corresponds to the classic backlog creation method. The delivery 

is delayed until the entire delivery quantity is present. The quantity already 
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available is assigned to the order. 

Cancel request The creation of backlogs is not permitted. 

If no inventory or very little inventory is determined to have been requested by 

the delivery date, the inventory request is canceled. 

 
 

WMSREQSTAT 

Description: Inventory request statuses 

Usage: This allocation table contains the statuses of the inventory requests. 
 

WMSREQTYPE 

Description: Inventory request types 

Usage: This allocation table contains the inventory request types available when you open the 

inventory requests. You can open inventory requests in a number of different ways (Open 

individual request, Open via main group, Open via group request). 
 

WMSSERBATNM 

Description: S/B numbering 

Usage: This allocation table specifies the method used for assigning serialized/batch IDs. The 

default numbering method must be specified beforehand under Numbering in the System 

functions module. For more information, see the Numbering Help topic. 

Note:  Please do not modify or delete any of the default entries included in the standard version. 

Insert new rows for new numbering methods. In the master data for the item, select the method to 

be used for each item from the S/B numbering field on the Inventory tab. 

Numbering name 

A description of the relevant method: 
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 No automatic numbering:  You must assign the IDs manually. 

 Numbering according to defined parameter:  The numbering that is set in the 

configuration with the COMMON.WMS.SERIALNUMBERINGMETHOD parameter applies. 

 Serial ized/batch IDs:  With this method, both batch IDs and serialized IDs can be assigned 

automatically. This method is necessary for items that require serialized and batch 

management. 

 Batch sequential  IDs : Standard numbering method used for automatically assigning batch 

IDs. 

 Serial ized sequential  IDs:  Standard numbering method used for automatically assigning 

serialized IDs. 

Num. class 

A class contains all of the numbering methods for an object. 

Num. 

Displays the selected numbering method. The numbering methods provided in the standard 

version are as follows: 

 590 Serialized ID 

 592 Batch ID (default setting) 

Method 

If the scope of the numbering method function does not meet your serialized/batch numbering 

requirements, your consultant can help you to customize it. The name of the corresponding Lj4 

code is then entered in the Method field. 

If this column contains an entry, the specified Lj4 code is run. You must ensure that this Lj4 code 

exists. This Lj4 code is then solely responsible for ID assignment. 
 

WMSSIDE 

Description: Sides of the warehouse 

Usage: This allocation table contains the possible issue methods used by the issue strategy 

(Right, Left). 

For more information, see Left/right picking (page 1044). 
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WMSSILBLCFG 

Description: Document control 

Usage: You can use this allocation table to specify whether batch-tracked inventory labels should 

be printed for individual processes. 

This decision is made according to the different batch-tracked inventory statuses. 

Clear the check boxes for any batch-tracked inventory for which labels should not be printed. 

Request 

This field displays the request type for printing the batch-tracked inventory label, i.e. the process 

for which you are printing the batch-tracked inventory label. 

Batch-tracked inventory status 

Various batch-tracked inventory statuses can occur in the individual processes. The associated 

batch-tracked inventory status is displayed according to the specific process. 

 

BTI L 

Use this field to specify whether the label for the batch-tracked inventory should be printed. 

Remainder 

Use this field to specify whether the label for the remaining batch-tracked inventory should be 

printed. 

SI 

Use this field to specify whether the label for the merged batch-tracked inventory should be 

printed. 

Canc. 

In this field, specify whether the label for the canceled batch-tracked inventory should be printed. 
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WMSSIOWN 

Description: Batch-tracked inventory owners 
 

WMSSISORTT 

Description: Batch-tracked inventory sorting 

Usage: This allocation table contains the criteria that you can use to sort batch-tracked inventory. 

You can select these values from the BTI sorting field on the Inventory location tab of the master 

data for the inventory location. 
 

WMSSPLTMELT 

Description: Split and merge statuses 
 

WMSSTOCKT 

Description: Inventory location types 

Usage: A location type must be assigned to each inventory location (see "Inventory locations" 

page 1091) that is created in Infor COM Inventory. You make this assignment on the Inventory 

location tab. This allocation table contains the different inventory location types available. 
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System This inventory location type is entered by default if the Y and Z coordinates 

were both preset as 0 (zero) when creating a location type. In this case, the 

other two location types are not available here. 

Pick An inventory location is generally a pick location. It is mostly used for 

picking partial quantities for issue. Inventory is replenished from reserve 

locations. 

Note:  You can preset the number of pick locations for each location for an 

item on the Inventory tab of the item's master data. We recommend you 

set a restriction. 

Reserve Reserve locations are locations at which containers are stored, usually on 

loading devices. They provide the inventory for replenishing pick locations 

and fixed locations. Containers are also picked from reserve locations, 

when required. 

To create reserve locations, you must set the  

COMMON.WMS.USERESERVELOCATIONS parameter in the 

configuration to Yes. If this parameter is changed from Yes to No after a 

reserve location has been created, the receipt strategy will no longer take 

this reserve location into account. 

 
 

WMSSTORAGET 

Description: Storage types 

Usage: In Infor COM Inventory, you must assign a storage type to each inventory location (see 

"Inventory locations" page 1091) in the master data for the inventory location. The weight and 

volume calculation is determined by the storage type of an inventory location. This allocation table 

contains the two storage types. 

Block In general, a block location is an area without direct restrictions. Volume, mass and 

dimensions are not checked at these areas during receipt. Theoretically, there are 

also no volume and weight restrictions at a block location. This means that you do not 

need to assign a location class (see "Location classes" page 1088) to a block 

location. 

Shelf The maximum permissible weight and volume limits cannot be exceeded when storing 

on shelf locations. The mass, volume and dimensions are checked during receipt. 
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WMSSTORET 

Description: Inventory area types 

Usage: This allocation table contains the possible inventory area types. 

You can choose from the following inventory area types. 

Inventory This is the default inventory area type. Inventory areas of this type are also required for 

supplier consignment warehouses. 

Inspection To post batch-tracked inventory with an inspection ID in Purchase receipt (page 1104), 

you must have created at least one inventory area of the Inspection type with inventory 

locations. 

Manufacturing This inventory area type is required for machine locations. 

Machine locations are system locations (see "Inventory locations" page 1091). 

The assignment is evaluated when the work center is set up with goods, i.e. when the goods 

are transferred from the inventory location to the machine location. 

If you do not create a machine location, the default machine location created automatically 

by the system is used. The coordinates of this default machine location are defined in the 

COMMON.WMS.DEFAULTMACHINELOCATIONNO parameter of the configuration. 

Goods receipt You must create at least one inventory area of the Goods receipt type. This is the only 

inventory area type that can be assigned to the necessary goods receipt locations in 

Purchase receipt. 

Goods issue You must create at least one inventory area of this type. The necessary goods issue 

locations in Goods issue (page 1145) can only be located in an inventory area of this type. 

S/C warehouse You must create inventory areas of this type for inventory locations that are not located in 

your own warehouse. This includes customer consignment warehouses (see Customer 

consignment (see "Customer consignment warehouse" page 1069)) and 

subcontracted manufacturer consignment warehouses (see Subcontracted 
manufacturer consignment (see "Create subcontracted manufacturer 

consignment warehouses" page 1080)). 

Supplier consignment inventory locations are not subcontracted warehouses because they 

are located in your own warehouse. They are therefore managed in Warehouse inventory 

areas (see above). 
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WMSSTOWING 

Description: Storage operations 
 

WMSTRCNFQDH 

Description: Actions in case of quantity variance 
 

WMSUANUMx 

Description: Batch-tracked inventory property NUMx 
 

WMSUATEXTx 

Description: Batch-tracked inventory property TEXTx 
 

WMSUSED 

Description: Degree of utilization 

Usage: This allocation table contains the possible degrees to which an inventory location is 

utilized. 

The entries can be selected from the Used field on the Statistics tab of the master data for the 

inventory location. 
 

WMSUSERATTR 

Description: User defined batch-tracked inventory properties 
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Record types (Inventory) 

A record type identifies the type of data record and classifies it according to the individual 

attributes of an object (for example, an item line or a purchase order). 

The following record types are used in the Inventory module. 

Record types in Goods receipt: 

Record type Label Description 

SCM Subcontracted 

material 

This record type flags material that a subcontracted manufacturer provides 

in order to process an order. 

HR Header The item lines of a purchase order are flagged as HR records. 

MA Material This record type flags the lines in a purchase order that contains the 

materials provided to a subcontracted manufacturer. 

D Residual/waste 

material 

Residual/waste material is flagged as an RM record. 

TL Tool receipt Record types (Tools) 

TX Text record This record type flags a line that contains text only. 

AC Additional costs Examples of additional costs are freight, insurance, and packaging. 

 
 

Inspection ID 

You can assign an inspection ID to items that need to undergo an inspection. The corresponding 

batch-tracked inventory is then automatically posted to Purchasing inspection (page 1108) when 

purchase receipt postings are carried out. 

To flag an item, use the Inspection flag section of the UOM/size management tab in the master 

data for the item. The following inspection IDs are provided in the standard version: 

Value Description 

 No mandatory inspection 



Infor COM 7.5 User Guide | 1039 

 

Inventory 

 

Value Description 

G Inspection plan on hold 

J Mandatory inspection 

N No inspection plan 

O Inspection plan open 

P Inspection plan created 

For batch-tracked inventory with flagged items, you can use the 

COMMON.WMS.ONLYQALOCATIONS parameter of the configuration to specify the default 

inventory area type in Purchase receipt. 

The default flag for new items is No mandatory inspection. Inspection flags are managed in the 

QSKNZ allocation table. 
 

Merging 

Individual batch-tracked inventories (see "BT-inv." page 1046) that have the same properties for 

splitting batch-tracked inventory (see "Item properties for splitting batch-tracked inventory" page 

1048) and refer to the same object (for example, inventory location) can be combined (merged) 

into one batch-tracked inventory. The oldest of the batch-tracked inventory records already 

available at the target inventory location is retained here. The quantities of the newer records are 

added to the oldest record, and the newer records are then deleted. 

Although items that have been quarantined by Inspection can be stored at the same location, they 

cannot be merged until they receive a positive inspection report. Similarly, they cannot be 

displayed as being available before the inspection either. 

To allow automatic merging of more than one batch-tracked inventory with identical properties, 

you must select the Can be merged option on the Inventory tab in the master data for the relevant 

item. 

You cannot merge multiple batch-tracked inventories in Inventory adjustment. The sequence of 

the records displayed and selected for merging is significant. Inventories are always merged into 

the top selected batch-tracked inventory. 
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A new batch-tracked inventory is always generated when an miscellaneous receipt is posted, and 

no merging takes place. An inventory adjustment is equivalent to a receipt followed by merging. 
 

Inventory strategies 

Inventory strategies allow the system to automatically find proposals for source and target 

locations of inventory movements. 

WMS differentiates between a receipt strategy (page 1040) and an issue strategy (page 1042). 

These strategies run in WMS as background processes. You do not need to start or end them 

separately. 

 
 

Receipt strategy 

The receipt strategy is one of two inventory strategies (page 1040) available in WMS. It is used for 

receipt postings in Purchasing and Manufacturing to automatically determine the appropriate 

inventory locations for receiving goods. The strategy is aimed at the optimum distribution of goods 

in warehouses. 

The strategy evaluates the following information. 

Inventory properties of the item 

To find the appropriate inventory locations, the strategy first determines the inventory-specific 

properties and requirements of the items received. In doing so it evaluates the Inventory flags tab 

and the ABC class, Temperature, and Risk class fields on the Inventory tab in the item master. 

Inventory location properties 

While searching for a suitable match, the strategy checks the inventory locations for the following 

properties: 

 Fixed location (see "Fixed locations" page 1093) 
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 Access privileges to the inventory areas. These privileges are defined on the Properties tab in 

the master data for the inventory area. 

 Receipt and issue priority of the work areas (page 1089). 

 Location type (see "WMSSTOCKT" page 1034) of the inventory locations. 

 Storage type (see "WMSSTORAGET" page 1035) of the inventory locations. 

 Location class (see "Location classes" page 1088) of the inventory locations. 

 Location-related properties of the inventory locations. These properties are defined on the 

Inventory location tab in the master data for the inventory location. 

Cross reference tables 

Default settings in any Item/location class (page 1101) cross reference tables that have been 

defined are checked. 

Processing sequence 

The strategy searches for appropriate inventory locations in the following order of priority: 

1. Partially used fixed locations of the Pick location type. 

2. Empty fixed locations of the Pick location type. 

3. Partially used fixed locations of the Reserve location type. 

4. Empty fixed locations of the Reserve location type. 

5. Fixed locations of the Block storage type. 

6. Partially used inventory locations of the Pick location type. 

7. Empty inventory locations of the Pick location type. 

8. Partially used inventory locations of the Reserve location type. 

9. Empty inventory locations of the Reserve location type. 

10. Inventory locations of the Block storage type. 

Please note: This sequence is subject to change by Infor development without prior notification. 
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Issue strategy 

The issue strategy is one of two inventory strategies (page 1040) available in WMS. It 

automatically searches for the appropriate batch-tracked inventory for issue postings in Sales and 

Manufacturing as well as for material issue postings for subcontracted manufacturing. 

In this context, the issue sequence methods FIFO and LIFO (also see Item properties for splitting 

batch-tracked inventory (page 1048)) are supported at inventory location level as is residual size 

management. 

Order of priority in which inventory is searched 

1. Reserved inventory 

2. FRA inventory 

3. Available inventory 

Process at each priority level 

Within each priority group, the search proceeds as follows: 

 Destination warehouse (goods issue or machine location) 

 Pick locations 

 Reserve locations 

The sequence of same-level inventory (a-c) is based on the sorting of the specified split flags. The 

order in which the split flags are evaluated is arbitrary. 

You can modify batch-tracked inventory that was determined this way or replace it with other 

inventory using manual specification (see "Enter manual batch-tracked inventory specification" 

page 1080). 
 

Path optimization 

In practice, path optimization means that pick lists and receipt lists are structured so that pickers 

need only cover the shortest possible distance between two inventory locations along their issue 

and receipt routes in the work areas. 
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Infor COM Inventory supports the optimization of path sequences for receipts and issues. Work 

areas are sorted by their path sequence parameters, and inventory locations are sorted on the 

basis of their X, Y, and Z coordinates. 

Work area 

In the work area, the path sequence is influenced by the following fields: 

 Receipt priority, Issue priority 

 Right/Left sequence 

In certain situations, three additional parameters are also evaluated: 

Access sequence 

Inventory locations are sorted based on their X, Y, and Z co-ordinates (see "Inventory locations" 

page 1091). If the X coordinate does not contain a numeric value, the inventory locations cannot 

be sorted. If this is the case, you can define a (numeric) substitute value for the X coordinate in the 

Access sequence field in the form header of the master data for the inventory location. If there is a 

value entered in the Aisle field, it overrides the value in the Access sequence field. 

Aisle 

The aisle is the pathway between two rows in a warehouse. If the same aisle is entered for two 

warehouse rows, the X coordinate of this warehouse row is ignored when the pick list lines in the 

list are sorted. You can enter the ID of the aisle in which the inventory location is located in the 

Aisle field on the form header of the master data for the inventory location. 

Side 

In addition to entering the aisle, you can enter the side of the aisle on which the inventory location 

is located. Together with the Aisle parameter, you can associate the X coordinates of two 

warehouse rows with the left and right properties of the Side parameter. This means it is possible 

for a pick list to have two inventory locations with the same Y and Z coordinates, both located in 

the same aisle, and distinguished only by whether the Right or Left side is specified. 

This information applies to Left/right picking (page 1044). 
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Enter the relevant side in the Side field on the form header of the master data for the 

corresponding inventory locations. 

Enter the Aisle and Side parameters if the inventory location coordinates are not created 

topologically (i.e. if they are not in a unique, hierarchical sequence). 
 

Left/right picking 

Picking is the grouping of different items in accordance with the specifications of an order. 

In the context of path optimization (page 1042), left/right picking means that the topology of a work 

area and the technical equipment available allow a picking process at a Y inventory location 

coordinate (see "Inventory locations" page 1091) to access the inventory location directly across 

from it if goods can also be issued from there. 

Example:  Picking in an aisle between two rows of shelves. 

To use left/right picking, you must set various parameters in the master data for the relevant 

inventory location - see Path optimization (page 1042). 

Note: If you want to apply left/right picking in a valid work area, you must select the RL sequence 

option in the master data for the work area. 
 

Size and residual size management 

Size management 

When you select the Size management option, the length, width, and height dimensions of an item 

are stored in its batch-tracked inventory and used as properties for splitting batch-tracked 

inventory (see "Item properties for splitting batch-tracked inventory" page 1048). 

To activate the Size management function, select the Size management check box on the 

Inventory flags tab in the master data for the item. If you select this option, the system will always 

expect you to enter the unit of length. You enter this value on the Size management section of the 

UOM/size management tab in the master data for the item. 
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All other Size management data is entered on this tab also: The three Length, Width, and Height 

dimensions, the Size management formula used for calculating the Size management result as 

well as the quantity conversion factor(s), if applicable. 

For more information, see the Help topic for the Size management form section. 

The dimensions are preset on special tabs (the Size management tab, for example) in purchase 

orders, sales orders, and production orders, where you can modify them if necessary. You can 

specify the number of items required in these dimensions. The system then uses the Size 

management formula and possibly a quantity conversion factor to automatically calculate the 

resulting purchase order or sales order quantity. 

Note: You can also store length, width, and height dimensions, formulas, and one or more 

quantity conversion factors for items for which the Size management function is not selected. 

Taking into account the required number of items, the system uses this data in purchase orders 

and sales orders to calculate the purchase order or order quantity. However, the batch-tracked 

inventory is stored without the dimension values. 

 

Residual size mgt 

To select the Residual size mgt function, you need to select both the Size management check box 

and the Residual size mgt check box on the Inventory flags tab in the master data for the item 

(Design > Items). 

Note: If you select the Residual size mgt function, you cannot select serialized ID management 

and the automatic generation of dummy inventory. 

If you do select this option, the system will always expect you to specify the unit of length and the 

size management formula before the item can be saved. If the inventory unit of measure differs 

from the Size management unit of measure, you will also have to specify a quantity conversion 

factor. All of this data is entered on the UOM/size management tab in the master data for the item. 

If the Residual size mgt function is selected, as is the case when the Size management function is 

selected on its own, the Size management data is also preset from the item master in purchase 

orders, sales orders, and production orders where it can be used to calculate the purchase order 

or order quantity. 
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The Residual size mgt function also provides the following option: If there is no batch-tracked 

inventory available in the required size for inventory issues for sales orders or purchase orders, 

you can use the Sales issue or Inventory transactions objects to split the batch-tracked inventory 

into the required length from batch-tracked inventory available in larger sizes. You do this by 

means of manual batch-tracked inventory specifications. The Residual size mgt function stores 

any remaining residual sizes as new batch-tracked inventory. 

The following requirements must be met here: 

 The item must not be managed in units of measurement such as packages, cartons, bags, 

units, etc.  

 As the availability of suitable batch-tracked inventory is always checked automatically when 

advance shipping notices are printed in Sales, you must select the Pick list option when 

specifying the issue document in sales orders (Sales > Sales orders). 

Note: As an alternative to entering manual batch-tracked inventory specifications, you can use 

the Inventory adjustment object (Inventory > Special functions) to manually split the batch-tracked 

inventory into the required number and length before carrying out the posting, that is, the issue. 

This method also allows you to split the batch-tracked inventory of items that are managed in the 

warehouse in units of measurement. For an overview of how this is done, see Split batch-tracked 

inventory for Residual size management items (page 1190). 
 

BT-inv. 

WMS allows you to manage items as batch-tracked inventory. 

Note:  The following explanations apply to tools also. 

Batch-tracked inventory is a quantity-based subunit (subquantity) of the total inventory of an item. 

The batch-tracked inventory total displays the physical inventory currently at the location. 

For each inventory receipt posting, batch-tracked inventory with a batch-tracked inventory quantity 

corresponding to the posted quantity is created. If a line is posted in more than one partial receipt, 

a separate batch-tracked inventory is created for each of these partial quantities. 
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If a line needs to be split into several units because of the different properties (see "Item properties 

for splitting batch-tracked inventory" page 1048) of the items it contains (see Receipt split (see 

"Split line" page 1081)), each split line becomes an individual batch-tracked inventory. Each of 

these batch-tracked inventories is uniquely defined by the properties of the item it contains. 

Batch-tracked inventory can also be generated as a result of splitting batch-tracked inventory that 

already exists. For example, this occurs in the Purchasing inspection, Manufacturing inspection, 

and Inspection objects if only partial quantities of batch-tracked inventory are posted. Or when you 

carry out transfers for which partial quantities of batch-tracked inventory totals are transferred and 

batch-tracked inventory must be split in order to obtain the quantity to be transferred. For this to 

occur, you must select the Can be split at issue option in the master data for the corresponding 

item. 

Batch-tracked inventory total 

The total of all identical batch-tracked inventory at a location, that is, all batch-tracked inventory of 

an item with identical property values, are merged into one batch-tracked inventory total. Taken in 

conjunction with planned receipts and issues, this total reflects the inventory currently available at 

a location.  

The batch-tracked inventory total for an item is identical to its batch-tracked inventory, unless the 

Can be merged flag is activated. 

The distinction made between batch-tracked inventory and batch-tracked inventory totals comes 

into play in Transfers (see "Transfer" page 1125) and Quantity transfers (see "Quantity transfer" 

page 1127). 

For information about the Merging option, see Merging (page 1039). 

Numbering method 1607 is used to assign IDs for the batch-tracked inventory of an item. Method 

1621 is used for the batch-tracked inventory of tools. 

Example: 160700096. 

The prefix used for tools is 1621. 

Example: 162100000345. 
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Item properties for splitting batch-tracked inventory 

Using item properties, you can assign splitting properties to an item in addition to its descriptive 

features such as price, text, supplier, etc. The items located in the warehouse are split into 

batch-tracked inventory (see "BT-inv." page 1046) with specific properties. You can then apply 

restrictions based on these attributes for all inventory movements. This ensures that only items 

with the required properties are used. 

In Infor COM Inventory, you can use the Inventory flags tab for each item to define the following 

properties as batch-tracked inventory attributes: 

 FIFO and LIFO sorting 

 Expiration date 

 Serialized ID (you must have selected Serialized/batch management (page 1066)) 

 Batch ID (you must have selected Serialized/batch management (page 1066)) 

 Inspection flags 

 Size and residual size management 

 Change status 

The item properties uniquely define a batch-tracked inventory and determine whether it is stored, 

processed, and delivered together with other batch-tracked inventory for the item. This splitting of 

batch-tracked inventory allows you to manage all inventories at the warehouse individually 

according to their item properties and to transfer them individually to Manufacturing and Sales. 

The values of the properties are entered when the items are received in Purchase receipt. If some 

items in a delivery line do not have the same values in their properties, for example, if their 

expiration dates do not match, you must perform a receipt split. This creates batch-tracked 

inventory containing items with identical property values only. 

Note: An item's properties for splitting batch-tracked inventory should not be confused with the 

inventory properties of an item; for example, its ABC frequency or sensitivity to temperature. 

Inventory properties are used by the receipt strategy (page 1040) when requested to find 

appropriate inventory locations. 
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Movement lists 

Description 

With movement lists, inventory movements can be planned and summarized in lists. For all 

inventory movements, you have the option of not carrying out the movement immediately but 

instead to issue a notification only, i.e. to advise of these movements. This is expressed in the 

Advised movement status. These movements can be added to an existing movement list. The 

movement list can be printed separately. The inventory posting is not carried out until the list is 

explicitly released. 

Using different criteria, the generated movements that belong to the same inventory request type 

can be included in a transfer list (see "Transfer lists" page 1129). The criteria are saved in the list. 

Movement lists can be used to plan inventory movements (page 1125) and compile them into lists. 

For all inventory movements, you can choose not to carry out the movement immediately, but 

instead issue a notification only, and assign it to a movement list if required. During the relevant 

process, you can specify by means of a selection dialog box whether inventory movements should 

be added to movement lists and how the lists should then be used. 

Notified movements can be added to existing movement lists. A movement list can be printed 

separately. However, the inventory posting is not carried out until the list is explicitly released.  

Note: The list can be generated with a path-optimized (see "Path optimization" page 1042) 

picking sequence. 

There is a separate movement list for each inventory movement: 

 Receipt lists (see "Receipt lists (Goods receipt)" page 1111) for goods receipts for purchase 

orders 

 Receipt lists (page 1159) for receipts for production orders 

 Transfer lists (page 1129) for transfer postings within the warehouse 

 Issue lists (see "Issue lists (Goods issue)" page 1146) for issue postings sales orders in Goods 

issue. 

 Issue lists (page 1156) as kit lists for issue and transfer postings for production orders 

Configuration 

The possible statuses of an inventory movement are stored in the WMSMOVEST allocation table. 
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You can determine which option is preset in this combo box for each individual order type using 

the movement list configurations in the WMSMVLSTCFG allocation table: 

For each receipt posting, transfer posting, and issue posting, you can select an entry from a 

combo box to specify whether a movement list is to be used, and if so, how it is to be processed. 

The possible options are provided for selection in the combo box. You can use the 

WMSMVLSTCFG allocation table to specify which of these options is set by default in the combo 

box for each order type (see below). You can also specify whether the user can change the default 

option during a process. 

In practice 

Note that when you delete a report, only the report is deleted. The movement status of the items in 

the report is retained. 

Manually generate movement lists 

To manually generate a movement list (see "Movement lists" page 1049), complete the following 

steps: 

1. Depending on the type of movement list, select the following processes: 

 Goods receipt > Receipt lists 

 Goods issue > Issue lists 

 Transfer > Transfer lists 

 Manufacturing > Receipt lists 

 Manufacturing > Issue lists 

2. Select the New tab and enter the data required to select the inventory movements that you 

want to add to the list. 

3. Then click Create to generate and display the list with the selected inventory movements. 

Note: You do not need to generate new movement lists for inventory movements that 

have not already been assigned. You can use a special function (see "Add movements 

that have not yet been assigned" page 1051) to add unassigned inventory movements to a 

movement list that has already been created. 
 



Infor COM 7.5 User Guide | 1051 

 

Inventory 

 

Open, print, and release movement list 

To manually print and/or release a movement list (see "Movement lists" page 1049), complete the 

following steps: 

1. Select one of the objects below, for example: 

Inventory > Goods receipt > Receipt lists 

Inventory > Goods issue > Issue lists 

Inventory > Inventory movements > Transfer lists 

2. Click the Open tab, enter the data required to select the movement list and select Load. 

For information on on how to add further inventory movements, see Add movements that have 

not yet been assigned (page 1051). 

Note: The status of lists that have not yet been printed or released is Generated status. If you 

would like to print a list, select Functions > Print list. After it is printed, the list has the status 

Printed. To print it again, use the Reprint menu command. 

To release the list, select Functions > Release. The status of the list is then changed to 

Confirmed and the status of the inventory movements is Completed. The goods are posted to 

the inventory locations. You do not need to print a list in order to release it. If you release a list 

that has not yet been printed, a message is displayed asking if you would to print the list first. If 

you respond to the message by clicking No, the list will be released without being printed. You 

can still print the list again at any time using either the Print list or Reprint menu command. 
 

Add movements that have not yet been assigned 

The following step-by-step instructions explain how to add as yet unassigned inventory 

movements to a movement list (see "Movement lists" page 1049) that already exists. 

Note: You can only add unassigned inventory transactions to lists whose status is Generated or 

Printed. If you select this function for lists that have already been printed, a message is displayed 

asking if you would like to continue anyway. If you confirm by clicking Yes, the process continues. 

Selecting No cancels the process.  
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You can only assign inventory movements from the same module (Purchasing, Sales) to a 

movement list. 

1. Load the relevant movement list by selecting one of the objects below, for example. 

Inventory > Goods receipt > Receipt lists 

Inventory > Goods issue > Issue lists 

Inventory > Transfer > Transfer lists 

2. Click the Open tab, enter the necessary data to select the required movement list and select 

Load to confirm. 

3. Once the list is loaded, select Functions > Add movements that have not yet been assigned. 

4. On the dialog box that is displayed, enter the data required to select the relevant inventory 

movements. 

5. Then click OK to add the inventory movements to the list and to close the dialog box. 

Note: If the list was already printed, you can print it again using the Reprint function. 
 

Warehouse address 

The warehouse address is the first of the five coordinate components of an inventory location (see 

Inventory location coordinates (see "Inventory locations" page 1091)). 

The warehouse address must be stored on the Address tab of the master data for eachinventory 

area (see "Inventory areas" page 1085). 

The warehouse address is the same as the address ID from the master data for a company. Each 

postal address that is entered here is automatically assigned an address ID. 

The addresses for your own warehouses are therefore taken from the address IDs of your 

company. We therefore recommend that you also enter the master data for your own company. 

For more information, see Enter master data for own company. 

See also the explanations of warehouse addresses in the Help topic for Default settings (page 

1099). 
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The warehouse addresses for customer consignment warehouses, supplier consignment 

warehouses, and subcontracted manufacturer warehouses are taken from the address IDs in the 

company master data of the corresponding customers, suppliers, and subcontracted 

manufacturers. 
 

Coordinate specification precision 

The coordinate specification precision specifies the exact level to which the system searches 

when determining the inventory location for the issue of items. This value is defined on the Default 

coordinates tab in the master data for the item and is set by default on purchase orders, 

production orders, and sales orders. The values are stored in the WMSCRDSPCS allocation table. 

XYZ The system searches for goods at the specified inventory location only. 

Cat. The system searches for goods within the specified inventory area. 

Address The system searches for goods in inventory areas with the specified 

address. 

 
 

Inventory posting IDs 

Information on this table:  The Object column displays the object in which the posting ID is 

available. Internal means that the system automatically sets and applies the ID when the relevant 

process is carried out. The inspection statuses referenced in the descriptions are stored in the 

WMSQAST allocation table. 

Note also that the posting IDs are assigned to separate posting IDs in Value flow. For more 

information, see Posting IDs in Value flow. 

ID Text/Object Effect 

7 Inventory count/Internal Posting ID used when the Post function is selected in inventory 
count lists (page 1178). 

10 TPD receipt/ 

Third-party delivery 
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ID Text/Object Effect 

11 Cancel TPD goods receipt/ 

Third-party delivery 

 

12 TPD RMA/ 

Third-party delivery 

 

15 TPD RMA/ 

Third-party delivery 

 

16 Cancel TPD goods flow/ 

Third-party delivery 

 

17 TPD return/ 

Third-party delivery 

 

60 Full receipt to consi. inspection Note: For the posting IDs 60-65, please also note the setting for the 

COMMON.WMS.ONLYCONSIGMENTLOCATION confirguration 

parameter. 

61 Partial receipt to consi. with 

inspection 

 

62 Unplanned receipt to consi. with 

inspection 

 

63 Cancel receipt to consi. with 

inspection 

 

64 Consi. with inspection RMA + 

requirement 

 

65 Consi. with inspection RMA  

80 Assignment/ 

Tool 

Tool reposted to machine location 

81 Separation/ 

Tool 

Tool posted back to warehouse (return posting) 

82 Unplan. assign./ 

Tool 

Corresponds to posting ID 188 for tool lines, i.e. a new tool line is 

added on the inventory transaction form and the tool is assigned to 

the production order. 

83 Full usage/ 

Tool 

Remaining life updated: The operation is complete or was 

interrupted. 

84 Partial usage/ 

Tool 

Remaining life updated: The operation is partially complete. 

85 Cancel usage/ 

Tool 

Operation canceled. 

86 Scrap defective material 

(manuf.)/Manufacturing 

Same effect as posting ID 90. 
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ID Text/Object Effect 

inspection 

87 Item conversion from/ 

Manufacturing inspection 

Same effect as posting ID 91. 

88 Item conversion to/ 

Manufacturing inspection 

Same effect as posting ID 92. 

90 Scrap defective 

material/Inspection 

 

If the inspection status of materials or tools is Manually 
quarantined, Order quarantined, or Order rejects, you can 

scrap them using posting ID 90. You can view the values of this 

scrapped materials or tools in the posting journal using journal types 

MSCJ/SSCJ/ISCJ. Scrapped batch-tracked inventory is assigned the 

internal inspection status 80 Scrapped. 



1056 | Infor COM 7.5 User Guide 

 

Inventory 

 

ID Text/Object Effect 

91 
Item conversion from/ 

Inspection 

Set this ID for batch-tracked inventory whose total quantity or partial 

quantity you want to convert to batch-tracked inventory of another 

item. To do this, the inspection status of the corresponding 

batch-tracked inventory must be Order quarantined, Manually 
quarantined, or Order rejects. After the final posting, the 

converted batch-tracked inventory is scrapped. For a more detailed 

description of the process, see Convert item in Inspection (page 

1194). 

92 
Item conversion to/ 

Inspection 

Use this ID to post batch-tracked inventory resulting from an item 

conversion. The system sets the ID automatically and you cannot 

select it manually. After the posting, the status of the batch-tracked 

inventory is No inspection. 

93 
Lock tool/ 

Inspection 

Sets the the inspection status of full batch-tracked tool inventory from 

No inspection or Order inspected to Manually quarantined. 

To scrap materials and tools with the status Manually 
quarantined or Order quarantined, you must use posting ID 90. 

94 
Restore tool life/ 

Inspection 

For more information, see Restore tool life. 

100 
Opening balance migration  

101 
Opening balance  

102 
Inv. count property adjustment  

103 
Attribute adjustment/ 

Inventory adjustment 

Special posting ID used if you only want to modify the properties (e.g. 

expiration date, serialized ID, dimensions etc.) of batch-tracked 

inventory. 

104 
Not inspected -> Inspected/ 

Inspection 

Changes the inspection status of batch-tracked inventory from Not 

manually inspected to Manually inspected. 

105 
Not inspected -> Locked/ 

Inspection 

Changes the inspection status of batch-tracked inventory from Not 
manually inspected to Manually quarantined. 

106 
Quarantined -> Inspected/ 

Inspection 

Changes the inspection status of batch-tracked inventory from Order 
quarantined or Manually quarantined to Manually inspected. 

107 
Inspected -> Quarantined/ 

Inspection 

Changes the inspection status of batch-tracked inventory from No 
inspection or Manually inspected to Manually quarantined . 

108 
Inspected -> Not inspected/ 

Inspection 

Changes the inspection status of the batch-tracked inventory from No 

inspection, Manually inspected, or Order not inspected to Not 
manually inspected. 
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109 
Quarantined -> Not inspected/ 

Inspection 

Changes the inspection status of batch-tracked inventory from Order 

quarantined or Manually quarantined to Not manually 
inspected. 

110 
Split from/ 

Internal + Inventory adjustment 

Posting ID used to split the original batch-tracked inventory (source 

batch-tracked inventory). The system uses this posting ID for transfers, 

for example. You can select it explicitly for splitting batch-tracked 

inventory in the Inventory adjustment object. A split process will always 

be followed by a posting process using posting ID 111 Split to. 

111 
Split to/ 

Internal 

Posting ID used by the system to post the batch-tracked inventory 

resulting from split processes (using posting ID 110 or 118, for 

example). 

112 
Merge from 

Internal 

 

113 
Merge to/ 

Internal 

 

114 
Available -> Reserved/ 

Internal 

 

115 
Reserved -> Available  

116 
New dummy inventory/ 

Internal 

Posting ID used by the system to post generated dummy batch-tracked 

inventory. 

117 
Cancel dummy inventory/ 

Internal 

Posting ID used by the system to cancel a posting made using posting 

ID 116 if the corresponding advance shipping notice and goods issue 

are canceled. 

118 
Split from (+LWH change)/ 

Inventory adjustment 

Posting ID used for Split batch-tracked inventory of Residual 
size management items (see "Split batch-tracked inventory 
for Residual size management items" page 1190) with prior 

specification of the required number, length, width, or height.  

When you split batch-tracked inventory using this posting ID, a 

subsequent posting is always made using posting ID 111 Split to. 

 

119 
Merge to (+LWH change) This posting ID is not currently used. 

120 
Insp. to quarantine W/H 

receipt/ 

Manufacturing inspection 

The quantity posted to Manufacturing inspection using posting ID 

121 or 122 is posted to the quarantine warehouse. The inspection 

status of the corresponding batch-tracked inventory records is changed 

from Order not inspected to Order quarantined. 

121 
Manuf. to insp. full receipt/ 

Inventory transaction 

The full quantity of the manufactured goods is posted in 

Manufacturing inspection, where the corresponding batch-tracked 
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inventory records are assigned the inspection status Order not 

inspected.  
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122 
Manuf. to insp. partial receipt/ 

Inventory transaction 

A partial quantity of the manufactured goods is posted in 

Manufacturing inspection, where the corresponding batch-tracked 

inventory records are assigned the inspection status Order not 

inspected. 

123 
Cancel manuf. to insp. receipt/ 

Inventory transaction 

Cancels postings made using posting IDs 121 and 122. 

124 
Inspection to warehouse 

receipt/ 

Manufacturing inspection 

Posts the batch-tracked inventory to the warehouse if it has the 

inspection status Order not inspected. After the posting, its 

inspection status changes to Order inspected. 

125 
Full ext. W/H receipt/ 

Manufacturing inspection 

Cancels postings made to the warehouse using posting ID 120 and 

postings made to the quarantine warehouse using posting ID 124. The 

inspection status is changed from Order inspected to Order not 
inspected, or from Order quarantined to Order not inspected. 

130 
Cancel ext. W/H receipt/ 

Subcontracted manufacturing 

Cancels the receipts made using posting IDs 131/132 

131 
Full ext. W/H receipt/ 

Subcontracted manufacturing 

This posting ID is used for purchased items that are required as 

materials provided for subcontracted manufacturers only. These items 

should not be stored but sent instead to the subcontracted 

manufacturer directly - See  Inventory transactions for material 

provided. 

132 
Partial ext. W/H receipt/ 

Subcontracted manufacturing 

Corresponds to posting ID 131 for partial receipts 

135 
S/C manuf. to insp. rec. RMA 

Subcontracted manufacturing 

Corresponds to posting ID 164 for subcontracted manufacturing 

purchase orders 

136 
S/C manuf. receipt RMA 

Subcontracted manufacturing 

Corresponds to posting ID 165 for subcontracted manufacturing 

purchase orders 

137 
Cancel consign. receipt/ 

RMAs/cancellations + Cancel 

inv. transactions 

You can use this posting ID to cancel the purchase receipt postings in 

the supplier consignment warehouse. 

Note: Purchase receipts are posted in the Supplier consignment 

object using posting ID 161 or 162.  

For more information, see RMAs/cancellations (page 1115) and 

Cancel inv. transactions (page 1113). 

138 
Consignment and requirement 

RMA/ 

RMAs/cancellations 

This posting ID is used for posting RMAs from supplier consignment 

warehouses. There is no replacement required for the returned 

quantity. See also RMAs/cancellations (page 1115) 

139 
Consignment RMA/ 

RMAs/cancellations 

This posting ID is used for posting RMAs from supplier consignment 

warehouses. A replacement is required for the returned quantity. See 

also RMAs/cancellations (page 1115) 
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140 
Cancel inspection receipt/ 

RMAs/cancellations + Cancel 

inv. transactions 

This posting ID cancels the goods receipts posted to Purchasing 

inspection from Purchase receipt. 

Note: Purchase receipts are posted in Purchase receipt using 

posting IDs 153 or 154. 

For more information, see RMAs/cancellations (page 1115) and 

Cancel inv. transactions (page 1113). 

141 
Cancel receipt/ 

RMAs/cancellations + Cancel 

inv. transactions 

This posting ID cancels the goods receipts posted to the warehouse 

from Purchase receipt. 

Note: Purchase receipts are posted in Purchase receipt using 

posting IDs 151  and 152. 

For more information, see RMAs/cancellations (page 1115). 

142 
Cancel S/C manuf. to insp. 

rec./ 

RMAs/cancellations 

This posting ID is specifically used for canceling receipt postings for 

subcontracted manufacturing items that were posted to Purchasing 

inspection from Purchase receipt using posting IDs 143 and 144. 

143 
S/C manuf. to insp. full rec. 

Purchase receipt 

Posts the total quantities of subcontracted manufactured items in 

Purchasing inspection. 

144 
S/C manuf. to insp. part. rec. 

Purchase receipt 

Same as posting ID 143, but posts partial quantities only. 

145 
FRA purchasing surplus  

146 
Partial S/C manuf. receipt/ 

Purchase receipt 

Same as posting ID 147, but posts partial quantities only. 

147 
Full S/C manuf. receipt/ 

Purchase receipt 

Posts the total quantities of subcontracted manufactured items to the 

warehouse. 

148 
Return from S/C 

manufacturing/ 

Materials provided 

For more information, see Materials provided (page 1119). 

149 
Cancel S/C manuf./ 

RMAs/cancellations 

This posting ID is specifically used for canceling postings made in 

Purchase receipt for the receipt of subcontracted manufactured items 

in the warehouse using posting ID 146 and 147. 

150 
Insp. to quarantine W/H 

receipt/ 

Purchasing inspection 

Posts batch-tracked inventory to the quarantine warehouse where this 

batch-tracked inventory was generated from postings made in 

Purchase receipt using posting IDs 153 and 154. The inspection 

status is changed from Order not inspected to Order 
quarantined. 

151 
Full inventory receipt/ 

Purchase receipt 

Posts the total quantities of purchase order lines to the warehouse. 

152 
Partial inventory receipt/ 

Purchase receipt 

Same as posting ID 151, but posts partial quantities only. 
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153 
Full inspection receipt/ 

Purchase receipt 

Posts the total quantities of purchase order lines for inspection in 

Purchasing inspection (Goods receipt folder). The status of the 

resulting batch-tracked inventory is Order not inspected. 

154 
Partial inspection receipt/ 

Purchase receipt 

Same as posting ID 153, but posts partial quantities only. 

155 
Cancel insp. to W/H receipt/ 

Purchasing inspection 

Cancels postings made in Purchasing inspection using posting IDs 

150 and 156. 

156 
Insp. to W/H receipt/ 

Purchasing inspection 

Reposts batch-tracked inventory from Inspection back to the 

warehouse. The inspection status changes from Order not 
inspected to Order inspected. 

157 
Full S/C manufacturing issue/ 

Materials provided 

For more information, see Materials provided (page 1119). 

158 
Partial S/C manufacturing 

issue/ 

Materials provided 

For more information, see Materials provided (page 1119). 

159 
Cancel S/C manuf./ 

Materials provided 

For more information, see Materials provided (page 1119). 

160 
Transfer to S/C manufacturing/ 

Materials provided 

For more information, see Materials provided (page 1119). 

161 
Full consign. receipt/ 

Supplier consignment 

Posts the total quantities of purchase order lines to the supplier's 

consignment warehouse. 

162 
Part cons rec/ 

Supplier consignment 

 

Same as posting ID 161, but posts partial quantities only. 

163 
Unplanned consignment 

receipt/ 

Supplier consignment, 

Inventory adjustment 

Posts lines that were added to the purchase order during purchase 

receipt to the supplier consignment warehouse. 

164 
Inspection and requirement 

RMA/ 

RMAs/cancellations 

The returned item was originally posted using the Inspection receipt 
posting ID. Inspection has now detected a defect and wants to return 

the item to the supplier. A replacement is required for the return. The 

outstanding quantity in the associated purchase order is automatically 

increased by the RMA quantity – See also RMAs/cancellations 

(page 1115). 

Note: When RMAs are carried out from Purchasing inspection, only 

quantities for which a posting has already been made in the warehouse 

(156 Inspection to warehouse receipt) or quarantine warehouse 

(150 Insp. to quarantine W/H receipt) are considered returnable. 
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165 
Warehouse and requirement 

RMA/ 

RMAs/cancellations 

The item is already posted to the warehouse as a receipt but needs to 

be sent back to the supplier. A replacement is required for the RMA 

quantity. The outstanding quantity in the associated purchase order is 

automatically increased by the RMA quantity -  

See also RMAs/cancellations (page 1115). 

166 
Inspection RMA/ 

RMAs/cancellations 

This posting ID is used for posting RMAs from Purchasing receipt. 

The item to be returned was originally posted using the inspection 
receipt posting ID. Since there is no replacement required for the 

RMA quantity, the delivery can be canceled. The outstanding quantity 

is therefore unchanged in this case - see also RMAs/cancellations 

(page 1115). 

Please refer to the  description provided for posting ID 164. 

167 
Inspection RMA/ 

RMAs/cancellations 

This posting ID is used for posting RMAs from the warehouse - the item 

to be returned is located in the warehouse. Since there is no 

replacement required for the RMA quantity, the delivery can be 

canceled. The outstanding quantity is unchanged in this case. Planning 

handles the item as an issue, and it is ordered again in the event of a 

shortage. See also RMAs/cancellations (page 1115). 

168 
Unplanned purchasing receipt/ 

Purchase receipt 

Posts lines that were added to the purchase order during purchase 

receipt to the warehouse. 

169 
Unplanned inspection receipt/ 

Purchase receipt 

Posts lines that were added to the purchase order during purchase 

receipt to Purchasing inspection. 

171 Full inv. issue/ 

Sales issue 

This posting ID is used for issuing total quantities from the warehouse. 

172 Part. inv. issue/ 

Sales issue 

Similar to posting ID 170, this posting ID is used for issuing partial 

quantities from the warehouse. 

173 Move to consignment/ 

Sales issue 

This posting ID is used to repost goods from the goods issue location 

(GI) to the customer's consignment inventory location. For more 

information, see Customer consignment (see "Customer 
consignment warehouse" page 1069). 

174 Return from consignment 

Sales issue 

Goods transferred to the consignment inventory location using posting 

ID 173 are reposted back again using this posting ID. 

176 Return to quarantine W/H 

Sales issue 

Goods already issued using posting ID 171 or 172 are reposted back 

to the quarantine warehouse. 

177 Return/ 

Internal 

Posting ID used by the system to post the return of goods that were 

already issued if an advance shipping notice is canceled in Sales. 

180 Cancel manuf. receipt/ 

Inventory transaction 

Cancels postings made in Manufacturing using posting IDs 181 and 

182. 

181 Full manufacturing receipt/ Posting ID used to post the total quantity of a manufactured item (HR 
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Inventory transaction record type) in a production order to the warehouse. 

182 Partial manufacturing receipt/ 

Inventory transaction 

Same as posting ID 181, but posts partial quantities. 

183 Full man. issue 

Inventory transaction 

Used to issue the material (MA record) required to manufacture 

finished products (HR records). 

184 Part. man. issue/ 

Inventory transaction 

Same as posting ID 183, but posts partial quantities. 

185 FRA manufacturing surplus  

188 Unplanned issue  

189 Cancel manuf. issue/ 

Inventory transaction 

Cancels issue postings made in Manufacturing using posting IDs 183 

and 184. 

191 Miscellaneous receipt/ 

Inventory adjustment 

Posting ID used for miscellaneous quantity postings to existing 

batch-tracked inventory or for miscellaneous entries of completely 

new batch-tracked inventory. 

192 Miscellaneous issue/ 

Inventory adjustment 

Miscellaneous quantity issue postings for existing batch-tracked 

inventory. 

193 Reposting/ 

Internal 

This posting ID is used, for example, if you use the Transfer object to 

carry out a transfer, or the Quantity transfer object to carry out a 

quantity transfer. Posting IDs 110 and 111 are always used to split the 

quantities here, even if the total quantity is reposted. 

Note: You cannot select this posting ID manually. 

194 Quantity adjustment/ 

Inventory adjustment 

Used to adjust batch-tracked inventory quantities. 

195 Value adjustment  

196 Supplier consignment W/H 

receipt/ 

Inventory adjustment 

Used for miscellaneous generation of batch-tracked inventory in 

supplier consignment warehouses. 

198 From quarantine warehouse/ 

Quarantine consignment 
warehouse (see 

"Quarantine consignment 

W/H" page 1150) (Goods 

issue) 

Posting ID used for deleting the COR (confirmation of receipt) flag 

from batch-tracked inventory in Automotive. When the flag is deleted, 

the inspection status is changed from Order not inspected to 

Order inspected. 

199 From quarantine warehouse/ 

Quarantine consignment 

warehouse (Goods issue) 

Resets the COR  (confirmation of receipt) flag (see also posting ID 

198). 

201 Revaluation  
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205 Inventory invoice price  

206 Cancel inventory invoice price  

207 Expense  

208 From supplier consignment 

W/H 

 

209 To supplier consignment W/H  

210 Shipping materials issue  

211 Shipping materials RMA  

212 Return from S/C available inv. Not currently supported. 

213 Repost ShM fr. main W/H to 

Q W/H 

Not currently supported. 

214 Repost ShM from Q W/H to 

avail. 

Not currently supported. 

215 Return from S/C quarantine 

W/H 

 

216 Return from S/C available inv. 
 

217 Repost to S/C quarantine 

W/H 
Not currently supported. 

218 Repost ShM to S/C 

quarantine W/H 

 

219 Return ShM from S/C avail. 

inv. 

 

220 Return ShM from S/C 

quarantine W/H 

Not currently supported. 

221 Return ShM to quarantine 

W/H 

Not currently supported. 

231 Repairs receipt  

232 Cancel repairs receipt  

233 Transfer to vehicle  

234 Return from vehicle  

242 Purchase credit memo 

quantity adjustment/ 

Purchase credit memo 

 

243 Cancel purchase credit memo  
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quantity adjustment/ 

Purchase credit memo 

244 Purchase credit memo price 

adjustment 

Purchase credit memo 

 

245 Cancel purchase credit memo 

price adjustment/ 

Purchase credit memo 

 

246 Debit memo quantity 

adjustment/ 

Debit memo 

 

247 Cancel debit memo quantity 

adjustment/ 

Debit memo 

 

248 Debit memo price adjustment/ 

Debit memo 

 

249 Cancel debit memo price 

adjustment/ 

Debit memo 

 

250 Full waste issue/ 

Purchase orders (Purchasing) 

Posting ID used for full issue postings of waste in disposal orders 

(EMS). 

251 Partial waste issue/ 

Purchase orders (Purchasing) 

Same as posting ID 250, but posts partial quantities only. 

252 Cancel full waste issue  

253 Cancel partial waste issue  
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Serialized/batch management 

Description 

The serialized and batch management function (see the terms series and batch) allows you to use 

serialized batch IDs to log and track all goods movements in Infor COM. 

In Infor COM, a batch refers to an identifiable quantity of an item with specific shared properties 

that is managed separately from other partial quantities of the same material in inventory. Each 

item in the batch will have the same batch ID. If the batch is merged, multiple batches can be used 

in one BOM line. If the batch is split, only one batch can be used (same batch). 

A series is a quantity of items that is manufactured in a given context. Each item in the series has 

an individual serialized ID. The sole purpose of the serialized ID is to uniquely identify an individual 

item (quantity =1) 

The Inventory management function alone is not capable of tracking the origin or previous usage 

of items. The inventory journal just logs the quantities that have been moved. 

To enable the allocation of items to an internal production process or supplier receipt even after 

delivery to a customer as well as the processing of complaints and call-backs, etc., an ID is 

assigned to these items when the receipt is entered. For groups of items, this ID is the batch ID; 

for individual items, it is the serialized ID. 

In the master data for the item, you can specify whether or not batch IDs or serialized IDs should 

be assigned automatically, and which method you want to use. You do this in the S/B numbering 

field on the Inventory tab. The numbering methods available for selection are maintained in 

the.WMSSERBATNM allocation table. 

Example: Batch ID 2608, Series: 26080001-26089999 

In this example, all items in the batch are assigned batch ID 2608. The series includes items with a 

serialized ID between 26080001 and 26089999. 

For items that are managed as batch items, you can select the Same batch check box to specify 

that the items must be issued as same-batch (see "Reserve same batch" page 1068) items. 
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Functions 

Generate batch IDs: You can access this function from the line view when you select Inventory > 

Goods receipt > Purchase receipt. When manual batch-tracked specifications are used, it 

automatically assigns a unique batch ID to each line (batch). Existing batch IDs are not 

overwritten. The batch IDs are entered on the Receipt properties tab. 

Serialized/batch ID according to presetting: You can access this function in the Inventory 

transactions and Purchase receipt objects, for example, when working with manual batch-tracked 

inventory specifications (see "Enter manual batch-tracked inventory specification" page 1080) and 

items that need to be managed as batch items or serialized items. When you run this function, the 

serialized IDs or batch IDs that were already pre-assigned in the production order or purchase 

order are transferred to the Receipt properties tab. 

Generate serialized IDs: You can access this function from the line view in Purchase receipt or 

Inventory transactions. When working with manual batch-tracked inventory specifications, it 

automatically generates a range of serialized IDs corresponding to the transaction quantity. Any 

manually entered serialized IDs are not replaced. The serialized IDs are entered on the Receipt 

properties tab. 

Note: You can also select this function when splitting lines (see Split line (page 1081)). To do this, 

simply select the check box of the same name on the corresponding dialog box. 

Accept number of serialized IDs as quantity: You can access this function from the line view in 

Inventory transactions or Purchase receipt when entering manual batch-tracked inventory 

specifications (see "Enter manual batch-tracked inventory specification" page 1080) of items that 

need to be managed using serialized IDs. This function compares the quantity in the currently 

selected line (see Receipt properties tab) with the number of specified serialized IDs. 

In practice 

Defining serialized/batch IDs: You can define whether you want an item to be managed as a batch 

item or serialized item by selecting the Batch ID or Serialized ID check box on the Inventory flags 

tab in the master data for the item (Design > Items). If an item is flagged as a batch item in the 

master data, a batch must be assigned to each batch-tracked inventory each time a goods receipt 

is carried out in Purchasing and a goods issue is carried out from Manufacturing. It's also possible 

to search for each product and material and create a corresponding where-used list. 
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Manually entering batch/serialized IDs: Perform purchase receipt (ms-its:wms.chm::/10111.htm). 

Automatically assigning batch/serialized IDs: See Automatically assign serialized and batch IDs. 

 
 

Reserve same batch 

Same-batch issue means that the quantity of a material line can only be issued from batch-tracked 

inventory that has the same batch ID. 

The Reserve same batch function is available in sales orders and in production orders for items for 

which the Batch ID and Same batch check boxes are selected on the Inventory flags tab. 

1. Select Sales > Order processing > Sales orders , or Manufacturing > Production orders, enter 

values in the required fields on the Open tab and click Load to confirm. 

2. Select Functions > Reserve same batch. 

For items with a Same batch flag, this function reserves batch-tracked inventory with the same 

batch ID only, and then enters the batch IDs on the  Properties tab. 

If there are no batch IDs entered here, no issue postings can be made. 

 

ms-its:wms.chm::/10111.htm


Infor COM 7.5 User Guide | 1069 

 

Inventory 

 

Customer consignment warehouse 

Customer consignment warehouses are warehouses on the customer's premises that store goods 

that are still your property. You do not invoice your customer for the goods until the customer 

issues the goods for further processing or sale. 

Customer consignment warehouses allow you to reduce the number of supplier processes and 

your inventory location space requirement. 

Note: In Automotive, customer consignment warehouses are used as subcontractor warehouses. 

For more information, see Subcontractors. 

Prerequisi tes for consignment del iveries to customers:  

 For each customer, you must create at least one inventory area with the address ID of the 

relevant customer. The warehouse type must be S/C warehouse, and the consignment 

warehouse type must be Customer consignment. 
 This inventory area must contain at least one inventory location. 
 

Enter sales order for delivery to consignment warehouse 

Customers generally request the delivery of stock to their consignment warehouse by creating an 

order on their end. This order is then used as the basis for creating a sales order at your end. 

As with any sales order, you can manually reserve batch-tracked inventory in your own warehouse 

by selecting Go to > Reservation > Warehouse address. If the status of the sales order is Issue, 

you can also reserve batch-tracked inventory in the consignment warehouse of the relevant 

customer by selecting Go to > Reservation > External address. For more information, see the 

Reservations in customer consignment warehouses (see "Create reservations in customer 

consignment warehouse" page 1071) Help topic. 

To enter a sales order for a delivery to a consignment warehouse, complete the following steps:  

For information on which requirements need to be met for a consignment delivery on the 

warehouse side, see Customer consignment warehouses. 
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1. In the Sales module, click the Order processing folder followed by the Sales orders object. 

Select the New tab. 

The next available order ID is assigned. You can overwrite this ID if required.  

To create a sales order for a delivery to the consignment warehouse, select the Consignment 

delivery check box. 

2. In the Customer ID field, enter a customer ID or select one from the combo box. 

3. You can enter additional text in the Job field. This can be used later for filtering orders. 

4. You can also enter the customer's PO ID. This can be included in subsequent printouts. 

5. If a requested delivery date has been agreed with the customer, you can enter this date here. 

Note: You can then calculate the earliest possible delivery date in the order itself by selecting 

Calculate delivery date from the Functions menu. 

6. Click Create. 

The data you entered in the previous dialog box is now displayed in the order header. With the 

exception of the order ID, you can correct this data here if necessary. 

7. From the order lines table on the Order tab, select the item(s) you require. You can enter the 

item ID in the Resource field. A description of the item is displayed in the Description field 

when you confirm. 

To search for the item, select Go to > Find master data. 

Note: It is also possible to enter an item for which no master data exists. For more information, 

see the Enter one-off item in sales order Help topic. 

8. In the Quantity field, enter the required quantities. The calculated unit price is displayed in the 

Price field. All group flags are taken into account here. For more information, see the Prices 

and discounts in Sales Help topic. 

9. Repeat steps 7 and 8 until you have entered all lines in the order. 

10. Select the External warehouse tab. 

Note: This tab displays the coordinates of the consignment warehouse location. If several 

consignment inventory locations exist for the customer, you can select the inventory location 

for each order line. If you do not select an inventory location, the first inventory location in the 

alphabetical sequence of available locations is posted automatically. 

11. Check whether the Area, X, Y, and Z fields contain the coordinates of the required 

consignment inventory location. If not, select these from the combo boxes in the fields. 
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12. From the Functions menu, select Create document. In the dialog box that is displayed, select 

the Order confirmation option and click OK to confirm. The order confirmation is printed. 

13. Select Data and Save to save the sales order and Data and Close to close the sales order. 
 

Create reservations in customer consignment warehouse 

In sales orders for consignment deliveries (see Customer consignment warehouses (see 

"Customer consignment warehouse" page 1069)), you can also reserve batch-tracked inventory 

that is stored at the customer's consignment warehouse and has the status Available. To do this, 

select Go to > Reservation > Ext. address. 

Please note that for this type of reservation the status of the sales order must be Issue. 

Note: To reserve batch-tracked inventory in your own warehouse, select Go to > Reservation > 

W/H address. 

To reserve batch-tracked inventory in a customer consignment warehouse, 

complete the fol lowing steps:  

1. In the sales order, select the line for which you want to reserve quantities. 

2. Select Go to > Reservation > Ext. address to display the reservation form. 

3. The table displays the batch-tracked inventory that has already been reserved for the sales 

order line when printing the advance shipping notice. The batch-tracked inventory is located at 

the consignment warehouse and has the status Consignment-reserved. The Outst. qty field on 

the form header displays the quantity of the order line. The Reserved quantity field below 

displays the quantity that has already been reserved for this order line. 

4. To reserve quantities of the available batch-tracked inventory at the customer's consignment 

warehouse, you need to load this batch-tracked inventory first. Select Functions > Reload 

batch-tracked inventory to display the Reload batch-tracked inventory dialog box. 
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Note: If you want to reload specific batch-tracked inventory directly, you do not need to 

open this dialog box. Instead, enter the ID of the required batch-tracked inventory in the 

BT-inv. field on the form header. If the item is managed as a serialized item, you can also 

reload the batch-tracked inventory using the serialized ID or, if available, the external 

serialized ID. You use the Serialized ID or Ext. SID fields to do this. When you exit the 

relevant field, the selected batch-tracked inventory is reloaded in the reservation table. If 

the batch-tracked inventory was already reserved for another sales order, a corresponding 

message is displayed and the reload process is canceled. Continue from step 6. 

5. On the Ext. warehouse tab, enter the warehouse coordinates where the required 

batch-tracked inventory is located. Then click OK. The dialog box closes and the 

batch-tracked inventory that is found by the system is reloaded in the reservation table.  

6. In the reservation table, select the Quantity tab. The status of the reloaded batch-tracked 

inventory is Unassigned. 

7. Use the Spec. qty field to specify exactly which quantity from which batch-tracked inventory 

you want to reserve. Note the following here: 

 The quantity of the batch-tracked inventory that is reserved must not exceed the quantity 

of the batch-tracked inventory that is available.  

 If you reserve a quantity that is greater than the overall order quantity (see Outst. qty field 

on form header), a corresponding message is displayed although you will still be able to 

reserve this quantity. However, when the invoice is printed later, and the associated issue 

posting is carried out automatically, only the required order quantity will be issued.  

 If you reserve a total quantity that is smaller than the required order quantity, this will 

cause problems if you enter a manual batch-tracked inventory specification when the 

invoice is being printed later. The total batch-tracked inventory quantity specified for an 

invoice line must match the transaction quantity of this invoice line. 

8. Save your entries. The reservation form closes and the sales order is displayed again. 

The next step involves printing the invoice (see "Print invoice for consignment delivery" 

page 1077). 
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Print advance shipping notice for consignment delivery 

The following overview describes how to generate and print an advance shipping notice for a 

delivery to a customer consignment warehouse. You can do this in the underlying sales order 

(Sales orders object), or in the Advance shipping notices object (Sales > Order processing). 

There are two options available for printing advance shipping notices. For detailed step-by-step 

instructions, see Print advance shipping notice for consignment delivery. 

Advance shipping notice without issue ASN with issue 

When you print an advance shipping notice 

without issue, the goods are transferred from your 

current inventory location to the defined goods 

issue location. Before printing the advance 

shipping notice, you can also select whether you 

want to work with an issue list (see "Movement 

lists" page 1049). Once the advance shipping 

notice is printed, the relevant batch-tracked 

inventory is automatically reserved for the 

underlying sales order and is assigned the 

reservation status Consignment-reserved. This 

batch-tracked inventory is no longer be available 

for other issues. 

It's also possible to print advance shipping 

notices with the simultaneous issue of 

batch-tracked inventory (ASN with issue 

option). In contrast to printing advance 

shipping notices without issues (see 

above), the difference here is that the 

batch-tracked inventory is transferred from 

your current inventory location to the 

consignment inventory location directly. In 

addition, the Generate and release 

automatically option is the only option 

available if you're working with an issue 

list. 

 

If an advance shipping notice was printed without issue, you need to manually post the transfer of 

goods from the goods issue location to the consignment inventory location. To do this, select 

Inventory > Goods issue > Sales issue and use posting ID 173 Move to consignment. 

 For more information, see Transfer batch-tracked inventory to a customer consignment 

warehouse (page 1079). 

Note:  

 If you are working with an issue list (see previous point), you must release this list first. 

 You must transfer the full advance shipping notice quantity. It is not possible to transfer a 

smaller or larger quantity. 
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 The External coordinates tab in Sales issue displays the consignment inventory location(s) 

specified beforehand in the sales order. You cannot make any changes here. 

 If the advance shipping notice is canceled after the transfer to the consignment inventory 

location, the relevant batch-tracked inventory is automatically posted back to the original 

batch-tracked inventory (using posting ID 174). 

 After the transfer to the customer consignment warehouse, the batch-tracked inventory is 

assigned the status Transferred and is now reserved for the sales order. The status of the 

sales order is set to Issue. This status also permits the reservation of batch-tracked inventory 

located at the consignment warehouse of the relevant customer.  

 For more information, see Reservations in customer consignment warehouses (see "Create 
reservations in customer consignment warehouse" page 1071). 

 From a posting point of view, the process is evaluated as a transfer. 

 

Provided the goods have not yet been issued from the consignment inventory location, you can 

also carry out the following actions: 

 Carry out inventory adjustments (see "Inventory adjustment" page 1188) 

 Transfer (page 1125) batch-tracked inventory or partial batch-tracked inventory quantities to 

and from customer consignment warehouses. Note that batch-tracked inventory transferred 

from a customer consignment warehouse will, of course, no longer be available for 

subsequent issues from this warehouse. Instead, transfers allow goods that were not accepted 

by the customer to be posted back to your own warehouse. 

 Using the Inventory count lists (page 1178) object, you can increase the inventory at a 

customer consignment warehouse as part of an inventory count. 

 
 

Print advance shipping notice for consignment delivery in sales order 

To print an advance shipping notice for a consignment delivery in the sales order: 

1. Select Sales > Order processing > Sales orders. 

2. On the Open tab, select the Consignment delivery check box, enter the data for the required 

sales order and click OK. 

3. Select Functions > Create document. 

Note: To then edit the advance shipping notice that was created, click the Edit button. When 

you enter the advance shipping notice ID, you are taken directly to the advance shipping 

notice. 
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4. Select whether you want to generate and print the advance shipping notice with or without the 

simultaneous issue of the relevant batch tracked inventory. To do this, select either the ASN 

option or the ASN + issue option. 

Advance 

shipping notice, 

ASN 

The batch-tracked inventory is transferred to the specified goods 

issue location. You then need to manually transfer it from here to 

the customer's consignment warehouse. For more information, 

see Transfer batch-tracked inventory to a customer consignment 

warehouse. 

ASN + issue The batch-tracked inventory is automatically transferred to the 

customer consignment warehouse. 

5. Use the Issue list field to determine whether you want to work with an issue list, and if so, 

which option you want to use.  

Note: Note that if you selected the ASN + issue option, the only option available will be 

Generate and release automatically. 

6. Click OK. The Create document dialog box closes. 

Depending on your settings, the advance shipping notice and, if applicable, the shipping 

documents are printed or the dialog box for assigning the ASN ID is displayed. 
 

Print advance shipping notice for consignment delivery in advance shipping notice 

To print an advance shipping notice for a consignment delivery in advance shipping notice: 

1. Select Sales > Order processing > Advance shipping notices and select the New tab. 

2. Select the Consignment delivery check box, select the data of the sales order for which you 

want to generate an advance shipping notice and click Create. 

Note: If you want to change the confirmed order quantity for the ASN printout, change the 

quantity details in the ASN qty field on the ASN tab. 

3. Select Functions > Create document to display the Create document dialog box. 

4. Select whether you want to generate and print the advance shipping notice with or without the 

simultaneous issue of the relevant batch tracked inventory. To do this, select either the ASN 

option or the ASN + issue option. 



1076 | Infor COM 7.5 User Guide 

 

Inventory 

 

Advance 

shipping notice, 

ASN 

The batch-tracked inventory is transferred to the specified goods issue 

location. You then need to manually transfer it from here to the 

customer's consignment warehouse. For more information, see Transfer 

batch-tracked inventory to a customer consignment warehouse. 

ASN + issue The batch-tracked inventory is automatically transferred to the customer 

consignment warehouse. 

5. If applicable, select the Shipping documents check box to print shipping documents. 

6. Use the Issue list field to determine whether you want to work with an issue list, and if so, 

which method you want to use. 

Note that if you selected the ASN + issue option, the only option available will be Generate and 

release automatically. 

7. Click OK to open the Create document dialog box. 

8. Confirm the New dialog box that is displayed by clicking OK. The advance shipping notice is 

then printed. 

Note: Once the advance shipping notice is printed, the status of the underlying sales order 

changes to ASN printed, or in the case of partial deliveries, to Par.ASN printed. 
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Print invoice for consignment delivery 

The following overview describes how to generate and print an invoice for a delivery to a customer 

consignment warehouse (page 1069). 

The issue posting for goods in a customer consignment warehouse is carried out automatically 

when the invoice for the consignment delivery is printed. 

 If a customer did not accept the full delivery quantity, the invoice quantity can be reduced 

accordingly before the invoice is printed. 

 The Manual batch-tracked inventory specification dialog box is displayed automatically before 

an invoice is printed. If required, you can manually specify the batch-tracked inventory that 

was already reserved for the sales order for the issue. You can also reload unreserved, that is, 

available batch-tracked inventory for manual specification. 

For more information, see Print invoices for consignment deliveries (see "Print invoice for 

consignment delivery" page 1077). 

 If a customer did not accept the full delivery quantity, you can process the remaining 

batch-tracked inventory at the customer consignment warehouse as follows: 

 Scrap it using the Inventory adjustment object or by posting a negative difference as part 

of an inventory count (see Enter quantities counted under Inventory count lists (page 

1178)). 

 Transfer it to your own warehouse. 

 Leave it at the consignment warehouse for future issues. 

Note: 

 If a customer did not accept the full delivery quantity, you can adjust the invoice quantity 

before printing. 

 When a consignment invoice is printed, the associated issue posting (posting ID 171 Full inv. 

issue) for the batch-tracked inventory at the consignment warehouse is carried out 

automatically. 

There two options available for printing invoices: 
 

Print invoice for consignment delivery from sales order 

To print an invoice for a consignment delivery in advance shipping notice: 

1. Select Sales > Order processing > Sales orders to load the order by selecting the 

Consignment delivery check box on the Open tab. 

2. Select Functions > Create document and select the Invoice and Print options. 
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3. Optional: Click Edit to edit the invoice quantity: 

1. Adjust the default quantity in the Calculate field on the Invoice tab. 

2. Select Functions > Create document. 

3. Select Invoice and click OK. 

The Manual batch-tracked inventory specification dialog box is opened. 

4. If necessary, enter the manual batch-tracked inventory specifications and click OK. 

4. Click OK. 

5. The invoice is printed and the sales order is displayed again. Its status is now Invoice printed, 

or if you only invoiced part of the invoice quantity, P. inv. printed. 
 

Print invoice for consignment delivery from invoice 

To print an invoice for a consignment delivery from an invoice: 

1. Select Sales > Order processing > Invoices. 

2. Populate the fields on the New tab and select the Consignment delivery check box. 

3. Click Create and select the Invoice tab. 

4. Optional: Adjust the quantity in the Calculate field. 

5. Select Functions > Create document. 

6. Select Invoice and click OK. 

7. If necessary, enter the manual batch-tracked inventory specifications and click OK. 

The invoice is printed and the status is changed from Invoice to Invoice printed. 
 

Carry out partial RMA for consignment delivery 

You can return part of a consignment ASN as follows: 

1. Select Inventory > Sales issue to load the consignment ASN. 
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2. Then select posting ID 174 Return from consignment and the quantity for the line. 

When you post, the line and corresponding quantity are posted back to the sales order with the 

status Return and can be credited using Functions > Create document > Invoice. 

The returned item is then available in the warehouse. If it needs to be posted back to the 

consignment warehouse, a new order must be used. 
 

Transfer batch-tracked inventory to a customer consignment warehouse 

For a brief description of the preparatory steps and special requirements that apply to sales orders 

generated for deliveries to customer consignment warehouses, see Customer consignment 

warehouses (see "Customer consignment warehouse" page 1069). 

If an advance shipping notice for this type of sales order was printed without an issue, you need to 

manually transfer the batch-tracked inventory from the goods issue location to the customer's 

consignment warehouse. The following overview describes how you do this. 

Prerequisite: If an issue list (see "Issue lists (Goods issue)" page 1146) was generated when 

printing the advance shipping notice, you must release this list first. Otherwise, the batch-tracked 

inventory is not prepared. 

1. In the Goods issue folder in the Inventory module, click the Sales issue object to open the start 

form. 

2. Select the Open tab and use the fields and options available here to select the required sales 

order. Then click Load. 

3. Select Functions > Transfer to consignment warehouse to preset posting ID 173 Move to 

consignment in the PID field for all order lines. You can also enter this ID in the PID field 

directly. 

Please note: When transferring to consignment warehouses, you must post the full 

advance shipping notice quantity for each line. This means you cannot change the 

transaction quantity. 

4. To post the transaction, save your entries or select Functions > Post. 

From a posting point of view, the batch-tracked inventory is now at the customer's 

consignment warehouse. The issue is carried out when the invoice is printed (see "Print 

invoice for consignment delivery" page 1077). 
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Create subcontracted manufacturer consignment warehouses 

Subcontracted manufacturer consignment warehouses are warehouses located on the premises 

of your subcontracted manufacturers in which the material you provide (see "Materials provided" 

page 1119) is stored. 

To repost materials provided to the warehouse of a subcontracted manufacturer for subcontracted 

manufacturing, there must be at least one consignment inventory location entered in Infor COM for 

the subcontracted manufacturer in question. 

The Inventory flags tab includes the Issue from cons. only option, which is specially designed for 

material provided. If you select his option, the system will only issue materials provided from the 

subcontractor's consignment inventory locations. 

To create a consignment inventory location, complete the following steps: 

1. First create the required inventory area (see Enter inventory area (page 1086)) using the 

following properties: 

 Area type: S/C warehouse 

 Co. W/H tp.: Subcontracted manufacturing 

 Co. ID: Company ID of the subcontracted manufacturer 

2. Create an inventory location in the inventory area. For an overview of how to create an 

inventory location, click here (see "Create inventory location" page 1094). 

Note: When completing step 3 of this overview, make sure to select the inventory area that 

you just created. 
 

Enter manual batch-tracked inventory specification 

You can use manual batch-tracked inventory specifications to more accurately define and quantify 

specific batch-tracked inventory before carrying out inventory transactions or printing documents. 

You have the following options: 
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 Change the batch-tracked inventory properties, such as the expiration date, inspection flag, 

external serialized/batch IDs, etc. 

 Generate serialized or batch IDs (see Perform purchase receipt 

(ms-its:wms.chm::/10111.htm)) 

 Change inventory location coordinates 

 Specify the required number and dimensions (see Size and residual size management 

(Inventory) (see "Size and residual size management" page 437)). 

 Reload additional batch-tracked inventory (see Reload batch-tracked inventory (dialog box)). 

 Split batch-tracked inventory (see Split line function (Inventory) (see "Split line" page 1081)). 

 Preset batch-tracked inventory in order to generate dummy batch-tracked inventory (see 

Manually generate dummy inventory (page 1199)). 

To enter a manual specification, complete the following steps: 

1. Select the Manual check box in the relevant line. 

Note: In general, the posting ID must be entered before the check box can be selected. In 

many processes, the check box is selected automatically when you set the posting ID. 

2. Double-click the row to display the line view. 

Depending on the object, there are various special tabs and functions available in the line view 

for entering batch-tracked inventory specifications. 
 

Split line 

You can use the Purchase receipt, Inventory transactions, and Inventory adjustment objects to 

split receipts before carrying out a receipt posting. This type of split involves splitting a line into 

multiple lines. 

You may need to split a receipt for the following reasons: 

 If the posting quantity items have different properties (see "Item properties for splitting 

batch-tracked inventory" page 1048) and therefore need to be managed as separate 

batch-tracked inventory.  

 If the received quantity needs to be distributed to multiple inventory locations. 

 If serialized and/or batch IDs need to be assigned.  

To split a line: 

Select the Purchase receipt or Inventory transactions object. Load a purchase order or a 

production order for the receipt posting. In the Inventory adjustment object, load the item for which 

you want to enter new miscellaneous inventory. 

ms-its:wms.chm::/10111.htm
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1. In the Purchase receipt and Inventory transactions objects, set the posting ID in the PID field 

for the relevant line. 

 

In the Inventory adjustment object, select Functions > New inventory > Enter inventory. 

Then enter the quantity for the new inventory. 

Note: For a partial receipt posting, enter the required partial quantity in the Transaction or 

Trans. qty field. 

2. Make sure the Ma check box in the line is selected. 

3. Make sure the line is selected. In Purchase receipt, open the PO line view, or in Inventory 

transactions, open Order line view. In Inventory adjustment, you can remain in the current 

view. 

4. Select the Split line function. The Split line  dialog box is displayed. 

5. Enter the split quantity in the Split quantity field. 

When the dialog box is opened, this field displays the total quantity of the line. The total 

quantity is split into equal parts, each one equal to the split quantity, and distributed to the 

split lines. If there is a remainder, it is assigned to its own split line. 

If a quantity was specified in the Container quantity field on the Inventory flags tab in the 

master data for the relevant item, this quantity will be preset here. 

Special  note about serial ized i tems:  The default split quantity for serialized items is 

1 since separate batch-tracked inventory is always managed for each individual serialized 

item. The Generate serialized ID check box is also selected. If it remains selected, a 

serialized ID is generated automatically (using numbering method 590) for the split lines 

that are generated during the split. If the check box is cleared, you can also generate IDs 

manually or automatically after the split (see step 10). 

6. If the Size management or Residual size mgt property has been set for the item and you want 

to edit these values for the split lines, enter the required data in the Number for size mgt field 

and also the Length, Width, and Height fields. 

When the dialog box is opened, it displays the dimensions from the master data for the 

item. You can still edit these properties for each individual split line after the split is carried 

out (see step 10). 
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For information about these properties, see Size and residual size management 

(Inventory) (see "Size and residual size management" page 437). 

7. If the Batch ID property has been assigned to the item, the Generate batch IDs check box is 

selected automatically. If it remains selected, batch IDs are automatically generated for the 

split lines (using numbering method 592). If the check box is cleared, you can also generate 

the IDs manually or automatically after the split (see step 10). 

8. Click OK to close the dialog box and generate the split lines. 

9. You can now use the following tabs to edit the properties of each individual split line, provided 

the item is also assigned these properties: 

 The Receipt coordinates, Receipt properties, Receipt size management, and Receipt 

dimensions tabs in the Purchase receipt and Inventory transactions objects. 

 The Properties, Dimensions, Weight/volume, and Tool tabs in the Inventory adjustment 

object. 

10. Once you have entered all of the property data, return to the Purchase order view in the 

Purchase receipt object, and the Order view in the Inventory transactions object. You can 

remain in the same view in the Inventory adjustment object. 

11. To carry out the receipt posting, select the Post receipt or Post function. 
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To use Infor COM Inventory, you first need to create or add certain master data: 

Master data  

object 

Cat. Type of master data 

Companies Finance Enter your own company's address(es) (see Enter master data for own 

company). You must also enter a postal address as the address when 

creating a new inventory area. 

Enter the master data of customers and suppliers with whom you maintain a 

consignment warehouse or who maintain one with you. Enter the IDs of 

these companies in the consignment inventory areas. 

Item Design Update the Inventory and Inventory flags tabs in the item master data 

with the necessary data. 

Inventory area Inventory Enter the inventory areas. You cannot create an inventory location without 

specifying an inventory area first. 

Location classes Inventory Enter the location classes. Location classes define the physical properties 

of the weight load, dimensions, and volume of the inventory locations 

assigned to them. 

Items and location classes are assigned to each other in the Item/location 
class (page 1101) cross reference table. 

Work areas Inventory Enter the work areas. These are assigned inventory locations. 

Inventory locations Inventory Enter the inventory locations (manually or automatically). You cannot create 

an inventory location without specifying an inventory area first. The work 

area and location class are stored in the master data for the inventory 

location. 

Default settings Inventory Enter the default goods receipt location and goods issue location as well as 

the default work area for each user group and warehouse address. 

 

 

Master data (Inventory) 
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Inventory areas 

Call 

Inventory > Master data > Inventory areas 

Description 

You use this object to enter and maintain your inventory areas. 

An inventory area is a closed organizational unit within the warehouse. In warehouse 

management, it is the second hierarchical level after the warehouse address (page 1052). 

An inventory area belongs to a specific warehouse address, which is assigned in the master data 

for the inventory area. You can use inventory areas to control the functional distribution of material 

in the warehouse. You can define various types of inventory areas. Each inventory area is 

assigned its own access privileges for Sales, Purchasing, and Manufacturing (receipt, issue). 

Configuration 

COMMON.LAGER.MAXWIDTHSTORENO 

In practice 

For information on how to work with inventory areas, see the description provided for the Work 

areas (page 1089) object in the Master data module. 

You must assign an inventory area type to each inventory area that you create. 

The inventory area type allows you to define the future properties and usage of an inventory area 

within the warehouse. The system checks that the inventory area for the specified warehouse type 

is valid. Inventory area types are maintained in the WMSSTORET allocation table. 
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For inventory locations in consignment warehouses, you must enter the type of consignment 

warehouse in the Co. W/H tp. field in the master data for each corresponding inventory area.  In 

Infor COM, there are three different types of consignment warehouse: Supplier consignment 

warehouses, Customer consignment warehouses (see "Customer consignment warehouse" page 

1069), and Subcontracted manufacturing warehouses (see "Create subcontracted manufacturer 

consignment warehouses" page 1080). 

 
 

Enter inventory area 

For information on inventory areas, see Inventory areas (page 1085). 

1. Select Inventory > Master data > Inventory areas 

2. Select the New tab. 

3. Enter the description of the inventory area in the Inventory area field on the New tab. 

Note: It is best to restrict your entry to a maximum of three characters so that the 

inventory location coordinates (see "Inventory locations" page 1091) do not become too 

long. 

4. Click Create. 

5. Select the Properties tab. 

6. In the Area type field, enter the inventory area type of the inventory area. 

Note: To create default coordinates for a machine location in Work centers, the inventory area 

type must be Manufacturing. 

7. Select the Plannable check box if the goods in this inventory area can be used for planning. 

8. You define the access rights for the various processes in the Access rights section in the 

inventory area. 

9. For a consignment warehouse, enter the consignment warehouse type in the Co. W/H tp. field. 

You also need to select the ID of the relevant supplier, customer, or subcontracted 

manufacturer from the Co. ID field. The entries available for selection from the combo box 

depend on the area type that you selected. 
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10. Select the Address tab and then select the postal address of the inventory area from the 

Address ID field. 

11. Select Data >Save. 
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Location classes 

Call 

Inventory > Master data > Location classes 

Description 

This object is used for entering and maintaining location classes. 

A location class includes the dimension limits and weight limits for a group of inventory locations 

(page 1091). You can therefore use location classes to define different categories of inventory 

location. 

You can use the Item/location class (page 1101) cross reference table to assign items and 

location classes to each other. 

You can use location classes to determine the way in which items are received (in lots or on 

loading devices), the number of items at an inventory location or on a loading device, as well as 

the possible number of loading devices at an inventory location. 

The cross reference table is then evaluated to determine the priority, specified quantity, and 

suitability of the various inventory locations. 

A location class must be assigned to each inventory location whose storage type (see 

"WMSSTORAGET" page 1035) is Shelf. 

You cannot assign a location class to inventory locations whose storage type is Block. Block 

locations are an exception because they are not checked for weight and volume. 
 

Create and assign location class 

For general information on location classes, see Location classes (page 1088). 

This Help topic describes how to create a location class. 
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1. Select Inventory > Master data > Location classes. On the New tab, enter the location class 

names and click Create. 

The Properties tab is displayed. You use this tab to enter the data for the location class. 

2. In the Maximum weight field, enter the maximum weight permitted for this location class. 

3. Enter the maximum permitted dimensions for this location class in the Length, Width, and 

Height fields.  

Note: These values are used to calculate the content of the Volume field. 

4. Select Data >Save. 

5. Select Inventory > Cross reference tables > Item/location class. 

6. Select the Open tab, and in the Selection condition section, select the Location class option. 

7. In the Location class field, select the location class that you created and click Load. 

The Item/location class tab will now be available for editing. 

8. Enter the item ID, priority, and maximum quantity. 

Note:  If you have licensed the Packaging (page 1205) module, you can also enter the 

master packaging and maximum number of load units, if necessary. 

9. Select Data >Save. 
 

Work areas 

Call 

Inventory > Master data > Work areas 

Description 

In addition to inventory areas, work areas are organizational units (groups of inventory locations) 

that define the picking procedures to be applied to the resources in the warehouse (warehouse 

staff, fork lifts, etc.). A work area can be assigned to each inventory location 
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Work areas are used when opening pick lists and when setting up transportation containers for 

goods receipt. They also play an important role in path optimization (page 1042). However, the 

main task of the work area is to regulate feedback behavior in the case of receipts, issues, and 

transfers. 

The following properties are defined in a work area: 

 Warehouse affiliation by specifying the relevant warehouse address. 

 Priorities for receipts, transfers, and issues. 

 Whether left/right picking (page 1044) is possible. 
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Inventory locations 

Call 

Inventory > Master data > Inventory locations 

Description 

This object is used for creating and maintaining inventory locations. 

In Infor COM Inventory, an inventory location is the smallest, physical, localizable, and uniquely 

identifiable unit of area or unit of volume used for storing goods in an inventory area. 

In Infor COM, a distinction is made between actual inventory locations (fixed locations (page 

1093), pick locations, and reserve locations), and virtual inventory locations known as system 

locations. Examples of system locations include I-point locations (see "I point" page 1135), buffer 

locations, and machine locations. 

A machine location could be an area around a machine in which consumables or manufactured 

goods are stored until they are processed or transported. 

Each work center group should be assigned to a machine location on the Default coordinates tab. 

The assignment is evaluated when the work center is set up with goods, i.e. when the goods are 

transferred from the inventory location to the machine location. 

An inventory location is an actual, physical inventory location. 

A system location generally exists in the system only. However, the system location can have a 

corresponding physical location in the actual warehouse too. For example, physical goods receipt 

locations (GR locations), goods issue locations (GI locations), and machine locations are all 

managed as system locations. 

The type of inventory area is also important for system locations: 

 The inventory area type of a goods receipt location must be Goods receipt 

 The inventory area type of a goods issue location must be Goods issue 

 The inventory area type of a machine location must be Manufacturing 

 The storage type of an inventory location whose location type is System can only be Block 

Inventory locations differ from system locations in two ways: 
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 Location type (see "WMSSTOCKT" page 1034): The location type (see "WMSSTOCKT" page 

1034) of an inventory location can be Pick, Reserve, or Fixed. The storage type (see 

"WMSSTORAGET" page 1035) of a location type can be Block or Shelf. 

 A location class must be assigned to each inventory location whose storage type (see 

"WMSSTORAGET" page 1035) is Shelf. 
 Coordinates: Each inventory location is identified by its inventory location ID. The inventory 

location ID consists of five coordinate components – Warehouse address/Inventory 
area/X/Y/Z. The warehouse address can be found in the Address ID field. 

 

Example: 

Inventory Coordinate value assignment 

Fixed locations, pick 

locations, and reserve 

locations 

Area/X/Y/Z <> 0 

I-point locations, buffer 

locations, and machine 

locations 

Area/X <> 0 

Y/Z = 0 

 

The physical properties of an inventory location are defined in the location class (see 

"Location classes" page 1088) that was assigned to it. 

Exception:  There are no location classes assigned to system locations. 

Configuration 

COMMON.WMS.COORDINATESEPARATOR 

COMMON.WMS.LOCATIONCOORDINATEDEFAULTLENGTH 

COMMON.WMS.USERESERVELOCATIONS 

COMMON.WMS.SYSTEMLOCATIONCOORDINATEMASK 

Functions 

The coordinates Y=00 and Z=00 are exclusively used to create  system locations (see "Inventory 

locations" page 1091). System locations include all goods issue locations, goods receipt locations, 

and machine locations, for example. 
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Infor COM Inventory supports the optimization of path sequences (see "Path optimization" page 

1042) for receipts and issues. This involves sorting the inventory locations by their X, Y, Z 

coordinates. If the X-coordinate does not contain a numeric value, the inventory locations cannot 

be sorted. In this case, you can define a (numeric) substitute value for the X-coordinate in the 

Access sequence field in the form header of the master data for the inventory location. 
 

Fixed locations 

Note: Inventory location types are stored in the WMSSTOCKT allocation table. 

The same item is always stored at a fixed location at any one time. An inventory location can 

become a fixed location in one of two ways: 

 Manual  method: In the corresponding master data (Inventory location > Master data > 

Inventory locations), select Manual fixed location as the fixed location type in the Fixed 

location field on the Inventory location tab. In the Item IDfield, enter the ID of the item to be 

created. The inventory location remains a fixed location until you manually delete the Manual 
fixed location flag. If the fixed location becomes full, the receipt strategy for the item creates 

additional Dynamic fixed locations (see below). 

 Automatic method:  An inventory location automatically becomes a fixed location when an 

item with the Same-item storage at location is stored there. The Dynamic fixed location 

location type is then automatically entered in the Fixed location field, and the ID of the item is 

automatically entered in the Item ID field. Once no inventory is available at the fixed location, it 

becomes a normal inventory location. The Dynamic fixed location ID and item ID are deleted 

from the fields. 

 

Note:  The Item ID also displays the ID of an item if it is not assigned the Same-item storage at 

location property but is the only item at the inventory location. Once another item is posted to 

the inventory location, the item ID is deleted. 

The remaining two Minimum quantity and Replenishment quantity fields on the Fixed location form 

section are activated if you entered the Manual fixed location type in the Fixed location field. Both 

fields are evaluated by the receipt strategy in Goods receipt and when receipts are carried out 

from Manufacturing: 

Enter the trigger quantity in the Minimum quantity field. If the quantity falls below this trigger 

quantity, a replenishment transfer is initiated. 

In the Replenishment quantity field, enter the quantity to be transferred for this replenishment, i.e. 

the quantity to be added to the fixed location. 
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Notes: 

 You cannot maintain the minimum quantity and replenishment quantity for dynamic fixed 

locations. 

 An inventory location whose type is system location cannot be defined as a fixed location. 

 To assign the Same item storage at location property to an item, select the Same item storage 

at location check box on the Inventory flags tab in the master data for the item. 

 The fixed location types are managed in the WMSFIXLOCT allocation table. 
 

Create inventory location 

For information on which requirements need to be met in order to create an inventory location, see 

Inventory locations (page 1091). 

1. In the Inventory module, open the Master data folder and select Inventory locations. 

2. In the Inventory area field on the New  tab, enter the inventory area. 

In the X coordinate, Y coordinate, and Z coordinate fields, enter the X, Y, and Z 

coordinates according to the Warehouse address/Inventory area/X/Y/Z template. 

Example inventory location:  1350/SI/12/18/03 

Example system locations:  GI/01/00/00, GR/01/00/00, MA/01/00/00 

3. Click Create. 

4. Specify the location type. The location type plays an important role for the inventory strategy 

(see "Inventory strategies" page 1040). 

The location type entered for inventory locations is generally Pick. 

Note: Machine locations required for Manufacturing must be assigned the location type 

System and the  storage type Block. 

5. Enter the storage type on the Inventory location tab (see WMSSTORAGET (page 1035)). 

6. Select Data >Save. 
 

Delete inventory locations 

To delete an inventory location, you must delete the references first. 

1. Select Inventory > Inventory locations. On the Open tab, enter the data of the inventory 

location to be deleted and click Load. 



Infor COM 7.5 User Guide | 1095 

 

Inventory 

 

2. Select Data >Delete. 

3. For inventory locations without references, click Yes to confirm that you want to delete the 

inventory location.  

For inventory locations with references, the Delete inventory location references dialog box is 

displayed. Using this dialog box, the references to the inventory location (source location) that 

you want to delete can be transferred to a different inventory location (target location), and the 

source location can then be deleted. 
 

Automatically generate inventory location(s) 

You can have inventory locations (page 1091) generated for an inventory area automatically. The 

required number of new inventory locations is generated from a template location, and all 

properties of the template location are inherited by the new inventory locations. 

A specific process then creates the X, Y, Z components of the IDs for new inventory locations 

based on the start values, final values, increments, and templates that you enter on a dialog box. 

You create template locations in the same way as you would any other inventory location. Create 

the template location first if this has not been done already (see Manually generate inventory 

locations (see "Create inventory location" page 1094)). 

Once you have created the template location, complete the following steps: 

1. Select Inventory > Master data > Inventory locations 

2. On the Open tab, select the inventory location that you want to use as the template location 

and click Load. 

3. Select Functions > Automatic generation of inventory location(s). 

4. Select the start value and final value for the required coordinates. For more information, see 

the context-sensitive Help. 

5. Use the Increment field to define the increment. See also the context-sensitive Help. 

These examples (see "Automatically generate inventory location(s) – Examples" page 

1096) show how to enter the start value, final value, and increment. 
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6. Start the automatic generation of inventory locations by clicking OK on the dialog box. A 

message appears confirming that the inventory location has been generated. It also displays 

the total number of locations created. 

7. Click OK to confirm the message and automatically display the Item overview. The inventory 

locations that have just been generated are highlighted in the overview. You can change the 

properties of the individual inventory locations if necessary. 
 

Automatically generate inventory location(s) – Examples 

The following examples illustrate the automatic generation of inventory location(s). For simplicity, 

the examples use the start value and final value of the X-coordinate only. An inventory location 

with an X-coordinate of 01 is used as the template for these examples. 

Example 1 

 Start value Final 

value 

Increment Templat

e 

X-C  C1 C5 11 A9 

Result: C1, C2, C3, C4, C5 

Example 2 

 Start value Final 

value 

Increment Templat

e 

X-C  C3 E5 11 A9 

Result: C3 ... C9, D0 ... D9, E0 ... E5 

Example 3 

 Start value Final 

value 

Increment Templat

e 

X-C  5B 5E 11 9A 

Result: 5B, 5C, 5D, 5E 

Example 4 
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 Start value Final 

value 

Increment Templat

e 

X-C  F1F F3F 111 A9A 

Result: F1F, F1G ... F1Z, F2A, F2B ... F2Z, F3A, F3B ... F3F 

Example 5 

 Start value Final 

value 

Increment Templat

e 

X-C  3D5 3G5 111 9A9 

Result: 3D5, 3D6 ... 3D9, 3E0, 3E1 ... 3E9, 3F0, 3F1 ... 3F9, 3G0, 3G1 ... 3G5 

Example 6 

 Start value Final 

value 

Increment Templat

e 

X-C  14 1D 11 9# 

Result: 14, 15 ... 19, 1A, 1B ... 1D 

Example 7 

 Start 

value 

Final 

value 

Increment Templat

e 

X-C  2C AC 11 #A 

Result: 2C, 2D ... 2Z, 3A, 3B ... 3Z, ... , 9A, 9B ... 9Z, AA, AB, AC 

Example 8 

 Start 

value 

Final 

value 

Increment Templat

e 

X-C  2A2 2CC 111 9A# 

Result: 2A2, 2A3 ... 2A9, 2AA, 2AB ... 2AZ, 2B0, 2B1 ... 2B9, 2BA, 2BB ... 2BZ, 2C0, 2C1 

... 2C9, 2CA, 2CB, 2CC 

Example 9 
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 Start 

value 

Final 

value 

Increment Templat

e 

X-C  01 20 11 99 

Result: 01 ... 20 

Example 10 

 Start 

value 

Final 

value 

Increment Templat

e 

X-C  A0B A1A 111 A9A 

Result: A0B, A0C ... A0Z, A1A 

Example 11 

 Start 

value 

Final 

value 

Increment Templat

e 

X-C  12 66 22 99 

Result: 12, 14, 16, 18, 30, 32, 34, 36, 38, 50, 52, 54, 56, 58 

Example 12 

 Start 

value 

Final 

value 

Increment Template 

X-C A10 G90 33 A99 

Result: 

A10, A11 ...  A19, A40, A41 ...  A49, A70, A71 ...  A79, 

D00, D01 ...  D09, D30, D31 ...  D39, D60, D61 ... D69, 

D90, D91 ... D99, G20, G21 ... G29, G50, G51 ... G59, 

G80, G81 ... G89,  

Note:  As the third position of the start value 0 (zero) does not have to be incremented to 

the 0 in the final value, you do not have to define a separate position for it in the increment. 

The system automatically sets the increment value to 1. 

Example 13 
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 Start value Final 

value 

Increment Template 

X-C  A22 G88 345 A99 

Result: A22, A27, A62, A67, D02, D07, D42, D47, D82, D87, G22, G27, G62, G67 

Note:  If the second position (2) of the start value did not have an increment of 5, the 

system would automatically set a value of 1 for the missing increment value. In this case, 

the third position (2) of the start value would be incremented to the third position of the final 

value (8) for each process. 

Example 14 

 Start value Final 

value 

Increment Template 

X-C  A0B A1B 112 A9A 

Result: A0B, A0D, A0F, A0H ... A0Z, A1B 
 

Default settings 

Call 

Inventory > Master data > Default settings 

Description 

You can use the Default settings object to determine the default settings that will be used for the 

warehouse address (page 1052), goods receipt location, goods issue location as well as a work 

area for each user group. 

When you make this kind of assignment, the warehouse address (address ID and target address 

ID), goods receipt location, goods issue location, and work area are entered automatically as soon 

as a member of the user group starts a corresponding process. However, the default data can be 

modified at any time during a process. 
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Configuration 

If you do not set a default warehouse address, the system will use the warehouse address set by 

the COMMON.WMS.DEFAULTSTOREADDRESSNO parameter in the configuration. You 

therefore need to check this default warehouse address and adjust it if necessary. However, we 

still recommend that you use the Default settings object to define the default data for each user 

group. 
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In Infor COM, cross reference tables are used for creating assignments and mapping a company's 

dynamic warehouse structure in the system.  

You can use cross reference tables to define the data for inventory strategies (page 1040) and 

plausibility checks. For example, the receipt strategy uses cross reference tables to control 

storage-optimized receipts. 

The receipt strategy (page 1040) plays an additional role in the generation of batch-tracked 

inventory in the context of location searches. An optimized target location is proposed during 

processing. 

 
 

Item/location class 

Call 

Inventory > Cross reference tables > Item/location class 

Description 

In this cross reference table, the items are assigned for storage to the location classes (page 

1088) entered in the master data in accordance with their physical properties. 

The assignments are evaluated by the receipt strategy (page 1040) when determining suitable 

inventory locations and by the Replenishment control (page 1132) function. 

This table also specifies the priority in which an inventory location of this location class is to be 

taken into account by the receipt strategy. It also defines the maximum quantity that can be 

transferred to an inventory location of this location class. 

In practice 

Create and assign location class (page 1088) 

Cross reference tables 
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Maintain assignments in Item/location class cross reference table 

For more information, see the Help topics on Location classes (page 1088) and the Item/location 

classes (see "Item/location class" page 1101) cross reference table. 

1. Select Inventory > Cross reference tables > Item/location class.  

2. Select the Open tab. 

3. On the Open tab, select the direction of the assignment in the Selection condition section. 

Select the Item option if you want to assign a location class to an item, or the Location class 

option if you want to assign an item to a location class. 

4. Select the item ID or location class from the corresponding fields and click Load. 

5. In the next empty row in the table, select the item ID or location class  from the combo boxes 

in the corresponding fields. 

6. Enter a value in the Prio. and Max. quantity fields. 

Note: After you enter the maximum quantity, the resulting weight and volume are 

compared against the capacity of the selected location class. If this capacity is exceeded, 

a message is displayed. You can either continue regardless, or you can modify the 

maximum quantity until it corresponds with the capacity. 

7. Select Data >Save. 
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The Goods receipt object in this folder is used for processing goods receipts and materials 

provided for subcontracted manufacturing. 

 

Goods receipt 
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Purchase receipt 

Call 

Inventory > Goods receipt > Purchase receipt 

Description 

Apart from making purchase receipt postings on the basis of purchase orders, you can also use 

the Purchase receipt object to make inventory receipt postings for delivery advices and order 

releases as well as shipping materials. For more information, click the relevant Help topic. 

The Purchase receipt object is used for posting the goods delivered by suppliers and 

manufacturers (see  Subcontracted manufacturing) to the warehouse, or if necessary, to the 

Purchasing inspection warehouse (Purchasing inspection). The purchase orders from Purchasing 

are used as the basis for this process. 

Note: You can access the Purchase receipt object from a purchase order directly. To do this, 

select the Inventory transaction function and then select the Purchase receipt option on the dialog 

box that is displayed. 

In practice 

Post goods receipts to supplier consignment warehouses (page 1142) 

 
 

Perform purchase receipt 

The following overview describes how to make a purchase receipt posting (see "Purchase receipt" 

page 1104). 

1. You can access the Purchase receipt object in two ways: 

 From the purchase order, select Functions > Inventory transaction. On the Inventory 

transaction dialog box that is displayed, select the Purchase receipt option. 
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 To open the purchase order, select Inventory > Goods receipt > Purchase receipt and 

select the purchase order on the  Open tab.Select the required posting ID from the PID 

field.  

Note: When you go from a purchase order directly to the purchase receipt, posting ID 151 

Full inventory receipt is set by default. Other purchase receipt posting IDs are 152, 153, 

and 154. For more information, see Inventory posting IDs (page 1053). 

2. If necessary, enter the required transaction quantity in the Transaction field on the Transaction 

tab. If you accessed Purchase receipt from the purchase order directly, the remaining quantity 

will be set by default. 

The Quantities tab provides detailed information about previously posted quantities and 

currently outstanding quantities. 

Postings for outline agreements: When making postings for outline agreements, you can 

use the 

COMMON.EINKAUF.OUTLINEAGREEMENTREFUSEENHANCEPERSTOREBOOKING 

parameter to specify whether the posting of an overdelivery should increase the total 

outline agreement quantity. If the total outline agreement quantity is not to be increased, 

this is indicated in a corresponding message. 

3. If necessary, you can change the default inventory location for the receipt on the Coordinates 

tab. 

4. You can also enter a manual batch-tracked inventory specification (see "Enter manual 

batch-tracked inventory specification" page 1080). This specification will override the receipt 

strategy. 

Example: Assigning serialized/batch IDs 

1. On the Transaction tab, select the Manual specification check box for the required line. 

2. Double-click the row header for the line. 

3. Select the Properties tab from the lower set of tabs. 

4. Enter the required serialized/batch ID for each line. 

Note: Follow the same procedure as for splitting a receipt (see "Split line" page 1081). 

5. Select Functions > Post receipt. 

6. Make the required entries on the Inventory receipt dialog box. 

7. Click OK. 
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Note: If you posted a full or partial receipt in Purchasing inspection, you can now process 

the relevant batch-tracked inventory here. For more information, see Edit inspection status 

in Inspection (page 1193). 
 

Perform subcontracted manufacturing purchase receipt 

The following overview describes how to post the receipt of subcontracted manufactured 

resources in the Purchase receipt object (Goods receipt folder). 

Notes: 

 For more information, see Subcontracted manufacturing. 

 When you post the receipt of subcontracted manufactured resources, as described here, any 

materials provided for the subcontractor are automatically issued at this point also, if this has 

not been done already. For more information, see Issue/repost materials provided for 

subcontracted manufacturing (page 1120). 

1. You can access the Purchase receipt object in two ways: 

 From the purchase order, select Functions > Inventory transaction. On the Inventory 

transaction dialog box that is displayed, select the Purchase receipt option. 

 To open the purchase order, select Inventory > Goods receipt > Purchase receipt and 

select the purchase order on the  Open tab.  

2. Select the required posting ID from the combo box in the PID field in the line for the 

subcontracted manufactured resource (HR record). 

 142: Cancels postings made using posting IDs 143 and 144. 

 143: Posts the full quantity to Purchasing inspection. 

 144: Posts a partial quantity to Purchasing inspection. 

 146: Posts a partial quantity to the warehouse. 

 147: Posts the full quantity to the warehouse. If you access Purchase receipt from the 

purchase order, this posting ID is set automatically. 

 149: Cancels postings made using posting IDs 146  and 147. 

3. If necessary, adjust the transaction quantity entered in the Transaction field. 

Notes: When you go from the purchase order to Purchase receipt directly, the full 

remaining quantity is set by default. The Planned, A insp, and A. inv. fields provide 

information on outstanding quantities and quantities that have already been posted. 

4. If necessary, you can change the default inventory location for the receipt on the Coordinates 

tab. 
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5. You can also enter a manual batch-tracked inventory specification (see "Enter manual 

batch-tracked inventory specification" page 1080). This specification will override the receipt 

strategy. 

Example: Assigning serialized/batch IDs 

1. On the Transaction tab, select the Manual specification check box for the required line. 

2. Double-click the row header for the line. 

3. Select the Properties tab from the lower set of tabs. 

4. Enter the required serialized/batch ID for each line. 

Note: Follow the same procedure as for splitting a receipt (see "Split line" page 1081). 

6. Select Functions > Post receipt. 

7. Make the required entries on the Inventory receipt dialog box. 

8. Click OK. 

Note: If you posted a full or partial receipt in Purchasing inspection, you can now process the 

relevant batch-tracked inventory here. For more information, see Edit inspection status in 

Inspection (page 1193). 
 

Perform purchase receipt for batch items 

The following Help topic describes how to perform a purchase receipt for batch items. 

1. Select Purchasing > Purchase orders > New. Enter the supplier ID of the required supplier and 

click Create. 

2. On the Quantities tab, enter the item ID of the batch item (see "Serialized/batch management" 

page 1066) in the Item field, and the required purchase order quantity in the Purchase order 

field. 

Example: 30 units 

3. Select Functions > Create document and click OK on the following dialog box. 

4. Select Inventory > Goods receipt > Purchase receipt and enter the purchase order ID of the 

purchase order that you just created on the Open purchase order tab. Then click Load. 
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5. On the Transaction tab, select posting ID  152 (Partial inventory receipt) and enter a partial 

quantity in the Transaction field. 

Example: 10 units 

6. Select View > PO line. Then select the Manual specification check box on the form header. 

The line is displayed on the Quantities tab with the transaction quantity. 

7. Reduce the transaction quantity for the line on the Quantities tab, and enter a second line for 

the quantity that was reduced in the first line. 

Example: Change the quantity in the first line from 10 units to 5 units. Then enter 5 in the 

Quantities field in the second line. 

8. Select the Properties tab, and enter a batch ID for each line. 

9. Select Functions > Post receipt. On the dialog box that is displayed, enter the external supplier 

ID and click OK. 

10. Select Inventory > Information > Inventory information. Enter the item ID on the Open tab and 

click Load. 

The Inventory information object contains information about the receipt. 

Note: All information relating to the postings processes is listed in the Inventory journal (page 

1184). 
 

Repairs receipt 

For more information, see Repairs receipt. 
 

Purchasing inspection 

Call 

Inventory > Goods receipt > Purchasing inspection 

Description 

This object is used for carrying out the inspection of batch-tracked inventory in Purchasing. 
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You can use the Purchasing inspection object to process goods that were posted in Purchase 

receipt using posting IDs 153 Full inspection receipt, 154 Partial inspection receipt, and 169 

Unplanned inspection receipt. The inspection status of this type of batch-tracked inventory is 

Order not inspected. 

Depending on the result of the inspection, you can then use the Purchasing inspection object to 

post the relevant batch-tracked inventory to either the quarantine warehouse using posting ID 150 

Insp. to quarantine W/H receipt, using posting ID 156 Inspection to warehouse receipt. You can 

cancel these postings again using posting ID 155 Cancel insp. to W/H receipt. Batch-tracked 

inventory posted to the quarantine warehouse is assigned the inspection status Order 

quarantined. Batch-tracked inventory posted from Purchasing inspection to the warehouse is 

assigned the inspection status Order inspected. 

When you post batch-tracked inventory in Purchasing inspection, you can process it in the 

Inspection (page 1191) object also. 

Configuration 

The inspection statuses are stored in the WMSQAST (page 1026) allocation table. 

In practice 

Inspection ID (page 1038) 

Edit inspection status in Inspection (page 1193) 

 
 

Perform inspection in Purchasing 

To perform an inspection in Purchasing: 

1. Select Purchasing > Purchase orders > New. Enter the supplier ID of the required supplier and 

click Create. 
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2. On the Quantities tab, enter the item ID of the serialized item (see "Serialized/batch 

management" page 1066) in the Item field, and the required purchase order quantity in the 

Purchase order field. 

Example: 12 units 

3. Select Functions > Create document and click OK on the following dialog box. 

4. Select Functions > Inventory transaction and click OK to confirm the following dialog box. 

5. On the Transaction tab, enter 153 - Full inspection receipt in the Posting ID field and then 

select  Functions > Post receipt. 

6. Enter the external advance shipping notice ID on the following dialog box, and click OK. 

7. Select Inventory > Goods receipt > Purchasing inspection. In the Order ID field, enter the ID of 

the above purchase order and then click Load. 

Since the ordered item is a serialized item, each ordered part is displayed as a separate line. 

Example: In our example, there are 12 lines displayed. 

8. On the Inspection tab, enter posting ID 156 - Inspection to warehouse receipt for the lines that 

are to be posted to the regular warehouse, and posting ID 150 - Insp. to quarantine W/H 

receipt for lines that are to be posted to the quarantine warehouse. 

Example: In our example, lines 1 to 8 are posted to the warehouse, and lines 9 to 12 are 

posted to the quarantine warehouse. 

Note: Select all of the lines that are to be posted, and then select Functions > Set posting ID > 

Inspection to warehouse receipt (or Insp. to quarantine W/H receipt). 

9. Select Functions > Post. 

10. Select Inventory > Information > Inventory information. In the Item ID field, enter the ID of the 

item that you just posted and click Load. 

11. Select the Status tab. 

After the assignment, the batch-tracked inventory now has the status Order inspected or Order 

quarantined. 

12. Select Inventory > Goods receipt > RMAs/cancellations. Enter the purchase order ID and click 

Load. 

13. Select View > PO line to select the batch-tracked inventory that is to be returned. 

14. Select posting ID (see "Inventory posting IDs" page 1053) 166 - Inspection RMA. 

15. Select the Manual specification check box. 
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16. Select the BT-inv. tab from the upper set of tabs, and the Quantities tab from the lower set of 

tabs. 

17. In the Specified quantity field on the Quantities tab, enter the quantity of the batch-tracked 

inventory that is to be returned. 

18. Select Functions > Post. Then click OK to confirm the following RMA dialog box. 
 

Receipt lists (Goods receipt) 

Call 

Inventory > Goods receipt > Receipt lists 

Description 

Receipt lists are used to optimize the receipt process between Goods receipt and the warehouse. 

You can use the Receipt lists object to carry out the following tasks: 

 Manually generate receipt lists 

 Manually print and release receipt lists that were generated manually or automatically 

Note that when you delete a report, only the report is deleted. The movement status of the items in 

the report is retained. 

Configuration 

You can manage the default settings for these options using the movement list configuration (see 

"Movement lists" page 1049). 

Functions 

You can decide if and how receipt lists should be generated for inventory movements that occur as 

a result of purchase receipt postings. To do this, select the corresponding options on the Inventory 

receipt dialog box. This dialog box opens when you select the Post function in the Purchase 

receipt object. 
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In practice 

Manually generate movement lists (page 1050) 

Open, print, and release movement list (page 1051) 
 

Receipt list feedback (Goods receipt) 

Call 

Inventory > Goods receipt > Receipt list feedback 

Task 

The Transfer list feedback, Receipt list feedback, and Issue list feedback objects allow goods 

issues and goods receipts to be treated differently from the internal warehouse movements, i.e. 

issues and receipts. This means that you can make manual adjustments for each individual 

movement if the current values differ from the planned values. Exceptions can be handled easily 

and you can also maintain the remaining quantity (inspection quarantine, specification of 

remaining quantities). 

We recommend this procedure for items with item properties for splitting batch-tracked inventory 

(page 1048). 

You define whether or not feedback is permitted in the master data for the work area (see "Work 

areas" page 1089) (Properties) tab. 

Please note: If the check boxes on this tab are not selected, or if the work area is not assigned 

to the inventory location, no feedback is possible since the relevant lists are automatically 

acknowledged during release and their status is set to Confirmed. 

Note that the Issue list feedback function accessed by selecting Inventory > Goods issue > Issue 

list feedback is intended for sales orders, and the Issue list feedback function accessed by 

selecting Inventory > Manufacturing > Issue list feedback is intended for production orders. 

To access the Feedback for receipt lists function, you must select Inventory > Manufacturing > 

Receipt list feedback or Inventory > Goods receipt > Receipt list feedback. 
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Cancel inv. transactions 

Call 

Inventory > Goods receipt > Cancel inv. transactions 

Description 

You can use the Cancel inv. transactions object to view a list of selected receipt processes and 

delete these if necessary. 

Examples: Full/partial warehouse receipts, Full/partial inspection receipts. 

Please note: It is not possible to enter manual specifications here for the batch-tracked 

inventory to be canceled. You can only specify the quantity. 

For cancellation postings in the Cancel inv. receipt object, the system automatically uses  posting 

ID (see "Inventory posting IDs" page 1053) 137, 140, or 141, depending on the original receipt 

posting type. 

Note:  The same posting IDs are also used to cancel postings in the  RMAs/cancellations (page 

1115) object. 

In practice 

You use this object if you entered an invalid posting and now need to cancel it, or if the properties 

of the items are identical and you just  want to cancel a partial quantity. In all other cases, you use 

the RMAs\Cancellations object. 

You can also cancel the inventory transaction from the purchase order. To do this, select Inventory 

transaction from the Function menu, and then select the Cancel inv. transaction option on the 

Inventory transaction dialog box that is displayed. 
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Cancel inventory transaction 

The following overview describes how to cancel one or more receipt postings for a purchase order 

in the Cancel inv. transaction object (Goods receipt folder). 

For general information about canceling inventory transactions and an explanation of the posting 

IDs that are used automatically by the system during this process, see the Help topic on the 

Cancel inv. transaction (see "Cancel inv. transactions" page 1113) object. 

1. There are two ways of loading a purchase order in the Cancel inv. transaction object: 

 If the purchase order is already open in the Purchase orders object in Purchasing, select 

Functions > Inventory transaction. On the dialog box that is displayed, select the Cancel 

option and click OK to confirm. The Cancel inv. transaction form is displayed. You can 

then continue from step 2. 

 If the purchase order is not loaded, you can load it in the Cancel inv. transaction object 

directly. To do this, open the Goods receipt folder and click Cancel inv. transaction. The 

start form is displayed. Select the Open tab. In the PO ID field, enter the purchase order ID 

or select it from the combo box. Click Load to display the Cancel inv. transaction form with 

the purchase order you specified. 

2. Select the Transaction tab. All receipt postings made to date for the purchase order are listed 

here. 

3. Next, specify which receipt postings and quantities you want to cancel. You do not need to set 

any posting ID. The system recognizes which ID it needs to use for the cancellation by the 

original receipt posting type. 

 If you want to cancel all of the listed receipt postings with their full transaction quantities, 

simply follow the instructions under step 4 only. 

 If you just want to cancel a partial quantity of a posting, replace the cancellation quantity 

for this posting with the required quantity. 

 If you do not want to cancel a receipt posting, set the cancellation quantity for this posting 

to 0.00 UOM. 

4. Select Functions > Post cancellation. 
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RMAs/cancellations 

Call 

Inventory > Goods receipt > RMAs/cancellations 

Description 

You use this object to cancel the purchase receipt postings made in the Purchase receipt and 

Supplier consignment objects (because of a posting error, for example), and post returned 

material assignments to the supplier. 

Note: You use this object if you need to specify which of the received items should be cancelled, 

or if you want to process returned material assignments. For straightforward cancellations, you 

use the Cancel inv. transactions (page 1113) object. 

Each line displayed in the RMAs/cancellations object represents a purchase order line. The 

quantities that have already been posted and the quantities that are available for posting are 

displayed. Apart from cancellations, you have the option of posting returned material assignments 

by entering the corresponding posting ID. You can also enter manual item specifications here. 

Manual specifications are important in cases where individual inventories have the same property 

types (for example, batch IDs or serialized IDs), and you need to specify exactly which items are to 

be returned.  

Returns 

When goods are returned to a supplier, the batch-tracked inventory that was initially received 

using purchase receipt postings is issued again using issue postings and returned via a goods 

issue location. Such goods may be returned because of defects, for example. The issue postings 

are independent of the purchase receipt postings that were originally used to receive the goods. 

The following posting IDs are available for RMA postings: 138, 139, 164, 165, 166, and 167. 
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Replacement deliveries for outline agreements: A replacement delivery will not change the 

remaining quantity in an outline agreement. The remaining quantity is not reduced or increased 

unless the replacement delivery is overdelivered or underdelivered. 

If there is no replacement required, the outstanding quantity remains unchanged since there is no 

requirement generated. The inspection quantity or received quantity is reduced by the returned 

quantity. The status of the underlying purchase order remains unchanged. 

RMAs without requirements for outline agreements: These increase the remaining quantity in an 

outline agreement. 

Cancellations: When a cancellation is made, a posting is canceled by means of a reverse posting. 

The following posting IDs are available for cancellation postings in the RMAs/cancellations object:  

137, 140, 141, 142, and 149. 

Cancellations for outline agreements: Each cancellation of an overdelivery increases the 

remaining quantity in the outline agreement accordingly. 

Functions 

You can access this function from the purchase order by selecting Functions > Inventory 

transaction, followed by the RMAs/cancellations option. 

In practice 

You can return quantities located in Purchasing inspection (page 1108), a supplier consignment 

warehouse, or a standard warehouse. You can choose between RMAs with or without 

requirements. If you require a replacement for the returned quantity, a requirement is generated. 

In this case, the outstanding quantity in the relevant purchase order lines is increased by the RMA 

quantity. 

Purchasing inspection: If quantities are returned from Purchasing inspection, the inspection 

quantity is reduced by the RMA quantity. 

Supplier consignment warehouse/standard warehouse: If quantities are returned from a supplier 

consignment warehouse or from the standard warehouse, the receipt quantity is reduced. If the 

status of the relevant purchase order was Receipt, it is reset to Partial receipt. 

Note: For information on the fields mentioned here, see Quantities. 
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Post RMAs to supplier 

The following overview describes how to post returns to a supplier using the RMAs/cancellations 

(page 1115) object. To post an RMA, the status of the purchase order must be at least Partial 

receipt. 

1. To access the RMAs/cancellations object, complete the following steps: 

 If the purchase order is already loaded in the Purchase orders object in the Purchasing 

module, select Functions > Inventory transaction. On the dialog box that is displayed, 

select the RMA option and click OK to confirm. The RMAs/cancellations dialog box is 

displayed. Continue from step 2. 

 If the purchase order is not loaded, you can load it directly in the RMAs/cancellations 

object. In the Goods receipt folder, click RMAs/cancellations to open the start form. In the 

PO ID field, enter the ID of the purchase order or select it from the combo box in the field. 

Click Load to display the RMAs/cancellations dialog box. 

2. Select the Transaction tab. 

3. Enter the appropriate posting ID in the PID field for the relevant line. 

4. As soon as you exit the PID field after entering the posting ID, the system calculates the 

quantity that can be posted and enters it in the Transaction and Pstbl Q fields. 

For more information on how the postable quantity is calculated, see the explanation 

provided for the Pstbl Q field in the Help topic on the Transaction tab.  

5. If you do not want to post the full quantity for a return, modify the quantity in the Transaction 

field. 

6. Make sure the correct goods issue location is entered on the Issue coordinates tab. 

7. Select Functions > Post. 

8. If you want to print a return advance shipping notice as an accompanying document, select the 

Return ASN option. To view the debit memo, select the Debit memo option. 

Effects: All returned items are available for selection in the Debit memo object. 

You can choose from the following options: 

 You can debit these items and/or enter additional costs in order to debit the return costs. 

The system debits all lines for which the Active flag is set. 

 You can finalize the debit by selecting the Approve debit memo function. 

9. For all other lines in the purchase order, complete the same process from step 3. 
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Perform cancellations using RMAs/cancellations 

The following overview describes how to cancel goods receipts in the RMAs/cancellations object 

(Goods receipt folder). 

For general information about performing cancellations using the RMAs/cancellations object and 

an explanation of the various IDs used in this process, see RMAs/cancellations (page 1115). 

1. In the Goods receipt folder, click RMAs/cancellations to open the start form. 

Note:  You cannot access the RMAs/cancellations object from a loaded purchase order. 

2. On the Open tab, enter the ID of the purchase order in the PO ID field or select it from the 

combo box in the field. 

3. Click Load to open the RMAs/cancellations form. 

4. Select the Transaction tab if it is not already displayed. 

All lines of the loaded purchase order are listed. The A insp and A. inv. fields display the 

quantities posted to date in Purchasing inspection or in the warehouse/supplier 

consignment warehouse. 

5. Set the appropriate posting ID in the PID field. For cancellations, you use posting IDs 137, 140, 

and 141. Select the posting ID from the combo box in the field or from the Functions menu. If 

you use the Functions menu, the selected posting ID is set in all lines for which cancellation 

postings using this posting ID are permitted. 

Note that only those posting IDs that can be applied in the current situation are available 

for selection. For example, if no receipt postings have been made in Purchasing inspection 

- in which case the A insp field would show a quantity of 0.00 - then posting ID 140 Cancel 

inspection receipt is not available for selection. 

6. When you exit the PID field, the maximum quantity that can be canceled with this posting ID is 

entered in the Transaction field automatically. If you do not want to cancel the full quantity, 

enter the required cancellation quantity. 

7. For other lines in the purchase order, complete the same process from step 5. 

8. To post the cancellation, select Functions > Post. 
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After the posting, the actual inspection quantity or actual inventory quantity is reduced by the 

quantity canceled. 
 

Materials provided 

When issuing external production orders, you can provide the supplier or subcontracted 

manufacturer with your own materials (semifinished products or raw materials) for the production 

of manufactured items. 

For more information, see Subcontracted manufacturing. 

You can use the Materials provided object (Goods receipt folder in Inventory) that is described 

here to make the following postings for materials provided: 

 157: Issues the full quantity of the materials provided for subcontracted manufacturing 

 158: Issues a partial quantity of the materials provided for subcontracted manufacturing. 

 159: Cancels postings made using posting IDs 157 or 158. 

 160: Transfers materials provided to the subcontracted manufacturer's consignment 

warehouse. 

 148: Returns materials provided that were already posted to a subcontracted manufacturer's 
consignment warehouse (see "Create subcontracted manufacturer consignment warehouses" 

page 1080) using posting ID 160. 
 

Post materials provided 

To carry out postings for materials provided, complete the steps below: 

1. Open the material issue. 

 Open the purchase order for the subcontracted manufacturing activity, select the Inventory 

transaction function, and on the dialog box that is displayed, select the Material issue 

option. 

 Select Inventory > Goods receipt > Materials provided and load the purchase order for the 

subcontracted manufacturing. 

2. Click the Transaction tab. 
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3. In the lines for the materials provided (MA record type), select the required posting ID from the 

combo box in the PID field. You can also select the corresponding command from the 

Functions menu. The posting ID is then set in the lines automatically. Note that only those 

posting IDs that can actually be used in the current line status are available for selection. 

Note:  If you accessed this object from the purchase order directly, and the 

COMMON.EINKAUF.MATERIALTRANSFERTOEXTERNALSUPPLIER parameter in the 

configuration is set to yes, posting ID 160 Transfer to S/C manufacturing is set by default. 

If this parameter is set to no, and the full quantity has not been issued yet, posting ID 157 

Full S/C manufacturing issue is set by default. When you select the posting ID, the 

remaining quantity is also set by default in the Transaction field (see next point below). 

4. If you want to post a partial quantity, enter this quantity in the Transaction field. 

5. Select Functions > Post. 
 

Issue/repost materials provided for subcontracted manufacturing 

You can make the issue postings for materials provided and the corresponding reposting to 

subcontracted manufacturer's consignment warehouses (see "Create subcontracted manufacturer 

consignment warehouses" page 1080) at various different stages of the subcontracted 

manufacturing process: 

1. When releasing the production order 

To release a production order, load the relevant production order and select Functions > Release. 

To issue or repost materials provided when releasing a production order, the following settings 

must be defined: 

Both the Release option and the Material issue check box must be selected. 

The Subcontracted manufacturing tab of the dialog box shows the subcontracted manufacturing 

lines of the production order. If you select the Print check box only for a line, the purchase order for 

the relevant subcontracted activity is generated and printed when the production order is released. 

The materials provided are issued automatically once the purchase order is printed. 
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If you select both the S/C whse. check box and the Print check box, the purchase order is 

generated and printed, however the materials provided are not issued but are instead reposted to 

the subcontracted manufacturer's consignment warehouse. 

Notes: 

 You can only make a reposting if the purchase order is printed. In other words, you can only 

select the S/C whse. check box if the Print check box is also selected. 

 You can define the default setting for the S/C whse. check box using the 

COMMON.EINKAUF.MATERIALTRANSFERTOEXTERNALSUPPLIER parameter. 

 You can use the Materials provided (page 1119) object to cancel any of the above postings at 

any time. 

If the Print check box is not selected, the purchase order is generated, however it is not printed 

and the materials provided are not issued. In this case, as described in steps 2 and 3 below, you 

can print the purchase order manually and then decide whether you want to issue or repost the 

materials provided. 

If you select the PO propsl check box only, a PO proposal is generated first when the order is 

released for each subcontracted activity. This PO proposal can then be used to generate a 

purchase order. The same process as described in Edit PO proposals applies here also. You can 

use the COMMON.LEITSTAND.FREMDFERTIGUNGVORSCHLAG parameter in the configuration to define a 

default setting for the PO propsl check box. 

2. When the purchase order for the subcontracted manufacturer is printed for the first 

time 

If, as explained in the previous step, a purchase order for the subcontracted manufacturer was 

generated but not printed when the production order was released, you can use the Purchase 

orders object in the Purchasing module to print the purchase order and issue or repost the 

materials provided. 

You can access the generated purchase order from the production order directly by selecting Go 

to > Subcontracted manufacturing PO. Alternatively, you can open the Purchase orders object in 

the Purchasing module and load the purchase order here. 

Note:  According to numbering method 725, the IDs of purchase orders for subcontracted 

manufacturers are assigned the prefix SPO by default. 
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When the purchase order is printed for the first time, the Material issue dialog box is opened 

automatically. If the Material issue check box is selected here, and you then select Full issue from 

S/C manufacturing, the materials provided are issued. However, if you select Reposting to 

subcontractor warehouse, the materials provided are reposted to the subcontracted 

manufacturer's consignment warehouse. 

Notes: 

 You can define the default setting for the Reposting to subcontractor warehouse option using 

the COMMON.EINKAUF.MATERIALTRANSFERTOEXTERNALSUPPLIER parameter. 

 You can manage repostings using status 143 in the Status4 field on the Internal tab of the 

purchase order. 

 You can use the Materials provided object to cancel any of the above postings at any time. 

If you clear the Material issue check box, or close the dialog box by clicking Cancel, there is no 

issue posting or reposting carried out. 

3. Using the Materials provided object 

If the materials provided have not yet been issued or reposted at any of the stages described 

above, you can make these postings in the Materials provided object. If the materials were already 

reposted to the subcontracted manufacturer's warehouse at a previous stage, you can use this 

object to issue the material from this warehouse. You can also cancel issue postings and 

repostings here. 

4. When making receipt postings for subcontracted manufactured resources 

At the latest, the materials provided are issued automatically when the purchase receipt posting 

for the subcontracted manufactured resources (see "Perform subcontracted manufacturing 

purchase receipt" page 1106) is made in the Purchase receipt object in the Inventory module. If 

the materials were reposted to a subcontractor warehouse at a previous stage, they are issued 

from this warehouse. 
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Issue lists (Goods receipt) 

Call 

Inventory > Goods receipt > Issue lists 

Description 

Issue lists document the issue of materials. In Goods receipt, you use issue lists to enter the 

material issues for materials provided. 

You can use the Issue lists object to carry out the following tasks: 

 Manually generate issue lists 

 Manually print and release issue lists that were generated manually or automatically 

In practice 

You can decide if and how issue lists should be generated for inventory movements that occur as 

a result of goods issue postings by selecting the corresponding options in the release dialog box 

for the production order or in the Create document dialog box that is displayed when you select the 

Create document function in the Sales orders object (Sales > Order processing). 
 

Issue list feedback (Goods receipt) 

Call 

Inventory > Goods receipt > Issue list feedback 



1124 | Infor COM 7.5 User Guide 

 

Inventory 

 

Description 

The Transfer list feedback, Receipt list feedback, and Issue list feedback objects allow goods 

issues and goods receipts to be treated differently from the internal warehouse movements, i.e. 

issues and receipts. This means that you can make manual adjustments for each individual 

movement if the current values differ from the planned values. Exceptions can be handled easily 

and you can also maintain the remaining quantity (inspection quarantine, specification of 

remaining quantities). 

We recommend this procedure for items with item properties for splitting batch-tracked inventory 

(page 1048). 

You define whether or not feedback is permitted in the master data for the work area (see "Work 

areas" page 1089) (Properties) tab. 

Please note: If the check boxes on this tab are not selected, or if the work area is not assigned 

to the inventory location, no feedback is possible since the relevant lists are automatically 

acknowledged during release and their status is set to Confirmed. 

Note that the Issue list feedback function accessed by selecting Inventory > Goods issue > Issue 

list feedback is intended for sales orders, and the Issue list feedback function accessed by 

selecting Inventory > Manufacturing > Issue list feedback is intended for production orders. 

To access the Feedback for receipt lists function, you must select Inventory > Manufacturing > 

Receipt list feedback or Inventory > Goods receipt > Receipt list feedback. 

The Issue list feedback object in the Goods receipt folder is used for materials provided. 

In practice 

Issue lists with open movements are generated and you are free to edit these. Employees in the 

warehouse can acknowledge these using theIssue list feedback function. They can also 

acknowledge variations in the same way. 
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The objects in this folder allow you to carry out inventory movements right across the logistical 

chain in order to optimize warehouse utilization or perform inventory adjustments. 

A warehouse movement refers to the movement of material between two points in a warehouse. 

Inventory movements are generated each time a receipt posting, transfer posting, or issue posting 

is made. 

A grouped movement is an inventory movement action without the specification of batch-tracked 

inventory. One or more batch-tracked inventories can be assigned when movements are 

confirmed (acknowledged). 

 This allows more flexibility when it comes to picking, while also allowing you to work with 

scanners and batch-tracked inventory labels.  

You can enter additional notes for the transaction for all recorded inventory movements. These 

notes are saved in the inventory journal. They can be used for evaluations or can simplify locating 

special posting procedures. Notes can either be taken from a table (WMSNOTES allocation table) 

or edited as free text depending on the COMMON.BUCHEN.NOTEEDITABLE parameter setting. 
 

Transfer 

Call 

Inventory > Inventory movements > Transfer 

Description 

You can use this object to transfer the inventory available at the warehouse. 

The Transfer object allows you to carry out the following tasks: 

 Transfer full quantities of batch-tracked inventory (see "BT-inv." page 1046) from one 

inventory location to another inventory location. 

 Transfer partial quantities of batch-tracked inventory from one inventory location to one or 

more other inventory locations. 

Inventory movements 
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Note: Transfers carried out using the  Transfer object are based on batch-tracked inventory, 

whereas quantity transfers carried out using the Quantity transfer object are based on 

batch-tracked inventory totals (see "BT-inv." page 1046). 

Configuration 

If the COMMON.WMS.USEPACKAGES parameter in the configuration is set to yes, you can use 

the Go to menu to switch to the Packaging information object or display information relating to the 

packaging content or load units. 

Functions 

The Possible locations function opens a dialog box that allows you to search for and accept 

suitable target inventory locations for the transfer. 

If you want to let the system search for a suitable location, select the Find location function. The 

system then presets a suitable target inventory location automatically. 

In practice 

You can add transfer movements to transfer lists (page 1129). 
 

Perform transfers 

The following overview describes how to carry out transfers (see "Transfer" page 1125): 

1. Select Inventory > Inventory transactions > Transfer and click the Open tab. 

2. Enter the data for the required batch-tracked inventory and click Load. 

3. Select the batch-tracked inventory to be transferred by clicking the row header. 

Note: Press the CTRL key to select multiple batch-tracked inventories if you would like to use 

the Possible locations function later to search for target location(s). 

4. Select the Quantities tab in the lower table. 

5. Use one of the following methods to enter the selected inventory locations on the Quantities 

tab. 
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 In the Inventory area, X-coordinate, Y-coordinate, and Z-coordinate fields on the 

Quantities tab, enter the coordinates of the inventory location to be used as the target 

location for the transfer. 

 If you would like to display an overview of the relevant inventory locations first, select 

Functions > Possible locations. 

Select the required target location from the following dialog box and click Transfer. 

 Select Functions > Find location to have the system's receipt strategy (page 1040) enter 

the appropriate target location automatically. 

Note: In all of the above options, the choice of inventory location is restricted to the 

warehouse whose ID you entered earlier in the Target address ID field on the Open tab. 

Once the location is specified, you can view the various properties of the selected location 

on the Target location tab. 

6. Enter the transfer quantity in the Quantity field. 

The Mov. qty field for the relevant batch-tracked inventory in the upper table on the 

Batch-tracked inventory tab displays the total quantity that can be moved. The movable 

quantity is reduced automatically by the specified transfer quantities. 

Note:  The Quantities and Target location tabs in the lower table always display the 

transfer data for the batch-tracked inventory that is currently selected.  

7. Select Functions > Post to display the Print dialog box. 

8. Enter the settings required to create the movement list and print the labels. Then click OK. 
 

Quantity transfer 

Call 

Inventory > Inventory movements > Quantity transfer 

Description 

This object allows you to carry out the following tasks: 

 Transfer full quantities of batch-tracked inventory totals (see "BT-inv." page 1046) from one 

inventory location to another inventory location. 

 Transfer partial quantities of batch-tracked inventory totals from one inventory location to one 

or more other inventory locations. 
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Transfers carried out using the Transfer object are based on  batch-tracked inventory (see 

"BT-inv." page 1046), whereas quantity transfers carried out using the  Quantity transfer object 

are based on batch-tracked inventory totals. 

You use the Quantity transfer object if you want to transfer a specific quantity of items and it is not 

important which batch-tracked inventory this quantity belongs to. 

Configuration 

If the UsePackages=yes setting is defined in the configuration, you can use the Go to menu to 

switch to the Packaging information object or display information relating to the packaging content 

or load units. 

Functions 

The Possible locations function opens a dialog box that allows you to search for and accept 

suitable target inventory locations for the transfer. 

If you want to let the system search for a suitable location, select the Find location function. The 

system then presets a suitable target inventory location automatically. 

In practice 

It is only possible to move or split the batch-tracked inventory totals of items for which the Can be 

split at issue property is selected on theInventory flags tab in the relevant master data. 

You can add the generated transfer movements to transfer lists (page 1129). 
 

Perform quantity transfers 

The following overview describes how to carry out quantity transfers (see "Quantity transfer" page 

1127): 

1. Select Inventory > Inventory transactions > Quantity transfer and click the Open tab. 

2. Enter the data for the required batch-tracked inventory totals and click Load. 
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3. Select the batch-tracked inventory to be transferred by clicking the row header. 

Note: Press the CTRL key to select multiple batch-tracked inventories if you want to use the 

Possible locations function later to search for target location(s). 

4. Select the Quantities tab in the lower table. 

5. Use one of the following methods to enter the selected inventory locations on the Quantities 

tab. 

 In the Inventory area, X-coordinate, Y-coordinate, and Z-coordinate fields on the 

Quantities tab, enter the coordinates of the inventory location to be used as the target 

location for the transfer. 

 If you would like to display an overview of the relevant inventory locations first, select 

Functions > Possible locations. 

Select the required target location from the following dialog box and click Transfer. 

 Select Functions > Find location to have the system's receipt strategy (page 1040) enter 

the appropriate target location automatically. 

Note: In all of the above options, the choice of inventory location is restricted to the 

warehouse whose ID you entered earlier in the Target address ID field on the Open tab. 

Once the location is specified, you can view the various properties of the selected location 

on the Target location tab. 

6. Enter the transfer quantity in the Quantity field. 

The Mov. qty field for the relevant batch-tracked inventory in the upper table on the 

Batch-tracked inventory tab displays the total quantity that can be moved. The movable 

quantity is reduced automatically by the specified transfer quantities. 

Note:  The Quantities and Target location tabs in the lower table always display the 

transfer data for the batch-tracked inventory that is currently selected.  

7. Select Functions > Post to display the Print dialog box. 

8. Enter the settings required to create the movement list and print the labels. Then click OK. 
 

Transfer lists 

Call 

Inventory > Inventory movements > Transfer lists 
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Description 

Generated active inventory movements of the same inventory request type are added to transfer 

lists according to various criteria. These criteria are saved in the list. 

Movement lists can be used to plan inventory movements (page 1125) and compile them into lists. 

For all inventory movements, you can choose not to carry out the movement immediately, but 

instead issue a notification only, and assign it to a movement list if required. During the relevant 

process, you can specify by means of a selection dialog box whether inventory movements should 

be added to movement lists and how the lists should then be used. 

Notified movements can be added to existing movement lists. A movement list can be printed 

separately. However, the inventory posting is not carried out until the list is explicitly released.  

The Transfer lists object allows you to carry out the following specific tasks: 

 Manually generate transfer lists 

 Manually print and release transfer lists that were generated manually or automatically 

Configuration 

You can manage the default settings for these options using the movement list configuration (see 

"Movement lists" page 1049). 

In practice 

 The list can be generated using path-optimized picking sequences (see "Path optimization" 

page 1042). 

 You can decide if and how transfer lists should be generated for inventory movements that 

occur as a result of transfer postings by selecting the appropriate options on the Print dialog 

box. To access this dialog box, open the Inventory movements folder, click the Transfer or 

Quantity transfer object, and select the Post function. 

 Note that when you delete a report, only the report is deleted. The movement status of the 

items in the report is retained. 
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Transfer list feedback 

Call 

Inventory > Inventory movements > Transfer list feedback 

Description 

The Transfer list feedback, Receipt list feedback, and Issue list feedback objects allow goods 

issues and goods receipts to be treated differently from the internal warehouse movements, i.e. 

issues and receipts. This means that you can make manual adjustments for each individual 

movement if the current values differ from the planned values. Exceptions can be handled easily 

and you can also maintain the remaining quantity (inspection quarantine, specification of 

remaining quantities). 

We recommend this procedure for items with item properties for splitting batch-tracked inventory 

(page 1048). 

You define whether or not feedback is permitted in the master data for the work area (see "Work 

areas" page 1089) (Properties) tab. 

Please note: If the check boxes on this tab are not selected, or if the work area is not assigned 

to the inventory location, no feedback is possible since the relevant lists are automatically 

acknowledged during release and their status is set to Confirmed. 

Note that the Issue list feedback function accessed by selecting Inventory > Goods issue > Issue 

list feedback is intended for sales orders, and the Issue list feedback function accessed by 

selecting Inventory > Manufacturing > Issue list feedback is intended for production orders. 

To access the Feedback for receipt lists function, you must select Inventory > Manufacturing > 

Receipt list feedback or Inventory > Goods receipt > Receipt list feedback. 
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In practice 

Issue lists with open movements are generated and you are free to edit these. Employees in the 

warehouse can acknowledge these using theIssue list feedback function. They can also 

acknowledge variations in the same way. 
 

Replenishment control 

Call 

Inventory > Inventory movements > Replenishment control 

Description 

You use this object to regulate the replenishment of batch-tracked inventory from reserve 

locations (see "WMSSTOCKT" page 1034) to fixed locations and pick locations. 

The minimum quantity defined (in the master data for the inventory location in the case of fixed 

locations (page 1093), and in the master data for the item in the case of pick locations (see 

"Inventory locations" page 1091)) defines the quantity below which the system will trigger 

replenishment control and the subsequent transfer of batch-tracked inventory from the reserve 

locations. If the quantity of batch-tracked inventory at these locations falls below this minimum 

quantity, this batch-tracked inventory must be replenished. 

Configuration 

COMMON.WMS.BOOKINGSERVERAVAILABLE=yes 

COMMON.WMS.USERESERVELOCATIONS=yes 
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In practice 

Replenishment control can be carried out automatically (see "Auto. replenishment control" page 

1133) or manually. 

The WMS posting server (see "Batch processing (Inventory movements)" page 1140) receives the 

requests to replenish the fixed locations and pick locations by means of transfers from reserve 

locations. 
 

Auto. replenishment control 

Call 

Inventory > Inventory movements > Auto. replenishment control 

Description 

You use this object to regulate the automatic replenishment of batch-tracked inventory from 

reserve locations to fixed locations and pick locations. 

The minimum quantity defined (in the master data for the inventory location in the case of fixed 

locations (page 1093), and in the master data for the item in the case of pick locations (see 

"Inventory locations" page 1091)) defines the quantity below which the system will trigger 

replenishment control and the subsequent transfer of batch-tracked inventory from the reserve 

locations. If the quantity of batch-tracked inventory at these locations falls below this minimum 

quantity, this batch-tracked inventory must be replenished. 

Configuration 

COMMON.WMS.BOOKINGSERVERAVAILABLE=yes 

COMMON.WMS.USERESERVELOCATIONS=yes 
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In practice 

Replenishment control can be carried out automatically or manually (see "Replenishment control" 

page 1132). 

If Replenishment control is carried out automatically, the system evaluates the Provision lead time 

field on the Manufacturing tab in the work centers. 

The WMS posting server (see "Batch processing (Inventory movements)" page 1140) receives the 

requests to automatically replenish the fixed locations and pick locations by means of transfers 

from reserve locations. 
 

Run Automatic replenishment control 

The minimum quantity defined (in the master data for the inventory location in the case of fixed 

locations (page 1093), and in the master data for the item in the case of pick locations (see 

"Inventory locations" page 1091)) defines the quantity below which the system will trigger 

replenishment control and the subsequent transfer of batch-tracked inventory from the reserve 

locations. If the quantity of batch-tracked inventory at these locations falls below this minimum 

quantity, this batch-tracked inventory must be replenished. 

To run an Automatic replenishment control (see "Auto. replenishment control" page 1133) 

process, complete the following steps: 

1. Select Inventory > Inventory movements > Auto. replenishment control. 

2. On the Open tab, select the required items or inventory areas. You can limit the display using 

the From/To fields, or load all data records using the % wildcard. 

3. Select the Activated check box for the lines for which automatic replenishment control is to be 

run.  

 Inventory requests will be generated for the selected lines and transferred to batch 

processing. 

4. Select Functions > Post. 

5. Select Inventory > Inventory movements > Batch processing. 
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I point 

Call 

Inventory > Inventory movements > I-point 

Description 

An I-point (ID point) is a central area within the warehouse where all goods receipts (from 

purchase orders, Manufacturing, or Subcontracted manufacturing, for example) arrive and are 

received. For more information, see Inventory locations (page 1091). 

The I-point function streamlines the processes used for entering transactions by combining the 

various module-specific processes into a single process. 

In practice 

When you open the I-point, the system recognizes the type of inventory transaction from the 

populated fields and then displays the corresponding transaction form (goods receipt, 

manufacturing receipt, etc.). For more information, see Open Inventory adjustment.  
 

Inventory requests 

Call 

Inventory > Inventory movements > Inventory requests 



1136 | Infor COM 7.5 User Guide 

 

Inventory 

 

Description 

Inventory requests are used to provide material required for production orders or sales orders on 

time. The posting server (see "Batch processing (Inventory movements)" page 1140) assigns the 

available quantities to the inventory requests and generates movements from the inventory to the 

right system location. If an inventory request cannot be filled with the required quantity, a backlog 

(see "Backlogs" page 1137) results. 

Inventory requests prepare for subsequent issues. 

Inventory requests can be grouped together or merged with other similar requests and picked. 

Configuration 

COMMON.WMS.USEADVANCEDPICKINGINPPC=YES 

COMMON.WMS.USEADVANCEDPICKINGINSALES=YES 

COMMON.WMS.SALESPICKINGPOSTFINISHACTION=7 

COMMON.VERTRIEB.ENTNAHMEBELEGE=2 

Functions 

Start prepicking: Select this function if you want picking to start even though the issue date is not 

until later. This function will set the status of the inventory movements to Advised and they can 

then be added to an issue list. 

Deliver immediately: Executable movements are generated for all executable inventory 

movements with at least a partial quantity. The inventory requests are spit into one request in 

Assigned status and another request for the outstanding remaining quantity in Released status. 

Picking start time: This function sets the picking start time in an inventory request or in all selected 

inventory requests to now if the statuses are Advised or Released. This lets the request be 

processed immediately by the posting server. 

In practice 

For information on how to create inventory requests from a sales order, see Generate inventory 

requests (see "Generate and release inventory requests" page 1137). 
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In the production order, select the Create inventory requests option when releasing the production 

order. 
 

Generate and release inventory requests 

For general information on inventory requests, see Inventory requests (page 1135). 

The following Help topic describes how to generate inventory requests from a sales order. 

1. Select Sales > Order processing > Sales order. Enter the required data on the New tab and 

click Create. 

2. Enter the required resource data on the Order tab. 

3. Select Functions > Create inventory requests. 

The Inventory request - structural overview is displayed. 

Note: The inventory requests are created with the requirement status Advised. This enables 

the inventory requests to be processed at a later stage. 

4. Select the Relation tab. 

You can also enter a follow-up action in the Picking post-processing field to be carried out 

once picking has completed. You can configure this follow-up action using the 

COMMON.WMS.SALESPICKINGPOSTFINISHACTION parameter. 

5. Select Functions > Release to release the inventory request. 

6. Select Inventory > Inventory movements > Batch processing. 

The Batch processing object processes released inventory requests. 

Inventory movements are generated and the goods are picked at the goods issue location. 

For information on how to proceed from here, see Generate and release issue lists (see 

"Generate, print, and acknowledge issue lists" page 1145). 
 

Backlogs 

Call 

Inventory > Inventory movements > Backlogs 
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Description 

The term backlog is used to describe the specific status of an inventory request (see "Inventory 

requests" page 1135) that cannot be fulfilled because there is insufficient inventory in the 

warehouse. 

The benefits of backlog management include the ability to quickly check outstanding deliveries 

and ensure that warehouse inventory is kept as low as possible so that warehouse inventory costs 

are reduced. 

During goods receipt, incoming items can be assigned to existing inventory requests either 

manually or automatically. 

Example: If a customer orders a larger quantity of an item than is available in the warehouse, 

you can map this situation using the Backlog management object. 

Configuration 

COMMON.WMS.SHORTAGEENABLEDINSALES=yes 

COMMON.WMS.AUTORESOLVEBACKORDERINPURCH=yes 

COMMON.WMS.AUTORESOLVEBACKORDERINPPC=yes 

In practice 

Handle backlogs (see "Generate backlogs" page 1138) 
 

Generate backlogs 

This topic describes how to generate backlogs. To do so, create a sales order that cannot be 

delivered in full. A backlog is therefore created, and this backlog is subsequently resolved 

manually via a receipt from Purchasing. 

1. Select Sales > Order processing > Sales order. Enter the required data on the New tab and 

click Create. 

2. Enter the required resource data on the Order tab. 

3. Select Go to > Inventory information > All addresses to check the inventory of the item. 

Please note: For a back log to be generated, the order quantity entered in the Quantity field 

on the Order tab must be greater than the warehouse inventory. 
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4. Select Functions > Create inventory requests. Click the Relation tab and in the BackHndlg 

field, select the Postpone request option (see WMSREQSHTG (page 1030)). 

5. Select Inventory > Inventory movements > Batch processing to start the posting server. 

6. Select Inventory > Inventory movements > Backlogs. On the Open tab, enter a value in the 

required fields and click Load. 

Note: You can also access the Backlogs object by selecting Go to > Backlogs. 
 

Resolve backlogs 

You can resolve backlogs automatically or manually. You define the required method for resolving 

backlogs using the COMMON.WMS.AUTORESOLVEBACKORDERINPURCH and 

COMMON.WMS.AUTORESOLVEBACKORDERINPPC configuration parameters. This topic 

describes the procedure. 

Note: Inventory that is not allocated is posted to the warehouse. Allocated inventory initially 

remains in Goods receipt and is then transferred to the machine location or to Goods issue. 

 
 

Resolve backlogs automatically 

To resolve backlogs automatically: 

1. Select Inventory > Goods receipt > Purchase receipt and load the required purchase order. 

2. On the Transaction tab enter the posting ID (PID). 

The quantity in the Backlog quantity field is automatically distributed to backlogged inventory 

requests. To view the result select Inventory movements > Inventory requests and open the 

Inventory request tab. 
 

Resolve backlogs manually 

To resolve backlogs manually: 

1. Select Inventory > Goods receipt > Purchase receipt and load the required purchase order. 

2. Select the required line and then select View > PO line. 
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3. Open the Inventory request tab and in the Inventory request ID field enter the inventory 

request ID. 
 

Display backlogs 

To display backlogs: 

 In Manufacturing select Production orders. Open the required production order and open the 

Request quantities tab to display the backlog quantity per line for material lines. 

 Select Inventory > Manufacturing > Inventory transactions and open the required production 

order. The backlog quantity is displayed on the Transaction and Request quantity tabs. 
 

Batch processing (Inventory movements) 

Call 

Inventory > Inventory movements > Batch processing 

Description 

You use this object to start the WMS posting server, which is responsible for processing inventory 

requests (page 1135). 

Batch processing reads the appropriate inventory requests (by due date, status, etc.) and 

generates the inventory movements. You can view these movements in the inventory information 

(page 1183). 

Note: The WMS posting server uses receipt strategies and issue strategies automatically. 

The WMS posting server processes inventory requests whose status is Released and whose 

issue date has either not been specified, or is before the current date. 

Configuration 

To use the WMS posting server, the COMMON.WMS.BOOKINGSERVERAVAILABLE=yes 

parameter must be set in the configuration. 
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A consignment warehouse is a warehouse that stores goods that are not yet the property of the 

warehouse owner. The goods remain the property of the supplier until the owner of the warehouse 

pays for them during inventory issue. 

There are three different types of consignment warehouse in Infor COM: 

 Supplier consignment warehouses, which are used for Purchasing. 

 Customer consignment warehouses (see "Customer consignment warehouse" page 1069), 

which are used for Sales. 

 Subcontracted manufacturer consignment warehouses (see "Create subcontracted 
manufacturer consignment warehouses" page 1080), which are used for Manufacturing. 

You can set the COMMON.WMS.ONLYCONSIGNMENTLOCATIONS parameter in the 

configuration to specify whether postings should be made to consignment inventory areas only. 

The functions included in the Supplier consignment (page 1141) and Consumption transaction 

(page 1144) objects in the Consignment warehouse folder of Inventory module are used for 

supplier consignment warehouses only. 
 

Supplier consignment 

Supplier consignment warehouses are warehouses on your premises that store goods that are still 

the property of your suppliers. The supplier fills the warehouse, which is available for planning  

but is not taken into account by the system from a value perspective.  

You are not invoiced for the goods until you issue them for processing or sale. You communicate 

this to the supplier by means of consumption transactions (see "Consumption transaction" page 

1144). 

You can use the Supplier consignment object to open purchase orders that were created for the 

supplier consignment warehouse, and then post the ordered items. 

You can also open purchase orders containing lines for different warehouses if at least one of 

these lines was specified for the consignment warehouse. In this case, only the line that was 

specified for the consignment warehouse will be available for posting. 

Consignment warehouse 
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For information on how to make purchase receipt postings for a consignment warehouse, see Post 

goods receipts to supplier consignment warehouses (page 1142). 
 

Post goods receipts to supplier consignment warehouses 

You generate purchase orders for goods at a supplier consignment warehouse in the same way 

as you create normal purchase orders using the Purchase orders object in the Purchasing 

module. For more information, see Enter purchase order (ms-its:purchasing.chm::/3831.htm). 

To post a purchase order for a supplier with a supplier consignment warehouse and the 

subsequent goods receipt to supplier consignment warehouse (see "Supplier consignment" page 

1141), complete the following steps. 

1. Select Purchasing > Purchase orders > New. Enter the supplier ID  and click Create. 

Please note: A Warehouse type inventory area (see "Inventory areas" page 1085) must 

exist for this supplier, and the consignment warehouse type must be Supplier consignment 

warehouse. There must also be an inventory location (see "Inventory locations" page 1091) 

created in this inventory area. 

2. Enter the item on the Quantities tab and the purchase order quantity in the PO field. 

3. Select the Coordinates tab. Then select the required  inventory area within the supplier 

consignment warehouse for the relevant line. 

4. Select Functions > Create document and click OK. 

5. To post the goods receipt for the purchase order, select Inventory > Consignment warehouse 

> Supplier consignment. Enter the purchase order ID on the Open purchase order tab and 

click Load. 

The coordinates for the consignment inventory area and consignment inventory location that 

were created for the relevant supplier are entered by default on the Coordinates tab. If there is 

more than one set of coordinates, just the coordinates in common are displayed. You can add 

to the remaining coordinates by selecting from the corresponding combo boxes. Otherwise, 

the first inventory location in the sort order is used. 

ms-its:purchasing.chm::/3831.htm
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6. On the Transaction tab for the required line, select posting ID 161. If necessary, enter the 

transaction quantity in the Transaction field. 

Note: Purchase receipts are posted to the supplier consignment warehouse using posting ID 

161 and 162 (partial receipts). You can use posting ID 163 to add further unplanned lines to 

the Transaction tab and post these to the consignment warehouse as unplanned receipts. 

7. Select Functions >Post consignment warehouse. 

8. Enter the external advance shipping notice ID on the following dialog box, and click OK. 
 

Goods issue postings from supplier consignment warehouses 

Goods issues from supplier consignment inventory locations are the same as issues from normal 

inventory locations. However, with a supplier consignment warehouse, the system specifically logs 

each goods issue posting from the consignment inventory locations for the subsequent 

consumption transactions that are sent to the suppliers. You can use the Consumption transaction 

(page 1144) object to generate and print these transactions. Suppliers use these transactions as 

the basis for invoicing. 
 

Value flow in a consignment warehouse 

The value flow for inventory at supplier consignment warehouses has a number of special 

features. 

Because the inventory still belongs to the supplier and is not valuated, the company does not incur 

the cost of originally supplying the warehouse. The company only incurs costs when the 

warehouse is replenished due to an inventory issue to one of its own warehouses. 

Note the fol lowing:  

 Warehouse inventory in a consignment warehouse is not valuated. Receipts to this warehouse 

do not affect the inventory valuation. 

 Inventory is valuated when it leaves the consignment warehouse. If there is no invoice issued, 

the inventory is valuated based on the terms contained in the outline agreement with the 

supplier. The value is transferred immediately to the WIP account (for manufactured items) or 

to the customer account (for sales items). 

 Purchase orders are generated to replenish the inventory to the agreed quantity. 



1144 | Infor COM 7.5 User Guide 

 

Inventory 

 

 Invoice approval is carried out for these purchase orders based on the inventory that is issued 

and not the inventory that is received. After invoice approval, the average price of the 

inventory is updated. 

 Inventory count movements can be posted to a consignment warehouse. These movements 

affect the supplier account and the profit and loss accounts, but not the inventory valuation. 
 

Consumption transaction 

Call 

Inventory > Consignment warehouse > Consumption transaction 

Description 

Goods in supplier consignment warehouses remain the property of your supplier until you issue 

the goods in order to process or sell them. You inform your suppliers of these issues by means of 

consumption transactions. Suppliers base their invoicing on these transactions. 

This object allows you to generate and print these consumption transactions. 
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You can access these objects via Inventory > Goods issue: 
 

Generate issue 

Call 

Inventory > Goods issue > Generate issue 

Inventory > Manufacturing > Generate issue 

Description 

In order to pick the inventory movements generated by the WMS posting server (see "Batch processing 
(Inventory movements)" page 1140), we recommend you create an issue list itemizing each of the picking 

movements. 

The Generate issue object allows the automatic generation of issue lists (see "Issue lists (Goods issue)" 
page 1146). 

In practice 

You can create issue lists as follows: 

 Select Inventory > Goods issue > Issue lists. Enter the required selection criteria on the New tab 

and click Create. 

 Generate, print, and acknowledge issue lists (page 1145) 
 

Generate, print, and acknowledge issue lists 

For information on how the WMS posting server is used to pick inventory movements, see 

Generate inventory requests (see "Generate and release inventory requests" page 1137). 

The following Help topic describes how to generate an issue list to which picking movements are 

added. 

Goods issue 
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1. Select Inventory > Goods issue > Generate issue. 

On the dialog box that is displayed, enter the selection criteria and options, and select 

Generate and print automatically in the  Issue list field. 

2. Click OK. 

Result: The issue list is printed. 

3. Select Inventory > Goods issue > Issue lists. On the  Open tab, enter the movement list ID 

and click Load. 

4. Select Functions > Release. 

The status of the issue list is set to Released. The goods are issued from the source location 

and moved to the specified goods issue location. 

Please note: This process will not function unless specific requirements are met. For more 

information, see Issue list feedback (page 1147). 

Note: To acknowledge the issue list lines at the target location, i.e. the sales issue 

location, select Inventory > Goods issue > Issue list feedback. 

You can check the results on the Quantities tab in the inventory requests (page 1135), or 

on the Actual quantities tab in the sales order. 
 

Issue lists (Goods issue) 

Call 

Inventory > Goods issue > Issue lists 

Description 

Movement lists can be used to plan inventory movements (page 1125) and compile them into lists. 

For all inventory movements, you can choose not to carry out the movement immediately, but 

instead issue a notification only, and assign it to a movement list if required. During the relevant 

process, you can specify by means of a selection dialog box whether inventory movements should 

be added to movement lists and how the lists should then be used. 

Notified movements can be added to existing movement lists. A movement list can be printed 

separately. However, the inventory posting is not carried out until the list is explicitly released.  
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Issue lists are specifically used for documenting material issues. 

You can use the Issue lists object to carry out the following tasks: 

 Manually generate issue lists 

 Manually print and release issue lists that were generated manually or automatically 

Functions 

Release: When you select this menu command, inventory movements are assigned the status 

Executable. The goods can then be moved in the warehouse, i.e. the goods can be issued from 

the source location and moved to the specified goods issue location (defined in the sales order). 

In practice 

You can decide if and how issue lists should be generated for inventory movements that occur as 

a result of goods issue postings by selecting the corresponding options in the release dialog box 

for the production order or in the Create document dialog box that is displayed when you select the 

Create document function in the Sales orders object (Sales > Order processing). 

Issue lists can also be generated automatically using the Generate issue (page 1145) object. 

Manually generate movement lists (page 1050) 

Open, print, and release movement list (page 1051) 

Note that when you delete a report, only the report is deleted. The movement status of the items in 

the report is retained. 

You can manage the default settings for these options using the movement list configuration (see 

"Movement lists" page 1049). 
 

Issue list feedback 

Call 

Inventory > Goods issue > Issue list feedback 
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Configuration 

Issue list feedback requires that the COMMON.WMS.USEADVANCEDPICKINGINSALES 

parameter is set to yes in the configuration. 

Description 

The Transfer list feedback, Receipt list feedback, and Issue list feedback objects allow goods 

issues and goods receipts to be treated differently from the internal warehouse movements, i.e. 

issues and receipts. This means that you can make manual adjustments for each individual 

movement if the current values differ from the planned values. Exceptions can be handled easily 

and you can also maintain the remaining quantity (inspection quarantine, specification of 

remaining quantities). 

We recommend this procedure for items with item properties for splitting batch-tracked inventory 

(page 1048). 

You define whether or not feedback is permitted in the master data for the work area (see "Work 

areas" page 1089) (Properties) tab. 

Please note: If the check boxes on this tab are not selected, or if the work area is not assigned 

to the inventory location, no feedback is possible since the relevant lists are automatically 

acknowledged during release and their status is set to Confirmed. 

Note that the Issue list feedback function accessed by selecting Inventory > Goods issue > Issue 

list feedback is intended for sales orders, and the Issue list feedback function accessed by 

selecting Inventory > Manufacturing > Issue list feedback is intended for production orders. 

To access the Feedback for receipt lists function, you must select Inventory > Manufacturing > 

Receipt list feedback or Inventory > Goods receipt > Receipt list feedback. 

In practice 

Generate, print and release issue lists (see "Generate, print, and acknowledge issue lists" page 

1145) 
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Sales issue 

Call 

Inventory > Goods issue > Sales issue 

Description 

This object allows you to post the following processes: 

 Deliveries: Use of posting IDs 171 Full inv. issue and 172 Part. inv. issue to carry out full and 

partial issue of goods for sales orders on the basis of advance shipping notices or pick lists. 

 Returns: Use of posting ID 176 Return to quarantine W/H  to return goods already issued 

using posting ID 171 or 172 with simultaneous posting to the quarantine warehouse. 

 Consignment deliveries: Use of posting ID 173 Move to consignment to post transfers to 

customer consignment warehouses (see "Customer consignment warehouse" page 1069). 

 Returns: Use of posting ID 174 Return from consignment to return goods posted to a customer 

consignment warehouse using posting ID 173. 
 

Post deliveries 

The following overview describes how to post a full or partial issue based on an advance shipping 

notice or pick list using the Sales issue object. 

1. Select Inventory > Goods issue > Sales issue. On the Open tab, select the Delivery option. 

2. Select the required advance shipping notice by completing the required fields and then click 

Load. 

Note: If the issue is based on a pick list, the Advance shipping notice ID field will be dimmed. 

In this case, specify a pick list using the ID of the associated sales order. 
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3. From the combo box in the PID field for the relevant lines on the Inventory tab, select posting 

ID  171 if you want to post a full issue, or posting ID 172 if you want to post a  partial issue. If 

you are posting a partial issue, change the transaction quantity accordingly. 

Please note: Within an advance shipping notice, you can only post one partial issue per line. 

If partial issues have been posted, you can generate one or more advance shipping notices for 

the remaining quantities that have not been issued in the corresponding sales order. You also 

have the option of closing these lines if no further deliveries are to be made. 

Note: If you would like to enter a manual batch-tracked inventory specification (see "Enter 

manual batch-tracked inventory specification" page 1080), select the Man. check box in the 

relevant line. Then go to the ASN line  view and enter the specification(s) here. Once you're 

done, return to the ASN view. 

4. Select Functions > Post . 

Note: If the issue posting was based on a pick list, an advance shipping notice is now 

generated and printed. Any returns that occur are then posted using this advance shipping 

notice instead of the pick list. Once the posting is carried out, the Sales issue object closes. 

5. Select Inventory > Information > Inventory journal. On the Open tab, enter a value in the 

required fields to display the inventory movements and check that the postings are correct. 
 

Quarantine consignment W/H 

In Automotive, you can assign the COR (confirmation of receipt) flag to your subcontractors' 

warehouses (S/C W/H). This ensures that unposted batch-tracked inventory at these warehouses 

remains quarantined until the flag is removed. You can remove the flag using the Quarantine 

consignment W/H object. 

For more information on the COR flag, see the  EDI section of the Help topic on the Coordinates 

tab. 

Note: In Infor COM, subcontractor warehouses are managed as customer consignment 

warehouses. 
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Remove Quarantine consignment W/H flag 

For more information on quarantining consignment warehouses, click Quarantine consignment 

W/H (page 1150). 

The following overview describes how to remove the COR (confirmation of receipt) flag from 

batch-tracked inventory in Automotive using the Quarantine consignment W/H object (Inventory > 

Goods issue): 

1. Select Inventory > Goods issue > Quarantine consignment W/H. 

2. On the Open tab, enter the data required to select the relevant batch-tracked inventory: 

3. Click Load and select the Quarantine consignment W/H tab. 

4. From the PID field for the relevant batch-tracked inventory, select posting ID 198 From 

quarantine warehouse. 

Or select Functions > Set posting ID > From quarantine warehouse  to set this posting 

ID in all lines in which this ID can be posted.  

Note: This posting ID can only be set for batch-tracked inventory whose current 

inspection status is Order not inspected (see Or. ins. stat. field). 

5. To carry out the posting, select Functions > Post. The flag is removed and the inspection 

status is changed to Order inspected (see PInspStat field). 

If necessary, you can reset this flag again using posting ID 199 To Q W/H. 
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The objects in the Manufacturing folder provide the information and functions you need to ensure 

the optimum supply of materials for manufacturing. 
 

Inventory transactions 

Call 

Inventory > Manufacturing >  Inventory transactions 

Description 

You use this object to generate inventory transactions on the basis of production orders. 

Note: Prerequisite for inventory transactions in Manufacturing: The production orders must be 

released (Status 4, Queue position 20). 

The following table provides an overview of the possible inventory transactions along with their 

associated posting IDs. 

Process Posting ID 

Full and partial receipt of manufactured items from Manufacturing in 

Inspection (Manufacturing inspection) 

121 Manuf. to insp. full receipt 

122 Manuf. to insp. partial receipt 

Cancellation of full and partial receipts from Manufacturing in 

Manufacturing inspection 

123 Cancel manuf. to insp. receipt 

Full and partial receipts of manufactured items from Manufacturing in the 

warehouse 

181 Full manufacturing receipt 

182 Partial manufacturing receipt 

Cancellation of full and partial receipts 180 Cancel manuf. receipt 

Full and partial issue of the materials required for Manufacturing 183 Full man. issue 

184 Part man. issue 

Cancellation of full and partial issues 189 Cancel manuf. issue 

Reject transactions 

Cancellation of reject transactions 

250 Full waste issue 

251 Partial waste issue 

Manufacturing 
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Enter reject transactions 

The following overview describes how to post a reject transaction in a production order. 

Note: You enter rejects in the Inventory transactions (page 1152) object. You also use this object 

to make the receipt postings for manufactured items (good items) and the issue postings for 

materials required in manufacturing. You can enter rejects separately, or together with the relevant 

posting for the good items. You use the same posting IDs for the reject transactions as for the 

receipt postings for the good items: Full receipt, 182 Partial receipt, 121 Manuf. to insp. full receipt, 

and 122 Manuf. to insp. partial receipt. 

1. Select Inventory > Manufacturing > Inventory transactions to load the relevant production 

order. 

The status must be set to Released. 

2. Select the Reject transaction tab. 

3. Select the required posting ID in the PID field. 

Please note: If you just want to post rejects and you do not want to post any good items, 

make sure the quantity entered in the Trans. qty field is 0.00. Instead of using a posting ID 

for full receipts here, we recommend that you post the reject transactions using a posting 

ID for partial receipts, i.e. 182 Partial receipt or 122 Manuf. to insp. partial receipt. It is not 

important which of these two posting IDs you use for posting the reject transactions. 

4. Enter the reject quantity in the Rej. field. 

Note: The reject quantity does not affect the planned quantity of the good items. 

5. Select Functions > Post to post the reject transaction and, if applicable, the receipt of the good 

items. 

The quantity in the Act rjcts field is increased by the reject quantity that you just posted. 

Batch-tracked inventory is generated for the reject quantity, and batch-tracked inventory 

per item is generated for items for which serialized management is mandatory. The 

inspection status (see "WMSQAST" page 1026) assigned to the batch-tracked inventory is 

Order rejects. 
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Process rejects further 

The following options are available to you for the further processing of batch-tracked inventory 

posted as rejects. 

 Scrapping or converting batch-tracked inventory 

You can use the Manufacturing inspection object (Inventory > Manufacturing) or the 

Inspection object (Inventory > Special functions) to scrap or convert the batch-tracked 

inventory. To scrap, use posting ID 86 Scrap defective material (manuf.) and to post, use 

posting ID 87 Item conversion from. For more information on posting IDs 86 and 87, see 

Inventory posting IDs (page 1053). 

 Cancelation 

You can cancel reject transactions using the Inventory transactions object, provided the 

relevant batch-tracked inventory has not been scrapped or converted in the meantime. 

You can cancel reject transactions separately, or together with the receipt postings for the 

good items. You use the same posting IDs as you would to cancel the receipt postings for 

the good items: 180 Cancel manuf. receipt or 123 Cancel manuf. to insp. receipt. You can 

use either of these posting IDs to cancel reject postings regardless of the type of receipt 

posting. 
 

Manufacturing inspection 

 

Call 

Inventory > Manufacturing > Manufacturing inspection  
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Description 

You can use the Manufacturing inspection object to process goods that were posted via the 

Inventory transactions object using posting IDs 121 Manuf. to insp. full receipt and 122 Manuf. to 

insp. partial receipt. The inspection status of this type of batch-tracked inventory is Order not 

inspected. 

Depending on the result of the inspection, you can then use the Manufacturing inspection object to 

post the relevant batch-tracked inventory either to the quarantine warehouse using posting ID 120 

Insp. to quarantine W/H receipt, or to the regular warehouse using posting ID 124 Inspection to 

warehouse receipt. 

You can cancel these postings again using posting ID 125 Cancel insp. to W/H receipt. The 

inspection status of batch-tracked inventory posted to the quarantine warehouse is Order 

quarantined. The inspection status of batch-tracked inventory posted from Manufacturing 

inspection to the warehouse is Order inspected. 

Batch-tracked inventory with the inspection status Order rejects that was generated from reject 

transactions in the Inventory transactions object (Inventory > Manufacturing) can be scrapped 

via Manufacturing inspection using posting ID 86 Scrap defective material (manuf.), or converted 

(see "Convert item in Inspection" page 1194) to batch-tracked inventory with a different item ID 

using posting ID 87 Item conversion from. 

When you post batch-tracked inventory in Manufacturing inspection, you can also edit it afterward 

in the Inspection (page 1191) object. 

See also: Edit inspection status in Inspection (page 1193) 
 

Generate issue 

Call 

Inventory > Manufacturing > Generate issue 
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Description 

In order to pick the inventory movements generated by the WMS posting server (see "Batch 

processing (Inventory movements)" page 1140), we recommend you create an issue list itemizing 

each of the picking movements. 

The Generate issue object allows the automatic generation of issue lists (see "Issue lists (Goods 

issue)" page 1146). 

In practice 

You can create issue lists as follows: 

 Select Inventory > Goods issue > Issue lists. Enter the required selection criteria on the New 

tab and click Create. 

 Generate, print, and acknowledge issue lists (page 1145) 
 

Issue lists 

Call 

Inventory > Manufacturing > Issue lists 

Description 

You can use the Issue lists object to carry out the following tasks: 

 Manually generate issue lists 

 Manually print and release issue lists that were generated manually or automatically 

In practice 

To decide if and how issue lists should be generated for inventory movements that occur as a 

result of material issue postings, select the corresponding options on the following dialog boxes: 

 The Release dialog box that opens in the Production orders object (Manufacturing) when you 

select the Release function. 

 The Issue list section of the Print dialog box that opens in the Inventory transactions object 

(Inventory > Manufacturing) when you select the Post function. 
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You can manage the default settings for these options using the movement list configuration (see 

"Movement lists" page 1049). 

See also: Manually generate movement lists (page 1050) and Open, print, and release movement 

list (page 1051) 
 

Generate issue list manually 

The following Help topic describes how to create an issue list by releasing a production order. 

1. Select Manufacturing > Production orders. On the Open tab, enter a value in the required 

fields for the production order to be released and click Load. 

2. Select Functions > Release. On the Issue list section, select Generate manually and click OK. 

3. Select Inventory > Manufacturing > Issue lists. On the New tab, select the order ID and click 

Create to confirm. 

4. Select Functions > Print list to print out the list. 

The status of the list is set to Printed. 

5. Select Functions > Release. 

The status of the batch-tracked inventory is set to Completed, and the status of the list is set to 

Confirmed . 
 

Generate issue list automatically 

The following Help topic describes how to have issue lists generated automatically. 

1. Select Manufacturing > Production orders. On the Open tab, enter a value in the required 

fields for the production order to be released and click Load. 
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2. Select Functions > Release. On the Issue list section, select one of the Generate 

automatically, Generate and print automatically, or Generate and release automatically 

options  

Note: For information on the individual options, see the context-sensitive Help for the dialog 

box. 

If you want the issue strategy to determine the batch-tracked inventory to be posted, specify 

Generate and release automatically as the default option in the WMSMVLISTCFG allocation 

table. 

3. Click OK. 
 

Issue list feedback 

Call 

Inventory > Manufacturing > Issue list feedback 

Description 

The Transfer list feedback, Receipt list feedback, and Issue list feedback objects allow goods 

issues and goods receipts to be treated differently from the internal warehouse movements, i.e. 

issues and receipts. This means that you can make manual adjustments for each individual 

movement if the current values differ from the planned values. Exceptions can be handled easily 

and you can also maintain the remaining quantity (inspection quarantine, specification of 

remaining quantities). 

We recommend this procedure for items with item properties for splitting batch-tracked inventory 

(page 1048). 

You define whether or not feedback is permitted in the master data for the work area (see "Work 

areas" page 1089) (Properties) tab. 

Please note: If the check boxes on this tab are not selected, or if the work area is not assigned 

to the inventory location, no feedback is possible since the relevant lists are automatically 

acknowledged during release and their status is set to Confirmed. 
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Note that the Issue list feedback function accessed by selecting Inventory > Goods issue > Issue 

list feedback is intended for sales orders, and the Issue list feedback function accessed by 

selecting Inventory > Manufacturing > Issue list feedback is intended for production orders. 

To access the Feedback for receipt lists function, you must select Inventory > Manufacturing > 

Receipt list feedback or Inventory > Goods receipt > Receipt list feedback. 

In practice 

Generate and release issue lists (see "Generate, print, and acknowledge issue lists" page 1145) 
 

Receipt lists 

Call 

Inventory > Manufacturing > Receipt lists 

Description 

You can use the Receipt lists object to carry out the following tasks: 

 Manually generate receipt lists 

 Manually print and release receipt lists that were generated manually or automatically 

In practice 

You can decide if and how receipt lists should be generated for inventory movements that occur as 

a result of purchase receipt postings for manufactured items by selecting the corresponding 

options on the Receipt list section of the Print dialog box. This dialog box opens in the Inventory 

transactions object (Inventory > Manufacturing) when you select the Post function. 

You can manage the default settings for these options using the movement list configuration (see 

"Movement lists" page 1049). 

See also: Manually generate movement lists (page 1050) and Open, print, and release movement 

list (page 1051) 
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Receipt list feedback 

Call 

Inventory > Manufacturing > Receipt list feedback 

Inventory > Goods receipt > Receipt list feedback 

Description 

The Transfer list feedback, Receipt list feedback, and Issue list feedback objects allow goods 

issues and goods receipts to be treated differently from the internal warehouse movements, i.e. 

issues and receipts. This means that you can make manual adjustments for each individual 

movement if the current values differ from the planned values. Exceptions can be handled easily 

and you can also maintain the remaining quantity (inspection quarantine, specification of 

remaining quantities). 

We recommend this procedure for items with item properties for splitting batch-tracked inventory 

(page 1048). 

You define whether or not feedback is permitted in the master data for the work area (see "Work 

areas" page 1089) (Properties) tab. 

Please note: If the check boxes on this tab are not selected, or if the work area is not assigned 

to the inventory location, no feedback is possible since the relevant lists are automatically 

acknowledged during release and their status is set to Confirmed. 

Note that the Issue list feedback function accessed by selecting Inventory > Goods issue > Issue 

list feedback is intended for sales orders, and the Issue list feedback function accessed by 

selecting Inventory > Manufacturing > Issue list feedback is intended for production orders. 

To access the Feedback for receipt lists function, you must select Inventory > Manufacturing > 

Receipt list feedback or Inventory > Goods receipt > Receipt list feedback. 
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S/B assignment 

Call 

Inventory > Manufacturing > S/B assignment 

Description 

This function allows you to assign serialized and batch IDs to the finished product . 

Alternately, you can use the S/B presetting function to have serialized and batch IDs set by default 

in the purchase order or production order. 

You use the S/B assignment object to assign serialized/batch IDs at a later point in time. For 

example, for a stored item that does not yet have a serialized/batch ID. 
 

Manufacturing provision 

Call 

Inventory > Manufacturing > Manufacturing provision 

Description 

This function allows you to calculate the actual materials required by Manufacturing for a specific 

period of time. In other words, it allows you to determine how much material is likely to be required 

at the selected work centers. 

Optimum inventory requests are created for the specified period of time, and these are then 

prepared and converted into inventory movement lists. Before the (raw) materials are provided to 

Manufacturing, the inventory movements are optimized in terms of time and quantity. The lists can 

then be processed by the relevant employees. 
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In practice 

You can use this object to open production orders that were released with the Material issue 

option cleared. 
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The Infor COM inspection functions are available in this folder. 

Call 

Inventory > Inspection 

Description 

A reconciliation between the expected and achieved results of the inspection takes places in 

Inspection. Individual steps are formulated for the inspection. The procesdure for the inspection is 

defined in the inspection plan. 

Configuration 

See Configuration (Inspection) 

Inspection 
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Inspection basics 

When a goods receipt is carried out from Purchasing or Manufacturing, an inspection is requested 

when materials received are checked. 

During the actual inspection, an inspection plan that was previously created from the available 

lines in the inspection catalog is processed. 

After the inspection, the inspection result is posted to the warehouse in terms of quantity and 

rejects. After the inspection decision has been posted via CAQ import, the original inventory is 

then available in the warehouse and can be processed further or issued. Reject quantities are 

posted to the quarantine warehouse. 

The inspection results of the individual inspection lines and the inspection decision are logged in 

the journal. 

Note: To automatically generate an inspection order for a goods receipt or manufacturing receipt 

for which inspection is mandatory, you can assign an existing inspection plan to a receipt line in 

item master data, BORs, purchase orders, and production orders. 
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Allocation tables (Inspection) 

WMSCAQCLASS 

Description: Entry class 

Usage: This table contains the four basic classes for entering information in Inspection. 

WMSCAQCLASS is used as the default setting for the entry class in WMSCAQDTYPE. 
 

WMSCAQDTYPE 

Description: Data type attributes 

Usage: This allocation table contains the data types with their attributes. It is responsible for 

controlling inspections and contains the functional parameters for default settings, form design, 

and inspection validation.  

Changes to the values in this table have an immediate effect on the input options and inspections 

in the Inspection objects. 

Input 

Data type 

This field contains the key value of the parameter record. This value is stored in the master data 

and movement data. 

Description 

This field displays the description of the data type. 

 

Inspection class 

This field allows you to assign the data type an inspection class from the WMSCAQCLASS 

allocation table. The inspection class differentiates between certain basic types of validation and 

logic.  
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Example: The Comment (9) class indicates that an inspection step cannot be entered. However, it 

can be used to display additional information. 

Threshold values 

This field allows you to specify whether thresholds are to be defined for the entry of numeric 

inspection results. You can select between absolute and relative threshold values. 

Entry form 

A separate form can be assigned for entering inspection results for each data type. This field 

allows you to specify the entry form that is to be used for the quality inspection. 

Check 

This field allows you to enter additional Lj4 check routines. 

Note: For more information, please check with your Infor consultant. 

Std. values 

You can store the design and functions for calculating threshold values on this tab. 

Standard form 

This field allows you to store a standard form for entering default values. 

 

Std. values 

This field is used for storing default values. 

 
 

WMSCAQFIX 

Description: Option can be changed 

Usage: This table allows you to specify the processing level for Inspection up to which an option 

can be changed. 
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WMSCAQGROUP 

Description: Inspection groups 

Usage: You can store inspection groups in this allocation table. Inspection groups can be stored 

in the inspection catalog when creating inspection lines. 
 

WMSCAQIDENY 

Description: Inspection types 

Usage: You can enter the reasons for rejection in this allocation table, which can be selected and 

stored during the inspection. 
 

WMSCAQIMODE 

Description: Inspection modes 

Usage: This allocation table is not currently used. 
 

WMSCAQLEVEL 

Description: Inspection levels 
 

WMSCAQLIMIT 

Description: Inspection with threshold values 
 

WMSCAQSTATE 

Description: Inspection status 

Usage: This allocation table contains the statuses of the inspection. 
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Perform inspection 

The following process shows a sample procedure for how to perform an inspection. 

To perform an inspection: 

1. Create a purchase order and print it. 

2. Select Functions > Inventory transaction and select Purchase receipt in the dialog box that 

follows. 

3. Enter the posting code 53 - Full inspection receipt on the Transaction tab. 

4. Select Functions > Post receipt and confirm the following dialog box once the external 

advance shipping notice ID has been entered. 

5. Select Manufacturing > Inspection > Inspection orders > New. 

6. Select the order ID of the created purchase order and enter the inspection plan. 

7. Click Create to confirm. 

8. On the Input tab enter the inspection results. 
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Inspection catalog 

Call 

Inventory > Inspection > Inspection catalog 

Description 

The inspection catalog is the directory for all available inspection lines. 

This desktop object allows you to enter the required steps and actions that make up the individual 

inspections within an inspection plan. 

All inspection lines that are definitely to be used in an inspection plan or an inspection order must 

be stored here. 

Create inspection line 

To create an inspection line: 

1. Select Inventory > Inspection > Inspection catalog > New. 

2. Enter the inspection line, description and inspection group and click Create. 

3. Select View > Inspection catalog overview. 

4. In the Fixing column in the Parameter tab, specify whether the parameters can still be changed 

in the subsequent processing levels Inspection plan and Inspection order. 
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Inspection plans 

Call 

Inventory > Inspection > Inspection plans 

Description 

In the inspection plan, define the inspection steps that are required for a special inspection from 

the inspection catalog in the order in which they are to be processed. 

In the inspection plan, define the behavior expected during the inspection as well as the permitted 

tolerances. 

Note: When data is transferred from the inspection catalog to the inspection plan, or from the 

inspection plan to the inspection order, it is copied. Therefore, changes to the parameter of an 

inspection plan line do not affect inspection plans that have been already created up to this point. 

In practice 

Create inspection plan 

To create an inspection plan: 

1. Select Inventory > Inspection > Inspection plans > New. 

2. Enter the inspection plan and description and click Create. 

3. On the Parameters tab enter the individual inspection steps as lines, by selecting an inspection 

line for each one in the Inspection line field. 

4. Optional: Enter additional information as autotexts in the Text ID 1 and Text ID 2 fields on the 

Texts/structure tab. 

5. Optional: Select the Extendable check box in the inspection plan header in order to be able to 

add more lines to an inspection order generated from the inspection plan. 
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Inspection orders 

Call 

Inventory > Inspection > Inspection orders 

Description 

An inspection plan is applied to a specific order in the inspection order. The inspection order 

consists of the inspection plan with the individual inspection plan steps and the receipt information, 

in particular the inspection quantities. 

The inspection order contains the specific processing of the inspection lines from the inspection 

plan as well as the evaluation of the inspection results. 

It is automatically generated on receipt, as long as an existing inspection plan is entered in the 

receipt line. Receipts that have not been assigned can be created on the "New" tab of the start 

form by assigning an inspection plan. 

In addition to the fields already known from the inspection catalog and the inspection plan, 

additional inspection order information can also be stored in the inspection order as autotexts. 

Functions 

Release inspection result: After you have processed all inspection steps, you can transfer the 

inspection results to the warehouse using this function. 

Insert new line in inspection order: With this function you can insert additional inspection lines from 

the inspection catalog into the existing inspection order, provided that the Extendable check box is 

selected in the inspection plan. 

Delete line in inspection order: You can delete lines from the inspection order using this function. 

Lines with the status Posted or Ignored cannot be deleted. 
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Delete inspection order: Select this function if you want to cancel processing of the inspection 

order and to delete the assigned inspection order. Posted partial approvals are thereby discarded 

and deleted from the journal. 

You can then create a new inspection order. 

Cancel inspection: Select this function if you want to cancel processing of the inspection order. 

With this function, the entire receipt quantity is declared as rejects and the inspection order is 

assigned the status of Canceled. 

Create inspection order 

To create an inspection order: 

Note: To save inspection results and quantities entered, select Data > Save. 

1. Select Inventory > Inspection > Inspection orders > New. 

2. Select the item ID or order ID and the inspection plan. 

3. Enter the data type for the inspection plan lines on the Input tab. 

Note: Based on the WMSCAQDTYPE allocation table, the design of the entry form and, if 

entered, the associated inspection function are defined using this field. 

4. After you have performed a detailed inspection, enter the measurement results in the entry 

form. 

5. Click Post to save the inspection result for each line. 

The line contains the status Posted. The posting is logged in the journal.  

Note: If the accepted quantity is reduced because of this posting, it will be reduced for the 

remaining lines that have yet to be posted as only this quantity has to be inspected further. 

6. Optional: Click Ignore. 

The entry for this line is not checked. The line contains the status Ignored. 

7. Optional: Click Cancel. 

This will cancel a Post or Ignore transaction. The line's status is Canceled. It can then be 

entered again. 

8. After you have processed all the inspection steps, select Functions > Release inspection 

result. 
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Journal 

Call 

Inventory > Inspection > Journal 

Description 

The results of the individual inspection steps are logged in the quality inspection journal and can 

be used for evaluation and verification. 
 

CAQ import 

Call 

Inventory > Inspection > CAQ import 

Inventory > Special functions > CAQ import 

Description 

This object is used for importing the results of internal and external inspections. 

Internal inspection 

The CAQ import transmits the result of the inspection to Inventory. The inspection result is only 

effective and visible in Inventory after the CAQ import has been carried out. 
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External inspection 

The term CAQ (Computer-Aided Quality) refers to the Infor COM component used for quality 

assurance, which is capable of interfacing with external quality management software, for 

example, Babtec). 

You can use the CAQ import object to import the updated CAQ file into the system. This 

automates the acknowledgment of inspection results. The inspection results to be imported are 

stored in an ASCII file. 

File structure 

BookingNo (characters 1-16) 

 

This field contains the CAQ ID, which is required for 

Inspection. The first character shows how the CAQ 

journal entry is identified (1 - Inventory item ID, 2 - Queue 

ID, 3 - Order line ID) 

TestResult (character 17) This field contains the result of the inspection (if identified 

via Queue ID) 

QAOrderNo (characters 18-37) This field contains the ID of the order. 

GoodQuantity (characters 38-48) This field contains the quantity of items of adequate 

quality. 

BadQuantity (characters 49-59) This field contains the quantity of items of inadequate 

quality. 

CR-LF (characters 60-61)  

 

In addition to the function provided in Infor COM for exporting to CAQ systems (also see the 

Inspection ID section in the master data), the CAQ import object provides an interface for 

importing the files containing the acknowledged inspection results. This is done directly or as a 

time-controlled process. 

The inspection results or transferred quantities are used to make the corresponding status 

changes in Inventory, for example, postings from the inspection warehouse to the standard 

warehouse in Purchasing. 

Three files are required for CAQ import: 

ixcCAQImport: This file is used for importing data from the CAQ application. 

ixcCAQPPC: This file is used for exporting postings carried out in Manufacturing. 

ixcCAQPurch: This file is used for exporting postings made in Purchasing. 
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Technical note: The records exported to CAQ are stored in the relWMSCAQJournal database 

table. The records imported from third-party quality assurance applications are stored in the 

relCAQImport database table. The viwCAQExport view contains the records that can be exported 

from CAQ. 

Configuration 

See Configuration (Inspection) 

In practice 

Messages relating to the CAQ import object are stored in mailbox 30. 
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At the end of the financial year, you need to carry out an inventory count in order to balance your 

warehouse inventory. The actual inventory of the items is calculated during this process. 

Depending on the country and applicable legislation, different types of inventory count are 

permitted. 

The following table provides an overview of the most important inventory count types. 

Please note: The extent to which an inventory count type is permitted - and the specific 

restrictions that apply - is regulated by the tax law and commercial law of the specific country (for 

example, US commercial law, or the German commercial code (HGB)). 

 

Inventory count 
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Cut-off date inventory count This involves the manual recording of the actual inventory on a certain 

cut-off date (or over a legally approved period of time starting from a 

cut-off date) and entering this data in inventory count (see "Inventory 

count lists" page 1178) lists. 

Perpetual inventory count With a perpetual inventory count, the inventory can be recorded over 

the entire year and therefore replace the inventory count submitted on a 

specific annual inventory cut-off date. 

You can configure this function in Infor COM using the 

COMMON.WMS.PERMANENTINVENTORY and 

COMMON.WMS.INVENTORYOFFSETDAYS parameters. The 

COMMON.WMS.PERMANENTINVENTORYJOURNAL parameter is 

used for configuring the log settings. When creating an inventory count 

list, you can select the Perpetual inventory count option. 

Note: You can use the WMSPINVCFG allocation table to specify the 

perpetual inventory count type for each individual posting ID. 

Random inventory count A random inventory count is an inventory count optimization method 

used for calculating the inventory on the basis of a statistical and 

mathematical procedure. It generally involves counting the inventory for 

the individual items and then projecting the calculated values for the 

entire inventory. 

To help you with this, Infor COM allows you to export a random 

inventory count list. 
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Inventory count lists 

Call 

Inventory > Inventory count > Inventory count lists 

Description 

Inventory count lists form the organizational basis for inventory counts (see "Inventory count" page 

1176) in Infor COM. 

In Infor COM, inventory counts can be managed on the basis of inventory locations or items. You 

can decide which method you want to use when creating the inventory count list. 

For an inventory count based on inventory location, the inventory count list will include all 

batch-tracked inventory found at the selected inventory area or inventory location. 

For an inventory count based on items, the list will include the selected items. 

Generate and print inventory count list 

To allow the inventory count employees to start manually recording the counted quantities, you 

need to print the inventory count list or sublists. The inventory count list must be printed before the 

inventory count starts. 

1. Select Inventory > Inventory count > Inventory count lists. 

2. On the New tab, enter the data required to generate the inventory count list and click Create. 

The list is assigned the status Created. 

 The statuses of the inventory count lists are maintained in the WMSINVST (page 1019) 

allocation table. 

3. Select Functions > Print inventory count list. 

4. On the following dialog box, you can specify the number of copies , and whether you want the 

attributes or planned quantities to be included on the list. Then click OK to confirm. 

The list is assigned the status Printed. 

Note: You can reprint the list at any time by selecting Functions > Print inventory count list. 
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Start inventory count 

To start entering the counted quantities in the system, you need to start the inventory count. 

1. Select Inventory > Inventory count > Inventory count lists. On the Open tab, enter the required 

data and click OK. 

2. Select Functions > Start inventory count. 

Once the inventory count has been started, the Actual qty and Difference fields on the 

inventory count list are activated. The relevant items cannot be accessed by any processes in 

Infor COM for the duration of the inventory count. 

The list is assigned the status Started. 
 

Edit item properties for splitting batch-tracked inventory 

To edit item properties for splitting batch-tracked inventory: 

1. Select Inventory > Inventory count > Inventory count lists. 

2. On the New tab, select Item as the inventory count type. Enter the data required to generate 

the inventory count list, select the Split flag chg check box, and clickCreate. 

3. Select Functions > Start inventory count, then click  OK to confirm the following Print dialog 

box. 

The dialog box for selecting/clearing item properties for splitting batch-tracked inventory is 

displayed. 

If there are properties selected here, you must enter the corresponding values before posting 

the list. 
 

Cancel inventory count list 

You can cancel inventory count lists with the status Started. 

1. Select Inventory > Inventory count > Inventory count lists. On the Open tab, select Started as 

the  inventory count status, enter the data for the required list, and click Load. 
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2. Select Functions > Cancel inventory count list. 

The list is assigned the inventory count status Cancelled. 
 

Record and post counted quantities and print variance report 

Once the inventory count has started, the inventory count list or sublists, if generated, are provided 

for entering the quantities counted during the inventory count. 

1. Select Inventory > Inventory count > Inventory count lists. On the Open tab, select Started as 

the  inventory count status, enter the data for the required list, and click Load. 

2. On the Quantities tab, enter the counted quantity per line in the Actual qty field, or enter the 

difference between the counted quantity and the planned quantity in the  Difference field. The 

corresponding field is then updated automatically. 

If the counted quantity matches the planned quantity, you can manually select the Pos. field. 

The planned quantity is then entered automatically in the Actual qty field. 

 

Note: Use a negative sign to enter a negative difference. 

When you exit this field, the Pos. check box is activated automatically. 

 

Please note:  If the planned quantity in a line is 0, you cannot enter an actual quantity. To 

enter an actual quantity for such lines, select Functions > Enter new inventory. 

 

Note:  To select or clear the Pos. check box in all rows at the same time, right-click the 

column header and select the required command from the context menu that is displayed. 

3. Select Functions > Post. 

The system only posts lines for which the Pos. check box is not selected. 

The inventory count freeze for the relevant items is canceled once the inventory count list has 

been posted. 

Once the inventory count list has been fully posted, it is assigned the status Posted. 

4. If there are differences between the planned quantity and the counted quantity, you can print 

the inventory count variance report after the posting by selecting Functions > Print variance 

report. 
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5. To close the inventory count list after posting, select Functions > Close. 

The list is assigned the inventory count status Closed. 
 

Enter new inventory 

Once the status of an inventory count list is Started, the Enter new inventory function will be 

available for selection in the inventory count list. 

Note: You must use this function to enter inventory for lines for which the planned inventory is 0. 

1. Select Inventory > Inventory count > Inventory count lists. On the Open tab, select Started as 

the  inventory count status, enter the data for the required list, and click Load. 

2. Select Functions > Enter new inventory. 

Open the Inventory adjustment (page 1188) object where you can enter new batch-tracked 

inventory. This batch-tracked inventory will then be added to the inventory count list as 

additional lines These lines will have a planned quantity of 0 and are flagged by a selected 

New line check box. 

Note: You can also enter new inventory if the status of the inventory count list is  Posted. In 

this case, its status was set to Partially posted. It therefore needs to be posted again by 

selecting Functions > Post. 
 

Adjust posting record 

To adjust posting records in the inventory count lists: 

1. Select Inventory > Inventory count > Inventory count lists. On the Open tab, select 

Posted/Partially posted as the inventory count status, enter the data for the required list, and 

click Load. 

2. To adjust a posting record, highlight the line to be adjusted and select Functions > Correct 

posting record. 

The Actual qty and Difference fields become available for editing again and the status of the 

list is set to Partially posted. 
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3. Enter the quantity required to adjust the posting in either of the two fields and then select 

Functions > Post. 

The status is set to Posted again. 
 

Export random inventory count list 

During a random inventory count, randomly selected company inventory, which is representative 

of the total inventory, is physically counted on a certain cut-off date. An inventory count and a 

difference posting is carried out for the elements of the random count. If the differences between 

the count and the book inventory are sufficiently small, it is assumed that the book inventories for 

inventory that has not been entered are correct. 

You can use a random inventory count to export the data contained in an inventory count list to a 

file. 

1. Open or generate the inventory count list (see "Inventory count lists" page 1178). 

2. Select Functions >Random inventory count. 

3. In the File path field, enter a file name and click OK. 

Note: Click the File path button to save the file to a different location (Default path: Infor COM 

system directory). 

The file name and path are set by default in the configuration using the 

COMMON.WMS.INVENTORYSPOTCHECKPATH parameter. 

You can then use a spreadsheet program such as Microsoft  Excel to edit the file that is 

generated. In this case, you can export the data to a file with a csv (comma-separated value) 

extension. 
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The objects in this Inventory folder are exclusively used for providing information. 
 

Inventory information 

Call 

Inventory > Special functions > Inventory information 

Description 

The Inventory information object provides detailed information about the inventory in the 

warehouse. 

Functions 

Expand level/Collapse level: You use this function to display/hide the details for the current level. 

Expand all/Collapse all: You use this function to display/hide the details for the entire item 

inventory. 

In practice 

The same form with additional adjustment options is available in the Inventory adjustment (page 

1188) object. 
 

Location capacity information 

The Location capacity information object (Inventory > Information) provides information about the 

current capacity of an inventory location. 

Information 
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On the Open tab, select the required inventory locations. You can restrict your selection to a 

specific warehouse address (page 1052), to specific inventory areas, or even to specific X, Y, and 

Z coordinates. 

If you do not enter any selection criteria, all inventory locations are loaded. 

The view on which the data is displayed consists of an upper table and a lower table. 

 Once loaded, the first level of the upper table displays the inventory areas in alphabetical order 

only. The data is not structured according to warehouse address. Inventory areas without 

inventory locations are not loaded. 

 The inventory areas are collapsed initially, which is indicated by the plus sign in front of each 

inventory area. To expand an inventory area, click the plus sign or select the row and press CTRL 

+ F3. The inventory locations in this inventory area can now be viewed on the second level. To 

expand all inventory areas, select Functions > Expand all or press F3. 

The data in the upper table is displayed on the Inventory location and Prohibit movements tabs. 

When you select a row in an inventory location, the batch-tracked inventory stored for this row is 

displayed in the lower table, provided it is not empty. The batch-tracked inventory symbols are 

used as follows: 

 Numbering method 1607 is used to assign IDs for the batch-tracked inventory of an item. 

Method 1621 is used for the batch-tracked inventory of tools. 

 The batch-tracked inventory is in the process of being moved from this inventory location to 

another inventory location. 

The data in the lower table is displayed on the Batch-tracked inventory, Properties, External 

properties, and Dimensions tab. 

 
 

Inventory journal 

Call 

Inventory > Information > Inventory journal 
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Description 

The Inventory journal object is used for storing journal information about inventory actions and 

inventory movements 

All of the actions performed in the Inventory module are saved in the Inventory journal. For 

information on how to valuate inventory processes, see Inventory value journal. 

Note: The postings are displayed in descending chronological order. 

Functions 

Archive:The Inventory journal offers an archiving function that transfers journal lines to an archive 

table. This allows you to speed up access to the inventory journal. 

 

In practice 

Reasons why archiving may not complete successfully: 

The system cannot archive any lines found in the specified period for which the corresponding 

consumption transaction or receipt to the supplier consignment warehouse has not yet been 

completed. Neither can it archive lines for which the purchase receipt has not yet been calculated, 

or lines that have not been closed fully (i.e. they have a status other than Closed, Manually closed, 

or Invoice printed). 

Problems are logged in mailbox 52. 
 

Item tracing 

Call 

Inventory > Information > Item tracing 



1186 | Infor COM 7.5 User Guide 

 

Inventory 

 

Description 

Because of complex supply chains or legal regulations, customers often want to be able to 

transparently trace a specific item flow within their company. 

The Item tracking object provides information about the composition of batch-tracked inventory, 

and indicates which raw materials are used in which finished products. 

The main task of the Item tracing object is to enable the tracking of serialized and batch IDs (see 

"Serialized/batch management" page 1066). This function allows you to determine when and 

where a goods receipt was carried out, where a unit was stored, and the company that it was sold 

to. 
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The Special functions folder in the Inventory module contains the following objects: 

 

Special functions 
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Inventory adjustment 

Call 

Inventory > Special functions > Inventory adjustment 

Description 

You can use the Inventory adjustment object to make miscellaneous inventory adjustment 

postings in the Inventory or Customer consignment warehouse (page 1069) modules. 

Miscellaneous postings are postings that do not result from sales orders, production orders, or 

purchase orders. 

Otherwise, the Inventory adjustment object provides the same information as the Inventory 

information (page 1183) object. 

Possible adjustments: 

 Miscellaneous quantity postings to existing batch-tracked inventory (posting ID 191). 

 Miscellaneous entry of new batch-tracked inventory in regular warehouses (posting ID 191) 

and customer consignment warehouses (posting ID 191) by selecting New inventory > Enter 

new inventory. 

 Miscellaneous entry of new batch-tracked inventory in supplier consignment warehouses 

(posting ID 196) by selecting New inventory > Enter supplier consignment inventory. 

 Miscellaneous quantity issue postings of existing batch-tracked inventory (posting ID 192). 

 Adjustments to quantities of existing batch-tracked inventory (posting ID 194). 

 Adjustments to properties of existing batch-tracked inventory (posting ID 103). 

Functions 

New inventory: You can use this function to add new batch-tracked inventory. 

Set posting ID (Inventory adjustment overview): You can use this function to set the posting ID by 

selecting it from the menu. 

Post: You use this function to carry out the posting. 
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In practice 

You can also access the Inventory adjustment function by selecting the Enter new inventory 

function in the Inventory count lists (page 1178) object. 
 

Enter new inventory 

You can use the Inventory adjustment (page 1188) object (Inventory > Special functions) to enter 

new batch-tracked inventory for regular warehouses as well as for customer and supplier 

consignment warehouses in the form of miscellaneous postings. 

This type of batch-tracked inventory entry is called miscellaneous because it does not result from 

purchase orders in Purchasing or from production orders in Manufacturing. 

Note: You can also use posting IDs191 Miscellaneous receipt and 192 Miscellaneous issue in the 

Inventory adjustment object to make miscellaneous receipt and issue postings to and from existing 

batch-tracked inventory. 

To enter new inventory, complete the fol lowing step s: 

1. In Inventory, select the Special functions folder and click Inventory adjustment. The start form 

opens. 

2. Enter the data required to select the relevant item and click Load to confirm your entries. 

3. If you want to post the batch-tracked inventory to a regular warehouse or to a customer 

consignment warehouse, select Functions > New inventory > Enter inventory. Alternatively, if 

you want to post the batch-tracked inventory to a supplier consignment warehouse, select 

Functions > New inventory > Enter supplier consignment inventory. In both cases, the New 

inventory overview is displayed. 

4. Enter a cost center and/or cost unit in the form header. If necessary, change the value in the 

Price source field and check the preset inventory location coordinates. If you are posting to a 

supplier consignment warehouse, make sure the correct supplier is entered in the Co. ID field. 

5. In the Quantity field on any of the available tabs, enter the quantity of the new batch-tracked 

inventory. 
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Note: If the Residual size mgt function is selected for the items involved, and the 

corresponding inventory unit is a length, area, or volume unit, the quantity must match the 

residual size management result or a whole multiple of this. 

6. Enter the remaining data for the item.  

7. Select Functions > Post to display the Inventory adjustment overview. Posting ID 191 

Miscellaneous receipt is set automatically on the Quantity change tab here. 

8. Select Functions > Post again. 
 

Split batch-tracked inventory for Residual size management items 

For basic information on the Residual size mgt function, click here (see "Size and residual size 

management" page 437). 

The following overview describes how batch-tracked inventory for items managed by the Residual 

size mgt function is split into batch-tracked inventory based on the required number and/or length. 

1. In Inventory, select the Special  functions  folder and click the Inventory adjustment  

object. 

2. On the start form that is displayed, enter the data required to select the relevant item and 

select the Open overview check box. 

3. Click Load. 

4. Select the Dimensions tab. 

5. Determine which of the displayed batch-tracked inventory is available in the required number 

and length and can therefore be used as the source for the split. 

6. Select the Quantity change tab. In the PID field for this batch-tracked inventory, select posting 

ID 118 Spilt from (+LWH change). 

7. If the selected source batch-tracked inventory is already available in the required number, 

continue from step 10. 

If this is not the case, batch-tracked inventory corresponding to the required number must 

be split from the selected source batch-tracked inventory. To do this, complete the 

following steps: 

 Enter the required number in the Number field for the source batch-tracked inventory. 
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 A message displays asking if you are sure you want to repost the batch-tracked inventory. 

Click OK to confirm. 

 New batch-tracked inventory is then generated in the following line based on the number 

you just specified. The 111 Split to posting ID is automatically set in the PID field for this 

new batch-tracked inventory. The number in the source batch-tracked inventory line is 

reduced accordingly. 

 Select Functions > Post to carry out the posting. 

 In the PID field for the new batch-tracked inventory, enter posting ID 118 Split from (+LWH 
change). Then continue from step 8. 

8. Overwrite the value in the Length field with the required length.  

Note: You cannot enter a length that is longer than the original.   

9. When you exit the Length field, a message asks if you are sure you want to repost the 

batch-tracked inventory. Click OK to confirm. 

10. New batch-tracked inventory is then generated in the following line based on the length you 

just specified. The 111 Split to posting ID is automatically set in the PID field for this new 

batch-tracked inventory. The length in the source batch-tracked inventory line is reduced 

accordingly. 

11. Select Functions > Post to carry out the posting. 

You have now generated new batch-tracked inventory in the required number and length. This 

batch-tracked inventory is now available for issue for sales orders and production orders. 
 

Inspection 

Call 

Inventory > Special functions > Inspection 

Description 

Apart from the Purchasing inspection (page 1108) and Manufacturing inspection (page 1154) 

objects, the Inspection object in the Special functions folder also allows you to edit the inspection 

status of batch-tracked item inventory and batch-tracked tool inventory. 
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Whereas the Purchasing inspect and Manufacturing inspection  objects only allow you to edit the 

inspection status of batch-tracked inventory in direct connection with the associated purchase 

orders and production orders, the  Inspection object allows you to edit the inspection status 

independently of orders. This means that you can change the status at any time. It is also useful 

for batch-tracked inventory that was generated miscellaneously in the Inventory adjustment (page 

1188) object. 

For example, you can use this object to set or cancel an inspection, or move inventory. 

Note that batch-tracked inventory whose inspection status in the Purchasing inspection and 

Manufacturing inspection objects is Order not inspected cannot be loaded in the Inspection object. 

A posting must be made for this batch-tracked inventory in these objects before they can be 

loaded in the  Inspection object. 

For a more detailed explanation of the posting IDs used to post batch-tracked inventory in the 

various inspection statuses, see Inventory posting IDs (page 1053). To view the posting IDs that 

are available in Inspection only, refer to the Inspection entry in the Object column of the table 

included in this Help topic. 

Configuration 

The Help topic for the WMSQAST allocation table describes the inspection statuses that can be 

assigned to batch-tracked inventory in the Inspection object. 
 

Load batch-tracked inventory in Inspection 

The following overview explains how to load batch-tracked inventory in the Purchasing inspection, 

Manufacturing inspection, and Inspection objects in order to edit its inspection status: 

1. Depending on the object in which you want to load batch-tracked inventory, select: 

Goods receipt > Purchasing inspection 

Manufacturing > Manufacturing inspection 

Special functions > Inspection. 

2. Select the batch-tracked inventory you want to load on the Open tab and click Load. 

You can use the Order rejects to Not man. inspected check boxes to restrict your selection 

to batch-tracked inventory with this particular inspection status. 
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3. Optional: Use the Inspection object to load Tools from the Tool tab. There you can select by 

batch-tracked inventory of a particular tool group or even of a particular tool. 
 

Edit inspection status in Inspection 

To repost the inspection status of a batch-tracked inventory in the Purchasing inspection, 

Manufacturing inspection, and Inspection objects: 

Note: For step-by-step instructions on how to perform item conversions (posting IDs 87/88 and 

91/92) in the Manufacturing inspection and Inspection objects, click here (see "Convert item in 

Inspection" page 1194). 

For step-by step instructions on how to load the required batch-tracked inventory in the 

Purchasing inspection, Manufacturing inspection, and Inspection objects (Special functions 

folder), click here (see "Load batch-tracked inventory in Inspection" page 1192). 

1. Load the batch-tracked inventory. 

2. Click the Inspection tab. 

3. Set the required posting ID in the PID field. 

Note:  Only posting IDs that can be set for the current inspection status of the 

batch-tracked inventory (see Original inspection status field) are available for selection. 

4. Select the field PostQty. 

Note:  When you exit the PID field, the PstInspStat field displays the inspection status 

assigned by the selected posting ID. 

5. In the PostQty field, enter the quantity that you want to post and then exit the field. 

6. Your next step depends on whether you entered the total quantity or just a partial quantity of 

the batch-tracked inventory for posting: 

 If you have entered the full batch-tracked inventory quantity for posting, select Functions > 

Post. 

 If you only entered a partial quantity, the system must first split off new batch-tracked 

inventory corresponding to this partial quantity from the original batch-tracked inventory. A 

message is therefore displayed asking if you want to repost the batch-tracked inventory. 

Click Yes to confirm. The system splits off a new batch-tracked inventory record 

corresponding to the posting quantity and inserts it below the original record. Select 

Functions > Post. 

Notes: 
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For information on how to cancel this reposting, see the notes under Return posting at the 

end of this Help topic. 

If you select posting ID 93 Lock tool, you cannot make partial quantity postings. 

Result :  The new inspection status of the relevant batch-tracked inventory is now 

displayed in the Or. ins. stat. and PstInspStat fields. If the batch-tracked inventory was 

split, the OI check box is automatically selected to flag the original batch-tracked inventory, 

and the SP.I  check box is selected to flag the split inventory. The quantity (see Orig. qty. 

field) of the original batch-tracked inventory is reduced by the amount of the reposted 

quantity. 
 

Carry out return posting 

To cancel a split resulting from a partial quantity posting (see step 5), proceed as follows: 

1. In the PID field for the relevant split inventory, set the posting ID to 0 Empty and then exit the 

field. 

2. A message asks if you really want to repost the batch-tracked inventory. Click Yes to confirm. 

This deletes the split inventory. 
 

Convert item in Inspection 

With a conversion, you can convert batch-tracked inventory (full quantities or partial quantities) for 

an item or tool into batch-tracked inventory for another item or tool. To do this, the inspection 

status of the corresponding  batch-tracked inventory must be Order quarantined or Manually 

quarantined. 

To perform an item conversion in Inspection (page 1191) and Manufacturing inspection (page 

1154), complete the steps below. These instructions (see "Load batch-tracked inventory in 

Inspection" page 1192) explain how the batch-tracked inventory is loaded. 

Note: This information also applies to the conversion of batch-tracked tool inventory. 

1. Load the required batch-tracked inventory. 

2. Select the Inspection tab in the Overview view. 
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3. If you are in the Inspection object, go to the row of the corresponding batch-tracked inventory. 

From the combo box in the PID field, select posting ID 91. In the Manufacturing inspection 

object, select posting ID 87. 

You can also set posting IDs by selecting Functions > Set posting ID. The selected posting 

ID is then set in all of the loaded batch-tracked inventory records that are suitable for this 

type of posting. 

4. Go to the Posting qty field using either the TAB key or the RIGHT ARROW key. 

5. Enter the quantity that you want to post. 

6. Exit the Posting qty field: 

 If you entered the full batch-tracked inventory quantity (see Orig. qty. field), the system 

opens the New inventory overview in the Inventory adjustment object. 

 If you entered a partial quantity only, the system must first split off new batch-tracked 

inventory corresponding to this partial quantity from the original batch-tracked inventory. A 

message therefore asks if you want to repost the batch-tracked inventory. Click Yes to 

confirm. The system opens the New inventory overview in the Inventory adjustment object. 

7. In the Item ID field on the form header, select the ID of the item or tool that is the target of the 

conversion. 

8. Enter a value in the Cost center or Cost unit fields. 

9. Enter the quantity for the new batch-tracked inventory in the Quantity field of the table. You 

can enter a higher or lower quantity than the original posting quantity. 

10. If you still need to enter properties for the new batch-tracked inventory, enter them on the 

Dimensions, Weight/volume, and/or Tool tabs. 

11. Select Functions > Post. 

The Inspection tab displays the following information: 

 If you converted the full quantity of a batch-tracked inventory, its CI (converted inventory) 

check box is selected. It is also assigned posting ID 91 or 87. The corresponding 

PstInspStat field displays the status Scrapped, since the batch-tracked inventory was 

scrapped after the final posting. The CI check box is selected to flag the new batch-tracked 

inventory resulting from the conversion. Its inspection status is No inspection. Posting ID 

92 or 88 was automatically assigned to the batch-tracked inventory for the final posting. 
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 If you only reposted a partial quantity of the batch-tracked inventory for conversion, the 

system first split off a new batch-tracked inventory corresponding to this partial quantity. 

The OI (original inventory) check box is selected to indicate the original inventory and its 

original quantity is reduced by the partial quantity. The SP.I (split inventory) and CI check 

boxes are selected to flag the split partial quantity, which is now assigned posting ID 91 or 

87. Its inspection status is Scrapped, since it was scrapped during the final posting that 

converted it to a new batch-tracked inventory. The inspection status of the batch-tracked 

inventory resulting from the conversion is No inspection, and it is automatically assigned 

posting ID 92 or 88 for the final posting to new inventory. 

12. Select Functions > Post. The batch-tracked inventory with the inspection status Scrapped is 

deleted from the table. 
 

Warehouse inventory by expiration date 

Call 

Inventory > Special functions > Expiration date list 

Description 

You use this object to create lists of item inventory whose expiration dates have already passed. 

The evaluation is carried out for all items for which the inventory flag Mandatory expiration date 

has been set. The expiration date is either entered when the item is received, or calculated based 

on the Deadline - Days value stored on the Inventory flags tab for the item. 
 

Reports (Inventory) 

For general information on using reports, see the step-by-step instructions in Print reports. 

Please note: Report names are always structured as follows: ir<module><report name>. For 

more information on the reports not found in this Help topic, see the Help topics for the reports for 

the modules concerned. 

The following reports are provided in the standard version of Infor COM Inventory: 

Note: You can influence the displayed lists by assigning user privileges. 
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Report Contents 

ABC projection See Reports (Finance) 

Batch-tracked inventory 

list 

Lists the current batch-tracked inventory. You can restrict your selection 

to batch-tracked inventory for items in a specific ID range and/or that 

have specific warehouse coordinates. 

Consumption 

transaction 

For information on this report, see Consumption transaction (page 

1144). 

Inventory count 

valuation with item 

totals 

See Reports (Finance) 

Item/location class 

cross reference table 

Lists the current item/location class assignments with the corresponding 

priority and maximum permitted inventory quantity. You can restrict your 

selection to items and/or location types within a specific ID range. For 

more information on this table, see Item/location class (page 1101). 

Labels for 

batch-tracked inventory 

Generates labels for batch-tracked inventory. You can restrict your 

selection to specific batch-tracked inventory, to the batch-tracked 

inventory for an item ID range, or to the batch-tracked inventory in 

inventory locations with a specific coordinate range. 

Labels for inventory 

locations 

Generates labels for inventory locations. You can restrict your selection 

to a range of inventory location coordinates (from-to). 

Revaluation history For information on this report, see Revaluation history. 

Warehouse inventory 

by expiration date 

Lists the inventory for items whose expiration date has passed. You can 

restrict your selection to inventory for a specific item and/or to inventory 

in specific inventory areas. 
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Dummy inventory 

Call 

Inventory > Special functions > Dummy inventory 

Description 

The Sales and Manufacturing modules in Infor COM allow you to make the necessary inventory 

issue postings for processing sales orders and productions orders even when there is no inventory 

available. This is done by generating dummy inventory for the missing items when covering 

requirements. The corresponding Dummy inventory check box is selected on the Inventory flags 

tab in the item master. If the A.DI check box is also selected here when creating documents, the 

required dummy inventory will be generated automatically by the system if you selected the ASN 

with issue option in the sales order, or the Material issue check box in the production order when 

releasing the production order. 

 It is not possible to automatically generate dummy inventory for items with properties for splitting 

batch-tracked inventory (see "Item properties for splitting batch-tracked inventory" page 1048). 

The A.DI check box is dimmed in this case. You therefore need to generate the dummy inventory 

for these items manually. 

Dummy inventory in Sales: If automatic dummy inventory generation is selected for an item, 

you can process the sales orders in the same way as you would normally. 

If automatic dummy inventory generation is not selected for an item (and the item has no 

inventory), you cannot print the advance shipping notice (ASN option), or print the advance 

shipping notice with simultaneous inventory issue (ASN with issue) option. In this case, you must 

use the Pick list option to print the pick list first. You can then open the Sales issue object (in the 

Goods issue folder) to manually generate the dummy inventory (see "Manually generate dummy 

inventory" page 1199) and then carry out the inventory issue posting. 
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Dummy inventory in Manufacturing: If automatic dummy inventory generation is selected 

for an item (material), you can process production orders in the same way as you would normally. 

If automatic dummy inventory generation is not selected for an item , you cannot release the order 

(Release option) and carry out a simultaneous material issue (Material issue option). In this case, 

you need to release the order without a material issue, and then use the Inventory transactions 

object (in the  Manufacturing folder) to manually generate the dummy inventory (see "Manually 

generate dummy inventory" page 1199) and then carry out the issue posting. 

Configuration 

COMMON.WMS.STRICTEDAUTORESOLVEISTOCK 

In practice 

The Inventory information object shows the dummy inventory quantities of an item that were 

generated both manually and automatically as an assigned quantity with a negative sign. 

Manually generate dummy inventory (page 1199) 

Resolve dummy inventory (page 1200) 

Resolve dummy inventory automatically (page 1202) 
 

Manually generate dummy inventory 

If you cannot, or do not want to, generate dummy inventory (page 1198) automatically, you need 

to generate it manually. 

1. Select one of the methods below: 

 For sales orders, select Inventory > Goods issue > Sales issue 

 For production orders, select Inventory > Inventory transactions >  Manufacturing 

2. Select the order ID of the relevant customer or production order and click Load. 

3. In the relevant line, set the posting ID for full inventory issue or partial inventory issue. 

4. Enter the required issue quantity in the Trans. qty field. 

Note: If physical batch-tracked inventory exists, the transaction quantity is preset 

automatically when you exit the PID field. 
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5. Click OK to confirm the following message. 

6. Select the Manual specification check box. 

7. Make sure you have selected the line. For a sales order, go to the ASN line view. For a 

production order, go to the Order line view. 

Please note: Any physical batch-tracked inventory that exists for the item will be 

displayed here. The transaction quantity is noted in the Spec. qty. field for the first 

batch-tracked inventory. If you still want to generate dummy batch-tracked inventory, set 

the quantity in this field back to 0. Otherwise, the quantity is posted from this batch-tracked 

inventory and the dummy batch-tracked inventory is canceled. 

8. Select Functions > Advance entry of batch-tracked inventory. 

9. Specify the required quantity in the Quantity field on the relevant tab of the  New inventory 

dialog box that is displayed. 

Enter the required specifications on the Properties tab, Dimensions tab, Weight\volume, 

and/or Tool tab, if applicable. 

10. Click OK. 

The dummy batch-tracked inventory that was just generated is displayed with the previously 

specified quantity. 

11. Select View > ASN or Order. 

The dummy inventory is generated. 

12. To carry out the issue posting, select Functions >Post. 

Addit ional  steps:  As soon as physical inventory becomes available, you can reconcile (see 

"Resolve dummy inventory" page 1200) it against the dummy inventory. 
 

Resolve dummy inventory 

As soon as at least one physical batch-tracked inventory becomes available as a result of a 

receipt, you can resolve the generated  dummy batch-tracked inventory (see "Dummy inventory" 

page 1198). If several physical batch-tracked inventories were required to resolve the dummy 

batch-tracked inventory, they are merged first into one common batch-tracked inventory when the 

dummy batch-tracked inventory is resolved. All references to the dummy batch-tracked inventory 

are transferred to this common batch-tracked inventory. 
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Note: The process of resolving dummy inventory depends on the Value flow model that you have 

selected. For more information, see the following notes: 

Unlike with Value flow model 0, you must also specify the inventory journal records to be used for 

resolving dummy inventory if you are using a Value flow model that is greater than 0. With these 

models, you also have the option of reloading the receipt records from the inventory journal that 

are dated before the receipt record of the dummy inventory to be resolved. If you specify this type 

of inventory journal record when resolving dummy inventory, it will be assigned its receipt date. 

However, if you are using Value flow model 0, you can only resolve dummy inventory using 

receipts that are carried out after the receipt of the dummy inventory. In this case, the relevant 

inventory journal records are assigned the date of the inventory journal record for the receipt of the 

batch-tracked inventory that was resolved. 

For all Value flow models, the inventory journal record for the receipt of the dummy batch-tracked 

inventory is deleted once the dummy inventory has been resolved. 

1. Select Inventory > Special functions > Dummy inventory. On the  Open tab, enter the data 

required to select the relevant dummy inventory. 

2. Click Load to open the Dummy inventory overview. 

The overview is divided into two parts. The upper table displays the dummy batch-tracked 

inventory, and the lower table displays the physical batch-tracked inventory available for 

resolving this dummy inventory. 

Please note:  The data displayed in the lower tab is determined by where you have your 

cursor in the upper table. 

3. On the Dummy inventory tab, select the dummy batch-tracked inventory row that you would 

like to resolve. 

4. Select a specific batch-tracked inventory from the lower tab, and enter the resolve quantity in 

its corresponding Spec. qty field. 

If the quantity of this physical batch-tracked inventory is not sufficient to resolve the dummy 

inventory, take the missing quantity from at least one other physical batch-tracked inventory. 

The Remaining quantity field for the dummy inventory shows the quantity that is still required 

in order to fully resolve the dummy batch-tracked inventory. 
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As soon as you have entered a sufficient quantity to resolve the dummy inventory, the 

Resolved check box in the corresponding row is selected and the quantity in the 

Remaining quantity field is set to 0. 

Note: If you are working with Value flow model 0, continue from step 8. 

The Inventory journal tab displays the inventory journal records for the receipts. 

Note: This tab will not be available for selection until the exact resolve quantity that is 

required has been specified in the Quantities tab. 

If necessary, you can select Functions > Reload inventory journal records to reload the 

inventory journal records of receipts that are dated before the date of the receipt record for 

the dummy inventory to be resolved. 

5. To resolve the dummy inventory, save your data or select Functions > Resolve. 

On the Quantity tab, you can see that each resolved dummy inventory and each associated 

physical batch-tracked inventory that has been used in full has been deleted from the 

respective tables. Partial batch-tracked inventory whose full available quantities were not 

required when resolving the dummy inventory are split into smaller batch-tracked inventory 

corresponding to the specified resolve quantity and are also deleted from the table. The table 

now contains the original batch-tracked inventory whose available quantity has been reduced 

accordingly, provided there is further dummy inventory yet to be resolved. 

Please note:  If you save your data before the required resolve quantity has been 

reached, i.e. if the remaining quantity of the dummy inventory to be resolved has not yet 

reached 0.00, the dummy inventory will be split again. This split batch-tracked inventory is 

entered at the top of the table and reserved. This is confirmed by the status Dummy 

reservation (appears reserved). The Source BTI field displays the ID of the original 

batch-tracked inventory from which the split batch-tracked inventory originated. 
 

Resolve dummy inventory automatically 

The following Help topic describes how dummy inventory (page 1198) is resolved automatically. 

This function resolves the dummy inventory using inventory that has the same attributes (batch ID, 

serialized ID, for example) and is located at the same warehouse locations that meet the 

conditions specified in the order (address ID, source area, coordinate specification precision). 

1. Select System functions > Administration > Batch control. 
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2. Enter the required data on the Status tab. 

3. Select the Action tab and enter wms.autoresolveistock.al_do in the Action field. 

4. Save your entries. 

The Accepted check box on theStatus tab is selected. 
 

Cancel old orders 

Call 

Inventory > Special functions > Cancel old orders 

Description 

This object allows you to prepare orders from the previous version of the Inventory module for 

cancellation. 

This preparation is not carried out during the actual conversion itself for time constraint reasons. 

In practice 

Please note: It only makes sense to use this function if you have already migrated the inventory 

structure from the Inventory module in Infor COM Release 6.1 or earlier releases to WMS 

inventory areas and inventory locations, and the existing master data, inventory, and orders have 

been prepared and converted for further processing in WMS. 
 

Archive inventory journal 

Call 

Inventory > Special functions > Archive inventory journal 
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Description 

This function allows you to archive selected lines from the inventory journal. 

Note: Regular archiving improves performance. 
 

Print BT inventory labels 

Call 

Inventory > Special functions > Print BT inventory labels 

Purpose 

This function allows you to print batch-tracked inventory labels that were entered via receipts (as a 

result of splitting or merging, for example). 

In practice 

You use the WMSSILBLCFG allocation table to define which labels can be printed by this function. 
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Please note: The functions available in the Packaging folder of the Inventory module must be 

licensed separately. 
 

Packaging basics 

The options available here for handling packaging overlap with those found in the Sales module. 

For example, you can predefine load units, and also create and reserve prepacked goods in 

Inventory. This means that packaging can be processed as soon as a production order is closed, 

for example. 

The Packaging module provides the following key functions for Inventory and Automotive: 

Information on Packaging information (page 1206), Inventory information (page 1183), and 

Inventory adjustment (page 1188).  

The Packaging information object provides more detailed inventory information that visually 

displays the structure of packaging and goods. 

The Inventory information object also provides an overview of specific packaging, for example. 

The Inventory adjustment object allows you to create packed and unpacked goods. 

Functions available in the context of load units (page 1210) 

 Manually create load units of any items with inventory 

 Reload shipping materials form other inventory locations 

 Pack, unpack, and repack load units 

 Remove boxes form or add boxes to pallets 

 Remove or add contents 

Functions available in the context of new load units (page 1217) 

 Create load units according to packaging instructions or shipping material requirements 

 Create load units 

 Perform automatic reservation 

 Manipulate load units 

Packaging 
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Scan-to-ship functions available in the context of load lists 

 Pack items on an order basis after manufacturing 

 Generate shipping labels and package IDs 

 Scan and reserve load units that have been prepared for shipment via package ID or 

batch-tracked inventory ID (Go to > Reservation) 

 

The objects in this folder are only active if the COMMON.WMS.USEPACKAGES parameter is set 

to yes. 

You can also use simplified shipping material management if you do not need the complex 

shipping material management functionality. 
 

Packaging information 

The Packaging information object (accessed by selecting Inventory > Packaging) shows detailed 

information about the packaging of stored items/batch-tracked inventory and visually displays the 

structure of the packaging and goods. 

Note: The Inventory information (page 1183) object is similar to the Packaging information object 

in terms of structure and information content, however it only indicates items as being packed and 

does not provide any additional information about the actual packaging of the items. 

The packaging level indicates the hierarchy of the shipping material that is used to assemble the 

packaging. 

The method used to assemble the packaging from the shipping materials is defined in packing 

instructions. 

Note: Packing instructions refer to different packaging levels. The following applies: Packing 

instruction level ID minus 1 = Packaging level. 
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Examples 

Batch-tracked inventory  I tem ID  Description  Packaging level  

 1622000000186 ShM1-001 Euro pallet 0 

  1622000000187 ShM2-002 Carton 4413 1 

  1607000000015 965-1295 Spring package 2 

  1622000000188 ShM3-001 Cover 4413 2 

  162000000191 ShM4-001 Protective cover 4413 3 

The Euro pallet shipping material is not assigned to any other shipping material and is therefore 

positioned at Packaging level 0. It takes the packages created at Packaging level 1 (see below) 

and groups these into a load unit. Shipping material at Packaging level 0 are always used to 

create load units. 

The Carton 4413 shipping material is positioned at Packaging level 1. The packaging for the 

Spring package item is created from the  Cover 4413 shipping material at Packaging level 2 and 

the Protective cover 4413 shipping material at Packaging level 3, which is required to complete 

Cover 4413. This packaging and the items packed inside constitute the package. This package is 

then grouped, possibly with other packages, into a load unit on the Euro pallet at Packaging level 0 

(see above). 

 

Unlike in the above example, the item can also be packed directly with the shipping material at 

Packaging level 0: 

Batch-tracked inventory  I tem ID  Description  Packaging level  

 1622000000286 ShM1-002 Euro mesh pallet 0 

  1607000000090 965-4706 Container trolley wheel 1 

  162000000267 ShM3-002 Cover  1 

In this case, the batch-tracked inventory for the Container trolley wheel item is positioned at 

Packaging level 1. The Cover shipping material is used later to cover the Euro mesh pallet 

shipping material thereby completing the packaging for the item. The load unit therefore 

corresponds to Batch-tracked inventory 1622000000286. 
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Levels 

The following information can be displayed at the individual levels of the Packaging information 

object: 

Level one: Level one displays the item IDs. 

Level two: This level displays the packing instructions that were used to pack the corresponding 

items.  

 This symbol, along with a packing instruction ID, indicates that the following batch-tracked item 

inventory was packed according to this packing instruction. 

 This symbol, along with the text Without packing instruction, indicates that there was no 

packing instruction used to pack the following batch-tracked item inventory. 

 This symbol, along with the text Unpacked, indicates that the following batch-tracked item 

inventory was stored at the inventory location unpacked. 

 This symbol designates shipping material without any substructures. This symbol can be found 

at any level if the shipping material is integrated into a load unit without any substructures. 

Level three: 

 This level displays the inventory locations (page 1091) at which the batch-tracked inventory for 

the corresponding item was stored either packed or unpacked. 

 This symbol designates shipping material without any substructures. This symbol can be found 

at any level if the shipping material is integrated into a load unit without any substructures. 

Level four (Packaging level): 

 This level displays the batch-tracked shipping material inventory for Packaging level 0. This 

inventory represents the  load units. Load units are generally created by grouping together the 

packages generated at Packaging level 5. 

 The batch-tracked item inventory at level four is unpacked at the inventory location. 

 This symbol designates shipping material without any substructures. This symbol can be found 

at any level if the shipping material is integrated into a load unit without any substructures. 

Level five (Packaging level 1): 
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  This batch-tracked shipping material inventory at Packaging level 1 together with the items 

packed inside the shipping materials (see level six), and the shipping materials from lower 

packaging levels, if applicable, constitute the packages. The packages are grouped into a load unit 

at the immediate parent level (fourth level), i.e. at Packaging level 0. 

 If Packaging level 1 displays batch-tracked item inventory, this inventory is packed directly with 

the shipping material at Packaging level 0 (see level 4). The package is created at Packaging level 

0. The load unit and package in this case are identical. 

 This symbol designates shipping material without any substructures. This symbol can be found 

at any level if the shipping material is integrated into a load unit without any substructures. 

Level six (Packaging level 2): 

  Batch-tracked shipping material inventory at Packaging level 2 is also required to create 

packaging at Packaging level 1 (see level 5).  

 Batch-tracked item inventory at this packaging level is packed into packages at  Packaging 

level 1 (see level 5) together with the shipping materials from Packaging level 1, and if applicable, 

the shipping materials from lower packaging levels. 

 This symbol designates shipping material without any substructures. This symbol can be found 

at any level if the shipping material is integrated into a load unit without any substructures. 

Level six and subsequent levels (Packaging level 3 and > 3) 

  If shipping materials are required in turn to create the packaging at Packaging level 2 (see 

level six), these shipping materials are displayed at the level seven. Further levels are generated 

accordingly. 

 This symbol designates shipping material without any substructures. This symbol can be found 

at any level if the shipping material is integrated into a load unit without any substructures. 

 

The Packaging information object hierarchically sorts the data on the first three levels according to 

item ID, packing instruction used, and inventory location. 

Level four displays the load units at the corresponding inventory locations. 

The subsequent levels display which quantities of which shipping material were used in 

assembling the packaging, and how the packages were created in terms of the corresponding load 

units. 
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You can use the Packaging information (page 1206) object to print a list of the contents of a 

package. To do this, select Functions > Print  package content l is t . 

 
 

Load units 

Call 

Inventory > Packaging > Load units 

Description 

You can use this object to manually create and resolve load units and packages. This can involve 

merging or splitting individual batch-tracked inventory (see "BT-inv." page 1046). The settings 

defined for merging (page 1039) are taken into account. 

When loading the batch-tracked inventory, you can use the shipping material and/or item as your 

selection criteria. You must always specify an inventory location here. However, you can also load 

by inventory location only. 

For instructions on packing batch-tracked inventory, see Pack batch-tracked inventory (page 

1214). For instructions on unpacking batch-tracked inventory, see Unpack batch-tracked inventory 

(page 1215). For instructions on reloading batch-tracked inventory, see Reload batch-tracked 

inventory (page 1215) . 

The form that is opened is divided into a form header and two additional sections (described here 

as upper and  lower sections). Both of these sections include a number of tabs each. The upper 

section displays all of the packed load units at this inventory location. The lower section displays 

all of the batch-tracked inventory with their corresponding properties. 

To display the structure of the load units and packages, the list is structured hierarchically. If you 

expand the structure (see Show/hide component data records), the lower-level packaging levels 

are displayed in succession. 
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Upper section Depending on the selections you made when loading, the following 

batch-tracked inventory is displayed in the upper section when the structure is 

collapsed. 

Selection by shipping material 

 All batch-tracked inventory for load units and packages for which the 

selected shipping materials are positioned at Packaging level 0. 

 All available batch-tracked inventory for the selected shipping 

material. 

 

Selection by item 

 Batch-tracked inventory for load units and packages in which the 

selected items are packed. 

 

Selection by shipping material and item 

Batch-tracked inventory that meet both selection criteria. 

Selection by inventory location 

 All batch-tracked inventory for load units and packages at this 

inventory location. 

 All available batch-tracked inventory for shipping materials at this 

inventory location. 

 

Lower section Batch-tracked inventory that was selected in the upper table and then 

unpacked is moved here. 

Batch-tracked inventory that is to be packed into a batch-tracked inventory in 

the upper table must be selected here. In the upper table, you need to select 

the batch-tracked inventory into which the batch-tracked inventory from the 

lower table is to be packed. 

Depending on which selections you made when loading the batch-tracked 
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inventory (see description provided for upper table), the following batch-tracked 

inventory is displayed in the lower table.  

Selection by shipping material 

 All batch-tracked inventory for unpacked items. 

 All available batch-tracked inventory for the selected shipping 

material. 

 All batch-tracked inventory for load units and packages for which the 

selected shipping materials are positioned at Packaging level 0. If you 

made this selection, this batch-tracked inventory is also displayed in the 

upper table. Any batch-tracked inventory currently selected in the upper 

table will not be displayed in the lower table. This is because 

batch-tracked inventory cannot be packed into itself. 

 

Selection by item 

 All unpacked batch-tracked inventory for the selected item.  

 All available batch-tracked inventory for shipping materials at the 

selected inventory location. 

 All batch-tracked inventory for load units and packages in which the 

selected items are packed. If you made this selection, this 

batch-tracked inventory will also be displayed in the upper table. Any 

batch-tracked inventory currently selected in the upper table will not be 

displayed in the lower table. This is because batch-tracked inventory 

cannot be packed in itself. 

 

Selection by item and shipping material 

Batch-tracked inventory that meet both selection criteria. 

 

Selection by inventory location 

 All batch-tracked inventory for load units and packages at this 
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inventory location. 

 All available batch-tracked inventory for shipping materials at this 

inventory location.  

 All unpacked batch-tracked inventory for the item at this inventory 

location.  

Unlike with the New load lists object, you are free to create any packaging here without using a 

template (such as a packing instruction, for example). This object provides all of the required 

packaging options. 

Functions 

Pack The following tasks can be completed using the Pack (see "Pack batch-tracked 

inventory" page 1214) function: 

 Items can be packed 

 Shipping materials can be packed into other shipping materials 

 More than one batch-tracked inventory can be packed into one shipping 

material at the same time 

 The batch-tracked inventory quantity can be split before the function is run. 

This means that you can also pack partial quantities. 

Unpack The following tasks can be completed using the Unpack (see "Unpack 

batch-tracked inventory" page 1215) function: 

 Batch-tracked inventory for items and shipping materials can be unpacked 

 Batch-tracked inventory for entire packages can be unpacked. 

For example, you can remove a carton and its packed contents from a pallet. 

 More than one batch-tracked inventory can be unpacked simultaneously 

 The batch-tracked inventory quantity can be split before the function is run. 

This means that you can also unpack partial quantities. 

Reload 

batch-tracked 

inventory 

See Reload batch-tracked inventory (page 1215) 
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Pack batch-tracked inventory 

You can use the Pack function in the Load units (page 1210) object (Inventory > Packaging) to 

pack batch-tracked item inventory and batch-tracked shipping material inventory into shipping 

materials. 

1. In the Inventory module, select the Packaging folder and click the Load units object. The start 

form opens. 

2. Select the Open tab and enter the data required to select the relevant batch-tracked inventory.  

Please note: You must always specify the inventory location. 

3. Click Load to open the object form. 

4. In the upper table, select the batch-tracked inventory for the shipping material in which you 

want to pack the items and shipping materials (see Select lines). If necessary, expand the 

structure until the level with the relevant batch-tracked inventory is visible (see Show/hide 

component data records).  

Please note:  

 Make sure that the batch-tracked inventory that you have selected is for shipping material, 

as you can only pack items into shipping materials. 

 The batch-tracked inventory to be packed is then added later one level down from the 

selected batch-tracked inventory. 

If there is no suitable shipping material available, you can reload (see "Reload 

batch-tracked inventory" page 1215) other batch-tracked shipping material inventory from 

other inventory locations. 

5. In the lower table, open the Batch-tracked inventory  tab and select the batch-tracked 

inventory that you want to pack into the shipping material selected above. 

6. If you just want to pack part of the batch-tracked inventory, enter the required quantity in the 

Split quantity field for the relevant batch-tracked inventory before continuing. Any split 

quantities that you enter are highlighted in color. 

7. Select Functions > Pack. The batch-tracked inventory that you selected in the lower table will 

be moved to the upper table. 

8. Save your data. The process does not close until you save your data. 
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Unpack batch-tracked inventory 

You can use the Unpack function to unpack batch-tracked item inventory and batch-tracked 

shipping material inventory from their packaging. 

1. Select Inventory > Packaging > Load units 

2. Select the required batch-tracked inventory on the Open tab and click Load. 

3. Select the Batch-tracked inventory tab in the upper table. 

4. Select the required batch-tracked inventory here (see Select lines). If necessary, expand the 

structure until the level with the relevant batch-tracked inventory is visible. See Show/hide 

component data records. 

5. If you just want to unpack part of the batch-tracked inventory, enter the required quantity in the 

Split quantity field before continuing. Any split quantities that you enter are highlighted in color. 

6. Select Functions > Unpack. The unpacked batch-tracked inventory is displayed in the lower 

table. 

7. Select Data > Save. 

The process does not close until you save your data. 
 

Reload batch-tracked inventory 

This function in the Load units (page 1210) object (Inventory > Packaging) allows you to reload 

shipping materials from other inventory locations. You can use this function if there is no shipping 

material at the inventory location or if the quantity of shipping material is insufficient. 

To reload batch-tracked inventory: 

1. Select Functions > Reload batch-tracked inventory to display the Reload batch-tracked 

inventory dialog box. 

2. Select the required shipping material and enter the coordinates of the inventory location where 

the batch-tracked inventory for this shipping material is located. You can also specify that all 

inventory locations in the selection are to be included. 
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3. Click OK to close the dialog box. 

The batch-tracked inventory for the selected shipping material will be displayed in the upper 

and lower tables. 

4. Optional: You can pack items into the reloaded shipping material directly. 

1. In the upper table, select the batch-tracked inventory for the reloaded shipping material. 

2. In the lower table, select the batch-tracked inventory of the item to be packed. 

3. If you just want to pack part of the batch-tracked inventory, specify this beforehand in 

the Split quantity field for the item to be packed. 

4. Select Functions > Pack. 

5. In the upper table, batch-tracked inventory corresponding to a quantity of 1 is now 

automatically split from the reloaded batch-tracked inventory. The packed 

batch-tracked inventory is added one packaging level below the packaging level  for 

the split batch-tracked inventory. The quantity of the original loaded batch-tracked 

inventory is reduced by the quantity 1. When you close the Load units object, any 

batch-tracked inventory that was not used will be deleted from the table. 

6. Select Data >Save. 

5. Optional: You can pack the reloaded shipping material into the loaded load units and packages 

in order to create packaging levels. 

1. In the upper table, select the batch-tracked inventory for the shipping material (see Select 

lines) into which you want to pack one or more reloaded shipping materials. If necessary, 

expand the structure until the level with the relevant batch-tracked inventory is visible (see 

Show/hide component data records). 

2. In the lower table, search for the reloaded batch-tracked inventory for the shipping 

material that you want to pack into the shipping material that you selected in the upper 

table. 

Note:If the required batch-tracked inventory is not displayed in the lower table, it could 

be that it is already selected in the upper table. Unselect it there if this is the case. 

3. In the corresponding Split quantity field, enter the quantity of the shipping material that 

you require. If you require the full quantity of the batch-tracked inventory, enter this 

quantity as the split quantity. 

Please note: You must always specify a value in the Split quantity field. 
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4. Select Functions > Pack. 

5. If you only require part of the batch-tracked inventory, batch-tracked inventory 

corresponding to the specified split quantity is now split from the reloaded 

batch-tracked inventory. The reloaded batch-tracked inventory, which has now been 

reduced by the split quantity, remains in the lower table until you close the object. In 

the upper table, the split batch-tracked inventory is now added one packaging level 

below the packaging level for the selected batch-tracked inventory. 

6. Select Data > Save.  

When you close the Load units object, any reloaded batch-tracked inventory that was 

not used will be deleted from the table again. 
 

New load units 

Call 

Inventory > Packaging > New load units 

Description 

You can use the New load units object (Inventory > Packaging) to generate load units (page 1210) 

or packages on the basis of a packing instruction or shipping material requirement. 

Once generated, these load units will then be available for subsequent reservations and issues. 

This means that you are not tied to current orders. 
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Functions 

Post This function allows you to create load units in Inventory and (based on 

the shipping material requirement for the line) you can then reserve these 

load units in the corresponding customer requirement line. In the case of 

sales orders, they are reserved in the actual line; for order releases, they 

are reserved in the order release header/totals record. 

Add package This function allows you to create load units in Inventory and (based on 

the shipping material requirement for the line) you can then reserve these 

load units in the corresponding customer requirement line. In the case of 

sales orders, they are reserved in the actual line; for order releases, they 

are reserved in the order release header/totals record. 

Create load units 

automatically 

You can use the Create load units automatically function to create 

multiple units of the same packaging structure, in which case the 

batch-tracked inventory can be assigned automatically. 

Assign batch-tracked 

inventory 

Using the Assign batch-tracked inventory function, the batch-tracked 

inventory that was found can be optimally assigned to each shipping 

material automatically. 

 

In practice 

Unlike with the Load units object, the New load units object generates packaging using templates 

such as packing instructions or requirements, for example. 

Load units are generated by assigning the batch-tracked inventory of an item (in the lower section 

of the form) to the individual levels of the packaging structure (in the upper section of the form). 

Load units can be assigned automatically (see "Assign batch-tracked inventory automatically" 

page 1219) or manually (see "Assign batch-tracked inventory manually" page 1220). 

Once created, the load units or packages will be required for the subsequent scan-to-ship process 

in the load list. 
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The form consists of an upper section and a lower section, each containing a number of tabs. 

After loading, the upper section displays the packaging structure, which is still empty. The 

structure is created on the basis of the loaded packing instruction or the shipping material 

requirement. 

The lower section displays the batch-tracked inventory for the items and shipping materials that 

can be used to create the load unit(s) in the upper table. If necessary, you can also reload 

additional batch-tracked inventory from other inventory locations. 
 

Assign batch-tracked inventory automatically 

To assign batch-tracked inventory automatically: 

1. Select Inventory > Packaging > New load units 

2. On the Open tab, select the packed item, inventory location, and warehouse address. Click 

Load to confirm. 
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3. Select Functions > Create load units automatically. 

If you choose this method, the system automatically assigns suitable batch-tracked inventory 

from the lower section of the New load units (page 1217) object to each level of the upper 

section. It  then enters this batch-tracked inventory in the BT inv. (batch-tracked inventory) 

field in the upper section under the same ID. 

At the same time, the quantity you required to create the load unit is entered automatically in 

the Spec. qty field in the lower table for the batch-tracked inventory that was used. The 

required quantity is entered by default in the Quantity field in the upper table. When you save 

the load unit(s) later, the available quantity will be reduced by the specified quantity. 

If a batch-tracked inventory is not sufficient to cover the required quantity for a given level, 

additional batch-tracked inventory is assigned from the lower table. Additional lines are added 

to the upper table at the corresponding level for this additional batch-tracked inventory. 

If the function is unable to find any suitable batch-tracked inventory for the assignment in the 

lower table, the BT. inv field will remain empty. However, if it finds batch-tracked inventory but 

the quantity is insufficient, the existing batch-tracked inventory is assigned first. A line is 

entered for the missing quantity, its corresponding BT inv. field is empty, and the Quantity field 

displays the quantity that is still missing. In this case, you can use the Reload batch-tracked 

inventory (page 1215) function to reload one or more batch-tracked inventories from other 

inventory locations. These will be loaded into the lower table. Then select the Assign 

batch-tracked inventory  function again to assign the batch-tracked inventory that is still 

missing. 

You can manually replace a batch-tracked inventory that was previously assigned 

automatically by the function with a different batch-tracked inventory from the table below, 

provided the quantity of this batch-tracked inventory is sufficient. To do this, select the required 

quantity from the combo box in the BT inv. field in the upper table. Note that any manual 

assignments you make will be cancelled if you select the function again. 

Similarly, it's also possible to change the quantity of an automatically assigned batch-tracked 

inventory. 
 

Assign batch-tracked inventory manually 

The following overview explains how to manually assign batch-tracked inventory. 
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1. Select Inventory > Packaging > New load units 

2. On the Open tab, select the packed item, inventory location, and warehouse address. Click 

Load to confirm. 

3. In the upper section, select the line containing the batch-tracked inventory that you want to 

assign. 

The lower section will display the batch-tracked inventory for the relevant item or shipping 

material that is suitable for assignment to this level. If necessary, you can reload (see "Reload 

batch-tracked inventory" page 1215) batch-tracked inventory from other inventory locations. 

4. In the lower table, find the batch-tracked inventory that you want to assign, and in the 

corresponding Spec. qty field, enter the quantity of this batch-tracked inventory that is to be 

assigned. 

Please note: The quantity must be less than the available quantity of the batch-tracked 

inventory. This is displayed in the Avail. qty field. 

5. Click Enter to confirm. 

6. Select Data > Save. On the dialog box that is displayed, select the documents to be printed 

and click OK. 

The batch-tracked inventory is split in the upper table. At the same time, an additional line for 

the item or shipping material is added at the same level. The BT inv. field for this line is empty, 

and the  Quantity field displays the quantity of the item or shipping material that has yet to be 

covered. 

Note: When the load unit is finally created, the assigned split inventory is allocated a separate 

batch-tracked inventory ID. 
 

Scan to ship 

Call 

To assign the packing instruction, enter the quantity and, once the process is complete, create the 

packages, select Inventory > Packaging > New load units. 

You can access the Scan-to-ship overview in Sales by selecting Order processing > Load lists. 
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Description 

In many cases, goods need to be packed immediately after manufacturing according to specific 

customer requirements and assigned a shipping label. The New load units object allows you to 

assign the required packing instruction to a manufactured item by selecting a sales order or order 

release. 

A load list is then created during shipping, lines and quantities are edited manually, if necessary, 

and the actual load list is finally created. The actual quantity is also set to 0. 

The shipping employee then scans the loads units that have been prepared for shipment in the 

warehouse (using their batch-tracked inventory ID or package ID). These load lists are then 

reserved for the load list and the actual quantity is increased. 

The load units are scanned from the Scan-to-ship overview, which displays all previously reserved 

packages, i.e. all reservations for all order releases for a load list. The actual quantity of the 

corresponding load list line is then updated. 

Once the load units have been scanned, packages are created or reassigned based on the actual 

quantity. The Scan-to-ship flag is set in the load list header, to indicate that the actual quantities 

can no longer be modified manually. 

Functions 

Reset scan-to-ship process: This function in the load list allows you to complete the following. 

 Reset all reservations for all load list lines in the corresponding order releases 

 Reset the Scan-to-ship  flag in the load list header 

 Reset the actual quantities in the load list to the original values 
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Note: For more information about configuring Purchasing, see Configuration (Purchasing). 

The Purchasing module is used to manage all master data for suppliers and purchased items and 

also includes all functions required for order handling, from creating a PO to issuing purchase 

invoices, all with integrated document flows. For more information on working with purchasing 

documents, see Documents in Purchasing (page 1226). 

 

Purchasing basics 
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Documents in Purchasing 

Depending on the processing progress in a purchasing process, you create, edit, and print the 

required documents in Purchasing. 
 

Statuses (Purchasing) 

The current status of a purchase order indicates how far it has progressed. 

The status displayed in the PO header is the flag from the Status column in the table below. 

The Status type is a subcategory within the more general categorization and is shown on the 

Internal tab, in the Status1 (Status type 1) to Status6 (Status type 6) fields. 
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Status Segment Status type Meaning 

Request for 

quote (RFQ) 

[1]   

  110 Default  

  111 RFQ An RFQ was created. 

  112 RFQ printed The RFQ was printed. 

  113 Quote This status type is set manually using Functions and 

Enter quote if an RFQ leads to a quote. 

  114 Partial quote  

  115 PO generated This status type is set if a purchase order was 

generated from a supplier's quote via Functions and 

Generate purchase order. 

  116 PROJECT created This status type is used for RFQs generated by 

Project. 

  117 Part. printed The RFQ was partially printed. 

  119 RFQ closed This status type is set if the purchase order procedure 

is completed via Functions and Close. 

Outline 

agreements 

[2]   

  120 Outl. agreement  

  121 Delivery plan  

PO 

proposals 

[2]   

  13 Lot See Status types in Item account 

  14 Man. generated See Status types in Item account 

  122 Planned PO A requirement was generated from Planning. 

  123 Man. generated The user has manually entered the PO proposal. 

Purchase 

order 

[3]   

  132 Created A purchase order was drafted and saved. 

  133 Printed A purchase order was printed. 

  134 Confirmed This status type can be set using Functions and 

Confirmation receipt after the purchase order has 

been confirmed by the supplier. 

  135 Reminded A reminder was printed for the purchase order. 
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Status Segment Status type Meaning 

  137 Closed  

  138 Modified  

  139 Canceled  

Receipt to 

inspection 

[4]   

  140 Not received  

  141 Inspection rcpt Inspection was notified of a goods receipt. 

  142 Part. insp. rct Inspection was notified of a partial delivery. 

  144 P rep. to SC WH Materials provided were reposted to a subcontractor 

warehouse 

  146 Unpl. insp. rcpt  

  148 Returned  

  149 Canceled  

  150 Not received  

Inventory 

receipt 

[5]   

  150 Not received Default value for standard record 

  151 Receipt Full inventory receipt 

  152 Partial receipt Partial inventory receipt 

  153 Issue  

  156 Unpl. receipt  

  157 Part. delivered  

  158 Returned  

  159 Canceled  

Invoices [6]   

  160 Not approved Posted in invoice, not approved 

  161 Approved Full invoice approved. This can be set by selecting 

Functions and Invoice receipt. 

  162 Part. approved Partial invoice approved. This can be set by selecting 

Functions and Invoice receipt. 
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Status Segment Status type Meaning 

  168 Closed This status type is set if the purchase order procedure 

is completed using Functions and Close. 

  169 Canceled  

 
 

Record types (Purchasing) 

The record type determines the type of a record, which contains the attributes of an object such as 

an item line or a purchase order. 

Example: A PO line (HR line) as data record for a purchase order contains, for example, the item 

ID, short description, PO quantity, price, and so on. 

Purchasing works with the following record types. 
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Record type Description 

SCM Subcontracted material: Indicates the lines in a purchase order that contain materials to be 

provided by the subcontracted manufacturer. 

HR Material: The item lines of the purchase order are indicated by HR. 

MA Material provided: Indicates the lines in a purchase order that contain materials provided for a 

subcontracted manufacturer. 

For purchase orders with material provided, the supplier can be included on this line. 

O Supplier: The DH record contains the data for the document header of a document. The header 

record shows the values of the entire order. DH records are created by the system and cannot 

be entered manually. 

S Totals record: The totals record forms part of an outline agreement containing special 

conditions. The outline agreement (which contains agreed terms for a longer period of time and 

details about specific quantities that can be released over time repeatedly) shows all the PO 

lines that are covered by the current agreement. The outline agreement consists of DH and the 

RT1 records only. 

A purchase order line that is assigned to an outline agreement will have the same ID as this 

outline agreement. This ID allows you to identify the purchase order lines as belonging to an 

outline agreement. 

TL See Record types (Tools) 

TX Text record: By default (setting in the configuration), these are treated as pure text lines that are 

entered in the supplier's purchase order. There is no price calculation here. 

AC Additional costs: If these have been saved in the master data under Additional costs, you can 

make a selection here (such as Freight, Insurance, etc.). 

The record type is evaluated, for example during scheduling. HR lines give the replenishment time 

calculated from the supplier's delivery time. 
 

Currency conversion 

In orders and purchase orders (page 1247), you have the option of entering a fixed rate and a 

daily rate on the Details tab for the transaction currency. The following examples indicate the 

entries you should make in different situations. The base currency is set by default in the dimmed 

text box on the right of the screen. The default setting is taken from the configuration and cannot 

be changed here. 
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Examples 

Example 1: You are an Infor COM user in Germany and your base currency is euro. The 

transaction currency is US dollars. 

On January 1, 1999, the individual exchange rates between the dollar and the various currencies 

of the EMU were replaced by one exchange rate between the dollar and the euro. This rate is 

flexible and is taken from the foreign currency table by default. If you need to change it for 

processing orders or purchase orders, you can enter the required rate in the Fixed rate field. 

This example is illustrated below: 

Daily rate     

1,000000 USD = 0,91642 EUR 

Fixed rate     

1,000000 USD = 0,000000 EUR 

The transaction currency is US dollars, while the base currency is euros. The Currency form 

section shows the transaction currency on the left and euros on the right (provided that the euro is 

set by default as the base currency). 

Example 2: You are an Infor COM user in Switzerland (not a member of the EMU). Your base 

currency is Swiss francs. The transaction currency is US dollars. In this case, the exchange rate is 

taken directly from the foreign currency table (provided it has been entered there). You can 

change (fix) this rate for the current order or purchase order in the Fixed rate field because the 

exchange rate for Swiss francs and US dollars is a floating exchange rate. 

This example is illustrated below: The base currency is Swiss francs (CHF) and the transaction 

currency is dollars. 

Daily rate     

1,000000 USD = 1,37120 CHF 

Fixed rate     

1,000000 USD = 0,000000 CHF 

The Currency form section shows the transaction currency on the left and the base currency on 

the right (if the base currency is not euros). 

All possible currency conversion scenarios may be examined on the basis of these examples. 
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The following generally applies: It makes no sense to change (fix) the euro exchange rate of one 

of the currencies in the EMU, because this exchange rate has been permanently fixed since 

January 1, 1999. The exchange rate between any other currency and the euro or another currency 

is a floating exchange rate and can therefore be changed as required for an order or purchase 

order. 
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Call 

Purchasing > PO proposals 

Description 

Infor COM determines the material requirement on the basis of incoming orders. As a rule, this 

happens in Planning. PO proposals created in Planning are available in Purchasing once they 

have been transferred to detailed planning and can be processed further there. See Edit PO 

proposals (page 1233). 

Note that different functions are available depending on the PO proposal you have selected. The 

following table shows the available menu commands, which are dependent on the actual business 

process. 

PO proposal for 

subcontracted 

manufacturing 

PO proposal in Purchasing PO proposal according to a 

generated RFQ 

Available: 

All menu functions except 

for the 

RFQ function. 

All menu functions are available. Available: 

 Display RFQ 

 RFQ overview 

A PO can only be generated 

from the RFQ. 

 
 

Edit PO proposals 

Planning generates PO proposals for planned sales orders and whenever you open Minimum 

inventory monitoring. These PO proposals are available once they have been transferred to 

detailed planning and can be processed further in Purchasing > PO proposals. 

PO proposals 
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1. Select Purchasing > PO proposals, and then select the Open tab. 

2. In the Item ID field, enter the % sign. Confirm your entries by clicking Load. 

Note: You can use the Supplier ID, Employee and Job fields to select supplier-related, 

purchaser-related, or job-related PO proposals for processing. 

3. There are two ways to create purchase orders: 

 Select Functions > Generate purchase orders > Automatically. 

Select Start or Start and print to generate (for Start) or generate and print (for Start and 

print) all purchase orders, or just the selected purchase orders . The system assigns the 

purchase order IDs here and lines for the same supplier are grouped together. 

 Select the Functions menu command, then Generate purchase orders and Manually, to 

load the selected PO into PO maintenance (like a manual PO). You can change or correct 

this here, and you can also add and print discounts. 
 

Expand PO 

In a PO proposal, you can use the Expand purchase orders function to transfer lines in the PO 

proposal to existing purchase orders for a supplier. This can be done if there are purchase orders 

for suppliers that have not been printed yet. 

Note that you can only add PO proposals to POs of the same type. 

Example: For example, you cannot add PO proposals for subcontracted manufacturing orders to 

POs that are purely Purchasing-related. 

To update an existing purchase order, complete the following steps: 

1. Click the + sign in the Item/supplier field in the open PO proposal to open the available 

suppliers for the item. Select the line with the item by clicking the row header. 

The standard system searches for purchase orders for the first supplier. If you want to find 

POs for other suppliers, in addition to selecting the item, also select the required 

supplier(s) by holding down the CTRL key and clicking the row header of the supplier. 

2. Select Functions > Expand purchase orders. 

An error message is displayed if there are no purchase orders for this supplier. Otherwise, a 

dialog box opens displaying the relevant purchase orders for this supplier. 

3. Select the required PO and click OK. The line is added to the selected PO, and the PO is 

displayed. 
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4. Save this changed PO. 
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Call 

Purchasing > Supplier RFQs 

Description 

A supplier RFQ is a request for one or more suppliers to provide information on item prices and 

delivery conditions. A print command allows you to print supplier RFQs for individual suppliers or 

all selected suppliers. 

When you receive quotes from suppliers in response to an RFQ, you can enter and compare 

them, select the best quote, and generate a purchase order automatically. 

Functions 

Document management: You can use this command to open the Document management 

function. 

Documents can be linked to the RFQ header, the item RFQ line, and the supplier RFQ line. You 

can access these in the following ways: 

 If there are no items or suppliers selected, the system displays the window used for managing 

the documents that are linked to the RFQ header. 

 If an item is selected on the form, the system displays the window used for managing the 

documents that are linked to the item RFQ line. The same applies when accessing the Item 

RFQ line view. 

 If a supplier is selected on the form, the system displays the window used for managing the 

documents that are linked to the supplier RFQ line. The same applies when accessing the 

Supplier RFQ line view. 
 

Find suppliers 

To search by supplier, complete the following steps: 

1. Under Purchasing > Supplier RFQs, select the New tab and click Create. 

Supplier RFQs 
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2. In the supplier RFQ, select an item from the Item tab. 

The possible supplier(s) for the item are automatically entered on the Suppliers tab 

underneath. 

Note: You can add more suppliers using the combo box, or delete them using CTRL +D. 

3. Select Functions > Find suppliers to locate more suppliers. In the dialog box that opens up, 

activate one or more of the following options: Alternative suppliers, Purchase orders, or 

Archive. 

4. Click Find. 

The suppliers are listed in the Alternative suppliers form section. 
 

Enter supplier RFQ 

To generate an RFQ for a supplier that is not based on a requirement, complete the steps below. 

Note: You can enter a supplier RFQ that is not based on a requirement by selecting Functions > 

Create RFQ. 

1. In the Purchasing folder, click Supplier RFQs and select the New tab. 

2. Confirm the selected RFQ ID by clicking Create. 

3. Now go to the Item table and enter the item ID of the item for which you want to obtain a quote 

in the Item field. 

The fields in the Item table are sometimes preset from the item master data after the item is 

confirmed. At the same time, the supplier(s) are preset from the item master data in the 

Suppliers table. To access the item master data, select Go to and Item master. 

4. Enter the RFQ quantity in the Item table. 

5. Select Functions and Create document. This activates the Standard printing option. An RFQ is 

created for each supplier in the Suppliers table. 
 

Enter supplier RFQs with quantity scales 

Complete the following steps to generate supplier RFQs for different quantity scales in order to 

use quantity discounts, for example: 



1238 | Infor COM 7.5 User Guide 

 

Purchasing 

 

1. Select Purchasing > Supplier RFQs, then select the New tab. 

2. Enter the required number of lines with the same item ID. 

 

Example: 

Item RFQ quantity UOM 

102-0010 10 U 

102-0010 100 U 

102-0010 1000 U 

 

 

3. Select Functions > Create document and click OK. 

4. Select Functions > Enter quote, enter a quote ID and click OK. 

5. On the Quote/price tab, specify the prices for the entered quantities. 

6. Select Functions > Compare prices. Click OK in the dialog box that is displayed. 

7. Select the check box in column PO for the required line. Then select Functions > Generate 

purchase orders > Automatically and click Start. 

The quantity and price for the selected line are automatically transferred to the purchase order. 
 

Close supplier RFQs 

Supplier RFQs that are no longer needed can be assigned the status Closed. 

There are two ways to close a supplier RFQ: 

 You can close a supplier RFQ manually. 

1. Under Purchasing > Supplier RFQs, select the Open tab. Enter details for the relevant 

supplier RFQ and click Load. 

2. Select Functions > Close supplier RFQs. 

Note: You can cancel the Close process using Functions > Undo supplier RFQ 

closing. 

 You can close a supplier RFQ by means of a batch process. 
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1. Select Purchasing > Batch processes > Close requests for quote 

2. In the dialog box that is displayed, enter the selection criteria and click Start. 
 

Enter quote 

When a supplier's quote is received in response to a supplier RFQ that you created, you can enter 

this quote from the RFQ, provided the status of this RFQ is Printed (see the Status field in the PO 

header). 

1. Under Purchasing > Supplier RFQs, select the Open tab. Enter the relevant data and click 

Load. 

2. Select Functions > Enter quote. 

Note: If several suppliers are displayed in the Suppliers table, select the supplier that sent you 

the quote. 

Please note: Quotes can only be created for printed RFQs. 

3. On the following form, Enter quote, specify the quote ID and click OK. 

If you wish, you can make changes in the modifiable fields on the Item, Quote/price, and 

Quote/IDs tabs. 

4. On the Quote/price tab, enter the different prices of the supplier. Activate the Accept to save 

the changed prices to the item master. 

5. Save the quote by selecting Data > Save. Then select Data > Close to return to the RFQ. 

6. If you entered several quotes, you can initiate a price comparison (see "Compare prices" page 

1239) between them here. 

For details of how to create a purchase order from the quote, see Generate PO from quote 

(page 1248). 
 

Compare prices 

You received quotes from suppliers in response to a supplier RFQ, and you have entered these 

quotes. You can now compare the prices in these quotes as follows. 

1. Open the supplier RFQ in question to perform a price comparison for its quotes. 
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2. Select Functions > Compare prices. 

3. In the dialog box that opens, select the item for which you want to compare prices, and confirm 

your choice by clicking OK. 

4. This takes you to the Compare prices tab. Each row in the table contains a supplier and the 

supplier's quote price for the selected item. 
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Call 

Purchasing > Outline agreements 

Description 

An outline agreement contains the terms agreed with your suppliers and specifies your claim on 

the following: to order and receive a particular item within a set period of time, in a specified total 

quantity (for a quantity-based outline agreement) or to a specified total value (for a value-based 

outline agreement), divided into various delivery quantities in accordance with specific delivery 

and payment terms. 

Configuration 

Use the COMMON.EINKAUF.OUTLINEAGREEMENTFULFILLMESSAGEONASSIGN parameter 

to configure a message when an outline agreement expires. Use the 

COMMON.EINKAUF.OUTLINEAGREEMENTUSEORSHOWEXPIREDAGREEMENTS parameter 

to manage the assignment of unfulfilled outline agreements that have expired. 

See Make outline agreement assignment (see "Make/cancel outline agreement assignment" page 

1243). 

The COMMON.EINKAUF.OUTLINEAGREEMENTREFUSEENHANCEPERORDER and 

COMMON.EINKAUF.OUTLINEAGREEMENTREFUSEENHANCEPERSTOREBOOKING 

parameters determine if and when the outline agreement quantity can be increased. 

Functions 

Outline agreement journal: From the very first time the outline agreement is printed, entries are 

stored in the journal for any changes that are relevant to remaining quantities. This function allows 

you to view the outline agreement journal. 
 

Outline agreements 
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Enter outline agreements 

To create a new outline agreement (see "Outline agreements" page 1241), select Outline 

agreements in Purchasing. 

1. An ID is proposed for the order in the Outl. agree. ID field on the New tab. You can accept this 

or overwrite it with another ID. 

2. In the Supplier ID field, enter the company ID of the required supplier, or select the ID from the 

combo box. The name of the selected supplier is automatically inserted in the Supplier 

description field. 

3. Activate either the quantity or the value option depending on the agreement type. 

 Quantity: Select this type of agreement if a quantity has been agreed for the total order. 

 Value: Select this type of agreement if a value has been agreed for the total order. 

4. Click Create to confirm your entries. The status of the order is set to Created and it is displayed 

in the Status field. 

5. In the Form ID field, you can select the ID of the form you want to use for printing the outline 

agreement. 

6. You can define the supplier address to which you want to send the outline agreement by 

selecting an address in the Address field. If you have already defined an outline agreement 

address for this supplier in the master data, this address will be shown here by default. 

7. Fill in the Item, Total quantity/value, Unit price, and Term from and to fields in the Item form 

section. 

8. If necessary, modify the flags for calculating any discounts granted. To do this, go to the 

Prices/discounts tab in the Outline agreement header view and set the required item group 

flags. Then go to the Prices/discounts tab in the Totals record view and set the company group 

flags. 

If the price table contains a discount record with both of these flags, this will be copied to the 

outline agreement. 

9. To print the outline agreement, select Functions and Create document. This opens the Create 

document dialog box. 

10. Select the Outline agreement option. 
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11. Click OK to start printing the outline agreement. The status changes to Printed. You can issue 

order releases once the outline agreement has been entered and printed. To learn more about 

how to do this, see Enter order releases (page 1244). 
 

Make/cancel outline agreement assignment 

In principle, the following outline agreement assignments are possible: 

Assignment OA valid Just one OA Parameterization Selection dialog box 

1 yes yes yes/no no 

2 yes no yes yes * 

3 no yes yes no ** 

4 no yes no yes 

OA: Outline agreement 

*  Applies if there are two outline agreements and the second one is invalid 

** Direct assignment occurs 

 

Example: Assignment 1 is interpreted as follows. If just one valid outline agreement exists, the 

system does not display a selection dialog box – regardless of the parameter settings. 

Configuration 

COMMON.EINKAUF.OUTLINEAGREEMENTUSEORSHOWEXPIREDAGREEMENTS 

Assign outline agreement 

To assign an outline agreement, complete the following steps: 

1. In the purchase order, select an item for which an outline agreement (see "Outline 

agreements" page 1241) has been created. 

2. In the purchase order, select Make outline agreement assignment. 
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Cancel outline agreement assignment 

To cancel an outline agreement assignment, complete the following steps: 

To cancel the outline agreement assignment, select Functions > Cancel outline agreement 

assignment. 
 

Increase outline agreement quantity 

If you want to order a quantity which, according to the outline agreement, exceeds the remaining 

quantity that has yet to be delivered, you can enter this quantity in the usual way using the PO 

quantity entry. However, this entry will not always give rise to an increase in the outline agreement 

quantity. 

1. Set the COMMON.EINKAUF.OUTLINEAGREEMENTREFUSEENHANCEPERORDER=yes 

parameter in the configuration. 

2. Enter the delivered quantity in the purchase order. 

When creating the document, you can use the dialog box to define whether the PO quantity 

change will affect the outline agreement quantities. 
 

Enter order releases 

To enter an order release, complete the following steps: 

Order releases can only be created if the outline agreement (see "Outline agreements" page 

1241) on which they are based has been printed. 

1. Select Purchasing > Purchase orders, then select the New tab. 

2. Enter the data and click Create. 

3. In the Item field on the Purchase order tab, enter the item that you want to open. 
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The system recognizes that an outline agreement for the delivery exists for this item. If the 

outline agreement in question is a quantity-based outline agreement, the agreed unit price 

from the agreement is automatically entered and fixed in the Price field once you enter the 

item ID. In the case of a value-based outline agreement, the unit price is not entered until 

you enter the quantity (see step 8). 

4. Enter the release quantity for the purchase order in the PO qty field. 

 When you enter the quantity, the total value of the order release line is calculated and 

entered in the Net 2 field. The value calculated is the product of the quantity and the price 

minus the discount granted. 

 If you save or print the purchase order at a later stage, the system checks the quantity you 

entered. For value-based outline agreements, the system checks the total value calculated 

using the quantity and the unit price. 

A message is displayed if the quantity you enter exceeds the total quantity defined in the 

outline agreement or the total value that has been calculated on the basis of this. 

If you confirm your entry by clicking Yes, the total quantity/total value in the outline 

agreement is increased accordingly and you can then continue with purchase order 

maintenance. 

If you choose No or Cancel, the action is canceled and you can then correct the quantity. 

You then need to save or print the purchase order again. 

5. Select Functions > Make outline agreement assignment to link the order release to the outline 

agreement. A dialog box opens. 

6. In this Assign outline agreement dialog box, go to the relevant tab for the outline agreement. 

In the dialog box, quantity-based and value-based outline agreements are managed on 

separate tabs.  

7. Select the required outline agreement by clicking on the row header. 

8. Click OK. The assignment is carried out. 

9. Select Functions > Create document. 

10. Make sure that the Purchase order option is selected. To start printing, click OK. 

Each order release is recorded in the assigned outline agreement with its ID, the ordered 

quantity, and the current status. Each time an order release is created, the remaining 

quantity or remaining value displayed in the outline agreement is updated accordingly. 
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Archive outline agreement 

When outline agreements (page 1241) are archived, the outline agreement data is deleted from 

the movement data and copied to the archive database table. 

To archive an outline agreement, complete the following steps: 

1. Under Purchasing > Outline agreements, select the Open tab and enter the Outline agreement 

ID. Click Load. 

2. Select Functions > Archive. 

Note: To view an archived outline agreement, select Purchasing > Archive > Outline 

agreements. It is not possible to reactivate an agreement once it has been archived. 
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Call 

Purchasing > Purchase orders 

You can generate purchase orders using the Functions menu in a PO proposal or supplier RFQ. 

You can also generate purchase orders by releasing production orders with external lines. 

Description 

A purchase order is used to place an order with a supplier to provide items or services. 

Outl ine agreements 

If an outline agreement exists, the purchase order is automatically assigned to it. If several outline 

agreements exist, the assignment must be made manually using a dialog box. See the parameter 

settings described in Outline agreements (page 1241). 

Functions 

S/B presetting: This function allows you to enter serialized and/or batch IDs. When you select this 

function, a dialog box is displayed in which you can manually enter the serialized and/or batch IDs 

in the manufacturing process or have them automatically generated. You can use this function if, 

for example, you need these IDs for manufacturing documents. 

Note: You can also assign serialized and/or batch IDs on receipt of finished items by selecting 

Inventory > Manufacturing > S/B assignment. 

If working with manual batch-tracked inventory specifications (see "Enter manual batch-tracked 

inventory specification" page 1080), you can use the Serialized/batch ID according to presetting 

function in the Purchase receipt or Inventory transactions objects to accept the pre-assigned IDs. 

Check availability: Select this function if you want to check the availability of the material provided 

before printing the purchase order(s). See Subcontracted manufacturing. 

Change procurement type 

Purchase orders 
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Document management 

In practice 

Purchase orders for suspended suppliers: Purchase orders cannot be created for suppliers that 

have been suspended via the company suspension function. However, this is possible for 

suppliers that have been suspended via the Supplier evaluation function. In this case, a message 

is displayed indicating that the supplier has been suspended but you can override this. 

Disc. item: A purchase order cannot be saved for a discontinued item, (Disc. item = 5, Planning 

tab). A discontinued item can only be provided if the requirement can be covered by available 

inventory. 

Use replacement item 

 
 

Generate PO from quote 

When you have completed the price comparisons and entered the PO quantities, you can 

generate the POs (see "Purchase orders" page 1247) for the selected suppliers from the quote. 

1. Select Functions  and then  Generate purchase orders. This brings up a selection menu with 

the Automatically and Manually methods. 

Automatically: With this method, the system generates all purchase orders based on the 

supplier you selected by entering the PO quantities during the price comparison. The 

system automatically assigns the purchase order IDs here, and you do not have the option 

to change them. In the dialog box that is displayed after you start the process, you can use 

the Start and Start and print buttons to decide whether the purchase orders are to be 

created only, or created and printed simultaneously. 
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Manually: Unlike with generating purchase orders automatically, here you can change the 

proposed purchase order ID in a dialog box before you generate each individual purchase 

order. With this manual PO generation method, the purchase orders are created only. 

There is no selection option for creating and then printing your new purchase orders here. 

To print the purchase orders, load them in the Purchase orders object and start the 

printing from there. 

The error message Order cannot be generated for any of the RFQ lines can appear for a 

number of reasons: 

 This item has already been ordered from another supplier. Switch to the supplier RFQ and 

place the cursor in the corresponding Item field. In the list of suppliers, check whether the 

status in any row is set to PO generated. 

 A quote has not yet been entered for the item. 

 A price comparison has not been carried out yet (using Functions and Compare prices), or 

a PO quantity has not been entered. 

Note: When purchase orders are created, the prices entered in the quote apply. Any prices 

contained in existing outline agreements are ignored. 

The error message Order cannot be generated for any of the RFQ lines can appear for a 

number of reasons: 

 This item has already been ordered from another supplier. Switch to the supplier RFQ and 

place the cursor in the corresponding Item field. In the list of suppliers, check whether the 

status in a row is set to PO generated. 

 A quote has not yet been entered for the item. 

 A price comparison has not yet been carried out (using Functions and Compare prices), or 

a PO quantity has not been entered. 

 If you have generated a PO, the status in the supplier field is set to PO generated. 

To obtain an overview of the POs generated, select Functions and PO overview. 

Note: When purchase orders are created, the prices entered in the quote apply. Any 

prices contained in existing outline agreements are ignored. 

2. Select Purchasing > Purchase orders to open the PO that was generated. 
 

Print purchase orders 

To learn how to print a single PO, see Enter PO (see "Enter and cancel purchase order" page 

1250). The Print purchase orders batch process allows you to print any number of POs, which you 

can choose from a range of criteria. 



1250 | Infor COM 7.5 User Guide 

 

Purchasing 

 

1. Select Purchasing > Batch processes > Print purchase orders. 

2. Populate the selection fields in the Print purchase orders dialog box with the required values, 

then click OK. 
 

Enter and cancel purchase order 

You enter a PO (see "Purchase orders" page 1247) through Purchase orders in Purchasing. 

1. Select Purchasing > Purchase orders > New. Enter the supplier ID and click Create. 

2. Enter the item on the PO tab. 

Select Go toand Find master datato search for items and accept them - see Find master data. 

Enter SV as the record type to create a purchase order for a service. You can create, print 

and confirm purchase orders for services. You can also perform invoice approval. The 

gauge indicator for the goods receipt is filled after the invoice is approved. 

Example: To display the available items for the chosen supplier, select the Ext. item ID 

tab in the Find master data dialog box. Enter the supplier and click Find. Copy the required 

items to the purchase order by double-clicking the row header. 

Note: You can also enter an item for a PO line for which no master data record exists - 

see One-off items. 

3. Enter the required PO quantity in the PO qty field. A unit price is now calculated and displayed 

in the Price field. This unit price is multiplied by the quantity to calculate the price in the Net 2 

field. If the supplier offers a discount on an item, this is also calculated in the Net 2 amount. 

The discount percentage to apply for this calculation is available in the %Disc field. For more 

information, see Prices and discounts in Purchasing (see "Price in Purchasing" page 1350). 

The earliest possible delivery date is entered in the PO field on the Due dates tab (=Today 

plus supplier's delivery time). You can replace this date. 

4. Select Functions > Schedule to calculate the earliest possible delivery date in the PO header 

for the entire purchase order (Earliest delivery date). The latest order date is set to tomorrow 

for a purchase order created manually, provided due dates were not changed manually. 
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5. Save the purchase order initially using Data > Save if you want to print it later or select 

Functions > Create document to print it immediately. 

Select Purchasing > Batch processes > Purchases orders to print several saved purchase 

orders. 

Note: Select Data and Save as to enter multiple purchase orders with similar data. 

6. Select Functions > Edit document in the purchase order and click the Cancel option in the 

Functions section to cancel the purchase order. When you confirm this action, a PO 

cancellation document is printed. 

7. Select Data and  Close to exit the PO. 
 

Trace PO 

Click here for information on how to enter a PO (see "Enter and cancel purchase order" page 

1250). 

You can use the following options to find out more about the PO document. 

1. The PO is sent to the supplier, who confirms the order. You enter this type of order 

confirmation from the supplier in Infor COM as follows. 

 Load the PO and compare the data from the supplier's confirmation with the PO data. Add 

any accepted variances in the PO before the confirmation. 

 Select Functions and Confirmation receipt. In the  Confirmation receipt dialog box that 

opens up, you can save the Date (the system date is entered by default) and ID (for 

example, the document ID assigned by the supplier) of the confirmation. Then enter the 

due date on which the supplier has agreed to ship the goods. 

 Confirm your entries by clicking OK. The status of the PO is set to Confirmed. 

2. You can monitor the PO with regard to adherence to delivery dates and the quantity and 

quality of a delivery. PO statuses can be traced in several ways. How you do this depends on 

whether inventory postings are reported through goods receipts from Purchasing or directly in 

the warehouse. 

 In Purchasing, you see the current status for each PO in the Purchase order overview 

view. A PO's current status shows to what extent the PO has been processed. In the PO 

header, the flag from the Status column is displayed as the status. The status types in the 

Status1 to Status6 and Stat. fields on the Internal tab are alternative types of status. 

 In the Inventory component, you can trace all inventory movements using the different 

selection criteria available there. 
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 You can print reports for POs and deliveries using the Reports command in Purchasing. 

Examples: You can print the reports for POs that have been created but not yet printed 

(named irPurchOpenPO), the report for PO lines that have not yet been delivered (named 

irPurchOutstDel), or the  delivery reminder by supplier report (named 

irPurchDeliveryReminder). 

3. See Create delivery and confirmation reminders for details on how to enter delivery and 

confirmation reminders. 

4. See the Purchase receipt Help topic for details on entering a goods receipt. 
 

Delete purchase order 

You can delete POs (see "Purchase orders" page 1247) that you no longer require from the 

database. The status of your PO will determine whether it can be deleted. You can no longer 

delete printed POs. You can archive POs (see "Archive PO" page 1253) as an alternative to 

deleting them. 

1. To delete a PO, select Data and then Delete in the opened PO. 

2. Choose Yes in the dialog box that is then displayed to delete the PO from the database. 
 

View reminder history 

You can view the reminder history for a PO as follows. 

1. Under Purchasing > Purchase orders, select the Open tab. Enter the selection criteria for the 

PO and click Load. 

2. Select the Due dates tab. 

The reminder counter references the reminder history in the the Remdr field. 

3. In the opened purchase order, select Functions and Edit document. Next, select Delivery 

reminder and click OK. 

If there are several reminders, the Select reminder document dialog box will open and you will 

be able to see the reminder history. 
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Archive PO 

To archive a purchase order (see "Purchase orders" page 1247), complete the following steps. 

1. Under Purchasing > Purchase orders, select the Open tab. 

2. Enter data in the fields for selecting the required purchase order and click Load. 

Note: The PO must have the Invoice approved status to enable it to be archived. If the PO in 

question does not have this status, you can effectively change this by selecting the Functions 

menu command and then Close. 

3. Select Functions > Archive. 

The entire PO is now moved from PO maintenance into the archive. You can open or activate 

archived POs under Purchasing > Archive > Purchase orders. 
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See the Help topic regarding incoming delivery advices. Click here. 
 

Purchase delivery advices 
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Call 

Purchasing > Supplier advance shipping notices 

Description 

The supplier advance shipping notice has a number of special features. In Infor COM, a supplier 

advance shipping notice (or supplier ASN) is a special type of posting document that can be 

created when inventory posting is carried out for the delivered item. This is why you cannot create 

a new advance shipping notice by selecting Purchasing and Supplier ASNs and finally the New 

tab. You enter the ID of an advance shipping notice when you have inventory receipt notification. 

This notification may be triggered from the purchase order using Functions and Inventory 

transaction, for example. For more information, see Purchase receipt. In this case, you are asked 

to specify the (external) advance shipping notice ID. You can then use this advance shipping 

notice ID to open the advance shipping notice in Purchasing with the supplier ASNs option. 

In practice 

Use Purchasing > Supplier ASNs to run invoice approval on the basis of advance shipping 

notices. This function is useful if you have received lines from several different purchase orders in 

a single delivery. Instead of grouping the individual purchase orders in one consolidated invoice to 

approve the invoice, load the advance shipping notice with its ID in the Supplier ASNs object and 

run the Invoice receipt function here. 

If you want to display one of the lines described in the line view, double-click the relevant ID in the 

numbering bar in the row header or select View and ASN line. 

 

 

Supplier advance shipping notices 
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Call 

Purchasing > Purchase invoices 

Description 

By selecting Purchase invoices in Purchasing, you can either open or create new purchase 

invoices. 

Functions 

ADC distribution (see "Distribute additional delivery costs" page 1263) 

In practice 

Purchase invoices are usually created in the PO by selecting Functions and Invoice receipt. 

Enter purchase credit memos 

Manual sales tax changes (ms-its:sales.chm::/27582.htm) 

 
 

Enter consolidated invoices in Purchasing 

Creating a consolidated invoice in Purchasing enables you to combine the lines from several 

purchase orders on one invoice using an external invoice ID and to transfer it to invoice approval. 

1. In Purchasing, click Purchase invoices and select the New tab. 

2. Select the supplier from the combo box in the Supplier field. Enter the invoice ID assigned by 

the supplier into the Ext. inv. ID field. The system date is proposed as the external invoice 

date. You can change this date as required. 

3. Click Create to confirm your entries. This takes you to the invoice form. 

Purchase invoices 

ms-its:sales.chm::/27582.htm


Infor COM 7.5 User Guide | 1257 

 

Purchasing 

 

4. Choose Data and Reload. 

5. Select the lines to be approved from the table. You can use the PO IDs for reference. Hold 

down the CTRL key and, at the same time, select the lines you require using the left mouse 

button. This allows you to select lines that do not follow each other in sequence. 

6. Click OK to confirm your selection. The table on the Invoice approval tab displays the lines you 

have just selected. 

7. Check the quantity and price data of each line to make sure that everything is right. Alter the 

data if required. 

8. Select Functions and Invoice approval to open the Invoice approval dialog box with all relevant 

invoice data. The internal invoice ID was assigned by the system. 

9. Click OK to confirm your approval. 

10. The invoice will now have Approved status. 
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Invoice approval in Purchasing 

You can perform invoice approval in Purchasing once your supplier's invoice is available. 

Following invoice approval, the invoice data is transferred to the invoice journal. In addition, the 

posting values and the additional delivery costs (see "Additional costs (Purchasing)" page 1346) 

per purchased item are copied to the posting journal and value journal. 

Before approving the invoice, you should compare the data from the supplier invoice with the 

invoice data in Infor COM. A specific function is provided for this purpose in Infor COM. 

You can access Invoice approval from the purchase order, the supplier advance shipping notice, 

or the purchase invoice (in the first two cases, you can approve the invoice without actually going 

to the invoice, provided that the data you are verifying does not differ from the details in the 

purchase order or the supplier advance shipping notice). 

Note: In all three cases, you can add extra advance shipping notice lines or extra purchase order 

lines to the existing ones. To do this, select Data and Reload. 

Invoice approval checks for additional costs with active distribution. For more information, see 

Distribute additional delivery costs (page 1263). 

On the Invoice approval tab of the Purchase invoice, you can compare or edit the prices and 

quantities shown there with those on the received invoice before actually approving the invoice. 

Select Functions and Invoice approval to copy the approved data to the invoice journal. 
 

Approve invoice based on PO 

To approve an invoice based on a purchase order, complete the following steps: 

1. In the Purchasing folder, click Purchase orders. 

2. Enter the PO ID on the Open tab and click Load to load the purchase order. 

3. To enter a purchase invoice for your supplier, open the purchase order and select Functions > 

Invoice receipt. 

4. Select one of the following procedures: 

The data on the received invoice matches the purchase order. 
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 In this case, select the 1:1 to purchase order check box. The invoice approval function is 

activated immediately and the invoice is not displayed. The Invoice approval dialog box 

opens and displays all of the relevant invoice data. 

 Click OK to carry out the invoice approval. This is the last step in the process. 

The data on the received invoice does not match the purchase order and requires editing. 

 Enter the external invoice ID and the external invoice date in the dialog box and confirm 

your entries by clicking OK. This invoice is then opened. 
 Select the required purchase order lines as required. Press and hold the Ctrl key and then 

left-click on the corresponding row numbers in the numbering bar. 

 Select Functions and Invoice receipt. 

5. Check the accuracy of the quantity and price data on the Invoice approval tab and adjust the 

data as required. 

6. In the opened invoice, select Functions and Invoice approval. 

7. Check the information displayed in the dialog box. The internal invoice ID here is assigned by 

the system. 

Note: The invoice approval function checks for additional costs with active distribution. If this 

is the case, the dialog box for the distribution of delivery costs opens. 

8. Click OK to confirm. 

9. Select Data and Close. This takes you back to the purchase order. The status of the invoice is 

now Approved, and the value has been adjusted in Inventory. You can verify this by opening 

the inventory journal. 

Approved invoices are managed in the Invoice journal. 
 

Approve invoice based on advance shipping notice (ASN) 

These step-by-step instructions explain how to approve invoices in Purchasing using a Supplier 

advance shipping notice (ASN). 

You approve an invoice based on an advance shipping notice when you have received lines from 

several purchase orders in one delivery. Instead of combining the purchase orders before 

approving the invoice, you can base your approval on the advance shipping notice. 

The following example refers to the purchase order created in step 3 of the Approve invoice based 

on PO (page 1258) Help topic: Supplier2700 has a purchase order for 100 units of item 103-0007 

at a unit price of 0.76. 
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Two receipts have been posted: A partial receipt of 40 units and a full receipt of 60 units. For more 

information, see Purchase receipt. 

To approve an invoice on the basis of an advance shipping notice, go to Supplier ASNs in 

Purchasing and proceed as follows. 

1. Click Supplier ASNs in the Purchasing folder to access the Open tab of the supplier advance 

shipping notice. Enter the advance shipping notice ID and click Load. This displays the 

advance shipping notice form. 

Example: This table shows the Receipt tab of the supplier advance shipping notice for the 

partial receipt of 40 units for our sample purchase order. 

 

 

Item PO ID Receipt UOM Delivery price Price basis UOM 

103-0007 EB3424 40 U 1,49 1 U 

 

 

2. Select Functions and Invoice receipt. This opens the New dialog box. 

3. Enter the external invoice ID and the external invoice date, clear the 1:1 to ASN option, and 

confirm by clicking OK. 

4. Next, check that the quantity and price data on the Invoice approval tab are correct. Then 

expand the structure for the displayed purchase invoice by clicking the + sign in the Str. field. 

The following table is displayed. 

 

 

Sq. ID RT Item Quantity, Qty, Q Ext. 

UOM 

PIA UOM Price Net value 

1 HR 103-0007 40 U Selected U 0,76 30,40 

1 HR 103-0007 40 U Not selected U 0,76 30,40 

 

In this example, we are assuming that the invoice contains  40 units at  $0.80 and 60 

units at $0.85. 
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5. Select Data and Reload. In the Reload dialog box, highlight the item to be reloaded, in this 

case the delivery of 60 units of item 103-0007, by clicking the ID in the row header. 

The collapsed structure is copied to the purchase invoice. 

6. Confirm this by clicking OK. The result is shown in the table below. 

 

 

Selected Sq. ID SVO Item Qty Ext. UOM PIA UOM Price Net value 

Not 

selected 

1 HR 103-0007 100 U Not selected U 0,76 76 

Activated 1 HR 103-0007 40 U Not selected U 0,76 30,40 

Activated 1 HR 103-0007 60 U Not selected U 0,76 45,60 

 

 

7. Modify the data shown so that it matches our example. The invoice now appears as in the 

following table. 

 

 

Active Sq. ID SVO Item Qty Ext. UOM PIA UO

M 

Price Net value 

Not 

selected 

1 HR 103-0007 100 U Not selected U 0,76 76,00 

Activated 1 HR 103-0007 40 U Not selected U 0,80 32,00 

Activated 1 HR 103-0007 60 U Not selected U 0,85 51,00 

 

 

8. Select Functions > Invoice approval. This opens the Invoice approval dialog box, which 

provides an overview of all relevant invoice data. The  internal invoice ID is assigned by the 

system. 

9. Click OK to confirm your approval. The status of the invoice now changes to Approved. You 

can verify this in the Stat. field on the Internal tab. 
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10. Close the invoice by selecting Data and Close. This takes you back to the advance shipping 

notice. The value has been adjusted in Inventory and copied to the invoice journal. You can 

verify this by opening the inventory journal and/or the invoice journal. 

Approved invoices are managed in the Invoice journal. 
 

Approve invoice using the desktop 

See Invoice approval in Purchasing (page 1258) for more information. 

Click here for background information on Invoice approval in Purchasing (page 1258). 

These step-by-step instructions explain how to approve invoices in Purchasing using the Purchase 

invoices object. 

Note: The Purchase invoices desktop object allows you to enter purchase invoices with or without 

a PO reference. 

1. Click the Purchase invoices object in Purchasing and select the New tab. 

2. Enter the supplier's ID in the Supplier field, or select it from the field combo box. Enter the 

invoice ID assigned by the supplier in the Ext. inv. ID field. Today, the system date, is 

proposed as the external invoice date. 

3. Click Create to confirm your entries. This takes you to the invoice form. You have two options 

for entering the invoice data - with or without reference to an existing PO. If you want to create 

the invoice with reference to an existing PO, follow the instructions in step 4. To learn how to 

create the invoice without a PO reference, go to step 5. 

4. For invoice approval with a PO reference, proceed as follows: 

 Select Data and Reload. This opens the Reload dialog box. 

 Select the lines to be approved from the table. You can use the PO and advance shipping 

notice IDs for reference. Hold down the CTRL key and, at the same time, select the lines 

you require using the left mouse button. This allows you to select lines that are not located 

directly above or below one another. 

 Click OK to confirm your selection. This takes you back to the invoice form. The table on 

the Invoice approval tab displays the lines you have just selected. 

 Check the quantity and price data of each line to ensure that it is correct, and edit this data 

if necessary. 

 Continue with step 6. 

5. For invoice approval without a PO reference, proceed as follows: 
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 Enter the record type on the Invoice approval tab and then specify the item ID of the item 

and the quantity to be approved. The price is now calculated automatically and the 

affected fields are populated, provided that a price is stored. Otherwise, these fields may 

have to be filled in manually. 

 Select Data and Save. 

 Continue with step 6. 

6. Select Functions and Invoice approval to open the Invoice approval dialog box with all relevant 

invoice data. 

7. Recheck the information displayed in the dialog box. The system assigns the internal invoice 

ID. 

8. Click OK to confirm your approval. The invoice now adopts the Approved status and it is 

transferred to the invoice journal, where approved invoices are managed. 
 

Distribute additional delivery costs 

See Invoice approval in Purchasing (page 1258) for more information. 

During invoice approval, a check is run to see whether there are additional costs (see "Additional 

costs (Purchasing)" page 1346) with an activated distribution. If this is the case, a dialog box is 

opened with the functions for distributing the additional delivery costs. 

To distribute the additional delivery costs, proceed as follows. 

1. Complete steps 1 to 8 of the Approve invoice using the desktop (page 1262) Help topic. If the 

invoice has additional costs with an active distribution, the ADC distribution dialog box is 

displayed. The Additional costs table displays the additional costs whose distribution is set as 

default in the master data. The Purchased items table displays the items among which the 

additional costs can be distributed. 

Please note: In a purchase invoice with additional costs without an active distribution, you 

can use Functions and ADC distribution to manually call the distribution of additional delivery 

costs. In this case, the distribution is only saved with the invoice approval. 

2. In the Dist. type column in the Additional costs table, specify how you want each additional 

cost to be distributed on the purchased item. If you select Free, you can enter the amounts 

manually in the table on the right. 

3. Now select the relevant lines in both Additional costs and Purchased items and click Insert ->. 

You can select one or more items for the distribution. 
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4. Then check the distribution of additional costs on the purchased item in the table on the right 

by clicking both tabs. For more detailed information, see the Help topic for the dialog box. 

5. The distribution is only completed if all the additional costs provided for distribution have been 

assigned. 

Select OK to confirm and close the dialog box. 
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Call 

Purchasing > Purchase credit memos 

Description 

You can use this object to enter credit memos for your suppliers. 

Purchase credit memos generally require a receipt posting for the ordered goods. However in 

certain situations, you may receive purchase credit memos before the goods receipt posting and 

you need to edit these. 

 

Purchase credit memos 
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Call 

Purchasing > Debit memos 

Description 

Debit memos are used when you charge your suppliers for returning goods (these can be costs for 

returned items as well as costs for the RMA itself). 

Instead of the supplier issuing a credit memo for the costs you incurred, you send the supplier a 

debit memo in which you deduct the value (of the goods) taken back. 

In terms of debit memo handling, the Supplier documents tab of the supplier master contains a 

document for canceling a debit memo, and a document for printing a debit memo. 

Examples: 

 Your supplier delivers a defective item. You charge the supplier the cost of the return shipment 

plus the cost of the returned item, because you want a refund of the invoice amount. 

 An item you obtained is the wrong color. You send the item back and demand a replacement. 

You charge the supplier the cost of the return shipment. 

Configuration 

COMMON.EINKAUF.DEBITNOTEAUTOAFTERREDELIVERY 

Functions 

After you select Functions and Approve debit memo..., the data is transferred to the invoice journal 

and value flow journal. In addition, the debit memo can now be printed using Functions and Print 

debit memo. 

Within the purchase order, select Functions > Debit memo overview to display all the debit memos 

belonging to the purchase order. 

Debit memos 
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In practice 

The debit can be effected at the same time as the RMA or it can be moved to after the RMA. 

When posting an RMA, you can access debit memo maintenance by selecting the Debit memo 

option in the print dialog box that appears for the return ASN. 

Post RMAs to supplier 

You can also create debit memos for subcontracted manufacturing. The relevant function is 

available through the Cancel inv. transactions object in Inventory (posting IDs 135 and 136). 
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See Invoice journal. 
 

Invoice journal (Purchasing) 
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Call 

Purchasing > Credit memo journal 

Description 

Approved purchase credit memos (page 1265) are stored in the credit memo journal. 

Functions 

Journal printout 

In practice 

Purchase credit memos are approved in the open purchase credit memo by selecting Functions > 

Credit memo approval. Once approval is complete, the credit memo becomes available in the 

journal. 
 

Credit memo journal 
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The approved debit memos (page 1266) are stored in the debit memo journal and can be printed 

from there using Functions > Journal printout. 

Description Approved debit memos (page 1266) are stored in the debit memo 

journal. 

Functions Journal printout 

In practice Debit memos are approved in the open debit memo by selecting 

Functions > Approve debit memo. Once approval is complete, the 

debit memo becomes available in the journal. 

 
 

Debit memo journal 



Infor COM 7.5 User Guide | 1271 

 

Purchasing 

 

In the Purchasing folder, select Reports. This opens the Report overview dialog box. 

Please note: Report names are always structured as follows: ir<module><report name>. For 

more information on the reports not found in this Help topic, see the Help topics for the reports for 

the modules concerned. 

The overview includes the following reports. 

Note: You can influence the displayed lists by assigning user privileges. 

Reports (Purchasing) 
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Report Contents 

Outstanding PO lines The report contains all purchase orders that have been printed but not yet delivered. 

PO commitments - Total 

report 

 

PO commitments - Cost 

unit report 

PO commitments comprise the sum of all payment commitments relating to purchases 

that are outstanding. The PO commitment reports contain purchase orders whose 

status is Outstanding delivery or Invoice not approved. The PO commitments - 

Total report is sorted by purchase order. The PO commitments - Cost units report is 

sorted by cost unit and purchase order. 

PO proposals This report contains PO proposals, sorted by item ID. 

Evaluation data per 

supplier 

See Reports (Supplier evaluation). 

EDI master data You can use this report to print the EDI master data. 

Purchased items - 

Movements 

This report contains inventory movements for purchased items, sorted by item ID. 

Quarantined suppliers 

with contact details 

See Reports (Supplier evaluation). 

Suppliers by category 

and sales revenue 

See Reports (Supplier evaluation). 

Supplier overview - 

Outstanding invoices 

Depending on the selections made in the dialog box, you will receive a printout of all 

suppliers, or suppliers and purchase orders, or suppliers and purchase orders and 

individual lines, for which invoices are outstanding. 

Supplier overview - 

Who's who 

This report shows which supplier supplies which items. 

Delivery reminder by 

supplier 

This report shows the supplier reminders by supplier. 

Unprinted purchase 

orders 

All purchase orders that have been entered (because they were planned) but not yet 

printed. 

Criteria marks per 

individual evaluation by 

supplier and item 

See Reports (Supplier evaluation). 

Outstanding 

requirements 

All requirements from rough planning for which no purchase order has been printed. 

Outstanding deliveries by 

due date 

This report contains outstanding deliveries, sorted by due date. 

Outstanding invoices All purchase orders that have been received in the warehouse but whose invoices 

have not yet been approved. 

Price list All item prices and discounts stored in the price table. 

Price list with period, 

customer and record 

This report contains the prices, discounts, etc. for the period in which the entered due 
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Report Contents 

selection date falls, depending on the selection. 

Invoice import - Check 

list 

When EDI invoices are imported, their data is checked and, where necessary, they 

are forwarded for invoice approval. Any errors that have occurred (price or quantity 

variances, no advance shipping notice found, etc.) are logged in this report. 

Sales revenue target by 

supplier for current 

year/previous year 

These reports evaluate the annual sales revenue in relation to a preset sales revenue 

objective/bonus. For this to work, the sales target, the sales bonus, and the sales 

bonus flag must have been entered in the company master data for the supplier in 

question. 

Address overview All company addresses entered, including contacts and phone numbers. 

Select the required report by clicking its ID in the numbering bar. You can specify the number of 

reports to be printed in the Number of copies field. Click OK to confirm and print the selected 

report. 

To preview the report, simply click the Preview button. 

You can find general information on printing reports under Print reports. 
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For basic information on statistics in Infor COM, see Statistics basics. 
 

Statistics (Purchasing) 
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You can create an expenses record directly from within the project (see "Project processing 

basics" page 129) (by releasing the respective line and then opening the Functions menu and 

selecting Transfer and then Transfer to expense recording (PROJECT)) or via the New tab in the 

Expense recording object in Purchasing (see also Select and release expenses). 

Please note the following points: 

 Invoice approval copies the approved data to the invoice journal. The status of the purchase 

order is changed to Invoice approved. The purchase order can no longer be changed in this 

status. 

 If you need to undo invoice approval, select Functions and Reset invoice approval. 
 

Expense recording (Project) 
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Automatic monthly progress monitoring is a pre-requisite for period-based evaluation. 

Note: Before progress monitoring is carried out the entire project needs to be costed to transfer 

forecasts and other values form bottom to top. 

Progress monitoring is performed via a batch process that runs at the beginning of each month 

and saves the data from the previous month into the progress monitoring tables. This kind of 

progress monitoring receives the status 3 - monthly to distinguish it from other (provisional or 

definitive) progress monitoring. 

In the current month you can still enter purchase invoices and expense invoices for the previous 

month. If progress monitoring documents are printed and such invoices are entered afterwards the 

data in the progress monitoring documents becomes obsolete. 

You can prevent this by performing a month-end closing. 

The system now checks whether the previous month has already been closed when purchase or 

expense invoices are entered. If the previous month has been closed, you can no longer post 

transactions to it, if is has not yet be closed, postings are still permitted. 

When printing progress monitoring documents the system checks whether the previous month has 

already been closed. If this is the case, the system issues a message to inform the user that the 

data is still subject to change. 

 

Month-end closing 
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In business-to-business (B2B), e-Procurement denotes purchasing using the Internet.  
 

e-Procurement basics 

e-Procurement provides functions for handling EDI processes in Purchasing. e-Procurement is 

beneficial for any user who wants to order purchased items by means of order release outline 

agreements (page 1298) within the context of an order release (see "Order releases" page 1305) - 

in other words, without having to use individual POs. e-Procurement also allows messages to be 

exchanged between the purchasing department and the supplier. 

For help with e-Procurement, see Use e-Procurement (page 1277). 
 

Use e-Procurement 

This topic show you how to use e-Procurement in practice. The individual steps take you through a 

sample run of the range of functions available in e-Procurement. 

Master data 

1. In the Infor COM Management Console under COMMON.ABSENDER.OWNCOMPANY, enter 

the ID of your own company. 

2. In Finance, open the Master data folder and choose your company (selection in Type of 

company). 

3. Enter addresses and plants in the addresses table on the Address tab. Then enter unloading 

points for the addresses/plants on the Unloading points tab. 

4. Go to the Contact tab and enter a contact person for each address. You can select these in the 

Internal planner field (see the Communication tab). 

Note: In the master data for the planner, the abbreviation must be specified on the Usage tab 

so that this data can be sent by EDI. 

e-Procurement 
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5. In Purchasing, open the Master data folder and the select Suppliers to create e-Procurement 

master data for each of a supplier’s addresses. 

6. Go to the Communication tab and enter supplier-specific procurement settings. 

7. Choose e-PROCUREMENT and EDI master data to enter the EDI master data for delivery 

order releases of the supplier. 

Please note: Data is always address-specific. 

8. Go to Purchasing and Master data to access the purchased items. On the Suppliers tab, 

create a supplier and an external item ID and, if applicable, the supplier's external description. 

9. Flag the item as an order release item on the Communication tab by selecting the Release 

procurement and Item-specific data check boxes and completing the planning horizon fields. 

Order release outline agreement 

10. Create an order release outline agreement (see "Order release outline agreements" page 

1298) for the supplier address. You can create order release outline agreements for every 

supplier address for which EDI master data has been entered. When you save the outline 

agreement, the system automatically checks that all entries are complete. 

Order releases 

11. Create an order release (see "Order releases" page 1305) for an outline agreement line. Order 

releases can either be created manually or - beginning with the first requirement - 

automatically using order release generation (page 1311). Create a requirement (an order 

release line) manually by selecting the Order release object, then Functions and Edit lines. To 

open automatic Order release generation, click the desktop object with the same name. 

12. Send the current release status from the order release by selecting Functions and Send 

delivery order release. To view the sent statuses, select Functions and Display sent order 

releases. 

Delivery advice 

13. You can import a delivery advice (page 1322) received from the supplier using the Import 

messages desktop entry. You can then view the imported delivery advice using the Delivery 

advice desktop object in the e-PROCUREMENT folder. 
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Goods receipt 

14. Delivery advices can be posted - once - in Goods receipt. For a description of how to do this, 

see Enter goods receipt using delivery advice (page 1325). 

If the supplier does not send any delivery advice, the goods receipt can be posted using 

releases. 

Invoice approval 

15. Invoices are approved using the supplier advance shipping notice or the invoice because there 

are no purchase orders for order release items. See EDI invoices (page 1326). 
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Allocation tables (e-Procurement) 

The following allocation tables, which are listed in alphabetical order, apply when working with 

e-Procurement. 

 
 

EPCALLUPKEY 

Description: Order release keys 

Usage: This table contains the VDA order release keys. 
 

EPCHGKEY 

Description: Modified design keys 

Usage: This table contains keys for the purchasing delivery advice according to VDA standard 

4913, record type 714, Modified design keys field. 

Value: For two-character entries, each character can have the values "_", "G", or "T". See the 

Description field. 

Description 

This field contains two types of information: 

1st character is G: Indicates a regular delivery 

2nd character is T: The design status was transferred in the first text field of record type 716 
 

EPCNOTE 

Description: Credit memo variables 

Usage: In the Credit memos section (VDA 4908), various credit memo types are provided in 

accordance with VDA standards. This table displays the different types of memo stored. 

Note: e-Procurement currently supports the Credit memo flag. 
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 Credit memo 

 Settlement invoice 

 Unvalued goods receipt 
 

EPCNPRICE 

Description: Price units for credit memos 

Usage: The VDA credit memo flags price units differently to Infor COM. This allocation table 

assists you by converting the Infor price units to standardized VDA flags. You must ensure that the 

Infor system only uses price units that support the VDA standard. 
 

EPCNRULE 

Description: EDI transfer rules (EP) 

Usage: This allocation table contains rules on the method used to export data from credit 

memos. 
 

EPCNVU 

Description: Units of measure for credit memos 

Usage: The flags used for units of measure in VDA credit memos are different from those used in 

the Infor system. This allocation table converts the Infor units of measure to VDA-standardized 

flags. 

Please note: The Infor system only uses units of measure that are supported by the VDA 

standard. 
 

EPCOMMODE 

Description: Transfer types 

Usage: This allocation table lists the possible transfer methods for messages (for example, for 

supplier order releases). You can assign the communication type in the supplier, item, or EDI 

master data. 
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EPCRITSTATE 

Description: Description and letter for critical status (order rel. field) 

Usage: This table is used to flag whether a requirement in the e-Procurement section is 

considered critical inventory, or, in other words, whether it is an item for which compliance with 

delivery deadlines is especially important. 
 

EPCUSTOMS 

Description: Dutiable goods 

Usage: The flag entered in this allocation table and used in an e-Procurement delivery advice 

indicates whether a certain item falls under dutiable goods. 
 

EPDASTAT 

Description: Delivery advice statuses 

Usage: This allocation table contains the statuses of the imported delivery advice, indicating 

whether a delivery advice has already been posted in goods receipt. The following statuses are 

possible: 

All: This status is used when you open delivery advice notes so that they can be loaded regardless 

of their status. 

Received: A delivery advice has been imported without errors into message processing and is 

ready to be processed further. 

Posted: A delivery advice has been posted with at least one partial quantity. 

Closed: The delivery advice was closed manually. 
 

EPDELINTERV 

Description: Delivery intervals 
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Usage: The flags that are stored in this allocation table and used in the e-Procurement outline 

agreement describe the delivery intervals for delivering goods. By default, the L=As per order 

release date flag should be used. 
 

EPDELKEY 

Description: Delivery IDs 

Usage: The flags of this allocation table specify the type of delivery in an e-Procurement delivery 

advice. 
 

EPDIRECTION 

Description: Direction of messages 

Usage: This allocation table contains flags related to message management that indicate 

whether a message type involves an export or import process. 
 

EPDRAWKEY 

Description: Design keys (change) 

Usage: This allocation table contains flags used in e-Procurement delivery advice notes that 

indicate whether a delivery is a standard delivery, a first regular delivery, or a design change. 
 

EPEDISENDER 

Description: Warehouse owner keys 

Usage: This allocation table contains flags used in e-Procurement delivery advice notes that 

indicate who created the shipment: Supplier, subcontractor, or carrier. 
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EPINVCLASS 

Description: Invoice classes for purchase invoices 

Usage: This allocation table contains the invoice classes for EDI (purchase) invoices. 
 

EPINVDEV 

Description: Tolerances for EDI invoice approval 

Usage: This allocation table contains possible tolerance values for assessing variances found 

during the approval process of an EDI invoice. 
 

EPINVSTAT 

Description: Statuses of EDI purchase invoices 

Usage: This allocation table contains the statuses of EDI purchase invoices. You have the option 

of opening the EDI purchase invoice, depending on its status according to this allocation table, 

and processing it further. The following statuses are possible: 

 

0: All 

20: Can be approved 

30: Contains errors 

50: Approved 

60: Canceled 

80: Rejected 
 

EPITEMGRP 

Description: Order release item groups 
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Usage: This allocation table contains flags in the item master for grouping items for an 

e-Procurement outline agreement into an outline agreement line (outline agreement handling of 

item order release groups). 

Note on Release 6.3: This allocation table is not in use at present. 
 

EPLADIFFL 

Description: Print keys for delivery advice difference list 

Usage: This allocation table contains settings for the supplier and item master that allow you to 

evaluate variances from e-Procurement delivery advice notes in a checklist. 
 

EPLISTTYPE 

Description: Document types 

Usage: This is an internal allocation table that flags the assignment of shipping materials to a 

transaction object (for example, to a purchase order or delivery advice) in shipping material 

processing. 

 
 

EPMODULI 

Description: Application modules 

Usage: This allocation table contains the flags used in message management that define 

whether a message communication is part of an e-Procurement or Automotive business process. 
 

EPOLAFASE 

Description: Order release processing phases 
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Usage: The flags contained in this allocation table control as of when a price is to be considered 

valid when creating prices in an outline agreement. 

Example: Price is valid as of delivery or as of invoicing. 

Note: This allocation table is not in use at present. 
 

EPOLAST 

Description: Statuses of outline agreements 

Usage: This allocation table contains information on the status of an e-Procurement order 

release outline agreement. The statuses allow you to selectively open order release outline 

agreements and control the options for processing the agreements further. 
 

EPOLASUSP 

Description: Outline agreement line statuses 

Usage: This allocation table contains information on the status of the outline agreement line. 

Depending on the status, the line can be processed further. 
 

EPOLATERM 

Description: Resource types in outline agreements 

Usage: This allocation table flags the type of outline agreement line. Purchased items and 

subcontracted activities are currently supported. 
 

EPOLATYPE 

Description: Outline agreement types 

Usage: This allocation table contains flags to differentiate between e-Procurement quantity 

outline agreements and value outline agreements. 
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EPPARALLEL 

Description: Transfer types (parallel) 

Usage: The parameters in this allocation table control whether messages should be printed or 

sent via fax at the same time that they are sent electronically. 
 

EPPREFER 

Description: Preference statuses 

Usage: This allocation table for delivery advice notes (in accordance with VDA4913, record type 

714) indicates the country of origin of the goods. 
 

EPPRICBAS 

Description: Price units 

Usage: This is an allocation table for the VDA price basis, which is different to the price basis in 

the Infor system. 
 

EPRORDERFIX 

Description: Fixing statuses of order releases 

Usage: Order releases can be fixed, for example, following manual editing, so they are not 

changed during an order release generation. This means that manual changes will not be 

overwritten by the next order release generation. The settings found in this allocation table also 

control when the fixing is lifted again. 
 

EPRORDERLCK 

Description: Order release statuses (prohibited or not) 
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Usage: This allocation table contains the quarantine flags for e-Procurement order releases. 

Order releases can be locked for further processing. For example, if order releases are prohibited 

(i.e. locked), no more requirements are generated; if delivery is prohibited, goods receipts are no 

longer allowed. 
 

EPROREQMODE 

Description: Modes for sending No requirement in order releases 

Usage: This allocation table contains flags related to the requirement situation during the 

shipping of e-Procurement order releases. 
 

EPROST 

Description: Order release statuses (header) in Purchasing 

Usage: This allocation table contains the header statuses of the e-Procurement order releases. 

Depending on the status, you have the option of opening the order releases and processing them 

further. 
 

EPROSTPOS 

Description: Order release statuses (line) in Purchasing 

Usage: The line statuses of the e-Procurement order releases are similar to the statuses in the 

order release header; see EPROST allocation table. 
 

EPSTOSTATE 

Description: Subcontractor inventory statuses 

Usage: This allocation table for delivery advice notes in accordance with VDA4913, record type 

714, field 20, forms the basis for subcontractor handling. 

Note: This allocation table is not in use at present. 
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EPTRUCKS 

Description: Truck type keys 

Usage: This is an allocation table for delivery advice notes in accordance with VDA4913, record 

type 712, Truck type keys field (appendix 10, line 10). It contains information regarding which type 

of truck is used to deliver the goods. 
 

EPVECOMPARE 

Description: Field replacements 

Usage: This allocation table is used for managing how the planned order release status is 

determined in the e-Procurement communication data in the supplier master. 

 
 

Subcontracted manufacturing (e-Procurement) 

For information on subcontracted manufacturing, click here. 

Order release outline agreements for subcontracted manufacturer services with a fixed price and 

requirements agreement are useful for series manufacturers and especially in the automotive 

supplier industry. 

The following overview provides important information on working with subcontracted 

manufacturing. 
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Master data 

Subcontracted activities You need to create a subcontracted activity first. In Purchasing, open the Master 

data folder and select Subcontracted activities. You can store the supplier on the 

Subcontracted manufacturer tab and the parameters for handling order release 

outline agreements or order release administration on the Communication tab. 

Note : Actual subcontracted activities are not planned. They are taken into account 

when the parent manufacturing material is planned. 

Suppliers You must store at least one supplier for the subcontracted activity. You can assign each 

supplier their own BOR using the Go to menu. 

Scaled prices When you create a supplier for the subcontracted activity, a data record without a price 

is created automatically on the Purchase prices tab. You can then create scaled 

prices for individual suppliers. 

You only need to create prices for subcontracted activities if the fixed price flag in the 

assigned outline agreement is not selected. Otherwise the price from the outline 

agreement is used. 

Packaging You can create packing instructions for material provided from subcontracted activity 

BORs. Go to the resource master and select Go to and then Packing instructions. 

Alternatively, you can create packing instructions from the item master for the material 

provided by again opening the Go to menu and selecting Packing instructions. 

To check the stored BOR for material provided and to load the packing instruction for 

the subcontracted activity supplier from the subcontracted activity, select Go to > 

Packing instructions. 

Communication Store communication data for the subcontracted activity for each supplier address on 

the Communication tab. If the data is already stored in the supplier master, it is 

displayed here and you can modify it. 

Usage 

BOR The subcontracted activity is indicated in the BOR by an SCO record. See Store 

subcontracted manufacturing in manufacturing structure. The subcontracted 

manufacturing structure with the individual records can be different for each supplier. 

It is maintained in a customized BOR and assigned to the relevant supplier. 

Planned/unplanned 

subcontracted 

manufacturing 

When you generate an order release, all subcontracted activities - rough planned and 

detailed - are taken into account. Therefore, if the order release procurement flag is 

selected on the Communication tab in the subcontracted manufacturing master 

data, both planned and unplanned subcontracted manufacturing activities are 

transferred to the order releases. 

Order release generation 
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Settings You can generate order releases manually using the Order release generation 

desktop object or using Batch control. 

When you generate order releases manually, a dialog box for transferring data to the 

order releases is displayed for the subcontracted activities you want to process using 

order releases (see the flag on the Communication tab in the resource). 

When you procure a subcontracted activity for an order release, you create a supplier 

with a valid outline agreement, which is assigned automatically. 

If you could not assign the resource (no valid outline agreement, order releases are 

prohibited, and so on), a log (page 1319) is output after you generate the order. 

Production order 

Schedule The duration of the subcontracted manufacturing activity is calculated in the OP lines 

of the subcontracted manufacturing structure. 

The Due field of the subcontracted manufacturing record (SCO record) contains the 

supplier's delivery date, and the Due field of the operation contains the supplier's PO 

date. 

The supplier's delivery date, which represents the arrival date for the goods recipient, 

is relevant for order release management. 

Release When you create a subcontractor PO, the discounts from the order release outline 

agreement are transferred to the PO. The price is only transferred if the fixed price flag 

is set. 

Otherwise, for example when scaled prices are used, the price is taken from the 

record for the PO quantity from the subcontracted activity master data. 

 
 

Time control (e-Procurement) 

All e-Procurement processes that can be automated can also be run as time-controlled processes. 

This requires the processes to be entered in Batch control. In addition, the start times and intervals 

must be coordinated individually. 

In the System functions module, open the Administration folder and select the Batch control 

object. Enter the required processes on the Status and Action tabs. 
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Reports (e-Procurement) 

To view e-Procurement reports, open the Purchasing folder and click Reports. This opens the 

Report overview dialog box. e-Procurement reports are flagged with the abbreviation EP. 

Note: You can influence the displayed lists by assigning user privileges. 

Rep. Contents 

Order release generation log This report generates an order release generation (page 1311) log. 

Order release backlog This report allows you to output order release backlogs by supplier. 

Order release status - check list This report allows you to verify cumulative order release quantities for defined 

suppliers. 

Master contact 

data for suppliers 

This report generates the contact data for the selected suppliers. 

 
 

Glossary (e-Procurement) 

This topic contains a glossary of terms specific to e-Procurement that are not included in the 

general glossary. 

Order release item 

An order release item is a purchased item that must be flagged as an order release item in the 

master data for the item. Requirements are generated for this item from Planning via the outline 

agreement and order release management function in the e-Procurement module. Manual 

exceptions can be made using standard purchasing procedures. 

Order release status, Release status, Rel status 

Whenever you send or print an order release, the status for all JIT lines and delivery order release 

lines is maintained separately. Each type has a unique release status ID. 
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JIT 

JIT deliveries according to VDA 4915. 

JIT horizon 

In the e-Procurement master data, you can define the period of time in days in which JIT deliveries 

are processed if the JIT flag is selected. This can be done for each item/supplier. 

JIT flag 

In the e-Procurement master data, you can specify whether individual items are handled using 

supplier JIT deliveries. 

DOR 

Delivery order releases according to VDA 4905. 

Delivery order release horizon 

In the e-Procurement master data, you can define the period of time in days in which delivery 

order releases are processed if the delivery order release flag is selected. This can be done by 

item/supplier, or by supplier alone.  

Delivery order release flag 

In the e-Procurement master data, you can specify whether individual items are handled using 

supplier delivery order releases. 

Load carrier 

Shipping material, Ship. mat. 
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Monthly demand 

In the e-Procurement master data, you can store the period in days in which requirements are 

grouped by month. This can be done by item/supplier. The requirement date is set to the 

beginning of the month to ensure timely coverage. 

Quotation 

 If an order release item or order release item group is procured from several suppliers, a 

percentage quota is stored in the outline agreement lines. The automatic generation process 

refers to this quota in order to distribute the individual requirements. 

Remaining requirement 

The remaining requirement period for delivery order releases is the period between the end of the 

monthly requirement period and the end of the delivery order release horizon. 

Immediate requirement 

In the e-Procurement master data, you can store the period in days for which a requirement is 

flagged as an immediate requirement for delivery order releases. This can be done per 

item/supplier. An immediate requirement is always a daily requirement. 

Daily requirement 

In the e-Procurement master data, the period of days for which a requirement is determined on a 

daily basis can be stored for delivery order releases by item/supplier. 

Weekly demand 

In the e-Procurement master data, the period in days for which requirements are grouped 

according to week can be stored by item/supplier. The requirement date is set to the beginning of 

the week to ensure timely coverage. 
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Maintain master data 

The following Help topics contain specific information on master data maintenance that is 

especially useful when working with e-Procurement. 

This includes the maintenance of plants and unloading points in the master data of your own 

company, as well as maintenance of the employees, supplier master, item master, and 

subcontracted activities. 
 

Maintain plants and unloading points 

To maintain plants and unloading points, complete the following steps: 

1. Select Sales > Master data > Customers. On the Open tab, select your own company by 

specifying Own company as the Type of company. 

Note: Your own company is configured via COMMON.ABSENDER in the configuration. 

2. Select View > Unloading points to switch to the unloading point. In the top address table, enter 

a plant for each required address in the corresponding field. 

3. In the bottom table, enter the required unloading points for the plant selected in the top table. 

Note: You must enter at least one unloading point for each plant. 
 

Maintain employees 

To maintain employee master data, complete the following steps: 

1. Select Sales > Master data > Customers and open your own company. 

2. Select View > Contact. In the bottom table, enter the corresponding contact person in your 

company for the address highlighted in the top table. 

3. To maintain the communication data, select Go to > Employee. 

4. Enter an abbreviation in the Abbreviation field. This abbreviation is sent along with delivery 

order releases. 
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Maintain supplier master data 

To maintain supplier master data, complete the following steps: 

1. Select Purchasing > Master data > Suppliers. Open the required supplier and select View > 

Contacts. 

2. You can store the relevant contacts in the lower table for each address selected in the upper 

table. 

Note: You can maintain the communication data by selecting Go to and Employee. 

3. Select the Company profile tab and, in the Ext. ID field, enter the ID assigned to your company 

by your supplier. 

Note: This ID must be unique for the EDI communication process. 

4. Select the Communication tab. To create new communication data, select the Communication 

data check box.  

Note: . The data is preset under COMMONSTD, where you can customize it to your needs. 
 

Maintain item master 

To maintain item master data, complete the following steps: 

1. Select Purchasing > Master data > Purchased items. Open the required item and select View 

> Planningto display the Planning tab. 

2. Set a value in the Rounding factor field to maintain a specific lot size for order release lines, for 

example to optimize fill quantities. 

3. Go to the Supplier tab and assign the item to the supplier. Make sure you are very careful 

when modifying external data, especially the external item ID. 

4. Go to the Communication tab, choose the correct supplier address, and then select the 

Item-specific data check box to overwrite the item-specific settings that the supplier predefined 

for this item. 
 



Infor COM 7.5 User Guide | 1297 

 

Purchasing 

 

Maintain subcontracted activities 

To create a subcontracted activity for which you want purchasing to be handled using delivery 

order releases, proceed as follows. 

1. In Purchasing, select Master data and open the subcontracted activity. 

2. On the Subcontracted manufacturer tab, enter the supplier. 

Note: At present, you can only enter one supplier. 

3. Select Go to and Subcontracted manufacturer BOR in the BOR. 

4. Create the BOR for the subcontracted activity. 

5. On the Communication tab, flag the subcontracted activity as an order release subcontracted 

activity (the procedure is the same as for an item. See Maintain item master (e-Procurement) 

(see "Maintain item master" page 1296)). 
 

EDI master data 

For general help with e-Procurement, see e-Procurement basics. 

For more information on this function, see EDI master data in the Automotive Help. The 

sales-related information found in this topic also applies to e-Procurement. 

In the EDI master data in e-Procurement, you can create EDI master data for each supplier 

address, business process (for example: delivery order release, delivery advice), and validity 

period. See Maintain EDI master data (e-Procurement) (see "Maintain EDI master data" page 

1297). 
 

Maintain EDI master data 

To maintain EDI master data (page 1297) for delivery order releases in e-Procurement, complete 

the following steps: 
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1. In Purchasing, open the e-PROCUREMENT folder, select EDI master data, and click the New 

tab. 

2. Select the EDI standard you require (for example, 4905 for delivery order releases). 

3. Enter the unique EDI ID for the supplier. This ID is required for communicating via Electronic 

Data Interchange. 

4. Specify the validity date from which you want EDI communication for this process to begin. 

5. Select Create to confirm your entries. 

6. In the form header, enter the required EDI profile and, if you like, a comment in the Remarks 

field. 

7. Save your entries. 
 

Order release outline agreements 

 

For general help with e-Procurement, see e-Procurement basics. 

To create and edit order release outline agreements, select the e-PROCUREMENT folder in 

Purchasing and then select the Order rel. outl. agreements object. 

Please note: To create an outline agreement, you must first correctly populate the fields on the 

Communication tab of the supplier/item master and create EDI master data for the supplier 

address. 

In an order release outline agreement in e-Procurement, you agree with a supplier that you will 

receive, within a set period of time, specific items and/or item groups/subcontracted manufacturing 

activities, divided into various delivery quantities in accordance with specific delivery and payment 

terms. 

An order release outline agreement can be either quantity-based or value-based. 

 For quantity-based order release outline agreements, a total quantity and a remaining quantity 

are managed for each item and/or item group/subcontracted manufacturing activity. The 

remaining quantity of a line is the difference between the total quantity of this line and the sum 

of the quantities released in all order releases processed by this line. 

Note the setting of the COMMON.EPROCUREMENT.DISTRIBUTEOLABALANCE parameter 

here. 
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 For value-based order release outline agreements, a total value and a remaining value are 

managed not only for each item and/or each item group/subcontracted manufacturing activity 

but also for the order release outline agreement. 

An order release outline agreement ine-Procurement is, in contrast to a standard outline 

agreement (see "Outline agreements" page 1241), specially tailored to releases (see "Order 

releases" page 1305) and contains special features detailed below. 

An order release outline agreement consists of a header (containing general information on the 

supplier, term of order release outline agreement, etc.) and the corresponding lines. 

The order release outline agreement header contains data valid for all lines; an order release 

outline agreement line contains line-specific data for one or more items/item groups/subcontracted 

manufacturing activities. 

 When creating an order release outline agreement, the unloading point, plant, consumption 

center, and planner are created as default settings for the order releases. 

 Changes in the unit price of a line are stored in the price history (see "Display price history of 
an order release outline agreement line" page 1303). 

 You can modify the upper and lower tolerance (see "Change upper and lower tolerance of an 
order release outline agreement line" page 1303) of an order release outline agreement line 

during the term of an order release outline agreement as long as the status of said agreement 

is not Archived. The status of this line should be reset after these modifications. 

Validity 

A valid outline agreement must meet the following prerequisites: 

 Supplier master data with communication data must exist. 

 EDI master data must exist for the delivery order release process. 

 A Term from/To must exist. 

Prerequisites 

To create a new outline agreement line, the following requirements must be met. 

Note: Lines can be entered for purchased items and subcontracted activities. 

 The supplier must be assigned to the resource. 

 The resource must be flagged as an order release item or order release subcontracted activity 

in the master data. 

 No other outline agreement with this supplier address can exist in the same period of validity 

for this resource. 

 The resource must not already exist in the outline agreement (with the exception of closed 

lines) 
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You can set default values for outline agreement lines in the COMMONSTD section of the 

configuration. 

Subcontracted activities 

Transactions for order release outline agreements for subcontracted activities differ from those for 

outline agreements for purchased items as follows: 

 Delivery order releases act as forecasts only. They are not used for shipments. Instead, 

shipments are made according to subcontractor purchase orders created by the release of 

goods from manufacturing. 

 Prices/discounts for subcontracted manufacturing orders also come from e-Procurement order 

release outline agreements, but the outline agreement can disable fixed prices and replace 

them with prices from standard price agreements. 

 You can only create one outline agreement for each subcontracted manufacturing resource. 

This means that only one supplier can be used per subcontracted manufacturing resource. 

 e-Procurement supports shipping material management for materials provided and 

subcontracted activities. 

 The PO overview function is only available for outline agreement lines with subcontracted 

activities. It is not available for items. 
 

Edit states and statuses in order release outline agreement 

For general help with order release outline agreements, click here (see "Order release outline 

agreements" page 1298). 

Please note the following information on the states and statuses of an order release outline 

agreement: 

The states for an outline agreement are stored in the EPOLAST allocation table, and the 

statuses are stored in the EPOLASUSP table. 

 A newly created order release outline agreement automatically receives the state New (in 

other words, the order release outline agreement is set up, but order releases are not yet 

created based on this agreement) and the status Active (in other words, not prohibited). You 

can only delete an order release outline agreement if its state is New. 

 An order release outline agreement can be locked (prohibited) at any time; the reason why it is 

locked is saved. No new order releases can be created on the basis of a locked order release 

outline agreement until it is unlocked (released); any order releases that had been sent prior to 

the locking are completed. The outline agreement can be unlocked at any time, but the 

requirements will only be recreated when the next generation process is carried out. 

 When the first order release has been created for the order release outline agreement, it 

receives the state Order release(s) created. 
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 As soon as the order releases for at least one line have been sent, the state of the order 

release outline agreement is set to Order release(s) sent. 
 When the last open line of an order release outline agreement has been completed, the 

agreement is closed automatically and it receives the state Closed. Use the Close order 

release outline agreement function to close an agreement manually. An agreement is closed 

manually when all open lines can be closed. Once closed, it becomes available for archiving. 

 

Similar to the states of an order release outline agreement, the following states are relevant for 

order release outline agreement lines: 

 When a new line is inserted, the item-specific and supplier-specific line data is entered by 

default from the master data. It can be modified based on the appropriate order release outline 

agreement. The newly inserted line automatically receives the state New. A line can only be 

deleted when its state is New. 

 As soon as the first order release has been created for a line, this line receives the state 

created. 

 After the first order release for this line has been sent, the line receives the state Order 
release(s) sent. 

 When the released quantity or the value reaches the lower tolerance (see "Change upper and 
lower tolerance of an order release outline agreement line" page 1303), the line receives the 

state Fulfilled; when it reaches the upper tolerance (see "Change upper and lower tolerance of 

an order release outline agreement line" page 1303), it receives the state Fulfilled to max. 

 When the released quantity or the value of a line reaches the upper tolerance, this line is 

automatically closed. You can use the Close order release outline agreement line function to 

close an order release outline agreement line manually, regardless of what quantity has 

already been released. If you change the unit price of a line, the new unit price, validity date, 

and so on are included. The new unit price applies to any order releases that have been 

processed through this line and whose release, advance shipping notice, goods receipt, or 

invoice date (depending on the setting used during the price change) is the same as or later 

than the validity date. 

An order release outline agreement line can have one of three statuses: 

 Active: Order releases can be processed through this line. This status is assigned to the line 

automatically when it is created. 

 Order release prohibited: No further order releases can be generated or sent for this line; order 

releases that have already been sent will be completed. 

 Delivery prohibited: For this line, no new order releases can be created or sent, and goods 

cannot be received. 
 

Lock order release outline agreement 

For general help with order release outline agreements, click here (see "Order release outline 

agreements" page 1298). 
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If you lock an order release outline agreement, no further order releases will be handled by this 

agreement. Processing of order release messages that have already been sent will be terminated. 

To lock an order release outline agreement, proceed as follows: 

1. In Purchasing, choose e-PROCUREMENT and then Order rel. outl. agreements. 

2. You lock an order release outline agreement by selecting the Order release prohibited option 

in the Status field in the outline agreement header. Once this check box has been selected, 

the system displays a dialog box that allows you to enter the reason the order release outline 

agreement was locked. When a reason is entered, it appears in the order release outline 

agreement header view and can be modified there. 

Note: If outline agreement lines with differing statuses exist, the dialog box will issue a 

warning to allow you to convert the status of all lines. 

3. Confirm your entry by clicking OK. 

4. To release the lock, select Active from the list box for the Status field in the order release 

outline header. 

As an alternative to locking the entire order release outline agreement, you can also lock 

individual lines. Use the list box on the Handling tab for the order release outline 

agreement to lock a line. The following is a list of alternatives. 

 Active 

 Order release prohibited 

 Delivery prohibited 

For more information, see Edit states and statuses in order release outline agreement 

(page 1300). 

Note: Order release outline agreements/lines are unlocked in the same way as statuses 

are converted. 
 

Delete order release outline agreement 

For general help with order release outline agreements, click here (see "Order release outline 

agreements" page 1298). 

You can delete an order release outline agreement or individual order release outline agreement 

lines. 
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You can only delete an order release outline agreement or a line if its state is Order release(s) 

created or New. Deletion is not permitted for the other states. 

When an order release outline agreement is deleted, the system checks whether all lines can be 

deleted. If this is the case, the order release outline agreement can be deleted. If the status of a 

line is Created, it may be deleted under certain circumstances. All order releases handled by this 

line must be deleted first and the status of the line must be set to New. 

To delete an order release outline agreement, proceed as follows: 

1. From the Data menu, select Delete. 

2. If you respond to the query by clicking Yes, the order release outline agreement will be 

deleted. 
 

Display price history of an order release outline agreement line 

For general help with order release outline agreements, click here (see "Order release outline 

agreements" page 1298). 

You have the option of retroactively changing the prices for order release outline agreement lines. 

You change prices using the Price changes dialog box. 

You can display changed prices in a price history. To do this, proceed as follows: 

1. Open the relevant order release outline agreement and highlight the line for which you want to 

display the price history. 

2. Choose Functions and Price history line. 

If available, the chronology is displayed in descending order. 
 

Change upper and lower tolerance of an order release outline agreement line 

For general help with order release outline agreements, click here (see "Order release outline 

agreements" page 1298). 

To determine the upper and lower tolerances for a line in an order release outline agreement, 

proceed as follows: 
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1. Open the order release outline agreement in Purchasing by opening the e-Procurement folder 

and selecting Order rel. outl. agreements. 

2. Select View and Order release outline agreement line to display the Handling tab. 

3. Specify the percentage values for the tolerances in the Tolerance from/to fields. 

Note: When the upper or lower tolerance of an order release outline agreement line is 

modified, the status of this line is set as follows: 

Field Increase Decrease 

Tolerance 

from 

Status is changed from Fulfilled to Active if 

Tolerance from has been increased so 

that the contractual quantities/values no 

longer reach the Tolerance from value. 

In all other cases, the status remains 

unchanged. 

Status is changed from Active to Fulfilled if 

Tolerance from has been decreased so that 

the contractual quantities/values reach the 

Tolerance from value. 

In all other cases, the status remains unchanged. 

Tolerance to The status is changed from Closed to 

Fulfilled if Tolerance to has been 

increased so that the contractual 

quantities/values do not exceed this 

Tolerance to value. 

In all other cases, the status remains 

unchanged. 

Status is changed from Fulfilled to Closed if 

Tolerance to has been decreased so that the 

contractual quantities/values exceed this 

Tolerance to value. 

In all other cases, the status remains unchanged. 

When the status of this line is changed from Closed to Fulfilled by increasing its upper 

tolerance, the system checks whether the order release outline agreement has the status 

Closed. If so, this status is changed from Closed to Fulfilled. 
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Order releases 

To access order release administration, from Purchasing open e-Procurement and select Order 

releases. 

This Help topic covers the basics of order release management and explains the terms release, 

order release, and order release status. 

The Order releases object manages all order releases according to the requirements of each order 

release outline agreement line. If specified in the master data and order release outline 

agreements, resources (receipts) from rough planning are transferred to the order releases. Order 

release lines are automatically generated, taking into account the current parameters of the order 

release outline agreement management and the item's master data. 

There are two ways of entering the requirements determined: 

 They can be transferred automatically (time-controlled) to the order releases using a batch 

process. The process includes all items to be procured automatically by order releases in 

Purchasing. (This is indicated by the relevant flag on the Communication tab in the item 

master.) 

 They can be created manually with order release lines using the Order releases object if the 

requirements have not been transferred by Planning. To do this, from the order release select 

Functions and Edit lines. 

If at least one valid order release outline agreement exists for this item, order release lines will be 

created to cover this requirement. If more than one valid order release outline agreement exists, 

requirements are divided up according to the quotations in the order release outline agreement 

line. If no order release exists, a new one will be generated automatically based on the order 

release outline agreement. 

Note: All order release items that cannot be assigned to a valid order release outline agreement 

are saved in a a log. Then, after each generation process, an evaluation list can either be sent 

automatically to a printer specified in the configuration or, if necessary, printed later. In addition, a 

Workflow process can be used to send update messages, and a mailbox entry is created. 



1306 | Infor COM 7.5 User Guide 

 

Purchasing 

 

Order release 

An order release differs from an order release outline agreement in the following ways: 

While order release outline agreements are general agreements on the delivery of specific 

quantities of one or more items (including subcontracted activities), order releases are always 

based on a specific outline agreement line. 

 

The term order release is therefore used to describe a container for the current releases of an item 

that are processed on the basis of specifications in an order release outline agreement. 

 

An order release provides an overview of the releases that have actually been completed during 

the term of an order release outline agreement along with the current release statuses and 

requirements. 

An order release is a continuous order that remains in place until the agreed release quantity has 

been fulfilled and, if necessary, beyond that point. 

An order release based on the terms of the order release outline agreement is created for each 

item. Then the current status is updated by the order release generation process based on the 

current planning situation, and it is subsequently sent to the supplier. The order release is 

therefore adjusted according to the new requirement transactions (releases). 

An order release lets you perform tasks such as the following: 

 Create and edit manual order releases 

 Edit releases generated by the system 

 Modify order release lines and send them to suppliers on paper (fax/document printing) or by 

EDI/SupplyWeb according to information included in the item master 

 Send order release data (via EDI or SupplyWeb) 

 

The order release contains the following components: 

 The order release header containing item- and supplier-specific data, status data (release 

status, cumulative quantities, and so on), and data for communication with suppliers (plant, 

unloading point, consumption center, and so on). 

 The order release lines. The lines contain requirements within the delivery release time 

horizon that are sorted by delivery date. They are assigned using the delivery order release 

horizon and are divided into backlogs, immediate/daily/weekly/monthly and remaining 

requirements on the basis of due date ceilings entered in the e-Procurement master data. 

An order release must be assigned to a line in an order release outline agreement. 



Infor COM 7.5 User Guide | 1307 

 

Purchasing 

 

When an order release is created automatically by the generation process, the order release 

outline agreement data (for example, plant, unloading point, delivery interval) is used as a 

template. If required, this data can be modified specifically for an individual order release. 

When the order release is opened, the data of the new current status to be sent is always 

displayed. The data, which is identical to the sent data once it is transmitted, is updated during the 

next generation process. To display sent order releases, open the Functions menu and choose 

Display sent order releases. 

In an order release, the Order release line tab displays the requirements within the delivery 

release time horizon by delivery date. They are assigned according to delivery order release type 

using the delivery order release horizon and are categorized into backlogs, 

immediate/daily/weekly/monthly and remaining requirements based on the due date ceilings 

entered in the e-Procurement master data. 

Releases, Order release statuses 

An order release can consist of several release headers with assigned lines of varying statuses. 

This is because the old status of order release data is saved every time it is sent, and a new 

current order release status is generated. When the order release is opened, the data of the new 

current status to be sent is always displayed. The data, which is identical to the sent data once it is 

transmitted, is updated during the next generation process. All sent statuses can be displayed. 

While an order release is always assigned to an order release outline agreement line and 

manages the current order release status as well as the sent order release statuses, a release 

describes the process and documents the sending of a release status. In contrast, release status 

defines the data in a release that has been sent. 

Releases can be sent manually or automatically. The current status of an order release can be 

created and edited manually or it can be generated automatically by the order release generation 

process. 

Note: To prevent manually entered order release data from being overwritten by the next 

automatic generation process, you can fix these modifications using the list box for the Fixing field. 

You can also specify whether the fixing should automatically be canceled the next time data is 

sent. 
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Maintain order releases 

A number of functions are provided for maintaining order releases. The following table provides an 

overview of these functions: 

Change order 

release header 

You can manually edit existing current statuses and modify automatically generated order 

releases. To avoid modifications being overwritten during the automatic generation process, 

you can flag this fixing in the order release header. See Order release header 

(e-Procurement). 

Delete You can delete order releases that have not yet been sent. In this case, the outline 

agreement line must also be deleted. Otherwise the next generation process will include the 

order release header again. 

Lock You can prohibit delivery and order releases in the order release header. In both cases, no 

further requirements are generated or sent. If delivery is prohibited, all additional deliveries 

are rejected. All lines are automatically deleted when these locks are set. 

Close Order releases are automatically closed if the corresponding outline agreement line is 

closed. 

 

To edit order release lines manually, proceed as follows: 

1. Open the order release. 

2. Select Functions and Edit lines. 

3. Edit the required line, or delete a line by entering the quantity 0. You can also create new lines 

by specifying the required quantity. 

4. If you want to accept all the lines with the quantities that have been created and add them to 

the line table, confirm by clicking OK. 
 

Confirm frozen zone lines 

In e-Procurement handling, suppliers receive requirements in the form of automatically generated 

delivery order releases. 
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Regardless of the supplier's ability to deliver, it is assumed that the requirements (quantities) 

identified by Infor COM can be delivered by the specified due dates. However, in practice this is 

not always the case. 

Infor COM therefore lets you fix periods and quantities for suppliers in the order release for a 

specific period (Frozen Zone), following which you can view any delays. 

The steps listed below show the Frozen Zone in use. The supplier transmits the order 

confirmations in the usual way (telephone, fax, e-mail). 

Note: For this function to work, the following setting is necessary: FrozenZoneActive=yes. 

1. Go to Purchasing > e-PROCUREMENT > Order rel. outl. agreements. Select View and Order 

release outline agreement line, and click the Releases tab. 

2. In the Frozen Zone form section, specify the Lead days and the fixing period. 

3. Using Order releases, open the order release that you require. Then select Functions and Edit 

lines. 

4. Select the Confirmed check box for the lines that you want to confirm or fix. 

5. If necessary, specify when the confirmation period ends using Confirmed to. 

Note: You can extend this period manually if, for example, you do not want a delivery to take 

place the next day. 

Please note: During order release generation, requirements that accrue during the 

confirmation period and which are not covered by the confirmed order release lines are set 

after the end of the period concerned. In this case, the generation process enables the 

Delay flag. 
 

Send releases 

For general information on order releases, see Order releases (page 1305). 

We generally recommend that you use the Batch control function for sending releases. However, 

releases can also be sent separately from the order release. To send releases, complete the 

following steps: 

1. Assign the transfer type on the Communication tab in the master data for the item or supplier. 
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2. If you have not already done so, enter the EDI master data for the supplier’s address ID for 

EDI standard 4905. 

Example: For the EDI transfer type, enter the delivery order release EDI profile. 

3. To send releases automatically, complete the following steps: 

 In System functions, select Administration and Batch control. 

 Click the Status and Action tabs one after the other, and complete the fields according to 

the table below. 

 Complete the rest of the fields in line with your requirements. 

 Select the Act. check box on the Status tab and save the current entries. The Accepted 

check box should now be selected by the system. 

Side Field Input 

Status Job Send EP order release(s) 

Action Action eProc.Export.al_TimerStartBatch 

4. To send releases manually, complete the following steps: 

 Open the Order release from which you want to send the release data. 

 From the Functions menu, select Send delivery order release. Once it is sent, the status is 

set to Sent. 
Please note: Errors can be analyzed in the Message editor. 

 Open the Functions menu and select Display sent order releases to bring up an overview 

of the releases sent for the order release. 
 

Display packing instructions for order release 

For general information on order releases, see Order releases (page 1305). 

This function is available in order releases, in order release outline agreements (with restrictions), 

and in purchase orders. 

To display the packing instructions for an order release, complete the following steps: 

1. Open the order release in Purchasing by selecting the e-PROCUREMENT folder followed by 

Order releases. 

2. Using the View menu, go to the Order release header or Order release line. 

3. Select Go to and Packing instructions. 

The system will display all relevant packing instructions in an overview sorted by priority. The 

most suitable instructions are placed at the top of the list. 
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4. Select Go to and Shipping materials to switch from the packing instructions to the shipping 

material master data view. 
 

Order release generation 

For general information on order releases, see Order releases (page 1305). 

Use the Order release generation object to initiate the order release generation batch process. 

The resources generated by Planning in Rough planning will be transferred to order release 

management if the master data and outline agreements have been configured accordingly. See 

also Order release generation details (page 1312). 

In the process, corresponding order release lines (and order release headers, if they do not 

already exist) are automatically generated, while taking into account current parameters from 

e-Procurement outline agreement management and the e-Procurement resource master data. 

Order release lines can be modified in order release management and transferred to the supplier 

on paper (fax/printout), by conventional EDI, or by SupplyWEB. 

The following points must be taken into consideration: 

 The resources created by planning (order release resources are generally rough planned by 

the system) can be transferred to order release management manually or by means of 

time-controlled batch processes. The process includes all resources to be procured 

automatically by order releases in Purchasing (according to flags in item/subcontracted activity 

masters). 

 If there is at least one valid order release outline agreement (see "Order release outline 

agreements" page 1298) for a resource, order releases will be generated for its requirements. 

 If more than one valid order release outline agreement exists, requirements are divided up 

according to the quotation (page 1313) in the order release outline agreement line. If no order 

release exists, a new one will be generated automatically based on the outline agreement. 

 All order release items that could not be processed correctly (because, for example, they are 

locked or do not have a valid outline agreement) are saved in a log with a detailed description. 

Then, after each generation process, an evaluation list can either be sent automatically to a 

printer specified in the configuration or, if necessary, printed later. In addition, a Workflow 

process can be used to send update messages. During each process, the system generates a 

mailbox entry that provides information about errors. 
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Note: If the total quantity of the rough planned orders exceeds the outstanding quantity of the 

outline agreement, the differential quantities are not used to generate order release lines and the 

purchaser is missing the required resources. If an outline agreement is fulfilled on the basis of 

quantity, but there are more requirements (rough planned orders) occurring within the period of the 

outline agreement, the requirement is transferred to the next outline agreement that still has free 

capacity. It is important that there is another outline agreement which can accept further 

quantities. A new outline agreement is not generated.  

Example: Outline agreements 1, 2, and 3 exist for an item, but only outline agreement 3 has free 

capacity. 

The generation log shows which quantities/due dates are transferred to which order release. 

Quotas are not applied. You can configure this process using the 

COMMON.EPROCUREMENT.DISTRIBUTEOLABALANCE parameter. 
 

Order release generation details 

The following points provide a detailed overview of the processes carried out during order release 

generation (page 1311). 

The Release procurement flag on the Communication tab in the item master must be set before 

you can proceed with order release generation. All valid purchased items with this flag are 

included in the order release generation process. 

 Order release outline agreement lines are loaded for each selected item. Item-specific lines 

are given priority over item group-specific lines. If no valid outline agreement line exists, a log 

will be created. 

 The order release data for the order release outline agreement lines is loaded. If no order 

release exists yet for an order release outline agreement line, an order release is automatically 

created from the line data and an entry is generated in the cumulative quantities table. 

 The order release outline agreement lines with the last status are deleted in the releases. 

 The rough planned orders for the item are loaded by planning according to delivery date (LD). 

All orders within the item’s maximum delivery order release/JIT horizon are included. 

If no rough planned order exists (or the order release outline agreement, item, or order release 

has not been released), each order release has an order release line with the No requirement 

ID. 
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 If at least one valid order release outline agreement line with a valid order release exists, a 

quotation is calculated for every rough planned order. This is because each quotation depends 

on the delivery date of the requirement. Even if only one valid order release exists, the 

quotation must be included in case it is less than 100%. 

If it is not possible to calculate a valid quotation (page 1313), a log (page 1319) is created. 

If at least one valid quotation exists, the requirement will be divided according to the quotation. 

 The allocated requirements are then added to each order release separately in sequential 

order of the horizons entered in the master data. The weekly, monthly, and remaining 

requirements are summarized according to the due date ceilings specified in the master data, 

and the immediate requirements and backlogs are calculated. 

 The current status is calculated for each order release, and the order release is saved. 

 Item processing is now complete. If there are no other items to be processed, generation is 

complete. 

 The log is saved. You can also initiate Workflow, or print directly to a configured printer. 
 

Quotation 

The quotation plays an important role in order release generation (page 1311). 

Principle: If an order release item or an order release item group is procured from several 

suppliers, a percentage quota is stored in the outline agreement lines. The automatic generation 

process refers to this quotation in order to individually distribute the requirements. 

In the configuration, you can set different procedures and plausibilities for the quotation. 

 

Setting 1: Distribution on 100% basis only 

Prerequisites for the distribution 
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Prerequisites Distribution 

The prerequisite for correct distribution of the requirements within the 

order release generation is met by means of the quotation. 

Because quotations can be item-specific as well as group-specific, and 

because, taking account of all related order release outline agreements, 

they must add up to exactly 100 percent to ensure correct distribution, the 

following plausibilities are checked at the time of entry: 

If only one order release outline agreement line exists for an item or an 

item group, and if no quotation is specified, a quotation of 100% is 

assumed. 

If only item-specific quotations exist, their total must be 100% 

If only group-specific quotations exist, their total must be 100% 

If both item-specific and group-specific quotations exist, the total of the 

item-specific quotations must be <= 100% and the total of all quotations 

must be >= 100% 

If the total is > 100%, the non-item-specific portion is distributed pro rata 

to the group-specific quotas. 

Note: These prerequisites must be met within the maximum JIT/delivery 

order release horizon, even after the validity of individual outline 

agreements has expired. 

For all combinations, the distribution is 

made uniformly as per the following: 

Each order release outline agreement 

line with an item-specific quota 

receives the corresponding 

requirement in percent. If the total of all 

item-specific quotas is less than 

100%, the difference yet to be 

distributed to specific groups is 

distributed pro rata to the 

group-specific quotas. 

 

Distribution formula 

 

Rounding differences are assigned to the order release outline agreement contributing the largest 

portion. 

 

Example 

For a requirement of 1000 items by June 10, the result is an item-specific portion of 700 items and 

a group-specific portion of 300 items. 
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Order release outline agreement Item-specific quota Group-specific quota Valid until 

OA1 60 30 30.06 

OA2 10 20 15.06 

OA3 0 10 30.06 

According to the formula, the distribution is as follows: 

600=[1000*60/100] + 150=[300 * 30/(30+20+10) ]=750 to OA1 

100=[1000*10/100] + 100=[300 * 20/(30+20+10) ]=200 to OA2 

0=[1000*  0/100] +   50=[300 * 10/(30+20+10) ]=  50 to OA3 

 

It would not be possible to distribute a requirement of 1000 items by June 28, because the 

quotation basis at that time would only be 70%. As a result, this order is ignored and an error log is 

written. 

 

Advantages/Disadvantages 

Advantages Disadvantages 

The distribution is always carried out correctly based on 

the quotas that are fully entered for all suppliers. If, for 

example, quotas of 20 and 50 percent exist for two 

suppliers, the entire 100% will not be distributed to these 

two suppliers because they may not be able to supply 

those quantities. In this case, the purchaser will be 

informed and can intervene for control purposes by 

changing the quotas. Therefore, it is the purchaser - and 

not the system - who decides how to proceed in such 

exceptional situations. 

If these conditions are not fulfilled for individual 

requirements, no order releases are generated for 

these requirements. Therefore, the requirement is not 

met, and the purchaser must intervene as quickly as 

possible. 

There must be a 100% quota at all stages within the 

maximum delivery order release/JIT horizon. This is 

not always easy to ensure. For example, in case of a 

quarantine or in the event of other changes, the quotas 

must always be readjusted to total 100%. 

Setting 2: Full distribution even if quotas are less than 100% 

Prerequisites for the distribution 
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Prerequisites Distribution 

At least one quota must exist. 

Note: This prerequisite must be met within the total 

delivery order release horizon, even after the validity of 

individual outline agreements has expired. 

The basis for distribution is the total of all valid 

quotations on the delivery date of an order release. 

 

Formula 

Quotation basis QB = ΣQuotas (item-specific and group-specific) 

OA portion = Requirement * Quota/QB 

Rounding differences are assigned to the order release outline agreement contributing the largest 

portion. 

 

Example 

Order release outline 

agreement 

Item-specific 

quota 

Group-specific quota Valid until 

OA1 60  30.06 

OA2 10  15.06 

OA3   0 10 30.06 

For a requirement of 1000 items by June 10, this means the following: 

Quotation basis = 80 (60+10+10) 

 

750=[1000*60/80]  to OA1 

125=[1000*10/80]  to OA2 

125=[1000*10/80]  to OA3 

For a requirement of 1000 items by June 28, this means the following: 

Quotation basis = 70 (60+0+10) 
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857.14=[1000*60/70]  to OA1 

0.00=[1000*0/70]  to OA2 

142.86=[1000*10/70]  to OA3 

A log is written as a warning. 

 

Advantages/Disadvantages 

Advantages Disadvantages 

The advantage of this setting is that the complete 

requirement is distributed and coverage is therefore 

always available. 

A disadvantage is that there is a possibility that required 

quantities are distributed among suppliers who may not be 

able to supply these quantities. 

When a quotation basis of < 100% is used, a log entry is generated as a warning. 

Setting 3: Partial distribution even if quotas are less than 100% 

Prerequisites 

Prerequisites Distribution 

At least one quota must exist. 

Note: This prerequisite must be met within the total delivery order release 

horizon, even after the validity of individual outline agreements has expired. 

The basis for distribution is 100%. 

 

Formula 

 

Rounding differences are assigned to the order release outline agreement contributing the largest 

portion. 

 

Example 
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Order release outline agreement Item-specific quota Group-specific quota Valid until 

OA1 60  30.06 

OA2 10  15.06 

OA3   0 10 30.06 

For a requirement of 1000 items by June 10, this means the following: 

600=[1000*60/100]  to OA1 

100=[1000*10/100]  to OA2 

100=[1000*10/100]  to OA3 

As a result, 200 items are not distributed. 

For a requirement of 1000 items by June 28, this now means the following: 

600=[1000*60/100]  to OA1 

0=[1000*0/100]  to OA2 

100=[1000*10/100]  to OA3 

As a result, 300 items are not distributed. If the entire requirement cannot be distributed, a log 

entry is generated as an error. 

 

Advantages/Disadvantages 

Advantages Disadvantages 

If a quotation is not complete, order release lines 

are generated at least for the portion of the 

requirement that can be distributed according to the 

quota arrangement, and this portion is covered. 

Suppliers are not assigned quantities that they may 

not be able to supply. 

A significant disadvantage is that partial requirements may 

not be covered. However, because the purchaser receives 

an error message, he can intervene for control purposes by 

changing the quotas and triggering a new generation 

process (for example, a manual generation process for this 

item), or he can obtain quantities from other suppliers by 

following standard purchasing procedures. 

 

 

In all distribution procedures, it is ensured that, in addition to these quotations, distributions do not 

exceed the maximum tolerance limit and that no distribution can be made to quarantined order 

releases. 
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Because it can happen that the period of validity of one or more order release outline agreements 

expires within the horizon in question, the quotation basis is recalculated when the valid range is 

exceeded. The same applies to various JIT/delivery order release horizons. 

When weekly demands, monthly demands, and remaining requirements are combined within 

these data ranges, only those rough planned orders that lie within the period of validity are 

distributed. This is the case when the period of validity ends within the week/month or within the 

remaining period. 
 

Log 

For general help with e-Procurement, see e-Procurement basics. 

All warnings and error messages that occur during order release generation are logged in a table. 

The log can be printed as follows: 

 Manually in Purchasing by selecting Reports and Order release generation log. 

 Immediately following a generation process (for example, after a time-controlled process at 

night), provided this has been set up accordingly in the configuration. The mailbox logs any 

errors that might occur. 

Note the following about the settings: 

RoDirectPrinting=yes activates direct printing following the generation run 

RoGenProtocolName specifies the name of the log to be printed 

RoDirectPrinter specifies the printer for outputting the log. 
 

Cumulative quantities 

Cumulative quantities are used to monitor the status of an order release without looking at 

individual lines. They allow you to monitor goods receipts. 
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Cumulative quantities in e-Procurement are required for checking the delivery status of order 

release outline agreements (page 1298) and order releases. They are key figures that indicate the 

quantities accumulated from a cut-off date. Not only are they important for you, they are also 

transferred to the supplier. They allow you to compare planned and actual delivery quantities 

easily. In situations where requirements vary frequently, they provide an overview of the current 

status and recent changes. 

The following cumulative quantities are of interest: 

 Cumulative received quantities (CRQ) are the agreed delivery quantities that have already 

been received and confirmed by the goods recipient, in other words, the total of all posted 

goods received for an order release. They are updated in Goods receipt and managed as 

absolute values throughout the entire term of an order release outline agreement and as 

relative values starting on a cut-off date for each type of order release. 

 Cumulative delivered quantity (CDQ): Cumulative delivered quantities are the quantities for 

which an advance shipping notice was created and transferred by the supplier, in other words 

the total of all notified delivery advices (see "Delivery advice" page 1322) for an order release. 

Cumulative delivered quantities are updated each time new delivery advices are imported and 

managed as absolute values (throughout the entire term of an order release outline 

agreement) and as relative values (from a cut-off date). If no EDI advance shipping notice is 

being used, the cumulative delivered quantity equals the cumulative received quantity. 

If the goods are received at the same time as the advance shipping notice, both cumulative 

quantities are updated. 

In the context of cumulative delivered quantities, there is no difference between delivery order 

releases and JIT deliveries. 

The difference between cumulative received quantities and cumulative delivered quantities is 

the quantity that was notified by the supplier but not yet received by the customer. 

 During planning, the current cumulative received quantity is used as the cumulative required 

quantity (ReqCQ), which is generated by planning and returns the quantity (requirement) 

requested by the supplier on a particular date. 

The current planning process copies the current absolute and relative cumulative received 

quantities to the cumulative required quantities. Goods received after planning increase the 

cumulative received quantities, resulting in a difference between the cumulative received 

quantities and cumulative required quantity. This difference is taken into account when the 

cumulative release quantity is calculated. 

 A cumulative order release quantity (CORQ) is the sum of the absolute (relative) cumulative 

required quantity minus the cumulative received quantity plus the total release quantities up to 

and including the release date. 

It is shown for each release date, and a distinction is made between delivery order releases 

and JIT deliveries. It is updated each time a delivery order release, JIT delivery, or 

manufacturing order release is displayed. It allows you to determine goods received since the 

release status was generated. Delivery advices can also be taken into account. 

 

Example: 
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From To Time type Explanation 

0:00 6:00 Posting time; 6:00 See Posting time in the previous example. 

6:00 8:00 Flextime See Flextime under Interval in the table in the 

Details form section. 

8:00 15:00 Basic shift; Automatic time 

account: 255, Basic shift 

violation 

See Basic shift in the previous example. 

9:00 9:15 Break; Break deduction 

[hr]: 0.25 

See Break in the previous example. 

12:00 12:30 Break; Break deduction 

[hr]: 0.5 

See Break in the previous example. 

15:00 18:00 Flextime See 6:00-8:00 

18:00 24:00 Posting time; 18:00:00 See Posting time in the previous example. 

24:00 24:00 Lockout time; 14:00 See Lockout time in the previous example. 

 

Note the following also: 

 Cumulative planned quantities are not required in e-Procurement. 

 The quantity in transit, which has already been advised but not yet received, equals the 

cumulative delivered quantity minus the cumulative received quantity. 

Note: In the Cumulative quantities object, the Advance shipping notice (ASN) overview 

allows you to view all supplier advance shipping notices, whereas the Invoice overview 

allows you to view all purchase invoices. Use the Change history menu command to view 

any logged manual changes. 
 

Set to zero 

To calculate new cumulative quantities (page 1319), proceed as follows: 

In Purchasing, open the e-PROCUREMENT folder and choose Set to zero to set the relative 

cumulative quantities to zero for one or more suppliers. 

Result: The cumulative received quantity and cumulative delivered quantity are reset to 0, and 

then all outstanding delivery advice quantities are added together. The changed quantities are 

transmitted during the next EDI. 
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EDI journal 

For more information on this function, see EDI journal in the Automotive Help. The sales-related 

information found in this topic also applies to e-Procurement. 
 

Delivery advice 

For general help with e-Procurement, see e-Procurement basics. 

To view scanned and processed delivery advices, from Purchasing open the e-PROCUREMENT 

folder and choose Delivery advice. 

Delivery advices are created by your supplier and sent to your company as a classic EDI or 

SupplyWEB transaction when the goods are shipped. In Infor COM, you can import these in 

real-time using message import (either time-controlled or manually) to forecast expected goods 

receipts with arrival dates and times and react promptly to variances. 

Note: In order to use delivery advices, the 

COMMON.EPROCUREMENT.IMPORTDELIVERYADVISEACTIVE=yes parameter must be set in 

the configuration. 

The delivery advice is imported into the system and processed before the goods are received. The 

data on the delivery advice is transferred automatically to a supplier advance shipping notice 

(new) and does not need to be entered manually. See also Goods receipt (page 1324). In 

e-Procurement, receipts are entered using the delivery advice including shipping materials 

scanning. 

Planned and notified delivery quantities are reconciled using cumulative quantities (page 1319). 

Differences are output to a variance report. Shipping materials data on the delivery advice is 

compared to the original packing instructions, and any variances are logged. 

You can switch from the delivery advice to goods received in the inventory posting process. 

Once the data has been imported, the responsible employee is notified by Workflow of the delivery 

advice receipt without a materials posting and is informed of any existing variances. 
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Import delivery advice 

To transfer data from delivery advices (see "Delivery advice" page 1322) in Purchasing, open the 

Messages folder and select Import messages. Data can be imported manually or using time 

control. 

1. In Purchasing, open the Messages folder and select Import messages. 

2. In the Type form section of the Import messages dialog box, select the Delivery advice check 

box. 

3. In the Import file section, enter the setting for the path and file with the delivery advice data you 

want to import. 

4. Select Live run. 

5. Click OK to confirm the dialog box. 

6. Ensure that the received messages are correct and check for error messages. See Check 

delivery advice messages (page 1323). 
 

Check delivery advice messages 

To import delivery advices (see "Delivery advice" page 1322) successfully in Infor COM, you need 

to set a number of parameters in the configuration, allocation tables, and master data. 

 

To verify or process the data import, proceed as follows. 

1. In System functions, choose Mailbox. Next, select mailbox ID 102 and open the mailbox. Then 

check the error log for errors that may have prevented the import. 

2. In Purchasing, open the e-PROCUREMENT folder and select EDI journal. The imported 

delivery advice is entered as a data record. To open the delivery advice, click Go to and 

Process. 
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3. In Purchasing, open the Messages folder and select Message editor (see Message editor 

(page 1333)). The delivery advice is recorded here. To open the advance shipping notice, click 

Go to and Process. Invalid records are flagged accordingly in the message editor. Correct the 

records and select the Process modified records check box (for importing messages (see 

"Import messages" page 1333)) to repeat steps 1 to 3. 
 

Goods receipt 

To access Goods receipt in e-Procurement, from Inventory choose Goods receipt and then 

Purchase receipt. 

When working with standard purchasing procedures, goods receipt is carried out by means of a 

purchase order. Because procurement in e-Procurement is not carried out using purchase orders, 

but using order releases, and because there is the option of using delivery advices, you can 

access Purchase receipt using the Open delivery advice and Open order release tabs. There is 

also an Open tab for posting returned hired shipping material. Another enhancement to the goods 

receipt function is the option to post shipping materials for purchase orders. 

Note: For purchase receipt postings of shipping materials, the only posting ID available is 152 

(Partial inv rec); the assumption is that, in the event of such a posting, a full receipt is generally not 

possible. 

You can select from the following options: 

 If you do not intend to exchange delivery advices with a supplier, the receipts are posted to 

order releases by loading the order release data. The posting ID and quantity must be entered 

manually because there is no fixed planned quantity from a purchase order. Therefore, in this 

case only partial inventory receipt and partial inspection receipt postings are possible. 

 A delivery advice (VDA 4913) has already been imported or created using EDI. As well as data 

on the delivered goods, the delivery advice also contains data on both packaging and 

individual packages. In this case, exact preset values can be populated at the time of posting. 

You also have the option of scanning packages, or you can enter them manually and then 

simply post them. See Enter goods receipt using delivery advice. 

 If valid packing instructions have been assigned to an item in a purchase order, the shipping 

materials are loaded automatically during posting. You can change the shipping materials if 

the goods were delivered in different packaging, or you can insert new shipping materials. 

The cumulative quantities and order release outline agreement quantities are updated 

automatically in Goods receipt. 
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Enter goods receipt using delivery advice 

For general information on goods receipt in e-Procurement, click here (see "Goods receipt" page 

1324). 

The following instructions explain the steps you need to take to enter a goods receipt using an 

existing delivery advice (page 1322). 

1. In Inventory, open the Goods receipt folder and choose Purchase receipt. Then select the 

required delivery advice on the Open delivery advice tab. 

 Please note the Shipping material requirements tab (in line view) and the Enter packages 

tab, which are specific to e-Procurement. 

2. Using the View menu, go to the PO line and select the Shipping material requirements tab. 

This displays the shipping material requirements that exist for the order release and compares 

them to the shipping materials transmitted in the advance shipping notice. Variances are 

highlighted in color. You need to decide whether the shipping material requirements were met 

or whether you want to reject the delivery. 

Please note: A variance from the shipping material requirement may need to be entered into 

the supplier evaluation manually, because the criteria can be defined as required. 

3. Select View and Purchase order to switch to the Enter packages tab: Packages with package 

IDs are displayed individually here. Highlight the Package ID field in the header of the tab. 

4. From the Functions menu, select Reset quantities to be scanned. This has the following 

effects: 

 The transaction quantities on the Receipt tab are reset to 0, and the packages (in red) are 

flagged as not entered. 

 The scanner enters the package ID in the Package ID field and then exits the field 

(depending on the scanner software settings). 

 The ID is assigned automatically to a package in the system following the scanning 

process or manual entry. 

 The fill quantities are added as transaction quantities in the posting line of the goods. 

 The number of packages is added as a transaction quantity in the posting record for the 

shipping material. 

5. In the Purchase order view, go to the Inspection result tab. The planned drawing change status 

(valid date) is displayed and can be automatically compared to the information contained in the 

shipping documents. Variances are marked in red. 
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6. Because of the goods receipt, the cumulative received quantity and the cumulative delivered 

quantity are modified when the ASN EDI is imported. 
 

Process an RMA 

For general information on goods receipt in e-Procurement, click here (see "Goods receipt" page 

1324). 

In e-Procurement, an RMA refers to an advance shipping notice because the order release 

contains multiple lines that do not necessarily correspond to the deliveries. A supplier advance 

shipping notice is loaded and its lines are available for RMA. 

1. Open the supplier advance shipping notice whose lines you want to return. 

2. Edit the lines in the overview table individually by selecting Functions and Inventory 

transaction. In the dialog box that is now displayed, select the RMA option. 

Note: The return ASN refers to a supplier ASN, and the line refers to a purchase order ID. 
 

EDI invoices 

To open EDI invoices, from Purchasing open the e-PROCUREMENT folder. The purchase 

invoices that are read are displayed in EDI invoices, where invalid EDI invoices can be edited and 

invoices can be approved. 

The following Help topic describes the Rbasics and functions of the EDI invoice object, as well as 

the requirements for message import, the actual import, and subsequent invoice approval. 

Basics 

The EDI invoice object allows suppliers to transfer invoice data to customers via EDI (or 

SupplyWEB). This data can be processed automatically as purchase invoices in Infor COM, as 

long as it lies within tolerances that can be parameterized. 

EDI invoices can be processed with reference to outline agreements and order releases as well as 

standard purchase orders. 
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The supplier sends the invoice data as a VDA 4906 message. This data is read by the conversion 

software used by the Infor COM user and converted to the internal Infor COM format. The file is 

loaded via the message import function and is used to create EDI invoices. For more information, 

see Requirements for importing messages. 

You can verify these EDI invoices in advance to correct any errors they may contain. See Edit 

invalid EDI invoices (page 1331). 

Adjusted invoices are subsequently converted to standard purchase invoices. 

As EDI invoices that comply with VDA 4906 always refer to POs or order releases and the 

associated supplier ASNs, the automatic invoice approval feature (if selected) can compare them 

to the associated supplier ASNs. If the actual invoice values are within the planned data tolerance, 

the EDI invoice is set to the status of an approved default invoice. Tolerances are used to set the 

percentage by which invoice line values can vary from the planned values without requiring 

troubleshooting. 

If you were able to assign the EDI invoice successfully and all values are correct, the invoice is 

approved when it is imported (set in EDI master data). 

The purchaser then only needs to process exceptions, which the user is informed of by variance 

reports or Workflow. Correct invoices are processed and transferred automatically to Financial 

accounting. 

Note: You can print a log of EDI invoices that have been read by selecting Purchasing and 

Reports, or by selecting Invoice import-Check list. 

Functions 

In addition to troubleshooting, the following functions are available in the EDI invoice object: 
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Lock line This function allows you to lock an invoice line. Locked lines are ignored during 

invoice approval. 

Release line You can release a locked line if the invoice has not been approved. 

Lock invoice You can use this feature to lock the entire invoice. The invoice cannot be approved 

until you release it. 

Release invoice Release a locked invoice to make it available for processing. 

Advance shipping notice 

(ASN) overview 

This function opens an overview of all advance shipping notices for the current item 

and PO. 

Assign advance shipping 

notice 

If an EDI invoice line is assigned to an incorrect ASN or if an ASN ID is incorrect, you 

can reassign the correct ASN using an overview of possible ASNs. 

Invoice approval If all EDI invoice lines can be checked, and the data in the invoice header is correct, 

the status in the invoice header is set to 'Can be approved'. You can then use the 

Invoice approval function to transfer this invoice to standard purchase invoice 

status. 

Note: The EDI invoice object indicates if an advance shipping notice has been posted 

twice, but another two invoice lines are still created in the standard purchase invoice. 

The standard purchase invoice is then transferred to the financial accounting system 

using a Financials transfer function or via the Financials online link. 

Invoice cancellation You can cancel EDI invoices that have already been approved. The standard 

purchase invoice status then becomes Canceled. 

 

Requirements for importing messages 

The following requirements must be met for EDI messages to be imported correctly: 

 The COMMON.EPROCUREMENT.EPROCACTIVE=yes and 

COMMON.EPROCUREMENT.IMPORTINVOICEACTIVE=yes  parameters must be set in the 

configuration. 

 The Dummy.arc synchronization file must be included in the import directory. Generating the 

Dummy.dta file from the Dummy.arc file locks messages and prevents them from being used 

for other processes. 

 The structure and standards for EDI invoices must be stored in the AMTYPEEDI allocation 

table (value 10). 

 The EDI master data (sender ID and standard) must have been created correctly. EDI invoice 

record type (811) contains the sender ID, which is checked against the EDI master data. 
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Import 

For step-by-step instructions, see Import and check EDI invoices (page 1330). 

The above requirements are checked when the invoice is imported. The following processes also 

occur during the import: 

 The link file is loaded (for example, from the Seeburger box). 

 The file format is checked to make sure it is correct (ASCII, record lengths). 

 The transfer ID is checked to make sure it is unique. 

 The invoice is created with the status New. 

 The individual records of the invoice are processed using the message profile from the EDI 

master data. 

 The data is checked to make sure it is complete and can be assigned. 

 A log is created in the message journal and, if errors occur, in the configured mailbox. 

 

Creating invoices 

The import process creates the EDI invoice if no errors have occurred. 

 An invoice header is created for each invoice, and the advance shipping notice lines are 

transferred to the EDI invoice lines. In addition, all planned data is loaded (such as master 

data, POs/order releases). 

 The content in the invoice header (invoice ID, customer tax reg. ID, currency), at advance 

shipping notice level (Does the advance shipping notice exist?), and at advance shipping 

notice line level (Does the item exist in the advance shipping notice? Does the invoice amount 

equal the amount received? Tolerance?) are validated. 

 Based on the result of the validation, the status is set in the invoice header and lines. 

 An error log is created. 

 

Invoice approval 

Once the invoice has been imported, it is approved automatically if this has been specified in the 

configuration via the COMMON.EPROCUREMENT.AUTOINVOICECHECK=yes parameter. 

The Automatic EDI invoice approval check box on the e-PROCUREMENT tab in the supplier EDI 

master data must have been set, and the EDI invoice status must be Can be approved following 

the import. 

The invoice is approved as follows: 
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 EDI invoice data is transferred to the standard purchase invoice data. 

 If the invoice is a purchase invoice, the default invoice approval processes are carried out in 

Infor COM. 

 Like the purchase invoice, the EDI invoice is assigned the status Approved. 

 The log indicates that the invoice was approved. 
 

Import and check EDI invoices 

You must import EDI invoices (page 1326) before you can approve and edit them. To do so, follow 

the steps below. 

1. In Purchasing, open the Messages folder and select Import messages. 

Data received via EDI is converted to VDA 4906 format by the conversion software. Select this 

file in the Import messages dialog box. 

Note: You can also import invoices using time-controlled batch processes. 

2. In the Import messages dialog box, select the Purchase invoices check box. In the Import file 

section, make sure the correct import file and path are specified. 

3. In System functions, open mailbox 103. Any errors that could prevent the message editor from 

loading the message are logged in the mailbox. 

Note: Use the Workflow function to notify the relevant employee of read errors. 

4. Open the e-PROCUREMENT folder and select the EDI journal. A data record is created in the 

EDI journal for every purchase invoice imported. To go to the EDI invoice, open the Go to 

menu and choose Process. 

Note: You can also go to the message editor from here. 

5. In the Messages folder, select Message editor. The message editor logs all purchase invoices. 

Records that contain errors are flagged and have relevant message texts. 

Note: You can adjust an imported message without having to access the original link file. To 

do so, open the Import messages object and select the Purchase invoice and Process 

modified records check boxes. Click OK. The messages that you edited manually in the 

message editor are processed again. 
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6. The entire purchase invoice is imported. The automatic invoice approval feature compares it 

with the corresponding supplier advance shipping notice, if this feature was activated in the 

configuration. 

EDI invoices with incorrect data are assigned the status Contains errors and must be edited 

manually. They can then be transferred manually to an approved default invoice. 

In Purchasing, select Reports to print the invoice import checklist variance report, which 

contains the documented problems (see Reports (Purchasing) (page 1271)). 
 

Edit invalid EDI invoices 

Errors that occur when EDI invoices (page 1326) are imported are logged in the mailbox defined in 

the configuration. You can also trigger workflow activities. 

After EDI invoices are imported and checked (see Import and check EDI invoices (page 1330)), 

you can manually edit any invoices that contain errors. Proceed as follows. 

1. To open the EDI invoices that contain errors, open the EDI invoices object and select the 

status Contains errors. 

2. Switch to the Invoice line view. The Check/values table lists the errors in detail. You can 

manually accept certain errors, such as tolerance errors, or correct them by changing the 

actual values. Manual adjustments are indicated by the Changed manually check box. 

There are also several other troubleshooting functions provided. 

The following table provides an overview of the specific functions available in the EDI 

invoice object for troubleshooting. 
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Function Explanation 

Accept data 

containing 

errors 

You can accept certain errors without having to make changes, such as errors where the 

tolerance is exceeded. This function becomes available when you select a check box. After 

you have selected the check box, you must confirm a prompt in order to accept the variance. 

Lock line If the line contains an error that cannot be corrected or if the line content is incorrect, select 

this function to prevent the line from being transferred to the standard purchase invoice. 

Release line If required, you can release locked lines before transferring them to the standard purchase 

invoice. 

Lock invoice If the entire invoice is incorrect, use this function to lock the invoice. 

Release invoice If required, you can release locked EDI invoices before transferring them to the standard 

purchase invoice. 

 
 

Generate credit memo 

For information on creating EDI invoices in e-Procurement, see EDI invoices (page 1326). 

For information on the credit memo procedure, see Credit memo procedure. 

This command allows you to create invoices for credit memo suppliers. 

This batch process allows you to enter all billable goods receipts for suppliers flagged as credit 

memo-capable in a purchase invoice. An invoice/credit memo is created with the current date as 

the invoice date for all suppliers that have a credit memo in the EDI master data whose period of 

validity does not expire before the current date. 

To display these credit memos, go to EDI invoices. 

Note: 

 The purchase invoice, which is created automatically, contains the quantities posted to 

Inventory and Inspection. 

 Header discounts from the PO or order release outline agreement are not transferred. 

 The payment terms are transferred from the supplier master. 

 Invoice items that are not billable are indicated in a log. 
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Transferring the credit memo to the supplier allows the origin of the differences to be calculated 

and clarified automatically. 
 

Messages 

You can edit messages in the Automotive and e-Procurement modules. See Messages. 
 

Import messages 

Message import is described in the Sales Help topic on importing messages. The functions 

described there also apply to Purchasing. 

The delivery advice message (VDA 4913) is also available in the Type form section. See Delivery 

advice (page 1322). 
 

Message editor 

For more information on this function, see Message editor in the Automotive Help. The 

sales-related information contained in that topic also applies to e-Procurement. 
 

Message profiles 

For more information on this function, see Message profiles in the Automotive Help. The 

sales-related information contained in that topic also applies to e-Procurement. 
 

Delete messages 

For more information on this function, see Delete messages in the Automotive Help. The 

sales-related information contained in that topic also applies to e-Procurement. 
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Export order releases 

This object is available in the Messages folder in Purchasing. 

Message export plays an important role in the processing of purchase orders for serialized items 

using order release outline agreements (page 1298). The Export order releases function allows 

you to save generated order release data (see Order releases (page 1305)) as ASCII link files, for 

example, in accordance with VDA 4905. These files are then sent by EDI using transfer software 

(such as the Seeburger box). 
 

Export credit memos 

You can access this function from Purchasing by selecting the Messages folder. Export credit 

memos allows you to export the messages generated with the Generate credit memo (page 1332) 

batch process (EDI, print, and so on). 

Note: You can also export credit memos individually in a loaded EDI invoice using the Functions 

menu command. 
 

Export goods receipt confirmations 

You can access this function through Purchasing > Messages > Export GR confirmations. 

This SupplyWEB (page 1336) function allows you to export goods receipt confirmations and 

repeats thereof. 

In the dialog box, you can select by supplier, item, ASN or receipt date. 
 

Packaging 

For more information, see Packaging. 
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The e-Procurement basics (page 1277) Help topic provides an overview of the packaging 

functions that are specific to e-Procurement. 
 

Shipping materials 

For an overview of packaging in e-Procurement, see Packaging (e-Procurement) (see 

"Packaging" page 1334). 

See Shipping materials for information on the use of shipping materials in Sales. The information 

provided in that topic largely applies here too. 
 

Post shipping materials receipt 

Like the delivery of items, the delivery of shipping materials is usually carried out in e-Procurement 

automatically by means of the appropriate messages. The following topic explains how to post 

received shipping materials manually. 

1. Create the shipping material if it does not exist already (see Create shipping material). Choose 

the required settings on the Shipping materials tab. 

Note: The setting shown in the Owner field must not be zero - this is to ensure that postings 

can be made in the shipping material account. 

2. Create the shipping material account to which you want to post goods receipts by using the 

corresponding New dialog box. 

3. To post a goods receipt for the shipping material, open Goods receipt in Inventory and enter 

the received quantity and posting ID for the received goods on the Receipt tab. Enter the 

shipping material on the Shipping material tab. Note that the PSA check box must be selected 

to ensure that the posting to the shipping material account is logged. 

4. Open the shipping material account to view the logged data. 
 

Packing instructions 

For an overview of packaging in e-Procurement, see Packaging (e-Procurement) (see 

"Packaging" page 1334). 
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For basic information on the use of packing instructions in Sales, see Packing instructions. The 

information provided in that topic largely applies here too. 
 

Shipping material account, Ship.mat. act 

For an overview of packaging in e-Procurement, see Packaging (e-Procurement) (see 

"Packaging" page 1334). 

This topic also includes basic information on the use of shipping material accounts in Sales. The 

information provided in that topic largely applies here too. 

The shipping material account in Purchasing offers the following functions: 

 Shipping material accounts are used to manage suppliers and their shipping material inventory 

and movements. 

 The system supports monitoring of your own hired material that you exchange with the 

supplier. Any message can be generated automatically or manually in accordance with VDA 

4927. 

 Sales orders are generated from the shipping material requirements of the supplier and used 

for deliveries of empty shipping material. 

 A message profile (see "Message profiles" page 1333) according to VDA 4927 is delivered 

along with the message profiles. If EDI master data exists, the data can be loaded through 

message import. This data is automatically edited and saved. 
 

SupplyWEB 

SupplyWEB is a web-based Automotive Supply Chain Management (SCM) solution. It facilitates 

electronic communication between companies and suppliers. SupplyWEB includes traditional EDI 

communication and web-based methods. It allows you to achieve complete electronic 

communication with the supplier, even if some of your suppliers do not have EDI capability. Data is 

exchanged between the systems using file transfer. 

SupplyWEB uses interfaces to process files in CSV, EDIFACT, ODETTE, VDA, X12, and XML 

formats. These are initially converted to XML using stylesheets and then transferred to the system. 

File export works in the reverse. 
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Desktop SWebDesk 

The SWebDesk desktop must be configured for users who do not have e-Procurement installed on 

their system. This desktop provides the additional folder SupplyWEB with the desktop objects 

Import messages, Delivery advice, and Export goods receipt confirmations. Each of these 

applications is required for linking to SupplyWEB. 

These objects are identical to those described ine-Procurement. You can therefore find assistance 

by referring to the relevant e-Procurement Help topics. 

The following modules contain the SupplyWEB functionality. 

 

e-Procurement 

e-Procurement uses the following SupplyWEB functions. 

 Delivery order releases (Infor COM  SupplyWEB) 

 Delivery advice (SupplyWEB  Infor COM) 

 Credit memos (Infor COM  SupplyWEB) 

Using EDI, releases, delivery advices, and credit memos are processed in accordance with 

VDA4905, VDA4913, and VDA4908. 

 

Purchasing 

In Purchasing, SupplyWEB applies to the following functions. 

 Purchase orders (Infor COM  SupplyWEB) 

 Delivery advice (SupplyWEB  Infor COM) 

 

During the export process for purchase orders, CSV files are created and sent to SupplyWEB. 

Each delivery advice for purchase order (transferred from SupplyWEB) is exported as VDA4913 

and, like the e-Procurement process, loaded and saved. 

 

 

Inventory 
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Inventory uses the following SupplyWEB functions. 

 Goods receipt confirmation (partial/full issue) (Infor COM  SupplyWEB) 

 The export process for goods receipt confirmations creates CSV files and transfers these to 

SupplyWEB. 

 

The following links provide an overview of the SupplyWEB settings in master data and documents. 

Master data 

 

Supplier master 

In the supplier master, the appropriate settings must be specified on the SupplyWEB tab for 

customers who do not use e-Procurement. 

If the SupplyWEB link on this tab is selected, the system will fill in the Transfer type field on the 

Communication with the setting SupplyWEB. 

When using e-Procurement, you must implement this setting yourself. 

 

Item master 

When using e-Procurement, the SupplyWEB transfer type must be selected on the 

Communication tab in the item master. 

This is only required if the communication type differs from the communication type in the supplier 

master when it comes to item specifics. Otherwise, the entry in the supplier master applies. 

 

Movement data 

To guarantee communication with SupplyWEB from the movement data listed below, the correct 

addressing must be defined. This table provides an overview of the fields that are required for 

addressing from the delivery order release, purchase order, or goods receipt confirmation. 
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Process type Addressing field Origin 

e-Procurement 

processes 

SupplierID ID from the supplier master (for purchase orders and 

confirmations of receipt), or else the EDI ID from the EDI 

master data. 

FacilityID Warehouse address from the order release or the message, 

entered for the own company (Address ID field in the  
Addresses table). 

ShipToID Plant from the order release or the message, entered for the 

own company (on the Address tab). 

Purchase order 

processes 

SupplierID Supplier ID on the SupplyWEB tab in the supplier master 

FacilityID This field shows the warehouse address using the warehouse 

address ID from the PO line, which was entered for your own 
company in the Address ID field of the  Addresses table. 

ShipToID Plant using the warehouse address ID from the PO line, entered 

for the own company (on the Address tab). 

 

Delivery order release 

Delivery order releases are exported via the e-Procurement desktop objects. The following table 

provides an overview of the processes involved: 

Expiration Desktop object 

Export single message from order 

release 

Purchasing > e-PROCUREMENT > Order releases 

Export messages collectively via a 

selection 

Purchasing > Messages > Export order releases 

Export messages using time control System functions > Administration > Batch control (EP: 

Export messages) 

 

Please note: Exporting delivery order releases to a SupplyWEB supplier also requires a fixed 

output path from which the data is read. This path is set in the configuration. 

Note: In order to identify the supplier, SupplyWEB requires the supplier ID. Similarly, in order to 

identify your own plant, it requires the plant and the ship-to address. 

 

Purchase order 
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With certain purchase order processes, a CSV message is exported and transferred to 

SupplyWEB. 

Process Process type (SupplyWEB) Trigger 

Print a purchase order New Create document dialog box 

Modify a purchase order Change Create document dialog box 

Cancel a purchase 

order 

Deletion/Cancellation Edit document dialog box 

 

Note: In order to identify the supplier, SupplyWEB requires the supplier ID. Similarly, in order to 

identify your own plant, the plant and the ship-to address are required. 

Please note: Supplier consignment warehouses are not supported. 

 

Delivery advice for order release 

The delivery advice for an order release is imported using e-Procurement desktop objects. 

Please note: A fixed predefined import path is required for SupplyWEB. 

The import can be carried out using 

 Manual selection (Purchasing > Messages > Import messages) 

 Time-controlled batch import (System functions > Administration > Batch control) 

 

Delivery advice for purchase order 

The delivery advice for a purchase order is handled similarly to the order release, since it is sent 

using message VDA4913. 

The delivery advice import can process both the delivery advice for an order release and the 

delivery advice for a purchase order. 

When using e-Procurement, purchase orders are loaded into the system using Purchasing > 

Messages > Import messages. 
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When not using e-Procurement, the Import messages object can be accessed in Purchasing by 

selecting the SupplyWEB folder. 

 

Goods receipt confirmation 

The SupplyWEB goods receipt confirmation does not distinguish between receipts to inspection 

inventory and unassigned inventory. It only recognizes the receipt process type. 

Note: Goods receipt confirmations can also be exported without reference to existing delivery 

advices, and sent to SupplyWEB. 

The process is exported as a CSV file if goods receipt is performed. The file output is triggered 

using the Export GR confirmations desktop object. 

Goods receipt confirmations can be exported using 

 manual selection (Purchasing > Messages > Export GR confirmations or - where 

e-Procurement is not active - using Purchasing > SupplyWEB > Export GR confirmations) 

 Batch control (Export goods receipt confirmations) 

  

Note: In order to identify the supplier, SupplyWEB requires the supplier ID. Similarly, in order to 

identify your company's own plant, it requires the ship-to address. 

 

Delivery advice import 

You can import a delivery advice in SupplyWEB as follows: 

 If e-Procurement is active: Use Purchasing > Messages > Import messages 

 If e-Procurement is not active: Use Purchasing > SupplyWEB and Import messages. 

All the data contained in the import directory is loaded. 

Note: Delivery advices for delivery order releases and purchase orders are both provided in 

VDA4913 format. 
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For general information on Purchasing, see Purchasing basics (page 1225). 

In Purchasing, enter master data in the Master data folder. Click this folder to display a list of 

master data that can be entered. The following Help topics show you how to create important 

master data in Purchasing. This data includes suppliers, employees, purchased items, services, 

additional delivery costs, external services, prices and discounts. 

 

Master data (Purchasing) 
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Suppliers 

Call 

Purchasing > Master data > Suppliers 

Description 

You normally create companies in Finance by selecting the Master data folder. In Purchasing, the 

Master data folder allows you to create suppliers. The advantage of this is that supplier-specific 

settings are predefined when these new suppliers are created. 

Configuration 

It is possible for an online validation check for accuracy to be carried out by the connected 

financial accounting system on company master data that has been created or modified in 

Purchasing and Sales. This is helpful in cases where changes are made to credit limits, or if a 

sales tax ID has been entered incorrectly. If an invalid sales tax ID is used while the online link is 

active, an error message is output immediately. The online validation function is activated via the 

COMMON.FIBU.ONLINE.BUSINESSPARTNER=yes parameter. 

When the customer or supplier master data is saved, the processes for transferring business 

partners to the configured financial accounting system are then called for the business partner you 

were processing. All of the data checks that would be carried out for a batch transfer are now 

carried out by Infor COM and the financial accounting system. The configuration parameters and 

interface configuration settings saved for the transfer of master data are evaluated and applied. 

For more information, see Infor Finance online functions. Error messages are displayed directly on 

the screen and are not saved. There are no additional mailbox entries. If the transfer is successful, 

there are no messages displayed. 
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Evaluation scales 

Click here for general information on master data in Purchasing (see "Master data (Purchasing)" 

page 1342). 

The Evaluation scales business object is an element of the licensed Supplier evaluation module 

within the Infor application. 

The weightings, properties, and mark ranges for the evaluation criteria of individual quality groups 

are specified in Evaluation scales. For more information, see Set evaluation scale of a quality 

group (Supplier evaluation). 
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Employees 

Call 

Finance > Master data > Employees 

Purchasing > Master data > Employees 

Sales > Master data > Employees 

Description 

It is possible to create employees with different functions (representative, etc.) and send 

shipments to these people. 

Contacts at outside companies can also specify this directly on the Contact tab. 
 

Purchase items 

Call 

Purchasing > Master data > Purchased items 

Description 

To create a purchase order or open an existing one, use the Purchased items object in the 

Purchasing module (see Create new item) . When you select this object, the Purchased item 

check box is activated and grayed out. Otherwise, the procedure is the same as for creating an 

item. 

In practice 

Assign suppliers 

Store manufacturer information 
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Additional costs (Purchasing) 

Click here for general information on master data in Purchasing (see "Master data (Purchasing)" 

page 1342). 

To access additional costs in Purchasing, open the Master data folder and select Additional costs. 

This object allows you to enter additional delivery costs and define how these are distributed 

among the purchased items. 

Additional delivery costs in Purchasing extra charges that the purchaser has to bear on top of the 

actual material costs. 

When goods are imported or procured, additional costs arise from transportation via ship, rail, or 

road. These additional costs can be freight and insurance costs, duty charges, taxes, and other 

state fees, or other costs (such as packaging or agent's commission). The procurement and 

startup costs can be added to the acquisition costs. 

In Invoice approval, a distribution option was created in order to be able to valuate purchased 

items with their additional delivery costs. The ADC distribution function was called for this - see 

Distribute additional delivery costs (page 1263). Several methods of distribution were offered - 

manual distribution or proportionate distribution according to weight or net value. 

 For every additional cost, you can define in both the overview and the single view that this is to 

be distributed proportionately on the purchased items. To do this, select the Distr. active (DAc) 

check box. The following entry in the configuration is a prerequisite for the distribution: 

StockValuationWithLandedCosts = yes. 

 This setting can also be made in the invoice line on the Additional costs tab in the purchase 

invoice. 

To ensure traceability, the distribution made is saved and it can be viewed at any time. 

Please note:  

 In principle, invoice approval (provided that the invoices contain additional costs to be 

distributed) can only be completed after the additional costs have been distributed properly. 

If additional costs were not provided for distribution, invoices can be approved in exceptional 

cases (only by selecting Functions and then Invoice approval). If a distribution is required at a 

later stage, you must cancel the invoice and then carry out invoice approval again. 

 A distribution of additional costs already carried out is retained when you cancel an invoice. 

 The additional delivery costs are included in the inventory valuation in the inventory value 

journal. In addition, the item price, ADC, and total price are displayed on the Purchasing tab. 

 The additional delivery costs are posted to the corresponding inventory account in the posting 

journal. Non-distributed additional delivery costs are posted to costs. 
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Create additional cost in Purchasing 

To create an additional cost, proceed as follows. 

1. In Purchasing, open the Master data folder and select Additional costs. Then click the New tab. 

Enter the required information and confirm your entries by clicking Create.  

Next, specify the accounts and price flags on the Purchasing tab. For information about the 

calculation of prices, see Prices and discounts in Purchasing (see "Price in Purchasing" page 

1350). 

The following image shows part of the Price/tax groups form section on the Purchasing tab for 

the Freight additional cost. 

Using a combination of this price flag and the price flag entered for the supplier, the system 

determines the price for the additional costs from the price table. 

Price 100 

If you want to assign the additional costs entered to the purchased items specified (see 

Distribute additional delivery costs (page 1263)), select the Distr. active check box. 

2. Enter the prices for the additional costs on the Prices tab. See also Prices and discounts in 

Purchasing (see "Subcontracted activities" page 1347). 

Note: The record type for additional costs is always AC. 

Select the check box in the % field if you want to define the additional costs as a percentage 

surcharge on the order value. 

Note: You can now enter the additional costs on the PO tab in the PO in Purchasing. To 

select the additional costs, enter the AC record type in the RT field on the PO tab. Then enter 

the required additional costs in the Resource field, either by typing the corresponding ID 

directly or by selecting it from the combo box. The Qty field, which usually contains the 

quantities of the selected resource, is populated in accordance with the type of additional cost. 
 

Subcontracted activities 

Click here for general information on master data in Purchasing (see "Master data (Purchasing)" 

page 1342). 
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Work processes that cannot be carried out in your own company for whatever particular reason 

can be outsourced to subcontractors as subcontracted activities. See Handle subcontracted 

manufacturing for more details. 
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Prices and discounts in Purchasing 

The following topics describe how to set prices and discounts in Purchasing and how they are 

calculated. In addition, they list the most important sources of error in price and discount 

calculation. 
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Price in Purchasing 

Price records (PR record type) are defined for combinations of item groups/item IDs on the one 

hand and for company groups/company IDs on the other.  

Discounts are price reductions that may be granted for various reasons (quantity discounts, 

reseller discounts, etc.). 

Price table maintenance is a basic requirement in order for the price and discount calculation to 

work properly. 

Normally, you create price/discount records in the item master data within Infor COM. The prices 

are then copied from there to the price table. 

Please note: The following description of the price and discount calculation also applies for 

calculating prices for additional costs (Prices - Additional costs desktop object) and tax rates (Tax 

desktop object). 

The following Help topics describe how prices and discounts are determined in purchase orders. 
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Discounts in Purchasing 

Select Purchasing > Master data > Discounts to store discounts. 

Please note: Like prices, discounts are stored on the Purchase prices tab in the item master. Your 

entries are transferred to the price table when you save them. If you want to perform automatic 

discount calculations from the documents, you must store the discount flags both in the item and 

supplier master data and in the price table. It is not enough to enter the discounts in the price 

table. 

In the supplier master (Supplier business data tab), define whether the discounts are to be added 

or multiplied. These are default settings in the PO and they can also be modified there. 

Please note the following points: 

 Discount records are created for suppliers/supplier groups and items/item groups, and 

combinations of these elements. 

 Discount records are created both for individual lines and for orders. 

 

Infor COM differentiates between line discounts and purchase order (value) discounts. The 

Record type column contains the name of the record type stored in the price table. The following 

table shows the permitted record types. 

Check 

The following example shows how the check for stored discounts is performed in four steps. 

 Item 602-0010 from item group 101 is ordered from supplier 2700, who belongs to supplier 

group 130. 

 The price table contains the following entries on the Current period tab. 
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 Item grp Item ID Co. grp Company ID DT % Current period 

D1 101 602-0010 100 2800 1 Selected 5,000 

D1 101 602-0010 100 2300 1 Selected 2,500 

D1 101  130  1 Selected 6,000 

 

If the item is entered in a purchase order on the basis of these prerequisites, the price 

table will be subjected to the following four checks in order to calculate a discount. At the 

first relevant condition, the data in the discount record is copied to the purchase order. 

1. Is there a discount record that contains both item ID 602-0010 and company ID 2700? This 

is not the case in our example. 

2. Is there a discount record that contains both item group flag 101 and company ID 

2700? This is not the case, either. 

3. Is there a discount record that contains both company group flag 130 and item ID 

602-0010? This is not the case, either. 

4. Is there a discount that contains both item group flag 101 and company group flag 

130? This is actually the case. For this combination, a discount rate of 6% is entered 

and copied to the purchase order. 
 

Line discounts 

Line discounts are discounts on individual purchase order lines. You can edit line discounts in the 

PO header view of a purchase order. 

 D1 (standard discount 1): Calculated on the line price. This discount type can only be used in 

relation to lines. 

 D2 (standard discount 2): Calculated on the line price after the deduction of the standard 

discount 1, the quantity discount and the value discount (RemValue discount type). This 

discount type can be used in relation to lines and orders. 

 QD (quantity discount): Calculated on the line price after the deduction of the standard 

discount 1 (RemValue discount type). The quantity ordered determines the level of discount. 

This discount type can only be used in relation to lines. 

In contrast to base discounts, quantity discounts can only be assigned on a percentage basis. 

 VD (value discount): Calculated on the line price after the deduction of the standard discount 1 

and the quantity discount. It is only calculated when a certain purchase order value is reached. 

This discount type can be used in relation to lines and orders. 
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Line discounts are calculated correctly subject to the following prerequisites. 

 Discount flags > = 100 and < 200 are stored in the Discount 1 field of the Supplier business 

data tab in the supplier's company master data. Flags from 200 are reserved for customers. 

 Discount flags > = 100 and < 200 are stored in the Discount 1 field of the Purchasing tab in the 

item's master data. Flags from 200 are reserved for Sales. 

 The price table contains a discount for the combination of the price flag belonging to the 

supplier/supplier group and that of the item/item group. 

Check that the settings are correct for every example in the purchase order on the Discount groups tab. The 

discount flag for the relevant discount in the footer must not be equal to 0. 

Examples for line discounts 

 

Example 1: 

A discount 1 of 7% is stored in the price table for item group 100 and company group 100. 

RT Item grp Item ID Co. grp Co. ID DT % Current period 

D1 100  100  1 Selected 7,000 

For this discount to work, the Discount groups tab in the purchase order must contain the following discount flag 

combination: 

Disc1 

100 

Footer 

100 

 

 

Example 2: 

 

Supplier 2800 grants a discount of 5% for items in item group 100. 

RT Item grp Item ID Co. grp Co. ID DT % Current period 

D1 100  100 2800 1 Selected 5,000 
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Example 3: 

 

In the price table, a discount 1  of 7% is stored for item 965-1322 and supplier 2300. 

SVO Item grp Item ID Co. grp Company ID DT % Current period 

D1 100 965-1322 100 2300 1 Selected 7,000 

 

In the purchase order, the item ID of the item to be ordered (HR line) is selected from the PO tab. This fulfills the 

conditions for the hierarchical check when calculating a PO discount, and the discount calculated in the price table 

is entered. 

The result can be seen in the following extract from the PO tab of a purchase order for item 965-1322 and 

supplier 2300. 

 

RT Item Description PO qty UOM Price %Disc Net 2 

HR 965-1322 Brake shoe 

with safety 

device 

1,00 U 79,81 7,000 74,22 

 

 

Example 4 (quantity discount): 

 

For purchased item 602-0010, 60x20 flat steel, the following scale applies for company group 1: 

For purchase orders starting from 5 units, the supplier grants a discount of 2%, rising to 3% starting from 15 units, 

4% starting from 25 units, and 5% starting from 35 units. The following table shows you the settings in the price 

table: 

RT Item grp Item ID Co. grp DT % Current period Limit 

QD 100 602-0010 1 1 Selected 2,000 5 

QD 100 602-0010 1 1 Selected 3,000 15 

QD 100 602-0010 1 1 Selected 4,000 25 

QD 100 602-0010 1 1 Selected 5,000 35 

 

The quantity scales for quantity discounts are entered in the Limit field where the limit always represents the lower 

limit. 

Please note: When you are creating a quantity discount, you cannot clear the % check box. 

 

Example 5 (quantity discount): 
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The following table shows the discount structure for item 965-1310 and supplier 2900. The 

quantity discount of 1 per cent applies to a PO quantity of 50 units (see Limit field), 2 per cent 

applies to a PO quantity of 200 units, and 3 per cent applies to a PO quantity of 500 units. 

SVO Item grp Item ID Co. grp Company ID DT % Current period Limit 

QD 100 965-1310 100 2900 1 Selected 1,000 50,00 

QD 100 965-1310 100 2900 1 Activated 2,000 200,00 

QD 100 965-1310 100 2900 1 Activated 3,000 500,00 

 

 

Example 6 (value discount): 

Supplier 2800 grants a discount of 0.1% on item 965-1322 starting from a PO value of EUR 6,000, a 0.25% 

discount starting from a PO value of EUR 12,000, a 0.5% discount starting from a PO value of EUR 60,000, and a 

1.0% discount starting from a PO value of EUR 120,000. Refer to the following price table overview. 

RT Item grp Item ID Co. grp Company ID DT % Current period Limit 

VD 100 965-1322 100 2800 1 Selected 0,100 6,000 

VD 100 965-1322 100 2800 1 Selected 0,250 12,000 

VD 100 965-1322 100 2800 1 Selected 0,500 60,000 

VD 100 965-1322 100 2800 1 Selected 1,000 120,00 

 

The sales revenue scale is entered in the Limit field. The corresponding discount is then granted 

starting from the value entered. The value discounts in this example are line-related. 
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Purchase order (value) discounts 

In contrast to line discounts, purchase order (value) discounts are granted on the full purchase 

order sum. You can edit this types of discount in the PO header view. The following record types 

are available. 

 OVD (purchase order value discount): Calculated on the purchase order sum after the 

deduction of all line discounts. It is calculated when a specific purchase order total is reached. 

 OD (purchase order discount): Calculated on the purchase order sum after the deduction of all 

line discounts and the order value discount. 

Note: You cannot create these records in the price table. 

 

The following table gives you an overview of what information you need to enter into the price 

table and the PO header to ensure that purchase order (value) discounts are calculated correctly. 

Price table Company group Company ID Item group Item ID 

Information from 

the PO header 

Any value Company ID 1 Field must be empty 

 Company group Field must be empty 1 Field must be empty 

As the discounts for the full purchase order apply, they never depend on the item. This is indicated 

in the search for item group 1 and in the empty Item ID field. 

Please note: Purchase order discounts can only be assigned using the D2 discount type, while 

purchase order value discounts are assigned using the VD discount type. 
 

Discounts for individual business transactions 

You can use default settings in the price table even with discounts that are granted for particular 

transactions only. For this purpose, define these discounts as general discount groups. In this 

case, you enter the flags manually on the Discount groups tab of the document (here: the 

purchase order). 

Ideally, you should assign the general discount flags as shown in the following example (the table 

shows a section from the current period in the price table). 

 



Infor COM 7.5 User Guide | 1357 

 

Purchasing 

 

RT Item grp Item ID Co. grp Company ID Current period 

D1 1  1  1 

D1 2  1  2 

D1 3  1  3 

D1 5  1  5 

D1 10  1  10 

D1 15  1  15 

 

Please note the following points in particular: 

For this entry, the item group value that you enter should correspond to the value in the Current 

period column. This means that the item group figure should be the same as the percent value. 

This works as follows: If a supplier grants a specific discount on a particular item group, you can 

set the required discount rate as the default in the open PO by entering the item group flag, without 

searching in the discount table. 

The figure in the Co. grp column plays an important role here. For discounts on individual 

transactions, enter a value of 1. If a company group flag is preset for the discount in the supplier 

master, this flag is copied when you create a document. You can check the current setting of the 

purchase order in the footer of the Discount groups tab. See the description of the footer field 

under Discount groups. If 1 is entered in the Co. grp field, the discount record of the entered item 

group flag is set for all company group flags that equal 1. 

Note:At the same time, the company group for all company group flags that do not equal 1, and for 

which there is no discount record, is set to 1, and calculations are performed with the discount 

record of the entered item group flag. 

Example 

The following table shows a section from the Discount groups tab of a purchase order. Please note 

the value 4 in the Disc1 field. 
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Sq. ID SVO Item Price Fixed Tax, Sales tax Disc1 

0 HR 602-0011 100 Not selected 1 4 

 

To access the price table, select  Go to and Price table. The following table shows the settings in 

this price table: 

 

 

SVO Item grp Item ID Co. grp Company ID DT % Current period 

D1 4  1  1 Selected 4,000 

 

Note that the value 4 is entered in the Item grp and Current period fields. This means that, when 

the purchase order is printed, a 4% discount is calculated and shown on the document. This will 

only work if the company group flag in the Price field on the Supplier business data tab of the 

supplier master is set to 1. 
 

Sources of error in price and discount calculation 

If errors occur during price or discount calculation eliminate the following sources of error first. 

 The currency stored in the price table does not match the one stored on the Supplier business 

data tab of the supplier's master data. In this case, neither the price nor the discount is 

calculated. 

 The price/discount flag stored in the price table does not match the price/discount flag on the 

Discount groups tab of the purchase order. In this case, neither a price nor a discount 

calculation takes place. 

 Check this on the Discount groups tab. 

 

Example: The following table shows the settings on the Discount groups tab in the purchase 

order. You will find the appropriate company group flag for the D1 discount group in the footer 

below the Disc1 column. It is preset here from the supplier master. 

In order for the discount calculation to work with the flags in this table, the price table must 

contain a discount record D1 for the company group 100 and the item group 100. 
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Disc1 

100 

Co. grp 

100 
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The following batch processes are available in Purchasing: 

 
 

Close requests for quote 

For a description of how to close and reactivate individual supplier RFQs, see Close supplier 

RFQs (page 1238). 

This batch process allows you to close whatever group of supplier RFQs you like. 
 

Print purchase orders 

To learn how to print a single PO, see Enter PO (see "Enter and cancel purchase order" page 

1250). The Print purchase orders batch process allows you to print any number of POs, which you 

can choose from a range of criteria. 

1. Select Purchasing > Batch processes > Print purchase orders. 

2. Populate the selection fields in the Print purchase orders dialog box with the required values, 

then click OK. 
 

Print delivery reminders 

Select Purchasing > Batch processes > Print delivery reminders to start printing several purchase 

orders/PO lines to be reminded together at a central location, without having to open each 

individual delivery reminder. The reminder is created subject to a check to determine whether a 

line has already been delivered and whether the delivery date was missed. See also Create 

delivery and confirmation reminders. 
 

Batch processes (Purchasing) 
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Convert purchase invoices 

It is possible to prepare old data from previous versions of Infor COM. You can do this using the 

Convert purchase invoices function in Batch processes in Purchasing. You can check the release 

ID by selecting Help and About Infor COM. 

When using the new options for invoice approval, it can sometimes be useful to convert data. 

However, data conversion is not a prerequisite for approving an invoice. If necessary, you can use 

the conversion option to solve any problems that may occur with partially approved order lines and 

canceled invoices. 
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Note: See also Configuration (Archive). 

In the Archive folder, you have several options for archiving and activating documents. You can 

also view the PO history. 
 

Archive purchase orders 

See also Archive (Purchasing) (page 1362). 

For details of how to archive individual purchase orders, see Archive PO (page 1253). 

The following section describes how you archive multiple purchase orders in one batch process. 

1. Select Purchasing > Archive > Archive purchase orders. 

2. A dialog box now appears. Enter the criteria for selecting the POs to be archived in the From - 

To fields. 

3. Select the Selection from list check box to display a list of all chosen documents prior to 

archiving. 

4. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

5. Select the Confirmation for outstanding purchase orders check box to instruct the system to 

report all outstanding (that is, not yet closed) orders prior to archiving. 

6. Click OK to start the archiving process. 
 

Activate purchase orders 

See also Archive (Purchasing) (page 1362). 

For details of how to archive purchase orders, see Archive purchase orders (page 1362). 

Archive (Purchasing) 
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1. Under Purchasing > Archive > Purchase orders, select the Open tab. Enter the data for the PO 

that you want to activate and click Load. 

2. Select Functions and Activate, and confirm the dialog box by clicking  OK. 

Note: You can now call the purchase order in Purchasing by selecting Purchase orders. 
 

Open purchase order history 

See also Archive (Purchasing) (page 1362). 

The purchase order history  shows all purchase procedures executed for one or more items. 

Please note: The purchase order history requires the 

COMMON.STAMMDATEN.PURCHHISTORY=yes parameter to be set in the configuration. 

Note: A modified PO is saved to the history once it has been printed. 

1. Select Purchasing > Archive > Purchase orders. 

Note: Alternatively, use the following path from within purchase orders: Go to > Statistics > 

Purchase order history. 

2. Enter the resource on the Open tab and click Load. 

Note: The system can search in archived purchase orders just like it can sort by PO value or 

due date. 
 

View archived outline agreements 

See also Archive (Purchasing) (page 1362). 

For details of how to archive an outline agreement, see Archive outline agreement (page 1246). 

You can view an archived outline agreement as follows. 

1. Select Purchasing > Archive > Outline agreements. On the Open tab, enter the data for the 

outline agreement that you want to open. 

2. Click Load to open the archived outline agreement. 

Note: You are not allowed to edit or activate an archived outline agreement. 
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Delete/export purchase orders 

See also Archive (Purchasing) (page 1362). 

For details of how to archive purchase orders, see Archive purchase orders (page 1362). 

To learn how to delete a single PO, see Delete purchase order (page 1252). 

To delete archived purchase orders using a batch process, proceed as follows. 

1. Select Purchasing > Archive > Delete/export PO. 

2. Choose the POs you require from the dialog box and select the Selection from list check box to 

view all the POs intended for deletion together in a list. 

3. Click OK to view the list of purchase orders to be deleted. 

4. Click OK again to start the deletion process. 
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This folder is provided for those who do not use e-Procurement when choosing SupplyWEB upon 

activating the SWebDesk desktop. For help with SupplyWEB and the available objects, see 

SupplyWEB (page 1336). 

 

SupplyWEB 
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Mailboxes output messages for the user's information. You can open and view the mailboxes in 

System functions. You can change the status of messages and delete processed messages. 

The following mailboxes are integrated in the system: 

Mailbox 
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ID Label Description 

11 Returns Contains outstanding return requests from Manufacturing with 

external link 

12 SFDC acknowledgement Acknowledged or confirmed SFDC transactions are logged (disabled 

by default) 

13 SFDC error Errors that occurred with transactions and are output to a dialog box 

during the program run. 

Example: "ID card ID xxxx is already present" 

14 SFDC link protocol This log records the linking of the SFDC journal to an external system. 

15 Dependent records Specific records such as milestones, assemblies, etc. were not found 

or cannot be reloaded (disabled by default) 

16 Posting errors Error while entering SFDC and inventory transactions such as unit of 

measure conversion not found, incorrect FID assignment. 

17 to 19 Check relDh/Check 

relDi/Check relDb 

Internal plausibility checks (disabled by default). 

20 NPI/discontinuation This mailbox logs the Replace processes in BORs. 

Example: BOR 978-3892: Resource 978-3893 -> 979-5000, 
line: 3 

Explanation: In BOR 978-8392 resources 978-3893 were 

replaced by 979-5000 in line 3 

21 BOR reconciliation In this batch process, changes in BORs are transferred to the 

associated orders if their status still allows this. Mailbox 21 logs the 

orders processed. 

Example: BOR 978-3892 updated in production order 

PrO0047 

25 Text system Mailbox 25 logs delete processes and rejected delete attempts. You 

will find the text ID and the language flag in these messages. 

The log records of deleted texts also record the reference counter of 

the text at the time it was deleted and the user who initiated the delete 

process. 

30 Error Contains all error messages from Manufacturing that occurred during 

the program run such as lines in production orders that were not 

expanded correctly due to missing allocation records 

35 Posting to host Contains the data of SFDC transactions 

40 Link host Outputs changes in production orders that were transferred to the 

host 

41 Link control panel Posting records prepared for direct transfer to the control station. This 

mailbox converts the records from mailbox 35 into file format 

42 Link EXVA This mailbox is no longer in use. 
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ID Label Description 

45 Master data consistency 

check 

 

48 Batch planning This mailbox is used when batch planning is selected in the 

configuration. A record is written to this mailbox for each deleted 

order line (from Sales, Planning, Manufacturing, and Purchasing) with 

planning types Full planning or Bottleneck - always plan 

because the deleted record cannot be assigned a batch flag. The 

respective item or work center must be re-planned  as it was 

deleted. 

Batch planning captures all resources with a batch flag and all records 

from mailbox 48. 

Mailbox 48 is deleted after successful batch planning. 

50 Generated order ID Contains production orders generated by batch planning 

51 Deletions Contains deleted orders from Purchasing and Sales and production 

orders deleted in batch mode 

52 Archive Contains archived orders 

53 Order structures Messages relating to order structures that could not be archived or 

deleted. 

58 Serialized/batch  

60 Average price 

calculation 

Contains error messages from average price calculation 

61 Costing A log record is written to mailbox 61 during batch cost rollup if 

warning and error messages are generated because the percentage 

difference between existing costs and newly costed costs exceeds the 

value specified in the dialog box (Warning begins at) 

an in-house item does not have a BOR 

– during manufacturing costing – a production order could not be set 

to costed due to outstanding invoices. 

62 Inventory transaction 

summary update 

 

63 Generate inventory count 

lists 

 

66 Statistics Contains statistical messages such as notes if a change of month or 

year was performed or is due 

67 REPORTS Errors that occurred during report printing or report definition such as 

"Field xxx does not exist" or "Invalid formula xxx" 

70 Batch printout (OC, ASN, IN) Error messages that occurred during batch printing of order 

confirmation, advance shipping notices, and invoices. 
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ID Label Description 

71 Follow-up  

72 Delivery cancellation Canceled advance shipping notices 

75 Purchasing: Messages  

80 Min. inv. monitoring error Errors that occurred during minimum inventory monitoring 

81 Min. inv. monitoring: POs 

created 

A log of POs generated by minimum inventory monitoring 

85 Planning: Error Errors that occurred during batch planning 

86 Planning: New A list of new orders generated by batch planning 

87 Planning: Modified A list of orders in which batch planning changed quantities or due 

dates 

88 Planning: Deleted Orders deleted by batch planning. For more information, see 

Mailboxes for batch planning. 

90 Employee error Contains errors that occur during balance transfer of external 

employee data. 

Example 1: Employee or ID card IDs were assigned twice. 

Example 2: An employee was deleted externally but still exists in 

Infor COM. 

91 Employee information Stores additional information about changes in Infor COM regarding 

the employee master during balance transfer. Such changes are 

made when there are data inconsistencies, such as when ID card IDs 

or active assignments were changed or employee IDs deleted. 

92 ID assignment This mailbox logs all errors that occurred during ID assignment 

96 SFDC offline Messages about temporary SFDC terminal failures 

99 Other Other error messages in batch processes that are usually displayed 

on screen such as ID assignment errors 

100 Link EDI delivery order 

releases  

 

101 Link EDI JIT orders  

102 Link advance shipping 

notices (ASN) 

 

103 Link EDI invoices  

104 Link EDI credit memos  

105 Link EDIFACT purchase 

orders 

 

106 Link EDIFACT invoices  
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ID Label Description 

107 Link subcontractors  

108 Link manufacturing order 

releases 

 

109 Link payment advices  

110 Notes on EDI delivery order 

releases 

 

111 Notes on EDI JIT orders  

112 Notes on advance shipping 

notices (ASN) 

 

113 Notes on EDI invoices  

114 Notes on EDI credit memos  

115 Notes on EDIFACT 

purchase orders 

 

116 Notes on EDIFACT invoices  

117 Notes on subcontractors  

118 Notes on manufacturing 

order releases 

 

119 Notes on payment advices  

120 Texts for EDI delivery order 

releases 

 

121 Texts for EDI JIT orders  

122 Texts for EDI credit memos  

125 Texts for EDIFACT purchase 

orders 

 

145 Time-controlled batch 

processes 

This mailbox logs all messages of the batch control component. 

160 Route planning Contains route planning messages 

161 Financial accounting Contains financial accounting messages 

170 EMS: Max. level in waste 

inventory has been reached. 

Is notified when the maximum level of waste has been reached. 

171 EMS: Create new hazardous 

materials 

This mailbox receives a message when a new hazardous material 

item is created. 

172 EMS: Delete hazardous This mailbox receives a message when a hazardous material item is 
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ID Label Description 

materials data deleted from the master data. 

173 EMS: Document check in 

goods receipt and goods 

issue 

This mailbox receives a message when the existence or updating of a 

document was confirmed during a document check. 

Prerequisite: The WhereToCheck parameter must be set to yes. 

180 Tool management Contains messages from Tool management. 

190 e-BUSINESS  

200 Duales System Deutschland 

(DSD) 

 

201 Link sales orders  

202 Notes on sales orders  

203 Link invoices  

204 Notes on invoices  

205 Link order confirmations  

206 Notes on order confirmations  

207 Link advance shipping 

notices (ASN) 

 

208 Notes on advance shipping 

notices (ASN) 

 

209 EP: Order release 

generation messages 

 

210 Temporary locks (AppTimer)  

220 Batch SFDC posting process 

to posting journal 

 

250 Suspension of companies  
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Delete mailbox records 

The messages stored in the mailboxes (see "Mailbox" page 1367) are not deleted automatically. 

You must check mailboxes at regular intervals and delete records that are no longer needed. 

Proceed as follows: 

1. Open the mailbox in which you want to delete records. 

2. Select Data and Delete. 

3. Select one of the options offered. 

4. Click Delete. 
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Call 

System functions > Shift plans 

As well as being accessible from production orders, shift plans can also be accessed from order 

lines and from the work center account and capacity account by selecting Go to > Capacity 

adjustment tables > Shift plan – see also Change shift plan in Planning. 

Description 

Shift plans are assigned to work centers and operations. 

All time and attendance templates that occur must be entered as shift plans. These provide the 

basis for determining capacity requirements, work center scheduling, and capacity increases in 

the event of bottlenecks.  

If you want to create an entirely new shift plan, you first have to create the required daily shift plan 

and then add the required daily shift plans to the annual shift plan. 

Configuration 

You can store several shift plan templates (i.e. all annual, weekly, and daily shift plans as well as 

shift schedules), and differentiate between them by name. Use the 

COMMON.TERMINRECHNUNG.DEFAULTNAME parameter in the configuration to specify the 

shift plan template that is to apply – SPlan is the default shift plan. 

 

Shift plans 
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Daily shift plans 

Call 

System functions > Shift plans > Daily shift plans 

You can edit daily shift plans from Planning (see Change shift plan in Planning) and from annual 

shift plans using the Go to command. 

Description 

Define shift periods for individual days using Daily shift plans. In Annual shift plans, you can later 

assign the required daily shift plan to each workday. 

The numbering scheme of daily shift plans is structured as follows. 

 Prefix: According to the COMMON.TERMINRECHNUNG.DEFAULTNAME parameter 

 Sequential ID: Numbering 358 is used for this. 
 

Enter daily shift plan 

To create a daily shift plan, complete the following steps: 

Please note: As an alternative to creating a new daily shift plan as described in the steps below, 

you can open an existing shift plan and save it with a new ID by selecting Data and Save as. Then 

make the required adjustments in the new shift plan. 

Example: If you need a modified daily shift plan from a specific date, use the Save as command for 

duplicating and changing to keep the history intact. 

1. In System functions, open the Shift plans folder, select Daily shift plans and click the New tab. 

The shift plan ID is entered by default. Enter a name for the daily shift plan and click Create. 

Note: You can also edit daily shift plans from inside an annual shift plan by selecting Go to 

and then Daily shift plan. The daily shift plan must be selected. 

2. Enter the times for each shift period on the Interval tab in the From and To fields. See the Help 

on Interval. 



1376 | Infor COM 7.5 User Guide 

 

System functions 

 

3. Enter shift IDs for each period. Please note that a shift ID must be equal to or greater than its 

predecessor. 

4. Select the type of shift time for all time periods using the combo box in the Time type field. 

5. Select Data and Save to save the daily shift plan. 
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Annual shift plans 

Call 

System functions > Shift plans > Annual shift plans 

Description 

The annual shift plans contain the required daily shift plans for each workday of the calendar year. 

The shift plans SPLANY00001 (Calendar weeks), SPLANY00002 (Calendar days) and 

SPLANY00003 (Workdays) are special. hey describe the delivery time units of suppliers in 

Purchasing. The earliest possible delivery date can be calculated from the information stored in 

the delivery time units. Planning uses the delivery time for order scheduling. 

1 Delivery time unit 1 states the Delivery time in calendar weeks. Delivery time = 5 means 5 calendar 

weeks until delivery. 

2 Delivery time unit 2 states the Delivery time in calendar days. Delivery time = 10 means 10 

calendar days until delivery. 

3 Delivery time unit 3 states the Delivery time in workdays.  

Delivery time = 10 means 10 workdays until delivery. 

These shift plans must not be deleted. Instead they must be maintained and updated. In the SPLANY00003 shift 

plan, assign the public holidays for the business. 

Functions 

You can use simplified options in the Functions menu to enter public holidays or to enter multiple 

daily shift plans at once. 

Enter daily shift plans: Use this menu item to enter daily shift plans for several days. 

Set/reset derivation: Use this function to create, modify, or undo inheritance hierarchies for annual 

shift plans. 

Update annual plans: Update means the transfer by the system of annual plans to subsequent 

years. You can find the Update annual plans function in the Annual shift plan overview view. 
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Deleting annual shift plans: An annual shift plan can only be deleted for each calendar year for 

which it is defined. If derived annual plans exist, a prompt is displayed and all derived annual plans 

are deleted as well if you confirm the prompt. You can access this function by selecting Data and 

Delete. 

Check annual plans: For each of the selected annual shift plans, you can use this function to 

check whether the daily plans for successive days overlap. This type of overlapping is not 

permitted and can cause scheduling problems, for example. 
 

Enter annual shift plan 

The following steps describe how to create an annual shift plan. 

Please note: As an alternative to the following steps for creating an annual shift plan, you can 

open an existing shift plan and save it with a different ID by selecting Data and Save. Then make 

the required adjustments in this new shift plan. 

1. In System functions, open the Shift plans folder, select Annual shift plans and click the New 

tab. The shift plan ID is entered by default. Enter a name for the annual shift plan and the 

calendar year of its validity and click Create. 

2. On the Annual overview tab, use the list box for each workday to enter the required daily shift 

plan. You can speed up entry by selecting Functions and Enter daily shift plans. 

3. Select Data and Save to save the shift plan you entered. 
 

Update annual shift plans 

Update means to transfer annual plans to subsequent years. 

Proceed as follows to display annual plans. 

1. Select System functions > Shift plans > Annual shift plans and load a shift plan. 

2. Select View > Annual shift plan overview. 

3. Select Functions > Update annual shift plans. 

An update is performed for all loaded or selected annual shift plans. An update does not 

change years for which an annual plan has been created. 
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Before an annual plan is updated, the system determines its hierarchy structure and 

updates its parent plans. 

Please note: In general, only shift plans of update types 1 or 3 (see Annual shift plan 

header) can be updated. 

Example: The following example shows a hierarchy structure with update rules. 

Basic plan for 

fixed public 

holidays 

 

 
Update by date 

 Level 2 for 

flexible public 

holidays or 

company days 

 
No update (manual 

maintenance) 

 

 Level 3 for 

weekday-dependent 

entries 

Update by weekday 

 

Gaps can develop when you update a hierarchy structure using different rules. 

Note: For resetting updates, see the note in Undo annual plan update. 

Any specifics that occur while updating or resetting an update are recorded in log files. 

Open the inforLogViewer.exe file and load the log file. 
 

Set derivation 

You define a derivation for shift plans (page 1374) in Annual shift plans (page 1377). 
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Copying shift plans Deriving shift plans 

When you copy an annual shift plan, 

the shift plan and all daily shift plans 

entered are copied and entered in the 

database. 

When you derive an annual shift plan, the shift plan is 

not copied in full. Specifically, the daily shift plans are 

not transferred to the database; references to the daily 

shift plans are copied (inherited). 

 

Inherited daily shift plans are indicated by a red bar. 

Changes to master shift plans affect the derived shift plans. Shift plans can have only one master 

shift plan, but you can derive a shift plan from a derived shift plan, creating inheritance hierarchies. 

Inheritance hierarchies are defined separately for each calendar year. Last year's inheritance rule 

is transferred in general during manual or automatic updates (see Annual shift plans (page 1377)). 

Proceed as follows to structure a hierarchy: 

1. In System functions open the Shift plans and then the annual shift plan you want to derive 

from. 

2. Select Data > Save as, enter the shift plan number, and select the Save as a derivation of 

check box. Click OK. 

Note: Alternatively, in the opened shift plan you can select Functions > Set/reset derivation. 

Please note:  The original basic plan can be supplemented step by step by building an 

inheritance hierarchy. 

3. Check the hierarchy properties of the annual plan by selecting Functions and Hierarchy 

properties. 
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Call 

System functions > Database administration 

Description 

This application lets you run scrips and processes for initializing or converting data (for example, 

during an installation). 

The scrips must be programmed in Lj4 as Lj4 functions and can be assigned to modules saved in 

the relFXDBMaintModule relation and can be imported using the ImEx script 

ixcFXDBMaintModule. 

The names of the Lj4 scripts that can be used are saved in the relFXDBMaintScript table. You can 

import them using the ImEx script ixcFXDBMaintScript. 

 

 

Database administration 
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Call 

System functions > Filters 

Description 

You can use filters in Infor COM for the following purposes: 

1. Filters can restrict the data volume when the database is accessed (Filters tab in Open tabs). 

2. You can use a filter to show or hide data in a VTab containing entries (such as in overview 

tables). 

3. You can use filters to print a report. 

In addition, various internal processes in Infor COM use filters. 

 The filters offered in applications are set up in System functions. For more information, see 

Filter maintenance in System functions (page 1390). 

 For more information on the use of filters, see Filter in applications (page 1393). 

 

Identifying filters 

Each filter is identified by a name, ID, and a description. Filter names must be unique in Infor 

COM. You can use the ID to group the filters by assigning the same ID to each filter of a group 

(e.g. Inventory=1, Sales=2, etc.). The description is provided for ease of identification. 

 

Times in filters 

Values that represent periods of time are always specified and edited in industrial time in filters. 

 

Loading and unloading filters 

To load or unload filters in System functions, Filter open the Administration folder and select 

Load/unload. 
 

Filters 
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Filter types 

Filters are divided into system filters and user filters. 

 System filters are only used internally and should be changed for adjustments only. They are 

not available in applications and can only be edited in System functions. 

 User filters are generally available, and you can modify them or create new ones. 

A filter can be defined as a system filter and a user filter at the same time. 
 

Field types in filters 

For easier access to frequently used database fields when using filters, you can divide the fields of 

a view into User fields and Administrator fields. When opening filters, the field display can be 

reduced to user fields in a view. 

 User fields are defined by the user in Filter settings. Users typically define fields as user fields 

if they are frequently used when using filters. 

 Administrator fields are all fields not defined as user fields. 

The standard defines user fields for the most common views (relAc, relCb, relDb, relFirma, relGb, 

relij, relPerson, relText, relXDb, viwAcVt, viwAdressen, viwBestLst, viwDbVt, viwEinkauf, viwEs1, 

viwJournal, viwKalkVT, viwPreistabelle, viwSaldVt, viwVertrieb). 

Access to specific fields can be made even easier using Field groups whereby database fields that 

have a similar content are grouped. You can create a field group that contains all SQL fields of a 

database table for each database view using SQL filter group (see SQL filter group (page 1486)). 

To define the field type and field groups in System functions, select the Administration folder and 

Filter settings (see Filter settings (page 1486)). 
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Filter criteria 

All criteria that are defined for a filter are stored in a table (see Create filter (page 1390)). 

A single filter criterion is a combination of the condition and value of a field. 

Condition Record type Condition Status Condition Queue position 

= 10 = 4   

= 10 = 5 <= 4 

= 90 = 4   

= 90 = 5 <= 4 

= 115 = 4   

= 115 = 5 <= 4 

Example: Condition "=" and value "90" of the Record type field results in the "record type = 90" 

criterion. 

The following applies regarding the interpretation of the table shown: 

 Each column contains one field as the basis for selection (such as Record type) and a 

condition for this field. The condition column always precedes the field column. 

 You may specify up to nine filter criteria in a row. 

 All criteria specified in a row are linked by an AND operator, i.e. all criteria of a row must apply 

in order for the filter condition to be met. 

Example: Row 3 in the table shown above applies when the "internal record type = 90" and the  

"Status = 4" criteria are true. 

 All rows are linked by an OR operator, i.e. at least one row must apply to meet the filter 

condition. 

Example: The filter defined in the above table applies when one of the six rows specified 

applies. 

Important: The From–To (exclusively) and From–To (inclusively)" conditions are exempt from 

the OR link of two rows because these are defined across two rows, and both must apply at 

the same time. The second row is blocked from entering more criteria. 

Notes on entering filter criteria 

Watch the field type and avoid special characters when entering criteria. For example, do not enter 

additional inverted commas in string fields. 
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Note: Dates can be entered using periods (e.g. 3.14.2014) or slashes (e.g. 3/14/2014) as 

separators, and can also include spaces before or after the separator (e.g. 3. 14. 2014). 

In numerical values you can use either a decimal point or a comma as decimal separator (e.g. 

12,34 or 12.34). When you enter a comma, it will be converted into a decimal point. Use of periods 

as thousands-group separators is not supported. 

Examples 

Example 1: Load all operations in progress 

You want to load all operations that are still in progress. The following values apply: internal record 

type (DbPart.SAint) = 60, status (DbPart.Zust) = 5, and queue position (DbPart.WS) > 3. 

These values are stored in the filter criteria as follows: 

Condition Record type Condition Status Condition Queue position 

= 60 = 5 > 3 

Example 2: Load all operations for which no end transaction has been entered 

You want to load all operations for which no End transaction has been entered. The following 

values apply: internal record type (DbPart.SAint) = 60, status (DbPart.Zust) = 5, and queue 

position (DbPart.WS) > 3 or status (DbPart.Zust) < 5. 

These values are stored in the filter criteria as follows: 

Condition Record type Condition Status Condition Queue position 

= 60 = 5 > 3 

= 60 < 5   

For more information, see Conditions for filter criteria (page 1385). 
 

Conditions for filter criteria 

You can use different conditions when defining filter criteria (page 1384). The filter conditions are 

stored in the FILTERCOND allocation table. 
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Please note: To view the internal field names for the following examples, you must select the 

Internal field name check box on the Display form section. 

Conditions for all field types 

The following table lists the conditions that you can specify for all field types. 

> Is greater than 

< Is less than 

= Is equal to (default condition when no condition is selected) 

<> Is not equal to 

Empty Left blank 

Not empty Has entries 

>= Is equal to or greater than 

<= Is equal to or less than 

From - to (exclusively) Greater than Value1 and less than Value2 

From - to (inclusively) Equal to or greater than Value1 and equal to or less than Value2 

 

The "From – to (exclusively)" and "From – to (inclusively)" conditions 

Two rows are provided for From – to (exclusively) and  From – to (inclusively): Enter Value1 

("From) in the first row and Value2 (To) in the second row. The second row is blocked from 

entering more criteria. 

Condition Record type 

From (incl.) 10 

To(incl.) 90 
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Conditions for text fields 

The following table lists the conditions that you can specify for text fields only: 

Contains Contained in text ("%search text%") 

Does not contain Not contained in the text 

Begins with Text start ("search text%") 

Ends with Text end ("%search text") 

Like Matches ("%search text%","search text%","%search text") 

Not like Does not match ("%search text%","search text%","%search text") 

 

Conditions for date/time fields 

The following table lists the conditions that you can specify for date and time fields only: 
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On On the date 

On or after On or after the date 

On or before On or before the date 

Yesterday The day before the current date 

Today On the current date 

Tomorrow The day after the current date 

Last month Between the 1st and 31st day of the previous calendar month 

This month Between the 1st and 31st day of the current calendar month 

Next month Between the 1st and 31st day of the next calendar month 

Last year Between Jan. 1 and Dec. 31 of the previous calendar year 

This year Between Jan. 1 and Dec. 31 of the current calendar year 

Next year Between Jan. 1 and Dec. 31 of the next calendar year 

Until now Between Jan. 1 of the current calendar year and the current date 

From now Between the current date and Dec. 31 of the current calendar year 

Last week Between Monday and Sunday of the last calendar week 

This week Between Monday and Sunday of the current calendar week 

Next week Between Monday and Sunday of the next calendar week. 

 
 

Restrictions when using filters 

The following restrictions apply when you use filters (page 1382): 

Runtime errors may occur if the filter criteria contain database fields that are not SQL fields. To 

prevent this problem, you can use the SQL filter group process to create a field group for each 

database view that contains all SQL fields of the database table. This group is created for each 

database view named SQL fields. Fields of this group can be used in filters without problems and 

do not result in the runtime errors mentioned above. 

Runtime errors can also occur if the filter criteria contain temporary fields of a view. Temporary 

fields should therefore be avoided when defining filter criteria. 
 



Infor COM 7.5 User Guide | 1389 

 

System functions 

 

Filter parameters in the configuration 

The COMMON.FILTER section in the configuration contains the following parameters for using 

filters (page 1382): 

 COMMON.FILTER.ADMINFIELDS: The setting of this parameter determines the default value 

of the Administrator fields check box in the Filters dialog box. If the setting is 

COMMON.FILTER.ADMINFIELDS= 0, the Administrator fields check box is not selected when 

the Filters dialog box is opened. If the setting is COMMON.FILTER.ADMINFIELDS=1, the 

Administrator fields check box is selected when the Filters dialog box is opened. You can 

select or clear the check box in the Filters dialog box at any time. 

For more information about the Administrator fields check box, see Filters. 

 COMMON.FILTER.INTERNALFIELDNAMES: The setting of this parameter determines the 

default value of the Internal fields check box in the Filters dialog box. If the setting is 

COMMON.FILTER.INTERNALFIELDNAMES= 0, the Internal fields check box is not selected 

when the Filters dialog box is opened. If the setting is 

COMMON.FILTER.INTERNALFIELDNAMES=1, the Internal fields check box is selected 

when the Filters dialog box is opened. You can select or clear the check box in the Filters 

dialog box at any time. 
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Filter maintenance in System functions 

In System functions, the following actions are available for filter maintenance: 

 To enter and change filters, select System functions > Filters (see Create filter (page 1390)). 

 To enter settings for views for which filters can be defined, select System functions > 

Administration > Filter settings. You can create field groups (see Create new field group (page 

1391)) and flag fields as user fields (see Filter settings (page 1486)). 

 To create an SQL fields group containing all of the SQL fields from the database table for each 

database view, select System functions > Administration > SQL filter group (see SQL filter 
group (page 1486)). 

 

Create filter 

The following instructions describe how to create a new filter (see "Filters" page 1382) in System 

functions. 

1. In System functions, open the Filter object. The Filters dialog box opens (see Filters). 

2. Enter the view to whose fields the new filter is to be applied. 

3. Enter the name for the new filter in the Name field. Click in any other field. If a filter with that 

name does not already exist for the specified view, a prompt is displayed when you exit the 

Name field asking Filter <name> not found. Create new filter?. Click Yes. 

4. Enter the usage of the new filter (User filter or System filter) (see Filter types (page 1383)). 

5. Define the criteria for the new filter as follows (see Filter criteria and Conditions for filter 

criteria): 

 Select a database field from the Field combo box that is to be used for filtering. You can 

change the field display in the combo box using the Internal fields and Administrator fields 

check boxes. 

 Transfer the database field you selected to the criteria table using the Transfer field button. 

 Place the required condition in front of the database field transferred in the Criteria row. If 

you want to assign various conditions to a field, write them one below the other in the 

following rows. The rows are linked by an OR operator. 

 Transfer more database fields in this way, if required. 

Each database field is written to its own column in the filter criteria table. The columns are 

linked by an AND operator. 

6. Save the newly created filters using the Save option. You are asked if the filter is to be created. 

Click Yes. 
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7. Then enter the ID, name, and description of the new filter in the Enter filter name dialog box 

and confirm your entries by clicking OK. 
 

Create new field group 

This function is available in Filter maintenance (see "Filters" page 1382). 

1. In System functions, open the Administration folder and select Filter settings . 

2. In the Filter settings dialog box, select the view for which you want to form a field group in the 

View field. You can also select a view by specifying a filter in the Filter field. When the filter is 

loaded, its associated view is loaded as well. 

3. Click New group. 

4. In the New group dialog box, enter a name and description for the new group and click OK. 

5. Select the new group you created from the combo box in the Group field. 

6. Transfer the required fields to the group. Select the fields in the Fields in view table, and click 

the Transfer to group button. Double-click fields to transfer them individually from the Fields in 

view table to the Fields in group table. 

7. Save the transferred fields using Save fields in group. 

8. Click Close to close the filter settings. 
 

Delete field group 

This function is available in Filter maintenance (see "Filters" page 1382). 

1. In System functions, open the Administration folder and select Filter settings. 

2. In the Filter settings dialog box, select the view for which you want to delete a field group in the 

View field. 

3. In the combo box of the Group field, select the field group that you want to delete. 

4. Click Delete group. 

5. The field group you want to delete is displayed in the Group field of the Delete group dialog 

box. You can select another field group in this combo box. 
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6. Click OK. 

Note: The selected group is deleted immediately without a confirmation prompt. 
 

Delete fields from a field group 

This function is available in Filter maintenance (see "Filters" page 1382). 

1. In System functions, open the Administration folder and select Filter settings. 

2. In the Filter settings dialog box, select the view for which you want to edit a field group in the 

View field. 

3. In the combo box of the Group field, select the group from which you want to remove fields. 

4. Select the fields to be deleted from the group in the Fields in group table. 

5. Click Delete group. 
 

Specify user fields 

This function is available in Filter maintenance (see "Filters" page 1382). 

1. In System functions, open the Administration folder and select Filter settings. 

2. In the Filter settings dialog box, select the view for which you want to define user fields in the 

View field. 

3. In the User column in the Fields in view table, select the fields that you want to be user fields. 

Fields that are not selected are treated as administrator fields. 

4. Click Save user fields. 
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Filter in applications 

You can use filters (page 1382) in applications for the following purposes: 

 You can reduce the data volume when accessing the database using the Filters tab in dialog 

boxes. 

 You can use the  and  icons to show or hide data in a VTab containing entries (e.g. in 

overview tables). 

 You can limit the data to be printed in a report using the Filter button in the Report overview 

dialog box. 
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Working with filters 

Edit filter 

The following steps show you how to edit filters in applications (see "Filter in applications" page 

1393). 

If you have loaded a filter in the Filters dialog box, you can change or expand the filter criteria. 

Proceed as follows: 

1. Select a database field from the Field combo box that is to be used for filtering. You can 

change the field display in the combo box using the Internal fields and Administrator fields 

check boxes. 

2. Transfer the database field you selected to the criteria table using the Transfer field button. 

3. In the condition column in front of the newly inserted field, select the condition you want to 

apply to the field. Enter the value for the condition in the field column (e.g. condition > and 

value 50 for the criterion > 50). 

If you want to have a field checked for being equal to a value, you only need to enter that value 

in the field column because the = condition is set as a standard condition. 

For more information, see Filter criteria (page 1384) and Conditions for filter criteria (page 

1385). 

4. If you want to delete a criterion already entered, place your cursor on the respective cell in the 

table. Then click Delete column if you want to delete a database field with its associated 

conditions from the table. Click Delete row to delete a row with criteria from the table. 

5. You can save your changes using the Save button. Assign an ID, name, and description to the 

filter in the Enter filter names dialog box (see Enter filter names). 

Assign a new filter name when you want to save a new filter. To overwrite an existing filter, 

leave the name displayed and confirm the following prompt. 

6. You can select all records that match the specified filter criteria using the Apply button. 

Click Cancel to exit the Filters dialog box without loading data. 
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You can import and export data using the Import/export module. 

During import, data from readable files (ASCII and other text files) is imported into Infor COM 

database tables. See Import/export. 

During export, data from Infor COM database tables is exported to text files. See Import/export. 

Configurations are required for both import and export. A configuration contains the information 

required for import or export (data file format, target and source table, etc.). These configurations 

are created in the Infor COM Dialog Manager (see Create configuration for import/export (page 

1396) and Structure of import/export configuration (page 1397)). 

The Import/export module directly accesses the database. It does not perform any master data 

additions, ID assignment, or consistency checks. These checks are available in the Master data 

transfer object (see Master data transfer (page 1488) in System functions). 

Log file 

All status and error messages of the Import/export module are logged in a central log file. This file 

is created in the user-specific subdirectory for log files and can be viewed using the separate Infor 

COM viewer (inforLogViewer.exe). 

The user-specific subdirectory for log files is specified in the Infor COM Management Console 

configuration (GeneralLogDir parameter). If nothing is specified, the log file is written to the 

following directory: 

<working directory Infor COM>\log\<user name>. 

After an import or export, you can have the Infor COM LogViewer start automatically and display 

the log entries of the Import/export module. 

If you start the Infor COM LogViewer manually, you can filter the log file entries using the ImEx 

group name to limit the message display to the Import/export module. 

Import/export 
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Import/export using Script Console rather than from the Infor COM desktop 

You can perform import/export actions with the Script Console command interpreter rather than 

from the desktop. You can find the respective Script Console script imex.vqs in: <working directory 

Infor COM>\sysbox\vqliscr\system. 

The log file is identical to the one used if you import/export from the desktop. 
 

Create configuration for import/export 

Configurations for the Import/export (page 1395) function are created and processed in the  

ScriptData domain of the Infor COM Dialog Manager. They belong to the ImExConfig element 

type. 

1. Open the Infor COM Dialog Manager. 

2. In the Infor COM Dialog Manager, load any object into the ScriptDataDef domain. 

3. Select File, New, and Create object. Click Insert to confirm the ImExConfig element type. 

4. Assign a name to the new configuration in the subsequent Hierarchy properties dialog box. 

Note the naming convention: Configurations have the prefix ixc. 

In addition, assign a description. This description is displayed on the desktop of Infor COM in 

the Import/export dialog box. 

Example: Template for transferring master data relAb (description of the 

ixcMigrationPatternrelAb configuration). 

5. Enter a tilde (~) as the first character in the description for configurations that are not to be 

displayed for selection in the Import/export dialog box. 

Example: ~ Export A file for EXVA (description of the ixcM8AStrEXVA configuration). 

Note on the declaration: Configurations are always defined as basic form components. The 

Derived from option in the Declaration section is blocked for configurations. To access this 

option, right-click the object and select Hierarchy properties from the shortcut menu. See also 

theHierarchy properties dialog box in IDM_us.chm Help. If you want to use one configuration 

as a template for another, we recommend that you transfer the content of the existing 

configuration to the new configuration using the clipboard. 

6. This new configuration is opened in Script mode and can be edited. 
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Structure of import/export configuration 

An import/export configuration consists of two sections. 

Section 1: The section starts with general settings (global properties). A semicolon concludes 

each entry. See also Global properties (ImExConfig) (page 1407). 

Section 2: The keyword FIELDS is followed by a list of fields that are contained in the data file 

during import or written to the data file during export. Each field name is concluded by a 

semicolon. 

You can set field-related properties for each field to influence the output or interpretation of the 

respective field. You can find the property between the field name and the semicolon. If you set 

multiple properties, these are separated by commas. See also Field-related properties 

(ImExConfig) (page 1429). 
 

Syntax of an import/export configuration 

This Help topic describes the syntax of an import/export configuration. 

You can enter comments for the rest of the row after a double slash //. 

You can frame comments in asterisks /* ... */ both within a row and across several rows. 

If you want to assign a field name like a key name, frame it in double inverted commas ("...") or 

mark it with a slash. 

Upper and lower case are not taken into account in keywords of the syntax. 
 

Strings for import/export configurations 

This Help topic describes the use of strings of characters in the Import/export function. 

Frame properties are expressed as strings in double inverted commas ("..."). Special characters 

are identified using a backslash \ like in the Lj4 syntax such as "\"A\"" for an A in double inverted 

commas. 
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If you want strings to contain a backslash (\), it has to be doubled, e.g. in path information 

(c:\\infor\\daten.io). 

There are keywords for special and separator characters (see Constants for separators 

(ImExConfig) (page 1403)). 

Strings and keywords are combined to form a string (see below in Examples of strings). 

Examples of strings 

String/keyword Example of usage 

CrLf Keyword as RecordSeparator 

"@@@" String as RecordSeparator 

Semicolon "@@@" CrLf Combination of keywords and string as RecordSeparator 

"SELECT * FROM relAc" String as statement for VQLExport 

"SELECT * FROM relAc" CrLf 

"Where DbPart.MNr LIKE 'K%'" 

Combination of strings and keyword as statement for VQLExport 

"C:\\Data\\ac.dat" String for specifying a file name 

 
 

Keywords for import/export configurations 

Keywords for configurations are reserved words. They should only be used in their capacity as 

keywords in a configuration, not in any other capacity such as a field name. 

The following list contains the keywords used for configurations. 
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Abort OnError (ImExConfig) (page 1419) 

Alignment Alignment (ImExConfig) (page 1429) 

ANSI CharacterSet (ImExConfig) 

AppendOrCreate FileCreateMode (ImExConfig) (page 1414) 

Blank Blank (ImExConfig) (page 1403) 

BlobFileName BlobFileName (ImExConfig) (page 1408) 

BlobFileNameCountLen Internal use 

BlobFileNameCountStart Internal use 

BlobFileNameFixName Internal use 

BlobFileNamePostCount Internal use 

BlobFileNamePreCount Internal use 

BlobFilePath BlobFilePath (ImExConfig) (page 1407) 

Both Usage (ImExConfig) (page 1424) 

By BlobFileName (ImExConfig) (page 1408) 

ByVTab OpChar (ImExConfig) (page 1443) 

CharacterSet CharacterSet (ImExConfig) 

Comma Comma (ImExConfig) (page 1403) 

Count BlobFileName (ImExConfig) (page 1408) 

Cr Cr (ImExConfig) (page 1403) 

CrLf CrLf (ImExConfig) (page 1404) 

DateFormat DateFormat (ImExConfig) (page 1409) 

DecimalAsciiEscapeChar Internal use 

DecimalPoint DecimalPoint (ImExConfig) (page 1410) 

Delete VQLImport (ImExConfig) (page 1427) 

DeleteBeforeInsert DeleteBeforeInsert (ImExConfig) (page 1410) 

DoNotOverwrite FileCreateMode (ImExConfig) (page 1414) 

DoNotStrip DoNotStrip (ImExConfig) (page 1431) 

DontOverwrite FileCreateMode (ImExConfig) (page 1414) 

DontStrip DoNotStrip (ImExConfig) (page 1431) 

DummyField DummyField (ImExConfig) (page 1442) 

EscapeChar EscapeChar (ImExConfig) (page 1411) 
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Export Usage (ImExConfig) (page 1424) 

ExportHeadline ExportHeadline (ImExConfig) (page 1412) 

ExportNewLineAs ExportNewLineAs (ImExConfig) (page 1413) 

ExtLen ExtLen (ImExConfig) (page 1432) 

BlobFileName (ImExConfig) (page 1408) 

Fields Structure of import/export configuration (page 1397) 

FieldSeparator FieldSeparator (ImExConfig) (page 1414) 

FileCreateMode FileCreateMode (ImExConfig) (page 1414) 

Filename Filename (ImExConfig) (page 1415) 

FileOnly Usage (ImExConfig) (page 1424) 

FillChar FillChar (ImExConfig) (page 1434) 

Fixed RecordFormat (ImExConfig) (page 1420) 

BlobFileName (ImExConfig) (page 1408) 

FullStop FullStop (ImExConfig) (page 1404) 

HexAsciiEscapeChar Internal use 

Import Usage (ImExConfig) (page 1424) 

ImportAsNewLine ImportAsNewLine (ImExConfig) (page 1415) 

Insert VQLImport (ImExConfig) (see "VQLExport (ImExConfig)" 
page 1425) 

Komma Comma (ImExConfig) (see "Komma (ImExConfig)" page 

1404) 

Left Alignment (ImExConfig) (page 1429) 

LeftFieldSeparator LeftFieldSeparator (ImExConfig) (page 1435) 

Lf Lf (ImExConfig) (page 1404) 

MaxVtLines MaxVtLines (ImExConfig) (page 1416) 

MessageLevel MessageLevel (ImExConfig) (page 1417) 

None None (ImExConfig) (page 1405) 

NumberAlignment NumberAlignment (ImExConfig) (page 1417) 

NumberFillChar NumberFillChar (ImExConfig) (page 1418) 

NumDecimal NumDecimals (ImExConfig) (page 1418) 

NumDecimals NumDecimals (ImExConfig) (page 1418) 

OEM CharacterSet (ImExConfig) 
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OnError OnError (ImExConfig) (page 1419) 

OpChar OpChar (ImExConfig) (page 1443) 

OverwriteAlways FileCreateMode (ImExConfig) (page 1414) 

Period Period (ImExConfig) (page 1405) 

Pre5DateMask Pre5DateMask (ImExConfig) (page 1437) 

ReadFile Usage (ImExConfig) (page 1424) 

RecordFormat RecordFormat (ImExConfig) (page 1420) 

RecordSeparator RecordSeparator (ImExConfig) (page 1421) 

RegExLeftFieldSeparator RegExLeftFieldSeparator (ImExConfig) (page 1438) 

RegExRightFieldSeparator RegExRightFieldSeparator (ImExConfig) (page 1438) 

Right Alignment (ImExConfig) (page 1429) 

RightFieldSeparator RightFieldSeparator (ImExConfig) (page 1439) 

SearchByFields SearchByFields (ImExConfig) (page 1422) 

Select VQLExport (ImExConfig) (page 1425) 

Semicolon Semicolon (ImExConfig) (page 1405) 

Semikolon Semicolon (ImExConfig) (see "Semikolon (ImExConfig)" 

page 1406) 

Separated BlobFileName (ImExConfig) (page 1408) 

Skip OnError (ImExConfig) (page 1419) 

SpecialChars EscapeChar (ImExConfig) (page 1411) 

Start BlobFileName (ImExConfig) (page 1408) 

StringAlignment StringAlignment (ImExConfig) (page 1423) 

StringFillChar StringFillChar (ImExConfig) (page 1423) 

Strip Strip (ImExConfig) (page 1439) 

Strip_Left StripLeft (ImExConfig) (page 1440) 

Strip_Right StripRight (ImExConfig) (page 1441) 

Tab Tab (ImExConfig) 

Underscore Underscore (ImExConfig) (page 1406) 

Unicode CharacterSet (ImExConfig) 

Update VQLImport (ImExConfig) (page 1427) 

Usage Usage (ImExConfig) (page 1424) 

Variable RecordFormat (ImExConfig) (page 1420) 



1402 | Infor COM 7.5 User Guide 

 

System functions 

 

View View (ImExConfig) (page 1425) 

VQLExport VQLExport (ImExConfig) (page 1425) 

VQLImport VQLImport (ImExConfig) (page 1427) 

WriteFile Usage (ImExConfig) (page 1424) 

Zero Zero (ImExConfig) (page 1406) 
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Constants for separators (ImExConfig) 

The Help topics below show available constants among the keywords that can be used as 

separators. 
 

Blank (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Space. 

Example:  FieldSeparator Blank; 
 

Comma (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Comma 

Identical to Komma (ImExConfig). 

Example: FieldSeparator Comma; 
 

Cr (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Carriage return (ASCII 13). 

Example: RecordSeparator Cr; 
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CrLf (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: MS DOS line break (ASCII 13+10). 

Example: RecordSeparator CrLf; 
 

FullStop (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Period. 

Identical to Period (ImExConfig). 

Example: FieldSeparator FullStop; 
 

Komma (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Comma. 

Identical to Comma (ImExConfig). 

Example: FieldSeparator Komma; 
 

Lf (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: UNIX line break (ASCII 10). 
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Example: RecordSeparator Lf; 
 

None (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Empty string. 

None is not permitted for all properties. 

Example: FieldSeparator None; 
 

Period (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Period. 

Identical to FullStop (ImExConfig). 

Example: FieldSeparator Period; 
 

Semicolon (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Semicolon. 

Identical to Semikolon (ImExConfig). 

Example: FieldSeparator  Semicolon; 
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Semikolon (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Semicolon. 

Identical to Semicolon (ImExConfig). 

Example: FieldSeparator Semikolon; 
 

Tab (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Tab (ASCII 9). 

Example: FieldSeparator Tab; 
 

Underscore (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Underscore ("_"). 

Example: FieldSeparator Underscore; 
 

Zero (ImExConfig) 

For general instructions on constants in import/export keywords (see "Keywords for import/export 

configurations" page 1398), see Constants for separators (ImExConfig) (page 1403). 

Explanation of constant: Zero. 

Example: FieldSeparator Zero; 
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Global properties (ImExConfig) 

See Create configuration for import/export (page 1396) to learn how to create configurations for 

the Import/export (page 1395) function. 

For an overview of keywords for import/export configurations see Keywords for import/export 

configurations (page 1398). 

Each definition of a global property typically consists of a keyword and its associated value. 

Each definition must be closed with a semicolon. 
 

BlobFilePath (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

BlobFilePath specifies the path of the file(s) with the contents of the blobs. 

Note: Blob(Binary Large Objects) fields are a special data type in database systems for storing 

multimedia information such as images, texts, and graphics in ERP systems. 

Property type: 

Global property. 

Example: BlobFilePath "sysbox\\imex\\imptexte\\rtf"; 

Related topics:  

BlobFileName (ImExConfig) (page 1408) 

Import/export texts with individual text files (Import/export example) (page 1454) 

Import/export texts with one shared text file (Import/export example) (page 1456) 
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BlobFileName (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

BlobFileName specifies if a joint file or individual files are used for blobs and what the file names 

are. File names are preceded by the BlobFilePath (if required, with "\"). If a joint file is used, offset 

and length are given in bytes in the Blob field of the export file. If single files are used for blobs, the 

file names are listed in the Blob field of the export file. In general, only one Blob field is supported 

per database table. 

Note: Blob(Binary Large Objects) fields are a special data type in database systems for storing 

multimedia information such as images, texts, and graphics in ERP systems. 

Property type: 

Global property. 

Permitted/default values 

Fix <File name> A joint file with the specified name. 

SearchByFields 

 [Separated By <separator>] 

Individual files whose name is formed from the content of the fields specified in 

SearchByFields. 

The default separator is Underscore ("_"). 

[<String>] Count 

 [ExtLen <Number>] 

 [Start <Number>] [<String>] 

Individual files with sequential numbers as part of their names. 

These optional entries represent constant name components before or after 

the counter, the minimum number of digits, and the start value for the first file. 

Default values are an empty string or 0. If no optional entries were made, 8 

digits and the extension ".blb" are used. 

Examples:  

BlobFileName Fix "texte.bin"; 

BlobFileName SearchByFields Separated By FullStop; 

BlobFileName "text" Count ExtLen 3 ".blb"; // generates the files text000.blb, 

text001.blb, etc. 

BlobFileName Count; // generates the files 00000000.blb, 00000001.blb, etc. 

Related topics:  
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BlobFilePath (ImExConfig) (page 1407) 

Import/export texts with individual text files (Import/export example) (page 1454) 

Import/export texts with one shared text file (Import/export example) (page 1456) 

SearchByFields (ImExConfig) (page 1422) 
 

DateFormat (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

DateFormat specifies which date format is to be used if a date format was not defined for a field. 

Property type: 

Global property. 

Permitted/default values 

infor2DigitYear Input/output in the following format: 

MMDDYYhhmmss or MM/DD/YY/hh:mm:ss (Pre5Datemask) 

infor4DigitYear Input/output in the following format: 

MM/DD/YYYY hh:mm:ss 

infor4DigitYearNoSeconds Input/output in the following format: 

MM/DD/YYYY hh:mm 

infor4DigitYearNoTime Input/output in the following format: MM/DD/YYYY 

<Free date format> See Date fields (ImExConfig) (page 1444). 

 

Example:  

DateFormat infor4DigitYear; 

Related topics:  

Date fields (ImExConfig) (page 1444) 
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DecimalPoint (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

DecimalPoint indicates the character used as a decimal point for floating point numbers.  

Property type: 

Global and field-related property. 

Permitted/default values 

You can use the separator constants as a decimal point. If you use a string, enter just one 

character. 

Example:  

DecimalPoint None;  // no decimal point 

DecimalPoint Period; // period as decimal point 

Related topics:  

Constants for separators (ImExConfig) (page 1403) 

NumDecimals (ImExConfig) (page 1418) 
 

DeleteBeforeInsert (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

Data frequently has to be re-imported. However, before data is imported, old records should be 

deleted to prevent duplicate records, for example. If  DeleteBeforeInsert is specified, records are 

deleted from the database before the import is started. The records to be imported are assigned to 

the records to be deleted via the SearchByFields property. 

Property type: 
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Global property. 

Permitted/default values 

<empty> Corresponds to the property set to the UseEveryRecord value. 

UseEveryRecord The values for the fields specified for SearchByFields are determined from each record 

to be imported. In this way a delete statement is send for each record before it is 

imported. 

If this option is used a record is usually deleted from the database for each record to be 

imported. 

UseFirstRecord The values for the fields specified for SearchByFields are determined only from the 

first record to be imported. The delete statement thus generated is only send once at the 

beginning of the import. 

If this option is used the number of records deleted form the database may exceed the 

number of records imported. 

The values of the fields specified for SearchByFields are appropriately identical across 

the entire import file. 

Examples:  View relAc; 

Usage Import; 

VQLImport       Insert; 

DeleteBeforeInsert; 

SearchByFields DbPart.MNr; 

Related topics:  

VQLImport with insert statement (Import/export example) (page 1451) 

SearchByFields (ImExConfig) (page 1422) 
 

EscapeChar (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

You can create an ID that covers characters in fields using EscapeChar. After EscapeChar, 

specify the characters to be covered using the SpecialChars keyword. The character specified as 

EscapeChar covers itself automatically. 
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You must set an EscapeChar ID when separators occur in string fields. A comma is a good 

example. It may be specified as a separator but also be contained in specific fields such as Desc. 

In this case, an EscapeChar ID is placed before the comma in such records. 

If the RecordFormat is variable, the back slash is the default EscapeChar ID. You need not set 

EscapeChar when you want to retain the back slash and cover the FieldSeparator. 

No EscapeChar is available for the fixed RecordFormat. 

Property type: 

Global property. 

Permitted/default values 

Characters that are used as field separators and that can also appears in string fields. 

Example:  

EscapeChar "/" SpecialChars ";,:"; 

In this example, the slash ("/") is defined as EscapeChar rather than the backslash ("\"). It is placed 

before the semicolon, comma, colon, and itself in string fields. 
 

ExportHeadline (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

Use ExportHeadline to output a list of the names of the exported fields or a static text in the first 

row when exporting data. This property has no effect on the import of data. 

Property type: 

Global property. 

Permitted/default values 
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<empty> Outputs the names of the exported fields in list format. 

The values set in the global RecordSeparator and FieldSeparator properties are used 

as separators. Field-related properties for separators such as RigthFieldSeparator are 

not taken into account. 

This property can also be used with the fixed RecordFormat property. However, the 

length of the field names are not adjusted to the fixed field lengths. In other words the 

length of the first row may differ from that of the other rows. 

Fix <Text> Outputs a static text. 

The value of the global property RecordSeparator is used as separator. 

 

Example:  

ExportHeadline; 

ExportHeadline Fix "This is the first row"; 

 
 

ExportNewLineAs (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

ExportNewLineAs indicates for the export how line breaks are to be written to the data file. You 

can use this property, for example, when there must not be a line break within a record during a 

link. 

Property type: 

Global and field-related property. 

Example:  

ExportNewlineAs Blank; 

Related topics:  

ImportAsNewLine (ImExConfig) (page 1415) 
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FieldSeparator (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

FieldSeparator specifies in what way the individual fields in a record are separated from each 

other. A global default field separator can be overwritten by a separator set for an individual field. 

Property type: 

Global and field-related property. 

Permitted/default values 

See Constants for separators (ImExConfig) (page 1403) 

Example:  

FieldSeparator  Semicolon; 
 

FileCreateMode (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

FileCreateMode can only be evaluated during unloading (for export Usage) and defines how the 

data file for the data to be exported (hereinafter called 'export file') should be treated. 

Property type: 

Global property. 
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Permitted/default values 

DoNotOverwrite 

DontOverwrite 

The export file must not exist before unloading. 

AppendOrCreate If an export file already exists, the data to be exported is appended to it. If no export file 

exists, an export file is generated. 

OverwriteAlways An existing export file must always be overwritten. If no export file exists, an export file is 

created. 

 

Example:  

FileCreateMode  DoNotOverwrite; 

Related topics:  

Usage (ImExConfig) (page 1424) 
 

Filename (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

File name specifies the name of the file to be saved or loaded as a default. 

Property type: 

Global property. 

Example:  

Filename "import.txt"; 
 

ImportAsNewLine (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 
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ImportAsNewLine indicates a string of characters that is transformed into a line break during 

import. 

Note: When you export data from Infor COM and then re-import it, we recommend that you use a 

string of characters that is otherwise unused for ExportNewLineAs and ImportAsNewLine. 

Property type: 

Global and field-related property. 

Example:  

ExportNewLineAs "$|"; 

ImportAsNewLine "$|"; 

Related topics:  

ExportNewLineAs (ImExConfig) (see "Field-related ExportNewLineAs (ImExConfig)" page 1433) 
 

MaxVtLines (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

MaxVtLines determines the blocks in which records are transferred. During import, one block is 

included in a database transaction. 

Property type: 

Global property. 

Permitted/default values 

1 - 30000 

The default value is 500. 

Specifics 

The MaxVtLines 1 setting may be useful in some cases. If a record generates a database error 

during import, all records of the current block are rejected. If MaxVtLines  is set to 1, only the 

corrupt record is not saved. 
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Example:  

MaxVtLines      1000; 

Related topics:  

OnError (ImExConfig) (page 1419) 
 

MessageLevel (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

You can control the message quantity and quality from Import/export using the MessageLevel 

parameter. Potential settings: 

MessageLevel 0 Only errors are output (on screen and Infor COM Reports) 

MessageLevel 1 MessageLevel 0 + warning messages (on screen and log 

file) 

MessageLevel 2 MessageLevel 1 + output of information to log file 

MessageLevel 3 MessageLevel 2 + output of information on screen 

The default setting is 2 (when the parameter is not set or the configuration has not been read). 
 

NumberAlignment (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

NumberAlignment specifies the alignment of the numeric fields. 

Property type: 

Global property. 

Permitted/default values 
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Right Right alignment. Right is the default 

setting. 

Left Left alignment. 

 

Example:  

NumberAlignment Right; 

Related topics:  

StringAlignment (ImExConfig) (page 1423) 
 

NumberFillChar (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

NumberFillChar specifies the fill character for numeric fields. 

Property type: 

Global and field-related property. 

Permitted/default values 

The default setting is the space (blank). 

Example:  

NumberFillChar Blank; 

Related topics:  

StringFillChar (ImExConfig) (page 1423) 
 

NumDecimals (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 
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NumDecimals specifies for a field of the Real field type how many decimal digits should be output 

for Export. The system rounds the values accordingly. 

The NumDecimals property is not checked during import. Decimal digits contained in the import 

file are read without change if a decimal separator is specified. But if the setting is DecimalPoint 

None; the NumDecimals value is evaluated. 

Property type: 

Global and field-related property. 

Permitted/default values 

The default value is zero. In this case, i.e. when there are zero decimal digits, no decimal point is 

output. 

Example:  

Some links transfer floating comma numbers with a fixed number of decimal digits but without a 

decimal point. If 2 decimal digits are set, pi would be 314. You can define this format for export and 

for import as follows: 

DbPart.BewPreis   DecimalPoint None, NumDecimals 2; 

Related topics:  

DecimalPoint (ImExConfig) (page 1410) 
 

OnError (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

OnError defines how to respond to an error during import or export. 

Property type: 

Global property. 

Permitted/default values 
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Abort Abort cancels the import at the exact record that was incorrectly read from the data file or was not 

saved to the database. It therefore does not matter what the position of the record is in one cycle 

(MaxVtLines).  

Abort is the default setting. 

Skip Skip skips records in which errors occur. This does not apply if the import is part of a parent transaction 

(for example in link processes). 

 

Example:  

OnError         Skip; 

Related topics:  

MaxVtLines (ImExConfig) (page 1416) 
 

RecordFormat (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

RecordFormat indicates the format of the data file. 

Property type: 

Global property. 

Permitted/default values 

Fixed Each record in the data file has a fixed length. Fields with a fixed length must be specified. 

You can define a fixed length using the field-related EXTLEN property. This fixed length must be 

specified for numeric fields. For string fields, the maximum number of characters from the 

database (internal length – 1) is used. We recommend that you define the length for these fields 

too. 

Variable The records in the data file may vary in length.  

If the Variable value is set, you must specify a record separator using RecordSeparator. In 

addition, you must specify the way in which the fields are separated. In general, you can use the 

FieldSeparator property. For individual fields, you can use LeftFieldSeparator, 

RightFieldSeparator, RegExLeftFieldSeparator, or RegExRightFieldSeparator. 
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Example:  

RecordFormat    Variable; 

Related topics:  

DummyField (ImExConfig) (page 1442) 

FieldSeparator (ImExConfig) (page 1414) 

LeftFieldSeparator (ImExConfig) (page 1435) 

RegExLeftFieldSeparator (ImExConfig) (page 1438) 

RegExRightFieldSeparator (ImExConfig) (page 1438) 

RightFieldSeparator (ImExConfig) (page 1439) 
 

RecordSeparator (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

RecordSeparator defines how records are separated. Frequently, a separator constant is used as 

the RecordSeparator. You may also specify any string or a combination of a constant and a string. 

If the RecordFormat is variable, a string used as RecordSeparator may only occur in this function 

in the data file and therefore must not occur in any field, for example. 

If the data file ends with the RecordSeparator, the closing line break is missing. A warning 

message is output and the system tries to interpret the unprocessed characters. 

Property type: 

Global property. 

Permitted/default values 

See Constants for separators (ImExConfig) (page 1403) 

Example:  

RecordSeparator CrLf; 

Related topics:  
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RecordFormat (ImExConfig) (page 1420) 
 

SearchByFields (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

SearchByFields indicates which fields are used to assign the imported records to records in the 

database. This property is needed in the following cases: 

 VQLImport Update 

 VQLImport Delete 

 DeleteBeforeInsert 

 Importing blobs (such as full descriptions) 

Property type: 

Global property. 

Permitted/default values 

Enter the required fields. If you have to enter more than one field, separate the fields by a comma. 

Example:  

View relAc; 

Usage Import; 

VQLImport       Insert; 

DeleteBeforeInsert; 

SearchByFields DbPart.MNr; 

Related topics:  

DeleteBeforeInsert (ImExConfig) (page 1410) 

VQLImport (ImExConfig) (page 1427) 

VQLImport with keyword update (Import/export example) (page 1452) 

VQLImport with keyword delete (Import/export example) (page 1453) 
 



Infor COM 7.5 User Guide | 1423 

 

System functions 

 

StringAlignment (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

StringAlignment specifies the alignment of alphanumeric fields. 

Property type: 

Global property. 

Permitted/default values 

Left Left alignment. Left is the default setting. 

Right Right alignment. 

 

Example:  

StringAlignment Left; 

Related topics:  

NumberAlignment (ImExConfig) (page 1417) 
 

StringFillChar (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

StringFillChar specifies the fill character for alphanumeric fields. 

Property type: 

Global property. 

Permitted/default values 

The default setting is the space (blank). 
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Example:  

StringFillChar Blank; 

Related topics:  

NumberFillChar (ImExConfig) (page 1418) 
 

Usage (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

Usage specifies the import or export steps for which a configuration can be applied. The other 

steps are not permitted. 

Property type: 

Global property. 

Permitted/default values 

Import Read records from a file and save them with the VQLImport 

statement. 

Export Load records with the VQLExport statement and write them 

to a file. 

Both Both import and export. 

ReadFile Read records from a file into a VTab. 

For internal use in processes only. 

WriteFile Write records from a VTab to a file. 

For internal use in processes only. 

FileOnly Both ReadFile and WriteFile. 

For internal use in processes only. 

 

Example:  

View relAc; 

Usage Import; 

VQLImport       Insert; 
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View (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

View defines the view to which the field names refer. The field types are taken from the view. 

Property type: 

Global property. 

Specifics 

View must be the first property in the configuration. 

Example:  

VIEW viwAcVt ; // view 

VIEW relAb;    // database table 
 

VQLExport (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

After VQLExport, formulate the VQL statement with which data is loaded from the database to a 

temporary VTab of the view defined above. As an alternative to a VQL statement, you can enter 

the Select keyword. 

The target view of the export statement must match the view or database table defined in VIEW. 

You must specify VQLExport if Usage is set to Export or Both (see Usage (ImExConfig) (page 

1424)). 

Property type: 

Global property. 

Permitted/default values 
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Select All records in the database are exported. 

"<Statement>" Records are exported in accordance with the statement entered. 

":<Statement name>" Records are exported in accordance with the saved statement specified. 

 

Example:  

 Output of address data (Import/export example) 

 VQLExport with Select keyword (Import/export example) 

 VQLExport with statement (Import/export example) 

 VQLImport (ImExConfig) 

Related topics:  

Usage (ImExConfig) (page 1424) 
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VQLImport (ImExConfig) 

Information on the global properties of the import/export configuration (see "Create configuration 

for import/export" page 1396) is available in the Global properties (ImExConfig) (page 1407) Help 

topic. 

After VQLImport, write the VQL statement with which records from a VTab are saved in a 

database. As an alternative to the VQL statement, you can use the Insert, Delete, or Update 

keywords. 

The maximum number of records in a VTab is specified in MaxVtLines. 

You must specify VQLImport if Usage is set to Import or Both. 

Property type: 

Global property. 

Permitted/default values 

Insert The records read from the data file are inserted in the database table. 

Delete Records that exist in the data file and the database are deleted from the database. 

Assignment is based on the field names entered in SearchByFields. 

Update <Field names> The fields listed after Update will be updated. All other fields remain unchanged. Each 

record in the data file must have a matching record in the database. Assignment is 

based on the field names entered in SearchByFields. 

An OpChar is not required and may not be read from the data file. If required, skip it 

using DummyField. 

Which fields are read from the data file is generally not dependent on the specified file 

name. If a field is not read during an update, it is overwritten with zero values. If a field 

is not specified during an update, it is not changed when read from the data file. This 

applies to the SearchByFields that have to be read but remain unchanged. 

Instead of <Field names> enter one or more field names separated by commas. 

"<Statement>" Records are imported in accordance with the statement entered. 

":<Statement name>" Records are imported in accordance with the saved statement specified. 

 

Example:  

 VQLImport with keyword insert (Import/export example) 

 VQLImport with insert statement (Import/export example) 
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 VQLImport with save statement (Import/export example) 

 VQLImport with keyword update (Import/export example) 

 VQLImport with keyword delete (Import/export example) 

 

Related topics:  

MaxVtLines (ImExConfig) (page 1416) 

SearchByFields (ImExConfig) (page 1422) 

VQLExport (ImExConfig) (page 1425) 
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Field-related properties (ImExConfig) 

See Create configuration for import/export (page 1396) to learn how to create configurations for 

the Import/export (page 1395) function. 

For an overview of keywords for import/export configurations see Keywords for import/export 

configurations (page 1398). 

When evaluating a configuration, the system does not check if a property specified for a field is 

suitable for the current field type. If a property does not fit, it is ignored without a message during 

data import/data export. 

The value of a property specified for a field takes priority over a global default value for that same 

property. 

Example:  

The global default is: NumDecimals 1; 

However, two decimal places occur in the DbPart.BewPreis field. This is because the specification 

for the field reads: 

DbPart.BewPreis  NumDecimals 2; 
 

Alignment (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

Alignment indicates the orientation for data entry in the field. You can enter data up to the length 

specified in ExtLen. 

Property type: 

Field-related property. 

This property can be set for all field types. 

Permitted/default values 
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Left Left alignment. 

Right Right alignment. 

The default values are those of the StringAlignment and NumberAlignment global properties. 

Example:  

... 

StringAlignment Left 

FIELDS 

  MNr Alignment Right; // overwrite global definition 

... 

Related topics:  

ExtLen (ImExConfig) (page 1432) 

NumberAlignment (ImExConfig) (page 1417) 

StringAlignment (ImExConfig) (page 1423) 
 

Field-related DateFormat (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

See also DateFormat (ImExConfig) (page 1409). 

This property can be set globally or field-related. The field value takes priority over the global 

value. 

Property type: 

Field-related property. 

This property can be set for all date fields (ImExConfig). 

Example:  

... 

DateFormat infor4DigitYear; 

FIELDS 

... 
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  Datum DateFormat infor2DigitYear; // overwrite global definition 

... 
 

Field-related DecimalPoint (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

See also DecimalPoint (ImExConfig) (page 1410) 

This property can be set globally or field-related. The field value takes priority over the global 

value. 

Property type: 

Field-related property. 

This property can be set for numeric fields. 

Example:  

... 

DecimalPoint None 

FIELDS 

  Preis DecimalPoint Comma; // overwrite global definition 

... 
 

DoNotStrip (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

Do not remove spaces when DoNotStrip is set. 

Property type: 

Field-related property. 

This property can be set for alphanumeric fields. 
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Permitted/default values 

This property is used without a value. 

Example:  

... 

FIELDS 

  MNr DoNotStrip; // do not remove spaces 

... 

Related topics:  

Strip (ImExConfig) (page 1439) 

StripLeft (ImExConfig) (page 1440) 

StripRight (ImExConfig) (page 1441) 
 

ExtLen (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

ExtLen specifies the length of the useful field content. This property should always be present for 

the fixed record format. If the field content is longer than the useful length specified, it is truncated 

on the right. A field is padded according to the Alignment and FillChar properties. 

Property type: 

Field-related property. 

This property can be set for all field types. 

Example:  

... 

RecordFormat Fix; 

... 

FIELDS 

  MNr ExtLen 20; // useful content 20 characters 

... 
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Related topics:  

Alignment (ImExConfig) (page 1429) 

FillChar (ImExConfig) (page 1434) 

RecordFormat (ImExConfig) (page 1420) 
 

Field-related ExportNewLineAs (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

See also ExportNewLineAs (ImExConfig) (page 1413) 

This property can be set globally or field-related. The field value takes priority over the global 

value. 

Property type: 

Field-related property. 

This property can be set for alphanumeric fields. 

Example:  

... 

ExportNewLineAs Blank 

FIELDS 

  Betreff ExportNewLineAs "@"; // overwrite global definition 

... 
 

Field-related FieldSeparator (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

See also FieldSeparator (ImExConfig) (see "FileCreateMode (ImExConfig)" page 1414) 
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This property can be set globally or field-related. The field value takes priority over the global 

value. 

Property type: 

Field-related property. 

This property can be set for all field types. 

Example:  

... 

FieldSeparator Semikolon; 

FIELDS 

  MNr FieldSeparator Komma; // overwrite global definition 

... 
 

FillChar (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

FillChar defines the character used for padding when the field content is shorter than the length 

specified in ExtLen. 

Property type: 

Field-related property. 

This property can be set for all field types. 

Permitted/default values 

The default values are those of the StringFillChar and NumberFillChar global properties. 

Example:  

... 

StringFillChar Blank; 

FIELDS 

  MNr FillChar Period; // overwrite global definition 

... 
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Related topics:  

ExtLen (ImExConfig) (page 1432) 

NumberFillChar (ImExConfig) (page 1418) 

StringFillChar (ImExConfig (see "StringFillChar (ImExConfig)" page 1423)) 
 

Field-related ImportAsNewLine (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

See also ImportAsNewLine (ImExConfig) (page 1415) 

This property can be set globally or field-related. The field value takes priority over the global 

value. 

Property type: 

Field-related property. 

This property can be set for alphanumeric fields. 

Example:  

... 

ImportAsNewLine "@" 

FIELDS 

  Betreff ImportAsNewLine Blank; // overwrite global definition 

... 
 

LeftFieldSeparator (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

LeftFieldSeparator indicates how to start an individual field in addition to a general FieldSeparator. 

Property type: 



1436 | Infor COM 7.5 User Guide 

 

System functions 

 

Field-related property. 

This property can be set for all field types. 

 

Example:  

... 

FIELDS 

  MNr LeftFieldSeparator "\""; // additional character on the left 

... 

Related topics:  

FieldSeparator (ImExConfig) (page 1414) 

RightFieldSeparator (ImExConfig) (page 1439) 
 

Field-related NumDecimals (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

See also NumDecimals (ImExConfig) (page 1418) 

This property can be set globally or field-related. The field value takes priority over the global 

value. 

Property type: 

Field-related property. 

This property can be set for numeric fields. 

Example:  

... 

NumDecimals 2 

FIELDS 

   Preis NumDecimals 3; // overwrite global definition 

... 
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Pre5Datemask (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

The Pre5Datemask property only influences export operations. If it is set, the date fields are output 

in MM/DD/YY/hh:mm:ss (GTERM) format. 

The default date format in the Import/export module consists of 12 sequential IDs. These 

represent MMDDYYhhmmss, or: 051998142336. The Pre5Datemask property converts the 

default date format into MM/DD/YY/hh:mm:ss, or: 05/19/05/14:23:36. 

Property type: 

Field-related property. 

This property can be set for numeric fields. 

Permitted/default values 

This property is used without a value. 

Example:  

DateFormat infor2DigitYear 

FIELDS 

  Datum Pre5Datemask; // Output date in DD.MM.YY/hh:mm:ss format 

or 

DateFormat infor4DigitYear 

FIELDS 

  Datum DateFormat infor2DigitYear, Pre5Datemask; // DD.MM.YY/hh:mm:ss 

Related topics:  

DateFormat (ImExConfig) (page 1409) 
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RegExLeftFieldSeparator (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

RegExLeftFieldSeparator is only taken into account when importing. This property defines the 

regular expression (according to Unix standard) to be expected as left field separator. 

Property type: 

Field-related property. 

This property can be set for all field types. 

Example:  

"....." means any 5 characters. 

"[^:]*:" means all characters to and including the first colon. 

Related topics:  

RegExRightFieldSeparator (ImExConfig) (page 1438) 
 

RegExRightFieldSeparator (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

RegExRightFieldSeparator is only taken into account when importing. This property defines the 

regular expression (according to Unix standard) to be expected as right field separator. 

Property type: 

Field-related property. 

This property can be set for all field types. 

Example:  

"....." means any 5 characters. 

"[^:]*:" means all characters to and including the first colon. 
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Related topics:  

RegExLeftFieldSeparator (ImExConfig) (page 1438) 
 

RightFieldSeparator (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

RightFieldSeparator indicates how to end an individual field in addition to a general 

FieldSeparator. 

Property type: 

Field-related property. 

This property can be set for all field types. 

Example:  

... 

FIELDS 

  MNr RightFieldSeparator "\""; // additional character on the right 

... 

Related topics:  

FieldSeparator (ImExConfig) (page 1414) 

LeftFieldSeparator (ImExConfig) (page 1435) 
 

Strip (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

If Strip is set, spaces to the left and right of the string fields will be removed. 

Property type: 



1440 | Infor COM 7.5 User Guide 

 

System functions 

 

Field-related property. 

This property can be set for alphanumeric fields. 

Permitted/default values 

This property is used without a value. 

Example:  

... 

FIELDS 

  MNr Strip; // Remove spaces to the left and right 

... 

Related topics:  

DoNotStrip (ImExConfig) (page 1431) 

StripLeft (ImExConfig) (page 1440) 

StripRight (ImExConfig) (page 1441) 
 

StripLeft (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

If StripLeft is set, spaces to the left of the string fields will be removed. This is the default when 

ExtLen is specified. 

Property type: 

Field-related property. 

This property can be set for alphanumeric fields. 

Permitted/default values 

This property is used without a value. 

Example:  

... 

FIELDS 
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  MNr StripLeft; // Remove the space(s) on the left 

... 

Related topics:  

ExtLen (ImExConfig) (page 1432) 

StripRight (ImExConfig) (page 1441) 
 

StripRight (ImExConfig) 

For information on Field-related properties (see "Field-related properties (ImExConfig)" page 

1429) of the Import/export configuration (see "Create configuration for import/export" page 1396), 

see these Help topics. 

If StripRight is set, the spaces to the right of the string fields will be removed. 

Property type: 

Field-related property. 

This property can be set for alphanumeric fields. 

Permitted/default values 

This property is used without a value. 

Example:  

... 

FIELDS 

  MNr StripRight; // Remove the space(s) on the right 

... 

Related topics:  

StripLeft (ImExConfig) (page 1440) 
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Special fields (ImExConfig) 

See Create configuration for import/export (page 1396) to learn how to create configurations for 

the Import/export (page 1395) function. 

The second part of a configuration file follows after the FIELDS keyword and lists fields that that are 

in the data file during import or are written to the data file during export. In addition to these field 

names, the list permits special fields to allow for special content in the data file. 
 

DummyField (ImExConfig) 

For general information on using special fields (see "Special fields (ImExConfig)" page 1442) in 

the import/export configuration (see "Create configuration for import/export" page 1396) see the 

respective topics. 

A field named DummyField can occur multiple times. The ExtLen property must be defined for 

fixed record format. For variable record format, if ExtLen is not defined, all characters up to the 

next field separator are considered part of the current field. 

The content of DummyFields is imported but not interpreted. During import, a DummyField in the 

data file is skipped without comparison with the specified string of characters. If required (fixed 

format, no FieldSeparator) the length of the string of characters is used as ExtLen. DummyFields 

are filled with spaces during export. 

Instead of a value in ExtLen, you can specify a fixed value to be written to the data file using 

DummyField Fix. 

Example: DummyField Fix "VppsNt"; 

Related topics:  

ExtLen (ImExConfig) (page 1432) 

RecordFormat (ImExConfig) (page 1420) 
 



Infor COM 7.5 User Guide | 1443 

 

System functions 

 

OpChar (ImExConfig) 

For general information on using special fields (see "Special fields (ImExConfig)" page 1442) in 

the import/export configuration (see "Create configuration for import/export" page 1396) see the 

respective topics. 

A field named OpChar identifies the line where you want to specify the required VTab ID (Insert, 

Update, Delete) during import or the record flag in the VTab during export. The characters are U, I, 

or D. During import with a Save statement, these characters define if a record is inserted, updated, 

or deleted. During export, these characters can be used by the VTab flag. Specify the ByVTab 

property in this case. If you wish a fixed assignment, enter Fix and I, U, or D. 

Example:  

VQLImport with save statement (Import/export example) 
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Field types (ImExConfig) 

See Create configuration for import/export (page 1396) to learn how to create configurations for 

the Import/export (page 1395) function. 

The following Help topics describe the formatting properties of various field types. 
 

Alphanumeric fields (ImExConfig) 

For general information about field types in conjunction with the import/export configuration, see 

Field types (ImExConfig) (page 1444). 

The following properties are specifically intended for formatting alphanumeric fields: 

 Strip (ImExConfig) 

 StripLeft (ImExConfig) 

 StripRight (ImExConfig) 

 DoNotStrip (ImExConfig) 

 ExportNewLineAs (ImExConfig) 

 ImportAsNewLine (ImExConfig) 
 

Date fields (ImExConfig) 

For general information about field types in conjunction with the import/export configuration, see 

Field types (ImExConfig) (page 1444). 

The date field format is defined using the DateFormat property. You can set this property globally 

or for a specific date field. The field value takes priority over the global value. If no property is set, 

the system uses the infor2DigitYear default value. 

You can set the following values for the DateFormat property. 

Infor2DigitYear 

The standard date format used for export is MMDDYYhhmmss. If the Pre5Datemask property is 

set for a specific date field, the date format is MM/DD/YY/hh:mm:ss. 
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During import you can use date formats with separators. You can use any character as a 

separator; only numbers are not permitted. If separators are used, you can use one-digit day and 

month entries. The year must have two digits. 

Hours, minutes, and seconds can be specified optionally. 

1.2.05 
1.2.05 00 
1.2.05 00:00 
1.2.05 00:00:00 

01.02.05 
01.02.05 00 
01.02.05 00:00 
01.02.05 00:00:00 

During import, you can also use date formats without a separator. When there are no separators, 

all parts including the year must be two-digit. If required, pad with a zero. 

Hours, minutes, and seconds can be specified optionally. 

010205 
01020500 
0102050000 
010205000000 

The following date formats may not be used for data import: 

06.01.2005 

Error: Four-digit year. 

Date is interpreted incorrectly. 

06012005 

Error: Four-digit year. 

Date is interpreted incorrectly. 

6105 

Error: One-digit day and month without separator. 

Date is interpreted incorrectly. 

Infor4DigitYear 

The MM/DD/YYYY hh:mm:ss format is used during export. 

During import, the individual date components must have a separator. You can use '.' (period), ':' 

(colon), '/' (slash), and '-' (hyphen) as separators. A space is permitted between the components of 

the year and the time of day. Day, month, hour, minutes, and seconds can be one-digit. The year 

must always be four-digit. 
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infor4DigitYearNoSeconds 

The MM/DD/YYYY hh:mm format is used during export. 

During import, the same rules apply as for Infor4DigitYear (see above). But the date must not 

contain seconds. 

 

Infor4DigitYearNoTime 

The MM/DD/YYYY format is used during export. 

During import, the same rules apply as for Infor4DigitYear (see above). But the date must not 

contain the time of day. 

 

Free date format 

Note: The free date format can only be used for export. 

The free date format can be a combination of the forms listed below. Other characters are 

permitted. These are output 1 to 1. 
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Form Meaning Example 

d The day is represented as a number without a leading zero. 5 

15 

DD The day is represented as a two-digit number with a leading zero. 05 

15 

DDD The weekday is represented as an abbreviation of (max.) 3 letters. Mon 

Wed 

DDDD The weekday is spelled out completely. Monday 

Wednesday 

MA The month is represented as a number without a leading zero. 5 

FE The month is represented as a two-digit number with a leading zero. 05 

MMM The name of the month is represented as an abbreviation of (max.) 3 

letters. 

Mar 

Oct 

MMMM The name of the month is spelled out completely. March 

October 

y The year is represented as a (max.) two-digit number without a leading 

zero. 

5 

YY The year is represented as a two-digit number with a leading zero. 05 

YYYY The year is represented as a four-digit number. 2005 

Example: 

Form Output 

M/D/Y 2.7.5 

MM/DD/YY 02.07.05 

DDD, MMM DD YYYY Fri, Jul 02 2005 

DDDD, MMMM DD YYYY 02.07.05 

 
 

Numeric fields (ImExConfig) 

For general information about field types in conjunction with the import/export configuration, see 

Field types (ImExConfig) (page 1444). 

The following properties are specifically intended for formatting numeric fields: 
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 DecimalPoint (ImExConfig) 

 NumDecimals (ImExConfig) 
 

Examples (Import/export) 

See Create configuration for import/export (page 1396) to learn how to create configurations for 

the Import/export (page 1395) function. 

The following Help topics give examples of import/export cases. 
 

VQLExport with Select keyword (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

You can use the Select keyword if all records in the database can be unloaded without additional 

conditions. 

Representation in the configuration file 

View relAc; 

Usage Export; // or Usage Both 

VQLExport       Select; 

FIELDS 

DbPart.MNr; 

Using the Select keyword is the equivalent of the VQL statement below (see VQLExport with 

statement (shown for Import/export) (see "VQLExport with statement (Import/export example)" 

page 1449)). 

Representation in the configuration file 
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View relAc; 

Usage Export; // or Usage Both 

VQLExport "Select * From relAc"; 

FIELDS 

DbPart.MNr; 

 
 

VQLExport with statement (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

You must enter a VQL statement if you want to unload specific records only. The respective 

condition is stated in the Where clause. 

In addition, you must enter a VQL statement if you want to unload the records sorted. The sort 

order is specified in the OrderBy clause. 

Representation in the configuration file 

View relAc; 

Usage Export; // or Usage Both 

VQLExport "Select * From relAc where DbPart.MNr Like 'A%' Order 

By DbPart.MNr"; 

FIELDS 

Db.Part.MNr; 

A VQL statement is also required when you do not export from a database table but from a view. 

The statement must assign the view to the table. 

Representation in the configuration file 
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View viwAcVt; 

Usage Export; // or Usage Both 

VQLExport "Select AcSatz=relAc Into viwAcVt From relAc where 

DbPart.MNr Like 'A%' Order By DbPart.MNr"; 

FIELDS 

AcSatz.DbPart.MNr; 

 
 

VQLImport with keyword insert (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

You want to insert all records from the import file into the database table. 

Representation in the configuration file 

View relAc; 

Usage Import; // or Usage Both 

VQLImport       Insert; 

FIELDS 

DbPart.MNr; 

The use of the Insert keyword is equivalent to the VQL statement below (see VQLExport with 

Insert statement (Import/export example) (see "VQLImport with insert statement (Import/export 

example)" page 1451)). 

Representation in the configuration file 

View relAc; 

Usage Import; // or Usage Both 

VQLImport "Insert * From relAc"; 

FIELDS 

DbPart.MNr; 
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VQLImport with insert statement (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

You must enter an Insert statement if you want to insert specific records only. The respective 

condition is stated in the Where clause. 

Representation in the configuration file 

View relAc; 

Usage Import; // or Usage Both 

VQLImport "Insert * From relAc where DbPart.MNr Like 

'A%'"; 

FIELDS 

DbPart.MNr; 

An Insert statement is also required when you do not import to a database table but to a view. 

The statement must assign the view to the table. 

Representation in the configuration file 

View viwAcVt; 

Usage Import; // or Usage Both 

VQLImport "Insert relAc=AcSatz Into relAc From viwAcVt where 

AcSatz.DbPart.MNr Like 'A%'"; 

FIELDS 

AcSatz.DbPart.MNr; 

You must also write an Insert statement when you want to delete records prior to importing in the 

target table or target view. 

Representation in the configuration file (import to table) 



1452 | Infor COM 7.5 User Guide 

 

System functions 

 

View relAc; 

Usage Import; // or Usage Both 

VQLImport       Insert; 

DeleteBeforeInsert; 

SearchByFields DbPart.MNr; 

FIELDS 

DbPart.MNr; 

 
 

VQLImport with save statement (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

You must write a Save statement if the OpChar field that defines the operation for the current row is 

evaluated during import. These are the characters U, I, and D. When importing with a Save 

statement, these characters define if a record is inserted, updated, or deleted (see OpChar 

(ImExConfig) (page 1443)). 

Representation in the configuration file (import to view): 

View relAc; 

Usage Import; // or Usage Both 

VQLImport "Save * from relAc"; 

FIELDS 

OpChar; 

DbPart.MNr; 

 
 

VQLImport with keyword update (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 
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You must write an Update statement if you want to update fields during import. The fields to be 

updated are listed after Update. All other fields remain unchanged. Each record in the data file 

must have a matching record in the database. Assignment is based on the field names entered in 

SearchByFields. 

Representation in the configuration file (import to view) 

View relAc; 

Usage Import; // or Usage Both 

VQLImport Update DbPart.Ktxt; 

SearchByFields DbPart.MNr; 

FIELDS 

DbPart.MNr; 

DbPart.Ktxt; 

 
 

VQLImport with keyword delete (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

You must write a Delete statement when you want to delete all records that exist in the data file 

and the database from the database during import. Assignment is based on the field names 

entered in SearchByFields. 

Representation in the configuration file (import to view) 

View relAc; 

Usage Import; // or Usage Both 

VQLImport Delete; 

SearchByFields DbPart.MNr; 

FIELDS 

DbPart.MNr; 
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Import/export texts with individual text files (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

The example below shows a configuration file for importing or exporting texts. The texts are stored 

in individual files. 
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/* 

  Importing/exporting texts 

  - Texts in individual files 

  - Data file with all fields used 

*/ 

VIEW            relText; 

Usage           Both; 

OnError         Skip; 

MaxVtLines      500; 

VQLExport       Select; 

VQLImport       Insert; 

SearchByFields  TextIdent.TextNr, 

                TextIdent.Sprache; 

DeleteBeforeInsert; 

FileCreateMode  DoNotOverwrite; 

RecordFormat    Variable; 

RecordSeparator CrLf; 

FieldSeparator  Semicolon; 

ExportNewLineAs Blank;   // reference, search term not multi-row 

BlobFilepath    "sysbox\\imex\\imptexte\\rtf";   // texts are located in the RTF 

subdirectory 

BlobFilename    SearchByFields;    // Texts in individual files 

FIELDS 

TextIdent.TextNr;           // alphanumeric string of characters, up to 9 characters 

TextIdent.Sprache;      // typically "us" 

                        // usage values: 0 = no, 1 = yes 

TextIdent.Verwendung(1);    //   Manufacturing control 

TextIdent.Verwendung(2);    //   Master data 

TextIdent.Verwendung(3);    //   Purchasing 

TextIdent.Verwendung(4);    //   Sales 

                            // ...(5) to ...(16) as yet unused 
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Text;         // Blob information, e.g. file name or offset:length 

Reference,      // up to 63 characters 

Search term,  // up to 79 characters 

TextTyp;      // 0 = standard, 1 = resource-spec., 2 = individual 

              // file, format not used. 

 

 

 
 

Import/export texts with one shared text file (Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

The example below shows a configuration file for importing or exporting texts. The texts are stored 

in a single file. 
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/* 

  Importing/exporting texts 

  - Texts in a joint file 

  - Data file with all fields used 

*/ 

VIEW            relText; 

Usage           Both; 

OnError         Skip; 

MaxVtLines      500; 

VQLExport       Select; 

VQLImport       Insert; 

SearchByFields  TextIdent.TextNr, 

                TextIdent.Sprache; 

DeleteBeforeInsert; 

FileCreateMode  DoNotOverwrite; 

RecordFormat    Variable; 

RecordSeparator CrLf; 

FieldSeparator  Semicolon; 

ExportNewlineAs Blank;   // reference, search term not multi-row 

BlobFilepath    "sysbox\\imex\\imptexte\\rtf";   // texts are located in the RTF 

subdirectory 

BlobFilename    Fix "reltext.rtf"; // joint file 

FIELDS 

TextIdent.TextNr;           // alphanumeric string of characters, up to 9 characters 

TextIdent.Sprache;      // typically "us" 

                            // usage values: 0 = no, 1 = yes 

TextIdent.Verwendung(1);    //   Manufacturing control 

TextIdent.Verwendung(2);    //   Master data 

TextIdent.Verwendung(3);    //   Purchasing 

TextIdent.Verwendung(4);    //   Sales 

                            // ...(5) to ...(16) as yet unused 
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Text;         // Blob information, e.g. file name or offset:length 

Reference,      // up to 63 characters 

Search term,  // up to 79 characters 

TextTyp;      // 0 = standard, 1 = resource-spec., 2 = individual 

              // file, format not used. 

 

 
 

Enclose output fields in inverted commas and separate with semicolon 

(Import/export example) 

See Examples (Import/Export) (page 1448) for general notes on these examples. 

The following example shows a configuration file for an export. 

 

 

VIEW            relAcp; 

Usage           Export; 

VQLExport       Select; 

Filename        "relAcp.io"; 

RecordFormat    Variable; 

RecordSeparator CrLf; 

FieldSeparator  "\";\""; // mask inverted commas with '\' 

FIELDS 

  RAint LeftFieldSeparator "\""; // inverted comma at the beginning 

  MNr; 

  RVerwend(1); 

  RVerwend(2); 

  RVerwend(3) RightFieldSeparator "\""; // inverted comma at the end 
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All output fields are enclosed within inverted commas and separated by a semicolon. To output an 

inverted comma at the beginning and at the end of a row, use the LeftFieldSeparator and 

RightFieldSeparator properties for the first field and the last field. 

Excerpt from the export file: 

"160";"965-1100";"0";"1";"0" 

"160";"965-1295";"1";"0";"0" 

"160";"965-1200";"0";"1";"0" 

"160";"965-1295";"0";"1";"0" 
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Model solutions for reports are offered in the dialog box that is displayed when you select System 

functions, Print sample reports, Report overview. 

For more information, see the Sample lists index entries in the IDM_us.chm Help. 
 

Print sample reports 
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See Document management (Project). 

 

Document management 
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Objects 

This folder is located in System functions in the Administration folder. To configure field mappings 

open the Business objects folder. Field mapping is a function that lets you define for Connect for 

example how and which values are transferred from one record to another for Connect links. 

Example: A sales order is generated from a customer's PO. All parts (such as the quantity) are 

transferred directly. Others (such as the customer ID) are transferred to other fields, while others 

are populated regardless of the PO. 

Field mapping comprises three steps: 

1. Configuring the objects (page 1469) 

2. Configuring the rule sets (page 1463) 

3. Configuring the specifications (page 1467) 
 

Field mapping 

Connect or the business interaction feature in Connect uses standard object functionality. This 

business interaction feature uses the Field mapping function included in the standard object 

functionality to transfer specific fields from one document type (such as a purchase order) to 

another. 

Field mapping is implemented using rule sets (page 1463) and specifications (page 1467). 

The configurations that you define here can be used via the following call: 

Administration 
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Function Infor.Framework.Configuration.Fieldmapping.Access::IAccess.UpdateRecord( 

ByVal pwObjectIDSrc   As tWord,  

ByVal phRecObjectSrc   As tHandle,  

ByVal pwObjectIDDst   As tWord,  

ByVal phRecObjectDst   As tHandle,  

ByVal phSpecificationParameter As tHandle) As tBoolean 

 

The parameters here correspond to the following: 

pwObjectIDSrc Source object ID 

phRecObjectSrc Source object handle 

pwObjectIDDst Target object ID 

phRecObjectDst Target object handle 

phSpecificationParameter Handle of the parameter object for selecting the specification 

 

The interpreter logs the completed processes ini Trace. 

To write only the messages from the interpreter, you must activate Trace using these settings: 

 Lj3: yes 

 Lj4: no 
 

Rule sets 

Call 

System functions > Administration > Objects > Field mapping > Rule sets 

Description 

Rule sets define the actual field mapping (page 1462). They always refer to specific views or 

elements of views that need to be explicitly different (the source view is not the same as the target 

view). 

Entire structures or individual fields of a view can be transferred. 
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Please note: You can customize rule sets to your specific requirements. However, fields that 

are important for the functioning of the system should not be overwritten. 

Example of how to change a rule set: 

You want to transfer the contents of the Remarks field in the PO header to the 

Details/Information/AddInf field of the order header. 

1. Using the Rule sets desktop object, open rule set 160009. 

2. In the Source view section, open the DbSatz.DbPart.Bemerkung database field and in the 

Target view the DbSatz.DbPart.EPos field and click Accept. The field is transferred to the 

Assignments section. 

3. Using the Rule sets desktop object, open rule set 160001. 

4. Repeat step 2. 

Structures 

Note: When you transfer entire structures, you only have a few options for influencing the data, 

for example by changing the values you want to transfer using formulas. You cannot use 

conditions or special types such as Empty target. 

Structures can only be transferred in full and directly. As a result, the target structure must have 

the same fields in the same sequence as the source. The target and source structures must also 

begin with the same field. The target can be longer than the source, however. 

Fields 

You can deactivate individual field mappings by clearing the Active flag in the Rule sets view. 

This allows you to define a configuration that is not used as standard but can be activated easily if 

required, for example. 

The following apply for ID assignment  when you create rule sets: 

 IDs are assigned in ascending order beginning with 1. 

 Add-ons assign IDs in ascending order starting from <Add-on ID> * 104. For a list of IDs, see 

the COMPONENTS allocation table or contact Infor Configuration management. 

 For customizations, we recommend assigning IDs in ascending order beginning with 108. 
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Create rule texts in English. 

  

The table below provides an overview of the conditions that apply when you define rule sets: 

Condition type Valid Condition Result 

 Structure Field 
 

 

None x x Not evaluated True 

Lj4 x x Name of the Lj4 method to run 

The method must correspond to the 

following prototype: 

Function <Name>( 

   ByVal phRecSrc As tHandle,  

   ByVal phRecDst As tHandle 

) As tBoolean 

Result of the Lj4 method 

Condition  x An example of a condition 

DbSatz.DbPart.Saint = 10 

(The condition is checked against the 

source data set) 

 

Result of the condition 

Empty target  x Not evaluated True, if the target field is empty 

Empty source  x Not evaluated True, if the source field is empty 

Empty source and 

target 

 x Not evaluated True, if the source and target 

fields are empty 

Calculations are permitted only for view fields, not for structures. If the condition is evaluated as 

True, the following apply for calculations: 
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Calculation type Formula Effect 

--- Not evaluated The field contents are transferred unconditionally 

Lj4 
The name of the Lj4 method to be 

run 

The method must correspond 

with the following prototype:  

Function <Name>( 
   ByVal phRecSrc As tHandle, 
   ByVal phRecDst As tHandle 
) As <target field type> 

The result of the Lj4 method is transferred to the 

target field 

Formula The formula that is to be calculated. 

The formula is run on the source 

field. 

The result of the formula is transferred to the 

target field 

Example: A sales order is generated from a purchase order. 

The following should be transferred for the header (DbSatz.DbPart Saint = 210): 

 DbSatz.DbPart.MNr -> DbSatz.DbPart.UTNr 

 In the target: DbSatz.DbPart.Saint = 10 

 

 The following should be transferred for lines (DbSatz.DbPart.Saint = 10): 

 DbSatz.DbPart.MNr -> DbSatz.DbPart.MNr 

 In the target: DbSatz.DbPart.Saint = 90 

  

 

A rule set of this type would look as follows: 
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Source field Target field Condition type Condition Calculation type Calculation 

...MNr ...UTNr Condition ...SAint =210 ---  

...SAint ...SAint Condition ...SAint =210 Constant 10 

...MNr ...MNr Condition ...SAint =10 ---  

...SAint ...SAint Condition ...SAint =10 Constant 90 

 
 

Specifications 

Call 

System functions > Administration > Objects > Field mapping > Specifications 

Description 

Specifications let you assign a specific rule set to a data transfer between specific objects. 

Please note: Although it is possible to change specifications, it is not recommended as it can 

cause link errors. 

The reason is because rule sets can become very confusing if they are defined for each 

source-target pair. You also run the risk of creating the same configuration more than once since 

for example when you go from the sales order to the order confirmation, almost the same thing 

happens as when you go from the sales order to the advance shipping notice. 

Specifications let you distinguish rule sets according to specific characteristics. 

Note: You can use conditions or Lj4 methods to use different rule sets as needed. You can clear 

the Active flag to deactivate a specification. 
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Condition type Field Rule set 

None Not evaluated Number of the rule set to use 

Condition A condition such as 

DbSatz.DbPart.SAint = 10 

Number of the rule set to use when the 

condition returns True 

Lj4 Name of the Lj4 method to run that 

returns the ID of the rule set to use 

Not evaluated 

 

The example in Rule sets (page 1463) would create two sets of specifications: 

Source Target Condition type Condition Rule set 

<Purchase order> <Sales order> Condition ...SAint = 210 1 

<Purchase order> <Sales order> Condition ...SAint = 90 2 

 

The following tables show the associated rule sets. 

ID Source field Target 

field 

Condition type Condition Calculation type Calculation 

1 ...MNr ...UTNr None   ---   

1 ...SAint ...SAint None   Constant 10 

 

ID Source field Target 

field 

Condition type Condition Calculation type Calculation 

2 ...MNr ...MNr None   ---   

2 ...SAint ...SAint None   Constant 90 

 

 

The following example shows how to configure the Source purchasing/purchase order object - 

Target sales/sales order object specification that is used by the Connect business interaction 

feature when a sales order is created from a purchase order.  

 

To view the configuration, complete the following steps: 
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1. In the System functions module, select Administration, Objects, and Field mapping, then select 

the Specifications object. 

2. Select the Purchasing – Purchase order source object and the Sales – Sales order target 

object and select Load. 

3. To display the details for the assignment, select View and Details. 

 

This configuration has the following effect: Once Connect has created a new sales order using the 

default interface for creating a new sales order, this sales order is populated with the data from the 

purchase order based on the above specification. A rule set is then determined from this 

specification, and this rule set in turn defines the field mapping. 

In this example, the rule set is determined using the return value of the Lj4 function 

Infor.Connect.Sales.Order.SalesOrder::GetFieldMappingRuleID . Depending on the record type 

and whether the record is to be inserted or modified, the function returns another rule set. The new 

header record inserted for a sales order is rule set 160009.  

You can view the fields you want to transfer using the Rule sets desktop object. 
 

Objects 

Call 

System functions > Administration > Objects > Object declarations 

Description 

Objects for field mapping are defined in the OBJECTS allocation table. The elements that make up 

an object and its underlying view can then be defined in the configuration using the Object 

declarations desktop object. 

If you declare new objects in the OBJECTS allocation table, you must also prepare constants to 

enable access within the processes and make them available in an interface. 
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Technical note: For standard objects, you should do so in the interface 

Infor.Framework.Configuration.Objects::IObject. The constants must be in the form cObjectType% 

(for example, cObjectTypeSalesOrder). 

Write the description of elements in English. 
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Data maintenance 

Call 

System functions > Administration > Data maintenance 

Description 

Data maintenance is a tool that is used for analyzing and adjusting data. Statements can be 

loaded and configured. Additional options can also be selected here. 

Data maintenance supports the following functions in particular: 

 Multi-site statements 

 All types of statement 

 Statements with parameters 

 Statements that return results in views or result parameters 

 Statements from the repository 

 

Please note: Use great caution when using this tool. 

To edit a statement, you need to open it first in the Data maintenance object. One or more tabs are 

provided for each statement type (for loading, saving, or running). 

You have two options here: you can define a statement or use the optional input field. 

The required fields are then displayed in a VTab (virtual table) and can be managed and/or edited 

there. When you save the VTab, the changes are written to the database. 

In practice 

Data maintenance provides three tabs: Load, Save, and Execute. 

Load 
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SELECT statements are permitted for loading. When you click the Load button, it is possible that 

only the first part of the results is loaded. If the number of loaded data records corresponds to the 

maximum number specified on the Options tab, the button for displaying more data records is 

activated. 

Save 

Saving is only possible if data has already been loaded. SAVE and INSERT statements are 

available for saving data. 

If you have loaded data using the the SELECT * FROM rel* statement, you can save it without 

using a statement. In all other cases, a SAVE statement is generated. If necessary, you can add 

this SAVE statement in the Optional input field using the Generate statement command from the 

shortcut menu. 

W/o statement 

To use this option, the following conditions must be met: 

 The VTab view must only contain one table section. For example, relAc and viwAc are 

permitted. viwAcVt is not permitted because this view contains relAc, rel Acp, etc. 

 The VLQ header must have loaded fully. 

 In this case, new data records can only be saved when the load statement has loaded all of 

the fields in the table section. 

Test statement 

When you click on Save, the data is saved in a transaction. If the Test statement check box is 

selected, all constraint violations are reported. The transaction is discarded. 

Execute 

To run the statement in a transaction, click Execute. UPDATE and DELETE statements are 

permitted. 
 

Define statement 

For general information on data maintenance, see Data maintenance (page 1471). 

To define a statement, complete following steps: 

1. Select System functions > Administration > Data maintenance. 



Infor COM 7.5 User Guide | 1473 

 

System functions 

 

2. In the following dialog box, select the required database table from the Table/field name 

column on the Statement tab. Click the + plus sign before the table name. 

When you do this, the name of the database table is written to the FROM - from table field on 

the form. In the Table/field name column, the selected table is expanded and all of the fields in 

this table are displayed. 

3. In the Table/field name column, click the required database field to select it and click the 

SELECT button on the right margin of the dialog box. The selected database field is written to 

the SELECT - required fields form field. 

Note: To select more than one field at a time, press CTRL and click the fields. 

4. To insert a WHERE clause, in the Table/field name column, click the required database field to 

select it,  and then click the WHERE button on the right margin of the dialog box. The 

selected database field is written to the Field field in the WHERE - with condition form field. 

5. You must complete the condition in the WHERE clause. To do so, in the database field, enter 

an operation and a value. 

Example: WHERE DbPart.MNr > '965' 

Then click in the Cond. field. The permitted operations are displayed in a list box. 

Value Description 

< Less than 

<> Not equal to 

= Equal to 

> Greater than 

IS NOT 

NULL 

Entered (strings) 

IS NULL Empty (strings) 

LIKE Like 

6. Next enter the required value in the Value field. 

You can combine more than one condition in the WHERE clause using AND or OR. To add 

conditions, in the second Cond[ition] field, enter the required keyword and formulate the 

required condition in the next row. 
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7. To insert an ORDER BY clause, in the Table/field name column, click the required database 

field to select it and then click the ORDER BY button on the right margin of the dialog box. The 

selected database field is written to the ORDER BY- sort by form field. 

8. Click OK to open the VTab with the fields listed in the VQL statement. The table is displayed in 

the Display/change form where it can be edited. 
 

Optional input 

Data maintenance (page 1471) lets you define statements (see "Define statement" page 1472) or 

enter them as described below. 

The Optional input tab on the Data maintenance dialog box allows you to specify the VQL 

statement for opening a table. You can enter the SELECT or ?SELECT command. 

SELECT Use this command to load all columns of a selected data record (even if selecting the SELECT 

command only selects some columns). The reason is that only loaded fields can be saved. Fields 

that are not loaded are lost when you save. 

?SELECT If instead of simply loading data from the database you want to carry out specific functions, you 

must run the VQL statement exactly as it was formulated. To prevent additional fields from being 

implicitly loaded from the database, you must use the ?SELECT command. 

You must use the question mark when using aggregate functions (COUNT, MIN, MAX) for DISTINCT 

or INTO clauses. 

Please note: You cannot use NoSQL fields in the WHERE clause or ORDER BY clause. If you use 

NoSQL fields in these parts of the statement, you will receive an error message. 

You can use NoSQL fields in the SELECT command. 
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Allocation tables 

Call 

System functions > Administration > Allocation tables 

Description 

Allocation tables control the following functions. 

 Allocation tables are often used as list boxes in fields that prompt you to enter general and 

company-specific settings such as customer, supplier, and item groups; inventory locations; 

units of measure, language flags, and more. 

 You can use tables to enter assignments such as currency conversions, units of measure, and 

due date table assignments in price lists and then use them in Infor COM. 

 Allocation tables allow you to make selections in special functions such as for mailbox records, 

language and country flags, planning types, and inventory locations. 

 Allocation tables control the display of certain messages in Infor COM, such as delay flags in 

planning and statuses in orders. 

Note: The selected allocation table (or the allocation tables of the required type) is loaded in the 

language of the editor. If table values in other languages are available, you can view and edit 

them. To do this, in the required table row, go to the Language field and click the plus sign, or in 

the Functions menu, select Expand all. See also Create allocation table in more than one 

language (page 1478). 

Site specifics 

The allocation tables available in Infor COM are provided as templates only. 

An allocation table is always loaded so that the data is displayed from the perspective of the site. 

All site-specific and template data for which there are no overwritten versions are loaded. If the 

content of a data record changes, a site-specific data record is generated when saving. Missing 

data is added and then saved as site-specific data records when you save. 
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Functions 

Note: Note that the available functions in the overview of allocation tables differs from those in the 

single view of a table. 

Check consistency This function checks the consistency of the different language versions of an allocation 

table. It runs the checks that are normally carried out automatically before you save. A 

message notifies you of the results of the check. 

Export/Import See Export allocation tables (page 1476) and Import allocation tables (see 

"Import allocation table" page 1477). 

During the export, a number of files are created; one file containing the template data, and 

one containing the allocation tables from the site's perspective.  

Synchronize 

language versions 

See Synchronize language versions (page 1477). 

 

Export glossary This function allows you to export the glossary of the current allocation table to a file 

where you can edit it. 

Export glossary for 

all tables 

This function allows you to export the glossary of all allocation tables to a file where you 

can edit it. 

Compare sites This function allows you run comparisons between sites and with the standard version, i.e. 

the template files. 

Delete site-specific 

data 

You can use this function to delete site-specific data for the current site. 

 
 

Export allocation tables 

Exporting allocation tables (page 1475) is an easy way to back up data. The files can also be used 

to transfer tables from one system to another (for example, when you want to transfer a change 

from the test system to the live system). 

To export allocation tables, complete the following steps: 

1. Open the allocation table(s). 

2. Select Functions and Export to export the currently loaded allocation table(s). 
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3. In the Save as dialog box, select the export directory and enter a name for the export file. We 

recommend that you use the extension .iMT. 

4. Click Save. 

Note: The site view is saved to a subdirectory as well as to the selected export path. 
 

Import allocation table 

To import an allocation table (see "Allocation tables" page 1475), complete the following steps: 

1. Select System functions, Administration, Allocation tables, and then click the Import tab. 

2. In the File name field, enter the file from which you want to import the allocation table. You can 

also use the Browse button to do this. 

3. Click Import. 

4. Check the configuration of the imported allocation table. 
 

Synchronize language versions 

The Synchronize language versions function allows you to make allocation tables (page 1475) 

created in older program versions (5.3b and older) consistent. 

It checks the following points: 

 Duplicate records (same key and same language) are reduced to one record. The first record 

remains. 

 Missing records are added based on the records from the editor's language. 

 If there is no record in the editor's language, the first available record is used as the basis. 

A message indicates the synchronization result. 

To synchronize language versions: 

1. Open the allocation table. 

2. Select the Functions and then Synchronize language version. 
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Create allocation table in more than one language 

To create an allocation table (see "Allocation tables" page 1475) in multiple languages, complete 

the following steps: 

1. Open the required allocation table. 

2. From View menu, select Table configuration. In the Header configuration table, you can see 

the languages for which records have already been created. 

3. In the next empty row, click the Language field. A combo box is displayed. Open it and select 

the required language. Then click anywhere on the Header configuration section. 

4. Click Yes or OK to acknowledge the following two messages. The required language is now 

inserted in the Header configuration table. The values for the table fields Table name, Form, 

Database table, Sort order, and Type were copied from the first table column. These values 

must be identical for all languages. 

5. In the Description field, enter the description that you want the allocation table to have in the 

newly created language. 

6. From the View menu, go to the table. The values of the allocation table are displayed. All 

entered languages are shown in expanded view. For the newly created language, the values 

from the language of the editor were inserted. Replace the language-dependent data. 

Typically, a different value must be entered for each language in the Description field. 

Note: Table configuration view is used, among other things, to define which fields of an allocation 

table need to contain different values in different languages. 
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Numbering 

Call 

System functions > Administration > Numbering 

Description 

In Infor COM, objects are identified using IDs. This affects all data in the system. These IDs can be 

assigned manually by the user or automatically by Infor COM, depending on the program situation 

(for example, item IDs). We recommend assigning IDs manually or automatically based on the 

specific program situation (for example, order IDs). For examples of how to create a numbering 

method, see Numbering for production orders (see "ID assignment for production orders" page 

1480) and Numbering for sales orders (see "ID assignment for sales orders" page 1482). 

Numbering applies on a cross-site basis but can be changed to be site-specific. If a site-specific 

data record exists for a numbering method, you will be able to see this clearly as the numbering 

will be highlighted in color. The style used here is configured using the 

COMMON.NUMBERMANAGEMENT.STYLESITESPECIFIC parameter. 

Functions 

Compare sites You can use this function to compare the current data record with data from other sites. 

Delete site-specific data This function allows you to delete a site-specific data record. 

Export (Functions > 

Unload to file) 

The export creates several files for each numbering method. One file is created with 

generally valid data, and a second file for each site-specific data record. 

Site-specific data is written to the 

<EntityFlag1>_<EntityFlag2>_<EntityFlag3>\NV subdirectory in the export 

path. 
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ID assignment for production orders 

For general information on numbering, see Numbering (page 1479). 

The following procedure is an example of how to assign IDs to production orders. Production 

orders created in Manufacturing are numbered as follows: 

Note that when creating new methods, the ID you select must not be used by another method. 

 Production orders are assigned the prefix 501. 

 You should insert four digits after 501 for example 5010001. 

 The production order ID range should be from 1 to 9,999. 

 IDs must be incremented by one. 

 Orders created in Sales, Purchasing, Manufacturing, and Planning must have different IDs. 

The method that assigns order IDs in Manufacturing in Infor COM is: 

501 Production order 

According to the above example, four-digit order IDs are always assigned by default to orders 

created in Manufacturing. 

You should also have a method with no default values for each class to ensure that orders without 

a default value are numbered. In other words, method 501 can be used. 

The following overview shows the required entries for the fields used in production orders. To add 

an empty row in the form, select Edit and Add new line. The fields in the table are included on the 

Method, Value range, and Fields tabs. 
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Condition Method for production orders 

ID Assign a new method ID, such as 502. 

Short 

description 

Enter a description for the process where numbering is used. 

Class The new method belongs to the numbering for the production orders class (501). 

Specification Enter an abbreviation. When a production order is created, only this abbreviation is entered on the 

New tab for the order ID. The order ID is assigned when you save the order. 

Form You want to issue a four-digit number. Enter # for each digit. In other words, enter #####. 

Prefix Production order IDs must begin with 501. Enter these three characters in the Prefix field. 

Minimum On the Value range tab, limit the ID range. You want numbering to begin with 1. You must enter 

this value as the Minimum. 

Maximum You want the last value assigned to be 9,999. Enter this value as the Maximum. 

Step You want each new ID to increase by one. Enter 1 as the increment. 

Fields On the Fields tab, enter the other ID fields in Infor COM that you want to check to make sure their 

IDs are unique. Sales, Purchasing, Manufacturing, and Planning IDs are checked. You must enter 

relFb.DbPart.ANr; relGb.DbPart.ANr; relCp.DbPart.ANr; relDb.DbPart.ANr 

Def. flg You can leave the check boxes for default values empty as they are only required if the 

Specification field is empty. 

 

The table for the above example looks like this: 

Method tab 

ID Short description Class Form Prefix 

501 Production order 501 #### 501 

502 Archived production 

order 

502 #### 502 

503 Order ID for archiving 

production orders 

503   

 

Value range tab 
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ID Type Minimum Maximum Step 

501 1 1 9.999 1 

502 1 1 9.999 1 

503 1 1 999 1 

 

ID assignment for sales orders 

For general information on numbering, see Numbering (page 1479). The detailed example of how 

to number production orders (see "ID assignment for production orders" page 1480) describes the 

basic process, which you can also apply to the following example. 

Note that when creating new methods, the ID you select must not be used by another method. 

If you want the sales order ID to indicate the department where the order was created, or the 

employee who created the order, you can set this in the numbering method. 

Example: The procedure for numbering sales orders is as follows: 

 Each department must have its own ID range. 

 Insert the department before the sequential ID and the employee initials after the ID. 

 The ID must have four digits, where the first two digits indicate the year the order was created. 

Example: 

Method tab 

ID Short description Class Form Prefix Suffix 

80

1 

Sales order 801 #### A1/96 xy 

 

Value range tab 

ID Type Minimum Maximum Step 

801 1 1.000 2.999 1 

831 1 3.000 4.999 1 

832 1 5.000 6.999 1 
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Note that when creating new methods, the ID you select must not be used by another method. 
 

Load/unload 

Call 

System functions > Administration > Load/unload 

Description 

This process allows you to load or unload different types of object. 

Each of these object types is imported or exported to or from its own subdirectory: 

Object type Name of the subdirectory 

Allocation table ZT 

Filters Sel 

ID assignment method Nv 

Summarization rule Ev 

Business object definition BODef 

Objects config 

XML schema images  

CONNECT configurations connect 

Status configurations  

Message profiles EDI 

Field configuration finance 

The following applies for all paths: You must end the path with a backslash (\). Do not specify the 

\ZT, \Sel, \Nv, \Ev, and \BODef subdirectories in the Paths for export/import directories field in the 

Load/unload dialog box. 

All status and error messages are logged in the central log file. This file is created in the 

user-specific subdirectory for log files and can be read using the separate Infor COM Log Viewer 

(inforLogViewer.exe). 
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The user-specific subdirectory for log files is specified in the COMMON.DIAGNOSE.ROOTDIR 

parameter in the Infor COM Management Console configuration. 

 



Infor COM 7.5 User Guide | 1485 

 

System functions 

 

Batch control 

Call 

System functions > Administration > Batch control 

Description 

Batch control allows you to set individual Infor COM batch jobs so that they run at a specific time 

and are repeated at predefined intervals. 

This allows you to run these time-intensive processes, which possibly require exclusive database 

access, outside the system's normal operation period. 

Please note: In Infor COM 7.5, Batch control only supports batch jobs that require an Infor COM 

environment. 

Time-controlled batch jobs can be started on any client computer. For practical purposes, we 

recommend one of the following procedures: 

 All time-controlled batch jobs are started on a separate computer. 

 Time-controlled batch jobs are started on an employee's computer once this employee has 

finished their standard working hours. 

To run a time-controlled batch job, it is set to wait mode. Every activated process is then started at 

the specified time. 

Batch control displays an overview of the statuses of all batch jobs. 

A batch job can be interrupted at any time, either while it is in wait mode or from the corresponding 

batch job. 
 

Define and start batch job 

To activate a batch job in Batch control (page 1485) and configure any required processes, 

complete the following steps: 

1. Select System functions > Administration > Batch control. 
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2. On the Action tab for each time-controlled batch job, enter the Job ID and the Action. 

3. On the Time control tab, enter the Time basis. 

4. Optional: On the Action tab, select the Require parameter check box. Then select Functions > 

Edit parameter to edit the parameter. 

5. Optional: On the Time control tab, enter the maximum delay and the maximum duration for 

each batch job. 

6. On the Status tab, set thestatus to Released. 

7. On the Status tab, select the released batch job in the table and click Start. 

8. Select the status tab. 

This tab shows the batch jobs that are active as well as the corresponding status, client, and 

user name. 
 

Filter settings 

To access the filter settings, open the Administration folder in System functions and select Filter 

settings. The filter settings are used to specify settings for the views for which filters can be 

defined. 

For background information on filters, see Filters (page 1382). See also Filter maintenance (see 

"Filter maintenance in System functions" page 1390). 
 

SQL filter group 

When using filters (page 1382), problems can occur if database fields that are not SQL fields are 

used in the filter criteria. To avoid this, you can create a field group for each database table that 

contains all SQL fields of the database table. Fields of this group can be used in filters without any 

issues. 

Open the Administration folder in System functions and select SQL filter group. The following 

message is displayed: Do you want to create an SQL filter group for each database relation? If you 

answer Yes, a field group with the name SQL fields is created for each database view. This field 

group then becomes available in Filter maintenance. 
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Filter administration 

For the general administration of filters, open the Administration in System functions and select 

Filter administration. Use this object to open the form for defining filters. For information on how to 

work with filter administration, see Define filters (see "Define filter" page 1487). 
 

Define filter 

For information on filter administration, click here (see "Filter administration" page 1487). To 

manage filters, complete the following steps: 

1. In System functions, open the Administration folder and select Filter administration. 

2. Click the New button if you want to create a new filter. The ID of the filter is preset 

automatically in the Filter field. 

3. Enter the name of the filter in the Name field. 

4. In the Class field, select the object class that can be used to apply the filter. 

5. Using the Field list box, select a field of this class and click Transfer field to accept it as a new 

column (you can have a maximum of 9 columns). Select Delete column to remove columns 

you do not need. 

6. In the Condition field, select the required comparison from the list box. The field type you have 

selected determines which comparisons you can choose from. 

7. Enter the comparison value in the column with the field name (if needed). 

Note: You can negate an entered condition by clicking the check box in the Not column. 

8. Enter additional conditions as needed. You can enter up to 9 conditions in a row. For more 

information, see the context-sensitive Help. 
 



1488 | Infor COM 7.5 User Guide 

 

System functions 

 

Master data transfer 

When installing Infor COM for the first time, you may have to transfer master data from another 

system. 

To open Master data transfer, open the Administration folder in System functions and select 

Master data transfer. 

The Master data transfer module enables you to transfer data from several files to the relevant 

databases in a single process. ASCII files, which you load using the Import/export (page 1395) 

module, are used for the transfer. 

For information on the differences between the Import/export and Master data transfer functions, 

see Transfer data to Infor COM (page 1490). 
 

Master data transfer basics 

This topic provides an overview of the process of transferring master data (see "Master data 

transfer" page 1488). 

When transferring master data, the settings in the COMMONSTD and the Infor COM Management 

Console configuration need to be taken into account first. 

To transfer master data, complete the following five steps: 

1. Unload (see "Unload data from old system (Master data transfer)" page 1489) data from the 

old system 

2. Rework (see "Postprocess unloaded data (Master data transfer)" page 1489) the unloaded 

data 

3. Create export files (see "Create export files (Master data transfer)" page 1490) and complete 

the mandatory fields 

4. Create configurations and transfer (see "Transfer data to Infor COM" page 1490) data to Infor 

COM 

5. Check consistency (see "Consistency check" page 1505) 
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Unload data from old system (Master data transfer) 

To open Master data transfer, open the Administration folder in System functions and select 

Master data transfer. 

If possible, in the first step, the data from the old system should be unloaded in a format that can 

be read by Access and Excel. Then the data can be postprocessed (see "Postprocess unloaded 

data (Master data transfer)" page 1489) using these programs. 

If the system that has been used so far uses a known database format such as dBase, Foxpro, or 

an ASCII format for saving data, you can continue to directly process this data. Documentation on 

the individual database fields can be helpful, if available. For data in ASCII format (that is, in 

simple text files), semicolons should be used as field separators and CR (carriage return) signs as 

row separators. 

Many programs offer export functions, for example, for printing to a file on the hard drive. In these 

cases, the exported format must be checked, documented, and then converted. 
 

Postprocess unloaded data (Master data transfer) 

To open Master data transfer, open the Administration folder in System functions and select 

Master data transfer. 

One very important aspect that is often overlooked is the second step, the postprocessing of the 

unloaded data. We recommend importing the unloaded files intoExcel. With Excel, you can 

perform Find and Replace processes quickly and relatively easily. The program provides default 

import filters for most of the common file formats. 

If semicolons are used as field separators, they must not be used within fields. They must be 

replaced with other characters, if necessary. 

MS-DOS-based legacy systems often use a different character set than the Windows Infor COM 

program. A different character is therefore used for special characters. This can also be resolved 

using the Find and Replace function. 

Be careful with text fields that contain numbers only. Excel usually formats these cells as numbers. 

This means that important information, such as leading zeros, can be lost. 
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Create export files (Master data transfer) 

To open Master data transfer, open the Administration folder in System functions and select 

Master data transfer. 

The third step is usually carried out in Access. Based on queries, mandatory fields are added to 

the postprocessed master data, which is stored in Excel files and appended to Access tables 

whose structure corresponds to the Infor COM master data relations. 

Example: You create an Access table called exp-ac. It contains the fields you want to transfer to 

the relAc database table in Infor COM. You add mandatory fields such as Int/ext. rec. type and so 

on. An append query populates the exp-ac table in Access with the values from the old system 

and with default values. 

For small volumes of data, you can also carry out this step in Excel. You can compile an export file 

by copying the individual columns of the Excel spreadsheet to the clipboard. To populate the fields 

with default values, use the AutoComplete tab (in the Tools menu, select Options). 
 

Transfer data to Infor COM 

To open Master data transfer, open the Administration folder in System functions and select 

Master data transfer. 

The export tables that have been created in Access or in Excel are saved in text or ASCII format in 

the fourth step (Excel:*.csv). Fields are separated by semicolons. These files are imported into 

Infor COM. 

For each file you want to import, a configuration must be created in the ScriptDataDef domain of 

the Infor COM Dialog Manager. 

Once these preparatory steps have been completed, the data can be imported into Infor COM. 

Please note: You can always import data using the Import/export module. The Master data 

transfer module can only be used when you want to import the files into one of the following 

database tables: relAc, relAcp, relAck, relAcd, relDlb, relFi, relFk, relAb, reFa, relFs, and relText. 
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Transfer company master data 

This process describes one of the master data transfer (page 1488) functions. 

For instructions on transferring data in Infor COM, see Transfer data to Infor COM (page 1490). 

The following topic contains a few points to be noted when transferring company master data to 

Infor COM. 

 You must transfer data using the viwAdrKonvert (see "Company master (viwAdrKonvert)" 

page 1493) view. You cannot import data into the database tables directly. 

 All fields in the ixcMigrationPatternFirmendaten configuration (sample configuration for 

importing company master data) stored in the Infor COM Dialog Manager are shown in the 

viwAdrKonvert view. You can remove or comment out fields you do not need. You must import 

mandatory fields (see below). 

 The communication fields Kng1/Nr1 through Kng10/Nr10, Tel1 through Tel5, and Fax1 

through Fax5 are interpreted as follows: 

The value of the ID (ID1, etc.) indicates the means of communication (phone, fax, e-mail, 

etc.) that is assigned to the subsequent number (ID1, etc.). The values of the IDs must 

correspond to the values in the KOMMART allocation table. 

Value Description 

1 Phone 

2 Fax 

3 Cellular phone 

4 E-mail 

5 www 

6 FTP 

7 Telex 

Examples: 



1492 | Infor COM 7.5 User Guide 

 

System functions 

 

...;Kng1;Nr1;... 

...;2;07216634200;... 

Nr1 is a fax number. 

...;Kng2;Nr2;... 

...;1;072166340;... 

Nr2 is a phone number. 

 

The two Tel1 to Tel5 and Fax1 to Fax5 field groups require the phone or  fax ID. These 

IDs are automatically interpreted as phone or fax numbers. 

Communication data is saved as per relKomm (one record per Kng/Nr,TelNr or FaxNr pair; 

AdresseNr is populated by the process). 

Communication data is assigned to an employee or company as follows:  

If the PersonNr field is populated in a record, the data belongs to a employee.  

If the PersonNr field is not populated in a record, the data belongs to a company. 

 
 

Master data tables 

Master data is subdivided into several database tables, which are described in the following Help 

topics: 

viwAdrKonvert (see "Company master (viwAdrKonvert)" page 1493), relFa (see "External item IDs 

(relFa)" page 1495), relFs (see "Foreign-language texts (relFs)" page 1495), relFi (see "Price table 

(relFi)" page 1496), relAcd (see "Planning parameters (relAcd)" page 1496), relAck (see "Item 

costs (relAck)" page 1497), relAcp (see "Price flags (relAcp)" page 1499), relAc (see "Resources 

(relAc)" page 1501), relAb (see "BORs (relAb)" page 1503), relText (see "Autotext (relText)" page 

1505). 

For each table there is a list of mandatory fields for import/export and a field list containing all 

fields in that table. 

Mandatory fields must be completed in a table. The master data transfer must include these 

mandatory fields. The other fields in a table are optional. They can, but do not have to contain 

values. 
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You can use the In4DumpView.exe program to generate a text file containing the fields and their 

internal field names, description, length, and type for each table or view. 

In4DumpView.exe is located in the main Infor COM directory. 
 

Company master (viwAdrKonvert) 

The viwAdrKonvert view plays an important role when transferring master data in Infor COM. For 

more information. see Transfer company master data (page 1491). 
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Mandatory fields for imports (viwAdrKonvert) 

Field Description Length Type Comment 

Adresse.AdresseNr Address ID 20 String  

Adresse.PersonNr Employee ID 20 String  

Adresse.FirmaNr Company ID 20 String  

Adresse.AnschriftNr Address ID 20 String  

Firma.FirmaNr Company ID 20 String  

Firma.Name Name 112 String  

Firma.KTxt Short description 42 String  

Firma.UStIdNr Tax ID 20 String  

Firma.SprachKnz Lang. 4 String  

Firma.Verwendung1 Type of company 2 Short  

Anschrift.AnschriftNr Address ID 20 String If empty, assigned by numbering. 

Anschrift.Postfach PO box 36 String Anschrift.Postfach or 

Anschrift.Strasse must exist. 

Anschrift.PLZPostfach Pst cde 12 String If Anschrift.Postfach exists. 

Anschrift.PLZOrt Pst cde 12 String If Anschrift.Strasse exists. 

Anschrift.Ort Town/city 36 String  

Anschrift.Strasse Street 36 String Anschrift.Postfach or 

Anschrift.Strasse must exist. 

Anschrift.LandKng Country ID 6 String If empty, populated from the configuration 

Anschrift.Verwendung1 Type of address 2 2  

Person.PersonNr Employee ID 20 String  

Person.Name Name 36 String  

Person.Vorname First name 36 String  

Person.BriefAnrede Salutation 22 String  

Person.SprachKnz Lang. 4 String If empty, populated from the configuration 

Person.Verwendung1 Function 2 2  

Field list (viwAdrKonvert) 
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Please note: You can generate the entire list using In4DumpView.exe , which is located in the 

main Infor COM directory. When you open the program, you are prompted to specify the name of 

the log file to which the information is written. For example, select the fourth menu command in the 

in4DumpView.exe prompt and specify the field output language and the relation name. 
 

External item IDs (relFa) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 

Mandatory fields for import/export (relFa) 

Field Description Length Type 

BP Resource 20 String 

MID Resource 20 String 

ExtItemID External item ID 40 String 

ExtKTxt External desc. 60 String 

Field list (relFa) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
 

Foreign-language texts (relFs) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 
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Mandatory fields for import/export (relFs) 

Field Description Length Type 

MID Resource 20 String 

SprachKnz Lang. 4 String 

Description Short description 42 String 

Field list (relFs) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. 
 

Price table (relFi) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 

Mandatory fields for import/export (relFi) 

There is currently no list of mandatory fields for relFi. 

Field list (relFi) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
 

Planning parameters (relAcd) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 
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Mandatory fields for imports/exports (relAcd) 

Field Description Length Type 

MID Resource 20 String 

Raext Resource type 4 String 

RTint Internal resource type 1 Byte 

RVerwend(1)  Usage flag 1 Byte 

RVerwend(2) Usage flag 1 Byte 

RVerwend(3) Usage flag 1 Byte 

RVerwend(4)  Usage flag 1 Byte 

RVerwend(5)  Usage flag 1 Byte 

Field list (relAcd) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
 

Item costs (relAck) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 
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Mandatory fields for import/export (relAck) 

Field Description Length Type Comment 

MNR Resource 20 String  

RAExt Resource type 4 String  

Raint Internal resource type 1 Byte  

Rverwend(1) Usage flag 1 Byte The value must match Ac.Acpart.RVerwend(1). 

Rverwend(2) Usage flag 1 Byte The value must match Ac.Acpart.RVerwend(2). 

Rverwend(3) Usage flag 1 Byte The value must match Ac.Acpart.RVerwend(3). 

Rverwend(4) Usage flag 1 Byte The value must match Ac.Acpart.RVerwend(4). 

Rverwend(5) Usage flag 1 Byte The value must match Ac.Acpart.RVerwend(5). 

KostenSumme.K

osten 

Costs 8 Real  

KostenSumme.K

basis 

Cost basis 8 Real  

KostenSumme.K

ME 

Unit of measure of cost 

basis 

4 String  

KalkLosKnz Lot size origin 2 Short  

Valuation Price Valuation price 8 Real The value must match Ac.DbPart.BewPreis. Can 

equal 0. 

Basis Qty 8 Real  

Helpful, but not necessary for data import (relAck) 

Field Description Length Type 

Kosten(1).Kosten Costs 8 Real 

Kosten(1).KBasis Cost basis 8 Real 

Kosten(1).KME Unit of measure of 

cost basis 

4 String 

Kosten(2).Kosten Costs 8 Real 

Kosten(2).KBasis Cost basis 8 Real 

Kosten(2).KME Unit of measure of 

cost basis 

4 String 

Kosten(3).Kosten Costs 8 Real 
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Kosten(3).KBasis Cost basis 8 Real 

Kosten(3).KME Unit of measure of 

cost basis 

4 String 

Kosten(4).Kosten Costs 8 Real 

Kosten(4).KBasis Cost basis 8 Real 

Kosten(4).KME Unit of measure of 

cost basis 

4 String 

Kosten(5).Kosten Costs 8 Real 

Kosten(5).KBasis Cost basis 8 Real 

Kosten(5).KME Unit of measure of 

cost basis 

4 String 

Kosten(6).Kosten Costs 8 Real 

Kosten(6).KBasis Cost basis 8 Real 

Kosten(6).KME Unit of measure of 

cost basis 

4 String 

Avg. price Average price 8 Real 

Field list (relAck) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
 

Price flags (relAcp) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 
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Mandatory fields for import/export (relAcp) 

Field Description Length Type 

MID Resource 20 String 

RAext Resource type 4 String 

RTint Internal resource type 1 Byte 

RVerwend(1) Usage flag 1 Byte 

RVerwend(2) Usage flag 1 Byte 

RVerwend(3) Usage flag 1 Byte 

RVerwend(4) Usage flag 1 Byte 

RVerwend(5) Usage flag 1 Byte 

AcpPart.Vertreter1 Representative 1 20 String 

AcpPart.Vertreter2 Representative 2 20 String 

AcpPart.VertrGrp1 Representative group 1 4 String 

AcpPart.VertrGrp2 Representative group 2 4 String 

AcpPart.InlKto Domestic 4 Word 

AcpPart.EUKto EU 4 Word 

AcpPart.AuslKto International 4 Word 

AcpPart.AdrNr0 Quote address ID 12 String 

AcpPart.AdrNr1 Order address ID 12 String 

AcpPart.AdrNr2 Advance shipping notice 

address ID 

12 String 

AcpPart.AdrNr3 Bill-to address ID 12 String 

AcpPart.AdrNr4 Credit memo address ID 12 String 

AcpPart.WE Currency unit 6 String 

AcpPart.WarenNr EU commodity ID 4 Word 

AcpPart.PreisKnz Price group 1 Byte 

AcpPart.MwstKnz Tax group 1 Byte 

AcpPart.ProvKnz1 Commission group 1 1 Byte 

AcpPart.ProvKnz2 Commission group 2 1 Byte 
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Field list (relAcp) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
 

Resources (relAc) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 
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Mandatory fields for import/export (relAc) 

Field Description Length Type Comment 

DbPart.SAint Record type 1 Byte  

DbPart.SAext Record type 4 String  

DbPart.MNr Resource 20 String  

DbPart.KTxt Short description 42 String  

DbPart.ME Unit of measure 4 String  

DbPart.BewPreis Valuation price 8 Real The value must match Ack.BewPreis. 

DbPart.BewPreisBasis Valuation price basis 8 Real The value must match Ack.BewPreisBasis. 

DbPart.BewPreisME UOM valuation price 4 String The value must match Ack.ME. 

DbPart.KontoBestand Account 4 Word  

DbPart.Planart Pl. type 1 Byte  

AcPart.RAext Resource type 4 String  

AcPart.RAint Internal resource type 1 Byte  

AcPart.RVerwend(1) Usage flag 1 Byte The value must match Ack.Rverwend(1). 

AcPart.RVerwend(2) Usage flag 1 Byte The value must match Ack.RVerwend(2). 

AcPart.RVerwend(3) Usage flag 1 Byte The value must match Ack.RVerwend(3). 

AcPart.RVerwend(4) Usage flag 1 Byte The value must match Ack.RVerwend(4). 

AcPart.RVerwend(5) Usage flag 1 Byte The value must match Ack.RVerwend(5). 

AcPart.RlNr BOR ID 20 String Mandatory field if a BOR exists for the 

resource. If there is no BOR, the field must 

be empty. 

AcPart.ZugangME Receipt UOM 4 String  

AcPart.BasisME Basic UOM 4 String  

Field list (relAc) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
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BORs (relAb) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 
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Mandatory fields for imports/exports (relAb) 

Field Description Length Type Comment 

DbPart.SAint Record type 1 Byte  

DbPart.SAext Record type 4 String  

DbPart.MNr Resource 20 String  

DbPart.LNr Work center 16 String Mandatory field for work centers 

DbPart.AgNr Operation ID 20 String Mandatory field for operations 

DbPart.UTNr Parent item ID 20 String  

DbPart.IPos Internal line ID 2 Short  

DbPart.StNr Level ID 1 Byte  

DbPart.Tr Setup time, STi 8 Real  

DbPart.Te Runtime 8 Real  

DbPart.SyncAnz Number of parallel 

lines 

1 Byte  

DbPart.SyncNr Parallel line ID 1 Byte Mandatory field for purchase BORs 

DbPart.Planart Pl. type 1 Byte The value must match 

relAc.DbPart.Planart. 

RlNr BOR ID 20 String  

PlanBrDn Planning breakdown 1 Byte For DispAufl, you must set the value in 

the header record to 1 if the BOR lines 

are planning type 1 or 2. Otherwise 

DispAuflmust be 0. 

Field list (relAb) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
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Autotext (relText) 

This Help topic describes one of the database tables (see "Master data tables" page 1492)/views 

used in master data transfer (page 1488). 

Mandatory fields for import/export (relText) 

There is currently no list of mandatory fields for relText. 

Field list (relText) 

Please note: You can create the field list using the In4DumpView.exe program. 

In4DumpView.exe is located in the Infor COM main directory. When you open the program, you 

must first specify the name of the log file to which you want the information to be written. For 

example, select the fourth menu command at the in4DumpView.exe prompt and enter the output 

language for the fields as well as the name of the relation. 
 

Consistency check 

We recommend that after transferring master data (see "Master data transfer" page 1488), you 

check the consistency of the allocation tables.  The consistency check verifies whether the fields 

that need to be populated due to the logical relationships between individual allocation tables are 

actually populated. You select the consistency check in the Master data transfer dialog box. 

The following relationships are checked: 

Purchased and sales items 
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Corresponding text in relText table 

Associated prices in the relAcp table 

Associated costs in the relAck table 

Associated BORs in the relAb table 

Associated BORs in the relAb table 

Associated inventory records in the relDlb table (if the 

COMMON.LAGER.BESTANDDYNAMISCH=no parameter is set in 

the configuration) 

 

Work centers, operations, and tools 

Associated costs in the relAck table 

 

Additional costs and payment plans 

Corresponding text in relText table 

Associated prices in the relAcp table 

 
 

Business periods 

Call 

System functions > Administration > Business periods 

Description 

Business periods can be months, quarters, or any other period. They can begin on any day of the 

month and they do not all have to be of the same length. They must, however, be in chronological 

order without gaps. 

Period descriptions are user-defined. They must be unique within the entire table and cannot 

contain more than 7 characters. We recommend using the format YYYYMM so that periods will be 

arranged in numeric order. 
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Example: <calendar year>12 for December <calendar year>. 

Note: If the same name is used more than once, the database will interpret the record as being 

written twice, and you will receive a data collision message. 

The Fin. year column groups periods by financial years. Financial years do not have to coincide 

with the calendar year, and individual financial years can be shortened or extended. 

For example, you can define a period consisting of only one day, for example, 31 December as the 

13th month. 

The names of financial years are also user-defined and can contain up to 15 characters. For 

example, to prevent the name from overlapping with the calendar year description, you can create 

names such as 2005/2006. 

Functions 

Update business periods: This function provides a convenient way of entering new business 

periods. 

In practice 

Close period (ms-its:finance.chm::/3031.htm) 
 

Field configurations 

The System functions > Administration > Field configurations object is part of Infor Finance. Field 

configuration stores the links to financial accounting systems. 
 

Create interface (Field configuration) 

For more information on field configuration, click here (see "Field configurations" page 1507). 

1. Select System functions > Administration > Field configuration, and then click the New tab. 

2. In the Target field, enter the name of the interface you want to create. 

3. In the Target view field, enter the target view for the new interface. 

ms-its:finance.chm::/3031.htm


1508 | Infor COM 7.5 User Guide 

 

System functions 

 

4. Select the Import check box if you want to use the interface for data import. 

5. Select the Export check box if you want to use the interface for data export. 

6. Click Create. 

You can then store records in the interface you created. For more information, see Edit interface 

(Field configuration) (page 1508). 
 

Open interface (Field configuration) 

For more information on field configuration, click here (see "Field configurations" page 1507). 

1. Select System functions > Administration > Field configuration, and then click the Open tab. 

2. In the Target field, select the name of the interface you want to open. 

3. In the Function field, select a function if you only want to load data records for this function. 

4. In the Target view field, select a target view if you only want to load data records for this target 

view. 

5. Select the Import check box if you only want to load data records for data import. 

6. Select the Export check box if you only want to load data records for data export. 

7. Click Load. 

You can then edit the open interface. For more information, see Edit interface (Field configuration) 

(page 1508). 
 

Edit interface (Field configuration) 

Field assignments are stored in a field configuration (see "Field configurations" page 1507). The 

table on the Field assignments tab contains a row for each field assignment. 

1. Open an existing interface (see Open interface (Field configuration) (page 1508)) or create a 

new interface (see Create interface (Field configuration) (page 1507)). 

2. Decide whether you want to create a new field assignment, change a field assignment, or 

delete a field assignment. 
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To create a new field assignment: 

1. In the Target field on the Field assignments tab, click the first empty row in the table. 

2. On the Field assignments and Function parameter tabs, complete all fields for the selected 

table row. For more information, see the context-sensitive Help. 

To change a field assignment: 

1. On the Field assignments tab, click the required row in the table. 

2. On the Field assignments and Function parameter tabs, change the required fields in the 

selected table row. For more information, see the context-sensitive Help. 

To delete a field assignment: 

1. On the Field assignments tab, click the required row in the table. 

2. Select Edit and Delete row. 
 

Mapping functions (Field configuration) 

For more information on field configuration, click here (see "Field configurations" page 1507). 

Mapping functions are used together with Field configuration. 

Mapping functions specify rules for converting a source field to a target field. The following 

mapping functions are available: 
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Function Result 

FinMT.al_CondFormatStr Converts string fields if certain conditions exist. 

FinMT.al_ConvCurr Converts currencies. 

FinMT.al_FormatDate Converts a transferred string to a specified date format. 

FinMT.al_FormatStr Converts a transferred value to a formatted string field. 

FinMT.al_SetFieldByZT Reads values from an allocation table. 

Source field name: ZTKey from allocation table 

Parameters: 

1 - Target field data type: - DatString,DatWord, 

DatByte, DatReal, DatShort, DatDate  

2 - Name of allocation table 

3 - Rows to be exported from the allocation table 

FinMT.al_StrToNumber Converts a transferred string field to a numeric field. 

FinMT.al_SubStr Truncates an existing string beginning at a specified 

position. 

FinMT.al_WriteField Evaluated if the source field is empty or if there is no 

source field. 

FinMT.al_WriteOnlineCurr Determines the online currency unit. 

 
 

Value flow data conversion 

For information on the value flow, see Value flow. 

To access this function, select System functions and then Administration. 

The Value flow data conversion object lets you start the upgrade of value flow data from 6.1 to 6.3. 
 

Regional taxes 

This topic provides information on calculating sales tax in Infor COM. 
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This object allows you to create generally valid sales tax rates for particular regions. The sales tax 

rates created here apply for all items within the specified region for which no item-specific sales 

tax rates have been specified. Depending on the state, a region can refer to an entire country, part 

of a city, or individual streets. 

When entering a regional sales tax rate, all fields must be populated. 

Example: For example, to store sales tax for a specific city, you need to enter a value in the 

Country, State, County, and City fields. 

Note: If you do not want this regional sales tax rate to apply to certain items, you must store 

item-specific sales tax rates. 

Please note: You can use the the COMMON.TAX.UIACTIVEREGIONS parameter to specify 

which columns in this table are available for entry. 

Examples:  

 In the EU, sales tax rates are defined at the country level. 

 For the US, enter sales tax rates down to the company's address level if necessary. 

Related topics: Configuration (Sales tax), Allocation tables (Sales tax) 
 

Import/export EF 

This function lets you import and export equipment files. This function is required for example if 

equipment files need to be transferred from an existing Infor system to a newly installed Infor 

system. 

Please note: Due to the range of possible applications, this function only provides a framework, 

which may need to be customized for company-specific requirements. You therefore may need to 

contact your consultant. 
 

Generate EF from ASN 

This function lets you generate equipment files from existing advance shipping notices. 
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Note: The function is only available if the advance shipping notice contains finished product 

items. 
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Call 

To open Connect, select System functions > CONNECT. 

Description 

Companies with legally independent and geographically separate registered offices generally run 

a number of independent Infor COM installations. These subsidiaries may sell the same products 

to the same customers as headquarters. 

On the one hand, this creates a requirement to synchronize data such as item and customer 

master data between the locations, and on the other hand, it creates a need for centralized 

procurement in order to take advantage of delivery discounts. To this end, the individual locations 

carry out intercompany business transactions, i.e. the internal exchange of goods, based on the 

EDIFACT standard. 

Connect supports these transactions in the following ways:  

 Firstly, Connect can be used for the asynchronous exchange of data between Infor COM 

systems in order to map intercompany business transactions (see "Intercompany business 

(business interaction)" page 1519) via messages and a store-and-forward transport model. 

This involves saving the messages temporarily and then forwarding them on to the recipient at 

a later stage. The synchronous exchange of data between Infor COM systems is also 

possible. 

 Connect allows the asynchronous exchange of objects between Infor COM systems. 

 Connect allows you to send data asynchronously to non-Infor COM applications in a universal 

format (XML), and to receive data in XML format. 

Note: Connect does not create new business processes in Infor COM. Connect is used solely to 

exchange messages between objects in the ERP systems involved. 

For more information about this function, see Connect basics (page 1514). Before using Connect, 

it must be configured. See Configuration (Connect). 

 

Connect 
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Connect basics 

For general information, see Connect (page 1513). 

Connect guarantees the secure transfer and management of messages exchanged between Infor 

COM systems and third-party applications. 
 

Master data replication 

For general information, see Connect (page 1513). 

The Master data replication function updates changes to master data in linked systems, or informs 

linked systems about the latest data version of an object. You define the scope of linked changes 

in the configuration (see "Configurations (Connect)" page 1540). Automatic changes can be made 

during replication. 

Conflicting changes are detected. If a master system has been defined, the conflict is resolved 

automatically. 

Master data replication concerns the following master data: 

 Item master 

 Additional costs 

 Company master 

 Autotext 

 QIS groups 
 

Item replication (Connect) 

For more information on master data replication, see Master data replication (page 1514). 

Item ID 

When receiving a message, the item is created based on the external item ID that the sender 

specified for the recipient. If the external item ID is not recognized by the sender's system, a new 

item ID is assigned in the recipient system based on the standard numbering method. 
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The recipient/sender item ID assignment is stored as the external item ID in the recipient's system, 

and as the business partner in the sender's system. When changes to an item are replicated, this 

data is retrieved in order to determine the recipient item that needs to be changed. 

Accounting accounts 

During replication, the accounts entered for the sender when creating items, shipping materials, 

and additional costs are transferred, and any missing account categories are updated 

automatically using the templates from the COMMONSTD configuration. 

In the COMMONSTD configuration file, the recipient can specify whether account categories can 

be updated, and if so, which ones: 1 = EU, 2 = International. 

There must always be a default record for the 0 = Domestic category; otherwise the resource 

cannot be saved. 

If the usage is changed, whereby a sales item for the sender becomes a purchased item for the 

recipient, a domestic purchasing account is generated automatically for the recipient. This account 

does not exist on the sender side. 
 

Item replication and BORs (Connect) 

For more information on master data replication, see Master data replication (page 1514). 

Standard and 1:1 replication 

In the standard system, items are replicated differently depending on their usage, and BORs are 

not necessarily replicated with the items. 

If you select 1:1 replication, items and the assigned BOR (the supplier for purchased parts) are 

transferred 1:1 from the sender system to the recipient's system. 

In item replication with BORs the type of replication is different for item types: 
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Item type Standard replication 1:1 replication 

Sales i tem 

(merchandise)  

Usage: Purchasing and sales 

The item is transferred as a purchased 

item, and the BOR is generated with the 

sender as the supplier. 

The item and BOR are transferred 

1:1. 

Sales i tem (in-house 

manufacturing)  

Usage: In-house 

manufacturing and sales 

The item is transferred as a purchased 

item, and the BOR is generated with the 

sender as the supplier. 

The item and BOR are transferred 

1:1. 

In-house i tem  

Usage: In-house 

manufacturing 

The item is transferred without the BOR. The item and BOR are transferred 

1:1. 

Purchased part  

Usage: Purchasing 

The item is transferred without the BOR. The item and BOR are transferred 

1:1. 

 

Updating BORs 

Changes to items can always affect BORs. As a result, BORs are always transferred during 

replication to update the recipient's system. 

Note the following when updating BORs: 

 Existing BOR lines are replaced. 

 New BOR lines are added. 

 Old BOR lines are deleted, as are the associated purchase prices. This takes place 

automatically in the standard system provided the prices are linked to Connect. 

 If the target system does not recognize a supplier, the supplier and its prices are not 

transferred, and a log record indicating that they were not transferred is generated. This does 

prevent the item from being transferred. 

This check is also carried out when new data is added during the replication. 
 

Configuration (Connect) 

To use Connect (page 1513), you must activate it in the configuration first. 

The main configuration settings for Connect are defined in the COMMON.CONNECT, 

COMMON.CONNECTCOMPANYSUMMARYACCOUNT sections. Here you can configure 

whether all messages are to be sent as soon as they are created, and whether messages should 

be generated in an external process. 
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We also recommend linking Infor COM systems using JMS adapters. To do this, you must 

customize the COMMON.JMSADAPTOR section in the Infor COM Management Console. 

To link to XDEX, the COMMON.SHIPPINGDOCUMENTS section also needs to be customized. 

For more information, see Configuration (XDEX). 

Please note: Before using Connect, a unique three-digit numeric ID must be set for each Infor 

COM system. This ID is stored in the COMMON.VQL.CONNECTSYSTEMIDENTIFIER entry in 

the Infor COM Management Console. 

To ensure that XML messages from all clients and batch servers are generated correctly, you 

must specify a UNC path that can be accessed by all clients. You can do this using the 

COMMON.GLOBAL.UNCCOMHOME parameter. 

The following parameters must be configured: 

COMMON.CONNECT.ACTIVE 

COMMON.CONNECT.AUTOSENDMODE 

COMMON.CONNECT.ASYNCHRONOUSMESSAGECREATIONISACTIVE 

COMMON.CONNECT.LOGLIMIT 

COMMON.CONNECT.MESSAGELIMIT 

COMMON.CONNECT.DELETELOG 

To configure the JMS adapter, additional parameters must be configured. 
 

Time-controlled processes 

Certain functions can be configured as time-controlled processes in Connect. See Types of 

automation. 

For Connect Business, the following functions are included as batch processes: 
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Function Method 

Start replication Infor.Framework.Connect.Base.Message.Replication::IService.ReplicateBatch 

Send messages Infor.Framework.Connect.Base.Message.MessageOut::IService.SendBatch 

Receive messages Infor.Framework.Connect.Base.Message.MessageIn::IService.ReceiveBatch 

Transfer messages Infor.Framework.Connect.Base.Message.MessageIn::IService.ProcessBatch 

Clean up log Infor.Framework.Connect.Base.Message::IService.CleanUpBatch 

 

You can configure or run the time-controlled variations of this function by selecting System 

functions> Administration > Batch control. 

For instructions on defining time-controlled processes, see Define and start batch job (page 1485). 
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Intercompany business (business interaction) 

For general information, see Connect (page 1513). 

When intercompany business transactions are carried out using Connect, interfaces are 

integrated into the standard business processes at the points where relevant status changes occur 

on the business partner side. For the most part, this involves the points at which documents are 

printed. For the recipient, the associated business processes are triggered by these messages. 

For example, the receipt of a purchase order will trigger creation of a sales order, or the receipt of 

a change message for an item will trigger replication of the change in the recipient's system. 

In the context of the Connect business interaction, Connect messages are created instead of 

traditional paper documents. It is also possible for these hardcopy documents to be requested 

also. 

Business interaction supports the following business processes: 

 Order items 

 Deliver items 

 Calculation of item delivery 

You can define how you want external item numbers for each object type to be handled for 

communication partners (see "Communication partners (Connect)" page 1542) on the Incoming 

and Outgoing tabs. 

All the fields available in the systems can be linked between Purchasing and Sales. 

A distinction must be made between data exchange from one system to another and field 

reconciliation, or processing a received message. 

The fields stored in the Connect configuration are used to receive messages. 

When the received messages are processed, the field configuration rule sets for Connect are 

evaluated. You can edit the rule sets in object maintenance. 

For an example of how to configure business interaction in the Communication partners object, 

see Create communication partner. 

The following Help topics explain how data is exchanged for selected applications. 
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Business interaction - purchase orders and sales orders 

For general information about business interaction in Connect, see Business interaction (see 

"Intercompany business (business interaction)" page 1519). 

This topic describes data exchange between purchase orders and sales orders and shows how 

you can exchange data between Purchasing and Sales in Infor COM. 

The data exchange always starts in the Purchasing module, which reports the requirement to 

Sales. Sales returns and calculates the reported requirement but does not generate a requirement 

in Purchasing. The consumer must always report the requirement. 

Prerequisites 

Before you can exchange PO and sales order data using Connect, you must meet the following 

prerequisites: 

 The business partners exchanging data must be known. You can ensure this by exchanging 

company masters. 

 The resources you want to exchange must be known. You can ensure this by exchanging item 

masters. 

 The Connect partners should define the exchange arrangements in detail. In other words, 

quantities, due dates and prices should rarely be changed or accepted as a rule. Incoming 

data should be considered reliable. 

Data exchange is event-oriented and is essentially linked to the document exchange. Business 

partners exchange data directly and without paper using Connect instead of printing documents 

(POs, order confirmations and so on). 

For all events that initiate a link, the link is run entirely in the background. Link data is received in 

Connect. 

The tables below show the Purchasing - Sales and Sales - Purchasing link in detail. 

Purchasing -> Sales 

This table provides an overview of the purchasing processes and their effects in the recipient's 

sales system. 
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Exchange of POs <--> sales orders 

Sender = purchasing system 
 

Recipient = sales system 

Confirmation receipt 
 

Order confirmation is printed 

Confirmation receipt is canceled 
 

Order confirmation is canceled 

Zero quantity is posted 

 
Close delivery 

PO line is closed 
 

Order line is closed 

PO line is deleted 
 

Order line is deleted 

Close PO 
 

Order is closed 

Sales -> Purchasing 

This table provides an overview of the sales processes and their effects in the recipient's 

purchasing system. 

Exchange of POs <--> sales orders 

Recipient = purchasing system 
 

Sender = sales system 

Confirmation receipt 
 

Order confirmation is printed 

Confirmation receipt is canceled 
 

Order confirmation is canceled 

Zero quantity is posted 

 
Close delivery 

PO line is closed 
 

Order line is closed 

PO line is closed 
 

Order line is deleted 

Close PO 
 

Order is closed 

Note the following when using this function: 

 You can configure printing for documents you want to link for each business relationship. 
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 You cannot create a Connect sales order manually. Sales orders are always created when a 

PO is transferred. 

 You cannot add additional material records to a sales order. The records must be determined 

using the purchasing system. 

 In both systems, you can create only record types that can be processed by the recipient's 

system. 

Details on linking 

As a general rule, purchasing and sales items, additional costs and comments records are 

exchanged. Since this data has different record types in Purchasing and Sales, the record types 

are automatically converted when the records are accepted by the recipient's system. The table 

below shows the corresponding record types. 

Purch.  Sales 

External RT Internal RT Meaning  Meaning Internal RT External RT 

O 210 Company type <--> Customer, Cust. 10 HR 

HR 10 Purchased 

items 

<--> Sales item 90 MA 

AC 215 Additional cost, 

Add. cost 

<--> Additional cost, 

Add. cost 

215 AC 

TX 110 Comments <--> Comments 110 TX 

 

When these records are linked, only selected fields are transferred, not all fields. The linked fields 

are primarily ID data (BOR ID and similar fields), due dates, quantities, and price information. 

Please note: Since only selected fields are transferred during linking, Connect business partners 

must agree on the data fields that they want to exchange. 

Example: If the DbPart.TextNr autotext field is transferred from Purchasing to Sales, the reference 

is also saved in the DbPart.TextNr field in Sales. The Sales employee therefore needs a text field 

in order to save the corresponding text. 
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Business interaction - deliveries 

For general information about business interaction in Connect, see Business interaction (see 

"Intercompany business (business interaction)" page 1519). 

Sales orders and POs generally turn into deliveries. If a sales order and PO are linked using 

Connect, it makes sense to link the associated deliveries too. Following the goods issue in Sales, 

the corresponding goods are issued in Purchasing in the Connect partner's system. 

If an RMA is initiated in Purchasing, an RMA is carried out in Sales in the Connect partner's 

system. 

Configuration 

Before deliveries can be linked, the communication partners must be configured.  

Linking deliveries 

To link deliveries, the supplier must have created an issue with the Sales - Advance shipping 

notice object type in the Communication partners object. The recipient of the delivery must have 

created a message receipt with the Sales - Advance shipping notice object type in the 

Communication partners object. 

Linking RMAs 

To link RMAs, the Connect partner that wants to return the received goods must have created a 

message issue with the Purchasing – Return advance shipping notice (ASN) object type in the 

Communication partners object. The Connect partner to which the goods are returned must create 

an outgoing message with the Purchasing – Return advance shipping notice (ASN) object type in 

the Communication partners object. 

The Sender, Recipient, Print documents, and External item ID fields are populated and function as 

in linking sales orders and POs (see "Business interaction - purchase orders and sales orders" 

page 1520). 
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Deliveries from linked sales orders are linked in full. No linking takes place for sales orders that 

were created without linking even if the business partner is a Connect partner. If the configuration 

is not yet complete, the system does not permit deliveries that must be linked by cannot be linked 

due to the incomplete configuration. 

Note: The partial cancellation of advanced shipping notices is not possible, either for partial 

quantities or individual advance shipping notice lines. 

Linked business processes 

The following business processes are affected by links: 

 

Sales 

Outgoing delivery 

Outgoing deliveries (ASN printing and goods issue posting) are carried out in the same way as 

they are in the standard system (without using Connect). When the goods issue is posted, an 

outgoing message is created containing all of the necessary data for the partner process. 

Outgoing delivery cancelation 

Cancelation takes place as in the standard system (without Connect).  

Exception: Partial cancelations are not permitted. 

If the outgoing message created when the goods receipt was posted has not bee sent, it is set to 

Processed so it can no longer be sent. If the outgoing message has already been sent, a new 

message with the cancelation data is created. 

Note: Since advance shipping notice data is not transferred until the goods issue has been posted, 

only the cancelation of previously issued advance shipping notice lines can be transferred via 

Connect. 

 

RMA 

You open RMAs as in the standard system. The start form contains only the sales orders for which 

a message from the partner process (Purchasing, RMA) is available. 
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The fields that must be completed for the RMA are populated by default, and the values are taken 

from the message. The actual posting process is the same as in the standard system. Once the 

posting is made, the message's status is set to Processed. 

The following errors are populated by default: Posting ID, Trans. qty, Unit of measure, 

Serialized/batch ID. 

 

 

Purch. 

Incoming delivery 

The purchase receipt is posted as in the standard system (without Connect), for example in 

Purchasing using Purchase orders. 

Only POs for which an outgoing delivery has already taken place in the associated sales order and 

for which the created message has been send are permitted. 

If there are multiple messages because outgoing deliveries were canceled and then created 

again, the message of the last outgoing delivery is used to populate the field. 

Note: If you want the serialized/batch information to be displayed on the posting form, you must 

set the COMMON.BUCHEN.PURCHAUTOUSEPRESET = yes parameter in the configuration. 

On the posting form, select Post to use the default data. The posting is carried out as in the 

standard system. 

Once the posting is made, the status of the message used is set to Processed. Messages that are 

not used due to cancelations remain in To be processed status and may need to be deleted 

manually. The same applies for messages that come too late, if for example the purchase receipt 

was already posted and a cancelation message is received. In this case, the warehouse inventory 

must be adjusted outside of the PO on the user side. 

Please note: For this reason, the deletion of messages should incorporate a delay rather than 

being carried out immediately. 

The following fields are set by default: Posting ID, Trans. qty, Unit of measure, Batch ID/Serialized 

ID, Ext. ASN ID, ASN date. 
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Incoming delivery cancelation 

The purpose of canceling an incoming delivery is only to adjust an incorrect user input. In all other 

cases, an RMA is used. 

The delivery is canceled as in the standard system. The status of the incoming message for the 

purchase receipt posting is set to To be processed. 

 

RMA 

RMAs are carried out as in the standard system. During the process, an outgoing message is 

created that contains all the data necessary for the partner process. 

 
 

Business interaction - invoices and credit memos 

For general information about business interaction in Connect, see Business interaction (see 

"Intercompany business (business interaction)" page 1519). 

Sales orders and POs generally result in invoices and potentially credit memos. If a sales order 

and PO are linked using Connect, it makes sense to link the associated invoices and any credit 

memos. 

An invoice or credit memo in Sales results in a corresponding invoice or credit memo in 

Purchasing in the Connect partner's system. 

Note: Purely invoice or credit memo data such as the feedback ID, resource ID, description, 

quantities, due dates, and prices are linked but no additional information. 

Configuration 

Before invoices can be linked, the communication partners must be configured. 

Linking invoices 

To link invoices, the supplier (sales system) must create a sales invoice in the outgoing messages 

in the Communication partners object. 
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The recipient of the invoice (purchasing system) must create a sales invoice in the incoming 

messages under Communication partners. 

 

Linking credit memos 

To link credit notes, the supplier (sales system) must create a sales credit memo in the outgoing 

messages under Communication partners. 

The Sender, Recipient, Print documents, and External item ID fields are populated and function 

the same as when you link POs and sales orders (see "Business interaction - purchase orders and 

sales orders" page 1520). 

 

Linked business processes 

The following business processes are affected by links: 

 

 

Sales 

Sales invoice 

To link invoices, the corresponding sales orders and purchase orders must be already linked via 

Connect. Invoices resulting from linked sales orders are always linked. Invoices for sales orders 

that were created without a link are not linked, even if the business partner is a Connect partner. If 

the configuration is incomplete, the invoice will be created without a link. 

If an invoice is created from a linked sales order, a Print invoice outgoing message is created 

when the invoice is printed. 

Note: You cannot create consolidated invoices from linked sales orders. 

 

Cancel sales invoice 

When a linked invoice is canceled in Sales, a Cancel invoice outgoing message is created, which 

contains all data necessary for the partner process (Purchasing, Cancel purchase invoice). 

Note: Linked invoices cannot be partially canceled. 
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Sales credit memo 

Manual credit memos created in Sales do not have a direct relationship to the associated sales 

order. You can enter an order or invoice ID in the credit memo for informational purposes. 

If you create a credit memo for a Connect partner, it is linked regardless of whether the credit 

memo contains a linked sales order. If the configuration is incomplete, the credit memo is created 

without a link. 

If you create a manual credit memo for a Connect partner, when the credit memo is printed, a Print 

sales credit memo outgoing message is created. 

Note: Credit memos can only contain lines of the CM, TX, and AC record type. 

 

 

Cancel sales credit memo 

When a linked credit memo is canceled in Sales, a Cancel sales credit memo outgoing message is 

created. 

 

 

Purch. 

Purchase invoice 

If the Connect partner created an outgoing message and the message was received, a purchase 

invoice can be created automatically from the message. 

The corresponding incoming message must be accepted as a Print invoice event. When the 

message is confirmed, a purchase invoice is created from the incoming message. The new 

purchase invoice contains the invoice ID of the sales invoice as the external invoice ID. The 

internal invoice ID is determined from the purchase invoice using numbering. The status of 

accepted invoice is Approved. 

Note: If the goods issue for a linked sales order has already been posted on the sales side, but the 

goods receipt has not been posted on the purchasing side, the invoice cannot be transferred. 
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Cancel purchase invoice 

If the Connect partner canceled an outgoing message and the message was received, the 

purchase invoice for the sales invoice can be canceled automatically. 

The corresponding incoming message must be accepted as a Cancel invoice event. If the 

message (Print invoice) to create the purchase invoice you want to cancel has not been accepted, 

the invoice approval automatically takes place before the invoice is canceled. Manual cancelations 

in Purchasing are not permitted. 

Received credit memo 

Received credit memos are essentially purchase invoices with negative amounts. If a Connect 

partner creates a sales credit memo and the created message is received, a received credit memo 

can be created automatically from the message. 

The corresponding incoming message must be accepted as a Print sales credit memo event. 

When the message is confirmed, a received credit memo is created from the incoming message. 

The new received credit memo is now a purchase invoice with negative amounts, and its external 

credit memo ID is the credit memo ID of the sales credit memo. The internal credit memo ID is 

determined from the purchase invoice using numbering. The status of the accepted credit memo is 

Approved. 

Cancel received credit memo 

If the Connect partner canceled a sales credit memo and the message created was received, the 

received credit memo for the sales credit memo can be canceled automatically. 

The corresponding incoming message must be accepted as a Cancel sales credit memo event. If 

the message to create the received credit memo that is to be canceled has not been accepted, the 

credit memo is automatically approved before it is canceled. 

Manual cancelations are not permitted in Purchasing. 
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Allocation tables (Connect) 

Connect (page 1513) uses the allocation tables listed in the following topics: 
 

COMPONENTS 

Description: Components 

Usage: This a user-definable allocation table in which you can declare areas, modules or 

components. 
 

DATATYPES 

Description: Base data types (groups) 

Usage: This allocation table stores the base data types that are used in the XSDDATATYPES 

allocation table. 
 

FMCONDTYPES 

Description: Condition types 

Usage: This allocation table stores the condition types that can be entered in rule definitions. 

 
 

FORMULATYPE 

Description: Calculation types 

Usage: This allocation table stores the calculation types that can be used in rule definitions. 
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ICBRECTYP 

Description: Record types for business interaction with CONNECT 
 

ICCONDTYPES 

Description: Condition types (IC mapping) 

Usage: This table contains the condition types for Connect mapping (XDEX (see "XDEX link" 

page 1544)). 
 

ICSCONNTYPE 

Description: IC link types 

Usage: This allocation table contains the link types supported by Connect. 
 

ICSYSBMODE 

Description: IC transfer modes for invalid BORs 

Usage: In Communication partners, you can define how unknown resources are dealt with when 

transferring resource lists. 

This allocation table declares the modes available. 
 

ICSYSCTYPES 

Description: Record types for business interaction with CONNECT 

Usage: The transport method for communicating with the partner system is configured in the 

configuration for the Connect server. This allocation table contains the available transport 

methods. 
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ICSYSELTYP 

For an overview of Connect allocation tables, see Allocation tables (CONNECT) (page 1530). 

Description: IC element types 

Usage: This allocation table contains the element types for Connect. 
 

ICSYSEVTYP 

For an overview of Connect allocation tables, see Allocation tables (CONNECT) (page 1530). 

Description: IC event types (system events < 1,000) 

Usage: This allocation table contains the event types for Connect. 
 

ICSYSFILTYP 

For an overview of Connect allocation tables, see Allocation tables (CONNECT) (page 1530). 

Description: IC filter types 

Usage: This allocation table contains the filter types for Connect. 
 

ICSYSFORMAT 

Description: IC data format types 

Usage: This allocation table contains the message formats for the exchange of messages. 
 

ICSYSLOGLEV 

For an overview of Connect allocation tables, see Allocation tables (CONNECT) (page 1530). 

Description: IC log classes (codes similar to cMsg%) 

Usage: This allocation table contains the log entry types for Connect. 
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ICSYSMASTER 

For an overview of Connect allocation tables, see Allocation tables (CONNECT) (page 1530). 

Description: IC master systems 

Usage: The possible leading systems for Connect are specified in this allocation table. 
 

ICSYSOBJTYP 

For an overview of Connect allocation tables, see Allocation tables (CONNECT) (page 1530). 

Description: IC object types 

Usage: This allocation table contains the object types for Connect. 
 

ICSYSSTATUS 

For an overview of Connect allocation tables, see Allocation tables (CONNECT) (page 1530). 

Description: IC message statuses 

Usage: This allocation table contains the possible messages statuses for Connect. 
 

ICSYSVALIDM 

Description: IC troubleshooting modes 

Type: The user is not allowed to modify this allocation table. 

Usage: This allocation table contains a description of the flags that specify how invalid message 

content is to be handled when sending Connect messages. 
 

SPECAREA 

Description: Valid ranges for field mapping 
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Usage: In the definition of the specification, you can enter the specific application areas for which 

this specification applies. This allocation table declares the known areas. 
 

XSDDATATYPE 

Description: XSD data types with hard-coded formatting 

Usage: This allocation table stores the supported xsd basis types in conjunction with the 

configuration of the data transfer to XML format. 
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Messages (Connect) 

For general information, see Connect (page 1513). 

Call 

System functions > CONNECT > Incoming messages/Outgoing messages 

Description 

The Incoming messages (see "Incoming messages (Connect)" page 1536) and Outgoing 

messages (see "Outgoing messages (Connect)" page 1537) objects are necessary for saving, 

managing, and processing messages. 

The messages objects contain a list of the messages that are to be processed. 

Functions 

You can find the following functions in incoming and outgoing messages alike. For other specific 

functions, see Incoming messages and Outgoing messages. 

Show message content: You can use this command to display the actual content of an XML 

message without processing it, i.e. this function allows you to view the XML document. You can 

then save the XML document as a file and validate it against the schema. 

Change message statuses: This command allows you to change the status of a message. 

The status of the message can also be obtained from the shortcut menu for the status field. 

If you accidentally created a message and do not want to send it, change the status. In this case, 

we recommend setting the status to Processed so that the message can be deleted. 

Please note: Deleting messages manually can cause data inconsistencies. 
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Clean up messages and log entries: As a rule, processed incoming and outgoing messages and 

their associated log entries should not be deleted immediately so that a history can be kept. You 

can define the number of messages and log entries that you want to keep after cleanup using the 

COMMON.CONNECT.MESSAGELIMIT and COMMON.CONNECT.LOGLIMIT parameters in the 

configuration. You can delete old messages and the log file using the Time control function or this 

menu command. 

In practice 

Sort: Incoming and outgoing messages can be sorted. You can sort incoming messages after a 

bulk transfer with a large number of entries, many of which may be duplicates due to 

customizations, for example. To process the report, sort it by object ID. 

 
 

Incoming messages (Connect) 

For information on messages in Connect, see Messages (see "Messages (Connect)" page 1535). 

Call 

System functions > CONNECT > Incoming messages 

Description 

This function allows you to modify incoming message data in order to resolve errors. If changes 

are made to messages, the modified fields are highlighted in color. 

Functions 

The following functions are available in the incoming messages when you select the menu option 

of the same name. You can find a description of the other functions in Messages (see "Messages 

(Connect)" page 1535). 
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Receive messages: Receive refers to the transfer of a message from a third-party system or file 

system. The message transfer can be initiated by the sender as well as the recipient. The 

message will be added to the recipient's incoming messages once the transfer has completed. 

Once the message has been received, its embedded content must be transferred to the target 

system. See Transfer messages. 

You can initiate the receipt of messages by selecting Incoming messages > New and then clicking 

the Receive button. There are also batch servers for Document and JMS adapter servers, which 

import messages into the Incoming messages (CONNECT) object automatically. 

Edit message: When a replication message is sent, conflicts can occur. This function allows you to 

resolve these conflicts manually. It can only be used for insert and update replication messages. It 

contains a message editor similar to the Data maintenance function, which you can use to merge 

data from the message with data from the database or edit data manually. Each table is displayed 

on a separate tab. 

Note : You can automatically resolve conflicts for messages in internal format by configuring either the sender or 

recipient as the master system. 
 

Outgoing messages (Connect) 

Call 

System functions > CONNECT > Outgoing messages 

Description 

Outgoing messages are transferred to the target system during processing. Sender data can be 

changed here in order to resolve problems. 

An outgoing message contains information about the recipient and also flags the action that 

initiated the generation of the message for the object. It also displays the number of log entries for 

the message. 
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Functions 

The following are examples of some of the functions that are available for outgoing messages. For 

a description of the other functions, see Messages (see "Messages (Connect)" page 1535). 

Start replication: This function allows you to manually generate messages that are not managed 

via event control (replication messages). 

Send messages: Outgoing messages consists of two elements: Metadata and message content. 

The metadata contains information about the sender, recipient, object, etc. This information is 

always sent in an internal format together with the message. 

When a message is sent, communication information is determined and applied using the 

metadata from the relevant server configuration.  

When messages are sent in XML format, only the message content is sent. 

The content of messages in internal format compiled into a string together with the meta 

information. The string is transported by the JMS adapter. 

Update message content: This function can be used to recreate the content of messages about 

replication objects based on the latest version of the object in the database. The rules that apply 

when validating new content also apply when creating new content. Error details can be viewed in 

the log entries for the message. 

Note: This command is available for replication messages in XML format only. 
 

Log entries (Connect) 

For general information, see Connect (page 1513). 

Call 

System functions > CONNECT > Log entries 
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Description 

All actions in Connect are logged. The log records are assigned to the associated message and 

the corresponding object. 

The log view allows you to process the event logs that have been generated for each object. 

You can load logs by object, message, and classification. 

Note: You can also access the log view by selecting Go to in the Connect messages object. 

Configuration 

If the COMMON.CONNECT.AUTOSENDMODE parameter is set to yes in the configuration, you 

can view the log entries here. 

The number of messages that are to be saved can be configured in the COMMON.CONNECT 

section of the configuration via the following parameters: 

 COMMON.CONNECT.LOGLIMIT: This parameter determines the maximum number of log 

entries. 

 COMMON.CONNECT.MESSAGELIMIT: This parameter defines the maximum number of 

processed messages that are to be kept. 

Functions 

Clean up log: See the description provided for the Clean up messages and log entries function in 

the Messages (see "Messages (Connect)" page 1535) Help topic. This function cleans up 

messages and log entries. 

 



1540 | Infor COM 7.5 User Guide 

 

System functions 

 

Configurations (Connect) 

For general information, see Connect (page 1513). 

Call 

System functions > CONNECT > Configurations 

Description 

An essential part of setting up Connect involves configuring supported objects and processes. 

You can define a basic configuration by activating or deactivating preconfigured object types, etc. 

The default configuration can also be updated to reflect customer-specific requirements. 

For each object, you must specify an interface that supports the required methods. 

Select an object type (Master data - Customer, for example) to load the corresponding object 

configuration. The parts (sections of database tables) that make up each class of object are 

specified here. Each of this parts is represented internally by a VTab. For each of these records, 

you can configure the exact fields (in internal format) that are to be taken into account. 

It is possible to configure the messages for the objects based on scope. However, a distinction 

needs to be made here in terms of configuring the display in internal format and configuring the 

display in XML format. For messages in XML format, you define which database content is to be 

transferred or expected in which element. For the internal format, it is only possible to define the 

elements (=data records) and fields that are absolutely necessary or irrelevant (e.g. local status 

fields) for the link. 

An object configuration is always loaded so that the data is displayed from the site perspective. It 

loads all site-specific data and all data templates for which there is no corresponding overwritten 

data or templates . If the content of a data record is changed, a site-specific data record is created 

when saving. If a new row is added, the new data is saved as site-specific data. 

Note: You can change Connect configurations on a site-specific basis. 
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Functions 

Delete site-specific data: You can use this function to delete site-specific data for the current site. 

Export: The export of object configurations generates template files as well as files with 

site-specific data, if applicable. 

Configuration 

If the COMMON.CONNECT.AUTOSENDMODE parameter is set to yes, you can prevent certain 

element records, fields, or object types from being sent automatically. 
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Communication partners (Connect) 

Call 

System functions > CONNECT > Communication partners 

Description 

This field allows you to define the details of the data interchange between a specific sender and a 

specific recipient. 

A communication partner activates the data transfer (outgoing) and the message process 

(incoming) for Infor COM objects being transferred to a partner system. If a partner has not been 

specified for outgoing communications for an object, no messages are created. If a partner has not 

been specified for incoming communications for an object type, incoming messages are not 

processed and online requests will not be permitted. 

Functions 

Initialize replication journal : This function allows you to select the object types and associated 

elements for each communication partner that are not to be detected, and therefore not to be 

replicated, during the next scan process. The corresponding objects are therefore only replicated if 

they were changed (Update flag) or inserted (Insert flag) after the date specified in the function. 
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Server configuration (Connect) 

For general information, see Connect (page 1513). 

Call 

System functions > CONNECT > Server configurations 

Description 

In a server configuration, the transport method for communicating with the partner system is 

configured. 

To set up communication partners, server links must be in place. 

Configuration 

The configuration is defined via COMMON.VQLSERVERMAP. 

An entry in the COMMON.VQLSERVERMAP section is structured as follows: 

<keyname>=<DbServer>,<DatabaseProgram>,<DbName>,<RequestBrokerLocation>,<RBNameServ

iceBootStrap>,<OracleInstanceListenPortNumber>,<OracleSchemaName> 

See also Configuration (Connect) (page 1516). 

Functions 

Reconcile communication partners with template: This function allows the communication partners 

for a Connect server that has been assigned to a template to be updated based on this template. 

You can also use this function to update an existing Connect server, and to adjust existing 

communication partners based on the latest requirement after this update has been carried out. 
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XDEX link 

The XDEX interface is used to send data as XML documents from Infor COM to the XDEX 

document system to support customs handling and shipment control. Data can currently be sent 

from Infor COM to XDEX, but data cannot be received from XDEX. 

When goods are issued in Sales, in other words goods are delivered to customers, and the 

associated invoices and credit memos are created, the data that is relevant for shipping is 

determined and transferred to XDEX. 

The same applies for canceling invoices and credit memos and for RMAs. 

The Automotive, Project, and Service areas are also taken into account. 

Unlike business interaction, sending an XDEX message does not depend on a specific company 

ID. You only need to have created a communication partner for the object. 

Standard server 

There are no server templates provided in the standard system for the XDEX link. You must 

manually create the Connect server and the communication partners. See Configure server. 

Example: To identify the server, use the abbreviation XDEX as name of the server (Server field) 

and as the Description on the New tab 

The server communication type must be JMS adapter. 

Note: The partner ID can be freely selected but cannot be a company ID that is already being 

used in the company master. 

In the Infor COM/XDEX installation assignment is defined on a 1:1 basis, the server type can be 

XDEX. This is actually the recommended entry in this case. The messages are then written 

directly to the mailbox for XDEX (relXDEX). 
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Please note: If several Infor COM systems communicate with XDEX, the XDEX server type 

must not be used for systems that do not manage the mailbox for XDEX in their own database 

schema. These systems must use the JMS adapter server type. The 

listenMessageHandler<x>=Infor.Framework.Reporting.Customs::XDEXQueueListener.proces

s parameter must be entered as the processing method in the COMMON.JMSADAPTOR section 

of the Infor COM Management Console configuration. 

Requirements: 

 Before you can define XDEX settings, the necessary configurations must be defined on the 

server. For information, see the Configuration Help for Connect. 

 To use the XDEX interface, Connect must be activated and configured. 

You can configure the XDEX link in the COMMON.SHIPPINGDOCUMENTS section of the 

configuration. 

 For more information, see the Configuration Help for Connect. 

Communication partner 

For the Connect server, create communication partners for the following objects for the XDEX link. 

The connection server for XDEX must be used as the server. See Create communication partners. 

 XDEX - Sales/credit memo 

 XDEX - Sales/advance shipping notice (ASN) 

 XDEX - Sales/invoice  

 XDEX - Purchasing/purchase invoice 

Schedule 

All XDEX messages correspond to the XDEX_INTERFACE.XSD xsd schema. 

Initial data transfer 

There is no initial data transfer carried out for the XDEX link.  
 

Create Connect mapping 

Mapping refers to the mapping of data to the XML document. To define the data mapping, select 

System functions > CONNECT > Configurations. Then go to the Data assignment form section on 

the Data format tab in the Elements and data formats view. 
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When you select a previously created data format assignment, the system displays the elements 

of the schema image for which a data can be mapped, together with existing mappings. A 

mapping can be defined here. 

Depending on the element type of the element/node selected in the Data mapping table, different 

form sections will display next to the table. Only the properties that are relevant for the current 

element are displayed. 

In general, the following applies: If an element is to contain values, or if values in this element are 

to be processed when a message is received, you need to assign a container element. This 

assignment can be defined locally or in a parent element in the schema structure.  

If you have selected the Direct transfer method, you must specify a field. When using other fill 

types, no fields should be specified. When using the direct transfer method, you must also select a 

field from the element. 
 

Connect distinguishes between the following element types: 
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inforConnectHeader This is a structure with a fixed predefined syntax in which the message 

header data mapping is hard coded. As a result, there is no configuration 

provided for this element. 

Element (with 

subelements), 

Element+End 

(element without 

subelements) 

In addition to the container element in the Element field and the Field name field 

containing the names of the fields, you can set the following properties for an element for 

sending and receiving: Row, Locally defined, Access type, Distribute to all rows. 

Attribute Similar to element type. 
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Repeat start You can assign a container element to a repeat that can be "inherited" by all 

subelements contained in it. However, you cannot assign a specific field. This 

must be done for each subelement. However, it is possible to define a start 

and end row. 

Note: 0 means up to and including the last VTab row. 

Example: For sales orders, the order lines start at VTab row 2. A repeat 

would therefore most likely start at VTab row 2 for sending and receiving. 

You can also store a synchronization method. This method is then run for 

each new pass of the repeat section. This means that the repeat section 

element can be used to synchronize different container elements on each row 

pass. 

Sync. method: This method is started for each new run of the repeat section. This 

means that a repeat element can be used to synchronize different container elements 

on each row pass. Stored methods must adhere to the following prototype: 

Sub <meth>(ByVal phContainer As tHandle, ByVal phObjectElement As 

tHandle) 

Example: 

A sales order is to be displayed as an XML document. The schema requires a section 

for the order header data and a section for the lines. For each order line, item-specific 

data must exist. 

In this case, the schema image will contain a section for the header data, and the 

order lines will be enclosed within a repeat section (starting in row 2). 

The sync method for the repeat start defines the row with the item ID from the current 

order line as the current row in the container element of the item master data. 

 Pre-sync method: This method is run once before the repeat section is run for the 

first time. 

You can select dependent container elements, for example. 

Stored methods must adhere to the following prototype: 

Sub <meth>(ByVal phContainer As tHandle, ByVal phObjectElement 

As tHandle) 

 Post-sync method: This method is run after the last repeat section is run. You can 

restore selections of dependent container elements for the parent repeat section, 

for example. Stored methods must adhere to the following prototype: 

Sub <meth>(ByVal phContainer As tHandle, ByVal phObjectElement 

As tHandle) 
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The following access types are currently supported: 
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Access type Explanation 

Direct transfer When sent, the value from the container element field is transferred directly to the 

XML document, and when received, it is transferred from the XML document to 

the VTab directly. 

Access via 

allocation table 

When sending and receiving, the original value from the container 

element or XML document is compiled via an allocation table before 

being processed further. If you select this access type, the following 

properties must be set also: 

 Table name 

 Lang. 

 AT target field 

 The allocation table key is determined from the allocation table 

configuration. It is displayed for information. 

Lj4 (run 

interface 

method) 

The original value is sent to the specified interface method. It must be 

a function that complies with the following requirements: 

 The function must be released in an interface and specified together 

with the interface call. 

 It must correspond with the following prototype: 

Function <method>( 
ByVal psValue As tString, 
ByVal phAppContainer As tHandle, 
ByVal phObjectElement As tHandle, 
ByVal psFieldName As tString, 
ByVal pwRow As tWord, 
pbDoFormat As tBoolean, 
ByVal pwFormatID As tWord, 
ByVal pwServerContentProfile As tWord) As tString 

If you select this access method, the interface method must 

be specified. 

Constant When a document is generated, the container element is not 

accessed; the stored value is set directly instead. When a message is 

processed, the constant is transferred directly to the container 

element field. 

Empty The element is generated but is not assigned a value. 



Infor COM 7.5 User Guide | 1551 

 

System functions 

 

ICEE link 

This Help topic describes the interface between Infor COM and ICEE. 

To configure the Infor COM/ICEE interface for the first time, see Configure Connect. 

We recommend activating asynchronous generation of messages (see "Configure asynchronous 

message generation (ICEE)" page 1554) to reduce the load on Infor COM clients as much as 

possible in terms of runtime. 

You can also View mapping information (see "View mapping information (ICEE)" page 1555). This 

information lets you see which data is written to which location during the transfer. 

Standard server 

The ICEE CRM template is provided in the Connect server configurations to enable 

communication with ICEE. It must be customized and activated – see Create server from 

template. 

The Connect server creates, sends, and receives messages for the objects that are sent to or 

received by ICEE. 

Schemas 

Communication with ICEE is based on the schemas generated for this data exchange. The files 

are stored in the sysinfo\xsd\ COM-ICEE_CRM directory of the main Infor COM directory. 

ProcessCustomerPartyMaster.xsd (schema image 200601) 

Customer master 

ProcessItemMaster (schema image 200602) 

Item master (future use) 

ProcessPerson (schema image 200606) 

Employee master 

SyncContract (schema image 200509) 

Outline agreements 
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SyncInvoice (schema image 200502) 

Invoices, credit memos 

SyncQuote (schema image 200510) 

Quotes 

SyncSalesOrder (schema image 200501) 

Sales orders and order releases 

SyncShipment (schema image 200504) 

Goods issue 

ChangeObjectID (schema image 200701) 

Change of object IDs (only ICEE > Infor COM in special cases) 

ID assignment/procedure for external IDs 

In Infor COM, the object IDs are recorded in the partner system and referenced in the messages 

for the object. 

The same applies for ICEE link. 

Note: If a data record, such as a customer, for example, is entered in ICEE, Infor COM will 

attempt to transfer this object ID. If this is not possible, the data record is transferred with a new 

object ID. ICEE receives a corresponding message and then attempts to transfer the object ID 

from Infor COM. Once the change has been made successfully in ICEE, the special 

ChangeObjectID message is sent from ICEE to Infor COM. 

Initial data transfer 

Note: You access action sequences by selecting System functions > Developer > Action 

sequences. 

To carry out the initial transfer of data, you need to complete several steps: 

1. Messages are generated for metadata (for example, entries from an allocation table) using 

action sequence 1500002. This action sequence can also generate messages for master data. 

However, the progress bar is less indicative. We therefore recommend transferring master 

data using the Connect replication function, especially for databases containing a large 

number of data records. 
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Note: If you do not want to replicate master data via action sequence, deactivate the call 

to subsequence 1500003 before the action sequence is started. To do this, clear the 

Active check box on the Actions tab in the opened action sequence.  

2. Master data is transferred using the Connect replication function. This can be done in one of 

two ways: 

 Option 1: Action sequence 1.500.003. If you are not using the standard ^CRM^ server, you 

must customize the server ID in both of the 

Infor.Framework.Connect.Base.Message.Replication::IService.RunReplication calls using 

the ServerName = ^CRM ^ parameter before the action sequence is started. 

 Option 2: System functions > CONNECT > Outgoing messages > New 

At this point, the user needs to make sure that customer master data is replicated before 

employee data. 

3. The action sequence 1500004 (CRM: Transfer data set) is provided for the initial transfer of 

movement data. 

By initializing the vdStartDate and vdEndDate variables used in this action sequence, you can 

restrict the time period for the movement data to be transferred. This is done by sending the 

following objects. 

 Sales orders 

 Goods issues 

 Invoices 

 Order releases 

 Quotes 

 Credit memos 

 Outline agreements 

The initial data transfer is not asynchronous. In other words, messages are transferred directly 

from the Infor COM client that initiated message generation. It can take some time to generate 

messages depending on the volume of existing data. 

If the asynchronous generation of messages is activated, the objects are only assigned low priority 

in the To do list (page 1558). They are processed in batches if there are no entries with higher 

priority on the To do list. During this process, the system continuously checks whether entries with 

higher priority have been added in the meantime. 

Depending on the existing data, the initial transfer of data can take a while. 
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Customizations 

To customize message transfer in XML format, you must synchronize the two communicating 

systems. 

To transfer additional fields, complete the steps below: 

1. Check with ICEE as to where the field can be placed in the XML format. 

2. If a new element in XML format is agreed on, complete the steps below: 

 Update the schema. 

 To load the schema image, select System functions > Administration > Objects > XML 

schema images. Then select Functions > Update schema image with XSD schema. 

 Update the XML structure in the Connect object configuration by loading and saving the 

data format for the object. 

3. Define and save the mapping for the element in the Connect object configuration. 

4. Once you have made your changes, restart the batch server. 

Customer master 

The schema for transferring customers contains variable structures whose content is configured 

using allocation tables. 

VariousFields 

The content of this structure is configured using the BODCONFVARF allocation table and is 

transferred in full to ICEE. This allocation table can be updated for customizations: 

CustomerGroups 

This structure is populated using the BODCONFGRP allocation table. 

Please note: This allocation table must not be changed without consulting ICEE. 
 

Configure asynchronous message generation (ICEE) 

For general information on the ICEE link, see ICEE link (page 1551). 
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Asynchronous generation of messages means that a log record is written to the database at 

runtime in Infor COM during certain events (for example, when you save an object). A batch 

server, which runs separately in the background, generates the message. 

Setting up the batch server 

1. In the Management Console, create a batch server with ASYNCMSG as the action type. 

2. Similar to configuring the registered system, use the port configuration to enter available ports. 

3. Use startBatchServer.bat to start the batch server from the file system of the dist/bin 

subdirectory of the batch server that was created. 

Note: If you created a new batch server, it is a good idea to check the server.log file in the 

batch server's dist/log directory. When this log no longer contains any exceptions, the batch 

server has been started successfully. 

Activating asynchronous message generation 

1. Set the COMMON.CONNECT.ASYNCHRONOUSMESSAGECREATIONISACTIVE 

configuration parameter to yes. 

2. Start the batch server. 
 

View mapping information (ICEE) 

For general information on the ICEE link, see ICEE link (page 1551). 

You can generate the description of the current mapping from the system. To do this, select 

System functions > Developer > Action sequences, open action sequence 1400003, and click 

Start. This process generates a csv file for each object in the Infor 

COM\sysbox\Bod_Mapping\Com\ directory. This file indicates the elements that are populated in 

an XML file and how this is done. 

Structure of the f i le : 

<BOD> <xPath>  <Origin/Function> 
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Example:  

Sync.Quote <xPath>  <Origin/Function> 

Sync.Quote Quote/QuoteHeader/DocumentID/ID  Sales - Quote/mapping object --> Order ID 

[DbSatz.DbPart.ANr] 

Sync.Quote Quote Synchronize dependants using 

'Infor.Sales.Quote.Connect::ITools.synchronizeH

eaderDependingElements' 

Sync.Quote Quote/QuoteHeader/DocumentID@agencyRol

e 

fix 'Supplier' 

Sync.Quote Quote/QuoteHeader/DocumentID/ID@account

ingEntity 

provided by 

Infor.Framework.ESB::IService.getAccountingEn

tityID 

Sync.Quote Quote/QuoteHeader/DocumentReference/Purc

haseOrderReference 

filtered by 

Infor.Framework.Connect.Base.Tool::IToolBS.isF

ieldFilled 

Sync.Quotea Quote/QuoteHeader/Note@use BOD - Text references --> Text usage 

[UsageCode] translated to DATA.BODCODE 

using BODTEXTUSG 

Sync.Quote Quote/QuoteHeader/Status/Code  Sales - Quote/mapping object --> Stat. 

[DbSatz.DbPart.Zust] processed by 

Infor.Sales.Quote.Connect::ITools.getDocument

StatusCode 

Sync.Quote Quote/QuoteLine  Sales - Quote/mapping object values of all lines 

starting with line 2 ... 

 

The Origin/Function column contains different keywords: 

 <element> --> <caption of the VTab field> [<vtab field>]: <source> in the following refers to this 

structure. It indicates direct VTab access and should be read as follows: 

Field DbSatz.DbPart.ANr is read from container element Sales - Quote/mapping object. The 

caption of this field in the database is Order ID. 

 Synchronize dependants using <meth>: Another VTab is synchronized using Lj4 method 

<meth>. 

 fix <value>: The XML element is populated with constant <value>. 

 Provided by <meth>: The value of the XML element is calculated using Lj4 method <meth>. 

 filtered by <meth>: The XML element is generated only if Lj4 method <meth> returns True. 

 <source> translated to <dest> using <map>: The value of the <source> field is translated 

using the <map> allocation table. The <dest> field in the allocation table is used. 

 <source> processed by <meth>: The VTab field content from <source> is converted to the 

value to be set in the XML file using Lj4 method <meth>. 
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 <element> values of all lines starting with line 2 …: A loop of all rows of the VTab beginning 

with row 2 is run. "…" indicates that additional actions are possible, such as Synchronize….   
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Administration 

To do list 

The To do list for the asynchronous generation of messages contains information about objects for 

which messages are to be generated asynchronously, i.e. outside normal business processes, 

when specific events occur (when data is saved, for example). A batch server is responsible for 

actually generating the messages. Once entries have been processed successfully, they are 

deleted automatically. If an error occurs during message generation, the status of the record in this 

list is set to Locked and information about the error is provided. 

Note: If no errors occur, the report does not contain any messages. 

If records exist with the status Locked, you can use this combo box to set the status back to To be 

processed. The batch server will then process this entry again. 

Please note: If the status of the entry reverts back to Locked again, please contact Infor 

support. 
 

Monitor 

Call 

System functions > CONNECT > Administration > Monitor 

Description 

The monitor provides an overview of the location of the messages and their corresponding status. 

The incoming and outgoing messages for the different Connect servers and internal mail boxes 

are displayed as separate bars on a graph. 

When the monitor is started, an initial overview of the data for the To do list, incoming and 

outgoing Connect messages, and the communication directories for existing Connect servers is 

displayed with the File and Document communication type. 
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You can itemize the data here in two further steps by double-clicking the corresponding section of 

the chart for the internal database tables: 

 Double-click the desired bar to display a detailed valuation in the form of a pie chart below the 

bar graph. 

 Double-click the desired section of the pie chart to display another pie chart that shows 

detailed information on the section you selected. 

Functions 

Click the Update button to re-calculate the valuation currently displayed. 

Example 

1. In the upper graph, double-click the bar for outgoing messages to display a pie chart to the 

bottom left of the bar graph. The pie chart shows the number of messages and their status. 

2. Double-click the yellow area to display a second pie chart to the right of the first one. This pie 

chart shows the number of messages available and their status per object type. 
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Call 

System functions > Text system 

Description 

The text system can be used to enter and manage texts that can be printed in documents and 

reports. These texts store recurring phrases such as terms of delivery and payment, shipping 

types, etc. 

The texts are used, for example, by Reports when generating documents and reports. 

The Text ID, language flag and usage form the unique key of a text. 

Configuration 

In the configuration, you assign a text editor to all Infor COM forms that contain notes – see 

Configuration (Text system). 

In practice 

Text type (page 1561): Each text is assigned one of text types 0, 1, or 2. Texts with the same text 

ID always have the same text type. 

Reference texts: The forms in most applications display reference texts. A reference text can be 

determined in two ways. The COMMON.TSVERSION.SPRBETREFF parameter lets you control 

the option that is to be used. 

Create texts (page 1562) 

Creating texts with the same text ID and language: You can create texts that have the same text 

ID and language flag and only differ in usage. Note that the usages of such texts cannot overlap. 

Text system 
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Not permitted Permitted 

Text ID LBED-1 with language flag us both for 

Purchasing, Sales and for Master data, Sales 

usages 

Text ID LBED-1 with language flag us both for 

Purchasing, Sales and for Manufacturing control, 
master data usages 

 

 
 

Text type 

In general, you can enter any text regardless of its text type in every text field of the application. 

But not every application changes the reference counter for a text or lets you edit the text. 

Standard text (0) Standard texts are texts that are used frequently and sometimes by the 

most varied applications (such as master data, Purchasing, Sales). A 

typical example of a standard text is the shipping type. 

BOR- 

specific (1) 

Texts of this type may also be used in the most varied applications. But 

usually they occur in BORs and are mostly referenced by BORs only. 

Free format text (2) These texts are firmly linked to a program situation. 

Example: You entered a line in a sales order and a standard text is 

assigned to the item of this line. You change this "item text" for your 

specific order. 

To keep the standard text of the item intact in other orders, the modified 

text is assigned a new ID when you save it. It is automatically assigned the 

Free format text type, and its reference counter is set to 1 during saving. 

This links the text to the line. 

All (255) This text type includes all types described (0, 1, and 2). You cannot assign 

it to a specific text. It is only used when you open text maintenance and all 

text types are to be displayed for selection. 
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Texts 

Call 

System functions > Text system > Texts 

Description 

The text system (page 1560) can be used to enter and manage texts that can be printed in 

documents and reports. These entered texts store recurring phrases such as terms of delivery and 

payment, shipping types, etc. 

In each object, you can create or edit texts based on the following text types (see "Text type" page 

1561): 

Object Permitted text type 

Master data 0, 1, 2 

Company master 0, 1, 2 

BORs 1, 2 

Sales 2 

Purch. 2 

Manufacturing control 2 

Planning 2 

Allocation tables 0 

 

It does not matter what status a text has when you edit texts in text maintenance. You can change 

texts even if the reference counter (page 1567) is greater than 1 and you can delete texts even if 

they are used in other objects. 
 

Create texts 

You can create texts (see "Text system" page 1560) using Text system > Texts or in applications. 
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Examples of applications in which you can store texts: 

 Master data 

 Company master 

 BORs 

 Sales 

 Purch. 

 Manufacturing control 

 Planning 

 Allocation tables 
 

Reload texts 

For information on texts, see the Texts (page 1562) Help topic. 

You can reload texts from single text view and from the overview table. 

1. Select System functions > Text system > Texts and open the required text or texts. 

2. Select Data and Reload. 

Note: Unlike when you open records, when you reload records, they existing records are not 

closed. They remain visible in the overview table. The new records are inserted at the end of 

the table. 
 

Save texts 

You can use two menu commands to save texts. 

Data > Save: The reference counter (page 1567) is not changed on the text maintenance forms. If 

two users enter a new text with the same text ID, only one of them can save the text with this ID. 

Any other user that attempts to add a text to the database using the same key (text ID and 

language) is alerted by means of an error message and redirected to the Save as process, where 

they can assign new key values to the record (such as a new text ID). 
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Data > Save as: This dialog box allows you to copy existing texts or make changes to a record and 

save it as a a new text. Like when creating a new text (Create texts), you can specify default 

values as required: Text ID, Lang., Text type, and Usage. In the same ways as when creating new 

text, the system checks the validity of these values (to determine if a text already exists in the 

database, for example). When you use the Save as command, all of the data for the record 

including the full description is copied. The reference counter is calculated from the database. You 

can then continue to edit the text. 

Please note: Texts created or saved in an application (see Texts (page 1562)) are only saved 

when you save the associated application object, such as the quote. The reference counter (page 

1567) is also adjusted when you save. 
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Change texts 

The following instructions describe 

 how you can change the language or reference text from an application 

 how you can change a text's language flag 

 
 

Archived texts 

To view archived texts in System functions, open the Text system folder and select Archived texts. 

You can only view archived texts, whether you call them from an application (such as archived 

sales orders) or archived text maintenance. Editing is not permitted. 

If a text is referenced in an archived application object (such as an archived sales order) that for 

some reason or other was not archived, this text is displayed when you go from the archived 

application to the text system of current texts. 
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Parameter texts 

Call 

System functions > Text system > Parameter texts 

Description  

When printing documents via e-mail, you often need to insert the document contents into both the 

e-mail subject line and body. 

You can do this by means of parameter texts when printing documents via e-mail. 

A parameter text comprises three parts: 

ID, language version, and document assignment. 

Functions 

Check validity: A parameter record is valid when each individual language version is valid. This is 

ensured by the following prerequisites: 

 All function parameters can be populated with all interfaces stored. 

 There are no blank parameters. 

 The existing parameters pass the syntax check. 

Note: The validity check is always run when saving. 

 

Displaying where-used lists for parameter text: Open the parameter text, and select Functions > 

Where-used list. The User column specifies the type of usage, the Key values column contains 

information about the user. 

The users of the parameter texts are stored in the PARTEXTREFS allocation table. 
 

Create parameter text 

This Help topic describes how to create parameter texts. 
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1. Select System functions > Text system > Parameter texts. On the New tab, enter the required 

text ID and click Create. 

In the Parameter text overview, enter a search term if required. 

2. Select View > Parameter text. 

3. On the Text tab, enter the language for the first text and click Enter. 

The system assigns the text ID. 

4. Right-click the Ref. field and select Insert VTab parameter. 

5. In the Insert VTab parameter dialog box, select the name of the required view or relation and 

click the Field name column to display the field name. 

6. To select the required field name, select the row in the Field name column and click OK. 

Note: Entering AT parameters and function parameters is similar to entering VTab 

parameters. 

7. Go to the Document assignment tab, select the required document type and click Enter. 

8. Right-click the Interface field and in the shortcut menu select Select interface. 

9. In the Select interface dialog box, select the row with the required interface and click OK. 

10. Right-click the interface, which is now displayed, and to display the methods made available by 

the invoice select Display interface. 

11. Select Data > Save. 

Note the validity check when saving. 
 

Reference counter 

For information on texts, see the Texts (page 1562) Help topic. 

A reference counter is assigned to each text. The reference counter (RefCount) shows how often 

a text is currently used. However, the reference counter only counts the number of usages in 

objects where it can be changed. 

Example: The reference counter for a standard text (text type (page 1561) 0) only changes when 

this text is put into or removed from an item. It does not change when the standard text is inserted 

in a sales order. 

Meaning of the reference counter: 
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 RefCount = 0: The text is nowhere in use. 

 RefCount = 1: The text is used in one object (such as an item). 

and so on. 

The reference counter for a new text is not necessarily 0. But the user cannot influence the value 

of the reference counter. This value is obtained from the database. 

Background: The text system sees to it that all texts with the same text ID have the same 

reference counter. When a new text is created (see "Create texts" page 1562) (also using Save 

as), the system determines the maximum reference counter of records that have the same text ID 

as the text to be generated. If the database does not contain a record with that same ID, the 

reference counter of the new text is assigned the value 0. 

The reference counter may change when entries are made in an application that has change 

privileges. The rules of changing the reference counter are described in Table 2 in the Change 

texts Help topic. 

If you are in doubt about the reference counter, you can obtain a new value in an adjustment run. 

For more information about this process, see Recalculate reference counter for texts (page 1568). 
 

Recalculate reference counter for texts 

The process used for recalculating the reference counter allows you to adjust the reference 

counter (page 1567). 

Please note: For performance reasons, start this process only when no other client is working in 

the system. 

The runtime may be very long, especially for large data volumes in the object tables (such as 

relFb*). The number of texts selected also affects runtime considerably. We recommend that you 

start the process when you have enough time (for example, at the beginning of a weekend). 

It may happen that various processes do not process the reference counter correctly. As a result, 

an application may change a text illegally because the reference counter is low, or a text may be 

copied unnecessarily because the reference counter is high. 

This process lets you adjust the reference counter after identifying and troubleshooting such 

processing errors. 



Infor COM 7.5 User Guide | 1569 

 

System functions 

 

The process is also helpful when you have to determine the reference counters of transferred texts 

for the first time after transferring old data. 

Configuration 

The configuration must contain the COMMON.TSVERSION.TABLESTYPE0, 

COMMON.TSVERSION.TABLESTYPE1, and COMMON.TSVERSION.TABLESTYPE2 entries. 

The values of these entries must contain the names of each table (not view) that contains text 

fields and generates texts of the respective type (see Text type). For example, the 

COMMON.TSVERSION.TABLESTYPE0 entry contains all tables that generate standard texts. 

The table names must be separated by commas. 

If other tables in a system contain text fields (e.g. due to adjustments), you must include the table 

names in the respective entry. 

To recalculate the reference counter: 

Processing is staggered by text type (page 1561) (descending order). 

All texts for which text type = 2 are processed first. This involves checking all Type2 tables. A 

Type2 table is any table from which type 2 texts are generated (i.e. all tables listed in the 

COMMON.TSVERSION.TABLESTYPE2 entry in the configuration). The system searches in these 

Type2 tables for all text fields that contain the respective text ID. It automatically determines the 

text fields of a table from the binary views (relVwx). All text fields found with the respective text ID 

are counted and noted. 

All Type2 tables are counted sequentially. The number of text fields with the respective text ID 

found is added to any previously noted value. 

After all Type2 tables are processed, the system processes texts with text type=1 or text type=2. 

The texts of these types are counted in Type1 tables in a similar way to the counting of Type2 

tables. 

After processing all Type1 tables, the system processes all texts with text type=0 or text type=1, or 

text type=2 (i.e. all texts that match the entry in the dialog box) in the Type0 tables. 

After processing these tables, the reference counter thus determined is written back to the 

database, and the process ends. 
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Check archived texts 

The Check archived texts process in the Text system is an adjustment run for archived texts (page 

1565). 

Please note: For performance reasons, start this process only when no other client is working in 

the system. 

The runtime can be very long. We recommend starting the process when you have enough time 

(for example, at the beginning of a weekend). 

Until now,texts could be deleted from the current texts table when the application object (such as a 

sales order) was archived although this text was still used in another application object. As a 

result, this other application object was referencing a text that no longer existed. 

You can check all archived texts for usage by current application objects using the Check archived 

texts process. 

In addition, you can retrieve these texts to the table of current texts. The reference counter is also 

updated. 

Texts found during the check are logged in one or more text files (depending on the number of 

texts found). These text files are created in the user-specific subdirectory under the name Etxt<Sq. 

ID>.txt (Sq. ID is an ascending counter for text files that starts at 0). If the subdirectory already 

contains text files whose name starts with Etxt, a message informs you that these files will be 

deleted when you start the check. You can continue the check or cancel it as required. 

 



Infor COM 7.5 User Guide | 1571 

 

System functions 

 

This Help topic describes the interface between Infor COM and PRO.FILE. 

This interface allows you to exchange the following data: 

 Item masters (bidirectional) 

 Bills of material (from PRO.FILE to Infor COM) 

 Documents (bidirectional) 

PLM is an open XML-based interface. It lets you exchange data with PRO.FILE as well as with 

other PLM/PDM systems. This Help topic focuses on describing how to exchange data with 

PRO.FILE. 

The interface is implemented for the following systems: 

System Versions 

PRO.FILE 8.0, 8.1 

Infor COM Infor COM Release 6.3 SP3, Infor COM 

Release 7.x 

BizTalk Server 2004, 2006 

Note: PLM is pre-installed as of Infor COM 7.1. You are not required to install additional 

components. 
 

PLM basics 

Please refer also to the configuration of PLM. 

Data is exchanged between PRO.FILE and <Infor> on the basis of XML files. An XML file contains 

an action that corresponds to a database transaction. 

PLM 
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The following schema illustrates the transfer process. 

 

PRO.FILE and Microsoft BizTalk Server are installed and configured by ProCAD. Schematically, 

they are processed in Infor COM as follows: 

 

Import 

The import process consists of the following steps: 

1. The import process expects to find the XML files to be imported in the import directory. 

2. The XML file is imported and processed. The data is saved in the <infor> database. 

3. Once it has been processed, the XML file is moved from the import directory to the backup 

directory. 
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Export 

1. An action such as saving an item or archiving or displaying a document, for example, will 

generate an export request, which is saved in the relEAIExport database. 

2. For each new export request, the export process generates an XML file in the export directory. 

3. The XML file is copied to the backup directory. 
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Import/export 

For general information about PLM, see PLM basics (page 1571). 

To start the PLM import\export process, complete the following steps: 

1. Select System functions > PLM > Import/Export. 

Note: You need to select the Import and Export check boxes. 

2. Select the Start processing automatically check box. 

This ensures that the import and export processes are started automatically within the 

configured intervals. For more information, see the Help topic for the 

COMMON.EAI.IMPORTTIMEINTERVAL and COMMON.EAI.EXPORTTIMEINTERVA 

parameters. 

Note: Any errors that occur during the process are logged in mailbox 95. 
 

Import item master 

For general information about PLM, see PLM basics (page 1571). 

PRO.FILE determines when a specific item is transferred to Infor COM. As soon as an item from 

PRO.FILE is available in the import directory in XML file format, it is imported into Infor COM. 

Adding/changing an item 

The following fields are imported into Infor COM from PRO.FILE: 
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Title Field name XML name 

Resource AcSatz.DbPart.MNr Item 

PRO-FILE ID AcdSatz.RessPLM.NFT_IDNR PDMItemID 

Part description AcSatz.DbPart.KTxt Description 

Dimension AcXSatz.AddName1 Description2 

Standards AcSatz.AcPart.Norm Standard 

Basic material AcSatz.AcPart.Werkstoff BasicMaterial 

Unit AcSatz.DbPart.ME QuantityUnit 

Usage Purchasing: AcSatz.AcPart.RVerwend(1) = 1 

Manufacturing: AcSatz.AcPart.RVerwend(3) = 1 

Usage 

Purchase/Manufacturing 

Sales - Usage AcSatz.AcPart.RVerwend(2) UsageSales 

Creator AcSatz.VQLHeader.CreateUser CreateUser 

Creation date AcSatz.VQLHeader.CreateDate CreateDate 

Modified by AcSatz.VQLHeader.ModifyUser ModifyUser 

Modification date AcSatz.VQLHeader.ModifyDate ModifyDate 

 

 

Please note: There are no characteristics transferred. The Quick item search function is not 

supported. 
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Notes 

Extending the 

import 

The import process accepts any field name from the viwAcVt and viwAcX views 

as an XML name. This allows you to extend the import easily. 

Processing 

brackets in field 

names 

The field names in Infor COM can contain brackets. Brackets are not permitted 

in XML nodes. Instead of brackets, you must use minus signs in the XML files. 

Example: 

AcSatz.AcPart.MEConv(1).Basis is changed to 

AcSatz.AcPart.MEConv-1--.Basis in the XML file. 

Checking 

existing item IDs 

The item ID is checked when an item is imported into Infor COM for the first time. 

If an item in Infor COM has already been assigned this ID, a new item ID is 

generated in Infor COM and is used for the new item. The new item ID is also 

sent back to PRO.FILE where it is saved as the valid item ID. 

Saving fields in 

the database 

The fields to be imported are not saved directly in the Infor COM database 

because this could cause data inconsistencies. Instead, the routine for saving 

the item is called along with all checks. This means that it is possible for a 

request to import an item to be rejected by Infor COM. 

Storing the 

source of an 

item 

In the item master, the source of an item is stored in the 

AcdSatz.RessPLM.NFT_FLO1 field: 

0 - Infor 

1 - PRO.FILE, etc. 

An item that originates from PRO.FILE should not be deleted in Infor COM. 

Defining locked 

fields 

A list of locked fields can be defined for items that originate in PRO.FILE. These 

fields cannot be changed in Infor COM. For more information, see the Help topic 

for the COMMON.EAI.LCKFIELDMATERIALx parameters. 

Deleting an item 
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The import interface can also be used to delete items in Infor COM. In this case, the XML file does 

not contain the Save action as is the case with a normal import, instead it contains a Delete action. 

In Infor COM, the standard delete function is called including all checks. This also means that a 

request to delete an item can be rejected by Infor COM. 

Locking an item 

The import interface can also be used to lock items in Infor COM. In this case, the XML file 

contains the Lock action. 

AcSatz.DbPart.Auslaufteil=3 is set in Infor COM and the normal Save function is called 

including all checks. This also means that a request to lock an item can be rejected by Infor COM. 
 

Export item master 

For general information about PLM, see PLM basics (page 1571). 

Export item 

An item can be exported from the Infor COM item master either manually or automatically. 
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Manual export In Items, you can manually export the current item by selecting Functions > 

Export. 

Automatic export Items that also exist in PRO.FILE, i.e. items for which a PDM item ID 

(relAcD.RessPLM.NFT_IDNr) has been specified, are exported automatically 

once you save, provided at least one of the export fields has changed. 

Note:  You can use the COMMON.EAI.EXPPATTERNMATERIAL1 and 

COMMON.EAI.EXPPATTERNMATERIAL2 parameters in the configuration to 

specify the items that are also to be exported automatically.  

You can use the % symbol (for any string) and _ symbol (for any character) as 

wildcards here. 

Example: COMMON.EAI.EXPPATTERNMATERIAL1=AB100%, 

COMMON.EAI.EXPPATTERNMATERIAL2=%XCV% 

In this example, all items whose item ID begins with AB100 or whose item ID 

contains the string XCV are exported automatically. 

Export fields 

You can use the COMMON.EAI.EXPPATTERNMATERIAL1 and 

COMMON.EAI.EXPPATTERNMATERIAL2 parameters to specify the item fields that are to be 

exported to the XML file. You can select from any of the fields in the viwAcVt and viwAcX views. If 

there is no XML name specified, the Infor COM field name is used in the XML file. 

Syntax:  ExpFieldMATERIAL<i>=<infor field name>[,<XML field name>] 

Example: AcSatz.DbPart.KTxt,DESCRIPTION 

The following fields are exported by default: 
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COMMON.EAI Title Field name XML name 

EXPFIELDMATERIAL1 Resource AcSatz.DbPart.MNr ITEM 

EXPFIELDMATERIAL2 Desc. AcSatz.DbPart.KTxt DESCRIPTION 

EXPFIELDMATERIAL3 Desc. 2 AcXSatz.AddName1 DESCRIPTION2 

EXPFIELDMATERIAL4 DIN std. AcSatz.AcPart.Norm STANDARD 

EXPFIELDMATERIAL5 Basic material AcSatz.AcPart.Werkstoff BASICMATERIAL 

ExpFieldMATERIAL6 Unit of measure AcSatz.DbPart.ME QUANTITYUNIT 

EXPFIELDMATERIAL7 Purchasing - Usage AcSatz.AcPart.RVerwend(1) USAGE (Value = 

PURCHASE) 

EXPFIELDMATERIAL8 In-house manufacturing - 

Usage 

AcSatz.AcPart.RVerwend(3) USAGE (Value = 

MANUFACTURING) 

EXPFIELDMATERIAL9 Sales - Usage AcSatz.AcPart.RVerwend(2) UsageSales 

EXPFIELDMATERIAL10 Created by AcSatz.VQLHeader.CreateUser CreateUser 

EXPFIELDMATERIAL11 Creation date AcSatz.VQLHeader.CreateDate CreateDate 

 

Deleting an item 

If an item was exported to PRO.FILE (PDM item ID specified), and then deleted in Infor COM, an 

export request is generated automatically when the delete action is carried out. 

Locking an item 

If an item is exported to PRO.FILE and then locked in Infor COM (AcSatz.DbPart.Disc.item=3), an 

export request is generated automatically when a lock action is carried out. 
 

Import bill of materials 

For general information about PLM, see PLM basics (page 1571). 

Bill of materials are transferred from PRO.FILE to Infor COM in one direction only. 
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PRO.FILE determines when a specific bill of material is transferred to Infor COM. As soon as a bill 

of material from PRO.FILE is available in the import directory in XML file format, it is imported into 

Infor COM. 

The following fields are imported: 

Title Field name XML name 

Position # AbPart.CADPosNr PosNumber 

Quantity AbPart.DbPart.Te Quantity 

Unit AbPart.DbPart.ME QuantityUnit 

Article no. AbPart.DbPart.MNr Item 

PRO.FILE ID AcdSatz.RessPLM.NFT_IDNR PDMItemID 

Additional notes AbPart.DbPart.Bemerkung Comment 

IDNR AbPart.DbPart.extRNr LinkID 
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Notes 

Extending the import The import process accepts any field name from the viwAbVt view as an XML name. This 

allows you to extend the import easily. 

Processing brackets 

in field names 

The field names in Infor COM can contain brackets. Brackets are not permitted in XML 

nodes. Instead of brackets, you must use minus signs in the XML files. 

Example: 

AbPart.DbPart.UeKnz(1) is changed to AbPart.DbPart.UeKnz -1--  in the XML 

file. 

Transferring entire 

bills of materials 

When a bill of materials is either created or changed, the entire modular bill of materials is 

transferred from PRO.FILE, i.e. the bill of materials header (top item) and all of the lines 

that are contained in the bill of materials directly (first hierarchy level). For multi-level bills 

of material, the levels are transferred individually. 

Checking items All items must exist in Infor COM before the bill of materials is created. The check is only 

carried at single level only. If some of the items do not exist in Infor COM, the bill of 

materials is not imported. 

Synchronizing the 

bill of materials 

The synchronization process to determine whether it is a new bill of materials or whether 

lines have been changed or deleted takes place in Infor COM when the bill of materials is 

imported. 

Identifying bill of 

material lines 

The bill of material line is identified in Infor COM on the basis of the  

AbPart.DbPart.extRNr field. If AbPart.DbPart.extRNr is <> 0, it means that this 

bill of material line was imported from PRO.FILE. 

Specifying locked 

fields   

A list of locked fields can be defined for bill of material lines that originate in PRO.FILE. 

These fields cannot be changed in Infor COM. For more information, see the Help topic for 

the COMMON.EAI.LCKFIELDBOMx parameters. 

Extending bills of 

material 

Bills of material to be transferred can be extended to include new lines in Infor COM. 

These are not transferred back to PRO.FILE. If the bill of materials is imported from 

PRO.FILE again, these lines are retained.  

Changing 

 bill of material 

structures 

A bill of material line that originates from PRO.FILE should not be deleted in Infor COM. 

In PRO.FILE, you can add or delete new items within a level of the bill of materials. 
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Exchange documents 

For general information about PLM, see PLM basics (page 1571). 

Documents are transferred from and to Infor COM and PRO.FILE. 

A document consists of the following components: 

 Document file (DOC, PDF, TXT, etc.) 

 Metadata (additional details about the document including the document type, title, document 

ID, creation date, status, etc.) 

In Infor COM, documents are managed in the Document management object. 

 
 

Import documents 

For general information on transferring documents between Infor COM and PRO.FILE, see 

Exchange documents (page 1582). 

Just the metadata from the document is transferred from PRO.FILE  to Infor COM. The document 

file itself remains in PRO.FILE. 

A document can be transferred from PRO.FILE to Infor COM multiple times. The first time it is 

transferred, the document is created in Document management, each time it is transferred again, 

it is simply updated. 

PRO.FILE determines when a specific document is transferred to Infor COM. As soon as a 

document from PRO.FILE is created in the Import directory in XML file format, it is imported into 

Infor COM. 

Overview 

Insert and change documents (page 1583) 

Document version control (page 1584) 

Delete documents (page 1585) 

Document links (page 1585) 
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Add/change a document 

The following fields are imported into Infor COM from PRO.FILE: 

Title Field name XML name 

Document No. DOKUFREMD, DocFix.DO_IDNR PDMDocumentID 

INFORDocKey ARCHIVNR DocKey 

Version key ARCHIVVER VersKey 

Description DOKTITEL Description 

Document type DOKTYP, PLMExt.DO_TYPE DocumentType 

Representation PLMExt.DO_DESIGNTYPE, DOKUATTR2 DesignType 

Created by DocFix.DO_CUSER CreateUser 

Creation date ERSTDT, DocFix.DO_CDATE CreateDate 

Source system PLMExt.DO_SOURCESYSTEM, DOKUATTR4 SourceSystem 

CAD type PLMExt.DO_CADTYPE, DOKUATTR6 CADType 

Extension DocFix.DO_EXT Extension 

File size DocFix.DO_FSIZE FileSize 

Version DocFix.DO_VERSION Version key 

Revision DocFix.DO_REVISION Revision 

Workflow status DOKSTATUS, 

PLMExt.DO_WORKFLOWSTATE, DOKUATTR8 

WorkflowState 

Drawing number PLM.DrwNo DrawingNumber 

Sheet DocVar.DV_VFLO1 SheetNumber 

From sheet DocVar.DV_VFLO2 NumberSheets 

Scale DocVar.DV_VSTL31 Scale 

Sheet format DocVar.DV_VSTL32 SheetFormat 

Creator original DocVar.DV_VSTL33 CreateUserOriginal 

Creation date original DocVar.DV_VFLO3 CreateDateOriginal 
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Notes: 

Extending the import The import process also accepts any field name from the relABDOKDATEN view as an 

XML name. This allows you to extend the import easily. 

Manually deleting 

documents 

In Infor COM, it is not possible to manually delete a document that has been 

transferred to Infor COM. 

Defining locked fields A list of locked fields can be defined for documents that originate in PRO.FILE. These 

fields cannot be changed in Infor COM. For more information, see the Help topic for the 

COMMON.EAI.LCKFIELDDOCUMENTx parameters. 

 
 

Version control 

In Infor COM, it is not possible to enter multiple versions of the same document. 

Document versions are managed in PRO.FILE only. The latest version of the document is always 

transferred to Infor COM from PRO.FILE.  

The DocId field (Document identification) is changed in PRO.FILE with every document version. 

For this reason, a new DocKey field was created in PRO.FILE , which remains the same in all 

versions. The DocKey field corresponds to the DocId of the first version of the document from 

PRO.FILE. 

DocId is saved in the DOKUFREMD field in Infor COM for information purposes only. 

DocKey is saved in the ARCHIVNR field in Infor COM and is used for identifying the document. 

The version ID in PRO.FILE consists of the following two fields: Version and Revision. These two 

fields (Version, Revision) are both merged as VersKey and transferred to Infor COM where they 

are saved in the ARCHIVVER field. 

When a document is called from PRO.FILE, the ARCHIVNR (DocKey) and ARCHIVVER 

(VersKey) fields are transferred to PRO.FILE. PRO.FILE can uniquely identify the document on 

the basis of these fields. 
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Delete documents 

It's also possible to use the import interface to delete documents in Infor COM, provided they have 

been imported from PRO.FILE beforehand. 

In this case, the XML file does not contain the Save action as is the case with a normal import, it 

contains the Delete action instead. 
 

Link documents 

In the Document management object in Infor COM, documents can be linked to various objects 

such as items, customers, suppliers, sales orders, advance shipping notices, invoices, purchase 

orders, production orders, etc. 

The item-document links are transferred from PRO.FILE to Infor COM. 

The version ID details are also transferred to Infor COM where they are saved. 

The import interface can also be used to change or delete links. 

You can choose from the following: 

 Creating a new link 

 Change the version ID in the existing link 

 Delete a link 

In Infor COM, you can manually create new links for any object, or delete existing links. The 

system does not check whether or not the link was imported from PRO.FILE. 

For each connection, you can specify whether the current document version is to be used. In this 

case, the version ID in the link is also changed automatically each time a document from 

PRO.FILE is updated. This setting is particularly relevant for links with master data (items, 

customers, suppliers). For movement data, the version ID in the link should never be changed.  

Change version ID 

For documents from PRO.FILE, it's possible to manually change the version ID in the link: 

1. Select System functions > Document management 

2. Select Functions > Archive > Change version ID in the link. 

A form is displayed with all versions of the document from PRO.FILE. 

3. Select the required version. 
 



1586 | Infor COM 7.5 User Guide 

 

System functions 

 

Export documents 

Overview 

Archive documents (page 1586) 

Archive documents when printing (page 1587) 

Display/print archived documents (page 1588) 
 

Archive documents 

Documents created in Infor COM can be transferred to PRO.FILE on a one-off basis. During this 

process, both the metadata and document file is exported from Infor COM and archived in 

PRO.FILE. 

The export fields are defined in the configuration using the 

COMMON.EAI.EXPFIELDDOCUMENTx parameters. You can select any field from the 

relABDOKDATEN view. If there is no XML name specified, the Infor COM field name is used in the 

XML file. 

Syntax: ExpFieldDOCUMENT1<i>=<infor field name>[,<XML field name>] 

Example: DOKTITEL,Description 

In the standard version, the following fields are exported: 

Configuration Title Field name XML name 

ExpFieldDOCUMENT1 Document ID DOKUNR InforDocID 

ExpFieldDOCUMENT2 Title DOKTITEL Description 

ExpFieldDOCUMENT3 Created by VQLHeader.CreateUser CreateUser 

ExpFieldDOCUMENT4 Creation date ERSTDT CreateDate 

ExpFieldDOCUMENT5 Source system PLMExt.DO_SOURCESYSTEM SourceSystem 

ExpFieldDOCUMENT6 Storage location ABLORT Path 

ExpFieldDOCUMENT7 Doc. type DOKTYP DocumentType 
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During archiving, the document file is copied to the directory specified in the 

COMMON.EAI.PATHEXPDOCFILE parameter in the configuration. It is then retrieved from this 

directory by PRO.FILE and archived. 

After archiving: 

 The content of the Storage location (path and filename on hard drive) is deleted in Infor COM. 

This means that the document is no longer linked to the original document file. (The file itself is 

not deleted.) 

 PRO.FILE returns the ID of the document (PFDocumentID, DocKey, and VersKey), which is 

saved in the Infor COM document (DOKUFREMD, ARCHIVIS, ARCHIVVER).  

Notes: 

 You cannot manually delete an archived document in Infor COM. 

 The links are not transferred to PRO.FILE. 
 

Archive documents when printing 

When printing certain documents in Infor COM, these documents can be archived. The process is 

as follows: 

 The document is saved as a PDF file. The path is specified using the 

COMMON.DOCUMENT.DOCUMENTOUTPATH parameter. 

 A new document is created in Document management and is linked to the relevant object 

(sales order, advance shipping notice, invoice, etc.). 

This new document is then archived in PRO.FILE. 

The document is created using the DOKPDFPAR allocation table. This allocation table stores the 

names of all documents that can be archived. You can define the following for each document 

name: 

 Document type 

 Title: The title can also contain wildcards for the document ID. 

Example: Purchase order [DbSatz.AcpPart.BelegNrBest] 

In the example, the title of the document that was created would be Purchase order EB0100. 
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 Field transfer: You can use this field to define the fields that are to be transferred from the 

document to the new document: <FieldName><NewDocument>-<FieldName><Document>; 

<FieldName><NewDocument>-<FieldName><Document>, etc. 

Instead of <FieldName><Document>, you can also specify a VQL statement. 

Example: The first and second name of the employee can be transferred as follows: 

DocVar.DV_VSTL15-SELECT :FieldValue = Concat(p.Name,Concat(' ',p.Vorname))  

FROM relPerson p, relAdresse a  

BY viwEinkauf 

WHERE a.PersonNr = p.PersonNr AND a.AdresseNr = :DbSatz.DbPart.Sachbearbeiter 

It is also possible to use stored VQL statements. 

Example:DocVar.DV_VSTL15-:qDMSysGetSachbearbeiter 

The VQL statement must always begin with SELECT :FieldValue. 
 

Display/print archived documents 

To display the archived documents from Infor COM, Infor COM sends a request to PRO.FILE. 

PRO.FILE then provides Infor COM with either an http link or a copy of the file (see the Help topic 

for the DocOpenAction parameter). The file or link is then displayed by Infor COM. 

The same applies when printing an archived document. In this case, PRO.FILE always provides a 

copy of the file, which is then printed in Infor COM. 
 

Field format for Infor COM exports 

Each of the fields defined in the configuration via the COMMON.EAI.EXPFIELD% parameter can 

be manipulated for the export using an Lj4 function. In the configuration, this function is prefixed to 

the name of the Infor COM database. 

The following example, which is based on the creation date of an item, should help illustrate this:  

EXPFIELDMATERIAL11=@GlbCnv.al_cnvDateYYYYMMDD@AcSatz.VQLHeader.CreateDate,CREATE

DATE  

In this example, AcSatz.VQLHeader.CreateDate is the database link for the creation date, whereas 

@GlbCnv.al_cnvDateYYYYMMDD@ refers to the name of the conversion routine. 

The name of the function can be freely selected, however it must comply with the following syntax:  

Lj4Def Function <Name>(ByVal pValue As tString) As tString 

In the conversion routine, it is not possible (permitted) to access (read or write access) the various 

data prepared for export. 
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Infor COM - Date value export: GlbCnv.al_cnvDateYYYYMMDD 

When transferring data fields, PROCAD currently expects the YYYYMMHH date format. 

However, the standard format that is provided by Infor COM (depending on the local Windows™ 

settings) in BizTalk must be adapted to this format. The GlbCnv.al_cnvDateYYYYMMDD routine was 

therefore implemented here and used in the configuration for the (relevant) data fields. 

Infor COM - Unit of measure export: GlbCnv.al_NormalizeQU 

When selecting the data, the same units of measure should exist in both systems. The notation 

should also be identical, especially in relation to case sensitivity. In Infor COM, the MEBasis 

allocation table is maintained for this purpose. In PRO.FILE, a corresponding reference table must 

be manually maintained in parallel. To ensure that jointly maintained units of measure are 

identical, also in terms of case sensitivity, the GlbCnv.al_NormalizeQU function has been 

implemented in Infor COM along with the unit of measure fields for the export configuration. 
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Action sequences 

Call 

Systemfunktionen > Developer > Action sequences 

Description 

Note: The main target groups for using this function are developers, consultants, customizers, 

and support personnel. 

The generation of demo data on a large scale using the interface-controlled processes in Infor 

COM can often be very time-consuming, and for many modules it requires specific knowledge of 

application-specific dependencies. Special tools for consistency checks and repair tools for 

application data are also required. 

To ensure user-friendly generation of demo data and mass data, as well as user-friendly running 

of scripts, interfaces are run using action sequences. It must be possible to populate, and continue 

to use, the parameters and function results of the interface methods using manually predefinable 

values. 

A range of actions can be stored for every action sequence ID. Each of these actions can, in turn, 

be populated with parameters. 

Configuration 

The action sequence is configured in the Action sequence form section. 

Functions 

Validity check: The following restrictions are verified during the validity check:  

 For every If there must be an End If. 

Developer 



Infor COM 7.5 User Guide | 1591 

 

System functions 

 

 For every Else there must be both an If and End If. 

 Variable declarations must be at the start of the action list. 

 Variable declarations must contain a data type and a reference name. 

 A method name must be specified for every method call. 

 Every referenced variable must be declared. 

Recalculate hierarchy: This function allows you to recalculate hierarchy levels at any time.  

Verify method prototypes: This function performs the following checks and returns the incorrect 

actions with a description of the error: 

 Does the repository actually contain all of the specified methods? 

 Have prototypes of used methods changed in the meantime? 

Export: Use this process to save an action sequence. Exported data can be transferred or linked to 

a version management tool. 

Exported data can be imported again by selecting System functions > Administration > 

Load/unload. 

Start: Click the Start button to start an action sequence. Once started, progress is indicated by a 

progress bar. The Results dialog box is then displayed. The results shown in this dialog box can 

be exported. 

In practice 

From the user's perspective, action sequences are mainly used to initially transfer certain data to 

third-party systems. To make it easier to find the required action sequence, action sequences are 

assigned a classification. This classification can also be used to load action sequences. In the 

standard version, predefined classifications are included in the ACTSEQCLASS allocation table. 

This means that they can be assigned a translatable description. 

Note: For customized versions, alternative classifications can be entered directly in the action 

sequence. There is no translation available for these. 
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This Help topic describes the Connect Online add-on module to Infor COM. This add-on module 

must be purchased and set up separately. 

Connect Online acquires cross-company item account data from several Infor COM systems and 

presents this data in an overview. The data is determined and displayed in real time, that is, 

directly following the request. If all of the data cannot be determined within an appropriate time 

period, the user is informed of the system in which no information is currently available. 

The Connect Online installation can only be used in conjunction with Connect, as it is only with 

Connect that the necessary uniformity of the master data in the systems involved can be achieved. 

Connect must be enabled in the configuration so that all functions can be used. 
 

Connect Online 
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In System functions > CONNECT > Communication partners, specify the linked server via which 

item account data is to be sent as messages. 

Server 

Item account data can be sent via a linked server created in Server configurations. 

The server must have the JMS adapter communication type. 

Object type 

You create a communication partner with the object type Planning - Item account on the Outgoing 

tab. 

On the Outgoing tab, as the Recipient, enter the company ID of the system to which the item 

account data is to be sent. The server name assigns it a physical target. As the Sender, enter the 

company ID under which the receiving system recognizes this system. 

The system from which the item account data is to be retrieved only sends the data if a 

corresponding communication server entry is created on the Incoming tab. Otherwise, an error 

message with the name of the requesting system is displayed. 

In the system where the cross-company item account data is combined, the other systems must 

be entered on the Incoming tab and in the configuration. 
 

Create communication partners 

(Connect Online) 
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To display the item account data, complete the following steps: 

1. Load the Item account for an item. In the Item account, select the Plant overview function. 

2. The Select plant section in the Plant overview form provides a list of the Infor COM systems for 

which it is possible to display the item account data. Select the Selection field for the system 

whose data you want to view. You can also select more than one field. Then click Load. The 

data that is transferred is displayed in a table in the lower section of the Plant overview form. 

For additional information on the display, see Plant overview. 

3. If you want to display data from additional systems, select these also in the Selection field. 

Then click Load or Update. For further information, see Plant overview. 

4. If you want to transfer inventory from one plant to another, select the Create purchase order 

button to send a purchase order to the other plant. When doing so, place the cursor in the row 

with the record type IR of the required partner system. The Create purchase order dialog box 

opens whereby the supplier and the item are already entered. Enter the required quantity and 

the appropriate unit of measure. 

Notes on querying the data 

The data is based on the item currently loaded in the item account. The data is queried 

synchronously, that is, the system waits for a response from a partner system. The query 

can be canceled after each response received. 

If inventory is to be transferred from one plant to another, you can use the Create 

purchase order button to send a PO to the other plant. 

 

Display item account data (Connect 

Online) 
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The Help topics for FinanceLink describe how to transfer data from Infor COM to a financial 

accounting system of your choice. 

The documentation details are based on the financial accounting system that you are using. For 

more information, see Configuration (FinanceLink). 

Documentation is currently available for the following financial accounting systems: 

 

FinanceLink 
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For general information on FinanceLink, see FinanceLink (page 1595). 

The following Help topic describes how to transfer data from Infor COM to Infor Finance. 
 

Set up Infor Finance 

For general information on the transfer of data in Infor Finance, see Infor Finance data transfer 

(see "Infor Finance data transfers" page 1596). 

To transfer data to Infor Finance, the relevant configuration settings must be defined at a number 

of levels. The following overview shows where and how you define these settings. 

File system 1 

The following files must be included in the 

..\InforCOM\InforCE\dist\client\lib\finance\components directory of your Infor COM 

system: 

 In4FinanceConnect.jar 

 in4FinanceLink.jar 

 in4FinanceOnline.jar 

 

Note: These files are shipped with Infor COM. 

Please note: Make sure that there are no backup copies of the *.jar files stored in the Infor COM 

directory or any of its subdirectories as all data will be loaded. 

Infor Finance data transfers 
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File system 2 

The VIS.CFG and VISCLIENT.DLL files must be copied directly from the ..\VIS\VISCLIENT 

directory of the Infor Finance server installation on your system to the Infor COM root directory. 

Infor Finance is the master system for these files. 

These files must be copied again each time Infor Finance has been updated. 

Please note: Before you copy these files, the port and IP address of the server on which the 

VISDaemon is permanently running must be entered in the VIS.CFG file.  

You can also configure the log settings (see "View Infor Finance logs" page 1631) in this file. 

Configuration 1 

In the COMMON.FIBU section of the configuration, set the following parameters: 

COMMON.FIBU.TARGETSYSTEM=InforFinance 

COMMON.FIBU.TRANSFERTORELVALFLPOSTING=yes 

COMMON.FIBU.ONLINEPERSACC=yes 

COMMON.FIBU.ONLINE.BUSINESSPARTNER=yes 

COMMON.FIBU.ONLINEWE=EUR 

COMMON.FIBU.COSTUNITS=yes 

COMMON.FIBU.COSTUNITS._2_=yes 

COMMON.FIBU.CREDITLIMITMASTER=no 

Configuration 2 

In the COMMON.INFORFINANCE section, set the following parameters: 
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COMMON.INFORFINANCE.USER=GUIDE 

COMMON.INFORFINANCE.PASSWORD=GUIDE 

COMMON.INFORFINANCE.MANDATOR=1 

COMMON.INFORFINANCE.COMPANY=990 

COMMON.INFORFINANCE.LANGUAGE=de 

COMMON.INFORFINANCE.CONVERSIONRATE=AVERAGE 

COMMON.INFORFINANCE.ANZAHLUNGEN=yes 

COMMON.INFORFINANCE.ANZAHLUNGEN._2_=yes 

COMMON.INFORFINANCE.ANZAHLUNGEN._3_=yes 
 

Infor Finance interface 

For general information on the transfer of data in Infor Finance, see Infor Finance data transfer 

(see "Infor Finance data transfers" page 1596). 

Communication with Infor Finance is based on the Varial integration server (VIS). This software 

provides interface services that have been defined by Varial. 

Note: The latest interface description is provided by Varial on each Infor Finance CD. For a 

definition of each field, please refer to this documentation. 

VIS consists of two components: a communication daemon and a communication server. 

Communication daemon (VISDaemon) 

The VISdaemon.exe forms the basis for the active VIS. It cannot be set up as a service. 

At runtime, VISdaemon waits for connection requests from applications for the configured port. As 

soon as one of these connection requests is received, it generates a VISserver process on 

another port, based on the port range defined in the VIS.CFG file. VISdaemon passes this port on 

to the requesting application and then returns to wait mode. 

Note: It is not possible to set up the VISdaemon.exe file as a service. 
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Communication server (VISServer) 

Once VISdaemon has started a VISserver process, this process will display as a running process 

in Task Manager. As a rule, it will remain displayed for as long as the calling application (Infor 

COM) is open. If this application is closed, VISserver will end also. 

If you do not want the VISServer.exe to be running for the entire duration that the calling 

application is running, you can use the Serveridletime parameter in the VIS.CFG file to specify the 

number of seconds for which the process can be idle before it will end automatically without having 

to wait for the calling application. The additional time required by the VISserver process in order to 

restart should be taken into account here also. 

Note: The interface documentation is contained on a CD accompanying the Infor Finance 

release. All of the documentation relating to the fields is available on this CD. 
 

Use Infor Finance interface 

The Varial integration server (see "Infor Finance interface" page 1598) (VIS) is shipped and 

installed with Infor Finance. 

Note: The VIS subfolder in the Infor Finance directory on the server contains all of the files you 

need in order to use VIS. 

1. In the VIS.CFG configuration file, enter the IP address of the server that VIS will run on, and 

specify an available port. 

2. Copy this modified VIS.CFG file and the VISCLIENT.DLL file from the VISCLIENT subfolder to 

the Infor COM root directory. Overwrite any existing files in this folder. 

Note: Infor Finance is always the master system for these files. 

Please note: Do not copy the VIS directory from Infor Finance to any another server, or run 

VIS on a different server from the one on which Infor Finance is installed. Because the copied 

folder is not updated automatically, and would need to be updated manually, this would 

increase the manual work involved with each Infor Finance update. 

3. Start VISDAEMON.EXE in the VIS directory. 

Note: VISDAEMON.EXE cannot be configured as a service. To activate VIS, you need to 

start this program. 
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Configure Infor Finance tax code 

Tax IDs are maintained in the TAXRATES allocation table in Infor COM. This allocation table 

allows you to configure the Infor Finance tax code that is transferred to Infor Finance with each 

invoice transfer. 

1. Select System functions > Administration > Allocation tables, then open the TAXRATES 

allocation table. 

2. Select the FINANCE-specific settings tab. 

3. In the VARIAL column, enter the Infor Finance tax ID for each tax type. 
 

Transfer Infor Finance data 

For general information on the transfer of data in Infor Finance, see Infor Finance data transfer 

(see "Infor Finance data transfers" page 1596). 

To transfer data between Infor COM and Infor Finance, select Finance > Transfers > Data 

transfer. 

Use the dialog box to define the master data and/or movement data that you want to transfer. 

For more information, see the context-sensitive Help. 
 

Transfer Infor Finance master data 

For general information on the transfer of data in Infor Finance, see Infor Finance data transfer 

(see "Infor Finance data transfers" page 1596). 

You can transfer master data for the following: 

Business partner (see "Transfer Infor Finance business partners" page 1601) 

Cost centers (see "Transfer Infor Finance cost centers" page 1607) 

Cost units (see "Transfer Infor Finance cost units" page 1610) 
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Currency rates (see "Transfer Infor Finance currency rates" page 1608) 

General ledger accounts (see "Transfer Infor Finance general ledger accounts" page 1613) 

Please note: Once you have selected the data that you want to transfer and clicked Start to 

confirm the selection dialog box, the data that is transferred on the basis of the selected settings is 

saved in the Infor Finance database. It is not possible to carry out any checks or changes to the 

transfer in Infor Finance. 
 

Transfer Infor Finance business partners 

Business partners are always transferred from Infor COM to Infor Finance. 

Examples of business partners to be transferred would be customers and suppliers from Infor 

COM. To transfer business partners to Infor Finance, select the Business partner check box in the 

Selection form section of the Data transfer dialog box, then select the data that you want to 

transfer in the Business partner form section. If a specific business partner was selected, then only 

this business partner can be transferred explicitly. 

Technical note: The status of the company account is saved in the relfinacacctstate table. 

For more information, see the context-sensitive Help. 

The address extracted from Infor COM for the transfer is taken from the Linked address field on 

the Company account tab for the business partner. If this field was not assigned a default value 

when created, the bill-to address from the Customer documents or Supplier documents tabs is 

used for the transfer and written to the Linked address tab. The Linked address field allows you to 

provide the financial accounting system with a different address from the bill-to address. 

For more detailed information about how VIS Service SPERS176 fields are populated, refer to the 

Varial Integrationsserver – Serviceprogramme für Finanzwesen document. (Varial Integration 

server – Service programs for financial accounting). The following table lists the relevant fields for 

the link with Infor COM. 
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ID Field description Length Type Description Infor COM field + condition 

1 Perskto_SA 1 num 
1 = Accounts receivable 

2 = Accounts payable 

Accounts receivable: 

RelFirma.Verwendung1=1; Accounts 

payable: RelFirma.Verwendung1=2 

2 Perskto_NR 8 num Account ID relacp.InlKto 

3 Beleg_NR 11 num 

0 for company-wide 

addresses and addresses 

for regular accounts  

000000000 

4 Unter_Beleg 3 num Zero Zero 

12 Name_1 40 alph Name 1 relFirma.Name 1.Zeile 

13 Name_2 40 alph Name 2 relFirma.Name 2.Zeile 

14 
Abteilung_Empfaenge

r 
40 alph Name 3, department, etc.  

15 PLZ_Postfach 10 alph Post code for PO box relAnsch.PLZPostfach 

16 PO box 10 alph Postfachnummer relAnsch.Postfach 

17 Street 40 alph Street relAnsch.Strasse 

18 Post code 10 alph 
Post code for street 

address 
relAnsch.PLZOrt 

19 Ort_1 40 alph Town/city name 1 relAnsch.Ort 

22 Staaten_KZ 3 alph 
Country flag, e.g. D for 

Germany 
relAnsch.Staat 

23 Laender_KZ 3 alph Region/state flag 

relAnsch.LandKng. LANDTAB 

allocation table must match country 

definitions in IF 

24 Sprachen_SZ 2 num 

0-99 for foreign-language 

reminders/balance 

statements 

relfirma. SprachKnz from SPRACHE 

allocation table, KnzVarial field 

25 Currency ID 3 num 

0=Base currency, 

1-999=Default foreign 

currency setting 

relAcp.AcpPart.WE from 

FREMDWEUR allocation table, 

Data.NumKey field 

26 Short Address 20 alph 

20 characters, e.g. 10 for 

street name 1, 1 blank 

space, 9 for town/city street 

1 

10-character relFirma.Name field, 1 

blank space, 9 characters for 

relAnsch.Ort 

29 Phone number 1 20 alph  
relKomArt.Nummer if 

relKomm.KomArt=1 
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ID Field description Length Type Description Infor COM field + condition 

30 Telex number 20 alph   

31 Fax number 20 alph  
relKomArt.Nummer if 

relKomm.KomArt=2 

35 USt_ID_Nummer  Alph EU-VAT Registration No. relFirma.UstIdNr 

38 BBN_BBS_Nummer 13 Num European company ID relFirma.EAN when creating only 

39 Auswert_Kz 5 Alph Individual ID  

40 Credit limit 11 Num 
Full amount (agreed credit 

limit) 

relFinAcAcctState.CreditLimit only 

when creating and if 

CreditLimitMaster=yes 

47 Kundengruppe_Mah  num 
0-99 = Customer group for 

reminder 
Only set to 01 when creating  

48 Mahnung_FAX_SZ 2 num 
1 = Print, 2 = Fax, 3 = Print 

+ fax 
Only set to 1 when creating 

49 Mahnung_Art 1 num 

0 = No reminder 

1 = Reminder with 

outstanding items 

2 = With outstanding item 

history 

3 = As balance statement 

Only set to 1 when creating 

57 Zahlungs_SZ 2 num 

00 = Without payment 

transaction  

Accounts receivable: 

01 = By direct debit 

02 = By debit transfer 

03 = Internal group offset 

Accounts payable: 

01 = By check 

03 = By bank transfer 

04 = By bank transfer or 

check 

07 = Foreign payment 

transaction 

Only when creating: 

Accounts payable=00 

Accounts receivable=04 

65 Bank1_Land 3 alph Bank country 
004=Germany, 038=Austria (value 

provided by German Bundesbank) 

66 Bank1_Leitzahl 8 num Bank details Relfirma.BLZ 
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ID Field description Length Type Description Infor COM field + condition 

67 Bank1_Bankkonto_Nr 11 num 

For bank details 1, the bank 

routing ID and bank 

account number must be 

entered in numeric format 

with leading zeros. 

relFirma.KTO 

68 Bank1_Name 40 alph Bank name relFirma.Bank 

73 Bank3_Land 3 alph 

Bank country, Bank details 

3 for all international banks 

- For accounts payable only 

Country code based on German 

Bundesbank (004 Germany, 038 

Austria, 039 Switzerland) 

74 Bank3_Typ 10 alph Bank type  

75 Bank3_Leitzahl 15 alph Bank details 

If Switzerland or domestic, then 

relFirma.blz; if domestic bank and not 

Switzerland, then relFirma.bic, if 

populated; otherwise relFirma.blz 

76 Bank3_Bankkonto_Nr 25 alph  
If (Switzerland or domestic) or 

international, then Relfirma.kto 

77 Bank3_Name1 40 alph 

Bank address for 

international bank details 

(max 35 characters for 

SWIFT) 

For international banks, 

relFirma.Bank 

78 Bank3_Name2 40 alph   

79 Bank3_Strasse 40 alph   

80 Bank3_Ort 40 alph   

83 Matchcode 15 Alph 

Matchcode/address ID (in 

conjunction with 

Anschriftsverb_Art field) 

relFirma.Suchbegriff 

99 Anschriftsverb_Art 1 alph 

1 = The address is saved 

on an account-specific 

basis 

1 

100 Account Type 1 num 

0 = Regular account 

without outstanding items 

1 = Regular account with 

outstanding items 

2 = Various accounts with 

outstanding items, separate 

addresses managed for 

outstanding items 

3 = One-off 

1 
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ID Field description Length Type Description Infor COM field + condition 

customer/supplier with 

outstanding items 
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ID Field description Length Type Description Infor COM field + condition 

101 Unter_OP 1 num 

0 = Without 

1 = With outstanding item 

history 

1 

102 OP_Verw_Konto 1 num 0 1 

103 Ford_Verbildl_SZ 1 num 

0-9 as per account from 

daily account table – for 

default setting only) 

0=Domestic 

1=EU 2= International 

Type determined by summary 

account (AcpPart.EUKto) in 

SACHKONTEN allocation table 

AR/AP localization: Type determined 

by USVARIAL allocation table 

104 Sachkonto_F_V_SA 1 num Record type 0 0 

105 Sachkonto_F_V_NR 8 num 

0 or AP/AR account 

number, default posting 

setting 

relAcp.euKto (summary account) 

106 Steuersatznummer 3 num 

0 = No default setting 

1-998: Standard tax rate for 

accounts 

receivable/accounts 

payable 

0 if creating, otherwise * 

107 Zahl_kond_Nummer 3 num 

0 = No default setting 

1-998 based on our 

payment terms allocation 

table, 999=Individual term 

for associated accounts 

relAcp.AcpPart.ZBed 

112 Kontonummer_Extern 15 Alph 
Account ID for 

customers/suppliers 
relFirma.FremdNr 

119 Vertrieb_Eink_Nr 15 Alph ID for Sales/Purchasing 

relAcp.AcpPart.Vertreter1 

If Representative/employee check 

box is selected. Representative must 

be created with same ID in <if>.   

 

146 Betrag_EW_EURO 1 Alph 

Blank space or N: 

All amounts (credit limit, 

balance, sales, etc.) are 

not transferred or 

If DefaultWE=EUR, then Yes; 

otherwise No 
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ID Field description Length Type Description Infor COM field + condition 

displayed in euro, as 

they are base currency 

amounts. 

Yes: All base currency 

amounts are 

transferred and 

displayed in euro.  

152 IBAN-Nummer 35 alph International bank ID relFirma.Iban 

156 Email 40 alph Email 
relKomArt.Nummer if 

relKomm.KomArt=4 

157 Sz Refefax 1 num 

For printing reference 

letters; 1=Letter, 2=Fax, 3= 

Letter and fax 

Only set to 1 when creating 

158 Sachkonto-Satzart 1 num 0 
0 if following field is to be populated 

also 

159 Sachkonto-Nummer 8 num 

General ledger account for 

presetting offset account 

during posting 

relAcp.AuslKto (revenue account) if 

populated 

163 Tax ID 25 alph Tax ID relFirma.TaxNo 

176 Homepage 50 alph Home page 
relKomArt.Nummer if 

relKomm.KomArt=7 

 
 

Transfer Infor Finance cost centers 

Cost centers are always transferred from Infor Finance to Infor COM. 

Cost centers are managed in the KSTSTELLE allocation table in Infor COM. All cost centers that 

exist in Infor Finance, but not in Infor COM, are created in this allocation table, with the exception 

of cost centers for which a delete or block date has been set. Cost centers that exist in Infor COM, 

but not in Infor Finance, are not deleted. 
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In the following table, the KSTSTELLE allocation table represents the data target, and the 

interface fields for the VIS service process SKST0095 (for reading cost centers) represent the data 

source. 

Note: For more detailed information on the service processes supported by Infor Finance, see the 

documentation provided for the Infor Finance Varial integration server included on the installation 

CD/DVD. 

ID Target field 

name 

Field description Source field name Condition 

1 Ident.Sprache Language of entry  An entry is generated for each 

language that is managed in the 

allocation table. 

2 Data.ZTKey Value/ID of the cost center KST_KTR_NR  

3 Data.KTxt Description of the cost center Bezeichnung1  

Please note: In Infor Finance, currency rates have only one description in the system language. 

It is not possible to maintain multiple descriptions in different languages. The system therefore 

assumes that both programs are working in the same language, and that descriptions need to be 

populated in the default system language only. For all other defined languages, a row is created 

with the same cost center description. 
 

Transfer Infor Finance currency rates 

Currency rates are read from Infor Finance. The following configuration parameters are evaluated 

here: 

 COMMON.INFORFINANCE.CONVERSIONRATE=AVERAGE 

This parameter determines the currency rate type: AVERAGE = Average rate, SELLING = 

Buying rate, BUYING = Selling rate. The current value is displayed in the dialog box: 

 COMMON.PREISRECHNUNG.DEFAULTWE 

This parameter indicates the base currency of the system. The current value is displayed 

in the Default CU field of the Data transfer dialog box. 
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Currency rates are stored in the FREMDWEUR allocation table in Infor COM. This table is subject 

to the relztfweur database table. All currency rates are entered and updated in this allocation 

table. 

Note: Currency rates that exist in Infor COM, but not in Infor Finance, are not deleted. 

In Infor Finance, currency rates have only one description in the system language. It is not 

possible to have several descriptions in different languages. The system therefore assumes that 

both programs work in the same language and that the description is entered in the default system 

language only. For all other defined languages, a row with the same description is created for the 

rate. If it is edited manually, this value will not be overwritten by updates. 

The fields are populated according to the following table: 
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Target field name Field description Infor Finance Condition 

Ident.TabName FREMDWEUR   

Ident.Sprache Language of entry  

An entry is generated for each 

language that is managed in the 

allocation table. 

Data.WE Currency unit Label  

Data.NumKey 
Currency code in Infor 

Finance 
FW_Kursnummer  

Data.KTxt Label Text 

Exists in Infor Finance system 

language only. There are no 

language-dependent 

descriptions.. 

Data.Datum Valid-from date Document date 
Valid-to date taken from Infor 

Finance 

Data.Basis Calculation basis SZ_Einheit IF: 1 = 1:1; 2 = 1:100; 3 = 1:1000 

Data.Kurs Conversion rate 

Average rate, selling rate or 

buying rate, depending on 

the value of the 

CurrencyRate parameter 

 

Data.Runden.MinWert 
Lowest value to which a 

number is to be rounded 
SZ_Rundung  

Data.Runden.Art 

Rounding type (to 

nearest whole number 

usually) 

  

Data.WEVDA    

Data.WEEDI  Label  

Data.IsoCodeWaehrung ISO code of currency Label  

Data.EuroKng    

 
 

Transfer Infor Finance cost units 

In Infor COM, cost units are managed in the COSTUNIT allocation table. 

Cost units can be transferred in two directions; from Infor Finance to Infor COM, or from Infor COM 

to Infor Finance. 
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You can use the COMMON.FIBU.COSTUNITS configuration parameter to specify the direction 

that is to apply. The first parameter specifies whether the cost units are to be read from Infor 

Finance. The second parameter determines whether the cost units are to be written to Infor 

Finance. 

It is also possible to activate both directions. In this case, the cost units are transferred from Infor 

Finance to Infor COM first, and then in a second step, they are transferred from Infor COM to Infor 

Finance. These two steps are carried out sequentially within the system. They should not be 

started separately. 

VIS provides service process SKST0095 for reading and writing cost units. 

Note: For more detailed information on the service processes supported by Infor Finance, see the 

documentation provided for the Infor Finance Varial integration server included on the installation 

CD/DVD. 

The record type of cost units is always 2. 

From Infor Finance to Infor COM 

The fields in the allocation table are populated according to the following table: 

The COSTUNIT allocation table in Infor COM represents the data target, and the interface fields of 

the VIS service process represent the data source. 
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Target field 

name 

Field description Source field name Condition 

Ident.Sprache Language of entry  An entry is generated for each 

language that is managed in the 

allocation table. 

Data.ZTKey Value/ID of the cost unit KST_KTR_NR  

Data.KTxt Description of the cost 

unit 

Bezeichnung1  

Data.FillerKN Flag indicating whether 

it is a cost unit or project 

SVO If record type = 4, then project 

(FillerKN=1); if record type = 2, then 

cost unit (FillerKN=0) 

 

 

Any cost units that do not exist in Infor COM are created in the allocation table. Cost units that 

exist in Infor COM, but not in Infor Finance, are not deleted. 

Cost units are read in Infor Finance. All cost units that do not exist in Infor COM are created in the 

allocation table. The Valid To field in Infor Finance is evaluated here. If a cost unit is no longer 

valid, it is not updated or added again. However, it is not deleted. Cost units that exist in Infor COM 

but not in Infor Finance are not deleted. 

Cost units for which a delete date or block date has been set in Infor Finance are not transferred to 

Infor COM. 

In Infor Finance, cost units have only one description in the system language. It is not possible to 

maintain multiple descriptions in different languages. The system therefore assumes that both 

programs are working in the same language, and that descriptions need to be populated in the 

default system language only. For all other defined languages, a row is created with the same cost 

unit description. 

Note: Projects are also created in this allocation table. They have different entries in the 

Data.FillerKN field. This field identifies the transfer and creates these projects as orders in the cost 

accounting system with the record type 4. 
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From Infor COM to Infor Finance 

If cost units are transferred from Infor COM to Infor Finance, certain fields need to be populated 

with default values. These fields are also listed in the table. The source is the Infor COM allocation 

table, and the target is the VIS service fields. 

 Please note: In the allocation table, the cost units should not be assigned a code of 0 or a 

blank code. 

ID Source field name Field description Target field name Condition 

1 Ident.Sprache Language of entry  An entry is generated for each 

language that is managed in the 

allocation table. 

2 Data.ZTKey Value/ID of the cost 

unit 

KST_KTR_NR  

3 Data.KTxt Description of the 

cost unit 

Bezeichnung1 
 

4 Data.FillerKN Flag indicating 

whether it is a cost 

unit or project 

 If Data.FillerKN = 0, then record 

type =2;  if Data.FillerKN = 1 

then record type = 4 

5   SzEinz Default value = 2 

6   SzIlvVol Default value = 1 

 

 

Only cost units that do not yet exist are created in Infor Finance. Existing cost units are not 

updated. 

The same applies for orders from the Infor Finance cost accounting system. If an order does not 

exist in the allocation table, it is created as a project. 
 

Transfer Infor Finance general ledger accounts 

General ledger accounts are transferred from Infor Finance to Infor COM and saved in the 

SACHKONTEN allocation table. This table is controlled by the relmtvalflaccounts database 

table. General ledger accounts always have the record type 0. 
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VIS provides the SSACH112 service process for reading the general ledger accounts. 

Note: For more detailed information on the service processes supported by Infor Finance, see the 

documentation provided for the Infor Finance Varial integration server included on the installation 

CD/DVD. 

The target fields in the allocation table are populated with the following VIS service fields: 

 

 

Target field name Field description Source field name Condition 

Ident.TabName SACHKONTEN   

Ident.Sprache Language of entry  

An entry is generated for each 

language that is managed in the 

allocation table. 

Data.ZTKey Value/ID Sachkonto_NR  

Data.KTxt Label Bezeichnung1  

Data.AccountNoExt External account ID Sachkonto_NR  

Data.AccountType 

Account type (taken from 

FINACCTYPE allocation 

table) 

  

Data.AcctCategory 

Category (taken from 

ACCCATEGORY allocation 

table) 

  

Data.DailyAcctType 

Daily account type (taken 

from DAILYACCT allocation 

table) 

  

Data. 

AccountCostingRelevant 
Cost accounting-relevant  Kostenrechnung_SZ  

 

All general ledger accounts that do not exist in Infor COM are created in the allocation table, with 

the exception of general ledger accounts for which a delete or block date has been set. 

General ledger accounts that already exist in Infor COM are updated. General ledger accounts 

that exist in Infor COM, but not in Infor Finance, are not deleted. 
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In Infor Finance, general ledger accounts have only one description in the system language. It is 

not possible to maintain multiple descriptions in different languages. The system therefore 

assumes that both programs are working in the same language, and that descriptions need to be 

populated in the default system language only. For all other defined languages, a row is created 

with the same general ledger account description. 

Note: General ledger accounts that exist in Infor COM, but not in Infor Finance, are not deleted. 
 

Transfer Infor Finance movement data 

For general information on the transfer of data in Infor Finance, see Infor Finance data transfer 

(see "Infor Finance data transfers" page 1596). 

All documents that can be transferred to a financial accounting system are included in the posting 

journal. All of the information required for the transfer of movement data is obtained from this 

journal. Only the contents of this journal can be accessed by FinanceLink. 

Technical note: The journal is saved in the relvalflposting database table. 

For the most part, the field configuration (System functions > Administration > Field functions) 

defines what is written to this journal. While you can adjust the field configuration, it is not possible 

to change the assignment between the fields in Infor COM and the fields in Infor Finance. 

The result of the transfer is saved in the Transfer date (LinkDate), Transfer status (LinkState), and 

Transfer ID (LinkNo) fields in the posting journal. 

The result of the transfer can be as follows: 

0 Document not accessed by transfer 

1 Document transferred successfully 

2 The document was transferred successfully, but a rounding difference was 

detected (general ledger postings only) 

255 An error occurred during the transfer. 

Note: The transfer date and transfer ID are not set unless the transfer is successful. 
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The data is transferred to the 120 Übernahme aus anderen Arbeitsgebieten (Transfer from other 

application areas) program in Infor Finance, where it can be checked before proceeding with the 

transfer. The postings are stored in the FinanceLink (FinanceLink) application. 

When transferring movement data, there are three types of posting available. You will find detailed 

information about the transfer of individual postings in the context-sensitive Help on the Data 

transfer dialog box. 
 

Transfer movement data (Expert mode) 

1. To configure the transfer of movement data in Expert mode, select Finance > Transfers > Data 

transfer, and then select the Movement data (Expert mode) tab. 

Note: This tab is displayed if the COMMON.FIBU.EXPERTMODE parameter in the 

configuration is set to yes. 

As the posting type, select either general ledger postings, invoices, or rounding difference 

postings. 

To carry out a transfer, make a selection in the Selection form section. The table must also 

contain at least one record type that matches the selection and is active. All selections and 

associated active records are processed in succession. 

Global transfer parameters are displayed in the Parameters section and can be configured 

there also. These parameters apply equally for all movement data transfers. 

2. If necessary, specify the transfers in the table. 

For more information, see the context-sensitive Help. 

3. Right-click in the Edit data filter column of the table to define a data filter. Then enter the data 

filter in the following dialog box. 

Note: You can also open the Infor COM filter dialog box using the shortcut menu for the 

corresponding row header. 
 

Transfer Infor Finance general ledger postings 

See also: Transfer movement data (Expert mode) (page 1616) 
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General ledger postings are only generated by the value flow function for value flow models 

greater than 0. This type of transfer is therefore not displayed on the dialog box unless the value of 

the COMMON.VALUEFLOW.COSTINGMODEL parameter is greater than 0. 

To ensure rounding accuracy in general ledger postings, you should set the 

COMMON.FIBU.MAXBALANCINGOFROUNDINGDIFFERENCES parameter, if applicable. This 

parameter controls the amount up to which rounding differences are reconciled automatically.  

The maximum permitted value is 0.1. If a greater value is entered, the value 0.1 is still used. 

Smaller values are permitted. 

Posting records for which differences are reconciled automatically are logged in mailbox 161. 

Posting records with greater differences are flagged as invalid and are not transferred. 

To transfer general ledger postings using the Movement data tab, the following minimum 

requirements must be met: 

 The General ledger postings check box must be selected 

 The table must contain an active line of the type 1 - General ledger posting 

 The Edit data filter field must be populated correctly 

Field values entered for compressed general ledger postings 

Compressed general ledger postings are always written on the first of the month of the period to 

be posted. 

Please note: It is essential that you synchronize the business periods in Infor COM with the 

periods in Infor Finance. 
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ID <if> field 

description 

Length Type <if> description Infor COM 

field/content 

Conditions 

1  Applikations-Kz  2  alph  Abbreviation of the 

specified application, 

e.g. AA 

FL  

2  Buchungsperiode  6  num  YYYYPP = Period in 

which posting made 

AccountingPeriod  

3  Entry date  6  num  YYMMDD = Date of 

transfer 

LinkDate  

4  Erfassungsnummer  6  num  000001-999999 LinkNo  

5  Sequential ID  5  num  00001-99999 

ascending 

 All transferred rows 

numbered 

6  Transakt_Nr  5  Num  00000-99999 

(transaction is the 

same for each 

document 

posting/reverse 

posting 

(release/delete) 

LinkNo  

7  Buchungsart_KZ  3  Alph  DIV = Posting 

BUC = Posting with 

reverse posting 

SAB = Reverse 

posting 

DIV  

8  Buchungs_ID  3  alph  ID of user that made 

the entry 

user  

9  Konto_SA  1  num  0 = General ledger 

account 

1 = Accounts 

receivable 

2 = Accounts payable 

0 All general ledger 

accounts 

10  Konto_Nr  8  num  Posting account AccountNoExt  

…       

16  Document ID  11  Num  00000000001 – 

99999999999 

LinkNo  

17  Unter_Beleg  3  Num  Subdocument ID   

18  Beleg_Datum  6  Num  YYMMDD First day of business 

period 
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19  Valuta_Datum  6  Num  YYMMDD First day of business 

period 

 

20  BS_Bezeichnung  3  Alph  SO: Debit posting 

HA: Credit posting 

If PostingType record 

type is SO or HA 

PostingType=1 -> "SO" 

PostingType=2 -> "HA" 

23  Origin  10  Alph  Short description of 

the specified 

application/program 

function 

"InforCOM"  

24  Soll_Haben_SZ  1  Num  1 = Debit for 

SO/AR/EG/AZ posting 

keys 

2 = Credit for 

HA/ER/AG/EZ posting 

keys 

Note: The same 

debit/credit code is 

assigned for 

cancellations. 

PostingType  

25  Storno_SZ  1  Num  Blank space (future 

release) 

  

26  Betrag_EW  15  +NU, Posting amount in 

base currency  

BaseGrossVal Totaled value 

41  Währungsnummer  3  num  Blank space or 000 = 

Base currency, 

001-998 = Foreign 

currency 

0  

50 Posting text 50 Alph Text 
Description 

parameter 

evaluated 

 

54  KST_KTR1_SA 1  Num  Record type (1=KST, 

2=KTR, 3=GER, 

4=AUF) 

1 or 2 Record type determined 

by content of field 55 

55  KST_KTR1_Nr  8  Num  Number 

(00000000-99999999) 

CostCentre or 

CostUnit 

If cost centers exist, 

these are entered; 

otherwise cost units 

56  KST_KTR2_SA  1  Num  Record type (1=KST, 

2=KTR, 3=GER, 

4=AUF) 

1 or 2 Record type determined 

by content of field 57 
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57  KST_KTR2_Nr  8  Num  Number 

(00000000-99999999) 

CostCentre or 

CostUnit 

If field 55 is populated 

and a cost unit exists, 

this cost unit should be 

entered here. 

88  Lieferschein_NR  15  alph  Blank space or text/ID 

for individual 

evaluations. 

Important: For 

integrations with 

Varial KEM, the cost 

unit or KEM order ID 

should be transferred 

here. 

DeliveryNoteNo  
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Field values entered for uncompressed general ledger postings 

ID 
<if> field 

description 
Length Type <if> description 

Infor COM 

field/content 
Conditions 

1  Applikations-Kz  2  alph  

Abbreviation of the 

specified application, 

e.g. AA 

FL  

2  Buchungsperiode  6  num  
YYYYPP = Period in 

which posting made 
AccountingPeriod  

3  Entry date  6  num  
YYMMDD = Date of 

transfer 
LinkDate  

4  Erfassungsnummer  6  num  000001-999999 LinkNo  

5  Sequential ID  5  num  
00001-99999 

ascending 
Incremented from 1 

Incremented with each 

transferred line 

6  Transakt_Nr  5  Num  

00000-99999 

(transaction is the 

same for each 

document 

posting/reverse 

posting 

(release/delete) 

Incremented from 1 
Incremented with each 

transferred document 

7  Buchungsart_KZ  3  Alph  

 DIV = Posting 

 SAB = Reverse 

posting 

DIV  

8  Buchungs_ID  3  alph  
ID of user that made 

the entry 
user  

9  Konto_SA  1  num  

 0 = General 

ledger account 

 1 = Accounts 

receivable 

 2 = Accounts 

payable 

0  

10  Konto_Nr  8  num  Posting account AccountNoExt  

16  Document ID  11  Num  
00000000001 – 

99999999999 
JrnEntryNo  

17  Unter_Beleg  3  Num  Subdocument ID   

18  Beleg_Datum  6  Num  YYMMDD TransactionDate  

19  Valuta_Datum  6  Num  YYMMDD TransactionDate  
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20  BS_Bezeichnung  3  Alph  

 SO: Debit 

posting 

 HA: Credit 

posting 

If PostingType record 

type is SO or HA 

PostingType=1 -> 

"SO" 

PostingType=2 -> 

"HA" 

23  Origin  10  Alph  

Short description of 

the specified 

application/program 

function 

"InforCOM"  

24  Soll_Haben_SZ  1  Num  

1 = Debit for 

SO/AR/EG/AZ posting 

keys 

2 = Credit for 

HA/ER/AG/EZ posting 

keys 

Note: The same 

debit/credit code is 

assigned for 

cancellations. 

PostingType  

25  Storno_SZ  1  Num  
Blank space (future 

release) 
  

26  Betrag_EW  15  +NU, 
Posting amount in 

base currency  
BaseGrossVal  

41  Währungsnummer  3  num  

Blank space or 000 = 

Base currency, 

001-998 = Foreign 

currency 

0  

50  Buchungstext  50  Alph  Text TransactionText  

54  KST_KTR1_SA  1  Num  

Record type (1=KST, 

2=KTR, 3=GER, 

4=AUF) 

1 or 2 

Record type 

determined by content 

of field 55 

55  KST_KTR1_Nr  8  Num  
Number 

(00000000-99999999) 

CostCentre or 

CostUnit 

If cost centers exist, 

these are entered; 

otherwise cost units 

56  KST_KTR2_SA  1  Num  

Record type (1=KST, 

2=KTR, 3=GER, 

4=AUF) 

1 or 2 

Record type 

determined by content 

of field 57 

57  KST_KTR2_Nr  8  Num  
Number 

(00000000-99999999) 

CostCentre or 

CostUnit 

If field 55 is populated 

and a cost unit exists, 

this cost unit should be 

entered here. 
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88  Lieferschein_NR  15  alph  

Blank space or text/ID 

for individual 

evaluations. 

 Important: For 

integrations with Varial 

KEM, the cost unit or 

KEM order ID should 

be transferred here. 

DeliveryNoteNo  

 

 
 

Transfer Infor Finance invoice postings in Expert mode 

See also: Transfer movement data (see "Transfer movement data (Expert mode)" page 1616) 

To transfer invoices in Expert mode, the following conditions must be met: 

 The Invoices check box must be selected. 

 The table on the tab must contain at least one active record of the type 2 - Invoice posting. 

 The Data filter field in the table must be populated correctly. 

With this record type, other parameter settings will have the same effects as with a standard 

invoice transfer. For more information, see Invoice postings. The settings of the relevant fields are 

described again in this topic. 
 

Infor Finance online functions 

For general information on the transfer of data in Infor Finance, see Infor Finance data transfer 

(see "Infor Finance data transfers" page 1596). 

The online function for reading a company account from the financial accounting system forms the 

basis for the functions described in the following section. 

The following fields are provided in the Infor.Finance.FinanceLink::ReadPersonalAccount Lj4 

function for customers who would like to make customizations. 

 Sat 

 Acct 
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 OpBeleg 

 OpUntBeleg 

 Prio 

 EroDat 

 AenNr 

 AenDat 

 AenId 

 KzFormat 

 KzAnrede 

 Nam1 

 Nam2 

 Abt 

 PlzPostf 

 Postf 

 Str 

 Plz 

 Ort1 

 Ort2 

 ZustPostamt 

 Country 

 Country 

 Sprach 

 SzKurs 

 KAns 

 BriefAnrede 

 VorwahlNr 

 TlfNr 

 TlxNr 

 TfxNr 

 TtxNr 

 BtxNr 

 MbxNr 

 UstId 

 KzWerk 

 KzDrei 

 BbnNr 

 Auswkz 

 Kredit 

 VersLim 

 KonzernLim 

 Wecobl 

 VersGes 

 VersArt 

 Vers. 

 KdnGrp 

 SzMahfax 

 SzMahnArt 
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 DispoGrp 

 MahnInfo1 

 MahnInfo2 

 ZinsArt 

 ZinsGrp 

 LztZinsDat 

 NZinsDat 

 SzZah 

 AwBnkSa 

 AwBnkKto 

 AwInh 

 BnkNrFix 

 ZahlGrp 

 SzBundbnk 

 PbcEsrNrCh 

 Bank1Staat 

 Bank1Lz 

 Bank1Ktonr 

 Bank1Name 

 Bank2Staat 

 Bank2Lz 

 Bank2Ktonr 

 Bank2Name 

 Bank3Staat 

 Bank3Typ 

 Bank3Lz 

 Bank3Ktonr 

 Bank3Nam1 

 Bank3Nam2 

 Bank3Str 

 Bank3Ort 

 ZahlInfo1 

 ZahlInfo2 

 Mc 

 GueltigVonDat 

 GueltigBisDat 

 LztBuchDat 

 LoeDat 

 LoeTolTage 

 LoeKz 

 BuchSperrDatVon 

 BuchSperrDatBis 

 BuchSperrKz 

 MahnSperrDatVon 

 MahnSperrDatBis 

 MahnSperrKz 

 ZahlSperrDatVon 
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 ZahlSperrDatBis 

 ZahlSperrKz 

 SzAns 

 Ktoart 

 SzUOp 

 SzOpVerw 

 SzFV 

 FVSa 

 FVKto8 

 SzSteu 

 SzZk 

 KorSa 

 KorKto8 

 ZzSa 

 ZzKto8 

 KtoLk 

 KonzernSa 

 KonzernKto8 

 NeuesSa 

 NeuesKto8 

 AltesSa 

 AltesKto8 

 VertrEinkNr 

 NrProfSa 

 NrProf8 

 Filiale 

 KdnLiefGrp 

 SzBranche 

 SzVerkEink 

 Vbez 

 Sort1 

 Sort2 

 Sort3 

 Sort4 

 Gj 

 VonPerX 

 BisPerX 

 Sv 

 UmssLfdj 

 UmshLfdj 

 SaldoLfdj 

 WechLfdj 

 WumsLfdj 

 UmssLfdm 

 UmshLfdm 

 UmssFolm 

 UmshFolm 
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 WumsLfdm 

 WumsFolm 

 BetrEwEuro 

 AzvStaat 

 AzvZahlart 

 AzvWeisSz 

 AzvKostver 

 AzvDienstl 

 IbanNr 

 VersichAnt 

 LimGueltigBis 

 AktId 

 EMail 

 SzRefefax 

 SachSa 

 SachKto8 

 FVVzSa 

 FVKto8 

 SzFreist 

 Tax ID 

 SZ_Bauabzug 

 Bauabzug 

 Limit_Hinweis 

 KredVers_HptKat 

 KredVers_UKat 

 KredVers_InfoDat 

 KredVers_EVSz 

 KredVers_EVDat 

 Geogr_Laenge 

 Geogr_Breite 

 KV_Pos 

 Factoring_Nr 

 Web Page 

These fields correspond to all of the fields of the SPERS176 company account service provided by 

the Varial integration server. The data format is always tString. 

Note: For more detailed information on the service processes supported by Infor Finance, see the 

documentation provided for the Infor Finance Varial integration server included on the installation 

CD/DVD. 
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Credit limit check 

For the credit limit check, the stored credit limit and outstanding items total are read from the 

financial accounting system. They are displayed in the company master on the Company account 

tab and saved in the relFinAcAcctState table. The balance fields are read from the 

customer/supplier master data in Infor Finance. 

Note: This function requires the COMMON.FIBU.ONLINEPERSACC=yes parameter. 

The values are only retrieved from the financial accounting system if the account has been created 

there. The company account status must be at least 1. 

The Credit limit check function can therefore query the current data in Infor Finance before 

carrying out each check. 

If a value greater than 0 is written to the Credit limit field in Infor COM, the  Credit limit check 

check box will be selected automatically for this customer. 

The balance fields displayed on the Company account tab are also read from the 

customer/supplier in Infor Finance. 

Note: The Balance fields section on the Company account tab is only displayed if the 

COMMON.FIBU.TARGETSYSTEM=InforFinance parameter is set. 

Company account ID 

When you create a customer or supplier in Infor COM, or make changes to the Company account 

field on the tab of the same name in the company master, the system checks whether the account 

ID already exists in the financial accounting system.  

It then checks whether this company account has already been assigned to another customer or 

supplier in Infor COM. Each ID can occur once for customers and once for suppliers, as they have 

different record types in Infor Finance. 

Note: The link between Infor COM and Infor Finance is established via the Company account field 

(relacp Feld AcpPart.InlKto table) in the company master. 
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In order to determine whether the company account is already populated, a query is submitted in 

Infor Finance to establish whether this company account already exists. If the status returned by 

the query indicates that the company account does not exist, it means that the company account 

ID can be used. If the ID does exist, the company account is incremented by one and refreshed in 

Infor COM. Another check is then carried out in Infor Finance in order to determine whether this 

company account ID is already in use. 

Note: The check requires the COMMON.FIBU.ONLINEPERSACC=yes parameter to be set in the 

configuration. 

 

Outstanding items 

In the financial accounting system, unpaid and unreconciled invoices exist as outstanding items. 

They can be imported into Infor COM via the interface, if permitted by the relevant financial 

accounting system. 

The current outstanding items from the financial accounting system are displayed on the 

Outstanding items tab of the company master. Before they can be displayed here, they must be 

read from the financial accounting system  

The program routine used for updating and displaying the outstanding items loads all of the 

outstanding items for the business partner that you have just opened. The outstanding items are 

not saved in Infor COM. This means that it is not possible to evaluate outstanding items in Infor 

COM. It simply provides a snapshot in time. 

Outstanding items are only displayed in this way if the COMMON.FIBU.ONLINEPERSACC 

parameter is set to yes in the configuration. 

Down payments/payment-on-account invoices 

In order to create a legally compliant final invoice in Infor COM, any (advance) payments that have 

already been made for the relevant order must be printed out. This information must be taken from 

the associated financial accounting system. 
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Whenever a final invoice is created, the COMMON.VERTRIEB.CHECKPAIDPAYMENTPLAN 

configuration parameter controls how this data is read from the current financial accounting 

system: 

This requires down payments and payment-on-account invoices to always be transferred to Infor 

Finance as statistical outstanding items. This is also a requirement of the 

COMMON.INFORFINANCE.ANZAHLUNGEN=yes, 

COMMON.INFORFINANCE.ANZAHLUNGEN._2_ =yes, and 

COMMON.INFORFINANCE.ANZAHLUNGEN._3_=yes parameters. 

Please note: This is the only possible setting for this parameter. 

In order to read the existing payments from Infor Finance, a query is run on outstanding items with 

the posting type VEZ (advance purchase down payment). If these items have the same order ID 

as the order from which the final invoice is printed, they will be returned as found payments. 

Please note: At this point, the link with the financial accounting system is based purely on the 

order ID. When entering the advance purchase down payment, it is therefore essential that you 

enter the order ID in Infor Finance. 

Payments can also be assigned to final invoices in Project. In this case, the dialog box used for 

selecting the down payments/payment-on-account invoices to be settled on the final invoice will 

include a new tab that lists the payments that were found in the financial accounting system. 

Note: You can use the COMMON.VERTRIEB.CHECKPAIDPAYMENTPLAN parameter to 

activate the old version of the final invoice with the down payments/payment-on-account invoices 

created in Infor COM. 

Online business partner link 

When the master data for a customer or supplier is saved, the processes for transferring business 

partners to the financial accounting system are called for exactly this customer/supplier. During 

this process, all configuration parameters and saved interface configuration settings are evaluated 

and applied. 

This online transfer is activated by the COMMON.FIBU.ONLINE.BUSINESSPARTNER 

configuration parameter. 
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View Infor Finance logs 

For general information on the transfer of data in Infor Finance, see Infor Finance data transfer 

(see "Infor Finance data transfers" page 1596). 

Note: Online functions (see "Infor Finance online functions" page 1623) are not logged. If an error 

occurs with an online function, a message is displayed directly on the screen for the user. 

1. Select Finance > Transfers > Data transfer. 

2. Click the Logs button. 

3. In the following Select logs dialog box, select the movement data and master data for which 

the log is to be displayed, and then click OK. 

The following Logs dialog box contains a tab for each selection. This tab includes a table 

that lists all of the transfers that were carried out for that selection. If an error occurred 

during a transfer, an error ID is set here. The exact error text is saved in the detailed log. 

4. Optional: Click the Details button to display the details for the selected transfer in a separate 

dialog box. If errors have occurred, this dialog box will allow you to view exactly which errors 

have occurred for which data record. 

Note: You can print out this detail list or export it to Excel via the shortcut menu for the 

table. 

To delete the log entry from the overview table and all corresponding details from the 

corresponding detail table, click the Delete button. 

Technical notes 

For all movement data transfers, the transfer ID corresponds to the transfer ID that was 

calculated by numbering method 220 and entered in the postings (posting journal transfer 

ID). 

The transfer IDs used for master data are not calculated by a numbering method and are 

simply incremented instead. 

The log entries for the individual transfers are saved in the relFinLReportGeneral overview 

table. The details for each transfer are saved in the following tables: 

 relFinLRCostCentres – Cost centers  

 relFinLRCostUnits – Cost units  



1632 | Infor COM 7.5 User Guide 

 

FinanceLink 

 

 relFinLRCustSuppliers – Business partners  

 relFinLRExchangeRates – Currency rates  

 relFinLRGeneralLedgers – General ledger accounts  

 relFinLRPaymentTerms – Payment terms  

 relFinLRCostPostings – Cost postings  

 relFinLRDebitsCredits – General ledger postings  

 relFinLRInvCredNotes – Invoices  

The overview table and details table are linked via the transfer type, transfer ID, and 

transfer date. 

The transferred data is documented in the detailed tables and if applicable, an error ID is 

set. 

5. Optional: Select the Show only records that contain errors check box to display records with 

transfer errors only. Any further restrictions selected via the shortcut menu for the table will 

apply to these invalid records only. 

6. Optional: Right-click on the row header to make a selection via the shortcut menu. 
 

Set up Batch control for Infor Finance 

The following Help topic describes how to set up data transfers via Batch control. 

1. Select System functions > Administration > Batch control. 

2. On the Action tab, enter Infor.Finance.FinanceLink::IUI.FinanceLinkBatchStart as the action. 

3. Select the Parameters required check box. 

4. Select Functions > Edit parameters. 

5. On the various tabs of the Data transfer dialog box, select all of the transfers that are to be 

carried out on a regular basis. Batch control always carries out all master data transfers first, 

and then all movement data transfers. Click OK to save your entries. 

Please note: You can also enter the data transfer job in Batch control multiple times. 

This is useful if different data types are to be transferred to the financial accounting system 

at regular but different intervals. In this case, you need to define individual transfer 

parameters for each job. 

6. On the Status tab, enter the status Released for the previously created job. 
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Infor Finance error analysis 

If an error occurs, and you need the help of the Infor support team in order to analyze the error, 

please have the following files to hand, in addition to the usual case description. Alternatively, you 

can send these files directly to support along with the error description. 

 Configuration settings 

 Lj4 level-1 trace for the process in question based on a small volume of data 

 VIS log. To create this log, complete the following steps: 

1. In the VIS.CFG file, which you can find in the Infor COM directory, activate the LOG=DEBUG 

entry. 

2. Deactivate the LOG=INFO parameter. 

3. Restart Infor COM. 

The VISCLIENT.TRC file in the Infor COM directory will now document the exact values of 

the fields in the called VIS service, as well as the values returned by this service. 

 visjnimt.trc 

 financelink.log log file 
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The FinanceLink Help topic describes how to transfer data from Infor COM to Infor Global 

Financials. 

 
 

Set up Infor Global Financials 

For an overview of the process of transferring data to Infor Global Financials, see Infor Global 

Financials Data transfer (page 1634). 

The connection between Infor COM and Infor Global Financials is established once for each Infor 

COM installation. The connection is maintained until Infor COM is closed. 

Since the link between the Infor COM application and the Infor Global Financials server is a 

permanent link, an interface user must be created in Infor Global Financials for each Infor COM 

user that wants to use this link. This interface user must also be stored in the configuration file for 

that Infor COM user. 

This interface user remains logged on to Infor Global Financials for the duration of the connection 

to Infor Global Financials. 
 

Set up Infor Global Financials-Infor COM link 

See also:  Set up Infor Global Financials (page 1634). 

To transfer data to Infor Global Financials, the relevant configuration settings must be defined at a 

number of levels. The following overview shows where and how you define these settings. 

1. Make sure that the following files are included in the 

..\InforCOM\InforCE\dist\client\lib\finance\components directory: 

 IGFConnect.jar 

 in4FinanceLink.jar 

 in4FinanceOnline.jar 

Infor Global Financials data transfer 



Infor COM 7.5 User Guide | 1635 

 

FinanceLink 

 

These files are necessary for the transfer of data to Infor Global Financials. They are 

provided as standard with Infor COM. 

2. Copy the following fields from the current ..\server\vwe folder of the Infor Global Financials 

server directory to the ..\InforCOM\InforCE\dist\client\lib\finance\components 

directory: 

 Vwe-accounting-idl.jar 

 Vwe-base-idl.jar 

 Vwe-costing-idl.jar 

3. Copy the Vwe-transfer.jar file from the ..\transfer\lib server directory to the 

..\InforCOM\InforCE\dist\client\lib\finance\components directory. 

4. These files must be copied again each time Infor Global Financials is updated. 

Note: Infor Global Financials is the master system for these files. 

5. Define the parameter settings as follows: 

COMMON.FIBU.TARGETSYSTEM=InforGlobalFinancials 

COMMON.FIBU.TRANSFERTORELVALFLPOSTING=yes 

COMMON.FIBU.ONLINEPERSACC=yes 

COMMON.FIBU.ONLINE.BUSINESSPARTNER=yes 

COMMON.FIBU.ONLINEWE=EUR 

CONNON.FIBU.MAXBALANCINGOFROUNDINGDIFFERENCES=0,03 

COMMON.FIBU.COSTUNITS=yes 

COMMON.FIBU.COSTUNITS._2_=yes 

COMMON.FIBU.CREDITLIMITMASTER=no 

6. Define the parameter settings as follows: 
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COMMON.INFORGLOBALFINANCIALS.SERVER=Server01 

COMMON.INFORGLOBALFINANCIALS.PORT=6668 

COMMON.INFORGLOBALFINANCIALS.USER=finance 

COMMON.INFORGLOBALFINANCIALS.PASSWORD=finance 

COMMON.INFORGLOBALFINANCIALS.COMPANY=MDE 

COMMON.INFORGLOBALFINANCIALS.ENVIRONMENT=0 

COMMON.INFORGLOBALFINANCIALS.DISPLAYLOCALE=de 

COMMON.INFORGLOBALFINANCIALS.LANGUAGEMAP=de=de us=us 

COMMON.INFORGLOBALFINANCIALS.DEBUGFILES=yes 

COMMON.INFORGLOBALFINANCIALS.DEBUGFILEPATH=C:/VarialOutput.xml 

COMMON.INFORGLOBALFINANCIALS.USECOMPANYNOASACCOUNT=yes 

COMMON.INFORGLOBALFINANCIALS.ANZAHLUNGEN=yes 

 
 

Maintain Infor Global Financials import codes 

See also: Set up Infor Global Financials (page 1634) 

Infor COM and Infor Global Financials contain master data that is independent of each other. In 

order to ensure that the correct master data is transferred between the two programs, Infor Global 

Financials uses import codes. 

The master data must therefore be assigned import codes, as described in the section below. This 

assignment only needs to be carried out once. 

1. Select System functions > Administration > Allocation tables, then open the TAXRATES 

allocation table. 

This allocation table defines the languages that are used in Infor COM and Infor Global 

Financials for reports and descriptions of all types. 

2. In the Language column, check which code is stored for which language. 

The code that is entered here forms the <language code 1> that is used by the 

COMMON.INFORGLOBALFINANCIALS.LANGUAGEMAP configuration parameter. 
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3. For each language that is used in Infor COM for reports and allocation tables, you need to 

enter a corresponding import code for Infor Global Financials. To do this, go to the 

COMMON.INFORGLOBALFINANCIALS.LANGUAGEMAP parameter in the configuration and 

assign a <language flag 2> value to each <language flag 1>. 

Example: LanguageMap=de=de us=us 

4. Select System functions > Administration > Allocation tables, then open the LANDTAB 

allocation table. 

This allocation table stores all of the countries that are used in Infor COM. In Infor Global 

Financials, enter the code that is stored here in the Import Code column for the 

corresponding language by selecting General Settings > Country. 

5. Select System functions > Administration > Allocation tables, then open the MEBASIS 

allocation table. 

All units of measure that are used in postings must be created in Infor Global Financials. 

To do this, enter the value of the Infor COM UOM column in the Import Code column in 

Infor Global Financials by selecting General Settings > Quantity Units. 

6. Select System functions > Administration > Allocation tables, then open the ZAHLBED 

allocation table. 

This allocation table stores all of the payment terms that are used in Infor COM. Enter the 

code that is stored in the ID column for the corresponding payment term as the Import 

Code in Infor Global Financials by selecting Sales Ledger > Terms of Payment. 

7. Select System functions > Administration > Allocation tables, then open the TAXRATES 

allocation table. 

This table contains the tax keys that are used in Infor COM. In Infor COM, the tax key is 

created from the numerical values of the Tax type and Tax ID fields. Both are represented 

as numbers. 

In Infor Global Financials, enter this concatenated tax type and tax ID value as the import 

code for the tax ID by selecting Financial Accounting > Setup Financial Accounting > Tax 

Codes. 

Please note: An import code can only be assigned once. 
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Transfer Infor Global Financials data 

For an overview of the process of transferring data to Infor Global Financials, see Infor Global 

Financials Data transfer (page 1634). 

The following topics describe how to transfer master data and movement data between Infor COM 

and Infor Global Financials. 
 

Transfer Infor Global Financials master data 

See also: Transfer Infor Global Financials data (page 1638) 

1. To initiate the transfer of data between Infor COM and Infor Global Financials using 

FinanceLink, select Finance > Transfers > Data transfer. 

2. In the dialog box that displays, select the Master data tab. 

3. In the Selection section, select the master data that you want to transfer. 

You can transfer master data for the following: 

Representative 

Business partner (page 1638) 

Cost centers (page 1639) 

Cost units 

Currency rates (page 1640) 

General ledger accounts (page 1642) 

Payment terms (page 1644) 
 

Business partner 

Business partners are always transferred from Infor COM to Infor Global Financials. 
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Examples of business partners to be transferred would be customers and suppliers from Infor 

COM. To transfer business partners to Infor Global Financials, select the Business partner check 

box in the Selection form section of the Data transfer dialog box, then select the data that you want 

to transfer in the Business partner form section. If a specific business partner was selected, then 

only this business partner can be transferred explicitly. 

Note: The COMMON.INFORGLOBALFINANCIALS.USECOMPANYNOASACCOUNT parameter 

controls whether the business partner is created with its company ID from Infor COM, or its 

customer/supplier account number from Infor Global Financials. 
 

Cost centers 

Cost centers are always transferred from Infor Global Financials to Infor COM. 

Note: The transfer does not require any parameters. 

Cost centers are managed in the KSTSTELLE allocation table in Infor COM. In the following table, 

the KSTSTELLE allocation table represents the target, while the interface fields for the cost 

centers in Infor Global Financials represent the source. 

Target field 

name 

Field description Source field name Condition 

Ident.Sprache Language of entry Language assignment as 

per Infor Global Financials 

COMMON.INFORGLOBALF

INANCIALS.LANGUAGEMA

P configuration parameter. 

An entry is generated for 

each language that is 

managed in the 

allocation table. 

Data.ZTKey Value/ID of the cost center costCentre.currentIdentifier.

code 

 

Data.KTxt Description of the cost center costCentre.currentIdentifier.

description 

Dependent on language 

Cost centers are read in Infor Global Financials. All cost centers that do not exist in Infor COM are 

created in the allocation table. The description in the cost centers that already exist in Infor COM is 

updated. The Valid To field from Infor Global Financials is evaluated here. 

Note: If the cost center is no longer valid, it is not added again or updated; however, it is not 

deleted either. Cost centers that exist in Infor COM, but not in Infor Global Financials, are not 

deleted. 
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Currency rates 

Currency rates are read from Infor Global Financials. 

Here, the rates table with the default currency unit from Infor COM is determined as the reference 

currency in Infor Global Financials. The default Infor COM currency unit is stored in the 

COMMON.PREISRECHNUNG.DEFAULTWE=EUR configuration parameter. 

In the data transfer dialog box, the Rates table field must be populated. In Infor Global Financials, 

you can find the name of the rates table to be entered by selecting General Setup > Conversion 

Rates. The currency rates are read from this rates table and transferred to Infor COM. 

Note: It is not currently possible to select the Inverted Rates check box. 

In Infor COM, currency rates are saved in the FREMDWEUR allocation table. This table is 

controlled by the relZTFWEUR database table. 

All currency rates are entered or updated in the allocation table. Currency rates that exist in Infor 

COM, but not in Infor Global Financials, are not deleted. 

The fields are populated according to the following table: 
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Target field name Field description Infor Global Financials Condition 

Ident.TabName FREMDWEUR   

Ident.Sprache Language of entry 
Language assignment as 

per 

COMMON.INFORGLOB

ALFINANCIALS.LANGU

AGEMAP configuration 

parameter in Infor Global 

Financials. 

An entry is generated for each 

language that is managed in the 

allocation table. 

Data.WE Currency unit CurrencyStruct.importcode  

Data.NumKey Code of the currency in Infor 

Global Financials 

  

Data.KTxt Label CurrencyStruct.name Exists in the Infor Global 

Financials system language 

only; language-dependent 

names are not possible 

Data.Datum Valid From CurrencyStruct.validFrom Valid from date from Infor 

Global Financials 

Data.Basis Calculation basis  Calculated from 

ExchangeRateStruct. 

conversionRate 

Data.Kurs Conversion rate ExchangeRateStruct.conversi

onRate 

 

Data.Runden.MinWert Lowest value to which a 

number is to be rounded 

CurrencyStruct.decimalplaces  

Data.Runden.Art Rounding type (to nearest 

whole number as a rule) 

  

Data.WEVDA    

Data.WEEDI  CurrencyStruct.isoCode  

Data.IsoCodeWaehrun

g 

ISO code of currency CurrencyStruct.isoCode  

Data.EuroKng    
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General ledger accounts 

General ledger accounts are transferred from Infor Global Financials to Infor COM. In Infor COM, 

they are saved in the SACHKONTEN allocation table. This allocation table is controlled by the 

relMTVALFLACCOUNTS database table. 

The fields are populated according to the following table: 
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Target field name Field description Source field name Condition 

Ident.TabName SACHKONTEN   

Ident.Sprache Language of entry Language assignment as 

per 

COMMON.INFORGLOB

ALFINANCIALS.LANGU

AGEMAP configuration 

parameter and language 

in Infor Global 

Financials. 

An entry is generated for each 

language that is managed in the 

allocation table. 

Data.ZTKey Value/ID accountcode  

Data.KTxt Label description  

Data.AccountNoE

xt 

External account ID code  

Data.AccountType Account type (taken 

from FINACCTYPE 

allocation table) 

80 (accounts receivable 

summary account) or 

81 (accounts payable 

summary account)  

If glAccount.isControlAccount 

-> && glAccount.accountCategory == 

NLAccountCategoryEnum.NACE_ASS

ET_RECEIVABLES then accounts 

receivable summary account 

If glAccount.isControlAccount 

-> && glAccount.accountCategory == 

NLAccountCategoryEnum.NACE_LIAB

ILITY_PAYABLES then accounts 

payable summary account 

Data.AcctCategor

y 

Category (taken from 

ACCCATEGORY 

allocation table) 

99  

Data.DailyAcctTyp

e 

Daily account type 

(taken from 

DAILYACCT allocation 

table) 

  

Data. 

AccountCostingRe

levant 

Cost 

accounting-relevant  

hasCosting  

 

The general ledger accounts are read using the COMMON.ABSENDER.OWNCOMPANY 

configuration parameter, as each company can only be assigned to one chart of accounts in Infor 

Global Financials. 
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General ledger accounts are read in Infor Global Financials. Any general ledger accounts that do 

not exist in Infor COM are created in the allocation table. Existing general ledger accounts in Infor 

COM are not updated. 

Note: General ledger accounts that exist in Infor COM, but not in Infor Global Financials, are not 

deleted. 

 

Payment terms 

Payment terms are transferred from Infor Global Financials to Infor COM. In Infor COM, they are 

saved in the ZAHLBED allocation table. This allocation table is controlled by the relZTZB database 

table. The fields in the allocation table are populated as per the following table: 

Target field name Field description Source field name Condition 

Ident.TabName ZAHLBED   

Ident.Sprache Language of entry Language assignment as per 

COMMON.INFORGLOBALFINANCIAL

S.LANGUAGEMAP configuration 

parameter and language in Infor Global 

Financials. 

An entry is generated for 

each language that is 

managed in the 

allocation table. 

Data.ZTKey Value/ID Importcode  

Data.KTxt Label descriptions Dependent on language 

Data.SktoProz1 Discount 1 percentage discount1.discount  

Data.SktoTage1 Discount 1 day discount1.dueDays.dueDays  

Data.SktoProz2 Discount 2 percentage discount2.discount  

Data.SktoTage2 Discount 2 day discount2.dueDays.dueDays  

Data.SktoTage3 Payment due days paymentCondition.paymentDueDays.du

eDays 

 

 

In Infor COM, it is not possible to save follow-up conditions and payment terms relating to cut-off 

dates. These payments terms are therefore not transferred to Infor COM. 

Note: Payment terms that do not exist in Infor Global Financials are not deleted in Infor COM. 
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Create template for transferring business partners 

To allow the automatic transfer of business partners from Infor COM to Infor Global Financials, it is 

important to create a separate template for accounts receivable (see "Create template for 

transferring accounts receivable" page 1645) and accounts payable (see "Create template for 

transferring accounts payable" page 1651). In both cases, the templates are assigned the name 

infor. 
 

Create template for transferring accounts receivable 

See also Create template for transferring business partners (page 1645). 

The following Help topic describes how to create a template for transferring accounts receivable 

data from Infor COM to Infor Global Financials. 

1. In Infor Global Financials, select Sales Ledger > Master Data > Customers. 

2. Name the template infor. 

3. Define the required default settings. 

These default settings are applied when the data is transferred from Infor COM, provided 

the corresponding fields are not already populated with a different value. 

Note: The address that is extracted from Infor COM for the transfer is taken from the 

Linked address field on the Company account tab. If this field was not assigned a default 

value when created, the bill-to address from the Customer documents or Supplier 

documents tabs is used for the transfer and written to the Linked address tab. The Linked 

address field allows you to provide the financial accounting system with a different address 

from the bill-to address. 

The fields for the company account interface are populated as follows: 
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Field in IGF IDL name in IGF Infor COM field or value Condition 

PersonalAccount220

BaseStruct  

baseData   

Company companyID Content of the 

COMMON.INFORGLOBALFINAN

CIALS.COMPANY configuration 

parameter 

 

Type type PersonalAccountTypeEnum.PATE

_CUSTOMER or 

PersonalAccountTypeEnum.PATE

_SUPPLIER 

Depending on whether it is a 

customer or supplier 

Template presetID "infor"  

Account ID code Company ID or Company account 

ID 

(relfinacacctstate.accountno 

(corresponds to relfirma.FirmaNr) 

or relacp.inlkto) 

Depending on setting of 

COMMON.INFORGLOBAL

FINANCIALS.USECOMPAN

YNOASACCOUNT 

configuration parameter. 

Short Address shortName Description (relfirma.ktxt) or 

search term (relfirma.suchbegriff) 

Dependent on setting of 

Override description 

parameter. 

One-off sundryAccount false  

Name name relfirma.Name Content overridden by 

Special address format 

parameter. 

The address is determined as follows: The Linked address field on the Company account tab is used. If this 

field is empty, the bill-to address is taken from the Customer documents or Supplier documents tabs. 

Address address relansch.strasse Content overridden by 

Special address format 

parameter.  

Post code postCode relansch.plzort  

Town/city town relansch.ort  

Region county relansch.land  

Country country relansch.landkng In Infor Global Financials, 

the country must be 

assigned the associated 

country abbreviation from 

the LANDTAB allocation 



Infor COM 7.5 User Guide | 1647 

 

FinanceLink 

 

table in Infor COM as the 

corresponding import code 

for Infor Global Financials. 

Tax ID vattaxnumber relfirma.taxno  

ECVAT registration 

number 

ectaxnumber relfirma.UStIdNr If the Tax ID parameter is 

set; otherwise it is blank. 

Lang. languageID relfirma.sprache The language code 

assignment in the 

COMMON.INFORGLOBAL

FINANCIALS.LANGUAGEM

AP configuration parameter 

must match the 

corresponding import code 

for the language in Infor 

Global Financials. 

Phone phone relkomm.nummer Where relkomm.kommart=1 

Fax fax relkomm.nummer Where relkomm.kommart=2 

E-mail email relkomm.nummer Where relkomm.kommart=4 

Web Page homepage relkomm.nummer Where relkomm.kommart=5 

Company ID companynumber   

PO box postOfficeBox relansch.Postfach  

PO box/post code postOfficeBoxPostC

ode 

relansch.PLZPostfach  

Withholding tax type 

(Ritenuta) 

ritenutatype RitenutaTypeEnum.RTE_DEFAUL

T 

 

Codice 

Fiscale/Giuridice 

codiceFiscaleOrGiu

ridice 

"*" Currently populated via 

customization only 

Tax Office taxOffice "*" Currently populated via 

customization only 

Codice Causale codiceCausale "*" Currently populated via 

customization only 

Tax Register taxRegister "*" Currently populated via 

customization only 

Tax code for 

withholding tax 

ritenutaTaxCode "*" Currently populated via 

customization only 
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Date of birth birthDate   

Place of Birth birthPlace   

Country of Birth birthCountry   

First name firstName   

Last name surName   

Gender gender SexEnum.SE_DEFAULT  

Control Account controlAccountID relacp.eukto External description from 

SACHKONTEN allocation 

table. 

Default Linked Account defaultAccountID relacp.auslkto External description from 

SACHKONTEN allocation 

table. 

Currency currencyID relacp.acppart.we  

Terms of Payment termsOfPaymentID relacp.acppart.zbed  

Tax Code taxcodeID "" "*" in the case of updates 

Payment mode modeOfPayment PaymentTypeEnum.PTE_DEFAU

LT 

 

Analysis codes analysisCodes The 10 analysis codes defined in 

Infor COM. 

Only if the Transfer analysis 

ID check box is selected. 

Number at Partner's ownNumberAtPartn

er 

relfirma.FremdNr Only if populated in Infor 

COM; otherwise  "*", to 

ensure that the value in Infor 

Global Financials is not 

overwritten. 

    

Representative representativeID AcpPart.Vertreter1 If 

"Representative/employee" 

check box is selected. 

Representative must be 

created with same ID in Infor 

Global Financials. 

Employee advisorID M8Footer.Sachbearbeiter If 

"Representative/employee" 

check box is selected. 

Representative must be 

created with same ID in Infor 
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Global Financials. 

Posting Block stop   

Reason for Posting 

Block 

stopNote   

Cost centers costCentreID   

Negotiated Exchange 

Rates 

negExchangeRate   

Terms of Payment for 

Bills 

termOfPaymBillID   

Bill of Exchange: 

Prolong Bill Risk by 

toleranceForBillRisk   

Withhold Collection withhold   

Reason for Block withholdNote   

Sub-Account isSubAccount   

Dunning Group  dunningGroupID  "*"  

Reminder by Phone  reminderByPhone    

Reminder by Letter  reminderByLetter    

Reminder by Fax  reminderByFax    

Reminder by E-mail  reminderByEmail    

Delivery Block  deliveryStop    

Reason for Delivery 

Block  

deliveryStopNote    

BankAddress220Struct 

(BankAddress220Seq) 

bankAddresses All bank details are only linked if either the Create bank details 

parameter or Update bank details parameter is set and the 

business partner is set to the appropriate status. 

The Infor COM fields are determined by the 

COMMON.STAMMDATEN.BANKINFONOTEBOOK parameter: 

no: Default bank details taken from relfirma  

yes: All bank details taken from relCompanyBankInfo for partner; 

for IGF version < 2.20, only default bank details without SEPA 

fields are transferred (BankData165Struct) 

 

Bank routing ID  sortingCode relfirma.BLZ/relCompanyBankInfo  
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.BankCode 

IBAN  iban  relfirma.IBAN/relCompanyBankInf

o.IBAN 

 

Bank Name  name  relfirma.Bank/relCompanyBankInf

o.BankName 

 

Branch of Bank  branch  "*" Only when creating  

Bank Address  address "*"  

Postcode Bank  postCode   

Bank Town  town   

Bank County  county   

Bank country  country  relfirma.bankcountrycode/relComp

anyBankInfo. BankCountryCode 

The country code from the 

LANDTAB allocation table 

must be stored as the import 

code for the country in Infor 

Global Financials. 

Bank Account Number  accountNumber  relfirma.KTO/relCompanyBankInfo

. AccountNo 

 

Deviating account 

holders  

deviatingOwner  "*"  

SWIFT House Bank  swiftBic relfirma.BIC/relCompanyBankInfo.

BIC 

 

Valid from validFrom   

Valid until validUntil   

SEPA Mandate  sepaMandate relfirma.SEPA.Mandate/relCompa

nyBankInfo. SEPA.Mandate 

 

Created On  sepaMandateDate relfirma.SEPA.MandateDate/relCo

mpanyBankInfo. 

SEPA.MandateDate 

 

SEPA Debit Debit Type  sepaDirectDebit relfirma.SEPA.DirectDebit/relCom

panyBankInfo. SEPA.DirectDebit 

 

One-off direct debit  oneOffDirectDebit relfirma.SEPA.oneOffDirectDebit/r

elCompanyBankInfo. 

SEPA.OneOffDirectDebit 

 

Last usage  sepaLastUsage relfirma.SEPA.LastUsage/relCom

panyBankInfo.SEPA.LastUsage 
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Default Bank  bankdefault true /relCompanyBankInfo.Default

Flag 

 

Limit195Struct 

(Limit195Seq) 

limits   

Limit From  fromDate    

Limit To  untilDate    

Limit Type  type    

Limit Amount  amount relfinacaccstate.creditlimit If creating and if 

CreditLimitMaster=yes  

Maximum Days 

Overdue  

maxDaysOverdue    

Limit Status  status    

Reason for rej.  refusalReasonID    

Notes  note   

 
 

Create template for transferring accounts payable 

See also Create template for transferring business partners (page 1645). 

The following Help topic describes how to create a template for transferring accounts payable data 

from Infor COM to Infor Global Financials. 

1. In Infor Global Financials, select Purchase Ledger > Master Data > Suppliers. 

2. Name the template infor. 

3. Define the required default settings. 

These default settings are applied when the data is transferred from Infor COM, provided 

the corresponding fields are not already populated with a different value. 



1652 | Infor COM 7.5 User Guide 

 

FinanceLink 

 

Note: The address that is extracted from Infor COM for the transfer is taken from the 

Linked address field on the Company account tab. If this field was not assigned a default 

value when created, the bill-to address from the Customer documents or Supplier 

documents tabs is used for the transfer and written to the Linked address tab. The Linked 

address field allows you to provide the financial accounting system with a different address 

from the bill-to address. 

The fields for the company account interface are populated as follows: 
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Field in IGF IDL name in IGF Infor COM field or value Condition 

PersonalAccount220

BaseStruct  

baseData   

Company companyID Content of the 

COMMON.INFORGLOBALFINAN

CIALS.COMPANY configuration 

parameter 

 

Type type PersonalAccountTypeEnum.PATE

_CUSTOMER or 

PersonalAccountTypeEnum.PATE

_SUPPLIER 

Depending on whether it is 

a customer or supplier 

Template presetID "infor"  

Account ID code Company ID or Company account 

ID 

(relfinacacctstate.accountno 

(corresponds to relfirma.FirmaNr) 

or relacp.inlkto) 

Depending on setting of 

COMMON.INFORGLOBAL

FINANCIALS.USECOMPA

NYNOASACCOUNT 

configuration parameter. 

Short Address shortName Description (relfirma.ktxt) or 

search term (relfirma.suchbegriff) 

Dependent on setting of 

Override description 

parameter. 

One-off sundryAccount false  

Name name relfirma.Name Content overridden by 

Special address format 

parameter. 

The address is determined as follows: The Linked address field on the Company account tab is used. If 

this field is empty, the bill-to address is taken from the Customer documents or Supplier documents tabs. 

Address address relansch.strasse Content overridden by 

Special address format 

parameter.  

Post code postCode relansch.plzort  

Town/city town relansch.ort  

Region county relansch.land  

Country country relansch.landkng In Infor Global Financials, 

the country must be 

assigned the associated 

country abbreviation from 

the LANDTAB allocation 
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table in Infor COM as the 

corresponding import code 

for Infor Global Financials. 

Tax ID vattaxnumber relfirma.taxno  

ECVAT registration 

number 

ectaxnumber relfirma.UStIdNr If the Tax ID parameter is 

set; otherwise it is blank. 

Lang. languageID relfirma.sprache The language code 

assignment in the 

COMMON.INFORGLOBAL

FINANCIALS.LANGUAGE

MAP configuration 

parameter must match the 

corresponding import code 

for the language in Infor 

Global Financials. 

Phone phone relkomm.nummer Where 

relkomm.kommart=1 

Fax fax relkomm.nummer Where 

relkomm.kommart=2 

E-mail email relkomm.nummer Where 

relkomm.kommart=4 

Web Page homepage relkomm.nummer Where 

relkomm.kommart=5 

Company ID companynumber   

PO box postOfficeBox relansch.Postfach  

PO box/post code postOfficeBoxPostC

ode 

relansch.PLZPostfach  

Withholding tax type 

(Ritenuta) 

ritenutatype RitenutaTypeEnum.RTE_DEFAUL

T 

 

Codice 

Fiscale/Giuridice 

codiceFiscaleOrGiu

ridice 

"*" Currently populated via 

customization only 

Tax Office taxOffice "*" Currently populated via 

customization only 

Codice Causale codiceCausale "*" Currently populated via 

customization only 

Tax Register taxRegister "*" Currently populated via 

customization only 
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Tax code for 

withholding tax 

ritenutaTaxCode "*" Currently populated via 

customization only 

Date of birth birthDate   

Place of Birth birthPlace   

Country of Birth birthCountry   

First name firstName   

Last name surName   

Gender gender SexEnum.SE_DEFAULT  

Control Account controlAccountID relacp.eukto External description from 

SACHKONTEN allocation 

table. 

Default Linked Account defaultAccountID relacp.auslkto External description from 

SACHKONTEN allocation 

table. 

Currency currencyID relacp.acppart.we  

Terms of Payment termsOfPaymentID relacp.acppart.zbed  

Tax Code taxcodeID "" "*" in the case of updates 

Payment mode modeOfPayment PaymentTypeEnum.PTE_DEFAU

LT 

 

Analysis codes analysisCodes The 10 analysis codes defined in 

Infor COM. 

Only if the Transfer 

analysis ID check box is 

selected. 

Number at Partner's ownNumberAtPartn

er 

relfirma.FremdNr Only if populated in Infor 

COM; otherwise  "*", to 

ensure that the value in 

Infor Global Financials is 

not overwritten. 

    

Representative representativeID AcpPart.Vertreter1 If 

"Representative/employee" 

check box is selected. 

Representative must be 

created with same ID in 

Infor Global Financials. 

Employee advisorID M8Footer.Sachbearbeiter If 

"Representative/employee" 



1656 | Infor COM 7.5 User Guide 

 

FinanceLink 

 

check box is selected. 

Representative must be 

created with same ID in 

Infor Global Financials. 

Posting Block stop   

Reason for Posting 

Block 

stopNote   

Cost centers costCentreID   

Negotiated Exchange 

Rates 

negExchangeRate   

Terms of Payment for 

Bills 

termOfPaymBillID   

Bill of Exchange: 

Prolong Bill Risk by 

toleranceForBillRisk   

Withhold Collection withhold   

Reason for Block withholdNote   

Sub-Account isSubAccount   

Dunning Group  dunningGroupID  "*"  

Reminder by Phone  reminderByPhone    

Reminder by Letter  reminderByLetter    

Reminder by Fax  reminderByFax    

Reminder by E-mail  reminderByEmail    

Delivery Block  deliveryStop    

Reason for Delivery 

Block  

deliveryStopNote    

BankAddress220Struct 

(BankAddress220Seq) 

bankAddresses All bank details are only linked if either the Create bank details 

parameter or Update bank details parameter is set and the 

business partner is set to the appropriate status. 

The Infor COM fields are determined by the 

COMMON.STAMMDATEN.BANKINFONOTEBOOK parameter: 

no: Default bank details taken from relfirma  

yes: All bank details taken from relCompanyBankInfo for 

partner; for IGF version < 2.20, only default bank details without 
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SEPA fields are transferred (BankData165Struct) 
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Bank routing ID  sortingCode relfirma.BLZ/relCompanyBankInfo

.BankCode 

 

IBAN  iban  relfirma.IBAN/relCompanyBankInf

o.IBAN 

 

Bank Name  name  relfirma.Bank/relCompanyBankInf

o.BankName 

 

Branch of Bank  branch  "*" Only when creating  

Bank Address  address "*"  

Postcode Bank  postCode   

Bank Town  town   

Bank County  county   

Bank country  country  relfirma.bankcountrycode/relComp

anyBankInfo. BankCountryCode 

The country code from the 

LANDTAB allocation table 

must be stored as the 

import code for the country 

in Infor Global Financials. 

Bank Account Number  accountNumber  relfirma.KTO/relCompanyBankInfo

. AccountNo 

 

Deviating account 

holders  

deviatingOwner  "*"  

SWIFT House Bank  swiftBic relfirma.BIC/relCompanyBankInfo.

BIC 

 

Valid from validFrom   

Valid until validUntil   

SEPA Mandate  sepaMandate relfirma.SEPA.Mandate/relCompa

nyBankInfo. SEPA.Mandate 

 

Created On  sepaMandateDate relfirma.SEPA.MandateDate/relCo

mpanyBankInfo. 

SEPA.MandateDate 

 

SEPA Debit Debit Type  sepaDirectDebit relfirma.SEPA.DirectDebit/relCom

panyBankInfo. SEPA.DirectDebit 

 

One-off direct debit  oneOffDirectDebit relfirma.SEPA.oneOffDirectDebit/r

elCompanyBankInfo. 

SEPA.OneOffDirectDebit 

 

Last usage  sepaLastUsage relfirma.SEPA.LastUsage/relCom  
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panyBankInfo.SEPA.LastUsage 

Default Bank  bankdefault true /relCompanyBankInfo.Default

Flag 

 

Limit195Struct 

(Limit195Seq) 

limits   

Limit From  fromDate    

Limit To  untilDate    

Limit Type  type    

Limit Amount  amount relfinacaccstate.creditlimit If creating and if 

CreditLimitMaster=yes  

Maximum Days 

Overdue  

maxDaysOverdue    

Limit Status  status    

Reason for rej.  refusalReasonID    

Notes  note   

 
 

Transfer Infor Global Financials movement data 

See also: Transfer Infor Global Financials master data and movement data (FinanceLink) (see 

"Transfer Infor Global Financials data" page 1638). 

All documents that can be transferred to a financial accounting system are included in the Infor 

COM posting journal. Each time movement data is transferred, data is retrieved from this journal. 

Only the contents of this journal can be accessed during a transfer. 

Technical note: The journal is saved in the relVALFLPOSTING database table. 

For the most part, it is the field configuration, which you can access by selecting System functions 

> Administration > Field functions, that defines what is written to this journal. While you can adjust 

the field configuration, it is not possible to change the assignment between the fields in Infor COM 

and the fields in Infor Finance. 

This assignment is described in the following section. 
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The result of the transfer is saved in the Transfer date (LinkDate), Transfer status (LinkState), and 

Transfer ID (LinkNo) fields of the posting journal (relValFlPosting table). 

Note: The Transfer date and Transfer ID fields are only populated if the transfer is successful. 

 

The result of the transfer can be as follows: 

0 Document not accessed by transfer 

1 Document transferred successfully 

255 An error occurred during the transfer. 

 

Once transferred successfully, the movement data is either saved in the Infor Global Financials 

database directly, or saved in the Transfer Correction program. This is dependent on the PD (Post 

directly) parameter in the individual transfers. 

 With direct transfers (also known as synchronous transfers), each document is individually 

posted to the Infor Global Financials database directly, provided they do not contain any 

errors. 

 With indirect transfers (also known as asynchronous transfers), a batch of specified 

documents is posted. The number of documents to be transferred in a batch is specified in the 

Batch size parameter. This parameter will only have an effect on postings for which the Post 

directly parameter is not set. 

The batch is saved in the Infor Global Financials database via the Transfer Correction 

program, provided no major errors have occurred, such as an account not being found. For 

less serious errors, the invalid postings are submitted to the Transfer Correction program in 

Infor Global Financials where they can be adjusted. 

Note also that it is not possible for an entire batch to be transferred to Infor Global Financials if 

a major error has occurred with one of the documents and been logged in Infor COM. The 

entire batch will not be transferred until this error has been resolved. 

Note: Infor COM is not notified about the deletion of documents in the Transfer Correction 

program. Deleted documents will therefore still be flagged as Transferred. It is imperative that the 

transfer status of these documents be reset manually in the posting journal, so that this data can 

be transferred again. 
 

Transfer Infor Global Financials invoice postings 

See also Transfer Infor Global Financials movement data (page 1659). 
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The transfer of invoices is configured on the Invoice data tab. To access this tab, select Finance > 

Transfers > Data transfer. 

For information on how the fields in the dialog box are populated, please refer to the 

context-sensitive Help. 

The following configuration parameters are evaluated for the transfer of invoice data. 

 

COMMON.PREISRECHNUNG section 

DEFAULTWE=EUR 

EUROWE=EUR 

EURO=YES 

 

COMMON.ABSENDER section 

UST-ID-NR=DE 

INLAND=D 

 

COMMON.VERTRIEB section 

CHECKPAIDPAYMENTPLAN 

 

COMMON.VALUEFLOW section 

COMMON.VALUEFLOW.SUPPRESSZEROPOSTINGS=yes 

 

COMMON.INFORGLOBALFINANCIALS section 

ANZAHLUNGEN=YES 

USECOMPANYNOASACCOUNT 

Fields 

Invoice header fields 
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General ledger account distribution fields in invoices 

Cost distribution fields in invoices 

Tax distribution fields in invoices (page 1662) 
 

Tax distribution fields in invoices 

A tax entry is generated for each tax flag included in an invoice. If the same tax flag is used in the 

invoice with different debit/credit flags, two separate tax entries are generated. 

Field in IGF XML tag  Field in Infor COM Condition 

Tax Code taxcodeID  TaxTypeIdent + 

TaxRateIdent 

The content of both of these fields is 

concatenated together and must be 

stored in Infor Global Financials as the 

import code for the tax key. 

Credit memo  isCreditnote true/false Dependent on CreditIndicator 

Steuerbetrag in 

Hauswährung  

amountBaseCurrency  BaseVATVal. For final 

invoices: TotalBaseTaxVal 

 

Steuerbetrag in 

Belegwährung  

amountForeign-Currenc

y  

OriginalVATVal. For final 

invoices: 

TotalOriginalTaxVal 

 

 
 

Transfer movement data (Expert mode) 

The transfer of movement data in Expert mode is configured on the Movement data (Expert mode) 

tab. 

This tab is displayed if the COMMON.FIBU.EXPERTMODE configuration parameter is set to yes. 

There are three types of posting available for selection: 

 Invoices (see also Transfer invoices) 

 General ledger postings 

 Cost postings 

For more information, see the context-sensitive Help. 
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Create Infor Global Financials data filters 

For each transfer, you need to define a data filter in the Edit data filter column of the table for the 

individual transfers. You can do this as follows: 

 Right-click in the Edit data filter field to open the input window and manually edit the data filter. 

 In the table, right-click on the row header for the individual transfer and select the Data filter 

command. In this case, the Infor COM dialog box for creating filters is displayed, where you 

can generate an Infor COM filter using the usual filter functions. 

Please note: The data filter cannot evaluate entries such as IN (1,2,3) or NOT IN (1,2,3). These 

entries need to be reformulated. 
 

Transfer Infor Global Financials general ledger postings 

See also: Transfer Infor Global Financials movement data (page 1659) 

General ledger postings are only generated by the value flow function for value flow models 

greater than 0. This type of transfer is therefore not displayed in the dialog box unless the value of 

the COMMON.VALUEFLOW.COSTINGMODEL parameter is greater than 0. 

Rounding accuracy in general ledger postings must be configured using the 

COMMON.FIBU.MAXBALANCINGOFROUNDINGDIFFERENCES configuration parameter. This 

parameter controls the amount up to which rounding difference are reconciled automatically. 

Posting records for which differences are reconciled automatically are logged in mailbox 161. 

Posting records with greater differences are flagged as invalid and are not transferred. 

You can configure the transfer of general ledger postings using the Movement data tab on the 

Data transfer dialog box. The following conditions must be met in order to transfer general ledger 

postings: 

 The General ledger postings check box must be selected. 

 The table on the tab must contain one active record of the type 1 - General ledger posting. 

 The Data filter field must be populated correctly. See Create Infor Global Financials data filters 

(page 1663). 

For more information, see the context-sensitive Help. 
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Infor Global Financials field values entered for compressed general ledger postings 

Document header fields in general ledger postings 

Field in IGF XML tag  Field in Infor COM Condition 

Company companyID COMMON.INFORFINAN

CE.COMPANY 

configuration parameter 

 

Document ID referencenumber   

Belegnummer für 

Storno  

referencenumber-cancel   

Sequence Number sequencenumber LinkNo Transfer ID 

Document date documentdate First day of 

AccountingPeriod 

Business periods in System 

functions in Infor COM 

Posting date transactiondate First day of 

AccountingPeriod 

 

Steuerdatum taxdate ""  

Tax type taxtype TaxTypeEnum.TTE_NO

NE 

 

Document type documenttype   
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General ledger account distribution fields in general ledger postings 

Field  XML tag  Field in Infor COM Condition 

Gen. ledger a/c nominalaccountID  AccountNoExt SACHKONTEN allocation table must be 

maintained. 

Amount in base 

currency  

amountBaseCurrency  basegrossval Gross total in base currency 

Debit/Credit  isDebit true/false If Postingtype=1, then true; otherwise 

false 

Tax Code  taxcodeID   

Gross  isgross   

Posting text  description Description parameter 

evaluated 

 

Analysis codes  analysiscodes.value    
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Cost distribution fields in general ledger postings 

Field in Infor Global 

Financials 

XML tag  Field in Infor COM Condition 

Cost center  costCentreID  costcentre  

Cost type  costtypeID    

Cost units  costunitID  costUnit  

Nettobetrag in 

Hauswährung  

amountBaseCurrency  basegrossval Gross total 

Nettobetrag in 

Belegwährung  

amountForeign-Currency    

Qty  quantity Quantity Total quantity 

Unit of measure  unit Quantifier  
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Infor Global Financials field values entered for uncompressed general ledger postings 

Document header fields in general ledger postings 

Field in IGF XML tag  Field in Infor COM Condition 

Company  companyID  COMMON.INFORFINANC

E.COMPANY configuration 

parameter 

 

Document ID  referencenumber JrnEntryNo  

Belegnummer für 

Storno  

referencenumber-cancel   

Sequence 

Number  

sequencenumber  ID of document in transfer 

batch 

 

Document date documentdate TransactionDate  

Posting date transactiondate TransactionDate  

Steuerdatum taxdate ""  

Tax type taxtype TaxTypeEnum.TTE_NONE  

Document type documenttype   
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General ledger account distribution fields in general ledger postings  

Field in Infor 

Global Financials 

XML tag  Field in Infor COM Condition 

Gen. ledger a/c  nominalaccountID  AccountNoExt SACHKONTEN allocation table must be 

maintained. 

Amount in base 

currency  

amountBaseCurrency  basegrossval Gross amount in base currency 

Debit/Credit  isDebit true/false If Postingtype=1, then true; otherwise 

false 

Tax Code  taxcodeID   

Gross  isgross   

Posting text  description AccountName  

Analysis codes  analysiscodes.value  Analysis1 to Analysis10  
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Cost distribution in general ledger postings 

Field in IGF XML tag  Field in Infor COM Condition 

Cost center costCentreID  costcentre  

Cost type costtypeID    

Cost units costunitID  costUnit  

Nettobetrag in 

Hauswährung 

amountBaseCurrency  basegrossval Gross 

Nettobetrag in 

Belegwährung 

amountForeign-Curren

cy  

basegrossval Gross 

Qty quantity  Quantity Qty 

Unit of measure unit  Quantifier  

Posting text description    

 
 

Transfer Infor Global Financials invoice postings in Expert mode 

To transfer invoices in Expert mode, the following conditions must be met: 

 The Invoices check box must be selected. 

 The table on the tab must contain at least one active record of the type 2 - Invoice posting. 

 The Data filter field must be populated correctly. See Create Infor Global Financials data filters 

(page 1663). 

For more information, see the context-sensitive Help. 

With this record type, other parameter settings will have the same effects as in the case of a 

standard invoice transfer. For more information, see Standard invoice transfers (see "Transfer 

Infor Global Financials invoice postings" page 1660), which also includes a description of how the 

various fields are populated. 
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Transfer Infor Global Financials cost postings 

Cost postings can be transferred directly to the Infor Global Financials cost accounting system. 

General ledger postings are only generated by the value flow function if the value flow model used 

is greater than 0. This transfer is therefore not displayed in the dialog box unless the 

COMMON.VALUEFLOW.COSTINGMODEL parameter is populated with a value greater than 0. 

Cost postings can be calculated from these general ledger postings and invoice postings. 

You can configure the transfer of cost postings using the Movement data tab on the Data transfer 

dialog box. To transfer cost postings, the following conditions must be met: 

 The Cost postings check box must be selected. 

 The table on the tab must include at least one active line of the type 3 - Cost posting.  

 The Edit data filter field in the table must be populated correctly. 

If the cost accounting information is posted to the cost accounting system directly, this data must 

not be included in the corresponding invoice and general ledger transfers. To ensure this, select 

the ICC (Ignore cost center) and ICU (Ignore cost unit) check boxes. When selected in 

combination, these check boxes ensure that the cost accounting data is not included in this 

transfer. 

Once the cost postings have been transferred successfully to the cost accounting system, the 

information about when the transfer took place is saved as follows: 

 The transfer date is written to the ResString2 field. This is a text field. The date is the day on 

which the transfer took place. 

 The transfer status is written to the ResReal3 field: 

 0 = Record not transferred yet (zero) 

 1 = Transfer successful 

 255 = Transfer not successful 

The fields are not displayed in the posting journal and can be accessed in Data maintenance only. 
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Field assignment 

Infor Global Financials online functions 

For an overview of the process of transferring data to Infor Global Financials, see Infor Global 

Financials Data transfer (page 1634). 

All online functions evaluate the 

COMMON.INFORGLOBALFINANCIALS.USECOMPANYNOASACCOUNT parameter. 
 

Infor Global Financials company accounts 

Read company account from Financials 

The online function for reading a company account from the financial accounting system forms the 

basis for the functions described in the following section. 

Technical notes 

For customers who want to make customizations, the following fields are provided in the 

CustomContext of the Infor.Finance.FinanceLink::ReadPersonalAccount Lj4 function:  

 balance (real) – Customer balance from Infor Global Financials 

 code (String) – Company code of customer from Infor Global Financials 

 companyID (String) – Company ID of the company read from Infor Global Financials 

 creditlimit (real) – Customer credit limit from Infor Global Financials 

 deliverystop (bool) – Supplier suspension from Infor Global Financials 

 netbalance (real) – Customer net balance from Infor Global Financials 

 postingstop (bool) – Posting block from Infor Global Financials 

 timestamp (String) – Time stamp of last customer change in Infor Global Financials 

 type (String) – Account type (Customer=0, Supplier=1) 
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Credit limit, Balance 

For the credit limit check, two values – the stored credit limit and the outstanding items total – are 

read from the financial accounting system and displayed in the company master on the Company 

account tab. The account must be created in Infor Global Financials, and the status of the 

company account must be >= 1. 

Both values are saved in the relFinAcAcctState table. A function is provided for the credit limit 

check in Infor COM that allows this value to be read online from Infor Global Financials. 

Note: This function requires the COMMON.FIBU.ONLINEPERSACC=yes parameter. 

The credit limit check function can therefore query the data in Infor Global Financials before 

carrying out each check. 

If a value greater than 0 is written to the Credit limit field in Infor COM, the  Credit limit check 

check box will be selected automatically for this customer. 

While the customer data is being read from Infor Global Financials, the Delivery Block and Reason 

for Block fields are also read from Infor Global Financials and displayed in Infor COM. 

These fields can be viewed in the company master on the Customer business data tab. 

Calculate company account ID 

When a customer or supplier is created in Infor COM, a check is carried out to determine whether 

the account ID already exists in Infor Global Financials. 

The link between Infor COM and Infor Global Financials is defined in the company master via the 

Company account field (relAcp table, AcpPart.InlKto field) provided the 

COMMON.INFORGLOBALFINANCIALS.USECOMPANYNOASACCOUNT=no configuration 

parameter is set.  

Otherwise, the company ID is used (relFirma table, FirmaNr field). 

The system then checks whether this company account has already been assigned to another 

customer or supplier in Infor COM. Each ID can occur once for customers and once for suppliers. 
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If the status returned indicates that the company account exists, it means this company account ID 

can be used. If the company account already exists, the ID is incremented by one and another 

check is carried out (first in Infor COM, then in Infor Global Financials) to determine whether this 

new company account ID is already in use.  

In certain situations, this internal process can lead to a deterioration in performance when creating 

business partners. As a result, the check is only carried out if the 

COMMON.INFORGLOBALFINANCIALS.USECOMPANYNOASACCOUNT=no parameter is set. 

This check is not necessary in other situations.  

Note: The check is only carried out if the COMMON.FIBU.ONLINEPERSACC=yes parameter is 

set in the configuration. 

Outstanding items 

In the financial accounting system, unpaid invoices exist in the form of outstanding items. If 

permitted by the financial accounting package, it is possible for these outstanding items to be 

exported by the interface. 

Once exported from the financial accounting system, the current outstanding items from Infor 

Global Financials are displayed on the Outstanding items tab in the company master. 

When the outstanding items are updated and displayed, all outstanding items for the current 

business partner are loaded from Infor Global Financials. 

The outstanding items are not saved in Infor COM. This also means that it is not possible to 

evaluate outstanding items in Infor COM. 

The program used for updating and displaying the outstanding items loads all of the outstanding 

items from Infor Global Financials for the business partner that you just opened. The outstanding 

items are displayed temporarily - they are not saved in Infor COM. 

Note: Outstanding items are only displayed in Infor COM if the 

COMMON.FIBU.ONLINEPERSACC=yes parameter is set in the configuration. 
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Infor Global Financials down payments/payment-on-account invoices 

This Help topic describes how down payments and payment-on-account invoices are read from 

Infor Global Financials. 

Down payments are payments that are made before a service is performed. Payments on account 

are payments that are made after a service has been performed in part. In both cases, an invoice 

must be issued in advance. 

Note: From a tax perspective, down-payment invoices and payment-on-account invoices are 

treated in the same way. For clarity, the term payment-on-account invoice is therefore used in the 

section below to refer to both types of payment. 

A final invoice is the closing invoice that settles the account. 

Final invoices with existing payments on account (page 1674) 

Final invoices with outstanding payments on account (page 1675) 
 

Final invoices with existing payments on account 

When creating final invoices in Infor COM, existing payments on account that have already been 

made for the relevant order must be taken into account. The required information must be taken 

from the associated financial accounting system. 

For data to be read from the financial accounting system when a final invoice is created, the 

COMMON.VERTRIEB.CHECKPAIDPAYMENTPLAN=yes parameter must be set in the 

configuration. The COMMON.INFORFINANCE.ANZAHLUNGEN=yes parameter must be set also. 

In Infor Global Financials, the Final Invoice with DPR check box under Finance Setup must not be 

selected. 

The payments made by a customer are read from FinanceLink using the customer ID and order ID 

from Infor Global Financials, and are displayed on the final invoice in Infor COM. The total value of 

the payments that have already been made are deducted from the overall order value. The 

individual payment amounts are broken down on the issued payment-on-account invoices. 
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In Infor COM, the payments printed on the final invoice are saved in the relFinAcFinalINvPay 

table. If the final invoice is transferred to Infor Global Financials at a later stage, the payment data 

is read from this table and the final invoice is updated with this information. 

These payments can also be assigned to final invoices in Project. In this case, the dialog box used 

for selecting the down payments/payments on account to be settled on the final invoice will include 

a new tab that lists the payments that were found in the financial accounting system. 
 

Final invoices with outstanding payments on account 

Infor Global Financials also allows final invoices with statistical outstanding items to be set off and 

the conversion of these into actual outstanding items. This means that all issued 

payment-on-account invoices do not need to be paid in full before a final invoice can be 

transferred. 

The following parameter must be set in this case: 

COMMON.VERTRIEB.CHECKPAIDPAYMENTPLAN=no. The 

COMMON.VERTRIEB.ANZAHLUNGEN=yes parameter must be set also. 

In this case, the down payments and payments on account that were previously printed in Infor 

COM are printed again on the final invoice. When the final invoice is printed, the outstanding item 

IDs of the statistical outstanding items that exist for this order in Infor Global Financials are loaded 

and linked with the final invoice. If the final invoice relates to a project, you will be able to select the 

exact statistical outstanding item for this order that is to be offset against this final invoice. If the 

final invoice relates to a project, you will be able to select from all statistical outstanding items for 

this order the exact item that is to be offset against this final invoice. 

In order to process final invoices in this way, a number of settings must be made in Infor COM and 

Infor Global Financials. 

 In Infor Global Financials, the Final Invoice with DPR check box in Finance Setup must be 

selected and a corresponding clearing account must be specified. This clearing account is 

required in Infor Global Financials in order to convert statistical outstanding items into actual 
outstanding items. 

 This clearing account must be stored as a revenue account on the Accounting tab of the 

payment plan in Infor COM. 

Please note: The balance of this account must always be 0. If this is not the case, 

please contact support and provide an extract of this account. 
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 In Infor Global Financials, an account must be entered in the Down Payment Control Account 

field on the Default tab in Customers. 
 

Infor Global Financials online business partner link 

When the master data for a customer or supplier is saved, the processes for transferring business 

partners to the financial accounting system are called for this customer or supplier. During this 

process, all configuration parameters and saved interface configuration settings are evaluated. 

This online transfer function is activated by the COMMON.FIBU.ONLINEPERSACC=yes and 

COMMON.FIBU.ONLINE.BUSINESSPARTNER=yes parameters in the configuration. 

 
 

View log in Infor Global Financials Data transfer 

See also Infor Global Financials Data transfer (page 1634). 

This Help topic describes how the data transfer log can be viewed. 

Note: Online functions are not logged. If an error occurs with an online function, a message is 

displayed directly on the screen for the user. 

1. Select Finance > Transfers > Data transfer. 

2. Click the Logs button. 

3. In the following Select logs dialog box, select the movement data and master data for which 

the log is to be displayed, and then click OK. 

The following Logs dialog box contains a tab for each selection. This tab includes a table 

that lists all of the transfers that were carried out for that selection. If an error occurred 

during a transfer, an error ID is set here. The exact error text is saved in the detailed log. 

4. Optional: Click the Details button to display the details for the selected transfer in a separate 

dialog box. If errors have occurred, this dialog box will allow you to view exactly which errors 

have occurred for which data record. 
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Note: You can print out this detail list or export it to Excel via the shortcut menu for the 

table. 

To delete the log entry from the overview table and all corresponding details from the 

corresponding detail table, click the Delete button. 

Technical notes 

 For all movement data transfers, the transfer ID corresponds to the transfer ID that was 

calculated by numbering method 220 and entered in the postings (Posting journal – 

Transfer IDs). 

The transfer IDs used for all master data are not calculated by a numbering method and 

instead an incremental transfer ID is used. 

 The log entries for the individual transfers are saved in the relFinLReportGeneral overview 

table. The details for each transfer are saved in the following tables: 

relFinLRCostCentres – Cost centers  

relFinLRCostUnits – Cost units  

relFinLRCustSuppliers – Business partners  

relFinLRExchangeRates – Currency rates  

relFinLRGeneralLedgers – General ledger accounts  

relFinLRPaymentTerms – Payment terms  

relFinLRCostPostings – Cost postings  

relFinLRDebitsCredits – General ledger postings  

relFinLRInvCredNotes – Invoices  

 The overview table and details table are linked via the transfer type, transfer ID, and 

transfer date. 

5. Optional: Select the Show only records that contain errors check box to display records with 

transfer errors only. Any further restrictions selected via the shortcut menu for the table will 

apply to these invalid records only. 

6. Optional: Right-click on the row header to make a selection via the shortcut menu. 
 

Set up Batch control for Infor Global Financials data transfers 

The following Help topic describes how to set up data transfers via Batch control. 

1. Select System functions > Administration > Batch control. 
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2. On the Action tab, enter Infor.Finance.FinanceLink::IUI.FinanceLinkBatchStart as the action. 

3. Select the Parameters required check box. 

4. Select Functions > Edit parameters. 

5. On the various tabs of the Data transfer dialog box, select all of the transfers that are to be 

carried out on a regular basis. Batch control always carries out all master data transfers first, 

and then all movement data transfers. Click OK to save your entries. 

Please note:  You can also enter the data transfer job in Batch control multiple times. 

This is useful if different data types are to be transferred to the financial accounting system 

at regular but different intervals. In this case, you need to define individual transfer 

parameters for each job. 

6. On the Status tab, enter the status Released for the previously created job. 
 

Error analysis for Infor Global Financials data transfers 

If an error occurs, and you need the help of the Infor support team in order to analyze the error, 

please send the following information to support along with a full case description: 

 Configuration settings 

 Lj4 level-1 trace for the process in question based on a small volume of data, where possible 

 Log file for Infor Global Financials server (single.log) 

 financelink.log file 

 Output file from FinanceLink transfer. In the standard version, this file is defined in the 

configuration via the 

COMMON.INFORGLOBALFINANCIALS.DEBUGFILEPATH=C:/VarialOutput.xml 

parameter. 
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For general information on FinanceLink, see FinanceLink (page 1595). 

The following Help topic describes how to configure and carry out the transfer of data from Infor 

COM to DATEV. 

Organization of the Help topics 

The Help topics that describe the transfer of data are divided as follows: 

 

 
 

Transfer data to DATEV 

For general information on transferring data to DATEV, see Datev (FinanceLink) (see "DATEV 

data transfer" page 1679). 

For master data and movement data to be transferred to DATEV, you must define the correct 

configuration for the data transfer. 

Please note that once a file has been generated, it must be deleted before a new transfer file can 

be generated. 

Transferring master data 

1. Select Finance > Transfers > Master data. 

2. Select the business partner whose data you want to transfer, or define the required setting in 

the Business partner section. 

3. Click OK. 

DATEV data transfer 
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Transferring movement data 

1. Select Finance > Transfers > Movement data. 

2. In the Date from and Date to fields, select the period for the data transfer. 

3. Click OK. 

 

Note: Any errors that occur during the transfer are logged in mailbox 161. 
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GPP is used for planning in Project . To access GPP, open Sales and then the GPP folder. 

With the help of the Planning board, GPP provides graphical support to Project resource planning 

(see "Project resource planning (GPP)" page 1698). When planning the employees required for 

projects , GPP takes into account their planned attendance in TIME (Employee capacity (see 

"Employee capacity data" page 1691)). 

Please note: The access options described depend on the licensing of the respective 

components and may not be available, or may be only partially available, in your system. 

Note: Depending on the configuration, you may need to select a user profile (see "Configuration 

(GPP)" page 1682) at start-up. 

 

GPP 
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This topic contains general information on GPP (page 1681). 

GPP has a number of configuration options. To access the configuration, select System and 

Configuration. 

Help on the settings of the individual tabs is available in the form of a ToolTip when you position 

your mouse pointer over a setting. 

More detailed Help on the fields of the individual tabs is available via the following links. 

Please note: The way in which the tabs are displayed can vary depending on whether you are 

using Service or Project. 

 

Configuration (GPP) 
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This topic contains general information on GPP (page 1681). 

Once you have started GPP, proceed as follows to carry out the data exchange between Infor 

COM and GPP.  

 

Start GPP from Service 

1. Select File and Data transfer, or click the Data transfer button. 

Note: If both Service and Project are activated, the Service resource planning tab and Project 

planning tab will be available when you select this command. 

2. You can use the Service resource planning tab to load orders from the database to GPP. 

Please note: The order types for the orders to be loaded are preset in accordance with the 

settings in the ISVCSOHTYPE allocation table. 

 For more information, see  

3. Then click Find to display a table containing all service orders that match the values selected in 

the dialog box. Orders that are displayed but not yet loaded are highlighted in gray in the first 

column of the table. 

Note: To add additional values, change the values in the dialog box header and click Find 

again. 

4. Click Load to load all orders that are displayed and selected in the first column. Resources and 

additional data that are referenced in the order data are also loaded automatically. 

Note: Orders that have been loaded but not yet changed are highlighted in green in the first 

column of the table. 

5. Note the following editing options for the display: 

 Click Delete and Update to display all orders that are currently loaded. 

 Select System and Delete all objects to delete all loaded data from the main memory. All 

changes that have not been saved are lost when you do this. 

 Double-click a row in the table to load the order. 

Data exchange GPP - Infor COM 
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User privileges administration 

The privileges of GPP users can be managed or restricted in the following ways: 

 

 Select System and Configuration. On the Transfer tab, specify whether the user can write 

modified data to  tables. 

 If you are logged on with the Administrator profile, you can select Administration and User 

administration and use the Configuration? column to specify whether the respective user has 

access to the configuration. 

Please note: If this check box is cleared, the user in question is not granted access to the 

System -> Configuration menu command and is also unable to change user profile. You 

should not under any circumstances deactivate the configuration for the Default user or for the 

users for which the Default option is activated in the Default column. 
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Note: The following description on maintaining shift plans applies to both APS and GPP. 

To access the shift plans, start APS or GPP, open the Data menu and select Shift plans > Display 

shift plan data. The functions provided by this command depend on the settings defined in the 

configuration. For more information about the fields displayed, see below. 

This dialog box displays an overview of the shift plan data that was loaded and is used for 

checking data. 

(Annual) shift plans in APS, like in Infor COM are composed of intervals, shifts, days, and weeks. 

In addition, shift plan chains are formed from successive annual plans. The individual shift plan 

objects of a shift plan chain can be listed here and the exact composition of the chain can 

therefore be checked. 

From, To (fields) 

These fields display the period for which shift plan data exists. 

Displayed, From 

These fields show the current and maximum number of pages respectively that you can scroll to 

by clicking the buttons on the right of the table. 

From, To (columns) 

These columns show the period covered by a shift plan object. 

Duration 

Shows the duration of the period covered by a shift plan. 

Type 

Displays the shift plan type. See also Store working hours in shift plan (APS). You can also filter 

the displayed shift plans according to type. To do this, use the Filter field. 

Please note: Use the Database or Files configuration setting on the Working hours tab to define 

whether you want to transfer the shift plans directly from the database or whether you want to 

maintain them redundantly - like in Infor COM Release 6.1. 

Shift plans 
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Maintain shift plans 

Please note: The maintenance of shift plans depends on the configuration described in the 

associated topic. 

The shift plans are structured in exactly the same way as those in Infor COM; in other words, you 

create annual shift plans that contain all information related to the working hours of one year. This 

type of annual plan consists of 52 (sometimes even 53) weeks. For each weekday, a special daily 

plan must be set up that, in turn, consists of the shifts specific to the company. The exact time 

intervals (shift duration, breaks, overlapping of shifts) are defined in the intervals. 

 The smallest unit of a shift plan is therefore the interval, followed by the shift, the day, the week 

and finally, the year (annual plan). 

Complete the following steps to create shift plans in APS/GPP: 

1. Define basic working hours (intervals, shifts, days, weeks) 

2. Define public holidays and other days that are generally non-working days 

3. Create annual plans based on this data 

4. Assign the annual plans to the shift plan IDs in the Infor COM database 
 

Store working hours in shift plan 

To store working hours in a shift plan (see "Shift plans" page 989), complete the following steps: 

1. From the Data menu, select Shift plans and then Edit shift plans to open and edit a shift plan. 

2. Before you can create a new annual plan, you need to define the basic working hours. First, 

define the intervals (in other words, the working hours without breaks) by clicking the New 

button next to the interval table. 

3. In the dialog box, enter a name for the new interval (one that does not already exist). 

4. Specify the start and the end of the interval in the table. 

Please note that the start time must be before the end time and that times after 0:00 must be 

specified as 24+x. If, for example, an interval begins at 23:00 and ends at 5:00, you must enter 

the end time as 24+5 = 29:00. 
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5. After you have created the intervals, you specify the shift combinations. To do this, select the 

New, button, enter the name of the shift plan in the dialog box that is displayed, and then enter 

the intervals for the shift plan. 

 

Note: When you create the days, you should make sure that you also create a free day and a 

half day. Using these day elements, the annual plan can take half days and free days into 

account. 

It is also recommended that you create week elements with one additional free day each (in 

other words, one week with Monday free, one with Tuesday free, and so on.). These special 

weeks are used later when you generate the annual plans. If required, APS/GPP can also 

generate these weeks automatically. However, if you create them in advance, you can ensure 

that they are named in accordance with your requirements. 

 

Apart from the New button, the following buttons are also available for further editing: 

 

Copy Creates a copy of the displayed element and saves it under a different name. 

Delete Removes the element displayed. If it is still in use, a corresponding warning 

message is displayed. If you delete the element anyway, APS/GPP replaces 

it with the Default element. 

Usage Displays a tree structure that illustrates the subsequent elements in which the 

element you have selected is used. When you double-click one of the 

elements, it is displayed in the corresponding part of the shift plan window. 

Rename Allows you to rename a shift plan element. This is of particular interest in the 

case of weeks that were created automatically when the annual plan was 

generated. 
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Store non-working days in shift plan 

When generating annual plans, APS/GPP can take public holidays and other non-working days 

into account. To store non-working days and public holidays in the shift plan, complete the 

following steps: 

1. Open the Data menu and select Shift plans followed by Public holidays. If the Load public 

holidays selection window is displayed, select the required file with the information. 

2. Edit the public holiday data in the dialog box that is displayed. When you click the arrow for a 

line in the Type field, a list box will display the type of public holiday available. 

 In the Shift column, you can also assign a shift day to each public holiday by selecting a shift 

day from the list box. When generating the annual plans, the corresponding day in the default 

week is then replaced with this shift day. 
 

Create and edit annual plan 

To create an annual plan, complete the following steps: 

1. Open the Data menu and select Shift plans followed by Edit shift plans. 

2. Click the New button next to the annual plan display to open the input dialog box. 

3. You can now use the From and To fields to create a series of annual plans. This series 

describes a shift plan over a period of several years. In other words, at the end of a year, an 

automatic change to the next year takes place. The shift plans can differ, for example, due to 

the different non-working days to be considered. 

 As well as entering values in the From and To fields, enter a name for the shift plan. For the 

period from - to, this name is then linked with the corresponding years. 

Note:  Use the Predecessor and Successor fields in the Edit shift plans dialog box to modify 

the relations between series of annual plans retrospectively. Note that each annual plan can 

only be a predecessor and a successor to one other plan. 

4. Enter the Week as copy template. This specifies the week that you want to use as the default 

week. 
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5. The file containing the public holidays is used as the basis for the non-working times that need 

to be taken into account. Click the Change button to select a different file or click the Without 

button to continue without taking into account any public holiday-related information. 

6. You can now edit the annual plans you have created in the annual plan table in the shift plan 

dialog box: 

 For example, select Select from the shortcut menu to replace individual weeks. 

 Click the Replace button to replace a week throughout the entire annual plan. 

7. Save the shift plan file using the Save button. A shift plan file can store any number of annual 

plans. 
 

Assign shift plans 

When loading the data, only the IDs of the Infor COM shift plans are transferred from the 

database. In order for APS or GPP to be able to use the correct APS/GPP shift plans during 

scheduling, the corresponding names of the APS/GPP plans must be assigned to these IDs. You 

can do this using a dialog box, which you can open by selecting Data, Shift plans, and Shift plan 

assignment. 

In this dialog box, you assign the shift plans in APS/GPP to Infor COM shift plans. To create a new 

entry, click New. This opens a dialog box where you need to enter the ID of the Infor COM plan. 

Select the required APS/GPP plan as usual using the shortcut menu (right-click). You should enter 

an early year, if possible. Annual plan series make the transition to subsequent years 

automatically. 

After you have assigned the APS/GPP plans to the Infor COM plans, you must save this 

assignment. Use a meaningful file name that describes the contents of the file. 

Note: For technical reasons, the change of shift plan assignments will only take effect after you 

reload the resource and order data. This also means that, for example, the old shift plan data will 

be shown in the planning board until you have reloaded the data. 
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Configure shift plans 

APS/GPP usually requires the shift plan data at the time the system is started; it therefore needs 

to know where to find the relevant shift plan and allocation files. It also requires a default shift plan 

for unresolved situations that it can use when no plan has been specified (for example, because 

no APS/GPP plan was specified for an Infor COM shift plan ID). Define the configuration as 

follows: 

1. Open the System menu, select Configuration and then click the Working hours tab. 

2. In the Shift plans section, select the required settings for the Default shift plan, the Shift plan, 

and the Assignment file. 

Note: These options can only be accessed if the Load shift plans from Files setting is 

enabled. 

The configuration settings for the shift plan data determine which data is loaded by default. 
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This topic contains general information on GPP (page 1681). 

To open this function, select Manufacturing, open the TIME system folder and select Employee 

capacity data. 

Note: The process can also be managed in time control (ODC.PersCap.al_Start function). 

Capacity planning provides data on the expected capacity per person and per day for a specific 

period. The planned attendances of employees can therefore be taken into account when planning 

project tasks and service orders. 

Please note: To be able to use this function, you must select the Employee capacity data check 

box on the Personal details tab in the Employee master. 

The data generated can be used during planning in GPP to take into account 

 whether an employee is available in a particular period - absences due to vacations and illness 

are taken into account here. 

 the number of hours that an employee can be scheduled in a particular period - full-time and 

part-time employment is taken into account here. 

For each day that an employee is present, GPP generates an attendance plan for this employee. 

This plan contains a period (interval) with the duration of the planned attendance for each 

attendance day of the employee. 

Note: Times on the previous day are displayed as negative times and times on the next day are 

displayed as times that have been increased accordingly. 

Example: -4:00, 26:00 

Employees can be grouped by cost center for particular time periods. An aggregate attendance 

plan is generated for each cost center involved. 

In this plan, each interval is assigned a list of employees who are present during the interval 

period. 

Employee capacity data 
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Capacity is calculated based on the time and attendance templates. The Planned attendance time 

type there can be used to determine the breakdown of the planned time (in other words, the 

designated working time per day) over the working day. 

Please note: A plausibility check is not carried out for planned attendance and planned times 

that have been entered. 

If no Planned absence has been entered, the planned time is used for calculating the capacity.  

Note: In the case of half-day absences, all existing planned attendance intervals are evaluated for 

the working day in question. If no attendance intervals have been entered, half of the planned 

absence time is taken for calculating the capacity. 

 
 

Display capacity supply and capacity requirements 

For general information on calculating capacity data, see Employee capacity data. 

This current Help topic describes how the calculated capacity data is displayed. 

The following views are used for displaying the available capacity: 

 In the resource views of the planning board, the shift plans represent the attendance plan for 

employees, and the aggregated attendance plan for cost centers. They are indicated by the 

green lines at the bottom of the view (1), see screenshot. 

 

 For work centers, the capacity requirement is displayed using a graph and the capacity supply 

is displayed using a constant line. For cost centers, both capacity requirements (2) and the 

capacity supply (3) are displayed using a graph. 

 In places where the capacity supply curve is below the requirement curve, the space in 

between is highlighted in red. 

 The ToolTip for the capacity graph shows which employees were scheduled for the current 

time for this cost center. Assignments are made by the day. 

Example: There are generally no assigned employees displayed for Sundays. 

 

The following views show how shift plan lines, capacity supply curves and capacity requirement 

curves come about. 

Note: To check the data, open the Data menu and select Shift plans and Display shift plan data. 

The starting point is a cost center (C) with three employees (E1-E3) in a company with three shifts. 
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Shift plan line 
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Day 1 Day 2 Day 3 

 

The screenshot shows a three-shift operation for three consecutive days. Employee 1 (E1) works 

the first shift on all three days, employee 2 (E2) works the second shift on all three days. Employee 

3 (E3) works the first shift on the first two days and does not work on the third day. 

Row C shows the aggregated attendance plan for cost center C. The cells displayed in gray in row 

C are depicted by a green shift plan line in the cost center and employee views in the planning 

board. 

Capacity supply 

 

C 
                 

 

                 

 

 

Day 1 Day 2 Day 3 
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This graphic shows the capacity supply for cost centre C on the basis of the data described in the 

Shift plan line example. The higher the graph, the greater the number of employees present at the 

time in question. 

 

Employee assignment 
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Day 1 Day 2 Day 3 

This graphic shows the employees' assignment due to scheduled activities 1 - 4. These activities 

are shown as continuous bars in the Gantt view, that is, the bars are not interrupted for the 

non-working times. For employee 1, activities 1 and 4 overlap on the third day. 
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Capacity supply and capacity requirements 
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Day 1 Day 2 Day 3 

The conventional capacity graph like the one in the above graphic runs in parallel with the bars of 

the Gantt view, in other words, a utilization is also displayed for the non-working times. The red 

line shows the capacity supply, that is, the maximum possible number of parallel operations. This 

display facilitates a direct comparison of the Gantt view and the graph view. 
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Day 1 Day 2 Day 3 

Unlike the previous graphics, this graphic with its combination of capacity supply and capacity 

requirements only shows the actual assignment. A utilization is only displayed if work is actually 

being carried out. This facilitates a comparison of the supply graph and the demand graph. The 

light gray areas show where the capacity supply exceeds the demand. The red area shows where 

there is not enough capacity available. 

 

 

The examples so far are based on activities being assigned to an employee. The differences 

between assigning an activity to an employee and to a cost center are shown below. 

The above Shift plan line example is used as the basis for the capacity supply. 

The following two graphics show the effects that the assignment to an employee and the 

assignment to a cost center have for the duration of activity 5. 
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This graphic shows the duration of activity 5 for scheduling on the basis of employee 1 (E1). The 

processing time is 3 days. 

Cost center 

C 5 5 5 5 5 5 5 5 
         

 

                  

 

 

Day 1 Day 2 Day 3 

 

This graphic shows the duration of activity 5 for scheduling on the basis of the cost center. As 

shown in the bottom row, the cost center provides two shifts per day (this corresponds to 4 cells in 

the graphic). The duration of the activity is therefore 1.5 days. 

 

If activity 5 is scheduled in addition to the activities 1 to 4 shown in the Employee assignment 

example above, the capacity graph will also vary according to whether scheduling was carried out 

for the cost center or for an actual employee. 

See the following image also. 
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Day 1 Day 2 Day 3 

This graphic shows the capacity graph for the additional scheduling of activity 5 on the cost center. 

All of the cost center's available capacity is used. 

  

5 
    

5 5 
    

5 
    

 

 

5 1 
    

1 1 
    

4 5 
   

 

C 3 3 
 

2 
  

3 3 2 2 
  

1 4 2 2 
 

 

 

Day 1 Day 2 Day 3 

This graphic shows the capacity graph for the additional scheduling of activity 5 for employee 1. 

Here, the available capacity in E2's second shift cannot be used. 
 

Update capacity data 

For general information on calculating capacity data, see Employee capacity data. 

The generation of employee capacity data for a long period and a lot of employees can lead to 

significant data volumes, which in particular has a negative effect when loading data in GPP. 

In practice, it is therefore recommended that you generate the data in TIME for a manageable 

period (3 months for example) and that you generate the data for the remainder of the time on the 

basis of estimated values. 

Define the creation of this data in the configuration (see "Configuration (GPP)" page 1682) on the 

Working time tab in GPP. 
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For general information on project processing, see Project processing basics. 

This topic contains general information on GPP (page 1681). 

A project describes a collection of services that must be provided at a particular time. Material 

resources and Time resources are required in order to provide these services. The time resources 

that are of relevance for GPP are Employees and Cost centers. 

The services to be provided as part of a project are structured using project lines, whereby a 

distinction is made between Group lines (GL), which group together various individual services, 

and Single lines (SL), which describe exactly one service. Single lines are subdivided into single 

material lines (SML) for material requirements and single operation lines (SOL) for employees and 

work centers. 

Project resource planning in GPP allows you to take planned attendances into account when 

scheduling project activities for employees. 

Please note: To use employee resource planning, the  

COMMON.IPROJ.PLANPERSONAKTIV parameter must be set to yes. If applicable, the 

COMMON.IPROJ.PLANPERSONISTWERTE and COMMON.IPROJ.PLANPERSONISTPROGNOSE 

parameters must also be set to yes in order to enable the calculation or forecasting of actual 

values. A further prerequisite for using employee resource planning is the maintenance of 

employee capacity in TIME. Employee capacity is required in GPP so that the planned absences 

of employees can be taken into account. 

 
 

Evaluation (GPP) 

Note: This function is not available for Service. 

Certain planning conditions are checked in GPP using rules. This check takes place: 

 Automatically when you click a bar - the descriptive text for the line and all the rules that were 

violated are displayed in the information window. 

Project resource planning (GPP) 
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 When you select Data and Evaluation for all loaded project data. 

When you select Data and Evaluation, the active rules are checked for all loaded project data and 

the result is displayed in the evaluation table. 

Evaluation table 

The total number of penalty points that was calculated for the current evaluation is displayed in the 

header of the table. This total can be used as an indicator of the overall quality of the project plan. 

For each violation (that is each row in the table), you can open a shortcut menu that takes you to 

the planning board where you can view the associated project and make improvements, if 

applicable. 

Rules 

Rules consist of a violation condition, a (maximum) penalty point number, and a function for 

calculating the severity of the violation. 

 The violation condition is used to check whether the rule was violated. 

Example: Does a coordination date end after its milestone? 

 The number of penalty points evaluates the relevance of a rule. The violation of an important 

rule results in more penalty points than the violation of a rule that is less important. The total 

number of penalty points for all violated rules can be used as an indicator of the quality of a 

project plan. 

 You can specify in the rule definition when a rule is violated 100 percent or when a violation is 

less relevant and therefore only results in a proportion of the maximum number of penalty 

points being applied. 

 

Using the menu command Data and Rules, you can view, (de)activate, or change the evaluation of 

the available rules. The following link shows an overview of the available rules. 

Overview of the available rules 
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Rule Description 

Plannable work center Checks whether the current work center of a single operation line is 

plannable. 

Work center overlap Checks whether scheduling the single operation line for the current date 

causes an overlap on the work center / work center group, or in other words, 

whether more than the maximum number of operations are scheduled in 

parallel. 

Earliest planning date violated Checks whether a coordination date for which no transaction has yet been 

entered was scheduled before the earliest planning date (generally Today or 

Tomorrow) and is therefore delayed. 

Milestone not reached Checks whether a coordination date violates its milestone. 

Sequence forward/backward Checks whether the predecessor/successor sequence is taken into account in 

the scheduling of the coordination date. 
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Plastics is a special add-on module for Infor COM users in the plastics processing industry. 

Plastics must be purchased separately; otherwise, the functions and tabs will not be available. 

The scope of Plastics includes:  

 The PLASTICS section for defining parameter settings. 

 Separate allocation tables (see "Allocation tables (Plastics)" page 1703). 

 The Plastics tab in the item master data (Design > Items). You can use the new Plastics record 
type (see "Record types (Plastics)" page 1708) on this tab to flag items as injection molded 

items in general, or as granules, shipping materials, or other materials. For injection molded 

items, the different weights such as the net item weight, sprue weight, or shot weight are also 

specified or calculated automatically on this tab. 

 The BOR work center, BOR tool and BOR material tabs in the item master data. These tabs 

record data for the BOR (see "BORs in Plastics" page 1712) of an injection molded item. 

When the injection molded items master data is saved, the individual tabs generate the 

assembled BOR for an injection molded item. 

 The PLASTICS and PLASTICS information tabs in the BOR object for displaying data specific 

to injection molded items. 

 The Parameter tab in the item master data, work center master data, and tool master data to 

save plastics-specific parameters. 

 The PLASTICS information tab in the Production orders object (Manufacturing) to display the 

specific data for the injection molded items to be manufactured. 

 The Convert alternative text records (see "Convert alternative text records function (Plastics)" 
page 1710) function for converting alternative AO (alternative operations), AMA (alternative 

material records), and ATL (alternative tools) text records into OP records, MA records, and TL 

records. 

 The Adjust cards object to record and manage Adjust cards (see "Adjust cards (Plastics)" 

page 1717). 

 

Plastics overview 
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The following allocation tables form part of or are used in the Plastics add-on: 
 

PLSTACDESC 

Description: PLASTICS adjust cards: Parameters 

Usage: Management of parameters for Adjust cards (see "Adjust cards (Plastics)" page 1717). 

This Plastics allocation table contains the parameters you can select in the Adjust cards object on 

the Parameter #-#-# tabs in the Parameter # field.  

Type: This allocation table can be modified by the user. 
 

PLSTACREP 

Description: PLASTICS adjust card: Document names 

Usage: In this allocation table, you must specify the documents that are to be made available for 

the printing of adjust cards (see "Adjust cards (Plastics)" page 1717). In the standard version, 

printing is managed using the irPlastAdjustCard report. The standard report is defined using the 

PLASTICS.ADJUSTCARD.REPORTNAME parameter. 

Type: This allocation table can be modified by the user. 
 

PLSTACRTYPE 

Description: PLASTICS adjust card: Record types 

Allocation tables (Plastics) 
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Usage: This Plastics allocation table contains the record types with line types. Use these record 

types to define which fields must be entered in the Adjust cards (see "Adjust cards (Plastics)" page 

1717) master data in order to be printed on the adjust cards.  

For an example of how these record types are handled, click here (see "Enter data for adjust cards 

- examples (Plastics)" page 1720).  

Type: Additional records can be created. They must be considered in the associated report. 

Value 

The abbreviation for the record type. 

Description 

The description tells you which fields can be populated for each record type. 
 

PLSTACSTATE 

Description: PLASTICS adjust card: Statuses 

Usage: Available status types for adjust cards are stored in this Plastics allocation table. 

For general information about adjust cards, see the Adjust cards (see "Adjust cards (Plastics)" 

page 1717) Help topic. For detailed information on the possible statuses, see the section on the 

Status field in the Adjust card header Help topic. 

Type: The user is not allowed to modify this allocation table. 
 

PLSTACTYPE 

Description: PLASTICS adjust card: Types 

Usage: Available types of adjust cards (see "Adjust cards (Plastics)" page 1717) are stored in 

this Plastics allocation table. 

Type: The user is not allowed to modify this allocation table. 
 



Infor COM 7.5 User Guide | 1705 

 

Plastics 

 

PLSTLABEL 

Description: PLASTICS label printout 

Usage: Reports available for label printout must be entered in this allocation table of the Plastics 

add-on. 

The reports are available for selection in the Print dialog box (Production orders > Functions > 

Manufactured item label ...) in the Label name field. 

In the standard version, printing is managed using the irPlastPPCLabel report. The default report 

is defined using the PLASTICS.LABELPRINT.REPORT parameter. 

Type: This allocation table can be modified by the user. 
 

PLSTSAPARAM 

Description: PLASTICS parameters 

Usage: This Plastics allocation table contains parameters you can select on the Parameter tab in 

the tool master data, item master data, and work center master data. 

In the Type field, define the UOM class of the parameter. The UOM classes from the LVTYP 

allocation table are available for selection here. 

Type: This allocation table can be modified by the user. 

 
 

PSATZART 

Description: Plastics record types 
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Usage: This allocation table contains the specific record types for Plastics. A record type 

identifies a data record in a table. For a short description of the record types contained in this 

allocation table, see Record types in Plastics (see "Record types (Plastics)" page 1708). 

Type: This allocation table can be modified by the user. 

The allocation table consists of the following tabs and fields: 

Data 1 

Lang. 

The allocation table is loaded in the language of the editor. If the table contains values in other 

languages, you can view and edit them. To do this, click the plus sign in the Language field in the 

required table row or select Functions > Expand all. See also Create allocation table in more than 

one language. 

Int.RT 

System internal identifications of Plastics record types. 

Description 

This field contains a description of the record type in words. 

RT 

Specifies the ID of a record type as it appears in Infor COM. It usually consists of between one and 

three upper case letters. 

Type 

The type describes the UOM class of each record type. 

Entering a UOM class only makes sense with the IMI, FOL, EXT, SI and GRA record types. 

Therefore, each of these record types has already been assigned to the associated class by 

default. The OMA (Other materials) record type should not be assigned a UOM class. 

The UOM class is checked as soon as one of the record types is selected in the item master data 

(Item object) on the Plastics tab in the PRT field. If the UOM class of the record type does not 

match the unit of measure of the item, a message will appear. 

The available classes are managed in the LVTYP allocation table. 
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Data 2, Data 3, Data 4 

Text 1 - Text 8 

Use these 8 fields to enter specifications for items with record type IMI, FOL, EXT and SI for 

labeling the 8 fields in the item master data on the Plastics tab in the Injection molded item section. 

Labeling of the three fields for items in the GRA or SHP record type will be specified using the Text 

6, Text 7, and Text 8 fields. 

If no entries are made in the fields, fixed coded labels from the Plastics tab will be used. They are: 

Net item weight, Sprue weight, Gross item weight, Shot weight, Operation weight, Color, Material, 

Remarks. 

Text 9 

Not used. 
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In order to identify special Plastics item types, the following record types are added to the standard 

record types in Plastics: 

Record 

type 

Int.RT Description Explanation 

EXT EXT Extrusion item The four available types of injection molded item. Each 

of these record types identifies an item (H record) as 

an injection molded item. 

 

FOL FOL Foil 

IMI POR Injection-molded item 

SI SI Stamping item 

GRA GRA Granules Use these record types to identify an item (HR record) 

as Plastics item type Granules, Shipping materials 

or Other material. 
 

 

OMA OMA Other materials 

SHP SHP Shipping material 

MAC MAC Machine The Plastics record type MAC is used to identify a 

work center (OP record) in the BOR of an injection 

molded item. The MAC record has special meaning. 

OOP OOP Other operation All other work centers of the BOR must be identified 

with the Plastics record type OOP. 

T T Tool The Plastics record type for tools (TL record) in the 

BOR of an injection molded item. 

PER PR Periphery The Plastics record type is used for peripheral devices 

(e.g. mills, bulk goods systems, robots) in the BOR of 

an injection molded item. 

 

The Plastics record types are managed in the PSATZART allocation table. 

Two additional record types are introduced with Plastics: 

Record types (Plastics) 
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Record 

type 

Int.R

T 

Description Explanation 

AMA 95 Alternative material These text records provide you with the option of entering 

alternative material and alternative tools in a BOR. If needed, 

they can then be converted to lines using the Convert 
alternative text records (see "Convert alternative text 

records function (Plastics)" page 1710) function. 

ATL 76 Alternative tool 

Note: The AO Alternative operation record type (Int.RT 66) is already included in the standard 

version. 

The alternative text record types are managed in the SATZART allocation table. 
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This function is used to convert alternative text records into lines. This exchanges the applicable 

text records and lines. 

The following conversions are available: 

SVO Int.

RT 

Description  SVO Int.RT Description 

AO 66 Alternative operation <-> OP 60 Operation* 

ATL 76 Alternative tool <-> TL 90 Tool* 

AMA 95 Alternative material <-> MA 70 Material* 

 

* You can use the PLASTICS.PLASTICS.XTOPOSRECTYPES parameter to specify the record 

types that are permitted for a conversion.  

Please note:  

 The function is only available for items that are identified as an injection molded item using one 

of the PLASTICS record types (see "Record types (Plastics)" page 1708) EXT, FOL, IMI, or SI. 
 Depending on the alternative text records that are supposed to be converted, the function can 

only be accessed in the item master data on the BOR work center, BOR tool or BOR material 

tabs in the item master data (Items object). The function is available on all tabs in a production 

order. 

 The units of measure of the lines must belong to the same UOM class. 

Converting an al ternat ive text record into a l ine:  

You are in the master data of the relevant item: 

1. If you want to convert an AO record into an OP record, display the BOR work center tab. 

 If you want to convert a Tlx record into a TL record, display the BOR tool tab. 

 If you want to convert an Mx record into an MA record, display the BOR material tab. 

2. Select the alternative text record and the line that it will be exchanged with. Keep the CTRL 

button pressed down and click the headers of both lines. 

Convert alternative text records 

function (Plastics) 
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3. Select Functions > Convert alternative text records. The text record and line will then be 

exchanged. The conversion is automatically saved in the BOR of the item. 

4. A message is displayed if the conversion is successful. 

You are in a production order: 

5. Select the alternative text record and the line that it will be exchanged with. Keep the CTRL 

button pressed down and click the headers of both lines. 

6. Select Functions > Convert alternative text records. The text record and line will then be 

exchanged. The conversion is automatically saved in the BOR of the item. 

7. If the conversion is successful, a message is displayed requesting you to carry out scheduling. 

8. Confirm the message by clicking OK. Then select Functions > Schedule. 

9. Select the required options and click OK. 
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The BORs for an injection molded item can be entered in its item master data in Plastics. 

The item master data will be expanded (Items object) to include the Plastics, BOR work center, 

BOR tool and BOR material tabs. 

As soon as the item master data is saved, the BOR will be composed automatically from the lines 

on the individual tabs. 

The correct linking of groups and sorting of lines is ensured by the introduction of a separate 

Plastics record type and by special properties of the Line ID and Ass.WkCtr fields. For a detailed 

description of these fields, see the Help topics for the tabs mentioned above. The sequence within 

a group is controlled using the internal record type ID (Int.RT). 

Example (see "BOR in Plastics - Example" page 1712) 

Please note: Just like other BORs, BORs for injection molded items can be loaded and 

processed in the BOR object. However, specific Plastics functions, such as the calculation of 

weights and material proportions, are only available on the new item master data tabs. 

Otherwise, the general requirements for BORs in Infor COM apply. 
 

BOR in Plastics - Example 

The following example illustrates how Plastics combines data from the BOR work center, BOR 

tool, and BOR material tabs to create an assembled BOR. 

Not all of the fields on these tabs are included in the example. On the other hand, the internal 

record type ID (Int.RT) is shown only in the example. For clarity, the entry of lines and the 

assignment to machine work centers is performed in two steps in the example. During the actual 

application, these do not have to be performed consecutively. Pay special attention to the Line ID 

and Ass.WkCtr fields. 

In the example, the BOR for IMI00R - injection molded item right is assembled. 

BORs in Plastics 
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BOR work center 

The following work center lines were entered: 

Line ID RT (Int.RT) PRT Ass.WkCtr Resource Description 

1 OP (60) OOP  INS001 Inspection final check 

2 OP (60) MAC  IMM001 Injection molding 

machine 1 

3 TX (110)   IMM002 Injection molding 

machine 2 

4 OP (60) OOP  PAS001 Pre-assembly 

The alternative text record IMM002 is assigned to machine work center IMM001. The text record 

then receives the Line ID of this work center. The work center PAS001 thereby moves to line 3. 

The line ID of work centers INS001 and IMM001 remains the same at 1 or 2: 

Line ID RT (Int.RT) PRT Ass. WkCtr Resource Description 

1 OP (60) OOP  INS001 Inspection final check 

2 OP (60) MAC  IMM001 Injection molding 

machine 1 

2 X (110)  IMM001 IMM002 Injection molding 

machine 2 

3 OP (60) OOP  PAS001 Pre-assembly 

BOR tool 

The following tool lines were entered: 

Line ID RT (Int.RT) PRT Ass. WkCtr Resource Description 

1 TL (70) T  TL0099 Mounting device 

2 TL (70) T  TT001 Testing tool 

3 TL (70) T  IMT001 Injection molding tool 

Each tool is assigned to a work center. Each tool is then assigned the Line ID of the associated 

work center and the table is re-sorted: 
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Line ID RT (Int.RT) PRT Ass. WkCtr Resource Description 

1 TL (70) T INS001 TT001 Testing tool 

2 TL (70) T IMM001 IMT001 Injection molding tool 

3 TL (70) T PAS001 TL0099 Mounting device 

BOR material tab 

The following material lines were entered: 

Line ID RT (Int.RT) PRT Ass. WkCtr Resource Description 

0 BH (15)   IMI00L Injection molded item left 

1 MA (90) OMA  S0012 Screw M5/20 mm 

2 MA (90) OMA  N0009 Nut M5 

3 MA (90) GRA  GRA001 Granules PC transparent 

4 MA (90) GRA  GRA002 Granules master batch red 

5 MA (90) OMA  SP0001 Steel pin 5*20 mm 

Each material record (RT=MA) is assigned to a work center. Each material record is then assigned 

the Line ID of the associated work center and the table is re-sorted: 

Line ID RT (Int.RT) PRT Ass. WkCtr Resource Description 

0 BH (15)   IMI00L Injection molded item left 

2 MA (90) GRA IMM001 GRA001 Granules PC transparent 

2 MA (90) GRA IMM001 GRA002 Granules master batch red 

2 MA (90) OMA IMM001 SP0001 Steel pin 5*20 mm 

3 MA (90) OMA PAS001 S0012 Screw M5/20 mm 

3 MA (90) OMA PAS001 N0009 Nut M5 

Assembled BOR 

To view the assembled BOR, go to the Plastics tab in the BORs object.  

Note: The internal record type ID (Int.RT) will not be displayed there. It is indicated additionally 

here to clarify the sorting you performed within these groups. 

First, the header data is noted above the BOR: 
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BOR ID IMI00R Resource IMI00R  Injection 

molded 

item 

Record 

type 

H

R 

The assembled BOR is located below the header data: 

RT (Int.RT) Resource PRT Line ID Ass. WkCtr Line 

BH (15) IMI00L  0  1 

OP (60) INS001 OOP 1  2 

TL (70) TT001 T 1 INS001 3 

OP (60) IMM001 MAC 2  4 

TL (70) IMT001 T 2 IMM001 5 

MA (90) GRA001 GRA 2 IMM001 6 

MA (90) GRA002 GRA 2 IMM001 7 

MA (90) SP0001 OMA 2 IMM001 8 

TX (110) IMM002  2 IMM001 9 

OP (60) PAS001 OOP 3  10 

TL (70) TL0099 T 3 PAS001 11 

MA (90) S0012 OMA 3 PAS001 12 

MA (90) N0009 OMA 3 PAS001 13 

The line sequence is based on the line IDs (see Line ID field). If the same Line ID occurs within a 

group (of work centers), sorting will be performed ascending by internal record type ID (Int.RT). 

The Line column contains the line IDs that apply to the assembled BOR. 
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To print labels inPlastics (see "Plastics overview" page 1701), complete the following steps: 

1. Load the production order. 

2. Select Functions > Manufactured item label..., which will open the Print dialog box. 

3. Enter the settings. 

4. Click OK, which will close the dialog box and start the printout. 

The parameters for the label printing function in Plastics are set in the PLASTICS.LABELPRINT 

section of the configuration. The reports for printing these labels must be specified in the 

PLSTLABEL allocation table. 
 

Set parameters for printing labels (Plastics) 

The parameters for configuring the printing of labels in Plastics are set in the 

PLASTICS.LABELPRINT section of the configuration. 

PLASTICS.LABELPRINT.ACTIV 

PLASTICS.LABELPRINT.ADDTEXT 

PLASTICS.LABELPRINT.CHARGE 

PLASTICS.LABELPRINT.GEWICHT 

PLASTICS.LABELPRINT.KADATA 

PLASTICS.LABELPRINT.NEXTNUMBERS 

PLASTICS.LABELPRINT.SAVEDATA 

PLASTICS.LABELPRINT.NVRNR 

PLASTICS.LABELPRINT.REPORT 

PLASTICS.LABELPRINT.NOOFLABELS 
 

Print labels (Plastics) 
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Note: The Adjust cards object is part of the Plastics add-on, which is subject to license. 

Adjust cards are used to secure machine settings per injection molding item and machine. Adjust 

cards are created and managed in the Adjust cards object (Design module). 

The following adjust card types are available: 

MAS - Master adjust card 

Master cards serve as a template for ITE adjust cards (see below). A distinction is made between 

the general MAS adjust cards and work center-related MAS cards: 

 General MAS adjust card 

A general MAS adjust card has no reference to a particular work center. Therefore, you do 

not enter any resources or work centers when you create a general MAS adjust card.  

Please note: There can only be one general MAS adjust card in the system. 

The general MAS adjust card is only used as a template to create a new ITE card if there is 

no MAS adjust card with reference to the associated work center. 

 Work center-related MAS adjust cards 

One MAS adjust card can be created for each work center stored in the system. You enter 

the ID of the associated work center when creating a work center-related MAS adjust card. 

If an MAS adjust card is not found for the associated work center during the creation of an 

ITE adjust card (see below), the General MAS adjust card is used as a template instead. 

ITE item/machine adjust card 

An ITE adjust card has a reference to a particular item and a particular work center. If an ITE 

adjust card is created, and if there is an existing MAS adjust card with reference to the specified 

work center, the parameters and values of this work center-related MAS adjust card will be 

entered. If a work center-related MAS adjust card does not exist, the parameters and values of the 

general MAS adjust card will be entered instead. 

Adjust cards (Plastics) 
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You can change or add to the pre-assigned parameter values in the adjust card. An ITE adjust 

card can be assigned a standard material and a standard tool from the BOR of the item. 

If a production order is created for an item with an ITE adjust card, the adjust card can only be 

correctly used under the following condition: 

The work center that the ITE adjust card references must also be stored in the MAC record in the 

BOR (see "BORs in Plastics" page 1712) of the item to be manufactured. 

If this applies and the... 

 production order is then released or  

 you select Go to > Adjust card in the production order to go to the adjust card, or  

 if you print the adjust card in the production order by selecting Functions > Adjust card,  

the ITE adjust card will be locked and a copy of it will be created with reference to the associated 

production order. The copy of an ITE adjust card is called a WOO adjust card (see below). 

However, this is not possible ... 

 if a WOO adjust card with this item/machine reference already exists for another production 

order, or   

 if the ITE adjust card was manually locked in the Adjust cards object using the Lock ITE adjust 

card function. To unlock it, select the Unlock ITE adjust card function. 

WOO - production order-related adjust card 

As already explained in the description of the ITE adjust cards, a WOO adjust card is the 

order-related copy of an ITE adjust card. 

Provided a WOO adjust card is being used by a production order and the associated ITE adjust 

card is therefore locked, no other production order can access the ITE adjust card.  

If a WOO adjust card is closed without prior changes, it will be archived and stored under its 

current ID and with the order ID specified as an adjust card of the type HIS (see below). The 

associated ITE adjust card will thereby be unlocked and set to Unassigned. It can then be used by 

another production order again. A copy will be created of the now unlocked ITE adjust card and 

this will also be archived and saved under a new ID as an HIS adjust card. 

Note: This is the standard behavior when unchanged WOO adjust cards are closed. You can 

change this behavior using the PLASTICS.ADJUSTCARD.WOOALWAYSHISTORY parameter in 

the configuration. 
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If a WOO adjust card is changed prior to closing during a production order, it will be marked PrO 

update. The card and associated ITE adjust card will be archived and saved under their current 

card IDs as HIS adjust cards. The ITE adjust card is saved without the changes applied to the 

WOO adjust card. When the changed WOO adjust card is closed, a new ITE adjust card will be 

generated with a new card ID. The new ITE adjust card contains all the changes in the closed 

WOO adjust card and can now be used by the next production order. 

HIS -  Historic adjust card  

Historic adjust cards are generated when, as explained in detail above, WOO adjust cards are 

closed. Change statuses are saved in HIS adjust cards and current parameterizations are 

documented. 

Note: You can use the PLASTICS.ADJUSTCARD.CREATEHISTORY parameter in the 

configuration to specify whether closed adjust cards should always be archived. 
 

Set parameters for adjust cards (Plastics) 

All of the parameters required to configure adjust cards (see "Adjust cards (Plastics)" page 1717) 

are included in the PLASTICS.ADJUSTCARD section of the configuration. 

PLASTICS.ADJUSTCARD.ACTIV 

PLASTICS.ADJUSTCARD.CARDNV 

PLASTICS.ADJUSTCARD.CREATEHISTORY 

PLASTICS.ADJUSTCARD.CUSTOMERITEMONE 

PLASTICS.ADJUSTCARD.DOCUMENTFLAGLINK 

PLASTICS.ADJUSTCARD.NOOFREPORTS 

PLASTICS.ADJUSTCARD.REPORTNAME 

PLASTICS.ADJUSTCARD.RNRNV 

PLASTICS.ADJUSTCARD.SHEET1 

PLASTICS.ADJUSTCARD.SHEET2 
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PLASTICS.ADJUSTCARD.SHEET3 

PLASTICS.ADJUSTCARD.SHEET4 

PLASTICS.ADJUSTCARD.SHEET5 

PLASTICS.ADJUSTCARD.WOOALWAYSHISTORY 

 
 

Enter data for adjust cards - examples (Plastics) 

Data for Adjust cards (see "Adjust cards (Plastics)" page 1717) is entered in Plastics as follows: 

 The parameters are entered in the work center-related MAS adjust cards as a template for ITE 

adjust cards.  

 In the general MAS adjust card, the parameters must be entered as a template in case a work 

center MAS adjust card does not exist. 

 Only item-specific changes are made to default parameter values in ITE and WOO adjust 

cards. Notes may also be entered. No additional parameters can be added to these types of 

cards. 

The fields on the Parameters 1-2-3, Parameters 4-5-6, Parameters 7-8-9 and Parameter 10 tabs 

of the Adjust cards object (Design) are available for entering parameters. As already mentioned 

above, parameters are exclusively entered in MAS adjust cards. 

Note: In the standard version, only the two Parameters 1-2-3 and Parameters 4-5-6 tabs are 

displayed for ITE, WOO, and HIS adjust cards. These tabs are identical to the two Parameters 

1-2-3 and Parameters 4-5-6 tabs – as displayed for MAS adjust cards – except for the omission of 

the RT field. Exactly which tabs and how many tabs are to be displayed for these cards can be set 

using parameters PLASTICS.ADJUSTCARD.SHEET1 to PLASTICS.ADJUSTCARD.SHEET5 in 

the configuration. 

You can use special record types here to select the fields that are to be populated so that they can 

also be printed on the adjust card later. The standard version of Plastics already includes various 

record types of this type. They are stored in the PLSTACRTYPE allocation table. 

In the standard version, the report used for printing adjust cards is the irPlastAdjustCard report. 

You can define the default report using the PLASTICS.ADJUSTCARD.REPORTNAME parameter 

in the configuration. Reports must be entered in the PLASTACREP allocation table. 
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You can adapt existing record types and create additional record types yourself. Changes and 

new record types must always be entered in the associated report. 

Below are examples for each of the predefined record types. The amount of fields for allocation 

with pre-defined record types is limited to the Parameters 1-2-3 tab. This is illustrated in diagrams 

in the examples below. Fields for allocation have colored borders. 

 

Record type: P 

Description: Parameter record (P1-V1-UOM1; P2-V2-UOM2) 

Example: 

RT Line Parameter 1 Value 

1 

UOM

1 

Y/N1 Parameter 2 Value 

2 

UOM

2 

Y/N2 Parameter 3 Value 

3 

UOM

3 

Y/N3 

P 1 Temperatur

e of zone 1 

185 °C o Temperatur

e of zone 2 

140 °C o    o 

 

Printout on adjust card: 

Temperature of zone 1   185   °C   Temperature of zone 2   140   °C 

 

Record type: P1 

Description: Parameter record (P1-V1-UOM1; P2-V2-UOM2; P3-V3-UOM3) 

Example: 

RT Line Parameter 1 Value 

1 

UOM

1 

Y/N1 Parameter 2 Value 

2 

UOM

2 

Y/N2 Parameter 3 Value 

3 

UOM

3 

Y/N3 

P1 6 Ejector  

path, phase 

1 

1200 mm 
o 

Ejector  

path, phase 

2 

1000 mm 
o 

Ejector  

path, phase 

3 

850 mm 
o 

Printout on adjust card: 

Ejector path, phase 1   1200   mm   Ejector path, phase 2   1000   mm   Ejector path, phase 

3   850   mm 

 

Record type: P2 
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Description: Parameter record (P1-V1-Y/N1; P2-V2-Y/N2) 

Example: 

RT Line Parameter 1 Value 

1 

UOM

1 

Y/N1 Parameter 2 Value 

2 

UOM

2 

Y/N

2 

Parameter 3 Value 

3 

UOM

3 

Y/N3 

P2 1 Ejector (y/n)   
þ 

Lock (y/n)   
o 

   
o 

Note: Fields do not have to be assigned, even if the parameter record permits assignment. 

Printout on adjust card: 

Ejector (y/n)   Y   Lock (y/n)   N 

 

Record type: P3 

Description: Parameter record (P1-V1-Y/N1; P2-V2-UOM2) 

Example: 

RT Line Parameter 1 Value 

1 

UOM

1 

Y/N1 Parameter 2 Value 

2 

UOM

2 

Y/N2 Parameter 3 Value 

3 

UOM

3 

Y/N3 

P3 1 Ejector (y/n)   
þ 

Ejector  

path, phase 

1 

1000 mm 
o 

   
o 

Printout on adjust card: 

Ejector (y/n)   Y   Ejector path, phase 1   1000   mm 

 

Record type: PT 

Description: Parameter record (P1-Text1-V1-UOM1) 

Example: 
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RT Line Parameter 1 Value 

1 

UOM

1 

Y/N1 Parameter 2 Value 

2 

UOM

2 

Y/N

2 

Parameter 3 Value 3 UOM

3 

Y/N

3 

PT 7 Ejector 

information 

  
o 

   
o 

   
o 

Note: The Parameter and UOM fields were not assigned in this example, although they would be 

printed onto the adjust card according to the record type. Text1 can then be entered in two ways: 

Either in the Text1 field of the Text input dialog box, which is opened by double-clicking the header 

of the corresponding line, or on the Parameter text tab in the Text 1 field:  

Text input dialog box: 

Text 1 Ejector information   Y/N 

 
No special features for the ejection device! 

 

 

Text 2    Y/N 

 
 

 

 

Parameter text tab 

RT Line Text 1 Text 2 

PT 7 No special features for the ejection device!  

Printout on the adjust card: See the next example for record type X. Record type PT was used as 

closing information.  

 

Record type: X 

Description: Information record (P1) 

Example: 
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RT Line Parameter 1 Value 

1 

UOM

1 

Y/N

1 

Parameter 2 Value 

2 

UOM

2 

Y/N

2 

Parameter 3 Value 

3 

UOM

3 

Y/N3 

X 1 Heating 

system 

nozzle 

  
o 

   
o 

   
o 

Note: When placed before other record types, the information record can be used to define area 

headers, for example. 

Example: 

RT Line Parameter 1 Value 

1 

UOM

1 

Y/N

1 

Parameter 2 Value 

2 

UOM

2 

Y/N

2 

Parameter 3 Value 

3 

UOM

3 

Y/N

3 

X 1 Heating system 

nozzle 

  
o 

   
o 

  
o 

P 2 Nozzle 

temperature 

185 °C 
o 

   
o 

   
o 

P 3 Temperature of 

zone 1 

100 °C 
o 

Temperatur

e of zone 2 

140 °C 
o 

   
o 

P 4 Temperature of 

zone 3 

160 °C 
o 

Temperatur

e of zone 4 

175 °C 
o 

   
o 

X 5 Ejector 

system 

  
o 

   
o 

   
o 

P1 6 Ejector path, 

phase 1 

1200 mm 
o 

Ejector  

path, phase 

2 

1000 mm 
o 

Ejector  

path, phase 

3 

850 mm 
o 

PT 7 Ejector 

information 

  
o 

   
o 

   
o 

Printout on adjust card: 

Heating system nozzle 
Temp. nozzle             185  °C 
Temperature of zone 1           100  °C   Temperature of zone 2           140   °C 
Temperature of zone 3           160  °C   Temperature of zone 4           175   °C 
Ejector system 
Ejector path, phase 1  1200  mm   Ejector path, phase 2  1000   mm    Ejector path, phase 

3    850   mm 
Ejector information  No special features for the ejection device! 

 

Record type: XFF 

Description: Page break during printout 
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Example: 

RT Line Parameter 1 Value 

1 

UOM

1 

Y/N

1 

Parameter 2 Value 

2 

UOM

2 

Y/N

2 

Parameter 3 Value 

3 

UOM

3 

Y/N

3 

XFF     
o 

   
o 

   
o 

This record type provides a page break at your line while printing the adjust card. 
 

Create MAS adjust card (Plastics) 

The following description explains how to create a general and a work center related Adjust card 

(see "Adjust cards (Plastics)" page 1717). 

Creating a general MAS adjust card:  

Please note: Only one general MAS adjust card can be created. 

1. In the Design module, click Adjust cards. 

2. On the start form, select the New tab. 

3. Accept the suggested adjust card ID. 

Note: The suggested ID is not relevant because the general MAS adjust card is always 

assigned the MASTER ID. 

4. Leave the Resource and Work center  fields empty. 

5. Select the Create master adjust card check box. 

6. Click Create. 

7. First, display the Parameter 1-2-3 tab. 

8. Select the correct record type in the RT combo box. 

9. Enter the parameters that will be set by default when new ITE adjust cards are created and 

that will be printed on the adjust cards. If necessary, go to the next tab Parameter 4-5-6, etc., if 

the selected record type requires it. 

For a description with examples, see the Enter data for adjust cards (see "Enter data for 

adjust cards - examples (Plastics)" page 1720) Help topic. 

10. Save. 
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Creating a work center related MAS adjust card:  

1. In the Design module, click Adjust cards. 

2. On the start form, select the New tab. 

3. Accept the suggested adjust card ID or enter a different one. 

Note: Automatic ID assignment is based on the numbering standard 5501. 

4. Leave the Resource field empty. 

5. Enter the Work center. This establishes the reference to the work center (machine). 

6. Select the Create master adjust card check box. 

7. Click Create. 

8. First, display the Parameter 1-2-3 tab. 

9. Select the correct record type in the RT combo box. 

10. Enter the parameters that will be set by default when new ITE adjust cards are created and 

that will be printed on the adjust cards. If necessary, go to the next tab Parameter 4-5-6, etc., if 

the selected record type requires it. 

For a description with examples, see the Enter data for adjust cards (see "Enter data for 

adjust cards - examples (Plastics)" page 1720) Help topic. 

11. Save the data you have entered. 
 

Create ITE adjust card (Plastics) 

The following description explains how to create an ITE adjust card (see "Adjust cards (Plastics)" 

page 1717). 

1. In the Design module, click the Adjust cards object. 

2. On the start form, select the New tab. 

3. Accept the suggested adjust card ID or enter a different one. 

Note: This is based on numbering 5501. 

4. Enter the item ID in the Resource field. 

5. Enter the work center in the Work center  field. 

6. Leave the Create master adjust card check box deactivated. 
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7. Click Create. 

If a work center related MAS adjust card with reference to the selected work center already 

exists, the parameters will be entered. If not, the parameters from the general MAS adjust 

card will be entered provided such a card was created. 

Note: In the standard version, the Parameters 1-2-3 and Parameters 4-5-6 tabs are the 

only two tabs displayed in the master data for ITE adjust cards. Exactly which tabs and 

how many tabs are to be displayed can be specified using parameters 

PLASTICS.ADJUSTCARD.SHEET1 to PLASTICS.ADJUSTCARD.SHEET5 in the 

configuration. 

8. Adjust the default parameter values (Value field) in an item-specific way, if required. 

9. Save. 
 

Change WOO adjust cards during a production order (Plastics) 

The following short description explains how you can change a production order related adjust 

card (WOO card) in a production order. 

You are in a production order: 

1. Select Go to > Adjust cards. 

2. Enter the change(s). 

The only changes that can be made to WOO adjust cards are changes to parameter 

values (Value field) or, if the record type permits, the insertion/modification of additional 

text.    

3. Return to the production order. To return, click the X button in the upper right-hand corner. 

For the consequences of changing a WOO adjust card, see the section in the Adjust cards (see 

"Adjust cards (Plastics)" page 1717) Help topic relating to the WOO production order related 

adjust card. 
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Close WOO adjust card (Plastics) 

There are two ways of closing a WOO adjust card. 

1. Select Design > Adjust cards > Open. 

2. Enter the data to select the associated WOO adjust card. 

3. Click Load. 

4. Select Functions > Close WOO adjust card. 

Or 

1. Load the production order that uses the associated WOO adjust card. Go to the Manufacturing 

module and click the Production orders object. 

2. Go to the Open tab on the start form and enter the data to select the production order. Click 

Load. 

3. Select Go to > Adjust card. The master data of the WOO adjust card will then be displayed. 

4. Select Functions > Close WOO adjust card. 

For the consequences of closing a WOO adjust card, see the section in the Adjust cards (see 

"Adjust cards (Plastics)" page 1717) Help topic relating to the WOO production order-related 

adjust card. 
 

Close ITE adjust card (Plastics) 

To save modifications for an ITE adjust card (see "Adjust cards (Plastics)" page 1717), it can be 

closed and archived. It will be saved as an HIS adjust card under its current card ID. Closing it will 

generate a copy of it including all modifications and will create a new ITE adjust card with a new 

card ID. 

Note: You can use the PLASTICS.ADJUSTCARD.CREATEHISTORY parameter in the 

configuration to specify whether closed adjust cards should always be archived. 
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Please note: As long as a WOO adjust card based on an ITE adjust card is used by a 

production order, the ITE adjust card cannot be closed. The WOO adjust card must be closed (see 

"Close WOO adjust card (Plastics)" page 1728) first. 

Closing an ITE adjust card: 

1. Select Design > Adjust cards > Open. 

2. Enter the data in the fields in order to select the associated ITE adjust card. 

3. Click Load. 

4. Select Functions > Close ITE adjust card. 
 

Print adjust cards (Plastics) 

The following description explains how to print Adjust cards (see "Adjust cards (Plastics)" page 

1717): 

All adjust card types can be printed in the Adjust cards object: 

1. In the Design module, click Adjust cards. The start form opens. 

2. Select the Open tab and enter the necessary data to select the required adjust cards. 

3. Click Load. 

4. Select Functions > Print adjust card. 

A WOO adjust card in a production order can be printed manually or automatically: 

 Manually: 

a) Load the associated production order. 

b) Select Functions > Print adjust card in the production order. 

 Automatic: 

You can use the PLASTICS.ADJUSTCARD.DOCUMENTFLAGLINK parameter to specify 

that a WOO adjust card is to be to printed automatically when the associated production 

order is released. 

Note: If a WOO adjust card has not yet been generated, this will occur no later than when it is 

printed.  
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Please note: This function must be licensed separately. 

Each of these functions belongs to Service: Equipment files, Service orders, Maintenance 

agreements, and Repair processing. 

You can find the Service functions in Sales, Manufacturing, Purchasing, and Inventory. 
 

Service Management (Service) 
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Please note: This function must be licensed separately. 

The Service Management System optimizes all the processes in the customer service and repairs 

areas. 

When you are using all Service components you can avail of a complete package which, on the 

one hand, is integrated into the Infor COM processes while, on the other hand, it builds on the 

CRM workflows. 

The following Service components are available, among others: 

 Service orders (page 1744) 

 Maintenance agreements (page 1753) 

 Jobs (page 1759) 

 Error statistics (page 1760) 

 Services (page 1768) 

 Service teams (page 1771) 

 Maintenance conditions (page 1771) 

 Maintenance operation templates (page 1772) 

 Equipment files (page 1776) 

 Inventory documents (page 1782) 

 Repair processing (see "Repair processing (Service)" page 1734) 

 Field service orders (page 1765) 

Service order processing includes recording problems in CRM supported by question trees and 

customer history, automatic assignment of a qualified technician, consideration of service 

agreements, and from creating service orders to the feedback of all technical solutions and 

associated expenses with regard to billing as well as updating the equipment file (see "Equipment" 

page 1774). 

To obtain an overview of the functions available in Service, we recommend that you read the 

following Help topics: Service orders (page 1744), Maintenance agreements (page 1753), and 

Equipment files (page 1776). 
 

Service basics 
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Glossary (Service) 

The following explanations provide an overview of the most important terms and abbreviations 

used on the various forms in Service. 

Service element 

A service procedure contains several service element records. These can be, for example, 

materials or services. If a service procedure is assigned to a maintenance agreement, the service 

elements are copied to that maintenance agreement, where they can subsequently be modified. If 

a service order is generated using the maintenance agreement, these records are ultimately 

copied to a service order. 

Service procedure (GSP) 

See Maintenance operation templates (page 1772) 

SLA 

See Maintenance conditions (page 1771) 

ASP 

See Maintenance operation templates (page 1772) 

M2R 

Material that needs to be repaired is flagged by an ID that indicates a specific identification 

process. 

When an M2R line is generated from a line containing returned material (RTM record type), this ID 

is first equated with the RTM ID. When own material is repaired, separate numbering is used for 

returned material. 
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Qualifications 

In Service (see "Service basics" page 1731), required qualifications can be created for equipment 

files (page 1776), service orders (page 1744), or services (page 1768). These qualifications are 

passed down to the field service orders through inheritance. 

When assigning employees to activities , the available qualifications of the employees involved in 

the field service order are compared with the required qualifications. If it happens that not all of the 

required qualifications are covered, the bar of the field service order (and the associated service 

order) is highlighted in color. 

Note: The color depends on the configuration. 
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Repair processing (Service) 

For general notes on the Service component, see Service basics (page 1731). 

In Infor COM, repair processing provides repairs-related functions for Service users for whom 

repairs constitute the core area of their company activities. 

To learn about repair processing, see Repair processing in practice (page 1736). 

The repair processing functions are available in the following desktop objects. 

In Sales: Repair check lists (page 1758) 

In Manufacturing: Repair orders (page 1762), Repair console (page 1764), Field service orders 

(page 1765), Repair work lists (page 1773), Repair check list templates (page 1773) 

In Inventory: Repairs receipt 

Features 

Repair processing covers both repairs initiated by the customer and repairs of your own 

equipment. 

 The process of repairing in-house material begins with the generation of a line of the M2R 

record type in the repair console, since there are no sale-specific processes involved in the 

repair of in-house material. 

 The process of repairing returned material begins with the creation of a Repair-type service 

order. 
 Repairs can be carried out in-house or assigned to subcontractors via repair purchase orders. 

Repair purchase orders are purchase orders that contain the following additional 

properties: 

Repair purchase orders can contain lines of the SCO record type. These lines contain 

services that have been purchased from suppliers. 

Repair purchase orders contain combinations of HR and M2R (material to be repaired) 

lines. Each of these individual combinations represents a repair by a supplier. A 

M2R-record type line refers to the repair material, whereas the HR-record type line refers 

to the inventory receipt posting. 
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Purchased repair services (SCO lines) and materials (MA lines) are included between the 

HR and M2R lines. 

 Repair processing facilitates the return of items that were not delivered via Order processing. 

Details 

Lines with the RTM record type don't just allow you to carry out repair processing, they also allow 

you to process returns from the customer: 

 Return of equipment for evaluation 

 Return of hire equipment 

 Return of wrong deliveries 

The reasons for return are noted once the returned items have been received. 
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Repair processing in practice 

The following steps provide an overview of the individual steps involved in repair processing. 

1. The customer contacts the CRM Help desk to report a problem with a piece of equipment. 

Note: This step is optional. Where CRM is not in use, the procedure begins with step 2 

instead. 

2. The CRM operator (or Infor COM user) creates a new repair service order and, if necessary, 

sends the customer a goods return form. 

See the Process repairs (see "Process repair" page 1737) Help topic. 

3. The customer returns the material with the specified service order ID (using the goods return 

form, if necessary). 

4. The defective part is entered in Inventory. Also see Repairs receipt (page 1738). 

5. Identify the source of the problem using the Repair check list and 8D report and create a cost 

estimate. 

6. Open the service order for which the repairs receipt was made by selecting Sales, Order 

processing and then Service orders. 

7. Open the Functions menu and choose Create document. To print the document, confirm the 

active Cost estimate option by clicking OK. 

Note: Then send the cost estimate to the customer. 

If the customer accepts the quote based on the cost proposal, the material is released for 

repair. 

Note: When repair material is released, lines containing the RTM record type are 

transferred to repair, i.e., an M2R record type is generated and the material is sent to 

Manufacturing. Sales cannot access the returned material while repairs are being carried 

out. 

8. Open the repair service order containing the defective material that needs to be released for 

repair. 

9. Select the RTM line(s) to be transferred to repair. 

10. From the Functions menu, choose Transfer to repair. 

Note: This action changes the statuses in the service order and repair console. 
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11. Service carries out the repair. The repair involves the management and posting of one or more 

repair purchase orders. Several repair purchase orders can be created for the material in need 

of repair. 

The material can only be processed for one repair order at a time. 

Note: For information on creating or processing repair orders, see Create repair order (page 

1763). 

After the order is released, the inventory posting is performed similarly to the production 

order - see Post repair order (page 1739). 

Note: A repair carried out externally by a subcontractor constitutes a special case. 

See the instructions in the Process third-party repair (page 1740) Help topic. 

12. Sales delivers the repaired material (including the advance shipping notice, and the invoice 

where applicable) - see Deliver repaired material (page 1741). 
 

Process repair 

For an overview of how repair processing works in practice, see Repair processing (see "Repair 

processing in practice" page 1736). 

1. In SDisplay item account data (Connect 

Online)ales, select the Order processing folder and click Service orders. Choose the New tab. 

2. As the service order type, select Repair service order. Select a customer ID too, and click 

Create. 

3. On the Order tab, enter the RTM record type - this stands for the returned material. 

4. The form header of the order contains the Equip. field. From this field, select the equipment file 

ID for the equipment. 

Note: The Internal repair tab contains important information about processing the repair, while 

the Equipment tab contains information about the equipment file assignment. The 

COMMON.INFORSERVICE.RETURNMATERIALGENTYPE=9 parameter automatically 

enters Repair as the generation type in the Equipment file generation field. 

5. For the simplest way to create RTM lines, select Go to and Find spare part. The system now 

displays a dialog box where you need to select Transfer as repair to transfer the selected lines 

as RTM lines. Close the dialog box once you have done this. 
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6. Select View and Service order header and click the Internal repair tab. Fill in the RMA 

transportation and RMA method of transportation fields. 

These are included on the goods return form. 

7. Select Functions and Create document. Select the Repair document and Goods return form 

options. If applicable, use the No. of empty rows field to specify the number of additional rows 

that are to be included in the order to allow for lines that have not been created yet. Confirm by 

clicking OK. 
 

Repairs receipt 

For an overview of how repair processing works in practice, see Repair processing (see "Repair 

processing in practice" page 1736). 

1. In Inventory, open the Goods receipt folder and select Repairs receipt. 

2. Select the order ID of the Repair service order to be loaded and click Load. 

3. In the Posting ID or PID field, enter posting ID 231 for a line that has yet to be received, and 

enter the transaction quantity to be received. 

Note: Alternatively, you can use Functions and Repairs receipt for the line. 

The transaction quantity is assigned the quantity entered in the service order. 

4. To carry out the posting, select Functions and Post. 

The system then displays a dialog box in which you can define whether a confirmation of 

receipt should be printed. 

Transfer the confirmation of receipt to the customer so that they receive the return ID. 

The return ID identifies a specific return item within a repair service order. Every item that is 

returned is assigned a return ID when repairs are received in Inventory. If a customer returns 

two items for repair, an RTM line with a quantity of 1 should be created for each item. The 

return ID is made up of the service order ID and a sequential ID. For example, RMA4711-001 

is the return ID of the first line that was returned for service order RMA4711. 

Note: During repair receipt, the related equipment line is removed automatically if the 

generation type is set accordingly. 

 

To cancel a repairs receipt, complete the following steps: 

1. Select the line for which you want to cancel the repairs receipt. 
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2. Open the Functions menu and choose Cancel repairs receipt. 

3. Open the  Functions menu and choose Post to carry out the cancellation. 
 

Post repair order 

For an overview of how repair processing works in practice, see Repair processing (see "Repair 

processing in practice" page 1736). 

Posting to the repair order is similar to the production order. 

With one exception: There are different value flow postings for a repair order: 

It must be possible to invoice the customer for service material. This is achieved in the 

following way. 

 Lines that have the MA record type (material lines) are - altered to record type SM (service 

material) - copied to the service order directly before the postings. The user cannot edit 

these records directly. 

 The issue updates the quantities both in the repair order and in the service order. These 

are posted to value flow as a sales issue, and the order information for the SM line is 

copied from the inventory journal. 

1. From Manufacturing, open the repair order for which you want to perform the inventory 

transaction. 

Note: You can also trigger this process in Inventory by choosing Manufacturing and Inventory 

transaction. 

2. From the Functions  menu, select Inventory transaction. 

3. For the line with record type M2R, select the Full man. issue (Full issue from S/C 

manufacturing) posting ID in the Posting ID or PID field. Then choose a transaction quantity, if 

applicable, and perform the posting via  Functions and Post. 

4. Log the receipt of the material to be repaired in the line with record type HR. For this, select 

posting ID 181 in the Posting ID or PID field and, if applicable, the transaction quantity. Next, 

open the Functions menu and choose Post. 

Please note: In contrast to the production order, you need to fully issue the M2R line with 

posting ID 183 before you can post the receipt of the line with record type HR with posting ID 

181. Partial postings are not permitted for either line. 
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Process third-party repair 

A repair carried out by an outside company is called a third-party repair. This involves the 

management and posting of one or more repair purchase orders. 

Please note: Multiple repair purchase orders can be created for one material in need of repair. 

At the same time, however, a material can only be processed for one repair purchase order. 

Repair purchase orders can be generated from a service order or created from scratch. In the 

case of returned material, you have two options, but only the second one is available for own 

material. 

The procedure for repair purchase orders is similar to the procedure for purchase orders with 

material provided. The following steps describe this procedure. 

 The line with record type M2R is issued with posting ID 157 - see Post repair purchase order - 
issue of M2R record type (page 1740). 

 After the material to be repaired has been issued and the third-party repair process has been 

carried out, you can post the receipt for the line with record type HR using posting ID 151  - 

see Post repair purchase order - receipt of HR record type (page 1741). 
 

Post repair purchase order - issue of M2R record type 

For an overview of third-party repair processing, click here (see "Process third-party repair" page 

1740). 

1. Open the repair purchase order from which the material issue is to take place. 

Note: Alternatively, you can post the issue in Inventory by choosing Goods receipt and 

Materials provided. 

2. Select the line with record type M2R that is to be issued. 

3. Select Functions and Inventory transaction. In the dialog box that is displayed, activate the 

Material issue option and confirm with OK. 

4. Select one of the following procedures: 

One-step procedure 

c) On the Transaction tab, go to the Posting ID or PID field and select posting ID 157 for 

record type M2R. 
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d) Open the Functions menu and choose Post, then click OK. 

In this case, the batch-tracked inventory is delivered to the supplier and issued 

immediately for repair. 

Two-step procedure 

a) On the Transaction tab, go to the Posting ID or PID field and select posting ID 160 for 

record type M2R. 

b) Open the Functions menu and choose Post. 

In this case the batch-tracked inventory is transferred to the subcontracted warehouse and 

can be displayed there. Issuing with posting ID 157 is performed at a later stage. 

Note: Use posting IDs 148/159 if you need to cancel posting IDs 157/160. 
 

Post repair purchase order - receipt of HR record type 

For an overview of third-party repair processing, click here (see "Process third-party repair" page 

1740). 

1. Open the repair purchase order for which receipt of the repaired material is to be posted. 

2. Select the line with record type HR. 

3. Open the Functions menu and choose Inventory transaction, then select the Purchase receipt 

option. 

Note: You can also carry out the posting in Inventory by choosing Goods receipt and 

Purchase receipt. 

4. If it is not already preset, select posting ID 151 in the PID field. 

5. Open the Functions menu and choose Post receipt. 

6. In the dialog box that is displayed, enter the external ASN ID and click OK. 

Note: You can cancel the receipt posting using posting ID 141. 
 

Deliver repaired material 

For an overview of how repair processing works in practice, see Repair processing (see "Repair 

processing in practice" page 1736). 

Once the repair is complete, the repaired material must be sent back to the customer. 
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Lines with record type RTM (returned material) are delivered in a similar way to lines with record 

type MA (material) in the advance shipping notice. 

1. Open the service order containing the material to be returned to the customer. 

2. Select Functions and Create document. 

3. In the dialog box that now opens up, select Issue document and ASN with issue. 

4. Confirm by clicking OK. 

Note: An invoice can be created following issue. When offsetting the repair, both service 

records and service material records come into play. 
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For general notes on the Service component, see Service basics (page 1731). 

When using Service, there are two possible scenarios: 

 Maintenance agreements (page 1753) (planned service orders) are planned at regular 

intervals. The necessary resources (employees, for example) must be scheduled in one field 

service order to ensure that they are available on the maintenance due date. 

 Extreme cases would be unplanned service orders, whereby, for example, the customer 

reports a fault via telephone. In this case, it's necessary to let the customer know if and when 

the required resources will be available. 

Please note: In both Sales and Manufacturing, the desktop objects for Service are located in the  

Service folder. In addition, the Goods receipt folder in Inventory contains the Repairs receipt. 

 

Order processing Service (Sales) 
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Service orders 

Note: This function only becomes available when the Service component is licensed. 

Call 

Sales > SERVICE > Order processing > Service orders 

Description 

The service order in Sales provides the basic functions of the Service component.  

A service order comprises lines for material records and lines for services that describe the 

activities of the service employee. 

It is comparable to the sales order, but it contains a few special tabs for dealing with errors (see 

"Error statistics" page 1760) and service data (see "Services" page 1768).  

Note: There is no specific sequence between the services of a service order, aside from explicitly 

predefined due dates. 

Service orders allow the user to invoice invoice services rendered and repairs, and also to trace 

the maintenance process for equipment. 

Please note: Service orders that have the Repair service orders service type are dealt with 

separately under Repair processing (see "Repair processing (Service)" page 1734). 

To learn how to create service orders, click here (see "Generate service orders" page 1745). 

Equipment files (page 1776) can be generated from a service order, but service orders can also be 

assigned to an equipment file. 

You can create documents in the same way as sales orders by selecting Functions and Create 

document. You can also use the Functions menu to modify the status. With the exception of the 

Entered status, statuses are provided for information only. 
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The following diagram provides a concise overview of working with service orders. 

 

Depending on the maintenance agreement (see "Maintenance agreements" page 1753) 

concluded with the customer, incoming service orders can be handled in different ways. 

If technicians have to be staffed at the customer's location, expenses chargeable to the customer 

will be incurred or, if equipment files (page 1776) are to be maintained, you can transfer the 

administration of service orders to Infor COM. 

Functions such as the following are then represented using service orders, while the equipment 

file manages the technician's repair reports. 

 Administration of different agreement types 

 Entering services (page 1768) 

 Setup of special prices (e.g. for spare parts or B parts, hire equipment, warranty, etc.). See 

Price calculation in the service order (page 1748) 

 Cost estimates (see "Create cost estimate" page 1748) 

 Posting of returns 

 Invoicing 

 

The support call ID is used to establish a link to the support call in CRM. To create a service order 

from a support call in CRM, select Support call and Create service order. 

 
 

Generate service orders 

For help on service orders, click here (see "Service orders" page 1744). 
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Service orders are generated as follows: 

 Select Sales > SERVICE > Order processing > Service orders, then select the New tab.  

 Activate the Transfer maintenance operations batch process. 

 From the Maintenance agreement, select Functions and Create SVO by service procedure. 

The Create general service procedure function must be run in the maintenance agreement 

first. See Generate a service order from a maintenance agreement (page 1746). 
 

Generate equipment files from a sales order 

For help on service orders, click here (see "Service orders" page 1744). See Equipment files 

(page 1776) for more information. 

The service is always based on a service order. Because of it, equipment requiring maintenance is 

delivered to the customer. Depending on the settings, a new equipment file (see "Equipment files" 

page 1776) will be generated for this equipment. 

All parts of the equipment are managed in the equipment file. The service order therefore has an 

Equipment tab. 

1. In the item master, select the Finished product option on the Equipment tab to specify that an 

equipment file should be managed for the item. 

2. Create a service order for this item. Then save the service order and create an issue document 

by selecting Functions > Create document. This generates an advance shipping notice. The ID 

for this advance shipping notice will be indicated in the following dialog box. Generating the 

advance shipping notice will also create an equipment file with the status Created. 

If the status in the equipment file is changed to Installed, it will be logged in the equipment file 

history. 
 

Generate a service order from a maintenance agreement 

For help on service orders, click here (see "Service orders" page 1744). See also Generate 

service orders (page 1745). 

You can generate service orders for a maintenance agreement (see "Maintenance agreements" 

page 1753) either using a batch process (see Transfer maintenance operations (page 1784)) or 

manually. 
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1. In the open maintenance agreement, select Functions and Create SVO by service procedure 

for the manual option. 

This allows you to create a service order for the current maintenance agreement. The next 

service order for the maintenance agreement is generated (see also Specify methods for 

generating service orders (see "Specify methods of generating service orders" page 1754)). 

If the creation method is set to Batch process generation, the next service date is 

automatically calculated according to the new date that was defined. 

If the creation method is set to Service order reported as complete, the next service date is 

not calculated automatically. In this case, the next service date is always calculated as the 

date of the service order feedback. You can enter the feedback date manually using 

Change status. 

2. Complete the fields of the service order dialog box as required, and clickOK. 
 

Schedule service order and service 

For help on service orders, click here (see "Service orders" page 1744). 

You schedule a service order, a service, or a field service order as follows. 

1. When creating a service order, define the requested start date and/or requested end date on 

the Service dates tab in the Order header view. Depending on the date you specify here, either 

forward or backward scheduling will be performed. If you specify both due dates, both 

scheduling types will be performed. 

2. Select Functions > Plan order and confirm with OK. 

An order is scheduled exclusively using Planning. When a service order is being scheduled, 

the individual services are scheduled either forward or backward depending on the requested 

start or end date for the service order. 

 The duration of an operation is determined using the operation content on the shift plan of 

the corresponding resource and taking the specified parallel activities into account. 

 The duration of a service is calculated from the duration of all operations, taking the 

parallel flags and transition times into account. Services can also be planned and 

executed in parallel. You obtain the requested due dates from the service order. The 

service is scheduled on the basis of the lines to be scheduled. The On site flag is taken 

into consideration here: Journeys and other activities that do not occur at the customer's 

site lie outside the requested due date interval of the service order. 



1748 | Infor COM 7.5 User Guide 

 

Service Management (Service) 

 

The result of the calculation is entered in the due date fields for the lines, field service orders, 

services and the service order. 
 

Create cost estimate 

For help on service orders, click here (see "Service orders" page 1744). 

You create a cost estimate in a service order (see "Service orders" page 1744) as follows. 

1. Open the Service order. 

2. Select Functions and Create document. 

3. In the Doc. section, select the Cost estimate option. 

4. Click OK to confirm. 

You can check the modified cost estimate status in the Service order header view (Service tab). 
 

Price calculation in the service order 

For help on service orders, click here (see "Service orders" page 1744). 

With the Service (see "Service basics" page 1731) component, you can use price lists to enter 

different prices for the same item and the same customer based on the quality of the item. The 

quality of the item can then be entered and modified by means of an extendable classification. 

1. Select the Discount groups tab in the service order. 

2. Store the price list for the line in the PL field. 

With regard to price calculation, this means that the quality related flag you assigned to the 

item will have the highest priority when the price is determined. The price is assigned with the 

price list flag, which means that the price list assigned to the item will determine the price of 

the resource. Price list 0 thereby stands for a new part. Prices are entered in the price table, 

which you can access using Go to. The flag for the price table must be maintained in the 

service order and also in the price table or item/service master. 

See also Calculate services (page 1755). 
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Calculate repair processes 

Similar to services (see "Service orders" page 1744), repairs are mainly processed in Infor COM 

through production orders. There are three different ways to process repairs. 

A. After receiving the cost estimate, the customer decides not to go ahead with a 

repair. 

In this case, the defective part will be returned to the customer. If billable services applicable to the 

cost estimate were rendered, the customer will be invoiced for them. This calculation of billable 

services is crucial for the handling of the transaction in Infor COM. In any case, a service order 

containing the defective part to be returned is created first. Since there is no charge for the part, it 

is not assigned a price. In addition, the user enters services to be billed, where this is necessary. 

The following options are now available: 

 Cash sale 

An invoice is created just as with the calculation of services and the returned part is 

automatically deducted from the repair inventory. 

 ASN with issue + Close order 
First, the part to be returned is deducted from the repair inventory, then the user closes the 

order manually, because the user is not creating an invoice for the services rendered. 

B. After receiving the cost estimate, the customer decides to go ahead with the repair. 

The actual repair of the part is processed using a production order in Infor COM. The user enters 

associated repair orders that will be processed. As soon as the repaired part is finished and added 

to the repair inventory, delivery and invoicing must be completed. The user can process invoicing 

directly from the service order. 

As with the previously explained cases, the service order may contain lines such as services or 

additional costs in addition to the repaired part. If an invoice is issued for spare parts used for the 

repair, they will be transferred with a flag from the repair order to the service order. 

These parts must not be taken from the warehouse. This is because the spare parts were already 

included in the delivered item during the repair and were therefore already issued from inventory 

during production. 
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C. The customer's defective item is not repaired and is replaced instead. 

Distribution processes for shipping and calculating spare parts are identical to those for defective 

parts for repairs. The difference is that, when the service order is entered, the associated spare 

part is provided instead of the repair part. 

 

 

It is important with all three methods that the executed process is already distinguished by the use 

of different price calculations (see "Price calculation in the service order" page 1748): 

 New part (for new production or sale) 

 Defective part (will be added, but may not be reused) 

 Spare part (replacement instead of repair) 

 Repaired part 

 Scrap/disposal 

Parts can be distinguished with a flag at the warehouse or with a special warehouse location. 
 

Statuses in (Service) 

The statuses of services orders, services, field service orders and their individual lines decide 

which actions you can perform. 

You can view the status of a service order in the Service order header view (Service tab). 

The SO main status is set according to the ISVCSOSTAT allocation table. 

The most important main statuses for service orders are listed in the following table: 
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Entered Planning does not access service orders with this status. Field service 

orders for a service can only be created manually. 

Cost estimate You can print a cost estimate when the status is cost estimate. This 

document contains all lines of the order together with prices. 

Planning does not access service orders with this status. Field service 

orders for a service can only be created manually. 

Released When the customer releases a repair, the service order is assigned the 

status Released. 

Postings can only be made to released operations. 

Note: If the service order was generated from a maintenance agreement, it is 

immediately assigned the status Released. Planning can therefore generate 

the related field service orders. 

Planned When an order is planned (rough scheduling), field service orders are 

generated for services and the service order is assigned the status Planned. 

Once an order has been planned in GPP (detailed scheduling), a fixed due 

date is assigned that prevents it from being replanned in Service.  

Pending This status is set after the 'Release field service order' function is run. This 

function fixes the service order, that is, the order must actually be executed 

in this form. At the time of release, the corresponding field service orders are 

released automatically. This release triggers the assignment of technicians, 

who can now issue material, for example. 

Entered as 

complete 

Once the last operation of a field service order is complete, the service or 

service order receives this status. 

 

You cannot change this status manually. 

The SO main status can have several sub-statuses, which are stored in the ISVCSOSUBST 

allocation table. These statuses are user-specific and can be changed manually. 
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There are several ways to change the main status in the service order. The following table 

provides an overview. 

From status To status Procedure 

Entered   Cost estimate Choose the Create document function and select the Cost 

estimate and Print options. 

Cost estimate Rejected Choose the Customer release function and select Reject. 

Cost estimate  Released Choose the Customer release function and select Release. 

Released Planned A field service order was generated/created for the service record in 

Planning or via the Create assigned field service order function. 

Planned  Pending The associated field service order was released using either the 

Release field service order function or the Field service orders 

object. 

Pending Entered as complete All OP lines of the associated field service order were entered as 

completed. 

 
 

Process spare parts order 

For help on service orders, click here (see "Service orders" page 1744). 

In the spare parts order, the customer orders either parts for his spare parts warehouse or 

concrete parts for replacement or general supplies for certain equipment. This information is 

entered in the order so that the equipment file (see "Equipment files" page 1776) or the information 

about which spare parts are assigned to the customer can be expanded automatically. 

Regarding the price calculation, note that parts with reduced quality (B inventory) are also offered 

at a lower price. Depending on the quality, several price lists may apply for a part, similar to the 

service order. 

Otherwise, a spare parts order is treated like a normal sales order, with separate numbering, so 

that it can be distinguished from the sales orders. 
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Maintenance agreements 

For general notes on the Service component, see Service basics (page 1731). 

Call 

Sales > SERVICE > Order processing > Maintenance agreements 

Description 

Maintenance agreements are general agreements for the maintenance of equipment.  

In Sales, you can enter the bases for maintenance agreements by choosing SERVICE > Master 

data > Maintenance conditions. These are transferred to the new maintenance agreement when it 

is created - see Maintenance conditions (page 1771). 

Equipment (page 1774) can be entered on the Assigned equipment files tab in the Assigned 

equipment files view. You can enter different lines of an equipment file (see "Equipment files" page 

1776) as separate maintenance processes. The individual equipment is displayed together with its 

structure on the Equipment file structure tab. The selected lines in the table are displayed on the 

maintenance certificate (see "Documents in maintenance agreements" page 1758). 

You make the most important default setting in the Maintenance agreement view. 

A maintenance operation template (see "Maintenance operation templates" page 1772) (service 

procedure) is selected on this form. On the basis of this template, the order data is filled in similarly 

to sales orders. 

Many different maintenance operation templates can be included. In this case, the service 

procedure data differs for each template that is included, and service order generation occurs 

specifically for each service procedure. 

All data influencing the generation of service orders is listed on the Service procedure data tab in 

the Maintenance agreement view. This also shows the data for already completed service 

procedures and the number of service procedures yet to be performed. 
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The service orders generated in the maintenance agreement or during the batch process (see 

Generate service orders (page 1745)) affect the status of the order. If the generation method (see 

"Specify methods of generating service orders" page 1754) is set to Service order reported as 

complete, the new service orders will only be generated if the previous one was already be 

confirmed. 

To generate feedback from a service order, you need to open the order and set its status to 

Entered by selecting Functions and Change status. The next order is then generated automatically 

and the required data is copied from the maintenance agreement - provided the number of orders 

to be generated was not reached. 

The date of the last confirmed service order is copied to the maintenance agreement (Service 

procedure data tab). This also contains the date of the next and last service to be scheduled. 
 

Specify methods of generating service orders 

See Maintenance agreements (page 1753) for more information. 

The system can automatically generate multiple service orders for a maintenance process (see 

Maintenance agreements (page 1753)). The user can specify the generation method. This 

requires settings to be made on the Service procedure data tab in the Maintenance agreement 

view. 

Information about the selected service procedure is displayed in the right section of the tab. This 

information may be edited (also see Maintenance operation templates (page 1772)). 

If multiple service procedures exist, you can assign them in sequence. If a service procedure ID 

was entered in the Dependent plan field, this service procedure will only be activated if the current 

procedure here has already expired. For this functionality to work, several service procedures 

must have been entered for the equipment. 

Options for service order generation can be modified in the Generation settings section. 

Possible settings for the Generation type are: 
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Does not 

expire 

No orders will be generated after the agreement line 

has been closed. 

Expires after A certain number of service orders will be generated. 

The number of service orders to be generated is 

displayed in the No. of SVOs until exp. field. The 

number of already generated orders is displayed in the 

Generated service orders field. 

Expires on The line is valid until a time that is defined by the user. 

Generation method, Gen. method 

The Generation method influences how and when the system will generate the service orders. 

Service order 

reported as 

complete  

A new service order will only be generated if the 

previous one was already be confirmed. (The status 

must be set to Entered in the service order.) 

Batch process 

generation  

All service orders are generated in one batch process. 

For more information, see Transfer maintenance 

operations (page 1784). 

For feedback from a service order, you need to open the order using Service orders and then 

choose Functions and Change status to set the status of the order to Entered. The next order is 

then generated automatically (if the number of orders to be generated was not reached) and the 

required data is copied from the maintenance agreement. 

The date of the last confirmed service order is copied to the maintenance agreement and 

displayed on the Service procedure data tab in the Maintenance agreement. The date of the next 

scheduled service and the last service date are also displayed. The last service date shows the 

scheduled date for the last repair. 
 

Calculate services 

For help on service orders, click here (see "Service orders" page 1744). 
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The service order to calculate services contains the list of materials required to perform the service 

on the Service description and specifies the services (page 1768) to be paid for that were 

rendered by service technicians either in-house or onsite. Infor COM supports these services 

using record type SV so that they can be entered and calculated simply and clearly. 

Note the following when calculating services: 

Calculated records are saved as usual to the invoice journal, where they are available for transfer 

to the Financials interface and also serve as the basis for the sales revenue statistics. When the 

service order is saved, they are automatically included in the order receipt statistics. 

You can access the sales revenue and order receipt statistics in Sales by selecting Order 

processing and Statistics. 
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Group service procedures in the maintenance agreement 

If you have assigned at least two service procedures to a maintenance agreement, you can assign 

service procedures to groups by selecting Functions and Group service procedures. 

Only service procedures with the same status can be added to a group. In addition, the service 

procedure data must be identical for the entire group. Therefore, the data must be entered when 

the group is created. This data is then transferred for each member of the group, and the service 

procedure data can only be modified within the grouping. 

Note: Service procedure data for ungrouped lines are maintained in the Maintenance agreement 

view. 

The following topics give an overview of the processing options in conjunction with the grouping. 
 

Documents in Service 

See Maintenance agreements (page 1753) for more information. 

When handling maintenance agreements (page 1753), you need to pay attention to document 

handling in Service. The (Equipment) Documents tab is available under Maintenance agreement, 

Equipment file and Item. 

On this tab, you can define documents and insert OLE objects. 

When a new document is entered, the entry cannot always be edited. Equipment documentation 

and software are automatically write-protected. This means that the lines with this document type 

cannot be edited after entry. In this case, the line must be deleted and re-entered for changes. 

Documents can be historized: New versions of a document can be created, but the old versions 

are not deleted. Instead, they are added to the current version with a Valid until date. 
 

Create general service procedure 

See Maintenance agreements (page 1753) for more information. 
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Use this function to create a maintenance operation template (see "Maintenance operation 

templates" page 1772). 

The Create general service procedure function becomes available in the Assigned equipment files 

view of the maintenance agreement when a maintenance agreement has a periodic expiration that 

is not equipment- or agreement-specific. 

1. From the menu in the open maintenance agreement, select Functions and Create general 

service procedure. 

2. Enter the necessary data just as you would with other service procedures. 

Price calculation is customer-specific, and you can enter the service procedure data for 

service order generation. 
 

Documents in maintenance agreements 

See Maintenance agreements (page 1753) for more information. 

Two documents can be created for maintenance agreements: A quote and a maintenance 

certificate. 

 The quote is a quote for a maintenance agreement. 

Note: A quote can only be printed if the status of the line was set to Created. 

 The maintenance certificate is a document that is sent to the printer. The maintenance 

certificate contains the structure of the selected equipment files. It cannot be canceled. The 

document can be printed in any status (except Created). 
 

Repair check lists 

For general information on repair processing, click here (see "Repair processing (Service)" page 

1734). 

Call 

Sales > SERVICE > Order processing > Repair check lists 
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Description 

If a customer complaint is received with regard to a material or equipment, a sequence of 

inspection and repair processes should be carried out as a rule. You can use repair check lists to 

establish these processes. 

Repair check lists contain repair work lists as individual lines. You can go from any line to its 

corresponding repair work list by selecting Go to from the menu. 

The lines of the check list are made up of three components: 

 A description of the issue to be checked 

 If the check fails - a description of the problem 

 A BOR for fixing the fault 

When creating a repair check list, you can use a repair check list template (see "Repair check list 

templates" page 1773) if one exists. 

Repair check lists are assigned to a returned material (record type RTM in the Repair service 

order). 

When performing checks or repairs, the service technician goes through the repair process set out 

in the repair check list. Each line in the repair check list has its own status with the values Opened, 

Processed , Invalid, OK. 

These statuses are entered manually, and they are used to define the status of the entire repair 

check list. 

From a repair check list, if you select Functions and Create repair order you can generate a repair 

order that contains a link to the failed checks according to the BOR. 

 
 

Jobs 

For general notes on the Service component, see Service basics (page 1731). 

Call 

Sales > SERVICE > Order processing > Jobs 
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Description 

The Job planning function in the service order allows you to assign different service orders (page 

1744) to a job and to transfer the due dates from the parent order to orders on sublevels. This 

function is useful if the system contains scheduled and event-related service orders for a 

maintenance agreement and the event-related orders need to be performed together with 

scheduled inspections. 

You access the function in the Service order via Functions and Job planning. Only orders that 

meet the following conditions can be assigned to a job: 

 The service order is assigned to the same equipment file 

 The service order type (according to the ISVCSOHTYPE allocation table) corresponds to a 

value between 30 and 70. 

 The order contains at least one service record whose status is relevant for the job. See the Job 

planning column in the ISVCSERSTAT allocation table. 

If at least one service order in addition to the current service order meets the above conditions, the 

Job planning application can be initiated. For scheduling to work properly, the Confirmed date field 

must contain an entry. 
 

Error statistics 

For general notes on the Service component, see Service basics (page 1731). 

Call 

Sales > SERVICE > Order processing > Error statistics 

Description 

Error statistics allows you to print a list showing the distribution of individual error classes and error 

IDs. 

Only services (page 1768) (record type SV) and items (record type MA) are included. 

The status of the services must be Completed, and Error class and Error ID must be filled in for the 

service on the Service statistics tab in the service order (see "Service orders" page 1744). 
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You can enter filter requirements for the list after you have started the function. These conditions 

influence the content of the list. 
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Repair orders 

Call 

Manufacturing > SERVICE > Order processing 

Description 

Repair orders can be compared with production orders from a functionality point of view. 

Repair orders in Manufacturing differ from production orders as follows. 

 In the production order, only one product is manufactured from defined resources. 

 Using the repair order, a specific job is executed for a particular item, or parts are fitted or 

replaced. 

In contrast to the production order, the following is a feature of the repair order: 

The first row of the BOR for a repair order is an M2R line. This denotes the material that is to be 

repaired. Material to be repaired is similar to standard material, the main difference being that its 

life cycle includes a few more statuses. These statuses are taken from the ISVCM2REV allocation 

table. 

A repair order can only contain M2R lines. 

A repair order therefore contains precisely one repair process which executes a repair for an M2R 

item. The individual lines of the repair order represent the repair process. 

Configuration 

COMMON.INFORSERVICE.RMA=yes 
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Create repair order 

For general information on repair processing, click here (see "Repair processing (Service)" page 

1734). 

You can generate or create a new repair order from a repair service order. 

Note: When it comes to repairing returned materials, both methods are allowed. However, own 

material can only be repaired using the second method. 
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Repair console 

Call 

Manufacturing > SERVICE > Order processing 

Description 

After the faulty goods have been accepted from the customer and a return ID has been generated, 

the repair phase starts. During this phase, the return ID will give you background information on 

the repair orders/purchase orders together with their current processing status and history. 

The repair console offers you the following functions: 

In addition to the material returned by the customer, you can also send batch-tracked inventory 

from your own stock for repair. 
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Field service orders 

Call 

Manufacturing > SERVICE > Order processing 

Description 

Field service orders are orders that combine several resources needed to provided a service. Like 

a production order, a field service order consists of one or more lines for describing the services to 

be provided and can be generated using a predefined BOR. However, in contrast to a production 

order, it describes an external activity but no manufacturing process. In addition, material is not 

posted when the field service order is completed. 

Each line in a field service describes the requirement for a specific resource or resource group. 

Capacity-relevant lines cover a specific period; they are scheduled for this period on a work center 

or line. 

Field service orders are used to schedule activities performed as part of services (page 1768). 

Field services orders are created in Planning (for example, using the Plan order function in the 

sales order). Alternatively, an empty field service order can be created for a service. All field 

service orders that have been created are assigned uniquely to a service. 

Field service orders are generated for detailed planning only. 

A field service order can involve several separate activities, each of which requires different 

resources. 

Examples: travel, replacement of defective parts, disassembly 

These activities can be run in sequence or in parallel. 

 

The field service order distinguishes between lines with record types OP (OP lines) and EC (EC 

lines): 

Every separate activity of a field service order is introduced by an operation (record type OP) that 

describes this activity, the operation content, and the start date. 
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On site 

 Use the On site check box to specify whether the operation described is to be performed on 

site for the customer. 

Example: For example, select the check box to specify that a machine can be used during 

the arrival and departure of the technician but is blocked during the actual on-site repair. 

 EC lines are lines that describe a requirement for a particular employee for the duration of the 

activity. For each employee to be planned, a corresponding EC record must be created in Infor 

COM . 

Assign employees to work centers 

For general information on field service orders, click here (see "Field service orders" page 1765). 

The capacity requirement of an activity according to the field service order is calculated from the 

operation content. The number of parallel activities in the operation specifies the number of 

employees needed to process the activity. 

In the field service order, the operation represents the group of employees to be used when 

scheduling the activity. 

Please note: During scheduling, only OP lines (operations) are taken into account. EC lines 

(employees) get their due dates from the OP line to which they are assigned.  

The following procedure allows GPP to assign a cost center's available capacity to a work center. 

1. In Manufacturing, open the TIME master data folder and select Employee master. Load the 

employee to be planned. 

2. Click the Cost center tab and assign the appropriate cost center to this employee. 

3. In Design, select Work centers and the New tab to create a work center group. Give it the 

same name (in the Work center field) as the cost center stored for the employee. 
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For general notes on the Service component, see Service basics (page 1731). 

To locate the Master data folder with Service desktop objects in Sales and Manufacturing, open 

the SERVICE subfolder. 

 

Master data Service (Sales) 
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Services 

For general notes on the Service component, see Service basics (page 1731). 

Call 

Sales > SERVICE > Order processing > Services 

Description 

Services are available in sales orders and service orders. 

Note: The full functionality of this service, including status change and cost estimate, is only 

available in the service order (see "Service orders" page 1744). 

Services are used if a component is installed in, removed from, or replaced in equipment (page 

1774). A service is similar to an item, but it has no inventory. 

For services relating to service orders (page 1744) and repair orders (see "Calculate repair 

processes" page 1749), Infor COM has its own record type SV. See Save master data for services 

(page 1768). 

Generating the equipment file with services is different than with material, because there are no 

requisitions. 

Services are supported in almost all sales objects, such as quotes, orders (including consignment 

orders and order releases), invoices, and credit memos. They are used for calculations only and, 

therefore, they cannot be planned or supplied. 

The material belonging to a service can be entered in the BOR for the service. They will then be 

transferred automatically to a generated field service order (see "Field service orders" page 1765). 
 

Save master data for services 

For services, master data is saved in the resource master and in the price table. 

1. Select Sales > Master data > Services > New. 
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2. Enter the required master data, such as sales prices or service costs, for example, and confirm 

your entries by selecting Create. 

3. Enter the required data on the tabs for the service, then save the service. 

4. Select Sales > Master data > Prices > New. 

5. Choose the required service as the item ID, and store the prices as with items. 
 

Enter services in order processing 

See Services (page 1768) for more information. 

1. Enter a service in order processing as follows: 

 Select the SV record type in the associated record type list box of the object, such as the 

sales order. Following the selection, only service resources will be available in the next 

resource list box. 

 In the open object (for example, sales order), select Go to and Find master data. Enter a 

search criterion for the services you are looking for and click Find. 

2. Choose the work hours to be invoiced from the service line, in the Quantity field. In addition, 

choose the appropriate unit, normally hours or workdays, from the UOM field. 

As soon as a quantity is assigned to a service, price calculation (see "Perform price calculation 

for services" page 1769) occurs automatically. 
 

Perform price calculation for services 

See Services (page 1768) for more information. 

Prices for services are calculated similar to prices for sales items, which means that a manually 

entered price has priority. Otherwise, the price list is accessed with the price group or discount 

group and the associated values are determined and entered into the current record. 

The record is calculated using the following formula: 
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Quantity * Price = Net 0 - Discounts + Surcharge = Net 1/Net 2 + Sales tax 

= Gross 

Note: The values entered in the Net 1 and Net 2 fields are always identical when the record type 

is SV. This is because no surcharges can be applied to a service. 

As with prices for sales items, the prices for services are included in the line total. 
 

Create evaluations for services 

The following evaluations have significance for services. 

Statistics 

Services are included in order receipt and sales revenue statistics. Services are not included in 

internal trade statistics and consumer statistics because they only list goods movements. 

Reports 

Services are included in reports in Sales if it makes sense to include them. 

Example: They are included in the Sales order overview report, but not in the Outstanding 

deliveries report. 
 

Enter BOR for service 

See Services (page 1768) for more information. 

Service orders revert back to services (page 1768). These, in turn, contain BORs that map the 

individual activities of this service. The following instructions describe how to create a service with 

a BOR. 

1. Select Sales > SERVICE > Master data > Services and click New. 

2. Enter a key and description for the service, and click Create. 

3. Select Go to and BOR, then click OK to confirm the dialog box. 
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4. Enter the relevant data on the Times/quantities tab in the BOR. When doing so, take note of 

the information provided in the Help for the fields on the tab. 

Note: The hierarchy in the BOR has a maximum of one level. 

The sequence of the OP-EC combinations must always be read from top to bottom. 

Example: The journey should always be at the lower end of the BOR. 
 

Service teams 

For general notes on the Service component, see Service basics (page 1731). 

Call 

Sales > SERVICE > Order processing > Service teams 

Description 

Service teams include personnel from your own company dealing with support services. For each 

service (see "Services" page 1768), a service team that provides the maintenance work can be 

added to the service order (see "Service orders" page 1744) and maintenance operation template 

(see "Maintenance operation templates" page 1772). 

Up to four employees can be assigned to a service team. They must be entered in the employee 

master data and assigned to the own company. They can then be assigned to the service teams in 

Sales via the Master data and Service teams folders. 

Service teams can be categorized by group type. The available types are maintained in the 

ISVCSGRPTYP allocation table. 
 

Maintenance conditions 

For general notes on the Service component, see Service basics (page 1731). 
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Call 

Sales > SERVICE > Order processing > Maintenance conditions 

Description 

You enter the templates for maintenance agreements here. Specify all time-relevant data except 

for the agreement start date. This will be entered in the maintenance agreement. 
 

Maintenance operation templates 

Call 

Sales > SERVICE > Order processing > Maintenance conditions 

Description 

In the maintenance operation template (service procedure), you can specify the records that are 

included in the maintenance agreement (see "Maintenance agreements" page 1753), if the 

template is assigned to the agreement. You can enter material, services, additional costs, text 

records, and component item lines. For the services (page 1768), you can also enter a default 

status and a service team. 

The specified data is automatically added to the maintenance agreement when you indicate the 

template on the Maintenance agreement. In addition, you can modify the data in the maintenance 

agreement. 

When creating a template, you must specify the template type. The default types are Maintenance 

and Inspection. You can add other template types in the ISVCSPTYE allocation table. 

Note: In the Help, the terms maintenance operation template and service procedure are used 

synonymously to a large extent. The following table shows how the two terms differ in theory. 



Infor COM 7.5 User Guide | 1773 

 

Service Management (Service) 

 

Maintenance operation template Service procedure 

Like BORs, maintenance operation templates are based 

on master data. If a certain measure (for example, 

annual maintenance) is planned in a maintenance 

agreement for equipment, this is done by assigning a 

maintenance agreement template. 

If the maintenance template is assigned to the 

equipment in the maintenance agreement, it is 

described as a service procedure in this status. It is 

similar to a rough planned order when in this status. 

 
 

Repair work lists 

Call 

Manufacturing > SERVICE > Master data > Repair work lists 

Description 

Repair work lists are special BORs that stipulate a sequence of inspection and repair steps. 

They are structured in a similar way to BORs but, unlike BORs, they cannot be assigned to items. 
 

Repair check list templates 

Call 

Manufacturing > SERVICE > Master data > Repair check list templates 

Description 

Repair check list templates allow you to document frequently used inspection and repair 

processes. 

When creating repair check lists and you need templates, you can use repair check list templates. 

The individual lines of a repair check list template are made up of repair work lists. 
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For general notes on the Service component, see Service basics (page 1731). 

Working with Service is based on a service order. Equipment requiring maintenance is delivered to 

the customer based on such. A new equipment file will be generated for this equipment regardless 

of the settings. All parts of the equipment are managed in the equipment file (see "Equipment files" 

page 1776). 

In principle, you can define all sales items as equipment. However, usually these are items of 

technical equipment. To be able to manage equipment using an equipment file, the appropriate 

flag must be set in the master data of the item on the Equipment tab. The options for generating 

equipment files are described in the Help topics for the Equipment tab in sales orders and service 

orders. 

The following functions are available for the equipment: 

Equipment 
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Upgrade 

equipment 

With this function, new equipment can be created as a copy of the current 

equipment. The status of the old equipment changes to Upgraded. Such 

equipment can only be opened in the equipment file if the Status field on the 

Open tab is set to Upgraded. The Show active status categories switch needs to 

be disabled for this. 

The new equipment file is created in the Created status and contains a copy of the original 

equipment file. 

Upgrade from/to You can link to the original equipment file using this function. In the dialog box for the function, 

you can enter the level to which it's possible to return when navigating. 

Equipment move Use this function to move equipment to another location. You can edit the customer 

information in this dialog box. When the equipment is moved, a line specifying the move date 

is entered in this history. 

Insert serialized ID 

from barcode 

You can use this function to add a serialized ID from the barcode reader to an item in the 

equipment file. This function requires the COMMON.INFORSERVICE.BARCODEMODE 

parameter to be set to yes. 

Select levels You can select all items on the same level in a hierarchy in the equipment file using the 

Select levels function. 

Select from item This function selects every line for which the EF-relevant check box is enabled on the 

Equipment tab. This selection is not deleted - lines that have already been selected remain 

unchanged. 

Accept template This function transfers a previously defined template to the equipment file. If the equipment file 

already has a structure, the elements from the template are added to the end of the equipment 

file and the already existing structure remains unchanged. 

Create document 

history 

You can use this function to historize documents, that is, changes in these documents can be 

traced. 

As well as processing using the Equipment files object, you can avail of other processing options 

in equipment file maintenance (see "Maintain equipment files" page 1779) and in the inventory 

documents (page 1782). 
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Equipment files 

For information on equipment in Service, click here (see "Equipment" page 1774). 

Call 

Sales > SERVICE > Order processing > Equipment files 

Description 

If a manufacturer has a service department, and deliveries are shipped worldwide, to a service 

technician this means guaranteeing mobile access to a service system, as well as ensuring the 

management of international spare parts warehouses. 

Security-relevant parts for contracting authorities also require special regulations with regard to 

identification, tracking, revisions, and secrecy. 

These facts about equipment files are processed so that information and data can be viewed, 

updated, and evaluated as quickly as possible. The basis for an equipment file is the structure 

BOR of an item. 

The following chart provides an example of how equipment files are managed for customers. 

 



Infor COM 7.5 User Guide | 1777 

 

Service Management (Service) 

 

You can access the equipment file in Sales by opening the Equipment folder and selecting 

Equipment files. Equipment files are the maintenance history files of items delivered to the 

customer, in whose master data the Finished product flag is set on the Equipment tab.  

Each of these items (equipment) has its own maintenance history. All problems and activities are 

assigned to the equipment using a serialized ID. 

An equipment file indicates the delivery status with the following components: 

 Equipment structure 

 Additional components 

 Ship-to address 

 Documentation 

 

The following information is entered into the equipment's maintenance history: 

 Installation 

 Removal 

 Upgrade (incl. change of serialized/item ID) 

 Warranty 

 Maintenance agreement 

 Status of the equipment 

The equipment information shows the current location first in descending order, as well as the 

other locations in a history. 

Using the Add to multi-equipment file function, you can assign an equipment file to a 

multi-equipment file. You can also go to the multi-equipment file. 

Functions 

Select from item: This function selects all lines for which the EF-relevant option is enabled on the 

Equipment tab in the item master. 

Templates: To edit equipment files more easily, you can save an equipment file as a template (see 

Equipment file types). To do this, select Data and Save as template. 

Note: Only selected lines will be transferred to the template; historic lines are not added. 
 

Define equipment file generation strategies 

See Equipment files (page 1776) for more information. 
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When an item is issued (i.e. when creating an advance shipping notice with issue, or during goods 

issue), an equipment file is generated for an item. If the 

COMMON.INFORSERVICE.BATCHMODUS configuration parameter is set to yes, the equipment 

files will not be generated for delivered lines either until the Generate equipment files (page 1784) 

batch process has started. If the parameter is set to no, the equipment files will be generated 

immediately after issue. 

The content of the equipment file can come from the BOR, a production order, or from a template 

(also see Equipment file types). In the sales order, the template ID must be specified in the 

Template field so that the lines are transferred to the equipment file during generation. 

If a template is not specified, Service will attempt to locate the source for the item: 

 Purchased items: A search is run for a previous purchase order for which a purchase receipt 

was already processed. 

 In-house items: A search is run for a production order for which an inventory receipt was 

already booked. If one exists, the structure of the order will be copied to the equipment file. 

 If there is no production order for the item in the system, the structure of the BOR will be 

transferred to the item. 

 With FRA items, receipt data from the database (FRA assignment) will be used. 
 

Generate equipment files from a sales order 

For help on service orders, click here (see "Service orders" page 1744). See Equipment files 

(page 1776) for more information. 

The service is always based on a service order. Because of it, equipment requiring maintenance is 

delivered to the customer. Depending on the settings, a new equipment file (see "Equipment files" 

page 1776) will be generated for this equipment. 

All parts of the equipment are managed in the equipment file. The service order therefore has an 

Equipment tab. 

1. In the item master, select the Finished product option on the Equipment tab to specify that an 

equipment file should be managed for the item. 
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2. Create a service order for this item. Then save the service order and create an issue document 

by selecting Functions > Create document. This generates an advance shipping notice. The ID 

for this advance shipping notice will be indicated in the following dialog box. Generating the 

advance shipping notice will also create an equipment file with the status Created. 

If the status in the equipment file is changed to Installed, it will be logged in the equipment file 

history. 
 

Generate equipment files from a project 

See Equipment files (page 1776) for more information. 

You can generate equipment files from a project as follows: 

1. Go to Sales > Project processing > Projects to open a project. 

2. In the Project structureview, select the Service tab. 

3. Implement the generation settings for the equipment files on this tab. 

Specify the generation settings for the equipment files on this tab. Generation can be run for 

an entire project group or for individual groups members. During generation, the system only 

includes material records (SMLs) whose status is at least 'Released', but not yet 'Closed'. 

4. Define a generation type for all SMLs to be generated. 

5. Select Functions and Create equipment file to start generating the equipment file. 

Note: Equipment file generation can also run as a time-controlled process. To do this, set the 

appropriate parameters for the ISvc.CAM.Batch.al_Process function by selecting System 

functions > Administration > Batch control. 
 

Maintain equipment files 

See Equipment files (page 1776) for more information. 

Equipment file maintenance is used for editing equipment files. Equipment file maintenance can 

be used to reposition parts. 

You edit the equipment file using Sales > SERVICE > Equipment > Equipment files. Open an 

equipment file and edit it by selecting Edit or Functions. 
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The icons in the table below are available to evaluate the status of the lines. Installation and 

(partial) removal of parts can be processed manually or through a service order. 

 This part was fitted. 

 This part was removed. 

 This part was added. 

 

If, at issue, a new line is added to an existing equipment file (see options for Equipment file 

generation on the Equipment tab), the new line will appear at the end of the equipment file. You 

can reposition this line using Edit and (Partially) issue spare part/Insert spare part (as component 

item line). You can only position lines with the  icon. 

1. Select the line and choose Edit and Issue spare part. 

Note: In this case, the entire quantity will be issued. To issue a partial quantity, choose Edit 

and Partially issue spare part. You can enter the quantity to be issued in the next dialog box. 

2. Position the cursor on the required line and select Edit and Insert spare part. The spare part 

will be inserted above the line where the cursor is located. 

Note: Select Edit and Insert new component item line to insert a component item line below 

the active line. 

Please note:  Only saved lines can be moved in the table. 

3. If the current line is suitable for all spare parts, select Functions and Close maintenance to 

exclude all possibility of repositioning. 

Note: Alternatively, you can finish further positioning, except for the selected item, by 

selecting Functions and Final line of spare part. 
 

Create document history 

See Equipment files (page 1776) for more information. 

To execute this function, select the Documents tab in the open equipment file, in the equipment 

file header or line. Then either choose an existing document or create a new one and save it. Next, 

select Functions and Create document history. You can use this function to historize documents, 

that is, changes in these documents can be traced. 
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A new line is created for the original line. The new line becomes the main line, and the historized 

line becomes the component item line. 
 

Resolve conflicts 

See Equipment files (page 1776) for more information. 

During equipment file generation (or at a later stage), the equipment file structure is created using 

the information contained in the system. The structure shows how the delivered product was 

manufactured. The substructure of an equipment file line shows the parts (batch-tracked 

inventory) used to create this part (batch-tracked inventory). The receipt information for the line is 

significant here, because it indicates the order (production order, purchase order) used to post this 

part to Inventory. 

In some cases, however, the receipt information cannot be determined, or the batch-tracked 

inventory and its attributes are not fully determined. These points are shown as conflicts in the 

structure and identified with different bitmaps. In the conflict resolution, you can check these 

conflicts and provide the missing information. 

A distinction can be made between the following: 

  Auto structure: Since the receipt information was missing, this was determined using a 

special logic (heuristics). In the conflict resolution, you can confirm the entered receipt data or 

specify the correct data. 

  Missing serialized/batch info: The line contains a serialized- or batch-mandatory part, but 

the serialized or batch ID could not be determined. 

Note: Situations like this can normally be avoided by using S/B assignment in the 

Manufacturing folder in Inventory. 

  Repair: This part has just been repaired. However, the repaired part can have a different 

substructure to the original part. These two substructures must be merged. 
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Inventory documents 

For general notes on the Service component, see Service basics (page 1731). 

Call 

Sales > SERVICE > Equipment > Inventory documents 

Description 

The Service component includes processing of production orders for repairs on defective parts. 

In Inventory documents you can, during the production process, save inspection certificates for 

parts. 

If a part (an assembly) is tested, this function allows you to save an inventory document for that 

part (for example, until the production process is finished). The inventory documents are collected 

later in the equipment file. 

Note: A comparable function is also offered in the line view of the equipment files. Open the 

equipment file and select View and Equipment file line, then click the Documents tab. 
 

Enter inventory documents 

For general information on inventory documents, click here (see "Inventory documents" page 

1782). 

To access inventory documents, select Sales > SERVICE > Equipment > Inventory documents. 

1. Click the Open tab of the inventory documents. 

2. Enter the required data to select the production order. 

3. Select View and Documents, where applicable. 

4. Make a selection in the Doc. type field of the table and click on the white space to the right of 

the table. Activation is indicated with a dotted frame. 
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5. Choose Edit and Insert object. In the dialog box that now opens up, select the Object type. The 

menu will adjust to the inserted object. 

Example: After inserting an Excel table, you can use the Excel editing functions for the object. 
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For general notes on the Service component, see Service basics (page 1731). 

The batch processes for Service are located under Sales > SERVICE > Batch processes. 
 

Generate equipment files 

For general notes on the Service component, see Service basics (page 1731). 

Call 

Sales > SERVICE > Batch processes > Generate equipment files 

Configuration 

This function requires the COMMON.INFORSERVICE.BATCHMODUS parameter to be set in the 

configuration. 

Description 

If the COMMON.INFORSERVICE.BATCHMODUS parameter is set to yes, no equipment files will 

be generated during issue. To generate the equipment files, you must run the batch process 

manually. 

Note: The equipment batch process can also run as a time-controlled process. To do this, set the 

appropriate parameters for the ISvc.CAM.Batch.al_Process function and add it to System 

functions > Administration > Batch control. 
 

Transfer maintenance operations 

For general notes on the Service component, see Service basics (page 1731). 

Batch processes 
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Call 

Sales > Batch processes > Transfer maintenance ops. 

Description 

Using this batch process, the system can automatically generate multiple service orders for a 

maintenance agreement (see "Maintenance agreements" page 1753) if the creation method (see 

"Specify methods of generating service orders" page 1754) is set to Batch process generation. 

You can use this dialog to filter by customer, maintenance agreement ID, and equipment file ID. 

You can enter a period of time as the interval. Then only service orders that lie within this period of 

time will be generated automatically. 
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For general information on repair processing, click here (see "Repair processing (Service)" page 

1734). 
 

Repairs receipt 

Call 

Inventory > Goods receipt > Repairs receipt 

Description 

The processes in Repairs receipt are similar to those in Purchase receipt. However, in Repairs 

receipt, inventory is not posted to a PO line. Instead, it is posted to a line with the RTM record type. 

In Repairs receipt, you can change the quantity of the confirmed material or add more lines with 

the RTM record type. This results in a similar change in the corresponding Repair service order. 

 

Goods receipt 
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Note: See also Configuration (Archive). 

You can access Service document archiving from Sales and Manufacturing by selecting the 

SERVICE folder and Archive subfolder. 

In Service, you can archive, re-archive, and delete (export) documents in the Archive subfolder (in 

the SERVICE folder in Sales and Manufacturing). Once archived, a document is no longer 

included in the overview of current documents. 

Documents can be archived individually or together in a batch process. 

The following Help topics describe the individual processes. 
 

Archive service orders 

For general information on archiving in Service documents, see Archive (see "Archive (Service) 

Sales" page 1787). 

1. Select Sales > SERVICE > Archive > Archive service orders. 

2. In the Archive service orders dialog box, implement the required limits for the documents that 

are to be archived, for example using an order ID and customer ID. 

Please note: You can make another selection using the check boxes in the Status form 

section. If you use, for instance, the Invoiced (default setting) selection criterion, the previous 

selection will again be limited to service orders that still have the Invoice printed status. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select the Selection from list check box to display a list of all chosen documents prior to 

archiving. 

Archive (Service) Sales 
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Note: If you want to exclude one or more of the documents displayed in this list from 

archiving, select every line that you want to archive. Documents that are not selected will 

not be archived. 

If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

5. Select the Confirmation for outstanding service orders check box to instruct the system to 

report all outstanding (that is, not yet closed) orders prior to archiving. 

6. Click OK to start the archiving process. 
 

Activate service orders 

For general information on archiving in Service documents, see Archive (see "Archive (Service) 

Sales" page 1787). 

1. Select Sales > SERVICE > Archive > Service orders. 

2. On the Open tab, enter the order ID in the Order ID field and click Load to confirm. 

To display all archived orders, enter % in the Order ID field and click OK to confirm. 

If there is more than one order, the order overview is opened. Select the required order by 

double-clicking the ID in the row header. 

Note: The following form where the document that is still archived is displayed has very 

limited functions and is only designed to allow you to view all order data. 

3. Select Functions > Activate. 

4. The system now opens a dialog box that proposes an order ID for the new document. 

Complete the rest of the fields in line with your requirements. 

Note: This order ID is the same as the ID for the archive document, provided that a document 

does not already exist with this ID in the movement data. If this ID does already exist, then the 

system automatically assigns a different ID. 

5. Confirm your entries by clicking OK. 

A new document with the details you just entered is now created from the archive order. The 

system switches to the order form to further process this new document. 
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Activate repair orders 

For general information on archiving in Service documents, see Archive (see "Archive (Service) 

Sales" page 1787). 

To activate an archived repair order, complete the following steps: 

1. Select Manufacturing > SERVICE > Archive > Repair orders. 

2. On the Open tab, enter the order ID in the Order ID field and click Load to confirm. 

To display all archived orders, enter % in the Order ID field and click OK to confirm. 

If there is more than one order, the order overview is opened. Select the required order by 

double-clicking the ID in the row header. 

Note: The following form where the document that is still archived is displayed has very 

limited functions and is only designed to allow you to view all order data. 

3. Select Functions > Activate. 

4. The system now opens a dialog box that proposes an order ID for the new document. 

Complete the rest of the fields in line with your requirements. 

Note: This order ID is the same as the ID for the archive document, provided that a document 

does not already exist with this ID in the movement data. If this ID does already exist, then the 

system automatically assigns a different ID. 

5. Confirm your entries by clicking OK. 

A new document with the details you just entered is now created from the archive order. The 

system switches to the order form to further process this new document. 
 

Activate field service orders 

For general information on archiving in Service documents, see Archive (see "Archive (Service) 

Sales" page 1787). 

To activate an archived field service order, complete the following steps: 

1. Select Manufacturing > SERVICE > Archive > Field service orders. 
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2. On the Open tab, enter the order ID in the Order ID field and click Load to confirm. 

To display all archived orders, enter % in the Order ID field and click OK to confirm. 

If there is more than one order, the order overview is opened. Select the required order by 

double-clicking the ID in the row header. 

Note: The following form where the document that is still archived is displayed has very 

limited functions and is only designed to allow you to view all order data. 

3. Select Functions > Activate. 

4. The system now opens a dialog box that proposes an order ID for the new document. 

Complete the rest of the fields in line with your requirements. 

Note: This order ID is the same as the ID for the archive document, provided that a document 

does not already exist with this ID in the movement data. If this ID does already exist, then the 

system automatically assigns a different ID. 

5. Confirm your entries by clicking OK. 

A new document with the details you just entered is now created from the archive order. The 

system switches to the order form to further process this new document. 
 

Archive repair orders 

For general information on archiving in Service documents, see Archive (see "Archive (Service) 

Sales" page 1787). 

To archive repair orders, complete the following steps: 

1. Select Manufacturing > SERVICE > Archive > Archive RO. 

2. In the dialog box that now opens, implement the required limits for the documents that are to 

be archived, for example using the order ID andcustomer ID key fields. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select the Selection from list check box to display a list of all chosen documents prior to 

archiving. 
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Note: If you want to exclude one or more of the documents displayed in this list from 

archiving, select every line that you want to archive. Documents that are not selected will 

not be archived. 

If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

5. Select the Confirmation for outstanding orders check box to instruct the system to report all 

outstanding (that is, not yet closed) orders prior to archiving. 

6. Click OK to start the archiving process. 
 

Archive field service orders 

For general information on archiving in Service documents, see Archive (see "Archive (Service) 

Sales" page 1787). 

To archive field service orders, complete the following steps: 

1. Select Manufacturing > SERVICE > Archive > Archive FSO. 

2. In the dialog box that now opens, implement the required limits for the documents that are to 

be archived, for example using the order ID andcustomer ID key fields. 

3. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

4. Select the Selection from list check box to display a list of all chosen documents prior to 

archiving. 

Note: If you want to exclude one or more of the documents displayed in this list from 

archiving, select every line that you want to archive. Documents that are not selected will 

not be archived. 
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If the list contains a large number of documents, you can speed up the selection process. 

Right-click anywhere on the numbering bar. In the menu displayed, choose Select all. 

Now deselect every document that you do not want to archive. 

To do this, hold down the CTRL key and click the relevant row headers. 

5. Select the Confirmation for outstanding orders check box to instruct the system to report all 

outstanding (that is, not yet closed) orders prior to archiving. 

6. Click OK to start the archiving process. 
 

Delete/export field service orders 

For general information on archiving in Service documents, see Archive (see "Archive (Service) 

Sales" page 1787). 

To delete archived field service orders, complete the following steps: 

1. Select Manufacturing > SERVICE > Archive > Delete/export FSO. 

2. Using the From - To fields in the selection dialog box that now appears, define the orders to be 

deleted. 

3. Activate Selection from list to display a list of the selected field service orders before you 

export the data. You can make a new selection by selecting lines. 

4. Click Filter to use additional optional filters. 

Note: If you use these filters, any filters that are set in the key fields are ignored. For more 

detailed information, see Use filter. 

5. Click OK to start the deletion process. 
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Manufacturing enterprises feel an ever greater need to secure their procurement market by 

sourcing high performing suppliers. Paying inadequate attention to acquiring and maintaining 

detailed information about a supplier's ability to deliver quality may result in quality shortages, 

delivery bottlenecks, and problems with the enterprise's own customers. 

The Infor COM supplier evaluation module not only provides the basis for systematic supplier 

selection, it also discloses weak points and improves your relationship with your suppliers. 

As well as conventional commercial-technical supplier evaluation, the Infor COM supplier 

evaluation module provides an option for evaluating environmental considerations (see 

"Commercial-technical and environmental supplier evaluation" page 1795). 

The Infor COM supplier evaluation module provides a wide range of evaluation criteria (see 

"Evaluation criteria (Supplier evaluation)" page 1805) for evaluating delivered goods, delivery 

dates, and general supplier capability. 

You can store an inspection plan (see "Inspection plans (Supplier evaluation)" page 1851) for 

each item and open this plan when inspecting goods during purchase receipt and as part of the 

quality assurance process in Purchasing (Purchasing inspection). 

The Infor COM supplier evaluation module can independently analyze a multitude of inspection 

criteria based on stored movement data and mark these using customizable mark ranges (see 

"Mark objective evaluation criteria (Supplier evaluation)" page 1829). 

It allows you to take items with differing evaluation instructions and group these into quality groups 

(see "Quality groups (Supplier evaluation)" page 1817) before applying group-specific evaluation 

criteria. 

The Infor COM supplier evaluation module calculates a whole range of IDs (see "IDs (Supplier 

evaluation)" page 1839) from marked and individually weighted evaluation criteria, which help you 

to evaluate the performance of your suppliers not only from a commercial and technical 

perspective, but also from an environmental point of view. 

The Infor COM supplier evaluation module automatically assigns ABC categories (see "Automatic 

ABC categorization for supplier evaluation" page 1845) to suppliers. 

Supplier evaluation basics 



Infor COM 7.5 User Guide | 1795 

 

Supplier evaluation 

 

You can use this module to suspend (see "Suspend supplier option in Supplier evaluation" page 

1846) suppliers if your ID marks show that there are quality issues in terms of their products and 

services. 

You can also analyze (see "Analyze supplier evaluation in PO proposals" page 1848) the results 

of Infor COM supplier evaluations for supplier selection in PO proposals. 

The Infor COM supplier evaluation module summarizes a wide selection of the resulting data in 

overview reports (see "Reports (Supplier evaluation)" page 1853). 

When you use the Supplier evaluation function, additional tabs are added to some of your Infor 

COM forms. 
 

Commercial-technical and environmental supplier evaluation 

Supplier evaluation (see "Supplier evaluation basics" page 1793) in Infor COM distinguishes 

between commercial-technical evaluations and environmental evaluations. 

Commercial-technical evaluation 

The commercial-technical evaluation assesses a supplier's services and products based on purely 

commercial and technical criteria. This evaluation focuses on criteria such as price, compliance 

with due dates, and functional quality. 

Environmental evaluation 

The environmental evaluation assesses suppliers based on the environmental compatibility of 

their products and services. An environmentally-focused management team evaluates a supplier's 

environmental awareness based on criteria such as ecological certification, material balance, 

willingness to accept returned packaging, means of transportation used, and so on. 

The incentive for performing an environmental supplier evaluation may be expected cost savings 

in addition to general environmental awareness. You can save on disposal costs for packaging 

materials if a supplier lets you return packaging. 
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Environmental supplier evaluation can therefore be viewed as the first decision you make towards 

achieving an ecologically efficient product design taking into account environmental protection 

beyond the company level in terms of supply chain management. 

The result of a supplier's environmental evaluation is expressed in the Environmental reliability 

(ER) (see "–Environmental reliability (ER) ID in Supplier evaluation" page 1842) ID. 

Please note: The environmental Supplier evaluation function must be activated explicitly in the 

configuration using the COMMON.EINKAUF.ECOLOGICALEVALUATION parameter. If it is not 

activated, environment-specific criteria will not be available for checks, and the ER ID will not be 

created. The corresponding input and display fields on the various forms will be hidden. 

If the parameter is cleared again, comparisons with former periods may be distorted. 

Criteria for commercial-technical and environmental evaluation of suppliers: 

Criteria are available for evaluating suppliers both from a commercial and environmental point of 

view. For information on other properties that distinguish Infor COM supplier evaluation criteria, 

click here (see "Evaluation criteria (Supplier evaluation)" page 1805). 
 

Set up supplier evaluation checklist 

Complete the following steps before initiating a supplier evaluation: 

 Setting parameters in the configuration: 

 In the COMMON.EINKAUF section: 

 In the COMMON.QUALITAETSSICHERUNG section: 

 Set mark ranges (see "Mark objective evaluation criteria (Supplier evaluation)" page 1829) 

 Set weightings of evaluation criteria and IDs in the ATTRID allocation table (see "Weighting of 
criteria and IDs (Supplier evaluation)" page 1815) 

 Create quality groups (see "Create quality groups (Supplier evaluation)" page 1817) 

 Set evaluation scales for quality groups (see "Set evaluation scale of a quality group (Supplier 
evaluation)" page 1818) 

 Assign items and quality groups to each other 

 Activate suppliers for evaluation (see "Activate evaluation function for a supplier" page 1803) 

 Mark supplier-related criteria in the Criteria section of the Supplier evaluation tab in the master 

data for the supplier you want to evaluate 

 Calculate a mark for the service/performance criterion (see "Service/performance criterion for 
supplier evaluation" page 1813) 
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 Assign items to inspection plans (see "Assign inspection plan to item (Supplier evaluation)" 
page 1851) 

Once these basic conditions are met, you can start individual evaluations (see "Mark subjective 

evaluation criteria (Delivery evaluation)" page 1833) of deliveries. 
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Allocation tables (Supplier evaluation) 

The Supplier evaluation (see "Supplier evaluation basics" page 1793) module uses the following 

allocation tables: 
 

ATTRID 

Description: Supplier evaluation attribute IDs 

Usage: This Infor COM Supplier evaluation allocation table lets you set the weighting factors (see 

"Weighting of criteria and IDs (Supplier evaluation)" page 1815) for all criteria and IDs. For 

detailed information, see Set weightings in ATTRID allocation table (Supplier evaluation) (page 

1815). 

Type: This allocation table can be modified by the user. 
 

CLASSIFY 

Description: Supplier evaluation categories 

Usage: This Infor COM Supplier evaluation table lets you arrange suppliers in an ABC 

classification (see "Automatic ABC categorization for supplier evaluation" page 1845) according to 

their rating. 

Type: This allocation table can be modified by the user. 

The fields on this tab are as follows: 

Sq. ID 

Specifies the sequential ID of the entry. 

Category 

Specifies the categories into which a supplier is classed up to the given mark limit (see the Mark 

limit field). 
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Mark limit 

Here, define the mark up to which the category (see the Category field) is to apply. 

Example:  

Category Mark limit 

A 2.00 

AB 4.00 

B 6.00 

BC 8.00 

C 10.00 

With these settings, a supplier would be classed as belonging to category B when the mark is 

between 4.01 and 6.00. 

 
 

DISTUNIT 

Description: Units for distances 

Usage: This Infor COM Supplier evaluation allocation table contains the units for the Distance 

criterion: miles, km. 

Type: This allocation table can be modified by the user. 

The fields on this tab are used as follows: 

Attribute ID 

Specifies the numeric ID of a distance unit. 

Description 

Indicates the description of a distance unit. 

Weight 

Specifies the mark or weighting for a distance unit. 
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ECOLCERT 

Description: Environmental certificates 

Usage: This Infor COM Supplier evaluation allocation table contains the properties for the 

Environmental certification criterion: 

- No certificate 

- EMAS I 

- EMAS II 

- ISO14001 

Type: This allocation table can be modified by the user. 

The fields on this tab are used as follows: 

Sequential ID, Sq. ID 

Indicates the environmental certificate ID. 

Environmental certificate 

Indicates the name of the environmental certificate. 

Evaluation 

Specifies a rating for the environmental certificate. 
 

MARKMAP 

Description: Supplier evaluation table 

Usage: This Infor COM Supplier evaluation table contains the default mark ranges for the 

objective item-related criteria. For more information, see Set mark range in MARKUP allocation 

table (Supplier evaluation) (see "Set mark range in MARKMAP allocation table (Supplier 

evaluation)" page 1830). 

Type: This allocation table can be modified by the user. 
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QUALCERT 

Description: Quality certificates 

Usage: This Infor COM Supplier evaluation allocation table lets you assign marks between 1 and 

10 to the quality certificates listed. If you want to enter other quality certificates, enter a sequential 

ID, a name, and a mark in the first free row. 

Current options: 

- No certificate 

- VDA 6.1 

- VDA 6.2 

- DIN ISO 9001 

- QS9000 

- ISO TS 16949 

- EFQM 

Type: This allocation table can be modified by the user. 
 

VEBACKVIEWT 

Description: Evaluation period types 
 

VETRANSP 

Description: Means of transport in Supplier evaluation 

Usage: This Infor COM Supplier evaluation allocation table contains the properties for the 

Transportation criterion. 

- Not specified 
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- Truck 

- Sea 

- Rail 

- Air 

The fields on this tab are used as follows: 

Sequential ID, Sq. ID 

Specifies the numeric ID of a means of transportation. 

Transportation 

Describes the means of transportation. 

Evaluation 

Rates the means of transportation. 

Type: This allocation table can be modified by the user. 
 

VEMARK# 

The following allocation tables are part of supplier evaluation in Infor COM.  

Marks are maintained in the allocation tables (in both number and linguistic form). You can select 

these when evaluating deliveries (see "Mark subjective evaluation criteria (Delivery evaluation)" 

page 1833) to mark the individual criteria from the combo boxes of the relevant mark fields. 

Please note: You can only used the marks stored in these allocation tables when evaluating 

deliveries.  

When supplier evaluation is delivered, the allocation tables contain the following mark values and 

descriptions by default: 

VEMARK1: Marks for accompanying documents 

VEMARK2: Marks for packaging 

VEMARK3GR: Marks for goods receipt quality 

VEMARK3QA: Marks for inspection quality 
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VEMARK4: Marks for material data 

VEMARK5: Marks for packaging return 

VEMARK6: Marks for the quality certificate 

VEMARK7: Marks for the environmental balance 

Note: You can use special parameters to define that the fields for the the marking are to be 

preassigned a mark automatically. For more information on this, see Set default marks for 

subjective criteria (see "Set default marks for subjective criteria in Purchase receipt" page 1834). 

Please check whether you are using automatic mark assignment and, if so, which marks are being 

preassigned. We recommend that you only preassign marks that are also stored in the allocation 

tables described here. 
 

VEPERIODS 

Description: Evaluation periods 

Usage: This allocation table in Infor COM supplier evaluation is used to define the evaluation 

periods that can be chosen in the supplier master. You can define as many months as you like. 

Type: This allocation table can be modified by the user. 

 
 

Activate evaluation function for a supplier 

You must activate the Supplier evaluation (see "Supplier evaluation basics" page 1793) function 

for each supplier that you want to evaluate. 

Then proceed as fol lows:  

1. Configure the Supplier evaluation function. See Configuration (Supplier evaluation). 

2. Open the corresponding supplier's master data. 

3. Select the Supplier evaluation active check box in the header of the master data form. 

4. Then go to the Supplier evaluation tab. 
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There, in the Criteria section, the supplier-related criteria are queried (Means of 

transportation, Quality certificate, Environmental certificate, EDI/VDA link, Electronic 

catalog). 

5. Check the criteria. Select the results from the combo boxes for the fields, or select the 

corresponding check boxes. 

Important:  A minimum of one criterion must be marked for an evaluation to be activated. 

6. Save your settings. 

Note:  When you deactivate the evaluation function, the system asks if you want to delete the 

previously created data. If you click Yes, the data is deleted and the evaluation is deactivated. If 

you click No, the evaluation is deactivated but the data is not deleted. 

A supplier's evaluation data must be updated (see "Evaluate all suppliers batch process" page 

1849) periodically. 
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You need to examine and consider many different aspects when evaluating a supplier's products 

and services. The Infor COM Supplier evaluation (see "Supplier evaluation basics" page 1793) 

module provides several evaluation criteria for these different aspects. Various IDs (see "IDs 

(Supplier evaluation)" page 1839) are generated from the marks assigned in evaluations, and you 

can then use these to assess a supplier's suitability and capability. 

The properties of the criteria on which an evaluation is based are as different as the aspects you 

want to examine in a supplier evaluation are varied. 

Different marking types: 

 Objective cri teria 

 Subjective cri teria  

Different focus: 

 Commercial - technical cri teria  

 Environmental  cri teria  

Different reference: 

 I tem-related cri teria (I  reference)  

 Suppl ier-related cri teria (C (=company) reference)  

Note:  These properties can be combined. 

Objective criteria 

Objective criteria are criteria that have quantifiable properties (see "Property of an evaluation 

criterion" page 1808). They can be measured and/or counted, and can be marked (see "Mark 

objective evaluation criteria (Supplier evaluation)" page 1829) automatically by the system using 

mark ranges. 

Examples: 

 RMA is a commercial-technical criterion that examines the ratio of returned items to the 

number of items delivered. The system calculates this ratio automatically from current posting 

data. It determines the mark for this ratio from the evaluation scale for the quality group. 

Evaluation criteria (Supplier evaluation) 



1806 | Infor COM 7.5 User Guide 

 

Supplier evaluation 

 

 Means of transportation is an environmental criterion for evaluating a supplier's preferred 

means of transportation from an environmental point of view. Enter the means of 

transportation manually in the master data for the supplier. The system automatically marks 

the selected means of transportation using an allocation table in which the mark for that 

means of transportation is stored. 

Note:  The number of objective criteria in the Infor COM supplier evaluation module is predefined, 

and the implementation of additional criteria requires considerable extra rework. Please contact 

your consultant. 

Subjective criteria 

Subjective criteria are criteria whose properties the system cannot enter or mark due to the 

specific nature of the conditions to be checked. 

Subjective criteria are item-related with one exception*. 

Subjective criteria are used – with one exception* – when the quality of delivery lines (individual 

evaluations) is evaluated and/or when purchased goods are inspected (Purchasing inspection). 

Marks for the properties of subjective criteria are entered manually (see "Mark subjective 

evaluation criteria (Delivery evaluation)" page 1833) by the responsible employees. Unlike 

objective criteria, mark ranges do not need to be stored for subjective criteria. 

*Exception:  The subjective Service/performance (see "Service/performance criterion for 

supplier evaluation" page 1813) criterion is an exception here. 

Examples:  

 GR quality is a commercial-technical evaluation criterion that is used for the visual inspection 

of goods received. Employees can evaluate the result of the inspection by assigning a mark 

between 1 and 10. If the check is carried out as a QA inspection, the name of the criterion is I. 
quality. 

 Packaging return is an environmental criterion that checks a supplier's willingness to accept 

returned packaging. Employees responsible for receiving goods and inspecting received 

goods (Purchasing inspection) can award a mark of 1 for Yes and a mark of 10 for No. 

Note: The number of subjective criteria - unlike the fixed preset objective criteria above - can be 

extended. You must add the corresponding fields to the forms in the Purchase receipt and 

Purchasing inspection business objects in Inventory and enter the marks for the additional 

subjective criteria. Please contact your consultant for assistance with this. 
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Marks entered in Purchase receipt or in Purchasing inspection can be adjusted (see "Adjust 

marking of subjective criteria (Adjust marks for deliveries)" page 1837) at any time. 

Commercial-technical criteria 

Commercial-technical criteria are used to evaluate the commercial and technical aspects of a 

supplier's performance. 

For a detailed description of the commercial and technical aspects of the Infor COM supplier 

evaluation module, click here (see "Commercial-technical and environmental supplier evaluation" 

page 1795). 

Environmental criteria 

Environmental criteria are used to evaluate the environmental compatibility of a supplier's 

products and services. 

For a detailed description of the environmental aspect of the Infor COM supplier evaluation 

module, click here (see "Commercial-technical and environmental supplier evaluation" page 

1795). 

Item-related criteria (I reference) 

Item-related criteria are exclusively used for checking and evaluating items grouped into quality 

groups (see "Quality groups (Supplier evaluation)" page 1817) and their associated delivery data. 

Examples: Price comparison, GR quality 

The system automatically checks (see "Check objective item-related criteria (Supplier evaluation)" 

page 1824) and marks (see "Mark objective evaluation criteria (Supplier evaluation)" page 1829) 

objective item-related criteria. Subjective item-related criteria need to be checked (see "Check 

subjective criteria (Supplier evaluation)" page 1828) manually. The marks (see "Mark subjective 

evaluation criteria (Delivery evaluation)" page 1833) are assigned by the system again. 

The system flags item-related criteria with an I for item. 
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Supplier-related criteria (C (=company) reference) 

Only objective criteria can have this property. They can have a commercial and technical or an 

environmental focus. 

Supplier-related criteria are used exclusively when a supplier's general properties and capabilities 

are checked and evaluated. Supplier-related criteria are queried on the Supplier evaluation tab in 

the supplier master data. 

Examples: EDI/VDA, Electronic catalog 

Supplier-related criteria must be checked (see "Check objective supplier-related criteria (Supplier 

evaluation)" page 1827) manually. The marks (see "Mark objective evaluation criteria (Supplier 

evaluation)" page 1829), however, are entered by the system. 

The system flags item-related criteria with a C for company. 
 

Property of an evaluation criterion 

The property of a criterion is the value that is determined when a condition for this criterion is 

checked. 

Examples: 

The Quantity criterion provides the basis for checking the variance in percent of the quantity 

ordered from the quantity actually delivered (delivery quantity variance). If instead of 100 units of 

an item, only 90 units are delivered, the variance is 10%. A variance of 10 percent is the property 

that the Quantity criterion assumed in this check. 

The Means of transportation criterion requests a supplier's preferred means of transportation from 

the supplier master. If the means of transportation is Road, Road is the property of the Means of 

transportation criterion. 
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Overview of all evaluation criteria (Supplier evaluation) 

The table of evaluation criteria provides a detailed overview of all criteria used in the standard 

version of the Infor COM Supplier evaluation (see "Supplier evaluation basics" page 1793) 

module. 

The table includes the fol lowing information:  

 The Criterion column shows the name of the criterion used throughout the system. 

 In the Type column, the criterion is classified as objective or subjective. For detailed 

information, see Evaluation criteria (Supplier evaluation) (page 1805). 

 The Focus column shows whether the criterion is commercial-technical or environmental. For 

detailed information, see Evaluation criteria (Supplier evaluation) (page 1805). 

 The Ref. column lists the reference of the criterion: 

I (item) = Item-related; C (company) = Supplier-related. 

 The Condition to be checked briefly explains which conditions are checked for the 

corresponding criterion. 

 The Check completed ... column indicates whether the result of inspecting the corresponding 

criterion can be determined automatically by the system or whether you have to inform the 

system of the result by manual entry. 

For more information, see Mark criteria (Supplier evaluation) (see "Criteria check (Supplier 

evaluation)" page 1824). 

 The Marks assigned... column indicates whether the system marks the resulting inspection 

values automatically (see above) or whether you need to enter these marks manually. 

For more information, see Mark criteria (Supplier evaluation) (page 1829). 

 The AT column shows the allocation table in which the mark range for this criterion is 

maintained. 

For more information, see Mark criteria (Supplier evaluation) (page 1829). 

There are no allocation tables to maintain for subjective criteria that have to be evaluated 

manually or for objective criteria that only have the two properties (see "Property of an 

evaluation criterion" page 1808) Yes or No. 

 The ID column shows the ID (see "IDs (Supplier evaluation)" page 1839) that is calculated 

later using the marked criterion. 

Exception:  The subjective Service/performance criterion, which is not listed in the table, is 

handled differently. For more information, see Service/performance criterion for supplier 

evaluation (page 1813). 
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Table of evaluation criteria 

Criterion/type Focus/ref. Condition to be checked Check/marks assigned Allocation 

table/ID 

Price 

comparison/objective 

Commercial- 

technical/I 

The variance in percent 

between the invoiced price 

and a specified comparison 

price. 

Automatically/automatically MARKMAP/

TP 

Price  

compliance/objective  

Commercial- 

technical/I 

The variance in percent 

between the price paid and 

the agreed price. 

Automatically/automatically MARKMAP/

TP 

Quantity  

compliance/objective  

Commercial- 

technical/I 

The variance in percent 

between the quantity ordered 

and the quantity delivered 

(delivery quantity variance). 

Automatically/automatically MARKMAP/

TP 

Due date  

compliance/objective  

Commercial- 

technical/I 

The difference in calendar 

days between the requested 

delivery date or PO date and 

the date of the receipt 

transaction. 

Automatically/automatically MARKMAP/

TP 

Returns/objective  Commercial- 

technical/I 

The proportion in percent of 

the returned lines in the total 

lines delivered. 

Automatically/automatically MARKMAP/

TP 

Partial 

deliveries/objective 

Commercial- 

technical/I 

The proportion in percent of 

partially delivered lines 

compared to fully delivered 

lines 

Automatically/automatically MARKMAP/

TP 

Inspection 

quantity/objective  

Commercial- 

technical/I 

The proportion in percent of 

the returned quantity in the 

delivery quantity until now 

Automatically/automatically MARKMAP/

TP 

EDI/VDA/objective  Commercial- 

technical/C 

Does the supplier have an 

EDI/VDA link? 

Manually: Using the EDI/VDA 

check box on the Supplier 

evaluation tab of the supplier 

master data/ 

Automatically: If the supplier 

works with a EDI/VDA link, 

select 1; otherwise, select 10. 

-/TP 

Electronic 

catalog/objective 

Commercial- 

technical/C 

Does the supplier offer an 

electronic catalog to import? 

Manually: Using the 

Electronic catalog check box 

- /TP 
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Criterion/type Focus/ref. Condition to be checked Check/marks assigned Allocation 

table/ID 

on the Supplier evaluation tab 

in the supplier master 

data/Automatically: If the 

supplier has an electronic 

catalog for importing, select 1; 

otherwise, select 10. 

Quality 

certificate/objective 

Commercial- 

technical/C 

Does the supplier have a 

quality certificate? For 

example, VDA 6.1, ISO9001. 

Manually: Select the 

certificate from the combo box 

for the Quality certification 

field on the Supplier 

evaluation tab of the supplier 

master data/ 

Automatically 

QUALCERT/

TP 

Distance/objective  Environmenta

l/C 

Mean distance from supplier 

warehouse to own 

warehouse. 

Manually 

 Enter the distance in the 

Distance field on the Supplier 

evaluation tab of the supplier 

master data/Automatically 

MARKMAP/

ER 

Company 

environmental 

certificate/objective  

Environmenta

l/C 

Has the supplier been 

awarded an environmental 

certificate? 

Manually 

 Select the certificate from 

the combo box for the 

Environmental certification 

field on the Supplier 

evaluation tab of the supplier 

master data/Automatically 

ECOLCERT/

ER 

Means of 

transportation/objecti

ve  

Environmenta

l/C 

Supplier's preferred means 

of transportation for average 

routes. 

Manually 

 Select from the combo box 

for the Transportation field on 

the Supplier evaluation tab of 

the supplier master 

data/Automatically 

VETRANSP/

ER 

Quantity of flawed 

material 

data/objective  

Environmenta

l/C 

The percentage proportion of 

delivery lines that were not 

assigned a mark of 1 when 

the material data was 

checked (see the 

explanations about the 

material data criterion in the 

table further below) in 

Purchase receipt or in 

Purchasing inspection as 

compared to the total number 

Automatically 

 The system enters the 

calculated value in the 

Insufficient material data field 

on the Supplier evaluation tab 

of the supplier master 

data/Automatically 

MARKMAP/

ER 



1812 | Infor COM 7.5 User Guide 

 

Supplier evaluation 

 

Criterion/type Focus/ref. Condition to be checked Check/marks assigned Allocation 

table/ID 

of delivery lines checked for 

material data. 

Accompanying 

docs/objective  

Commercial/

C 

Scope, status, and content of 

the accompanying 

documents received with a 

delivery. 

Manually/manually 

 Enter a mark between 1 and 

10 in the Accmp. docs field on 

the Supplier evaluation tab in 

Purchase receipt or in 

Purchasing inspection. 

- /TP 

Packaging/objective  Commercial/

C 

Quality of the packaging 

received with a delivery. 

Manually/manually: Enter a 

mark between 1 and 10 in the 

Packaging field on the 

Supplier evaluation tab in 

Purchase receipt or in 

Purchasing inspection. 

- /TP 

GR quality/objective  Commercial/

C 

Quality of the goods as 

established during purchase 

receipt. 

Manually/manually: Enter a 

mark between 1 and 10 in the 

GR quality field on the 

Supplier evaluation tab in 

Purchase receipt. 

- /TP 

I.quality/objective Commercial/

C 

Quality of goods as 

established during detailed 

inspection in the quality 

assurance process in 

Purchasing (Purchasing 

inspection) 

Manually/manually: Enter a 

mark between 1 and 10 in the 

I. quality field on the Supplier 

evaluation tab in Purchasing 

inspection. 

 /TP 

Material 

data/objective  

Environmenta

l/C 

The quality of the material 

data as determined when 

checking the delivered goods 

in Goods receipt or in 

Inspection. The mark for the 

Quantity of flawed material 

data criterion (see above) is 

determined from the number 

of delivery lines that were not 

assigned a mark of 1. 

Manually/manually: Enter a 

mark between 1 and 10 in the 

Mat. data field on the Supplier 

evaluation tab in Purchase 

receipt or in Purchasing 

inspection. 

-/ER 
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Criterion/type Focus/ref. Condition to be checked Check/marks assigned Allocation 

table/ID 

Packaging  

return/objective  

Environmenta

l/C 

Does the supplier let you 

return packaging? 

Manually/manually: If yes, 

select a mark of 1; if no, as 

indicated in the Packaging 

return field on the Supplier 

evaluation tab in Purchase 

receipt or in Purchasing 

inspection, select a mark of 

10. A value of 0 indicates no 

mark. 

-/ER 

(Product)  

certificate/objective  

Environmenta

l/C 

Does the inspected item 

have a quality certificate? 

Manually/manually: If yes, 

select a mark of 1; if no, as 

indicated in the Certif. field on 

the Supplier evaluation tab in 

Purchase receipt or in 

Purchasing inspection, select 

a mark of 10. A value of 0 

indicates no mark. 

-/ER 

Env. bal./objective  Environmenta

l/C 

Does the inspected item 

have an environmental 

balance sheet? 

Manually/manually: If yes, 

select a mark of 1; if no, as 

indicated in the Env. bal. field 

on the Supplier evaluation tab 

in Purchase receipt or in 

Purchasing inspection, enter 

a mark of 10. A value of 0 

indicates no mark. 

-/ER 

 
 

Service/performance criterion for supplier evaluation 

The subjective service/performance criterion is handled differently to the other subjective 

evaluation criteria available in the Infor COM Supplier evaluation (see "Supplier evaluation basics" 

page 1793) module. 

The other subjective criteria are used when checking individual delivery lines in Purchase receipt 

or in Purchasing inspection. 
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The service/performance criterion is used to evaluate a number of basic supplier properties. For 

example, you could distribute a specially devised questionnaire at annual or semi-annual intervals 

that all of your Purchasing employees are asked to complete. You could query issues such as the 

quality of processing complaints, cooperation, fairness, and other supplier properties. After the 

questionnaire is evaluated, enter the overall mark in the Service/perf. field on the Supplier 

evaluation tab in the master data for the evaluated supplier. 

If you combine the marks for the service/performance evaluation criterion and the technical 

performance (TP) (see "Technical performance (TP) ID in Supplier evaluation" page 1839) ID, you 

get the total technical performance (TTP) (see "Total technical performance (TTP) ID in Supplier 

evaluation" page 1841) ID. 
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Infor COM provides various IDs for evaluating suppliers. Some of these IDs are generated from 

evaluation criteria marks, others from aggregations of these IDs. For a detailed overview, see IDs 

(Supplier evaluation) (page 1839). 

Evaluation criteria and IDs can be multiplied by weighting factors to give them a greater or lesser 

weight when calculating IDs. A weighting factor is a number by which values are multiplied to give 

them a greater or lesser influence on the overall result. 

Set the weighting factors for all evaluation criteria and IDs in the ATTRID allocation table. 

The weighting factors set in this table for item-related evaluation criteria are automatically used to 

populate the quality groups (see "Quality groups (Supplier evaluation)" page 1817) where they are 

adjusted to the specifics of each group. 
 

Set weightings in ATTRID allocation table (Supplier evaluation) 

For basic information on weighting, see the Weighting (see "Weighting of criteria and IDs (Supplier 

evaluation)" page 1815) topic. 

To set weightings in the ATTRID allocation table, complete the following steps: 

1. In System functions, open the Administration folder and click Allocation tables. The start form 

is displayed. 

2. On the Open tab, enter the table name ATTRID in the Table name field. 

3. Click Load. The ATTRID allocation table opens. 

4. In the Weight field, enter the weighting factor for the required criterion or ID that you want to 

use for weighting the calculation of the ID in the ID column. A weighting factor is a number by 

which values are multiplied to give them a greater or lesser influence on the overall result. 

See the following example. 

Weighting of criteria and IDs (Supplier 

evaluation) 
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Attribute ID Description Weight ID Type Ref. Scale 

1 PRICE COMPLIANCE 0.10 TP DH I U 

Explanation: The mark determined for the Price compliance criterion is weighted with a 

factor of 0.10 when the Technical performance (TP) ID is calculated in the standard 

version. 

The IDs are broken down as follows: 

Attribute ID Type of criterion 

01 - 19 Objective commercial-technical criteria 

20 - 29 Objective environmental criteria 

30 - 39 Subjective commercial-technical criteria 

40 - 49 Subjective environmental criteria 

50 Service/performance criterion 

51 - ... IDs 

Recommendation and t ip:  If you do not want a criterion to be taken into account, 

assign it a weighting factor of 0 (zero). Try to avoid having to change selected weightings 

later. This keeps evaluations comparable. 

5. Save your entries. 
 

Set weightings in quality groups (Supplier evaluation) 

For basic information on weighting in the Infor COM Supplier evaluation module, see the 

Weighting (see "Weighting of criteria and IDs (Supplier evaluation)" page 1815) topic. 

You can set weighting factors for quality groups by editing the evaluation scale of each group. You 

can also set mark ranges there. 

For information on setting up an evaluation scale for a quality group, see here (see "Set evaluation 

scale of a quality group (Supplier evaluation)" page 1818). 
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The Infor COM Supplier evaluation (see "Supplier evaluation basics" page 1793) module 

examines and assesses various aspects when evaluating a supplier. The overall evaluation of a 

supplier consists of the individual evaluation of the supplier's performance and general services, 

the quality of the goods delivered, and the associated delivery data. 

 

You can use different evaluation instructions to evaluate item and delivery data. Items that are 

similar in terms of evaluation method and quality should be grouped into quality groups. 

You can use an evaluation scale in a quality group to set the specific weightings (see "Weighting 

of criteria and IDs (Supplier evaluation)" page 1815), properties (see "Property of an evaluation 

criterion" page 1808), and associated mark ranges of an evaluation criteria for the items of this 

quality group. 

The standard version checks each quality group for the same item-related evaluation criteria. A 

mark is assigned to a criterion in each quality group. The final mark is calculated (see "Calculate 

final mark of a quality group criterion" page 1820) by adding the marks for the individual quality 

groups. This mark is then used together with the final marks of the other quality group criteria and 

the final marks of the supplier-related criteria to calculate both the technical performance and 

environmental reliability IDs (see "IDs (Supplier evaluation)" page 1839). 

 
 

Create quality groups (Supplier evaluation) 

For an overview of quality groups, see Quality groups (Supplier evaluation) (page 1817). 

To create one or more qual i ty  groups, complete the fol lowing steps:  

1. As quality groups should be defined in their own unused allocation table for item group flags, 

you first need to determine which of the five AGRKNZ1 to AGRKNZ5 allocation tables is still 

available in your Infor COM system and can therefore be used to define quality groups. 

Quality groups (Supplier evaluation) 
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2. To find an empty allocation table, open the Administration folder in System functions, and click 

Allocation tables. This displays the start form. 

3. Select the Open tab and, in the Table name field, enter the agr% string. The percent sign is a 

wildcard. 

4. Then click the Load button to display an overview of available allocation tables for item group 

flags (AGRKNZ). In the standard version of Infor COM, these allocation tables are called 

AGRKNZ1 through AGRKNZ5. 

5. Now click the >> button (next record) on the start form. 

Click once to load the AGRKNZ1 allocation table. Like the AGRKNZ3 allocation table, this 

table is already populated in the standard version of Infor COM. Each time you click, the 

next allocation table is displayed. The Description field for empty table will contain the 

entry Not defined. 

6. In the GrFlag field in one of the empty tables, enter the group flag to be used for the quality 

group. 

Please note: Use numeric characters only. 

7. Enter a brief description of the group in the Description field. 

8. Define more quality groups in this way if required. 

9. Save the table. 

10. Make sure that the selected allocation table is set in the configuration via the 

COMMON.EINKAUF.AGRKNZ parameter. 

Once the quality group(s) are defined, you can now set the corresponding evaluation scales. For 

more information, see Set evaluation scale of a quality group (Supplier evaluation) (page 1818). 

The last step involves assigning items to quality groups. For more information, see Assign items 

and quality groups to each other (Supplier evaluation) (page 1820). 
 

Set evaluation scale of a quality group (Supplier evaluation) 

The weightings and mark ranges for the criteria of a quality group (see "Quality groups (Supplier 

evaluation)" page 1817) are defined beforehand in an evaluation scale. An evaluation scale is the 

technical conversion of the required evaluation instructions for the items of a quality group. 



Infor COM 7.5 User Guide | 1819 

 

Supplier evaluation 

 

Important:  A quality group will only be assigned an evaluation scale if you have opened the 

Evaluation scales object and saved the ID of that quality group at least once. For basic 

instructions, see below. 

Before sett ing evaluat ion scales, read the notes below.  

 The criteria in a quality group are exclusively item-related. 

 The weighting preset in the evaluation scale are taken from the ATTRID allocation table. If you 

change the weighting in the ATTRID table, it has no effect on the evaluation scales of quality 

groups that already exist. 

 The preset properties and mark ranges of objective criteria (type O) in the evaluation scales 

are taken from the MARKMAP (see "Set mark range in MARKMAP allocation table (Supplier 

evaluation)" page 1830) allocation table. If you change mark ranges in this allocation table, 

this has no effect on the evaluation scales of quality groups that already exist. 

 As subjective criteria (type S) must be marked manually, you only need to set weightings - you 

do not have to maintain mark ranges. The Mark range tab is locked for these criteria. 

 You cannot completely delete or insert criteria in the Evaluation scales object. If you want to 

add another subjective item-related criterion, the supplier evaluation forms need to be 

adjusted. Please contact your consultant. 

To set an evaluation scale: 

1. In the Purchasing module, select Evaluation scales. The start form is displayed. 

2. On the Open tab, select the ID of the required quality group from the ID field. Then click Load. 

3. Open the Evaluation scales tab. The table lists all evaluation criteria. The ID field shows the ID 

(see "IDs (Supplier evaluation)" page 1839) you want to calculate using the weighted criterion. 

4. In the Weight field, enter the weighting factor that determines the degree to which this criterion 

is taken into account when calculating the associated ID. If you do not want to take a criterion 

into account at all, enter a weighting factor of 0 (zero). 

5. Go to the Mark range tab to assign the corresponding properties of this criterion to marks. 

Example: The Quantity criterion checks the variance in percent between the quantity 

ordered and the quantity actually delivered (delivery quantity variance). If you want to 

assign the mark 1 to a variance of 5% - both for under deliveries and over deliveries - enter 

the number 5 in the Value field in the row for this mark. 

6. Save your entries. 

It does not matter whether you set the weighting and mark range for each evaluation criterion first, 

or if you set all weightings for all criteria first, and then set the mark ranges. 
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Once you have set the evaluation scale for a quality group, you can assign the quality group to the 

corresponding items. See Assign items and quality groups to each other (Supplier evaluation). 
 

Assign items and quality groups to each other (Supplier evaluation) 

For an overview of quality groups, see Quality groups (Supplier evaluation) (page 1817). 

To assign an i tem to a qual i ty  group: 

1. Load the master data for the item. To do this, select the Purchasing module, open the Master 

data folder, and click Purchased items. The start dialog box is displayed. 

2. Go to the Open tab and enter the ID of the item in the Item field or select it from the combo box 

for this field. 

3. Click Load. The master data form is displayed. 

4. Go to the Statistics/documents tab. 

5. Select the required quality group from the combo box for the appropriate Group flag field. 

If you have defined quality groups in the AGRKNZ4 allocation table, for example, the 

quality groups will be stored in the fourth of the five fields. 

6. Save the master data. 

Note: Items that are not assigned to a quality group are not taken into account by the supplier 

evaluation function. 
 

Calculate final mark of a quality group criterion 

For basic information on quality groups, see the Quality groups (see "Quality groups (Supplier 

evaluation)" page 1817) topic. 

First, the average mark of a criterion is calculated from the individual marks assigned in each 

quality group. The total of the individual marks is divided by the number of evaluations: 

Average mark j =  Mark {i, 1, Evaluations} / Number of evaluations 
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In the next step, the average mark is multiplied by the weighting factor stored for this criterion in 

the quality group, which results in a weighted average mark of the criterion for the quality group. 

Weighted average mark j = Average mark x Weighting factor j 

In this way, the weighted average mark of the criterion is calculated for all other quality groups. 

These average marks are totaled in the next step. The result is the total average mark. 

Total average mark =  Weighted average mark k {k, 1, QG} 

The weighting factors are also added to obtain the weighting value: 

Weighting value n =  Weighting factor k,n {k, 1, QG} 

In the final step, the total average mark is divided by the weighting value to determine the final 

mark for the criterion. 

Final mark = (Total average mark / Weighting value) 

To view an example that illustrates this process, click here (see "Example of calculating the final 

mark for a quality group criterion" page 1821). 

The final marks for all quality group criteria are calculated in all quality groups. These final marks 

are used to calculate the TP (see "Technical performance (TP) ID in Supplier evaluation" page 

1839) or ER (see "–Environmental reliability (ER) ID in Supplier evaluation" page 1842) IDs. 
 

Example of calculating the final mark for a quality group criterion 

The calculation example below has been simplified and is intended to illustrate the general 

explanation (see "Calculate final mark of a quality group criterion" page 1820) of how final marks 

are calculated using the objective Quantity criterion as an example for all quality groups (Price 

comparison, Price compliance, Quantity, Due date compliance, Partial deliveries, Inspection 

quantity, Invalid material data, Returns). 

Let us assume that 1000 units of an item were ordered in a PO. The supplier only delivered 873 

units. The variance in percent of the quantity ordered and quantity actually delivered is 12.7%. 

12.7 = | ((1000 - 873) / 1000) | x 100 
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The variance value we just calculated is evaluated in the next step. The system determines the 

evaluation scale (see "Set evaluation scale of a quality group (Supplier evaluation)" page 1818) of 

the quality group that the item is assigned to for the mark set for this property (see "Property of an 

evaluation criterion" page 1808). 

Mark Value 

1 10.00 

2 20.00 

3 30.00 

4 40.00 

If we use the above mark range from an evaluation scale, a variance of 12.7% would fall into a 

value range of 20.00. A mark of 2 is stored for this variance. 

Note:  Marks are calculated differently for subjective quality group criteria such as GR quality. 

Employees enter these marks directly during inspection. For more information, see Mark 

subjective evaluation criteria (Delivery evaluation) (page 1833). The other calculation steps apply 

to both types of criteria however. 

The next step is to calculate the average mark for the Quantity criterion from the individual marks 

found for this quality group. The individual marks are added and then divided by the number of 

evaluations. If in five evaluations of the Quantity criterion, the marks awarded were 2, 1, 3, 2, and 

3, the average mark is 2.2: 

2.2 = (2 + 1 + 3 + 2 + 3) / 5 

This average mark is now weighted using the weighting factor set for this criterion in the quality 

group. The result is the weighted average mark. Let's assume this factor is 0.1: 

2.2 x 0.1 = 0.22 

The weighted average marks for the other quality groups are calculated in the same way. The final 

mark can then be calculated. The quotient is obtained by dividing the weighted average marks 

total by the weighting factors total. 

Assume that three other quality groups are defined with weighting factors set to 0.05, 0.2, and 0.3 

and that the weighted average marks for the criterion were 0.1, 0.54, and 0.96: 

(0.1 + 0.22 + 0.54 + 0.96) / (0.05 + 0.1 + 0.2 + 0.3) = 3.45 
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This final mark is used to calculate the corresponding ID together with the final marks for the other 

criterion. For our Quantity criterion, the ID is Technical performance (TP). 
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The Infor COM Supplier evaluation (see "Supplier evaluation basics" page 1793) module provides 

a number of evaluation criteria (see "Evaluation criteria (Supplier evaluation)" page 1805) that are 

used as the basis for checking supplier services, delivery dates, and goods delivered. 

Whether the system checks the criteria and analyzes the results or whether you have to do this 

manually depends on the type and reference of the evaluation criteria. 
 

Check objective item-related criteria (Supplier evaluation) 

For basic information on checking criteria in the Infor COM Supplier evaluation module, see 

Criteria check (see "Criteria check (Supplier evaluation)" page 1824). 

The objective item-related criteria (Price comparison, Price compliance, Quantity, Due date 

compliance, Partial deliveries, Inspection quantity, Invalid material data, Returns) are checked and 

evaluated by the system automatically. 

These criteria can be analysed automatically, because the system contains all the data required 

provided the relevant business transactions were carried out using Infor COM. The system can 

compare the values found in inspections to the actual order data or to a preset reference value 

and calculate variances in percent or as a proportion. 

Example: The system can detect any variance between ordered quantities and delivered 

quantities as checked using the objective Quantity criterion, since it can access the quantity in the 

PO and the actual posted quantity in the purchase receipt posting. 

Price comparison 

Checks the variance in percent between the invoiced price and a specified comparison price. 

Variance (in %) = ((Invoiced price - Comparison price) / Order price) x 100 

Criteria check (Supplier evaluation) 
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The current average, most recent, highest or lowest price can be selected as the comparison 

price. The required comparison price must be set in the configuration using 

the  COMMON.EINKAUF.PRICEFORCOMPARISON parameter. 

We recommend that you use the average price that is set as a default value in the standard 

version. 

The price for comparison is the price that is invoiced by the supplier. The values are calculated in 

the base currency according to the COMMON.PREISRECHNUNG.DEFAULTWE parameter. The 

mark for the calculated value is entered automatically in the Price field in the master data for this 

supplier. 

Price compliance 

Checks the variance in percent between the invoiced price and the original order price. 

Variance (in %) = ((Invoiced price - Order price) / Order price) x 100 

Quantity 

Checks the variance in percent between the quantity ordered and the quantity actually delivered 

(delivery quantity variance). 

Variance (in %) = ((Order quantity - Delivery quantity) / Order quantity) x 100 

This check is carried out automatically as part of invoice approval. 

Due date compliance 

Checks the difference in calendar days between the requested delivery date or PO date and the 

date of the receipt transaction. 

Variance (in calendar days) = Reference date – Transaction date 

The required reference date must be set in the configuration using the 

COMMON.EINKAUF.DATEFORCOMPARISON parameter. As explained, you can choose 

between the requested delivery date and the order date. The requested delivery date is the default 

setting. 
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Partial deliveries 

Calculates the proportion in percent of partially delivered lines compared to fully delivered lines: 

Proportion (in %) = (Number of partial deliveries / Total number of deliveries) x 100 

The number of fully delivered lines consists of the total number of lines with a full receipt and the 

total number of closed lines with a partial receipt. 

The mark for the calculated proportion across all quality groups is entered automatically in the 

Partial deliveries field in the master data for the corresponding supplier. 

Inspection quantity 

Calculates the proportion of the returned quantity in the overall delivery quantity. 

Variance (in %) = (RMA quantity / Total delivery quantity) x 100 

Invalid material data 

Calculates the percentage proportion of lines per quality group that were assigned a mark of less 

than 1 in Purchase receipt or Purchasing inspection for the Material data criterion as compared to 

the total number of lines checked for material data. 

Proportion (in %) = (Number of lines with a mark for material data > 1 / Total number of lines 

checked for material data) x 100 

The mark for the proportion determined is entered in the Insufficient material data field in the 

supplier master data. 

Returns 

Calculates the proportion in percent of returned lines in the total lines delivered. 

Proportion (in %) = (Number of returned lines / Total number of lines delivered) x 100 

The total number of lines delivered consists of the PO lines with a full receipt and the closed PO 

lines with a partial receipt. The mark for the calculated value is entered automatically in the 

Returns field in the master data for the corresponding supplier. 
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Examples 

The following examples, which are based on the Quantity criterion, can be applied to all objective 

item-related criteria: 

Price comparison, Price compliance, Quantity, Due date compliance, Partial deliveries, Inspection 

quantity, Invalid material data, Returns. 

A PO contained an order for 1000 units of an item. Only 873 units were delivered, resulting in an 

underdelivery. According to the formula given for the Quantity criterion above, the result is a 

percent variance from the ordered quantity of 12.7%: 

12.7 = ((1000 - 873) / 1000) x 100 

If an excess quantity of 139 units were delivered, the variance would be: 

((1000 - 1139) / 1000) x 100 = -13.9 

Note: Only postings with a transaction quantity of > 0 are taken into account for full and partial 

receipts. 

The system assigns marks to the results using mark ranges. For more information, see Mark 

objective evaluation criteria (see "Mark objective evaluation criteria (Supplier evaluation)" page 

1829). 
 

Check objective supplier-related criteria (Supplier evaluation) 

For basic information on checking criteria, see Criteria check (Supplier evaluation) (page 1824). 

The six objective supplier-related evaluation criteria provided with the Infor COM Supplier 

evaluation (see "Supplier evaluation basics" page 1793) module check whether a supplier has an 

electronic catalog, an EDI/VDA link,  as well as quality and environmental certification and if so, 

the type of certification, the means of transportation it prefers, and the mean distance from the 

supplier's warehouse to your own warehouse. 

These criteria can only be checked and analyzed manually. Enter the inspection results in the 

Criteria section on the Supplier evaluation tab in the corresponding supplier's master data. 
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The system assigns marks to the results using mark ranges. For more information, see Mark 

objective evaluation criteria (see "Mark objective evaluation criteria (Supplier evaluation)" page 

1829). 
 

Check subjective criteria (Supplier evaluation) 

For basic information on checking criteria, see Criteria check (Supplier evaluation) (page 1824). 

The subjective evaluation criteria (Accompanying documents (ID=30), Packaging (ID=31), GR 

quality (ID=32), Inspection quality (ID=33), Material data (ID=40), Packaging return (ID=41), 

Product certificate (ID=42), Environmental balance (ID=43)) of the Infor COM Supplier evaluation 

(see "Supplier evaluation basics" page 1793) module are only used when employees in Purchase 

receipt or Purchasing inspection check the delivered items and associated delivery data. 

After you have determined and analyzed the inspection results, you can assign marks to the 

criteria. For more information, see Mark subjective evaluation criteria (see "Mark subjective 

evaluation criteria (Delivery evaluation)" page 1833). 
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The Infor COM Supplier evaluation (see "Supplier evaluation basics" page 1793) module provides 

several evaluation criteria (see "Evaluation criteria (Supplier evaluation)" page 1805) for checking 

a supplier's general properties, the quality of items grouped into quality groups (see "Quality 

groups (Supplier evaluation)" page 1817), and the associated delivery data. 

After checking (see "Criteria check (Supplier evaluation)" page 1824) the criteria and obtaining the 

inspection results, these results must be given a mark. Depending on the evaluation criteria, either 

the system marks the result automatically or you assign marks manually. 

 
 

Mark objective evaluation criteria (Supplier evaluation) 

For basic information on marking criteria, see Mark criteria (see "Mark criteria (Supplier 

evaluation)" page 1829). 

The system marks objective quality criteria based on predefined mark ranges. 

Where these mark ranges are maintained and what you must watch out for depends on what the 

criterion refers to: 

Mark ranges for objective item-related criteria 

The Supplier evaluation module in Infor COM allows items that are evaluated in a similar way to be 

combined into quality groups. When a new quality group is created, mark ranges are assigned to 

the objective item-related evaluation criteria. (Price comparison, Price compliance, Quantity, Due 

date compliance, Partial deliveries, Inspection quantity, Invalid material data, Returns.) These 

default mark ranges are set in the MARKMAP allocation table. 

The default mark ranges can be adjusted to the evaluation specifics of the items using the 

evaluation scale of the newly created quality group. 

Mark criteria (Supplier evaluation) 
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For information on setting mark ranges in quality groups, see Set evaluation scale of a quality 

group (Supplier evaluation) (page 1818). 

Mark ranges for objective supplier-related criteria 

The mark ranges for objective supplier-related criteria are defined in a separate allocation table of 

their own, with two exceptions. 

Means of transportation, Quality certificate, Environmental certificate, Distance, EDI/VDA link, 

Electronic catalog 

For information on setting mark ranges in allocation tables, see Set mark range for objective 

supplier-related criteria (Supplier evaluation) (page 1831). 
 

Set mark range in MARKMAP allocation table (Supplier evaluation) 

 

The default values for the objective item-related evaluation criteria (Price comparison, Price 

compliance, Quantity, Due date compliance, Partial deliveries, Inspection quantity, Invalid material 

data, Returns.) for the evaluation scales of quality groups (see "Quality groups (Supplier 

evaluation)" page 1817) are defined in the MARKMAP allocation table. In the evaluation scales for 

the quality groups, you then need to adjust the mark ranges to the items in each group. 

Note:  The mark range for the objective supplier-related evaluation criterion Distance, which is not 

used in the evaluation scales, is also maintained in the MARKMAP allocation table. 

To set mark ranges in the MARKMAP al location table, complete the fol lowing 

steps: 

1. Load the MARKMAP allocation table. To do this, select System functions, open the 

Administration folder, and click Allocation tables. The start form is displayed. 

2. Select the Open tab. 

3. In the Table name field, enter MARKMAP. 

4. Click Load. The selected table is loaded. 
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5. Now you can define up to ten value ranges for each criterion and assign marks 1 to 10. Enter 

the values in the Value column, and the marks in the Mark column. 

 Values and marks are already defined in the standard version. Overwrite these if required. 

 Values, marks, and assignments must be unique within a criterion. The system does not 

accept duplicate values, marks, or assignments. 

 Entering and marking negative values can be useful for some criteria. 

Example: The Price compliance criterion checks the variance in percent between the 

order price and invoice price. If you want to mark cases in which the invoice price is less 

than the order price, store the flat value -1.00 for this condition and assign it a good mark 

(such as mark 1). 

6. Save your entries. The values within a criterion are sorted in ascending order when you save 

the table. 

Note: Changes to properties and mark ranges in this allocation table do not affect the evaluation 

scales of quality groups that have already been created. 
 

Set mark range for objective supplier-related criteria (Supplier 

evaluation) 

For basic information on marking criteria, see Mark criteria (Supplier evaluation) (page 1829). 

When automatically marking objective supplier-relevant criteria, the system refers to mark ranges 

in which you predefined the marks for potential properties (see "Property of an evaluation criterion" 

page 1808). 

The table below lists the allocation tables in which these mark ranges are maintained for these 

criteria: 
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Criterion Allocation 

table 

Preset 

properties 

Transportation VETRANSP - None 

- Road 

- Sea 

- Rail 

- Air 

Quality certification QUALCERT - No certificate 

- VDA 6.1 

- VDA 6.2 

- DIN ISO 9001 

- QS 9000 

- ISO TS 16949 

- EFQM 

Environmental certification ECOLCERT - No certificate 

- EMAS I 

- EMAS II 

- ISO14001 

Distance MARMAP 100 , 200 , 300 , ... , 1000 

EDI/VDA 

Electr. catalog 

- 

- 

These two criteria can only be assigned the properties (see 

"Property of an evaluation criterion" page 1808) Yes to 

indicate they exist or No if they do not. A mark of 1 for Yes 

and 10 for No are preset by the system and are not defined in 

an allocation table. 

You can store and mark additional properties or change existing properties and marks at any time. 

The number of properties for the Distance criterion is limited to 10 distance ranges. 

To define mark ranges for objective criteria, complete the following steps: 

1. In System functions, open the Administration folder and select Allocation tables. The start form 

is displayed. 

2. Select the Open tab. 

3. In the Table name field, enter the name of the required allocation table. The names are listed 

in the table above. 

4. Click Load. The selected table is displayed. 



Infor COM 7.5 User Guide | 1833 

 

Supplier evaluation 

 

 VETRANSP 

 Assign marks between 1 and 10 to the means of transportation listed. If you want to enter 

other means of transportation, enter a sequential ID, a name, and a mark in the first free 

row. 

 QUALCERT 

 Assign marks between 1 and 10 to the quality certificates listed. If you want to enter other 

certificates, enter a sequential ID, a name, and a mark in the first free row. 

 ECOLCERT 

 Assign marks between 1 and 10 to the environmental certificates listed. If you want to 

enter other certificates, enter a sequential ID, a name, and a mark in the first free row. 

 MARKMAP 

You can define up to 10 distance ranges and assign each range marks between 1 and 10 

for the Distance criterion. Enter the distance in the Value column. Then enter the mark for 

the value in the Mark column. The unit of measure (miles or km) is entered in the delivery 

master data if one of the distance ranges defined here is assigned to the supplier. 
 

Mark subjective evaluation criteria (Delivery evaluation) 

For basic information on marking criteria, see Mark criteria (see "Mark criteria (Supplier 

evaluation)" page 1829). 

Subjective evaluation criteria are used to evaluate delivered goods and associated delivery data, 

with the exception of the Service/performance (see "Service/performance criterion for supplier 

evaluation" page 1813) criterion. 

The individual lines of a delivery are evaluated manually when you mark the criteria in the 

Purchase receipt business object (Inventory > Goods receipt). 

If lines or parts of lines are posted to the Purchasing inspection object (Inventory > Goods receipt) 

for a more detailed inspection, instead of being posted immediately to inventory, they can/must* 

be marked there too: 

Purchasing inspection offers the same evaluation criteria as in Purchase receipt, with the 

exception of the Purchasing inspection criterion. Instead of the GR quality criterion, which checks 

the quality of purchase receipts by simple visual inspection, Purchasing inspection uses the I. 

quality criterion to determine quality. 

Note: You can use the COMMON.EINKAUF.EVALUATIONISMUST parameter in the 

configuration to indicate whether marks are mandatory. This rule will apply to marks in both the 

Purchase receipt and Purchasing inspection objects. 
 



1834 | Infor COM 7.5 User Guide 

 

Supplier evaluation 

 

Set default marks for subjective criteria in Purchase receipt 

The Infor COM Supplier evaluation (see "Supplier evaluation basics" page 1793) module allows 

you to preset the marks for individual evaluations (see "Mark subjective evaluation criteria 

(Delivery evaluation)" page 1833) in Purchase receipt and Purchasing inspection. 

Use this function if your suppliers typically deliver the same quality. If checks find exceptions, you 

will only need to adjust the marks for the criteria involved. 

Note:  It is in your own interest  to ensure that default marks are not accepted globally without 

carrying out any checks. This may distort the evaluation results, and the supplier evaluation 

function may become meaningless. Use this function with caution. 

The configuration also contains parameters that let you set a default mark for each of the eight 

subjective criteria. The value 0 is set by default (this stands for Not evaluated): 

Parameter Criterion Possible mark Default setting 

DefaultValue30 Accmp. docs 1 to 10 0 

DefaultValue31 Packaging 1 to 10 0 

DefaultValue32 GR quality 1 to 10 0 

DefaultValue33 I. quality 1 to 10 0 

DefaultValue40 Mat. data 1 to 10 0 

DefaultValue41 Packaging return 1 or 10 0 

DefaultValue42 Product certificate 1 or 10 0 

DefaultValue43 Env. bal. 1 or 10 0 

Note: The two-digit ID in the parameter name is the ID of the criterion as it is listed in the ATTRID 

allocation table. 

Interaction wi th other parameter sett ings:  

 Default marks are set automatically even if evaluation is not set as mandatory 

(EvaluationIsMust=no). 

 The automatic populate function (AutoFillIn=yes) populates fields that are assigned a value 

of 0 by the automatic mark assignment function. 

For more information on the Supplier evaluation parameters, go to Set up supplier 

evaluation checklist (page 1796) and see Setting parameters in the configuration. 
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Matching up wi th the notes stored in the VEMARK1 to VEMARK7 al location t ables: 

For greater clarity during the evaluation, you should ensure that you only predefine those notes 

that you have also stored in the relevant allocation table, although this is not a prerequisite for the 

evaluation to work properly. For more information on these allocation tables, click here (see 

"VEMARK#" page 1802). 
 

Evaluate delivery in Purchase receipt 

For basic information on evaluating deliveries, see Evaluate deliveries (see "Mark subjective 

evaluation criteria (Delivery evaluation)" page 1833). 

The procedure of evaluating delivery lines in purchase receipt is described below: 

1. Load the purchase order in Purchase receipt. To do this, open the Inventory module and select 

Purchase receipt. The start form is displayed. 

2. On the Open tab, enter the ID of the purchase order in the PO ID field or select it from the 

combo box for the field. 

3. Click Load to load the selected PO. The Purchase receipt form is displayed. 

4. Now you can enter the posting IDs and transaction quantities on the Receipt tab. You can also 

do this after the evaluation. 

See also the explanations provided for the COMMON.EINKAUF.EVALUATIONISMUST 

parameter. 

5. If you want to carry out an evaluation, open the Supplier evaluation tab. 

Please note:  This tab will only be displayed if the evaluation function has been 

activated (see "Activate evaluation function for a supplier" page 1803) for the supplier. 

6. Now mark the criteria based on the inspection results for each line you want to evaluate. 

For all criteria, please select a mark from the relevant combo box. 

Notes: 

If you are working with automatic default marks (see "Set default marks for subjective 

criteria in Purchase receipt" page 1834), replace the marks if required. 

When entering marks, the setting defined for the COMMON.EINKAUF.AUTOFILLIN 

parameter must be taken into account. 
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If you have stored inspection plans (see "Inspection plans (Supplier evaluation)" page 

1851) with items, you can view them now. Place your cursor in the corresponding line, go 

to the PO line view, and select the InspPlan function. 

You cannot mark items that are not assigned to a quality group (see "Quality groups 

(Supplier evaluation)" page 1817). The mark fields for these items are locked. 

7. Save your entries. The system carries out the postings and stores the marks for the criteria in 

the corresponding quality groups. 

If you posted lines or parts of lines to Purchasing inspection in the Inventory module, you can or 

must (depending on the situation) enter marks there as well. For more information, see Evaluate 

delivery in Purchasing inspection (page 1836). 
 

Evaluate delivery in Purchasing inspection 

For basic information on evaluating deliveries, see Evaluate deliveries (see "Mark subjective 

evaluation criteria (Delivery evaluation)" page 1833). 

The following process describes the procedure for evaluating delivery lines in Purchasing 

inspection in the Inventory module. 

1. Open the Inventory module and select Purchasing inspection. The start form is displayed. 

2. On the Open tab, enter the data for selecting a delivery line. 

3. Click Load to load the selected delivery line. 

4. Now you can enter the posting IDs and quantities on the Inspection tab. You can also do this 

after the evaluation. 

See also the explanations provided on the COMMON.EINKAUF.EVALUATIONISMUST 

parameter. 

5. If you want to carry out an evaluation, open the Supplier evaluation tab. 

Please note:  This tab will only be displayed if the evaluation function has been 

activated (see "Activate evaluation function for a supplier" page 1803) for the supplier. 

6. Now mark the criteria based on the inspection results for each line you want to evaluate. 

For all criteria, please select a mark from the relevant combo box. 

Notes: 
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If you are working with automatic default marks (see "Set default marks for subjective 

criteria in Purchase receipt" page 1834), replace the marks if required. 

When entering marks, note the setting of the COMMON.EINKAUF.AUTOFILLIN 

parameter. 

If you have stored inspection plans (see "Inspection plans (Supplier evaluation)" page 

1851) with items, you can view them now. Place your cursor in the corresponding line, go 

to the PO line view, and select the InspPlan function. 

You cannot mark items that are not assigned to a quality group (see "Quality groups 

(Supplier evaluation)" page 1817). The mark fields for these items are locked. 

7. Save your entries. The system carries out the postings and stores the marks for the criteria in 

the corresponding quality groups. 
 

Adjust marking of subjective criteria (Adjust marks for deliveries) 

Any marks assigned by the Infor COM Supplier evaluation (see "Supplier evaluation basics" page 

1793) function can be adjusted in Purchase receipt and Purchasing inspection at a later stage. 

Adjustments are made on a special adjustment tab located in the PO line view in Purchase orders 

(Purchasing) and Purchase receipt (Inventory). 

Note:  You can only adjust marks in Purchase receipt as long as a full receipt has not been posted 

for the corresponding PO lines. In Purchase orders, however, you can make adjustments even 

after a full receipt is posted. 

The adjustment process is the same in both Purchase receipt and Purchase orders: 

1. To load the purchase order containing the lines whose marks you want to adjust, choose from 

one of the following options: 

 Select Purchasing > Purchase orders. 

 Select Inventory > Goods receipt > Purchase receipt 

 Select Inventory > Goods receipt > Purchasing inspection 

2. Open the Supplier evaluation tab. It displays the marks assigned during purchase receipt 

and/or purchasing inspection. If the tab is dimmed, no adjustable marks have been assigned. 

3. Select the line in which you want to adjust marks. Place your cursor in any field in this line. 

4. Press F8 to go to the PO line view. 
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5. Display the Supplier evaluation tab. 

6. Adjust the marks by selecting them from the combo box. 

7. If you want to adjust marks in other PO lines, use the Next row or Previous row buttons to 

display the lines. 

8. Save your adjustments. 
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You can use IDs to express problem-related information in condensed form. The Infor COM 

Supplier evaluation (see "Supplier evaluation basics" page 1793) module provides the following 

IDs for evaluating the commercial and environmental suitability and capability of your suppliers: 

 Technical performance (TP) 

 Total technical performance (TTP) 

 Environmental reliability (ER) 

 Total performance (TP) 

For a detailed description of each ID, refer to the links at the end of this topic. 

ID generation 

The TP and ER IDs are derived from marks assigned to evaluation criteria (see "Evaluation 

criteria (Supplier evaluation)" page 1805). 

However, the TTP and TP IDs are the results of aggregations as shown in the overview below: 

 Technical performance (TP) ID 

+ Mark for the Service/performance criterion 

= Total technical performance (TTP) ID 

+ Environmental reliability (ER) ID* 

= Total performance (TP) ID 

* Optional 
 

Technical performance (TP) ID in Supplier evaluation 

For basic information on IDs, see the IDs (see "IDs (Supplier evaluation)" page 1839) topic. 

The standard version uses the following commercial evaluation criteria to calculate the mark for 

the technical performance (TP) ID: 

IDs (Supplier evaluation) 
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Objective criteria Subjective criteria 

Description Ref. Wgt Description Ref. Wgt 

Price compliance I 0.10 Accmp. docs I 0.10 

Price comparison I 0.10 Packaging I 0.10 

Quantity compliance I 0.10 GR quality I 0.10 

Due date compliance I 0.10 I. quality I 0.10 

Electronic catalog I 0.10    

Quality certificate I 0.10    

Returns I 0.10    

Partial deliveries I 0.10    

Inspection quantity I 0.10    

EDI/VDA C 0.10    

The reference of the criteria is specified in the Ref. column. C = Supplier-related (company), I = 

Item-related. 

The Wgt column contains the default weighting factor for the corresponding criterion as stored in 

the ATTRID (see "Set weightings in ATTRID allocation table (Supplier evaluation)" page 1815) 

allocation table. A weighting factor is a number by which values are multiplied to give them a 

greater or lesser influence on the overall result.If there are quality groups (see "Quality groups 

(Supplier evaluation)" page 1817) with evaluation criteria, the weighting factors specified in this 

table apply to item-related criteria. 

To calculate the mark for the TP ID, complete the following steps: 

1. The final marks of all analyzed criteria for all quality groups must be calculated in order to 

determine the mark for the TP ID. 

For more information on calculating final marks, see Calculate final mark of a quality group 

criterion (page 1820). 

2. After the final marks are calculated, they need to be totaled. 

3. Then divide this total by the total of all weighting factors. 

The last two steps can be represented in an equation as follows: 

TP mark =  Weighted average mark n {n, 1, m} /  Weighting factor n {n, 1, m} 
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The mark for technical performance (TP) is displayed in the field of the same name on the Supplier 

evaluation tab in the supplier master data. 

The Total technical performance (TTP) (see "Total technical performance (TTP) ID in Supplier 

evaluation" page 1841) ID is derived from combining the weighted mark for the Technical 

performance (TP) ID described here and the mark for the Service/performance (see 

"Service/performance criterion for supplier evaluation" page 1813) criterion: 
 

Total technical performance (TTP) ID in Supplier evaluation 

 

For basic information on IDs, see the IDs (see "IDs (Supplier evaluation)" page 1839) topic. 

The total technical performance (TTP) ID expresses the quality of the supplier's commercial 

performance. Its mark is derived from the weighted mark for Technical performance (TP) (see 

"Technical performance (TP) ID in Supplier evaluation" page 1839) and the weighted mark for the 

supplier's service/performance (see "Service/performance criterion for supplier evaluation" page 

1813) (SP): 

TTP = ((Wgt TP x TP mark) + (Wgt SP x SP mark)) / (Wgt TP + Wgt SP) 

Both weighting factors are defined in the ATTRID (see "Set weightings in ATTRID allocation table 

(Supplier evaluation)" page 1815) allocation table. The following default weightings are preset in 

the ATTRID allocation table in the standard version of Infor COM: 

Attribute ID Description Weight ID 

50 REPAIR/GENERAL SERVICE 0.10 TTP 

51 TECHNICAL PERFORMANCE 0.10 TTP 

The mark for total technical performance (TTP) is displayed in the field of the same name on the 

Supplier evaluation tab in the supplier master data. 

If specific requirements are met, a Total performance (TP) ID can be generated using the Total 

technical performance (TTP) ID described here in combination with the Environmental reliability 

(ER) ID. For more detailed information, see Total performance (TP) ID in Supplier evaluation 

(page 1843). 
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Environmental reliability (ER) ID in Supplier evaluation 

For basic information on IDs, see the IDs (see "IDs (Supplier evaluation)" page 1839) topic. 

Please note: To calculate the Environmental reliability ID, you must activate the environmental 

supplier evaluation (see "Commercial-technical and environmental supplier evaluation" page 

1795) function. 

The standard version uses the following objective and subjective criteria to calculate the mark for 

environmental reliability (ER): 

Objective evaluation cri teria  Subjective evaluation cri teria  

Name Ref. Wgt Name Ref. Wgt 

Company environmental 

certificate 

C 0.10 Mat. data I 0.10 

Means of transportation C 0.10 Packaging return I 0.10 

Distance C 0.10 Product certificate I 0.10 

Invalid material data I 0.10 Env. bal. I 0.10 

The reference of the criteria is specified in the Ref. column. C = Supplier-related (company), I = 

Item-related. 

The Wgt column contains the default weighting factor for the corresponding criterion as stored in 

the ATTRID (see "Set weightings in ATTRID allocation table (Supplier evaluation)" page 1815) 

allocation table. A weighting factor is a number by which values are multiplied to give them a 

greater or lesser influence on the overall result.If there are quality groups (see "Quality groups 

(Supplier evaluation)" page 1817) with evaluation criteria, the weighting factors specified in this 

table apply to item-related criteria. 

Calculating the mark for the ER ID: 

To calculate the mark for the ER ID, the system must first calculate the final marks for the 

analyzed evaluation criteria. 
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 The system determines the mark of a supplier-related (C reference) criterion from the mark 

range of the corresponding allocation table. For more detailed information, see Set mark range 
for objective supplier-related criteria (see "Set mark range for objective supplier-related criteria 

(Supplier evaluation)" page 1831). 

 The final marks for item-related criteria (I reference) are calculated from the weighted average 

marks of each quality group, which must be determined first. For more information, see 

Calculate final mark of a quality group criterion (page 1820). 

If the weighted final marks are available, they are added and divided by the total of the weighting 

factors. The quotient from these two totals then gives the mark for the ER ID. An equation 

expressing this relationship would look as follows: 

Mark for environmental reliability =  Weighted average mark n {n, 1, m} /  Weighting factor n {n, 1, 

m} 

The calculated mark is stored in the Environmental evaluation field on the Supplier evaluation tab 

in the master data for the corresponding supplier. 

If specific requirements are met, a Total performance (TP) ID can be generated using the Total 

technical performance (TTP) ID described here in combination with the ER ID. For more detailed 

information, see Total performance (TP) ID in Supplier evaluation (page 1843). 
 

Total performance (TP) ID in Supplier evaluation 

For basic information on IDs, see the IDs (see "IDs (Supplier evaluation)" page 1839) topic. 

The value of the Total performance (TP) ID is derived from the value of the Total technical 

performance (TTP) (see "Total technical performance (TTP) ID in Supplier evaluation" page 1841) 

ID, which corresponds to a supplier's commercial performance: 

TP = TTP 

If you want to take the Environmental reliability (ER) (see "–Environmental reliability (ER) ID in 

Supplier evaluation" page 1842) ID into account when evaluating a supplier's total performance, 

the following conditions must be met: 

 The environmental supplier evaluation (see "Commercial-technical and environmental supplier 

evaluation" page 1795) function must be active in order to generate the ER ID. 

 The Comm./env. perform. field on the Supplier evaluation tab in the supplier master data must 

have a value other than 0.00. 
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This field allows you to set the ratio of environmental to commercial performance when 

calculating the value of the TP ID. A ratio of 0.00 only considers commercial performance; 

it does not take environmental performance into account. 

If you include the environmental performance in the total performance, the resulting equation is as 

follows: 

TP = ((Wgt TTP x TTP mark) + (Wgt ER x ER mark)) / (Wgt TTP + Wgt ER) 

Both weighting factors are defined in the ATTRID (see "Set weightings in ATTRID allocation table 

(Supplier evaluation)" page 1815) allocation table. The following default weightings are preset in 

the ATTRID allocation table in the standard version of Infor COM: 

Attribute ID Description Weight ID 

52 TOTAL TECHNICAL PERFORMANCE 0,10 TP 

53 ENVIRONMENTAL RELIABILITY 0,10 TP 

The mark determined for the TP ID is entered in the Total performance field on the Supplier 

evaluation tab in the supplier master data. The adjacent Category field contains the supplier class 

(see "Automatic ABC categorization for supplier evaluation" page 1845) resulting from this mark. 

Suppliers in PO proposals are sorted by their TP ID values. For more information, see Analyze 

supplier evaluation in PO proposals (page 1848). 
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The Infor COM Supplier evaluation (see "Supplier evaluation basics" page 1793) module lets you 

assign ABC categories to suppliers. Categorization is based on the mark they achieved for the 

Total performance (TP) (see "Total performance (TP) ID in Supplier evaluation" page 1843) ID. 

Exception:  If the environmental supplier evaluation function is not 

selected(EcologicalEvaluation=no), the mark for Total technical performance (TTP) (see "Total 

technical performance (TTP) ID in Supplier evaluation" page 1841) is used for classification. 

The category determined is displayed in the Category field on the Supplier evaluation tab in the 

supplier master data. The maximum mark limits are defined and maintained in the CLASSIFY 

(page 1798) allocation table. The following mark limits are defined in the standard version: 

Category Mark limit 

A 1.00 

B 2.00 

C 10.00 

 
 

Automatic ABC categorization for 

supplier evaluation 
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You can use the optional Infor COM Supplier evaluation (see "Supplier evaluation basics" page 

1793) module to set two different suspension flags on the Supplier evaluation tab in the supplier 

master data: 

Suspend supplier 

Use this option to globally suspend a supplier for both commercial-technical and environmental 

quality issues. 

A warning message is displayed when you try to create a PO for this supplier in PO proposals or in 

Purchase orders in the Purchasing module. You can then decide whether or not you want to order 

from this supplier. 

Suspend supplier for environ. products 

This flag indicates that no environmental items can be ordered from this supplier. The flag is for 

your information only and does not trigger a warning message when you try to order 

environmental items from this supplier. If you want a warning message to be displayed, select the 

Suspend supplier option. 

To set the flags manually, complete the following steps: 

1. In Purchasing, open the Master data folder and select Suppliers. The start form is displayed. 

2. On the Open tab, enter the ID of the supplier in the company ID field or select it from the 

combo box for the field. 

3. Click Load. The master data form is displayed. 

4. Select the Supplier evaluation tab. 

5. In the Supplier suspension section, select the Suspend supplier and/or the Suspend supplier 

for environ. products check box. 

6. Save your entries. 

To set the f lags automatical ly,  complete the fol lowing steps:  

Suspend supplier option in Supplier 

evaluation 
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1. Activate automatic suspension in evaluation runs. To do this, set the 

COMMON.EINKAUF.AUTOLOCKVENDORS to yes. 

2. Define suspension marks. In the configuration, enter the marks for the basic suspension types 

in the COMMON.EINKAUF.LOCKVENDORATMARK parameter. If you are also using the 

environmental evaluation function, enter the suspension marks required for this in the 

COMMON.EINKAUF.LOCKVENDORECOLOGICALATMARK parameter. 

3. Open and then evaluate a supplier. Upon reaching the locking mark limit, the check box for the 

lock in question will be enabled. This function is also available for the Evaluate all suppliers 

(see "Evaluate all suppliers batch process" page 1849) batch process. 
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The results of Infor COM supplier evaluations (see "Supplier evaluation basics" page 1793) are 

analyzed in PO proposals in Purchasing. 

For automatically created POs, the supplier you entered at the top of the list in the BOR of the item 

you want to order is used. This list is changed automatically when the Infor COM Supplier 

evaluation feature is used. The top supplier is the one with the best total performance (see "Total 

performance (TP) ID in Supplier evaluation" page 1843) and will be chosen by the system when 

creating POs automatically. 

Please note that this is dependent on the COMMON.EINKAUF.SORTVENDORSACTIVE 

parameter in the configuration. 

Two extra tabs are added to the single record view in PO proposals. These tabs provide 

information to help you select the most reliable and cost-effective supplier. 

 The Supplier evaluation tab displays the current supplier evaluation and suspension status of 

potential suppliers. 

 The Price comparison tab shows the discounts granted by each supplier. This allows you to 

quickly find out which supplier can offer you the most favorable purchase price. 
 

Analyze supplier evaluation in PO 

proposals 
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As there is an ongoing marking process for a supplier's products and services integrated in the 

Infor COM supplier evaluation module, evaluation data must be updated periodically. 

You can do this for each supplier individually, or for all evaluated suppliers in the form of a batch 

process. 

To update a single suppl ier,  complete the fol lowing steps:  

1. Open the corresponding supplier's master data. 

2. Go to the Supplier evaluation tab if you want to view the updated evaluation right away. 

3. From the Functions menu, select Start evaluation. 

The date and time of day of this update are noted in the Date of last evaluation field. 

Please note: if no data exists yet for the evaluation, the function cannot be executed. In this 

case, the menu option is dimmed.  

To update using a batch process, complete the fol lowing steps:  

1. On the Batch processes tab in the Purchasing module, click the Evaluate all suppliers object. 

2. Click Start to begin updating the evaluation data for all suppliers. 

For an overview of the evaluation data of all evaluated suppliers, see the Evaluation data per 

supplier (irPurchVendEval) report (see "Reports (Supplier evaluation)" page 1853). 

Note: The evaluation function must be explicitly activated (see "Activate evaluation function for a 

supplier" page 1803) in the supplier master data. 
 

Evaluate all suppliers batch process 
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You can generate statistics on the evaluation of suppliers in the Infor COM Supplier evaluation 

module. 

The statistics function calculates annual averages from the marks achieved for the Technical 

performance (TP), Total technical performance (TTP), Environmental reliability (ER), and Total 

performance (TP) IDs (see "IDs (Supplier evaluation)" page 1839) and determines a category (see 

"Automatic ABC categorization for supplier evaluation" page 1845) based on the TP ID. 

Data preparation 

Prepare data to ensure statistics are based on the most current evaluations. In Purchasing, go to 

Batch processes and click Supplier evaluation statistics. A dialog box with the same name is 

opened. Click Start to start the process. The dialog box is closed automatically when the process 

is completed. 

Printing or viewing statistics 

1. In Purchasing, click Statistics to open the Statistics selection dialog box. 

2. Select the row with the description Supplier evaluation statistics. To do this, click the row ID. 

3. Click OK to open the Create statistics dialog box. 

4. Specify the evaluation year and the month to show separately in the respective fields. The 

current year and month are entered by default. 

5. Use the Report or Excel options to define where the statistics are to be output. 

6. Click OK to print the statistics or click Preview to view the statistics first. 
 

Supplier evaluation statistics 
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You can store an inspection plan for each item in Infor COM. You can create inspection plans 

using Microsoft  Word and save them in .doc or .rtf format, for example. 

These inspection plans can provide the basis for checking deliveries in Supplier evaluation (see 

"Supplier evaluation basics" page 1793). 

To define the parameters for the file format, path to the inspection plan directory, and the program 

used for viewing and editing inspection plans, use the 

COMMON.QUALITAETSSICHERUNG.DEFAULTDOCTYPEFORQADOCS, 

COMMON.QUALITAETSSICHERUNG.PATHTOQADOCS, and 

COMMON.QUALITAETSSICHERUNG.VIEWERFORQADOCS parameters. 
 

Assign inspection plan to item (Supplier evaluation) 

For basic information on inspection plans, see Inspection plans (Supplier evaluation) (page 1851). 

To assign an inspection plan to an i tem:  

1. Load the item to which you want to assign an inspection plan. To do this, select Purchasing, 

open the Master data folder, and click Purchased items. The start form is displayed. 

2. Enter the required data in the start form fields and click Load. The item master data is opened. 

3. Select the UOM/size management tab. 

4. In the InspPlanName field, enter the name of the file containing the inspection plan. 

Alternatively, click the button to the right of the field to find it using a dialog box. 

5. If required, enter an ID for the inspection plan in the InspPlan field. 

6. Save your entries. 

For information on how to open an inspection plan in the Purchase receipt and Purchasing 

inspection objects in the Inventory module, see here (see "Open inspection plan in Purchase 

receipt/Inspection (Supplier evaluation)" page 1852). 
 

Inspection plans (Supplier evaluation) 



1852 | Infor COM 7.5 User Guide 

 

Supplier evaluation 

 

Open inspection plan in Purchase receipt/Inspection (Supplier 

evaluation) 

For basic information on inspection plans, see Inspection plans (Supplier evaluation) (page 1851). 

To open an inspection plan in the Purchase receipt or Purchasing inspection objects in the 

Inventory module, complete the following steps: 

1. Position the cursor in the line for which you want to view the inspection plan. 

2. Go to the PO line view. 

3. Start the InspPlan function. 
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The following reports are included in the Reports business object of the Purchasing module in the 

standard version of the Infor COM Supplier evaluation (see "Supplier evaluation basics" page 

1793) module: 

Note: You can influence the displayed lists by assigning user privileges. 

 Criteria marks per individual evaluation by supplier and item (irPurchVES) 

The marks for each evaluation by criterion, sorted by supplier, item, and delivery line. The 

average mark for each criterion is displayed for each item. The report also illustrates the 

external processing. 

 Suppliers suspended for environmental or commercial reasons (irPurchVendLocked) 

Contact, ABC category, and current status of any commercial or environmental 

suspension for each supplier. 

 Evaluation data per supplier (irPurchVendEval) 

ABC category, ID marks, status of the commercial or environmental suspension 

 Suppliers by category and sales revenue (irPurchVendTurnover) 

ABC category and revenue in the current and previous two business years for each 

evaluated supplier. 

For more detailed information on handling reports, see Print reports. 

 

Reports (Supplier evaluation) 
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This Help describes the Third Party Delivery add-on module. 

The settings for Third Party Delivery are specified in the configuration via the 

COMMON.DISPOSITION.GENERATIONMETHODPRIO parameter. 

 

Third-party delivery 
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This Help topic describes the Infor COM Third-party delivery add-on. The add-on must be 

purchased and configured separately. 

Chain transaction  (also known as distance transaction or chain trading) 

In materials management, a chain transaction refers to a transaction involving goods which, in its 

simplest form, is carried out according to the following distribution model:  

A customer who orders goods from a supplier (supplier A) does not receive the goods from this 

supplier; instead he receives them directly from a subcontractor (supplier B) who was 

commissioned by supplier A to deliver and, if necessary, manufacture the goods also. The 

inventory of supplier A, who simply acts as an intermediary here, is not affected by the delivery of 

the goods from supplier B to the customer. 

Note: Chain transactions can involve more than three companies. 

Triangular transaction 

With every chain transaction, a triangular transaction generally takes place also. While the term 

Chain transaction relates more to the logistical distribution of goods, the term Triangular 

transaction concerns the sales tax regulations that apply to this type of transaction - particularly 

with regard to the obligation to pay sales taxes. 

Intra-communi ty tr iangular transaction  

If such triangular transactions are carried out across national borders within the EU, they are 

referred to as Intra-EU triangular transactions (also Chain transactions in EU internal market). 

According to §25b of the German sales tax law, an intra-EU triangular transaction is defined on the 

basis of the following requirements, for example: 

 At least three trading parties enter into sales transactions for the same goods. 

 The goods are sent directly from the first supplier to the final buyer. 

 The goods are sent from one member state to another member state. 

 The companies involved are registered for sales taxes in various member states. 

In addition to triangular transactions, third-party deliveries also map the associated chain 

transactions. They can be used by each company involved in triangular transactions, regardless of 

their role in this particular form of chain transaction. 

Third-party delivery basics 
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The following Help topics describe the extensions that have been added to the various Infor COM 

modules for the Third-party delivery add-on. 
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Business processes (Third-party delivery) 

Depending on a user's role in the third-party delivery, different business processes must be taken 

into account in Infor COM. The three possible roles and associated business processes are 

outlined below. Only those processes that differ from the standard business processes are 

described. In general, the description of the sales processes refers to sales orders only, however 

the information applies to order releases also. 

Based on a standard process (see "Perform third-party delivery" page 1865), the following Help 

topics explain the business processes in context. 
 

Infor COM user as main supplier 

In this case, the Infor COM user is the main supplier who acquires the goods that were ordered 

from another company, a subcontractor. The subcontractor delivers the goods to the orderer. This 

situation affects the Item master, Planning, Purchase orders, Advance shipping notices, Delivery 

advices, Purchase invoices, RMAs, and Sales invoices. 

Item master 

For merchandise, you can use the item master to preset which items are generally delivered by 

the main supplier and which are generally delivered by subcontractors (see By supplier field on 

Sales tab in the item master). Items that are delivered by subcontractors must also be planned 

with the receipt generation type 1:1 Order generation. This planning parameter can also be set by 

default (see Receipt generation field on Planning tab in item master). Both presettings can be 

modified according to the specific order. 
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Planning 

The receipt generation type selected for the item or order is evaluated by order and batch 

planning. If the 1:1 Order generation option is selected (see Receipt generation field on Planning 

tab of item master), the sales order lines that caused the requirement and the purchase order line 

that was created to cover this requirement are linked together internally by the system. If the By 

supplier flag is also set (Sales tab in item master), the PO proposal lines that were created can be 

immediately grouped into purchase orders. This means that a purchase order is created for every 

supplier acting as a subcontractor. If necessary, this purchase order can be printed immediately. 

All basic sales order data (shipping type, quantity, and due date information) is transferred to the 

new purchase order. Existing outline agreements with suppliers can also be taken into account, if 

necessary. Items with reservations at order level are also displayed in a separate view in the item 

account. 

Purchase orders 

When you print a purchase order that was created for a subcontractor, the following information is 

also forwarded from the associated sales order to the subcontractor: The customer's purchase 

order ID and purchase order date, the ship-to address for the goods, the shipping type, and, if 

applicable, any restrictions that apply as a result of partial deliveries being prohibited. 

Note: If you use Connect, this data is transferred electronically with the purchase order. 

For purchase orders to subcontractors, all goods receipt functions are inactive in PO maintenance 

and the Inventory module, since the subcontractor does not deliver to the supplier who places the 

order, but rather to their customer directly. 
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Advance shipping notices 

If an advance shipping notice for the commissioned supplier needs to be attached to the purchase 

order to the subcontractor for forwarding to the customer, you can create it in Sales by selecting 

Functions > Create document > ASN > Edit. After switching to the purchase order form, you can 

save the advance shipping notice with the status ASN prepared and you can view the document 

by selecting Preview in the Create document dialog box. All other advance shipping notice and 

issue functions are inactive for the lines in a purchase order issued to subcontractors, since the 

actual delivery is carried out by the subcontractor. The subcontractor's address is specified as the 

return-to address on the pre-printed advance shipping notice described here. 

Note:  The pre-printed advance shipping notice cannot be sent using Connect. 

Delivery advices 

The subcontractor can send a delivery advice to the main supplier after delivery is made to the 

customer. The delivery advice can be accepted in Purchasing using the Purchase delivery advices 

function. The delivery advice contains the following information: Delivered goods, delivered 

quantities, day of delivery, advance shipping notice ID, supplier, and customer. 

Acceptance of a delivery advice changes the status of the purchase order and sales order lines. 

The new status types Delivered and Part. delivered have been added to both objects for this 

purpose. The delivered quantity is also entered in both objects according to the specifications 

defined on the delivery advice. 

Note:  You can receive the delivery advice electronically if you use Connect. 

Purchase invoices 

If a purchase invoice is accepted in Purchasing without a delivery advice being received 

beforehand, the system always assumes that the delivery preceded the invoice and that it is not an 

advance payment. If there is no delivery advice, in addition to the purchase invoice being posted in 

the sales order and the purchase order, the status is also changed to Delivered. 
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RMAs 

RMAs from the customer to the subcontractor who was commissioned by the main supplier will 

affect the business processes of the main supplier if the subcontractor is unable to deliver a 

replacement and if a financial settlement is necessary. In the case of a financial settlement, the 

subcontractor can either send the main supplier a credit memo, or a purchase invoice with RMA 

lines as negative items. 

If the received data is complete and the associated sales order can be uniquely determined, the 

RMA lines are entered with their quantity and advance shipping notice information in the 

associated sales order during invoice approval, where they are assigned the status Returned. 

If the associated sales order cannot be updated (if it has already been archived, for example), a 

corresponding message will be displayed in Infor COM. The main supplier must then respond 

independently of Infor COM by manually creating a credit memo, for example. 

Sales invoices 

Provided there has been no advance payment made, a status of Delivered in Sales constitutes 

approval to issue the invoice to the customer. 
 

Infor COM user as subcontractor 

In this case, the Infor COM user is the subcontractor. The subcontractor delivers the ordered 

goods to the main supplier's customer on behalf of the main supplier. This situation affects the 

customer master, RFQ and order receipts, delivery, and RMAs. 

Customer master maintenance 

Additional ship-to addresses are required for deliveries made to partner companies. These are 

stored in the customer master and are assigned the flag Partner. This flag affects the following 

business processes as described below: 

 The partner addresses can be selected as ship-to addresses only. 

 If partner addresses are output on documents, the content from the Name 1, Name 2, and 

Name 3 fields from the partner address are output instead  the company name from the 

customer master record. 
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 When printing the order confirmation,  the ship-to address, sales tax ID, purchase order ID, 

and purchase order date of the goods recipient (the customer's partner company) are 

confirmed separately. 

 The data for the partner company is displayed in the Goods recipient section of the 

Documents/costs tab in the order header. 

Note:  If you use Connect, the partner company data described above is transferred electronically. 

In customer master maintenance, the form for the delivery advice to be sent can also be preset on 

the Documents tab. 

RFQ or order receipts 

The RFQ or purchase order that the subcontractor receives from the customer not only contains 

data relating to the goods and delivery date; it also contains the address of the company to which 

the delivery is to be made, and the purchase order ID of the goods recipient. It also specifies 

whether partial deliveries are permitted for each purchase order line. The goods recipient is 

flagged as the ship-to address in the quote or customer order. The goods recipient's address must 

be stored as a partner company in the customer master (see Customer master maintenance 

section). When a quote or order confirmation is printed, the ship-to address is output on the 

document as additional information. 

Delivery 

When the advance shipping notice is printed, the ship-to address of a partner company is output 

as additional information. 

Example: "We are delivering these goods on behalf of <Address on order confirmation>" 

In the header of the advance shipping notice, the goods recipient's original purchase order ID and 

purchase order date are printed for information purposes. The advance shipping notice also 

includes the subcontractor's address as a possible return-to address. 

A delivery advice can also be printed as a new document and used together with the advance 

shipping notice to notify the ordering party of the delivery. 

Note:  The delivery advice data can be transferred electronically using Connect. 
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RMAs 

If the customer returns goods to the subcontractor, the RMAs can be processed in a number of 

different ways. 

A replacement delivery can be sent. This is processed with the goods recipient directly. The 

ordering party is not involved here. 

The customer can receive a credit memo to the value of the goods. In this case, the ordering party 

must be notified. This can happen implicitly whereby the RMA is automatically accounted for on 

the subcontractor's invoice to the ordering party. Text fields can be used to add any explanations 

that need to be made to the ordering party. The ordering party can also be notified explicitly by 

means of a credit memo, in which the goods recipient's purchase order ID is listed as a unique 

reference. It is the ordering party's responsibility to forward the invoice reduction or credit memo to 

the goods recipient. There is no direct settlement made between the subcontractor and the goods 

recipient. 
 

Infor COM user as customer 

Supplier master maintenance 

The company that the customer orders the goods from uses a subcontractor to deliver the goods. 

The subcontractor address is stored in the supplier master under the suppliers from whom the 

goods were ordered and is assigned the flag Partner. This flag affects the other business 

processes below as follows: 

 The partner addresses can be selected as return-to addresses only. 

 If a partner address is specified on a document, the content from the Name 1, Name 2, and 

Name 3 fields from the partner address are printed instead of the company name from the 

supplier master record. 
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Purchase receipts 

If the incoming advance shipping notice contains a return-to address that is different from the 

purchase order address, this address must be stored in in the return-to address field provided on 

the header record of the advance shipping notice. The return-to address should already have been 

stored in the supplier master as a partner address for the supplier who received the purchase 

order. You can check this by switching from the goods receipt process to the supplier master. 

RMAs 

The return is always made to the subcontractor, i.e. to the return-to address already flagged during 

Goods receipt. 
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Allocation tables (Third-party delivery) 

The following allocation tables form part of the Third-party delivery add-on, or are used in this 

add-on: 
 

PURCHDNTYPE 

Description: Advance shipping notice (ASN) types 
 

RECEIPTCR 

Description: Receipt generation types 

Usage: This allocation table for the Third-party delivery add-on stores the various receipt 

generation methods. The methods are provided for selection in the Receipt generation combo box 

on the Planning tab in the item master, on the Order line view on the Texts/details tab in the sales 

order, and on the Open tab in the item account. 

Type: The user is not allowed to modify this allocation table.Only the descriptions may be edited. 

The following receipt generation methods are provided: 

 0 Receipt generation with all receipts pulled in 

 1 Receipt generation at shortage due date 

 2 Receipt generation with unfixed receipts pulled in 

 3 Receipt generation at shortage due date with reservation 

Method 3 is part of the Third-party delivery add-on. For more information, see Receipt 

generation method 3 (Third-party delivery) (page 1870). 

 4 Receipt generation with fixed order-related 1:1 assignment 

Note: Method 2 is selected in the combo boxes by default. 
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Perform third-party delivery 

To carry out a third-party delivery, complete the following steps: 

1. Create a sales order by selecting Sales > Order processing > Sales orders.  

For more information about entering master data, see Item master (Third-party delivery) (page 

1867) and Customer master (Third-party delivery) (page 1868). 

2. In the open sales order, select Plan order. Then select the Detailed option and click Start to 

confirm the dialog box that is displayed. 

Note: Select the Create purchase order option to skip the generation of PO proposals and 

create purchase orders directly. Continue from Step 5 if you select this option. 

3. Select Purchasing > PO proposals, and then open the PO proposal that was created. 

4. Select Functions > Generate purchase orders > Automatically, and then click Start on the 

dialog box that is displayed. 

5. Select Purchasing > Purchase orders, and then open the purchase order that was created. 

6. Select Functions > Delivery advice receipt. 

7. On the New dialog box, enter the Purchase DA ID and click OK to confirm. 

You can modify the delivery quantity here if necessary. See the context-sensitive Help for 

information on the options available. 

8. Select Functions > Close entry. 
 

Third-party delivery and Connect 

Third-party deliveries can be processed using Connect. The following table lists the required 

Third-party delivery information that can be exchanged between the relevant systems using 

Connect. 
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Master data Item master  Receipt generation and delivery data 

 Company master  Partner addresses 

 Customer master  Document and address for delivery advice 

 Goods recipient as partner address 

Planning Item account  Reservations at order level 

Sales Sales order  Document and address for delivery advice 

 Type of receipt generation and delivery 

 Goods recipient 

 Delivery advice 

 Invoice  Relevant data from delivery advice 

Purchasing Purchase order  "Delivery to third party" note 

 Address of goods recipient as ship-to address 

 Partial delivery prohibited setting from 

associated sales order 

 Purchase delivery advice  A delivery advice can be received automatically. 

 A delivery advice can be canceled 

automatically. 
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The following Help topics explain the master data maintenance  processes that relate to the 

Third-party delivery add-on. 
 

Item master (Third-party delivery) 

The receipt generation method is stored for the item. For items delivered by subcontractors, you 

must select receipt method 3 (see description of Receipt generation field on Planning tab). 

For merchandise, you can use the Sales tab in the item master to specify that an item is to be 

delivered by a subcontractor by default (see description of By supplier option on Sales tab). 
 

Company master (Third-party delivery) 

In the address table, you can assign the Partner flag to addresses. In Sales (customer master), the 

addresses are then treated as goods recipient address, while in Purchasing (supplier master), 

they are treated as addresses of subcontractors who deliver the goods on behalf of another 

supplier. For more information, see Role 2: Subcontractor (see "Infor COM user as subcontractor" 

page 1860) and Role 3: Customer who receives deliveries from a subcontractor (see "Infor COM 

user as customer" page 1862). 
 

Maintain master data for Third-party 

delivery 
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Customer master (Third-party delivery) 

For customer document data, it is possible to specify the document that is to be used for printing a 

delivery advice. The subcontractor uses the delivery advice to notify his customers of the delivery 

of the goods to the recipient. When the delivery advice is created, the address field is populated 

with the address from the order confirmation by default. For more information, see Print delivery 

advice (see "Print delivery advice (Third-party delivery)" page 1876). 
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The following Help topics explain the processes in the Infor COM Planning module that relate to 

the Third-party delivery add-on. 

 

Plan third-party deliveries 
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Receipt generation method 3 (Third-party delivery) 

An additional receipt generation method has been implemented for the Third-party delivery 

add-on: Method 3 Receipt generation at shortage due date with automatic order reservation. 

Note: You can manage the receipt generation methods in the RECEIPTCR allocation table. 

As with Method 1 Receipt generation at shortage due date ("intuitive" method), which is provided 

in the standard version of Infor COM, 1:1 receipt generation is carried out for this method also.  

1:1 Receipt generation means that exactly one rough planned PO proposal or one rough planned 

production order (receipt) is generated to cover each requirement (issue) during planning. 

Method 3 builds on Method 1 in that the generated receipts for the issues are also reserved when 

you select Method 3. This is achieved by means of a reservation at order level (see "Reservations 

at order level (Third-party delivery)" page 1872). 

 The Third-party delivery add-on allows you to generate purchase orders automatically (see 

"Generate purchase orders automatically (Third-party delivery)" page 1873). 
 

Configure receipt generation method 3 (Third-party delivery) 

For information about receipt generation method 3, see Receipt generation method 3 (see 

"Receipt generation method 3 (Third-party delivery)" page 1870). 

As with the three other receipt generation methods provided in the standard version, receipt 

generation method 3 is configured in the master data for the relevant items (Design > Items). The 

Receipt generation combo box is provided on the Planning tab in the item master data for this 

purpose. 

Note: In the standard version of Infor COM, the default method that is to be used for generating 

receipts is defined in the configuration using the 

COMMON.DISPOSITION.ZUGANGSERZEUGUNG  parameter. If you are using the Third-party 

delivery add-on, you can define this setting on an item-specific basis. 
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If required, you can modify the receipt generation method in the order lines of these items at any 

time. You can make this change using the Receipt generation combo box on the Order line view of 

the Texts/details tab in the relevant sales order. 

Because this method allows you to make item-specific assignments,  an order line for this type of 

item is permanently linked during planning to the associated line in the detailed order that is 

created (purchase order, production order, etc.). For more information on reservations at order 

level, see Reservation at order level (see "Reservations at order level (Third-party delivery)" page 

1872). 

Notes:   

 Receipt generation method 3 cannot be used for items that are planned using fixed 

requirement allocations. 

 With the Third-party delivery add-on, a Delivery by supplier check box is provided on the 

Sales tab in the item master data. This flag is intended for merchandise that is generally not 

delivered to the customer by you, but is delivered instead by a subcontractor commissioned by 

you. For this type of triangular transaction, your customer's order to you (issue) and your 

purchase order to your supplier (receipt) must be assigned to each other. Receipt generation 

method 3 is therefore set by default also when you select this check box. 

However, if the item is only delivered by your subcontractors in a small number of cases, 

the check box can also be set in the relevant sales orders. The Delivery by supplier check 

box is located on the Texts/details tab in the order line.  
 

Evaluate receipt generation methods during planning process (Third-party 

delivery) 

If you use the Third-party delivery add-on and the option it provides for modifying the receipt 

generation method for an item on an order-specific basis (see Configure receipt generation 

method 3 (see "Configure receipt generation method 3 (Third-party delivery)" page 1870)), it can 

happen that issues and receipts exist for several different methods. 

For more information about receipt generation method 3, see Receipt generation method 3 (see 

"Receipt generation method 3 (Third-party delivery)" page 1870). 

When planning an item, the system must first check whether issues and receipts exist for several 

receipt generation methods (see "RECEIPTCR" page 1864), and if so, it must determine how 

many exist. 
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If this is the case, the item must be planned separately for each receipt generation method that is 

used. Planning processes the methods in the sequence 0, 2, 1, 3.  

Note: The sequence is defined in the configuration via the 

COMMON.DISPOSITION.GENERATIONMETHODPRIO parameter. 

For this reason, only issues and receipts of a specific receipt generation method can be loaded for 

the item (Planning > Item account). The Receipt generation combo box is provided for this 

purpose on the Open tab of the start form in the item account. You can use this combo box to 

select the required method before loading your data. 
 

Reservations at order level (Third-party delivery) 

If you use receipt generation method 3 (see "Receipt generation method 3 (Third-party delivery)" 

page 1870) in the Third-party delivery add-on, receipts are generated automatically to cover the 

sales orders that generated a requirement. The receipts are generated in the form of rough 

planned PO proposals (see Automatic purchase order generation (see "Generate purchase orders 

automatically (Third-party delivery)" page 1873)) or rough planned production orders and are also 

reserved automatically for these sales orders. 

With these reservations at order level, the receipts that cover the requirement and the issues that 

generate the requirement are assigned to each other in the form of n:m links. 

Note: This is not the same as the fixed requirement allocation procedure that is used in 

order-based manufacturing in Infor COM. 

With this type of reservation, the planned receipt quantity and planned issue quantity are reduced 

by the reservation quantity. See the following example: 

A sales order (SO001) generates a requirement for 500 units of an item. On the Balance tab in the 

relevant item account, this is displayed as follows (abridged): 

Order Receipt Issue Balance 

SO001 0,00 500,00 -500,00 

The planned quantity for the issue is 500.00 units. 
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In accordance with receipt generation method 3, which is stored for the item in its master data or 

was modified specifically for this case in the relevant order line, a receipt in the form of a rough 

planned purchase order for 500 units is now generated when planning the item in order to cover 

the issue. This receipt is also reserved simultaneously for the issue. 

Order Receipt Issue Balance 

SO001 0,00 0,00 0,00 

00117 0,00 0,00 0,00 

The planned issue quantity (SO001) has been reduced by the 500 units that were reserved for this 

issue. The planned quantity of 500 units for the receipt that was created to cover the requirement 

(00117) has also been reduced by the reserved quantity. 

The Order reservation tab in the item account has been specifically provided in order todisplay 

these reservations (see "Issues and receipts reserved at order level in item account (Third-party 

delivery)" page 1874). 
 

Generate purchase orders automatically (Third-party delivery) 

With receipt generation method 3 (see "Receipt generation method 3 (Third-party delivery)" page 

1870) provided in the Third-party delivery add-on, issues are generated to cover requirements and 

are then automatically reserved for these requirements. 

When planning with detailed order generation, the issues are generated in the form of detailed 

production orders or detailed PO proposals. 

The Third-party delivery add-on allows purchase orders to be generated automatically from the 

detailed PO proposals and also printed immediately if necessary. 

The Create purchase order and Print purchase order check boxes are provided on the Breakdown 

parameters for planning dialog box for this purpose.  

Please note: To carry out planning with detailed order generation, you must select the Detailed 

option in the Orders for section of this dialog box. 
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Issues and receipts reserved at order level in item account 

(Third-party delivery) 

If you use the Third-party delivery add-on and the option it provides for modifying the receipt 

generation method for an item on an order-specific basis (see Configure receipt generation 

method 3 (see "Configure receipt generation method 3 (Third-party delivery)" page 1870)), it can 

happen that issues and receipts exist for several different methods. 

This is why you are prompted to specify the receipt generation method when you load the issues 

and receipts for an item in the corresponding item account. The Receipt generation combo box is 

provided on the Open tab of the start form in the item account and is used for selecting the method 

before loading. This means that only the issues and receipts of the specified receipt generation 

method are loaded in the item account. 

Note: The default setting for the receipt generation method is defined in the configuration via the 

COMMON.DISPOSITION.ZUGANGSERZEUGUNG parameter. 

In the item account, the additional Order reservation tab is displayed. This tab is used for 

displaying the resources that cover the requirement (receipts), and the resources that generated 

the requirement (issues), both of which have been linked together by a reservation at order level 

(see "Reservations at order level (Third-party delivery)" page 1872). 
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The following Help topics explain the processes in the Sales module that relate to the Third-party 

delivery add-on. 
 

Sales orders in Third-party delivery 

The document name that was specified for the delivery advice in the customer master can be 

modified using the Documents/costs tab in the order header (see Documents/costs tab in 

customer master). If a delivery is made to a customer's partner company, the data for this partner 

company is entered and displayed in the Goods recipient section. 

In the order line of the Texts/details tab, you can modify the receipt generation type stored in the 

master data for an item (see Planning tab in item master) as well as the corresponding default 

delivery type (see Sales tab in item master). The Delivery by supplier option can be set for 

merchandise only. 

If the ship-to address is modified retroactively in a sales order, the system will check whether the 

associated purchase orders can still be modified. If they can be modified, a message is displayed. 

If you want to modify the ship-to address, this change will be applied to all purchase orders that 

can still be modified. Purchase orders that can no longer be modified automatically must be edited 

manually. 

If all material lines are delivered by the supplier, the External properties, Coordinates, and 

Properties tabs used by the Inventory module are not active in order maintenance. 
 

Advance shipping notices and Goods issue in Third-party delivery 

If the Delivery by supplier option is selected for order lines, you cannot print the pick list, issue list, 

or advance shipping notice (with or without issue). However, you can save an advance shipping 

notice with the status Prepared and then print a prepared advance shipping notice. If required, you 

can provide the subcontractor with this advance shipping notice for forwarding to the customer. 

Configure Third-party delivery in Sales 
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Note: A prepared advance shipping notice cannot be transferred using Connect. 
 

Print delivery advice (Third-party delivery) 

For deliveries made by a subcontractor to a customer, a delivery advice can also be created for 

the ordering party in addition to the advance shipping notice that the customer receives. You can 

print a delivery advice using the print dialog box accessed in the Sales orders, Advance shipping 

notices, Print advance shipping notices (ASN), or Goods issue objects (for deliveries based on 

pick lists). 

The Delivery advice option is only available on the print dialog boxes or taken into account during 

batch printing if the ship-to address in the sales order is for a partner company (see Company 

master (Third-party delivery). The information on the delivery advice is mostly the same as the 

information on the advance shipping notice. However, the delivery advice is intended for the 

ordering party, while the advance shipping notice is intended for the customer. The print date on a 

delivery advice is displayed on the Documents/costs tab in the header of the associated advance 

shipping notice. You can reprint a delivery advice using the print dialog box in the Advance 

shipping notices module. 

Important: The delivery advice does not have a unique ID. The ID of the associated advance 

shipping notice is printed on the delivery advice. 
 

Delivered status (Third-party delivery) 

The receipt of a delivery advice in Purchasing causes the quantities and status to change 

automatically in the sales order. The delivered quantity is displayed in the Issue row in the order 

line of the Documents/due dates tab and is therefore treated as a quantity that you delivered 

yourself. Provided the order line is not calculated as a prepayment, it will also result in an increase 

in the planned quantity invoice. If the full order quantity was delivered, the status of the order line 

is changed to Delivered. If only a partial quantity was delivered, the status of the order line is 

changed to Part. delivered. 

The order header reflects the status based on all order lines. 
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If prepared advance shipping notices exist for an order line, these are closed automatically when 

the status of the line changes to Delivered. 
 

Order releases in Third-party delivery 

In the context of third-party deliveries, order releases are handled in the same way as sales 

orders. You can also specify item-specific settings, i.e. the receipt generation type and the 

Delivery by supplier option, in the outline agreement directly. These settings are then transferred 

from the outline agreement to each order line, where they can be modified as required. 
 

Invoices and credit memos in Third-party delivery 

When you print an invoice for order lines that were delivered by a subcontractor, the additional 

delivery advice data, i.e. the external advance shipping notice ID and external advance shipping 

notice date, is read, where possible, from the delivery advice received in Purchasing and is 

included on the invoice also. If there is no delivery advice received for a line, and the purchase 

invoice is the only delivery document, the delivery date and advance shipping notice ID from the 

purchase invoice are entered in the invoice to the customer. The invoice contains one record per 

delivery and is therefore structured exactly as if the delivery was carried out from your own 

company. If partial quantities are calculated, the invoice quantity will be smaller than the quantity 

of the known deliveries. You can therefore use the Delivery advice tab in invoice maintenance to 

select which deliveries you want to calculate. When you save the invoice, the system records 

which delivery advice records or purchase invoice records were calculated. This ensures that 

multiple calculations are avoided and the invoice can be reprinted. 

When canceling invoices, the output of data for credit memos is structured according to the 

invoice. In addition, all quantity and status changes that were made when the invoice was printed 

are canceled when the invoice is canceled. 
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If the underlying transaction is an intra-EU triangular transaction, and the three companies 

involved are registered in different EU states, this is expressly indicated on the invoice, or on the 

credit memo if the invoice is canceled. This requirement is based on §14a of the German sales tax 

law. In addition to your own sales tax ID, the goods recipient's sales tax ID must also be specified 

on all invoices issued in the context of an intra-EU triangular transaction (see §14a of the German 

Sales tax law). 
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The following Help topics explain the processes in the Purchasing module that relate to the 

Third-party delivery add-on. 
 

PO proposals in Third-party delivery 

When purchase orders are created from PO proposals, the lines that are to be delivered directly by 

the supplier are handled in a specific way. The Expand purchase orders function is limited to 

purchase orders that are linked as requirement generators to the same sales order via order 

reservation. Only lines that are included in the same sales order are transferred to a common 

purchase order when you select the Generate purchase orders > Manually and Generate 

purchase orders > Automatically functions. The newly generated purchase order also contains 

additional information from the assigned sales order (ship-to address, terms of delivery, shipping 

type). 

The above criteria are also taken into account if the most suitable supplier is determined for PO 

proposals before purchase order generation. 
 

Purchase orders in Third-party delivery 

If a purchase order is to be delivered directly from the supplier in the context of a triangular 

transaction, this is indicated using the Delivery to third party field in the purchase order header. 

This type of purchase order cannot be updated manually to include additional purchase order 

lines. All Inventory functions and the advance shipping notice overview are also inactive for this 

type of purchase order. 

The TPD address is displayed on the Details tab in the PO header view. 

Configure Third-party delivery in 

Purchasing 
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Additional information relating to the TPD address is taken from the associated sales order and 

printed on the purchase orders and purchase order updates. If partial delivery is prohibited in the 

sales order, the supplier is notified of this also. 

Note: All additional information is transferred to the goods recipient electronically if you use 

Connect. 
 

Receive delivery advice in Third-party delivery 

A delivery advice is created by the subcontractor and sent to the main supplier so that they can 

track the status of the delivery. 

You can enter incoming delivery advices as follows. 

1. Select Purchasing > Purchase delivery advices. 

2. On the New tab, complete the Delivery advice ID, Delivery advice date, and Receipt due date 

fields, as well as the PO ID field or the Supplier ID field, and then click Create. 

3. The Delivery advice <ID> form (see Delivery advice <ID>) is opened and the associated 

Delivery advice tab is displayed (see Delivery advice). If you entered the PO ID before creating 

the delivery advice, all lines that have not yet been delivered are loaded from the selected 

purchase order and displayed. In the Del. qty field on the Delivery advice tab, enter the 

delivered quantity that was acknowledged on the delivery advice. This quantity can be less 

than the purchase order quantity displayed in the PO qty field. 

If you entered the supplier ID before creating the delivery advice but have not yet selected a 

purchase order ID, you must select one or more purchase orders for which the current delivery 

advice has been entered (see Reload). To do this, select Data and Reload. The delivery 

quantity displayed in the Del. qty field can also be modified in this case. 

4. Click Save. This saves the delivery advice with the status Not processed. This status still 

allows the entries  be changed. For example, you can update the delivery advice by adding 

lines from other purchase orders for the current supplier. To do this, select Data and Reload. 
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5. Select Functions and Close delivery to close the entry for the new delivery advice. The delivery 

advice lines are then assigned the status Received. If all lines have been assigned this status, 

the entire delivery advice is assigned the status Received. 

Note: You can also enter a delivery advice in the opened purchase order by selecting 

Functions > Delivery advice receipt... (see New). The 1:1 to purchase order option is also 

available here. You can use this option to transfer the data from the currently loaded purchase 

order to the delivery advice. 

When the entry for a delivery advice is closed (by selecting Functions > Close entry), both the 

relevant order lines and the linked sales order lines are updated. The delivery advice quantity 

is entered in both the purchase order and the sales order, and the status is changed to 

Delivered or Part. delivered. In the purchase order, the delivery advice quantity is added to the 

receipt quantity and is therefore handled during other business processes in Purchasing in 

much the same way as a goods receipt on your own premises. 

If a delivery advice is canceled, the status changes in Purchasing and Sales are canceled 

also. A cancellation only affects the inventory quantities in the purchase order and the sales 

order. It does not affect the associated invoice data. The status of the delivery advice in the 

system is left as Canceled. 

Note:  If you use Connect, you can receive and cancel the delivery advice automatically and 

electronically. 
 

Goods receipt in Third-party delivery 

When the goods are received in the customer system, the return-to address listed on the advance 

shipping notice must be entered in the supplier's company master as a partner address. It must 

also be selected as the return-to address on the advance shipping notice header in Goods receipt. 

The return-to address is required in order to send RMAs to the correct address if necessary. The 

return-to address must also be known in order to create valid Intrastat records for deliveries from 

other EU states. 

The return-to address is always set by default from the company master or from the purchase 

order data. You can also switch to the company master to create a new partner address there. 
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Purchase invoices in Third-party delivery 

During invoice approval, delivery advice records are handled in the same way as goods receipt 

records. When the purchase invoice is saved, the status of the delivery records is also changed to 

Approved or Part. approved, and their invoice quantities are updated. This ensures that these 

records will not be available again for the next invoice approval process. 

If there is no delivery advice received, only the purchase order lines are available for invoice 

approval. The receipt of the invoice is always taken as constituting delivery in this case. 

Prepayment is therefore not possible. You can enter the delivery advice data as by way of 

reference on the Delivery advice tab in the invoice receipt. Saving the purchase invoice will trigger 

the same quantity and status changes as when the delivery advices are received. In addition, 

information regarding the goods movement is provided to the Value flow function. 

Lines entered in the purchase invoice with negative invoice quantities are interpreted as RMAs to 

the subcontractor, which are to be offset automatically against the purchase invoice. These lines 

must always be permanently assigned to a purchase order, since they are transferred to the sales 

order to which this purchase order is permanently assigned via reservation when the purchase 

invoice is saved. The sales employee is therefore informed of the return and can reduce the 

invoice to the customer accordingly. 
 

Purchase credit memos in Third-party delivery 

Purchase credit memos cannot be created for purchase orders from the Third-party delivery 

add-on. 
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Supplier evaluation in Third-party delivery 

The employee who receives the goods manually enters the subjective supplier evaluation criteria 

in Goods receipt. However, the goods are not received on the actual premises when deliveries are 

made by a subcontractor. The subjective evaluation data is therefore not available and cannot be 

used in the evaluation. The objective supplier evaluation criteria are determined from the purchase 

order, goods receipt, and invoice receipt data in the usual way. Since there is no goods receipt 

data available in certain cases in third-party delivery transactions, this data can only be 

determined approximately from the entries in the delivery advice. This causes limitations in terms 

of the RMAs, Partial delivery, and Inspection quantity criteria, which are described below. 

Returns If a replacement delivery is carried out for the RMA, this process is not evaluated as a 

RMA, unlike in the standard evaluation process. 

Partial deliveries A delivery is evaluated as a partial delivery if the delivery quantity does not correspond 

to the purchase order quantity. The receipt type is used here in the standard 

evaluation. 

Inspection quantity The same limitation applies for the inspection quantity as for RMAs. 
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The following Help topics explain the effects of the Third-party delivery add-on on Finance and 

Value flow. 

To map a third-party delivery correctly, the entire posting must be carried out within a single 

transaction. If a posting fails, the entire transaction is rejected. 

Unlike for processes that result in an inventory receipt in your own warehouse, the value-based 

posting of the transaction is also carried out for third-party delivery postings in the context of 

invoice approval, since this is not mapped in WMS. The postings in the inventory value journal do 

not change the value of your own inventory. The goods flow is mapped, because consumption and 

the entire cost of sales must be taken into account in order to determine the sales revenue. 

To differentiate the inventory relevance of the postings, you can select a goods flow account in the 

Goods flow field on the Costs tab in the item master. This field is used instead of the inventory 

account. It must not be the same as the inventory account. 
 

Purchase invoice approval in Third-party delivery 

Material movements are generated during invoice approval.  

In the context of Value flow, checks are carried out during purchase invoice approval to determine 

whether the invoice is for a third-party delivery. 

If the invoice is for a third-party delivery, the following three records are generated for each HR 

record in the invoice: 

Posting ID Description 

11010 Third-party delivery goods receipt 

32010 Third-party delivery goods issue 

11910 Third-party delivery invoice approval 

 

Third-party delivery in Finance 
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The usual posting process for invoice records is then carried out. In the posting journal, entries are 

created for both the goods movements and the invoice records. The Inventory value, Average 

price, and Inventory quantity fields in the item master are not updated. Any differences between 

the purchase order price and invoice price are not posted. The Last purchase price, Minimum 

purchase price, and Maximum purchase price fields are only updated if the 

COMMON.VALUEFLOW.UPDATEPURCHPRICEMASTERDATA parameter in the configuration is set to yes. 

 

The Third-party delivery goods receipt account must be added to the inventory account group. The 

Third-party delivery goods issue account belongs to the group of inventory change accounts. 

When the COMMON.VALUEFLOW.TRANSFERGOODSRECEIPTTOFINANCE parameter in the configuration is 

set to no, the goods receipt clearing account must be replaced by the goods issue account. 

Negative invoice lines are handled in the same way as positive lines. 
 

Cancel invoice approval in Third-party delivery 

As both the goods receipt postings and goods issue postings as well as the invoice approval 

records are grouped together as one within the inventory value journal, these records are also 

taken into account when an invoice is canceled. The cancelation is carried out in the same way as 

invoice approval, but in the opposite direction.  

The Last purchase price, Minimum purchase price, and Maximum purchase price fields are only 

updated if the COMMON.VALUEFLOW.UPDATEPURCHPRICEMASTERDATA parameter in the configuration is 

set to yes. 
 

Purchase credit memos in Third-party delivery in Finance 

Purchase credit memos cannot be created for purchase orders from the Third-party delivery 

add-on. 
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Sales tax calculation in Third-party delivery 

If companies from the EU, whose headquarters in some cases can even be located in different EU 

states, are involved in a chain transaction, their member state, sales tax ID, and terms for the 

delivery of the goods to the customer must be used to calculate the sales tax. For information on 

the possible combinations of the specified criteria and their effects on the sales tax for 

subcontractors, see Calculate sales tax for foreign businesses. 

Case 1: The same tax rate is calculated for all order lines 

In this case, the tax rate stored in the order header applies to all lines in this order. In the company 

master, the appropriate link to this tax rate must be stored for the default ship-to address and 

default bill-to address. Along with the address data, it is entered in the order data when a new 

order is created and the master data is updated, and it can be modified by the user for each item 

specifically. If the delivery or bill-to address is changed in the order, the tax is calculated according 

to the stored regional tax. Provided that the newly selected address belongs to a different country 

category to the previous one, the tax ID in the header record is replaced automatically by the ID 

stored for the regional tax. The same process is used if the terms of delivery for the order are 

modified. 

 

Case 2: Different tax rates can be calculated for the order lines. 

In this case, the domestic tax rates must always be stored as a link to the item in the item master. 

If a new order is created with a foreign ship-to address or bill-to address, the flag for the order lines 

is modified according to the regional tax. The same procedure is applied if the ship-to address, 

bill-to address, or terms of delivery are modified in the order header. In these cases, only lines that 

have not yet been calculated are affected by the change. 

 

Prerequisites 

The following conditions must be met in order to calculate the sales tax:  
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 The business partner's sales tax ID must be known. 

 Only one sales tax ID is supported for each business partner. 
 

Reports and statistics in Third-party delivery 

Reports 

The pick list overrides order lines that are delivered directly by the supplier. All other purchasing 

and sales reports remain unchanged. 

Statistics 

Consumption statistics use the data in the Value flow journal and therefore include the items that 

were delivered directly by the supplier. 

Intrastat 

Intrastat declarations are only required for goods that are delivered between EU states. If a 

delivery crosses EU borders, both the customer, as goods recipient, and the subcontractor, as 

goods supplier, must issue Intrastat declarations in the context of a triangular transaction. The two 

business partners must exchange their addresses, so that it can be determined whether it is an EU 

import or EU export that needs to be reported. 
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